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e-Compute™ ©2000-2010 was replaced by “Compute Manager” which is now Altair
Access

Altair SmartWorks™ - Innovation Intelligence®

Altair SmartCore™ ©2011-2019

Altair SmartEdge™ ©2010-2019

Altair SmartSight™ ©2014-2019

Altair intellectual property rights are protected under U.S. and international laws and treaties.
Additionally, Altair software is protected under patent #6,859,792 and other patents pending. All other
marks are the property of their respective owners.

ALTAIR ENGINEERING INC. Proprietary and Confidential. Contains Trade Secret Information.

Not for use or disclosure outside of Altair and its licensed clients. Information contained in Altair
software shall not be decompiled, disassembled, “unlocked”, reverse translated, reverse engineered,
or publicly displayed or publicly performed in any manner. Usage of the software is only as explicitly
permitted in the end user software license agreement. Copyright notice does not imply publication.

Third party software licenses
AcuConsole contains material licensed from Intelligent Light (www.ilight.com) and used by permission.

Software Security Measures:

Altair Engineering Inc. and its subsidiaries and affiliates reserve the right to embed software security
mechanisms in the Software for the purpose of detecting the installation and/or use of illegal copies of
the Software. The Software may collect and transmit non-proprietary data about those illegal copies.
Data collected will not include any customer data created by or used in connection with the Software
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and will not be provided to any third party, except as may be required by law or legal process or to
enforce our rights with respect to the use of any illegal copies of the Software. By using the Software,
each user consents to such detection and collection of data, as well as its transmission and use if an
illegal copy of the Software is detected. No steps may be taken to avoid or detect the purpose of any
such security mechanisms.
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Technical Support
Altair provides comprehensive software support via web FAQs, tutorials, training classes, telephone and
e-mail.

Altair Support on the World Wide Web
The Altair web site is a valuable online companion to Altair software. Visit www.altairhyperworks.com
for tips and tricks, training course schedules, training/tutorial videos, and other useful information.

Altair Training Classes
Altair training courses provide a hands-on introduction to our products, focusing on overall functionality.
Courses are conducted at our main and regional offices or at your facility. If you are interested in
training at your facility, please contact your account manager for more details. If you do not know who
your account manager is, please send an e-mail to training@altair.com and your account manager will
contact you.

Telephone and E-mail
When contacting Altair support, please specify the product and version number you are using along with
a detailed description of the problem. Many times, it is very beneficial for the support engineer to know
what type of workstation, operating system, RAM, and graphics board you have, so please have that
information ready. If you send an e-mail, please specify the workstation type, operating system, RAM,
and graphics board information in the e-mail.

To contact an Altair support representative, reference the following table or the information available on
the HyperWorks website: www.altairhyperworks.com/ClientCenterHWSupportProduct.aspx.

Location Telephone E-mail

Australia 64.9.413.7981 anzsupport@altair.com

Brazil 55.11.3884.0414 br_support@altair.com

Canada 416.447.6463 support@altairengineering.ca

China 86.400.619.6186 support@altair.com.cn

France 33.1.4133.0992 francesupport@altair.com

Germany 49.7031.6208.22 hwsupport@altair.de

India 91.80.6629.4500

1.800.425.0234 (toll free)

support@india.altair.com

Israel israelsupport@altair.com

Italy 39.800.905.595 support@altairengineering.it

http://www.altairhyperworks.com/
mailto:training@altair.com
http://www.altairhyperworks.com/ClientCenterHWSupportProduct.aspx
mailto:anzsupport@altair.com
mailto:br_support@altair.com
mailto:support@altairengineering.ca
mailto:support@altair.com.cn
mailto:francesupport@altair.com
mailto:hwsupport@altair.de
mailto:support@india.altair.com
mailto:israelsupport@altair.com
mailto:support@altairengineering.it
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Location Telephone E-mail

Japan 81.3.6225.5830 support@altairjp.co.jp

Malaysia aseansupport@altair.com

Mexico 55.56.58.68.08 mx-support@altair.com

South Africa 27 21 8311500 support@altair.co.za

South Korea 82.70.4050.9200 support@altair.co.kr

Spain 34 910 810 080 support-spain@altair.com

Sweden 46.46.460.2828 support@altair.se

United Kingdom 01926.468.600 support@uk.altair.com

United States 248.614.2425 hwsupport@altair.com

For questions or comments about this help system, send an email to connect@altair.com.

In addition, the following countries have resellers for Altair Engineering: Colombia, Czech Republic,
Ecuador, Israel, Russia, Netherlands, Turkey, Poland, Singapore, Vietnam, Indonesia

Official offices with resellers: Canada, China, France, Germany, India, Malaysia, Italy, Japan, Korea,
Spain, Taiwan, United Kingdom, USA

See www.altair.com for complete contact information.
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Get Started 1

Get Started

Learn the basics and discover the workspace.

This chapter covers the following:

• User Interface  (p. 21)

• Preferences  (p. 42)
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User Interface
Explore the HyperMesh user interface.

1. Title Bar

2. Menu Bar

3. Toolbars

4. Tab Area

5. Modeling Window

Proprietary Information of Altair Engineering

6. Browsers

7. Entity Editor

8. Panels

9. Status Bar

10. Undo-Redo

11. Search and Find HyperMesh Tools
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1. Title Bar. Indicates which product is active. Because you can switch between clients, clicking on
and activating a different window may change the information in the title bar. If the client you
have opened supports user profiles, the name of the active loaded user profile is also shown.

2. Menu Bar. Contains pull-down menus that provide access to standard functions such as New,
Open, Save and Undo/Redo. This is also where you can access system preferences, and the help.

3. Toolbars. Group of icon buttons that provide access to common tools.

4. Tab Area. Contains browsers, Utility menus for the solver interfacing user profiles, and other
functionality not shown in the panel area.

5. Modeling Window. Displays your model, geometry, and plots, and allows you to select entities and
manipulate the view of the model in the modeling window.

6. Browsers. Displays view-related functionality in HyperWorks Desktop by listing the parts of a
model in a tabular and/or tree-based format, and provides controls inside the table that allow you
to alter the display of model parts.

7. Entity Editor. Opens when you select an entity in a browser, and allows you to view and edit
entities in a model and correctly setup solver information.

8. Panels. Displays pre-processing and post-processing tools.

9. Status Bar. Displays information pertaining to the currently loaded model as well as descriptions
of the pages and panels.

10. Undo-Redo. Undo and redo actions

11. Quick Access Tool. Quickly find and open the tools, panels, and browsers that are available from
the menu bar pull-downs or from the Utility Browser, as well as create solver cards.

Title Bar
The title bar displays the name of the Session file (*.mvw) that is currently opened, along with the
active product and user profile.

The title bar is located at the top, left of the application.

Because you can switch between clients, clicking on and activating a different window may change the
information in the title bar. If the client you have opened supports user profiles, then the name of the
active loaded user profile is also shown.
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Menu Bar
The menu bar contains pull-down menus that provide access to standard functions such as file 
management operations, system preferences, and help.

Toolbars
Each toolbar contains a group of icon buttons that provide access to common HyperMesh tools.

Toolbars are dockable, meaning they can be moved and either floated or pinned to a location, allowing 
you to configure the workspace according to your preferences.

Turn toolbars on and off from the View > Toolbars menu.

Checks
The Checks toolbar provides access to checks and calculations tools that are commonly used in the 
model building process.

Turn the Checks toolbar on and off from the View > Toolbars > HyperMesh > Checks menu.

Figure 2:

Opens the Distance Panel.

Opens the Length Panel.

Opens the Mass Calc Panel.

Opens the Edges Panel.

Opens the Features Panel.
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Opens the Faces Panel.

Opens the Normals Panel.

Opens the Penetration Panel.

Opens the Check Elems Panel.

Opens the Summary Panel.

Opens the Loads Summary Tool.

Opens the Count Panel.

Collectors
The Collectors toolbar provides access to tools that allow you to create, edit, delete, card edit, organize,
and renumber HyperMesh collectors.

Turn the Collectors toolbar on and off from the View > Toolbars > HyperMesh > Collectors menu.

Figure 3:

Opens the Assemblies Panel.

Opens the Component Collectors Panel.

Opens the Material Collectors Panel.

Opens the Property Collectors Panel.

Opens the Load Collectors Panel.
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Opens the System Collectors Panel.

Opens the Vector Collectors Panel.

Opens the Beamsection Collectors Panel.

Opens the Multibody Collectors Panel.

Opens the Delete Panel.

Opens the Card Editor Panel.

Opens the Organize Panel.

Opens the Renumber Panel.

Display
The Display toolbar controls what entities HyperMesh displays in the graphics area, primarily by
masking entities to hide or display.

Turn the Display toolbar on and off from the View > Toolbars > HyperMesh > Display menu.

Figure 4:

Opens the Mask Panel.

Left-click: Reverses the mask state of all elements in currently displayed collectors.
Right-click: Reverses the mask state of all entities (elements, loads, and so on) in currently
displayed collectors.

Unmasks the row of elements adjacent to the currently displayed ones. If some of the unmasked
elements reside in components that are currently not displayed, those components will also be
unmasked.
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Unmasks all entities (elements, loads, and so on) in the currently displayed collectors.

Left-click: Masks all entities (elements, loads, and so on) located outside of the graphics area but
in currently displayed collectors.
Right-click: Unmask all entities (elements, loads, and so on) located outside of the graphics area
but in currently displayed collectors.

Opens the Spherical Clipping Panel.

Opens the Find Panel.

Opens the Numbers Panel.

Displays a scale in the lower, right-hand corner of the graphics area, which you can use to
measure different parts of your model. The numbers on the scale are dependent upon the
dimension of the model and the zoom factor you are currently using in the graphics area.

Switches the display of element handles on/off.

Switches the display of load handles on/off.

Points the load vector toward the load application point (tip), or away from the load application
point (tail) when the tip or the tail of the load vector is attached to the load application point.

Note:  The direction of the vector does not change when you select this option.

Switches the display of fixed points on/off.

Favorites
The Favorites toolbar allows you to save and access a menu that lists your favorite panels. HyperMesh
saves the list of favorite panels and restores it accordingly when you start a new session.

Turn the Favorites toolbar on and off from the View > Toolbars > HyperMesh > Checks menu.
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Figure 5:

Patch Checker
The Patch Checker toolbar contains a group of icon buttons that you can use to review quality results,
sliver surfaces, elements attached to selected nodes, and so on.

Entities placed on the user mark are used as input. The user mark is populated by selecting the save
option from advanced entity selections, specific panels that have the save button (such as Check
Elems), or via Tcl script using *marktousermark.

This tool creates "patches", or local regions, from each input entity. A patch includes only displayed
entities. Patches are not created for any input entities that are not displayed. A spherical clipping is
then calculated and applied for each patch, with the input entity highlighted and the adjacent entities
low lighted. In order to keep the performance high, only the first 500 entities on the user mark are
considered.

Turn the Patch Checker toolbar on and off from the View > Toolbars > HyperMesh > Patch Checker
menu.

Figure 6:

Select the elements entity type.

Select the surfaces entity type.

Select the nodes entity type.

Turn the tool on or off.

Go to the previous patch.
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Go to the next patch.

Go back to the first patch.

Decrease the size of the spherical clip.

Increase the size of the spherical clip.

Reset the spherical clip back to its default.

Undo-Redo
The Undo-Redo toolbar provides access undo and redo functionality.

Turn the Undo-Redo toolbar on and off from the View > Toolbars > HyperMesh > Undo-Redo menu.

Figure 7:

Visualization
The Visualization toolbar contains a group of icons that you can use to control the display of entities in
the graphics area.

Turn the Visualization toolbar on and off from the View > Toolbars > HyperMesh > Visualization
menu.

Figure 8:

Geometry - Color mode options

Automatically select a color mode based on the active panel.
You can change display colors in the Options panel, Colors subpanel.

All surfaces are colored based on the assemblies they belong to. Each assembly receives a
different color (although models with many assemblies may have colors repeated for more
than one assembly). Any surfaces that do not belong to an assembly are colored gray.
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All surfaces are colored based on the parts they belong to. Any surfaces that do not belong
to a part receive the color assigned to the master model.

Changes the color of all surfaces and solid faces to the color assigned to the component in
which that geometry resides. All surface edges and solid face edges are colored black.

Surfaces are colored gray (2D faces (topo) with surface edges colored by topology: red
(free edges), green (shared edges), yellow (t-junctions), or blue (suppressed edges). Solid
faces and face edges are colored transparent green (bounding faces) with internal faces
colored yellow (full partition faces).

Surfaces are colored gray (2D faces (topo) with surface edges colored by topology: red
(free edges), green (shared edges), yellow (t-junctions), or blue (suppressed edges). Solid
faces and face edges are colored blue, ignoring solid topology.

Surfaces and surface edges are colored blue, ignoring surface topology. Solid faces and face
edges are colored transparent green (bounding faces) with internal faces colored yellow (full
partition faces).

Surfaces are colored by component with surface edges colored by topology. Solid faces are
colored by component with solid face edges colored by topology.

Surfaces display in wireframe mode, with surface edges colored blue (ignoring topology).
Solid faces are colored by mappability: red (not mappable), yellow (1d mappable), or green
(3d mappable). Solid face edges are colored by topology.

Geometry - Shade options

Set geometry mode to shaded with surface edges.

Set geometry mode to shaded.

Geometry - Wireframe options

Set geometry to wireframe with surface lines.

Set geometry to wireframe mode.
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Opens the Transparency panel.

Mesh - Color mode options

All elements are colored based on the parts they belong to. Any elements that do not
belong to a Part receive the color assigned to the master model.

All elements are colored by the color assigned to the component in which that element
resides.

All elements are colored by the property assigned to that element. Properties are assigned
to elements directly or indirectly. Properties are assigned directly to the element by using
the Property > Assign panel. Indirect element properties are inherited from the component
in which the element resides; component properties are assigned in the Component >
Assign panel. Directly assigned properties override indirect ones. Solvers in group #1
(Radioss (Bulk Data), OptiStruct, Nastran) can support both direct and indirect element
property assignment. Solvers in group #2 (Radioss (Block), LS-DYNA) only support indirect
element property assignments. Any element without a property is colored gray.

All elements are colored by the material assigned to that element. Materials are assigned
to elements differently for solver group #1 and solver group #2; Solver Group #1 (Radioss
(Bulk Data), OptiStruct, Nastran) assign materials to properties, and then properties to
elements (either directly or indirectly as discussed in Color by Property). Elements with both
direct and indirect property assignments use the material associated with the direct element
property assignment. Solver group #2 (Radioss (Block), LS-DYNA) assigns materials to
elements indirect by assigning materials to the component in which the element resides
using the Component > Assign panel. Any element which does not have a material assigned
to it, directly or indirectly, will be colored gray.

All elements are colored based on the assemblies they belong to. Each assembly receives a
different color (although models with many assemblies may have colors repeated for more
than one assembly). Any elements that do not belong to an assembly are colored gray.

All elements are colored by their topology: green (1D), blue (2D), and red (3D).

All elements are colored by their element configuration (mass, reb2, spring, bar, rod, gap
tria3, quad4, tetra4, and so on).
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Opens the Thickness View, and colors shell elements according to their thickness values.
Both element as well as node thicknesses are supported. A thickness legend is shown in the
upper-left corner of the graphics area.
Thickness coloring can be combined with 2D Detailed Element Representation

Figure 9: Element Thickness with 2D Detailed Representation

Figure 10: Nodal Thickness with 2D Detailed Representation

Opens the Element Quality View mode in the graphics area.
This permanent mode serves as a useful tool to investigate each specific element criteria, as
well as evaluate the overall quality of a mesh.

All elements are colored based on the domains they belong to. A domain is a morphing
entity which enables design changes to an existing FE topology. Each domain receives a
different color. Any elements that do not belong to a domain are colored gray.
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Elements - Shaded options

Set current element visual mode to shaded with mesh lines. Elements are shaded, and
surface mesh lines display.

Set current element visual mode to shaded with feature lines. Elements are shaded but
have no mesh lines, while feature lines display.

Set current element visual mode to shaded. Elements are shaded, but no lines display.

Elements - Wireframe options

Set the current element visual mode to wireframe (skin only). Internal mesh lines will not
display.

Set the current element visual mode to wireframe. Internal and surface mesh lines display.

Set current element visual mode to transparent with elements and feature lines.
Elements are shaded but transparent, no mesh lines display, but feature lines do.

1D - Element options

Display a more detailed, shaped-based representation for 1D beam elements.

Display both the simple and detailed representations for 1D beam elements.

2D - Element options

Display a simple representation for 2D shell elements.

Display a more detailed, shaped-based representation for 2D shell elements.

Display both the simple and detailed representations for 2D shell elements.
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Ply/Composite options

Ply layers are not displayed. 

Plies in a composite material are displayed.

Figure 12:

The exact nature of the display depends on the 2D Element Representation button. See
Element and Ply Visualization for details.
For continuum shells the display can be overlaid with the transparent representation of the

original continuum shell elements, if 2D Traditional Element Representation ( ) is

turned on.

Display layers with vectors indicating their appropriate ply orientation. Corrected fiber
directions are shown if the drape data is available on every element of the ply.

Figure 13:

The exact nature of the display depends on the 2D/3D element visualization button. See
Element and Ply Visualization for details.
For continuum shells the display can be overlaid with the transparent representation of the

original continuum shell elements, if 2D Traditional Element Representation ( ) is

turned on.

Enables the ply lay-up or stack boundaries to be visualized, which provides an easy way to
view ply drop-off. When the stack topology shape is changed, the visualization of the edges
is automatically updated. Ply layer geometry edges are always outlined in white, where as
FE edges are always outlined in the same color as the ply. FE edges are always outlined with
a thicker line compared to geometry edges.
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Opens Visualization Controls tab.

Element and Ply Visualization
The exact visualization of ply layers in a composite material, requires the use of both the Composite
Visualization and Element (complexity) Visualization options.

These options work in tandem to determine exactly how composite layers will display in HyperMesh.

Access these options from the Visualization toolbar.

 (1D/2D Element Representation)

 (Composite Visualization)

2D Traditional Element Representation ( )

HyperMesh represents composite layers, when visible, as 2D shells:

Figure 14: Layers Off

Figure 15: Composite Layers

Figure 16: Layers with Fiber Direction
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Toggle on/off shrink elements by shrink factor.
Shrink factor can be set from the Options panel, Graphics subpanel.
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2D Detailed Element Representation ( )

Figure 17: Layers Off

Figure 18: Composite Layers

Figure 19: Layers with Fiber Direction

2D Traditional and Detailed Element Representation ( )

Figure 20: Layers Off
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Figure 21: Composite layers

Figure 22: Layers with Fiber Direction

Figure 23: Layers with Fiber Direction for Continuum Shells
Original element geometry is shown in transparent mode, so that differences in elemental versus property thickness can

be easily seen.

Tab Area
The tab area organizes browsers, Utility menus for the solver interfacing user profiles, and other
functionality not shown in the panel area in different tabs.

The tab area can be turned on or off from the View menu. A check mark indicates that the tab area is
currently displayed.

The tab area can be positioned on either the left or right side of the modeling window, both, or turned
off completely by selecting Left, Right, Expand Both, or Collapse Both from the View > Tab Area
menu.
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Modeling Window
The modeling window displays your model, geometry and plots.

The modeling window occupies the middle portion of the application.

You can select entities and manipulate the view of the model in the modeling window.

The global axes, located in the bottom, left of the modeling window, indicates the location of the 
displayed model. The active background has a thin blue line surrounding it to indicate which window is 
currently active.

You can customize the color of the global axes and backgrounds in the modeling window using the Color 
Preferences.

Figure 24: Modeling Window

Status Bar
The status bar displays information pertaining to the currently loaded model as well as descriptions of
the pages and panels.

The status bar, located along the very bottom of the application, can be turned on or off from the View
menu. A check mark indicates that a toolbar is currently displayed.

Messages
The left side of the status bar displays messages and descriptions of active features in the User
Interface.
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When you are on one of the main menu pages, not within a panel, a description of the active menu
page name, for example, Geometry, displays.

Figure 25: Surfaces Panel, Cylinder Full Subpanel
Panel and subpanel name is displayed in the status bar.

When you are in a panel, the panel title and subpanel title display.

Tip:  Holding down the left mouse button on the panel button displays a description of the
panel.

Figure 26: Distance Panel
Description of Distance panel is displayed in the status bar.

Errors messages and miscellaneous messages such as status updates or completed operations also
display, and temporarily override the title and status information.

Messages are color-coded.

Red
Error message.

Green/Gray
Miscellaneous messages, such as status updates or completed operations. These messages
appear in green when using HyperMesh classic dark menu colors and they appear in gray when
using Windows light menu colors.
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Figure 27: Error Message

Click a mouse button to remove a message from the status bar.

Current Collector
The right side of the status bar displays the current include, component and load collector.

Tip:  Quickly change the active collector by clicking the name of the collector in the
corresponding box on the status bar to open the appropriate panel which lists the available
collectors.

Figure 28: Current Collectors

Undo-Redo
Undo and redo actions performed in HyperMesh.

Not all the actions performed in HyperMesh can be undone or redone. If an operation does not support
undo/redo, the undo/redo functionality will be disabled once the action is completed and any previous
undo/redo history recorded will be reset. The undo/redo history will also be reset every time a macro or
other tcl application is invoked.

Note:  The undo/redo functionality is supported by most HyperMesh panels, tools and user
interface functionalities.

By default, the number of undo actions is set to 100 and the maximum undo memory (MB) is set
to 2500. You can modify both of these settings in the Undo/Redo Settings dialog accessed from the
Preferences > Undo/Redo Settings menu.

Undo/redo history may use a large amount of memory. By default, a threshold of 80% of the total
memory limit will not be exceeded. Once the memory threshold is exceeded, all older actions will be
automatically purged.

• Undo an action by clicking  from the Undo-Redo toolbar, or pressing Ctrl+Z.
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• Redo an action by clicking  from the Undo-Redo toolbar, or pressing Ctrl+Y.

Tip:  Simultaneous actions can be undone/redone by selecting them from the Undo/Redo
drop-down menus on the Undo-Redo toolbar.

Figure 29:

Search and Find HyperMesh Tools
Quickly find and open the tools, panels, and browsers that are available from the menu bar pull-downs
or from the Utility Browser, as well as create solver cards.

You can only create solver cards with the Quick Access tool in the Radioss, OptiStruct, Abaqus, LS-
DYNA, PAM-CRASH 2G and Permas user profiles.

1. Enable the Quick Access tool by pressing Ctrl + F.

Once enabled, a search bar opens in the top, right of the application.

Figure 30:

2. Enter a search string.
Predicted results appear in a list.

3. Select a search result from the list, or press Enter to select the highlighted search result.

4. Exit the Quick Access tool by pressing Esc or clicking anywhere outside of the tool.

Selecting a tool, panel, or browser from the list opens the respective tool.
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Figure 31:

Selecting a solver card from the list creates a new card.

Tip:  When creating solver cards with the Quick Access tool, set the Model Browser as the
current tab so that you can easily recognize where newly created cards are being stored
upon creation.

Figure 32:
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Preferences
Configure the view of HyperMesh.

Check Element Settings
Check Element settings control which version of each element check to use.

Access Check Element settings by selecting Preferences > Check Element Settings from the menu
bar.

Click the 2D and 3D tabs to set check element settings for the different types of elements.

Solver Settings

• Choose All set to to set all checks to the same solver's methods.

• Choose Set individually to set each check method individually.

Checks/Solvers
For each check, select the desired solver.

Checks/Method
For each check, select the method used to calculate the check.

Color Settings
Color settings control the display color of the user interface, as well as the display color of geometry
and mesh entities.

Access Color settings by selecting Preferences > Colors from the menu bar.

General
Access color settings that control the user interface in the General tab.

Background 1/Background 2
Select any colors for Background 1 and Background 2, which control the color of the background
gradient in the graphics area.
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Figure 33:

Gradient Direction
Select one of the gradient boxes to change the direction and style of the gradient in the graphics
area. The boxes themselves illustrate the gradient pattern that they apply, but not the current
colors.

Show Global Axes
Show the global axes in the graphics area.

Global X axis / Global Y axis / Global Z axis / Axis label
Change the colors of the X, Y, and Z global axis vectors. By default, the X axis is red, the y axis is
green, and the Z axis is blue.
Change the color of the axis labels. By default, the axis labels are white.

Figure 34:

Text and Line Color
Change the color of all the text and lines that displays in the graphics area to be black. By default,
the text is white.

Geometry
Access color settings that control the geometric entities in the Geometry tab.
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Different types of geometric features are broken down first by dimensionality (2D surfaces, 3D solids),
each having no influence on the geometry of the other type. A third category, By mappable display
mode (solids), applies to qualities of solids rather than parts of them. These colors apply specifically
to how many possible directions solids can be mapped in, and are specific to the mappable geometry
display mode. They will not show in any other display mode, even if the model contains solid entities.

Surface data

Free edges
Edges of surfaces that do not connect to any other surfaces.

Shared edges
Edges of surfaces that connect to one other surface.

Suppressed edges
Shared edges that have been manually suppressed so that the automesher treats the shared
surfaces as if they were one surface, allowing elements to cross the edge as if it were not there at
all.

T-junctions
Edges shared by 3 or more surfaces.

3D Solids

Fin faces
Surfaces that split a 3D solid entity, but only partway through. They do not actually extend
through the entire entity.

Bounding faces
The outer faces of solid entities.

Full partition faces
The faces of adjoined solids.

2D faces (topo)
When using the by 2D topo visualization mode, this is the color of 2D faces that are not part of a
solid.

Ignored (topo)
The color of 2D faces when using the by 2D topo visualization mode.

Edges (comp)
Mesh edges when coloring mesh with the by comp visualization mode.

By mappable display control (solids)

1 dir. map
Visualization for solids that can be mapped (for 3D meshing) in one direction.

3 dir. map
Visualization for solids that can be mapped (for 3D meshing) in three directions.

Not mappable
Visualization for solids that have been edited, but still require further partitioning to create
mappable solids.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Get Started p.45

Ignored map
Default visualization for solids that require partitioning to become mappable.

Mesh
Access color settings that control the FE entities in the Mesh tab.

Mesh line
Specify the color of the lines on a mesh that indicate the edges of mesh elements. By default,
mesh line is set to auto, which assigns the component color as the mesh line color. To select a
custom mesh line color for the entire mesh, click the toggle.
This option only works when the element color mode is set to By Comp. Other element color
modes render mesh lines black or use the defaults selected in the Options panel, Color subpanel
or in the Colors dialog, Mesh tab, accessed from the Preferences menu.
These settings are not applicable to 2nd order elements and clipped elements of section cuts, or
when you are in Automesh panel mode.
Used in conjunction with the Mesh Appearance settings.

Elems, no prop/mat
Specify the color for elements that do not currently have any properties or materials assigned to
them, either directly or inherited from the collectors that they belong to.

Mesh/Geometry Appearance Settings
Mesh/Geometry Appearance settings control the display of mesh lines, geometry lines, and application
level anti-aliasing.

Access Mesh/Geometry Appearance settings by selecting Preferences > Mesh/Geom Appearance
from the menu bar.

Meshing
Detail: Mesh Line Settings

Moving the Detail slider from 1 to 10 allows the displaying of mesh lines when you are viewing the
model at further zoomed out levels regardless of the mesh coarseness.
These settings are not applicable to 2nd order elements and clipped elements of section cuts, or
when you are in the Automesh panel.
These settings are used in conjunction with the mesh line option in the Options panel, Colors
subpanel.

Transparency: Finite Element Settings
Moving the Transparency slider from 2.0 to 9.5 adjusts the transparency levels of finite element
models from more opaque to more transparent.
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Transparent with mesh lines
Check this box on to display mesh lines when finite elements are transparent.

Geometry
Detail: Geometry Line Settings

Moving the Detail slider from 1 to 10 allows the displaying of geometry lines when you are
viewing the model at further zoomed out levels.

Solid edge width: Geometry Solid Edge Line Width Setting
Moving the Solid edge width slider from 1.0 to 5.0 allows the displaying of geometry solid edge
line width thickness.

Auto edge adjustment
Check this box on to change the geometry line widths dynamically when zooming in and out.

Anti-aliasing
Anti-aliasing

Check this box on to have all graphic lines be anti-aliased, that is drawn smoother.

'

Lighting Settings
Lighting settings control the location, direction and intensity (high/low) of the specular lighting.

Access Lighting settings by selecting Preferences > Lighting from the menu bar.

One light
Manually control the direction of lighting, and adjust the specular lighting by moving the slider.
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Multi-lights (default)
Use the standard placement of the multiple lights, and adjust the specular lighting by moving the
slider.
This setting does not allow for directional control.
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Scale Settings
Scale settings control the scale display in the graphics area.

Access Scale settings by selecting Preferences > Scale from the menu bar.

Scale Position
Select a location to display the scale.

Scale Size
Select a display size for the scale.

Scale Color
Pick a color to display the scale.
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Script Performance Settings
Script Performance settings control the APIs used to improve script performance when the original 
script may not have cleaned itself up correctly due to poor logic, unhandled errors or unexpected 
behavior.

Access Script Performance settings by selecting Preferences > Script Performance from the menu 
bar.

If you experience issues with entity selection not highlighting, messages not posting to the status bar, 
command files not populating or graphics not redrawing, reset the settings in this dialog.
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Manage Favorite Panels
Save and access a list of your favorite panels. HyperMesh saves the list of favorite panels and restores it 
accordingly when you start a new session.

Figure 39:

Add Favorites

1. Open the panel you wish to save to the favorite panels menu.
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2. From the Favorites toolbar, click  and select Add Current Panel.

Remove Favorites

1. Open the panel you wish to remove from the favorite panels menu.

2. From the Favorites toolbar, click  and select Remove Current Panel.
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Change Solver Interfaces
Load a different solver interface in HyperMesh.

1. From the Standard toolbar, click .

2. In the User Profiles dialog, select a solver interface and click OK.
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Interface with External Products

Solver interfaces supported in HyperMesh.

This chapter covers the following:

• Current Supported Versions  (p. 53)

• Change Solver Interfaces  (p. 57)

• Types of Interfacing  (p. 58)

• Abaqus Interface  (p. 60)

• Actran Interface  (p. 63)

• AcuSolve Interface  (p. 64)

• ANSYS Interface  (p. 87)

• EXODUS Interface  (p. 94)

• Feko Interface  (p. 95)

• LS-DYNA Interface  (p. 96)

• MADYMO Interface  (p. 99)

• Marc Interface  (p. 100)

• Nastran Interface  (p. 101)

• PAM-CRASH 2G Interface  (p. 105)

• Permas Solver Interface  (p. 108)

• OptiStruct Interface  (p. 110)

• Radioss Interface  (p. 111)

• Samcef Interface  (p. 112)
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Current Supported Versions
Currently supported solver interface versions.

Note:  CAD translator support can be found in the CAD Reader Support and CAD Writer
Support topics of the Geometry chapter.

Solver Compatible
Version

Model Files Result File Input
Translator

Template

Abaqus 2019 *.INP (ASCII) *.FIN
(ASCII)

*.FIL
(binary)

*.ODB

abaqus Standard 2D

Standard 3D

Explicit

Actran 2004 *.RES actran/actran

ANSYS 2019 R1 *.CDB (ASCII) *.RST
(binary)

*.RTH
(binary)

*.RMG
(binary)

ansys ansys/
ansys.tpl

EXODUS 6.09 *.ex

*.exo

*.ex2

NA exodus exodus/
exodus.tpl

LS-DYNA 971R6.1 –
13.0

971R7.0 –
13.0.110

971R7.1 –
14.0.110
(R7.0
renamed to
R7.1)

971R8.0 –
14.0.110

*.k

*.key

*.dyn

*.dat

*.bdf

*.inc

dynain
(ASCII)

d3plot,
intfor,
d3eigv,
d3int, ptf

binout
(binary)

All ASCII
time
history files

FEMZIP (up
to v8.73)

dynakey ls-
dyna/dyna.key
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Solver Compatible
Version

Model Files Result File Input
Translator

Template

971R9.0 –
2019

d3plot,
intfor

MADYMO 7.0, 6.4, 6.3 *.xml (ASCII) KIN3
(ASCII)

FEMANI
(ASCII)

madymo madymo/

madymo70 

madymo/

madymo63

Marc Version 12

2008 r1 release

.dat (ASCII) .t16 (binary) marc.exe marc/Stress2D.tpl 

marc/Stress3D.tpl

Nastran MSC 2015

NX 9
*.dat*.bdf

*.nas

*.f06
(ASCII)

*.pch
(ASCII)

*.op2
(binary)

*.xdb
(binary)

FEMZIP
Nastran
(v1.3.6)

nastran nastran/

general 

nastran/

generallf

PAM-CRASH 2G VPS 2012 –
14.0

VPS 2013 –
14.0.110

VPS 2014 –
14.0.110

VPS 2015 –
14.0.130

VPS 2016 –
2017.2

VPS 2017 –
2019

*.pc

*.dat

*.inc

*.hma
(ASCII)

*.DSY

*.THP
(binary)

*.ERHF5
(binary)

FEMZIP
DSY
(v8.73)

VPS 2012 –
12.0.110

VPS 2013 –
13.0.110

VPS 2014 –
14.0

VPS 2015 –
14.0.130

pamcrash2g pamcrash2g/
general
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Solver Compatible
Version

Model Files Result File Input
Translator

Template

VPS 2016 –
2017.2

VPS 2017 –
2017.2.3

Modular
ERF - 2019

Permas 15 *.dat

(.uci not
supported)

*.h3d (binary)
– no translator
necessary

permas permas/permas

OptiStruct OptiStruct 2019 *.fem

*.dat

*.out
(ASCII)

*.pch
(ASCII)

*.h3d
(binary)

*.op2
(binary)

*.res
(binary)

optistruct optistruct/

optistruct 

optistruct/

optistructlf

Radioss (Fixed
Format)

4.1 *.d00 (ASCII) *animate.A00
(binary)

history.T0*
(binary)

Engine file
*D01 not
supported

radiossfix radioss/

radioss31.fix 

radioss/

radioss41.fix

Radioss Radioss2018 -
2019

*.d00
(ASCII),*_
0000.r ad

Engine
file *D01,
*_001.rad

animation
*A

00,

*#A00*
(binary)

Time
history
*T0*,
*_000*.thy,
*@T0*,
*#T0*

radiossblk radioss/
radioss41.blk

radioss/
radioss42.blk

radioss/
radioss44.blk

radioss/
radioss51.blk

radioss/
radioss90.blk
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Solver Compatible
Version

Model Files Result File Input
Translator

Template

radioss/
radioss100.blk

radioss/
radioss110.blk

radioss/
radioss120.blk

radioss/
radioss130.blk

radioss/
radioss140.blk

radioss/
radioss2017.blk

radioss/
radioss2018.blk

Samcef 17.1 .dat n/a n/a samcef/general
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Change Solver Interfaces
Load a different solver interface in HyperMesh.

1. From the Standard toolbar, click .

2. In the User Profiles dialog, select a solver interface and click OK.
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Types of Interfacing
HyperMesh uses three types of external interfacing.

These include:

• Importing CAD-generated geometry or finite element model information

• Exporting CAD geometry or finite element information for specific analysis codes

• Translating analysis results information to HyperMesh binary results format

CAD-generated geometry and finite element model information are input using the Import tab.
HyperMesh internally supports PDGS and DXF formats. External interfaces are supplied for finite
element analysis codes Abaqus, ANSYS, EXODUS, LS-DYNA KEY, LS-DYNA SEQUENTIAL, MADYMO,
Marc, MoldFlow, Nastran, OptiStruct, PAM-CRASH, Radioss, Radioss {Fixed Format}, and Samcef) and
for crash codes (LS-DYNA3D, PAM-CRASH, and Radioss), as well as for CAD codes, (CATIA, DXF, IGES,
PDGS, PRO/E, STEP and UG). There is an external interface for the universal IGES format, as well. You
can also create your own translation package.

The Export tab allows you to write information from a HyperMesh database to many finite element
formats. Geometry data can be written in IGES format.

HyperMesh uses templates to create the analysis input decks for finite element solvers. You can modify
the existing templates to support a desired feature or create a new template to support another
analysis code. The HyperMesh templates can be used to create model summaries and perform some
analysis calculations, such as center of gravity. You can also use the templates to perform complex
editing or data manipulation tasks.

HyperMesh provides external translators that convert analysis-specific results into the HyperMesh
results format. The results subpanel allows you to specify the results files for use in post-processing.

Note:  For more information, refer to the individual translators on the Results Translation
page.

HyperMesh uses both internal and external translators. You can write new external
translators to support CAD or FEA formats by using the functions provided in hminlib.

Note:  The HyperMesh Programmer’s Guide provides information about working with:

hmlib

hminlib

hmmodlib

hmreslib

See FE Input Readers for more information about writing your own translators.
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When you open the Export tab, HyperMesh sets the Template: field to the default analysis template
directory and the first template selected is designated the global template.

Export Options
There are several options available for exporting model data. For example, the all/displayed option
allows you to export files based on a subset of the existing HyperMesh database. If you select all, the
entire model is written, regardless of the current display settings. When you select displayed in the
Export tab, only a portion of the model displayed on the screen is exported.

Additional information about export options for geometry and solvers is included in the section that
pertains to the specific format.
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Abaqus Interface
Overview of the Abaqus Interface.

Supported Abaqus Profiles
Standard.2d

Generates a deck for two-dimensional models containing planar or axisymmetric elements for use
with Abaqus Standard.

Standard.3d
Generates a deck for three-dimensional models containing bar, shell, and solid elements for use
with Abaqus Standard.

Explicit
Generates a deck for use with Abaqus Explicit.

Import and Export
• HyperMesh places all elements into separate components, based on sectional property. Each

component is written out from HyperMesh as an element set in the Abaqus input deck.

• Although HyperMesh supports 160 characters in entity names, Abaqus output files are truncated at
80 characters to match the Abaqus name support level.

• Loads and constraints are organized under load collectors in HyperMesh and added to a load step
for the *STEP card in the Abaqus history definition. If loads are applied to node or element sets,
you can resolve these sets to individual nodes or elements by enabling the Expand loads on sets
option in the Import panel under Import options.

• Output options are organized under output blocks in HyperMesh. These output blocks also need to
be added to load steps.

• Resolve sets into nodes or elements, which are defined using the GENERATE parameter, using the
Solver options in the Import Browser. This is useful when nodes/elements are renumbered due to
ID conflicts during import.

Syntax
• HyperMesh supports some abbreviated key words and parameters.

• All Abaqus keywords and parameters supported in HyperMesh are not case insensitive.

• HyperMesh ignores spaces in keyword lines.

• HyperMesh supports quotation marks around component (ELSET with sectional properties) names,
which is especially useful for names that begin with a number.

HyperMesh Operations
• Warnings and error messages are written to a file named abaqus.msg. Unrecognized lines are

written to a *.hmx file. These files are created in the same directory from where HyperMesh is
launched.

• Step time calculations can differ between HyperMesh and Abaqus (Explicit analyses), therefore
you may find differences between reported values in the Abaqus status (.sta) file and the Time
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subpanel of the Check Elems panel. The values reported by HyperMesh are close estimates of the
step time; refer to the Abaqus documentation to learn about the factors that Abaqus/Explicit uses
to reach the final result.

Degenerated Brick Element
Elements that are defined in one configuration can be degenerated or collapsed to create other
configurations, while still preserving the number of nodes and element type in the original configuration.

For example, the HyperMesh Qaud4 element can degenerate into a Tria3 element, but when exported,
the four nodes and quadrilateral element information is written in the solver deck.

Degenerated brick elements are either Hex8 or Hex20 elements, collapsed into a wedge element
(Penta6 or Pet15). Penta6 (Element configuration 206) is a 3D, 1st order, triangular prism shape
element with a 6 noded order as shown inFigure 40. Hex8 (Element configuration 208) is a 3D,
1st order, brick shape element with a 8 noded order as shown in Figure 41. The Degenerated Brick
(Element configuration 206) option is a 3D, 1st order, triangular prism shape element with a 8 noded
order as shown in Figure 42.

Standard node order for a 1st order, penta6 element will be 1, 2, 3, 4, 5, 6. In cases of degenerated
brick elements, the node order will be 1, 2, 2, 4, 5, 6, 6, 8, with nodes 2 and 6 being repeated during
export. The same node repetition method is used for a 2nd order, degenerated brick element, but nodes
2 and 6 will be repeated twice and node 18 will be repeated once (1, 2, 2, 4, 5, 6, 6, 8, 9, 10, 2, 12, 6,
14, 15, 16, 17, 18, 18, 20).

Figure 40: Element Configuration 206, 6-Noded Penta
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Figure 41: Element Configuration 208, 8-Noded Hexa

Figure 42: Element Configuration 206, 8-Noded Penta

Since the 8-noded, hexa element is degenerated into a 8-noded penta element, the 1st order brick
element option is added under the 6-noded penta (Element configuration 206) and the 2nd order brick
element option is added under the 15-noded penta (Element configuration 215).
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Actran Interface
Overview of the Actran interface.

Define Actran Models
Define an Actran model in HyperMesh.

1. Create materials.

Four types of materials can be defined: fluid, visco-elastic, porous, and viscothermal fluid.

2. Create components.

3. Create mesh on the appropriate components.

4. Define boundary conditions, both node-related and element face-related.

5. Define the control card properties.

6. Create the Actran input deck file.
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AcuSolve Interface
Overview of the AcuSolve interface.

Supported AcuSolve Entities
Entities used to set up a case to run a CFD analysis using AcuSolve.

Global
Contains the physical description of the case, for example, laminar/turbulent and numerical
parameters, such as convergence tolerance.

Output
Define the frequency of different outputs: Derived Quantity Output, Nodal Output and Restart
Output.

Volumes
Components with Fluid and Solid card images are grouped in this folder.

Surfaces
Components with Inflow, Outflow, Wall, Slip, Symmetry and Far Field card images are grouped in
this folder.

Components With No Card Image
Components with no card image will not be exported with the solver deck. By default, all of the
components will not have a card image. You have to choose the appropriate card image for the
component and the component will be moved to the Surfaces or Volumes folder accordingly.

Nodal Boundary Condition
Define boundary conditions on nodes apart from surface boundary conditions.

Materials
Contains material definitions.

Body Force
Define gravity and heat source for volume components.

Periodic Boundary Condition
Define periodic or axisymmetric boundaries along with the transformation definition.

Reference Frame
Define rotational reference frame for the model.

Mesh Motion
Define translation and rotation for the mesh.

Emissivity Model
Define emissivity model for radiation surface.
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Multiplier Function
Define multiplier functions (Constant, Piecewise Linear, Cubic Spline, Piecewise Log Linear) and
utilize multiplier functions to ramp up supported parameters, for example angular velocities of
reference frame.

Parameters
Parameters can be utilized to run solver parameter based studies.
For example, if you want to run a series of simulations with inlet velocity values of 0.5 m/s, 0.75
m/s, 1 m/s respectively, you can define a parameter on inlet velocity with the desired values.
Using the HyperStudy Job Launcher DOE studies can be performed.

Solver Job Launcher
The Solver Job Launcher enables you to execute AcuSolve jobs directly from Engineering Solutions.

The tool integrates the mesh export and the AcuSolve job run. The submitted job can also be controlled
from Engineering Solutions.

Invoke Solver Job Launcher

Click the  icon in the CFD toolbar.

The Job Launcher dialog opens.
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Table 1:

Problem name Specifies the name of the input deck without the
extension *.inp. Do not use spaces in the name.

Problem directory Directory where the input deck is located. The
solver run will be started in the problem directory.

Working directory The result files of the AcuSolve run will be saved
into the working directory.

Solver exec dir Define the AcuSolve executable path. The path will
be auto selected if the solver is available in the
same installation path. If it is not available, the
path will be blank. The path needs to point to the
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AcuSolve bin folder (/acusolve/win64/bin or /
acusolve/linux64/bin).

Solver module A selection of several solver modules.

prep
Processes and prepares the input data for
the solver run.

view
View factor computation for problems
including radiation.

solve
Runs the solver.

prep-solve

all

No. of processors The number of processors used for this run.

Auto run AcuProbe Automatically opens the plotting utility AcuProbe
to monitor run data of the current run, for
example residual.

Auto run AcuTail Automatically opens AcuTail to view the log file of
the current run.

Output format Converts the results of the final time step into the
specified format.

Output time steps All
Creates the output file in a user defined
format with all of the time steps. This option
is useful for a transient run.

Final
Creates an output file in a user defined
format with only the final time step. This
option should be utilized for a steady state
run.

Additional solver arguments Additional solver options can be specified, for
example number of threads.

Generate solver deck On
A new .inp file will be created.

Off
An .inp file will not be generated and the
program will look for the existing file.
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Export options Always two layers for interfaces
Creates two interface layers between two
volumes, if one or both are missing.

Create exterior faces
Creates outer shell surface of volume if
missing.

Always add elem type to comp names
Append element configuration at the
component names.

Extract Output from AcuSolve Run
Use this utility to extract specific output from an AcuSolve run.

The extracted results will be in a .csv file. From these results you can create a field, which can be
utilized to map CFD results to other structural mesh. This utility requires a finished AcuSolve run. If the
mapping field is defined before the solver run, the tool will generate output in a .csv file format. This
utility can be utilized any time after the solver run to extract results.
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Figure 43:

Table 2:

Variable You can select the desired output. The options
are Pressure, Velocity and Eddy viscosity. The
selection list is dependent on the solver options
selected (Turbulence model).

Extract results on You can extract results on all of the components
that are selected.

Create field loads If this checkbox is activated, a field will be created
automatically, which can be utilized to map the
results on a structure mesh.
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Generate This button will be activated to click if any result
data is present in the working directory.

Launch Job

1. Click Launch in the Solver Job Launcher to open the AcuSolve Control dialog.

Figure 44:

2. Select the AcuSolve tab.

The AcuSolve tab contains options to stop the run, restart the run, and output results.

3. Click Stop.

The Restart option appears.

Stop: stops the run as soon as the current iteration is finished.

Restart: restarts the job from the previous time step.

Output: the existing iteration result is output and you can visualize the results later on.

4. Select the Tools tab.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Interface with External Products p.71

Figure 45:

The Tools tab contains options to launch or relaunch AcuProbe, AcuTail and AcuOut.

AcuSolve Set Up Features
The following AcuSolve set up features are supported in Engineering Solutions via the Solver Browser.

Problem Description
• Title

• Analysis type (Steady State or Transient)

• Flow equation (Navier Stokes)

• Abs. pressure offset

• Temperature equation (Advective Diffusive or None)

• Abs. temperature offset

• Radiation equation (Enclosure or None)

• Turbulence model (Laminar, Spalart Allmaras, SST, K Omega, Detached Eddy Simulation, SST DES,
Dynamic LES, Classical LES)

• Mesh type (Fixed or Fully Specified)

Solver Settings
• Max time steps

• Final time

• Initial time increment

• Auto time increment

• Multiplier Function

• Convergence tolerance

• Min stagger iterations
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• Max stagger iterations

• Relaxation factor

• Flow

• Temperature

• Temperature flow

• Enclosure radiation

• Turbulence

For full support of all AcuSolve features, use AcuConsole. A model can be transferred from Engineering

Solutions to AcuConsole by clicking the  icon in the CFD toolbar.

Set Up an AcuSolve Input Deck
The following section describes the set up of an AcuSolve input deck within Engineering Solutions.

Note:  All of the data in Engineering Solutions is dimensionless, meaning it is your
responsibility to use a consistent unit system throughout the modeling process. All units are
assumed to be SI units

Import an Existing AcuSolve Model

Click the icon on the Standard toolbar. If you are importing an AcuSolve solver deck (.inp file) the

defined parameters in the solver deck will also be imported in the model.

If any parameters defined in the solver deck are not supported, they will be collected in Unsupported
Entries under each folder category of the Solver Browser. You can manually edit those entries and the
modified values will be exported.

Figure 46:
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Note:  If you defined any fields in the Unsupported Entries category that are not recognized
by AcuSolve, this will result in an error.

Load the CFD User Profile and Open the Solver Browser

1. Click the  icon on the Standard toolbar.

2. Select Engineering Solutions > CFD > AcuSolve in the User Profiles dialog.

3. Click View > Solver Browser.

Create CFD Components

1. Click Mesh > Components > CFD to open the Create CFD Components dialog.

You can change the name and color of the components, add new components to the list or change
the quantities of the components.

2. Using the Organize panel, you can move elements to the appropriate components.

Figure 47:

Set Up the Model in the Solver Browser
The Solver Browser can be used to set up a case to run CFD analysis using AcuSolve.

It is useful for setting up problems with simple boundary conditions. For more complex problems,
export the model and set it up in AcuConsole.
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The Solver Browser contains the following main folders:

Table 3:

Global This folder is used to define problems and set
solver parameters for that problem. It contains
the following sub folders: Nodal Initial Condition,
Problem Description, Radiation Parameters and
Solver Settings. The Problem Description folder
contains utilities to set up the analysis type and
solver models. Use the Solver Settings folder to
define parameters related to selected analysis
types and solver models. Initial condition can be
defined in the Nodal Initial Condition folder. The
radiation parameters for the model can be defined
in the Radiation Parameters folder.

Output Define the frequency of different outputs: Derived
Quantity Output, Nodal Output and Restart
Output.

Volumes Components with Fluid and Solid card images are
grouped in this folder.

Surfaces Components with Inflow, Outflow, Wall, Slip,
Symmetry and Far Field card images are grouped
in this folder.

Components With No Card Image Components with no card image will not be
exported with the solver deck. By default, all of
the components will not have a card image. You
have to choose the appropriate card image for the
component and the component will be moved to
the Surfaces or Volumes folder accordingly.

Nodal Boundary Condition Define boundary conditions on nodes apart from
surface boundary conditions.

Materials Define/edit the material model for CFD analysis.

Body Force Define gravity and heat source for volume
components.

Periodic Boundary Condition Define periodic or axisymmetric boundaries along
with the transformation definition.

Reference Frame Define reference frames.

Mesh Motion Define mesh motion.
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Emissivity Model Define emissivity model for radiation.

Multiplier Function Define multiplier functions to ramp up supported
parameters.

Parameter Parameters can be utilized to run solver parameter
based studies.

For example, if you want to run a series of
simulations with inlet velocity values of 0.5 m/
s, 0.75 m/s, 1 m/s respectively, you can define
a parameter on inlet velocity with the desired
values. Using the HyperStudy Job Launcher DOE
studies can be performed.

Clicking any of these entities in one of the main folders opens the Entity Editor at the bottom of the
browser, where parameters for this particular entity can be entered.

Figure 48:

Define Component Type / Properties

1. Load an existing mesh file into Engineering Solutions.

The different components will appear in the browser.

2. Click the component and edit it in the Entity Editor.

The elements are grouped into components of a specific type. By default, all components will
have None card image and will appear in the Components With No Card Image folder. You have
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to choose the appropriate card image for the component and the component will be moved to
the Surface or Volume folder accordingly. There are eight types of components: FLUID, SOLID,
INFLOW, OUTFLOW, WALL, SLIP, SYMMETRY and Far Field. Each component in the model needs to
be assigned to one of those types. For INFLOW, OUTFLOW, WALL and SYMMETRY there are four
categories: Simple Boundary Condition, Radiation Surface, Interface Surface and Surface Output.
Each category can be turned on or off.

Figure 49:

Define Nodal Boundary Condition

This folder can be used to define boundary conditions on nodes apart from simple boundary conditions.

1. Right-click Nodal_Boundary_Condition and select Create.

Figure 50:

2. Select Nodal component or Nodal BC file (.nbc file) as the input.

If you select Nodal component select a component whose nodes will be assigned a specific nodal
boundary condition. You have to make sure that the defined source and target are mappable, or
else the solver run will have an error. If you select Nodal BC file and you already have the file from
a previous run specify the file path.
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3. Select a Boundary condition variable.

4. Select an Active type.

5. Select Multiplier function and Reference frame, if applicable.

Create Material Model
The Materials entity is used to define/edit the material model for CFD analysis.

The materials created by default when you open the Solver Browser are:

• Aluminum

• Air

• Water

1. Right-click Materials and select Create > Material(Fluid) or Material(Solid).

Figure 51:

2. Define/edit the material properties.

You can define Porosity when you select Material (Fluid).

3. Assign material to the volume components.

Create Body Force
This folder can be used to define gravity and heat source for volume components.

1. Right-click Body_Force and select Create.

Figure 52:

2. Define the properties.

3. Assign newly created body force to volume components.

Create Periodic Boundary Condition
This folder can be used to define periodic boundary condition.

1. Right-click Periodic_Boundary_Condition and select Create.
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Figure 53:

2. Select Periodic components or Periodic BC file as the input.

If you select Periodic components you need to define the Source and Target components. You have
to make sure that the defined source and target are mappable, or else the solver will have an
error. Select Periodic BC file, if you already created a .pbc file using the acuPbc utility or have it
from a previous run.

3. Select the Periodic BC type, which can be Periodic or Axisymmetric.

If you select Axisymmetric, define the Rotation axis with two node definitions.

Create Reference Frame
This folder can be used to define reference frames.

1. Right-click Reference_Frame and select Create.

Figure 54:

2. Define the Rotation center, Angular velocity and set force.

3. Assign reference frame to volume components and/or surface components.

Create Mesh Motion
This folder can be used to define mesh motion.

1. Right-click Mesh_Motion and select Create.

Figure 55:

2. Define the translation, rotation or translation parameters for mesh.
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3. Assign reference frame to volume components and/or surface components.

Create Emissivity Model
This folder can be used to define emissivity model for radiation.

1. Right-click Emissivity_Model and select Create.

Figure 56:

2. Define emissivity.

3. To assign it to surface, activate radiation in the desired surface.

4. Assign emissivity to the model.

Figure 57:

Create Multiplier Function

1. Right-click Multiplier_Function and select Create.

Figure 58:

2. Define the Multiplier Function Type as Constant, Piecewise Linear, Cubic Spline or Piecewise Log
Linear.
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Figure 59:

3. If you select Piecewise Linear, Cubic Spline or Piecewise Log Linear, right-click on Curves >
Create to create a new plot for the curve definition.

Figure 60:

4. Right-click on Curves > Plot Curves.

The Curve editor opens.

Figure 61:

5. Edit the plot values, click Update to visualize the plot and then close the Curve Editor.
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Figure 62:

6. Define the Curve fit variable and Evaluation Type.

7. Assign the multiplier function to one of the supported fields: reference frame, mesh motion,
emissivity model or material properties (viscosity and conductivity).

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Interface with External Products p.82

Figure 63:

Create Parameter
This folder can be used to define parameters for Solver parameter based studies.

1. Right-click Parameter and select Create.

Figure 64:

2. Define the Parameter mode and the Parameter type. Two parameter modes are available: Discrete
and Continuous. Discrete refers to the input values list. You have to first define how many counts
you want to define, and then click on the table to define the values.

Figure 65:
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Figure 66:

Continuous refers to incremental values defined by Lower bound, Upper bound and No of levels.

Figure 67:

3. Assign the defined parameter to the solver variable input by right clicking Solver > variable
input > Select Parameter.

Figure 68:

Note:  If the solver variable accepts double values only parameters with double type
will be filtered out for selection.

Figure 69:
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4. Open the HyperStudy Job Launcher to run a sequential run with parametric values.

Launch the Solver Run

1. Invoke the Solver job Launcher by clicking the  icon in the CFD toolbar. In the dialog, define

the Problem name and specify the Problem directory, which contains the solver input file.

2. Clicking Launch starts the Solver run.

Figure 70:

By default Auto run AcuProbe and Auto run AcuTail are activated, which will invoke AcuTail to
monitor the .log file and AcuProbe to monitor the residuals of the current run. Both utilities
access the .log file of a solver run.
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Figure 71:
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Figure 72:
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ANSYS Interface
Overview of the ANSYS interface.

The HyperMesh ANSYS interface allows you to:

• Read an ANSYS ASCII database

• Create and edit an ANSYS ASCII database from within HyperMesh

• Preview and edit ANSYS cards after they are created

• Summarize ANSYS elements, loads, and properties

• Output an ANSYS ASCII database

• Convert an ANSYS binary results file into a HyperMesh binary results file that can be read into
HyperMesh for post-processing

• Assign macro commands to modify HyperMesh’s default ANSYS output

HyperMesh treats ANSYS as a card image code.

HyperMesh supports ANSYS element types for STATIC STRUCTURAL, THERMAL, and MODAL analyses
using ANSYS versions 15.0, and earlier version. ANSYS 19.0 and earlier reads .rst, .rmg and .rth files
in HyperView. HyperMesh can read .rst, .rmg and .rth files from ANSYS 8.1 or earlier versions. To
read result files later than 8.1, use HyperView. Warnings and error messages are written to a file called
ansys.msg. Unrecognized lines are written to a *.hmx file. These files are created in the directory from
which HyperMesh is launched.

The ANSYS interface is only available once you have loaded the ANSYS user profile.

RBE3 Elements
In ANSYS, RBE3 card distribute the force/moment applied at the master node to a set of slave nodes,
taking into account the geometry of the slave nodes as well as weighting factors.

In HyperMesh, RBE3 is an element that includes multiple 1D elements, which are defined between a
single dependent (master) node and one or more independent (slave) nodes. RBE3 cards are created
using the RBE3 panel (1D page).

RBE3 elements are different from Nastran RBE3 elements. In ANSYS, the RBE3 card is used to
distribute the force/moments from the master node to a set of slave nodes. Whereas in Nastran, these
elements define the rigid body motion. In HyperMesh, the RBE3 card is mapped as a RBE3 element.
Therefore, when creating the RBE3 elements in HyperMesh for the template, the following points should
be noted:

• When a RBE3 element is created in HyperMesh, the DOFs are defined for the master as well as for
the slave nodes. However, since the slave node DOFs are not applicable in , they are not exported.

• By default, when a RBE3 element is created in HyperMesh, the same weight factor that is applied
at the master node is also applied on all the slave nodes. The Update subpanel in the RBE3 panel
allows you to modify the weight factors for the individual slave nodes. Since the master node
weight factor is not applicable in ANSYS, it is not exported.
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• The RBE3 elements created in HyperMesh using other solver templates, such as Nastran, are
exported according to template terminology.

Parameter Arrays Exported for RBE3 Elements
Two parameter arrays are exported for each RBE3 element. The first array contains slave node IDs and
the second array contains slave node weights. These arrays appears in the beginning of the exported
file.

Exportation of the SLAVE# Array:

*DIM,SLAVE#,ARRAY,      NS,       1,       1
*SET,SLAVE#(       1,       1,       1),  ID_1  
*SET,SLAVE#(       2,       1,       1),  ID_2  
*SET,SLAVE#(       3,       1,       1),  ID_3
.
.
.
*SET,SLAVE#(      NS,       1,       1),  ID_NS

Where,

#
HyperMesh element ID of the RBE3

NS
Number of slave nodes within the RBE3

ID_1, ID_2, ID_3,…,ID_NS
IDs of the slave nodes

Exportation of the WEIGHT# Array:

*DIM,WEIGHT#,ARRAY,      NS,       1,       1
*SET,WEIGHT#(       1,       1,       1),  WF_1
*SET,WEIGHT#(       2,       1,       1),  WF_2
*SET,WEIGHT#(       3,       1,       1),  WF_3
.
.
.
*SET,WEIGHT#(      NS,       1,       1),  WF_NS

Where,

#
HyperMesh element ID of the RBE3

NS
Number of slave nodes within the RBE3

WF_1, WF_2, WF_3,…,WF_NS
Weighting factors corresponding to each slave node

Each RBE3 element is written using a RBE3 card with the following format:

RBE3, Master_ID, DOF, SLAVE#, WEIGHT#
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Where,

Master_ID
ID of the master node

DOF
Degrees of freedom checked in the RBE3 panel for RBE3 elements with ID #. DOF is exported as
follows:

U
If ux is checked

UY
If uy is checked

UZ
If uz is checked

ROTX
If rotx is checked

ROTY
If roty is checked

ROTZ
If rotz is checked

UXYZ
If ux, uy, and uz are checked

RXYZ
If rotx, roty, and rotz are checked

ALL
If all are checked

If a combination of DOFs not listed above are checked, several RBE3 cards will be exported for the
same element. For example, if ux, uy, and roty are checked, three RBE3 cards will be exported.

RBE3, Master_ID, UX, SLAVE#, WEIGHT#
RBE3, Master_ID, UY, SLAVE#, WEIGHT#
RBE3, Master_ID, ROTY, SLAVE#, WEIGHT#

SLAVE#
Name of the slave node ID array

WEIGHT#
Name of the weighting factor array

Where, # is the RBE3 element ID.

The exportation location is the CP or CERIG elements.

FE Input Translator Support for RBE3
Importing the exported files

In ANSYS, RBE3 is not an element; it is created by a command called RBE3. ANSYS does not
export these RBE3s as an RBE3 card, but rather as a set of constraint equations (CE). The
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HyperMesh- FE input translator imports CE equations as CE equations only, and not as RBE3
elements.

Importing the HyperMesh exported files
HyperMesh writes out RBE3 elements using RBE3 cards, therefore the H_ FE input translator
imports the HyperMesh exported RBE3 cards as RBE3 elements.

Tips and Techniques
Tip and techniques for working with ANSYS in HyperMesh

• The operations performed in HyperMesh can also be saved as a compact HyperMesh binary file
using the File > Save As option.

• Bolt simulation configuration files are available in the ANSYS profile. In the Bolt panel, you can
create general bolt, bolt with one or two washers, bolt with spider option and clips.

• Use the Mass Calc panel (Tool page) to determine the mass of your finite element model. Select the
ansys.tpl template file through the Import tab. The mass calculation is supported for the following
element type numbers: 1, 2, 3, 4, 5, 8, 10, 13, 16, 18, 20, 21, 23, 24, 25, 28, 31, 32, 33, 41, 42,
43, 44, 45, 46, 51, 53, 54, 55, 57, 58, 60, 61, 62, 63, 64, 67, 69, 70, 71, 75, 77, 78, 80, 82, 83,
87, 90, 91, 92, 93, 95, 96, 97, 98, 99, 107, 116, 117, 118, 119, 120, 121, 143, 145, 147, 148,
150, 152, 153, 154, 157, 162, 163, 164, 173, 174, 180, 181, 182, 183, 185, 186, 187, 191

• Each operation in HyperMesh results in an ASCII command that is added to a command.cmf file.
This file is useful if your computer shuts down while working in HyperMesh. You can restore your
previous work by reading this file with the command function, which can by found by clicking
File > Run > Command File. You can delete this file if it requires too much disk space.

The command.cmf file can also be used to store repetitive HyperMesh operations. If you deal
with the same set of geometrical and material properties, you can record the creation of these
collectors, such as steel plate, foam solids and aluminum rods, into series of command files and
read them as needed.

• The ANSYS template is associated with the Composites panel. Using this panel for laminated
elements, such as SHELL99, enables the following:

Element orientation by two methods:

◦ By system assigns a system to the element (set ESYS for the element).

◦ By vector projects a vector on the element plane. A coordinate system, in which the x-axis is
parallel to the defined vector, is created and assigned to the element as ESYS.

◦ The by system axis and by angle options are not available for this template.

◦ Visualization of the element orientation

◦ Visualization of the ply direction on a layer-by-layer basis. Visualizes the angles defined in the
R card with respect to the element orientation.

• If you change KEYOPT3 for MASS21 and KEYOPT6 for BEAM23 elements, make sure you do so on
the component as well as on property collector.

• When you click the card image button while creating a property collector, the GENERAL card is
shown at the end of the list. This card is used to card edit the properties that are not used by any
element.
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• The ANSYS connectivity for a second order (3-node) line element (such as BEAM189 or SURF153),
is as follows: End-node-I, End-node-J and Mid-node-K. However, for creation of a bar3 element in
HyperMesh (using the bar panel/bar3 subpanel), pick node A, node B, and node C in the following
order: End-node-I, Mid-node-K and End-node-J, respectively. The ANSYS template will export the
bar3 element using the ANSYS connectivity.

• Apply loads in local coordinate systems (ANSYS NROTAT card) using HyperMesh with the following
methods:

◦ The Forces panel and the Moments panel allow you to apply loads in a local coordinate system
by using the local system option.

◦ The set analysis option in the Systems panel, Assign subpanel can be used to assign a node to
a coordinate system. A load applied to that node would be displayed correctly after exportation
and importation of the ANSYS deck.

If both options of applying loads in local coordinate systems are used for the same node, the first
method (via the Forces and Moments panels) takes precedence.

Pressure Load on Beam Elements
HyperMesh supports pressure load on bar and rod elements, which means you can import the pressure
load [SFBEAM] applied on ANSYS BEAM elements.

The following items are supported under this feature:

• Import pressure load applied on BEAM3, BEAM4, BEAM23, BEAM44 elements. Import restrictions
are explained below.

• Use the Pressure panel to apply SFBEAM load on beam elements.

• Export pressure load applied on BEAM elements in HyperMesh as SFBEAM load in ANSYS solver
deck. The Export feature is explained in detail below.

Pressure Load Import
SFBEAM is the keyword command in ANSYS decks to apply pressure load on BEAM elements. This
command line has following arguments:

SFBEAM,ELEM,LKEY,Lab,R5.0,DIOFFST,DJOFFST

ELEM
Element ID and Lab is always pres(pressure).

LKEY
Load key number which determines the face of the beam where the pressure load is applied.
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Refer to the ANSYS solver documentation for information on the face of the beam and corresponding
LKEY number as it changes from BEAM to BEAM.

Restrictions
• The HyperMesh-ANSYS interface presently supports the following LKEY values for each BEAM

element. You can import SFBEAM load with these LKEYs.

Table 4:

ELEMENT TYPE SUPPORTED LKEYs

BEAM3 1, 3, 4

BEAM4 1, 2, 4, 5

BEAM23 1, 3, 4

BEAM24 1, 2, 4, 5

BEAM44 1, 2, 4, 5

BEAM54 1, 3, 4

BEAM188 1, 2, 4, 5

BEAM189 1, 2, 4, 5

• DIOFFST, DJOFFST, which define offset values for pressure value at node I and J, are not supported
in HyperMesh.

• SFLOAD, which applies a pressure load that varies across the length of the beam, is not supported
in HyperMesh 9.0. Only pressure load with constant value can be imported.

Pressure Applied on BEAM Elements
• You can apply a pressure load in HyperMesh on any bar2, bar3 and rod, elements. Only the

pressure loads which are applied on supported BEAM element types can be exported.

• If no option for direction is selected, pressure is applied on ‘element – y’ direction by default. You
can use the options available in the Pressure Load panel to specify the direction of the load.

• The ANSYS solver allows pressure on beam elements in only specified faces of the elements, as
mentioned by LKEYS. In other words, pressure on beam elements is applied in element co-ordinate
system. Keep this in mind before determining the direction of the pressure.

• You cannot apply a pressure load that varies across the length of the BEAM even though it is
allowed in the ANSYS Solver.

• Load offsets at node I and J are not supported.

Export Pressure Load on BEAM Elements
• Pressure on beams is exported as SFBEAM cards.
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• Pressure only applied on BEAM3, BEAM4, BEAM23, BEAM44, BEAM54, BEAM188, BEAM189
elements will be exported.

• Pressure applied in any arbitrary direction is resolved in to corresponding element systems, and
relevant LKEYs will be assigned while exporting. When you import the deck back to HyperMesh, you
will see resolved loads.
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EXODUS Interface
Overview of the EXODUS interface.

The EXODUS interface enables you to store a large amount of topological and result data in a binary
format for finite element analysis.

In HyperMesh, the import and export of EXODUS files is supported in the EXODUS interface. An
EXODUS file (*.ex, *.exo, *.ex2) can be read using the Import tab, and the finished model can be
written using the Export tab.

EXODUS supports the following types of entities, which can be created from the Solver Browser:

• Blocks (Component)

• Control Cards

• Coordinate Frames (System)

• Functions (Curve)

• Loads

• Materials

• Plots

• Sets

• TiedJoints (Group)
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Feko Interface
The Feko interface provides a pre-processing environment for preparing and editing Feko mesh element
and material data.

In HyperMesh you can import and export Feko mesh element and material data. To import, create,
modify or export Feko mesh and material data you have to load the Feko user profile in HyperMesh.

Import and Export Guidelines
Guidelines for importing and exporting mesh and material data in the Feko interface.

• The Feko interface can import Feko mesh elements and material settings and assignments from
Feko-generated *.fhm and *.inc files.

Note:  When mesh data is exported from Feko into the *.fhm file format, an *.inc file
with the same file name and containing the material data is created automatically.

During import of such an *.fhm file, HyperMesh automatically imports the *.inc file with the same
file name if it is found in the same directory.

• The Feko interface can export Feko mesh elements and materials settings and assignments into
*.fhm and *.inc files that can be imported into a CADFEKO model (using the mesh import menu)
or an EDITFEKO *.pre file (using the IN card). The Feko components would automatically import
the materials data from the *.inc file if it is found in the same directory as the provided *.fhm file.

• The Feko interface supports Feko wires segments, triangles and tetrahedra. Straight and curvilinear
wire segments in Feko are represented as Bar2 and Bar3 elements respectively in HyperMesh.
Flat and curvilinear triangles in Feko are represented as Tria3 and Tria6 elements respectively in
HyperMesh. Feko tetrahedra are represented as Tetra4 elements in HyperMesh.

• Each individual mesh label (Wire segments, Face, or Region) is represented as a unique Component
in HyperMesh. HyperMesh Properties are used to assign Materials to these Components.

• Supported Feko media include (anisotropic) dielectric media (with optional magnetic properties)
and metallic media. Feko’s default Free space, Perfect electric conductor, and Perfect magnetic
conductor media are also supported.
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LS-DYNA Interface
Overview of the LS-DYNA interface.

HyperMesh provides a complete pre-processing environment for preparing LS-DYNA data decks for
analysis.

HyperMesh can read existing LS-DYNA decks, create a model, display and edit LS-DYNA cards as they
will look in the deck, and write a deck for analysis.

To create LS-DYNA decks in HyperMesh, you must load the LS-DYNA user profile with the appropriate
template to access the full pre-processing capability.

Import and Export
• HyperMesh support LS-DYNA solver versions till 971_R9.0.

• Solver specific import options are available during import in the Solver Options tab.

• HyperMesh supports LS-DYNA Dummy models with the Primer and LSTC dummy information
format. HyperMesh writes out the dummy information on Primer format.

• Most ID’s in the solver deck are preserved in HyperMesh. If a keyword is not supported in a
dedicated HyperMesh entity to ensure its unique ID-Pool, then HyperMesh renumbers those
keywords when ID conflicts are detected. The new ID’s are posted during the import process.

• The LS-DYNA interface supports a smart, reliable FE input reader that warns you when your input
deck contains unsupported fields and unsupported data lines.

• HyperMesh supports parameterized IDs for Components, Materials, Properties, and Curves.

• HyperMesh supports undefined entities, meaning, entity IDs are referenced in keywords (for
example a Material ID in a *PART) but not defined in the deck. In this case, HyperMesh creates a
default card (for example a material of type *MAT_ELASTIC is then created) in order to preserve
the ID. This keyword has the Defined checkbox toggled off and is automatically not exported.

Duplicate ID’s
• Several LS-DYNA keywords are mapped to one HyperMesh entity in some instances. By default the

LS-DYNA interface doesn’t allow duplicate ID within the same HyperMesh entity with exception of
elements while LS-DYNA allows duplicate ID’s across cards mapped to one HyperMesh entity. In
HyperMesh ID flexibility similar to LS-DYNA can be enabled by switching on Duplicate ID option in
Preferences menu.

• Duplicate ID's are supported for the following HyperMesh entities in the LS-DYNA user profile:
elements, properties, entity sets, sensors, Load collectors and control volumes.

Mass Calculations
• Mass supplied by *PART_INTERIA card is used instead of calculating the mass based

on the individual elements. Also, mass calculations include the mass supplied on the
*CONSTRAINED_NODAL_RIGID_BODY_INERTIA cards.

• Shell element thickness for volume calculation is one of the following:

◦ Thickness on the first node for uniform thickness shells

◦ Average thickness at three or four nodes for non-uniform thickness shells
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• The thickness values come from the *SECTION_SHELL card, unless a
*ELEMENT_SHELL_THICKNESS card is defined for an element. If an *ELEMENT_SHELL_THICKNESS
card is defined, its thickness values override the thickness values from the *SECTION_SHELL.

• Integrated beams have an area equal to the average of the two end areas. Resultant beams use
the area entered on the *SECTION_BEAM card. The volume is calculated by multiplying the length
of the beam with the *SECTION_BEAM card area. Discrete beams use the volume supplied by
the *SECTION_BEAM card. In all cases, if an *ELEMENT_BEAM_THICKNESS card is defined for an
element, then the element values override the *SECTION_BEAM values.

• Only element masses are considered. Other mass specifications, such as on a rigid wall card, are
ignored.

Recommended Process

Editing an LS-DYNA Model to Add Cards not Supported
Use unsupported cards with the LS-DYNA model by adding them in HyperMesh. There is no need to
use a text editor. Select unsupp_cards in the Control Cards panel. You can then enter the cards in the
pop-up text editor. Use caution regarding formatting and card validity. Care should also be taken if any
of the cards point to entities, such as cards pointing to sets and parts. These cards are stored as text
and pointers are not considered. When importing an LS-DYNA mode, any cards that are encountered
that are not supported are written in this section, therefore they are exported along with the remaining
model.

Blanks
In the Card Editor all of the attribute fields are supported as Blanks. You must click the field and input
the value.

LS-DYNA Mass Calculation
Mass calculation for LS-DYNA is accessible from the Summary panel (Post page).

The mass reported is not simply calculated by Density x Volume for each part. It follows the many LS-
DYNA requirements to handle rigid body mass, non-structural mass, and lumped mass.

Contributing Total Mass factors: totalmass = structuralmass + lumpedmass + nonstructuralmass +
rigidbodymass + transferredmass + distributedmass

Structural Mass
Volume x density; except in case of *PART_INERTIA in which it is also the total mass.

Lumped Mass
Accounts for contributions from *ELEMENT_MASS, *ELEMENT_MASS_NODE_SET, and
*ELEMENT_INERTIA. This does not take into account the transfer of lumped mass to rigids.
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Non structural Mass (NSM)
Accounts for contributions from ELEMENT_MASS_PART, ELEMENT_MASS_PART_SET, and NSM in
*SECTION. This does not take into account the transfer of lumped mass to rigids.

RigidBodyMass Mass
Mass of *CONSTRAINED_NODAL_RIGID_BODIES.

Transferred mass
Mass transferred from deformable nodes to rigid materials. This includes lumped mass transferred
from rigid or deformable nodes to the rigid materials.

• For rigid material, this is the mass gained from deformable (+).

• For deformable parts, this is the mass lost to rigid material (-).

Distributed Mass
Mass distributed from nodal rigid bodies to free nodes.

Engineering Mass
Mass of the part that most closely matches its real engineering meaning. The engineering mass is
the most useful for possible mass adjustments. Engineering mass is the sum of structural, non-
structural, and lumped mass.
Engineering mass exceptions:

• For PART with PART_INERTIA:

◦ Slave CRB of this part should have 0 mass.

◦ Mass of the part should be equal to TM (if Iflag=1 => transfer mass from slave to
master).

• For *CONSTRAINED_NODAL_RIGID_BODY_INERTIA:

◦ The mass of the slave nodes on the connected part should not be taken into account and
excluded.

LS-DYNA Part Mass
The mass listed in d3hsp, where you also have COG information.
Total mass is also obtained with the following calculations:
Total mass = LS-DYNA part mass + lumped mass (for deformable parts as rigid part already
include lumped mass) + CNRB mass.
Center of Gravity (CG) is computed from the total mass (for each part); the inertia are computed
from the total mass.

Deck Export
Supported LS-DYNA files that can be exported.

• LS-DYNA v971_R7.0, v971_R6.1, v971, v970 and v960 input files in Keyword format.

• By default, the LS-DYNA user profile outputs v971_R6.1 .key files.

• Two templates are also provided to output the defined curves in the database:

◦ To output curves in Keyword format, use the curves.key template

◦ To output curves in Structured format, use the curves.seq template
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MADYMO Interface
Overview of the MADYMO interface.

The MADYMO interface supports both the import and export of MADYMO files. A MADYMO .xml file can
be read using the Import tab. The model will be displayed. The model can be altered and the finished
model can be written using the Export tab.

User Profiles
The MADYMO interface has two sub-profiles.

• MADYMO63

• MADYMO70

Importing a MADYMO Model
The MADYMO input file is based on XML and must be converted to be used in HyperMesh. If HyperMesh
supports the equivalent MADYMO entities, the mapping is straightforward. If HyperMesh does not
provide the entity, a transformation rule is used.

Several MADYMO entities are mapped on the same type of HyperMesh entities; for example ACTUATOR,
CONTROLLER, OPERATOR, SENSOR, SIGNAL, STATE and SWITCH are all mapped on sensor. This puts
a restriction on the use of names for these entities; all names of the MADYMO entities mapped on
the same HyperMesh entity must be unique, for example, a MADYMO SENSOR cannot have the same
name as a MADYMO CONTROLLER. During the FE import process HyperMesh will rename the entities as
required to avoid duplicate names.

Exporting MADYMO Models
During export only the nodes that are in use according to MADYMO are exported. HyperMesh temporary
nodes are not exported even if they are used in a node set or a MADYMO node LIST. It is advised to
remove all temporary nodes before exporting the model.

In general, the IDs of entities in the HyperMesh model correspond with the IDs in the MADYMO .xml
file after exporting the model. An exception to this rule is when PLANES in MADYMO are a subtype
of the entity SURFACE that contains also the subtypes CYLINDER and ELLIPSOID. The IDs must be
unique within the SURFACE type. In HyperMesh these entities are mapped onto two different entities
(mbplanes and ellipsoids) with their own unique numbering. Therefore, during export the mbplanes are
renumbered to get unique MADYMO IDs for the PLANEs.
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Marc Interface
Overview of the Marc interface.

Follow these guidelines when creating a model for use with the HyperMesh Marc interface.

• HyperMesh treats Marc as a card image code.

• The Marc interface is based on Marc version 12; 2008r1 release.

• The current interface supports linear and nonlinear static analysis.

For 2D models, use the template stress2d.tpl. For 3D models, use the template stress3d.tpl. 2D
and 3D models cannot be combined. 2D models should use the xy-plane.

Warnings and error messages are written to a file called marc.msg. Unrecognized cards are written to an
*.hmx file. These files are created in the same directory from where HyperMesh is launched.

Any data which is currently not supported in HyperMesh is stored as unsupported data and is added to
the model if the model is exported from HyperMesh.

The Marc solver interface supports PATRAN exported in Marc format.
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Nastran Interface
Overview of the Nastran interface.

• Two sub-profiles are available for the Nastran interface:

◦ MSC Nastran

◦ NX Nastran

• During input, the Nastran interface assumes that the continuation line always follows the line
before, therefore no continuation cards are needed in the input file. During export, HyperMesh
writes "+" or "*" as a continuation card to ensure that the continuation line follows the reference
card.

• Warnings and error messages are written to an open text file for your review. You can save this
file. All the lines in the input file that are unrecognized by the translator are written to unsupported
cards, which can be edited.

• The Nastran input translator supports single, double, free, and fixed formats.

• Two templates are available for export and viewing (editing) Nastran cards. The Nastran/general
template outputs all cards in a single precision, fixed format. The nastran/generallf template
outputs System, Grid, Element, Load, Subcase, Property, and Material cards in a fixed, double
precision (Long) format.

• By selecting the Nastran user profile, you can work with pre-defined panels that are more specific
to Nastran usage.

• Symbolic substitution is supported as parameters in the MSC Nastran user profile for properties and
materials. All the attributes in materials and properties can be parameterized.

• Before exporting or editing Nastran cards, a Nastran template must be loaded. Setting the user
profile to Nastran automatically loads the Nastran template.

• HyperMesh reads and writes certain HyperMesh commands in the Nastran bulk data file as
comments. These comment cards enable HyperMesh to preserve pre-defined preferences across
sessions. It is strongly suggested that you do not hand edit these cards.

Thermal Surface Elements for Nastran
HyperMesh supports the modeling of boundary condition surface elements used in heat transfer solution
sequences in Nastran (such as SOL400).

HyperMesh currently has full support of CHBDYE elements, and partial support of CHBDYG elements.

Thermal Surface
Element

Import Export Edit Create

CHBDYE Y Y Y Y

CHBDYG Y Y Y N
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These cards are represented as slave elements as part of a CONDUCTION, CONVECTION, or RADIATION
group in HyperMesh, and are created through the Interfaces panel.

Convection
• Group type = CONVECTION

• Group Card Image = PCONV

• Slave element type = CHBDYE/CHBDYG

• Additional associated cards = CONV: Represented as a checkbox inside slave element card preview.

Radiation
• Group type = RADIATION

• Group Card Image = RADM

• Slave element type = CHBDYE/CHBDYG

• Additional associated cards = VIEW: Represented as a loadcollector in HyperMesh

CHBDYE Side Conventions for 3D Elements
To automatically calculate the appropriate value of the SIDE parameter for newly created CHBDYE
slaves on solid elements according to the specified face nodes and break angle, go to the Interfaces
panel, Add subpanel, and set the slave option to face.

CHBDYE Side Conventions for 2D Elements
For CHBDYE slaves on 2D shell elements, HyperMesh will automatically assign a SIDE parameter value
of 1 (top) or 6 (bottom), depending on CHBDYE normal direction. Use the Normals panel inside the Tool
menu page to change CHBDYE normal direction.

Regardless of base shell element normal direction, visualization of CHBDYE normal in HyperMesh will
always identify the direction the CHBDYE slave is facing.
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Figure 73: Resulting SIDE Value for CHBDYE Slave on 2D Shell Element

CHBDYG Side Conventions for 2D Elements
Visualization of CHBDYG normal in HyperMesh identifies the direction the CHBDYG slave is facing.
CHBYG node order is adjusted accordingly. Use the Normals panel inside the Tool menu page to change
CHBDYG normal direction.
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Figure 74: Resulting Node Order for CHBDYG Slave on 2D Shell Element
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PAM-CRASH 2G Interface
Overview of the PAM-CRASH 2G interface.

HyperMesh provides a complete pre-processing environment for preparing PAM-CRASH 2G data decks
for analysis. HyperMesh can read existing PAM-CRASH 2G decks, create a model, display and edit PAM-
CRASH 2G cards as they will look in the deck, and write a deck for analysis. Although HyperMesh also
offers limited post-processing capabilities in results translation you are encouraged to exclusively use
HyperView. To create PAM-CRASH 2G decks in HyperMesh, you must load the Pamcrash2G user profile
with the appropriate template to access the full pre-processing capability.

Import and Export
• PAM-CRASH 2G version 2012 - 2017.

• The Pamcrash2G input translator also supports reading older Pamcrash2G files 2002 - 2011 and
map into the loaded template.

• Pamcrash and Pamcrash2G 2002 - 2011 templates are available in the installation and can be
loaded. However they are no longer maintained.

• During import all the GES associated with the solver keywords are mapped to entity sets in
HyperMesh and associated with the solver entity. They are exported back as GES during export.

• In addition to the custom export options available in the Export Browser, several templates are
available to export specific solver entities only.

Table 5:

Template Name Description

control_modeldoc Exports only the model documentation.

ctrlvol Exports only the airbag and chamber definitions.

groups_nsmas Exports only the non-structural mass cards.

groups_rigwa Exports only the rigid wall cards.

groups_slint Exports only the sliding interface cards.

crosssection Exports only the cross section cards.

load Exports only the load and load collector cards.

materials Exports only the material cards.

property Exports only the property cards.

sensor Exports only the sensor cards.

sets Exports only the PAM-CRASH 2G groups.
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Template Name Description

curves Exports only the function cards.

parts Exports only the part cards.

Mass Calculations
• The mass of each element is calculated by density * volume. Density is retrieved from the material

associated with the element’s component. Several assumptions are made in mass calculation based
on PAM-CRASH 2G solver.

• For rigid bodies (RBODY) of type 3 with a user-imposed center of gravity and mass and inertia
properties, the structural mass of the PART components are replaced by the rigid body mass. All
other keywords besides the PART keyword are neglected in the RBODY type 3 mass calculation.

• The following table summarizes how each supported element except shells and solid in the
HyperMesh PAM-CRASH 2G interface performs these calculations:

PAM-CRASH 2G
Keyword

Area Volume Mass Notes

MASS / 0 0

SLIPR / 0 0 0

RETRA / 0 0 0

SENPT / 0 0 0

PLINK / 0 0 0

RBODY / 0 0 $RBODY_MASS Rigid body type 3.

NODCO / 0 0 0

SPRING / 0 0 Material type 220.

SPRGBM / 0 0 Material type 223.

BAR / 0 Material types 200,
201, 202, 203,
204, and 205.

JOINT / 0 0 0

KJOIN / 0 0 0

NSMAS 0 0 MASS Non-Structural
Mass Definition
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PAM-CRASH 2G
Keyword

Area Volume Mass Notes

- Standard Input
Format

NSMAS2 0 0 MASS / MLEN /
MARE / MVOL

Non-Structural
Mass Definition
- Alternate Mass
Distribution Method
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Permas Solver Interface
Overview of the Permas interface.

The HyperMesh Permas interface enables you to:

• Read in a Permas .dat file

• Read and write .gz files

• Specify linear, nonlinear static and frequency analyses

• Preview and edit Permas cards

• Output an HyperView .h3d file for post-processing

HyperMesh supports Permas .dat files for direct import. Permas .uci command files are not supported.

The Permas interface supports names up to 40 characters in length.

MPC ID Pools
The HyperMesh Permas Interface allows multipoint constraints (MPC) to use the same the ID as other
elements, such as beams, shells or solids within HyperMesh. In other words, it can be said that selected
elements and MPCs can use different “ID pools.”

Some restrictions apply. To explain, a list of MPC types and which HyperMesh entity they are mapped to
is provided:

Table 6:

HyperMesh entity MPC type

ASSIGN

RIGID

SAME

rigid

JOIN

rbe3 WLSCON

equation GENERAL

ISURFACE

WLSSURFACE

group

WLDSURFACE

While rigid and rbe3 elements use the same ID pool in HyperMesh, equations and groups have separate
ones. Thus, it is possible to create duplicate IDs for MPCs as well. To resolve this, during export a solver
option is available in the Export tab to renumber MPCs if duplicate IDs are present. Renumber MPCs if
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IDs are duplicated. This option will check for the highest rigid/rbe3 ID and renumber equation entities
accordingly. Groups are not included in the renumbering functionality as contact IDs would be affected
by renumbering.

Due to the mapping scheme explained above, it is possible to import MPCs with duplicate IDs, for
example, MPC JOIN and GENERAL equation and groups although Permas does not allow it.

Before working with your model, ensure that the Permas user profile is loaded. The user profile provides
a customized HyperMesh environment for working with Permas.
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OptiStruct Interface
Overview of the OptiStruct interface.

• The OptiStruct user profile is designed to support OptiStruct, version 2019, although several entries
are unsupported.

• Elements of different types (solids, shells, bars, and so on) should be organized into separate
components. This is most important for shell and solid elements where the component card image
contains the referenced property definition.

• On importing an input file:

◦ The interface requires that continuation cards follow the referencing card. An error message is
issued if the continuation card does not follow the referencing card.

◦ Warnings and error messages are displayed in an Import Process Messages pop-up window
and are also written to a file in the current run directory called optistruct.msg.

◦ If a line in the input file that is not a continuation line and starts with a keyword that
is not recognized or supported, then the entire card gets written to the appropriate
unsupported card section (CTRL_UNSUPPORTED_CARD, SUBCASE_UNSUPPORTED or
BULK_UNSUPPORTED_CARD). Also, if the name of a PARAM or DOPTPRM entry is unrecognized, it
is stored as an UNSUPPORTED_PARAM or UNSUPPORTED_DOPTPRM, respectively.

◦ If the continuation line for a supported card is formatted incorrectly or if a certain feature for a
recognized keyword is not supported, then the corresponding line gets written to the .hmx file.

• The bulk data input translator supports free, fixed and large field formats.

• Two templates are available for export and viewing (editing) OptiStruct cards. The OptiStruct
template outputs all cards in single precision, fixed format. The optistructlf template outputs
System, Grid, Element, Load, Subcase, Property, Material, and Optimization cards in fixed, double
precision (Long) format.

• HyperMesh reads and writes certain HyperMesh commands to the OptiStruct input files as
comments. These comment cards enable the preservation of pre-defined preferences across
sessions. It is strongly suggested that you do not hand edit these cards.

• All settings necessary to interface with OptiStruct can be loaded by their respective user profiles.
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Radioss Interface
Overview of the Radioss interface.

HyperMesh provides a complete pre-processing environment for preparing Radioss data decks for
analysis.

HyperMesh can read existing Radioss decks, create a model, display and edit Radioss cards as they will
look in the deck, and write a deck for analysis.

To create Radioss decks in HyperMesh, you must load the Radioss user profile with the appropriate
template to access the full pre-processing capability.

Import and Export
• HyperMesh supports Radioss solver versions for import and export till Radioss 2018.

• Solver specific import options are available during import in the Solver Options tab.

• HyperMesh supports Radioss Dummy models.

• Most ID’s in the solver deck are preserved in HyperMesh. If a keyword is not supported in a
dedicated HyperMesh entity to ensure its unique ID-Pool, then HyperMesh renumbers those
keywords when ID conflicts are detected. The new ID’s are posted during the import process.

• The Radioss interface supports a smart, reliable FE input reader that warns you when your input
deck contains unsupported fields and unsupported data lines.

• HyperMesh supports undefined entities, meaning, entity IDs which are referenced in keywords (for
example a Material ID in a PART) but not defined in the deck. In this case, HyperMesh creates a
default card (for example a material of type elastic is then created) in order to preserve the ID.
This keyword has the Defined checkbox toggled off and is automatically not exported.

Duplicate ID’s
• Several Radioss keywords are mapped to one HyperMesh entity in some instances. By default

the Radioss interface does not allow duplicate IDs within the same HyperMesh entity, with the
exception of elements. Radioss does allow duplicate IDs across cards mapped to one HyperMesh
entity. In HyperMesh, ID flexibility similar to Radioss can be enabled by switching on the Duplicate
ID option in the Preferences menu.

• Duplicate IDs are supported for the following HyperMesh entities in the Radioss user profile:
elements, properties, entity sets, and sensors.

Rigid Body Management
Any RBODY created with less than 10000 slave nodes is shown with the spider connecting the master
node to the slave nodes. If the RBODY has more than 10000 slave nodes, then it is shown with a single
link connecting the master node to one of the slave node. All other options are similar for both.

Mass Calculation
The mass of each element is calculated by density * volume. Density is retrieved from the material
associated with the element’s component. Currently mass calculation for RBODY, RBE3, RBE2 is not
supported.
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Samcef Interface
Overview of the Samcef interface.

The Samcef interface enables you to:

• Specify linear analysis (module ASEF)

• Specify a linear, nonlinear static analysis

• Export a .dat file.

• Read and write a .dat file

• Preview and edit Samcef cards

In addition:

• Samcef .sdb files are not supported

• Warnings and error messages are written to a file named samcef.msg. Unrecognized lines are
written to a *.hmx file. These files are created in the same directory from where HyperMesh is
launched.

The following commands are supported:

• Nodes (.NOE)

• Elements (.MAI, .MCE MEAN, .MCC MEAN, .MCE BUSH)

• Property (.PHP, .BPR, .MCC BUSH)

• Material (.MAT)

• Loads (.CLM)

• System (.FRA)

• Output request (.SAI)

• Hypothesis (.HYP)

• Entity Set (.SEL NOE, .SEL MAI)

• Contactsurfs (.SEL FACE)

• Composite definition (.PLI, .LAM, .ETA)

• Contact definition (.MCT, .STI)

Contact .MCT
Link between HyperMesh keywords and the Samcef contact .MCT parameters.

For a complete definition of the card .MCT, refer to the Samcef help.

Selection of “contact resolution method” [Option_number]

“Uncoupled“ (default)
Write OPT 3

“Coupled”
Write OPT 2.
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“Sliding magnitude” [Contact_characteristics]. You can control this option by two choices:

« Moderate » (default)
Nothing is written on MCT Card.

« Large »
NLIM -1 must be written on the MCT definition

“Initial gap” Contact_characteristics. You can control this option by two choices:

“As mesh is” (default)
Nothing is written on the MCT definition.

“No initial gap”
UN3 1 must be written on the card definition.

“Contact offset” Contact_characteristics. You can control this option by two choices:

“As mesh is” (default)
Nothing is written on the MCT definition.

“Contact offset”
You must enter a value XX; DMIN XX must be written on the card definition.

“Kind of contact” Contact_characteristics. You can control this option by two choices:

“Standard” (default)
Nothing is written on the MCT definition.

“Normal direction glue”
OPCO 2 must be written on the card definition.

Selection of “Curvature smoothing contact faces” [Smoothing_characteristics]

“Non activated” (default)
Nothing is written by default on MCT card.

“Activated”
Write KSMO 1 on MCT card.

Selection of “Curvature smoothing contact faces” [Smoothing_characteristics]

“Non activated” (default)
Nothing is written by default on MCT card.

"Activated”
Write KSMO 1 on MCT card.

Blank text line Additionnal_user_text.

Enter free text on the current panel, on the Samcef MCT card. The text is saved with the contact
definition in HyperMesh.

Examples:

.MCT I 10 GROUP 17 GTAR 23 OPT 3 ! Contact default

.MCT I 20 GROUP 65 GTAR 12 OPT 2 NLIM -1 UN3 1 DMIN -0.0245 KSMO 1 ! Advanced contact
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.MCT I 30 GROUP 45 GTAR 75 OPT 2 UN3 1 OCPO 2 KSMO 1 ! Glue contact

Contact .STI
Link between HyperMesh keywords and the Samcef contact .STI parameters.

For a complete definition of the card .STI, refer to the Samcef help.

Selection of “Node project” [Option_number]

• “Non activated“ by default ; write PROJ 0

• “Activated”; nothing to write on STI card

Example:

.STI I 1 GROUP 17 23 PROJ 0 ! Glue default

.STI I 2 GROUP 35 64 ! Advanced glue
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Entities and Solver Interfaces

A solver interface is made up of a template and a FE-input reader.

This chapter covers the following:

• Collectors and Collected Entities  (p. 123)

• Named Entities  (p. 204)

• Morphing Entities  (p. 450)

• Optimization Entities  (p. 457)

• Control Cards  (p. 474)

• Undefined Entities  (p. 542)

• Solver Encryption Entities  (p. 545)

• Element Property and Material Assignement Rules  (p. 546)

• Supported Cards  (p. 549)

Altair HyperMesh Entities
Entities can have none or multiple card images associated to them. Card images are defined within
a solver interface template and allow for creation, editing, and deletion of a solver card within a
HyperMesh model. Entities contain two types of data; data names and attributes.

Data names
Part of the entity data structure itself and are available to all instantiations of the entity regardless
if the entity has an associated card image or not.

Attributes
Additional data, defined in a solver interface template, which are necessary to store solver specific
data for a card image associated with an entity.

Entities can be subdivided into Collectors, Collected Entities, Named Entities, Optimization Entities, and
Morphing Entities.

Solver Interfaces
A solver interface is made up of a template and a FE-input reader. A template defines the mapping
between solver cards and entities, the attributes necessary to store data for solver cards, and the
format which the solver cards are exported from a HyperMesh database. FE-input readers perform
the function of reading solver decks and importing solver cards into the appropriate entities with the
appropriate card images, data names, and attributes set as defined by the template. Furthermore, FE-
input readers require template attribute definitions to perform their tasks.
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Figure 75: Schematic of the Solver Interfacing Architecture

Templates
Below is an example that demonstrates the interaction between entities and templates with data names
and attributes for an OptiStruct MAT1 card.

(1) (2) (3) (4) (5) (6) (7) (8) (9) (10)

MAT1 MID E G NU RHO A TREF GE

ST SC SS

The HyperMesh material named entity has data names of name and ID. Therefore the template would
also have to define attributes for E, G, NU, RHO, A, TREF, GE, ST, SC, and SS in order to completely
define and store the OptiStruct MAT1 solver card within a HyperMesh material named entity with a
MAT1 card image. Templates define attributes using the *defineattribute() command. The example
template code uses the *defineattribute() command to define these attributes.

In order to associate the OptiStruct MAT1 solver card to the HyperMesh material named entity with
a MAT1 card image the template would contain a *materials(MAT1) definition block to define this
association. Within the *materials(MAT1) definition block a MAT1 card image would be defined using
a *beginmenu() definition block . This *beginmenu() definition block is read every time a materials
named entity with a MAT1 card image is card edited using the card editor within HyperMesh. In addition,
an export format for the OptiStruct MAT1 solver card would be defined using a *format() definition
block within the *materials(MAT1) definition block. This *format() definition block is read every time
an export of the HyperMesh database is requested which contains a materials named entity with a MAT1
card image. Example template code which performs these definitions for the OptiStruct MAT1 solver card
is given.

In the example below you can find this example template code in [Install Directory]\hm\examples
\templates\ExampleTemplate.tpl.

*codename(ExampleTemplate,100)
//MAT1 Attributes
*defineattribute(MAT1,1,integer,none)
*defineattribute(E,2,real,none)
*defineattribute(G,3,real,none)
*defineattribute(NU,4,real,none)
*defineattribute(RHO,5,real,none)
*defineattribute(A,6,real,none)
*defineattribute(TREF,7,real,none)
*defineattribute(GE,8,real,none)
*defineattribute(ST,9,real,none)
*defineattribute(SC,10,real,none)
*defineattribute(SS,11,real,none)
//Materials Named Entity - MAT1 Card Image and Export Format
*materials(MAT1)
//MAT1 Card Image
*beginmenu()
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*menustring("MAT1    ")
*menufield("ID",integer,id,8)
*menufield("E",real,$E,8)
*menufield("G",real,$G,8)
*menufield("NU",real,$NU,8)
*menufield("RHO",real,$RHO,8)
*menufield("A",real,$A,8)
*menufield("TREF",real,$TREF,8)
*menufield("GE",real,$GE,8)
*menulineend()
*menustring(" ")
*menufield("ST",real,$ST,8)
*menufield("SC",real,$SC,8)
*menufield("SS",real,$SS,8)
*menulineend()

*endmenu()
//MAT1 Export Format
*format()

*string("MAT1    ")
*field(integer,id,8)
*field(real,$E,8)
*field(real,$G,8)
*field(real,$NU,8)
*field(real,$RHO,8)
*field(real,$A,8)
*field(real,$TREF,8)
*field(real,$GE,8)
*end()
*string(" ")
*field(real,$ST,8)
*field(real,$SC,8)
*field(real,$SS,8)

*end()
*output()

FE-Input Readers
FE-input readers perform the function of reading solver decks and importing solver cards into the
appropriate entities with the appropriate card images, data names, and attributes set as defined by the
template. Furthermore, FE-input readers require template attribute definitions to perform their tasks.

In the FE-Input code example below, you can find this example template code in [Install
Directory]\hm\examples\feinput\ExampleFEInput.cxx.

#include <iostream>
#include <fstream>
#include <cstring>
#include "hmlib.h"
#include "hminlib.h"
using namespace std;
//Material Data Structure
int nummaterials;
struct materials {
 char name[12];
 int id;
 double E;
 double G;
 double NU;
 double RHO;
 double A;
 double TREF;
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 double GE;
 double ST;
 double SC;
 double SS;
} material[100];
//Function Prototypes
int get_data(char *fileptr);
entityfunctionptr HM_getfunction(int function, HM_entitytype entities);
int HM_getMaterials();
int main(int argc, char *argv[])
{
 /* The main function calls get_data to process the data in the solver deck,
  initializes HyperMesh, sets the solver to 100 (the same number defined in
  the template), reads the model and passes material data structures to HyperMesh,
  and finally closes the connection between HM and the FE-input reader. */
 get_data(argv[1]);
 HMIN_init("ExampleFEInput", "10.0", argc, argv);
 HMIN_setsolver(100);
 HMIN_readmodel(HM_getfunction);
 HMIN_close();
 return(0);
}
int get_data(char *fileptr)
{
 /* This function opens a solver deck defined as the first argument on the
 input line and reads the solver deck for MAT1 cards.  If a MAT1 card is found
 then the MAT1 solver card is read and a material data structure is populated. */
 ifstream infile;
 char token[9];
 char line[128];
 //Open Solver Deck
 infile.open(fileptr, ios::in);
 if (infile.fail())

return(1);
 //Read Solver Deck for MAT1 Solver Cards and Populate Material Data Structure
 nummaterials = 0;
 while (!infile.eof())
 {

infile.get(token, 9);
if (strcmp(token, "MAT1    ") == 0)
{

//Name
strcpy_s(material[nummaterials].name, "material");
//id
infile.get(token, 9);
material[nummaterials].id = atoi(token);
//E
infile.get(token, 9);
material[nummaterials].E = atof(token);
//G
infile.get(token, 9);
material[nummaterials].G = atof(token);
//NU
infile.get(token, 9);
material[nummaterials].NU = atof(token);
//RHO
infile.get(token, 9);
material[nummaterials].RHO = atof(token);
//A
infile.get(token, 9);
material[nummaterials].A = atof(token);
//TREF
infile.get(token, 9);
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material[nummaterials].TREF = atof(token);
//GE
infile.get(token, 9);
material[nummaterials].GE = atof(token);
infile.get();
//Blank Field
infile.get(token, 9);
//ST
infile.get(token, 9);
material[nummaterials].ST = atof(token);
//SC
infile.get(token, 9);
material[nummaterials].SC = atof(token);
//SS
infile.get(token, 9);
material[nummaterials].SS = atof(token);
infile.get();
nummaterials++;

}
else

infile.getline(line, sizeof(line));
 }
 return(0);
}
entityfunctionptr HM_getfunction(int function, HM_entitytype entities)
{
 /* This user-defined function is passed into hminlib and is
 used by hminlib to find all of the user-defined functions
 which perform reading and information passing.  Note
 that if a user-defined function is not required, this function
 must return NULL. */
 switch (function)
 {

case HMIN_OPENFUNCTION:
break;

case HMIN_ENTITYOPENFUNCTION:
break;

case HMIN_ENTITYGETFUNCTION:
switch (entities)
{

case HM_ENTITYTYPE_NULL:
break;

case HM_ENTITYTYPE_CARDS:
break;

case HM_ENTITYTYPE_SYSTCOLS:
break;

case HM_ENTITYTYPE_SYSTS:
break;

case HM_ENTITYTYPE_NODES:
break;

case HM_ENTITYTYPE_VECTORCOLS:
break;

case HM_ENTITYTYPE_VECTORS:
break;

case HM_ENTITYTYPE_MATS:
return(HM_getMaterials);

case HM_ENTITYTYPE_PROPS:
break;

case HM_ENTITYTYPE_COMPS:
break;

case HM_ENTITYTYPE_GROUPS:
break;

case HM_ENTITYTYPE_ELEMS:
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break;
case HM_ENTITYTYPE_LOADCOLS:

break;
case HM_ENTITYTYPE_EQUATIONS:

break;
case HM_ENTITYTYPE_LOADS:

break;
case HM_ENTITYTYPE_GEOMETRY:

break;
case HM_ENTITYTYPE_LINES:

break;
case HM_ENTITYTYPE_SURFS:

break;
case HM_ENTITYTYPE_POINTS:

break;
case HM_ENTITYTYPE_ASSEMS:

break;
case HM_ENTITYTYPE_CURVES:

break;
case HM_ENTITYTYPE_PLOTS:

break;
case HM_ENTITYTYPE_BLOCKS:

break;
case HM_ENTITYTYPE_TITLES:

break;
case HM_ENTITYTYPE_SETS:

break;
case HM_ENTITYTYPE_OUTPUTBLOCKS:

break;
case HM_ENTITYTYPE_LOADSTEPS:

break;
case HM_ENTITYTYPE_SENSORS:

break;
case HM_ENTITYTYPE_DESIGNVARS:

break;
case HM_ENTITYTYPE_BEAMSECTCOLS:

break;
case HM_ENTITYTYPE_BEAMSECTS:

break;
case HM_ENTITYTYPE_OPTITABLEENTRS:

break;
case HM_ENTITYTYPE_OPTIFUNCTIONS:

break;
case HM_ENTITYTYPE_OPTIRESPONSES:

break;
case HM_ENTITYTYPE_DVPRELS:

break;
case HM_ENTITYTYPE_OPTICONSTRAINTS:

break;
case HM_ENTITYTYPE_DESVARLINKS:

break;
case HM_ENTITYTYPE_OBJECTIVES:

break;
case HM_ENTITYTYPE_CONTROLVOLS:

break;
case HM_ENTITYTYPE_MULTIBODIES:

break;
case HM_ENTITYTYPE_ELLIPSOIDS:

break;
case HM_ENTITYTYPE_OPTICONTROLS:

break;
case HM_ENTITYTYPE_OPTIDSCREENS:

break;
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case HM_ENTITYTYPE_TAG:
break;

case HM_ENTITYTYPE_MBJOINT:
break;

case HM_ENTITYTYPE_MBPLANE:
break;

case HM_ENTITYTYPE_DOBJREFS:
break;

case HM_ENTITYTYPE_CONTACTSURFS:
break;

case HM_ENTITYTYPE_CONNECTORS:
break;

case HM_ENTITYTYPE_SYMMETRYS:
break;

case HM_ENTITYTYPE_HANDLES:
break;

case HM_ENTITYTYPE_DOMAINS:
break;

case HM_ENTITYTYPE_SHAPES:
break;

case HM_ENTITYTYPE_SOLIDS:
break;

case HM_ENTITYTYPE_MORPHCONSTRAINTS:
break;

case HM_ENTITYTYPE_HYPERCUBES:
break;

case HM_ENTITYTYPE_DDVALS:
break;

case HM_ENTITYTYPE_BAGS:
break;

case HM_ENTITYTYPE_MAX:
break;

}
break;

case HMIN_ENTITYCLOSEFUNCTION:
break;

case HMIN_NAMEFUNCTION:
break;

case HMIN_MOVEFUNCTION:
break;

case HMIN_COLORFUNCTION:
break;

case HMIN_ASSOCIATEFUNCTION:
break;

case HMIN_CEDATAFUNCTION:
break;

case HMIN_METADATAFUNCTION:
break;

case HMIN_CLOSEFUNCTION:
break;

 }

 return(NULL);

}

int HM_getMaterials()
{
 /* This function writes each material data structure to HyperMesh. */

 int i;

 //Write each material data structure to HyperMesh
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 for (i=0; i<nummaterials; i++)
 {

HMIN_material_write(material[i].id, material[i].name);
HMIN_writeattribute_int(HM_ENTITYTYPE_MATS, material[i].id, 1, 0, 1, 1);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 2, 0, 1,

 material[i].E);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 3, 0, 1,

 material[i].G);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 4, 0, 1,

 material[i].NU);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 5, 0, 1,

 material[i].RHO);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 6, 0, 1,

 material[i].A);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 7, 0, 1,

 material[i].TREF);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 8, 0, 1,

 material[i].GE);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 9, 0, 1,

 material[i].ST);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 10, 0, 1,

 material[i].SC);
HMIN_writeattribute_double(HM_ENTITYTYPE_MATS, material[i].id, 11, 0, 1,

 material[i].SS);
 }

 return(0);
}
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Collectors and Collected Entities
Collectors are named organizational containers for collected entities. Collected entities are nameless
entities which must reside within one, and only one, collector. Collected entities are mutually exclusive
to a collector.

Collector Entities
An example of a collector is the component collector which collects collected entities such as
points, lines, surface, solids, elements, and connectors for model organization purposes.
The current collector is bolded in the Model Browser. Newly created entities are automatically
organized within the respective current collector.
Collectors control the display state, on or off, of all their collected entities as a group. The display
state of collectors can be controlled in the Model Browser.
With the exception of assemblies and bags, operations performed on a collector affect the
collected entities within the collector. For example, if you delete a vector collector, the vectors
within the vector collector are also deleted.

Collected Entities
Examples of collected entities include points, lines, surfaces, solids, elements, and connectors,
which are collected by a component collector.
Newly created entities are automatically organized within the respective current collector.

Include Files and SolverSubmodels

Include Files
Include files enable solver decks to be split into separate files for organizational purposes, and provide a
mechanism to include these files in a master solver beck, typically using an include statement.

Solver include files can generally have any solver card defined within them, therefore the include file
entity has the capability to store and organize all entities. Every entity is stored and organized into
an include file. There is a special include file called the Master Model which corresponds to the master
solver deck and is automatically created for every HyperMesh model. New entities are automatically
stored and organized into the current include file. If there are no include files defined then entities are
automatically stored and organized into the Master Model.

The contents of the Master Model can be observed by changing the entity view in the Model Browser to
Include View.

Every include file has a name and a location with a full or relative path.

Include file structures can be imported and exported with solver decks. By default, the solver include
file structure is preserved during import. Include files are generated to match and organize all data
within the solver include files into the appropriate include file. Solver include file references are also
preserved in the Master Model. During export, all entities are written into their corresponding solver
include files along with their references in the master solver deck. Change this functionality by selecting
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a different setting from the Include export option in the File Options dialog that opens when you
export a solver deck.

Abaqus
• Complete information is required for each keyword. A keyword and its data lines must be part of

the same file.

• Complete information is required for cards that contain multiple sub-keywords. For example, all
sub-keywords and their data lines in a *Material card must be part of the same include file.

• Complete information is required for *Step cards. All history keywords and their data lines must be
a part of the same file.

• The Abaqus solver interface is comprised of four types of include files, which define the sequence of
the *Include keywords in the model.

◦ Model (start) is written at the beginning of the deck, after the *Node block.

◦ Model (middle) is written in the middle of the deck, after the *Material block.

◦ Model is written at the end of the model definition.

◦ History keywords are written after the model definition.

• Include file names are sorted according to their names in the browser. The sequence in the
exported model is primarily determined by include file type. Within each type the sequence is
determined by the order in which they are created.

• Include file path syntax.

◦ File names can include a full or relative path name. Relative path names must be in relation to
the directory from which the job was started. If a path is not specified, it is assumed that the
file is located in the same directory from which the job was submitted.

◦ From HyperMesh, it is, however, not always possible to predict the directory from which the job
will finally be submitted. Therefore a relative path must be defined. This relative path should
be defined with respect to the folder where the corresponding *Include keyword appears. If
you run the job from a different folder in subsequent runs, you must also update the path
name.

LS-DYNA
• The LS-DYNA keywords *INCLUDE, *INCLUDE_STAMPED_PART, *INCLUDE_STAMPED_PART_SET,

*INCLUDE_TRANSFORM, *INCLUDE_COMPENSATION_OPTION are mapped to include files.

• You can switch to different types of includes (with the exception of *INCLUDE_TRANSFORM and
*INCLUDE_STAMPED_PART, *INCLUDE_STAMPED_PART_SET) using the context menu Include File
option in the Model Browser.

• INCLUDE_TRANSFORM is managed using the Transformation Manager.

• During import, if the same include file is referenced more than once using *INCLUDE_TRANSFORM,
then it is imported, but appended with .#, where # = 1…n and is shown in the Model Browser.
These will not be exported unless you clear the Instance checkbox.

• During import, *INCLUDE_STAMPED_PART and *INCLUDE_STAMPED_PART_SET are imported, by
default, as read only to preserve the associativity.

• During import, an include file can be read when *INCLUDE comes after *INCLUDE_TRANSFORM.
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• In the solver options of the Import browser, an option to choose the type of the Include file
is available at the time of importing a file as include to the file in session. This allows you
to set the include file type as one of the following: INCLUDE, INCLUDE_STAMPED_PART,
INCLUDE_STAMPED_PART_SET, INCLUDE_COMPENSATION_options. This is the only option to
attach any file of type INCLUDE_STAMPED_PART, INCLUDE_STAMPED_PART_SET.

Radioss
• Radioss Keyword #include is mapped to the Include files.

• A solver deck can be directly imported as an Include file, when the import option Import as
include is enabled in the Import browser.

• The order of the include files in the Model browser is dependent from their appearance order in the
solver deck.

• During import, if the same Include file is referred more than once, then it is imported but appended
with .# where # = 1…n and shown in the Model browser. These will not be exported unless you
clear the Instance checkbox.

SolverSubmodels
SolverSubmodels allow you to manage ID offsets as well as define transformations on solver entities or
Include files.

SolverSubmodels are generally used to position a sub-assembly of a model by defining transformations
on it, and, manage the entities IDs in the sub-assembly by defining IDs offsets.

The SolverSubmodel is differentiated from a solver Include files by its entity icon ( ).

In the Radioss solver profile, the //SUBMODEL keyword is mapped to the SolverSubmodels.

The definition of a Position entity and Transformations on a SolverSubmodel allows you to position the
content of a SolverSubmodel in the space.

Create SolverSubmodels
Manage ID offsets as well as define transformations on solver entities or Include files using the
SolverSubmodel entity.

1. Use the Model or Solver browser to create a SolverSubmodel.

• In the Model browser, right-click and select Create > Solversubmodel from the context
menu.

• In the Solver browser, right-click and select Create > Submodel from the context menu.

2. In the Create SUBMODEL dialog, define the SolverSubmodel.

a) In the Name field, enter a name.

b) Under Offsets, define all entity ID offsets.

c) Click Create.

3. Modify ID offsets in the Entity Editor, or by dragging-and-dropping entities or Include Files into the
SolverSubmodel in the browser.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.126

ID offsets will be automatically assigned on affected entities during a move operation (drag-and-
drop) of those entities (or Include files) into the Submodel.

Changing the ID offsets in the SolverSubmodel Entity Editor will not renumber the entity IDs
already defined in the SolverSubmodel. You can manage ID offsets of entities defined in a
SolverSubmodel in the ID Manager using the Edit ID Offsets option accessed from the
contextual menu.

Tip:

Moving entities or Include files into SolverSubmodel when ID offsets are defined,
may result in ID conflicts during ID offset operation. In that case, you will receive a
message to inform you about such IDs have conflicts, and you can choose to perform
an automatic renumbering of conflicting entities or stop the move operation.

Assemblies
Assemblies collect and organize sub-assemblies and components into hierarchical data structures which
are intended to reflect the data structure of the product being modeled.

Operations performed on an assembly do not affect the sub-assemblies or components collected
within the assembly. For example, if you delete an assembly, the sub-assemblies or components in the
assembly are not deleted.

PAM-CRASH Cards

Card Description

MBSYS/ Describes an assembly of multibodies

Radioss Cards

Card Description

/SUBSET Describes subsets.
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Card Description

Note:  Block Format Keyword

Components and Geometric/FE Entities

Components
Components collect and organize points, lines, surfaces, solids, elements and connectors. Components
are intended to be organizational containers for the geometry and FE idealization of a physical part
which makes up a product.

Components can be organized into one or more assemblies, therefore, components are not mutually
exclusive to an assembly. It is not recommended to organize components into multiple assemblies
if it can be avoided. The components which are not organized into an assembly can be observed by
changing the entity view in the Model Browser to Assembly View.

Components can be assigned properties and materials. Component property and material assignments
are solver interface dependent. In general, when a component is assigned a property or material,
that property or material assignment is applied to all elements organized within that component. The
method of assigning properties and materials at the component level is therefore referred to as indirect
property and material assignment. Direct property and material assignment is performed directly on the
elements themselves. Direct property and material assignments always take precedence over indirect
property and material assignments.

ANSYS Cards

Card Description

*HM_COMP

EXODUS Cards

Card Description

Beam

ConMass

ContactTie
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Card Description

ElementBlocks

Shell

Solid

Spring

Truss

LS-DYNA Cards

Card Description

*PART Defines parts for part adaptivity.

*PART_COMPOSITE Provides a simplified method of defining a composite material model for shell
elements that eliminates the need for user defined integration rules and part
IDs for each composite layer.

*PART_COMPOSITE_CONTACTAllows part based contact parameters to be used with the automatic contact
types a3, 4, a5, a10, 13, 15 and 26.

*PART_COMPOSITE_TSHELL

*PART_COMPOSITE_LONG

*PART_CONTACT Allows part-based contact parameters to be used with the automatic contact
types a3, a5, a10, a13, 15 and 26

*PART_CONTACT_PRINT

*PART_INERTIA Allows the inertial properties and initial conditions to be defined rather than
calculated from the finite element mesh.

*PART_INERTIA_CONTACT

*PART_INERTIA_CONTACT_PRINT

*PART_INERTIA_PRINT

*PART_MOVE Translate a part by an incremental displacement in either a local or a global
coordinate system.

*PART_PRINT Allows user control over whether output data is written into the ASCII files
MATSUM and RBDOUT.
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Card Description

*PART_REPOSITION Applies to deformable materials and is used to reposition deformable
materials attached to rigid dummy components whose motion is controlled
by either CAL3D or MADYMO.

*PART_REPOSITION_CONTACT

*PART_REPOSITION_CONTACT_PRINT

*PART_REPOSITION_PRINT

PAM-CRASH Cards

Card Description

PART / Part_3D

PART / Part_2D

PART / Part_1D

PART / Part_LINK

Permas Cards

Card Description

$ELPROP Assignment of geometrical data and material to elements.

Radioss Cards

Card Description

/PART Defines a part, which combines material and property information.
Optionally, the interface gap can be specified.
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Card Description

Note:  Block Format Keyword

Geometric Entities

Every point, line, surface or solid must be organized into one component, and therefore are mutually
exclusive to a component.

Points
A point is a zero-dimensional geometric entity.

A free point is a zero-dimensional geometry entity in space that is not associated with a surface. It is
displayed as a small "x". These types of points are typically used for weld locations and connectors.

A fixed point is a zero-dimensional geometry entity that is associated with a surface. It is displayed as a
small "o". The automesher places a node at each fixed point on the surface being meshed. A fixed point
that is placed at the junction of three or more non-suppressed edges is called a vertex or vertex point.
Such vertices cannot be suppressed (removed).

Lines
A line represents a curve in space and is not attached to any surface or solid. A line is a one-
dimensional geometric entity.

A line can be composed of one or more line types. Each line type in a line is referred to as a segment.
The end point of each line segment is connected to the first point of the next segment. A joint is the
common point between two line segments. Line segments are maintained as a single line entity, so
operations performed on the line affect each segment of the line. In general, HyperMesh automatically
uses the appropriate number and type of line segments to represent the geometry.

Lines are different from surface edges and are sometimes handled differently for certain operations.

Surfaces
A surface represents the geometry associated with a physical part. A surface is a two-dimensional
geometric entity that may be used in automatic mesh generation.

A surface is comprised of one or more faces. Each face contains a mathematical surface and edges to
trim the surface, if required. When a surface has several faces, all of the faces are maintained as a
single surface entity. Operations performed on the surface affect all the faces that comprise the surface.
In general, HyperMesh automatically uses the appropriate number of and type of surface faces to
represent the geometry.

The perimeter of a surface is defined by edges. There are four types of surface edges:

Free edges
A free edge is an edge that is owned by only one surface.
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Free edges are colored red by default.
On a clean model consisting of surfaces, free edges appear only along the outer perimeter of
the part and around any interior holes. Free edges that appear between two adjacent surfaces
indicate the existence of a gap between the two surfaces. The automesher will leave a gap in the
mesh wherever there is a gap between two surfaces.

Shared edges
A shared edge is an edge that is owned, or shared, by two adjacent surfaces.
Shared edges are colored green by default.
When the edge between two surfaces is a shared edge, there is no gap or overlap between the
two surfaces - they are geometrically continuous. The automesher always places seed nodes
along the length a shared edge and will produce a continuous mesh without any gaps along that
edge. The automesher will not construct any individual elements that cross over a shared edge.

Suppressed edges
A suppressed edge is shared by two surfaces but it is ignored by the automesher.
Suppressed edges are colored blue by default.
Like a shared edge, a suppressed edge indicates geometric continuity between two surfaces but,
unlike a shared edge, the automesher will mesh across a suppressed edge as if it were not even
there. The automesher does not place seed nodes along the length of a suppressed edge and,
consequently, individual elements will span across it. By suppressing undesirable edges you are
effectively combining surfaces into larger logical meshable regions.

Non-manifold edges
A non-manifold edge is owned by three or more surfaces.
Non-manifold edges are colored yellow by default.
They typically occur at "T" intersections between surfaces or when 2 or more duplicate surfaces
exist. The automesher always places seed nodes along their length and will produce a continuous
mesh without any gaps along that edge. The automesher will not construct any individual
elements that cross over a T-joint edge. These edges cannot be suppressed.

Surface edges are different from lines and are sometimes handled differently for certain operations.

The connectivity of surface edges constitutes the geometric topology.

Solids
Solids are closed volume of surfaces that can take any shape. Solids are three-dimensional entities that
can be used in automatic tetra and solid meshing.

The surfaces defining a solid can belong to multiple component collectors. The display of a solid and its
bounding surfaces are controlled only by the component collector to which the solid belongs.

Faces
A face is a single Non-uniform Rational B-Spline (NURBS) and is the smallest area entity. It has a
separate underlying mathematical definition, specified when it was created.

All faces are represented mathematically with the following formulations:

• plane

• cylinder/cone

• sphere
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• torus

• NURBS

A surface can be made up of a single face type or of multiple face types. Multiple types are used for
more complex surfaces that contain sharp corners or highly complex shapes.

Finite Element Entities
Supported finite element entities.

Elements

Nodes

Load Collectors, Loads and Equations

Load Collectors
Load collectors collect and organize loads, constraints, and equations.

Abaqus Cards
Loads or constraints that are to be used as history data (under *STEP) should be collected into
load collectors with the HISTORY card image. These load collectors also need to be added to the
corresponding load steps (*STEP). In contrast, loads or constraints for model data should be collected
into load collectors with INITIAL_CONDITION card image. They will automatically be written out in the
model portion of the Abaqus input deck.

Note:  All loads and boundary conditions on sets can be expanded to individual nodes and
elements by selecting the Expand load on sets option in the File Options dialog, which
is invoked upon importing a solver deck. If a **HMLOAD_SETS_EXPAND comment is found
in the input file, all loads and boundary conditions on sets are expanded to individual nodes
and elements.

Card Description

*CFILM Defines film coefficients and associated sink temperatures at one or more
nodes or vertices.

Note:  Only in HISTORY card image.

*CONNECTOR
HARDENING
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Card Description

*CONNECTOR LOAD Specifies loads for available components of relative motion in connector
elements.

Note:  Only in HISTORY card image.

*CONNECTOR MOTION Specifies the motion of available components of relative motion in connector
elements.

Note:  In both HISTORY and INTIAL_CONDITION card image.

*DSLOAD Specifies distributed surface loads.

Note:

Only in HISTORY card image.

*INERTIA RELIEF Applies inertia-based load balancing.

Note:

Only in HISTORY card image of Standard template.

*INITIAL_CONDITION_FLUID_PRESSURESpecifies initial pressures for hydrostatic fluid filled cavities.

*INITIAL_CONDITION_TEMPERATURESpecifies initial temperatures for heat transfer analysis.

*INITIAL_CONDITION_TYPE_STRESSSpecifies initial stresses.

*INITIAL_CONDITION_VELOCITYSpecifies initial velocities for dynamic analysis.

*SFILM Define film coefficients and associated sink temperatures over a surface for
heat transfer analysis.

Note:

Only in HISTORY card image.

EXODUS Cards

Card Description

Acceleration
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Card Description

Boundary

Force

Flux

Moment

Thermal

Velocity

LS-DYNA Cards
Load collector information is specified with a required $HMNAME comment card and an optional
$HMCOLOR comment card. If an input translator encounters one of these comments while reading
a load card, a new load collector is created. For the comments to be valid, they must follow a load
keyword or the last line of the previous Structured block. The loads that follow a $HMNAME LOADCOLS
comment are read into that collector. If there is a new keyword or structured block, the previous load
collector information is ignored.

For non-HyperMesh generated input decks, loads are divided into collectors based on classification. The
following load collectors are created:

• Mechanical loads for forces and moments

• Constraints/Displacements

• Velocities

• Accelerations

• Pressures

If translational or rotational constraints are defined in the input model, they are placed in a separate
load collector named Nodal Constraints.

Load collectors are not used by LS-DYNA, but are useful for visualization. Additional load collectors can
be defined to describe other entities.

Card Description

*BOUNDARY_CONVECTION_SETDefine convection boundary conditions for a thermal or coupled thermal/
structural analysis. Two cards are defined for each option.

*BOUNDARY_NON_REFLECTINGDefine a non-reflecting boundary.

*BOUNDARY_NON_REFLECTING_2DDefine a non-reflecting boundary.

*BOUNDARY_RADIATION_SETDefines surface segment sets that transfer energy by radiation to the
environment.
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Card Description

*BOUNDARY_SPC_SET Define nodal single point constraints.

*BOUNDARY_SPC_SET_ID

*BOUNDARY_TEMPERATURE_SETDefine temperature boundary conditions for a thermal or coupled thermal/
structural analysis.

*CONSTRAINED_RIGID_BODY_STOPPERSStops the motion based on a time dependent constraint. The stopper
overrides prescribed motion boundary conditions (except relative
displacement) operating in the same direction for both the master and
slaved rigid bodies.

*DEFINE_CURVE_FEEDBACKDefine information that is used as the solution evolves to scale the ordinate
values of the specified load curve ID.

*DEFINE_CURVE_FEEDBACK_TITLE

*DEFORMABLE_TO_RIGIDDefine materials to be switched to rigid at the start of the calculation.

Note:  Select an arraycount for the PSID and MRB pairs.

*DEFORMABLE_TO_RIGID_AUTOMATICDefine materials to be switched to rigid or to deformable at some stage in
the calculation.

Note:  Change the option to automatic and card edit. In the
D2R fields enter the number of PIDs that need to be converted
to Rigid. Create an entity set of comps of the slave PIDs and
select the set.

*DEFORMABLE_TO_RIGID_INERTIAInertial properties can be defined for the new rigid bodies that are created
when the deformable parts are switched. These can only be defined in the
initial input if they are needed in a later restart.

*INITIAL_AXIAL_FORCE_BEAMInitialize axial force in the beam for modeling bolt

*INITIAL_DETONATION Define points to initiate the location of high explosive detonations in part IDs
which use the material (type 8) *MAT_HIGH_EXPLOSIVE_BURN.

*INITIAL_STRESS_SECTIONInitialize stress in solid sections

*INITIAL_TEMPERATURE_SETDefine initial nodal point temperatures using nodal set IDs or node numbers.

*INITIAL_VEHICLE_KINEMATICSDefine initial kinematical information for a vehicle.

*INITIAL_VELOCITY Define initial nodal point translational velocities using nodal set IDs. This
may also be used for sets in which some nodes have other velocities.
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Note:  InitialVel

This card changes the INITV definition on Control Card 11. Only
the first card defined is valid for Structured.

*INITIAL_VELOCITY_GENERATIONDefine initial velocities for rotating and translating bodies.

*INITIAL_VELOCITY_GENERATION_START_TIMEDefine a time to initialize velocities after time zero.

*INITIAL_VELOCITY_RIGID_BODYDefine the initial translational and rotational velocities at the center of
gravity for a rigid body or a nodal rigid body.

*INTERFACE_SPRINGBACKDefine a material subset for an implicit springback calculation in LS-DYNA
and any nodal constraint to eliminate rigid body degrees-of-freedom.

*INTERFACE_SPRINGBACK_LSDYNA

*INTERFACE_SPRINGBACK_LSDYNA_NOTHICKNESSDefine a material subset for an implicit springback calculation in LS-DYNA
and any nodal constraints to eliminate rigid body degrees-of-freedom.

*INTERFACE_SPRINGBACK_LSDYNA_THICKNESS

*INTERFACE_SPRINGBACK_NASTRAN

*INTERFACE_SPRINGBACK_NASTRAN_NOTHICKNESS

*INTERFACE_SPRINGBACK_NASTRAN_THICKNESS

*INTERFACE_SPRINGBACK_SEAMLESS

*INTERFACE_SPRINGBACK_SEAMLESS_NOTHICKNESS

*INTERFACE_SPRINGBACK_SEAMLESS_THICKNESS

*LOAD_BEAM_SET Defines load on beam element set

*LOAD_BLAST Define an airblast function for the application of pressure loads due to
explosives in conventional weapons.

*LOAD_BODY_GENERALIZEDDefine body force loads due to a prescribed base acceleration or prescribed
angular velocity over a subset of the complete problem.

*LOAD_BODY_PARTS Define body force loads due to a prescribed base acceleration or angular
velocity using global axes directions.

Note:  Select component set.
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*LOAD_BODY_X Define body force loads due to a prescribed base acceleration using global
axes directions.

Note:  Activate the proper option and enter the data. Only the
first card defined is valid for Structured.

*LOAD_BODY_Y
Note:  Activate the proper option and enter the data. Only the
first card defined is valid for Structured.

*LOAD_BODY_Z
Note:  Activate the proper option and enter the data. Only the
first card defined is valid for Structured.

*LOAD_BODY_RX Define body force loads due to a prescribed angular velocity using global
axes directions.

Note:  Activate the proper option and enter the data. Only the
first card defined is valid for Structured.

*LOAD_BODY_RY
Note:  Activate the proper option and enter the data. Only the
first card defined is valid for Structured.

*LOAD_BODY_RZ
Note:  Activate the proper option and enter the data. Only the
first card defined is valid for Structured.

*LOAD_BRODE Define Brode function for application of pressure loads due to explosion.

*LOAD_MASK Apply a distributed pressure load over a three-dimensional shell part.

*LOAD_NODE_SET Apply a concentrated nodal force to a node or a set of nodes.

*LOAD_RIGID_BODY

*LOAD_SEGMENT_SET Apply the distributed pressure load over each segment in a segment set.

*LOAD_SHELL_SET Apply the distributed pressure load over one shell element or shell element
set.

*LOAD_SUPERELASTIC_FORMING
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*LOAD_THERMAL_CONSTANTDefine nodal sets giving the temperature that remains constant for the
duration of the calculation.

*LOAD_THERMAL_LOAD_CURVE

*LOAD_THERMAL_VARIABLEDefine nodal sets giving the temperature that is variable in the duration of
the calculation.

Nastran Cards
Nastran supports specific and generic load collectors. Specific load collectors have a card image which
can be edited to group other load collectors together for simultaneous application in a single subcase,
or to provide special information for a specific analysis type (such as modal analysis). Use specific load
collectors for specialized loading cards, such as SPCADD, MPCADD, EIGRL, EIGB, EIGC, EIGP, EIGR,
FREQ, FREQ1, LOAD, GRAV, RFORCE, and TEMPD. Generic load collectors do not have a card image. Use
generic load collectors to collect loads and constraints for display purposes and to assign an ID to the
loads.

General boundary conditions, such as loads and constraints, should not be collected into specific
load collectors. Organizing loads and constraints into a specific load collector may result in an error
termination.

When a Nastran deck is imported into HyperMesh, loads that have the same SID are collected into the
same load collector. If a load collector already exists in the database with the same SID, one of the
following can occur:

• If overwrite is off (default), the new load collector’s ID is offset and all loads in that collector will
have a new SID upon export.

• If overwrite is on, the new load collector replaces the existing load collector. The original load
collector and the loads it contains are deleted.

Card Description

ACSRCE Defines the power versus frequency curve for a simple acoustic source.

AEFACT Defines real numbers for aeroelastic analysis.

AEPARM Defines a general aerodynamic trim variable degree-of-freedom
(aerodynamic extra point).

AESTAT Specifies rigid body motions to be used as trim variables in static
aeroelasticity.

AEFORCE Defines a vector of absolute or “per unit dynamic pressure” forces
associated with a particular control vector.

BCPARA Defines contact parameters.
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BCRPARA

BMFACE

DAMPING Defines a parameter and hybrid damping specification.

DELAY Defines the time delay term in the equations of the dynamic loading
function.

Note:  Supported as constraints.

DLOAD Defines a dynamic loading condition for frequency response or transient
response problems as a linear combination of load sets defined via RLOAD1
or RLOAD2 entries for frequency response or TLOAD1 or TLOAD2 entries for
transient response

DTI SPECSEL Defines table data blocks

EIGB Defines data needed to perform buckling analysis

EIGC Defines data needed to perform complex eigenvalue analysis

EIGP Defines poles that are used in complex eigenvalue extraction by the
Determinant method

EIGR Defines data needed to perform real eigenvalue analysis

EIGRL Defines data needed to perform real eigenvalue (vibration or buckling)
analysis with the Lanczos method

FLFACT Used to specify density ratios, Mach numbers, reduced frequencies, and
velocities for flutter analysis.

FLUTTER Defines data needed to perform flutter analysis.

FREQ Defines a set of frequencies to be used in the solution of frequency response
problems.

Note:  Defined using FREQi.

FREQ1 Defines a set of frequencies to be used in the solution of frequency response
problems by specification of a starting frequency, frequency increment, and
the number of increments desired.

Note:  Defined using FREQi.
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FREQ2 Alternative form of frequency list. Defines a set of frequencies to be used in
the solution of frequency response problems by specification of a starting
frequency, final frequency, and the number of logarithmic increments
desired.

Note:  Defined using FREQi.

FREQ3 Frequency List, Alternate Form 3. Defines a set of frequencies for the
modal method of frequency response analysis by specifying the number of
frequencies between modal frequencies.

Note:  Defined using FREQi.

FREQ4 Frequency List, Alternate Form 4. Defines a set of frequencies for the modal
method of frequency response analysis by specifying the amount of "spread"
around each modal frequency and the number of equally spaced frequencies
within the spread.

Note:  Defined using FREQi.

FREQ5 Frequency List, Alternate Form 5. Defines a set of frequencies for the modal
method of frequency response analysis by specification of a frequency range
and fractions of the natural frequencies within that range.

Note:  Defined using FREQi.

GRAV Defines acceleration vectors for gravity or other acceleration loading

GUST Selects the gust field in an aeroelastic response problem.

HYBDAMP Defines a hybrid modal damping for direct dynamic solutions.

LOAD Defines a static load as a linear combination of load sets defined via FORCE,
MOMENT, FORCE1, MOMENT1, FORCE2, MOMENT2, PLOAD, PLOAD1,
PLOAD2, PLOAD4, PLOADX1, SLOAD, RFORCE, and GRAV entries.

LSEQ Defines a sequence of static load sets.

MARCOUT Selects output to be saved on the Marc t16 end/or t19 file(s) used in SOL
600 only.

MFLUID Defines the properties of an incompressible fluid volume for the purpose of
generating a virtual mass matrix
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MKAERO1 Provides a table of Mach numbers (m) and reduced frequencies (k) for
aerodynamic matrix calculation.

MPCADD Defines a multipoint constraint set as a union of multipoint constraint sets
defined via MPC entries.

NLAUTO Defines parameters for automatic or fixed load/time stepping used in SOL
600 only.

NLDAMP Defines damping constants for nonlinear analysis when Marc is executed
from SOL 600 only.

NLPARM Defines a set of parameters for nonlinear static analysis iteration strategy

NLRGAP Defines a nonlinear radial (circular) gap for transient response or nonlinear
harmonic response.

NLSTEP Describes the control parameters for Mechanical, Thermal and Coupled
Analysis in SOL 400 and for Linear Contact Analysis in SOL 101.

NLSTRAT Defines strategy parameters for nonlinear structural analysis used in SOL
600 only.

NOLIN1 Defines a forcing function for transient responses or nonlinear harmonic
responses.

NSMADD Defines non structural mass as the sum of the sets listed.

NTHICK Defines nodal thickness values for beams, plates and/or shells.

RADCAV Identifies the characteristics of each radiant enclosure.

RANDPS Defines load set power spectral density factors for use in random analysis
having the frequency dependent form:

RFORCE Defines a static loading condition due to an angular velocity and/or
acceleration

RLOAD1 Defines a frequency-dependent dynamic load of the form:

for use in frequency response problems

RLOAD2 Defines a frequency-dependent dynamic excitation of the form:
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for use in frequency response problems

RSPEC Defines a directional combination method, modal combination method,
excitation direction(s), response spectra and scale factors for response
spectrum analysis.

SPC1 Defines a single-point constraint, alternate form.

SPCADD Defines a single-point constraint set as a union of single-point constraint
sets defined on SPC or SPC1 entries

SPCR Defines an enforced relative displacement value for a load step in SOL 400
and SOL 600.

TABDMP1 Defines modal damping as a tabular function of natural frequency

TABLED1 Defines a tabular function for use in generating frequency-dependent and
time-dependent dynamic loads

TABLED2 Defines a tabular function for use in generating frequency-dependent and
time-dependent dynamic loads. Also contains parametric data for use with
the table

TABLED3 Defines a tabular function for use in generating frequency-dependent and
time-dependent dynamic loads. Also contains parametric data for use with
the table

TABLED4 Defines the coefficients of a power series for use in generating frequency-
dependent and time-dependent dynamic loads. Also contains parametric
data for use with the table

TABLEM1 Defines a tabular function for use in generating temperature-dependent
material properties.

TABLEM2 Defines a tabular function for use in generating temperature-dependent
material properties. Also contains parametric data for use with the table.

TABLEM3 Defines a tabular function for use in generating temperature-dependent
material properties. Also contains parametric data for use with the table.

TABLEM4 Defines coefficients of a power series for use in generating temperature-
dependent material properties. Also contains parametric data for use with
the table.

TABLES1 Defines a tabular function for stress-dependent material properties such as
the stress-strain curve (MATS1 entry), creep parameters (CREEP entry) and
hyperelastic material parameters (MATHP entry).
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TABLEST Specifies the material property tables for nonlinear elastic temperature-
dependent materials

TABRND1 Defines power spectral density as a tabular function of frequency for use in
random analysis. Referenced by the RANDPS entry.

TEMPD Defines a temperature value for all grid points of the structural model that
have not been given a temperature on a TEMP entry.

TIC Defines values for the initial conditions of variables used in structural
transient analysis. Both displacement and velocity values may be specified
at independent degrees-of-freedom. This entry may not be used for heat
transfer analysis.

TLOAD1 Defines a time-dependent dynamic load or enforced motion of the form:

for use in transient response analysis

TLOAD2 Defines a time-dependent dynamic excitation or enforced motion of the
form:

for use in a transient response problem, where:

TRIM Specifies constraints for aeroelastic trim variables. The SPLINE1 and
SPLINE4 entries need to be here for the finite plate spline.

TSTEP Defines time step intervals at which a solution will be generated and output
in transient analysis

TSTEPNL Defines parametric controls and data for nonlinear transient structural or
heat transfer analysis. TSTEPNL is intended for SOLs 129, 159, and 99.

UXVEC Specification of a vector of aerodynamic control point (extra point) values.

VIEW Defines radiation cavity and shadowing for radiation view factor calculations.
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VIEW3D Defines parameters to control and/or request the Gaussian Integration
method of view factor calculation for a specified cavity.

OptiStruct Cards
Specific load collectors are used for specialized loading cards, such as EIGRL, SPCADD, GRAV, RLOAD
and DTABLEi. Specific load collectors have a card image which can be edited to group other load
collectors together for simultaneous application in a single subcase, or to provide special information for
a specific analysis type (such as modal analysis).

General boundary conditions, such as loads and constraints, should not be collected into specific
load collectors. Organizing loads and constraints into a specific load collector may result in an error
termination.

Card Description

ACSRCE Defines acoustic source as a function of power vs. frequency.

Note:  Bulk Data Entry

CDSMETH Can be used in the component dynamic synthesis method for generating
component dynamic matrices at each loading frequency.

Note:  Bulk Data Entry

CMSMETH Defines the CMS (Component Mode Synthesis) method, frequency upper
limit, number of modes, and starting SPOINT ID to be used in a CMS
solution. The eigenvalue solver is also specified. In addition, preload as
well as loads for reduction and residual vector generation can be defined.
Also, an ASCII file containing CELAS4 and CDAMP3 element data and/or their
corresponding design variable definitions can be generated for DMIG to allow
the use of the component modes in optimization runs.

Note:  Bulk Data Entry

CNTSTB Defines parameters for stabilization control of surface-to-surface contact
and large displacement node-to-surface contact. A CNTSTB Bulk Data Entry
should be referenced by a CNTSTB Subcase Information entry to be applied
in a particular subcase.
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Card Description

Note:  Bulk Data Entry

A CNTSTB Bulk Data Entry should be referenced by a CNTSTB
Subcase Information entry to be applied in a particular subcase.

DLOAD Defines a dynamic loading condition for frequency response problems as a
linear combination of load sets defined via RLOAD1 and RLOAD2 entries, or for
transient problems as a linear combination of load sets defined via TLOAD1
and TLOAD2 entries, or acoustic source ACSRCE entries.

Note:  Bulk Data Entry

DTI, SPECSEL Correlates spectra lines specified on TABLED1 entries with damping values.

Note:  Bulk Data Entry

EIGC Defines data required to perform complex eigenvalue analysis.

Note:  Bulk Data Entry

EIGRA Defines the data required to perform real eigenvalue analysis with the
Automated Multi-Level Sub-structuring technique.

Note:  Bulk Data Entry

EIGRL Defines data required to perform real eigenvalue analysis (vibration or
buckling) with the Lanczos Method.

Note:  Bulk Data Entry

FATDEF Defines elements, and associated fatigue properties, for consideration in a
fatigue analysis.

Note:  Bulk Data Entry

FATEVNT Defines loading events for fatigue analysis.

Note:  Bulk Data Entry
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FATLOAD Defines fatigue loading parameters.

Note:  Bulk Data Entry

FATPARM Used to define parameters required for a Fatigue Analysis.

Note:  Bulk Data Entry

FATSEQ Defines a loading sequence for a Fatigue Analysis.

Note:  Bulk Data Entry

FLLWER Define parameters for the calculation of loads dependent on deformation.
Two type of loads, pressure load (only PLOAD4 Bulk Data Entries) and
concentrated force (only FORCE1/FORCE2 Bulk Data Entries) can use this
entry to control the options for Follower Loads.

Note:  Bulk Data Entry

FREQ Defines a set of frequencies to be used in the solution of frequency response
problems.

Note:  Bulk Data Entry

FREQ1 Defines a set of frequencies to be used in the solution of frequency response
problems by specification of a starting frequency, frequency increment, and
the number of increments desired.

Note:  Bulk Data Entry

Defined using FREQi.

FREQ2 Defines a set of frequencies to be used in the solution of frequency response
problems by specification of a starting frequency, final frequency, and the
number of logarithmic increments desired.

Note:  Bulk Data Entry

Defined using FREQi.
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FREQ3 Defines a set of frequencies for the modal method of frequency response
analysis by specifying the number of frequencies between modal
frequencies.

Note:  Bulk Data Entry

Defined using FREQi.

FREQ4 Defines a set of frequencies for the modal method of frequency response
analysis by specifying the amount of "spread" around each modal frequency
and the number of equally spaced frequencies within the spread.

Note:  Bulk Data Entry

Defined using FREQi.

FREQ5 Defines a set of frequencies for the modal method of frequency response
analysis by specification of a frequency range and fractions of the natural
frequencies within that range.

Note:  Bulk Data Entry

Defined using FREQi.

FSI Defines the settings for Fluid-Structure Interaction Analysis with AcuSolve.

Note:  Bulk Data Entry

GRAV Defines the gravity vectors for use in determining gravity loading for the
static structural model. It can also be used to define the EXCITEID field
(Amplitude "A") of dynamic loads in RLOAD1, RLOAD2, TLOAD1, TLOAD2 and
NLOAD1 Bulk Data Entries for dynamic solution sequences.

Note:  Bulk Data Entry

HYBDAMP This Bulk Data Entry defines the application of modal damping to the
residual structure in a Direct Transient or Frequency Response analysis.

Note:  Bulk Data Entry

INVELB Defines initial velocity in a multibody situation.
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Note:  Bulk Data Entry

LOAD The LOAD is equivalent to the LOADADD.

Note:  Bulk Data Entry

MBACT Defines the entity/set that needs to be activated in the multibody system for
the subsequent simulation.

Note:  Bulk Data Entry

MBDEACT Defines the entity/set that needs to be deactivated in the multibody system
for the subsequent simulation.

Note:  Bulk Data Entry

MBLIN Defines the parameters for a multibody system linear analysis.

Note:  Bulk Data Entry

MBREQ Defines a multibody as a combination of request sets defined via MBREQE and
MBREQM.

Note:  Bulk Data Entry

MBREQE Defines a multibody solver output request to output the results of a set of
expressions.

Note:  Bulk Data Entry

MBREQM Defines a multibody solver output request to output displacement, velocity,
acceleration, or force with respect to markers.

Note:  Bulk Data Entry

MBSEQ Defines the simulation sequence for the multibody solver.
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Note:  Bulk Data Entry

MBSIM Defines the parameters for a multibody simulation.

Note:  Bulk Data Entry

MBSIMP Defines the simulation parameters for subsequent multibody simulation.

Note:  Bulk Data Entry

MBVAR Defines a multibody solver variable which can be referred to by multiple
expressions.

Note:  Bulk Data Entry

MFLUID Defines the parameters and damp shell elements for a fluid volume.

Note:  Bulk Data Entry

MLOAD Defines a multibody as a linear combination of load sets defined via GRAV,
MBFRC, MBFRCC, MBFRCE, MBMNT, MBMNTC, MBMNTE, MBSFRC, MBSFRCC, MBSFRCE,
MBSMNT, MBSMNTC, and MBSMNTE.

Note:  Bulk Data Entry

MOTION Defines a multibody as a combination of motion sets defined via MOTNJ,
MOTNJC, MOTNJE, MOTNG, MOTNGC, and MOTNGE.

Note:  Bulk Data Entry

MPCADD Defines a multipoint constraint set as a union of multipoint constraint sets
defined via MPC entries.

Note:  Bulk Data Entry

NLADAPT The NLADAPT Bulk Data Entry defines parameters for time-stepping and
convergence criteria in Nonlinear Analysis.
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Note:  Bulk Data Entry

Refers to Subcase information entry NLADAPT.

NLOAD Defines a loading condition for nonlinear problems as a linear combination of
load sets defined via NLOAD1.

Note:  Bulk Data Entry

NLOAD1 Defines a time-dependent load or enforced motion for use in geometric
nonlinear analysis.

Note:  Bulk Data Entry

NLOUT Defines incremental result output parameters for small displacement
nonlinear analysis and large displacement analysis.

Note:  Bulk Data Entry

Refers to Subcase information entry NLOUT.

NLPARM Defines parameters for Nonlinear Static Analysis, Nonlinear Direct Transient
Analysis, and Heat Transfer Analysis solution control.

Note:  Bulk Data Entry

NLPARMX Defines additional parameters for geometric nonlinear implicit static
analysis.

Note:  Bulk Data Entry

NSMADD Defines non-structural mass as the sum of the sets listed.

Note:  Bulk Data Entry

PEAKOUT Defines criteria used for the automatic identification of loading frequencies
at which result peaks occur. Other result output may then be requested
at these "peak" loading frequencies. This feature is only supported for
frequency response solution sequences.
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Note:  Bulk Data Entry

PFAT Defines element properties for fatigue analysis.

Note:  Bulk Data Entry

PFPATH Defines a one-step transfer path analysis.

Note:  Bulk Data Entry

PTADD Defines a pretension load as a linear combination of load sets defined via
PTFORCE, PTFORC1, PTADJST and PTADJS1 entries.

Note:  Bulk Data Entry

RANDPS Defines load set power spectral density factors for use in random analysis
having the frequency dependent form Sjk (F) = (X + iY) G(F).

Note:  Bulk Data Entry

RFORCE Defines a static loading condition due to a centrifugal force field. It can also
be used to define the EXCITEID field (Amplitude "A") of dynamic loads in
RLOAD1, RLOAD2, TLOAD1 and TLOAD2 Bulk Data Entries. RFORCE is used as a
linear dead-load in Large Displacement Nonlinear Analysis.

Note:  Bulk Data Entry

RGYRO Includes data required to perform Rotor Dynamics analysis in Modal
Frequency Response Analysis and/or Modal Complex Eigenvalue Analysis.
The RGYRO Bulk Data Entry is referenced by a corresponding RGYRO Subcase
Information Entry in a specific subcase.

Note:  Bulk Data Entry

RLOAD1 Defines a frequency-dependent dynamic load of the form:

 for use in frequency response problems.
RLOAD1 (Form 1) can be used when the frequency-dependent dynamic load
input is available in real/imaginary number format.
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Note:  Bulk Data Entry

RLOAD2 Defines a frequency-dependent dynamic load of the form

for use in frequency response problems. RLOAD2
(Form 2) can be used when the frequency-dependent dynamic load input is
available in magnitude/phase number format.

Note:  Bulk Data Entry

RSPEC Specifies directional combination method, modal combination method,
excitation direction(s), response spectra and scale factors.

Note:  Bulk Data Entry

RSPEED Specifies a set of reference rotor speed values for asynchronous analysis in
Rotor Dynamics.

Note:  Bulk Data Entry

SOLVTYP Defines the solver type to be used for static, dynamic analysis and
geometric nonlinear implicit analysis.

Note:  Bulk Data Entry

SPCADD Defines a single-point constraint set as a union of single-point constraint
sets defined via SPC or SPC1 entries.

Note:  Bulk Data Entry

TABDMP1 Defines modal damping as a tabular function of natural frequency.

Note:  Bulk Data Entry

TABFAT Defines y values of each point on the loading time history.

Note:  Bulk Data Entry
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TABLED1 Defines a tabular function for use in generating frequency-dependent and
time-dependent dynamic loads.

Note:  Bulk Data Entry

TABLED2 Defines a tabular function for use in generating frequency-dependent and
time-dependent dynamic loads. Also contains parametric data for use with
the table.

Note:  Bulk Data Entry

TABLED3 Defines a tabular function for use in generating frequency-dependent and
time-dependent dynamic loads. Also contains parametric data for use with
the table.

Note:  Bulk Data Entry

TABLED4 Defines the coefficients of a power series for use in generating frequency-
dependent and time-dependent dynamic loads. Also contains parametric
data for use with the table.

Note:  Bulk Data Entry

TABLEM1 Defines a tabular function for use in generating temperature-dependent
material properties.

Note:  Bulk Data Entry

TABLEM2 Defines a tabular function for use in generating temperature-dependent
material properties. Also contains parametric data for use with the table.

Note:  Bulk Data Entry

TABLEM3 Defines a tabular function for use in generating temperature-dependent
material properties. Also contains parametric data for use with the table.

Note:  Bulk Data Entry
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Card Description

TABLEM4 Defines coefficients of a power series for use in generating temperature-
dependent material properties. Also contains parametric data for use with
the table.

Note:  Bulk Data Entry

TABLES1 Defines a tabular function for use as stress-strain curve in elasto-plastic
material properties MATS1, MATX33, MATX65, MATHF, as well as material curve
in nonlinear material properties MATX36, MATX42, and MATX70. The TABLES1
entry can also be used to define the corresponding material curves on the
MATHE Bulk Data Entry.

Note:  Bulk Data Entry

TABLEST Specifies the material property tables for elasto-plastic, temperature-
dependent materials.

Note:  Bulk Data Entry

TABRND1 Defines power spectral density as a tabular function of frequency for use in
random analysis. Referenced on the RANDPS entry.

Note:  Bulk Data Entry

TEMPD Defines a temperature value for all grid points of the structural model that
have not been given a temperature on a TEMP entry.

Note:  Bulk Data Entry

TICA Defines values for the initial velocity of a set of grids along and about an
axis for explicit analysis.

Note:  Bulk Data Entry

TLOAD1 Defines a time-dependent dynamic load or enforced motion.

Note:  Bulk Data Entry

TLOAD2 Defines a time-dependent dynamic excitation or enforced motion.
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Card Description

Note:  Bulk Data Entry

TSTEP Defines time step parameters for control and intervals at which a solution
will be generated and output in transient analysis.

Note:  Bulk Data Entry

TSTEPNL Defines parameters for geometric nonlinear implicit dynamic analysis
strategy.

Note:  Bulk Data Entry

TSTEPNX Defines additional parameters for geometric nonlinear implicit dynamic
analysis.

Note:  Bulk Data Entry

UNBALNC Defines the unbalanced rotating load during a rotor dynamic analysis in
Frequency Response solution sequences. The unbalanced load is specified in
a cylindrical system where the rotor rotation axis is the Z-axis.

Note:  Bulk Data Entry

XHISADD Defines a time history output set as a union of time history outputs defined
via XHIST entries.

Note:  Bulk Data Entry

XSTEP Defines explicit analysis control.

Note:  Bulk Data Entry

PAM-CRASH Cards

Card Description

ACC3D / Imposed accelerations
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Card Description

Note:  Keyword input

ACFLD / Acceleration field

Note:  Keyword input

BDFOR / Body force constraints

Note:  Keyword input

BOUNC / Specify boundary conditions on the base body

Note:  Keyword input

CONLO / Concentrated nodal load

Note:  Keyword input

DAMP / Nodal damping group cards

Note:  Keyword input

DIS3D / Imposed displacement

Note:  Keyword input

DIS3DM / Imposed minimum displacement

Note:  Keyword input

DIS3DX / Imposed maximum displacement

Note:  Keyword input

INVEL / Specify the initial velocity of the base body
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Card Description

Note:  Keyword input

PREFA / Pressure on shells

Note:  Keyword input

PREBM / Pressure on beams

Note:  Keyword input

RAC3D / Imposed rotational acceleration

Note:  Keyword input

RAN3D / Imposed angular rotations

Note:  Keyword input

RDA3D / Radial 3D boundary conditions

Note:  Keyword input

RDD3D / Radial 3D boundary conditions

Note:  Keyword input

RDV3D / Radial 3D boundary conditions

Note:  Keyword input

RVE3D / Imposed rotational velocities

Note:  Keyword input

VEL3D / Imposed velocities
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Card Description

Note:  Keyword input

Permas Cards

Card Description

$ADDMODES Definition of static mode shapes to be added to the set of eigenmodes used
for transformation to modal space.

Note:  Available as a load collector when the source = loads.

To change the LPAT = field, set the AddmodeLoads toggle to
LOADSELECT, which ensures that each data line will define
different ADDMODES.

In the NoOfLoads_AddMode = field, enter the number of load
patterns to assign the ADDMODES to.

$CONTVAL Assignment of properties to contacts referenced by contact identifier or
name.

Note:  Supported as a load collector (card image LOADS). To
create a card, use an existing load collector or create a new one
with card image LOADS and select the CONTVAL check box.

A maximum number of 5 keywords are allowed per load collector
(load pattern).

$PRETENSION LOAD Assignment of load properties to pretension threads/areas referenced by
identifier or name.

Note:  Supported as a load collector (card image LOADS). To
create a card, use an existing load collector or create a new one
with card image LOADS and select the PRETENSION checkbox.
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Card Description

$SUPPRESS Definition of suppressed degrees of freedom. The degrees of freedom given
on the header line are suppressed for all nodes listed within the data block.

Radioss Cards
Assign loads to a collector by creating individual loads, all of the same type and degree of freedom, and
storing them in the appropriate load collector, or by identifying the nodes on which loads/BCs act by
selecting them through a set. The selection of the set is possible by editing the card image of the load
collector.

Card Description

/ACTIV Describes the deactivation/activation of element groups.

Note:  Block Format Keyword

/ALE/BCS Describes the ALE boundary conditions.

Note:  Block Format Keyword

/BCS Defines boundary conditions on node groups for translational and rotational
motion.

Note:  Block Format Keyword

/CLOAD Defines a concentrated force or moment applied to each node of a
prescribed nodal group.

Note:  Block Format Keyword

/CONVEC Describes the free or forced convective flux.

Note:  Block Format Keyword

/DFS/DETLINE Enable explosive material ignition from a detonation line [A,B].

Note:  Block Format Keyword

/DFS/DETPOINT Locates the detonation point and set lighting time for an explosive material
law.
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Card Description

Note:  Block Format Keyword

/DFS/LASER Enable to model laser impact taking into account laser-matter interaction.

Note:  Block Format Keyword

/DFS/WAV_SHA Enables to shape detonation wave to take into account obstacles.

Note:  Block Format Keyword

/EBCS Describes the elementary boundary condition sets.

Note:  Block Format Keyword

/GRAV Defines gravity load on node group.

Note:  Block Format Keyword

/IMPACC Defines imposed accelerations on a group of nodes.

Note:  Block Format Keyword

/IMPDISP Defines imposed displacements on a group of nodes.

Note:  Block Format Keyword

/IMPTEMP Defines imposed temperatures on a group of nodes.

Note:  Block Format Keyword

/IMPVEL Defines imposed velocities on a group of nodes.

Note:  Block Format Keyword

/INITEMP Describes the initial nodal temperature.
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Card Description

Note:  Block Format Keyword

/INIVEL Defines initial velocity on a group of nodes.

Note:  Block Format Keyword

/INIVEL/AXIS Initialize both translational and rotational velocities on a group of nodes in a
given coordinate system.

Note:  Block Format Keyword

/LOAD/CENTRI Computes a load according to the rotational velocity around an axis.

Note:  Block Format Keyword

/LOAD/PFLUID Simulates hydrodynamic fluid pressure on a structure. The fluid pressure
is calculated according to the specified fluid velocity, orientation of the
structural surface against the fluid vector and the height of the fluid column
above the surface of the structure.

Note:  Block Format Keyword

/PLOAD Defines pressure load on a surface.

Note:  Block Format Keyword

/SPHBCS Describes the SPH symmetry conditions.

Note:  Block Format Keyword

/SPH/INOUT Describes the SPH inlet/outlet conditions.
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Card Description

Note:  Block Format Keyword

Loads

Every load and constraint must be organized into one load collector, and therefore are mutually
exclusive to a load collector.

Load Configurations
Load entities have an associated load configuration. A load configuration determines how to draw, store,
and work with a load.

Accelerations

Configuration 9 - Acceleration loads allow for an acceleration (length/time2) to be defined on the
model.

Accelerations are displayed as a vector with the letter A at the tail end in the modeling window.

Constraints

Configuration 3 - Constraints allow for constrained degrees of freedom to be defined on the
model.

Constraints are displayed with a triangle that connects to the node, with the dof numbers that
apply to the node beside the triangle in the modeling window.

Fluxes

Configuration 6 - Flux loads are defined as an amount that flows through a unit area per unit time
(amount/length2/time). Fluxes are typically used in modeling transport phenomena such as heat
transfer, mass transfer, fluid dynamics, and electromagnetism.

Fluxes are displayed as a thick arrow labeled with the word "flux" in the modeling window.

Forces

Configuration 1 - Force loads allow for a concentrated force (mass*length/time2) to be applied to
the model.

Forces are displayed as a vector with the letter F at the tail end in the modeling window.

Moments

Configuration 2 - Moment loads allow for a concentrated moment (length*force) to be applied to
the model.

Moments are displayed with a double-headed vector with the letter M at the tail end in the
modeling window.
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Pressures

Configuration 4 - Pressure loads allow for a pressure (force*length2) to be applied to the model.

For most solvers, the pressure load is considered as force/area, therefore the magnitude of the
pressure is multiplied by the calculated area of the elements to which it is applied and resolved as
concentrated force loads at the associated nodes.

Pressures are displayed as a vector with the letter P at the tail end in the modeling window.

Temperatures

Configuration 5 - Temperature loads allow for a concentrated temperature to be applied to the
model.

Temperatures are displayed as a vertical line with the letter T at the top in the modeling window.

Velocities

Configuration 8 - Velocity loads allow for a velocity (length/time) to be applied to the model.

Velocities are displayed as a vector with the letter V at the tail end in the modeling window.

Abaqus Cards
Loads or constraints that are to be used as history data (under *STEP) should be collected into
load collectors with the HISTORY card image. These load collectors also need to be added to the
corresponding load steps (*STEP). In contrast, loads or constraints for model data should be collected
into load collectors with INITIAL_CONDITION card image. They will automatically be written out in the
model portion of the Abaqus input deck.

Note:  All loads and boundary conditions on sets can be expanded to individual nodes and
elements by selecting the Expand load on sets option in the File Options dialog, which
is invoked upon importing a solver deck. If a **HMLOAD_SETS_EXPAND comment is found
in the input file, all loads and boundary conditions on sets are expanded to individual nodes
and elements.

Card Supported Load Types Description

*BOUNDARY (electric
potential, dof 9)

Flux Specifies flux boundary conditions for piezoelectric
analysis.

*BOUNDARY (structural) Constraint Creates structural boundary conditions.

*BOUNDARY

(temperature, dof 11)

Temperatures Specifies temperature boundary conditions.

*CECHARGE Flux Specifies concentrated electric charges for
piezoelectric analysis.

*CECURRENT Flux Specifies concentrated current in electric
conduction.
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Card Supported Load Types Description

*CFLUX Flux Specify concentrated fluxes in heat transfer or
mass diffusion analyses.

*CLOAD Force Creates concentrated forces.

*CLOAD Moment Creates concentrated moments.

*COUPLING Constraint Define a surface-based coupling constraint

*DECHARGE Pressure Distributes electric charges for piezoelectric
analysis.

*DFLUX Pressure Specify distributed fluxes in heat transfer or mass
diffusion analyses.

*DISTRIBUTING Constraint Define a distributing coupling constraint

*DISTRIBUTING
COUPLING

Elements Specify nodes and weighting for distributing
coupling elements

*DLOAD Pressure Specifies distributed loads

*FILM Pressure Define film coefficients and associated sink
temperatures.

*KINEMATIC Multi-point Constraints Define a kinematic coupling constraint

*KINEMATIC COUPLING Multi-point Constraints Constrain all or specific degrees of freedom of
a set of nodes to the rigid body motion of a
reference node

*MPC Multi-point Constraints Define multi-point constraints

*RADIATE Pressure Specify radiation conditions in heat transfer
analyses

*TEMPERATURE Temperature Specifies predefined temperature field.

ANSYS Cards

Card Supported Load Types Description

BF Flux Defines a nodal body force load.

BF_FLUE Flux

BF_HGEN Flux
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Card Supported Load Types Description

BF_TEMP Temperatures

BFE_FLUE Flux Defines an element body force load.

BFE_HGEN Flux

BFE_TEMP Flux

CE_STRUCT Equation

CE_THERM Equation

CE_MAG Equation

CE_ELEC Equation

ConvBulkTe Pressure

ConvFilmCo Pressure

D_A Constraint Vector magnetic potential.

D_CONSTRNT Constraint Defines DOF constraints at nodes.

D_MAG Constraint Scalar magnetic potential.

D_PRES Constraint

D_TEMP Temperature

D_VOLT Constraint

F_FLOW Flux Specifies force loads at nodes.

F_HEAT Flux

FLOTRAN Pressure Specifies "FLOTRAN data settings" as the
subsequent status topic.

Note:  FLOTRAN surface load label
“FSI [fluid-structure interaction flag]”
is available under pressure load.

You must use DOF1 to add value for
this label.

FORCE Force Selects the element nodal force type for output.

FORCE2 Moment
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Card Supported Load Types Description

FSI Pressure

HFLUX Pressure

IC_A Constraint

IC_CONSTRN Constraint Specifies initial conditions at nodes.

IC_MAG Constraint

IC_PRES Constraint

IC_TEMP Temperature

IC_VOLT Constraint

PRESSURE Pressure

RDSF_EMI Pressure

RDSF_ENCL Pressure

SFE Pressure

Convection

Heatflux

Defines elemental surface load.

Note:  Structural, thermal and Fluid
labels are covered.

SFE Structural

Thermal

Fluid

Surface load

Structural label: PRES

Thermal label: CONV, HLFUX

Fluid label: FSI

LS-DYNA Cards
Several load types cause three cards to be output for x, y, and z components. During input, these are
grouped into one load. Loads cannot be applied to sets, components, or boxes. Load curves are input
and output. Use the Card Editor to select load curves. Unless mentioned in the Notes column, load cards
cannot be edited.

Card Supported Load Types Description

*BOUNDARY_PRESCRIBED_MOTION_NODEConstraints

Type 2; Card 26,
VAD = 2

Define an imposed nodal motion (velocity,
acceleration, or displacement) on a node or a set
of nodes.
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Card Supported Load Types Description

DEATH

BIRTH

DOF 4, -4, 8, -8, 9, -9, 10, -10, 11, -11 are not
supported.

*BOUNDARY_PRESCRIBED_MOTION_NODEVelocity

Type 1; Card 26;

VAD = 0

Define an imposed nodal motion (velocity,
acceleration, or displacement) on a node or a set
of nodes.

DOF 4, -4, 8, -8, 9, -9, 10, -10, 11, -11 are not
supported

*BOUNDARY_PRESCRIBED_MOTION_NODEAcceleration

Type 1

Card 26

VAD = 1

Define an imposed nodal motion (velocity,
acceleration, or displacement) on a node or a set
of nodes.

DOF 4, -4, 8, -8, 9, -9, 10, -10, 11, -11 are not
supported

*BOUNDARY_PRESCRIBED_MOTION_NODE_(ID)Velocity

*BOUNDARY_PRESCRIBED_MOTION_NODE_(ID)Constraints

Type 2; Card 26,
VAD = 2

dynaName

DEATH

BIRTH

*BOUNDARY_PRESCRIBED_MOTION_RIGIDPID

DOF

VAD

LCID

SF

VID

DEATH

BIRTH

Define an imposed nodal motion (velocity,
acceleration, or displacement) on a node or a set
of nodes.

RIGID_LOCAL and _SET options are supported.

*BOUNDARY_PRESCRIBED_MOTION_RIGID_IDDyna_Name

PID

DOF

VAD

LCID

SF

Define an imposed nodal motion (velocity,
acceleration, or displacement) on a node or a set
of nodes.
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Card Supported Load Types Description

VID

DEATH

BIRTH

*BOUNDARY_PRESCRIBED_MOTION_RIGID_LOCALPID

DOF

VAD

LCID

SF

VID

DEATH

BIRTH

Title

*BOUNDARY_PRESCRIBED_MOTION_RIGID_LOCAL_IDDyna_Name

PID

DOF

VAD

LCID

SF

VID

DEATH

BIRTH

*BOUNDARY_PRESCRIBED_MOTION_SETNSIDDOF

VAD

LCID

SF

VID

DEATH

BIRTH

TITLE

Define an imposed nodal motion (velocity,
acceleration, or displacement) on a node or a set
of nodes.

*BOUNDARY_PRESCRIBED_MOTION_SET_IDDyna_Name

NSID

DOF

VAD

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.169

Card Supported Load Types Description

LCID

SF

VID

DEATH

BIRTH

*BOUNDARY_SPC_NODE Constraints

Type 1; Card 13
SPC

CID

Define nodal single point constraint

*BOUNDARY_SPC_NODE_(ID)Constraints

dynaName

CID

*BOUNDARY_TEMPERATURE_NODETemperature

LCID

LOC

Define temperature boundary conditions for a
thermal or coupled thermal/structural analysis.

*CONSTRAINED_GLOBAL Constraints Define a global boundary constraint plane.

*INITIAL_TEMPERATURE_NODETemperatures

LOC

Define initial nodal point temperatures using nodal
set IDs or node number.s

*INITIAL_VELOCITY Type 2

Card 30

INITV = 3

Define initial nodal point translational velocities
using nodal set IDs.

For structured output, global velocity is set to 0.0.
For structured input, non-zero values for INITV =
1 or INITV = 5 create velocities. INITV values of 2,
4, 6, and 7 are ignored.

*INITIAL_VELOCITY_NODERotation Define initial nodal point velocities for a node.

*LOAD_BEAM_ELEMENT Pressure Defines load on beam elements

*LOAD_MASK N/A Apply a distributed pressure load over a three-
dimensional shell part

*LOAD_NODE_POINT Force

Type 1

Card 23

Apply a concentrated nodal force to a node or a
set of nodes.

LS-DYNA Load Configs 1, 2, 3 and 4
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Card Supported Load Types Description

Point Loads

FollowerForce

A load curve can be selected for these loads.

*LOAD_NODE_POINT Moment

Type 1

Card 23

Point Loads

Apply a concentrated nodal force to a node or a
set of nodes.

LS-DYNA Load Configs 5, 6 7 and 8.

*LOAD_SEGMENT Pressure

LCID

AT

Apply the distributed pressure load over one
triangular or quadrilateral segment defined by
four, six or eight nodes.

*LOAD_SEGMENT_ID Pressure

LCID

AT

Apply the distributed pressure load over one
triangular or quadrilateral segment defined by
four, six or eight nodes.

*LOAD_SHELL_ELEMENT Pressure

AT

LCIDoption

Apply the distributed pressure load over one shell
element or shell element set.

*LOAD_SHELL_ELEMENT_IDPressure

LCID

AT

Apply the distributed pressure load over one shell
element or shell element set.

*LOAD_SHELL_PRESSUREPressure

Type 2

Card 24

Pressure BC

Apply the distributed pressure load over one shell
element or shell element set.

*LOAD_THERMAL_CONSTANT_NODETemperature

N/A

Define nodal sets giving the temperature
that remains constant for the duration of the
calculation.

*LOAD_THERMAL_VARIABLE_NODETemperature

TS

Define nodal temperature that is variable during
the calculation.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.171

Card Supported Load Types Description

LCID

Nastran Cards

Note:  Other loads such as SPCADD, MPCADD, FREQ, FREQ1, EIGR, EIGRL, EIGC, EIGP,
EIGB, GRAV, and RFORCE are supported as load collectors.

Card Supported Load Types Description

ASET Constraints Defines degrees-of-freedom in the analysis set (a-
set)

ASET1 Constraints Defines degrees-of-freedom in the analysis set (a-
set)

BNDFIX1 Constraints Defines analysis set (a-set) degrees-of-freedom
to be fixed (b-set) during generalized dynamic
reduction or component mode synthesis
calculations.

BOLTFOR Flux

BSET1 Constraints Defines analysis set (a-set) degrees-of-freedom
to be fixed (b-set) during generalized dynamic
reduction or component mode synthesis
calculations.

CSET1 Constraints Defines analysis set (a-set) degrees-of-freedom
to be free (c-set) during generalized dynamic
reduction or component modes calculations.

DAREA Constraints Defines scale (area) factors for static and dynamic
loads. In dynamic analysis, DAREA is used in
conjunction with RLOADi and TLOADi entries.

DEFORM Flux Defines enforced axial deformation for one-
dimensional elements for use in statics problems.

FORCE Force Requests the form and type of element force
output or particle velocity output in coupled fluid-
structural analysis.

MOMENT Moment Defines a static concentrated moment at a grid
point by specifying a scale factor and a vector that
determines the direction.
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Card Supported Load Types Description

OMIT1 Constraints Defines degrees-of-freedom to be excluded (o-set)
from the analysis set (a-set).

PLOAD Pressure Defines a uniform static pressure load on a
triangular or quadrilateral surface comprised
of surface elements and/or the faces of solid
elements.

PLOAD1 Pressure Defines concentrated, uniformly distributed, or
linearly distributed applied loads to the CBAR or
CBEAM elements at user-chosen points along the
axis.

PLOAD2 Pressure Defines a uniform static pressure load applied to
CQUAD4, CSHEAR, or CTRIA3 two-dimensional
elements.

The THRU field is supported for feinput only. On
export, additional pressure cards for the range
specified are written.

PLOAD4 Pressure Defines a pressure load on a face of a CHEXA,
CPENTA, CTETRA, CTRIA3, CTRIA6, CTRIAR,
CQUAD4, CQUAD8, or CQUADR element.

The THRU field is supported for feinput only. On
export, additional pressure cards for the range
specified are written.

Unequal nodal pressures are now supported.
The average pressure value is used as the
magnitude of the pressure for visualization only.
The individual field values, P1-P4, can be viewed
or edited using the card editor.

Updating the magnitude of pressure from the
Pressures panel will have no effect on PLOAD4
cards defined using unequal nodal pressures.

QBDY1 Flux Defines a uniform heat flux into CHBDYj elements.

QSET1 Constraints Defines generalized degrees-of-freedom (q-set)
to be used for generalized dynamic reduction or
component mode synthesis.

QVOL Flux Volume Heat Addition - Defines a rate of
volumetric heat addition in a conduction element.
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Card Supported Load Types Description

SPC Constraints Defines a set of single-point constraints and
enforced motion (enforced displacements in static
analysis and enforced displacements, velocities or
acceleration in dynamic analysis).

Constraints on nodes are supported through SPC
cards. PS field in GRID card is not supported.
Upon import, any PS entry on the GRID card will
be converted into an SPC card.

SPC1 Constraints Defines a set of single-point constraints.

Supported for feinput only. On export, equivalent
SPC cards are written. Alternate format with THRU
in the fifth field is supported.

SPCD Constraints Defines an enforced displacement value for
static analysis and an enforced motion value
(displacement, velocity or acceleration) in dynamic
analysis.

SUPORT Constraints Defines determinate reaction degrees-of-freedom
in a free body.

SUPORT1 Constraints Defines determinate reaction degrees-of-freedom
(r-set) in a free body-analysis. SUPORT1 must
be requested by the SUPORT1 Case Control
command.

TIC(D) Constraints Transient Initial Condition - Defines values for the
initial conditions of variables used in structural
transient analysis.

TIC(V) Constraints Transient Initial Condition - Defines values for the
initial conditions of variables used in structural
transient analysis.

TEMP Temperatures Defines temperature at grid points for
determination of thermal loading, temperature-
dependent material properties, or stress recovery.

TEMPBC Temperatures Defines the temperature boundary conditions for
heat transfer analysis.

USET Constraints Defines a degree-of-freedom set.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.174

Card Supported Load Types Description

USET1 Constraints Defines a degrees-of-freedom set.

OptiStruct Cards
General boundary conditions, such as loads and constraints, should not be collected into specific
load collectors. Organizing loads and constraints into a specific load collector may result in an error
termination.

Card Supported Load Types Description

ASET Constraints Defines the boundary degrees-of-freedom of a
superelement assembly for matrix reduction.

ASET1 Constraints Defines the boundary degrees-of-freedom of a
superelement assembly for matrix reduction.

DAREA Constraints Defines scale (area) factors for dynamic loads.
DAREA is used in conjunction with RLOAD1, RLOAD2,
TLOAD1, and TLOAD2 entries.

DELAY Constraints Defines the time delay term τ in the equations
of the dynamic loading function. DELAY is used
in conjunction with RLOAD1, RLOAD2, TLOAD1, and
TLOAD2 entries.

DEFORM Flux Defines enforced axial deformation for one-
dimensional elements for use in statics problems.

DPHASE Constraints Defines the phase lead term  in the equation of
the dynamic loading function. DPHASE is used in
conjunction with RLOAD1 and RLOAD2 entries.

FORCE Force Defines a static force at a grid point or a SET of
grid points by specifying a vector.

FORCE1 Force Used to define a static force by specification
of a value and two grid points that determine
the direction. It can also be used to define the
EXCITEID field (Amplitude "A") of dynamic loads
in RLOAD1, RLOAD2, TLOAD1 and TLOAD2 Bulk Data
Entries. Additionally, the FORCE1 entry can be
defined as Follower Loads in Large Displacement
Nonlinear Analysis.
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Card Supported Load Types Description

MBFRC Force Defines a constant force at a grid point by
specifying a vector.

MBFRCC Force Defines a curve force at a grid point by specifying
a vector.

MBMNT Moment Defines a constant moment at a grid point by
specifying a vector.

MBMNTC Moment Defines a curve moment at a grid point by
specifying a vector.

MOMENT Moment Defines a static moment at a grid point or a SET of
grid points by specifying a vector.

MOMENT1 Moment Defines a static moment by specification of a
value and two grid points, which determine
the direction. It can also be used to define the
EXCITEID field (Amplitude A) of dynamic loads in
RLOAD1, RLOAD2, TLOAD1 and TLOAD2 Bulk Data
Entries.

MOTNG Constraint Defines a constant grid point motion.

MOTNGC Constraint Defines a grid point motion vs. time by specifying
a curve.

PLOAD Pressure Defines a static pressure load on a triangular
or quadrilateral element. It can also be used
to define the EXCITEID field (Amplitude "A") of
dynamic loads in RLOAD1, RLOAD2, TLOAD1 and
TLOAD2 Bulk Data Entries.

PLOAD1 Pressure Defines concentrated, uniformly distributed, or
linearly distributed applied loads to the CBAR or
CBEAM elements or a SET of such elements at
user-chosen points along the axis. It can also be
used to define the EXCITEID field (Amplitude "A")
of dynamic loads in RLOAD1, RLOAD2, TLOAD1 and
TLOAD2 Bulk Data Entries.

PLOAD2 Pressure Defines a uniform static pressure load applied
to two-dimensional elements, or a SET of such
elements.

PLOAD4 Pressure Defines a load on a face of a HEXA, PENTA, TETRA,
PYRA, TRIA3, TRIA6, QUAD4, or QUAD8 element.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.176

Card Supported Load Types Description

It can also be used to define the EXCITEID field
(Amplitude "A") of dynamic loads in RLOAD1,
RLOAD2, TLOAD1 and TLOAD2 Bulk Data Entries.
Additionally, the PLOAD4 entry can be defined as
Follower Loads in Large Displacement Nonlinear
Analysis.

QBDY1 Flux Defines a uniform heat flux for CHBDYE elements.

QVOL Flux Defines a rate of volumetric heat addition in a
conduction element.

SPC Constraint Defines sets of single-point constraints, enforced
displacements for static analysis, and thermal
boundary conditions for heat transfer analysis.

SPCD Constraint Defines an enforced displacement value for static
analysis, an enforced displacement, velocity or
acceleration for dynamic analysis and a thermal
boundary condition for heat transfer (or transient
heat transfer) analysis. It can also be used to
define the EXCITEID field (Amplitude "A") of
dynamic loads in RLOAD1, RLOAD2, TLOAD1 and
TLOAD2 Bulk Data Entries.

SUPORT Constraint Defines determinate reaction degrees-of-freedom
in a free body.

SUPORT1 Constraint Defines determinate reaction degrees-of-freedom
in a free body.

TEMP Temperature Defines temperature at grid points or a SET of grid
points for determination of Thermal Loading and
Stress recovery.

TIC(D) or (V) Constraint Defines values for the initial conditions of variables
used in structural transient analysis and explicit
analysis. Both displacement and velocity values
may be specified at independent degrees-of-
freedom.

USET Constraint Defines a set of degrees-of-freedom.
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Card Supported Load Types Description

USET1 Constraint Defines a set of degrees-of-freedom.

PAM-CRASH Cards

Card Supported Load Types Description

ACC3D / Acceleration Imposed accelerations

BOUNC / Constraints Define boundary condition

CONLO / Force(1) Concentrated nodal load

DIS3D / Constraints Imposed displacement

DIS3DM / Constraints Imposed minimum displacement

DIS3DX / Constraints Imposed maximum displacement

INVEL / Velocity Define initial velocity

PREFA / Pressure(1) Pressure on shells

RAC3D / Acceleration Imposed rotational acceleration

RAN3D / Constraints Imposed angular rotations

RDA3D / Acceleration Radial 3D boundary conditions

RDD3D / Constraints

RDV3D / Velocity Radial 3D boundary conditions

RVE3D / Velocity Imposed rotational velocities

RWALL / Rigid wall definition

SECFO_PLANE /
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Card Supported Load Types Description

VEL3D / Velocity Imposed velocities

Permas Cards

Card Supported Load Types Description

$ADDMODES Constraints Definition of static mode shapes to be added to
the set of eigenmodes used for transformation to
modal space.

If static mode shapes will be added directly
to nodes or nodesets (SOURCE=INPUT), the
$ADDMODES can be created through the
Constraints panel.

Click sysid to specify the system regarding to
which the modes shall be applied.

Use the DOFTYPE button to select an option: DISP,
TEMP, PRES, POTE and MATH.

$ADDMODES Pressure Definition of static mode shapes to be added to
the set of eigenmodes used for transformation to
modal space.

If mode shapes will be applied based on the
natural deformation of elements (SOURCE=INPUT)
the $ADDMODES keyword needs to be created
here.

$CONLOAD Force Definition of concentrated loads at nodal point
degrees of freedom.

$CONLOAD Moment Definition of concentrated loads at nodal point
degrees of freedom.

$DISLOAD PRESS Pressure Definition of pressure loads for elements, where
loads are given for elements or element sets.

Applicable to shells and solids, but also
axisymmetric solid elements. Therefore please
apply a pressure on an HM shell element. Face
identifiers are written in this case. On import IDS
ELNODES or NODES will be resolved into ELGEO
(face identifiers).
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Card Supported Load Types Description

$DISLOAD TEMP Pressure Nodal temperatures defined on elements or
element sets.

$DISLOAD TEMPFILM Pressure Surrounding temperatures for convective heat
transfer applied on elements or element sets.

$DISLOADN TEMP Temperature Nodal temperatures definition applied on nodes or
node sets

$DISLOADN TEMPFILM Temperature Surrounding temperatures for convective heat
transfer applied on nodes or node sets.

$INIVAL Constraints Definition of initial values for nodal point degrees
of freedom.

For $INIVAL source parameter INPUT is currently
supported to specify the initial values based on
nodal points.

$INERTIA Pressure Definition of inertia forces acting on entire
component or element sets. Available are force
distributions due to linear acceleration, constant or
accelerated rotation and coriolis acceleration.

Only ACCELERATION and GRAVITY are supported.
This card is created in the Pressure panel. Assign
to a set of elements, and the set statement
displays in the card image. To create the card
without a set, create a pressure on a 'dummy'
element; the card will be created without a set
and can be applied to the whole model.

$INERTIAX Pressure Definition of inertia forces acting on entire
axisymmetric component or element sets.
Available are force distributions due to linear
acceleration and constant rotation.

Only ACCELERATION and GRAVITY are supported.
This card is created in the Pressure panel. Assign
to a set of elements, and the set statement
displays in the card image. To create the card
without a set, create a pressure on a 'dummy'
element; the card will be created without a set
and can be applied to the whole model.

$MPC GENERAL/
$MPCVAL

Equation Multipoint constraint definition.
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Card Supported Load Types Description

Both cards are created simultaneously in the
Equation panel.

The equation needs to be placed into a load
collector with card image SUPRESS.

By attaching the load collector to a load step
with ‘CONSTRAINTS’ attribute set, the $MPCVAL
card gets written in the desired $CONSTRAINTS
variant.

$PRESCRIBE/ PREVAL Constraints Prescribed degrees of freedom/Nodal point values
(implemented as HyperMesh constraints)

$SUPPRESS Constraints Suppressed degrees of freedom

Samcef Cards

Card Supported Load Types Description

.CLM FIX Constraint Defines a set of single-point constraints

.CLM DEP Constraint Defines sets of enforced displacements

.CLM CHA COMP 123 Force Defines a static force at a grid point by specifying
a vector and a value.

.CLM FOL COMP 123 Force Defines a follower force at a grid point by
specifying a vector and a value

.CLM CHA COMP 456 Moment Defines a static moment at a grid point by
specifying a vector and a value.

.CLM FOL COMP 456 Moment Defines a follower moment by specifying a vector
and a value
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Card Supported Load Types Description

.CLM PRESSURE Pressure Defines a static pressure load on any elements
type

Equations
Equation entities contain mathematical equations that define more complex loads. They are used to
define linear constraints in local and global coordinate systems.

Every equation must be organized into one load collector, and therefore are mutually exclusive to a load
collector.

Equations are displayed as lines between the dependent node and the independent node(s) with EQ
displayed at the dependent node of the equation in the modeling window.

Equations are used in Nastran as MPC (Multipoint Constraint Equation) or in Abaqus as *equation.

Equations are organized into load collectors.

Abaqus Cards
Loads or constraints that are to be used as history data (under *STEP) should be collected into
load collectors with the HISTORY card image. These load collectors also need to be added to the
corresponding load steps (*STEP). In contrast, loads or constraints for model data should be collected
into load collectors with INITIAL_CONDITION card image. They will automatically be written out in the
model portion of the Abaqus input deck.

Note:  All loads and boundary conditions on sets can be expanded to individual nodes and
elements by selecting the Expand load on sets option in the File Options dialog, which
is invoked upon importing a solver deck. If a **HMLOAD_SETS_EXPAND comment is found
in the input file, all loads and boundary conditions on sets are expanded to individual nodes
and elements.

Card Description

*EQUATION Define linear multi-point constraints.
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Card Description

Note:  Explicit node IDs are supported. Node sets are not
supported.

Equations are considered as loads and therefore, they are
collected in load collectors. Upon export, they write to the bulk
data portion of the Abaqus deck.

ANSYS Cards

Card Description

CE Defines a constraint equation relating to degrees of freedom.

LS-DYNA Cards
Several load types cause three cards to be output for x, y, and z components. During input, these are
grouped into one load. Loads cannot be applied to sets, components, or boxes. Load curves are input
and output. Use the Card Editor to select load curves. Unless mentioned in the Notes column, load cards
cannot be edited.

Card Description

*CONSTRAINED_LINEAR Define linear constraint equations between displacements and rotations,
which can be defined in a local coordinate system.

*CONSTRAINED_LINEAR_GLOBALDefine linear constraint equations between displacements and rotations,
which can be defined in global coordinate systems.

Nastran Cards

Note:  Other loads such as SPCADD, MPCADD, FREQ, FREQ1, EIGR, EIGRL, EIGC, EIGP,
EIGB, GRAV, and RFORCE are supported as load collectors.

Card Description

MPC Defines a multipoint constraint equation of the form.
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Card Description

Note:  Individual weight factors can be created on the nodes of
an MPC equation using the update functionality in the Equations
panel.

OptiStruct Cards

Card Description

MPC Defines a multipoint constraint equation of the form.

Note:  Bulk Data Entry

Permas Cards

Card Description

$MPC GENERAL General linear constraint equation.

Part Assemblies and Parts
HyperMesh supports CAE and PDM parts and part assemblies. CAE parts and part assemblies can
be imported into HyperMesh, or can be manually created in the Part Browser. PDM parts and part
assemblies can be imported into HyperMesh via a PDM generated PLMXML file. You cannot modify or
delete any part assembly or part level entities.

Part Assemblies
Part assemblies collect and organize sub part assemblies and/or parts.

A part assembly can temporarily contain a component if it does not contain part assemblies or parts.
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You can create, review, and edit part assemblies in the Part Browser.

Parts
A part represents and organizes subsystems of a physical part into a hierarchal data structure, which
reflects the data structure of the product being modeled.

Parts can be organized into a part assembly in the Part Browser. A part can only contain components.

You can create, review, and edit parts in the Part Browser.

System Collectors and Systems

System Collectors
System collectors collect and organize systems.

LS-DYNA Cards
System collector cards can be previewed, but not edited.

Card Description

*DEFINE_TRANSFORMATIONDefine a transformation for the INCLUDE_TRANSFORM keyword option.

Note:  Transformations can be created using the Transformation
Manager.

*INCLUDE_PATH Defines path for the include file location.

Note:  Card Edit is not available. Keyword details can be
accessed from the Include file options in the Include browser.

*INCLUDE_STAMPED_PARTAttaches a file that has stamping results for a part in the model as an
include file.

Note:  Card Edit is not available. Keyword details can be
accessed from the Include file options in the Include browser.

*INCLUDE_STAMPED_PART_SETAttaches a file that has stamping results for a collection of parts (set) in the
model as an include file.
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Card Description

Note:  Card Edit is not available. Keyword details can be
accessed from the Include file options in the Include browser.

*INCLUDE_TRANSFORM Include file that supports offset on its content IDs and transforms on its
contents.

Note:  HyperMesh support offset on the entity ID's. During
import, offsets are applied on to the ID's of the corresponding
include_transform file contents. During export, offset is
subtracted from the ID's. The current release only supports
Input and output therefore the offsets cannot be changed.

*NODE_TRANSFORM Transformation defined on node set.

Note:  Transformations can be created using the Transformation
Manager.

PAM-CRASH Cards

Card Description

TRANSFORMATION /

Radioss Cards

Card Description

/TRANSFORM/ROT Defines a rotation for a node group around a defined axis, center of rotation
and rotation angle.

Note:  Block Format Keyword

/TRANSFORM/TRA Defines a translation for a node group with a defined vector.

Note:  Block Format Keyword

/TRANSFORM/SCA Defines a scale for a node group with defined scale center and scale factor.
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Card Description

Note:  Block Format Keyword

/TRANSFORM/SYM Defines a symmetry for a node group normal to the plane defined by a
vector.

Note:  Block Format Keyword

Systems
System entities, commonly called coordinate systems, can be defined as rectangular, cylindrical, or
spherical coordinate systems.

Every system must be organized into one system collector, and therefore are mutually exclusive to a
system collector.

Several systems may be nested. There are two types of system assignments to entities; as a reference
system, or as a displacement system. A system may be a reference system, a displacement system, or
both.

Reference System
Defines the geometric positions of entities.
Entities that can be assigned a reference system include systems, nodes, and loads. By default,
each of these entities is defined in the global system with an ID of zero. Entity data is always
displayed and reviewed transformed into the global system. When a reference system is deleted,
the position of the entity assigned that reference system is maintained relative to the global
system in the transformation process. For example, if you define the nodes of a cylindrical
structure in a cylindrical reference coordinate system, and then delete the cylindrical reference
coordinate system in which the nodes are defined, the model retains its cylindrical shape and also
its location in space but is now referenced to the global system.

Displacement System
Defines the nodal degree of freedom coordinate system assigned to a node.
The only entity that may be assigned a displacement system is a node. When you delete a
displacement system, the nodal degrees of freedom are not transformed to the global system, so
all degree of freedom definitions after the deletion of the displacement system are now simply in
the global system.

Abaqus Cards
A system can be exported as a *SYSTEM or *TRANSFORM card depending on the nodal assignment of
the system. To export an *ORIENTATION card it is required to enable the option in the card image of
the system card.
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Card Description

*ORIENTATION Define a local axis system for material or element property definition, for
kinematic coupling constraints, for free directions for inertia relief loads, or
for connectors.

Note:  The *ORIENTATION card needs a name in Abaqus. Since
systems do not have a name, a name needs to be entered in the
system card image. The restriction of one system per system
collector has been removed with version 10.0 – SA1-130.

DEFINITION = NODES option with only two nodes is converted
to DEFINITION=COORDINATES upon import from an input file.

*ORIENTATION with SYSTEM = Z RECTANGULAR is converted to
RECTANGULAR upon import from an input file.

*SYSTEM Specify a local coordinate system in which to define nodes.

Note:  Whenever a system is assigned to nodes with the set
reference option from the Systems panel activated, a *SYSTEM
card is exported before the node block of its assignment.

*TRANSFORM Specify a local coordinate system at nodes.

Note:  If assigned to individual nodes, on export each
*TRANSFORM card creates references to an automatically
generated *NSET card. This *NSET card is followed by the list of
the nodes that are assigned to the coordinate system with the
set displacement option.

Systems can be assigned to node sets with the same assignment
procedure.

ANSYS Cards

Card Description

LOCAL Defines a local coordinate system by location and orientation.

Note:  Even if KCN>10, 10 is added to the current value.

LOCAL Defines a local coordinate system by location and orientation.
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Card Description

Note:  Type = PRM not supported

EXODUS Cards

Card Description

Coordinate Frame Defined for reference to materials and boundary conditions.

LS-DYNA Cards
Systems cards can be previewed, but not edited.

Card Description

*DEFINE_COORDINATE_NODESDefine a local coordinate system with three nodes.

*DEFINE_COORDINATE_SYSTEMDefine a local coordinate system with three points.

*DEFINE_COORDINATE_VECTORDefine a local coordinate system with two vectors.

Nastran Cards

Card Description

CORD1R Defines a rectangular coordinate system using three grid points.

CORD2R Defines a rectangular coordinate system using the coordinates of three
points.

CORD1C Defines a cylindrical coordinate system using three grid points.

CORD2C Defines a cylindrical coordinate system using the coordinates of three points.

CORD1S Defines a spherical coordinate system by reference to three grid points.
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Card Description

CORD2S Defines a spherical coordinate system using the coordinates of three points.

OptiStruct Cards

Card Description

CORD1C Defines a cylindrical coordinate system using three grid points. The first
point is the origin, the second lies on the Z-axis, and the third lies in the X-Z
plane.

Note:  Bulk Data Entry

Created from the create by node reference subpanel when
cylindrical is the chosen type.

CORD1R Defines a rectangular coordinate system using three grid points. The first
point is the origin, the second lies on the Z-axis, and the third lies in the X-Z
plane.

Note:  Bulk Data Entry

Created from the create by node reference subpanel when
rectangular is the chosen type.

CORD1S Defines a spherical coordinate system using three grid points. The first point
is the origin, the second lies on the Z-axis, and the third lies in the X-Z
plane.

Note:  Bulk Data Entry

Created from the create by node reference subpanel when
spherical is the chosen type.

CORD2C Defines a cylindrical coordinate system using three grid points specified with
respect to a reference coordinate system. The coordinates of the three non-
collinear grid points are used to uniquely define the coordinate system. The
first point is the origin, the second lies on the Z-axis, and the third lies in
the X-Z plane.
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Card Description

Note:  Bulk Data Entry

Created from the create by axis direction subpanel when
cylindrical is the chosen type.

Various combinations of axes and planes are allowed to be
indicated in the create by axis direction subpanel, but will write
out the appropriate coordinates to define the z- axis and the x-z
plane.

CORD2R Defines a rectangular coordinate system by using three grid points. The
coordinates of the three non-collinear grid points are used to uniquely define
the coordinate system. The first point is the origin, the second lies on the Z-
axis, and the third lies in the X-Z plane.

Note:  Bulk Data Entry

Created from the create by axis direction subpanel when
rectangular is the chosen type.

Various combinations of axes and planes are allowed to be
indicated in the create by axis direction subpanel, but will write
out the appropriate coordinates to define the z- axis and the x-z
plane.

CORD2S Defines a spherical coordinate system three grid points. The coordinates of
the three non-collinear grid points are used to uniquely define the coordinate
system. The first point is the origin, the second lies on the Z-axis, and the
third lies in the X-Z plane.

Note:  Bulk Data Entry

Created from the create by axis direction subpanel when
spherical is the chosen type.

Various combinations of axes and planes are allowed to be
indicated in the create by axis direction subpanel, but will write
out the appropriate coordinates to define the z- axis and the x-z
plane.

CORD3R Defines a rectangular coordinate system using three grid points. The first
point is the origin, the second lies on the X-axis, and the third lies in the X-Y
plane.
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Card Description

Note:  Bulk Data Entry

Created from the create by node reference subpanel when
rectangular is the chosen type.

CORD4R Defines a rectangular coordinate system using three grid points specified
with respect to the basic coordinate system. The coordinates of the three
non-collinear grid points are used to uniquely define the coordinate system.
The first point is the origin, the second lies on the X-axis, and the third lies
in the X-Y plane.

Note:  Bulk Data Entry

Created from the create by axis direction subpanel when
rectangular is the chosen type.

Various combinations of axes and planes are allowed to be
indicated in the create by axis direction subpanel, but will write
out the appropriate coordinates to define the z- axis and the x-z
plane.

Editing the card image for a CORD2R will allow you to define a
CORD4R.

PAM-CRASH Cards

Card Description

FRAME / Local frame definition - system collectors

Note:  If there is a $HMMOVE directive found for a system and
that system collector exists in the model, the system is placed in
that collector. Otherwise, a separate system collector is made for
the frame.

FRAME / Local frame definition - systems

Note:  If a base node is not given, system is created at the
global origin 0, 0, 0. In case of frame definition with nodes,
system is created at the first node.
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Card Description

TRSFM / Select elements and nodes subject to transformation.

Permas Cards

Card Description

$RSYS Reference system

Note:  Assign the system to nodes to write the RSYS parameter
in to the nodal coordinates card $COORD.

$ROTB Analysis or displacement system assigned to nodes.

Note:  Assign a system as displacement system to nodes to
receive this card.

Radioss Cards

Card Description

/FRAME/FIX Describes the frames.

Note:  Block Format Keyword

/FRAME/MOV Describes moving frames. Relative motion with respect to a reference frame.

Note:  Block Format Keyword

/FRAME/MOV2 Describes moving frames. Relative motion with respect to a reference frame.
Moving frame definition differs from /FRAME/MOV.

Note:  Block Format Keyword

/FRAME/NOD Describes the node defined moving frame.

Note:  Block Format Keyword
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Card Description

/SKEW/FIX Describes the fixed skew frames.

Note:  Block Format Keyword

/SKEW/MOV Describes a moving local coordinate system.

Note:  Block Format Keyword

/SKEW/MOV2 Describes a moving local coordinate system.

Note:  Block Format Keyword

Samcef Cards

Card Description

.FRA Coordinate system definition

Note:

I frame_nr TYPE chosen_frame_type

ORIGIN frame_origin

V1 axis_definition V2 axis_definition V3 axis_definition

Vector Collectors and Vectors

Vector Collectors
Vector collectors collect and organize vectors.

Nastran Cards
Vectors can be used to define orientation directions for some 1D elements and forces, or to define the
SNORM card. For orientation vectors, it is not necessary to load any card image data onto the vector
collector. For SNORM vectors, you must load the SNORM card image onto the vector collector. Once this
is done, all vectors organized into that vector collector will write out as SNORM vectors to the Nastran
bulk data file.
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Card Description

SNORM Defines a surface normal vector at a grid point for CQUAD4, CQUADR,
CTRIA3, and CTRIAR shell elements.

Note:  There is no card image associated with the collector. In
order to view the actual SNORM cards, each vector must be
individually card edited. Loading the SNORM card image onto
the collector assigns the SNORM type onto all of the vectors
contained in that collector.

PAM-CRASH Cards

Card Description

ADAPT /

PICK /

SUBDF / Substructure definition

Vectors
Vector entities allow for the definition of a vector in 3D space. Vectors can be created using three
methods; base & magnitude, two nodes, or cross-product.

LS-DYNA Cards

Card Description

*DEFINE_SD_ORIENTATIONDefine orientation vectors for discrete springs and dampers.
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Card Description

*DEFINE_VECTOR Define a vector by defining the coordinates of two points.

Beamsection Collectors and Beamsection

Beamsection Collectors
Beamsection collectors collect and organize beamsections and are used in HyperBeam to organize 1D
beam section data.

Nastran Cards

Card Description

BELTS / Output activation and format/file selection for kinematic animation output.

Beamsections
Beamsection entities store 1D beam cross-section data.

Beamsections can be created from geometry, elements, or from solver standard sections, that is, I-
Sections, H-Sections, and so on.

All sections can be created and modified in HyperBeam. Generic sections and Standard sections can also
be created in the Model Browser and modified in the Property Editor.

The default section type and attribute values assigned to beam section vary based on solver interface.

On import, each 1D beam property card within a solver deck is automatically imported as a
beamsection entity and a property entity with associated beamsection. The beamsection entity holds
the 1D beam section data (A, I, and so on..., and/or Dimensions) and is associated to the property
entity which has a 1D property card image. The beamsection association to a property is what transfers
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the 1D section data to the 1D property solver card for export. Editing of all 1D beam section data is
accomplished through HyperBeam.

Generic Sections
Generic sections define sections without defining actual cross-section geometry. Areas, inertias,
centroids, and other coefficients are supported directly through spreadsheet data entry of values.

Shell Sections
Shell sections define thin cross-sections with geometric lines or 1D elements. Once the cross-section is
created, it can be further edited in HyperBeam.

Figure 76:

Solid Sections
Solid sections to define solid cross-sections with surfaces, lines that form a closed loop, or 2D elements.
Once the cross-section is created it can be further edited in HyperBeam.
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Figure 77:

Standard Sections
Standard sections to define solver supported cross-sections. Each supported solver interface has a
library of supported solver cross-sections. For standards sections, only the dimensions of the section are
necessary as input.
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Figure 78:

Bags
Bags collect and organize entities.

Operations performed on a bag do not affect the entities collected within the bag. For example, if you
delete a bag, the entities collected within the bag are not deleted.

The entities that are permissible for a bag entity to collect are determined by the configuration of the
bag.

Currently, only the optimization configuration of bag entity can be created, edited, and deleted.
Optimization problem configurations of the bag entity can be created, edited, and deleted in the Model
Browser Optimization View.

All other configurations of bag entities can be created, edited, and deleted using the Tcl Modify
Commands *bagcreate and *bagentityupdate.

Generic
Configuration 1 - Collect and organize any entities, including other bag entities.

Optimization Problem
Configuration 2 - Collect and organize Optimization entities.

• Design Variables

• Design Variable Links

• Objective

• Design Variable Property Relationships
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• Objective References

• Optimization Constraints

• Optimization Constraint Screenings

• Optimization Controls

• Optimization Equations

• Optimization Responses

• Optimization Table Entries

• Discrete Design Variables

FBD Forces (All Loads)
Configuration 3 - Collect and organize nodes, element sets, systems, and load collectors.

FBD Forces (Applied Loads Only)
Configuration 4 - Collect and organize nodes, element sets, systems, and load collectors.

FBD Forces (Reaction Loads Only)
Configuration 5 - Collect and organize nodes, element sets, systems, and load collectors.

FBD Displacements
Configuration 6 - Collect and organize node sets, element sets, systems, and load collectors.

Resultant Force & Moment
Configuration 7 - Collect and organize systems, load collectors, and FBD cross-section bag entities.

FBD Cross-section
Configuration 8 - Collect and organize nodes, node sets, element sets, and systems.

ADM Part
Configuration 9 - Collect and organize any entities, including other bag entities.

ADM Material
Configuration 10 - Collect and organize any entities, including other bag entities.

Multibodies
Multibodies collect and organize ellipsoids, multibody planes, and multibody joints and are typically used
in multi-body analysis.

Ellipsoids, multibody planes, and multibody joints can be organized into a multibody using the Organize
panel. Every ellipsoid, multibody plane, and multibody joint must be organized into one, and only one,
multibody and therefore are mutually exclusive to a multibody. Newly created ellipsoids, multibody
planes, and multibody joints are automatically organized into the current multibody.
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Operations performed on a multibody collector affect ellipsoids, multibody planes, and multibody joints
within the multibody collector. For example, if you delete a multibody collector, the ellipsoids, multibody
planes, and multibody jonts within the multibody collector are also deleted.

MADYMO

Card Description

BODY.DEFORMABLE Deformable body.

body local system and center of gravity are not used.

Enter the number of MODEs in MODE_LIST and select each applicable MODE
element.

Select the DAMPING check box to apply MODAL_DAMP.

BODY.FLEXIBLE_BEAM Flexible beam.

body local system and center of gravity are not used.

BODY.RIGID This element contains the information necessary to define a unique rigid
body: mass, inertia matrix and location of center of gravity.

body local system = ORIENT_INERTIA. If you 'use' the referenced system,
no system of a JOINT or BODY should be selected.

center of gravity = CENTRE_OF_GRAVITY

JOINT

SURFACE.CYLINDER Hyper-elliptical cylinder.

Ellipsoids
No solver support is currently supported for ellipsoids.

Multibody Planes

MADYMO

Card Description

SURFACE.PLANE Rectangular plane.

multibody = BODY

N1 = POINT_1
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Card Description

N2 = POINT_2

N3 = POINT_3

To create a SURFACE under the SYSTEM.REF_SPACE, a reference to a null
body must be selected because a reference to a multibody is required when
creating a multibody plane. A null body can be created like any other BODY
(card image is not relevant and should not be used), Nullbody should be put
under the SYSTEM.REF_SPACE assembly.

Multibody Joints

MADYMO

Card Description

JOINT.BRAC Card image = BRAC

JOINT.CYLI Card image = CYLI

D1 and R1 can not be changed, because they are defined by the position
and orientation of the systems connected by the JOINT.

JOINT.FREE Card image = FREE

D1 through D3, R1 through R3 and ORIENT can not be changed, because
they are defined by the position and orientation of the systems connected
by the JOINT. When importing a model containing non-zero values for Q1
through Q7, these values are translated into the values for displacement and
rotation; since no values for Q1 through Q7 can be set, no values will be
exported.

JOINT.FREE_BRYANT Card image = FREE

D1 through D3, R1 through R3 and ORIENT can not be changed, because
they are defined by the position and orientation of the systems connected
by the JOINT. When importing a model containing non-zero values for Q1
through Q7, these values are translated into the values for displacement and
rotation; since no values for Q1 through Q7 can be set, no values will be
exported.

JOINT.FREE_EULER Card image = FREE

D1 through D3, R1 through R3 and ORIENT can not be changed, because
they are defined by the position and orientation of the systems connected
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Card Description

by the JOINT. When importing a model containing non-zero values for Q1
through Q7, these values are translated into the values for displacement and
rotation; since no values for Q1 through Q7 can be set, no values will be
exported.

JOINT.FREE_ROT_DISP Card image = FREE_BRYANT

D1 through D3, R1 through R3 and ORIENT can not be changed, because
they are defined by the position and orietation of the systems connected by
the JOINT. Any JOINT.FREE_ROT_DISP is translated into a JOINT.FREE during
import of the model. When importing a model containing non-zero values for
Q1 through Q7, these values are translated into the values for displacement
and rotation; since no values for Q1 through Q7 can be set, no values will be
exported.

JOINT.PLAN Card image = PLAN

R1, D2 and D3 can not be changed, because they are defined by the position
and orientation of the systems connected by the JOINT.

JOINT.REVO Card image = REVO

R1 can not be changed, because it is defined by the position and orientation
of the systems connected by the JOINT.

JOINT.REVO_TRAN Card image = REVO_TRAN

D1 and R2 can not be changed, because they are defined by the position
and orientation of the systems connected by the JOINT.

JOINT.SPHE Card image = SPHE

R1 through R3 and ORIENT can not be changed, because they are defined
by the position and orientation of the systems connected by the JOINT.
When importing a model containing non-zero values for Q1 through Q4,
these values are translated into the values for rotation; since no values for
Q1 through Q4 can be set, no values will be exported.

JOINT.SPHE_BRYANT Card image = SPHE_BRYANT

R1 through R3 can not be changed, because they are defined by the position
and orientation of the systems connected by the JOINT.

JOINT.SPHE_EULER Card image = SPHE_EULER

R1 through R3 can not be changed, because they are defined by the position
and orientation of the systems connected by the JOINT.
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Card Description

JOINT.TRAN Card image = TRAN

D1 can not be changed, because it is defined by the position and orientation
of the systems connected by the JOINT.

JOINT.TRAN_REVO Card image = TRAN_REVO

D1 and R2 can not be changed, because they are defined by the position
and orientation of the systems connected by the JOINT.

JOINT.TRAN_UNIV Card image = TRAN_UNIV

D1, R2 and R3 can not be changed, because they are defined by the position
and orientation of the systems connected by the JOINT.

JOINT.UNIV Card image = UNIV

R1 and R2 can not be changed, because they are defined by the position and
orientation of the systems connected by the JOINT.

JOINT.UNIV_TRAN Card image = UNIV_TRAN

D1, R2 and R3 can not be changed, because they are defined by the position
and orientation of the systems connected by the JOINT.

JOINT.USER Card image = USER
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Named Entities
Entities which are given a name but are not collected or organized into containers.

Examples of named entities include materials and properties.

Some named entities also have a display state, on or off, which control the display of that entity in the
modeling window.

All named entities have active and export states. The active state of a named entity controls the display
state of the named entity and the listing of the named entity in the Model Browser.

The export state of a named entity controls the export of that entity to a solver deck. The active and
export states of named entities can be controlled in the Entity State Browser.

Accelerometers
Accelerometer entities measure acceleration in the simulation.

In the LS-DYNA interface, Accelerometer entities are defined by three nodes. The first node defines
the base point, and the other two nodes define a local coordinate system in which accelerations are
measured. There are additional fields that enable you to adding a mass or subtract the acceleration due
to gravity from the computed acceleration output.
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In the Radioss interface, Accelerometer entities are defined by a node and a local coordinate system of
type SKEW. This coordinate system is not mandatory. If it is not defined, accelerations are measured in
the global coordinate system, otherwise, in the defined local coordinate system

LS-DYNA Cards

Card Description

*ELEMENT_SEATBELT_ACCELEROMETERDefines a seat belt accelerometer.

Radioss Cards

Card Description

/ACCEL Defines an accelerometer.

Ale Fsi Projection
Ale Fsi Projection entities provide a coupling method for simulating the interaction between a
Lagrangian material set (structure) and ALE material set (fluid).

The nearest ALE nodes are projected onto the Lagrangian structure surface at each time step. This
method does not conserve energy, as mass and momentum are transferred via constrained based
approach.

LS-DYNA Cards

Card Description

*ALE_FSI_PROJECTION Provides a coupling between Lagrangian material set (structure) and ALE
material set (fluid).

Ale Reference System Curve
Ale Reference System Curve entities defines a motion and/or a deformation prescribed for a geometric
entity, where a geometric entity may be any part, part set, node set, or segment set.

The motion or deformation is completely defined by the 12 parameters & these are
defined in terms of 12 load curves. This command is required only when PRTYPE = 3 in the
*ALE_REFERENCE_SYSTEM_GROUP command

LS-DYNA Cards

Card Description

*ALE_REFERENCE_SYSTEM_CURVEMotion and/or a deformation prescribed for a geometric entity, where a
geometric entity may be any part, part set, node set, or segment set.

Ale Reference System Group
Ale Reference System Group entities used to associate a geometric entity to a reference system type.

A geometric entity may be any part, part set, node set, or segment set of a model (or a collection of
meshes). A reference system type refers to the possible transformation allowed for a geometric entity
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(or mesh). This command defines the type of reference system or transformation that a geometric
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entity undergoes. In other words, it prescribes how certain mesh can translate, rotate, expand,
contract, or be fixed in space, and so on.

LS-DYNA Cards

Card Description

*ALE_REFERENCE_SYSTEM_GROUPDefines the type of reference system or transformation that a geometric
entity undergoes.

Ale Reference System Node
Ale Reference System Node entities defines a group of nodes that control the motion of an ALE mesh.

It is used only when PRTYPE = 5 or 7 in a corresponding *ALE_REFERENCE_SYSTEM_GROUP card.

LS-DYNA Cards

Card Description

*ALE_REFERENCE_SYSTEM_NODEDefines a group of nodes that control the motion of an ALE mesh.

Ale Reference System Switch
Ale Reference System Switch entities allows for the time-dependent switches between different types of
reference systems, that is, switching to multiple PRTYPEs at different times during the simulation.

This command is required only when PRTYPE = 6 in ARSG card.

LS-DYNA Cards

Card Description

*ALE_REFERENCE_SYSTEM_SWITCHAllows for the time-dependent switches between different types of reference
systems.

Ale Smoothing
Ale Smoothing entities constraint keeps an ALE slave node at its initial parametric location along a line
between two other ALE nodes.

If these nodes are not ALE nodes, the slave node has to follow their motion. This constraint is active
during each mesh smoothing operation. This keyword can be used with ALE solids, ALE shells and ALE
beams.

LS-DYNA Cards

Card Description

*ALE_SMOOTHING Smoothing constraint that keeps an ALE slave node at its initial parametric
location along a line between two other ALE nodes.

Ale Tank Test
Ale Tank Test keyword provides curve through an engineering approximation when control volume
airbags only require two engineering curves to define gas inflator and those two curves can be
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experimentally measured but the ALE inflator needs one additional state variable - the inlet gas velocity
which is impractical to obtain.

LS-DYNA Cards

Card Description

*ALE_TANK_TEST Provides curve through an engineering approximation for gas inflator’s
experimentally measured two curves with additional state variable needed
for ALE inflator.

Blocks
Block entities are enclosed volumes represented by a "box" or block.

Nodes, elements, points, lines, surfaces, solids, loads, equations, systems, vectors, and connectors can
be reviewed and saved within a block.

LS-DYNA Cards

Card Description

*DEFINE_BOX Defines a box to select entities in the model.

*DEFINE_BOX_COARSEN Defines a box to select elements in the model that are protected from mesh
coarsening.

*DEFINE_BOX_ADAPTIVE Defines a box to select elements in the model that will be adaptive meshed
during solver run.

*DEFINE_BOX_SPH Defines a box to select SPH elements for use to define motion on the SPH
particles.
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Card Description

*DEFINE_BOX_DRAWBEADDefine a box around the drawbead to define elements for contact with
drawbead.

Bodies
Body entities define a kinematic assembly made of FE parts or nodes.

Bodies are created and organized in the Mechanism Browser.

Boxes
Box entities are enclosed volumes, which are represented by a box.

Nodes, elements, lines, and surfaces can be reviewed and saved within a box.

Radioss Cards

Card Description

/BOX/CYLIN Describes a cylinder box for entities selection.

/BOX/SPHER Describes a spherical box for entities selection.

/BOX/RECTA Describes a rectangle box for entities selection.

Note:  Block Format Keyword

Constrained Extra Nodes
Constrained extra node entities define and store the keywords *CONSTRAINED_EXTRA_NODES_NODE
and *CONSTRAINED_EXTRA _NODES_SET.

LS-DYNA Cards

Card Description

*CONSTRAINED_EXTRA_NODES_NODEDefine extra nodes for rigid body.
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Card Description

*CONSTRAINED_EXTRA_NODES_SETDefine extra nodes for rigid body.

Constraints
Constraint entities define kinematical constraints on a body at a specified node or point location.

Constraints are created and organized in the Mechanism Browser.

Contact Surfaces
Contact surface entities define and store contact definitions typically used in contact analysis.

Contact surfaces are defined using elements (1D/2D/3D) and their respective facecodes. A contact
surface is displayed as an arrow on the selected element faces in the modeling window. The direction of
the arrow is along the element normal that defines the contact surface.

EXODUS Cards

Card Description

SideSets Provides a second means of applying loads and boundary conditions to the
model.

LS-DYNA Cards

Card Description

*SET_SEGMENT Definition segements on element faces.

Nastran Cards

Card Description

ELIST Defines a list of CQUAD4 and CTRIA3 structural elements for virtual fluid
mass.

OptiStruct Cards
Master Slave contact is represented using contact surfaces.
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Card Description

ELIST Specifies damp shell elements for a fluid volume. ELIST entries are
referenced by the MFLUID entry.

SURF Defines a face of a 2D or 3D element as part of a surface.

Permas Cards

Card Description

$SURFACE Surface definition.

Note:  The name of the contact surface is getting exported to
the SFSET parameter. On import, the contact surface will be
named after the SFSET parameter.

Known limitations:

• The reader does not combine two individual $SURFACE
cards into a surface set if the carry the same name.

• Several surfaces can be combined by an $SFSET card
instead.

Radioss Cards

Card Description

/LINE/SEG Definition of a line.

Note:  Block Format Keyword

/SURF/SEG Defines a face of a 2D or 3D element as part of a surface.
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Card Description

Note:  Block Format Keyword

Samcef Cards

Card Description

.SEL FACE Defines a set of faces of 3D elements

Control Volumes
Control volume entities define and store control volumes typically used in safety analysis.

Control volumes do not have a display state.

LS-DYNA Cards
Use the Control Volume panel to control volume objects within a model. The *AIRBAG_OPTION card is
output from this panel. The POP option is supported for WANG_NEFSKE options.

Card Description

*AIRBAG_ADIABATIC_GAS_MODEL_IDDefine an airbag or control volume

*AIRBAG_ADVANCED_ALE*DEFINE_ALEBAG_BAG, *DEFINE_ALEBAG_HOLE, and
*DEFINE_ALEBAG_INFLATOR to define ALE type AIRBAG in modular way.

*AIRBAG_ALE Provides a simplified approach to defining the deployment of the airbag
using the ALE capabilities with an option to switch from the initial ALE
method to control volume method at a chosen time.

*AIRBAG_HYBRID_CHEMKIN_IDDefine an airbag or control volume

*AIRBAG_HYBRID_ID Define an airbag or control volume

*AIRBAG_HYBRID_JETTING_ID

*AIRBAG_HYBRID_JETTING_CM_ID

*AIRBAG_INTERACTION_IDDefine two connected airbags which vent into each other

*AIRBAG_LINEAR_FLUID_ID
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Card Description

*AIRBAG_LOAD_CURVE_ID

*AIRBAG_PARTICLE To define an airbag using the particle method.

*AIRBAG_REFERENCE_GEOMETRY_BIRTHIf the reference configuration of the airbag is taken as the folded
configuration, the geometrical accuracy of the deployed bag will be affected
by both the stretching and the compression of elements during the folding
process.

*AIRBAG_REFERENCE_GEOMETRY_BIRTH_RDT

*AIRBAG_REFERENCE_GEOMETRY_RDT

*AIRBAG_SHELL_REFERENCE_GEOMETRY

*AIRBAG_SIMPLE_AIRBAG_MODEL_ID

*AIRBAG_SIMPLE_PRESSURE_VOLUME_ID

*AIRBAG_WANG_NEFSKE_ID

*AIRBAG_WANG_NEFSKE_JETTING_ID

*AIRBAG_WANG_NEFSKE_JETTING_CM

*AIRBAG_WANG_NEFSKE_JETTING_POP_ID

*AIRBAG_WANG_NEFSKE_JETTING_POP_CM

*AIRBAG_WANG_NEFSKE_MULTIPLE_JETTING_CM_ID

*AIRBAG_WANG_NEFSKE_MULTIPLE_JETTING_ID

*AIRBAG_WANG_NEFSKE_MULTIPLE_JETTING_POP_CM_ID

*AIRBAG_WANG_NEFSKE_MULTIPLE_JETTING_POP_ID

*AIRBAG_WANG_NEFSKE_POP_ID

*DEFINE_ALEBAG_BAG Defines the surface that constitutes the airbag's outer surface for ALE
airbag.

*DEFINE_ALEBAG_HOLE Defines the surface that constitutes the vents for ALE airbag.

*DEFINE_ALEBAG_INFLATORDefines the inflator for ALE airbag.

*DEFINE_CPM_BAG_INTERACTIONAllows interaction between two particle bags.

*DEFINE_CPM_CHAMBER Defines airbag chambers for air particle initialization or chamber interaction.
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Card Description

*DEFINE_CPM_GAS_PROPERTIESDefines extended gas thermodynamic properties.

*DEFINE_CPM_VENT Defines extended vent hole options.

*INITIAL_FOAM_REFERENCE_GEOMETRYThe reference configuration allows stresses to be initialized in the following
hyperelastic material models: 2, 7, 21, 23, 27, 31, 38, 57, 73, 83, 132 and
181.

PAM-CRASH Cards

Card Description

BAGIN Airbag definition

CHAMBER Multiple chamber definitions

END_BAGIN Terminates the whole general airbag definition

END_CHAMBER Ends each chamber description

EXT_SKIN Chamber outer skin elements

Note:  Sub-keyword of CHAMBER

FPM FPM definition card

Note:  Sub-keyword of BAGIN

FPM_HOLE Hole for SPHCEL

Note:  Sub-keyword of CHAMBER

GAS Chamber GAS definition

Note:  Sub-keyword of BAGIN

Sub-keyword of CHAMBER

GEN_INI_COND Chamber gas initial condition

Note:  Sub-keyword of BAGIN
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Card Description

INFLATOR Airbag inflator definition

Note:  Sub-keyword of CHAMBER

INI_COND Initial condition of gas

Note:  Sub-keyword of CHAMBER

JET Jet definition

Note:  Sub-keyword of CHAMBER

LEAKAGE Vents and holes definition in airbag

Note:  Sub-keyword of CHAMBER

LOCAL_H FPM - Local smoothing length card

Note:  Sub-keyword of BAGIN

WALL_FABRIC Define chamber wall fabric

Note:  Sub-keyword of CHAMBER

WALL_OPENING Chamber wall opening

Note:  Sub-keyword of CHAMBER

Radioss Cards

Card Description

/MONVOL Describes the monitored volume types.

Note:  Block Format Keyword
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Card Description

/MONVOL/AIRBAG1 Describes one-chambered airbag with hybrid input of injected gas. This
keyword is similar to /MONVOL/AIRBAG (Obsolete), but has more flexible
input.

Note:  Block Format Keyword

/MONVOL/AREA Describes the monitored volume type AREA.

Note:  Block Format Keyword

/MONVOL/COMMU1 Describes multi-chambered airbag with hybrid input of injected gas. This
keyword is similar to obsolete keyword /MONVOL/COMMU, but has more
flexible input.

Note:  Block Format Keyword

/MONVOL/FVMBAG1 Describes Finite Volume Method Airbag, which has more flexible input than
the similar obsolete keyword /MONVOL/FVMBAG.

Note:  Block Format Keyword

/MONVOL/GAS Describes the perfect gas monitored volume type.

Note:  Block Format Keyword

/MONVOL/PRES Describes the pressure load curve monitored volume type.

Note:  Block Format Keyword

/REFSTA Describes the reference state for elements belonging to a part, using given
nodal coordinates.
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Card Description

Note:  Block Format Keyword

You need to create a new include file, set the include file type as
REFSTA and create this card in the include file.

Cross Sections
Cross section entities store cross section definitions used in a crash analysis.

A cross section is defined by a set of nodes and elements. These sets can be explicitly defined in
the entity or computed by intersecting a given geometry (plane, circle) with a set of elements or
components.

Supported Solver Cards
Solver cards supported for cross sections.

LS-DYNA Cards

Card Description

*DATABASE_CROSS_SECTION_PLANE(ID)XsectionPlane

*DATABASE_CROSS_SECTION_SET(ID)Define a cross section for resultant forces written to an ASCII file SECFORC.

PAM-CRASH 2G
No graphics are display for SECFO cards.

Card Description

SECFO /

NTYP = PLANE

Transmission force at cutting plane

Graphics available.

SECFO /

NTYP = CONTACT

Cumulated contact forces

No graphics available.

SECFO /

NTYP = LINK

Cumulated link forces

No graphics available.
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Card Description

SECFO /

NTYP = SECTION

Transmission force at section

No graphics available.

SECFO /

NTYP = SUPPORT

Support reaction force

No graphics available.

SECFO /

NTYP = VOLFRAC

Fraction of volume affected by a defined criterion

No graphics available.

SECFO /

NTYP = CONT_MS

Contact forces between Master and Slave nodal groups

No graphics available.

SECFO /

NTYP = DETECT

Accumulated nodal mass in selected volume

No graphics available.

Radioss Cards

Card Description

/SECT A section is a set of nodes and a set of elements.

Note:  Block Format Keyword

/SECT/CIRCLE A section is a set of nodes and a set of elements. Sets are built
automatically, by intersecting the concerned groups of elements with a disc.

Note:  Block Format Keyword

/SECT/PARAL A section is a set of nodes and a set of elements. Sets are built
automatically, by intersecting the concerned groups of elements with a
parallelogram.
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Card Description

Note:  Block Format Keyword

Create Cross Sections
Create cross sections using the Cross Section Assistant.

Restriction:  Available in the Radioss, LS-DYNA, PAM-CRASH 2G user profiles.

1. In the Model Browser, right-click and select Create > Cross Section from the context menu.
The Cross Section Assistant dialog opens.

2. In the Cross Section Name field, enter a name for the cross section.

Note:  If Create Multiple is enabled, the cross section name defines the prefix of
each cross section created.

3. In the Cross Section Type field, select the type of cross section to create.

4. In the Entity Selection field, use the entity selector to select the mesh that will be cut by the
cross section.

5. To create multiple cross sections simultaneously, select the Create Multiple checkbox.

Note:  When this checkbox is enabled, a cross section path definition will replace the
Base Node and Normal Definition parameters.

6. If you are creating multiple cross sections, in the Cross Section Path field, use the entity
selector to select a node path for the creation of each cross section.

7. If you are creating a single cross section:

a) In the Base Node field, define the location of the cross section.

Manually enter the coordinates of the cross section, or click  select the base node in the

graphics area.

b) In the Normal Direction field, define the normal of the cutting plane to be used for the
generation of the cross section.

Manually enter the coordinates of the vector, or click  to pick two or three nodes.

8. Click Create.

HyperMesh automatically fits the cross section to the selected mesh. If you are using the Radioss user
profile, the cross section time history Output Blocks is automatically created.
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Figure 79: Radioss Cross Section

Figure 80: LS-DYNA Cross Section

Curves
Curve entities define and store xy data and are associated with a plot entity.

Curves do not have a display state. However, the display of a curve in a xy plot window is controlled by
the display state and active state of its associated plot.

Abaqus Cards
Curves are exported as *AMPLITUDE card in the Abaqus input file.

Card Description

*AMPLITUDE Define an amplitude curve
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Card Description

Note:  For Standard and Explicit profiles:

The TABULAR definition reads either pairwise entries (new) or
four pairs of values per dataline (old). The EQUALLY SPACED
option has been updated to the new format as well. The old
format is required by users using pre 6.9 Abaqus solver.

The reader can read both formats. The card will be exported
the same way as it was imported. The card image allows you to
switch between both formats.

EXODUS Cards

Card Description

Function Time, frequency and/or spatially dependent functions for transient and
frequency response analysis.

LS-DYNA Cards
The output of curves creates a *DEFINE_CURVE or Structured Card 22 using Option 0.

*DEFINE_CURVE can be changed to *DEFINE_TABLE in the card previewer. When DEFINE_CURVE is
changed to DEFINE_TABLE, the number of curves the table should contain depends on the XY curves
that are referenced by a load, material, component, property, and so on are output.

Upon input, the *DEFINE_CURVE and *DEFINE_TABLE/Card 22 cards are read and placed in a plot
called LS-DYNA Load Curves. Upon input, references to curves are preserved and are output along with
the card, such as material, component, property and load.

Card Description

*DEFINE_CURVE Define a curve.

*DEFINE_CURVE_SMOOTHDefine a smoothly varying curve using few parameters.

*DEFINE_CURVE_TRIM Define a curve for trimming.

*DEFINE_CURVE_TRIM_3DDefine a curve for trimming. Trimming is processed based on the element
normal rather than the vector.

*DEFINE_FUNCTION Define a function that can be referenced by a limited number of keyword
options.
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Card Description

*DEFINE_TABLE Define a table.

*DEFINE_TABLE_2D Define a table.

*DEFINE_TABLE_3D Define a table.

OptiStruct Cards
Multi-body dynamics curves are represented as curves.

Card Description

MBCRV Specifies the data used to define a curve.

Note:  Bulk Data Entry

PAM-CRASH Cards

Card Description

FUNCT/ Definition of curves.

Permas Cards

Card Description

$FUNCTION Function definition.

Radioss Cards

Card Description

/FUNCT Defines a function (For example: stress (Y-axis) as a function of strain (X-
axis)).

Note:  Block Format Keyword

/MOVE_FUNC Describes the function scale and shift.
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Card Description

Note:  Block Format Keyword

Dummy
Dummy entities are defined by bodies representing the different kinematic assemblies of the dummy.

Dummy entities are the root of the hierarchy in the Dummy Browser. Dummy entities can only be
imported into HyperMesh.

Element Clusters
Element clusters are used to describe an assembly of elements for post-processing and failure control.

In Radioss, element clusters are defined with a set of elements (brick or spring) in the related
keyword /CLUSTER, inside of which a failure model can also be specified.

Element clusters have a display state, either ON or OFF, which controls the display of an element cluster
in the graphics area. To hide or show an element cluster, activate the "Hide Attached" option in the
Model Browser configuration window. You can control the display state of an element cluster using the
icon next to the element cluster entity in the Model Browser.

Element clusters also have an active and export state. The active state of an element cluster controls
the display state and the listing in the Model Browser and any of its views. If an element cluster entity
is active, its display state can be turned ON or OFF and is listed in the Model Browser and any of its
views. If an element cluster entity is inactive, its display state is turned OFF permanently and is not
listed in the Model Browser or any of its views.

The export state of an element cluster entity controls whether that element cluster is exported when
the custom export option is used. The all export option is not affected by the export state of an element
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cluster. The active and export states of an element cluster can be controlled using the Entity State
Browser.

Table 7:

Card Description Parameters Notes

/CLUSTER Define an element
cluster

Related keywords: /TH/
CLUSTER and /ANIM/
VECT/CLUSTER

Failures
Failures describe material failure criteria to be coupled to material models.

In Radioss, Failure models are defined with the keywords /FAIL.

Failure entities have a display state, on or off, which controls the display of these entities in the graphics
area. To hide or show a Failure entity, the “Hide Attached” option in the Model Browser configure
window, must be activated. The display state of a Failure entity can be controlled using the icon next to
the entity in the Model Browser.

Failure entities also have an active and export state. The active state of a Failure entity controls its
display state and its listing in the Model Browser along with its views. If a Failure entity is active, then
its display state is available to be turned on or off and it is listed in the Model Browser along with its
views. If a Failure entity is inactive, then its display state is turned off permanently and it is not listed in
the Model Browser or any of its views.

The export state of a Failure entity controls whether or not this entity is exported when the custom
export option is used. The all export option is not affected by the export state. The active and export
states of Failure entities can be controlled using the Entity State Browser.

Radioss Cards

Card Solver Description Application Notes

/FAIL/BIQUAD Strain failure model Ductile metal Direct input on effective
plastic strain to failure

/FAIL/CHANG Chang-Chang model Composite Failure criteria for
composites

/FAIL/CONNECT Failure Connection spot weld Normal and Tangential
failure model

/FAIL/EMC Extended Mohr Coulomb
failure model

Metal Failure dependent on
effective plastic strain
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Card Solver Description Application Notes

/FAIL/ENERGY Energy isotrop Metal, plastic Specific energy

/FAIL/FLD Forming limit diagram Metal Forming Fld

/FAIL/HASHIN Composite model Composite Hashin model

/FAIL/JOHNSON Ductile failure model Ductile metal Johnson-Cook

/FAIL/LAD_DAMA Composite delamination Composite Ladeveze delamination
model

/FAIL/NXT NT failure model Metal Forming Similar to FLD, but
based on stresses

/FAIL/PUCK Composite model Composite Puck model

/FAIL/SNCONNECT Failure Connection, spot weld Failure criteria for plastic
strain

/FAIL/SPALLING Ductile + Spalling Ductile metal Spalling + Johnson-
Cook

/FAIL/TAB1 Strain failure model Ductile metal Based on damage
accumulation using
user-defined functions

/FAIL/TBUTCHER Tuler-Butcher model Ductile metal Failure due to fatigue

/FAIL/TENSSTRAIN Traction Metal, plastic Strain failure

/FAIL/USERi User failure model n/a n/a

/FAIL/WIERZBICKI Ductile material Ductile metal Bao-Xue-Wierzbicki
model

/FAIL/WILKINS Ductile failure model Ductile metal Wilkins model

/FAIL/XFEM XFEM (Extended Finite
Element Method

Features
Feature entities track and manage certain geometric features.

Dimension features facilitate the change of dimensions in a model, and store information such as the
surface vertices, parametrization, and control options required to edit a dimension.
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For a dimension manipulator to be shown in the modeling window, both of its associated vertices must
be displayed.

Fields
Field entities store spatially varying values, which can later be realized (mapped) to the element and
node data of a new target mesh.

Field mapping can be used to:

• Transfer temperature result data in an analysis results file from a thermal analysis to a structural
model (a different mesh to that of the thermal model) as nodal temperature loads. (Continuous
field)

• Transfer displacement values in an analysis results file from a coarse structural analysis to a
detailed structural model (sub modeling based on enforce displacement from a global model) as
nodal enforced displacement. (Continuous field)

• Transfer temperature or pressure values in a .csv file ( x,y,z, temperature) to a structural model as
nodal temperature loads or element pressure loads. (Discrete field)

• Transfer pressure data in an analysis deck from an existing model to a new structural model
(different mesh) as element pressures. (Continuous field)

• Transfer two-dimensional parametric data (u,v, data value) in a .csv file to a 3D surface model.
Data vales can be temperature or pressure. Mapping is done in a parametric system. (Continuous
field)

• Transfer property ID, material orientation, and/or load data in an analysis input deck from an
existing model to a new structural model (different mesh). (Continuous field)

• Transfer 2D/axis-symmetric model temperate or pressure data to a new 3D model as temperate or
pressure loads. (Continuous field)

• Bar/Beam 1D to 2D/3D element mapping.

• 3D to 2D/3D element mapping.

• Mapping types (for discrete/.csv data only.)

• Generic field mapping.

• Reviewing and transforming source data.

• Nodal force balancing using OptiStruct.

You can create field entities in the Model Browser, and edit their corresponding attributes in the Entity
Editor. All fields are stored in the Field folder within the Model Browser.

Creating Fields
In this topic you will learn how to create fields.

Before creating a field, import the target model or analysis file that contains the new mesh into your
current HyperMesh session.

1. In the Model Browser, right-click and select Create > Field from the context menu.

2. In the Entity Editor, select one of the following field types:
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• Continuous fields evaluate data based on the shape function of source mesh data and its
nodal or elemental values. If the location of the x,y,z points or u,v points are well structured
in a rectangular array, a source mesh can be constructed.

Source data contains the mesh and the nodal or elemental values. The target mesh is
different from the source mesh.

Figure 81:

• Discrete fields provide data on discrete x,y,z locations (real) or u,v locations (parametric),
without the source mesh. Depending on the fitness of the data points, the closest point
approach or inverse distance linear interpolation method will be used to map.

Figure 82:

3. Select one of the following System types:

• Real coordinate systems (x,y,z values)
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Figure 83:

• Parametric systems (u,v tables)

Figure 84:

4. Select one of the following Sources to create the field:

• Results: loads an existing results file.

• Current Model: imports an analysis data file (.bdf, .fem, .inp, and so on). If you select
Current Model, you will see the following fields:

◦ Data Source Type:
◦ Source Entity List:

• CSV file: loads a .csv file containing x,y,z, value1, value2 discrete data.

• Matrix: loads a matrix file which will be used to generate data using matrix query tools.

• HV Current Contour:

Realizing (Mapping) Fields
In this topic you will learn how to realize, or map, fields.

Field realization creates pressures and temperature loads, and maps property IDs. To map the spatially
varying values stored in a field entity to the element and node data of the new target mesh, you must
realize the field entity.
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The following types of mapping are supported: node temperature loads, node displacement, element
pressure, element property IDs and indirect thickness, and element material orientation.

1. In the Model Browser, right-click on the field that you would like to realize and select Realize from
the menu.

2. In the Field Realization dialog, define realization settings:

a) Using the Entity selector, select the elements or nodes to be realized.

b) Select a field type.

c) Select the type of interpolation to perform: shape function (based on mapping), proximity
(based on close point evaluation), or linear interpolation (based on inverse distance).

d) Click Apply.

Once the field has been realized, the new mapped values can be visualized using contour, or they
can be exported to solver decks. When a solver deck is exported, mapped loads will be available
on the new mesh.

Mapping Examples
The following tasks show examples of various mapping strategies.

Continuous Temperature/Displacement Mapping Example
This task is an example of how to map fields.

Continuous temperature or displacement mapping from a results file to a new model.

1. Import the model containing the new mesh into HyperMesh.

Figure 85:

2. In the Model Browser, right-click and select Create > Field from the menu.

3. In the Entity Editor, edit the field's corresponding attributes:

a) Set Type to continuous.

b) Set System Type to real.

c) Set Source to results.
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d) In the File field, locate the results file with temperatures or displacements. Results files can
be of type .opt, .odb, .xdb, or any HyperView results file.

4. In the Model Browser Field folder, right-click on the field entity and select Realize from the
menu.

5. In the Field Realization dialog, define the realization settings:

Figure 86:

a) With the Entity selector set to Node, select the target nodes (nodal temperature loads) that
you would like to map.

b) Set Field Type to temperature.

c) Set Interpolation to shape function.

d) Under Loadcases, select the loadcases you would like to transfer. Each load case selection will
create a new load.

e) Under DataTypes, select the temperature.

f) Under DataComponents, select scalar values or displacement x, y, and z values.

g) Click Apply.
Temperatures from the result file are now mapped to the new mesh.
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Figure 87:

6. Click Contour to view the contour for each load case (select the correct load case).

Figure 88:

7. Click Report to view the values in table format.

Discrete Temperature Mapping Example
This task is an example of discrete mapping of temperatures or pressures.

In this task you will learn how to use discrete mapping of temperatures or pressures from a .csv file.

1. Import the model containing the new mesh in HyperMesh.
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Figure 89:

2. In the Model Browser, right-click and select Create > Field from the menu.

3. In the Entity Editor, edit the field's corresponding attributes:

a) Set Type to discrete.

b) Set System Type to real.

c) Set Source to .csv file.

d) In the File field, locate the .csv results file that contains the temperatures or pressures.

4. In the Model Browser, right-click on the field entity and select Realize from the menu.

5. In the Field Realization dialog, define the realization settings:

Figure 90:

a) With the Entity selector set to Node, select the nodes you would like to map.

b) Set Field Type to temperature.

c) Set Interpolation to proximity (finds the closest nodes) or linear (finds nodes using the
inverse distance average).

d) In the Tolerance field, type the perpendicular projection tolerance. Nodes outside of the 14.0
limit will not be mapped.

e) Click Apply.
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Temperatures from the .csv file are now mapped to the new mesh.

Figure 91:

f) Click Contour to see the mapping.

Figure 92:

Discrete Mapping Using a .csv File and System
This task is an example of mapping using data from a .csv file.

Data in a .csv file can be based on a local coordinate system. The format of the .csv file is x, y, z,
value1, value2, and so forth. The x, y, z data can be in a global or local system , including cylindrical.

The following mapping methods can also be selected:
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• Proximity

• Linear Interpolation

• Inverse Distance

• Triangulation

1. In the Model Browser, right-click and select Create > Field from the menu.

2. In the Entity Editor, edit the field's corresponding attributes:

a) Set Type to discrete.

b) Set System Type to real.

c) Set Source to .csv file.

d) In the File field, locate the .csv file.

e) In the Systems field, select the system. The system should match the x, y, z data in the .csv
file.

3. In the Model Browser, right-click on the field entity and select Realize from the menu.

4. In the Field Realization dialog, define the realization settings:

Figure 93:

a) With the Entity selector, select nodes or elements that you would like to map.

b) In the Field Type field, select a realization method.

c) Set Interpolation to proximity (finds the closest nodes) or linear (finds nodes using the
inverse distance average).

d) In the Search Radius field, type a search radius.

e) Click Apply.

f) Click Contour to see the mapping.
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Figure 94:

Transfer Load Mapping Examples
This method is useful when transferring data from existing solver decks (.bdf, .fem, .inp, and so
forth) to new meshed models. Old mesh shape functions are used with this method.

The x,y,z values in .csv files can be used without old mesh data. Discrete mapping (close point
approach) will be used instead, which is less accurate than continuous shape function mapping. The
matrix utility can be used to export x,y,z value data from old solver decks to a .csv file.

Transfer Load Data from an Existing Model to a New Model
This task is an example of transferring load data to a new model.

In this task you will learn how to transfer data from an existing model to a new model.

1. Import the model or analysis file containing transfer loads into HyperMesh.

Figure 95:
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2. In the Model Browser, right-click and select Create > Field from the menu.

3. In the Entity Editor, edit the field's corresponding attributes:

Figure 96:

a) Set Type to continuous.

b) Set System Type to real.

c) Set Source to current model.

d) Set Data Source to pressures.

e) In the Source Entity List field, use the elements selector to select pressure loads on the old
mesh.

After selecting source entities, a Table entity is automatically created and populated with values
associated to the nodes/element.

Figure 97:

4. Delete the old mesh and loads. Do not delete the field you just created.

5. Import the new mesh into HyperMesh.
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Figure 98:

6. In the Model Browser, right-click on the field entity and select Realize from the menu.

7. In the Field Realization dialog, define the realization settings:

Figure 99:

a) Using the Entity: Node selector, select the nodal temperature load target nodes to be
mapped.

b) Set Field type to pressure.

c) Click Apply.
Transfer loads are mapped to the new mesh, thereby transferring the thickness, material
angle, or ply information to the new elements.

Figure 100:

d) Click Contour to view the contour of the pressure loads transferred to the new mesh.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.238

Figure 101:

Transfer Property IDs from an Existing Model to a New Model
This task is an example of transferring property IDs to a new model.

In this task you will learn how to transfer property IDs from an existing model to a new model.

1. Import the model or analysis file containing property IDs into HyperMesh.

Figure 102:

2. In the Model Browser, right-click and select Create > Field from the menu.

3. In the Entity Editor, edit the field's corresponding attributes:
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Figure 103:

a) Set Type to continuous.

b) Set System Type to real.

c) Set Source to current model.

d) Set Data Source Type to propertyid.

e) In the Source Entity List field, use the elements selector to select property IDs from the
current model.
After selecting source entities, a Table entity is automatically created and populated with
values associated to the nodes/element.

Figure 104:

4. Delete the old mesh. Do not delete the field or properties created.

5. Import the new mesh into HyperMesh, or re-mesh the model.

6. In the Model Browser, right-click on the field entity and select Realize from the menu.

7. In the Field Realization dialog, define the realization settings:
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Figure 105:

a)

Transfer 2D Parametric Data in a .csv File to a 3D Surface Model
Use this method to map data from an old geometry model to a new geometry model during CAD
parametric updates. This method uses geometry to node associativity.

In this example you will learn that though the u, v values are used as discrete data from a .csv file, a
2D mesh using the u, v locations is created internally. The shape function mapping is used in the 2D u,
v space.

1. In the Model Browser, right-click and select Create > Field from the menu.

2. In the Entity Editor, edit the field's corresponding values:

Figure 106:

a) Set Type to continuous.

b) Set System Type to parametric.

c) Set Source to .csv file.

d) In the File field, locate the .csv file containing the rectangular array of u, v data.

3. Import the new model in HyperMesh.
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4. Mesh the surface of the model. The surface of the model should be associated with the target
mesh. Every node should be mapped to a u, v.

5. In the Model Browser, right-click on the field entity and select Realize from the menu.

6. In the Field Realization dialog, define the realization settings:

Figure 107:

a) Using the Entity: Element selector, select the elements to map.

b) Using the Surface: selector, select the surface to map.

c) Using the Node(0,0) and Node(1,1) selectors, select the two nodes that coincide with (0,0)
and (1,1) of the u, v surface. You can rotate the position by selecting two nodes which define
the corner locations of the u, v.

d) Click Apply.
The 2D parametric data is mapped to the model.

Transfer Axis Symmetric Model Temperature/Pressure Data to a 3D Model
Use this method to map data from an axis symmetric model to a 3D model.

An axis symmetric model may contain nodal temperatures or pressures in the R, Z plane. You will need
an axis symmetric mesh and the data in a .csv file. This data can be mapped to a full 3D model.

Limitation: 3D model nodes when rotated to the R, Z plane should fall inside the axis symmetric model.

1. In the Model Browser, right-click and select Create > Field from the menu.

2. In the Entity Editor, edit the field's corresponding attributes:
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Figure 108:

a) Set Type to continuous.

b) Set System Type to real.

c) Set Source to current model.

d) Set Data Source Type to value from file.

e) In the File field, open the .csv file.

f) In the System field, select the system in which the .csv file x, y, z data is created (the
default is global).

g) In the Source Entity List field, select element from the current model.

3. After creating the model, delete the current model (not the field).

4. Import the new model into HyperMesh.

5. Import the new 3D model (target model).

6. In the Model Browser, right-click on the field entity you just created and select Realize from the
menu.

7. In the Field Realization dialog, define the realization settings:
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Figure 109:

a) Using the Entity elements/nodes selector, select the elements or nodes to map.

b) Set Field Type to temperature.

c) Set Interpolation to shape function or proximity.

d) Check Cyclic Symmetry and then select the cylindrical System where the axis symmetry
mesh resides.

e) Click Apply.

Figure 110:

Bar/Beam 1D to 2D/3D Element Mapping
Use 1D source element data (results and current model with .csv) to map to 2D/3D target elements.

In this task you will learn how to map bar/beams to 2D/3D elements.

1. Create or open a model containing 2D/3D target elements.

2. Create and define a field entity:

a) In the Model Browser, right-click and select Create > field from the menu.
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b) In the Entity Editor, set Source Type to results file, or current model with .csv results file-
based results of temperature or displacements from 1D source elements.

3. In the Model Browser, right-click on the field and select Realize from the menu.

4. In the Field Realization dialog, define the realizations settings:

Figure 111:

a) Set Field Type to temperature or displacement.

b) Set Interpolation to shapefunction.

c) Select the appropriate Loadcases, DataTypes, and DataComponents.

d) Click Apply.

5. In the Field Realization dialog, click the Contour button to contour the results.
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Figure 112:

3D to 2D/3D Element Mapping
3D linear or quadratic source element data can be mapped to 2D/3D target elements. 3D source
elements can have loads or results which can be mapped.

In this task you will map 3D elements to other 2D/3D elements.

1. Import or open a 3D/2D target model.

You can import a 3D model from solver files (current model), or results files containing
temperatures, pressures, or other loads. When importing, use ID offset in order to preserve the
new model's IDs.

2. Create and define a field entity.

a) In the Model Browser, right-click and select Create > Field from the menu.

b) In the Entity Editor, define the current model using loads or results.

Figure 113:

3. Delete the source model.

4. Realize the field:

a) In the Model Browser, right-click and select Realize from the menu.

b) In the Field Realization dialog, define the realization settings.
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Figure 114:

c) Click Apply.

5. Click Contour to contour the target elements of a mapped temperature load from another 3D
source model.
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Figure 115:

Mapping Types
These tasks will introduce you to the various mapping types.

Triangulate XYZ points based on .csv file source data before mapping, and use linear shape function
mapping (2D/3D target elements).

1. Create a field entity using a discrete .csv file.

Figure 116:

2. Realize the field using the triangulation method. A source mesh is automatically created using the
xyz points. Mapping is calculated using the linear shape function.
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Figure 117:

3. Contour the mapped temperature.

Figure 118:

Inverse Distance Weighted Mapping
This task makes use of the inverse distance weighting method.

1. Create a field entity using a discrete .csv file.
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2. Realize the field using the inverse distance weighting method. A source mesh is automatically
created using the xyz points in the .csv file, and mapping is calculated using the linear shape
function.

Figure 119:

Shape Function and Proximity Mapping
In this task you will map target nodes, which fall outside the source elements, using the close point
approach. Nodes that fall inside the source elements will use the shape function.

If the target model is slightly bigger than the source model, within the tolerance specified in the Field
Realization dialog, the close point method will be used to find the values of the nodes outside the
model. Use shapefunctionandproximity instead of shapefunction.

Provide the correct Search Radius to detect the nodes that fall outside of the source model. If the
Search Radius = 0 , the distance will be automatically found and searched.
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Figure 120:

Generic Field Mapping
Generic field mapping (table mapping) uses matrix columns (source data) to map and export target
elements to a new Excel table.

Supported field mapping entities include: Temperature, Displacement, Pressure, and Property ID. These
entities are standard HyperMesh database entries. Entries that are not standard HyperMesh supported
field entities can be mapped using the Matrix Browser and a table entity.

1. Open the model containing the source data.

2. Create and define a field entity:

a) In the Model Browser, right-click and select Create > Field from the menu.

b) In the Entity Editor, set Type to continuous, System Type to real, and Source to matrix.

c) Right-click on the Source field and select Invoke from the menu.

3. In the Field dialog, select the source data to map.
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Figure 121:

a) From the DataSource list, select HMdata.

b) From the Entities list, select elements or nodes.

c) Click the Query button.

d) In the panel area, use the elems/nodes selector to select elements/nodes and then click
Proceed.

e) In the matrix, click the Elements column.

f) From the Datanames list, select the type of data to import and then click the Query button.

g) Click OK.
A table entity containing all of the mapping entities based on the source model is
automatically created.

4. Delete the source model.

5. Realize the field:
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Figure 122:

a) In the Model Browser, right-click on the field and select Realize from the menu.

b) Set Field Type to table.

c) Select the table created by the Matrix Browser.

d) Set Field Column to the column name used in the Matrix Browser.

e) Click Apply.

A new table entity is created based on the target element/nodes after mapping (field realization).

6. Export target elements to Excel:

a) Open the Matrix browser from the menu bar by clicking Tools > Matrix Browser.
b) Set Worksheet to the new table created during mapping.

c) Click Excel.
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Figure 123:

Reviewing and Transforming Source Data
When source data is not in the correct location and overlaps with the target model, the tools provided in
the Field Realization dialog can be used to transform the source model to the target model's location
with linear transformation, rotation, or scale methods.

The transformed source model will be stored with the field entity and will remain in the database for
future reviews.

1. Open or import the target model.

2. Create and define a field entity:

a) In the Model Browser, right-click and select Create > Field from the menu.

b) In the Entity Editor, define the source model data (results, csv, and current model).

Figure 124:

3. Realize the field:

a) In the Model Browser, right-click and select Realize from the menu.

b) In the Field Realization dialog, define the realization settings.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.254

Figure 125:

c) Click Apply.

4. In the Field Realization dialog, click Review to display the target model (green) and the source
model (pink).

Figure 126:

5. Transform the source data:

a) In the Field Realization dialog, click the Transform button.
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Figure 127:

b) In the Field Transformation dialog, define settings in the Type field to perform either a
Translation, Rotation, or Scale transformation of the source node.

c) Click the Close button to perform the transformation operation.

d) Click Reset Review to display the updated location of the new source model.

e) Repeat this operation until the source model and the target model are in the same location.

Note:  Manually define the vector direction by entering the Source node x,y,z
location, Target node x,y,z location, and Magnitude of the vector.

Nodal Force Balancing using OptiStruct
Perform nodal force balance mapping using OptiStruct to ensure mapped target nodal forces and source
nodal forces are in equilibrium.

Forces from a source model are mapped to new target model nodal forces. The total load calculation on
the source model and the new mapped model must be the same in order to ensure forces are balanced.

Equilibrium mapping is performed using the linear OptiStruct solver, therefore you must have the
OptiStruct installed with license on the same installation directory as HyperWorks Desktop.

1. Open or import the target model. When importing, use ID Offset to preserve the source model ID.
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Figure 128:

2. Create and define a field entity:

a) In the Model Browser, right-click and select Create > Field from the menu.

b) In the Entity Editor, define the nodal field using the current model and forces data source,
then select the loads to map.

Figure 129:

3. Realize the field:

a) In the Model Browser, right-click on the field and select Realize from the menu.

b) In the Field Realization dialog, define the realization settings.
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Figure 130:

c) Set Interpolation to forcebalancing.

d) Click Apply.
New forces and moments are created and applied to the nodes of the target mesh.
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Figure 131:

Groups
Group entities define and store interfaces and rigid walls typically used in contact analysis.

Interfaces
Configurations 1 - 4: Define contact interactions between various parts of the model.

Rigid Walls
Configuration 5: Define a contact or sliding rigid wall in an analysis code.
In all solver interfaces except for LS-DYNA, rigid walls are created as group entities with
configuration 5. In the LS-DYNA solver interface, a rigid wall is created as a rigid wall entity.

ALE Setup
Configuration 6: Define input data pertaining to the Arbitrary-Lagrangian-Eulerian LS-DYNA
capability.

Abaqus Cards

Card Description

*BLOCKAGE Control contacting surfaces for blockage.
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Card Description

Note:  Must be used in conjunction with the *SURFACE
INTERACTION card.

*CHANGE FRICTION Change friction properties.

Note:  The Standard template only.

It must be added to a load step (*STEP).

*CLEARANCE Specify a particular initial clearance value and a contact direction for the
slave nodes on a surface.

Note:  Must be added to a load step (*STEP) in explicit
template.

*COHESIVE BEHAVIOR Used to define surface-based cohesive behavior in a mechanical contact
analysis.

Note:  It must be used in conjunction with the *SURFACE
INTERACTION option.

*CONTACT(General
Contact)

Begin the definition of general contact.

*CONTACT CLEARANCE Define contact clearance properties.

*CONTACT CLEARANCE
ASSIGNMENT

Assign contact clearances between surfaces in the general contact domain.

*CONTACT CONTROLS Specify additional controls for contact.

Note:  Must be added to a load step (*STEP).

*CONTACT CONTROLS
ASSIGNMENT

Assign contact controls for the general contact algorithm.

Note:  This card is a sub-option in the *CONTACT card image.

*CONTACT DAMPING Define viscous damping between contacting surfaces.

Note:  This card is a sub-option in the *SURFACE INTERACTION
card image.
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Card Description

*CONTACT EXCLUSIONS Specify self-contact surfaces or surface pairings to exclude from the general
contact domain.

Note:  This card is a sub-option in the *CONTACT card image.

*CONTACT
FORMULATION

Specify a nondefault contact formulation for the general contact algorithm.

Note:  This card is a sub-option in the * CONTACT card image.

*CONTACT INCLUSIONS Specify self-contact surfaces or surface pairings to include in the general
contact domain.

Note:  This card is a sub-option in the *CONTACT card image.

*CONTACT
INTERFERENCE

Prescribe time-dependent allowable interferences of contact pairs and
contact elements.

Note:  The Standard template only.

Must be added to a load step (*STEP).

*CONTACT PAIR Define surfaces that contact each other.

*CONTACT PROPERTY
ASSIGNMENT

Assign contact properties for the general contact algorithm.

Note:  This card is a sub-option in the *CONTACT card image.

*CONTROLS Reset solution controls.

Note:  The Standard template only.

*CONTROLS Reset solution controls.

Note:  The Standard template only.

*COUPLING Define a surface-based coupling constraint where the *SURFACE card points
to elements.
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Card Description

Note:  The *COUPLING is also supported as rigid elements
(COUP_KIN) and RBE3 (COUP_DIS) when *SURFACE points to
nodes.

*DEBOND Used to specify that crack propagation may occur between two surfaces that
are initially partially bonded.

Note:  The Standard template only.

The *FRACTURE CRITERION option must appear immediately
following this option.

*DIAGNOSTICS Control diagnostic messages.

Note:

Explicit template only.

Must be added to a load step (*STEP).

*DISTRIBUTING Define a distributing coupling constraint.

Note:  This card is a sub-option in the *COUPLING card image.

It is also supported as COUP_DIS type rbe3 elements.

*FASTENER (SPOT
WELD)

Define mesh-independent fasteners.

Note:

*FILTER Define a filter for output filtering.

Note:  Explicit template only

*FIXED MASS SCALING Specify mass scaling at the beginning of the step.

Note:  Explicit template only.

Must be added to a load step (*STEP).

*FRACTURE CRITERION Used to specify the criterion for crack propagation along initially partially
bonded surfaces.
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Card Description

Note:  It must appear immediately following the *DEBOND
option in Abaqus/Standard and after the *COHESIVE BEHAVIOR
option in Abaqus/Explicit.

*FRICTION Specify a friction model.

Note:  This card is a sub-option in the *SURFACE INTERACTION
card image.

*FRICTION Specify a friction model.

Note:

This card is a sub-option in the *CHANGE FRICTION card image.

*INITIAL CONDITIONS Prescribe initial conditions for an analysis.

*INTEGRATED OUTPUT
SECTION

Define an integrated output section over a surface with a local coordinate
system and a reference point.

*KINEMATIC Define a kinematic coupling constraint.

Note:  This card is a sub-option in the *COUPLING card image.

It is also supported as COUP_KIN type rigid elements.

*MODEL CHANGE Remove or reactivate elements and contact pairs.

Note:  The Standard template only.

Must be added to a load step (*STEP).

*PRE-TENSION
SECTION

Associate a pre-tension node with a pre-tension section.

*SHELL TO SOLID
COUPLING

Define a surface-based coupling between a shell edge and a solid face.

Note:

*SURFACE Define a surface or region in a model.

Note:
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Card Description

*SURFACE BEHAVIOR Define alternative pressure-overclosure relationships for contact.

Note:  This card is a sub-option in the *SURFACE INTERACTION
card image.

*SURFACE
INTERACTION

Define surface interaction properties.

Note:  Explicit template only.

This card is defined from the Property panel in case of Standard
3D and Standard 2D templates.

*SURFACE PROPERTY
ASSIGNMENT

Assign surface properties to a surface for the general contact algorithm.

Note:  This card is a sub-option in the *CONTACT card image.

*TIE Define surface-based tie and cyclic symmetry constraints or coupled
acoustic-structural interactions.

*VARIABLE MASS
SCALING

Specify mass scaling during the step.

Note:  Explicit template only.

Must be added to a load step (*STEP).

EXODUS Cards

Card Description

TiedJoint

LS-DYNA Cards
AnLS-DYNA entity that utilizes a *SET_ [NODE, SHELL, PART, and so on] keyword card belongs to a
group, with the exception of Rigid Bodies/RBE2’s.

The difference among configurations is the type of entities contained within a group.

Config 1
Contains master and slave elements.

Config 2
Contains master elements and slave nodes.
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Config 3
Contains slave elements.

Config 4
Contains slave nodes.

Sliding interfaces specifications.

•

• The Keyword _TITLE option is supported. The _THERMAL(IREAD==3) option is not supported.

• Use the additional cards option in Keyword decks to select number of lines of data. If this is on, two
additional cards are available.

• In Structured, additional cards are controlled by using the IREAD variable. Valid values are 0, 1,
and 2.

• Boxes, part sets, and sets are supported.

• The $HMNAME fields are used for names. When using the _TITLE option, the 70-character field is
considered a comment.

• If the line following the keyword (No TITLE option), or the first line of the Structured card contains
$HM_NAME, the name supplied is read and used as the group's name. If the string $HM_ID also
exists, this is used as the group’s ID. NAME is 16 characters, starting in Column 9. ID field is 8
characters, starting in Column 35.

• The solver interface type defines the general type of the LS-DYNA Sliding Interface. Use the
Property Editor to make changes to the LS-DYNA type.

Card Description

*BOUNDARY_AMBIENT_EOS Defines the IDs of 2 load curves: 1) internal
energy per unit reference specific volume and 2)
relative volume.

*BOUNDARY_FLUX_SET Define flux boundary conditions for a thermal or
coupled thermal/structural analysis.

*BOUNDARY_SPH_FLOW Define a flow of particle

*CONSTRAINED_BUTT_WELD Define a line of coincident nodes that represent a
structural butt weld between two parts defined by
shell elements.

*CONSTRAINED_LAGRANGE_IN_SOLID Provides the coupling mechanism for modeling
Fluid-Structure Interaction.

*CONSTRAINED_RIGID_BODIES Merge two rigid bodies.

*CONSTRAINED_SPOTWELD Defines massless spot welds between non-
contiguous nodal pairs.
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Card Description

*CONSTRAINED_TIE-BREAK Define a tied shell edge to shell edge interface that
can release locally as a function of plastic strain of
the shells surrounding the interface nodes.

*CONSTRAINED_TIED_NODES_FAILURE Define a tied node set with failure based on plastic
strain.

*CONTACT_AIRBAG_SINGLE_SURFACE(ID) Define a contact interface.

*CONTACT_AIRBAG_SINGLE_SURFACE_MPP(ID)

*CONTACT_AUTO_MOVE Move the master surface in a contact definition to
close an initial gap between the slave and master
surfaces.

*CONTACT_AUTOMATIC_GENERAL(ID) Define a contact interface.

*CONTACT_AUTOMATIC_GENERAL_INTERIOR(ID) Define a contact interface.

*CONTACT_AUTOMATIC_GENERAL_INTERIOR_MPP(ID)

*CONTACT_AUTOMATIC_GENERAL_MPP(ID)

*CONTACT_AUTOMATIC_NODES_TO_SURFACE(ID) Define a contact interface.

*CONTACT_AUTOMATIC_NODES_TO_SURFACE_MPP(ID)

*CONTACT_AUTOMATIC_NODES_TO_SURFACE_SMOOTH(ID)Define a contact interface.

*CONTACT_AUTOMATIC_NODES_TO_SURFACE_SMOOTH_MPP(ID)

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE(ID)

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_ORTHO_FRICTION(ID)

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH(ID)

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK(ID)

*CONTACT_AUTOMATIC_SINGLE_SURFACE(ID)

*CONTACT_AUTOMATIC_SINGLE_SURFACE_MORTAR(ID)Define a contact interface.

*CONTACT_AUTOMATIC_SINGLE_SURFACE_MPP(ID)

*CONTACT_AUTOMATIC_SINGLE_SURFACE_SMOOTH(ID)

*CONTACT_AUTOMATIC_SINGLE_SURFACE_SMOOTH_MPP(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE(ID)
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Card Description

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_TIED(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_ORTHO_FRICTION(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_SMOOTH(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_SMOOTH_MPP(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_THERMAL_FRICTION(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK(ID)

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK_MPP(ID)

*CONTACT_CONSTRAINT_NODES_TO_SURFACE(ID)

*CONTACT_CONSTRAINT_NODES_TO_SURFACE_MPP(ID)

*CONTACT_CONSTRAINT_SURFACE_TO_SURFACE(ID)

*CONTACT_CONSTRAINT_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_DRAWBEAD(ID)

*CONTACT_DRAWBEAD_MPP(ID)

*CONTACT_ENTITY(ID) Define a contact entity

*CONTACT_ENTITY_MPP(ID)

*CONTACT_ERODING_NODES_TO_SURFACE(ID)

*CONTACT_ERODING_NODES_TO_SURFACE_MPP(ID)

*CONTACT_ERODING_SINGLE_SURFACE(ID)

*CONTACT_ERODING_SINGLE_SURFACE_MPP(ID)

*CONTACT_ERODING_SURFACE_TO_SURFACE(ID)

*CONTACT_ERODING_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_FORCE_TRANSDUCER_CONSTRAINT(ID)

*CONTACT_FORCE_TRANSDUCER_CONSTRAINT_MPP(ID)

*CONTACT_FORCE_TRANSDUCER_PENALTY(ID)
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Card Description

*CONTACT_FORCE_TRANSDUCER_PENALTY_MPP(ID)

*CONTACT_FORMING_NODES_TO_SURFACE(ID)

*CONTACT_FORMING_NODES_TO_SURFACE_MPP(ID)

*CONTACT_FORMING_NODES_TO_SURFACE_SMOOTH(ID)

*CONTACT_FORMING_NODES_TO_SURFACE_SMOOTH_MPP(ID)

*CONTACT_FORMING_ONEWAY_SURFACE_TO_SURFACE(ID)

*CONTACT_FORMING_ONEWAY_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET(ID)

*CONTACT_FORMING_ONEWAY_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET_MPP(ID)

*CONTACT_FORMING_ONEWAY_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET_SMOOTH(ID)

*CONTACT_FORMING_ONEWAY_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET_SMOOTH_MPP(ID)

*CONTACT_FORMING_ONEWAY_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_FORMING_ONEWAY_SURFACE_TO_SURFACE_SMOOTH(ID)

*CONTACT_FORMING_ONEWAY_SURFACE_TO_SURFACE_SMOOTH_MPP(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET_MPP(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET_SMOOTH(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET_SMOOTH_mpp(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE_MORTAR(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE_SMOOTH(ID)

*CONTACT_FORMING_SURFACE_TO_SURFACE_SMOOTH_MPP(ID)

*CONTACT_INTERIOR(ID) Define interior contact for foam hexahedral and
tetrahedral elements.

*CONTACT_INTERIOR_MPP(ID)

*CONTACT_NODES_TO_SURFACE(ID)
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Card Description

*CONTACT_NODES_TO_SURFACE_INTERFERENCE(ID)

*CONTACT_NODES_TO_SURFACE_INTERFERENCE_MPP(ID)

*CONTACT_NODES_TO_SURFACE_MPP(ID)

*CONTACT_NODES_TO_SURFACE_SMOOTH(ID)

*CONTACT_NODES_TO_SURFACE_SMOOTH_MPP(ID)

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE(ID)

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE(ID)

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE_CONSTRAINED_OFFSET(ID)

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE_CONSTRAINED_OFFSET_MPP(ID)

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE_MPP(ID)

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH(ID)

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_MPP(ID)

*CONTACT_RIGID_BODY_ONE_WAY_TO_RIGID_BODY(ID)Define rigid surface contact.

*CONTACT_RIGID_BODY_ONE_WAY_TO_RIGID_BODY_MPP(ID)

*CONTACT_RIGID_BODY_TWO_WAY_TO_RIGID_BODY(ID)

*CONTACT_RIGID_BODY_TWO_WAY_TO_RIGID_BODY_MPP(ID)

*CONTACT_RIGID_NODES_TO_RIGID_BODY(ID)

*CONTACT_RIGID_NODES_TO_RIGID_BODY_MPP(ID)

*CONTACT_RIGID_SURFACE(ID)

*CONTACT_RIGID_SURFACE_MPP(ID)

*CONTACT_SINGLE_EDGE(ID)

*CONTACT_SINGLE_EDGE_MPP(ID)

*CONTACT_SINGLE_SURFACE(ID)

*CONTACT_SINGLE_SURFACE_MPP(ID)

*CONTACT_SLIDING_ONLY(ID)
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Card Description

*CONTACT_SLIDING_ONLY_MPP(ID)

*CONTACT_SLIDING_ONLY_PENALTY(ID)

*CONTACT_SLIDING_ONLY_PENALTY_MPP(ID)

*CONTACT_SPOTWELD(ID)

*CONTACT_SPOTWELD_MPP(ID)

*CONTACT_SPOTWELD_WITH_TORSION(ID)

*CONTACT_SPOTWELD_WITH_TORSION_MPP(ID)

*CONTACT_SURFACE_TO_SURFACE(ID)

*CONTACT_SURFACE_TO_SURFACE_CONTRACTION_JOINT(ID)

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE(ID)

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE_CONSTRAINED_OFFSET

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE_CONSTRAINED_OFFSET_MPP(ID)

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE_MPP(ID)

*CONTACT_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_SURFACE_TO_SURFACE_SMOOTH(ID)

*CONTACT_SURFACE_TO_SURFACE_SMOOTH_MPP(ID)

*CONTACT_SURFACE_TO_SURFACE_THERMAL_FRICTION(ID)

*CONTACT_THERMAL_SURFACE_TO_SURFACE_(ID)

*CONTACT_THERMAL_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_TIEBREAK_NODES_TO_SURFACE(ID)

*CONTACT_TIEBREAK_NODES_TO_SURFACE_MPP(ID)

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE(ID)

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_TIED_NODES_TO_SURFACE(ID)

*CONTACT_TIED_NODES_TO_SURFACE_CONSTRAINED_OFFSET(ID)

*CONTACT_TIED_NODES_TO_SURFACE_CONSTRAINED_OFFSET_MPP(ID)
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Card Description

*CONTACT_TIED_NODES_TO_SURFACE_MPP(ID)

*CONTACT_TIED_NODES_TO_SURFACE_OFFSET(ID)

*CONTACT_TIED_NODES_TO_SURFACE_OFFSET_MPP(ID)

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE(ID)

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_BEAM_OFFSET(ID)

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_BEAM_OFFSET_MPP(ID)

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_CONSTRAINED_OFFSET(ID)

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_CONSTRAINED_OFFSET_MPP(ID)

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_MPP(ID)

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_OFFSET(ID)

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_OFFSET_MPP(ID)

*CONTACT_TIED_SURFACE_TO_SURFACE(ID)

*CONTACT_TIED_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET(ID)

*CONTACT_TIED_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET_MPP(ID)

*CONTACT_TIED_SURFACE_TO_SURFACE_MPP(ID)

*CONTACT_TIED_SURFACE_TO_SURFACE_OFFSET(ID)

*CONTACT_TIED_SURFACE_TO_SURFACE_OFFSET_MPP(ID)

*CONTACT_TIED_SURFACE_TO_SURFACE_TITLE(ID)

*CONTACT_2D_AUTOMATIC_SURFACE_TO_SURFACE(ID)Define a two-dimensional contact or slide line.

*CONTACT_2D_AUTOMATIC_SURFACE_TO_SURFACE_THERMAL_TITLE(ID)

*CONTACT_2D_AUTOMATIC_SURFACE_TO_SURFACE_THERMAL_TITLE_MPP(ID)

*CONTACT_2D_AUTOMATIC_SURFACE_TO_SURFACE_TITLE(ID)

*CONTACT_2D_AUTOMATIC_SURFACE_TO_SURFACE_TITLE_MPP(ID)

*CONTACT_2D_AUTOMATIC_TIED_TITLE Defines a two-dimensional contact or slide line.
May be used with rigid body material.
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Card Description

*DATABASE_FSI Used to output information about certain coupled
Lagrangian surfaces.

*DATABASE_NODAL_FORCE_GROUP Define a nodal force group for output into ASCII
file NODFOR and the binary file XTFILE.

*ELEMENT_TRIM Define a part subset to be trimmed by
*DEFINE_CURVE_TRIM

*INITIAL_GAS_MIXTURE Used to specify a) which ALE multi-material groups
may be present inside an ALE mesh set at time
zero and b) the corresponding reference gas
temperature and density which define the initial
thermodynamic state of the gases.

*INITIAL_VOID (PART and SET) Define initial voided part set IDs or part numbers.

*INITIAL_VOLUME_FRACTION Define initial volume fractions of different
materials in multi-material ALE elements.

*INITIAL_VOLUME_FRACTION_GEOMETRY Volume filling command for defining the volume
fractions of various ALE multi-material group that
can occupy certain regions in some specified ALE
mesh set.

*SET_MULTI-MATERIAL_GROUP_LIST(TITLE) Defines an ALE multi-material set ID which
contains a collection of one or more ALE multi-
material group IDs.

Nastran Cards
Contact, thermal analysis definitions and non-structural mass are represented using group entities.

Card Description

AESURF Specifies an aerodynamic control surface as a member of the set of
aerodynamic extra points.

BCBODY Defines a flexible or rigid contact body in 2D or 3D.

Note:  Defined using the Interfaces panel.

BCBODY1 Defines a flexible or rigid contact body in 2D and 3D.

BCONECT Defines the touching and touched contact bodies.
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Card Description

BCTABL1 Defines a Contact Table

Note:  Not supported in the BCTABLE Manager.

BCTABLE Defines a contact table.

Note:  Use BCTABLE Manager tool to create BCTABLE, located in
the utilities tab inside NASTRAN1

BCTSET
Note:  Defined using the Interfaces panel

BSURF Defines a contact body or surface defined by Element IDs.

Note:  Defined using the Interfaces panel

BSURFS 3D Contact Region Definition by Solid Elements.

Note:  NX Nastran only. Defined using the Interfaces panel

CONDUCTION Defines CHBDYE slave elements used for thermal conduction analysis.

Note:  Defined using the Interfaces panel

CONVECTION Defines CHBDYE slave elements used for thermal convection analysis, and
also allows for CONV continuation cards to be defined.

Note:  Has PCONV card image. Defined using the Interfaces
panel.

NSM1 Defines non-structural mass per unit length/area on properties or elements.

Note:  Defined using the NSM panel.

NSML1 Defines lumped non-structural mass on properties or elements.

Note:  Defined using the NSM panel.
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Card Description

PCONV Specifies the free convection boundary condition properties of a boundary
condition surface element used for heat transfer analysis.

Note:  Defined using the Interfaces panel, using CONVECTION
group type.

RADIATION Defines CHBDYE slave elements used for thermal radiation analysis.

Note:  Has RADM card image. Defined using the Interfaces
panel.

RADM Defines the radiation properties of a boundary element for heat transfer
analysis.

Note:  Defined using the Interfaces panel, using RADIATION
group type.

SPBLND1 Defines a strip based blending of two splines.

SPBLND2 Defines a curve based blending of two splines.

SPRELAX Defines relaxation of a spline based on an adjacent spline.

SPLINE1 Defines a surface spline for interpolating motion and/or forces for aeroelastic
problems on aerodynamic geometries defined by regular arrays of
aerodynamic points.

SPLINE2 Defines a beam spline for interpolating motion and/or forces for aeroelastic
problems on aerodynamic geometries defined by regular arrays of
aerodynamic points.

SPLINE4 Defines a curved surface spline for interpolating motion or forces for
aeroelastic problems on general aerodynamic geometries.

SPLINE5 Defines a 1D beam spline for interpolating motion and/or forces for
aeroelastic problems on aerodynamic geometries.

SPLINE6 Defines a 6DOF or 3DOF finite surface spline for interpolating motion and/or
forces between two meshes.

SPLINE7 Defines a 6DOF finite beam spline for interpolating motion and/or forces
between two meshes.
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Card Description

SPLINRB Defines a rigid body spline for interpolating motion or forces for aeroelastic
problems on general aerodynamic geometries.

OptiStruct Cards
Contact, thermal analysis definitions, multi-body dynamics bodies, non-structural mass, rigid walls and
section outputs are represented using group entities.

Card Description

CONTACT Defines a contact interface for Small Displacement Nonlinear Analysis
(NLSTAT), Nonlinear Transient Dynamics (NLGEOM), and Contact-based
Thermal Analysis (HEAT).

Note:  Bulk Data Entry

CONDUCTION Defines CHBDYE slave elements used for thermal conduction analysis.

Note:  Bulk Data Entry

CONVECTION Defines CHBDYE slave elements used for thermal conduction analysis, and
also allows for CONV continuation cards to be defined.

Note:  Bulk Data Entry

GROUND Defines a ground body out of a list of finite element properties, elements,
and grid points.

Note:  Bulk Data Entry

MBCNTDS Defines a Multibody Contact between a set of nodes and a deformable
surface.

Note:  Bulk Data Entry

MBCNTR Defines a Multibody contact between rigid bodies.

Note:  Bulk Data Entry

NODESET
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Card Description

NSM1 Defines non-structural mass per unit area or per unit length for a list of
elements or properties.

Note:  Bulk Data Entry

NSML1 Defines lumped non-structural mass for a list of elements or properties.

Note:  Bulk Data Entry

PCONV Defines a free convection boundary condition properties.

Note:  Bulk Data Entry

PFBODY Defines a flexible body out of a list of finite element properties, elements,
and grid points.

Note:  Bulk Data Entry

PRBODY Defines a rigid body out of a list of finite element properties, elements and
grid points.

Note:  Bulk Data Entry

SECT Defines a section for force output in geometric nonlinear analysis.

Note:  Bulk Data Entry

TIE Defines a tied contact in Linear Static Analysis (STATICS) and Small
Displacement Nonlinear Analysis (NLSTAT). Penalty-based and MPC-based
TIE contacts are available and can be selected using CONTPRM, TIE.

Note:  Bulk Data Entry

XDAMP Defines the values for Raleigh damping for geometric nonlinear dynamic
analysis.
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Card Description

Note:  Bulk Data Entry

PAM-CRASH 2G Cards

Card Description

CNTAC / NTYPE = 1 Special sliding without separation

CNTAC / NTYPE = 10 Internal solid anti-collapse contact

CNTAC / NTYPE = 21 Body-to-multiplane contact

CNTAC / NTYPE = 33 Symmetric node-to-segment contact with edge treatment

CNTAC / NTYPE = 34 Non-symmetric node-to-segment contact with edge treatment

CNTAC / NTYPE = 36 Self-impacting node-to-segment contact with edge treatment

CNTAC / NTYPE = 37 Enhanced self-impacting contact for airbags

CNTAC / NTYPE = 43 Edge-to-edge master-slave contact

CNTAC / NTYPE = 44 Node-to-segment-oriented contact with smooth contact surface

CNTAC / NTYPE = 46 Edge-to-edge self-impacting contact

CNTAC / NTYPE = 54 Non-symmetric-oriented contact

CNTAC / NTYPE = 61 Node-to-analytical surface contact

CNTAC / NTYPE = 154 Implicit small sliding contact

MASS_GES / Added mass definition (only when IDNOD = 0)

NSMAS / Non-structural mass definition

NSMAS2/ Alternate mass distribution method
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Card Description

TIED / Node-surface tied interface

Permas Cards

Card Description

$CONTACT Contact definitions

$MPC ISURFACE Coupling of two surfaces

$MPC WLSSURFACE/
WLDSURFACE

Weld connection between nodes and surfaces

$PRETENSION PLANE Pretension definition without detailing the threaded connection.

$PRETENSION THREAD Modeling a threaded pretension section

Radioss Cards

Card Description

/INICONT Container definition for ALE material.

Note:  Block Format Keyword

/INIVOL Defines material in the ALE containers.

Note:  Block Format Keyword

/INTER Describes the interfaces.

Note:  Block Format Keyword

/INTER/LAGMUL/TYPE7 Describes the Lagrange Multiplier interface TYPE7. Multi usage impact
interface between a master surface and a list of slaves nodes.

Note:  Block Format Keyword

/INTER/TYPE1 Defines a fluid-structure interaction. Lagrangian elements (structure) can
interact with ALE elements, which model a viscous fluid.
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Card Description

Note:  Block Format Keyword

/INTER/TYPE2 Defines a TYPE2 tied interface that connects a set of slave nodes to a master
surface. It can be used to connect coarse and fine meshes, model spotwelds,
rivets, and so on.

Note:  Block Format Keyword

/INTER/TYPE3 Simulates impacts between two surfaces (with oriented segments). This
interface works properly if the two surfaces are simply convex.

Note:  Block Format Keyword

/INTER/TYPE5 Simulates impacts between a master surface and a list of slave nodes.

Note:  Block Format Keyword

/INTER/TYPE6 Simulates contact between two rigid bodies with tabulated input of the
contact force. It works similar to interface TYPE3. Contact force between the
bodies can be input as a function of maximal penetration. The interface also
allows you to input a force function for unloading.

Note:  Block Format Keyword

/INTER/TYPE7 Multi-usage impact interface, modeling contact between a master surface
and a group of slave nodes. It is also possible to consider heat transfer and
heat friction.

Note:  Block Format Keyword

/INTER/TYPE8 Simulates drawbeads. It is mainly used in the process industry to model
metal forming. Drawbeads are used to prevent the metal strip from sliding
during the stamping process. Normals of the master segments must be
oriented toward the slave nodes (unsorted group).

Note:  Block Format Keyword

/INTER/TYPE9 Defines the ALE Lagrange with void opening and free space. Non-impacted
ALE nodes are on a free surface. The grid velocity is equal to the material
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Card Description

velocity in normal direction. The normal of the master surface elements
must be oriented toward the slave nodes.

Note:  Block Format Keyword

/INTER/TYPE10 Tied contact with void.

Note:  Block Format Keyword

/INTER/TYPE11 Simulates impact between edge to Edge or lines. A line can be a beam or
truss element or a shell edge or spring elements.

Note:  Block Format Keyword

/INTER/TYPE12 Defines fluid to fluid contact and enables the transmission of flow between
two ALE surfaces (master and slave side). The slave node velocities are
interpolated from master surface values. Then convective fluxes are
calculated between the two surfaces.

Note:  Block Format Keyword

/INTER/TYPE14 Simulates impacts between a hyper-ellipsoidal rigid master surface and a
list of slave nodes. The hyper-ellipsoidal surface is treated as an analytical
surface (hyper-ellipsoidal surfaces are only discretized for post-processing).
For this interface, generally, use a mesh whose size is finer than the lowest
semi- axis of master surface. The master surface must be a MADYMO hyper-
ellipsoidal surface or a Radioss hyper-ellipsoidal surface.

Note:  Block Format Keyword

/INTER/TYPE15 Ellipsoidal Surfaces to Elements Contact. It is a penalty contact interface
without damping. This interface replaces interface TYPE14, especially if
the mesh is coarser than the ellipsoid size. The slave surface must be a
set of 3-node or 4-node segments (i.e. any kind of surface; except ELLIPS
and MDELLIPS surfaces). The master surface must be a MADYMO hyper-
ellipsoidal surface or a Radioss hyper-ellipsoidal surface, and Interface does
not allow penetrations up to half the ellipsoid.

Note:  Block Format Keyword

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.280

Card Description

/INTER/TYPE18 Defnes the Euler/Lagrange or ALE/Lagrange contact. Euler-Lagrange or ALE-
Lagrange contact is the contact between a Lagrangian master surface and
a list of Eulerian or ALE slaves nodes. Material velocity for all slave nodes is
imposed by master surface with a penalty formulation. ALE slave node grid
velocity is not modified by this interface.

Note:  Block Format Keyword

/INTER/TYPE19 Combination of interface TYPE7 and TYPE11, with common input based on
the same slave/master surfaces. Slave node group for interface TYPE7, as
well as slave and master line segments used by equivalent TYPE11 interface
are virtually generated from these input surfaces.

Note:  Block Format Keyword

/INTER/TYPE20 A general single surface or surface to surface contact interface. Edge to edge
contact is also possible. Penalty stiffness is constant and therefore the time
step is not affected (for standard penalty stiffness). This contact interface
can replace interface TYPE3, TYPE5, TYPE7, TYPE11 or TYPE19. The interface
is basically defined in terms of one or two surfaces. If only one surface is
used, this surface is self-impacting. If two surfaces are defined, nodes of
surface two impact surface one. A symmetric treatment can be activated.
Edges of surface one and two can be taken into account for the contact.
Nodes can be added to surface.

Note:  Block Format Keyword

/INTER/TYPE21 Specific interface between a non-deformable master surface and a slave
surface designed for stamping. All nodes of the master surface must belong
to the rigid body.

Note:  Block Format Keyword

/INTER/TYPE23 Defines a contact interface for airbag fabrics, modeling contact between
a master surface and a slave surface which are supposed to belong to an
airbag. This is a soft penalty contact which can deal with penetrations and
intersections often coming in the folded airbag mesh. This interface can be
used for self-impacting.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.281

Card Description

Note:  Block Format Keyword

Samcef Cards

Card Description Examples

.BOLT Defines a bolt contact.
.BOLT I 1 NDIST 1155 MACRO 2090 $
GROUP "PRETENS_1" METHOD 1 ! "BOLT_1"

.CLM NOEUD I 1155 CHA COMP 1 VAL 150000.0

.BOLT I 2 NDIST 1156 MACRO 3090 FIX 2 $
GROUP "PRETENS_2" METHOD 2 ! "BOLT_2"

.CLM NOEUD I 1156 DEP VAL 10.5 COMP 1

.MCT Defines a flexible
contact. .MCT I 10 GROUP 17 GTAR 23 OPT 3 ! Contact default

.MCT I 20 GROUP 65 GTAR 12 OPT 2 NLIM -1 UN3 1
DMIN -0.0245 KSMO 1 ! Advanced contact

.MCT I 30 GROUP 45 GTAR 75 OPT 2 UN3 1 OCPO 2
KSMO 1 ! Glue contact

.STI Defines a glue contact.
.STI I 1 GROUP 17 23 PROJ 0! Glue default

.STI I 2 GROUP 35 64 ! Advanced glue

.ZYG Defines a periodic
condition or cyclic
condition - explicit
mode contact.

.ZYG GROUP "slaves_nodes" "master" $
TRAN 0.0 1.0 0.0 ! "contact_Periodic"

.ZYG GROUP "slaves_nodes" "master" $
WAVE 1 $
AXE X $
ORIGIN 0.88366595 1.02703438 -40.0 $
ANGL 45.0 $
PROJ 0 ! "contact_cyclic"
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Card Description Examples

.ZYG_AUTO Defines a cyclic
condition - automatic
mode contact.

.ZYG AUTO GROUP "auto_elements" $

WAVE 0 $

AXE Y $
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Card Description Examples

ORIGIN -8.41253531 5.4064082 -16.47058824 !
"contact_Auto_Cyclic"

Hourglass
Hourglass entities define hourglass and bulk viscosity properties which are referenced via HGID in the
*PART command.

LS-DYNA Cards

Card Description

*HOURGLASS Define hourglass and bulk viscosity properties which are referenced via
HGID in the *PART command

Interface Component
Interface Component entities create an interface in interface file for use in subsequent linking
calculations.

Each definition consists of a set of cards that define the interface. Interfaces may consist of a set of
segments for later use with *INTERFACE_LINKING_SEGMENT, an ordered line of nodes for use with
*INTERFACE_LINKING_EDGE, or an unordered set of nodes for use with *INTERFACE_LINKING_NODE.

LS-DYNA Cards

Card Description

*INTERFACE_COMPONENT
(NODE & SEGMENT)

Creates an interface in interface file for use in subsequent linking
calculations.

Interface Linking
Interface Linking Discrete keyword link node(s) to an interface in an existing interface file.

This link applies to all element types. With this command, nodes in a node set must be given in the
same order as they appear in the interface file.
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Interface Linking Edge keyword link a series of nodes to an interface in an existing interface force file.

Interface Linking Segment keyword link segments to an interface in an existing interface file.

LS-DYNA Cards

Card Description

*INTERFACE_LINKING
(DISCRETE, EDGE and
SEGMENT)

Link entities to an interface in existing interface file.

Joints
Joint entities define the kinematic relationship between two bodies (for Ball, Cylinder, Revolute, Slider
joints) or three bodies (for DoubleSlider joints).

Joints are created and organized in the Mechanism Browser.

Laminates
Laminate entities define laminates, which make up a laminated structure by defining the stacking
sequence of ply entities that make up the laminated structure.

Ply Laminates
Define laminates which make up flat or slightly curved laminated structures.
Ply laminates stack ply entities. The stack direction for the plies of a ply laminate is in the
direction of the element's normal.
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Figure 132:

Sub-Laminates
Similar to ply laminates in that they also stack ply entities. However, sub-laminates define only a
portion of a laminate rather than a complete laminate structure.
The stack direction for the plies of a sublaminate is defined by an interface definition within an
associated interface laminate. However, the ply order defined within a sublaminate must remain
in the defined order. An interface definition of an interface laminate defines which ply of the
sublaminate is on “top” and which is on the “bottom” relative to the elements normal.
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Figure 133:

Interface Laminates
Define laminates which make up complex laminated structures that wrap around corners.
Interface laminates stack sublaminates. The stack direction for the sublaminates of an interface
laminate is in the direction of the element's normal. The exact stacking sequence of the plies of
the sublaminates is defined by the interface definitions within an interface laminate. An interface
definition defines which surface plies of two sublaminates touch, or interface, with each other.
Each sublaminate stacked within an interface laminate must have at least one interface definition.
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Figure 134:

Supported Solver Cards
Solver cards supported for laminates.

Abaqus Cards
If a laminate is realized, as many composite properties as needed are created to represent the ply
and laminate based definition. A ‘template’ composites property (SHELL SECTION or SHELL GENERAL
SECTION) has to be assigned all concerned elements first, as the algorithm derives the new properties
from the same.
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The laminate name ends up in the LAYUP parameter of the Abaqus property.

Nastran Cards
If a laminate is realized, as many composite properties (PCOMPG) as needed are created to represent
the ply and laminate based definition. A ‘template’ composites property PCOMPP has to previously be
assigned all concerned elements. The PCOMPP property is not exported.

OptiStruct Cards
Laminate realization can be used to convert a ply based model into a zone based model. In this case the
export state of all ply related entities (PCOMPP property, PLY and STACK) will be set so that they are not
exported.

To generate PCOMPG properties representing the ply and laminate definition, a PCOMPP card has to
be defined and assigned to the elements involved in the composites definition before the realization is
started.

Card Description

STACK Defines the stacking information and stacking sequence for ply-based
composite definition.

Note:  Bulk Data Entry

Radioss Cards
The stacking definition of the property cards /PROP/STACK (TYPE17), /PROP/TYPE51, and /STACK are
represented as a laminate entity.

Samcef Cards
Laminates created will be selected in the definition of the composite properties (.ETASHELL or .
ETASOLID).

Create and Realize Laminates
Overview of how to create and realize laminates.

Create Laminates

Radioss

1. In the Model Browser, right-click and select Create > Laminate from the context menu.

2. In the Create Laminate dialog, define attributes accordingly.
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Option Description

Type Defines the type of laminate definition.

Name Name of laminate.

Save as Duplicate an existing laminate.

Card image Card image of the property that will be linked with the laminate (/PROP/
TYPE17 > P17_STACK or /PROP/TYPE51 > P51_STACK), or will create /
STACK and /PROP/PCOMPP if card image LAM_STACK is used.

Color Laminate color.

Laminate option Only the Total option is available.

Define laminate Select plies, and define the stacking sequence.

Phi and Zi will define the attributes of the same name in /PROP/TYE17 or /
PROP/TYPE51.

The stacking sequence can be modified at any time using the Entity Editor.

You can modify the stacking sequence of a set of defined plies at any time by
right-clicking on the laminate in the Model Browser and selecting Edit from
the context menu.

3. Click Create.

When you create a laminate entity via the Model Browser, a corresponding property entity with the /
PROP/TYPE17 (STACK) or /PROP/TYPE51 card image is created, and assigned to the laminate entity. If
you select the card image LAM_STACK, HyperMesh will create the corresponding /STACK keyword and
the /PROP/PCOMPP property, and link the laminate with the created property.
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Figure 135:

If you create a property entity with the /PROP/STACK (TYPE17) or /PROP/TYPE51 card image, you
can manually assign the corresponding laminate entity in the Entity Editor, Laminate field, using the
Laminate selector.
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Figure 136:

Realize Laminates

Before you can realize laminates, a ‘template’ property must be assigned to all elements referred to
through the ply and laminate entities.

In the Model Browser, right-click on a laminate and select Realize from the context menu.
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A ply based model is converted into a zone based model. The realization algorithm creates as many
properties as needed (as a copy from the template property) to represent the ply/laminate definition.
Each region of the model with a unique set of layers will get its own property.

Load Steps
Load step entities define and store load cases for a given analysis.

Load steps are defined by selecting associated load collectors and output blocks.

Abaqus Cards
A load step corresponds to a *STEP definition in Abaqus model history. Load collectors, output blocks
and groups within a load step are exported under the corresponding *STEP block in the Abaqus input
deck.

Card Description

*ADAPTIVE MESH Defines an adaptive mesh domain and specifies the frequency and intensity
of adaptive meshing for that domain.

Note:  Defined in the load step card image.

*BUCKLE Obtain eigenvalue buckling estimates.

Note:  Defined in the load step card image.

*BULK VISCOSITY

(Explicit)

Modify bulk viscosity parameters.

Note:  History data.

*COUPLED TEMP-
DISPLACEMENT

Analyze problems where the simultaneous solution of the temperature and
stress/displacement fields are necessary.

Note:  Defined in the load step card image.

*DYNAMIC

(Explicit)

Dynamic stress/displacement analysis.

Note:  Defined in the load step card image.

*DYNAMIC

(Standard)

Dynamic stress/displacement analysis.
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Card Description

Note:  Defined in the load step card image.

*FILE FORMAT Specify format for results file output and invoke zero-increment results file
output.

Note:  Defined in the load step card image.

*FREQUENCY Extract natural frequencies and modal vectors.

Note:  Defined in the load step card image.

*GEOSTATIC Verify that the geostatic stress field is in equilibrium with the applied loads
and boundary conditions on the model and to iterate, if needed, to obtain
equilibrium.

*HEAT TRANSFER Transient or steady-state uncoupled heat transfer analysis.

Note:  Defined in the load step card image.

*LOAD CASE Begin a load case definition for multiple load case analysis.

Note:  Defined in the load step card image.

*MODAL DYNAMIC Dynamic time history analysis using modal superposition

Note:  Defined in the load step card image.

*MONITOR Define a degree of freedom to monitor.

Note:  Defined in the load step card image.

*PRINT Request or suppress output to the message file in an Abaqus/Standard
analysis or to the status file in an Abaqus/Explicit analysis.

Note:  Defined in the load step card image.

*RADIATION_
VIEWFACTOR

Control the calculation of viewfactors during a cavity radiation analysis.
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Card Description

Note:  Defined in the load step card image; visible in *Heat
Transfer analysis procedure.

*RESPONSE SPECTRUM Calculates estimates of peak values of nodal and element responses.

Note:  Defined in the load step card image.

*RESTART WRITE Save and reuse data and analysis results.

Note:  Defined in the load step card image.

*STATIC Static stress/displacement analysis.

Note:  Defined in the load step card image.

*STEADY STATE
DYNAMICS

Steady-state dynamic response based on harmonic excitation.

Note:  Defined in the load step card image.

*STEP Begin a step.

Note:  Parameters are defined in the load step card image.

*VISCO Transient, static, stress/displacement analysis with time-dependent material
response (creep, swelling, and viscoelasticity)

Note:  Defined in the load step card image.

ANSYS Cards

Card Description

ACEL Specifies the linear acceleration of the structure.

ANTYPE Specifies the analysis type and restart status.

CECMOD
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Card Description

CMACEL Specifies the translational acceleration of an element component.

CMDOMEGA Specifies the rotational acceleration of an element component about a user-
defined rotational axis.

CMOMEGA Specifies the rotational velocity of an element component about a user-
defined rotational axis.

EQSLV Specifies the type of equation solver.

LSSOLVE Reads and solves multiple load steps.

NLGEOM Includes large-deflection effects in a static or full transient analysis.

NSUBST Specifies the number of substeps to be taken this load step.

OMEGA Specifies the rotational velocity of the structure.

OUTRES Controls the solution data written to the database.

TIME Sets the time for a load step.

Nastran Cards
Load step entities directly correspond to Nastran subcase definitions.

Load steps can reference constraint (SPC), static load (LOAD), multi-point constraint (MPC), fictitious
support (SUPORT1), non-linear parameters (NLPARM), eigenvalue extraction data (METHOD), frequency
range (FREQ), damping (SDAMPING), dynamic load (DLOAD), thermal loading (TEMP), and so on
subcase definitions. Other input data is automatically generated (the SUBCASE header) or may be
added to the subcase definition.

Card Description

NLSTEP Describes the control parameters for mechanical, thermal and coupled
analysis in SOL 400 and for linear contact analysis in SOL 101.

SUBCASE Delimits and identifies a subcase.

SUBCOM Defines a combination subcase.

Note:  Automatically created when a new load step of type
“Combination Subcase Delimiter” is created. The SUBCOM ID
matches the ID of the HyperMesh load step entity.

SUBSEQ Subcase sequence coefficients.
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Card Description

Note:  Only available for Combination Subcase Delimiter load
steps.

Enable SUBSEQ to input combination coefficients.

TSTEPNL Defines parametric controls and data for nonlinear transient structural or
heat transfer analysis.

OptiStruct Cards
Loadsteps directly correspond to OptiStruct subcases. Load steps can reference static loads (LOAD),
constraints (SPC), and dynamic loads (DLOAD).

Supported card parameters are dependent upon the selected analysis type (solution sequence).

Card Description

ACCELERATION Requests acceleration vector output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select ACCELERATION.

ANALYSIS Used in the I/O Options section to request that only a finite element analysis
be performed (optimization input is ignored). It may also be used in the I/
O Options or Subcase Information sections to identify the solution sequence
for all subcases or for individual subcases, respectively.

Note:  Subcase Information Entry

Enable the subcase option ANALYSIS and then select an analysis
type.

CMSMETH Requests that only a component mode synthesis solution be performed and
to select a component mode synthesis method definition to be used.

Note:  Subcase Information Entry

CSTRAIN Requests ply strain output for elements referencing PCOMP, PCOMPP or
PCOMPG properties for all subcases or individual subcases, respectively.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.297

Card Description

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select CSTRAIN.

CSTRESS Requests ply stress output for elements referencing PCOMP, PCOMPP or
PCOMPG properties for all subcases or individual subcases, respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select CSTRESS.

DESOBJ Selects a single response definition as the objective function of an
optimization, or to select system response definitions when the objective
function is the least squares sum of these definitions. The DESOBJ command
also indicates if this response is to be minimized or maximized.

Note:  Subcase Information Entry

Part of the optimization problem setup, created when you define
an objective.

DESSUB Used within a subcase definition, to select a constraint set that is subcase
dependent.

Note:  Subcase Information Entry

Part of the optimization problem setup, created when you define
a dconstraint.

DISPLACEMENT Requests displacement vector output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select DISPLACEMENT.

DLOAD Selects a dynamic load to be applied in a transient and frequency response
analysis subcase. The DLOAD command can also be used to select a user-
defined loading curve to be applied in a nonlinear static analysis subcase.

Note:  Subcase Information Entry

Enable the subcase definition DLOAD and select load collectors
with dynamic loading information (DLOAD, RLOAD1, RLOAD2,
TLOAD1, TLOAD2).
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Card Description

EIGVRETRIEVE Retrieves eigenvalue and eigenvector results of a Normal Modes Analysis
from an external data file (.eigv).

Note:  Subcase Information Entry

EIGVSAVE Outputs eigenvalue and eigenvector results of a Normal Modes Analysis to
an external data file (.eigv).

Note:  Subcase Information Entry

ELFORCE Requests structural element force output and elemental fluid particle velocity
output for all subcases or individual subcases, respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select ELFORCE.

ERP Requests equivalent radiated power output for all subcases or individual
subcases, respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select ERP.

ESE Requests strain energy and strain energy density output for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select ESE.

EXCLUDE Selects a set of elements to be excluded from a Linear Buckling Analysis.

Note:  Subcase Information Entry

Enable the subcase option OUTPUT to select EXCLUDE, then
select a SET definition.

FATDEF Selects a FATDEF Bulk Data Entry that will define the elements, and their
associated fatigue properties, to be considered for Fatigue Analysis.

Note:  Subcase Information Entry
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Card Description

FATPARM Selects a FATPARM Bulk Data Entry that will define the parameters to be used
for a Fatigue Analysis.

Note:  Subcase Information Entry

FATSEQ Indicates that a subcase is a fatigue analysis subcase and to select a
FATSEQ Bulk Data Entry that will define the loading sequence for the Fatigue
Analysis.

Note:  Subcase Information Entry

FREQUENCY Selects the set of forcing frequencies to be solved in a frequency response
problem.

Note:  Subcase Information Entry

Enables you to select load collectors with frequency information
(FREQ, FREQ1, FREQ2, FREQ3, FREQ4, FREQ5).

GLOBSUB Selects a subcase that references the global structure for Local-Global
Analysis and a set of grid points in the local structure that defines the cut
surface for displacement.

Note:  Subcase Information Entry

GPFORCE Requests grid point force balance output for all subcases or individual
subcases, respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select GPFORCE.

GPSTRESS Requests grid point stresses output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select GPSTRESS.

IC Selects initial conditions for Transient and Explicit Analysis.

Note:  Subcase Information Entry
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Card Description

INVEL Selects a multibody initial velocity set to be applied in a multibody problem.

Note:  Subcase Information Entry

LABEL Provides a subcase with a label.

Note:  Subcase Information Entry

LOAD Selects a static load set to be applied in linear static solutions.

Note:  Subcase Information Entry

Enables you to select load collectors with static load information
(FORCE, MOMENT, PLOAD, PLOAD2, PLOAD4, LOAD), or inertial
loading information (GRAV, RFORCE).

MBSIM Selects a Multibody simulation definition to be applied in a Multibody
problem.

Note:  Subcase Information Entry

METHOD Selects a method for real eigenvalue extraction.

Note:  Subcase Information Entry

Select load collectors with an EIGRL card image for
METHOD(STRUCT) or METHOD(FLUID).

MLOAD Selects a Multibody load set to be applied in a Multibody problem.

Note:  Subcase Information Entry

Enables you to select load collectors with multi-body dynamic
load information (GRAV, MBFRC, MBFRCC, MBMNT, MBMNTC,
MLOAD).

MODEWEIGHT Defines a multiplier for computed eigenvalues that are to be used in
the calculation of the "weighted reciprocal eigenvalue" and "combined
compliance index" optimization responses.
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Card Description

Note:  Subcase Information Entry

Part of the optimization problem setup, created when you define
a response.

MOTION Selects a Multibody motion set to be applied in a multibody problem.

Note:  Subcase Information Entry

Enables you to select load collectors with multi-body dynamic
motion information (MOTION, MOTNG, MOTNGC).

MPC Selects a multi-point constraint set.

Note:  Subcase Information Entry

MPCFORCE Requests multi-point force of constraint vector is output for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase Information Entry

NLPARM Activates nonlinear solution methods for this subcase and to select the
parameters used for Nonlinear Quasi-static Analysis, Geometric Nonlinear
Implicit Analysis, and Nonlinear Direct Transient Analysis.

Note:  Subcase Information Entry

NSM Selects a non-structural mass set for mass generation. The selector
command must appear before the first SUBCASE statement.

Note:  Subcase Information Entry

OFREQUENCY Requests a set of frequencies for output requests for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select OFREQUENCY.

OLOAD Requests the form of applied load vector output and temperature load
output for all subcases or individual subcases, respectively.
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Card Description

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select OLOAD.

OMODES Requests a set of modes for output requests for all subcases or for individual
subcases, respectively. This command is applicable for normal modes and
linear buckling solution sequences only.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select OMODES.

RESVEC Controls the calculation of residual vectors.

Note:  Subcase Information Entry

RSPEC References combination rules, excitation degrees-of-freedom, and input
spectra for use in response spectrum analysis.

Note:  Subcase Information Entry

RWALL Selects rigid walls for geometric nonlinear analysis.

Note:  Subcase Information Entry

SDAMPING Applies modal damping as a function of natural frequency in modal
solutions.

Note:  Subcase Information Entry

SOLVTYP Defines the solver type to be used for static, dynamic analysis and
geometric nonlinear implicit analysis.

Note:  Bulk Data Entry

SPC Selects a single-point constraint set.

Note:  Subcase Information Entry
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Card Description

SPCFORCES Requests single-point force of constraint vector output for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase Information Entry

STATSUB Selects a static solution subcase.

Note:  Subcase Information Entry

STRAIN Requests strain output for all subcases or individual subcases, respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select STRAIN.

STRESS Requests stress output for all subcases or individual subcases, respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select STRESS.

SUBCASE Indicates the start of a new subcase definition.

Note:  Subcase Information Entry

SUBCOM Delimits and identifies a combination subcase.

Note:  Subcase Information Entry

SUBMODEL Selects a submodel as a set of elements. Subcase entries specific to the
selected element set can be used to solve the submodel without affecting
the rest of the structure.

Note:  Subcase Information Entry

SUBSEQ Gives the coefficients for forming a linear combination of the previous static
subcases.

Note:  Subcase Information Entry

SUBTITLE Defines the subtitle for all subcases or for individual subcases, respectively.
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Card Description

SUPORT1 Selects a fictitious support set to be applied to the model.

Note:  Subcase Information Entry

TEMP Defines temperature at grid points or a SET of grid points for determination
of Thermal Loading and Stress recovery.

TSTEP Selects integration for transient analysis.

Note:  Subcase Information Entry

TTERM Used in a geometric nonlinear subcase to define the termination time.

Note:  I/O Options and Subcase Information Entry

VELOCITY Requests velocity vector output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase Information Entry

Enable the subcase option OUTPUT to select VELOCITY.

WEIGHT Defines a weighting factor (multiplier) for the compliances of individual
linear static solution subcases, which are used in the calculation of the
"weighted compliance" and "combined compliance index" optimization
responses.

Note:  Subcase Information Entry

XHIST Selects time history output for geometric nonlinear analysis.

Note:  Subcase Information Entry

Permas Cards

Card Description

$CONSTRAINTS Constraint variant bracket header line.
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Card Description

Note:  Set AnalysisProcedure to CONSTRAINTS.

$FREQLOAD Definition of frequency dependent dynamic loads for use in frequency
response analysis.

Note:  Only available when AnalysisProcedure is set to
LOADING.

$LOADING Loading variant bracket header line.

Note:  Set AnalysisProcedure to LOADING.

$NLLOAD Define a nonlinear static load history.

Note:  Only available when AnalysisProcedure is set to
LOADING.

$SITUATION Situation definition header line.

Note:  Set AnalysisProcedure to SITUATION.

$TRANSLOAD Definition of time dependent dynamic loads for use in transient response
analysis.

Note:  TRANSLOAD cards and FREQLOAD cards are mutually
exclusive.

Materials
Material entities define and store material definitions for a model.

Materials do not have a display state in the modeling window. You can color the model according to the
colors assigned to each material, which is based on element material relationships, by changing the
color mode to material.

Element material relationships are dependent on the solver interface. In general, when a component is
assigned a material, that material assignment is applied to all elements collected by that component.
The method of assigning materials at the component level is therefore referred to as indirect material
assignment. Direct material assignment is performed directly on the elements themselves, typically via
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a property assignment. Direct material assignments always take precedence over indirect property and
material assignments.

Abaqus Cards
The material keywords *MATERIAL, *GASKET MATERIAL, and *CONNECTOR BEHAVIOR are supported in
the ABAQUS_MATERIAL, GASKET_MATERIAL and CONNECTOR_BEHAVIOR card images, respectively.

Abaqus has a large selection of material types, many of which are not supportered. In the Abaqus
solver interface, material cards can be imported as generic materials. Generic materials are assigned
the GENERIC_MATERIAL card image, and all material sub-options, parameters, and data lines are
imported as simple text.

The validity or syntax of data is not checked when material cards are imported as generic materials. You
must manually check the validity of the data. This method is helpful when material models are already
defined, and are imported for the purpose of adding them to the corresponding sectional properties. No
editing, updating, or review of the material data is intended.

The Generic Material setting can be enabled in the File Options dialog, that opens when you import a
solver deck. You can also add an **HM_GENERIC_MATERIAL comment before a material card to have it
imported as a generic material.

User comments blocks are supported for all materials. These comments are preserved during import
and export of the Abaqus solver deck.

Card Description

*BIAXIAL TEST DATA Provides biaxial test data (compression and/or tension).

*BRITTLE CRACKING Define cracking and postcracking properties for the brittle cracking material
model.

*BRITTLE FAILURE Used with the brittle cracking material model to specify brittle failure of the
material.

*BRITTLE SHEAR Define the postcracking shear behavior of a material used in a brittle
cracking model.

*CLAY HARADENING Define piecewise linear hardening/softening of the Cam-clay plasticity yield
surface.

*CLAY PLASTICITY Specify the plastic part of the material behavior for elastic-plastic materials
that use the extended Cam-clay plasticity model.

*COMBINED TEST DATA Simultaneously defines the normalized shear and bulk compliance or
relaxation moduli as functions of time.
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Card Description

Note:  Must be used in conjunction with the *VISCOELASTIC
option.

Cannot be used if the *SHEAR TEST DATA and *VOLUMETRIC
TEST DATA options are used.

*CONDUCTIVITY Defines thermal conductivity.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*CONNECTOR
BEHAVIOR

Begins the specification of a connector behavior.

*CONNECTOR
CONSTITUTIVE
REFERENCE

Defines reference lengths and angles to be used in specifying connector
constitutive behavior.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

*CONNECTOR CONTACT
FORCE

Defines the damping behavior for connector elements.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

*CONNECTOR DAMPING Defines connector damping behavior.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

*CONNECTOR DERIVED
COMPONENTS

Define user-customized components from numbered components.

*CONNECTOR
ELASTICITY

Defines connector elastic behavior.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

*CONNECTOR FAILURE Defines a failure criterion for connector elements.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

Only available in the Explicit template.

*CONNECTOR FRICTION Defines friction forces and moments in connector elements.
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Card Description

(Abaqus 6.4 version)
Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

*CONNECTOR FRICTION

(Abaqus 6.5 or later
version)

Defines friction forces and moments in connector elements.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

A *FRICTION card is needed, which can be created as a property
using the FRICTION card image.

*CONNECTOR
HARDENING

Defines the initial yield surface size and, optionally, the post-yield hardening
behavior in connector available components of relative motion.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

*CONNECTOR LOCK Defines a locking criterion for connector elements.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

*CONNECTOR
PLASTICITY

Defines plasticity behavior in connector elements. It must be used in
conjunction with the *CONNECTOR HARDENING option.

*CONNECTOR
POTENTIAL

Define a restricted set of mathematical functions to represent yield or
limiting surfaces in the space spanned by connector available components.

*CONNECTOR STOP Defines connector stops for connector elements.

Note:  Sub-option in the CONNECTOR_BEHAVIOR card image.

*CREEP Defines a creep law.

Note:  Sub-option in both the ABAQUS_MATERIAL and *GASKET
MATERIAL card images.

Only available in the Standard templates.

*CRUSHABLE FOAM Defines the crushable foam plasticity model.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*CRUSHABLE FOAM
HARDENING

Defines hardening for the crushable foam plasticity model.
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Card Description

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*DAMPING Defines material damping.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*DETONATION POINT Defines detonation points for a JWL explosive equation of state.

Note:  Sub-option in the ABAQUS_MATERIAL card image.
Available when *EOS, Type=JWL is selected.

Only available for Abaqus/Explicit.

*DENSITY Defines material mass density.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*DIELECTRIC Defines dielectric material properties.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*ELASTIC Defines elastic material properties.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*EOS Defines a hydrodynamic material model in the form of an equation of state.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

It is only available for Abaqus/Explicit.

*EOS COMPACTION Defines plastic compaction behavior for a hydrodynamic material.

Note:  Sub-option in the ABAQUS_MATERIAL card image.
Available when *EOS, Type=USUP / TABULAR is selected.

It is only available for Abaqus/Explicit.

*EXPANSION Defines thermal expansion.
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Card Description

Note:  Sub-option in both the ABAQUS_MATERIAL and *GASKET
MATERIAL card images.

*FABRIC Define the in-plane behavior of a fabric material under plane stress
conditions.

*FLUID BEHAVIOR Defines fluid behavior for a fluid cavity.

*GASKET BEHAVIOR Begins the specification of a gasket behavior.

Note:  Only available in the Standard templates.

*GASKET CONTACT
AREA

Defines a gasket contact area or contact width for average pressure output.

Note:  Sub-option in the *GASKET_MATERIAL card image.

*GASKET ELASTICITY Defines elastic properties for the membrane and transverse shear behaviors
of a gasket.

Note:  Sub-option in the *GASKET_MATERIAL card image.

*GASKET THICKNESS
BEHAVIOR

Defines a gasket thickness-direction behavior.

Note:  Sub-option in the *GASKET_MATERIAL card image.

*GAS SPECIFIC HEAT Defines the specific heat of reacted gas products for an ignition and growth
equation of state.

Note:  Sub-option in the ABAQUS_MATERIAL card image.
Available when *EOS, Type=IGNITION AND GROWTH is
selected.

Only available for Abaqus/Explicit.

*HYPERELASTIC Defines elastic properties for approximately incompressible elastomers.
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Card Description

Note:  Sub-option in the ABAQUS_MATERIAL card image.

Supported sub-options:

*BIAXIAL TEST DATA

*PLANAR TEST DATA

*UNIAXIAL TEST DATA

*VOLUMETRIC TEST DATA

*HYPERFOAM Defines elastic properties for a hyperelastic foam.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

Supported sub-options:

*BIAXIAL TEST DATA

*PLANAR TEST DATA

*SIMPLE SHEAR TEST DATA

*UNIAXIAL TEST DATA

*VOLUMETRIC TEST DATA

*LOADING DATA Define the loading response data for the uniaxial behavior of connector
elements.

*LOW DENSITY FOAM Define material coefficients for low-density foam materials.

*MATERIAL Begins the definition of a material.

*MULLINS EFFECT Defines Mullins effect material parameters for elastomers.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

Supported sub-options:

*BIAXIAL TEST DATA

*PLANAR TEST DATA

*UNIAXIAL TEST DATA

*PIEZOELECTRIC Defines piezoelectric material properties.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

Only available in the Standard templates.

*PLANAR TEST DATA Provides planar test (or pure shear) data (compression and/or tension).

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.312

Card Description

Note:  This option can be used only in conjunction with the
*HYPERELASTIC option, the *HYPERFOAM option, and the
*MULLINS EFFECT option. This type of test does not define the
hyperelastic material constants fully; at the least, uniaxial or
biaxial test data should also be given.

*PLASTIC Defines a metal plasticity model.

*RATE DEPENDENT Defines a rate-dependent viscoplastic model.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*REACTION RATE Defines the reaction rate for an ignition and growth equation of state.

Note:  Sub-option in the ABAQUS_MATERIAL card image.
Available when *EOS, Type=IGNITION AND GROWTH is
selected.

Only available for Abaqus/Explicit.

*SHEAR FAILURE Defines a shear failure model and criterion.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

Only available for Abaqus/Explicit.

*SHEAR TEST DATA Provides shear test data.

Note:  Can be used only in conjunction with the *VISCOELASTIC
option.

*SIMPLE SHEAR TEST
DATA

Provides simple shear test data.

Note:  Can be used only in conjunction with the *HYPERFOAM
option.

*SPECIFIC HEAT Defines specific heat.

Note:  Sub-option in the ABAQUS_MATERIAL card image.
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Card Description

*UNIAXIAL Indicate the start of shear or uniaxial test data along a particular direction to
define the behavior of a fabric material.

*UNIXIAL TEST DATA Provides uniaxial test data (compression and/or tension).

Note:  Can be used only in conjunction with the
*HYPERELASTIC option, the *HYPERFOAM option, and the
*MULLINS EFFECT option.

*UNLOADING DATA Define unloading response for the uniaxial behavior of connector elements.

*USER MATERIAL Defines material constants for use in subroutine UMAT, UMATHT, or VUMAT.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

*USER OUTPUT
VARIABLES

Defines the number of user variables.

Note:  Sub-option in both the ABAQUS_MATERIAL and *GASKET
MATERIAL card images.

*VISCOELASTIC Defines dissipative behavior for use with elasticity.

Note:  Sub-option in the ABAQUS_MATERIAL card image.

Supported sub-options:

*COMBINED TEST DATA

*SHEAR TEST DATA

*VOLUMETRIC TEST DATA

For the sub-options, the parameters SHRINF and VOLINF are
supported.

*VOLUMETRIC TEST
DATA

Provides volumetric test data.

ANSYS Cards
If an unsupported field in a card is found, a message is displayed on the status bar. Messages are also
printed to the file ansys.msg. General slash commands, SOLUTION commands, POST1 commands, and
POST26 commands are referred to as control cards. Unrecognized cards are written to a *.hmx file.
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Card Description

MAT Sets the element material attribute pointer.

MP Defines a linear material property as a constant or a function of
temperature.

MPDATA Defines property data to be associated with the temperature table.

MPDATA Defines property data to be associated with the temperature table.

MPTEMP Defines a temperature table for material properties.

Note:  Supports temperature tables for each material attribute.

MPTEMP
Note:  Supports temperature tables for each material attribute.

TB Activates a data table for nonlinear material properties or special element
input.

TBDATA Defines data for the data table.

EXODUS Cards

Card Description

Acoustic

Anisotropic

Isotropic

Isotropic_Viscoelastic

Orthotropic

Stochastic

Feko
Supported media definitions and assignments are (anisotropic) dielectric media (with optional magnetic
properties) and metallic media. Feko’s default Free space, Perfect electric conductor, and Perfect
magnetic conductor materials are also supported.
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Properties are defined in HyperMesh to map the required material assignments to mesh elements.

For Feko wire segments (Bar2 and Bar3) a Property with the Card Image Segment must be defined and
applied to the Components that contain segments. The Segment radius, Core medium, and Surrounding
medium must be set in such a Property.

For Feko triangles (Tria3 and Tria6) a Property with the Card Image = Triangle must be defined and
applied to the Components that contain triangles. The Front and Back medium, and the Face medium
must be defined. For Metallic faces, the Thickness must be defined. For the boundary surface between
two dielectric regions (or between Free space and a dielectric) the Face Medium should be left as
<Unspecified>.

For Feko tetrahedra (Tetra4) a Property with the Card Image = Tetrahedron must be defined and
applied to the Components that contain tetrahedral mesh elements. The Volume medium must be set as
either a dielectric medium or Perfect electric conductor.

LS-DYNA Cards
LS-DYNA allows you to program your own materials that can be used in a simulation. Unsupported LS-
DYNA materials and user defined LS-DYNA materials are assigned the MAT_UNSUPPORTED card image.

HyperMesh imports unsupported material with the MAT_UNSUPPORTED card image, and preserves their
corresponding IDs and associated components.

In the MAT_UNSUPPORTED card image, all material sub-options, parameters, and data lines are
supported as simple text. The validity or syntax of any data is not checked in this mode. You must
manually check the validity of the data. No editing, updating, or review of the material data is intended.
Also, time step calculation and mass calculation are not available for the component that refers to this
material.

Card Description

DI Defines the dielectric or metallic medium properties.

SK Assigns a material property to a surface.

Card Description

*MAT_ACOUSTIC

(*MAT_090)

Appropriate for tracking low pressure stress waves in an acoustic media such
as air or water and can be used only with the acoustic pressure element
formulation.

Note:  Material Type 90

*MAT_ALE_INCOMPRESSIBLE

(*MAT_160)

Solves imcompressible flows with the ALE solver. It should be used with the
element formulation 6 and 12 in *SECTION_SOLID.
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Card Description

Note:  Material Type 160

*MAT_ANISOTROPIC_ELASTIC

(*MAT_002_ANIS)

Valid for modeling the elastic-orthotropic behavior of solids, shells and thick
shells.

Note:  Material Type 2

*MAT_ANISOTROPIC_ELASTIC_PLASTIC

(*MAT_157)

Valid for modeling the elastic-orthotropic behavior of solids, shells and thick
shells and solid elements.

Note:  Material Type 157

*MAT_ANISOTROPIC_PLASTIC

(*MAT_103_P)

Simplified version of the Material Type 103. Applies only to shell elements.

Note:  Material Type 103P

*MAT_ANISOTROPIC_VISCOPLASTIC

(*MAT_103)

Applies to shell and brick elements.

Note:  Material Type 103

*MAT_ARRUDA_BOYCE_RUBBER

(*MAT_127)

Provides a hyperelastic rubber model combined optionally with linear
viscoelasticity.

Note:  Material Type 127

*MAT_ARUP_ADHESIVE

(*MAT_169)

Used for adhesive bonding in aluminum structures.

Note:  Material Type 169

*MAT_BAMMAN

(*MAT_051)

Models temperature and rate dependent plasticity with a fairly complex
model that has many input parameters.

Note:  Material Type 51

*MAT_BAMMAN_DAMAGE

(*MAT_052)

Extension of model 51 which includes the modeling of damage.

Note:  Material Type 52
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Card Description

*MAT_BARLAT_ANISOTROPIC_PLASTICITY

(*MAT_033)

Used for modeling anisotropic material behavior in forming processes.

Note:  Material Type 33

*MAT_BARLAT_YLD2000

(*MAT_133)

Developed to overcome some shortcomings of the six parameters Barlat
model implemented at Material Type 33. Available for shell elements only.

Note:  Material Type 133

*MAT_BARLAT_YLD96

(*MAT_033_b)

Used for modeling anisotropic material behavior in forming processes in
particular for aluminum alloys. Available for shell elements only.

Note:  Material Type 33b

*MAT_BILKHU/
DUBOIS_FOAM

(*MAT_075)

Used for the simulation of isotropic crushable forms.

Note:  Material Type 75

*MAT_BLATZ-KO_FOAM

(*MAT_038)

Used for the definition of rubber-like foams of polyurethane.

Note:  Material Type 38

*MAT_BLATZ-
KO_RUBBER

(*MAT_007)

Used for the modeling of nearly incompressible continuum rubber.

Note:  Material Type 7

*MAT_BOLT_BEAM

(*MAT_208)

Used with beam elements using ELFORM=6 (Discrete Beam).

Note:  Material Type 208

*MAT_BRITTLE_DAMAGE

(*MAT_096)

*MAT_CABLE_DISCRETE_BEAM

(*MAT_071)

Permits elastic cables to be realistically modeled; thus, no force will develop
in compression.

Note:  Material Type 71
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*MAT_CELLULAR_RUBBER

(*MAT_087)

Provides a cellular rubber model with confined air pressure combined with
linear viscoelasticity.

Note:  Material Type 87

*MAT_CLOSED_CELL_FOAM

(*MAT_053)

Used for the modeling of low density, closed cell polyurethane foam.

Note:  Material Type 53

*MAT_CODAM2

(*MAT_219)

A sub-laminate-based continuum damage mechanics model for fiber
reinforced composite laminates made up of transversely isotropic layers.
Used for brick, shell, and thick shell elements.

Note:  Material Type 219

*MAT_COHESIVE_ELASTIC

(*MAT_184)

Simple cohesive elastic model for use with solid element types 19 and 20
and is not available for other solid element formulations.

Note:  Material Type 184

*MAT_COHESIVE_GENERAL

(*MAT_186)

Cohesive material model that includes three general irreversible mixed-
mode interaction cohesive formulations with arbitrary normalized traction-
separation law given by a load curve.

Note:  Material Type 186

*MAT_COHESIVE_MIXED_MODE

(*MAT_138)

Cohesive material model that includes a bilinear traction-separation law with
quadratic mixed mode delamination criterion and a damage formulation.

Note:  Material Type 138

*MAT_COHESIVE_MIXED_MODE_ELASTOPLASTIC_RATE

(*MAT_240)

Cohesive material formulation limited to linear softening with mixed mode
delamination criterion and a damage formulation.

Note:  Material Type 240

*MAT_COHESIVE_TH

(*MAT_185)

Cohesive material for use with solid element types 19 and 20. Not available
for any other solid element formulation.
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Note:  Material Type 185

*MAT_COMPOSITE_DAMAGE

(*MAT_022)

An orthotropic material with optional brittle failure for composites can be
defined.

Note:  Material Type 22

*MAT_COMPOSITE_FAILURE_MODEL
Note:  Material Type 59

*MAT_COMPOSITE_FAILURE_SHELL_MODEL

(*MAT_059_SHELL) Note:  Material Type 59

*MAT_COMPOSITE_FAILURE_SOLID_MODEL

(*MAT_059_SOLID) Note:  Material Type 59

*MAT_COMPOSITE_LAYUP

(*MAT_116)

Used for modeling the elastic responses of composite layups that have an
arbitrary number of layers through the shell thickness.

Note:  Material Type 116

*MAT_COMPOSITE_MATRIX

(*MAT_117)

Used for modeling the elastic responses of composites where a pre-
integration is used to compute the extensional, bending, and coupling
stiffness coefficients for use with the Belytschko Tsay resultant shell
formulation.

Note:  Material Type 117

*MAT_COMPOSITE_MSC

(*MAT_161)

Used to model the progressive failure analysis for composite materials
consisting of unidirectional and woven fabric layers.

Note:  Material Type 161

*MAT_COMPOSITE_MSC_DMG

(*MAT_162)

Used to model the progressive failure analysis for composite materials
consisting of unidirectional and woven fabric layers.

Note:  Material Type 162
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*MAT_CONCRETE_DAMAGE

(*MAT_072)

Used to analyze buried steel reinforced concrete structures subjected to
impulsive loadings.

Note:  Material Type 72

*MAT_CONCRETE_DAMAGE_REL3

(*MAT_072R3)

Used to analyze buried steel reinforced concrete structures subjected to
impulsive loadings.

Note:  Material Type 72R3

*MAT_CONCRETE_EC2

(*MAT_172)

Represents plain concrete only, reinforcing steel only, or a smeared
combination of concrete and reinforcement.

Note:  Material Type 172

*MAT_CORUS_VEGTER

(*MAT_136)

Plane stress orthotropic material model for metal forming.

Note:  Material Type 136

*MAT_CRUSHABLE_FOAM

(*MAT_063)

Used to model crushable foam with optional damping and tension cutoff.

Note:  Material Type 63

*MAT_CSCM

(*MAT_159)

Concrete material

Note:  Material Type 159

*MAT_CSCM_CONCRETE

(*MAT_159_CONCRETE)

Concrete material

Note:  Material Type 159

*MAT_DAMPER_NONLINEAR_VISCUOUS

(*MAT_S05)

Used for discrete springs and dampers.

Note:  Material Type SD-5

*MAT_DAMPER_VISCOUS

(*MAT_S02)

Used for discrete springs and dampers.

Note:  Material Type SD-2
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*MAT_DESHPANDE_FLECK_FOAM

(*MAT_154)

Used for modeling aluminum foam used as a filler material in aluminum
extrusions to enhance the energy absorbing capability of the extrusion. For
solid elements.

Note:  Material Type 154

*MAT_ELASTIC

(*MAT_001)

Isotropic elastic material that is available for beam, shell and solid elements.

Note:  Material Type 1

*MAT_ELASTIC_FLUID

(*MAT_001_FLUID)

Isotropic elastic material available for beam, shell and solid elements.

Note:  Material Type 1

*MAT_ELASTIC_PLASTIC_HYDRO

(*MAT_010)

Used for the modeling of an elastic-plastic hydrodynamic material.

Note:  Material Type 10

*MAT_ELASTIC_PLASTIC_THERMAL

(*MAT_004)

Temperature dependent material coefficients can be defined.

Note:  Material Type 4

*MAT_ELASTIC_SPRING_DISCRETE_BEAM

(*MAT_074)

Permits elastic springs with damping to be combined and represented with a
discrete beam element type 6.

Note:  Material Type 74

*MAT_ELASTIC_VISCOPLASTIC_THERMAL

(*MAT_106)

Elastic viscoplastic material with thermal effects.

Note:  Material Type 106

*MAT_ELASTIC_WITH_VISCOSITY

(*MAT_060)

Used to simulate forming of glass products at high temperatures.

Note:  Material Type 60

*MAT_ELASTIC_6DOF_SPRING_DISCRETE_BEAM

(*MAT_093)

Defined for simulating the effects of nonlinear elastic and nonlinear viscous
beams by using six springs each acting about one of the six local degrees of
freedom.
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Note:  Material Type 93

*MAT_EMMI

(*MAT_151)

The Evolving Microstructural Model of Inelasticity (EMMI) is a temperature
and rate-dependent state variable model developed to represent the large
deformation of metals under diverse loading conditions. This model is
available for 3D solid elements, 2D solid elements and thick shell forms 3
and 5.

Note:  Material Type 151

*MAT_ENHANCED_COMPOSITE_DAMAGE

(*MAT_054)

Enhanced versions of the composite model Material Type 22.

Note:  Material Types 54-55

*MAT_FABRIC

(*MAT_034)

Developed for airbag materials.

Note:  Material Type 34

*MAT_FINITE_ELASTIC_STRAIN_PLASTICITY

(*MAT_112)

An elasto-plastic material with an arbitrary stress versus strain curve and
arbitrary strain rate dependency can be defined.

Note:  Material Type 112

*MAT_FLD_TRANSVERSELY_ANISOTROPIC

(*MAT_039)

Used for simulating sheet forming processes with anisotropic material.

Note:  Material Type 39

*MAT_FLD_3_PARAMETER_BARLAT

(*MAT_190)

Used for modeling sheets with anisotropic materials under plane stress
conditions.

Note:  Material Type 190

*MAT_FORCE_LIMITED

(*MAT_029)

With this material model, for the Belytschko-Schwer beam only, plastic hinge
forming at the ends of a beam can be modeled using curve definitions.

Note:  Material Type 29

*MAT_FRAZER_NASH_RUBBER_MODELThis model defines rubber from uniaxial test data.
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(*MAT_031)
Note:  Material Type 31

*MAT_FU_CHANG_FOAM

(*MAT_083)

Rate effects can be modeled in low and medium density foams.

Note:  Material Type 83

*MAT_FU_CHANG_FOAM_DAMAGE_DECAY

(*MAT_083_DAMAGE_DECAY)

Rate effects can be modeled in low and medium density foams.

Note:  Material Type 83

*MAT_GAS_MIXTURE

(*MAT_148)

Used for the simulation of thermally equilibrated ideal gas mixtures.

Note:  Material Type 148

*MAT_GENERAL_JOINT_DISCRETE_BEAM

(*MAT_097)

Used to define a general joint constraining any combination of degrees of
freedom between two nodes.

Note:  Material Type 97

*MAT_GENERAL_NONLINEAR_1DOF_DISCRETE_BEAM

(*MAT_121)

Very general spring and damper model.

Note:  Material Type 121

*MAT_GENERAL_NONLINEAR_6DOF_DISCRETE_BEAM

(*MAT_119)

Very general spring and damper model.

Note:  Material Type 119

*MAT_GENERAL_SPRING_DISCRETE_BEAMPermits elastic and elastoplastic springs with damping to be represented
with a discrete beam element type 6 using six springs each acting about one
of the six local degrees of freedom.

Note:  Material Type 196

*MAT_GENERAL_VISCOELASTIC

(*MAT_076)

Provides a general viscoelastic Maxwell model having up to 6 terms in the
prony series expansion and is useful for modeling dense continuum rubbers
and solid explosives.
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Note:  Material Type 76

*MAT_GEOLOGIC_CAP_MODEL

(*MAT_025)

This is an inviscid two invariant geologic cap model.

Note:  Material Type 25

*MAT_GEPLASTIC_SRATE_2000a

(*MAT_101)

Characterizes General Electric's commercially available engineering
thermoplastics subjected to high strain rate events.

Note:  Material Type 101

*MAT_GURSON

(*MAT_120)

Gurson dilatational-plastic model. Available for shell and solid elements.

Note:  Material Type 120

*MAT_GURSON_JC

(*MAT_120_JC)

Enhancement of Material Type 120. Gurson model with additional Johnson-
Cook failure criterion.

Note:  Material Type 120B

*MAT_GURSON_RCDC

(*MAT_120_RCDC)

This is an enhancement of material Type 120. This is the Gurson model with
the Wilkins Rc-Dc fracture model added. This model is available for shell and
solid elements.

Note:  Material Type 120C

*MAT_HIGH_EXPLOSIVE_BURN

(*MAT_008)

Used fo the modeling of the detonation of a high explosive.

Note:  Material Type 8

*MAT_HILL_FOAM

(*MAT_177)

Highly compressible foam.

Note:  Material Type 177

*MAT_HILL_3R

(*MAT_122)

Planar anisotropic material model with 3 R values.

Note:  Material Type 122
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*MAT_HILL_90

(*MAT_243)

Used for modeling sheets with anisotropic materials under plane stress
conditions.

Note:  Material Type 243

*MAT_HONEYCOMB

(*MAT_026)

The major use of this material model is for honeycomb and foam materials
with real anisotropic behavior.

Note:  Material Type 26

*MAT_HYDRAULIC_GAS_DAMPER_DISCRETE_BEAM

(*MAT_070)

Special purpose element represents a combined hydraulic and gas-filled
damper which has a variable orifice coefficient.

Note:  Material Type 70

*MAT_HYPERELASTIC_RUBBER

(*MAT_077_H)

Provides a general hyperelastic rubber model combined optionally with linear
viscoelasticity.

Note:  Material Type 77

*MAT_INELASTIC_SPRING_DISCRETE_BEAM

(*MAT_094)

Elastoplastic springs with damping are represented with a discrete beam
element type 6.

Note:  Material Type 94

*MAT_INELASTIC_6DOF_SPRING_DISCRETE_BEAM

(*MAT_095)

Defined for simulating the effects of nonlinear inelastic and nonlinear viscous
beams by using six springs each acting about one of the six local degrees of
freedom.

Note:  Material Type 95

*MAT_ISOTROPIC_ELASTIC_FAILURE

(*MAT_013)

Non-iterative plasticity with simple plastic strain failure model.

Note:  Material Type 13

*MAT_ISOTROPIC_ELASTIC_PLASTIC

(*MAT_012)

Very low cost isotropic plasticity model for three-dimensional solids.

Note:  Material Type 12
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*MAT_JOHNSON_COOK

(*MAT_015)

The Johnson/Cook strain and temperature sensitive plasticity is sometimes
used for problems where the strain rates vary over a large range and
adiabatic temperature increases due to plastic heating causes material
softening.

Note:  Material Type 15

*MAT_JOHNSON_HOLMQUIST_CERAMICS

(*MAT_110)

Used for modeling ceramics, glass, and other brittle materials.

Note:  Material Type 110

*MAT_JOHNSON_HOLMQUIST_CONCRETE

(*MAT_111)

Used for modeling concrete subjected to large strains, high strain rates, and
high pressures.

Note:  Material Type 111

*MAT_JOHNSON_HOLMQUIST_JH1

(*MAT_241)

Used for modeling ceramics, glass, and other brittle materials.

Note:  Material Type 241

*MAT_KELVIN-
MAXWELL_VISCOELASTIC

(*MAT_061)

Used for modeling viscoelastic bodies, such as foams.

Note:  Material Type 61

*MAT_KINEMATIC_HARDENING_BARLAT2000

(*MAT_242)

Used to model metal sheets under cyclic plasticity loading and with
anisotropy in plane stress condition.

Note:  Material Type 242

*MAT_KINEMATIC_HARDENING_BARLAT89

(*MAT_226)

Used to model metal sheets under cyclic plasticity loading and with
anisotropy in place stress condition.

Note:  Material Type 226

*MAT_KINEMATIC_HARDENING_TRANSVERSELY_ANISOTROPIC

(*MAT_125) Note:  Material Type 125
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*MAT_LAMINATED_COMPOSITE_FABRIC

(*MAT_058)

Depending on the type of failure surface, may be used to model composite
materials with unidirectional layers, complete layers, complete laminates,
and woven fabrics.

Note:  Material Type 58

*MAT_LAMINATED_GLASS

(*MAT_032)

With this material model, a layered glass including polymeric layers can be
modeled.

Note:  Material Type 32

*MAT_LAYERED_LINEAR_PLASTICITY

(*MAT_114)

Layered elastoplastic material with an arbitrary stress versus strain curve
and an arbitrary strain rate dependency can be defined.

Note:  Material Type 114

*MAT_LINEAR_ELASTIC_DISCRETE_BEAM

(*MAT_066)

Used for simulating the effects of a linear elastic beam by using six springs
each acting about one of the six local degrees of freedom.

Note:  Material Type 66

*MAT_LOW_DENSITY_FOAM

(*MAT_057)

Used for modeling high density foams.

Note:  Material Type 57

*MAT_LOW_DENSITY_SYNTHETIC_FOAM

(*MAT_179)

Used for modeling rate independent low density foams, which have the
property that the hysteresis in the loading-unloading curve is considerably
reduced after the first loading cycle.

Note:  Material Type 179

*MAT_LOW_DENSITY_SYNTHETIC_FOAM_WITH_FAILURE

(*MAT_179_WITH_FAILURE)

Used for modeling rate independent low density foams, which have the
property that the hysteresis in the loading-unloading curve is considerably
reduced after the first loading cycle.

Note:  Material Type 179

*MAT_LOW_DENSITY_SYNTHETIC_FOAM_ORTHO

(*MAT_180)

Used for modeling rate independent low density foams, which have the
property that the hysteresis in the loading-unloading curve is considerably
reduced after the first loading cycle.
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Note:  Material Type 180

*MAT_LOW_DENSITY_SYNETHIC_FOAM_ORTHO_WITH_FAILURE

(*MAT_180_WITH_FAILURE)

Used for modeling rate independent low density foams, which have the
property that the hysteresis in the loading-unloading curve is considerably
reduced after the first loading cycle.

Note:  Material Type 180

*MAT_LOW_DENSITY_VISCOUS_FOAM

(*MAT_073)

Used for modeling Low Density Urethane Foam with high compressibility and
with rate sensitivity which can be characterized by a relaxation curve.

Note:  Material Type 73

*MAT_MICROMECHANICS_DRY_FABRIC

(*MAT_235)

Used for modeling the elastic response of loose fabric used in inflatable
structures, parachutes, body armor, blade containments, and airbags.

Note:  Material Type 235

*MAT_MODIFIED_CRUSHABLE_FOAM

(*MAT_163)

Dedicated to modeling crushable foam with optional damping, tension cutoff,
and strain rate effects.

Note:  Material Type 163

*MAT_MODIFIED_HONEYCOMB

(*MAT_126)

Used for aluminum honeycomb crushable foam materials with anisotropic
behavior.

Note:  Material Type 126

*MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY

(*MAT_123)

An elasto-plastic material with an arbitrary stress versus strain curve and
arbitrary strain-rate dependency can be defined.

Note:  Material Type 123

*MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY_RATE

(*MAT_123_RATE)

An elasto-plastic material with an arbitrary stress versus strain curve and
arbitrary strain rate dependency can be defined.

Note:  Material Type 123
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*MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY_RTCL

(*MAT_123_RTCL)

An elasto-plastic material with an arbitrary stress versus strain curve and
arbitrary strain rate dependency can be defined.

Note:  Material Type 123

*MAT_MODIFIED_ZERILLI_ARMSTRONG

(*MAT_065)

Rate and temperature sensitive plasticity model which is sometimes
preferred in ordinance design calculations.

Note:  Material Type 65

*MAT_MOMENT_CURVATURE_BEAM

(*MAT_166)

Beam material for performing non-liner elastic or multi-linear plastic
analysis.

Note:  Material Type 166

*MAT_MOONEY_RIVLIN_RUBBER

(*MAT_027)

A two-parametric material model for rubber can be defined.

Note:  Material Type 27

*MAT_MTS

(*MAT_088)

Available for applications involving large strains, high pressures and strain
rates.

Note:  Material Type 88

*MAT_NONLINEAR_ELASTIC_DISCRETE_BEAM

(*MAT_067)

Used for simulating the effects of nonlinear elastic and nonlinear viscous
beams by using six springs each acting about one of the six local degrees of
freedom.

Note:  Material Type 67

*MAT_NONLINEAR_ORTHOTROPIC

(*MAT_040)

Used fo the definition of an orthotropic nonlinear elastic material based on a
finite strain formulation with the initial geometry as the reference.

Note:  Material Type 40

*MAT_NONLINEAR_PLASTIC_DISCRETE_BEAM

(*MAT_068)

Used for simulating the effects of nonlinear elastoplastic, linear viscous
behavior of beams by using six springs each acting about one of the six local
degrees of freedom.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.330

Card Description

Note:  Material Type 68

*MAT_NULL

(*MAT_009)

Allows equations of state to be considered without computing deviatoric
stresses.

Note:  Material Type 9

*MAT_OGDEN_RUBBER

(*MAT_077_O)

Provides the Ogden (1984) rubber model combined optionally with linear
viscoelasticity.

Note:  Material Type 77

*MAT_ORIENTED_CRACK

(*MAT_017)

This material may be used to model brittle materials which fail due to large
tensile stresses.

Note:  Material Type 17

*MAT_ORTHOTROPIC_ELASTIC

(*MAT_002)

Valid for modeling the elastic-orthotropic behavior of solids, shells and thick
shells.

Note:  Material Type 2

*MAT_ORTHOTROPIC_SIMPLIFIED_DAMAGE

(*MAT_221)

An orthotropic material with optional simplified damage and optional failure
for composites can be defined. Only valid for 3D solid elements with reduced
or full integration.

Note:  Material Type 221

*MAT_ORTHOTROPIC_THERMAL

(*MAT_021)

A linearly elastic, orthotropic material with orthotropic thermal expansion.

Note:  Material Type 21

*MAT_ORTHOTROPIC_VISCOELASTIC

(*MAT_086)

Allows the definition of an orthotropic material with a viscoelastic part.
Applies to shell elements.

Note:  Material Type 86
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*MAT_PIECEWISE_LINEAR_PLASTICITY

(*MAT_024)

An elasto-plastic material with an arbitrary stress versus strain curve and
arbitrary strain rate dependency can be defined.

Note:  Material Type 24

*MAT_PLASTICITY_COMPRESSION_TENSION

(*MAT_124)

An isotropic elastic-plastic material where unique yield stress versus plastic
strain curves can be defined for compression and tension.

Note:  Material Type 124

*MAT_PLASTICITY_COMPRESSION_TENSION_E0S

(*MAT_155)

An isotropic elastic-plastic material where unique yield stress versus plastic
strain curves can be defined for compression and tension.

Note:  Material Type 155

*MAT_PLASTIC_KINEMATIC

(*MAT_003)

Suited to model isotropic and kinematic hardening plasticity with the option
of including rate effects.

Note:  Material Type 3

*MAT_PLASTICITY_POLYMER

(*MAT_089)

An elasto-plastic material with an arbitrary stress versus strain curve and
arbitrary strain rate dependency can be defined.

Note:  Material Type 89

*MAT_PLASTICITY_WITH_DAMAGE

(*MAT_082, *MAT_081)

An elasto-visco-plastic material with an arbitrary stress versus strain curve
and arbitrary strain rate dependency can be defined.

Note:  Material Types 81-82

*MAT_PLASTICITY_WITH_DAMAGE_ORTHO

(*MAT_081_ORTHO)

Invokes an orthotropic damage model.

Note:  Material Types 81-82

*MAT_PLASTICITY_WITH_DAMAGE_ORTHO_RCDC

(*MAT_082_ORTHO_RCDC)

Invokes the damage model developed by Wilkins.

Note:  Material Types 81-82
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*MAT_PML_ELASTIC

(*MAT_230)

A perfectly-matched layer (PML) material. An absorbing layer material used
to simulate wave propagation in an unbounded isotropic elastic medium.
Only available for solid 8-node bricks (element type 2).

Note:  Material Type 230

*MAT_PML_ELASTIC_FLUID

(*MAT_230_FLUID)

A perfectly-matched layer (PML) material with a pressure fluid constitutive
law. Used in a wave-absorbing layer adjacent to a fluid material
(*MAT_ELASTIC_FLUID) in order to simulate wave propagation in an
unbound fluid medium.

Note:  Material Type 230

*MAT_POLYMER

(MAT_168)

Used for brick elements.

Note:  Material Type 168

*MAT_POWDER

(*MAT_271)

Used to analyze the compaction and sintering of cemented carbides. Only
available for solid elements.

Note:  Material Type 271

*MAT_POWER_LAW_PLASTICITY

(*MAT_018)

This is an isotropic plasticity model with rate effects which uses a power law
hardening rule.

Note:  Material Type 18

*MAT_PSEUDO_TENSOR

(*MAT_016)

This model has been used to analyze buried steel reinforced concrete
structures subjected to impulsive loadings.

Note:  Material Type 16

*MAT_RATE_SENSITIVE_POLYMER

(*MAT_141)
Used to model the simulation of an isotropic ductile polymer with strain rate
effects.

Known as the modified Ramaswamy-Stouffer model.

Note:  Material Type 141
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*MAT_RATE_SENSITIVE_POWERLAW_PLASTICITY

(*MAT_064)

Used to model strain rate sensitive elasto-plastic material with a power law
hardening.

Note:  Material Type 64

*MAT_RESULTANT_ANISOTROPIC

(*MAT_170)

This model is available for the Belytschko-Tsay and the C0 triangular shell
elements and is based on a resultant stress formulation.

Note:  Material Type 170

*MAT_RESULTANT_PLASTICITY

(*MAT_028)

A resultant formulation for beam and shell elements including elasto-plastic
behavior can be defined.

Note:  Material Type 28

*MAT_RIGID

(*MAT_020)

Parts made from this material are considered to belong to a rigid body (for
each part ID).

Note:  Material Type 20

*MAT_RIGID_DISCRETE

(*MAT_220)

Rigid material for shells or solids.

Note:  Material Type 220

*MAT_SAMP-1

(*MAT_187)

Uses an isotropic C-1 smooth yield surface for the description of non-
reinforced plastics.

Note:  Material Type 187

*MAT_SCHWER_MURRARY_CAP_MODEL

(*MAT_145)

The Schwer & Murray Cap Model, known as the Continuous Surface Cap
Model, is a three invariant extension of the Geological Cap Model (Material
Type 25) that also includes viscoplasticity for rate effects and damage
mechanics to model strain softening.

Note:  Material Type 145

*MAT_SEATBELT

(*MAT_B01)

Define a seat belt material.

Note:  Material Type B01
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*MAT_SEISMIC_BEAM

(*MAT_191)

Enables lumped plasticity to be developed at the 'node 2' end of Belytschko-
Schwer beams (resultant formulation).

Note:  Material Type 191

*MAT_SHAPE_MEMORY

(*MAT_030)

This material model describes the superelastic response present in shape-
memory alloys that is the peculiar material ability to undergo large
deformations with full recovery in loading-unloading cycles.

Note:  Material Type 30

*MAT_SID_DAMPER_DISCRETE_BEAM

(*MAT_069)

The side impact dummy uses a damper that is not adequately treated by the
nonlinear force versus relative velocity curves since the force characteristics
are dependent on the displacement of the piston.

Note:  Material Type 69

*MAT_SIMPLIFIED_JOHNSON_COOK

(*MAT_098)

Used for problems where the strain rates vary over a large range.

Note:  Material Type 98

*MAT_SIMPLIFIED_JOHNSON_COOK_ORTHOTROPIC_DAMAGE

(*MAT_099)

Implemented with multiple through thickness integration points. Extension
of Model 98 to include orthotropic damage as a means of treating failure in
aluminum panels.

Note:  Material Type 99

*MAT_SIMPLIFIED_RUBBER_FOAM

(*MAT_181)

Provides a rubber and foam model defined by a single uniaxial load curve or
by a family of uniaxial curves at discrete strain rates.

Note:  Material Type 181

*MAT_SIMPLIFIED_RUBBER_FOAM_WITH_FAILURE

(*MAT_181_WITH_FAILURE)

Provides a rubber and foam model defined by a single uniaxial load curve or
by a family of uniaxial curves at discrete strain rates.

Note:  Material Type 181

*MAT_SIMPLIFIED_RUBBER_WITH_DAMAGE

(*MAT_183)

Provides an incompressible rubber model defined by a single uniaxial load
curve for loading (or a table if rate effects are considered) and a single
uniaxial load curve for unloading.
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Note:  Material Type 183

*MAT_SOIL_AND_FOAM

(*MAT_005)

Simple model that works in some ways like a fluid.

Note:  Material Type 5

*MAT_SOIL_AND_FOAM_FAILURE

(*MAT_014)

The input for this model is the same as for *MAT_SOIL_AND_FOAM;
however, when the pressure reaches the failure pressure, the element loses
its ability to carry tension.

Note:  Material Type 14

*MAT_SOIL_CONCRETE

(*MAT_078)

Permits concrete and soil to be efficiently modeled.

Note:  Material Type 78

*MAT_SPECIAL_ORTHOTROPIC

(*MAT_130)

Applies to Belytschko-Tsay and the C0 triangular shell elements.

Note:  Material Type 130

*MAT_SPOTWELD

(*MAT_100)

Applies to beam elements Type 9 and to solid elements Type 1 with Type 6
hourglass controls.

Note:  Material Type 100

*MAT_SPOTWELD_DAIMLER_CHRYSLER

(*MAT_100_DAIMLER_CHRYSLER)

Applies to solid elements Type 1 with Type 6 hourglass controls.

Note:  Material Type 100

*MAT_SPOTWELD_DAMAGE-
FAILURE

(*MAT_100_DAMAGE-
FAILURE)

Applies to beam element type 9 and to solid element type 1 with type 6
hourglass controls.

Note:  Material Type 100

*MAT_SPRING_ELASTIC

(*MAT_S01)

Used for discrete springs and dampers. Provides a translational or rotational
elastic spring located between two nodes.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.336

Card Description

Note:  Material Type SD-1

*MAT_SPRING_ELASTOPLASTIC

(*MAT_S03)

Used for discrete springs and dampers. Provides an elastoplastic
translational or rotational spring with isotropic hardening located between
two nodes.

Note:  Material Type SD-3

*MAT_SPRING_GENERAL_NONLINEAR

(*MAT_S06)

Used for discrete springs and dampers. Provides a general nonlinear
translational or rotational spring with arbitrary loading and unloading
definitions.

Note:  Material Type SD-6

*MAT_SPRING_INELASTIC

(*MAT_S08)

Used for discrete springs and dampers. Provides an inelastic tension or
compression only, translational or rotational spring.

Note:  Material Type SD-8

*MAT_SPRING_MAXWELL

(*MAT_S07)

Used for discrete springs and dampers. Provides a three Parameter Maxwell
Viscoelastic translational or rotational spring.

Note:  Material Type SD-7

*MAT_SPRING_NONLINEAR_ELASTIC

(*MAT_S04)

Used for discrete springs and dampers. Provides a nonlinear elastic
translational and rotational spring with arbitrary force versus displacement
and moment versus rotation, respectively.

Note:  Material Type SD-4

*MAT_STEEL_EC3 Tables and formulae from Eurocode 3 are used to derive the mechanical
properties and their variation with temperature, although these can be
overriden by user-defined curves.

Note:  Material Type 202

*MAT_STEINBERG

(*MAT_011)

This material is available for modeling materials deforming at very high
strain rates (>105) and can be used with solid elements.
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Note:  Material Type 11

*MAT_STEINBERG_LUND

(*MAT_011_LUND)

This material is a modification of the Steinberg model to include the rate
model of Steinberg and Lund (1989).

Note:  Material Type 11

*MAT_STRAIN_RATE_DEPENDENT_PLASTICITY

(*MAT_019)

A strain rate dependent material can be defined.

Note:  Material Type 19

*MAT_TABULATED_JOHNSON_COOK

(*MAT_224)

Defines an elasto-viscoplastic material with arbitrary stress versus strain
curve(s), and arbitrary strain rate dependency.

Note:  Material Type 224

*MAT_TEMPERATURE_DEPENDENT_ORTHOTROPIC

(*MAT_023)

Defines an orthotropic elastic material with arbitrary temperature
dependency.

Note:  Material Type 23

*MAT_THERMAL_ISOTROPIC

(*MAT_T01)

Defines isotropic thermal properties.

Note:  Thermal Material Property Type 1

*MAT_THERMAL_ISOTROPIC_TD_LC

(*MAT_T06)

Defines isotropic thermal properties that are temperature dependent
specified by load curves.

Note:  Thermal Material Property Type 6

*MAT_THERMAL_ORTHOTROPIC

(*MAT_T02)

Defines orthotropic thermal properties.

Note:  Thermal Material Property Type 2

*MAT_THERMO_ELASTO_VISCOPLASTIC_CREEP

(*MAT_188)

Defines creep separately from plasticity.

Note:  Material Type 188
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*MAT_TRANSVERSELY_ANISOTROPIC_CRUSHABLE_FOAM

(*MAT_142)

Used for an extruded foam material that is transversely istropic, crushable,
and of low density with no significant Poisson effect.

Note:  Material Type 142

*MAT_TRANSVERSELY_ANISOTROPIC_ELASTIC_PLASTIC

(*MAT_037)

Simulates sheet forming processes with anisotropic material.

Note:  Material Type 37

*MAT_TRANSVERSELY_ANISOTROPIC_ELASTIC_PLASTIC_NLP_FAILURE

(*MAT_037_NLP_FAILURE)

Simulates sheet forming processes with anisotropic material.

Note:  Material Type 37

*MAT_TRANSVERSELY_ANISOTROPIC_ELASTIC_PLASTIC_ECHANGE

(*MAT_037_ECHANGE)

Simulates sheet forming processes with anisotropic material.

Note:  Material Type 37

*MAT_TRIP

(*MAT_113)

Isotropic elasto-plastic material model that applies to shell elements only.

Note:  Material Type 113

*MAT_UHS_STEEL

(*MAT_244)

Material for hot stamping and press hardening.

Note:  Material Type 244

*MAT_UNSUPPORTED

*MAT_USER_DEFINED_MATERIALUser can supply their own subroutines.

Note:  Material Types 41-50

*MAT_VACUUM

(*MAT_140)

Dummy material representing a vacuum in a multi-material Euler/ALE
model.

Note:  Material Type 140

*MAT_VISCOELASTIC

(*MAT_006)

Used for the modeling of viscoelastic behavior for beams (Hughes-Liu),
shells, and solids.
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Note:  Material Type 6

*MAT_VISCOELASTIC_HILL_FOAM

(*MAT_178)

Highly compressible foam.

Note:  Material Type 178

*MAT_VISCOELASTIC_LOOSE_FABRIC

(*MAT_234)

Used for modeling the elastic and viscoelastic response of loose fabric used
in body armor, blade containments, and airbags.

Note:  Material Type 234

*MAT_VISCOPLASTIC_MIXED_HARDENING

(*MAT_225)

An elasto_viscoplastic material with an arbitrary stress versus strain curve
and arbitrary strain rate dependency can be defined. Kinematic, isotropic, or
a combination or kinematic and isotropic hardening can be specified. Also,
failure based on plastic strain can be defined.

Note:  Material Type 225

*MAT_VISCOUS_FOAM

(*MAT_062)

Used to represent the Confor Foam on the ribs of EuroSID side impact
dummy.

Note:  Material Type 62

*MAT_WINFRITH_CONCRETE

(*MAT_084)

Only Type 84 includes rate effects. Model is a smeared crack, smeared
rebar model implemented in the 8-node single integration point continuum
element.

Note:  Material Type 84 and Type 85

*MAT_WOOD

(*MAT_143)

Wood material.

Note:  Material Type 143

*MAT_WOOD_FIR

(*MAT_143_FIR)

Wood material.

Note:  Material Type 143

*MAT_WOOD_OPTION Transversely isotropic material and is available for solid elements.
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Note:  Material Type 143

*MAT_WOOD_PINE

(*MAT_143_PINE)

Wood material.

Note:  Material Type 143

*MAT_WTM_STM Anisotropic-viscoplastic material model.

Note:  Material Type 135

*MAT_WTM_STM_PLC

(*MAT_135_PLC)

Anisotropic material.

Note:  Material Type 135PLC

*MAT_1DOF_GENERALIZED_SPRING

(*MAT_146)

Linear or spring damper that allows different degrees of freedom at two
nodes to be coupled.

Note:  Material Type 146

*MAT_3-
PARAMETER_BARLAT

(*MAT_036)

Used for modeling sheets with anisotropic materials under plane stress
conditions.

Note:  Material Type 36

*MAT_3-
PARAMETER_BARLAT_NLP

(*MAT_036_NLP)

Used for modeling sheets with anisotropic materials under plane stress
conditions.

Note:  Material Type 36

Nastran Cards
The PCOMP card contains all information regarding composite materials, including the orientation
of the longitudinal direction of each ply. The material longitudinal axis of the element is obtained
either by rotating the x axis of the element THETA degree (from THETA field in the element card)
counterclockwise, or by projecting the x axis of a system (from MCID field in the element card) onto
the surface of the element. Each ply orientation, shown a as ply direction, is obtained by rotating the
material longitudinal axis THETAi degree (from the THETAi field in the PCOMP card) counterclockwise.
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MAT1 Defines the material properties for linear isotropic materials.

MAT2 Defines the material properties for linear anisotropic materials for two-
dimensional elements.

MAT4 Defines the constant or temperature-dependent thermal material properties
for conductivity, heat capacity, density, dynamic viscosity, heat generation,
reference enthalpy, and latent heat associated with a single-phase change.

MAT5 Defines the thermal material properties for anisotropic materials.

MAT8 Defines the material property for an orthotropic material for isoparametric
shell elements.

MAT9 Defines the material properties for linear, temperature-independent,
anisotropic materials for solid isoparametric elements.

MAT10 Defines material properties for fluid elements in coupled fluid-structural
analysis.

MATEP Specifies elasto-plastic material properties to be used for large deformation
analysis. Used in SOL 600 only.

MATHE Specifies hyperelastic (rubber-like) material properties for nonlinear (large
strain and large rotation) analysis in SOL 600 and MD Nastran SOL 400 only.

MATHP Specifies material properties for use in fully nonlinear (i.e., large strain and
large rotation) hyperelastic analysis of rubber-like materials (elastomers).

MATG Specifies gasket material properties to be used in SOL 600 and MD Nastran
SOL 400.

MATHP Specifies material properties for use in fully nonlinear (that is, large
strain and large rotation) hyperelastic analysis of rubber-like materials
(elastomers).

MATEP Specifies elasto-plastic material properties.

MATS1 Specifies stress-dependent material properties for use in applications
involving nonlinear materials.

MATT1 Specifies temperature-dependent material properties on MAT1 entry fields
via TABLEMi entries.

MATT2 Specifies temperature-dependent material properties on MAT2 entry fields
via TABLEMj entries.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.342

Card Description

MATT4 Specifies table references for temperature-dependent MAT4 material
properties.

MATT8 Specifies temperature-dependent material properties on MAT8 entry fields
via TABLEMi entries.

MATT9 Specifies temperature-dependent material properties on MAT9 entry fields
via TABLEMk entries.

OptiStruct Cards

Card Description

MAT1 Defines the material properties for linear, temperature-independent, and
isotropic materials.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MAT2 Defines the material properties for linear, temperature-independent, and
anisotropic materials for two-dimensional elements.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MAT3 Defines the material properties for linear, temperature-independent,
and orthotropic materials used by the CTAXI and CTRIAX6 axisymmetric
elements.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MAT4 Defines constant thermal material properties for conductivity, density, and
heat generation.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MAT5 Defines the thermal material properties for anisotropic materials.
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Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MAT8 Defines the material properties for linear temperature-independent
orthotropic material for two-dimensional elements.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MAT9 Defines the material properties for linear, temperature-independent, and
anisotropic materials for solid elements.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MAT9ORT Defines the material properties for linear, temperature-independent, and
orthotropic materials for solid elements in terms of engineering constants.

Note:  Bulk Data Entry

MAT10 Defines material properties for fluid elements in coupled fluid-structural
analysis.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MATFAT Defines material properties for fatigue analysis.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MATF1 Specifies frequency-dependent material properties on MAT1 entry fields via
TABLEDi entries.

Note:  Bulk Data Entry

MATF2 Specifies frequency-dependent material properties on MAT2 entry fields via
TABLEDi entries.
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Note:  Bulk Data Entry

MATF8 Specifies frequency-dependent material properties on MAT8 entry fields via
TABLEDi entries.

Note:  Bulk Data Entry

MATF9 Specifies frequency-dependent material properties on MAT9 entry fields via
TABLEDi entries.

Note:  Bulk Data Entry

MATF10 Specifies frequency-dependent material properties on MAT10 entry fields via
TABLEDi entries.

Note:  Bulk Data Entry

MATHE Defines material properties for nonlinear hyperelastic materials. The
Polynomial form is available and various material types can be defined by
specifying the corresponding coefficients.

Note:  Bulk Data Entry

MATPE1 Defines the material properties for poro-elastic materials.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

MATT1 Specifies temperature-dependent material properties on MAT1 entry fields via
TABLEMi entries.

Note:  Bulk Data Entry

MATT2 Specifies temperature-dependent material properties on MAT2 entry fields via
TABLEMj entries.

Note:  Bulk Data Entry
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MATT4 Defines temperature-dependent material properties for the corresponding
MAT4 Bulk Data Entry fields via TABLEMi entries.

Note:  Bulk Data Entry

MATT5 Defines temperature-dependent material properties on MAT5 entry fields via
TABLEMi entries.

Note:  Bulk Data Entry

MATT8 Specifies temperature-dependent material properties on MAT8 entry fields via
TABLEMi entries.

Note:  Bulk Data Entry

MATT9 Specifies temperature-dependent material properties on MAT9 entry fields via
TABLEMk entries.

Note:  Bulk Data Entry

MGASK Defining the material properties for gasket-like materials.

Note:  Bulk Data Entry

PAM-CRASH Cards

Card Description

MAT_SECURE

PLY

TYPE 1 Elastic Plastic

Note:  Post-Yield behavior - defined by Yield Stress list box.

TYPE 2 Crushable Foam

TYPE 5 Linear Viscoelastic
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TYPE 7 Isotropic - Elastic-Plastic-Hydrodynamic

TYPE 11 Blatz-Ko Rubber

TYPE 16 Elastic-Plastic with Damage

TYPE 17 Hyperleastic Mooney-Rivlin

Note:  To enter LTC on card 4, a curve must exist.

TYPE 18 Hyperelastic Hart-Smith

TYPE 20 Inelastic Crushable Foam

TYPE 21 Elastic Foam

Note:  Curve definition may be defined with points or with curve
entities.

TYPE 22 Non-linear Viscoelastic

TYPE 25 Solid for Foam Side Impact Barriers

TYPE 26 Elastic Plastic with Gurson Damage Model

TYPE 30 Unidirectional Composite Bi-Phase

Note:  To enter IPLY on card 3, a material collector with a
defined PLY_DATA card image must exist.

TYPE 31 Unidirectional Composite Non-linear

Note:  To enter IPLY on card 3, a material collector with a
defined PLY_DATA card image must exist.

TYPE 36 Elastic/Stiffening - Plastic with Failure

TYPE 37 Viscoelastic Ogden Rubber

TYPE 41 Improved Side Impact Barrier TYPEerial

Note:  Full material input and simplified material input are
available.
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TYPE 42

TYPE 45 General Non-linear Strain Rate Dependent

TYPE 52 Elastic-Plastic Solid with Fracture Criteria

TYPE 61 Elastic-Plastic 8 Node Thick Shell

TYPE 62 Elastic-Plastic for 8-Node Thick Shell Elements with Total Lagrangian
Formulation

TYPE 71 Elastic-Plastic with EWK Damage and Failure

TYPE 99 Null TYPEerial for Solid

TYPE 100 Null TYPEerial

TYPE 101 Elastic

TYPE 102 Elastic Plastic

TYPE 103 Elastic Plastic

TYPE 105 Elastic Plastic with Isotropic Damage

TYPE 106 Elastic Plastic with Anisotropic Damage

TYPE 107

TYPE 108 Anisotropic Elastic Plastic

TYPE 109
Note:  TYPE 109 data will not be exported (not valid for PAM
2006 and above).

TYPE 110 Super Elastic

TYPE 115 Elastic Plastic with Gurson Damage

TYPE 116 Elastic Plastic with Isotropic Damage

TYPE 117
Note:  Type 117 data will not be exported (not valid for Pam
2006 and above).

TYPE 118 Anisotropic Elastic Plastic

TYPE 121 CRASH/FORMING, Non-linear Visco Elastic
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TYPE 126 Glass

TYPE 128 Anisotropic Elastic Plastic

TYPE 130 Multilayered Shell Elements

Note:  To specify a ply database, a material collector with the
PLY_DATA card image must exist in the database. Ply auxiliary
variables default to blank and can be overridden.

TYPE 131 Multilayered Shell Elements

Note:  To specify a ply database, a material collector with the
PLY_DATA card image must exist in the database. Ply auxiliary
variables default to blank and can be overridden.

TYPE 132 Multilayered Shell Elements

Note:  To specify a ply database, a material collector with the
PLY_DATA card image must exist in the database. Ply auxiliary
variables default to blank and can be overridden.

TYPE 143 Elastic-Plastic with Elastic Stiffening

TYPE 150 Layered TYPEerials for Membrane Elements

TYPE 151 Fabric Membrane Elements with Non Linear Fibre

TYPE 161 Elastic for 4-Node Thick Shell

TYPE 162 Elastic Plastic with 4-Node Thick Shell

TYPE 171 Elastic Plastic with EWK Damage

TYPE 200 Null TYPERerial

TYPE 201 Elastic

Note:  Card fields vary depending upon the element type
selected (beam or bar).

TYPE 202 Elastic-Plastic
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Note:  Card fields vary depending upon the element type
selected. Post-Yield behavior - defined by Yield Stress list box.

TYPE 203 Nonlinear for BAR

Note:  Number of editable fields depends on NLOAD, NUNLD,
and NRELD.

TYPE 204 Nonlinear for BAR/DASHPOT

Note:  Force-deflection curve specification requires existence of
curves in the database.

TYPE 205 Nonlinear Tension Only Barn

Note:  NLOAD can be set to 0 or to a curve (right-click field
label to reset NLOAD curve selection). Other fields for material
type 205 depend on the value of NLOAD.

TYPE 212 Elastic-Plastic for Beam Elements

Note:  Post-Yield behavior - defined by Yield Stress list box.

TYPE 213 Elastic-Plastic for Beam Elements

Note:  Post-Yield behavior - defined by Yield Stress list box.
Specification of the cross section description through the list box
affects the layout of cards 8 through NIPS 8.

TYPE 214 Global Beam Column

Note:  Curves must exist in the model before specifying curve
fields.

TYPE 220 Nonlinear 6-DOF Spring/Dashpot

Note:  Curves must exist in the model before specifying curve
fields.
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TYPE 221 Spherical Joint Elements

Note:  Curves must exist in the model before specifying curve
fields.

TYPE 222 Flexion Torsion Joint Elements

Note:  Curves must exist in the model before specifying curve
fields.

TYPE 223 Nonlinear 6-DOF Spring-Beam Elements

Note:  Curves must exist in the model before specifying curve
fields.

TYPE 224 6-DOF Penalty Spring Beam Elements

Note:  6-DOF penalty spring beam elements

TYPE 230 KineTYPEic Joint Elements

Note:  Curves must exist in the model before specifying curve
fields.

TYPE 301 SLINK, ELINK elements or TIED interface.

TYPE 302 PLINK elements.

TYPE 303 LLINK elements

TYPE 304 TIED Interfaces

PLYDATA Only TSAI-WU failure criterion supported

Permas Cards

Card Description

$COMPRESS Fluid compressibility

$CONDUCTIVITY Heat conductivity
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$DAMPING Structural damping

$DENSITY Material density

$DIELECTRIC Definition of dielectricity.

$ELASTIC Linear elastic material data.

$ELCONDUCT Definition of electric conductivity.

$ENTER MATERIAL Material input bracket header line.

$FLDENS Definition of fluid material density.

$FLUID Opens the bracket for definition of a fluid material.

$GASKET Definition of material for gaskets.

$GSKLOAD Definition of the loading behavior for gasket material.

$GSKUNLOAD Definition of the unloading behavior for gasket material.

$HARDENING Hardening

$HEATCAP Heat capacity

$MATERIAL Definition of homogenous material.

$PERMEABILITY Definition of magnetic permeability.

$PLASTIC Plasticity data

$SURFABS Definition of absorption at the boundary surface of a fluid.

$THERMEXP Thermal expansion coefficients

$VOLDRAG Definition of volumetric drag of a fluid.

$YIELD Yield limit

Radioss Cards
Radioss allows you to program your own materials that can be used in a simulation. Unsupported
Radioss materials and user defined Radioss materials are assigned the MAT_UNSUPPORTED card image.

HyperMesh imports unsupported materials with the MAT_UNSUPPORTED card image, and preserves
their corresponding IDs and associated components.

In the MAT_UNSUPPORTED card image, all material sub-options, parameters, and data lines are
supported as simple text. HyperMesh does not check the validity or syntax of any data in this mode.
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You must manually check the validity of the data. No editing, updating, or review of the material data
is intended. Also time step calculation and mass calculation are not available for the component that
refers to this material.

Card Description

/ALE/MAT Describes the ALE material.

Note:  Block Format Keyword

/MAT/LAW12 (3D_COMP) Describes a solid material using the Tsai-
Wu formulation that is usually used to model
composites. This material is assumed to be 3D
orthotropic-elastic before the Tsai-Wu criterion
is reached. The material becomes nonlinear
afterwards. The Tsai-Wu criterion can be set
dependent on the plastic work and strain rate in
each of the orthotropic directions and in shear
to model material hardening. Stress based
orthotropic criterion for brittle damage and failure
is available. This material is a generalization and
improvement of /MAT/LAW14 (COMPSO).

Note:  Block Format Keyword

/MAT/B-K-EPS Describes the boundary conditions material in
flow analysis (ALE or EULER). It is based on
boundary material /MAT/LAW11 (BOUND) activating
boundary turbulence modeling and adding 2 input
lines for k -  parameters. It is compatible for 2D
and 3D analysis. It is not compatible with Multi-
material ALE laws, LAW37 (BIMAT) and /MAT/
LAW51 (MULTIMAT).

Note:  Block Format Keyword

/MAT/LAW57 (BARLAT3) Describes plasticity hardening defined by a
user function and can be used only with shell
elements. This is an elasto-plastic orthotropic
law for modeling anisotropic materials in forming
processes especially aluminum alloys. This material
law must be used with property set type /PROP/
TYPE9 (SH_ORTH) or /PROP/TYPE10 (SH_COMP).
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Note:  Block Format Keyword

/MAT/LAW20 (BIMAT) ALE multi-material law for 2D analysis.

Note:  Block Format Keyword

/MAT/LAW37 (BIPHAS) Describes the hydrodynamic bi-material liquid
gas material. It is not recommended to use this
multi-material laws (LAW37) with Radioss single
precision engine.

Note:  Block Format Keyword

/MAT/LAW34 (BOLTZMAN) Describes the Boltzmann (visco-elastic) material.
This law is applicable only for solid elements and
can be used to model polymers and elastomers.

Note:  Block Format Keyword

/MAT/LAW11 (BOUND) Describes the boundary conditions material in flow
analysis (ALE or EULER). It is compatible for 2D
and 3D analysis. It is not compatible with Multi-
Material ALE laws, LAW37 (BIMAT) and /MAT/
LAW51 (MULTIMAT). In case of turbulence, activate
boundary turbulence modeling using /MAT/B-K-EPS
and input κ -  boundary conditions.

Note:  Block Format Keyword

/MAT/LAW15 (CHANG) Models composite shell elements, similar to
LAW25. The plastic behavior is based on the Tsai-
Wu criteria (/MAT/LAW25 (COMPSH) for Tsai-Wu
description) and failure is based on the Chang-
Chang failure criterion is used.

Note:  Block Format Keyword

/MAT/LAW25 (COMPSH) Two variations of the same material LAW25 are
implemented:Tsai-wu formulation and CRASURV
formulation.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.354

Card Description

Note:  Block Format Keyword

/MAT/LAW14 (COMPSO) Describes an orthotropic solid material using the
Tsai-Wu formulation that is mainly designed to
model uni-directional composites. This material is
assumed to be 3D orthotropic-elastic before the
Tsai-Wu criterion is reached. The material becomes
nonlinear afterwards. The nonlinearity in direction
3 is the same as that in direction 2 to represent
the behavior of a composite matrix material.
The Tsai-Wu criterion can be set dependent on
the plastic work and strain rate in each of the
orthotropic directions and in shear to model
material hardening. Stress based orthotropic
criterion for brittle damage and failure is available.
/MAT/LAW12 (3D_COMP) is an improved version of
this material and should be used instead of LAW14.

Note:  Block Format Keyword

/MAT/LAW24 (CONC) Models brittle elastic-plastic behavior of reinforced
concrete. The law assumes that the two failure
mechanisms are tensile cracking and compressive
crushing of the concrete material. This keyword is
compatible only with solid elements.

Note:  Block Format Keyword

/MAT/LAW59 (CONNECT) Describes the Connection material, which can be
used to model spotweld, welding line, glue, or
adhesive layers in laminate composite material.
Elastic and elastoplastic behavior in normal and
shear directions can be defined. The curves that
represent plastic behavior can be specified for
different strain rates. This material is applicable
only to solid hexahedron elements (/BRICK)
and the material time-step does not depend on
element height.

Note:  Block Format Keyword
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/MAT/LAW68 (COSSER) Describes the honeycomb material.

Note:  Block Format Keyword

/MAT/LAW44 (COWPER) The Cowper-Symonds law models an elasto-plastic
material. The basic principle is the same as the
standard Johnson-Cook model; the only difference
between the two laws lies in the expression for
strain rate effect on flow stress.

Note:  Block Format Keyword

/MAT/LAW22 (DAMA) This law is identical to Johnson-Cook material (/
MAT/LAW2), except that the material undergoes
damage if plastic strains reach a user-defined
value ( ). This law can be applied to both shell
and solid elements.

Note:  Block Format Keyword

/MAT/LAW21 (DPRAG) Specific interface between a non-deformable
master surface and a slave surface designed for
stamping. All nodes of the master surface must
belong to the rigid body.

Note:  Block Format Keyword

/MAT/LAW10 (DPRAG1) This law, based on Drücker-Prager yield criteria,
is used to model materials with internal friction
such as rock-concrete. The plastic behavior of
these materials is dependent on the pressure in
the material. This law is similar to LAW21 (/MAT/
LAW21 (DRAGP)); the only difference being that in
this law, the pressure is defined as a cubic function
of volumetric strain, and hence requires the input
of certain coefficients. This law is compatible only
with solid elements.

Note:  Block Format Keyword
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Card Description

/MAT/LAW1 (ELAST) Defines an isotropic, linear elastic material
using Hooke's law. This law represents a linear
relationship between stress and strain. It is
available for truss, beam (type 3 only), shell and
solid elements.

Note:  Block Format Keyword

/MAT/LAW65 (ELASTOMER) Describes non-linear elastoplastic material with
strain rate dependent loading and unloading
behavior.

Note:  Block Format Keyword

/MAT/LAW58 (FABR_A) Describes a hyperelastic anisotropic fabric
material. It uses an anisotropic coordinate
system with anisotropy angle, following element
deformation. The material formulation provides
coupling between warp and weft directions in order
to reproduce physical interaction between fibers.
The shear degree of freedom is fully decoupled
from the translational degrees of freedom.
Optionally, nonlinear stress-strain curves for
loading and unloading can be specified for warp,
weft directions and in shear.

Note:  Block Format Keyword

/MAT/LAW19 (FABRI) Defines an elastic orthotropic material and is
available only for shell elements. It is used to
model airbag fabrics.

Note:  Block Format Keyword

/MAT/LAW33 (FOAM_PLAS) Models a visco-elastic plastic foam material. This
law is applicable only for solid elements and is
typically used to model low density, closed cell
polyurethane foams such as impact limiters.

Note:  Block Format Keyword
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Card Description

/MAT/LAW70 (FOAM_TAB) Describes the visco-elastic foam tabulated
material. This material law can be used only with
solid elements.

Note:  Block Format Keyword

/MAT/LAW35 (FOAM_VISC) Describes a visco-elastic foam material using
Generalized Maxwell-Kelvin-Voigt model where
viscosity is based on Navier equations. This law is
applicable only for shell and solid elements and can
be used for open cell foams, polymers, elastomers,
seat cushions and dummy paddings.

Note:  Block Format Keyword

/MAT/GAS Describes the gas molecular weight and specific
heat coefficients.

Note:  Block Format Keyword

/MAT/LAW16 (GRAY) This material law is based on Gray EOS and
Johnson-Cook yield criteria.

Note:  Block Format Keyword

/MAT/LAW52 (GURSON) This law is based on the Gurson constitutive law,
which is used to model visco-elastic-plastic strain
rate dependent porous metals.

Note:  Block Format Keyword

/MAT/LAW63 (HANSEL) This law describes the trip steel plastic material.
This material law can be used only with shell
elements.

Note:  Block Format Keyword

/MAT/LAW32 (HILL) Describes the Hill orthotropic plastic material. It is
applicable only to shell elements. This law differs
from LAW43 (HILL_TAB) only in the input of yield
stress.
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Card Description

Note:  Block Format Keyword

/MAT/LAW72 (HILL_MMC) Describes the anisotropic hill material with
a modified Mohr fracture criteria. This law is
available for shell and solid.

Note:  Block Format Keyword

/MAT/LAW43 (HILL_TAB) Describes the Hill orthotropic material and is
applicable only to shell elements. This law differs
from LAW32 (HILL) only in the input of yield stress
(here it is defined by a user function).

Note:  Block Format Keyword

/MAT/LAW73 Describes the Thermal Hill orthotropic material
and is applicable only to shell elements. This law
differs from /MAT/LAW43 (HILL_TAB) by the fact
that yield stress not only depends on strain rate
and plastic strain, but also on temperature (it is
defined by a user table).

Note:  Block Format Keyword

/MAT/LAW28 (HONEYCOMB) Describes a three dimensional nonlinear elasto-
plastic material, usually used to model honeycomb
or foam material. Nonlinear elasto-plastic behavior
can be specified for each othrotropic direction and
shear as function of strain or volumetric strain. All
degrees of freedom are uncoupled and the material
is fully compressible. Tension and shear strain
based failure criteria can be specified.

Note:  Block Format Keyword

/MAT/LAW4 (HYD_JCOOK) Represents an isotropic elasto-plastic material
using the Johnson-Cook material model. This
model expresses material stress as a function of
strain, strain rate and temperature. This material
may account for the nonlinear dependence
between pressure and volumetric strain when
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Card Description

corresponding equation of state is specified. A
built-in failure criterion based on the maximum
plastic strain is available. This material law is
compatible with solid elements only.

Note:  Block Format Keyword

/MAT/LAW3 (HYDPLA) Represents an isotropic elasto-plastic material
using the Johnson-Cook material model. This
model expresses material stress as a function
of strain and may account for the nonlinear
dependence between pressure and volumetric
strain when corresponding equation of state is
specified. A built-in failure criterion based on the
maximum plastic strain is available. This material
law is compatible with solid elements only.

Note:  Block Format Keyword

/MAT/LAW6 (HYDRO) Describes the hydrodynamic viscous fluid material
using a polynomial EOS.

Note:  Block Format Keyword

/MAT/LAW79 (JOHN_HOLM) Describes the behavior of brittle materials, such
as ceramics and glass. The implementation is the
second Johnson Holmquist model: JH-2.

Note:  Block Format Keyword

/MAT/LAW5 (JWL) Describes the Jones-Wilkins-Lee EOS for
detonation products of high explosives.

Note:  Block Format Keyword

/MAT/LAW6 (K-EPS) Describes the k -  turbulence viscous material for
fluid.

Note:  Block Format Keyword
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Card Description

/MAT/LAW40 (KELVINMAX) Describes the generalized Maxwell-Kelvin material.
This law can only be used with solid elements.

Note:  Block Format Keyword

/MAT/LAW66 Models an isotropic tension-compression elasto-
plastic material law using user-defined functions
for the work-hardening portion of the stress-strain
(plastic strain vs. stress). This law can be defined
for compression and tension.

Note:  Block Format Keyword

/MAT/LAW69 This law (extension of /MAT/LAW42 (OGDEN))
defines a hyperelastic and incompressible
material specified using the Ogden, Mooney-Rivlin
material models. It is generally used to model
incompressible rubbers, polymers, foams, and
elastomers. Material parameters are computed
from engineering stress-strain curve from uniaxial
tension and compression tests. It is used with shell
and solid elements.

Note:  Block Format Keyword

/MAT/LAW74 Describes the Thermal Hill orthotropic 3D material
and is applicable only to solid elements. The yield
stress may depend on strain rate, or on both strain
rate and temperature.

Note:  Block Format Keyword

/MAT/LAW77 This open cell foam material law is a generalization
of LAW70. It accounts for a non-viscous
compressible ideal gas flow inside of the foam
and its interaction with the foam structure.
ALE simulation of the gas flow and Lagrangian
simulation of the foam deformation is performed
on the same elements system. Interaction between
the gas flow and the structure is through Darcy law
and direct application of the gas pressure to the
structure.
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Card Description

Note:  Block Format Keyword

/MAT/LAW78 This law is the Yoshida-Uemori model for
describing the large-strain cyclic plasticity of
metals. The law is based on the framework
of two surfaces theory: the yielding surface
and the bounding surface. During the plastic
deformation, a yield surface will move within
the bounding surface and will never change
its size, and the bounding surface can change
both in size and location. The plastic-strain
dependency of the Young's modulus and the work-
hardening stagnation effect are also taken into
account. Concerning SPH, it is compatible with
solid only, this can be verified with the /SPH/
WavesCompression test. The solid version is only
isotropic. The shell version is anisotropic based on
Hill criterion.

Note:  Block Format Keyword

/MAT/LAW80 Models the ultra-high strength steel behavior at
high temperatures and the phase transformation
phenomena from austenite to ferrite, pearlite,
bainite and martensite during cooling.

Note:  Block Format Keyword

/MAT/LAW81 This law is based on Drücker-Prager yield criteria
with cap. It has a strain-hardening cap model
based on the principles of Foster. Plasticity has an
isotropic hardening. Failure surface is limited to
the standard linear Drücker-Prager relation, with
symmetry around the pressure axis. This law is
LAG, ALE and EULER compatible.

Note:  Block Format Keyword

/MAT/LAW82 Defines the Ogden material. This law is compatible
with solid and shell elements. In general it is used
to model polymers and elastomers.
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Card Description

Note:  Block Format Keyword

/MAT/LAW83 Describes the Connection material, which can be
used to model spotweld, welding line, glue, or
adhesive layers in laminate composite material.
Elastic and elastoplastic behavior can be defined.
The plastic behavior of the material can be coupled
in normal and shear directions for corresponding
strain-rates. This material is applicable only to
solid hexahedron elements (/BRICK) and the
material time-step does not depend on element
height.

Note:  Block Format Keyword

/MAT/LAW41 (LEE-TARVER) Describes detonation products using an ignition
and growth model of a reactive material. The Lee-
Tarver model is based on the assumption that
ignition starts at local hot spots in the passage of
shock front and grows outward from these sites.
The reaction rate is controlled by the pressure and
the surface area as in a deflagration process.

Note:  Block Format Keyword

/MAT/LAW46 (LES_FLUID) Describes the viscous fluid material with sub-grid
scale viscosity.

Note:  Block Format Keyword

/MAT/LAW51 (MULTIMAT) Up to four material laws can be defined: elasto-
plastic solid, liquid, gas and detonation products.
The material boundaries inside an element are not
explicitly defined, but an anti-diffusive technique
is used to avoid expansion of transition zone (/
UPWIND in Radioss Starter Input).

Note:  Block Format Keyword

/MAT/LAW42 (OGDEN) Defines a hyperelastic, viscous, and incompressible
material specified using the Ogden, Mooney-Rivlin
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Card Description

material models. This law is generally used to
model incompressible rubbers, polymers, foams,
and elastomers. This material can be used with
shell and solid elements.

Note:  Block Format Keyword

/MAT/LAW27 (PLAS_BRIT) Combines an isotropic elasto-plastic Johnson-Cook
material model with an orthotropic brittle failure
model. Material damage is accounted for prior to
failure. Failure and damage occur only in tension.
This law is applicable only for shells.

Note:  Block Format Keyword

/MAT/LAW23 (PLAS_DAMA) Models an isotropic elastic plastic material and
combines Johnson-Cook material model with a
generalized damage model. The law is applicable
only for solid elements.

Note:  Block Format Keyword

/MAT/LAW2 (PLAS_JOHNS) Represents an isotropic elasto-plastic material
using the Johnson-Cook material model. This
model expresses material stress as a function
of strain, strain rate and temperature. A built-in
failure criterion based on the maximum plastic
strain is available.

Note:  Block Format Keyword

/MAT/LAW60 (PLAS_T3) Models an isotropic elasto-plastic material using
user-defined functions for the work-hardening
portion of the stress-strain curve (that is, plastic
strain vs. stress) for different strain rates. It is
similar to LAW36, except yield stress is a nonlinear
interpolation from the functions.

Note:  Block Format Keyword

/MAT/LAW36 (PLAS_TAB) Models an isotropic elasto-plastic material using
user-defined functions for the work-hardening
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Card Description

portion of the stress-strain curve (for example,
plastic strain vs. stress) for different strain rates.

Note:  Block Format Keyword

/MAT/LAW75 (POROUS) Describes the P-α porous material model. This
material describes ductile Porous material with
Herrmann model. It only works with 8-node brick
element and is not compatible with ALE.

Note:  Block Format Keyword

/MAT/LAW54 (PREDIT) Describes the predit material. This material law is
only used with /PROP/TYPE36 (PREDIT).

Note:  Block Format Keyword

/MAT/LAW13 (RIGID) Models part(s) as rigid bodies.

Note:  Block Format Keyword

/MAT/LAW76 (SAMP) Describes a semi-analytical elasto-plastic material
using user-defined functions for the work-
hardening portion for tension, compression and
shear (stress as function of strain).

Note:  Block Format Keyword

/MAT/LAW26 (SESAM) This ALE material law describes a SESAME tabular
EOS, used with a Johnson-Cook yield criterion.
SESAME EOS covers a wide range of phases
including solids, fluids and high temperature/high
density plasmas, and the well-known transitions
between these various phases. It requires SESAME
tables, which were developed at Los Alamos
National Laboratory in USA.

Note:  Block Format Keyword

/MAT/LAW49 (STEINB) Defines an elastic plastic material with thermal
softening.
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Card Description

Note:  Block Format Keyword

/MAT/LAW18 (THERM) Describes thermal material.

Note:  Block Format Keyword

/MAT/LAW53 (TSAI_TAB) Describes the law that is a uni-directional
orthotropic elasto-plastic law and is only used with
solid elements.

Note:  Block Format Keyword

/MAT/LAW64 (UGINE_ALZ) Describes the Ugine & Alz trip steel material. This
material law can be used only with shell elements.

Note:  Block Format Keyword

/MAT/USERij Describes the user material.

Note:  Block Format Keyword

/MAT/LAW50 (VISC_HONEY) Describes the honeycomb material with strain rate
dependency (based on material LAW28 + strain
rate dependency).

Note:  Block Format Keyword

/MAT/LAW62 (VISC_HYP) Describes the hyper visco-elastic material. This
law is compatible with solid and shell elements.
In general it is used to model polymers and
elastomers.

Note:  Block Format Keyword

/MAT/LAW38 (VISC_TAB) Describes the visco-elastic foam tabulated material
and can only be used with solid elements.

Note:  Block Format Keyword
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Card Description

/MAT/LAW0 (VOID) Defines elements to act as a void, or an empty
space.

Note:  Block Format Keyword

/MAT/LAW48 (ZHAO) Describes the Zhao material law used to model
an elasto-plastic strain rate dependent materials.
The law is applicable only for solids and shells.
The global plasticity option for shells (N=0 in shell
property keyword) is not available in the actual
version.

Note:  Block Format Keyword

/VISC/PRONY This is an isotropic visco-elastic Maxwell model
that can be used to add visco-elasticity to certain
shell and solid element material models. The visco-
elasticity is input using a Prony series.

Note:  Block Format Keyword

Samcef Cards

Card Description

.MAT, ANISOTROPIC Define the properties of one or several materials.

.MAT, ISOTROPIC Define the properties of one or several materials.

.MAT, ORTHOTROPIC Define the properties of one or several materials.
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Mechanisms
Mechanism entities are the root of the hierarchy in the Mechanism Browser.

Output Blocks
Output block entities define and store solver output requests.

Output blocks do not have a display state.

Abaqus Cards
Output blocks are added to load steps (*STEP). Output requests organized into the output blocks are
written out within the corresponding step definition in the Abaqus input deck. Output blocks must
be added to the corresponding load steps for them to be written out to the Abaqus deck. All types of
output requests in an output block are defined from the card image.

Card Description

*CONTACT FILE Define results file requests for contact variables.

*CONTACT OUTPUT Specify contact variables to be written to the output database.

*CONTACT PRINT Define print requests for contact variables.

*EL FILE Define results file requests for element variables.

*EL PRINT Define data file requests for element variables.

*ELEMENT OUTPUT Define output database requests for element variables.

*ENERGY FILE Write energy output to the results file.

*ENERGY OUTPUT Define output database requests for whole model or element set energy
data.

*ENERGY PRINT Print a summary of the total energies

*INCREMENTATION
OUTPUT

Define output database requests for time incrementation data.

Note:  Explicit template only. History data. Only for *OUTPUT,
HISTORY.

*INTEGRATED OUTPUT Specify variables integrated over a surface to be written to the output
database.
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Card Description

Note:  Only for *OUTPUT, HISTORY

*MODAL OUTPUT Write generalized coordinate (modal amplitude) data to the output database
during a mode-based dynamic or complex eigenvalue extraction procedure.

Note:  Standard 2D and 3D templates only. History data. Only
for *OUTPUT, HISTORY.

*NODE FILE Define results file requests for nodal data

*NODE OUTPUT Define output database requests for nodal data

*NODE PRINT Define print requests for nodal variables

*OUTPUT Define output requests to the output database

LS-DYNA Cards
Data on LS-DYNA output blocks cannot be edited.

Card Description

*DATABASE_HISTORY_BEAM(ID)Describe time history for beam elements.

*DATABASE_HISTORY_BEAM_SETDescribe time history for beam element sets.

*DATABASE_HISTORY_DISCRETE

*DATABASE_HISTORY_DISCRETE_SET

*DATABASE_HISTORY_NODE(ID)Describe time history for nodes.

*DATABASE_HISTORY_

NODE_LOCAL(ID)

Describe time history for nodes.

*DATABASE_HISTORY_

NODE_SET

Describe time history for node sets.

*DATABASE_HISTORY_NODE_SET_LOCALDescribe time history for node sets.

*DATABASE_HISTORY_NODE_SET_LOCAL(ID)Describe time history for node sets.

*DATABASE_HISTORY_SEATBELTDefine time history on seat belt element.
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Card Description

*DATABASE_HISTORY_SHELLDescribe time history for shell elements.

*DATABASE_HISTORY_SHELL(ID)Describe time history for shell elements.

*DATABASE_HISTORY_SHELL_SETDescribe time history for shell element sets.

*DATABASE_HISTORY_SOLIDDescribe time history for solid elements.

*DATABASE_HISTORY_SOLID(ID)Describe time history for solid elements.

*DATABASE_HISTORY_SOLID_SETDescribe time history for solid element sets.

*DATABASE_HISTORY_SPHDescribe time history for SPH elements.

*DATABASE_HISTORY_TSHELLDescribe time history for TSHELL elements.

*DATABASE_HISTORY_TSHELL(ID)Describe time history for TSHELL elements.

*DATABASE_HISTORY_TSHELL_SETDescribe time history for TSHELL element sets.

OptiStruct Cards

Card Description

XHIST Defines the time history output request for geometric nonlinear analysis.

Note:  Bulk Data Entry

PAM-CRASH Cards
Keyword selection for output blocks is supported as GES selection.

The appropriate keyword is output when selecting elements for time-history output.

Card Description

PLANE

SECFO / Section definition for force output.

Note:  Slave nodes and master elements define the cross
section. To define non-shell elements, create an entity set first.
The master definition must be by sets.
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Card Description

SECTION

SENPT / Sensor point output definition.

SENPTG / Sensor point output definition.

SUPPORT

THELE / Element time history.

Note:  Uses element output block.

THLOC / Local frame definition for node output.

Note:

THNOD / Nodal time history.

Note:  Uses output block including nodes.

VOLFRAC

Permas Cards

Card Description

$FREQUENCY Definition of frequency list for frequency response analysis.

Note:  The FREQUENCY option is available in the results
bracket.

$NLRESULTS Output request for nonlinear static analysis.

$TIMESTEPS Specify specific time steps when results are written.

Radioss Cards

Card Description

/TH/ACCEL/ Describes the time history for accelerometers.
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Card Description

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/BEAM/ Describes the time history for beams.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/BRIC/ Describes the time history for bricks.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/CYL_JO/ Describes the time history for cylindrical joints.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/FRAME/ Describes the time history for frames.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/GAUGE Describes the time history for gauges.

Note:  Block Format Keyword

/TH/INTER/ Describes the time history for interfaces.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/MONVOL/ Describes the time history for monitored volume.

Note:  Block Format Keyword

Options to assign ATH...ITH
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Card Description

/TH/NODE/ Describes the time history for nodes.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/QUAD/ Describes the time history for a quad.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/PART/ Describes the time history for parts.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/RBODY/ Describes the time history for rigid bodies.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/RWALL/ Describes the time history for rigid wall.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/SECTIO/ Describes the time history for sections.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/SH3N/ Describes the time history output for 3-noded shell elements. Output
parameters are components of stress and strain tensor expressed in
different coordinate systems, plastic strains, strain rate, internal energy,
element thickness, element deletion flag, and so on.

Note:  Block Format Keyword

Options to assign ATH...ITH
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Card Description

/TH/SHEL/ Describes the time history output for 4-node shell elements. Output
parameters are components of stress and strain tensor expressed in
different coordinate systems, plastic strains, strain rate, internal energy,
element thickness, element deletion flag, and so on.

Note:  Options to assign ATH...ITH

/TH/SPHCEL/ Describes the SPH cell output to time history.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/SPRING/ Describes the time history for springs.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/SUBS/ Describes the time history for subsets.

Note:  Block Format Keyword

Options to assign ATH...ITH

/TH/TRUSS/ Describes the time history for trusses.

Note:  Block Format Keyword

Options to assign ATH...ITH

Parameters
Parameter entities parameterize FE entity and geometric entity attributes.

Abaqus Cards
To properly read and import parameters, independent parameters must be defined before dependent
parameters. If parameters are not properly defined, Abaqus will abort the evaluation, and an error
message will display.

In the image below, parameter2 must be defined ahead of parameter1.
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Figure 137:

Parameters are evaluated and their values are determined by the solver. The final value, after the
evaluation of the parameter, will be written in the input deck. The order in which the parameters are
written determines the value assigned to the parameter. The value of Parameter1, regardless of where
Parameter1 is written in the input deck, will be 2.

*PARAMETER
parameter1 = 1.0
**HMNAME PROPERTY          1 property1
*SHELL SECTION, ELSET=property1, MATERIAL=Steel
<parameter1>,         5
*PARAMETER
Parameter1 = 2.0

During export, parameters are exported in the order in which they were created. Parameter information
is written at the top of the input deck. If a parameter is in an Include file, then it will be written at the
top of the Include file.

The keywords, *Parameter Dependence and *Parameter Table are not yet supported.

Card Description

*PARAMETER Defines numerical values through algebraic expressions of parameter names
referenced throughout the input file.
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Card Description

Note:  Supported:

• Parameters can be created, imported, and exported.

• Edit parameters in the Property Editor.

• Parameter expressions are evaluated on the fly.

• Parameter expressions can reference another parameter.

• If you edit the value of a parameter, the other parameters
that references it will be updated accordingly.

• Edit parameterized variables in the Property Editor.

• You can create and assign parameters from the fields of an
entity in Property Editor.

• Load magnitude, element node ID, Node coordinate, and so
on can all be parameterized.

Limitations:

• Support is limited to all properties and materials.

• Parameterization of entity IDs is not supported.

• Unsupported parameterized entities and fields are replaced
with corresponding parameter values during import, to
avoid the loss of data.

• In macros and browsers, if any parameterized variable
is changed, you will receive a warning message in the
message bar and the value will not be updated.

• The creation of duplicate parameters is not supported.
During import, duplicate parameters and their
corresponding expression will be replaced with the resolved
value in the input deck.

LS-DYNA Cards

Card Description

*PARAMETER

*PARAMETER_LOCAL

Defines numerical values of parameter names referenced throughout the
input file.
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Card Description

Note:  Supported:

• Parameters can be created, imported, and exported.

• Edit parameter expressions in the Property Editor.

• Parameter expressions are evaluated on the fly.

• A parameter expression can reference another parameter.

• If you edit the value of a parameter, the other parameters
that references it will be updated accordingly.

• Edit parameterized values in the Property Editor.

• Same parameters can be used for negation by prefixing
negative signs “-“.

• You can create and assign parameters from the fields of an
entity in Property Editor.

• Parameters can be referenced in angular brackets, along
with the usual reference using “&”.

• When more than one *PARAMETER with the same name
exist in a deck, the first one will be retained.

• Parameters with same names are maintained when
*PARAMTER_LOCAL is used and they are specified in
different include files.

• Free format is supported.

Limitations:

• Support is limited to all FE entities except elements and
nodes.

• Parameterization of entity ID’s is only supported for
Components, Properties, Materials and Curve.

• Parameterization of entity ID’s is not supported.

• Unsupported parameterized entities and fields are replaced
with corresponding parameter values during import, to
avoid the loss of data.

• In macros and browsers, if any parameterized variable is
changed a warning message will appear in the message bar
and the value will not be updated.

*PARAMETER_EXPRESSION

*PARAMETER_EXPRESSION_LOCAL

Defines numerical values through algebraic expressions of parameter names
referenced throughout the input file.
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Card Description

Note:  Supported:

• Parameters can be created, imported, and exported.

• You can edit parameters and parameter expressions in the
Property Editor.

• Parameter expressions are evaluated on the fly.

• Parameter expression can reference another parameter.

• If you edit the value of a parameter, the other parameters
that references it will be updated accordingly.

• Same parameters can be used for negation by prefixing
negative signs “-“.

• Edit parameterized variables in the Property Editor.

• Parameters can be referenced in angular brackets, along
with the usual reference using “&”.

• When more than one *PARAMETER_EXPRESSION with the
same name exists in a deck, the first one will be retained.

• Parameters with the same names are maintained when
*PARAMTER_EXPRESSION_LOCAL is used and they are
specified in different include files.

• Free format is supported.

Limitations:

• Support is limited to all FE entities except elements and
nodes.

• Parameterization of entity ID’s is only supported for
Components, Properties, Materials and Curves.

• Parameterization of entity ID’s is not supported.

• Unsupported parameterized entities and fields are replaced
with corresponding parameter values during import, to
avoid the loss of data.

• In Macros and Browser, if any parameterized variable is
changed a warning message will appear in the message bar
and the value will not be updated.

Nastran Cards

Card Description

%DEFREPSYM Defines default parameter values.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.378

Card Description

Note:  Can be created, imported, and exported.

Edit in the Property Editor.

%DEFREPWIDTH Defines default width information.

Note:  Automatically created during export when a parameter is
created in HyperMesh.

%SETREPSYM Defines default values.

Note:  Cannot be created in HyperMesh, only imported and
exported.

%UNDEFREPSYM Clears or unsets default parameter values.

Note:  Cannot be created in HyperMesh, only imported and
exported.

%UNSETREPSYM Clears or unsets parameter values.

Note:  Cannot be created in HyperMesh, only imported and
exported.

Materials that can be parameterized in the NastranMSC user profile.

• MAT1

• MAT10

• MAT2

• MAT4

• MAT5

• MAT8

• MAT9

• MATEP

• MATG

• MATHE

• MATHP

Properties that can be parameterized in the NastranMSC user profile.

• PAABSF
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• PACBAR

• PACINF

• PAERO2

• PBEND

• PBUSH

• PBUSH1D

• PCOMP

• PCOMPG

• PCOMPP

• PCONVM

• PWELD

• PDAMP

• PELAS

• PELAST

• PFAST

• PGAP

• PHBDY

• PMASS

• PROD

• PSEAM

• PSHEAR

• PSHELL

• PSHELL1

• PTUBE

• PVISC

OptiStruct Cards
• The parameter entity is supported in the OptiStruct interface, however support is limited to

parameters that are created in HyperMesh and associated with parameters in HyperStudy.

• Scope is limited to material and property entity types. Also, within those entity types,
parameterization is restricted to template attributes of type double.

• Parameterized attributes are unparameterized with their original value during export.

• Parameters cannot be exported or imported.

Radioss Cards

Card Description

/GLOBAL/INT_EXPR/ Defines numerical values through algebraic expressions of parameter names
referenced throughout the input file.
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Card Description

Note:  Supported:

• Parameters can be created, imported, and exported.

• Edit parameter expressions in the =Property Editor.

• Parameter expressions are evaluated on the fly.

• Parameter expressions can reference another parameter.

• If you edit the value of a parameter, the other parameters
that references it will be updated accordingly.

• Same parameters can be used for negation by prefixing
negative signs “-“.

• Edit parameterized variables in the Property Editor.

Limitations:

• Support is limited to all FE entities except elements and
nodes.

• Parameterization of entity IDs is not supported.

• Unsupported parameterized entities and fields are replaced
with corresponding parameter values during import, to
avoid the loss of data.

• In macros and browsers, if any parameterized variable
is changed, you will receive a warning message in the
message bar and the value will not be updated.

/GLOBAL/INTEGER/ Defines numerical values of parameter names referenced throughout the
input file.
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Card Description

Note:  Supported:

• Parameters can be imported, exported, and created.

• Edit parameter expressions in the Property Editor.

• Create and assign parameters on the fly in Property Editor.

• Same parameters can be used for negation by prefixing
negative signs “-“.

• Edit parameterized variables in the Property Editor.

Limitations:

• Support is limited to all FE entities except elements and
nodes.

• Parameterization of entity IDs is not supported.

• Unsupported parameterized entities and fields are replaced
with corresponding parameter values during import, to
avoid the loss of data.

• In macros and browser, if any parameterized variable
is changed, you will receive a warning message in the
message bar and the value will not be updated.

/GLOBAL/REAL/ Defines numerical values of parameter names referenced throughout the
input file.
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Card Description

Note:  Supported:

• Parameters can be imported, exported, and created.

• Edit parameter expressions in the Property Editor.

• Create and assign parameters on the fly in Property Editor.

• Same parameters can be used for negation by prefixing
negative signs “-“.

• Edit parameterized variables in the Property Editor.

Limitations:

• Support is limited to all FE entities except elements and
nodes.

• Parameterization of entity IDs is not supported.

• Unsupported parameterized entities and fields are replaced
with corresponding parameter values during import, to
avoid the loss of data.

• In macros and browser, if any parameterized variable
is changed, you will receive a warning message in the
message bar and the value will not be updated.

/GLOBAL/REAL_EXPR/ Defines numerical values through algebraic expressions of parameter names
referenced throughout the input file.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.383

Card Description

Note:  Supported:

• Parameters can be imported, exported, and created.

• Edit parameter expressions in the Property Editor.

• Parameter expressions are evaluated on the fly.

• Parameter expressions can reference another parameter.

• If you edit the value of a parameter, the other parameters
that references it will be updated accordingly.

• Same parameters can be used for negation by prefixing
negative signs “-“.

• Edit parameterized variables in the Property Editor.

Limitations:

• Support is limited to all FE entities except elements and
nodes.

• Parameterization of entity IDs is not supported.

• Unsupported parameterized entities and fields are replaced
with corresponding parameter values during import, to
avoid the loss of data.

• In macros and browser, if any parameterized variable
is changed, you will receive a warning message in the
message bar and the value will not be updated.

Samcef Cards
• The parameter entity is supported in the Samcef interface, however these parameters cannot be

directly exported in HyperStudy.

• Scope is limited to material and property entity types.

• Parameters are exported as the macro command /ABRE in the deck.

• Parameters can be exported or imported.

Plies
Ply entities define a FEA ply which is the FEA correlation to a physical ply.

Physical plies manufacture laminates which make up composite structures. A physical ply has attributes
of material, shape (area), thickness, and fiber orientation; where its shape is any complex flat pattern
that can be cut from a roll of material. Similarly, a FEA ply is composed of the same data attributes
as a physical ply (material, shape/area, thickness, and fiber orientation). The shape of a FEA ply can
either be defined by closed lines or approximated from the elements which most closely represent its
actual complex shape. In the case where plies are defined on lines, perform a realization to convert this
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information into a definition by elements. Ply data defined on lines is imported from Catia Composites
Parts Design (CPD) data.

Plies defined by elements
The shape (area) of an FEA ply is defined by selecting elements which most closely represent
the complex shape of a physical ply. In Figure 138, an elliptical physical ply shape is defined by
the brown line. The corresponding FEA ply shape is defined by the gray shaded elements of the
associated FEA mesh. Typically, if an element's centroid exists within the bounds of the physical
ply shape, that element is considered part of the FEA ply shape.

Figure 138:

Plies defined by lines
Plies can be defined by selecting lines which build a closed area. If CPD data is imported from
Catia files, plies are defined on lines.
Once a mesh is available, plies defined by lines can be converted into plies defined by elements by
performing a realization. Realization/conversion methods include:

Project normal to target mesh
If the element centroid projected along its normal lies within the geometrical ply definition,
it is associated with this ply.

Normal by ply contour
Projection along a normal on a surface derived from the lines of a ply contour.

Specified direction
Manually define a projection direction.
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The ply thickness is typically defined as the final cured thickness of a single ply of material. In addition,
the ply can be made of any material: isotropic, orthotropic, anisotropic, or any other material law.

Figure 139:

The fiber orientation of a ply defines the direction fibers lay within that ply. The ply fiber orientation is
typically an integer value between -90 and 90. The fiber orientation of a ply is always defined relative to
each elements material direction using right hand rule around the elements normal, or thru-thickness
direction, to define positive angles. Even though a ply's fiber orientation is a constant integer, element
material directions can vary from element to element, and this allows varying fiber directions within a
ply to be modeled. Element material directions are defined differently from solver interface to solver
interface.

Figure 140:

Once all of the plies which make up a composite structure are defined, just as in the actual hand-layup
manufacturing process, plies are stacked in a specific given order within the laminate entity to define a
laminate of the structure. It is possible to stack plies, whether they are defined based on geometry or
elements.

Turn the display of plies on/off or change the way plies appear in the modeling window with the Ply
layers display setting, which can be accessed from the Mesh Display settings on the View Controls
toolbar.
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Supported Solver Cards
Solver cards supported for plies.

Abaqus Cards
The Abaqus solver has no direct match for a ply, therefore the ply entity does not have a card image in
the Abaqus solver interface. Ply entity names will end up in the ply name of the composite properties
SHELL SECTION and SHELL GENERAL SECTION, if used in a laminate entity and realized into a zone
based model.

Nastran Cards
The Nastran solver has no direct match for a ply, therefore the ply entity does not have a card image in
the Nastran solver interface. Ply entity IDs will end up as global ply ID in the PPOMG property card, if
used in a laminate entity and realized into a zone based model.

OptiStruct Cards
The OptiStruct PLY card is represented as a ply entity. Plies can be created from the selection of
individual elements or from predefined element sets which define the ply shape.

Card Description

PLY Defines the properties of a ply used in ply-based composite definition.
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Card Description

Note:  Can only be created and edited in the Ply Editor from the
Model Browser.

Radioss Cards
The property card /PROP/PLY (TYPE19) and keyword /PLY are represented as a ply entity.

Samcef Cards
The Samcef .PLI card is represented as a ply entity.

Create and Realize Plies
Overview of how to create and realize plies.

Radioss

Create Plies

1. In the Model Browser, right-click and select Create > Ply from the context menu.

2. In the Create Ply dialog, define attributes accordingly.

Option Description

Name Ply name.

This will define the prop_title attribute of /PROP/TYPE19.

Same as Duplicate an existing ply.

Card Image Keyword used for the ply creation.

/PROP/PLY if P19_PLY card image is used, or /PLY if PLY card image is used.

Color Color of ply.

Dummy ply Create simple ply without a card image.

Material Type Type of material assigned to ply.

Material Material assigned to ply.

This will define the mat_ID attribute in /PROP/TYPE19.
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Option Description

Thickness Ply thickness.

This will define the t attribute in /PROP/TYPE19

System Reference system used for the angle calculation of the ply.

The system is not linked to an attribute of the /PROP/TYPE19, but can be
defined by importing external composite data like FiberSim information. This
information will be taken into account during the realization of the ply.

Orientation Fiber angle on the ply.

This will define the delta_phi attribute in /PROP/TYPE19.

Integration
points

Number of integration point through the ply thickness.

This will define the Npt_ply attribute in /PROP/TYPE19.

Drape table Drape table to link to the ply.

The drape table will not linked to an attribute of the /PROP/TYPE19, but can
be defined by importing external composite data like FiberSim information.
If specified, a realization of the ply is needed to obtain the initial fiber
angle defined with the Radioss cards /INISHE/ORTH_LOC and /INSH3N/
ORTH_LOC.

Shape Shape of the ply.

The attributes grsh4n_ID and grsh3n_ID of /PROP/TYPE19 are automatically
generated.

If the shape is defined by a line or surface, which may be the case when
importing CAD/CPD data, a realization of the ply is needed to generate the
FE element sets defining the FE shape.

Base Surfaces Base surfaces to be used during ply realization.

This is useful when the projection of the shape is not found on a unique
surface.

3. Click Create.
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You can edit a ply by right-clicking on it in the Model Browser and selecting Edit from the context
menu.

Realize Plies
Realize plies when ply definitions need to be imported from external composite data, such as FiberSim
or CAD/CPD.

Before you realize plies, make sure the Radioss composite property card /PROP/TYPE17 or /PROP/
TYPE51 is assigned to the composite components on which the realization should be performed.

During the realization process, the shape of the ply will be projected on the selected FE mesh and,
if drape information is available, the corresponding Radioss cards /INISHE/ORTH_LOC, /INSH3N/
ORTH_LOC, or /DRAPE will be generated.

1. In the Model Browser, right-click on the Plies folder and select Realize from the context menu.

2. In the Ply Realization dialog, define realization settings accordingly.

Note:  For each case (FiberSim or CAD/CPD), a dedicated projection method is
proposed in the Projection options field.

3. Click Realize.

Plots
Plot entities associate and organize curve entities within a xy plot window.

Positions
Position entities allow you to apply a Transformation sequence on set of nodes or SolverSubmodels.

Abaqus Cards

Card Description

*NMAP Maps nodes from one coordinate system to another, and rotates, translates,
or scales the nodal coordinates.
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Card Description

Note:  A *NMAP keyword is generated for each Transformation
listed in the given Position entity.

Radioss
In the Radioss solver profile, there is no solver keywords mapped in Position entity. The Position
entity is used to manage the Transformations applied on a set of nodes or a Submodel. Position and
Transformations are managed in the Position/Transformation Tool.

Pretensioner
Pretensioner entities define pretensioners.

LS-DYNA Cards

Card Description

*ELEMENT_SEATBELT_PRETENSIONERDefines pretensioners.

Properties
Property entities define and store 1D, 2D, and 3D property definitions for a model.

Properties do not have a display state in the modeling window. You can color the model according to
the colors assigned to each property, which is based on element property relationships, by changing the
color mode to propety.

Element property relationships are dependent on the solver interface. In general, when a component is
assigned a property, that property assignment is applied to all elements collected by that component.
The method of assigning properties at the component level is therefore referred to as indirect property
assignment. Direct property assignment is performed directly on the elements themselves, typically via
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a property assignment. Direct property assignments always take precedence over indirect property and
material assignments.

Abaqus Cards

Card Description

*ADAPTIVE CONTROLS Controls various aspects of the adaptive meshing and advection algorithms
applied to an adaptive mesh domain.

*BEAM ADDED INERTIA Define additional beam inertia.

*BEAM GENERAL
SECTION

Specify a beam section when numerical integration over the section is not
required.

Note:  Only one *BEAM GENERAL SECTION card is output per
component, therefore the beam elements in each component
must have the same cross-sectional properties.

*BEAM SECTION Specify a beam section when numerical integration over the section is
required.

Note:  Only one *BEAM SECTION card is output per component,
therefore the beam elements in each component must have the
same cross-sectional properties.

*COHESIVE SECTION Specify element properties for cohesive elements.

*CONNECTOR SECTION Specify connector attributes for connector elements.

Note:

The following types are supported:

Standard template:

,

Explicit template:

All listed above, as well as ROTATION-ACCELEROMETER

*CONTACT DAMPING Define viscous damping between contacting surfaces.

Note:  This card is a sub-option in the *SURFACE INTERACTION
card image.

*DASHPOT Define dashpot behavior.
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Card Description

Note:  Only one *DASHPOT card is output per component,
therefore the spring elements in each component must have the
same properties.

When the *DASHPOT card is written for DASHPOT1 elements,
both dof1 and dof2 are written, but Abaqus only reads dof1.

For DASHPOTA elements, choose the DASHPOTA option in the
*DASHPOT card image.

*ELEMENT PROPERTIES

*EULERIAN SECTION Define properties of Eulerian continuum elements, including the list of
materials that may occupy the elements.

*FASTENER (SPOT
WELD) PROPERTY

Prescribe mesh-independent fastener properties.

*FLUID BULK MODULUS Define compressibility for a hydraulic fluid.

Note:  This option is used to define compressibility for the
hydraulic fluid model. It can only be used in conjunction with the
*FLUID BEHAVIOR option or the *FLUID PROPERTY option.

*FLUID DENSITY Specify hydrostatic fluid density.

Note:  This option is used to define the reference fluid
density for fluid cavities. It is only applicable for hydraulic and
pneumatic fluids, and should not be used for user-defined fluids.
The *FLUID DENSITY option can only be used in conjunction
with the *FLUID BEHAVIOR option or the *FLUID PROPERTY
option.

*FLUID EXPANSION Specify the thermal expansion coefficient for a hydraulic fluid.

Note:  This option is used to define thermal expansion
coefficients for the hydraulic fluid model. It can only be used in
conjunction with the *FLUID BEHAVIOR option or the *FLUID
PROPERTY option.

*FLUID PROPERTY Define properties for hydrostatic fluid elements.

*FRICTION Specify a friction model.
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Card Description

Note:  This card is a sub-option in the *SURFACE INTERACTION
card image. It is also supported as a separate card image to
allow for it to be used as a sub-option of the *CONNECTOR
FRICTION card (in *CONNECTOR BEHAVIOR).

*GAP Specify clearance and local geometry for GAP-type elements.

Note:  Only one *GAP card is output per component, therefore
the gap elements in each component must have the same
properties.

Not available in the Explicit template.

*GASKET SECTION Specify element properties for gasket elements.

Note:  Not available in the Explicit template.

*ITS Define the properties for ITS-type elements.

*JOINT Define properties for JOINTC elements.

Note:  Only one *JOINT card is output per component, therefore
the spring elements in each component must have the same
properties.

The *SPRING and *DASHPOT cards in the *JOINT property
behave the same way as the individual cards mentioned above.
See the How do I section below for more information.

Not available in the Explicit template.

*M1 Define the first bending moment behavior of beams.

*M2 Define the second bending moment behavior of beams.

*MASS Specify a point mass.

Note:  Only one *MASS card is output per component, therefore
the mass elements in each component must have the same
properties.

*MEMBRANE SECTION Specify section properties for membrane elements.
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Card Description

*NONSTRUCTURAL
MASS

Specify mass contribution to the model from nonstructural features.

Note:  Only available in the Explicit template.

*PHYSICAL CONSTANTS Specify physical constants.

*REBAR LAYER Reinforcement definition

Note:  The keyword is available in the card image of the SHELL
SECTION (homogeneous and composite), MEMBRANE SECTION,
and SURFACE SECTION.

*RIGID BODY Define a set of elements as a rigid body and define rigid element properties.

Note:  For Analytical Rigid Surfaces, the ANALYTICAL
SURFACE parameter should point to the corresponding
ANALYTICAL_RIGID_SURFACE group from the card image of the
*RIGID BODY card.

*ROTARY INERTIA (no
longer listed on panel)

Define rigid body rotary inertia.

Note:  Only one *ROTARY INERTIA card is output per
component, therefore the ROTARY1 elements in each component
must have the same properties.

*SECTION CONTROLS Specify section controls.

*SHELL GENERAL
SECTION

Define a general, arbitrary, elastic shell section.

*SHELL SECTION Specify a shell cross-section.

*SOLID SECTION Specify element properties for solid, infinite, acoustic, and truss elements.

*SPRING Define spring behavior.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.395

Card Description

Note:  Only one *SPRING card is output per component,
therefore the spring elements in each component must have the
same properties.

When the *SPRING card is written for SPRING1 elements, both
dof1 and dof2 are written, but Abaqus only reads dof1.

For SPRINGA elements, choose the SPRINGA option in the
*SPRING card image.

*SURFACE BEHAVIOR Define alternative pressure-overclosure relationships for contact.

Note:  This card is a sub-option in the *SURFACE INTERACTION
card image.

*SURFACE
INTERACTION

Define surface interaction properties.

Note:  For Abaqus Explicit template, this card is defined as a
group.

*SURFACE PROPERTY /
*EMISSIVITY

Define surface properties for cavity radiation analysis. It must immediately
precede the *EMISSIVITY option.

*SURFACE SECTION Specify section properties for surface elements.

*SURFACE SMOOTHING Create a surface smoothing definition for contact interactions. It must be
used in conjunction with the *CONTACT PAIR option.

*TRANSVERSE SHEAR
STIFFNESS

Define transverse shear stiffness for beams and shells.
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Card Description

Note:  This option must be used in conjunction with the *BEAM
GENERAL SECTION, *BEAM SECTION, *COHESIVE SECTION,
*SHELL GENERAL SECTION, or the *SHELL SECTION options.
The transverse shear stiffness defined with this option affects
only the transverse shear flexible elements whose section
properties are defined by the immediately preceding section
option.

ANSYS Cards

Card Description

SECTYPE Associates section type information with a section ID number.

LS-DYNA Cards

Card Description

*CONSTRAINED_JOINT_STIFFNESS_FLEXION-
TORSION

Define optional rotational and translational joint stiffness for joints.

*CONSTRAINED_JOINT_STIFFNESS_GENERALIZEDDefine optional rotational and translational joint stiffness for joints.

*CONSTRAINED_JOINT_STIFFNESS_TRANSLATIONALDefine optional rotational and translational joint stiffness for joints.

*DAMPING_PART_MASS Define mass weighted damping by part ID

*DAMPING_PART_MASS_SET

*DAMPING_PART_STIFFNESSAssign Rayleigh stiffness damping coefficient by part ID

*DAMPING_PART_STIFFNESS_SET

*DAMPING_RELATIVE Apply damping relative to the motion of a rigid body.

*DEFINE_CONNECTION_PROPERTIESDefine failure related parameters for solid element spot weld failure by
*MAT_SPOTWELD_DAIMLERCHRYSLER.

*EOS_GRUNEISEN (EOS
4)

Equation of state Form 4.
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Card Description

*EOS_IDEAL_GAS (EOS
12)

Equation of state for 12 for modeling ideal gas.

*EOS_IGNITION_AND_GROWTH_OF_REACTION_IN_HE
(EOS 7)

Equation of state Form 7.

*EOS_JWL (EOS 2) Equation of state Form 2.

*EOS_LINEAR_POLYNOMIAL
(EOS 1)

Equation of state Form 1. Define coefficients for linear polynomial EOS and
initialize the initial thermodynamic state of the material.

*EOS_LINEAR_POLYNOMIAL_WITH_ENERGY_LEAK
(EOS 6)

Equation of state Form 6.

*EOS_PROPELLANT_DEFLAGRATION
(EOS 10)

Equation of state Form 10. Added to model airbag propellants.

*EOS_RATIO_OF_POLYNOMIALS
(EOS 5)

Equation of state Form 5.

*EOS_SACK_TUESDAY
(EOS 3)

Equation of state Form 3.

*EOS_TABULATED (EOS
9)

Equation of state Form 9.

*EOS_TABULATED_COMPACTION
(EOS 8)

Equation of state Form 8.

*EOS_TENSOR_PORE_COLLAPSE
(EOS 11)

Equation of state Form 11.

*INTEGRATION_BEAM Define user defined through the thickness integration rules for the beam
element.

*INTEGRATION_SHELL Define user defined through the thickness integration rules for the shell
element.

*MAT_ADD_EROSION Many of the consitutive models in LS-DYNA do not allow failure and erosion.
This option provides a way of including failure in these models although the
option can also be applied to constitutive models of other failure/erosion
criterion.

*SECTION_BEAM(TITLE) Define cross sectional properties for beam, truss, discrete beam and cable
elements.

*SECTION_BEAM_AISC Defines cross-sectional properties for beams and trusses.
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Card Description

*SECTION_DISCRETE(TITLE)Define spring and damper elements for translation and rotation.

*SECTION_POINT_SOURCE(TITLE)Provides the inlet boundary condition for single gas flow (inflation potential)
via a set of point source(s).

*SECTION_POINT_SOURCE_MIXTURE(TITLE)Provides: (a) an element formulation for a solid ALE part of the type similar
to ELFORM=11 of *SECTION_SOLID and (b) the inlet gas injection boundary
condition for multiple-gas mixture in-flow via a set of point sources.

*SECTION_SEATBELT(TITLE)Define section properties for the seat belt elements.

*SECTION_SHELL(TITLE) Define section properties for shell elements.

*SECTION_SHELL_ALE(TITLE)Define section properties for shell elements.

*SECTION_SHELL_EFG(TITLE)Define section properties for shell elements.

*SECTION_SOLID(TITLE) Define section properties for solid continuum and fluid elements.

*SECTION_SOLID_ALE(TITLE)Define section properties for solid continuum and fluid elements.

*SECTION_SOLID_EFG(TITLE)Define section properties for solid continuum and fluid elements.

*SECTION_SPH Define section properties for SPH particles.

*SECTION_SPH_TENSOR

*SECTION_SPH_USER

*SECTION_TSHELL(TITLE)Define section properties for SPH particles.

Nastran Cards
Only one card image can be loaded into each property collector.

1D elements can be grouped into components with 2D and 3D elements for display purposes. The
component groupings are maintained on export and import.

Properties for PBAR and PBEAM cards can be manually input in the card image or automatically created.

The HM_ELAS card defines properties for an HM_Spring element.

The Nastran and OptiStruct solver interfaces allow the property between groups to have the same ID.
For example, PBAR3, PSHELL 3 and PSOLID 3. Duplicate IDs within the same group is not allowed.

Nastran and OptiStruct properties are grouped as follows:

0D_Rigids
PMASS
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1D
PBAR, PBARL, PBEAM, PBEAML, PBEAND, PROD, PTUBE, PWELD

SPRING_GAP
PBUSH, PBUSH1D, PDAMP, PELAS, PGAP, PVISC

2D
PSHELL, PSHEAR, PCOMP, PCOMG

3D
PSOLID

Card Description

BCBDPRP Defines contact body parameters.

BCONPRG Defines geometric contact parameters of touching bodies.

BCONPRP Defines physical contact parameters of touching bodies.

PAABSF Defines the properties of a frequency-dependent acoustic absorber element.

PACABS Defines the properties of the acoustic absorber element.

PACBAR Defines the properties of the acoustic barrier element.

Note:  PACBAR is referenced by a CHACBR entry only.

Either FRESON or KRESON must be specified, but not both.

PACINF Defines the properties of acoustic conjugate infinite elements.

PAERO1 Defines associated bodies for the panels in the Doublet-Lattice method.

PAERO2 Defines the cross-sectional properties of aerodynamic bodies.

PAXSYMH Defines the properties of a linear axisymmetric harmonic element.

PBAR Defines the properties of a simple beam element (CBAR entry).

PBARL Defines the properties of a simple beam element (CBAR entry) by cross-
sectional dimensions.

PBEAM Defines the properties of a beam element (CBEAM entry). This element may
be used to model tapered beams.

Note:  Blank fields are not supported for intermediate stations.
Appropriate default values are inserted during feinput.

PBEAML Defines the properties of a beam element by cross-sectional dimensions.
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Card Description

Note:  Blank fields are not supported for intermediate stations.
Appropriate default values are inserted during feinput.

PBEND Defines the properties of a curved beam, curved pipe, or elbow element
(CBEND entry).

PBUSH Defines the nominal property values for a generalized spring-and-damper
structural element.

PBUSH1D Defines linear and nonlinear properties of a one-dimensional spring and
damper element (CBUSH1D entry).

PBUSHT Defines the frequency dependent properties or the stress dependent
properties for a generalized spring and damper structural element.

PCOMP Defines the properties of an n-ply composite material laminate.

PCOMPG Defines global (external) ply IDs and properties for a composite material
laminate.

PCOMPLS Defines global (external) ply IDs and properties for a composite material
laminate in SOL 600 and SOLs 400 and 700.

PCONVM Specifies forced convection boundary condition properties for a boundary
condition surface element.

PDAMP Specifies the damping value of a scalar damper element using defined
CDAMP1 or CDAMP3 entries.

PELAS Specifies the stiffness, damping coefficient, and stress coefficient of a scalar
elastic (spring) element (CELAS1 or CELAS3 entry).

PELAST Defines the frequency dependent properties for a PELAS Bulk Data entry.

PFAST Defines the CFAST fastener property values.

PGAP Defines the properties of the gap element (CGAP entry).

PHBDY Property entry referenced by a CHBDYP element to give auxiliary geometric
information for it.

PLPLANE Defines the properties of a fully nonlinear (i.e., large strain and large
rotation) hyperelastic plane strain

or axisymmetric element.
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Card Description

PLSOLID Defines a fully nonlinear (i.e., large strain and large rotation) hyperelastic
solid element.

PMASS Specifies the mass value of a scalar mass element (CMASS1 or CMASS3
entries).

PROD Defines the properties of a rod element (CROD entry).

PSEAM Defines the PSEAM property values.

PSHEAR Defines the properties of a shear panel (CSHEAR entry).

PSHELL Defines the membrane, bending, transverse shear, and coupling properties
of thin shell elements.

PSHELL1 Defines the properties of SOL 700 shell elements, which are more
complicated than the shell elements defined using the PSHELL entry.

PSHLN1

PSOLID Defines the properties of solid elements (CHEXA, CPENTA, and CTETRA
entries).

PTUBE Defines the properties of a thin-walled cylindrical tube element (CTUBE
entry).

PVISC Defines properties of a one-dimensional viscous damping element (CVISC
entry).

PWELD Defines the properties of connector (CWELD) elements.

OptiStruct Cards
Only one property definition is allowed on each property collector. For definitions like PMASS, which
allow more than one definition on the same card, this is separated on import into four different cards.

1D elements can be organized into components with 2D and 3D elements, and these component
groupings are maintained on export and import. However, this usage is not recommended.

Card Description

HM_ELAS Defines properties for a HM_Spring element.

Note:  Bulk Data Entry

PAABSF Defines the properties of the fluid acoustic absorber element.
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Card Description

Note:  Bulk Data Entry

PAXI Defines the properties of axisymmetric elements. Referenced by CTAXI
entry.

Note:  Bulk Data Entry

Referenced by CTAXI.

PBAR Defines the properties of a simple beam (bar), which is used to create bar
elements via the CBAR entry.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

PBARL Defines the properties of a simple beam (bar) by cross-sectional dimensions,
which is used to create bar elements via the CBAR entry.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

PBEAM Defines the properties of beam elements defined via the CBEAM entry.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

PBEAML Defines the properties of a beam element by cross-sectional dimensions that
are used to create beam elements via the CBEAM entry.

Note:  Bulk Data Entry

PBUSH Defines the nominal property values for a generalized spring-damper-mass
structural element.

Note:  Bulk Data Entry

PBUSH1D Defines the linear and nonlinear properties for a one-dimensional spring-
and-damper structural element.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.403

Card Description

Note:  Bulk Data Entry

PCOMP Defines the structure and properties of an n-ply composite laminate
material.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

PCOMPG Defines the structure and properties of a composite laminate material,
allowing for global ply identification.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

PCOMPP Defines the properties of a composite laminate material used in ply-based
composite definition.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

PCONT Defines properties of a CONTACT interface.

Note:  Bulk Data Entry

PCONTX Defines properties of a CONTACT interface for geometric nonlinear analysis.

Note:  Bulk Data Entry

PDAMP Specifies the damping of a scalar damper element using defined CDAMP1 or
CDAMP3 entry.

Note:  Bulk Data Entry

PELAS Used to define the stiffness and stress coefficient of a scalar elastic element
(spring) by means of the CELAS1 or CELAS3 entry.

Note:  Bulk Data Entry
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Card Description

PFAST Define properties of connector (CFAST) elements.

Note:  Bulk Data Entry

PGAP Defines properties of the gap (CGAP or CGAPG) elements.

Note:  Bulk Data Entry

PGASK Defining the properties for solid gasket elements.

Note:  Bulk Data Entry

PLSOLID Defines the properties of nonlinear hyperelastic solid elements, referenced
by CHEXA, CPENTA, and CTETRA Bulk Data Entries. The MATHE hyperelastic
material can be referenced to define corresponding material properties.

Note:  Bulk Data Entry

PMASS Defines the mass value of a scalar mass element (CMASS1 or CMASS3 entry).

Note:  Bulk Data Entry

PROD Defines the properties of a rod, which is referenced by the CROD entry.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

PSHEAR Defines the properties of a shear panel.

Note:  Bulk Data Entry

PSHELL Defines the membrane, bending, transverse shear, and membrane-bending
coupling of shell elements.

Note:  Bulk Data Entry

Exported in large field format by optistructlf template.

PSOLID Defines the properties of solid elements, referenced by CHEXA, CPENTA,
CPYRA and CTETRA Bulk Data Entries.
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Card Description

Note:  Bulk Data Entry

PTUBE Defines the properties of a thin-walled cylindrical tube element, referenced
by a CTUBE entry.

Note:  Bulk Data Entry

PVISC Defines properties of a one-dimensional viscous damping element (CVISC
entry).

Note:  Bulk Data Entry

PWELD Defines properties of connector (CWELD) elements.

Note:  Bulk Data Entry

PAM-CRASH Cards

Card Description

FRICT / Friction modeling definition.

GASPEC / Specification of air bag gas.

RUPMO / Rupture model definition.

Permas Cards

Card Description

$GEODAT BEAM Beam

$GEODAT CONA Surface convection

$GEODAT CONS Shell surface convection

$GEODAT DAMPER Viscous damper

$GEODAT FLANGE Flange

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.406

Card Description

$GEODAT GASKET Gasket

$GEODAT MASS Mass

$GEODAT SCALAR Scalar

$GEODAT SHELL Shell

$GEODAT SOLID Solid

$GEODAT SPRING Spring

$GEODAT SPRINGX Spring

Radioss Cards
Radioss allows you to program your own properties, mostly for springs, that can be used in a
simulation. Unsupported Radioss properties and user defined Radioss properties are assigned the
PROP_UNSUPPORTED card image.

HyperMesh imports unsupported properites with the PROP_UNSUPPORTED card image, and preserves
their corresponding IDs and associated components.

In the PROP_UNSUPPORTED card image, all property sub-options, parameters, and data lines are
supported as simple text. HyperMesh does not check the validity or syntax of any data in this mode.
You must manually check the validity of the data. No editing, updating, or review of the property data
is intended. Also time step calculation and mass calculation are not available for the component that
refers to this property.

Card Description

/ADMESH/SET Defines the criteria for adaptive meshing in parts. This keyword is not
available for SPMD computation.

Note:  Block Format Keyword

/DAMP/ Defines the Rayleigh mass and stiffness damping coefficients applied to a
set of nodes. The damping can be applied to any nodal DOF either in local or
global coordinate system.

Note:  Block Format Keyword

/EOS/GRUNEISEN Describes the Gruneisen equation of state.
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Card Description

Note:  Block Format Keyword

/EOS/POLYNOMIAL Describes the Linear polynomial equation of state P( ρ ,E).

Note:  Block Format Keyword

/EOS/PUFF Describes the linear polynomial equation of state P(ρ,E) .

Note:  Block Format Keyword

/EOS/SESAME Describes the SESAME table equation of state.

Note:  Block Format Keyword

/EOS/TILLOTSON Describes the Tillotson equation of state.

Note:  Block Format Keyword

/FAIL Describes the failure models.

Note:  Block Format Keyword

/FAIL/CHANG Describes the Chang failure model.

Note:  Block Format Keyword

/FAIL/CONNECT Describes the failure model for CONNECTION material with elongation
criteria and/or energy criteria.

Note:  Block Format Keyword

/FAIL/ENERGY Describes a specific energy failure model.

Note:  Block Format Keyword

/FAIL/FLD Describes the forming limit.
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Card Description

Note:  Block Format Keyword

/FAIL/HASHIN Describes the Hashin failure model. This failure model is available for Shell
and Solid.

Note:  Block Format Keyword

/FAIL/JOHNSON Describes the failure criteria by Johnson-Cook failure model.

Note:  Block Format Keyword

/FAIL/LAD_DAMA Describes the Ladeveze failure model for delamination (interlaminar
fracture).

Note:  Block Format Keyword

/FAIL/PUCK Describes the Puck failure model.

Note:  Block Format Keyword

/FAIL/SPALLING Describes the Spalling and Johnson-Cook failure model.

Note:  Block Format Keyword

/FAIL/TAB1 Describes the strain failure model based on damage accumulation using
user-defined functions.

Note:  Block Format Keyword

/FAIL/TBUTCHER Describes a Tuler-Butcher failure model.

Note:  Block Format Keyword

/FAIL/TENSSTRAIN Describes a strain failure model.

Note:  Block Format Keyword
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Card Description

/FAIL/USERi (USER 1, 2,
3)

Describes a user failure model.

Note:  Block Format Keyword

/FAIL/WIERZBICKI Describes the BAO-XUE-Wierzbicki failure model.

Note:  Block Format Keyword

/FAIL/WILKINS Describes the Wilkins failure model.

Note:  Block Format Keyword

/FAIL/XFEM Describes a XFEM (eXtended Finite Element Method) failure model.

Note:  Block Format Keyword

/LEAK/MAT Specifies effective leakage area of porous airbag fabric materials LAW19 and
LAW58 as function of time, pressure, area and other parameters.

Note:  Block Format Keyword

/PROP Describes the property sets.

Note:  Block Format Keyword

/PROP/TYPE3 (BEAM) Describes the beam property for torsion, bending, membrane or axial
deformation.

Note:  Block Format Keyword

/PROP/TYPE43
(CONNECT)

Designed for spotweld, welding line or glue type connections. Only used with
/MAT/CONNECT material law.

Note:  Block Format Keyword

/PROP/TYPE14 (FLUID) Describes the general fluid property set.

Note:  Block Format Keyword
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Card Description

/PROP/INJECT1 Describes mass injected for each constituent gas.

Note:  Block Format Keyword

/PROP/INJECT2 Describes molar fraction injected for each constituent gas and total mass
injected.

Note:  Block Format Keyword

/PROP/TYPE18
(INT_BEAM)

Describes the integrated beam property set. This beam model is based on
Timoshenko theory and takes into account transverse shear strain without
warping in torsion. It can be used for deep beam cases (short beams). Beam
section and position of integration points can be either used as predefined or
prescribed directly.

Note:  Block Format Keyword

/PROP/TYPE33 (KJOINT) Describes the joint type spring.

Note:  Block Format Keyword

/PROP/TYPE45
(KJOINT2)

Describes the joint type spring between two rigid bodies.

Note:  Block Format Keyword

/PROP/TYPE19 (PLY) Defines the ply property set used in ply-based composite definition. It is
used in combination with /PROP/STACK (/PROP/TYPE17) or /PROP/TYPE51 to
create ply-based sandwich composite properties.

Note:  Block Format Keyword

/PROP/TYPE15
(POROUS)

Describes the porous solid element property set (extended Darcy's law).

Note:  Block Format Keyword

/PROP/TYPE5 (RIVET) Describes the rivet property set.

Note:  Block Format Keyword
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Card Description

/PROP/TYPE10
(SH_COMP)

Defines the composite shell property set. It is possible to define composite
with several layers and each layer with individual orthotropic direction.

Note:  Block Format Keyword

/PROP/TYPE16
(SH_FABR)

Defines the anisotropic layered shell property set. This property is currently
only compatible with Elastic Anisotropic Fabric (/MAT/LAW58 (FABR_A)) and
only one layer is allowed.

Note:  Block Format Keyword

/PROP/TYPE9
(SH_ORTH)

Defines the orthotropic shell property.

Note:  Block Format Keyword

/PROP/TYPE19 (PLY) Defines the ply property set used in ply-based composite definition. It is
used in combination with /PROP/STACK (/PROP/TYPE17) or /PROP/TYPE51 to
create ply-based sandwich composite properties.

Note:  Block Format Keyword

/PROP/TYPE11
(SH_SANDW)

Defines the sandwich shell property set. It is possible to define sandwich
composite with several layers and each lay with individual material,
thickness, layer position and orthotropic direction. This property is only
compatible with Material Laws 15, 25, 27, 36, 60, 72 and user laws.

Note:  Block Format Keyword

/PROP/TYPE1 (SHELL) Describes the shell property set which used for 3-node or 4-node shell
element. Belytschko, QBAT or QEPH shell formulation are available.

Note:  Block Format Keyword

/PROP/TYPE6
(SOL_ORTH)

Describes the orthotropic solid property set. This property set is used to
define the fiber plane for /MAT/LAW14(COMPS0), the steel reinforcement
direction for /MAT/LAW24 (CONC) or the cell direction for /MAT/LAW28
(HONEYCOMB). This property is only available for 8-node linear solid elements
(/BRICK), tetrahedron elements (/TETRA4 and /TETRA10), and 2D solid
elements (/QUAD). Quadratic bricks (/BRIC20 and /SHEL16) and pentahedron
elements (/PENTA6) are not compatible with this property.
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Card Description

Note:  Block Format Keyword

/PROP/TYPE14 (SOLID) Defines the general solid property set.

Note:  Block Format Keyword

/PROP/SPH Defines the axisymmetric spring property set.

Note:  Block Format Keyword

/PROP/TYPE25
(SPR_AXI)

Defines the axisymmetric spring property set.

Note:  Block Format Keyword

/PROP/TYPE13
(SPR_BEAM)

A beam type spring property that works as a beam element with six
independent modes of deformation. This spring accounts for non-linear
stiffness, damping and different unloading. Deformation, force and energy-
based failure criteria are available.

Note:  Block Format Keyword

/PROP/TYPE44
(SPR_CRUS)

A spring element property that represents a simple macro model of a
crushable frame in compression, tension, torsion and bending. Originally,
this element was developed in cooperation with PSA PEUGEOT CITROËN.

Note:  Block Format Keyword

/PROP/TYPE8
(SPR_GENE)

A spring property that works with six independent modes of deformation.
This spring accounts for non-linear stiffness, damping and different
unloading. Deformation, force and energy based failure criteria are available.
The general spring property is often used to model a joint connection
between two parts.

Note:  Block Format Keyword

/PROP/TYPE32
(SPR_PRE)

Describes the pretension spring property set.

Note:  Block Format Keyword
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Card Description

/PROP/TYPE12
(SPR_PUL)

A pulley spring property set (with one translational DOF) used to model a
pulley.

Note:  Block Format Keyword

/PROP/TYPE26
(SPR_TAB)

Defines the tabulated spring property.

Note:  Block Format Keyword

/PROP/TYPE4 (SPRING) Defines spring property with one translational DOF. This spring accounts for
non-linear stiffness, damping and different unloading. Deformation based
failure criteria is available.

Note:  Block Format Keyword

/PROP/TYPE17 (STACK) Defines the sandwich shell property set using the stack and ply approach.

Note:  Block Format Keyword

/PROP/TYPE2 (TRUSS) Defines the truss property set.

Note:  Block Format Keyword

/PROP/TYPE22
(TSH_COMP)

Defines the composite thick shell property set.

Note:  Block Format Keyword

/PROP/TYPE21
(TSH_ORTH)

Defines the orthotropic thick shell property set.

Note:  Block Format Keyword

/PROP/TYPE20 (TSHELL) Defines the general thick shell property set.

Note:  Block Format Keyword

/PROP/USER User-defined property.

Note:  Block Format Keyword
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Card Description

/PROP/TYPE0 (VOID) Defines the void property set.

Note:  Block Format Keyword

/THERM_STRESS/MAT Adds thermal expansion property for Radioss material (shell and solid).

Note:  Block Format Keyword

Samcef Cards

Card Description

.BPR Define beam profiles.

.ETASHELL Used to assign the laminate to the elements. The Projection method is
supported.

.ETASOLID Used to assign the laminate to the elements. The Projection method is
supported.

.MCCBUSH Defines the property on the BUSH element.

.PHP SHELL Assign physical properties to an existing mesh.

SOLIDMAT Assign physical properties to an existing mesh.

Note:  This is a dummy property that creates a link between the
elements and the material, as it is not possible to directly assign
a material to the elements.

Regions
Region entities store information used to facilitate and automate modeling practices and processes. It
enables a selection which can be common across design changes or other models, provided region data
is the same.

Region entities support two configurations of input: By ID and By Metadata. Both inputs are supported
for geometry only, and can be used for selection purposes.
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For example, when using mesh controls, it is possible to mesh a surface which has been tagged with
metadata (or ID). If the design changes and a new version is authored, then you can quickly reapply
the same mesh controls as long as the metadata (or ID) is still applied to the new CAD version. Region
entities enables an automated re-meshing process that is consistently repeatable.

Retractors
Retractor entities define retractors.

LS-DYNA Cards

Card Description

*ELEMENT_SEATBELT_RETRACTORDefines retractors.

Rigid Walls
Rigid wall entities provide a method for treating a contact between a rigid surface and nodal points of a
deformable body. In the LS-DYNA and Radioss user profiles, rigid walls can be created in the Model and
Solver browsers.

LS-DYNA Cards

Card Description

*RIGIDWALL_GEOMETRIC_CYLINDER

*RIGIDWALL_GEOMETRIC_CYLINDER_DISPLAY

*RIGIDWALL_GEOMETRIC_CYLINDER_MOTION

*RIGIDWALL_GEOMETRIC_CYLINDER_MOTION_DISPLAY

*RIGIDWALL_GEOMETRIC_FLAT

*RIGIDWALL_GEOMETRIC_FLAT(FINITE)

*RIGIDWALL_GEOMETRIC_FLAT_DISPLAY

*RIGIDWALL_GEOMETRIC_FLAT_DISPLAY(FINITE)

*RIGIDWALL_GEOMETRIC_FLAT_MOTION

*RIGIDWALL_GEOMETRIC_FLAT_MOTION(FINITE)
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Card Description

*RIGIDWALL_GEOMETRIC_FLAT_MOTION_DISPLAY

*RIGIDWALL_GEOMETRIC_FLAT_MOTION_DISPLAY(FINITE)

*RIGIDWALL_GEOMETRIC_PRISM

*RIGIDWALL_GEOMETRIC_PRISM(FINITE)

*RIGIDWALL_GEOMETRIC_PRISM_DISPLAY

*RIGIDWALL_GEOMETRIC_PRISM_DISPLAY(FINITE)

*RIGIDWALL_GEOMETRIC_PRISM_MOTION

*RIGIDWALL_GEOMETRIC_PRISM_MOTION(FINITE)

*RIGIDWALL_GEOMETRIC_PRISM_MOTION_DISPLAY

*RIGIDWALL_GEOMETRIC_PRISM_MOTION_DISPLAY(FINITE)

*RIGIDWALL_GEOMETRIC_SPHERE

*RIGIDWALL_GEOMETRIC_SPHERE_DISPLAY

*RIGIDWALL_GEOMETRIC_SPHERE_MOTION

*RIGIDWALL_GEOMETRIC_SPHERE_MOTION_DISPLAY

*RIGIDWALL_PLANAR Define planar rigid walls with either finite or infinite size.

*RIGIDWALL_PLANAR_FINITE

*RIGIDWALL_PLANAR_FINITE_FORCES

*RIGIDWALL_PLANAR_FINITE_MOVING

*RIGIDWALL_PLANAR_FINITE_MOVING_DISPLAY

*RIGIDWALL_PLANAR_FINITE_MOVING_FORCES

*RIGIDWALL_PLANAR_FINITE_MOVING_FORCES_DISPLAY

*RIGIDWALL_PLANAR_MOVING_FORCES

*RIGIDWALL_PLANAR_MOVING

*RIGIDWALL_PLANAR_MOVING_DISPLAY

*RIGIDWALL_PLANAR_MOVING_FORCES

*RIGIDWALL_PLANAR_MOVING_FORCES_DISPLAY
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Card Description

*RIGIDWALL_PLANAR_ORTHO

*RIGIDWALL_PLANAR_ORTHO_FINITE

*RIGIDWALL_PLANAR_ORTHO_FINITE_FORCES

*RIGIDWALL_PLANAR_ORTHO_FORCES

OptiStruct

Card Description

RWALADD Defines a rigid wall set as a union of rigid walls defined via RWALL entries.

Note:  Bulk Data Entry

RWALL Defines a rigid wall for geometric nonlinear analysis.

Note:  Bulk Data Entry

Radioss Cards

Card Description

/RWALL/PLANE Infinite Plane rigid wall

/RWALL/CYL Infinite Cylinder rigid wall

/RWALL/SPHER Spherical rigid wall

/RWALL/PARAL Parallelogram rigid wall
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Card Description

/RWALL/THERM ALE infinite plane rigid wall with thermal conductivity

Sensors
Sensor entities define and store sensors typically used in safety analysis.

Sensors do not have a display state in the modeling window.

LS-DYNA Cards

Card Description

*DATABASE_CPM_SENSORActivates an ASCII file "cpm_sensor". Its input defines sensors' locations
based on the positions of some Lagrangian segments. The output gives the
history of the velocity, temperature, density, and pressure averaged on the
number of particles contained in the sensors.

*PART_SENSOR Links part/component to a sensor to activate and deactivate during the
analysis.

Note:  This is supported as an attribute to an element to
maintain its associativity with element inside HyperMesh.

*SENSOR_CONTROL Applies sensor result on an entity during run.

*SENSOR_DEFINE_ELEMENTStrain gauge type sensor.

*SENSOR_DEFINE_FORCEForce transducer type sensor.

*SENSOR_DEFINE_NODE Accelerometer type sensor.

*SENSOR_DEFINE_CALC-
MATH

Perform mathematical calculations on sensor values.

*SENSOR_SWITCH Compares sensor value with input value and gives a logical signal.
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Card Description

*SENSOR_SWITCH_CALC-
LOGIC

Performs mathematical calculations on the logical signal from sensor logic.

Nastran

Card Description

MONDSP1 Defines a virtual point displacement response at a user-defined reference
location (coordinates and coordinates system) as a weighted average of the
motions at a set of grid points.

MONPNT1 Defines an integrated load monitor point at a point (x,y,z) in a user defined
coordinate system.

MONPNT2 Element Monitor Output Results Item.

MONPNT3 Sums select Grid Point Forces to a user chosen monitor point.

OptiStruct Cards

Card Description

MARKER Defines a marker by associating a grid and a coordinate system.

Note:  Bulk Data Entry

PAM-CRASH Cards

Card Description

SENSO / Definition of a sensor.

Note:  Types 2 and 4 are not supported.

SENSOR/ Definition of a sensor.
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Card Description

Note:  Types 2 and 4 are not supported.

Radioss Cards

Card Description

/GAUGE Defines gauges.

Note:  Block Format Keyword

/SENSOR Defines a sensor for geometric nonlinear analysis. Sensors may be used to
activate loads (see NLOAD1).

Note:  Block Format Keyword

/SENSOR/ACCE Defines an accelerometer..

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to Acceleromter - Type 1.

/SENSOR/AND ON if sensors SID1 and SID2 are ON

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to ON as long as S1 AND S2 - Type 4.

/SENSOR/DIST Defines pressure gauge.

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to Nodal Distance - Type 2.

/SENSOR/GAUGE

/SENSOR/INTER Defines interface activation and deactivation.
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Card Description

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to Interface Act and Deact - Type 6.

/SENSOR/NOT ON if sensor SID1 is OFF.

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to On as long as S1 is OFF - Type 8.

/SENSOR/OR ON if sensors SID1 or SID2 is ON.

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to On as long as S1 OR S2 - Type 5.

/SENSOR/RBODY Activation of sensor by Rigid Body force criteria.

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to RBody - Type11.

/SENSOR/RWAL Activation/Deactivation of sensor by contact with rigid wall.

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to Rigid wall Act and Deact - Type 7.

/SENSOR/SECT Activation of sensor by Section force criteria.

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to Sect - Type12.

/SENSOR/SENS Activation with sens_ID1; Deactivation with sens_ID2.
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Card Description

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to Active S1, Deact S2 - Type 3.

/SENSOR/TIME Start time.

Note:  Block Format Keyword

Available in the /SENSOR card image, when the Sensor Type is
set to Start Time - Type 0.

Sets
Set entities define and store lists of entity IDs for entities, sets of sets, or lists of set IDs.

Sets can only be generated for certain entity types.

Sets do not have a display state in the modeling window.

Abaqus Cards
User Comment blocks are supported for all sets, and will be preserved during the import and export of
the Abaqus input deck.

Sets using the GENERATE parameter can be expanded upon import by enabling the Expand sets defined
by range option from the File Options dialog, which opens when you import a solver deck. This option
is useful when node/element IDs are renumbered during import.

Card Description

*DISTRIBUTION Define spatial distributions.

*ELSET Assign elements to an element set.

*EMBEDDED ELEMENT Specify an element or a group of elements that lie embedded in a group of
“host” elements in a model.

*NODAL THICKNESS Define shell or membrane thickness at nodes.
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Card Description

*NSET Assign nodes to a node set.

ANSYS Cards

Card Description

CMGRP Groups components and assemblies into an assembly.

Note:  This is supported as sets of sets.

EXODUS Cards

Card Description

NodeSets Provides a means to reference a group of nodes with a single ID.

Also used to specify load or boundary conditions, or to identify nodes for a
special output request.

LS-DYNA Cards
Default LS-DYNA attribute values for a set can be edited, whereas individual values cannot be edited.

Card Description

*ALE_MULTI-
MATERIAL_GROUP

Defines the appropriate ALE material groupings for interface reconstruction
when many ALE Multi-Material Groups are present in a model.

*DEFINE_HEX_SPOTWELD_ASSEMBLYAssembly of elements that describes a spotweld.

*DEFINE_HEX_SPOTWELD_ASSEMBLY_N

*SET_BEAM(TITLE) Define a set of beam elements.

*SET_BEAM_ADD Define a beam set by combining beam sets.

*SET_BEAM_GENERATE(TITLE)Generates a block of beam element IDs between a starting ID and an ending
ID.

*SET_DISCRETE(TITLE) Define a set of discrete elements.

*SET_DISCRETE_ADD Define a discrete set by combining discrete sets.
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Card Description

*SET_DISCRETE_GENERATE(TITLE)Generates a block of discrete element IDs between a starting ID and an
ending ID.

*SET_NODE_ADD Define a node set by combining node sets.

*SET_NODE_ADD_ADVANCEDDefine a node set by combining node sets or by combining NODE, SHELL,
SOLID, BEAM, SEGMENT, DISCRETE and THICK SHELL sets.

*SET_NODE_COLUMN Define a nodal set with some identical or unique attributes.

*SET_NODE_LIST(TITLE) Define a nodal set with some identical or unique attributes.

*SET_NODE_LIST_GENERATE(TITLE)Generate a block of node IDs between a starting nodal ID number and an
ending nodal ID number.

*SET_PART_ADD Define a part set by combining part sets.

*SET_PART_COLUMN(TITLE)Define a set of parts with optional attributes.

*SET_PART_LIST_GENERATE(TITLE)Generate a block of part IDs between a starting part ID number and an
ending part ID number.

*SET_SEGMENT_GENERALDefinition of contact surface from parts, elements, box.

*SET_SHELL_ADD Define a shell set by combining shell sets.

*SET_SHELL_COLUMN Define a set of shell elements with optional identical or unique attributes.

*SET_SHELL_LIST(TITLE)Define a set of shell elements with optional identical or unique attributes.

*SET_SHELL_LIST_GENERATE(TITLE)Define a set of shell elements with optional identical or unique attributes.

*SET_SOLID(TITLE) Define a set of solid elements.

*SET_SOLID_ADD Define a solid set by combining solid sets.

*SET_SOLID_GENERAL

*SET_SOLID_GENERATE(TITLE)Generate a block of solid element IDs between a starting ID and an ending
ID.

*SET_TSHELL(TITLE) Define a set of thick shell elements.

*SET_TSHELL_GENERAL
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Card Description

*SET_TSHELL_GENERATE(TITLE)Generate a block of thick shell element IDs between a starting ID and an
ending ID.

Nastran Cards
When reading input decks that were not created in HyperMesh, an attempt is made to create two sets
for each set found: one containing elements and one containing nodes. You can delete the unnecessary
set. Sets that are created are maintained as node or element sets by using the $HMSET comment
cards.

Card Description

AECOMP Defines a component for use in monitor point definition or external splines.

AECOMPL Defines a component for use in aeroelastic monitor point definition or
external splines as a union of other components.

AELIST Defines a list of aerodynamic elements or grid ID’s.

BCPROP Defines a 3D contact region by element properties.

BNDFREE1

BOLT Defines a rigid bolt by a set of MPC constraints.

BOLTLD

CSUPER Defines the grid or scalar point connections for identical or mirror image
superelements or superelements from an external source.

CSUPEXT Assigns exterior points to a superelement.

ERPPNL Defines one or more panels by referencing sets of elements or properties.

PANEL Defines one or more panels by referencing sets of grid points, elements or
properties.

ROTORG Specifies grids that compose the rotor line model.

RSPINR Specifies the relative spin rates between rotors for complex eigenvalue,
frequency response, and static analysis.

Note:  Supported in conjunction with ROTORG.

RSPINT Specifies rotor spin rates for Transient analysis.
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Card Description

Note:  Supported in conjunction with ROTORG.

SEBNDRY Defines a list of grid points in a partitioned superelement for the automatic
boundary search between a specified superelement or between all other
superelements in the model.

SEBSET1 Defines boundary degrees-of-freedom to be fixed (b-set) during generalized
dynamic reduction or component mode calculations.

SECSET1 Defines boundary degrees-of-freedom to be free (c-set) during generalized
dynamic reduction or component mode synthesis calculations.

SEQSET1 Defines the generalized degrees-of-freedom of the superelement to be used
in generalized dynamic reduction or component mode synthesis.

SESET Defines interior grid points for a superelement.

SET Defines a set of element or grid point numbers to be plotted.

Note:  Node and element sets supported with the THRU option.

SET1 Defines a list of structural grid points or element identification numbers.

SET3 Defines a list of grids, elements or points.

SEUSET1 Defines a degree-of-freedom set for a superelement.

OptiStruct Cards
OptiStruct sets are represented in HyperMesh as entity sets. The sets can be composed of grids,
elements, design variables, MBD entities, mode numbers, frequencies or times for reference by
other input definitions. In addition to the definition of entity sets through the explicit selection of the
constituents, it is possible to define a set of nodes or a set of elements through a combination of
formulaic expressions.

Sets that are created in HyperMesh are maintained on I/O by using the $HMSET comment cards.

Card Description

BORE Defines the surface, coordinate system, and parameters required to request
Bore Deformation output for Static Analysis Subcases.

Note:  Bulk Data Entry
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Card Description

ERPPNL Defines one or more sets of elements as panels for equivalent radiated
power output for a frequency response analysis of a coupled fluid-structural
model.

Note:  Bulk Data Entry

MBDCRV Defines an ordered list of grids as a Multibody Deformable Curve.

Note:  Bulk Data Entry

MBDSRF Defines a multibody deformable surface.

Note:  Bulk Data Entry

MBPCRV Defines a Multi-body Parametric Curve using node sets.

Note:  Bulk Data Entry

PANEL Defines up to four sets of grid points or elements as panels for panel
participation output for a frequency response analysis of a coupled fluid-
structural model.

Note:  Bulk Data Entry

PANELG Defines a set of grid points and/or elements as generic panel.

Note:  Bulk Data Entry

ROTORG Specifies grids that determine the Rotor Line model.

Note:  Bulk Data Entry

RSPINR Defines the relative spin rates between rotors during a rotor dynamic
analysis in Modal Complex Eigenvalue or Frequency Response solution
sequences.

Note:  Bulk Data Entry
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Card Description

SET Defines a set of grids, elements, design variables, MBD entities, mode
numbers, frequencies or times for reference by other input definitions.

Note:  Bulk Data Entry

Sets of integer and real values are supported as entity sets.

SET3 Defines a set of grids or elements.

Note:  Bulk Data Entry

PAM-CRASH Cards
During import, entity sets are automatically generated. PAM-CRASH cards with general entity selection
generate entity sets.

Card Description

GES /

GROUP / Keyword selection.

Note:  GROUP / card and general entity selection (GES) are
mapped as set of sets.

A set is created if only one keyword is used.

A set of sets will be created:

• If the definition uses more than one keyword.

• Unresolved groups are used in the definition.

• More than one GRP keyword is present in the definition.

• A GROUP definition is always implemented as a set of set.

Permas Cards

Card Description

ESET Definition of new element sets. An element set may be defined by a list of
element numbers or other element set names or using some generation
rules.
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Card Description

ESETBIN Definition of element set bins. An element set bin is defined by a list of
element set names.

NSET Definition of new node sets. A node set may be defined by a list of node
numbers or other node set names or using some generation rules.

NSETBIN Definition of node set bins. A node set bin is defined by a list of node set
names.

SFSET Definition of new surface sets. A surface set may be defined by a list of
surface numbers or other surface set names or using some generation rules.

Radioss Cards
Sets of different types but with the same ID are supported.

Card Description

/GRBEAM Defines the beam groups.

Note:  Block Format Keyword

/GRBEAM/BEAM Defines the beam number groups.

Note:  Block Format Keyword

/GRBEAM/BOX Defines the beam groups which are inside the box.

Note:  Block Format Keyword

All elements having all nodes inside the box or on its surface are
selected.

/GRBEAM/BOX2 Defines the beam groups which are inside the box.

Note:  Block Format Keyword

All elements with at least one node inside the box or on its
external surface are selected.

/GRBEAM/GRBEAM Defines the beam groups which are selected from other beam groups.

Note:  Block Format Keyword

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.430

Card Description

/GRBEAM/MAT Defines the beam material groups which belong to given materials.

Note:  Block Format Keyword

/GRBEAM/PART Defines the beam part groups which belong to given parts.

Note:  Block Format Keyword

/GRBEAM/PROP Defines the beam property groups which belong to given properties.

Note:  Block Format Keyword

/GRBEAM/SUBSET Defines the beam subset groups which belong to givens subsets.

Note:  Block Format Keyword

/GRBRIC Defines the brick groups.

Note:  Block Format Keyword

/GRBRIC/BOX Defines the brick box groups which are inside the box.

Note:  Block Format Keyword

All elements having all nodes inside the box or on its surface are
selected.

/GRBRIC/BOX2 Defines the brick box groups which are inside the box.

Note:  Block Format Keyword

All elements with at least one node inside the box or on its
external surface are selected.

/GRBRIC/BRIC Defines the brick number groups.

Note:  Block Format Keyword

/GRBRIC/GRBRIC Defines the brick groups which are selected from other brick groups.
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Card Description

Note:  Block Format Keyword

/GRBRIC/MAT Defines the brick material groups which belong to given materials.

Note:  Block Format Keyword

/GRBRIC/PART Defines the brick part groups which belong to given parts.

Note:  Block Format Keyword

/GRBRIC/PROP Defines the brick property groups which belong to given properties.

Note:  Block Format Keyword

/GRBRIC/SUBSET Defines the brick subset groups which belong to given subsets.

Note:  Block Format Keyword

/GRNOD Defines the node groups.

Note:  Block Format Keyword

/GRNOD/BOX Defines the node box groups which are inside the box.

Note:  Block Format Keyword

/GRNOD/GENE Defines the node groups.

Note:  Block Format Keyword

/GRNOD/GRBEAM Defines the node groups which are selected from beam groups.

Note:  Block Format Keyword

/GRNOD/GRBRIC Defines the node groups which are selected from brick groups.
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Card Description

Note:  Block Format Keyword

/GRNOD/GRQUAD Defines the node groups which are selected from quad groups.

Note:  Block Format Keyword

/GRNOD/GRSH3N Defines the 3 node shell groups which are selected from 3-node shell
groups.

Note:  Block Format Keyword

/GRNOD/GRSHEL Defines the 4 node shell groups which are selected from 4-node shell
groups.

Note:  Block Format Keyword

/GRNOD/GRSPRI Defines the node spring groups which are selected from spring groups.

Note:  Block Format Keyword

/GRNOD/GRTRUS Defines the node truss groups which are selected from truss groups.

Note:  Block Format Keyword

/GRNOD/MAT Defines the node material groups which belong to given materials.

Note:  Block Format Keyword

/GRNOD/NODE Defines the node groups.

Note:  Block Format Keyword

/GRNOD/NODENS Defines the unsortable node number groups.

Note:  Block Format Keyword

/GRNOD/PART Defines the node part groups which belong to given parts.
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Card Description

Note:  Block Format Keyword

/GRNOD/PROP Defines the node part groups which belong to given parts.

Note:  Block Format Keyword

/GRNOD/SUBSET Defines the node subset groups which belong to given subset.

Note:  Block Format Keyword

/GRNOD/SURF Defines the node surface groups which belong to given surfaces.

Note:  Block Format Keyword

/GRPART Defines the part groups.

Note:  Block Format Keyword

/GRQUAD Defines the quad groups.

Note:  Block Format Keyword

/GRQUAD/BOX Defines the quad groups are inside the box.

Note:  Block Format Keyword

All elements having all nodes inside the box or on its surface are
selected.

/GRQUAD/BOX2 Defines the quad groups are inside the box.

Note:  Block Format Keyword

All elements with at least one node inside the box or on its
external surface are selected.

/GRQUAD/GRQUAD Defines the quad groups which are selected from other quad groups.

Note:  Block Format Keyword
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Card Description

/GRQUAD/MAT Defines the quad material groups which belong to given materials.

Note:  Block Format Keyword

/GRQUAD/PART Defines the quad part groups which belong to given parts.

Note:  Block Format Keyword

/GRQUAD/PROP Defines the quad property groups which belong to given properties.

Note:  Block Format Keyword

/GRQUAD/QUAD Defines the quad number groups.

Note:  Block Format Keyword

/GRQUAD/SUBSET Defines the quad subset groups which belong to given subsets

Note:  Block Format Keyword

/GRSH3N Defines the 3-node shell groups.

Note:  Block Format Keyword

/GRSH3N/BOX Defines the 3-node shell groups which are inside the box.

Note:  Block Format Keyword

All elements having all nodes inside the box or on its surface are
selected.

/GRSH3N/BOX2 Defines the 3-node shell groups which are inside the box.

Note:  Block Format Keyword

All elements with at least one node inside the box or on its
external surface are selected.

/GRSH3N/GRSH3N Defines the 3-node shell groups which are selected from other 3-node shell
groups.
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Card Description

Note:  Block Format Keyword

/GRSH3N/MAT Defines the 3-node shell material groups which belong to given materials.

Note:  Block Format Keyword

/GRSH3N/PART Defines the 3-node shell part groups which belong to given parts.

Note:  Block Format Keyword

/GRSH3N/PROP Defines the 3 node shell groups which belong to given properties.

Note:  Block Format Keyword

/GRSH3N/SH3N Defines the 3-node shell groups.

Note:  Block Format Keyword

/GRSH3N/SUBSET Defines the 3-node shell subset groups which belong to given subsets.

Note:  Block Format Keyword

/GRSHEL Defines the shell groups.

Note:  Block Format Keyword

/GRSHEL/BOX Defines the shell box groups which are inside the box.

Note:  Block Format Keyword

All elements having all nodes inside the box or on its surface are
selected.

/GRSHEL/BOX2 Defines the shell box groups which are inside the box.

Note:  Block Format Keyword

All elements with at least one node inside the box or on its
external surface are selected.
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Card Description

/GRSHEL/GRSHEL Defines the shell groups which are selected from other shell groups.

Note:  Block Format Keyword

/GRSHEL/MAT Defines the shell material groups which belong to given materials.

Note:  Block Format Keyword

/GRSHEL/PART Defines the shell part groups which belong to given parts.

Note:  Block Format Keyword

/GRSHEL/PROP Defines the shell property groups which belong to given properties.

Note:  Block Format Keyword

/GRSHEL/SHEL Defines the shell number groups.

Note:  Block Format Keyword

/GRSHEL/SUBSET Defines the shell subset groups which belong to given subsets.

Note:  Block Format Keyword

/GRSPRI Defines the spring groups.

Note:  Block Format Keyword

/GRSPRI/BOX Defines the spring groups which are inside the box.

Note:  Block Format Keyword

All elements having all nodes inside the box or on its surface are
selected.

/GRSPRI/BOX2 Defines the spring groups which are inside the box.
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Card Description

Note:  Block Format Keyword

All elements with at least one node inside the box or on its
external surface are selected.

/GRSPRI/GRSPRI Defines the spring groups which are selected from other spring groups.

Note:  Block Format Keyword

/GRSPRI/PART Defines the spring part groups which belong to given parts.

Note:  Block Format Keyword

/GRSPRI/PROP Defines the spring property groups which belong to given properties.

Note:  Block Format Keyword

/GRSPRI/SPRI Defines the spring groups.

Note:  Block Format Keyword

/GRSPRI/SUBSET Defines the spring subset groups which belong to given subsets.

Note:  Block Format Keyword

/GRTRUS Defines the truss groups.

Note:  Block Format Keyword

/GRTRUS/BOX Defines the truss box groups which are inside the box.

Note:  Block Format Keyword

All elements having all nodes inside the box or on its surface are
selected.

/GRTRUS/BOX2 Defines the truss box groups which are inside the box.
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Card Description

Note:  Block Format Keyword

All elements with at least one node inside the box or on its
external surface are selected.

/GRTRUS/GRTRUS Defines the truss groups which are selected from other truss groups.

Note:  Block Format Keyword

/GRTRUS/MAT Defines the truss material groups which belong to given materials.

Note:  Block Format Keyword

/GRTRUS/PART Defines the truss part groups which belong to given parts.

Note:  Block Format Keyword

/GRTRUS/PROP Defines the truss property groups which belong to given properties.

Note:  Block Format Keyword

/GRTRUS/SUBSET Defines the truss subset groups which belong to given subsets.

Note:  Block Format Keyword

/GRTRUS/TRUS Defines the truss groups.

Note:  Block Format Keyword

/LINE Defines the line.

Note:  Block Format Keyword

/LINE/BOX Defines the lines inside the box.

Note:  Block Format Keyword

All elements having all nodes inside the box or on its surface are
selected.
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Card Description

/LINE/BOX2 Defines the lines inside the box.

Note:  Block Format Keyword

All elements with at least one node inside the box or on its
external surface are selected.

/LINE/EDGE Defines the selected edges from given surfaces as lines.

Note:  Block Format Keyword

/LINE/GRBEAM Defines the lines selected from beam groups.

Note:  Block Format Keyword

/LINE/GRTRUS Defines the lines selected from truss groups.

Note:  Block Format Keyword

/LINE/MAT Defines the lines which belong to given materials.

Note:  Block Format Keyword

/LINE/PROP Defines the lines which belong to given properties.

Note:  Block Format Keyword

/LINE/SURF Defines the lines which belong to given surfaces.

Note:  Block Format Keyword

/SURF Defines the surface definition.

Note:  Block Format Keyword

/SURF/BOX Defines the surfaces inside the box.
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Card Description

Note:  Block Format Keyword

All segments supported by solids, shells and 3-node shells with
all nodes inside the box or on its external surface are selected
(segments lying on solid elements are not considered).

/SURF/BOX/ALL Defines the surfaces inside the box (include inner segments).

Note:  Block Format Keyword

All segments supported by solids, shells and 3-node shells with
all nodes inside the box or on its external surface are selected
(segments lying on solid elements are not considered).

/SURF/BOX/EXT Defines the surfaces which are inside the box (exclude inner segments).

Note:  Block Format Keyword

All segments supported by solids, shells and 3-node shells with
all nodes inside the box or on its external surface are selected
(segments lying on solid elements are not considered).

/SURF/BOX2 Defines the surfaces inside the box.

Note:  Block Format Keyword

All segments with at least one node inside the box or on its
surface are selected.

/SURF/GRSHELL Defines the surface selected from shell groups.

Note:  Block Format Keyword

/SURF/MAT Defines the material surfaces which belong to given materials.

Note:  Block Format Keyword

/SURF/MAT/ALL Defines the material surfaces which belong to given materials.

Note:  Block Format Keyword

/SURF/MAT/EXT Defines the external material surfaces which belong to given materials.
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Card Description

Note:  Block Format Keyword

/SURF/PART Defines the parts surfaces which belong to given parts.

Note:  Block Format Keyword

/SURF/PART/ALL Defines the parts surfaces which belong to given parts.

Note:  Block Format Keyword

/SURF/PART/EXT Defines the external parts surfaces which belong to given parts.

Note:  Block Format Keyword

/SURF/PROP Defines the property surfaces which belong to given properties.

Note:  Block Format Keyword

/SURF/PROP/ALL Defines the property surfaces which belong to given properties.

Note:  Block Format Keyword

/SURF/PROP/EXT Defines the external property surfaces which belong to given properties.

Note:  Block Format Keyword

/SURF/SUBSET Defines the subset surfaces which belong to given subsets.

Note:  Block Format Keyword

/SURF/SUBSET/ALL Defines the subset surfaces which belong to given subsets.

Note:  Block Format Keyword

/SURF/SUBSET/EXT Defines the external subset surfaces which belong to given subsets.
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Card Description

Note:  Block Format Keyword

/SURF/SURF Defines the surface selected from other surfaces.

Note:  Block Format Keyword

Samcef Cards

Card Description

.SEL NOE Defines a set of grids.

.SEL MAI Defines a set of elements.

Slip Rings
Slip ring entities define sliprings.

LS-DYNA Cards

Card Description

*ELEMENT_SEATBELT_SLIPRINGDefines sliprings.

Solver Masses
Solver masses are used to model lumped mass finite element mesh.

Solver mass entities have a display state, on or off, which controls the display of these entities in the
graphics area. The display state of a Solver Mass entity can be controlled using the icon next to the
entity in the Model Browser.

Solver Mass entities also have an active and export state. The active state of a Solver Mass entity
controls its display state, its listing in the Model Browser, and any of its views. If a Solver Mass entity
is active, then its display state is available to be turned on or off and it is listed in the Model Browser
along with its views. If a Solver Mass entity is inactive, then its display state is turned off permanently
and it is not listed in the Model Browser or any of its views.
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The export state of a Solver Mass entity controls whether or not this entity is exported when the custom
export option is used. The all export option is not affected by the export state. The active and export
states of Solver Mass entities can be controlled using the Entity State Browser.

Solver Mass entities have also a Review mode which is accessible from the context menu of the entity.

Radioss Cards

Card Description

/ADMAS/0 Mass is added to each node of node group. Mass Type=0 in Solver Mass
Entity Editor.

/ADMAS/1 Mass/N is added to each node of node group. N being the total number of
nodes in the node group. Mass Type=1 in Solver Mass Entity Editor.

/ADMAS/2 Mass/Area - additional surface mass applied on the shell area. Mass Type=2
in Solver Mass Entity Editor.

/ADMAS/3 Additional mass distributed on the part-group. Mass Type=3 in Solver Mass
Entity Editor.

/ADMAS/4 Final mass distributed on the part-group. Mass Type=4 in Solver Mass Entity
Editor.

/ADMAS/5 Mass is added to each single node. Mass Type=5 in Solver Mass Entity
Editor.

/ADMAS/6 Additional mass distributed on each single part. Mass Type=6 in Solver Mass
Entity Editor.

/ADMAS/7 Final mass distributed on each single part. Mass Type=7 in Solver Mass
Entity Editor.

Note:  A special Review is available for Solver Mass entity with Mass Type=5. It displays the
mass distribution on all the nodes referenced in the Solver Mass, with a dynamic legend:
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Figure 141:

Tables
Table entities collect data points.

Abaqus Cards

Card Description

*DISTRIBUTION ANGLE Creates a *Distribution table for angles.

Note:  Can be referenced in *Orientation.

A default angle must be provided, which will be used for
elements without angle values.

*DISTRIBUTION DRAPE Creates a *Distribution table for thickness and angle.
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Card Description

Note:  Contains both the angle and thickness, but during export
separate *Distribution keywords are written.

Can be referenced by *Shell Section with composite ply
information.

A default angle and thickness must be provided, which will be
used for elements without thickness and angle values.

*DISTRIBUTION OFFSET Creates a *Distribution table for offset. The offset values define the offset
and thickness of elements.

Note:  Can be referenced by *Shell Section using the thickness
option.

A default offset must be provided, which will be used for
elements without offset values.

*DISTRIBUTION
ORIENTATION

Creates a *Distribution table for orientation. The orientation values define
the orientation of elements.

Note:  Can be referenced by *Orientaion.

A default orientation value must be provided, which will be used
for elements without orientation values.

*DISTRIBUTION
THICKNESS

Creates a *Distribution table for thickness. The thickness values define the
thickness of elements.

Note:

Can be referenced by *Shell Section using the thickness option.

A default thickness value must be provided, which will be used
for elements without thickness values.

*SPECTRUM Creates a *Spectrum table for *RESPONSE SPECTRUM ANALYSIS. This value
can be defined as a function of spectrum, frequency, and damping.
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Card Description

Note:  Can be referenced by *RESPONSE SPECTRUM.

Tags
Tag entities tag a piece of information, called the body, onto a node, element, line, surface, point, or
solid within the model.

Limitations
Tags are automatically deleted when:

• A tag is on a surface edge and the edge is split, toggled (in either direction), or surface normals are
adjusted.

• A tag is on a free line and the free line is split.

• A tag is on a surface vertex and all but one (owning parent of the vertex) of the associated
surfaces are deleted, or the vertex is toggled (in either direction).

Terminations
Termination entities provides an alternative way to stop the calculation before the termination time is
reached.

Termination entities have a display state, on or off, which controls the display of the entity in the
graphics area. The graphic representation depends on the referenced entity defined in the Termination
card. For example, *TERMINATION_BODY refers to a component. This component will be shown/hidden
when the Termination will be shown/hidden. The display state of Termination entity can be controlled
using the icon next to the entity in the Model Browser.

Termination entities also have an active and export state. The active state of a Termination entity
controls the display state of the Termination entity and the listing of the Termination entity in the
Model Browser and any of its views. The export state of a Termination entity controls whether or not
that entity is exported when the custom export option is used. The all export option is not affected by
the export state of a Termination entity. The active and export states of Terminations entities can be
controlled using the Entity State Browser.

LS-DYNA Cards

Card Description

*TERMINATION_BODY Termination based on rigid body displacements.
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Card Description

*TERMINATION_CONTACTTermination when the magnitude of the contact interface resultant force is
zero.

*TERMINATION_CURVE Termination when the load curve value returns to zero.

*TERMINATION_DELETED_SHELLSTermination when the number of deleted shells for a specified part exceeds
the defined value.

*TERMINATION_DELETED_SOLIDSTermination when the number of deleted solids for a specified part exceeds
the defined value.

*TERMINATION_NODE Termination when the position of the specified node reaches either the
maximum or minimum values defined.

*TERMINATION_SENSOR Termination when the switch condition defined in *SENSOR_SWITCH is met.

Titles
Title entities attach a title box with text to the modeling window, or to a node, element, load, or
system.

A title entity will move with the model if it is attached to a node, element, load, or system. The title
entity is static if it is attached to the modeling window.

Transformations
Transformation entities define solver transformations, and are used to define a transformation sequence
in a Position entity, to be applied on a set of nodes or on a SolverSubmodel.

Abaqus
Transformation entities hold the transformation information that is provided in the datalines of the
*NMAP keyword.

Card Description

*NMAP Maps nodes from one coordinate system to another, and rotates, translates,
or scales the nodal coordinates.
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Card Description

Note:  More than one transformation can be applied on a given
node set using additional *NMAP keywords.

A given transformation can be applied multiple times using
separate *NMAP keywords for each required instance.

The coordinates for Point A and Point B cannot be the same.

If the Magnitude is greater than 0, the nodes will be translated
in the direction of the vector AB; if the Magnitude is less than
0, the nodes will be translated in the opposite direction of the
vector AB. If the Magnitude is equal to 0, an error message will
be issued when the transformation is applied.

A positive angle results in a counter clockwise rotation; a
negative angle results in a clockwise rotation. If the Angle
is equal to 0, an error message will be issued when the
transformation is applied.

If the scale factor along the X, Y, and Z axes are uniform, then
the Uniform Scale checkbox can be selected and one Scale
size can be specified. If the scale factor is different along each
axis, then it can be entered separately by clearing the Uniform
scale checkbox.

Radioss
Transformations entities hold the Radioss keywords /TRANSFORM.

Supported Card Solver Description

//SUBMODEL Defines a part of the model with separate definition of numeration, unit
system and Radioss version.

/TRANSFORM/TRA Defines a translation for a set of nodes or a submodel.

A transformation cannot be applied on a node set and a submodel using the
same keyword.

/TRANFORM/ROT Defines a rotation for a set of nodes or a submodel.

A transformation cannot be applied on a node set and a submodel using the
same keyword.

/TRANFORM/SCA Defines scaling factors in X,Y,Z directions for a set of nodes.
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Supported Card Solver Description

/TRANSFORM/SYM Defines a symmetry on a set of nodes, normal to the plane defined by a
vector.
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Morphing Entities
Entities used for morphing the shape of FE model.

Domains
Domain entities divide the model into different domains during morphing.

Each domain contains either elements (for 1D, 2D, 3D, or general domains), a series of nodes (for edge
domains), or a group of nodes (for global domains).

The shape of a domain changes when the handles associated with a domain move, which in turn
changes the position of the nodes inside those domains.

Domains do not have an active or export state.

Domain Types
1D Domain

Group of 1D elements, such as bars and rigid elements.

2D Domain
Group of shell elements.

3D Domain
Group of solid elements.

General Domain
Group of any element type.

Edge Domain
Series of nodes that are commonly found along the edges of 2D and 3D domains.

Global Domain
Group of nodes.

Handles
Handle entities control the shape of domains during morphing.

A handle can be associated with any domain, but must be associated with one and only one domain.
When a handle associated with a 1D, 2D, 3D, general, or edge domain is moved, it moves the nodes
within that domain along with the nodes in any other domain that the handle is touching. A handle
associated with the global domain affects only the nodes in that domain. You can make large-scale
changes to your model by moving the handles on the global domain and make small-scale changes
to your model by moving the handles on local (1D, 2D, 3D, general, and edge) domains. You can also
make both large-scale and small-scale changes to your model and have their effects combined in a
logical manner.
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Handles can also be dependent on other handles, either in the global domain or in local domains.
This allows handles to control, but not restrict, the movements of other handles. A handle dependent
on another handle inherits the perturbations applied to its parent handle which are added to any
perturbations applied to the dependent handle directly. This allows you to set up a hierarchical control
system for the handles in the model, such as making three handles which control the positions of three
different holes dependent on a handle in the middle of all of them. When the middle handle is moved,
the other handles move the same way, which in turn move all of the holes. Moving any one of the
dependent handles moves only the hole it controls. You may also make a handle dependent on multiple
handles. The dependent handle will be perturbed an amount equal to the average perturbation applied
to the parent handles based on distances between them.

Global handles are red and are associated to global domains. Local handles are orange and are
associated to local domains. Both global and local handles can have dependent handles which are of
varying colors and sizes.

Handles do not have an active or export state.

Morph Constraints
Morph constraint entities restrict the movements of nodes or force compliance with dimensional
requirements during morphing.

Morph constarints do not have an active or export state.

Morph Constraint Types
Fixed

Selected nodes do not move when the mesh morphs around them.

Cluster
Nodes move with the rest of the mesh, but remain fixed relative to each other. The cluster will
move, but will also not stretch or become deformed.

Smooth
When handles move on a selected edge domain, the edge morphs according to spline-based
motion rather than linear motion, creating smooth edge curves instead of straight edge lines.
You may also choose whether to apply the spline-based motion to the nodes directly, or to
dependent handles between the morphed handles.

Along Vector
Nodes will move only in the direction of a selected vector.

Along Line
Nodes will move, but will either move along the length of a selected line or will be bounded by the
selected line.

On Plane
Nodes will move, but will either move across the surface of a selected plane, or be bounded by
the selected plane.
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On Surface
Nodes will move, but will either move across a selected surface, or be bounded by the selected
surface.

On Elements
Nodes move, but will either move along the surface of a selected mesh, or be bounded by the
selected mesh. This is similar to the along surface option but without requiring surface geometry.

On Equation
Nodes will move, but will either move across the surface of a function, or be bounded by the
surface of the function. The surface of a function is defined at the threshold where f(x,y,z) is equal
to zero.

Along dofs
Nodes will move, but can have one, two, or all three of their x, y, or z (or r, theta, or phi)
coordinates fixed for any given coordinate system, local or global.

Match Elems
Two groups of elements will be forced to match each other regardless of the morphing applied
to the nodes on either group. The matching can be forced relative to the normal direction of the
elements, relative to a vector, or by selecting nodes to orient one group of elements relative to
another.

Note:  Three or more groups of elements can be joined together by using this
constraint more than once.

Tangency
Continuous tangency can be enforced across a pair of edge or 2D domains. Also, edge domains
may have their ends constrained to defined angles, be joined in a master-slave tangency, or have
one edge "attached" to another.

Length
Used in conjunction with one or more morphing shapes, to enforce a specific, maximum, or
minimum distance as measured along the nodes in a specified node list.

Angle
Used in conjunction with one or more morphing shapes, to control the angle of three selected
nodes. These nodes will move, even relative to each other, but the angle they form remains either
fixed, above a certain value, or below a certain value depending on your choice.

Radius
Used in conjunction with one or more morphing shapes, to control the radius of a given edge
domain.
The radius is measured using an edge domain and one of the following methods for finding the
center of curvature: an axis, a line, a node, or inferred from the plane of the edge domain.
For example, if an edge domain lies along a cylinder which has been cut by a plane or planes
that are not perpendicular to the axis of the cylinder, the axis of the cylinder can be selected as
the center for the radius of the domain. The radius of the domain would then be measured with
respect to the assigned axis.
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Arc Angle
Used in conjunction with one or more morphing shapes, to control the arc angle of a given edge
domain. As for the radius option, the arc angle is measured using an edge domain and one of the
following methods for finding the center of curvature: an axis, a line, a node, or inferred from the
plane of the edge domain.

Area
Used in conjunction with one or more morphing shapes, to control the area of a number of
elements. The selected elements will deform during morphs, but their total surface area remains
either constant, above a certain value, or below a certain value, depending in your choice.

Volume
Used in conjunction with one or more morphing shapes, to control the volume of a number of
elements. The selected elements will deform during morphs, but the volume of the selected
elements remains constant, below a maximum value, or above a minimum value.

Mass
Used in conjunction with density data supplied by a property card, to control the mass of a
number of elements. The selected elements will deform during morphs, but the total mass of the
selected elements remains equal to, above, or below a specified number, even as the elements
change shape during morphing.

Morph Volumes
Morph volume entities are highly deformable six-sided prisms which surround a portion of the FE mesh,
and can be used to manipulate a mesh by manipulating the shape of the morph volume.

Morph volumes are very malleable; the length and curvature of each edge can be modified
independently of the others, and adjacent morph volumes can be linked through various tangency
conditions. This malleability allows you to enclose a given mesh with morph volumes, alter the morph
volumes to fit your model, and then change the shape of your model by modifying the morph volumes.

Morph volumes support tangency between adjoining edges and allow for multiple control points along
their edges. Handles placed at the corners and along the edges of the morph volumes allow for the
morphing of the morph volumes which in turn morphs the mesh inside the morph volumes.

Morph volumes can morphed independently of the enclosed mesh. For example, to change the shape
of your morph volumes without affecting the mesh you can set the morph volumes to be inactive.
This allows you to use all of the morphing capabilities to modify the shape and position of your morph
volumes to better fit your mesh. Then you can switch the morph volumes back to being active and use
them to morph the mesh.

Morph volumes will only morph the mesh for nodes that have been registered. In some cases, nodes
within morph volumes are automatically registered when the morph volumes are created, while in
others only the selected nodes or nodes on selected elements are registered. If the morph volumes do
not appear to be morphing nodes inside them, you may need to register those nodes.
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Morph volumes do not have an active or export state.

Shapes
Shape entities are collections of handle and/or node perturbations from the initial configuration of the
FE mesh before morphing.

When you morph your model, the morph is stored internally as a collection of perturbations which you
can then undo, redo, and/or save as a shape.

Shapes do not have an active or export state.

Symmetries
Symmetry entities define planes of symmetry within a model so that morphs can be applied in a
symmetric fashion.

Symmetries do not have an active or export state.

There are two basic symmetry groups: reflective and non-reflective. Symmetries can be combined,
but you must be careful not to create confusing symmetrical arrangements. Symmetries can also be
applied to unconnected domains. In this case, the symmetric handle linking works the same as that for
connected domains, but the influences between handles and nodes for non-reflective symmetries do not
extend across to all domains.

Reflelctive Symmetires
Reflective symmetries link handles in a symmetric fashion so that the movements of one handle will
be reflected and applied to the symmetric handles. You can also use reflective symmetries to reflect
morphs performed on domains when using the alter dimensions.

Reflective symmetries are one plane, two plane, three plane, and cyclical.

One Plane
A mirror is placed at the origin perpendicular to the selected axis (default = x-axis).

Two Plane
Two mirrors are placed at the origin perpendicular to the selected axis and the subsequent axis
(that is x and y, y and z, z and x) (default = x and y-axis).

Three Plane
Three mirrors are placed at the origin perpendicular to all three axes.

Cyclical
Two mirrors are placed along the selected axis (default = z-axis) and running through the origin
with a given angle in between that is a factor of 360. The result is a wedge that is reflected a
certain number of times about the selected axis.

Reflective symmetries can be defined as either unilateral or multilateral and either approximate or
enforced.
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Unilateral Symmetries
One side governs the other, but not vice versa.
For example, handles created and morphs applied to handles on the positive side of the symmetry
are reflected onto the other side or sides of the symmetry, but handles created or morphs applied
to handles on the other side or sides of the symmetry are not reflected.

Multilateral Symmetries
All sides govern all other sides.
For example, a handle created or a morph applied to a handle on any side is reflected to all the
other sides.

Approximate Symmetries
Contain handles that are not symmetric to other handles. This option is best for asymmetrical, but
similar, domains or for a cyclical symmetry applied to a mesh that sweeps through an arc but not
a full circle.
For example, handles created on any side of the symmetry are not reflected to the other sides.

Enforced Symmetries
Cannot contain handles that are not symmetric on all other sides.
For example, handles created or deleted on any side of the symmetry are created or deleted
on the other sides so that the symmetry is maintained. When a reflective symmetry is created
with the enforced option, additional handles may also be created to meet the enforcement
requirements.

Note:  Handles created due to the enforced symmety may not be located on any
mesh, however, they will always be assigned to the nearest domain and will affect
nodes in that domain.

Non-Reflective Symmetries
Non-reflective symmetries change the way that handles influence nodes as well as link the symmetric
handles so that the movement of one affects the others.

The handles for a domain with non-reflective symmetry will act as if they are the shape of the
symmetry type. For instance, a domain with linear symmetry causes handle movements to act on
the domain as if the handle was a line in the direction of the x-axis. A domain with circular symmetry
causes handle movements to act on the domain as if the handle was a circle centered around the z-
axis. The edges of a domain affect how influences between handles and nodes are calculated. Non-
reflective symmetries work best for domains that are shaped like the symmetry type and have a regular
mesh. For example, a circular symmetry works best for a round domain with a concentric mesh.

Non-reflective symmetries are linear, circular, planar, radial 2D, cylindrical, radial + linear, radial 3D, and
spherical.

Linear
Handle acts as a line drawn through the handle location parallel to the selected axis (default = x-
axis).

Circular
Handle acts as a circle drawn through the handle position about the selected axis (default = z-
axis).
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Planar
Handle acts as a plane drawn through the handle location perpendicular to the selected axis
(default = x-axis).

Radial 2D
Handle acts as a ray drawn through the handle position originating from and extending
perpendicular to the selected axis (default = z-axis).

Cylindrical
Handle acts as a cylinder drawn through the handle position about the selected axis (default = z-
axis).

Radial + Linear
Handle acts as a plane drawn through the handle position extending from the selected axis
(default = z-axis).

Radial 3D
Handle acts as a ray drawn through the handle position originating from origin.

Spherical
Handle acts as a sphere drawn through the handle position centered on the origin.
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Optimization Entities
Entities used to set up optimization problems.

Design Variables
Design variable entities define and store design variables for optimization problems.

Design variables do not have a display state in the modeling window.

Nastran Cards

Card Description

DESVAR Defines a design variable for design optimization.

Note:  Design variable definition.

DLINK Relates one design variable to one or more other design variables.

Note:  Design variable link.

OptiStruct Cards

Card Description

DCOMP Defines manufacturing constraints for composite sizing optimization.

Note:  Bulk Data Entry

DESVAR Defines a design variable.

Note:  Bulk Data Entry

DSHAPE Defines parameters for the generation of free-shape design variables.

Note:  Bulk Data Entry

DSHUFFLE Defines parameters for the generation of composite shuffling design
variables.
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Card Description

Note:  Bulk Data Entry

DSIZE Defines parameters for the generation of free-size design variables.

Note:  Bulk Data Entry

DTPG Defines parameters for the generation of topography design variables.

Note:  Bulk Data Entry

DTPL Defines parameters for the generation of topology design variables.

Note:  Bulk Data Entry

DVGRID Defines the relationship between a design variable and a grid point location.

Note:  Bulk Data Entry

Exported in large field format by both the optistruct and
optistructlf templates.

Radioss Cards

Card Description

DESVAR Defines an optimization design variable (max. or min.).

DSHAPE Design variable for Free-Shape optimization.

DSIZE Design variable for Free-Size optimization.

DTPG Design variable for Topography optimization.

DTPL Design variable for Topology optimization.

DVPREL1 Defined linearly, relates a design variable to an analysis model property
using the equation.
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Card Description

DVGRID Defines the relationship between design variable and grid point location.

Design Variable Links
Design variable link entities define links between design variables for optimization problems.

Design variable links do not have a display state in the modeling window.

Nastran Cards

Card Description

DLINK Relates one design variable to one or more other design variables.

DLINK2

OptiStruct Cards

Card Description

DLINK Defines a link between one design variable and one or more other design
variables.

DLINK2 Defines a link of one design variable to one or more other design variables
defined by a DEQATN card. The equation inputs come from the referenced
DESVAR values and the constants defined on the DTABLE card.

Design Variable Property Relationships
Design variable property relationship entities define relationships between design variables and
properties for optimization problems.

Design variable property relationships do not have a display state in the modeling window.

Nastran Cards

Card Description

DVCREL1 Defines the relation between a connectivity property and design variables.
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Card Description

Note:  Generic Property

DVCREL2 Defines the relation between a connectivity property and design variables
with a user-supplied equation.

DVMREL1 Defines the relation between a material property and design variables.

DVMREL2 Defines the relation between a material property and design variables with a
user-supplied equation.

DVPREL1 Defines the relation between an analysis model property and design
variables.

Note:  Generic Property

DVPREL2 Defines the relation between an analysis model property and design
variables with a user-supplied equation.

Note:  Function Property

OptiStruct Cards

Card Description

DVCREL1 Linearly relates a design variable to an analysis model element property

using the equation:

CBAR, CELAS2, CELAS4, CMASS2, CMASS4, CDAMP2, CDAMP4, CONM1, CONM2,
CONROD, CQUAD4, CTRIA3, CQUAD8, CTRIA6 elements can be selected.

Note:  Bulk Data Entry

DVCREL2 Relates design variables to an analysis model element property using a
relationship defined by a DEQATN card. The equation inputs come from the
referenced DESVAR values and constants defined on a DTABLE card.

CBAR, CELAS2, CELAS4, CMASS2, CMASS4, CDAMP2, CDAMP4, CONM1, CONM2,
CONROD, CQUAD4, CTRIA3, CQUAD8, CTRIA6 elements can be selected.
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Card Description

Note:  Bulk Data Entry

DVLREL1 Linearly relates a design variable to an analysis model element.

DVLREL2 Relates a design variable to an analysis model loading using a relationship
defined by a DEQATN card. The equation inputs come from the referenced
DESVAR values and the constants defined on the DTABLE card.

DVMREL1 Linearly relates a design variable to an analysis model material property

using the equation:

MAT1, MAT2, MAT8 and MAT9 materials can be selected.

Note:  Bulk Data Entry

DVMREL2 Relates design variables to an analysis model material property using a
relationship defined by a DEQATN card. The equation inputs come from the
referenced DESVAR values and constants defined on a DTABLE card.

MAT1, MAT2, MAT8 and MAT9 materials can be selected.

Note:  Bulk Data Entry

Requires a dequation definition.

DVPREL1 Linearly relates a design variable to an analysis model property using the

equation:

PBAR, PBARL, PBEAM, PBEAML, PBUSH, PCOMP, PCOMPG*, PCOMPP, PDAMP, PELAS,
PMASS, PROD, PSHEAR, PSHELL, PVISC properties and PLY entities can be
selected.

Note:  Bulk Data Entry

For PCOMPG, either global plies or property specific plies may be
selected.

DVPREL2 Relates a design variable to an analysis model property using a relationship
defined by a DEQATN card. The equation inputs come from the referenced
DESVAR values and the constants defined on the DTABLE card.

PBAR, PBARL, PBEAM, PBEAML, PBUSH, PCOMP, PCOMPG*, PCOMPP, PDAMP, PELAS,
PMASS, PROD, PSHEAR, PSHELL, PVISC properties and PLY entities can be
selected.
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Card Description

Note:  Bulk Data Entry

Requires a dequation definition.

For PCOMPG, either global plies or property specific plies may be
selected.

Discrete Design Variables
Discrete design variable entities define and store discrete design variables for optimization problems.

Discrete design variables do not have a display state in the modeling window.

Nastran Cards

Card Description

DDVAL Define real, discrete design variable values for discrete variable optimization.
Supported as a ddval entity.

OptiStruct Cards

Card Description

DDVAL Define real, discrete design variable values for discrete variable optimization
or to define relative rotor spin rates in rotor dynamics.
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Card Description

Note:  Bulk Data Entry

Optimization Responses
Optimization response entities define and store model responses for optimization problems.

Optimization responses do not have a display state in the modeling window.

Nastran Cards

Card Description

DRESP1 Defines a set of structural responses that is used in the design either as
constraints or as an objective.

Note:  Generic response

DRESP2 Defines equation responses that are used in the design, either as constraints
or as an objective.

Note:  Function response

OptiStruct Cards

Card Description

DRESP1 A response or a set of responses that are the result of a design analysis
iteration. These responses can be used as a design objective or as design
constraints.

Note:  Bulk Data Entry

DRESP2 When a desired response is not directly available from OptiStruct, it may be
calculated using DRESP2. This response can be a functional combination of
any set of responses resulting from the design analysis iteration. Responses
defined in this manner can be used as design objectives or constraints. The
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Card Description

DRESP2 card identifies the equation to use for the response relationship and
the input values to evaluate the response function.

Note:  Bulk Data Entry

DRESP3 When a desired response is not available from OptiStruct, either directly or
via equations, it may be calculated through external user-supplied functions
implemented in shared/dynamic libraries or external files. The DRESP3 card
identifies the external function to be called and defines the parameters to be
transferred to that function.

Note:  Bulk Data Entry

DSYSID Defines responses and their target values for a system identification
problem.

Note:  Bulk Data Entry

MODEWEIGHT Defines a multiplier for computed eigenvalues that are to be used in
the calculation of the "weighted reciprocal eigenvalue" and "combined
compliance index" optimization responses.

Note:  Subcase Information Entry

PSD STRAIN

PSD STRESS

RMS STRAIN

RMS STRESS

WEIGHT Defines a multiplier for computed eigenvalues that are to be used in
the calculation of the "weighted reciprocal eigenvalue" and "combined
compliance index" optimization responses.
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Card Description

Note:  Subcase Information Entry

Radioss Cards

Card Description

DRESSP1 Defines a response (mass, displacement, stress, velocity, and so on) or a
set of responses.

DRESP2 Design Response via Equations for Design Optimization.

Optimization Constraints
Optimization constraint entities define and store constraints on model responses for optimization
problems.

Optimization constraints do not have a display state in the modeling window.

Nastran Cards

Card Description

DCONADD Defines the design constraints for a subcase as a union of DCONSTR entries.

Note:  Collects constraints

DCONSTR Defines design constraints.

Note:  Constraint to define lower and upper bounds.

DESGLB Selects the design constraints to be applied at the global level in a design
optimization task.

Note:  Global constraint; belongs in the subcase section.

DESSUB Selects the design constraints to be used in a design optimization task for
the current subcase.
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Card Description

Note:  Constraint dependent on the load step; Belongs in the
subcase section.

OptiStruct Cards

Card Description

DCONADD Creates a combination of several DCONSTR sets that can be referenced by a
subcase.

Note:  Bulk Data Entry

DCONSTR Defines design constraint upper and lower bounds where response is defined
by DRESP1, DRESP2, and DRESP3 cards.

Note:  Bulk Data Entry

DESGLB Used before the first subcase statement, to select a constraint set that is not
subcase dependent.

Note:  I/O Options and Subcase Information Entry

DESSUB Used within a subcase definition, to select a constraint set that is subcase
dependent.

Note:  Subcase Information Entry

Radioss Cards

Card Description

DCOMP Defines manufacturing constraints for composite sizing optimization.
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Card Description

DCONSTR Defines constrains a design response by specifying its lower and upper
bounds.

Optimization Equations
Optimization equation entities define and store equations for optimization problems.

Optimization equations do not have a display state in the modeling window.

Nastran Cards

Card Description

DEQATN Defines one or more equations for use in design sensitivity or p-element
analysis.

Note:  Equations referenced on DRESP2, DVPREL2

OptiStruct Cards

Card Description

DEQATN Specifies one or more equations for use in optimization.
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Card Description

Note:  Bulk Data Entry

Radioss Cards

Card Description

DEQATN Specifies one or more equations for use in optimization.

Optimization Table Entries
Optimization table entry entities define and store table data for optimization problems.

Optimization table entires do not have a display state in the modeling window.

Nastran Cards

Card Description

DTABLE Defines a table of real constants that are used in equations.

Note:  Table entries referenced on DRESP2, DVPREL2

OptiStruct Cards

Card Description

DTABLE List of constants to be used in functions defined by DEQATN.
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Card Description

Note:  Bulk Data Entry

Objectives
Objective entities define and store an objective for an optimization problem.

Objectives do not have a display state in the modeling window.

Nastran Cards

Card Description

DESOBJ Selects the DRESP1 or DRESP2 entry to be used as the design objective.

Note:  Objective function, can be in or out of the load step;
Belongs in the subcase section.

MAXMIN Objective functions for maxmin problems.

MINMAX Objective functions for minmax problems.

OptiStruct Cards

Card Description

DESOBJ Selects a single response definition as the objective function of an
optimization, or to select system response definitions when the objective
function is the least squares sum of these definitions. The DESOBJ command
also indicates if this response is to be minimized or maximized.

Note:  Subcase Information Entry

MINMAX or MAXMIN Selects normalized response or system identification definitions as the
objective function for a "Minmax" or "Maxmin" optimization.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.470

Card Description

Note:  Subcase Information Entry

RADIOSS Cards

Card Description

DESOBJ Specifies a response as the objective function of an optimization.

Objective References
Objective reference entities define and store objective references for an optimization problem.

Objective references do not have a display state in the modeling window.

OptiStruct Cards

Card Description

DOBJREF Defines a response and its reference values for a minmax (maxmin)
optimization problem.
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Card Description

Note:  Bulk Data Entry

Optimization Constraint Screenings
Optimization constraint screening entities define and store constraint screening data for optimization
problems.

Optimization constraint screenings do not have a display state in the modeling window.

Nastran Cards

Card Description

DSCREEN Defines screening data for constraint deletion.

OptiStruct Cards

Card Description

DSCREEN Defines design response screening data.

Note:  Bulk Data Entry

SHAPEOPT Constraint screenings.
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Card Description

Note:  Bulk Data Entry

Optimization Controls
Optimization control entities define and store controls for optimization problem run.

Optimization controls do not have a display state in the modeling window.

Nastran Cards

Card Description

DOPTPRM Overrides default values of parameters used in design optimization.

OptiStruct Cards

Card Description

DOPTPRM Defines design optimization parameters by overriding the defaults.

Note:  Bulk Data Entry

If an unsupported argument is encountered on importing a
DOPTPRM card, the data is stored as UNSUPPORTED_DOPTPRM
on the DOPTPRM card.

It is also possible to create an unsupported DOPTPRM card using
the UNSUPPORTED_DOPTPRM option on the opticontrol card
image.

DOPTPRM, NESLEXPD Specifies the number of time steps retained for optimization from each
EXPDYN subcase.

Note:  Bulk Data Entry

DOPTPRM, NESLIMPD Specifies the number of time steps retained for optimization from each
IMPDYN subcase.
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Card Description

Note:  Bulk Data Entry

DOPTPRM, NESLNLGM Specifies the number of time steps retained for optimization from each
NLGEOM subcase.

Note:  Bulk Data Entry

RADIOSS Cards

Card Description

BULK Used to insert bulk format data.

BULKFMT Used to define different OptiStruct formats (FREE, LARGEFREE, FIXED, or
LARGEFIXED) during the Radioss-to-OptiStruct conversion.

BULKMAT Used to insert bulk format material card.

BULKPROP Used to insert bulk format property card.

ESLPART This keyword defines parts in the model, which will be included in ESLM
optimization.
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Control Cards
Control card entities create solver control cards such as results file I/O options, CPU and memory limits,
and others.

A solver interface template must be loaded which defines control cards in order to create and edit
control cards.

Abaqus
Control cards define model information, which needs to be specified only once in the input file.

Card Description

*CONSTRAINT CONTROLS Reset overconstraint checking controls.

*DEPVAR Specify solution-dependent state variables.

*HEADING Print a heading on the output.

*PREPRINT Select printout for the analysis input file processor.

*RESTART Save and reuse data and analysis results.

ANSYS
The input translator recognizes ANSYS cards. If an unsupported field is found in a card, a message
is displayed on the status bar. The messages are also printed to the file ansys.msg. General slash
commands, SOLUTION commands, POST1 commands, and POST26 commands are referred to as control
cards. Unrecognized cards are written to a *.hmx file.

Card Description

ACEL Specifies the linear acceleration of the structure.

ALPHAD Defines the mass matrix multiplier for damping.

ANTYPE Specifies the analysis type and restart status.

ARCLEN Activates the arc length method.

ARCTRM Controls termination of the arc-length solution

/ASSIGN Reassigns a file name to an ANSYS file identifier.

AUTOTS Specifies whether to use automatic time stepping
or load stepping.

/BATCH Sets the program mode to "batch"
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Card Description

BETAD Defines the stiffness matrix multiplier for
damping.

BFUNIF Assigns a uniform body force load to all nodes.

BUCOPT Specifies buckling analysis options

CGLOC Specifies the origin location of the acceleration
coordinate system.

CGOMGA Specifies the rotational velocity of the global
origin.

CMDOMEGA Specifies the rotational acceleration of an element
component about a user-defined rotational axis.

CMOMEGA Specifies the rotational velocity of an element
component about a user-defined rotational axis.

CNVTOL Sets convergence values for nonlinear analyses.

/COM Places a comment in the output.

/COPY Copies a file.

CRPLIM Specifies the creep criterion for automatic time
stepping.

DCGOMG Specifies the rotational acceleration of the global
origin.

/DELETE Deletes a file.

DELTIM Specifies the time step sizes to be used for this
load step.

DMPRAT Sets a constant damping ratio.

DOF Adds degrees of freedom to the current DOF set.

DOMEGA Specifies the rotational acceleration of the
structure.

EMUNIT Specifies the system of units for magnetic field
problems.

EQSLV Specifies the type of equation solver.
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Card Description

ERESX Specifies extrapoloation of integration point
results.

EORIENT Reorient SOLID elements' axes

ETABLE Fills a table of element values for further
processing.

EXPASS Specifies an expansion pass of an analysis.

HARFRQ Defines the frequency range in the harmonic
response analysis.

HREXP Specifies the phase angle for the harmonic
analysis expansion pass.

HROPT Specifies harmonic analysis options.

HROUT Specifies the harmonic analysis output options.

IRLF Specifies that inertia relief calculations are to be
performed.

KBC Specifies stepped or ramped loading within a load
step.

KUSE Specifies whether or not to reuse the
triangularized matrix.

LNSRCH Activates a line search to be used with Newton-
Raphson.

LSSOLVE Reads and solves multiple load steps.

LVSCALE Scales the load vector for mode superposition
analyses.

MDAMP Defines the damping ratios as a function of mode.

MODE Specifies the harmonic loading term for this load
step.

MODOPT Specifies modal analysis options.

MXPAND Specifies the number of modes to expand and
write for a modal or buckling analysis.

NCNV Sets the key to terminate an analysis.
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Card Description

NEQIT Specifies the maximum number of equilibrium
iterations for nonlinear analyses.

NLGEOM Includes large-deflection effects in a static or full
transient analysis.

NROPT Specifies the Newton-Raphson options in a static
or full transient analysis.

NSUBST Specifies the number of substeps to be taken this
load step.

NUMOFF

OMEGA Specifies the rotational velocity of the structure.

OUTRES Controls the solution data written to the database.

/POST1 Enters the database results post-processor.

PRED Activates a predictor in a nonlinear analysis.

PRESOL Prints the solution results for elements.

PSTRES Specifies whether prestress effects are calculated
or included.

RSYS Activates a coordinate system for printout or
display of results.

SLOAD Loads a pretension section.

/SOLU Enters the solution processor.

SOLU Specifies solution summary data per substep to be
stored.

SOLVE Starts a solution.

SSTIF Activates stress stiffness effects in a nonlinear
analysis.

/STITLE Defines subtitles.

SUBOPT Specifies options for subspace iteration eigenvalue
extraction.

/SYS Passes a command string to the operating system.
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Card Description

TIME Sets the time for a load step.

TIMINT Turns on transient effects.

TINTP Defines transient integration parameters.

/TITLE Defines a main title.

TOFFST Specifies the temperature offset from absolute
zero to zero.

TOTAL Specifies automatic MDOF generation.

TREF Defines the reference temperature for the thermal
strain calculations.

TRNOPT Specifies transient analysis options.

TUNIF Assigns a uniform temperature to all nodes.

/UNITS Annotates the database with the system of units
used.

UNSU_END

UNSU_PREP7

EXODUS

Card Description

OUTPUTS Determines which data will be written to the
output file.

PARAMETERS Input parameters that are independent of the
solution method or solver.
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Card Description

SOLUTION Solution method and options to be selected in the
solution.

LS-DYNA

Card Description

*CONTROL_ACCURACY Define control parameters that can improve the
accuracy of the calculation.

*CONTROL_ADAPSTEP Define control parameters for contact interface
force update during each adaptive cycle.

*CONTROL_ADAPTIVE Activate adaptive meshing.

*CONTROL_ADAPTIVE_CURVE To refine the element mesh along a curve.

*CONTROL_ALE Set global control parameters for the Arbitrary
Lagrange-Eulerian and Eulerian calculations.

*CONTROL_BULK_VISCOSITY Reset the default values of the bulk viscosity
coefficients globally.

*CONTROL_CHECK Check for various problems in the mesh.

*CONTROL_COARSEN Adaptively de-refine (coarsen) a shell mesh by
selectively merging four adjacent elements into
one.

*CONTROL_CONTACT Change defaults for computation with contact
surfaces.

*CONTROL_COUPLING Change defaults for MADYMO3D/CAL3D coupling.

*CONTROL_CPM Global control parameters for CPM (Corpuscular
Particle Method).

*CONTROL_CPU Control CPU time.

*CONTROL_DYNAMIC_RELAXATION Initialize stresses and deformation in a model to
simulate a preload.

*CONTROL_EFG Define controls for the mesh-free computation.

*CONTROL_ENERGY Provide controls for energy dissipation options
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Card Description

*CONTROL_EXPLOSIVE_SHADOW Compute detonation times in explosive elements
for which there is no direct line of sight.

*CONTROL_HOURGLASS Set the default values of the hourglass control to
override the default values.

*CONTROL_IMPLICIT_AUTO Define parameters for automatic time step control
during implicit analysis.

*CONTROL_IMPLICIT_BUCKLE Activate implicit buckling analysis when
termination time is reached.

*CONTROL_IMPLICIT_DYNAMICS Activate implicit dynamic analysis and define time
integration constants.

*CONTROL_IMPLICIT_EIGENVALUE Activate implicit eigenvalue analysis and define
associated input parameters.

*CONTROL_IMPLICIT_FORMING Activate implicit static analysis, primarily for metal
forming processes.

*CONTROL_IMPLICIT_GENERAL Activate implicit analysis and define associated
control parameters.

*CONTROL_IMPLICIT_INERTIA_RELIEF Allows analysis of linear static problems that have
rigid body modes.

*CONTROL_IMPLICIT_MODES Request calculation of constraint and/or
attachment modes for later use in modal analysis
using *PART_MODES.

*CONTROL_IMPLICIT_SOLUTION Optional card that applies to implicit
calculations.Used to specify whether a linear or
nonlinear solution is desired.

*CONTROL_IMPLICIT_SOLVER Optional card that applies to implicit calculations.
The linear equation solver performs the CPU-
intensive stiffness matrix inversion.

*CONTROL_IMPLICIT_STABILIZATION Optional card that applies to implicit calculations.
Artificial stabilization is required for multi-step
unloading in implicit springback analysis.

*CONTROL_IMPLICIT_TERMINATION Specify termination criteria for implicit transient
simulations.
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Card Description

*CONTROL_MPP_DECOMPOSITION_AUTOMATIC Instructs the program to apply a simple heuristic
to try to determine the proper decomposition for
the simulation.

*CONTROL_MPP_DECOMPOSITION_CHECK_SPEED Modifies the decomposition depending on the
relative speed of the processors involved.

*CONTROL_MPP_DECOMPOSITION_CONTACT_DISTRIBUTEEnsures that the indicated contact interfaces are
distributed across all processors, which can lead to
better load balance for large contact interfaces.

*CONTROL_MPP_DECOMPOSITION_CONTACT_ISOLATEEnsures that the indicated contact interferences
are isolated on a single processor, which can lead
to decreased communication.

*CONTROL_MPP_DECOMPOSITION_FILE Allow for pre-decomposition and a subsequent run
or runs without having to do the decomposition.

*CONTROL_MPP_DECOMPOSITION_METHOD Specify the decomposition method to use.

*CONTROL_MPP_DECOMPOSITION_NUMPROC Specify the number of processors for
decomposition.

*CONTROL_MPP_DECOMPOSITION_SHOW Allows display of the final decomposition.

*CONTROL_MPP_DECOMPOSITION_TRANSFORMATIONSpecifies transformations to apply to modify the
decomposition.

*CONTROL_MPP_IO_LSTC_REDUCE Controls the decomposition of the model for
solving in multiple CPU's.

*CONTROL_MPP_IO_NOD3DUMP Suppress the output of all dump files.

*CONTROL_MPP_IO_NODUMP Suppresses the output of all dump files and full
deck restart files.

*CONTROL_MPP_IO_NOFULL Suppresses the output of the full deck restart files.

*CONTROL_MPP_IO_SWAPBYTES Swap bytes on some of the output files.

*CONTROL_OUTPUT Set miscellaneous output parameters.

*CONTROL_PARALLEL Control parallel processing usage for shared
memory computers by defining the number of
processors invoking the optional consistency of the
global vector assembly.
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Card Description

*CONTROL_REMESHING Provide control over the remeshing of solids which
are meshed with the solid tetrahedron element
type 13.

*CONTROL_RIGID Special control options related to rigid bodies and
the rigid-flexible bodies.

*CONTROL_SHELL Provide controls for computing shell response.

*CONTROL_SOLID Provide controls for solid element response.

*CONTROL_SOLUTION Specify the analysis solution procedure if thermal
only or coupled thermal analysis is performed.

*CONTROL_SPH Provide controls for computing SPH particles.

*CONTROL_SPOTWELD_BEAM Provides factors for scaling the failure force
resultants of beam spot welds as a function of
their parametric location on the contact segment
and the size of the segment.

*CONTROL_STRUCTURED Write out a LS-DYNA structured input deck for
version 970.

*CONTROL_STRUCTURED_TERM Write out a LS-DYNA structured input deck for
version 970. Termination will occur after the
structured input file is written.

*CONTROL_SUBCYCLE Control time step subcycling.

*CONTROL_TERMINATION Stop the job.

*CONTROL_THERMAL_NONLINEAR Set parameters for a nonlinear thermal or coupled
structural/thermal analysis.

*CONTROL_THERMAL_SOLVER Set options for the thermal solution in a thermal
only or coupled structural-thermal analysis.

*CONTROL_THERMAL_TIMESTEP Set time step controls for the thermal solution in
a thermal only or a coupled structural/thermal
analysis.

*CONTROL_TIMESTEP Set structural time step size control using different
options.

*DAMPING_FREQUENCY_RANGE Provides approximately constant damping over a
range of frequencies.
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Card Description

*DAMPING_GLOBAL Define mass weighted nodal damping that applies
globally to the nodes of deformable bodies and to
the mass center of rigid bodies.

*DATABASE_ABSTAT Specify time interval and file type for Airbag
statistics time history file output.

*DATABASE_AVSFLT Specify time interval for AVS database output.

*DATABASE_BINARY_D3PART Dt for partial output states.

*DATABASE_BINARY_D3PLOT Dt for complete output states.

*DATABASE_BINARY_D3DRLF Dynamic relaxation database.

*DATABASE_BINARY_D3THDT Dt for time history data of element subsets.

*DATABASE_BINARY_D3DUMP Binary output restart files. Define output
frequency in cycles.

*DATABASE_BINARY_FSIFOR ALE interface force database

*DATABASE_BINARY_INTFOR Dt for output of contact interface data.

*DATABASE_BINARY_RUNRSF Binary output restart file. Define output frequency
in cycles.

*DATABASE_BINARY_XTFILE Flag to specify output of extra time history data to
XTFILE at same time as D3THDT file.

*DATABASE_BNDOUT Specify time interval and file type for Boundary
condition forces and energy time history file
output.

*DATABASE_DEFGEO Specify time interval deformed geometry file
output.

*DATABASE_DEFORC Specify time interval and file type for discrete
element forces time history file output.

*DATABASE_ELOUT Specify time interval and file type for element data
time history file output.

*DATABASE_EXTENT_AVS Specify output database to be written.

*DATABASE_EXTENT_BINARY Specify output database to be written.

*DATABASE_EXTENT_D3PART Controls, to some extent, the content of specific
output databases.
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Card Description

*DATABASE_EXTENT_MOVIE Specify output database to be written.

*DATABASE_EXTENT_MPGS

*DATABASE_EXTENT_SSSTAT

*DATABASE_FORMAT

*DATABASE_GCEOUT Specify time interval and file type for Geometric
contact entities force time history file output

*DATABASE_GLSTAT Specify time interval and file type for global model
data time history file output.

*DATABASE_JNTFORC Specify time interval and file type for joint force
time history file output

*DATABASE_MASSOUT Export nodal masses into ASCII file MASSOUT.

*DATABASE_MATSUM Specify time interval and file type for material
energies time history file output

*DATABASE_MOVIE Specify time interval for movie output

*DATABASE_MPGS Specify time interval for MPGS

*DATABASE_NCFORC Specify time interval and file type for nodal
interface forces time history file output

*DATABASE_NODFOR Specify time interval and file type for nodal force
groups time history file output

*DATABASE_NODOUT Specify time interval and file type for nodal point
data time history file output

*DATABASE_OPTION Control cards for all ASCII output

*DATABASE_RBDOUT Specify time interval and file type for rigid body
data time history file output.

*DATABASE_RCFORC Specify time interval and file type for resultant
interface forces time history file output.

*DATABASE_RWFORC Specify time interval and file type for rigid wall
forces time history file output.

*DATABASE_SBTOUT Specify time interval and file type for Seat belt
time history file output.
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Card Description

*DATABASE_SECFORC Specify time interval and file type for cross section
forces time history file output

*DATABASE_SLEOUT Specify time interval and file type for sliding
interface energy time history file output

*DATABASE_SPCFORC Specify time interval and file type for SPC reaction
forces time history file output

*DATABASE_SPHOUT Specify time interval and file type for SPH element
data time history file output

*DATABASE_SPRING_FORWARD Create spring forward nodal force file.

*DATABASE_SSSTAT Specify time interval and file type for Subsystem
data time history file output

*DATABASE_SUPERPLASTIC_FORMING Specify the output intervals to the superelastic
forming output files.

*DATABASE_SWFORC Specify time interval and file type for nodal
constraint reaction forces time history file output

*DATABASE_TPRINT Specify time interval and file type for thermal time
history file output.

Thermal output from a coupled structural/thermal
or thermal only analysis.

*DATABASE_TRACER Tracer particles will save a history of either a
material point or a spatial point into an ASCII file,
TRHIST.

*DATABASE_TRHIST Tracer particle history information

*INTERFACE_COMPENSATION_NEW Calculate the deviation of the part from its
intended design of the stamped part and
automatically compensate the tool to minimize
the deviation, modify the trimming curve after
the die modification, and automatically detect the
undercut problem

*STRESS_INITIALIZATION Allows all or selected parts to be initialized on
restart, using data from the d3dump or runrsf
database.

*STRESS_INITIALIZATION_DISCRETE Initializes all discrete parts from the old parts.
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Card Description

*STRESS_INITIALIZATION_SEATBELT Initializes all seatbelt parts from the old parts.

Nastran

Card Description

ACMODL Defines modeling parameters for the interface
between the fluid and the structure.

AERO Gives basic aerodynamic parameters for unsteady
aerodynamics.

AEROS Defines basic parameters for static aeroelasticity.

AUTOSPC Constrains stiffness singularities via m-sets or s-
sets.

B2GG Selects direct input damping matrix or matrices.

B2PP Selects direct input damping matrix or matrices.

BEGIN BULK Designates the end of the Case Control Section
and/or the beginning of a Bulk Data Section.

Note:  When the model is created
from HyperMesh, this card is on by
default.

BULK-UNSUPPORTED_CARD
Note:  On import, all unsupported
bulk data will be written into this card.
You can edit the card.

CASE-UNSUPPORTED_CARD
Note:  If CEND and SUBCASE exist,
on import, all unsupported cards
between CEND and the first SUBCASE
will be written into this card. You
can edit the card. If SUBCASE does
not exist and BEGIN BULK exists, all
unsupported cards between CEND and
BEGIN BULK will be written into this
card.
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Card Description

CEND
Note:  When the model is created
from HyperMesh, this card is on by
default.

DIAG Requests diagnostic output or special options.

ECHO Bulk Data Echo Request

ENDDATA Designates the end of the Bulk Data Section.

Note:  When the model is created
from HyperMesh, this card is on by
default.

EXEC_UNSUPPORTED_CARDS
Note:  If CEND exists in the imported
deck, on import, all unsupported
cards before CEND will be written into
this card. You can edit the card. If
CEND does not exist, on import, all
unsupported cards before BEGIN BULK
will be written into this card.

ERP Equivalent Radiated Power Panel Participation
Factor Output Request

FLSPOUT Control for fluid-structure mode participation
output.

FLUX Request gradient and flux output for all heat
transfer analysis subcases or individual heat
transfer analysis subcases respectively.

GLOBAL

GLOBAL CASE CONTROL

GLOBAL OUTPUT REQUEST

GRDSET Defines default options for fields 3, 7, 8, and 9 of
all GRID entries

IC
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Card Description

ID Specifies a comment.

INCLUDE_BULK Inserts an external file into the input file

INCLUDE_CTRL Inserts an external file into the input file

INCLUDE_EXEC Inserts an external file into the input file

K2GG

K2PP Selects direct input stiffness matrices, which are
not included in normal modes

M2GG Selects direct input mass matrix or matrices.

MAXLINES Sets the maximum number of output lines.

Note:  The maximum number of lines
is 999999999 (Nastran default).

MONITOR_POINTS Defines an integrated load monitor point.

NLMOPTS Specifies nonlinear material optional schemes in
SOL 400. Extends to material options, property
options including property mapping, boundary
condition options.

OMIT_BEGIN_BULK
Note:  By selecting this control card,
you are forcing HyperMesh to not
write BEGIN BULK CARD.

OMIT_CEND
Note:  By selecting this control card,
you are forcing HyperMesh to not
write the CEND card.

OMIT_END_BULK
Note:  By selecting this card, you are
forcing HyperMesh to not write the
END_BULK card.

P2G Selects direct input load matrices.

PARAM Specifies values for parameters.
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Card Description

Note:  On import, all unsupported
PARAM cards are written into the
UNSUPPORTED PARAMS block within
PARAM CARD in the Control Cards
panel. You can edit this data block.

PRESSURE Pressure output request

RADSET Specifies which radiation cavities are to be
included for radiation enclosure analysis.

RESTART Requests that data stored in a previous run be
used in the current run.

RESVEC Controls residual vectors

RIGID Rigid Element Method

SET CARD Defines a set of element or grid point numbers to
be plotted.

Note:  Only real number sets can be
created using control cards.

SOL Specifies the solution sequence or main subDMAP
to be executed.

SUBTITLE Defines a subtitle that will appear on the second
heading line of each page of printer output.

SWLDPRM Overrides default values of parameters for CFAST,
CWELD, and CSEAM connectivity search.

TIME Sets the maximum CPU and I/O time.

TITLE Defines a character string that will appear on
the first heading line of each page of NX Nastran
printer output.
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Card Description

TSTEPNL Defines parameters for geometric nonlinear
implicit dynamic analysis strategy.

OptiStruct
I/O Option Entries are supported as control cards when appearing before the first SUBCASE statement.
In many cases, information supplied on these entries is overridden by repeated definitions within
subcases.

Card Description

ACCELERATION Requests acceleration vector output for all
subcases or individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

ACMODL Defines model parameters for the fluid-structure
interface.

Note:  Bulk Data Entry

ANALYSIS Used in the I/O Options section to request that
only a finite element analysis be performed
(optimization input is ignored). It may also be
used in the I/O Options or Subcase Information
sections to identify the solution sequence for all
subcases or for individual subcases, respectively.

Note:  Subcase Information Entry

Supported as an output option on the
subcase definition when it appears
within a subcase.

ASSIGN Used in the I/O Options section to identify external
files and their contents.
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Card Description

Note:  I/O Options and Subcase
Information Entry

Supported as an output option on the
subcase definition when it appears
within a subcase.

AUTOSPC Used to automatically constrain stiffness
singularities and near singularities with single
point constraints.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_CASE_CONTROL.

B2GG Selects a direct input viscous damping matrix.

Note:  Subcase Information Entry

Global matrix selectors.

BULK_UNSUPPORTED_CARDS
Note:  If a line (not a continuation
line) occurs after the BEGIN BULK
statement in an input file and
starts with a keyword that is not
recognized or supported, then
the entire card gets written to
BULK_UNSUPPORTED_CARDS.

It is also possible to manually define
an unsupported OptiStruct card using
the BULK_UNSUPPORTED_CARDS.

BULK_UNSUPPORTED_CARDS are
exported near the bottom of the
exported OptiStruct input file, just
before the ENDDATA statement.

CFAILURE Requests failure index output for elements
referencing PCOMP, PCOMPP or PCOMPG properties
for all subcases or individual subcases,
respectively.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.492

Card Description

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

CFAILURE is supported for static
analysis only.

CHECK Requests that only a model check be performed.

Note:  I/O Options and Subcase
Information Entry

CMDE Used above the first SUBCASE or within a SUBCASE
definition to request component modal synthesis
damping energy output for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

CMKE Used above the first SUBCASE or within a SUBCASE
definition to request component modal synthesis
kinetic energy output for all subcases or individual
subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

CMSE Used above the first SUBCASE or within a SUBCASE
definition to request component modal synthesis
strain energy output for all subcases or individual
subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.
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Card Description

CONTF Requests contact results output for all Nonlinear
Analysis subcases or individual nonlinear analysis
subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

CONTPRM Defines the default properties of all contacts
and sets parameters that affect all contacts. The
default values set here can be overridden by
values explicitly specified on PCONT, PCONTX, and
CONTACT cards.

Note:  Bulk Data Entry

CSTRAIN Requests ply strain output for elements
referencing PCOMP, PCOMPP or PCOMPG properties
for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

CSTRESS Requests ply stress output for elements
referencing PCOMP, PCOMPP or PCOMPG properties
for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.
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Card Description

CTRL_UNSUPPORTED_CARDS
Note:  If a line (not a continuation
line) occurs before the BEGIN
BULK statement and before the
first SUBCASE statement and
starts with a keyword that is not
recognized or supported, then
the entire card gets written to
CTRL_UNSUPPORTED_CARDS.

It is also possible to manually define
data cards appearing above the
first SUBCASE statement using the
CTRL_UNSUPPORTED_CARDS.

CTRL_UNSUPPORTED_CARDS are
exported near the top of the exported
OptiStruct input file, just before the
first SUBCASE statement.

DAMAGE Requests fatigue damage results output for all
fatigue subcases or individual fatigue subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

DEBUG Supports internal issues for debugging purposes in
HyperMesh.

Note:  I/O Options and Subcase
Information Entry

Some special or custom features
can be accessed through the use of
'debug, <string>, <real>' statements.

DENSITY Requests density output for a topology
optimization.

Note:  I/O Options and Subcase
Information Entry
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Card Description

DENSRES Controls the frequency of output of design results
(density, shape, or thickness).

Note:  I/O Options Entry

DESHIS Controls the creation of the optimization history
file .hgdata.

Note:  I/O Options and Subcase
Information Entry

DESVARG Defines an override for design variable settings.

Note:  Bulk Data Entry

DGLOBAL Defines input parameters required for the Global
Search Option (GSO).

Note:  Bulk Data Entry

DISPLACEMENT Requests displacement vector output for all
subcases or individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

DMIGNAME Defines the name given to the reduced matrices
written to an external data file.

Note:  I/O Options and Subcase
Information Entry

DSA Requests Design Sensitivity Analysis results in a
Frequency Response Analysis.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.
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DTI_UNITS Defines units for multibody, component mode
synthesis (flexible-body preparation), and
geometric nonlinear solution sequences.

Note:  Bulk Data Entry

ECHO Outputs the interpreted forms of Subcase
Information and Bulk Data Entries to the .out file.

Note:  I/O Options and Subcase
Information Entry

EDE Requests element energy loss per cycle and
element energy loss per cycle density output for
all subcases or individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

EIGVNAME Defines the prefix to be used for external
eigenvalue data files (.eigv).

Note:  I/O Options and Subcase
Information Entry

EKE Requests kinetic energy and kinetic energy density
output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

ELFORCE Requests structural element force output and
elemental fluid particle velocity output for all
subcases or individual subcases, respectively.
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Card Description

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

ENERGY Requests energy output for all geometric nonlinear
analysis subcases or individual geometric
nonlinear analysis subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

ERP Requests equivalent radiated power output for all
subcases or individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

ESE Requests strain energy and strain energy density
output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.
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Card Description

FLUX Requests temperature gradient and flux output for
all steady-state heat transfer analysis subcases,
transient heat transfer analysis subcases or
individual heat transfer analysis subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

FORMAT Indicates the format in which results are to be
output.

Note:  I/O Options Entry

Formats are: H3D (default), HM, FLX,
OPTI, OUTPUT2, PUNCH, PATRAN,
APATRAN, NONE.

FOS Requests fatigue factor of safety, hydrostatic
pressure, and shear stress output for all fatigue
subcases or individual fatigue subcases.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

GAPPRM Defines parameters that control connectivity and
configuration checks for gap elements (CGAP and
CGAPG). Most of these parameters also affect
contact elements that are automatically created
on CONTACT interfaces.

Note:  Bulk Data Entry

GLOBAL_CASE_CONTROL Handles the data selectors FREQ, METHOD, MPC,
SDAMPING and SPC appearing above the first
SUBCASE statement.
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Card Description

It also handles the data selector DESVAR, used
to select a set of design variables for use in an
optimization run.

It also handles the output control OMODES, used to
define a set of modes for output requests.

Note:  This control card OMODES is
also supported as an output option on
the subcase definition when it appears
within a subcase.

GPFORCE Requests grid point force balance output for all
subcases or individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

GPSTRAIN Requests grid point strain output for all or
individual subcases.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST

GPSTRESS Requests grid point stresses output for all
subcases or individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

GRDSET Defines default options for fields 3, 7, and 8 of all
GRID entries.
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Card Description

Note:  Bulk Data Entry

HISOUT Controls the amount of data printed to the
.hgdata file.

Note:  I/O Options and Subcase
Information Entry

INCLUDE_BULK
Note:  This control card is retained to
support old database files.

INCLUDE_CTRL
Note:  This control card is retained to
support old database files.

INFILE Identifies the file containing the Bulk Data Entries.

Note:  I/O Options Entry

Its extension must be .fem.

K2GG Selects a direct input stiffness matrix.

Note:  Subcase Information Entry

Global matrix selectors

K2PP Selects a direct input stiffness matrix, which is not
included in normal modes.

Note:  Subcase Information Entry

Global matrix selectors

K42GG Selects a direct input stiffness matrix.

Note:  Subcase Information Entry

Global matrix selectors
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LIFE Requests output of fatigue life results for all
fatigue subcases or individual fatigue subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

LOADLIB Defines the external libraries and external files to
be loaded into OptiStruct. External functions can
be implemented within dynamic libraries (.dll)
under Windows, shared libraries (.so) under
Linux, by using HyperMath (.hml) on Windows
and Linux, and external files by using Microsoft
Excel (.xls or .xlsx) on Windows.

Note:  I/O Options and Subcase
Information Entry

M2GG Selects a direct input mass matrix.

Note:  Subcase Information Entry

Global matrix selectors

MBFORCE Requests force output for a set of joints and/
or force elements from multibody dynamics
subcases.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

MODALDE Used above the first SUBCASE or within a
SUBCASE definition to request modal damping
energy (the energy loss per cycle) output for all
subcases or individual subcases, respectively. Note
that this modal damping energy only includes
the energy contribution from viscous dampers.
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Structural damping and modal damping are not
included.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

MODALKE Used above the first SUBCASE or within a SUBCASE
definition to request modal kinetic energy
output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

MODALSE Used above the first SUBCASE or within a SUBCASE
definition to request modal strain energy
output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

MODEL Requests output of only a subset of the model and
related results for H3D and OUTPUT results files as
well as for CMS superelements.

Note:  I/O Options and Subcase
Information Entry

This option is intended for multi-
body dynamics and transient solution
sequences with which users often
require results for only a subsection
of a model, but it is applied to all
solution sequences.
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Card Description

Model Documentation
Note:  $HMBEGINDOC and
$HMENDDOC indicate a section of
comment cards which are supported
on import and export. The comments
are stored on control card Model
Documentation.

This information is exported at the top
of the exported OptiStruct input file.

MPCFORCE Requests multi-point force of constraint vector
is output for all subcases or individual subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

MSGLMT Limits the number of ERROR, WARNING and
INFORMATION messages output, or to elevate
a WARNING or INFORMATION message to an
ERROR.

Note:  I/O Options and Subcase
Information Entry

NLLOAD Used to request nonlinear load output for
Transient Response Analysis for each time step for
all subcases or individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

OFREQUENCY Requests a set of frequencies for output
requests for all subcases or individual subcases,
respectively.
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Card Description

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

OLOAD Requests the form of applied load vector output
and temperature load output for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

OSDIAG
Note:  Some special diagnostic
information can be processed through
the use of 'osdiag, <integer>,
<integer>, <real>, <real>'
statements.

OTIME Requests a set of times for output requests for
Transient Analysis for all subcases or individual
subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

OUTFILE Defines the prefix for the results files output.

Note:  I/O Options and Subcase
Information Entry

OUTPUT Controls the format of results output and the
creation of certain results files.
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Card Description

Note:  I/O Options Entry

P2G Used before the first subcase to select a direct
input load matrix.

Note:  Subcase Information Entry

Global matrix selectors

PARAM Defines values for parameters used during
analysis and optimization.

Note:  Bulk Data Entry

If an unsupported argument
is encountered on importing a
PARAM card, the data is stored as
UNSUPPORTED_PARAMS on the
PARAM card. It is also possible to
create an unsupported PARAM card
using the UNSUPPORTED_PARAMS
option.

PEAKOUT Defines criteria used for the automatic
identification of loading frequencies at which result
peaks occur. Other result output may then be
requested at these "peak" loading frequencies.
This feature is only supported for frequency
response solution sequences.

Note:  Bulk Data Entry

PFGRID Requests output of acoustic grid participation
factors for all Modal Frequency Response
subcases. The output will be in the .h3d file.

Note:  I/O Options and Subcase
Information Entry

PFMODE Requests output of modal participation factors for
all modal frequency response subcases.
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Card Description

Note:  I/O Options and Subcase
Information Entry

PFPANEL Requests output of acoustic panel participation
factors for all Modal Frequency Response
subcases.

Note:  I/O Options and Subcase
Information Entry

POWERFLOW Requests output of the power flow field.

Note:  I/O Options Entry

Found under
GLOBAL_OUPUT_REQUEST.

PRESSURE Requests the output of pressure results.
Analogous to the DISPLACEMENT command.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

PRETBOLT Requests output of pretension force/adjustment
values in the pretension bolts for all pretensioning
and pretensioned subcases.

Note:  I/O Options and Subcase
Information Entry

Found under
GLOBAL_OUPUT_REQUEST.

PROPERTY Requests the output of the property definitions
used in the final iteration of an optimization.
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Note:  I/O Options and Subcase
Information Entry

REQUEST Selects a multibody request definition to be used
in a multibody problem.

Note:  I/O Options and Subcase
Information Entry

RESPRINT Rorces all unretained responses of a certain type
to be printed to the output file, provided they are
referenced either as an objective or a constraint.
This also applies to manufacturing constraints for
composites.

Note:  I/O Options and Subcase
Information Entry

RESTART Indicates that the current optimization is to be
restarted from the final iteration of a previous
optimization.

Note:  I/O Options and Subcase
Information Entry

RESULTS Determines the frequency of output of analysis
results for all subcases or for individual subcases,
respectively.

Note:  I/O Options Entry

SACCELERATION Requests the form and type of modal participation
accelerations output for all subcases or individual
subcases, respectively.
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Card Description

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.
Supported as an output option on the
subcase definition when it appears
within a subcase.

SCREEN Controls the output of model, analysis, and
optimization information to the UNIX or DOS shell.

Note:  I/O Options and Subcase
Information Entry

SDISPLACEMENT Requests the form and type of modal participation
displacements output for all subcases or individual
subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.
Supported as an output option on the
subcase definition when it appears
within a subcase.

SENSITIVITY Requests the output of the responses and
sensitivities for size and shape design variables to
a Microsoft Excel spreadsheet.

Note:  I/O Options and Subcase
Information Entry

SENSOUT Controls the frequency of output of responses and
sensitivities for size and shape design variables to
a Microsoft Excel spreadsheet.

Note:  I/O Options and Subcase
Information Entry

SHAPE Requests altered shape output for a shape
optimization.
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Card Description

Note:  I/O Options and Subcase
Information Entry

SHRES Controls the frequency of output of the state files
(.#.sh file and the .#.grid file).

Note:  I/O Options Entry

SINTENS Used in the I/O Options section to request Sound
Intensity output for all frequency response
subcases. The SINTENS command can be used in
the I/O Options or Subcase Information sections
to request Sound Intensity output for all subcases
or individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

SPCFORCE Requests single-point force of constraint vector
output for all subcases or individual subcases,
respectively.

Note:  SPCFORCE

I/O Options and Subcase Information
Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

SPL Requests Sound Pressure output for all subcases
or individual subcases, respectively. SPL can only
be requested for frequency response subcases.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.
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SPOWER Requests Sound Power output for all subcases or
individual subcases, respectively. SPOWER can only
be requested for frequency response subcases.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

STRAIN Requests strain output for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

STRESS Requests stress output for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

SUBTITLE Defines the subtitle for all subcases or for
individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Individual subcases may have their
own SUBTITLE definitions which are
supported on the subcase definition.
These will override the default subtitle.

SVELOCITY Requests the form and type of modal participation
velocities output for all subcases or individual
subcases, respectively.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.511

Card Description

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

SWLDPRM Defines values of parameters used during the
CWELD and CSEAM connectivity search.

Note:  Bulk Data Entry

SYSSETTING Alters system settings. Any setting defined here
may be over-ridden by command line arguments
(Run Options). Most of these options can also be
specified in one of the config files (Configuration
File).

Note:  I/O Options Entry

THERMAL Requests temperature output for all heat transfer
analysis subcases or individual heat transfer
analysis subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

THICKNESS Requests thickness output for elements
referencing a PSHELL, PCOMP or PCOMPP properties
in size/free-size optimization and analysis runs.

Note:  I/O Options and Subcase
Information Entry

THIN Requests thinning and thickness output for
all geometric nonlinear analysis subcases or
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individual geometric nonlinear analysis subcases,
respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

TITLE Defines the title for the OptiStruct job.

Note:  I/O Options and Subcase
Information Entry

TMPDIR Chooses the directory in which the scratch files
are to be written.

Note:  I/O Options and Subcase
Information Entry

OptiStruct allows multiple TMPDIR
entries, but only one instance is
currently supported.

UNITS Defines a system of units for the model.

Note:  I/O Options and Subcase
Information Entry

VELOCITY Requests velocity vector output for all subcases or
individual subcases, respectively.

Note:  I/O Options and Subcase
Information Entry

Found under GLOBAL_OUPUT_REQUEST.

Supported as an output option on the
subcase definition when it appears
within a subcase.

XSHLPRM Defines default shell element parameters for
geometric nonlinear analysis.

Note:  Bulk Data Entry
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XSOLPRM Defines default SOLID properties for geometric
nonlinear analysis.

Note:  Bulk Data Entry

PAM-CRASH 2G

Card Description

AIRBAGCHECK Airbag check option (Prime Control keywords)

AIRBAGCHECK is executed by default to check the airbag’s closed volume.

ANALYSIS Analysis definition (Prime Control keywords)

If AUTOSLEEP is not present inside the input file or AUTOSLEEP is not set to
YES, the solver stops if the license tokens are not available at the beginning
of the computation.

AUTOSLEEP Autosleep option (Prime Control keywords)

CCTRL / Contact Control Cards (Standard Control keywords)

CKCTRL/ Check Control Cards (Standard Control keywords)

COUPLING Coupling (Optional Control keywords)

DATACHECK Data Check option (Prime Control keywords)

DCOMP DMP Domain Decomposition Method option (Prime Control keywords)

DEBUG Debug option (Prime Control keywords)

DRAPP Draping Database Path Name Definition (Standard Control keywords)

DRAPF / Import Composite Layer Draping File Definition (Standard Control keywords)

ECTRL / Element Control Cards (Standard Control keywords)

EIGEN / Eigenmode Extraction and Damping Matrix Generation Analyses (Standard
Control keywords)

EOCTRL/ ERF Control Cards (Standard Control keywords)

ENDDATA End of Data option (General Model setup)
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Note:  Cards after the ENDDATA card are ignored. This card
is not created during FE input process, but it will be exported
automatically.

FILE File Root Name option (Prime Control keywords)

FPCTRL/ FPM Control Definition (Standard Control keywords)

HEAT / Heat Analysis Control (Standard Control keywords)

ICTRL / Implicit General Control Cards Definition (Standard Control keywords)

INPUTVERSION Input Version Definition (Prime Control keywords)

MAXMEMORY Maximum Memory Check option (Prime Control keywords)

MERGEGAP Common Node Merge option (Prime Control keywords)

METRIC/ Metric Input Definition (Standard Control keywords)

METRICCHECK Metric Check option (Prime Control keywords)

MSTRM / Mass Trimming Definition (Standard Control keywords)

OCTRL / Output Parameters Control Cards (Standard Control keywords)

ORTHF / Import Element Orientation Definition (Standard Control keywords)

ORTHP Element Orientation File Path Name Definition (Standard Control keywords)

PFLOW / Porous Flow Analysis Definition (Standard Control keywords)

PIPE Process Independent Parallel Execution (PIPE) option (Optional Control
keywords)

PRCTRL/ Print Control Definition (Standard Control keywords)

PROFILE_DMP DMP Profile Guided Domain Decomposition option (Prime Control keywords)

LCTRL / Load Control Definition (Standard Control keywords)

MCTRL / Metric Control Definition (Standard Control keywords)

RESTARTFILES Cyclic Restart File option (Prime Control keywords)

RUNEND/ End of Run Definition (Standard Control keywords)

SHELLCHECK Shell Element Data Check option (Prime Control keywords)
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SIGNAL Job Signal option (Prime Control keywords)

SOLIDCHECK Solid Element Data Check option (Prime Control keywords)

SOLVER Solver Selection option (Prime Control keywords)

SPCTRL/ Smoothed Particle Hydrodynamics (SPH) Control Cards (Standard Control
keywords)

STOPRUN Stop Run option (Prime Control keywords)

SUBRUN Substructure Run option (Prime Control keywords)

TCTRL / Time Step Definition (Standard Control keywords)

TITLE / Title Card or Header on Output Listing Card (Standard Control keywords)

UNIT Unit System Definition (Prime Control keywords)

SECURE_NODE_VISU Secured Nodes Visualization option (PAMCOMFORT) (Optional Control
keywords)

$HMUNSUPPORTED
CARDS

Unsupported cards

Note:  All unsupported information found in the input deck is
imported in this card. You can edit this card.

$HMBEGINDOC

$HMENDDOC

Imported model documentation

Note:  The input deck can contain model documentation text
that is imported and exported via the comment lines. For decks
not written by HyperMesh, all comment lines before the first
non-comment line are treated as model documentation. For
decks written by HyperMesh, the documentation lines must be
placed in a block that begins with the line $HMBEGINDOC and
ends with the line $HMENDDOC. This card is always overwritten
by the current model documentation.

$HMBEGINDOC

$HMENDDOC

Model documentation
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Note:  This card is not created during FE input process. You can
create this card, but once this card is defined, only this will be
exported. You can access macros from the PAM-CRASH solver
interface to append or overwrite the information from Imported
Model Documentation to this card.

Permas

Card Description

$COMPONENT Component input bracket header line.

$ECHO Controls the echo print of Permas data input lines.

$MODDAMP Definition of viscous or structural modal damping.

Note:  This option is available in the
SYSTEM card as a separate checkbox.

$SYSTEM Opens the bracket for input of system data.

Radioss

Card Description

/@TFILE The time at which the time history file begins.

Note:  Engine Keyword

/@TFILE/Keyword2 The time at which the time history file begins.

Note:  Engine Keyword

/ABF Describes the output of .abf files. (.abf [binary]
files are optimized for fast plotting of very large
data sets and is intended for creating 2D and 3D
plots using HyperGraph and HyperGraph 3D).
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Note:  Engine Keyword

/ADMESH/GLOBAL Defines the global parameters for adaptive
meshing. This keyword is not available for SPMD
computation.

Note:  Block Format Keyword

/ALE Sets parameters for DONEA grid velocity
formulation of ALE.

Note:  Engine Keyword

/ALE/2 Sets parameters for Radioss grid velocity
formulation for ALE.

Note:  Engine Keyword

/ALE/3 When this keyword is used instead of /ALE or /
ALE/2, no grid calculation is performed. Grid does
not move, unless constrained otherwise.

Note:  Engine Keyword

/ALE/4 Sets the Radioss standard formulation.

Note:  Engine Keyword

/ALE/GRID/DISP The displacement of a grid node depends on the
displacements of the neighboring grid nodes.

Note:  Block Format Keyword

/ALE/GRID/DONEA Velocity of a given grid node depends on velocity
and displacements of neighboring grid nodes.

Note:  Block Format Keyword
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/ALE/GRID/SPRING Grid nodes are connected with nonlinear springs
(those springs have no effect on the material, only
on the movement of the grid).

Note:  Block Format Keyword

/ALE/GRID/STANDARD Describes the standard formulation for ALE grid
velocity computation. It is an improved /ALE/
GRID/SPRING formulation based on edge springs
and anti-shear springs.

Note:  Block Format Keyword

/ALE/GRID/ZERO Describes the Euler formulation.

Note:  Block Format Keyword

/ALESUB Subcycling on Lagrangian parts.

Note:  Engine Keyword

/AMS Describes the part group on which the advanced
mass scaling is applied.

Note:  Block Format Keyword

/ANALY Defines the type of analysis and sets analysis
flags.

Note:  Block Format Keyword

/ANIM Generates animation files containing results
according to the keywords specified. The keywords
are specified in the topics within Animation and
Post-processing Output Files.

Note:  Engine Keyword

/ANIM/BRICK/TENS Generates animation files containing tensor data
(mean value or value in specified integration
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point) for brick elements, in global coordinate
system.

Note:  Engine Keyword

/ANIM/BRICK/TENS/STRAIN Generates animation files containing strain tensor
for a specified integration point of a solid, in global
coordinate system.

Note:  Engine Keyword

/ANIM/BRICK/TENS/STRESS Generates animation files containing stress tensor
for a specified integration point of a solid, in global
coordinate system.

Note:  Engine Keyword

/ANIM/CUT/1 Defines a section cut on a deformed geometry.

Note:  Engine Keyword

/ANIM/CUT/2 Defines a section cut on the initial geometry.

Note:  Engine Keyword

/ANIM/CUT/3 Defines a section cut on a deformed geometry
using three nodes.

Note:  Engine Keyword

/ANIM/DT Write animation files (A-files) at a time frequency
equal to Tfreq, the first file being written at time
T. The animation file name will be RunnameAnnn,
where Runname is the Run Name and nnn is the file
number.

Note:  Engine Keyword

/ANIM/Eltyp/FORC Generates animation files containing force and
moment data for the specified element type.
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Note:  Engine Keyword

/ANIM/Eltyp/Restype Generates animation files containing element data
for the specified result.

Note:  Engine Keyword

/ANIM/GPS1 Generates animation files containing simple
average GPS data. The average value at node is
calculated by the mean stress of all elements,
which are connected to this node.

Note:  Engine Keyword

/ANIM/GPS2 Generates animation files containing volume based
averaged GPS data, which is done by the relative
element volumes (connected to same node use Vi/
V_total).

Note:  Engine Keyword

/ANIM/GZIP Generates animation files in GZIP format.

Note:  Engine Keyword

/ANIM/KEEPD In animation files, keep deleted elements in their
original part; otherwise group all deleted elements
in an extra part (named "deleted elements").

Note:  Engine Keyword

/ANIM/LSENSOR Write additional animation files (Animation Output
File (A-File)) at a time frequency equal to Tfreq,
the first file being written at sensor activation
time. The sensor activation time is given by the
sensor property set sens_IDN.

Note:  Engine Keyword
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/ANIM/MASS Generates animation files containing nodal
masses.

Note:  Engine Keyword

/ANIM/MAT Generates animation files with one part for each
material.

Note:  Engine Keyword

/ANIM/NODA Generates animation files containing nodal scalar
data.

Note:  Engine Keyword

/ANIM/SENSOR Write additional animation files (Animation Output
File (A-File)) with a time frequency equal to Tfreq,
the first file being written once sensor activated.
(The activation of sensor will be defined in /
SENSOR).

Note:  Engine Keyword

/ANIM/SHELL/EPSP Generates animation files containing plastic strain
as function of a shell element integration point.

Note:  Engine Keyword

/ANIM/SHELL/PHI/ALL Animation output of the angle between the
element skew and direction 1 orthotropy for all
layers.

Note:  Engine Keyword

/ANIM/SHELL/PHI/N Animation output of the angle between the
element skew and direction 1 orthotropy for layer
N.

Note:  Engine Keyword
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/ANIM/SHELL/TENS Generates animation files containing shell tensor
data for a specified result.

Note:  Engine Keyword

/ANIM/SHELL/USRi Generates animation files containing shell element
data for variables of user law on each integration
point.

Note:  Engine Keyword

/ANIM/VECT Generates animation files containing vectorial data
for the specified variable.

Note:  Engine Keyword

/ANIM/VECT/FREAC Generates animation files containing vectorial
data for reaction forces of imposed velocities,
displacements, accelerations and boundary
conditions.

Note:  Engine Keyword

/ANIM/VERS Generates animation files in Radioss environment
post-processing formats 41 and 44.

Note:  Engine Keyword

/ARCH Describes the architecture flag.

Note:  Block Format Keyword

/ATFILE Defines the frequency of writing additional time
history file of T-file "RunnameTnnx".

Note:  Engine Keyword

/BCS/ALE Given node numbers will be constrained in
specified directions X, Y or Z for grid DOF: Ω = 0.
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Note:  Engine Keyword

/BCS/LAG Given node numbers will be lagrangian in specified
directions X, Y or Z: V = W.

Note:  Engine Keyword

/BCS/ROT Given node numbers will be constrained in
specified directions X, Y or Z for rotational DOF: Ω
= 0.

Note:  Engine Keyword

/BCS/TRA Given node numbers will be constrained in
specified directions X, Y or Z for material
translational DOF: V = 0.

Note:  Engine Keyword

/BCSR/ALE Given node numbers will be released in specified
directions X, Y or Z for grid DOF.

Note:  Engine Keyword

/BCSR/LAG Given node numbers will no longer be lagrangian
in specified directions X, Y or Z.

Note:  Engine Keyword

/BCSR/ROT Given node numbers will be released in specified
directions X, Y or Z for material translational DOF.

Note:  Engine Keyword

/BCSR/TRA Given node numbers will be released in specified
directions X, Y or Z for material translational DOF.

Note:  Engine Keyword
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/BEGIN Sets the run name, the version of the input
manual, the number of starter run and input and
work unit systems.

Note:  Block Format Keyword

/CAA Describes the computation Aero-Acoustic
formulation for Eulerian or quasi-Eulerian
simulations. Internal forces are computed with
finite volume formulation. It improves results for
under integrated elements. By default artificial
viscosity is canceled, (qa,qb) default values are
zero.

Note:  Block Format Keyword

/DAMP Defines the Rayleigh mass and stiffness damping
coefficients applied to a set of nodes. The damping
can be applied to any nodal DOF either in local or
global coordinate system.

Note:  Block Format Keyword

/DEF_SHELL Sets default values for certain parameters in shell
property (/PROP/SHELL).

Note:  Block Format Keyword

/DEF_SOLID Sets default values for certain parameters in solid
property (/PROP/TYPE14 (SOLID) and /PROP/
TYPE20 (TSHELL)).

Note:  Block Format Keyword

/DEL Delete element numbers N1, N2, . . ., NN.

Note:  Engine Keyword

/DEL/Eltyp/1 Delete element numbers N1
first to N1

last, . . ., N
I
first

to NI
last.
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Note:  Engine Keyword

/DEL/INTER Delete interface numbers N1, N2, . . ., NN.

Note:  Engine Keyword

/DELINT If a slave node is only connected to 2D solid
elements that are all deleted, the node is
deactivated from the interface.

Note:  Engine Keyword

/DT Time step defaults for all elements.

Note:  Engine Keyword

/DT/AMS Elementary time step for Advanced Mass Scaling.

Note:  Engine Keyword

/DT/Eltyp/Iflag Time step for select entities.

Note:  Engine Keyword

/DT/Eltyp/Keyword3/Iflag Element time step control.

Note:  Engine Keyword

/DT/NODA/Keyword3 Nodal time step control.

Note:  Engine Keyword

/DT/SHELL The time step for shell elements using /DT1 is
lower but more accurate. Otherwise, this option is
identical to /DT1/SHELL.

Note:  Engine Keyword
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/DT/SHNOD or /DT/SHNOD/CST Time step for shells.

Note:  Engine Keyword

/DT/SPHCEL Generates the SPH cells time step.

Note:  Engine Keyword

/DT/SPHCEL/Keyword3 Generates the SPH cells time step control type.

Note:  Engine Keyword

/DT/THERM Time step for thermal modeling.

Note:  Engine Keyword

/DT1/SHELL The time step for shell elements using /DT1 is
lower, but more accurate. Otherwise, this option is
identical to /DT/SHELL.

Note:  Engine Keyword

/DTIX Sets initial and maximum time step for this run.

Note:  Engine Keyword

/DTSDE The time step for degenerated or PENTA6 solid
elements using this option is higher (almost factor
2).

Note:  Engine Keyword

/DYREL Dynamic relaxation.

Note:  Engine Keyword

/DYREL/1 Dynamic relaxation applied to node group
identifier grnd_ID.
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Note:  Engine Keyword

/END/ENGINE This keyword has to be set at the end of the
Engine input deck when using Single File Input.

Note:  Engine Keyword

/FVMBAG/MODIF Activates FVM airbag merging parameter
modifications in Engine file.

Note:  Engine Keyword

/FXINP Generates input files for flexible bodies from
eigenmodes and static modes computation.

Note:  Engine Keyword

/IMPL Keywords used for implicit solution. Different
implicit solver methods (linear, nonlinear, buckling
or quasi-static), different options to control
the implicit computation, different implicit time
step method and implicit output messages are
introduced.

Note:  Engine Keyword

/IMPL/AUTOSPC A zero stiffness DOF will be constrained
automatically.

Note:  Engine Keyword

/IMPL/BUCKL/1 Euler buckling modes will be computed.

Note:  Engine Keyword

/IMPL/BUCKL/2 Euler buckling modes will be computed based on
actual pre-stress stat.
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Note:  Engine Keyword

/IMPL/CHECK Implicit model checking will be run.

Note:  Engine Keyword

/IMPL/DIVERG/n Divergence criterion with successive increasing
residual number for nonlinear analysis.

Note:  Engine Keyword

/IMPL/DT/1 Implicit time step control method 1.

Note:  Engine Keyword

/IMPL/DT/2 Implicit automatic time step control method 2.

Note:  Engine Keyword

/IMPL/DT/3 Implicit automatic time step control with Riks
method.

Note:  Engine Keyword

/IMPL/DT/FIXPOINT Users' input fix time points where implicit
nonlinear computation will not miss with
automatic time step control.

Note:  Engine Keyword

/IMPL/DT/STOP The computation will be stopped, if DT_min is
reached. If DT_max is reached, the computation
will continue with constant time step set as
DT_max.

Note:  Engine Keyword

/IMPL/DTINI Initial time step for nonlinear implicit analysis.
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Note:  Engine Keyword

/IMPL/DYNA/1 Describes the implicit dynamics with α-HHT
method.

Note:  Engine Keyword

/IMPL/DYNA/2 Describes the implicit dynamics with a general
Newmark method.

Note:  Engine Keyword

/IMPL/DYNA/DAMP Rayleigh structure damping with dynamic implicit
analysis.

Note:  Engine Keyword

/IMPL/DYNA/FSI Defines the settings for Fluid Structure Interaction
Analysis with AcuSolve.

Note:  Engine Keyword

/IMPL/GSTIF/OFF Geometrical stiffness matrix will not be used for
implicit nonlinear calculation.

Note:  Engine Keyword

/IMPL/INTER/KCOMP Describes the stiffness matrix; due to contact
interfaces will be assembled completely.

Note:  Engine Keyword

/IMPL/INTER/KNONL Defines including some contact nonlinearities in
PCG linear solver.

Note:  Engine Keyword
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/IMPL/LBFGS/L Change the maximum number of BFGS quasi-
Newton method for implicit nonlinear.

Note:  Engine Keyword

/IMPL/LINEAR Linear implicit solution will be computed.

Note:  Engine Keyword

/IMPL/LINEAR/INTER Implicit linear analysis will take into account
contact interfaces.

Note:  Engine Keyword

/IMPL/LRIGROT Due to some linearization used in geometrical
nonlinear analysis, small time step has to be
chosen to avoid accumulated errors under large
rotation. In this case, this option improves the
accuracy using usual time step.

Note:  Engine Keyword

/IMPL/LSEARCH/n Line search methods for nonlinear analysis.

Note:  Engine Keyword

/IMPL/LSEARCH/OFF Deactivating line search for nonlinear analysis.

Note:  Engine Keyword

/IMPL/MONVOL/OFF Describes the stiffness of gas in monitored volume
type 3 (tire modeling).

Note:  Engine Keyword

/IMPL/NCYCLE/STOP The computation will be stopped, if Ncy_max is
reached.

Note:  Engine Keyword
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/IMPL/NONLIN Nonlinear implicit methods.

Note:  Engine Keyword

/IMPL/NONLIN/SMDISP Only small displacement effects will be considered
with this option.

Note:  Engine Keyword

/IMPL/PREPAT Describes the implicit option for pre-conditioning.

Note:  Engine Keyword

/IMPL/PRINT/LINEAR Printout frequency for linear solvers.

Note:  Engine Keyword

/IMPL/PRINT/NONLIN Printout frequency for nonlinear implicit iterations.

Note:  Engine Keyword

/IMPL/PSTIF/OFF Deactivating load (pressure) stiffness matrix.

Note:  Engine Keyword

/IMPL/QSTAT Quasi-static implicit solution will be computed.

Note:  Engine Keyword

/IMPL/QSTAT/DTSCAL Quasi-static implicit solution with a factor for
inertia stiffness matrix.

Note:  Engine Keyword

/IMPL/RREF/INTERF/n Different reference force residual computations
used for stop criteria on nonlinear analysis with
contact.
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Note:  Engine Keyword

/IMPL/RREF/LIMIT Define reference force residual limit values used in
stop criteria for implicit nonlinear.

Note:  Engine Keyword

/IMPL/RREF/OFF Deactivation reference residual option and using
the previous one in stop criteria for implicit
nonlinear analysis.

Note:  Engine Keyword

/IMPL/SBCS/MSGLV Describes the message level for BCS (Boeing)
solver.

Note:  Engine Keyword

/IMPL/SBCS/ORDER Reordering method definition for BCS.

Note:  Engine Keyword

/IMPL/SBCS/OUTCORE BCS solver will use minimum in-core memory.

Note:  Engine Keyword

/IMPL/SHPOFF The full projection of QEPH shell element for
warped elements will be deactivated to keep
consistency between the stiffness matrix and the
internal force computations.

Note:  Engine Keyword

/IMPL/SHPON The full projection of QEPH shell element for
warped elements will be activated for stiffness
matrix to keep consistency with the internal force
computations.
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Note:  Engine Keyword

/IMPL/SINIT Describes the initial stresses that will be imposed
gradually.

Note:  Engine Keyword

/IMPL/SOLVER Selects linear solver.

Note:  Engine Keyword

/IMPL/SPRBACK Implicit spring-back will be run in this session.

Note:  Engine Keyword

/IMPL/SPRING Describes the linear or nonlinear stiffness choices
for nonlinear spring in implicit nonlinear analysis.

Note:  Engine Keyword

/IMPLICIT Allows different default values which are suitable
for implicit calculations.

Note:  Block Format Keyword

/INCMP Quasi-incompressible formulation for fluid material
(compatible with /MAT/LAW6 and /MAT/LAW11).

Note:  Engine Keyword

/INISTA Describes the initial state file.

Note:  Block Format Keyword

/INIV/AXIS/Keyword3 Initialize rotational velocity about an axis and
translational velocity.
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Note:  Engine Keyword

/INIV/AXIS/Keyword3/1 Initialize rotational velocity about an axis and
translational velocity.

Note:  Engine Keyword

/INIV/ROT Initialize rotational velocity in the specified
direction X, Y or Z.

Note:  Engine Keyword

/INIV/ROT/Keyword3/1 Initialize rotational velocity in the specified
direction X, Y or Z.

Note:  Engine Keyword

/INIV/TRA Initialize translational velocity in the specified
direction X, Y or Z.

Note:  Engine Keyword

/INIV/TRA/Keyword3/1 Initialize translational velocity in the specified
direction X, Y or Z.

Note:  Engine Keyword

/INTER Describes an interface.

Note:  Engine Keyword

/IOFLAG Describes the input-output flags.

Note:  Block Format Keyword

/KEREL Kinetic energy relaxation.
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Note:  Engine Keyword

/KEREL/1 Kinetic energy relaxation applied to node group
grnd_ID.

Note:  Engine Keyword

/KILL The Engine is stopped if one of the following
criteria is exceeded.

Note:  Engine Keyword

/MADYMO Activates MADYMO- Radioss coupling.

Note:  Engine Keyword

/MEMORY Describes the memory request.

Note:  Engine Keyword

/MON Provides an estimation of the CPU time spent for
each processor.

Note:  Engine Keyword

/OUTP Write ASCII formatted output files.

Note:  Engine Keyword

/OUTP/LSENSOR An outp file is written each time a sensor in the
defined list is activated.

Note:  Engine Keyword

/PARITH Turns the parallel arithmetic ON/OFF.

Note:  Engine Keyword
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/PRINT Sets printout frequency for output file.

Note:  Engine Keyword

/RAD2RAD/ON To activate Multi-Domain coupling, Radioss Engine
Input file must contain the following directive.

Note:  Engine Keyword

/RANDOM Describes the nodal random noise to check
stability of model by introducing random noise on
nodal coordinates.

Note:  Block Format Keyword

/RBODY Listed rigid bodies will be activated or deactivated.

Note:  Engine Keyword

/RERUN Permits to continue a previous Radioss run.

Note:  Engine Keyword

/RFILE Writes a Restart R-File.

Note:  Engine Keyword

/RFILE/n Rewrites a Restart R-File.

Note:  Engine Keyword

/RUN Identifies the run number.

Note:  Engine Keyword

/RUN/Run Name/Run Number/Restart Letter Identifies the run number.

Note:  Engine Keyword
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/SHSUB Enables you to activate new sub-cycling option,
for which Isubcycle=2 in the /ANALY Radioss Starter
option should be specified.

Note:  Engine Keyword

/SHVER/V51 The new large rotational body motion formulation
for QEPH, QBAT and DKT18 will be deactivated.

Note:  Engine Keyword

/SPHGLO Describes the SPH global parameters.

Note:  Block Format Keyword

/SPMD Sets SPMD parameters for Hybrid Massively
Parallel Program (HMPP) computation.

Note:  Block Format Keyword

/STAMPING Allows adapting error messages to stamping
applications.

Note:  Block Format Keyword

/STATE/BRICK/AUX/FULL Describes the internal variable state for solid.

Note:  Engine Keyword

/STATE/BRICK/ORTHO Describes orthotropy direction for orthotropic solid
or thick shells.

Note:  Engine Keyword

/STATE/BRICK/STAIN/FULL Describes the strain state for solid.

Note:  Engine Keyword
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/STATE/BRICK/STRAIN/GLOBFULL Describes the strain state for solid in global
reference system.

Note:  Engine Keyword

/STATE/BRICK/STRES/FULL Describes the stress state for solid.

Note:  Engine Keyword

/STATE/BRICK/STRESS/GLOBFULL Describes the stress state for solid in global
reference system.

Note:  Engine Keyword

/STATE/DT Writes the state file.

Note:  Engine Keyword

/STATE/NODE/TEMP Describes the temperature for nodes.

Note:  Engine Keyword

/STATE/LSENSOR A state file is written each time a sensor in the
defined list is activated.

Note:  Engine Keyword

/STATE/SHELL/AUX/FULL Describes the internal variable state for solid.

Note:  Engine Keyword

/STATE/SHELL/EPSP/FULL Describes the Epsilon plastic state for shell.

Note:  Engine Keyword

/STATE/SHELL/ORTHL Describes the orthotropy direction for shell.

Note:  Engine Keyword

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.539

Card Description

/STATE/SHELL/STRAIN/FULL Describes the strain state for shell.

Note:  Engine Keyword

/STATE/SHELL/STRESS/FULL Describes the stress state for shell.

Note:  Engine Keyword

/STATE/STR_FILE When writing the state file, /INISHE, /INISH3 and
/INIBRI will be written in a separate file which
can be asked for being compressed (using GZIP)
or not. The state file will then resume to the nodes
coordinates and element connectivity.

Note:  Engine Keyword

/STOP The Engine is stopped, due to reached energy
error ratio criteria, total mass ratio criteria or
nodal mass ratio criteria.

Note:  Engine Keyword

/TFILE Defines the frequency of writing the time history
file of T-file "RunnameTnn".

/TH/VERS Generates the Time History files in Radioss
environment post-processing format "Version
Number".

Note:  Engine Keyword

/TITLE Input a title.

Note:  Engine Keyword

/UNIT Defines a local unit system for the keywords listed
below.

Note:  Block Format Keyword
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/UPWIND Describes the upwind coefficient.

Note:  Block Format Keyword

/UPWM/SUPG Streamline Upwind Petrov Galerkin formulation.

Note:  Engine Keyword

/UPWM/TG Describes the Taylor Galerkin method for
momentum advection. This method is not
available with multi-material LAW51 (/MAT/
MULTIMAT).

Note:  Engine Keyword

/VEL/ALE With ALE links on grid velocities, given nodes are
linked to the given master grid velocities. You can
specify direction or a combination of directions.

Note:  Engine Keyword

/VEL/ROT Given node numbers have the same rotational
velocity in a specified direction X, Y or Z.

Note:  Engine Keyword

/VEL/TRA Given node numbers have the same velocity
in a specified direction X, Y or Z for material
translational DOF.

Note:  Engine Keyword

/VERS Identifies the input data version number.
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Card Description

Note:  Engine Keyword

Samcef

Card Description

BOLT_OUTPUT Defines the output code definitions for all .BOLT
defined in the model.

UNIT Defines the unit used to set up the model.

Note:  This control card is mandatory
when beams are being defined in a
model.

UNSUPPORTED_CARDS
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Undefined Entities
Undefined entities are entities that will not be written to the solver deck.

The import and export of undefined entities is fully supported for:

• Components

• Properties

• Materials

• Curves

• Sets

• Rigid Walls

• Cross Sections

• Accelerometers

• Boxes

Undefined entities imported from new include files will be organized in the master model.

If an entity is referenced in a solver deck, but is not defined, an undefined entity will be created and
assigned the ID of the referenced entity on import. A default card image and a default name will also be
assigned to the newly created undefined entity.

Referenced components are created as an undefined entity.

The defined state of an entity is indicated in the Model Browser, Defined column (Property and Material
entity views), or in the Property Editor, Defined Entity field. An active checkbox indicates an entity is
defined, whereas an inactive checkbox indicates an entity is undefined.

Figure 142:

Undefined entities exhibit the same behaviors as defined entities; they are visible in all relevant
browsers and in the Property Editor. The defined state simply controls the export of the entity.

• If Defined is inactive, the entity not will be written to the solver deck.

• If Defined is active, the entity will be written to the solver deck.
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The export status of undefined entities cannot be changed. If Defined is inactive, the export status will
also be inactive in the Entity State Browser.

Resolve Undefined Entities
Undefined entities can be defined interactively in the session or via the import of a model that contains
the referenced entities. This ensures the entity will be written to the solver deck.

• Define an entity interactively in the session by activating the Defined checkbox in the browser or
Property Editor.

Figure 143:

• Define an entity via the import of a model containing the referenced entities.

If additional entities residing in the solver deck do not exist, they will be imported as is.

a) From the menu bar, click File > Import > HyperMesh Model.
b) In the Import File dialog, open the model containing the referenced entities.

c) In the File Options dialog, set the relevant option(s) to Keep Incoming Attributes and click
OK.
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Figure 144:

Renumber Undefined Entities
The renumbering of undefined entities is restricted to ensure references to entities that reside in
external Include files will not be invalidated.

1. In the Property Editor, ID field, enter a new number for the undefined entity.

2. In the dialog that appears, click Yes to execute the renumbering operation.

Figure 145:
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Solver Encryption Entities
The encryption of solver entities is used to translate entity data into an undisclosed language.

Support of encrypted solver entities will allow you, for example, to manipulate encrypted dummies
within the Dummy Browser.

You can view encrypted entities from the Model Browser, Solver Browser and References Browser. If an
entity is encrypted, then its corresponding attributes will not be exposed in Property Editor, and curves
cannot be reviewed or edited in the Curve Editor.

Undo and redo encryption actions made in HyperMesh using Undo/Redo.

LS-DYNA
Encrypted material and curve entities can be imported and exported.

PAM-CRASH 2G
Secure MATER, PART, FUNCT, and PLY can be imported and exported.

Radioss
Property and failure entities can be imported and exported.
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Element Property and Material Assignement Rules
Element property and material assignment rules are based on the current user profile (solver interface).

There are two basic solver groups supported in HyperMesh; solver group1 and solver group2.

Solver Group 1
• OptiStruct

• Abaqus

• Nastran

• Samcef

Element property and material assignment rules for solver group 1:

• Components have no card images.

• Properties are assigned to elements or components using the following rules in order:

1. If a property is assigned directly to an element, then that property is the elements property
regardless of any other property assignments. Properties are assigned directly to elements on
the Properties panel, Assign subpanel.

2. If there is no property assigned directly to an element, then the property assigned to the
component the element is organized into becomes the elements property. Properties are
assigned to components on the Properties panel, Assign subpanel.

3. If there is no property assigned to the component, then the element has no property
assignment.

• Materials are always assigned to properties. Elements are assigned the material of their assigned
property. If a property has no assigned material, then all elements assigned to that property
have no material assignment. Materials are assigned to properties on the Properties panel, Assign
subpanel.
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Figure 146: Solver Group1 Property/Material Assignment Schematic

Solver Group 2
• Radioss

• LS-DYNA

• PAM-CRASH

• ANSYS

• Permas

Element property and material assignment rules for solver group 2:

• Components have card images; typically "part" card images.

• Properties and materials are assigned to components only. There is no property or material
assignment directly to elements. Properties and materials are assigned to components on the
Components panel, Assign subpanel.

• Elements are assigned the property and material assigned to the component in which they are
organized into.

• If a component is not assigned a property or material, then all elements within that component
have no property or material assignment.
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Figure 147: Solver Group 2 Property/Material Assignment Schematic
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Supported Cards
Supported cards organized by solver.

Abaqus
*AMPLITUDE

*BEAM ADDED INERTIA

*BEAM GENERAL SECTION

*BEAM SECTION

*BIAXIAL TEST DATA

*BLOCKAGE

*BOUNDARY

*BRITTLE CRACKING

*BRITTLE FAILURE

*BRITTLE SHEAR

*BUCKLE

*BULK VISCOSITY

*CECHARGE

*CECURRENT

*CFILM

*CFLUX

*CHANGE FRICTION

*CLAY HARDENING

*CLAY PLASTICITY

*CLEARANCE

*CLOAD

*COHESIVE BEHAVIOR

*COHESIVE SECTION

*COMBINED TEST DATA

*CONDUCTIVITY

*CONNECTOR BEHAVIOR

*CONNECTOR CONSTITUTIVE REFERENCE

*CONNECTOR CONTACT FORCE

*CONNECTOR DAMPING

*CONNECTOR DERIVED COMPONENTS

*CONNECTOR ELASTICITY

*CONNECTOR FAILURE

*CONNECTOR FRICTION

*CONNECTOR HARDENING
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*CONNECTOR LOAD

*CONNECTOR LOCK

*CONNECTOR MOTION

*CONNECTOR PLASTICITY

*CONNECTOR POTENTIAL

*CONNECTOR SECTION

*CONNECTOR STOP

*CONSTRAINT CONTROLS

*CONTACT (General Contact)

*CONTACT CLEARANCE

*CONTACT CLEARANCE ASSIGNMENT

*CONTACT CONTROLS

*CONTACT CONTROLS ASSIGNMENT

*CONTACT DAMPING (Explicit template)

*CONTACT DAMPING (Standard templates)

*CONTACT EXCLUSIONS

*CONTACT FILE

*CONTACT FORMULATION

*CONTACT INCLUSIONS

*CONTACT INTERFERENCE

*CONTACT OUTPUT

*CONTACT PAIR

*CONTACT PRINT

*CONTACT PROPERTY ASSIGNMENT

*CONTACT PROPERTY ASSIGNMENT, PROPERTY=OFFSET FRACTION

*CONTACT PROPERTY ASSIGNMENT, PROPERTY=THICKNESS

*CONTROLS

*COUPLED TEMP-DISPLACEMENT

*COUPLING

*CREEP

*CRUSHABLE FOAM

*CRUSHABLE FOAM HARDENING

*DAMPING

*DASHPOT

*DEBOND

*DECHARGE

*DENSITY

*DEPVAR

*DFLUX
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*DIAGNOSTICS

*DIELECTRIC

*DISTRIBUTING

*DISTRIBUTING COUPLING

*DISTRIBUTION

*DISTRIBUTION_ANGLE

*DISTRIBUTION_DRAPE

*DISTRIBUTION_OFFSET

*DISTRIBUTION_ORIENTATION

*DISTRIBUTION_THICKNESS

*DLOAD

*DSLOAD

*DYNAMIC

*DYNAMIC (Explicit)

*EL FILE

*EL PRINT

*ELASTIC

*ELEMENT

*ELEMENT OUTPUT

*ELEMENT PROPERTIES

*ELGEN

*ELSET

*EMBEDDED ELEMENT

*ENERGY FILE

*ENERGY OUTPUT

*ENERGY PRINT

*EQUATION

*EULERIAN SECTION

*EXPANSION

*FABRIC

*FASTENER (SPOT WELD)

*FASTENER PROPERTY

*FILE FORMAT

*FILM

*FILTER

*FIXED MASS SCALING

*FLUID BEHAVIOR

*FLUID BULK

*FLUID DENSITY
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*FLUID EXPANSION

*FLUID PROPERTY

*FRACTURE CRITERION

*FREQUENCY

*FRICTION (Explicit template)

*FRICTION (Standard templates)

*GAP

*GASKET BEHAVIOR

*GASKET CONTACT AREA

*GASKET ELASTICITY

*GASKET SECTION

*GASKET THICKNESS BEHAVIOR

*GEOSTATIC

*HEADING

*HEAT TRANSFER

*HYPERELASTIC

*HYPERFOAM

*INCREMENTATION OUTPUT

*INERTIA RELIEF

*INITIAL CONDITION (TYPE=STRESS)

*INITIAL CONDITION (TYPE=PRESSURE)

*INITIAL CONDITION (TYPE=TEMPERATURE)

*INITIAL CONDITION (TYPE=VELOCITY)

*INTEGRATED OUTPUT

*INTEGRATED OUTPUT SECTION

*ITS

*JOINT

*KINEMATIC

*KINEMATIC COUPLING

*LOAD CASE

*LOADING DATA

*LOW DENSITY FOAM

*M1

*M2

*MASS

*MATERIAL

*MEMBRANE SECTION

*MODAL_DAMPING

*MODAL DYNAMIC
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*MODAL OUTPUT

*MODEL CHANGE

*MONITOR

*MPC

*MULLINS EFFECT

*NODAL THICKNESS

*NFILL

*NGEN

*NMAP

*NODE

*NODE FILE

*NODE OUTPUT

*NODE PRINT

*NONSTRUCTURAL MASS

*NSET

*ORIENTATION

*OUTPUT

*PARAMETER

*PHYSICAL CONSTANT

*PIEZOELECTRIC

*PLANAR TEST DATA

*PLASTIC

*PREPRINT

*PRE-TENSION SECTION

*PRINT

*RADIATE

*RADIATION VIEWFACTOR

*RATE DEPENDENT

*REBAR LAYER

*RELEASE

*RESPONSE SPECTRUM

*RESTART

*RESTART

*RIGID BODY

*ROTARY INERTIA

*SECTION CONTROLS

*SFILM

*SHEAR FAILURE

*SHEAR TEST DATA
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*SHELL GENERAL SECTION

*SHELL SECTION

*SHELL TO SOLID COUPLING

*SIMPLE SHEAR TEST DATA

*SOLID SECTION

*SPECIFIC HEAT

*SPECTRUM

*SPRING

*STATIC

*STEADY STATE DYNAMICS

*STEP

*SURFACE

*SURFACE BEHAVIOR (Explicit template)

*SURFACE BEHAVIOR (Standard templates)

*SURFACE INTERACTION (Explicit template)

*SURFACE INTERACTION (Standard templates)

*SURFACE PROPERTY/*EMISSIVITY

*SURFACE PROPERTY ASSIGNMENT (Explicit template)

*SURFACE SECTION

*SURFACE SMOOTHING

*SYSTEM

*TEMPERATURE

*TIE

*TRANSFORM

*TRANSVERSE SHEAR STIFFNESS

*UNIAXIAL

*UNIAXIAL TEST DATA

*UNLOADING DATA

*USER MATERIAL

*USER OUTPUT VARIABLES

*VARIABLE MASS SCALING

*VISCO

*VISCOELASTIC

*VOLUMETRIC TEST DATA

Actran
ACCELERATION

ADMITTANCE

ANALYSIS
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AXISYMMETRY

BC_MESH

BOUNDARY_CONDITION

COUPLING_SURFACE

DIMENSION

DISCRETE

DISPLACEMENT

DISTRIBUTED_LOAD

DISTRIBUTED_PRESSURE

ELEMENT

FIELD_POINT_SURFACE

FREQUENCY_DOMAIN

IMPERVIOUS

INCIDENT_SURFACE

INFINITE ADMITTANCE

INFINITE_DOMAIN

INFINITE_ELEMENT

INFINITE_FLUID

INFINITE_MESH

INTERFACE

LIGHTHILL

MATERIAL (FLUID)

MATERIAL (SHELL)

MATERIAL (SOLID)

MATERIAL (POROUS_UP)

MATERIAL (POROUS_RIGID)

MATERIAL (VISCOTHERMAL)

MESH

MEAN_FLOW

MODAL_BASIS

MODAL_EXTRACTION

MODAL_SURFACE

NODE

OUTPUT_FRF

OUTPUT_MAP

POINT_LOAD

POROUS_UP

PRESSURE

RADIATING_SURFACE
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RAYLEIGH_SURFACE

RIGID_POROUS

SAVE

SHELL

SOLID

SOLVER

SOURCE

STIFFENER

SUPER_CONNECTOR

SUPER_ELEMENT

TEMPERATURE_PRESSURE

TITLE

VELOCITY

VISCOTHERMAL

VISCOTHERMAL_FLUID

ANSYS
The input translator recognizes the ANSYS cards listed below. If an unsupported field is found in a card,
a message is displayed on the status bar. The messages are also printed to the file ansys.msg. General
slash commands, SOLUTION commands, POST1 commands, and POST26 commands are referred to as
control cards. Unrecognized cards are written to a *.hmx file.

Note:  One component collector is created for every unique combination of Type, Real,
Mat, and SECNUM. Surface loads on 1D elements is not supported. Property collectors are
created for each real set defined in the ANSYS deck. Material collectors are also created
for each material ID encountered. The component in HyperMesh is different from the
component (CM) in ANSYS.

ACEL

ALPHAD

ANTYPE

ARCLEN

ARCTRM

/ASSIGN

AUTOTS

/BATCH

BEAM3

BEAM4

BEAM23

BEAM24

BEAM44

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.557

BEAM54

BEAM188

BEAM189

BETAD

/BFUNIF

BF

BF_FLUE

BF_HGEN

BF_TEMP

BFE_FLUE

BFE_HGEN

BFE_TEMP

BUCOPT

CE

CERIG

CGLOC

CGOMGA

CIRCU124

CMACEL

CMDOMEGA

CMOMEGA

CMGRP

CNVTOL

/COM

COMBIN14

COMBIN39

COMBIN40

CONTA171

CONTA172

CONTA173

CONTA174

CONTA175

CONTA177

CONTA178

CONTAC12

CONTAC48

CONTAC49

CONTAC52

ConvBulkTe
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ConvFilmCo

/COPY

CP_ELEC

CP_STRUC

CRPLIM

D_CONSTRNT

D_TEMP

D_VOLT

DCGOMG

/DELETE

DELTIM

DIM

DMPRAT

DOF

DOMEGA

EMUNIT

EQSLV

ERESX

EORIENT

ETABLE

EXPASS

F_FLOW

F_HEAT

FLOTRAN

FLUID

FLUID29

FLUID30

FLUID80

FLUID116

FORCE

FORCE2

HARFRQ

HF118

HF119

HF120

HFLUX

HM_COMP

HREXP

HROPT
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HROUT

HYPER58

IC_CONSTRN

IC_TEMP

IC_VOLT

INFIN9

INFIN110

INTER192

INTER193

INTER194

INTER195

IRLF

KBC

KUSE

LINK1

LINK8

LINK10

LINK31

LINK32

LINK33

LINK34

LINK68

LINK180

LNSRCH

LOCAL

LSSOLVE

LVSCALE

MASS21

MASS71

MAT

MATRIX27

MDAMP\

MESH200

MODE

MODOPT

MP

MPDATA

MPC184

MPTEMP
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MXPAND

N

NBLOCK

NCNV

NEQIT

NLGEOM

NROPT

NSUBST

OMEGA

OUTRES

PIPE16

PIPE18

PIPE20

PIPE60

PLANE2

PLANE13

PLANE25

PLANE35

PLANE42

PLANE53

PLANE55

PLANE67

PLANE75

PLANE77

PLANE78

PLANE82

PLANE83

PLANE121

PLANE145

PLANE146

PLANE162

PLANE182

PLANE183

PLANE223

/POST1

PRED

PRESOL

PRESSURE

PRETS179
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PSTRES

RBE3

RSYS

SECCONTROLS

SECDATA

SECOFFSET

SECTYPE

SFE

SHELL28

SHELL41

SHELL43

SHELL51

SHELL57

SHELL61

SHELL63

SHELL91

SHELL93

SHELL99

SHELL131

SHELL132

SHELL143

SHELL150

SHELL157

SHELL163

SHELL181

SHELL208

SHELL209

SHELL281

SLOAD

SOLID5

SOLID45

SOLID46

SOLID62

SOLID64

SOLID69

SOLID70

SOLID72

SOLID73

SOLID87
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SOLID90

SOLID92

SOLID95

SOLID96

SOLID97

SOLID98

SOLID117

SOLID147

SOLID148

SOLID164

SOLID168

SOLID185

SOLID186

SOLID187

SOLID191

SOLID226

SOLID227

SOLSH190

/SOLU

SOLU

SOLVE

SSTIF

/STITLE

SUBOPT

SURF151

SURF152

SURF153

SURF154

SURF156

SURF251

SURF252

/SYS

TARGE169

TARGE170

TB

TBDATA

TIME

TIMINT

TINTP
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/TITLE

TOFFST

TOTAL

TREF

TRNOPT

TUNIF

/UNITS

VISCO88

VISCO107

EXODUS
ACCELERATION

Acoustic

Anisotropic

Beam

BOUNDARY

ConMass

ContactTie

Coordinate Frames

ElementBlocks

FLUX

FORCE

Function

Isotropic

Isotropic_Viscoelastic

MOMENT

NodeSets

Orthotropic

OUTPUTS

PARAMETERS

Plot

Shell

SideSets

Solid

SOLUTION

Spring

Stochastic

THERMAL

TiedJoint
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Truss

VELOCITY

Feko
/DI

/SK

LS-DYNA
*AIRBAG_ADIABATIC_GAS_MODEL

*AIRBAG_ALE

*AIRBAG_HYBRID

*AIRBAG_HYBRID_CHEMKIN

*AIRBAG_HYBRID_JETTING

*AIRBAG_HYBRID_JETTING_CM

*AIRBAG_INTERACTION

*AIRBAG_LINEAR_FLUID

*AIRBAG_LOAD_CURVE

*AIRBAG_PARTICLE

*AIRBAG_PARTICLE_DECOMPOSITION

*AIRBAG_PARTICLE_DECOMPOSITION_MOLEFRACTION

*AIRBAG_PARTICLE_MOLEFRACTION

*AIRBAG_PARTICLE_MPP

*AIRBAG_PARTICLE_MPP_DECOMPOSITION

*AIRBAG_PARTICLE_MPP_MOLEFRACTION

*AIRBAG_PARTICLE_MPP_DECOMPOSITION_MOLEFRACTION

*AIRBAG_REFERENCE_GEOMETRY

*AIRBAG_REFERENCE_GEOMETRY_BIRTH

*AIRBAG_REFERENCE_GEOMETRY_BIRTH_RDT

*AIRBAG_REFERENCE_GEOMETRY_RDT

*AIRBAG_SHELL_REFERENCE_GEOMETRY

*AIRBAG_SHELL_REFERENCE_GEOMETRY_RDT

*AIRBAG_SIMPLE_AIRBAG_MODEL

*AIRBAG_SIMPLE_PRESSURE_VOLUME

*AIRBAG_WANG_NEFSKE

*AIRBAG_WANG_NEFSKE_JETTING

*AIRBAG_WANG_NEFSKE_JETTING_CM

*AIRBAG_WANG_NEFSKE_JETTING_POP

*AIRBAG_WANG_NEFSKE_JETTING_POP_CM

*AIRBAG_WANG_NEFSKE_MULTIPLE_JETTING
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*AIRBAG_WANG_NEFSKE_MULTIPLE_JETTING_CM

*AIRBAG_WANG_NEFSKE_MULTIPLE_JETTING_POP

*AIRBAG_WANG_NEFSKE_MULTIPLE_JETTING_POP_CM

*AIRBAG_WANG_NEFSKE_POP

*ALE_FSI_PROJECTION

*ALE_MULTI-MATERIAL_GROUP

*ALE_REFERENCE_SYSTEM_CURVE

*ALE_REFERENCE_SYSTEM_GROUP

*ALE_REFERENCE_SYSTEM_NODE

*ALE_REFERENCE_SYSTEM_SWITCH

*ALE_SMOOTHING

*ALE_TANK_TEST

*BOUNDARY_AMBIENT_EOS

*BOUNDARY_CONVECTION_SET

*BOUNDARY_CYCLIC

*BOUNDARY_FLUX_SET

*BOUNDARY_NON_REFLECTING

*BOUNDARY_NON_REFLECTING_2D

*BOUNDARY_PRESCRIBED_ACCELEROMETER_RIGID

*BOUNDARY_PRESCRIBED_MOTION_NODE(Accl)

*BOUNDARY_PRESCRIBED_MOTION_NODE(Disp)

*BOUNDARY_PRESCRIBED_MOTION_NODE(Vel)

*BOUNDARY_PRESCRIBED_MOTION_NODE

*BOUNDARY_PRESCRIBED_MOTION_RIGID(Accl)

*BOUNDARY_PRESCRIBED_MOTION_RIGID(Disp)

*BOUNDARY_PRESCRIBED_MOTION_RIGID(Vel)

*BOUNDARY_PRESCRIBED_MOTION_RIGID

*BOUNDARY_PRESCRIBED_MOTION_RIGID_LOCAL

*BOUNDARY_PRESCRIBED_MOTION_RIGID_LOCAL(Accl)

*BOUNDARY_PRESCRIBED_MOTION_RIGID_LOCAL(Disp)

*BOUNDARY_PRESCRIBED_MOTION_RIGID_LOCAL(Vel)

*BOUNDARY_PRESCRIBED_MOTION_RIGID_LOCAL

*BOUNDARY_PRESCRIBED_MOTION_SET

*BOUNDARY_PRESCRIBED_MOTION_SET(Accl)

*BOUNDARY_PRESCRIBED_MOTION_SET(Disp)

*BOUNDARY_PRESCRIBED_MOTION_SET(Vel)

*BOUNDARY_RADIATION_SET

*BOUNDARY_SPC_NODE

*BOUNDARY_SPC_NODE_BIRTH_DEATH
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*BOUNDARY_SPC_SET

*BOUNDARY_SPC_SET_BIRTH_DEATH

*BOUNDARY_SPH_FLOW

*BOUNDARY_TEMPERATURE_NODE

*BOUNDARY_TEMPERATURE_SET

*CONSTRAINED_BUTT_WELD

*CONSTRAINED_EXTRA_NODES_NODE

*CONSTRAINED_EXTRA_NODES_SET

*CONSTRAINED_GENERALIZED_WELD_BUTT

*CONSTRAINED_GENERALIZED_WELD_COMBINED

*CONSTRAINED_GENERALIZED_WELD_CROSS_FILLET

*CONSTRAINED_GENERALIZED_WELD_FILLET

*CONSTRAINED_GENERALIZED_WELD_SPOT

*CONSTRAINED_GLOBAL

*CONSTRAINED_INTERPOLATION

*CONSTRAINED_INTERPOLATION_LOCAL

*CONSTRAINED_JOINT_CONSTANT_VELOCITY_FAILURE

*CONSTRAINED_JOINT_CONSTANT_VELOCITY

*CONSTRAINED_JOINT_CONSTANT_VELOCITY_LOCAL_FAILURE

*CONSTRAINED_JOINT_CONSTANT_VELOCITY_LOCAL

*CONSTRAINED_JOINT_CYLINDRICAL

*CONSTRAINED_JOINT_CYLINDRICAL_FAILURE

*CONSTRAINED_JOINT_CYLINDRICAL_LOCAL_FAILURE

*CONSTRAINED_JOINT_CYLINDRICAL_LOCAL

*CONSTRAINED_JOINT_GEARS_FAILURE

*CONSTRAINED_JOINT_GEARS

*CONSTRAINED_JOINT_GEARS_LOCAL_FAILURE

*CONSTRAINED_JOINT_GEARS_LOCAL

*CONSTRAINED_JOINT_LOCKING_FAILURE

*CONSTRAINED_JOINT_LOCKING

*CONSTRAINED_JOINT_LOCKING_LOCAL_FAILURE

*CONSTRAINED_JOINT_LOCKING_LOCAL

*CONSTRAINED_JOINT_PLANAR

*CONSTRAINED_JOINT_PLANAR_FAILURE

*CONSTRAINED_JOINT_PLANAR_LOCAL_FAILURE

*CONSTRAINED_JOINT_PLANAR_LOCAL

*CONSTRAINED_JOINT_PULLEY_FAILURE

*CONSTRAINED_JOINT_PULLEY

*CONSTRAINED_JOINT_PULLEY_LOCAL_FAILURE
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*CONSTRAINED_JOINT_PULLEY_LOCAL

*CONSTRAINED_JOINT_RACK_AND_PINION_FAILURE

*CONSTRAINED_JOINT_RACK_AND_PINION

*CONSTRAINED_JOINT_RACK_AND_PINION_LOCAL_FAILURE

*CONSTRAINED_JOINT_RACK_AND_PINION_LOCAL

*CONSTRAINED_JOINT_REVOLUTE

*CONSTRAINED_JOINT_REVOLUTE_FAILURE

*CONSTRAINED_JOINT_REVOLUTE_LOCAL_FAILURE

*CONSTRAINED_JOINT_REVOLUTE_LOCAL

*CONSTRAINED_JOINT_ROTATIONAL_MOTOR_FAILURE

*CONSTRAINED_JOINT_ROTATIONAL_MOTOR

*CONSTRAINED_JOINT_ROTATIONAL_MOTOR_LOCAL_FAILURE

*CONSTRAINED_JOINT_ROTATIONAL_MOTOR_LOCAL

*CONSTRAINED_JOINT_SCREW_FAILURE

*CONSTRAINED_JOINT_SCREW

*CONSTRAINED_JOINT_SCREW_LOCAL_FAILURE

*CONSTRAINED_JOINT_SCREW_LOCAL

*CONSTRAINED_JOINT_SPHERICAL

*CONSTRAINED_JOINT_SPHERICAL_FAILURE

*CONSTRAINED_JOINT_SPHERICAL

*CONSTRAINED_JOINT_SPHERICAL_LOCAL_FAILURE

*CONSTRAINED_JOINT_SPHERICAL_LOCAL

*CONSTRAINED_JOINT_STIFFNESS_FLEXION-TORSION

*CONSTRAINED_JOINT_STIFFNESS_GENERALIZED

*CONSTRAINED_JOINT_STIFFNESS_TRANSLATIONAL

*CONSTRAINED_JOINT_TRANSLATIONAL

*CONSTRAINED_JOINT_TRANSLATIONAL_FAILURE

*CONSTRAINED_JOINT_TRANSLATIONAL

*CONSTRAINED_JOINT_TRANSLATIONAL_LOCAL_FAILURE

*CONSTRAINED_JOINT_TRANSLATIONAL_LOCAL

*CONSTRAINED_JOINT_TRANSLATIONAL_MOTOR_FAILURE

*CONSTRAINED_JOINT_TRANSLATIONAL_MOTOR

*CONSTRAINED_JOINT_TRANSLATIONAL_MOTOR_LOCAL_FAILURE

*CONSTRAINED_JOINT_TRANSLATIONAL_MOTOR_LOCAL

*CONSTRAINED_JOINT_UNIVERSAL

*CONSTRAINED_JOINT_UNIVERSAL_FAILURE

*CONSTRAINED_JOINT_UNIVERSAL_LOCAL_FAILURE

*CONSTRAINED_JOINT_UNIVERSAL_LOCAL

*CONSTRAINED_LAGRANGE_IN_SOLID
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*CONSTRAINED_LAGRANGE_IN_SOLID_EDGE

*CONSTRAINED_NODAL_RIGID_BODY

*CONSTRAINED_NODAL_RIGID_BODY_INERTIA

*CONSTRAINED_NODAL_RIGID_BODY_SPC

*CONSTRAINED_NODAL_RIGID_BODY_SPC_INERTIA

*CONSTRAINED_NODE_SET

*CONSTRAINED_RIGID_BODIES

*CONSTRAINED_RIGID_BODY_STOPPERS

*CONSTRAINED_RIVET

*CONSTRAINED_SHELL_TO_SOLID

*CONSTRAINED_SPOTWELD

*CONSTRAINED_SPOTWELD_FILTERED_FORCE

*CONSTRAINED_TIE-BREAK

*CONSTRAINED_TIED_NODES_FAILURE

*CONTACT_2D_AUTOMATIC_SURFACE_TO_SURFACE

*CONTACT_2D_AUTOMATIC_SURFACE_TO_SURFACE_THERMAL

*CONTACT_2D_AUTOMATIC_TIED

*CONTACT_AIRBAG_SINGLE_SURFACE

*CONTACT_AIRBAG_SINGLE_SURFACE_MPP

*CONTACT_AUTO_MOVE

*CONTACT_AUTOMATIC_BEAMS_TO_SURFACE

*CONTACT_AUTOMATIC_BEAMS_TO_SURFACE_MPP

*CONTACT_AUTOMATIC_GENERAL_EDGEONLY

*CONTACT_AUTOMATIC_GENERAL_EDGEONLY_MPP

*CONTACT_AUTOMATIC_GENERAL

*CONTACT_AUTOMATIC_GENERAL_INTERIOR

*CONTACT_AUTOMATIC_GENERAL_INTERIOR_MPP

*CONTACT_AUTOMATIC_GENERAL_MPP

*CONTACT_AUTOMATIC_NODES_TO_SURFACE

*CONTACT_AUTOMATIC_NODES_TO_SURFACE_MPP

*CONTACT_AUTOMATIC_NODES_TO_SURFACE_SMOOTH

*CONTACT_AUTOMATIC_NODES_TO_SURFACE_SMOOTH_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL
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*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_THERMAL

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK_THERMAL_FRICTION

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK_THERMAL_FRICTION_MPP

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK_THERMAL

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACE_TIEBREAK_THERMAL_MPP

*CONTACT_AUTOMATIC_SINGLE_SURFACE

*CONTACT_AUTOMATIC_SINGLE_SURFACE_MORTAR

*CONTACT_AUTOMATIC_SINGLE_SURFACE_MORTAR_MPP

*CONTACT_AUTOMATIC_SINGLE_SURFACE_MPP

*CONTACT_AUTOMATIC_SINGLE_SURFACE_SMOOTH

*CONTACT_AUTOMATIC_SINGLE_SURFACE_SMOOTH_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_COMPOSITE

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_COMPOSITE_THERMAL

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_COMPOSITE_THERMAL_FRICTION

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_THERMAL_FRICTION

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_THERMAL_FRICTION_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_THERMAL

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_THERMAL_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_TIED

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_TIED_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_TIED_THERMAL_FRICTION

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_TIED_THERMAL_FRICTION_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_TIED_THERMAL

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MORTAR_TIED_THERMAL_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_SMOOTH

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_SMOOTH_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_SMOOTH_THERMAL
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*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_SMOOTH_THERMAL_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_THERMAL

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK_THERMAL_FRICTION

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK_THERMAL_FRICTION_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK_THERMAL

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIEBREAK_THERMAL_MPP

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIED_WELD

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIED_WELD_THERMAL

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE_TIED_WELD_THERMAL_FRICTION

*CONTACT_CONSTRAINT_NODES_TO_SURFACE

*CONTACT_CONSTRAINT_NODES_TO_SURFACE_MPP

*CONTACT_CONSTRAINT_SURFACE_TO_SURFACE

*CONTACT_CONSTRAINT_SURFACE_TO_SURFACE_MPP

*CONTACT_CONSTRAINT_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_CONSTRAINT_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_CONSTRAINT_SURFACE_TO_SURFACE_THERMAL

*CONTACT_CONSTRAINT_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_DRAWBEAD

*CONTACT_DRAWBEAD_MPP

*CONTACT_ENTITY

*CONTACT_ERODING_NODES_TO_SURFACE

*CONTACT_ERODING_NODES_TO_SURFACE_MPP

*CONTACT_ERODING_SINGLE_SURFACE

*CONTACT_ERODING_SINGLE_SURFACE_MPP

*CONTACT_ERODING_SURFACE_TO_SURFACE

*CONTACT_ERODING_SURFACE_TO_SURFACE_MPP

*CONTACT_ERODING_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_ERODING_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_ERODING_SURFACE_TO_SURFACE_THERMAL

*CONTACT_ERODING_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_FORCE_TRANSDUCER_CONSTRAINT

*CONTACT_FORCE_TRANSDUCER_CONSTRAINT_MPP

*CONTACT_FORCE_TRANSDUCER_PENALTY

*CONTACT_FORCE_TRANSDUCER_PENALTY_MPP
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*CONTACT_FORMING_NODES_TO_SURFACE

*CONTACT_FORMING_NODES_TO_SURFACE_MPP

*CONTACT_FORMING_NODES_TO_SURFACE_SMOOTH

*CONTACT_FORMING_NODES_TO_SURFACE_SMOOTH_MPP

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_MPP

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_MPP

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION_MPP

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_MPP

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_THERMAL

*CONTACT_FORMING_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE

*CONTACT_FORMING_SURFACE_TO_SURFACE_MORTAR

*CONTACT_FORMING_SURFACE_TO_SURFACE_MORTAR_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE_MORTAR_THERMAL_FRICTION

*CONTACT_FORMING_SURFACE_TO_SURFACE_MORTAR_THERMAL_FRICTION_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE_MORTAR_THERMAL

*CONTACT_FORMING_SURFACE_TO_SURFACE_MORTAR_THERMAL_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE_SMOOTH

*CONTACT_FORMING_SURFACE_TO_SURFACE_SMOOTH_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION

*CONTACT_FORMING_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE_SMOOTH_THERMAL

*CONTACT_FORMING_SURFACE_TO_SURFACE_SMOOTH_THERMAL_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_FORMING_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_FORMING_SURFACE_TO_SURFACE_THERMAL

*CONTACT_FORMING_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_GUIDED_CABLE

*CONTACT_INTERIOR

*CONTACT_NODES_TO_SURFACE

*CONTACT_NODES_TO_SURFACE_INTERFERENCE

*CONTACT_NODES_TO_SURFACE_INTERFERENCE_MPP
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*CONTACT_NODES_TO_SURFACE_MPP

*CONTACT_NODES_TO_SURFACE_SMOOTH

*CONTACT_NODES_TO_SURFACE_SMOOTH_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE_THERMAL_FRICTION

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE_THERMAL_FRICTION_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE_THERMAL

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_INTERFERENCE_THERMAL_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_SMOOTH_THERMAL_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_THERMAL

*CONTACT_ONE_WAY_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_RIGID_BODY_ONE_WAY_TO_RIGID_BODY

*CONTACT_RIGID_BODY_ONE_WAY_TO_RIGID_BODY_MPP

*CONTACT_RIGID_BODY_TWO_WAY_TO_RIGID_BODY

*CONTACT_RIGID_BODY_TWO_WAY_TO_RIGID_BODY_MPP

*CONTACT_RIGID_NODES_TO_RIGID_BODY

*CONTACT_RIGID_NODES_TO_RIGID_BODY_MPP

*CONTACT_RIGID_SURFACE

*CONTACT_SINGLE_EDGE

*CONTACT_SINGLE_EDGE_MPP

*CONTACT_SINGLE_SURFACE

*CONTACT_SINGLE_SURFACE_MPP

*CONTACT_SLIDING_ONLY

*CONTACT_SLIDING_ONLY_MPP

*CONTACT_SLIDING_ONLY_PENALTY

*CONTACT_SLIDING_ONLY_PENALTY_MPP

*CONTACT_SPOTWELD_BEAM_OFFSET

*CONTACT_SPOTWELD_BEAM_OFFSET_MPP

*CONTACT_SPOTWELD_CONSTRAINED_OFFSET
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*CONTACT_SPOTWELD_CONSTRAINED_OFFSET_MPP

*CONTACT_SPOTWELD

*CONTACT_SPOTWELD_MPP

*CONTACT_SPOTWELD_WITH_TORSION

*CONTACT_SPOTWELD_WITH_TORSION_MPP

*CONTACT_SURFACE_TO_SURFACE_CONTRACTION_JOINT

*CONTACT_SURFACE_TO_SURFACE_CONTRACTION_JOINT_MPP

*CONTACT_SURFACE_TO_SURFACE_CONTRACTION_JOINT_THERMAL_FRICTION

*CONTACT_SURFACE_TO_SURFACE_CONTRACTION_JOINT_THERMAL_FRICTION_MPP

*CONTACT_SURFACE_TO_SURFACE_CONTRACTION_JOINT_THERMAL

*CONTACT_SURFACE_TO_SURFACE_CONTRACTION_JOINT_THERMAL_MPP

*CONTACT_SURFACE_TO_SURFACE

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE_MPP

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE_THERMAL_FRICTION

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE_THERMAL_FRICTION_MPP

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE_THERMAL

*CONTACT_SURFACE_TO_SURFACE_INTERFERENCE_THERMAL_MPP

*CONTACT_SURFACE_TO_SURFACE_MPP

*CONTACT_SURFACE_TO_SURFACE_SMOOTH

*CONTACT_SURFACE_TO_SURFACE_SMOOTH_MPP

*CONTACT_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION

*CONTACT_SURFACE_TO_SURFACE_SMOOTH_THERMAL_FRICTION_MPP

*CONTACT_SURFACE_TO_SURFACE_SMOOTH_THERMAL

*CONTACT_SURFACE_TO_SURFACE_SMOOTH_THERMAL_MPP

*CONTACT_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_SURFACE_TO_SURFACE_THERMAL

*CONTACT_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_TIEBREAK_NODES_TO_SURFACE

*CONTACT_TIEBREAK_NODES_TO_SURFACE_MPP

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE_MPP

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE_THERMAL_FRICTION

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE_THERMAL_FRICTION_MPP

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE_THERMAL

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE_THERMAL_MPP

*CONTACT_TIED_NODES_TO_SURFACE_CONSTRAINED_OFFSET

*CONTACT_TIED_NODES_TO_SURFACE_CONSTRAINED_OFFSET_MPP
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*CONTACT_TIED_NODES_TO_SURFACE

*CONTACT_TIED_NODES_TO_SURFACE_MPP

*CONTACT_TIED_NODES_TO_SURFACE_OFFSET

*CONTACT_TIED_NODES_TO_SURFACE_OFFSET_MPP

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_BEAM_OFFSET

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_BEAM_OFFSET_MPP

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_CONSTRAINED_OFFSET

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_CONSTRAINED_OFFSET_MPP

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_MPP

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_OFFSET

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE_OFFSET_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_CONSTRAINED_OFFSET_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_CONSTRAINED_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_CONSTRAINED_OFFSET_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_OFFSET_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_CONSTRAINED_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_CONSTRAINED_OFFSET_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_FRICTION_CONSTRAINED_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_FRICTION_CONSTRAINED_OFFSET_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_FRICTION

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_FRICTION_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_FRICTION_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_FRICTION_OFFSET_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_FAILURE_THERMAL_OFFSET_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE

*CONTACT_TIED_SURFACE_TO_SURFACE_MPP

*CONTACT_TIED_SURFACE_TO_SURFACE_OFFSET

*CONTACT_TIED_SURFACE_TO_SURFACE_OFFSET_MPP
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*CONTROL_MPP_IO_NOD3DUMP

*CONTROL_MPP_IO_NODUMP

*CONTROL_MPP_IO_NOFULL
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*CONTROL_RIGID

*CONTROL_SHELL
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*CONTROL_STRUCTURED
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*DATABASE_BINARY_D3CRACK

*DATABASE_BINARY_D3DRLF

*DATABASE_BINARY_D3DUMP
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*DATABASE_BINARY_D3PROP

*DATABASE_BINARY_D3THDT

*DATABASE_BINARY_DEMFOR

*DATABASE_BINARY_FSIFOR

*DATABASE_BINARY_INTFOR

*DATABASE_BINARY_RUNRSF

*DATABASE_BINARY_XTFILE

*DATABASE_BNDOUT

*DATABASE_CPM_SENSOR

*DATABASE_CROSS_SECTION_PLANE

*DATABASE_CROSS_SECTION_SET

*DATABASE_CURVOUT

*DATABASE_DCFAIL

*DATABASE_DEFGEO
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*DATABASE_DISBOUT

*DATABASE_ELOUT

*DATABASE_EXTENT_AVS

*DATABASE_EXTENT_BINARY

*DATABASE_EXTENT_BINARY_COMP
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*DATABASE_FSI_SENSOR
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*DATABASE_HISTORY_DISCRETE_SET

*DATABASE_HISTORY_NODE
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*DATABASE_MOVIE
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*DATABASE_NCFORC_FILTER

*DATABASE_NODAL_FORCE_GROUP
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*DATABASE_SSSTAT
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*DATABASE_SWFORC

*DATABASE_TPRINT

*DATABASE_TRACER
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*DATABASE_TRHIST

*DEFINE_ALEBAG_BAG

*DEFINE_ALEBAG_HOLE

*DEFINE_ALEBAG_INFLATOR

*DEFINE_BOX

*DEFINE_BOX_ADAPTIVE

*DEFINE_BOX_ADAPTIVE_LOCAL

*DEFINE_BOX_COARSEN

*DEFINE_BOX_COARSEN_LOCAL

*DEFINE_BOX_DRAWBEAD

*DEFINE_BOX_LOCAL

*DEFINE_BOX_SPH

*DEFINE_BOX_SPH_LOCAL

*DEFINE_CONNECTION_PROPERTIES

*DEFINE_CONNECTION_PROPERTIES_ADD

*DEFINE_COORDINATE_NODES

*DEFINE_COORDINATE_SYSTEM

*DEFINE_COORDINATE_VECTOR

*DEFINE_CPM_BAG_INTERACTION

*DEFINE_CPM_CHAMBER

*DEFINE_CPM_GAS_PROPERTIES

*DEFINE_CPM_VENT

*DEFINE_CURVE

*DEFINE_CURVE_FEEDBACK

*DEFINE_CURVE_FUNCTION

*DEFINE_CURVE_SMOOTH

*DEFINE_CURVE_TRIM

*DEFINE_CURVE_TRIM_3D

*DEFINE_FRICTION

*DEFINE_FUNCTION

*DEFINE_HEX_SPOTWELD_ASSEMBLY

*DEFINE_SD_ORIENTATION

*DEFINE_STOCHASTIC_VARIATION
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*DEFINE_TABLE_2D

*DEFINE_TABLE_3D

*DEFINE_TRANSFORMATION

*DEFINE_VECTOR
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*DEFORMABLE_TO_RIGID

*DEFORMABLE_TO_RIGID_AUTOMATIC

*DEFORMABLE_TO_RIGID_INERTIA

*ELEMENT_BEAM

*ELEMENT_BEAM_ORIENTATION

*ELEMENT_BEAM_PID

*ELEMENT_BEAM_PID_ORIENTATION

*ELEMENT_BEAM_PID_SCALAR

*ELEMENT_BEAM_PID_SCALR

*ELEMENT_BEAM_SCALAR

*ELEMENT_BEAM_SCALAR_ORIENTATION

*ELEMENT_BEAM_SCALR

*ELEMENT_BEAM_SCALR_ORIENTATION

*ELEMENT_BEAM_SECTION

*ELEMENT_BEAM_SECTION_ORIENTATION

*ELEMENT_BEAM_SECTION_PID

*ELEMENT_BEAM_THICKNESS

*ELEMENT_BEAM_THICKNESS_ORIENTATION

*ELEMENT_BEAM_THICKNESS_PID

*ELEMENT_BEAM_THICKNESS_SCALAR

*ELEMENT_DISCRETE

*ELEMENT_DISCRETE_LCO

*ELEMENT_INERTIA

*ELEMENT_INERTIA_OFFSET

*ELEMENT_MASS

*ELEMENT_MASS_NODE_SET

*ELEMENT_MASS_PART

*ELEMENT_MASS_PART_SET

*ELEMENT_PLOTEL

*ELEMENT_SEATBELT

*ELEMENT_SEATBELT_ACCELEROMETER

*ELEMENT_SEATBELT_PRETENSIONER

*ELEMENT_SEATBELT_RETRACTOR

*ELEMENT_SEATBELT_SENSOR

*ELEMENT_SEATBELT_SLIPRING

*ELEMENT_SHELL

*ELEMENT_SHELL_BETA

*ELEMENT_SHELL_BETA_OFFSET

*ELEMENT_SHELL_BETA_COMPOSITE_LONG
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*ELEMENT_SHELL_COMPOSITE

*ELEMENT_SHELL_COMPOSITE_LONG

*ELEMENT_SHELL_MCID

*ELEMENT_SHELL_MCID_COMPOSITE_LONG

*ELEMENT_SHELL_MICD_OFFSET

*ELEMENT_SHELL_OFFSET

*ELEMENT_SHELL_SHL4_TO_SHL8

*ELEMENT_SHELL_THICKNESS

*ELEMENT_SHELL_THICKNESS_BETA

*ELEMENT_SHELL_THICKNESS_BETA_OFFSET

*ELEMENT_SHELL_THICKNESS_MCID

*ELEMENT_SHELL_THICKNESS_MCID_OFFSET

*ELEMENT_SOLID

*ELEMENT_SOLID_ORTHO

*ELEMENT_SOLID_TET4TOTET10

*ELEMENT_SOLID_H20

*ELEMENT_SOLID_H8TOH20

*ELEMENT_SPH

*ELEMENT_TSHELL

*ELEMENT_TSHELL 6N

*ELEMENT_TSHELL 8N

*END

*EOS_GRUNEISEN

*EOS_IDEAL_GAS
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*EOS_JWL
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*EOS_SACK_TUESDAY

*EOS_TABULATED

*EOS_TABULATED_COMPACTION

*EOS_TENSOR_PORE_COLLAPSE

*HOURGLASS

*INCLUDE

*INCLUDE_PATH

*INCLUDE_TRANSFORM

*INCLUDE_STAMPED_PART
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*INTEGRATION_BEAM
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*INTERFACE_COMPONENT_SEGMENT
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*INTERFACE_SPRINGBACK_LSDYNA_NOTHICKNESS

*INTERFACE_SPRINGBACK_LSDYNA_THICKNESS

*INTERFACE_SPRINGBACK_NASTRAN
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*INTERFACE_SPRINGBACK_SEAMLESS_THICKNESS

*KEYWORD

*KEYWORD_ID
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*LOAD_BEAM_SET

*LOAD_BLAST
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*LOAD_BODY_PARTS
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*LOAD_BODY_RY

*LOAD_BODY_RZ

*LOAD_BODY_VECTOR

*LOAD_BODY_X

*LOAD_BODY_Y

*LOAD_BODY_Z

*LOAD_BRODE

*LOAD_GRAVITY_PART

*LOAD_GRAVITY_PART_SET

*LOAD_MASK

*LOAD_NODE_POINT

*LOAD_NODE_SET

*LOAD_RIGID_BODY

*LOAD_SEGMENT

*LOAD_SEGMENT_SET

*LOAD_SHELL_ELEMENT

*LOAD_SHELL_SET
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*LOAD_THERMAL_VARIABLE

*LOAD_THERMAL_VARIABLE_NODE

*NODE

*NODE_RIGID_SURFACE

*NODE_TRANSFORM

*PARAMETER

*PARAMETER_LOCAL

*PARAMETER_EXPRESSION

*PARAMETER_EXPRESSION_LOCAL

*PART

*PART_COMPOSITE

*PART_COMPOSITE_CONTACT

*PART_COMPOSITE_LONG
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*PART_CONTACT
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*RIGIDWALL_GEOMETRIC_FLAT(FINITE)

*RIGIDWALL_GEOMETRIC_FLAT_DISPLAY(FINITE)

*RIGIDWALL_GEOMETRIC_FLAT_DISPLAY
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*RIGIDWALL_GEOMETRIC_PRISM(FINITE)

*RIGIDWALL_GEOMETRIC_PRISM_DISPLAY(FINITE)
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*SECTION_SHELL_XFEM

*SECTION_SOLID
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*SECTION_SPH

*SECTION_SPH_USER

*SECTION_TSHELL

*SENSOR_CONTROL
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*SENSOR_SWITCH
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*SET_BEAM_ADD

*SET_BEAM_COLLECT

*SET_BEAM_COLLECT(MASTER)

*SET_BEAM_GENERAL
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*SET_BEAM_GENERATE

*SET_BEAM_GENERATE_COLLECT
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*SET_DISCRETE_GENERAL

*SET_DISCRETE_GENERATE
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*SET_NODE_ADD
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*SET_PART_ADD

*SET_PART_COLUMN

*SET_PART_COLUMN_COLLECT

*SET_PART_LIST

*SET_PART_LIST_COLLECT

*SET_PART_LIST_GENERATE

*SET_PART_LIST_GENERATE_COLLECT

*SET_PART_COLLECT(MASTER)

*SET_SEGMENT

*SET_SEGMENT_GENERAL

*SET_SHELL_LIST

*SET_SHELL_LIST_COLLECT

*SET_SHELL_ADD

*SET_SHELL_COLUMN

*SET_SHELL_GENERAL

*SET_SHELL_LIST_GENERATE

*SET_SOLID

*SET_SOLID_ADD

*SET_SOLID_GENERAL

*SET_SOLID_GENERATE

*SET_TSHELL

*SET_TSHELL_GENERAL

*SET_TSHELL_GENERATE

*SET_TSHELL_ADD

*STRESS_INITIALIZATION
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*STRESS_INITIALIZATION_SEATBELT
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*TERMINATION_BODY
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*TERMINATION_DELETED_SHELLS_SET
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*TITLE
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*MAT_ADD_COHESIVE

*MAT_ADD_EROSION

*MAT_ADD_FATIGUE

*MAT_ADD_GENERALIZED_DAMAGE

*MAT_ADD_PERMEABILITY

*MAT_ADD_PORE_AIR

*MAT_ADD_THERMAL_EXPANSION

001 - *MAT_ELASTIC

001 - *MAT_ELASTIC_FLUID

002_ANIS - *MAT_ANISOTROPIC_ELASTIC (*MAT_002_ANIS)

002 - *MAT_ORTHOTROPIC_ELASTIC (*MAT_002)

003 - *MAT_PLASTIC_KINEMATIC

004 - *MAT_ELASTIC_PLASTIC_THERMAL

005 - *MAT_SOIL_AND_FOAM

006 - *MAT_VISCOELASTIC

007 - *MAT_BLATZ-KO_RUBBER

008 - *MAT_HIGH_EXPLOSIVE_BURN

009 - *MAT_NULL

010 - *MAT_ELASTIC_PLASTIC_HYDRO

010 - *MAT_ELASTIC_PLASTIC_HYDRO_SPALL

011 - *MAT_STEINBERG

011 - *MAT_STEINBERG_LUND

012 - *MAT_ISOTROPIC_ELASTIC_PLASTIC

013 - *MAT_ISOTROPIC_ELASTIC_FAILURE

014 - *MAT_SOIL_AND_FOAM_FAILURE

015 - *MAT_JOHNSON_COOK

015 - *MAT_JOHNSON_COOK_STOCHASTIC

016 - *MAT_PSEUDO_TENSOR

017 - *MAT_ORIENTED_CRACK

018 - *MAT_POWER_LAW_PLASTICITY

019 - *MAT_STRAIN_RATE_DEPENDENT_PLASTICITY

020 - *MAT_RIGID

021 - *MAT_ORTHOTROPIC_THERMAL

021 - *MAT_ORTHOTROPIC_THERMAL_CURING

021 - *MAT_ORTHOTROPIC_THERMAL_FAILURE

022 - *MAT_COMPOSITE_DAMAGE

023 - *MAT_TEMPERATURE_DEPENDENT_ORTHOTROPIC

024 - *MAT_PIECEWISE_LINEAR_PLASTICITY

024 - *MAT_PIECEWISE_LINEAR_PLASTICITY_HAZ
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024 - *MAT_PIECEWISE_LINEAR_PLASTICITY_LOG_INTERPOLATION

024 - *MAT_PIECEWISE_LINEAR_PLASTICITY_MIDFAIL

024 - *MAT_PIECEWISE_LINEAR_PLASTICITY_STOCHASTIC

025 - *MAT_GEOLOGIC_CAP_MODEL

026 - *MAT_HONEYCOMB

027 - *MAT_MOONEY-RIVLIN_RUBBER

028 - *MAT_RESULTANT_PLASTICITY

029 - *MAT_FORCE_LIMITED

030 - *MAT_SHAPE_MEMORY

031 - *MAT_FRAZER_NASH_RUBBER_MODEL

032 - *MAT_LAMINATED_GLASS

033 - *MAT_BARLAT_ANISOTROPIC_PLASTICITY

033_96 - *MAT_BARLAT_YLD96

034 - *MAT_FABRIC

034M - *MAT_FABRIC_MAP

036 - *MAT_3-PARAMETER_BARLAT

036 - *MAT_3-PARAMETER_BARLAT_NLP

037 - *MAT_TRANSVERSELY_ANISOTROPIC_ELASTIC_PLASTIC

037 - *MAT_TRANSVERSELY_ANISOTROPIC_ELASTIC_PLASTIC_ECHANGE

037 - *MAT_TRANSVERSELY_ANISOTROPIC_ELASTIC_PLASTIC_NLP_FAILURE

038 - *MAT_BLATZ-KO_FOAM

039 - *MAT_FLD_TRANSVERSELY_ANISOTROPIC

040 - *MAT_NONLINEAR_ORTHOTROPIC

041-050- *MAT_USER_DEFINED_MATERIAL_MODELS

051 - *MAT_BAMMAN

052 - *MAT_BAMMAN_DAMAGE

053 - *MAT_CLOSED_CELL_FOAM

054-055 - *MAT_ENHANCED_COMPOSITE_DAMAGE

057 - *MAT_LOW_DENSITY_FOAM

058 - *MAT_LAMINATED_COMPOSITE_FABRIC

059 - *MAT_COMPOSITE_FAILURE_SHELL_MODEL

059 - *MAT_COMPOSITE_FAILURE_SOLID_MODEL

059 - *MAT_COMPOSITE_FAILURE_SPH_MODEL

060 - *MAT_ELASTIC_WITH_VISCOCITY

060C- *MAT_ELASTIC_WITH_VISCOSITY_CURVE

061 - *MAT_KELVIN-MAXWELL_VISCOELASTIC

062 - *MAT_VISCOUS_FOAM

063 - *MAT_CRUSHABLE_FOAM

064 - *MAT_RATE_SENSITIVE_POWERLAW_PLASTICITY
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065 - *MAT_MODIFIED_ZERILLI_ARMSTRONG

066 - *MAT_LINEAR_ELASTIC_DISCRETE_BEAM

067 - *MAT_NONLINEAR_ELASTIC_DISCRETE_BEAM

068 - *MAT_NONLINEAR_PLASTIC_DISCRETE_BEAM

069 - *MAT_SID_DAMPER_DISCRETE_BEAM

070 - *MAT_HYDRAULIC_GAS_DAMPER_DISCRETE

071 - *MAT_CABLE_DISCRETE_BEAM

072 - *MAT_CONCRETE_DAMAGE

072R3 - *MAT_CONCRETE_DAMAGE_REL3

073 - *MAT_LOW_DENSITY_VISCOUS_FOAM

074 - *MAT_ELASTIC_SPRING_DISCRETE_BEAM

075 - *MAT_BILKU-DUBOIS_FOAM

076 - *MAT_GENERAL_VISCOELASTIC

077_H - *MAT_HYPERELASTIC_RUBBER

077_O - *MAT_OGDEN_RUBBER

078 - *MAT_SOIL_CONCRETE

079 - *MAT_HYSTERETIC_SOIL

081,082 - *MAT_PLASTICITY_WITH_DAMAGE

081,082 - *MAT_PLASTICITY_WITH_DAMAGE_ORTHO

081,082 - *MAT_PLASTICITY_WITH_DAMAGE_ORTHO_RCDC

081,082 - *MAT_PLASTICITY_WITH_DAMAGE_STOCHASTIC

083 - *MAT_FU_CHANG_FOAM

083 - *MAT_FU_CHANG_FOAM_DAMAGE_DECAY

083 - *MAT_FU_CHANG_FOAM_LOG_LOG_INTERPOLATION

084_085 - *MAT_WINFRITH_CONCRETE

086 - *MAT_ORTHOTROPIC_VISCOELASTIC

087 - *MAT_CELLULAR_RUBBER

088 - *MAT_MTS

089 - *MAT_PLASTICITY_POLYMER

090- *MAT_ACOUSTIC

093 - *MAT_ELASTIC_6DOF_SPRING_DISCRETE_BEAM

094 - *MAT_INELASTIC_SPRING_DISCRETE_BEAM

095 - *MAT_INELASTIC_6DOF_SPRING_DISCRETE_BEAM

096 - *MAT_BRITTLE_DAMAGE

097 - *MAT_GENERAL_JOINT_DISCRETE_BEAM

098 - *MAT_SIMPLIFIED_JOHNSON_COOK

098 - *MAT_SIMPLIFIED_JOHNSON_COOK_STOCHASTIC

099 - *MAT_SIMPLIFIED_JOHNSON_COOK_ORTHOTROPIC_DAMAGE

100 - *MAT_SPOTWELD
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100 - *MAT_SPOTWELD_DAMAGE-FAILURE

100_DA - *MAT_SPOTWELD_DAIMLERCHRYSLER

101 - *MAT_GEPLASTIC_SRATE_2000a

103 - *MAT_ANISOTROPIC_VISCOPLASTIC

103P - *MAT_ANISOTROPIC_PLASTIC

104 - *MAT_DAMAGE_1

105 - *MAT_DAMAGE_2

106 - *MAT_ELASTIC_VISCOPLASTIC_THERMAL

110 - *MAT_JOHNSON_HOLMQUIST_CERAMICS

111 - *MAT_JOHNSON_HOLMQUIST_CONCRETE

112 - *MAT_FINITE_ELASTIC_STRAIN_PLASTICITY

113 - *MAT_TRIP

114 - *MAT_LAYERED_LINEAR_PLASTICITY

115 - *MAT_UNIFIED_CREEP

115_O - *MAT_UNIFIED_CREEP_ORTHO

116 - *MAT_COMPOSITE_LAYUP

117 - *MAT_COMPOSITE_MATRIX

119 - *MAT_GENERAL_NONLINEAR_6DOF_DISCRETE_BEAM

120 - *MAT_GURSON

120B - *MAT_GURSON_JC

120C - *MAT_GURSON_RCDC

121 - *MAT_GENERAL_NONLINEAR_1DOF_DISCRETE_BEAM

122 - *MAT_HILL_3R

122_3D - *MAT_HILL_3R_3D

123 - *MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY

123 - *MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY_RATE

123 - *MAT_MODIFIED_PIECEWISE_LINEAR_PLASTICITY_RTCL

124 - *MAT_PLASTICITY_COMPRESSION_TENSION

125 - *MAT_KINEMATIC_HARDENING_TRANSVERSELY_ANISOTROPIC

125 - *MAT_KINEMATIC_HARDENING_TRANSVERSELY_ANISOTROPIC_NLP

126 - *MAT_MODIFIED_HONEYCOMB

127 - *MAT_ARRUDA_BOYCE_RUBBER

130 - *MAT_SPECIAL_ORTHOTROPIC

133 - *MAT_BARLAT_YLD2000

135 - *MAT_WTM_STM

135 - *MAT_WTM_STM_PLC

136 - *MAT_CORUS_VEGTER

138 - *MAT_COHESIVE_MIXED_MODE

140 - *MAT_VACUUM
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141 - *MAT_RATE_SENSITIVE_POLYMER

142 - *MAT_TRANSVERSELY_ANISOTROPIC_CRUSHABLE_FOAM

143 - *MAT_WOOD

143 - *MAT_WOOD_FIR

143 - *MAT_WOOD_PINE

145 - *MAT_SCHWER_MURRAY_CAP_MODEL

146 - *MAT_1DOF_GENERALIZED_SPRING

148 - *MAT_GAS_MIXTURE

151 - *MAT_EMMI

154 - *MAT_DESHPANDE_FLECK_FOAM

155 - *MAT_PLASTICITY_COMPRESSION_TENSION_EOS

157 - *MAT_ANISOTROPIC_ELASTIC_PLASTIC

159 - *MAT_CSCM

159 - *MAT_CSCM_CONCRETE

160 - *MAT_ALE_INCOMPRESSIBLE

161 - *MAT_COMPOSITE_MSC

162 - *MAT_COMPOSITE_MSC_DMG

163 - *MAT_MODIFIED_CRUSHABLE_FOAM

165 - *MAT_PLASTIC_NONLINEAR_KINEMATIC

165B - *MAT_PLASTIC_NONLINEAR_KINEMATIC_B

166 - *MAT_MOMENT_CURVATURE_BEAM

168 - *MAT_POLYMER

169 - *MAT_ARUP_ADHESIVE

170 - *MAT_RESULTANT_ANISOTROPIC

172 - *MAT_CONCRETE_EC2

177 - *MAT_HILL_FOAM

178 - *MAT_VISCOELASTIC_HILL_FOAM

179 - *MAT_LOW_DENSITY_SYNTHETIC_FOAM

179 - *MAT_LOW_DENSITY_SYNTHETIC_FOAM_WITH_FAILURE

180 - *MAT_LOW_DENSITY_SYNTHETIC_FOAM_ORTHO

180 - *MAT_LOW_DENSITY_SYNTHETIC_FOAM_ORTHO_WITH_FAILURE

181 - *MAT_SIMPLIFIED_RUBBER_FOAM

181 - *MAT_SIMPLIFIED_RUBBER_FOAM_LOG_LOG_INTERPOLATION

181 - *MAT_SIMPLIFIED_RUBBER_FOAM_WITH_FAILURE

183 - *MAT_SIMPLIFIED_RUBBER_WITH_DAMAGE

183 - *MAT_SIMPLIFIED_RUBBER_WITH_DAMAGE_LOG_LOG_INTERPOLATION

184 - *MAT_COHESIVE_ELASTIC

185 - *MAT_COHESIVE_TH

186 - *MAT_COHESIVE_GENERAL
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187 - *MAT_SAMP-1

188 - *MAT_THERMO_ELASTO_VISCOPLASTIC_CREEP

189 - *MAT_ANISOTROPIC_THERMOELASTIC

190 - *MAT_FLD_3-PARAMETER_BARLAT

191 - *MAT_SEISMIC_BEAM

196 - *MAT_GENERAL_SPRING_DISCRETE_BEAM

202 - *MAT_STEEL_EC3

208 - *MAT_BOLT_BEAM

214 - *MAT_DRY_FABRIC

219 - *MAT_CODAM2

220 - *MAT_RIGID_DISCRETE

221 - *MAT_ORTHOTROPIC_SIMPLIFIED_DAMAGE

224 - *MAT_TABULATED_JOHNSON_COOK

224_GYS - *MAT_TABULATED_JOHNSON_COOK_GYS

225 - *MAT_VISCOPLASTIC_MIXED_HARDENING

226 - *MAT_KINEMATIC_HARDENING_BARLAT89

230 - *MAT_PML_ELASTIC

230 - *MAT_PML_ELASTIC_FLUID

234 - *MAT_VISCOELASTIC_LOOSE_FABRIC

235 - *MAT_MICROMECHANICS_DRY_FABRIC

240 - *MAT_COHESIVE_MIXED_MODE_ELASTOPLASTIC_RATE

241 - *MAT_JOHNSON_HOLMQUIST_JH1

242 - *MAT_KINEMATIC_HARDENING_BARLAT2000

243 - *MAT_HILL_90

244 - *MAT_UHS_STEEL

248 - *MAT_PHS_BMW

249 - *MAT_REINFORCED_THERMOPLASTIC

251 - *MAT_TAILORED_PROPERTIES

252 - *MAT_TOUGHENED_ADHESIVE_POLYMER

254 - *MAT_GENERALIZED_PHASE_CHANGE

255 - *MAT_PIECEWISE_LINEAR_PLASTIC_THERMAL

260A - *MAT_STOUGHTON_NON_ASSOCIATED_FLOW

260A - *MAT_STOUGHTON_NON_ASSOCIATED_FLOW_XUE

260B - *MAT_MOHR_NON_ASSOCIATED_FLOW

260B - *MAT_MOHR_NON_ASSOCIATED_FLOW_XUE

261 - *MAT_LAMINATED_FRACTURE_DAIMLER_PINHO

262 - *MAT_LAMINATED_FRACTURE_DAIMLER_CAMANHO

270 - *MAT_CWM

271 - *MAT_POWDER
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274 - *MAT_PAPER

275 - *MAT_SMOOTH_VISCOELASTIC_VISCOPLASTIC

277 - *MAT_ADHESIVE_CURING_VISCOELASTIC

279 - *MAT_COHESIVE_PAPER

280 - *MAT_GLASS

B01 - *MAT_SEATBELT

S1 - *MAT_SPRING_ELASTIC

S2 - *MAT_DAMPER_VISCOUS

S3 - *MAT_SPRING_ELASTOPLASTIC

S4 - *MAT_SPRING_NONLINEAR_ELASTIC

S5 - *MAT_DAMPER_NONLINEAR_VISCOUS

S6 - *MAT_SPRING_GENERAL_NONLINEAR

S7 - *MAT_SPRING_MAXWELL

S8 - *MAT_SPRING_INELASTIC

T1 - *MAT_THERMAL_ISOTROPIC

T10- *MAT_THERMAL_ISOTROPIC_TD_LC

T2 - *MAT_THERMAL_ORTHOTROPIC

U1 - *MAT_UNSUPPORTED

MADYMO
ACTUATOR

AIRBAG_CHAMBER

AMPLIFICATION.ABS_POLY

AMPLIFICATION.EXP

AMPLIFICATION.LOG

AMPLIFICATION.POLY

ANIMATION

BELT

BELT_FUSE

BELT_RETRACTOR

BELT_SEGMENT

BELT_TYING

BODY.DEFORMABLE

BODY.FLEXIBLE_BEAM

BODY.RIGID

CHAR_MOD

CHARACTERISTIC.CONTACT

CHARACTERISTIC.LOAD

CHARACTERISTIC.MATERIAL

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.596

COMP_SIX_DOF

COMPONENT

CONNECT_N2

CONNECT_N3

CONSTRAINT.LINEAR

CONSTRAINT.RIGID_FE

CONSTRAINT.SIMPLE

CONTACT_EVALUATE

CONTACT.FE_FE

CONTACT_FORCE

CONTACT.MB_FE

CONTACT.MB_MB

CONTROL_AIRBAG

CONTROL_ALLOCATION

CONTROL_ANALYSIS

CONTROL_FE_MODEL

CONTROL_FE_TIME_STEP

CONTROL_IMM

CONTROL_OUTPUT

CONTROL_SYSTEM

CONTROLLER

COORDINATE.CARTESIAN

COORDINATE_REF.CARTESIAN

COUPLING_BODY

COUPLING_SURFACE

DAMAGE

ELEMENT.MASS1

EQUATION.MASTER

EQUATION.SLAVE

FE_CRDSYS

FE_MODEL

FUNC_MOD

FUNCTION.XY

GAS

GAS_FLOW_GRID

GAS_MIXTURE

GAS_MIXTURE_VARIABLE

GROUP_FE

GROUP_MB
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HOLE

HOLE_AREA

HOLE_SUBSEGMENT

INFLATOR

INFLATOR.CHAR

INFLATOR.DEF

INFLATOR.REF

INJURY

JET

JOINT

LAYER

LOAD

MADYMO

MATERIAL.ANISO

MATERIAL.FABRIC

MATERIAL.FOAM

MATERIAL.HOLE

MATERIAL.HONEYCOMB

MATERIAL.HONEYCOMB_PLASTIC

MATERIAL.HYSISO

MATERIAL.INTERFACE

MATERIAL.ISOLIN

MATERIAL ISOLIN

MATERIAL ISOPLA

MATERIAL.KELVIN1D

MATERIAL.KELVIN1D_NL

MATERIAL.KELVIN3D

MATERIAL KELVIN3D_NL

MATERIAL LINVIS

MATERIAL MOONRIV

MATERIAL NULL

MATERIAL ORTHOLIN

MATERIAL ORTHOLIN_LAYERED

MATERIAL ORTHOPLA

MATERIAL RIGID

MATERIAL SANDWICH

MATERIAL STRAP

MATERIAL TONER

MATERIAL USER
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MATERIAL.VISCO_NL

MODE

MODE_SHAPE

MOTION.NODE

MOTION_STRUCT_FE

OPERATOR

ORIENTATION.MATRIX

ORIENTATION.SCREW_AXIS

ORIENTATION.SUCCESSIVE_ROT

ORIENTATION.VECTOR

OUTPUT_AIRBAG_CHAMBER

OUTPUT_ANIMATION

OUTPUT_BELT

OUTPUT_BODY

OUTPUT_BODY_REL

OUTPUT_CONTACT

OUTPUT_CONTROL_SYSTEM

OUTPUT_CROSS_SECTION

OUTPUT_ELEMENT

OUTPUT_ELEMENT_INITIAL

OUTPUT_ENERGY_FE_MODEL

OUTPUT_JET

OUTPUT_JOINT_CONSTRAINT

OUTPUT_JOINT_DOF

OUTPUT_MARKER

OUTPUT_MOTION_STRUCT

OUTPUT_NODE

OUTPUT_NODE_INITIAL

OUTPUT_RESTRAINT

OUTPUT_SENSOR

OUTPUT_SYSTEM_COG

PART

PERMEABILITY

POINT_OBJECT

POINT_OBJECT_1_MB

POINT_OBJECT_2_MB

POINT_OBJECT_FE

POINT_OBJECT_1_FE

POINT_OBJECT_2_FE
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PORT

PRINT_MARKER

PRINT_OUTPUT_FE

PROPERTY.BEAM2_BOX

PROPERTY.BEAM2_CIRCULAR

PROPERTY.BEAM2_DISCRETE

PROPERTY.BEAM2_GENERAL

PROPERTY2.BEAM2_PIPE

PROPERTY.BEAM2_RECTANGULAR

PROPERTY.BEAM2_USER

PROPERTY.FACET6

PROPERTY.INTERFACE4

PROPERTY.MEM3

PROPERTY.MEM3_LAYERED

PROPERTY.MEM3NL

PROPERTY.MEM3NL_LAYERED

PROPERTY.MEM4

PROPERTY.MEM4NL

PROPERTY.SHELL3

PROPERTY.SHELL4

PROPERTY.SHELL4_LAYERED

PROPERTY.SHELL6

PROPERTY.SOLID4

PROPERTY.SOLID8

PROPERTY.TRUSS2

PROPERTY.USERL2

PROPERTY.USERL3

PROPERTY.USERP3

PROPERTY.USERP4

PROPERTY.USERV8

RATE

RESTRAINT.CARDAN

RESTRAINT.JOINT

RESTRAINT.KELVIN

RESTRAINT.POINT

RESTRAINT.SIX_DOF

RESULT_ANIMATION_FE

RIGID_ELEMENT

RUNID
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SCALING

SELECT

SENSOR

SIGNAL

SPOTWELD.NODE_NODE

SPOTWELD.THREE_NODE

STATE

STRAP

SUPPORT

SURFACE.CYLINDER

SURFACE.PLANE

SWITCH

SYSTEM.MODEL

SYSTEM.REF_SPACE

TIME_HISTORY_CONTACT

TIME_HISTORY_ENERGY

TIME_HISTORY_FE

TIME_HISTORY_MB

TIME_HISTORY_SYSTEM

USER_INT

Marc
ASSUMED (ASSUMED STRAIN)

AUTO INCREMENT

Body 3D Deformable

Body 3D Rigid

CBUSH

Constant Dilatation

Contact Header

Contact Table

CONTACT_TYPE

Disp_chang

DIST_LOADS

DIST LOADS (CONTROL CARD)

E_1

E_2

E_3

E_5

E_6
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E_7

E_9

E_10

E_11

E_14

E_18

E_20

E_21

E_25

E_26

E_27

E_28

E_29

E_32

E_33

E_34

E_35

E_38

E_39

E_45

E_52

E_53

E_54

E_55

E_57

E_58

E_59

E_60

E_61

E_63

E_64

E_66

E_67

E_68

E_69

E_70

E_74

E_75

E_78
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E_80

E_81

E_82

E_83

E_84

E_89

E_95

E_96

E_98

E_114

E_115

E_116

E_117

E_118

E_119

E_120

E_124

E_125

E_126

E_127

E_128

E_129

E_130

E_134

E_138

E_139

E_140

E_157

E-195

ELSTO

FEATURE

Finite

Fixed_Acce

Fixed_Disp

Fixed_Pres

FOLLOW FOR

FOUNDATION

Init_Disp

INITIAL_vel
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LARGE DISP

MASSES

MAT_FOAM

MAT_ISOTROPIC

MAT_MOONEY

MAT_OGDEN

MAT_ORTHOTROPIC

MOMENT

MPC CHECK

NO LIST

OPTIMIZE

ORIENTATION

OSET

PBUSH

PLASTICITY

POINT_LOAD

POST

PROP_GEOMETRY

RBE

RBE2

RBE3

SHELL SECT

SIZING

SOLVER

SPRING

SUMMARY

TABLE

TIE

TITLE

TYING

tying100

UPDATE

VERSION

Nastran
ACMODL

AECOMP

AECOMPL

AEFACT
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AEFORCE

AELIST

AEPARM

AERO

AEROS

AESTAT

AESURF

ASCRCE

ASET

ASET1

AUTOSPC

B2GG

B2PP

BCBODY

BCBODY1

BCDPRP

BCONECT

BCONPRG

BCONPRP

BCPARA

BCPROP

BCTABLE

BCTABL1

BCTSET

BEGIN BULK

BMFACE

BNDFREE1

BNDFX1

BOLT

BOLTFOR

BSET1

BSURF

BSURFS

BULK-UNSUPPORTED_CARD

CAABSF

CACINF3

CACINF4

CAERO1

CAERO2
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CASE-UNSUPPORTED CARD

CBAR

CBEAM

CBEND

CBUSH

CBUSH1D

CDAMP1

CDAMP2

CDAMP3

CDAMP4

CELAS1

CELAS2

CELAS3

CELAS4

CEND

CFAST

CGAP

CHACAB

CHBDYE

CHBDYP

CHEXA (20-noded)

CHEXA (8-noded)

CMASS1

CMASS2

CMASS3

CMASS4

CONM1

CONM2

CONROD

CONVECTION

CORD1C

CORD1R

CORD1S

CORD2C

CORD2R

CORD2S

CPENTA (6-noded)

CPENTA (15-noded)

CQUAD4
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CQUAD8

CQUADR

CQUADX

CROD

CSET1

CSHEAR

CSUPER

CSUPEXT

CTETRA (4-noded)

CTETRA (10-noded)

CTRIA3

CTRIA6

CTRIAX

CTRIAX6

CTRIAR

CTUBE

CVISC

CWELD

DAMPING

DAREA

DCONADD

DCONSTR

DDVAL

DEFORM

DELAY

DEQATN

DESGLB

DESOBJ

DESSUB

DESVAR

DIAG

DLINK

DLINK2

DLOAD

DOPTPRM

DPHASE

DRESP1

DRESP2

DSCREEN
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DTABLE

DTISPECSEL

DVCREL1

DVCREL2

DVMREL1

DVMREL2

DVPREL1

DVPREL2

ECHO

EIGB

EIGC

EIGP

EIGR

EIGRL

ELIST

ENDDATA

ERP

ERPPNL

EXEC_UNSUPPORTED_CARDS

FLFACT

FLSPOUT

FLUTTER

FLUX

FORCE

FREQ

FREQ1

FREQ2

FREQ3

FREQ4

FREQ5

GENEL

GLOBAL

GLOBAL CASE CONTROL

GLOBAL OUTPUT REQUEST

GRAV

GRDSET

GRID

GUST

HM_ELAS

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Entities and Solver Interfaces p.608

HM_SPRING

HYBDAMP

ID

INCLUDE BULK

INCLUDE_CTRL

INCLUDE_EXEC

K2GG

K2PP

LOAD

LOADSEQ

M2GG

MARCOUT

MAT1

MAT2

MAT4

MAT5

MAT8

MAT9

MAT10

MATEP

MATG

MATHE

MATHP

MATS1

MATT1

MATT4

MAXLINES

MAXMIN

MBOLT

MBOLTUS

MFLUID

MINMAX

MKAERO1

MOMENT

MONDSP1

MONPNT

MONPNT1

MONPNT2

MONPNT3
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MPC

MPCADD

NLAUTO

NLDAMP

NLMOPTS

NLPARM

NLRGAP

NLSTEP

NLSTRAT

NOLIN1

NSMADD

NSM1

NSML1

NTHICK

OMIT1

OMIT_BEGIN_BULK

OMIT_CEND

OMIT_END_BULK

P2G

PAABSF

PACABS

PACBAR

PACINF

PAERO1

PAERO2

PANEL

PARAM

PAXSYMH

PBAR

PBARL

PBEAM

PBEAML

PBEND

PBUSH

PBUSH1D

PBUSHT

PCOMP

PCOMPG

PCONV
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PCONVM

PDAMP

PELAS

PELAST

PFAST

PGAP

PHBDY

PLPLANE

PLOAD

PLOAD1

PLOAD2

PLOAD4

PLOTEL

PLSOLID

PMASS

PROD

PSEAM

PSHEAR

PSHELL

PSHLN1

PSOLID

PRESSURE

PTUBE

PVISC

PWELD

QBDY1

QSET1

QVOL

RADCAV

RADIATION

RADM

RADSET

RANDPS

RBAR

RBE2

RBE3

RESTART

RESVEC

RFORCE
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RIGID

RJOINT

RLOAD1

RLOAD2

ROTORG

RROD

RSPEC

RSPINR

RSPINT

SEBNDRY

SEBSET1

SECSET1

SEQSET1

SESET

SET

SET (Control Card)

SET1

SET3

SEUSET1

SNORM

SOL

SPC

SPC1

SPCADD

SPCD

SPCR

SPBLND1

SPBLND2

SPLINE1

SPLINE2

SPLINE4

SPLINE5

SPLINE6

SPLINE7

SPLINRB

SPRELAX

SPOINT

SUBCASE

SUBCOM
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SUBSEQ

SUBTITLE

SUPORT

SUPORT1

SWLDPRM

TABDMP1

TABLED1

TABLED2

TABLED3

TABLED4

TABLEM1

TABLEM2

TABLEM3

TABLEM4

TABLES1

TABLEST

TABRND1

TEMP

TEMPBC

TEMPD

TIC

TIME

TITLE

TLOAD1

TLOAD2

TRIM

TSTEP

TSTEPNL (Load Collector)

TSTEPNL (Control Card)

USET

USET1

UXVEC

VIEW

VIEW3D

OptiStruct
ACCELERATION

ACCLR

ACMODL
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ACSRCE

ANALYSIS

ASET

ASET1

ASSIGN

AUTOSPC

B2GG

BMFACE

BORE

CAABSF

CAALOAD

CBAR

CBEAM

CBUSH

CBUSH1D

CDAMP1

CDAMP2

CDAMP3

CDAMP4

CDSMETH

CELAS1

CELAS2

CELAS3

CELAS4

CFAST

CGAP

CGAPG

CGASK6

CGASK8

CGASK12

CGASK16

CHACAB

CHBDYE

CHECK

CHEXA (8-noded)

CHEXA (20-noded)

CMASS1

CMASS2

CMASS3
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CMASS4

CMBEAM

CMBUSH

CMBUSHC

CMBUSHE

CMBUSHT

CMSMETH

CMSPDP

CMSPDPC

CMSPDPE

CMSPDPT

CNTSTB

CONM1

CONM2

CONROD

CONTACT

CONTF

CONTPRM

CONV

CORD1C

CORD1R

CORD1S

CORD2C

CORD2R

CORD2S

CORD3R

CORD4R

CPENTA (6-noded)

CPENTA (15-noded)

CPYRA (5-noded)

CPYRA (13-noded)

CQUADR

CQUAD4

CQUAD8

CROD

CSHEAR

CSTRAIN

CSTRESS

CTAXI
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CTETRA (4-noded)

CTETRA (10-noded)

CTRIAR

CTRIAX6

CTRIA3

CTRIA6

CTUBE

CVISC

CWELD

DAMAGE

DAREA

DCOMP

DCONADD

DCONSTR

DDVAL

DEBUG

DEFORM

DENSITY

DENSRES

DEQATN

DESGLB

DESHIS

DESOBJ

DESSUB

DESVAR

DESVARG

DGLOBAL

DISPLACEMENT

DLINK

DLINK2

DLOAD

DMIGNAME

DOBJREF

DOPTPRM

DPENTA6

DQUAD4

DRESP1

DRESP2

DRESP3
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DSCREEN

DSHAPE

DSHUFFLE

DSIZE

DSYSID

DTABLE

DTETRA4

DTI_SPECSEL

DTI_UNITS

DTPG

DTPL

DTRIA3

DVCREL1

DVCREL2

DVGRID

DVMREL1

DVMREL2

DVPREL1

DVPREL2

ECHO

EIGC

EIGRA

EIGRL

EIGVNAME

EIGVRETRIEVE

EIGVSAVE

ELFORCE

ELIST

ENERGY

ERP

ERPPNL

ESE

EXCLUDE

FATDEF

FATEVNT

FATLOAD

FATPARM

FATSEQ

FLLWER
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FLUX

FORCE

FORCE1

FORMAT

FREQ

FREQ1

FREQ2

FREQ3

FREQ4

FREQ5

FREQUENCY

FSI

GAPPRM

GLOBAL_CASE_CONTROL

GLOBSUB

GPFORCE

GPSTRAIN

GPSTRESS

GRAV

GRDSET

GRID

GROUND

HISOUT

HM_ELAS

HMSPRING

HYBDAMP

IC

INCLUDE_BULK

INCLUDE_CTRL

INFILE

INVEL

INVELB

JOINT

K2GG

K2PP

K42GG

LABEL

LIFE

LOAD
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LOADLIB

M2GG

MARKER

MAT1

MAT2

MAT3

MAT4

MAT5

MAT8

MAT9

MAT9ORT

MAT10

MATFAT

MATF1

MATF2

MATF8

MATF9

MATF10

MATHE

MATPE1

MATS1

MATT1

MATT2

MATT4

MATT5

MATT8

MATT9

MATX02

MATX13

MATX27

MATX33

MATX36

MATX42

MATX44

MATX62

MATX65

MATX70

MATX82

MBACT
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MBCNTDS

MBCNTR

MBCRV

MBDCRV

MBDEACT

MBDSRF

MBFORCE

MBFRC

MBFRCC

MBLIN

MBMNT

MBMNTC

MBPCRV

MBREQ

MBREQE

MBREQM

MBSEQ

MBSIM

MBSIMP

MBVAR

METHOD

MGASK

MFLUID

MINMAX

MLOAD

MODEL

MODEWEIGHT

MOMENT

MOMENT1

MOTION

MOTNG

MOTNGC

MPC

MPCADD

MPCFORCE

MPCFORCES

MSGLMT

NESLEXPD

NESLIMPD
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NESLNLGM

NLADAPT

NLOAD (Constraint Load)

NLOAD (Case Control)

NLOAD1

NLOUT

NLPARM

NLPARMX

NSM (Global Case Control Card)

NSMADD

NSM1

NSML1

OFREQUENCY

OLOAD

OMODES

OSDIAG

OTIME

OUTFILE

OUTPUT

P2G

PAABSF

PACABS

PANEL

PANELG

PARAM

PAXI

PBAR

PBARL

PBEAM

PBEAML

PBUSH

PBUSH1D

PCOMP

PCOMPG

PCOMPP

PCONT

PCONTX

PDAMP

PEAKOUT (Control Card)
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PEAKOUT (Load Collector)

PELAS

PFAST

PFAT

PFBODY

PFGRID

PFMODE

PFPANEL

PFPATH

PGAP

PGASK

PLOAD

PLOAD1

PLOAD2

PLOAD4

PLOTEL

PLOTEL3

PLOTEL4

PLY

PMASS

PRBODY

PRESSURE

PROD

PROPERTY

PSHEAR

PSHELL

PSOLID

PTADD

PTUBE

PVISC

PWELD

QBDY1

QVOL

RANDPS

RBAR

RBE2

RBE3

REQUEST

RESPRINT
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RESTART

RESULTS

RESVEC

RFORCE

RGYRO

RLOAD1

RLOAD2

ROTORG

RROD

RSPEC

RSPEC (Case Control)

RSPEED

RSPINR

RWALL (Group)

RWALL (Case Control)

RWALLADD

SCREEN

SDAMPING

SECT

SENSITIVITY

SENSOUT

SET

SET3

SHAPE

SHAPEOPT

SHRES

SOLVTYP

SPC

SPCADD

SPCD

SPCFORCES

SPOINT

STACK

STATSUB

STRAIN

STRESS

SUBCASE

SUBCOM

SUBMODEL
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SUBSEQ

SUBTITLE

SUPORT

SUPORT1

SURF

SWLDPRM

SYSSETTING

TABDMP1

TABFAT

TABLED1

TABLED2

TABLED3

TABLED4

TABLEFAT

TABLEM1

TABLEM2

TABLEM3

TABLEM4

TABLES1

TABLEST

TABRND1

TEMP

TEMPD

THERMAL

THICKNESS

THIN

TIC

TICA

TIE

TITLE

TLOAD1

TLOAD2

TMPDIR

TSTEP

TSTEPNL

TSTEPNX

TTERM

UNBALNC

UNITS
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USET

USET1

VELOCITY

WEIGHT

XDAMP

XHIST (Output Block)

XHIST (Case Control)

XHISTADD

XSHLPRM

XSOLPRM

XSTEP (Load Collector)

PAM-CRASH 2G
ACC3D/

ACFLD/

AIRBAGCHECK

ANALYSIS

AUTOSLEEP

BAGIN/

BAR/

BDFOR/

BDFOR / AFIELD

BDFOR / VOLUME

BDFOR / RADIAL

BDFOR / ROTACC

BDFOR / PRSTRS

BDFOR / PRFORC

BDFOR / PREND

BEAM/

BELTS/

BOUNC/

BSHEL/

CCTRL/

CDATA/

CHAMBER

CHEM/

CKCTRL/

CNODE/

CNTAC/
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CNTAC / NTYPE = 1

CNTAC / NTYPE = 10

CNTAC / NTYPE = 21

CNTAC / NTYPE = 33

CNTAC / NTYPE = 34

CNTAC / NTYPE = 36

CNTAC / NTYPE = 37

CNTAC / NTYPE = 43

CNTAC / NTYPE = 44

CNTAC / NTYPE = 46

CNTAC / NTYPE = 54

CNTAC / NTYPE = 61

CNTAC / NTYPE = 154

CNTPTY/

CONLO/

DAMP/

DAMP / SENSOR

DAMP / TIDAMP

DATACHECK

DCOMP

DEBUG

DELEM/

DIS3D/

DIS3DM/

DIS3DX/

DRAPF/

DRAPP

ECTRL/

EIGEN/

ELINK/

ENDDATA

EOCTRL/

EXPORT/

FILE

FPCTRL/

FPM

FRAME/

FRAME/ IAXIS = 0 (rectangular)

FRAME/ IAXIS = 1 (rectangular)
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FRAME/ IAXIS = 2 (rectangular)

FRAME/ IAXIS = 3 (rectangular)

FRAME/ IAXIS = 4

FRAME/ IAXIS = 5

FRICT/

FRICT / IFROPT = 1

FRICT / IFROPT = 2

FRICT / IFROPT = 3

FRICT / IFROPT = 4

FRICT / IFROPT = 5

FRICT / IFROPT = 6

FRICT / IFROPT = 10

FRICT / IFROPT = 11

FRICT / IFROPT = 12

FUNCT/

FUNCSW/

GASPEC/

GROUP/

HEAT/

ICTRL/

IMPFIL/

IMPORT/

INCLU/

INFLATOR

INPUTVERSION

INTEM/

INVEL/

JOINT/

KJOIN/

KJOIN / JTYP = SPHERICA

KJOIN / JTYP = TRANSLAT

KJOIN / JTYP = REVOLUTE

KJOIN / JTYP = CYLINDRI

KJOIN / JTYP = PLANAR

KJOIN / JTYP = UNIVERSA

KJOIN / JTYP = GENERAL

KJOIN / JTYP = FLEX-TOR

LAYER/

LCTRL/
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LEAKAGE

LINCO/

LLINK/

MASS/

MATER/

MATER / MATYP = 1

MATER / MATYP = 2

MATER / MATYP = 5

MATER / MATYP = 6

MATER / MATYP = 7

MATER / MATYP = 8

MATER / MATYP = 12

MATER / MATYP = 15

MATER / MATYP = 16

MATER / MATYP = 20

MATER / MATYP = 22

MATER / MATYP = 24

MATER / MATYP = 26

MATER / MATYP = 28

MATER / MATYP = 30

MATER / MATYP = 31

MATER / MATYP = 35

MATER / MATYP = 36

MATER / MATYP = 37

MATER / MATYP = 38

MATER / MATYP = 41

MATER / MATYP = 42

MATER / MATYP = 45

MATER / MATYP = 47

MATER / MATYP = 51

MATER / MATYP = 52

MATER / MATYP = 61

MATER / MATYP = 62

MATER / MATYP = 71

MATER / MATYP = 80

MATER / MATYP = 81

MATER / MATYP = 82

MATER / MATYP = 83

MATER / MATYP = 85
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MATER / MATYP = 99

MATER / MATYP = 100

MATER / MATYP = 101

MATER / MATYP = 103

MATER / MATYP = 105

MATER / MATYP = 106

MATER / MATYP = 107

MATER / MATYP = 108

MATER / MATYP = 109

MATER / MATYP = 110

MATER / MATYP = 115

MATER / MATYP = 116

MATER / MATYP = 117

MATER / MATYP = 118

MATER / MATYP = 121

MATER / MATYP = 126

MATER / MATYP = 127

MATER / MATYP = 128

MATER / MATYP = 131

MATER / MATYP = 143

MATER / MATYP = 150

MATER / MATYP = 151

MATER / MATYP = 161

MATER / MATYP = 162

MATER / MATYP = 171

MATER / MATYP = 180

MATER / MATYP = 181

MATER / MATYP = 182

MATER / MATYP = 183

MATER / MATYP = 184

MATER / MATYP = 185

MATER / MATYP = 200

MATER / MATYP = 201

MATER / MATYP = 202

MATER / MATYP = 204

MATER / MATYP = 205

MATER / MATYP = 212

MATER / MATYP = 213

MATER / MATYP = 214
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MATER / MATYP = 220

MATER / MATYP = 221

MATER / MATYP = 222

MATER / MATYP = 223

MATER / MATYP = 224

MATER / MATYP = 225

MATER / MATYP = 226

MATER / MATYP = 230

MATER / MATYP = 301

MATER / MATYP = 302

MATER / MATYP = 303

MATER / MATYP = 304

MATER / MATYP = 305

MATER / MATYP = 371

MATER / MATYP = 380

MAXMEMORY

MBSYS/

MBSYS / H_POINT

MCTRL/

MEMBR/

MERGEGAP

META

METRIC/

METRICCHECK

MSTRM/

MTOCO/

MTOCO / ITMTO = 0

MTOCO / ITMTO = 1

MTOJNT/

NLAVE/

NODE/

NSMAS/

NSMAS2/

OCTRL/

ORTHF/

ORTHP

OTMCO/

PART/

PART / ATYPE = SOLID
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PART / ATYPE = BSHEL

PART / ATYPE = TETRA

PART / ATYPE = SPHEL

PART / ATYPE = COS3D

PART / ATYPE = SHELL

PART / ATYPE = TSHEL

PART / ATYPE = MEMBR

PART / ATYPE = BAR

PART / ATYPE = BEAM

PART / ATYPE = ELINK

PART / ATYPE = GAP

PART / ATYPE = JOINT

PART / ATYPE = KJOIN

PART / ATYPE = LLINK

PART / ATYPE = MBKJN

PART / ATYPE = MBSPR

PART / ATYPE = MTOJNT

PART / ATYPE = PLINK

PART / ATYPE = SLINK

PART / ATYPE = SPRGBM

PART / ATYPE = SPRING

PART / ATYPE = TIED

PENTA6/

PFLOW/

PICEXP/

PICIMP/

PLINK/

PLY/

PLY / ITYP = 0

PLY / ITYP = 1, MATYP = 131

PLY / ITYP = 1, MATYP = 30

PLY / ITYP = 2, SIGMAy

PLY / ITYP = 2, CURVE

PLY / ITYP = 2, POWER

PLY / ITYP = 2, KRUPK

PLY / ITYP = 3, SIGMAy

PLY / ITYP = 3, CURVE

PLY / ITYP = 3, POWER

PLY / ITYP = 3, KRUPK
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PLY / ITYP = 7

PLY / ITYP = 8, MATYP = 131

PLY / FAILINP = 1

PLY / FAILINP = 1, FAILTYP = 0

PLY / FAILINP = 1, FAILTYP = 1

PLY / FAILINP = 1, FAILTYP = 2

PLY / FAILINP = 1, FAILTYP = 3

PLY / FAILINP = 1, FAILTYP = 4

PLY / FAILINP = 1, FAILTYP = 5

PLY / FAILINP = 1, FAILTYP = 6

PLY / FAILINP = 1, FAILTYP = 7

PLY / FAILINP = 1, FAILTYP = 8

PLY / FAILINP = 1, FAILTYP = 9

PLY / FAILINP = 1, FAILTYP = 10

PRCTRL/

PREBM/

PREFA/

PROFILE_DMP

PYFUNC/

PYVAR/

RAC3D/

RAN3D/

RBODY/

RBODY / ITRB = 0

RBODY / ITRB = 1

RBODY / ITRB = 2

RBODY / ITRB = 3

RBODY / ITRB = 4

RDA3D/

RDD3D/

RDV3D/

RVE3D/

RESTARTFILES

RETRA/

RUNEND/

RUPMO/

RUPMO / IRUPT = 0

RUPMO / IRUPT = 1

RUPMO / IRUPT = 2
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RUPMO / IRUPT = 3

RUPMO / IRUPT = 5

RUPMO / IRUPT = 6

RUPMO / IRUPT = 7

RVE3D/

SECFO/

SECFO / NTYP = CONTACT

SECFO / NTYP = LINK

SECFO / NTYP = PLANE

SECFO / NTYP = SECTION

SECFO / NTYP = SUPPORT

SECFO / NTYP = VOLFRAC

SECFO / NTYP = CONT_MS

SECFO / NTYP = DETECT

SECURE/

SECURE/ ENCRYTYP = MATER

SECURE/ ENCRYTYP = PLY

SECURE/ ENCRYTYP = FUNCT

SECURE/ ENCRYTYP = PART

SECURE_NODE_VISU

SENPT/

SENPTG/

SENSOR/

SENSOR/ ITYP = 1

SENSOR/ ITYP = 2

SENSOR/ ITYP = 3

SENSOR/ ITYP = 4

SENSOR/ ITYP = 5

SENSOR/ ITYP = 6

SENSOR/ ITYP = 7

SENSOR/ ITYP = 8

SENSOR/ ITYP = 9

SENSOR/ ITYP = 10

SENSOR/ ITYP = 11

SENSOR/ ITYP = 12

SENSOR/ ITYP = 13

SENSOR/ ITYP = 14

SHELL/

SHELLCHECK
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SIGNAL

SLINK/

SLIPR/

SOLID/

SOLIDCHECK

SOLVER

SPCTRL/

SPHEL/

SPRGBM/

SPRING/

STOPRUN

SUBDF/

SUBRUN

TCTRL/

TEMBC/

TETR4/

TETR10/

THELE/

THLOC/

THNOD/

THNPO/

TIED/

TITLE/

TRSFM/

TSHEL/

UNIT

VEL3D/

Permas
$ADDMODES

$BEAM2

$BECOC

$BECOS

$COMPONENT

$COMPRESS

$CONA3

$CONA4

$CONA6

$CONA8
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$CONDUCTIVITY - materials

$CONDUCTIVITY - loads

$CONLOAD

$CONS3

$CONS4

$CONS6

$CONS8

$CONSTRAINTS

$CONTACT

$CONTVAL

$COOR

$DAMP1

$DAMP3

$DAMP6

$DAMPING

$DENSITY

$DIELECTRIC

$DISLOAD

$DISLOADN

$ECHO

$ELASTIC

$ELCONDUCT

$ELPROP

$ELSYS

$ENTER MATERIAL

$ESET

$ESETBIN

$FLA2

$FLA3

$FLDENS

$FLHEX8

$FLHEX20

$FLPENT6

$FLPENT15

$FLPYR5

$FLTET4

$FLTET10

$FLUID

$FREQLOAD
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$FREQUENCY

$FSINTA3

$FSINTA4

$FSINTA6

$FSINTA8

$FUNCTION

$GASKET

$GEODAT

$GEODAT SPRINGX

$GKHEX8

$GKHEX20

$GKPNT6

$GKPNT15

$GSKLOAD

$GSKUNLOAD

$HARDENING

$HEATCAP

$HEXE8

$HEXE20

$INERTIA

$INERTIAX

$INIVAL

$JOIN

$LAMINATE

$LOADA3

$LOADA4

$LOADA6

$LOADA8

$LOADING

$LOADS

$MASS3

$MASS6

$MATERIAL

$MODDAMP

$MPC ASSIGN

$MPC GENERAL

$MPC ISURFACE

$MPC JOIN

$MPC_RIGID
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$MPC_SAME

$MPC WLDSURFACE

$MPC WLSCON

$MPC WLSSURFACE

$NLDAMP

$NLDAMPR

$NLSTIFF

$NLSTIFFR

$NSET

$NSETBIN

$PENTA15

$PENTA6

$PERMEABILITY

$PLASTIC

$PLOTA3

$PLOTA4

$PLOTA6

$PLOTA8

$PLOTL2

$PLOTL3

$PLY

$POINTS

$PRESCRIBE/PREVAL

$PRETENSION LOAD

$PRETENSION PLANE

$PRETENSION THREAD

$PYRA5

$QUAD4

$QUAM4

$REFSYS

$RIGID

$ROTB

$RSYS

$SAME

$SFSET

$SHEAR4

$SHELL3

$SHELL4

$SITUATION
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$SPRING1

$SPRING3

$SPRING6

$SUPPRESS

$SURFABS

$SURFACE

$SYSTEM

TEMP

TEMPFILM

$TET4

$TET10

$THERMEXP

$TRANSLOAD

$TRIA3

$TRIA3K

$TRIM3

$TRIM6

$TRIMS6

$VOLDRAG

$X1DAMP3

$X1DAMP6

$X1GEN6

$X2GEN6

$X1MASS3

$X1MASS6

$X1STIFF3

$X1STIFF6

$X2DAMP3

$X2DAMP6

$X2GEN6

$X2STIFF3

$X2STIFF6

$YIELD

Samcef
.BOLT

.BOLT_OUTPUT

.BPR

.CLM
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.ETASHELL

.ETASOLID

.FRA

.HYP

.LAM

.MAI

.MCC BUSH

.MCC MEAN

.MCE BUSH

.MCE MEAN

.MAT, ANISOTROPIC

.MAT, ISOTROPIC

.MAT, ORTHOTROPIC

.MCT

.NOE

.PHP SHELL

.PLI

.SEL FACE

.SEL NOE

.SEL MAI

.STI

.SUB

.UNIT

.ZYG

.ZYG_AUTO

Radioss
Radioss Starter

#include

#RADIOSS Starter

/ACCEL

/ACTIV

/ADMAS

/ADMESH/GLOBAL

/ADMESH/SET

/ADMESH/STATE/SH3N

/ADMESH/STATE/SHELL

/ALE/BCS

/ALE/CLOSE
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/ALE/GRID/DISP

/ALE/GRID/DONEA

/ALE/GRID/SPRING

/ALE/GRID/STANDARD

/ALE/GRID/ZERO

/ALE/MAT

/ALE/MUSCL

/AMS

/ANALY

/ANIM/VERS

/ARCH

/BCS

/BEAM

/BEGIN

/BOX

/BRIC20

/BRICK

/CAA

/CLOAD

/CLUSTER

/CNODE

/CYL_JOINT

/DAMP

/DAMP/INTER

/DEF_SHELL

/DEF_SOLID

/DEFAULT/INTER/TYPE11

/DEFAULT/INTER/TYPE19

/DEFAULT/INTER/TYPE2

/DEFAULT/INTER/TYPE24

/DEFAULT/INTER/TYPE7

/DFS/DETCORD

/DFS/DETLINE

/DFS/DETPLAN

/DFS/DETPOIN

/DFS/DETPOIN/NODE

/DFS/DETPLAN/NODE

/DFS/DETLINE/NODE

/DFS/LASER
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/DFS/WAV_SHA

/DRAPE

/END

/EOS/GRUNEISEN

/EOS/POLYNOMIAL

/EOS/PUFF

/EOS/SESAME

/EOS/TILLOTSON

/EOS/NOBEL-ABEL

/EOS/LSZK

/EOS/MURNAGHAN

/EOS/IDEAL-GAS

/EOS/OSBORNE

/EOS/STIFF-GAS

/EREF

/EULER/MAT

/FAIL/BIQUAD

/FAIL/CHANG

/FAIL/CONNECT

/FAIL/EMC

/FAIL/ENERGY

/FAIL/FABRIC

/FAIL/FLD

/FAIL/HASHIN

/FAIL/HC-DSSE

/FAIL/ORTHSTRAIN

/FAIL/JOHNSON

/FAIL/LAD_DAMA

/FAIL/NXT

/FAIL/PUCK

/FAIL/SNCONNECT

/FAIL/SPALLING

/FAIL/TAB1

/FAIL/TBUTCHER

/FAIL/TENSSTRAIN

/FAIL/USERi

/FAIL/WIERZBICKI

/FAIL/WILKINS

/FRAME/FIX
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/FRAME/MOV

/FRAME/MOV2

/FRAME/NOD

/FUNCT

/GAUGE

/GAUGE/SPH

/GRAV

/GRBEAM

/GRBRIC

/GRNOD

/GRPART

/GRQUAD

/GRSH3N

/GRSHEL

/GRSPRI

/GRTRUS

/HEAT/MAT

/IMPACC

/IMPDIS/FGEO

/IMPDISP

/IMPLICIT

/IMPTEMP

/IMPVEL

/IMPVEL/FGEO

/IMPVEL/LAGMUL

/INIBRI

/INIBRI/FILL

/INICRACK

/INIQUA/DENS

/INIQUA/ENER

/INIQUA/EPSP

/INIQUA/STRESS

/INISH3/AUX

/INISH3/EPSP

/INISH3/EPSP_F

/INISH3/ORTH_LOC

/INISH3/ORTHO

/INISH3/STRA_F

/INISH3/STRS_F
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/INISH3/STRS_F/GLOB

/INISH3/THICK

/INISHE/AUX

/INISHE/EPSP

/INISHE/EPSP_F

/INISHE/FAIL

/INISHE/ORTH_LOC

/INISHE/ORTHO

/INISHE/STRA_F

/INISHE/STRS_F

/INISHE/STRS_F/GLOB

/INISHE/THICK

/INISTA

/INITEMP

/INIVEL

/INIVEL/AXIS

/INIVOL

/INTER/LAGMUL/TYPE7

/INTER/SUB

/INTER/TYPE1

/INTER/TYPE10

/INTER/TYPE11

/INTER/TYPE12

/INTER/TYPE14

/INTER/TYPE15

/INTER/TYPE18

/INTER/TYPE19

/INTER/TYPE2

/INTER/TYPE20

/INTER/TYPE21

/INTER/TYPE22

/INTER/TYPE23

/INTER/TYPE24

/INTER/TYPE25

/INTER/TYPE3

/INTER/TYPE5

/INTER/TYPE6

/INTER/TYPE7

/INTER/TYPE8
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/INTER/TYPE9

/IOFLAG

/KEY

/LEAK/MAT

/LINE

/LOAD/CETRI

/LOAD/PFLUID

/MAT/B-K-EPS

/MAT/GAS

/MAT/LAW0 (VOID)

/MAT/LAW1 (ELAST)

/MAT/LAW10 (DPRAG1)

/MAT/LAW11 (BOUND)

/MAT/LAW12 (3D_COMP)

/MAT/LAW14 (COMPSO)

/MAT/LAW15 (CHANG)

/MAT/LAW16 (GRAY)

/MAT/LAW18 (THERM)

/MAT/LAW19 (FABRI)

/MAT/LAW2 (PLAS_JOHNS)

/MAT/LAW2 (PLAS_ZERIL)

/MAT/LAW20 (BIMAT)

/MAT/LAW21 (DPRAG)

/MAT/LAW22 (DAMA)

/MAT/LAW23 (PLAS_DAMA)

/MAT/LAW24 (CONC)

/MAT/LAW25 (COMPSH)

/MAT/LAW3 (HYDRPLA)

/MAT/LAW4 (HYD_JCOOK)

/MAT/LAW5 (JWL)

/MAT/LAW6 (HYDRO)

/MAT/LAW6 (K-EPS)

/MAT/LAW26 (SESAM)

/MAT/LAW27 (PLAS_BRIT)

/MAT/LAW28 (HONEYCOMB)

/MAT/LAW32 (HILL)

/MAT/LAW33 (FOAM_PLAS)

/MAT/LAW34 (BOLTZMAN)

/MAT/LAW35 (FOAM_VISC)
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/MAT/LAW36 (PLAS_TAB)

/MAT/LAW37 (BIPHAS)

/MAT/LAW38 (VISC_TAB)

/MAT/LAW40 (KELVINMAX)

/MAT/LAW41 (LEE-TARVER)

/MAT/LAW42 (OGDEN)

/MAT/LAW43 (HILL_TAB)

/MAT/LAW44 (COWPER)

/MAT/LAW46 (LES_FLUID)

/MAT/LAW48 (ZHAO)

/MAT/LAW49 (STEINB)

/MAT/LAW50 (VISC_HONEY)

/MAT/LAW51 (MULTIMAT)

/MAT/LAW52 (GURSON)

/MAT/LAW53 (TSAI_TAB)

/MAT/LAW54 (PREDIT)

/MAT/LAW57 (BARLAT3)

/MAT/LAW58 (FABRI_A)

/MAT/LAW59 (CONNECT)

/MAT/LAW60 (PLAS_T3)

/MAT/LAW62 (VISC_HYP)

/MAT/LAW63 (HANSEL)

/MAT/LAW64 (UGINE_ALZ)

/MAT/LAW65 (ELASTOMER)

/MAT/LAW66

/MAT/LAW68 (COSSER)

/MAT/LAW69

/MAT/LAW70 (FOAM_TAB)

/MAT/LAW71

/MAT/LAW72 (HILL_MMC)

/MAT/LAW73

/MAT/LAW74

/MAT/LAW75 (POROUS)

/MAT/LAW76 (SAMP)

/MAT/LAW77

/MAT/LAW78

/MAT/LAW79 (JOHN_HOLM)

/MAT/LAW80

/MAT/LAW81
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/MAT/LAW82

/MAT/LAW83

/MAT/LAW84

/MAT/LAW87

/MAT/LAW88

/MAT/LAW90

/MAT/LAW92

/MAT/LAW93 (ORTH_HILL)

/MAT/LAW94 (YEOH)

/MAT/LAW95

/MAT/LAW97 (/MAT/JWLB)

/MAT/LAW100

/MONVOL/AIRBAG1

/MONVOL/AREA

/MONVOL/COMMU1

/MONVOL/FVMBAG1

/MONVOL/GAS

/MONVOL/PRES

/MOVE_FUNCT

/NODE

/PARAMETER

/PART

/PENTA6

/PLOAD

/PLY

/PROP/INJECT1

/PROP/INJECT2

/PROP/PCOMPP

/PROP/TYPE0 (VOID)

/PROP/TYPE1 (SHELL)

/PROP/TYPE2 (TRUSS)

/PROP/TYPE3 (BEAM)

/PROP/TYPE4 (SPRING)

/PROP/TYPE6 (SOL_ORTH)

/PROP/TYPE8 (SPR_GENE)

/PROP/TYPE9 (SH_ORTH)

/PROP/TYPE10 (SH_COMP)

/PROP/TYPE11 (SH_SANDW)

/PROP/TYPE12 (SPR_PUL)
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/PROP/TYPE13 (SPR_BEAM)

/PROP/TYPE14 (FLUID)

/PROP/TYPE14 (SOLID)

/PROP/TYPE15 (POROUS)

/PROP/TYPE16 (SH_FABR)

/PROP/TYPE17 (STACK)

/PROP/TYPE18 (INT_BEAM)

/PROP/TYPE19 (PLY)

/PROP/TYPE20 (TSHELL)

/PROP/TYPE21 (TSH_ORTH)

/PROP/TYPE22 (TSH_COMP)

/PROP/TYPE25 (SPR_AXI)

/PROP/TYPE26 (SPR_TAB)

/PROP/TYPE28 (NSTRAND)

/PROP/TYPE32 (SPR_PRE)

/PROP/TYPE33 (KJOINT)

/PROP/TYPE34 (SPH)

/PROP/TYPE36 (PREDIT)

/PROP/TYPE43 (CONNECT)

/PROP/TYPE44 (SPR_CRUS)

/PROP/TYPE45 (KJOINT2)

/PROP/TYPE46 (SPR_MUSCLE)

/PROP/TYPE51

/QUAD

/RADIATION

/RANDOM

/RBE2

/RBE3

/RBODY

/REFSTA

/RLINK

/RWALL

/RWALL/THERM

/SECT

/SECT/CIRCLE

/SECT/PARAL

/SENSOR

/SH3N

/SHELL
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/SKEW/FIX

/SKEW/MOV

/SKEW/MOV2

/SPH/INOUT

/SPH/RESERVE

/SPHBCS

/SPHCEL

/SPHGLO

/SPMD

/SPRING

/STACK

/STAMPING

//SUBMODEL

/SUBSET

/SURF/BOX

/SURF/DSURF

/SURF/GRBRIC/EXT

/SURF/GRBRIC/FREE

/SURF/GRSH3N

/SURF/GRSHEL

/SURF/MAT

/SURF/MAT/ALL

/SURF/MAT/EXT

/SURF/PART

/SURF/PART/ALL

/SURF/PART/EXT

/SURF/PLANE

/SURF/PROP

/SURF/PROP/ALL

/SURF/PROP/EXT

/SURF/SEG

/SURF/SUBMODEL

/SURF/SUBSET

/SURF/SUBSET/ALL

/SURF/SUBSET/EXT

/SURF/SURF

/TABLE

/TETRA4

/TETRA10
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/TH/ACCEL

/TH/BEAM

/TH/BRIC

/TH/CLUSTER

/TH/CYL_JO

/TH/FRAME

/TH/GAUGE

/TH/INTER

/TH/MONVOL

/TH/NODE

/TH/NSTRAND

/TH/PART

/TH/QUAD

/TH/RBODY

/TH/RWALL

/TH/SECTIO

/TH/SH3N

/TH/SHEL

/TH/SPHCEL

/TH/SPRING

/TH/SUBS

/TH/SURF

/TH/TRUSS

/THERM_STRESS/MAT

/TITLE

/TRANSFORM/MATRIX

/TRANSFORM/ROT

/TRANSFORM/SCA

/TRANSFORM/SYM

/TRANSFORM/TRA

/TRUSS

/UPWIND

/VISC/PRONY

/XELEM

/XREF

Radioss Engine

/@TFILE

/@TFILE/Keyword2

/ABF
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/ALE/GRID/DISP

/ALE/GRID/DONEA

/ALE/GRID/SPRING

/ALE/GRID/STANDARD

/ALE/GRID/ZERO

/ALE/SPRING

/ALE/STANDARD

/ALE/ZERO

/ALESUB

/ANIM/BRICK/DAMA

/ANIM/BRICK/TDEL

/ANIM/BRICK/TDET

/ANIM/BRICK/TENS

/ANIM/BRICK/TENS/STRAIN

/ANIM/BRICK/TENS/STRESS

/ANIM/BRICK/VDAM

/ANIM/CUT/1

/ANIM/CUT/2

/ANIM/CUT/3

/ANIM/DT

/ANIM/Eltyp/FORCE

/ANIM/Eltyp/Restype

/ANIM/ELEM/TDET

/ANIM/QUAD/TDET

/ANIM/ELEM/EINT

/ANIM/GPS/TENS

/ANIM/GPS1

/ANIM/GPS2

/ANIM/GZIP

/ANIM/LSENSOR

/ANIM/MASS

/ANIM/MAT

/ANIM/NODA

/ANIM/SHELL/DAMA

/ANIM/SHELL/EPSP

/ANIM/SHELL/NXTFACTOR

/ANIM/SHELL/PHI

/ANIM/SHELL/SIG1H

/ANIM/SHELL/SIG2H
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/ANIM/SHELL/TDEL

/ANIM/SHELL/TENS

/ANIM/SHELL/IDPLY

/ANIM/SHELL/FLDZ

/AMIN/SHELL/FLDF

/ANIM/SENSOR

/ANIM/TITLE

/ANIM/VECT

/ANIM/VERS

/ATFILE

/BCS/ALE

/BCS/LAG

/BCS/ROT

/BCS/TRA

/BCSR/ALE

/BCSR/LAG

/BCSR/ROT

/BCSR/TRA

/DAMP

/DEL

/DEL/Eltyp/1

/DEL/INTER

/DELINT

/DT

/DT/CST_AMS

/DT/ALE

/DT/AMS

/DT/Eltyp/Iflag

/DT/Eltyp/Keyword3/Iflag

/DT/GLOB

/DT/NODA/Keyword3

/DT/SHELL

/DT/SHNOD

/DT/SPHCEL

/DT/SPHCEL/Keyword3

/DT/THERM

/DT1/SHELL

/DTIX

/DTSDE
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/DYREL

/DYREL/1

/END/ENGINE

/FVMBAG/MODIF

/IMPL/AUTOSPC

/IMPL/BUCKL/1

/IMPL/BUCKL/2

/IMPL/CHECK

/IMPL/DIVERG/n

/IMPL/DT/1

/IMPL/DT/2

/IMPL/DT/3

/IMPL/DT/FIXPOINT

/IMPL/DT/STOP

/IMPL/DTINI

/IMPL/DYNA/1

/IMPL/DYNA/2

/IMPL/DYNA/DAMP

/IMPL/DYNA/FSI

/IMPL/GSTIF/OFF

/IMPL/INTER/KCOMP

/IMPL/INTER/KNONL

/IMPL/LBFGS/L

/IMPL/LINEAR

/IMPL/LINEAR/INTER

/IMPL/LSEARCH/n

/IMPL/LSEARCH/OFF

/IMPL/MONVOL/OFF

/IMPL/NCYCLE/STOP

/IMPL/NONLIN

/IMPL/NONLIN/SMDISP

/IMPL/NONLIN/SOLVINFO

/IMPL/PREPAT

/IMPL/PRINT/LINEAR

/IMPL/PRINT/NONLIN

/IMPL/PSTIF/OFF

/IMPL/QSTAT

/IMPL/QSTAT/DTSCAL

/IMPL/QSTAT/MRIGM
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/IMPL/RREF/INTERF/n

/IMPL/RREF/LIMIT

/IMPL/RREF/OFF

/IMPL/SBCS/MSGLV

/IMPL/SBCS/ORDER

/IMPL/SBCS/OUTCORE

/IMPL/SHPOFF

/IMPL/SHPON

/IMPL/SINIT

/IMPL/SOLVER

/IMPL/SPRBACK

/IMPL/SPRING

/INCMP

/INIV/ROT

/INIV/ROT/Keyword3/1

/INIV/TRA

/INIV/TRA/Keyword3/1

/INTER

/KEREL

/KEREL/1

/KILL

/MADYMO

/MON

/OUTP

/OUTP/LSENSOR

/PARITH

/PRINT

/RAD2RAD/ON

/RERUN

/RBODY

/RFILE

/RFILE/n

/RUN

/RUN/Run Name/Run Number/Restart Letter

/SHSUB

/STATE/BRICK/AUX/FULL

/STATE/BRICK/FAIL

/STATE/BRICK/ORTHO

/STATE/BRICK/STRAIN/FULL
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/STATE/BRICK/STRAIN/GLOBFULL

/STATE/BRICK/STRES/FULL

/STATE/BRICK/STRESS/GLOBFULL

/STATE/DT

/STATE/LSENSOR

/STATE/NO_DEL

/STATE/NODE/TEMP

/STATE/SHELL/AUX/FULL

/STATE/SHELL/EPSP/FULL

/STATE/SHELL/FAIL

/STATE/SHELL/ORTHL

/STATE/SHELL/STRAIN/FULL

/STATE/SHELL/STRESS/FULL

/STATE/STR_FILE

/STOP

/STOP/LSENSOR

/TFILE

/TH/VERS

/THERMAL

/TITLE

/UPWIND

/UPWM/SUPG

/UPWM/TG

/VEL/ALE

/VEL/ROT

/VEL/TRA

/VERS
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CAD Interfaces

Support provided by the CAD readers and writers.

This chapter covers the following:

• CAD Import  (p. 655)

• CAD Export  (p. 857)
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CAD Import
Learn about the CAD readers supported by HyperMesh and the options available for importing CAD
geometry data.

CAD readers are dynamically loaded upon demand.

Supported CAD Readers
CAD readers supported by HyperMesh.

Format Latest Version Supported File Extensions Supported

ACIS r21 .sat

AVEVA Marine TXHSTL-R XML Export v1.3 .xml

CATIA v4

v5-6R2018 (R28)

v6-2015X

CATIA v4

.model

.exp

CATIA v5

.CATProduct

.CATPart

.cgr

CATIA v6

.3dxml

.3DRep

.PLMBriefcase

CATIA Composites Link .h5

Creo 5.0 .prt

.asm

DXF AutoCAD 12 .dxf

FiberSim .h5

IGES
v6.0

JAMA-IS

.iges

.igs
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Format Latest Version Supported File Extensions Supported

Inspire 2018.1 .stmod

Intergraph schema 2013 .xml

Inventor 2018 .ipt

.iam

JT 10.2 .jt

NX 10.0

11.0

12.0

.prt

Parasolid v30.0.185 .x_t

.x_b

.xmt_txt

.xmt_bin

PDGS v26 .fsf

Rhino1 3 .3dm

SolidWorks 2018 .sldasm

.sldprt

.SLDASM

.SLDPRT

STEP AP203

AP214

.step

.stp

VDAFS v2 .vda

.vdafs
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1. Rhino is only supported on Windows.

ACIS Reader

Supported Entities
Entities supported by the ACIS reader.

• Coordinate systems

• Free points

• Free curves

• Surfaces

• Quilt bodies

• Solid bodies

Import Options
The ACIS reader uses the ct_reader.ini file.

@AttributesAsMetadata

Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

@AvoidThirdPartyConversion

Value Description

on Avoid using the conversion functions provided by third-party (default).

off Use the conversion functions provided by third-party.
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@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.
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Value Description

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly
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Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.
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Value Description

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@OriginalIdAsMetadata

Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@ShrinkSurfaces

Value Description

on For trimmed surfaces, shrink the corresponding base surfaces to only
enclose the extents of the external trimming contour, plus a narrow frame.

off Do not modify the base surfaces (default).
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@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@StitchingAcrossBodies

Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).

@UseParasolidNativeReader

Value Description

on Use the Parasolid reader to read embedded XT breps (default).

off Also use the standard JT reader to read XT breps.

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.
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Value Description

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

Supported Metadata
Metadata generated from the ACIS reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on
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Type Entities Description

solids

DENSITY

Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

LAYER

Type Entities Description

integer points

lines

surfs

solids

Value of the layer of an entity.

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles
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Type Entities Description

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

ORIGINAL_ID points

lines

surfs

solids

parts

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on

AVEVA Marine Reader

Supported Entities
Entities supported by the AVEVA Marine reader.

• Plane panels

• Curved panels

• Knuckled panels

• Plane plates

• Curved plates

• Pillars

• Stiffeners (also with sub-flanges)

• Curved stiffeners

• Face plates (also with sub-flanges)

• Flanges
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• Brackets

When @CreationType = TreeOfComponents, an assembly tree is created and organized as follows:

• 1 assembly corresponding to the whole ship (1 ship per part).

• 1 assembly per block.

◦ 1 assembly per PlanePanel.

∙ 1 component for the detailed contour of the current PlanePanel (with relevant option).

∙ 1 component for the simple contour of the current PlanePanel (with relevant option).

∙ 1 component per PlanePlateGroup. The material name, material side, thickness and offset
are created as metadata. If material data are available, a PSHELL material is created.

1 1 surface per PlanePlate. The profile existing in the file is used for the external loop.
Holes can be added as internal loops (with relevant option).

∙ 1 component per PlanePillarGroup.

1 1 set of trace lines per PlanePillar.

2 1 surface per web (with relevant option).

∙ 1 component per PlaneFlangeGroup.

1 1 set of trace lines per PlaneFlange.

∙ 1 component per PlaneStiffenerGroup.

1 1 set of trace lines per PlaneStiffener.

2 1 surface per web and per flange (with relevant option).

∙ 1 component per PlaneFaceplateGroup.

1 1 set of trace lines per PlaneFaceplate.

2 1 surface per web and per flange (with relevant option).

∙ 1 assembly per sub-PlanePanel. The contents correspond to the ones for normal
PlanePanels.

∙ 1 assembly per PlaneBracketGroup.

1 1 component per bracket if no sub-elements exist (stiffeners, planeplates, flanges). 1
assembly if sub-elements exist.

1 1 surface per PlaneBracket. The profile existing in the file is used for the external
loop. No holes are allowed by the AVEVA Marine format. If sub-elements are
present in the current PlaneBracketGroup, a specific component is created for the
surface in order to keep it separate from its sub-elements.

2 1 component per PlaneStiffenerGroup sub-element (no flanges inside the stiffener
group are allowed).

3 1 component per PlaneFaceplateGroup sub-element (no flanges inside the faceplate
group are allowed).

4 1 component per PlaneFlangeGroup sub-element.

∙ 1 assembly per CurvedPanel.

1 1 component for the simple contour of the current CurvedPanel (with relevant option).

2 1 component per CurvedPlateGroup.
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1 1 surface per CurvedPlate. The profile existing in the file is used for the external
loop. Internal holes are implemented.

3 1 component per CurvedStiffenerGroup.

1 1 set of trace lines per CurvedStiffener.

∙ 1 assembly per KnuckledPanel.

When @CreationType is “Parts”, a corresponding tree is created but no assembly entities are created,
parts are created instead. The components are also created.

When @CreationType is “BOM Only”, a corresponding tree is created with parts as in the previous case,
but no components are actually created.

PlanePlates, CurvedPlates and PlaneBrackets are mapped as surfaces. Other objects are imported as
curves, lying on the plates. Groups of objects may share similar properties (such as material, material
side, thickness and offset). In this case, metadata are added to these objects, and if possible the
material description is also created. Holes of curved surfaces are not taken into consideration for this
release.

The reader instantiates objects in their nominal position, hence there may be gaps between panels,
brackets, and so forth, due to idealizations that do not take thickness into account. Hence, no stitching
between surfaces is performed on import.

Available material fields include Young's modulus, Poisson's ratio, expansion coefficient, and density.
Yield stress and ultimate stress are not imported. Each material is associated with a unique grade
name.

When a thickness is provided, the corresponding value is given to a HyperMesh properties.

Objects affected by material/thickness include PlanePlateGroup, PlanePillarGroup, PlaneFlangeGroup,
PlaneStiffenerGroup, PlaneFaceplateGroup, PlaneBracketGroup, CurvedPlateGroup and
CurvedStiffenerGroup.

Import Options
The AVEVA Marine reader uses the aveva_reader.ini file.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol
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Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@CurvedPlateColor

Value Description

string A RGB description of the color to use for curved plates, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonCurvedPlateColor is corresponding to this option and still
supported.
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@CurvedSimpleContourColor

Value Description

string A RGB description of the color to use for curved simple contours, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonCurvedSimpleContourColor is corresponding to this option and
still supported.

@CurvedStiffenerColor

Value Description

string A RGB description of the color to use for curved stiffeners, with values
ranging from 0.0 to 1.0 (e.g. "0.1,0.5,0.4"). If not specified, default color
management will be utilized. The obsolete @TribonCurvedStiffenerColor
is corresponding to this option and still supported.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@FlangeColor

Value Description

string A RGB description of the color to use for flanges, with values ranging
from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not specified, default
color management will be utilized. The obsolete @TribonFlangeColor is
corresponding to this option and still supported.

@ImportCutoutProfiles

Value Description

on Import cutout profiles.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.670

Value Description

off Do not import cutout profiles (default).

@ImportFaceplatesAsSurfaces

Value Description

on Import faceplates as surfaces if the surface description is present in the
file, otherwise import as curves (default).

off Import faceplates as curves.

@ImportHoles

Value Description

on Create holes (default).

off Do not create create holes.

@ImportNotchProfiles

Value Description

on Import notch profiles.

off Do not import notch profiles (default).

@ImportPanelProfiles

Value Description

on Create curves along the panel profiles.

off Do not create curves along the panel profiles (default).

@ImportPillarsAsSurfaces
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Value Description

on Import pillars as surfaces if the surface description is present in the file,
otherwise import as curves (default).

off Import pillars as curves.

@ImportStiffenersAsSurfaces

Value Description

on Import stiffeners as surfaces if the surface description is present in the
file, otherwise import as curves (default).

off Import stiffeners as curves.

@ImportUnboundedCurvedPlates

Value Description

on Import curved plates lacking boundary descriptions (default).

off Do not import curved plates lacking boundary descriptions.

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.
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@PlaneBracketColor

Value Description

string A RGB description of the color to use for plane brackets, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonPlaneBracketColor is corresponding to this option and still
supported.

@PlaneDetailedContoursColor

Value Description

string A RGB description of the color to use for plane detailed contours, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonPlaneDetailedContoursColor is corresponding to this option and
still supported.

@PlaneFaceplateColor

Value Description

string A RGB description of the color to use for plane faceplates, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonPlaneFaceplateColor is corresponding to this option and still
supported.

@PlaneFlangeColor

Value Description

string A RGB description of the color to use for plane flanges, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonPlaneFlangeColor is corresponding to this option and still
supported.

@PlanePillarColor
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Value Description

string A RGB description of the color to use for plane pillars, with values ranging
from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not specified, default color
management will be utilized. The obsolete @TribonPlanePillarColor is
corresponding to this option and still supported.

@PlanePlateColor

Value Description

string A RGB description of the color to use for plane plates, with values ranging
from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not specified, default color
management will be utilized. The obsolete @TribonPlanePlateColor is
corresponding to this option and still supported.

@PlaneSimpleContourColor

Value Description

string A RGB description of the color to use for plane simple contours, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonPlaneSimpleContourColor is corresponding to this option and
still supported.

@PlaneStiffenerColor

Value Description

string A RGB description of the color to use for plane stiffeners, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonPlaneStiffenerColor is corresponding to this option and still
supported.

@PreferDetailed

Value Description

on When multiple representations of a AVEVA Marine object are available,
import the most complex one (default).
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Value Description

off When multiple representations of a AVEVA Marine object are available,
import the least complex one.

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SplitComponents

Value Description

Part Generate part-based component (only allowed value if
CreationType=Parts).

General Keep component as in CAD (only allowed value if
CreationType=TreeOfComponents).

@SubFaceplateColor

Value Description

string A RGB description of the color to use for sub-faceplates, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonSubFaceplateColor is corresponding to this option and still
supported.

@SubStiffenerColor

Value Description

string A RGB description of the color to use for sub-stiffeners, with
values ranging from 0.0 to 1.0 (for example "0.1,0.5,0.4"). If not
specified, default color management will be utilized. The obsolete
@TribonSubStiffenerColor is corresponding to this option and still
supported.
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@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

Supported Metadata
Metadata generated from the AVEVA Marine reader.

BENDING_RADIUS

Type Entities Description

string assems The value of the BendingRadius attribute for a
plane flange group.

BODY_ID

Type Entities Description

string points Identifier of the CAD body containing the entity.
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Type Entities Description

lines

surfs

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string comps
Three RGB values, ranging from 0 to 255,
indicating the color for the object.

Generated when the corresponding
@Tribon<object>Color option is used.

COMP_ID

Type Entities Description

string assems The value of the CompId attribute for a plate or
bracket.

DATA_TYPE

Type Entities Description

string assems The value of the DataType attribute for a panel.

EXTENT_MAX

Type Entities Description

string assems The value of the maximum extent of a block or
panel, as retrieved from the Max attribute of the
object.

EXTENT_MIN
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Type Entities Description

string assems The value of the minimum extent of a block or
panel, as retrieved from the Min attribute of the
object.

FORCE_UNITS

Type Entities Description

string assems The value of the ForceUnits attribute for a ship
units object.

FUNCTIONAL_PROPERTY

Type Entities Description

string assems The value of the FunctionalProperty attribute for a
panel or a group of sub-objects of a panel.

HEIGHT

Type Entities Description

string assems The value of the Height attribute for a plane flange
group.

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

LENGTH_UNITS
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Type Entities Description

string assems The value of the LengthUnits attribute for a ship
units object.

MATERIAL_DIRECTION

Type Entities Description

string faces The value of the MaterialDirection attribute for a
flange, curved panel or knuckled panel.

MATERIAL_SIDE

Type Entities Description

string assems The value of the material side data for a plate
group or bracket group.

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.
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OFFSET

Type Entities Description

string assems The value of the offset data for a plate group.

RENDERING_TYPE

Type Entities Description

string assems The value of the Type attribute for a ship
rendering object.

RootSystemID

Type Entities Description

string assems Generated for root system assemblies. Its value is
the XML field OID.

THICKNESS

Type Entities Description

string assems The value of the Thickness attribute for a plane
flange group.

VERSION

Type Entities Description

string assems The value of the Version attribute for a ship.

WEIGHT_UNITS
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Type Entities Description

string assems The value of the WeightUnits attribute for a ship
units object.

CATIA Reader

Supported Entities
Entities supported the CATIA readers.

CATIA v4 Reader
Supported entities.

• Point (type 1)

• Line segment (type 2)

• Parametric curve (type 3)

• Conics (types 20-23)

• Composite curve (type 24)

• Parametric surface (type 5)

• Face (type 6)

• Volume (type 7)

• Coordinate system (type 8)

• Skin (type 13)

• Mock-up solids (type 17-1)

• Exact solids (type 17-2)

• Ditto (type 28)

CATIA v5 Reader
Supported entities.

• Free points

• Free curves

• Surfaces

• Skin bodies

• Solid bodies

• Facets/triangles

• Infinite planes

• Coordinate systems

• Publications

• Composite data

• Parts (.CatPart)
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• Assemblies (.CatProduct)

Entities that are part of other entities are not created as independent entities.
Entities with non-Latin characters in their names are supported.

CATIA v6 Reader
Supported entities.

• Free points

• Free curves

• Surfaces

• Skin bodies

• Solid bodies

• Facets/triangles

• Infinite planes

• Coordinate systems

• Publications

• Composite data

• Parts (.3dxml, .3DRep)

• Assemblies (.3dxml)

Entities that are part of other entities are not created as independent entities.
Entities with non-Latin characters in their names are supported.

Import Options
The CATIA v5 and CATIA v4 readers use the ct_reader.ini file.

@AttributesAsMetadata

Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.
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@AvoidThirdPartyConversion

Value Description

on Avoid using the conversion functions provided by third-party (default).

off Use the conversion functions provided by third-party.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Same as integer.

off Do not read color attributes (default).

@CreationType
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Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DisableSurfaceRelimination

Value Description

on Disable the third party algorithm for performing base surface trimming
during import. This option should be used in conjunction with
@ShrinkSurfaces.

off Do not disable the third party algorithm (default).

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@FullNameAsMetadata
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Value Description

on
Generate the full CAD name, as retrieved from the CAD part, as metadata.
This consists of assembly name/part name/feature name/entity name.

FULL_IDENTIFIER

off Do not generate full name metadata (default).

@ImportBlanked

Value Description

on
Enable the import of invisible (blanked/NO SHOW) components.

This option, when used, takes priority over any other similar options/
settings.

off
Disable the import of invisible (blanked/NO SHOW) components (default).

This option, when used, takes priority over any other similar options/
settings.

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.
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Value Description

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@ImportPublicationData

Value Description

on Create regions from the geometry referenced in publications.

off Do not create regions from the geometry referenced in publications
(default).

@InfinitePlaneSizeFactor

Value Description

double A factor > 0 for sizing of infinite planes. The factor is a percentage of the
modal size.

The defaault is 0.5.

@LayerAsMetadata
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Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MaterialName

Value Description

string Name of the CAD attribute containing the PDM material name info of the
current part.

Default is "Material".

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@MeshFlag

Value Description

string Name of the CAD attribute containing the PDM mesh flag name info of the
current part.
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Value Description

Default is "MeshFlag".

@MID

Value Description

string Name of the CAD attribute containing the PDM material ID info of the
current part.

Default is "MID".

@OriginalIdAsMetadata

Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@PartNumber

Value Description

string Name of the CAD attribute containing the PDM part number info of the
current part.

Default is "PartNumber”.

@PID

Value Description

string Name of the CAD attribute containing PDM property ID info of the current
part.

Default is "PID”.

@PlyContourGapTolerance
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Value Description

double Acceptable gap between curves of a ply contour (default 0.3). Meaningful
if @ReadCompositeData is enabled.

@ReadCompositeData

Value Description

on Import CATIAV5 composite data.

off Do not import CATIAV5 composite data (default).

@ReadHiddenPlyBaseSurfaces

Value Description

on Read hidden ply base surfaces. Meaningful if @ReadCompositeData is
enabled.

off Do not read hidden ply base surfaces (default).

@RemoveTinySegInCompositeCurves

Value Description

on Remove small segments present in composite curves and closes the gap
by modifying the adjacent segments, while minimizing the distortion.

off Do not remove small segments present in composite curves.

@Revision

Value Description

string Name of the CAD attribute containing PDM major revision info of the
current part.

Default is "Revision”.

@ScaleFactor
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Value Description

double Define the model scaling factor during import.

Default is 1.0.

@ShrinkSurfaces

Value Description

on For trimmed surfaces, shrink the corresponding base surfaces to only
enclose the extents of the external trimming contour, plus a narrow frame.

off Do not modify the base surfaces (default).

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@StitchingAcrossBodies

Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).
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@TagsAsMetadata

Value Description

on
Create entity name as metadata (default).

TAG

FromBody
Take entity from its parent body and create as metadata.

TAG

off Do not read tags.

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).
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@ThicknessName

Value Description

string Name of the CAD attribute containing the PDM thickness info of the
current part.

Default is "Thickness".

@TrimPlySurfaces

Value Description

on Trim ply surfaces when a ply points to one surface only. Meaningful if
@ReadCompositeData is enabled.

off Do not trim ply surfaces (default).

@UID

Value Description

string Name of the CAD attribute containing the PDM UID info of the current
part.

Default is "UID".

There is also the possibility to specify a default search path for files referenced by assemblies via the
CT_DefaultPartPath environment variable.

By default, the referenced files will be read from the locations referenced in the assembly files.

If a referenced file cannot be found:

• If the CT_DefaultPartPath environment variable is not defined, an attempt will be made to locate
the file in the directory where the assembly exists.

• If the CT_DefaultPartPath environment variable is defined, an attempt will be made to locate the
file in the directories defined by the environment variable, following the order the directories are
given (directories separated by semi-colons).

Supported Metadata
Metadata generated from the CATIA reader.

BODY_ID
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Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

COMMENT_BLOCK

Type Entities Description

string assems The command block text for a CATIA v4 file. This
is only attached to the root assembly.

COORDINATE_SYSTEM_<name>

Type Entities Description

string assems The <name> field is the name of the local
coordinate system and the value is the local
coordinate system information.

DENSITY

Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on
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FULL_IDENTIFIER

Type Entities Description

string
points

lines

surfs

solids

comps

assems

A string indicating the name in the following
format:

"part_name/name"

Generated when @FullNameAsMetadata = on

LAYER

Type Entities Description

integer points

lines

surfs

solids

Value of the layer of an entity.

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles
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Type Entities Description

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

string
points

lines

surfs

solids

parts

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on

TAG

Type Entities Description

string
points

lines

surfs

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on
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Type Entities Description

solids

CATIA Composites Link Reader
Use the CATIA Composites Link option to import drape data. This method is separate from the CATIA
reader, where drape data is not imported.

You need to use the CATIA Composites Link (Simulyt) module and export a HDF5 file and then use that
to import in HyperMesh using the CATIA Composites Link connection. This is similar to the FiberSim
reader.

1. Import a CAD model (without composite data) using the CATIA geometry import method.

2. Use the CATIA Composites Link connection to import the HDF5 files created from the Simulyt
interface in CATIA.

3. When realizing the plies, use the CATIA Composites Link drape map by proximity method in the
Ply Realization dialog.

4. When exporting the composite data to CAD including draping, use the geometry export option
CATIA Composites.

Creo Reader

Supported Entities
Entities supported by the Creo reader.

• Free points

• Free curves

• Surfaces

• Quilt bodies

• Solid bodies

• Coordinate systems

• Assemblies

• Assembly Level Features are currently not supported.

• Family Tables are currently not supported.

Entities with non-latin characters in their names are supported.

Import Options
The Creo reader uses the ct_reader.ini file.

@AttributesAsMetadata
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Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

@AvoidThirdPartyConversion

Value Description

on Avoid using the conversion functions provided by third-party (default).

off Use the conversion functions provided by third-party.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.
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@ColorsAsMetadata

Value Description

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@FullNameAsMetadata
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Value Description

on
Generate the full CAD name, as retrieved from the CAD part, as metadata.
This consists of assembly name/part name/feature name/entity name.

FULL_IDENTIFIER

off Do not generate full name metadata (default).

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).
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Value Description

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MaterialName

Value Description

string Name of the CAD attribute containing the PDM material name info of the
current part.

Default is "Material".
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@MeshFlag

Value Description

string Name of the CAD attribute containing the PDM mesh flag name info of the
current part.

Default is "MeshFlag".

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@MID

Value Description

string Name of the CAD attribute containing the PDM material ID info of the
current part.

Default is "MID".

@OriginalIdAsMetadata

Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@PartNumber

Value Description

string Name of the CAD attribute containing the PDM part number info of the
current part.
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Value Description

Default is "PartNumber”.

@PID

Value Description

string Name of the CAD attribute containing PDM property ID info of the current
part.

Default is "PID”.

@Revision

Value Description

string Name of the CAD attribute containing PDM major revision info of the
current part.

Default is "Revision”.

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@ShrinkSurfaces

Value Description

on For trimmed surfaces, shrink the corresponding base surfaces to only
enclose the extents of the external trimming contour, plus a narrow frame.

off Do not modify the base surfaces (default).

@SkipCreationOfSolid
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Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@SplitComponentsByBody

Value Description

on
Create one component per third-party body. There might be one or more
third-party bodies per third-party component.

This option cannot be used when @ReadCompositeData is enabled, or in
conjunction with @SplitComponentsByPart.

off Do not consider the division of third-party components into third-party
bodies while creating components (default).

@StitchingAcrossBodies

Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).

@TagsAsMetadata
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Value Description

on
Create entity name as metadata (default).

TAG

FromBody
Take entity from its parent body and create as metadata.

TAG

off Do not read tags.

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@ThicknessName
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Value Description

string Name of the CAD attribute containing the PDM thickness info of the
current part.

Default is "Thickness".

@UID

Value Description

string Name of the CAD attribute containing the PDM UID info of the current
part.

Default is "UID".

Supported Metadata
Metadata generated from the Creo reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

DENSITY
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Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

FULL_IDENTIFIER

Type Entities Description

string
points

lines

surfs

solids

comps

assems

A string indicating the name in the following
format:

"part_name/name"

Generated when @FullNameAsMetadata = on

LAYER

Type Entities Description

integer points

lines

surfs

solids

Value of the layer of an entity.

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT
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Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

string
points

lines

edges

surfs

solids

parts

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on

TAG

Type Entities Description

string
points

lines

edges

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.707

Type Entities Description

surfs

solids

DXF Reader

Supported Entities
Entities supported by the DXF reader.

• Free points (POINT)

• Free curves (LINE)

• Surfaces (3DFACE)

• Solid (SOLID)

• Facets/triangles (POLYLINE with Group Code 70=64 for polyface mesh)

Import Options
The DXF reader uses the dxf_reader.ini file.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata
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Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.
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@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SplitComponents

Value Description

Part Generate part-based component (only allowed value if
CreationType=Parts).

General Keep component as in CAD (only allowed value if
CreationType=TreeOfComponents).

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.
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Value Description

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

Supported Metadata
Metadata generated from the DXF reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

FiberSim Reader
The FiberSim reader is supported for Nastran and OptiStruct user profiles.

Supported Entities
Entities supported by the FiberSim HDF5 reader.

Plies
Name, thickness, and fiber orientation information is directly read and mapped as a Ply entity.
Plies that point to woven and stack materials are split/separated into multiple plies with half the
thickness and correct orientation angles. These split ply names always have _1 and _2 suffix in
them for each identification.

Date Map/Table
Data map with element set (ply shapes), material orientation angles (orient1 , orinet2 , draping
corrections) thickness corrections, reference direction and normal information for each ply is
preserved/mapped in the table entity, therefore each ply has a table associated with it. Nodes and
elements are not created in the database from FiberSim triangulation data to define ply shapes.
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Instead, it preserves this information in a table so that when these plies are mapped (realized)
on actual good mesh, HyperMesh uses this triangular information to define the ply boundary and
extract the actual elements.

Laminates
One laminate per HDF5 component with all the ply sequence preserved as per layer_id value.

Materials
Material names and their mechanical properties are read and mapped to solver cards
automatically depending on the user profile loaded while importing the model. Currently
mechanical properties such as E1, E2, E3, G12, G13, G23, Alpha1, Alpha2 and Alpha_ref
temperature are mapped to solver material attributes.

Rosette/Systems
All the system definitions available in the HDF5 file will be imported into one system collector.
Currently HyperMesh does not preserve the ply and system relation.

IGES Reader

Supported Entities
Entities supported by the IGES reader.

• Circular arc (100)

• Composite curve (102)

• Conic arc (104)

• Copious data (106)

• Plane (108)

• Line (110)

• Parametric spline curve (112)

• Parametric spline surface (114)

• Point (116)

• Ruled surface (118, form 1 only)

• Surface of revolution (120)

• Tabulated cylinder (122)

• Direction (123)

• Transformation matrix (124)

• Flash (125)

• Rational B-spline curve (126)

• Rational B-spline surface (128)

• Offset surface (140)

• Boundary (141)

• Curve on a parametric surface (142)

• Bounded surface (143)
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• Trimmed (parametric) surface (144)

• Manifold solid B-rep object (186)

• Plane surface (190)

• Right circular cylindrical surface (192)

• Right circular conical surface (194)

• Spherical surface (196)

• Toroidal surface (198)

• Angular dimension (202)

• Diameter dimension (206)

• General label (210)

• General note (212)

• Leader (214)

• Linear dimension (216)

• Radius dimension (222)

• General symbol (228)

• Sectioned area (230)

• Line font definition (304)

• Subfigure definition (308)

• Color definition (314)

• Form 7 group without back pointers (402)

• Drawing (404)

• Form 15 name (406)

• Singular subfigure instance (408)

• View (410)

• Vertex (502)

• Edge (504)

• Loop (508)

• Face (510)

• Shell (514)

Import Options
The IGES reader uses the iges_reader.ini file. The first section of this file contains instructions for
reading each type of IGES entity. It is recommended that you do not change this section. The second
section controls the options for the translator.

@CheckFacet

Value Description

on Based on the success of the normal faceting operation, more cleanup
attempts may be required. One option is to mesh it in advance to check
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Value Description

the faceting. This may slow down the import due to the possible use of
meshing operations, but should result in cleaner surfaces (default).

off Do not check the faceting and apply normal cleanup.

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.
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Value Description

off Merge edges together during the import cleanup phase (default).

@GroupAsRegions

Value Description

on Create region entities corresponding to IGES groups.

off Do not create region entities. (default).

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints
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Value Description

on Import free points into the model (default).

off Do not import free points.

@ImportLayers

Value Description

Layers to skip
Enables the specification of layer numbers to import, in order to skip
unwanted layers.

To specify layer groupings, enter a hyphen between the beginning and
ending values of the desired group. Groups are separated by commas.

Example: @ImportLayers = "1,2-5,100-200"

@ImportType

Value Description

ASSEMBLY Generate an assembly tree corresponding to the one contained in the file
(default).

Meaningful if @CreationType = “TreeOfComponents”.

LAYERS_ONLY Create components based on the layer (=level) structure of the file.

Meaningful if @CreationType = “TreeOfComponents”.

LAYERS_AND_GROUPS Create components corresponding to layers and groups contained in the
file.

Meaningful if @CreationType = “TreeOfComponents”.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER
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Value Description

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@PropertyAsGroup

Value Description

NEVER_MANAGE Do not generate special metadata (default).

Meaningful if @CreationType = “TreeOfComponents”.

MANAGE_CORRECT_ONLY
Read group ID and name as metadata.

This is useful for special cases where the group ID and name have special
meaning, such as to indicate a property ID and name. This applies to IGES
entity type #402, form number #7.

GROUP_ID

GROUP_NAME

Meaningful if @CreationType = “TreeOfComponents”.

@ReadAsIndependent
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Value Description

INDEPENDENT

PHYSICALLY_DEPENDENT

LOGICALLY_DEPENDENT

Enable the import of three types of independent entities.

Use a semicolon to separate multiple values. When more than one value
is used, both independent and logically dependent entities are treated as
independent. Generally, this option should only be used for a particular
vendor that marks some entities as dependent when they are imported.
The reader imports the entities according to the value specified in the file.
The default is INDEPENDENT.

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SkipConnectivityComputation

Value Description

on
Import the model without computing connectivity. The surfaces will not be
connected.

This option speeds up import, but may not be suitable for any other
purpose than visualization.

off Import the model in the normal fashion (default).

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SkipEntities
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Value Description

Entity types and
subtypes to skip

Specific entity types, or even subtypes (that is entity types with specific
form numbers) that should be skipped during import.

The list of types uses semicolons as separators.

Example: @SkipEntities = "ENTTYPE1;ENTTYPE2.FORM2"

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@TagsAsMetadata

Value Description

on
Read tags of supported entities as metadata (default).

TAG

off Do not read tags.

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.
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Value Description

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@Transform402form16

Value Description

on
Entities referenced by an entity type #402 from #16 are transformed from
2D local space into 3D absolute space.

Early IGES files from SolidWorks require such an operation.

off (default)

@TraverseGroups

Value Description

on The reader attempts to traverse group entities (default).

off Ignore references to entities within a group.

@TrimRevolvedWithModelSpaceCurves
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Value Description

on Attempt to compute the boundary definition by projecting 3D trimming
curves (if such curves are available) onto the surface only for revolution
surface entities (type #120).

off Use parameter space trimming loops whenever possible. Given an IGES
file containing correct data, this option is faster and more robust than
reading object space loops (default).

@TrimWithModelSpaceCurves

Value Description

on Attempt to compute the boundary definition by projecting 3D trimming
curves (if such curves are available) onto the surface. This is useful if the
parameter space trimming loops in the file contain incorrect geometry
data.

off Use parameter space trimming loops whenever possible. Given an IGES
file containing correct data, this option is faster and more robust than
reading object space loops (default).

@TrimWithPreferredRepresentation

Value Description

on
Attempt to create the boundary definition using 2D or 3D curves, based on
the preferred representation provided by entity type #142.

This option can be overridden by either
@TrimRevolvedWithModelSpaceCurves = on or
@TrimWithModelSpaceCurves = on.

off (default)

@UseAnsys128Format

Value Description

on Attempt to read Ansys NURBS surface format.

off (default)
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@vendors

Value Description

List of vendor names
Use vendor information to search the global section of the file to
determine if it is from a particular vendor. Each vendor name is separated
by semicolons and all spaces in the vendor name must be replaced by an
underscore.

Example: @vendors = "vendor1;vendor2;vendor3"

After a vendor has been added to the list, options for that particular
vendor can be specified. If a file is recognized as coming from a particular
vendor, settings for that vendor take priority over "general" settings.

Example: @<vendor>.<option> = "<value>"

Supported Metadata
Metadata generated from the IGES reader.

AUTHOR

Type Entities Description

string comps The author block as read from the 'G' section of
the file. This is generated only when the block is
found in the file.

AUTHORS_ORGANIZATION

Type Entities Description

string comps The author's organization block from the 'S'
section of the file. This is generated only when the
block is found in the file.

COLOR_RGB

Type Entities Description

string
lines

surfs

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.
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Type Entities Description

Generated when @ColorsAsMetadata = on

COMMENT_BLOCK

Type Entities Description

string comps The comment block from the 'S' section of the file.
This is generated only when the block is found in
the file.

DRAFTING_STANDARD

Type Entities Description

integer comps The drafting standard block from the 'G' section of
the file. This is generated only when the block is
found in the file.

FILE_NAME

Type Entities Description

string comps The file name block from the 'G' section of the file.
This is generated only when the block is found in
the file.

GROUP_ID

Type Entities Description

integer comps
The IGES entity type #402, form number #7
group ID as read from the CAD model, if one
exists.

Generated when @PropertyAsGroup =
ManageCorrectOnly

GROUP_NAME
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Type Entities Description

string comps
The IGES entity type #402, form number #7
group name as read from the CAD model, if one
exists.

Generated when @PropertyAsGroup =
ManageCorrectOnly

IGES_VERSION

Type Entities Description

integer comps The IGES version block from the 'G' section of the
file. This is generated only when the block is found
in the file.

IMPORT_DATE

Type Entities Description

string comps The import date block from the 'G' section of the
file. This is generated only when the block is found
in the file.

LAYER

Type Entities Description

integer points

lines

surfs

solids

Value of the layer of an entity.

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

Hierarchy of an entity within a part.
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Type Entities Description

surfs Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

MODIFICATION_DATE

Type Entities Description

string comps The modification date block from the 'G' section of
the file. This is generated only when the block is
found in the file.

PREPROCESSOR_VERSION
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Type Entities Description

string comps The preprocessor version block from the 'G'
section of the file. This is generated only when the
block is found in the file.

PRODUCT_IDENTIFICATION

Type Entities Description

string comps The product identification block from the 'G'
section of the file. This is generated only when the
block is found in the file.

RECEIVING_PRODUCT_ID

Type Entities Description

string comps The receiving product ID block from the 'G' section
of the file. This is generated only when the block is
found in the file.

SYSTEM_ID

Type Entities Description

string comps The system ID block from the 'G' section of the
file. This is generated only when the block is found
in the file.

TAG

Type Entities Description

string
points

lines

surfs

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on

UNITS
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Type Entities Description

string comps The units block from the 'G' section of the file.
This is generated only when the block is found in
the file.

Inspire Reader

Supported Entities
Entities supported by the Inspire reader.

• Models

• Assemblies

• Parts

• Solids

• Sheets

• Curves

• Points

• Axis Systems

• Alternatives

◦ Active alternatives are imported by default.

◦ All alternatives are imported when hidden (blanked/no show) entities are imported.

The following properties associated to entities are supported:

• Visibility

• Color

• Transparency

• Active status

◦ Active geometry is imported by default.

◦ All geometry is imported when hidden (blanked/no show) entities are imported.

Import Options
The Inspire reader uses the inspire_reader.ini file.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID
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Value Description

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata
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Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@ExtractManifoldFromGeneralBody

Value Description

on Extract the manifold body from a Parasolid general body that is non-
manifold and/or of mixed topological dimensionality (default).

off Extract Parasolid general bodies as defined.

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.
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Value Description

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.
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@OriginalldAsMetadata

Value Description

on Import original Inspire and Parasolid entity IDs as metadata.

off Do not import original Inspire and Parasolid entity IDs as metadata
(default).

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@SplitPeriodicFaces

Value Description

on Split periodic surfaces to improve the quality and robustness of the import
(default).

off Import periodic surfaces as a single surface with a seam edge.
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@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@UniqueIdAsMetadata

Value Description

on Split periodic surfaces to improve the quality and robustness of the import
(default).

off Import periodic surfaces as a single surface with a seam edge.

Supported Metadata
Metadata generated from the Inspire reader.

BODY_ID
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Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

DENSITY

Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps Model units specified in the CAD file.

1 = inches
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Type Entities Description

parts 2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

string
comps

points

lines

surfs

solids

parts

The original Inspire ID for comps and the Parasolid
entity IDs for the geometry.

Generated when @OriginalIdAsMetadata = on

UNIQUE_ID

Type Entities Description

string
points

lines

surfs

A combination of the Inspire body ID and the
Parasolid entity ID.

Generated when @OriginalIdAsMetadata = on
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Type Entities Description

solids

Intergraph Reader

Supported Entities
Entities supported by the Intergraph reader.

Systems
The following systems, listed in hierarchical order, are supported and created as assemblies or
components, when @CreationType = TreeOfComponents.

• Generic systems. One assembly is created for each generic system.

◦ Root systems. One assembly is created for each root system.

∙ Plate systems. One component is created for each plate system.

∙ Stiffener systems. By default one or more components (depending on the properties
you created) are created for each stiffener child geometry; this behavior can be
changed based on the ini option @CreateMultipleComponentsForStiffeners.

∙ ER systems. Same as stiffener systems.

◦ Bracket systems. One assembly is created for each bracket system.

∙ Bracket system child. One component is created for each bracket child.

∙ Stiffener systems

◦ Beam systems. Same as stiffener systems.

◦ Member systems. By default one component is created for each
member part; this behavior can change based on the ini option
@CreateMultipleComponentsForLinearMembers.

When @CreationType is “Parts”, a corresponding tree is created but no assembly entities are
created, parts are created instead. The components are also created.

When @CreationType is “BOM Only”, a corresponding tree is created with parts as in the previous
case, but no components are actually created.

Compartments
By default, no compartments are imported. To import compartments, the @ImportCompartments
or @ImportIGESCompartments ini options should be set.

Topological Properties
By default no topological properties are created; this behavior can change based on the ini option
@ImportTopologicalProperties.

Plate Geometries
The following plate geometries are supported and created:

• Planar
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• Curved

• External (supported just in IGES format)

Stiffener/ER/Beam Systems Cross Section
The following stiffer/ER/beam system cross sections are supported and created:

• Flat bar

• Angle

• TBar

• IBar

• Channel

• Round

• Rectangle

Linear Members
The only member parts that are imported have a straight NURBS as a contour 3D, and a cross
section of type round.

Materials and Properties
By default, materials and properties are created for the Nastran solver; a different solver can be
selected with the ini option @Solver.
The following properties are created:

• For each plate system and bracket child system, a PSHELL property is created.

• For stiffener/beam/ER system children, the behavior depends on the analysis type (global or
local analysis, see “GUI Options”):

◦ Local analysis: By default, a component and a PROD property are created for each ER
system child, a component and a PSHELL property are created for each web and flange
of stiffener/beam system children.

◦ Global analysis: By default, a component and a PROD property are created for each
stiffener/beam/ER system child; if it is longitudinal, then a PBAR property is also created.

By default these properties are assigned to the corresponding components; this behavior can be
changed by using the ini option @AssignPropertiesToComponents.
When @CreationType is “Parts” the thickness (assigned to the PSHELL property) is also assigned
to the part.
Materials are created for plate systems, bracket, stiffener, beam, and ER children; for the Nastran
solver, the material created is of type MAT1.
When @CreationType is “Parts” the material is also assigned to the part.

Import Options
The Intergraph reader uses the intergraph_reader.ini file.

@AssignPropertiesToComponents

Value Description

on Assign properties to the corresponding component (for components which
have more than one property, properties are not assigned).
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Value Description

off Do not assign properties to components (default).

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@CreateMetadataForStiffenerNormals

Value Description

on Attach some metadata with information about normals to stiffener/beam/
ER systems.

START NORMAL, START POINT, END NORMAL, END POINT, MOUNTING RULE

off Do not attach metadata with information about normals to stiffeners/
beam/ER systems (default).

@CreateMultipleComponentsForLinearMembers

Value Description

on Create one component for each member part (default).
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Value Description

off Group member parts belonging to the same member system based on
thickness and diameter, that is, just one component is created for each set
of data.

@CreateMultipleComponentsForStiffeners

Value Description

on Create one or more components for each stiffener/beam/ER geometry
(one for each property; that is, if we have flange and web, then two
different properties and components are created) (default).

off Group stiffener/beam/ER geometries belonging to the same root stiffener/
beam/ER system based on their properties (that is, just one component is
created for each set of property data).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@ImportCompartments
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Value Description

on Import both compartments in the IGES files, and compartments defined
by “Faces”. The former by importing the geometry, the latter just by
creating a metadata; also reference planes are created, because they can
be referenced by compartments.

off Do not import any compartments (default).

@ImportIGESCompartments

Value Description

on Import compartments in the IGES files.

off Do not import any compartments in the IGES files (default).

@ImportPlateSystemMetadata

Value Description

on Create physical properties assigned in the XML to plate systems and
bracket children as metadata.

off Do not import physical properties assigned in the XML to plate systems
and bracket children (default).

@ImportStiffenerMidSurfaces

Value Description

on Create stiffener/beam/ER midsurfaces (instead of solid geometry) in both
global and local analysis; also create landing curves in Global Analysis.

off Create stiffener/beam/ER solid geometry in local analysis, and landing
curves in Global Analysis (default).

@ImportTopologicalProperties

Value Description

on Create reference planes and sketch contours, and attach metadata to the
systems which own these properties (see Intergraph Metadata Suppport).
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Value Description

off Do not import topological property (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@PropertyName

Value Description

string Name of the properties created in HyperMesh. It can contain “special”
strings that will be replaced with their meaning: <COMPONENT_NAME>
is the name of the component to which the property is associated,
<PROPERTY_CARD_NAME> is the name of the property card. Default is
<COMPONENT_NAME>

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@Solver
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Value Description

string Use to choose the solver for which materials and properties are created;
currently this string can be “nastran” or “ansys”; the default solver is
Nastran.

@SplitComponents

Value Description

Part Generate part-based component (only allowed value if
CreationType=Parts).

General Keep component as in CAD (only allowed value if
CreationType=TreeOfComponents).

@StiffenerJustCurves

Value Description

on Create only landing curves for stiffeners.

off Create the complete stiffener geometry (default).

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.
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Value Description

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

Supported Metadata
Metadata generated from the Intergraph reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

BRACKET SUPPORT

Type Entities Description

string assems
Created for each bracket system and associated to
the bracket system assembly.

Its value is "Name = <name_1> ID = <id_1>;
Name = <name_2> ID = <id_2>; …; Name =
<name_n> ID = <id_n>”, where <name_1>,
<name_2>, … <name_n> are the support names
and <id_1>, <id_2>, …<id_n> are the support
ids.

COMPARTMENT <name>
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Type Entities Description

string assems
Created for each compartment which has a child
of type “Faces” and is attached to the generic
system assembly to which the compartment
belongs to.

The <name> field is the name of the
compartment; the value is “Faces = <id_1>
<id_2>… <id_n> Compartment father = <id>”,
where <id_1>, <id_2>…<id_n> are the ids of
the faces, and <id> is the id of the compartment
father if it exists (there could be a hierarchy of
compartments).

Generated when @ImportCompartments = on.

END NORMAL

Type Entities Description

string comps
Created for ER systems in any case, and also for
stiffener/beam systems in Global Analysis.

Its value is the normal direction of the stiffener at
the landing curve end point.

Generated when
@CreateMetadataForStiffenerNormals = on.

END POINT

Type Entities Description

string comps
Created for ER systems in any case, and also for
stiffener/beam systems in Global Analysis.

Its value is the normal direction of the stiffener at
the landing curve end point.

Generated when
@CreateMetadataForStiffenerNormals = on.
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LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

6 = meters

This is always generated.

MOUNTING RULE

Type Entities Description

string comps
Created for ER systems in any case, and also for
stiffener/beam systems in Global Analysis.

Its value is the mounting rule value as found in
the XML.

Generated when
@CreateMetadataForStiffenerNormals = on.

<name>

Type Entities Description

double

string

assems
The attributes that are in the XML under “Details” are attached
to the main ship assembly.

The <name> field is the attribute name and the double/string
is the value of the attribute.
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Type Entities Description

double

string

comps Physical Properties
Physical properties assigned in the XML to plate systems
and bracket child are created as metadata.
The <name> field is the property name and the double/
string is the property value.
Generated when @ ImportPlateSystemMetadata = on.

Molder Properties
Molded properties assigned in the XML to plate systems
and bracket child are created as metadata.
The <name> field is the property name and the double/
string is the property value.

NamingCategory

Type Entities Description

string
assems

comps

Generated for root system assemblies,
bracket system assemblies, stiffener/beam/ER
components, and member part components. Its
value is the the XML field NamingCategory ->
LongDesc.

OBJECT TYPE

Type Entities Description

string
assems

comps

Generated for root system assemblies, bracket
system assemblies, and stiffener/beam/ER
components. Its value can be:

• RootSystem

• BracketSystem

• RootStiffenerSystem

• RootBeamSystem

• RootERSystem

PLANE NAME
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Type Entities Description

string surfaces
Created for reference planes. Its value is the name
of the reference plane as found in the XML.

Generated when @ImportTopologicalProperties
= on or @ ImportCompartments = on.

REFERENCE PLANE <n>

Type Entities Description

string assems
Created for root systems, for each XML child
of type TopologicalProperties -> Boundaries ->
RefPlane (the number <n> is just the index of the
child).

Its value is the value of this field.

Generated when @ImportTopologicalProperties
= on.

REFERENCE STRUCTURE <n>

Type Entities Description

string assems
Created for root systems, for each XML child
of type TopologicalProperties -> Boundaries ->
ReferenceStruct (the number <n> is the index of
the child).

Its value is the value of this field.

Generated when @ImportTopologicalProperties
= on.

RootSystemID
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Type Entities Description

string assems Generated for root system assemblies. Its value is
the XML field OID.

START NORMAL

Type Entities Description

string comps
Created for ER systems in any case, and also for
stiffener/beam systems in Global Analysis.

Its value is the normal direction of the stiffener at
the landing curve start point.

Generated when
@CreateMetadataForStiffenerNormals = on.

START POINT

Type Entities Description

string comps
Created for ER systems in any case, and also for
stiffener/beam systems in Global Analysis.

Its value is the landing curve start point.

Generated when
@CreateMetadataForStiffenerNormals = on.

STIFFENER TYPE

Type Entities Description

string comps
Created for each stiffener/beam/ER system
component.

Its value is the XML field Molded -> Type.

XSECTION DATA
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Type Entities Description

string comps
Created for ER systems and member parts in
any case, and also for stiffener/beam systems in
Global Analysis.

Its value contains the xsection geometrical data
(different for each xsection type) in the form
“<data name 1> = <data_value 1> <data name
2> = <data value 2>… <data name n> = <data
value n>”.

Inventor Reader

Supported Entities
Entities supported by the Inventor reader.

• B-rep geometry

Import Options
The Inventor reader uses the ct_reader.ini file.

@AttributesAsMetadata

Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

@AvoidThirdPartyConversion
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Value Description

on Avoid using the conversion functions provided by third-party (default).

off Use the conversion functions provided by third-party.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType
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Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).
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Value Description

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).
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@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@OriginalIdAsMetadata

Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@ShrinkSurfaces

Value Description

on For trimmed surfaces, shrink the corresponding base surfaces to only
enclose the extents of the external trimming contour, plus a narrow frame.
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Value Description

off Do not modify the base surfaces (default).

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@StitchingAcrossBodies

Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.
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Value Description

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

Supported Metadata
Metadata generated from the Inventor reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on
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DENSITY

Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

LAYER

Type Entities Description

integer points

lines

surfs

solids

Value of the layer of an entity.

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters
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Type Entities Description

11 = microinches

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

ORIGINAL_ID points

lines

surfs

solids

parts

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on

FULL_IDENTIFIER

Type Entities Description

string
points

lines

surfs

solids

comps

assems

A string indicating the name in the following
format:

"part_name/name"

Generated when @FullNameAsMetadata = on

JT Reader

Supported Entities
Entities supported by the JT reader.

• Free points

• Free curves
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• Surfaces

• Solid bodies (JT B-rep)

• Embedded Parasolid (XT B-rep)

• Facets (triangular only)

• Parts

• Assemblies

Import Options
The JT reader uses the jt_reader.ini file.

@ApplyLayerFilters

Value Description

string Import only the specified layer filters.

The string should be in the form of "%filter1%filter2%filter3". The
filter names are listed, separated by a character that you choose, and
inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string. A special value of DEFAULT can be used to
indicate the default layer filter.

@AttributesAsMetadata

Value Description

all Import all generic attributes as metadata (default).

<name>

%attribute1%attribute2%attribute3Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

<name>

@BodyIdAsMetadata
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Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@BrepAndTessLoadOption

Value Description

0 Import B-rep or tessellation, with B-rep given preference. If B-rep is
present, tessellation is not imported (default).

1 Import both the B-rep and the tessellation.

2 Import only the B-rep. If B-rep is not present, nothing is imported.

3 Import only the tessellation. If tessellation is not present, nothing is
imported.

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType
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Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@FilterByJTOpenParts

Value Description

string The string should be in the form of "%part1%part2%part3". The part
names are listed, separated by a character that you choose, and inserted
as the first element of the string. The example uses '%' as a separator.
You can choose another character as a separator, in case one of the listed
attribute names contains '%'. HyperMesh will recognize it as it is the first
character of the string.

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves
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Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MaterialName

Value Description

string Name of the CAD attribute containing the material name info of the
current part. Default is "P_MAT".

@MeshFlag

Value Description

string Name of the CAD attribute containing the PDM mesh flag name info of the
current part.

Default is "MeshFlag".

@MetadataPrefix
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Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@MID

Value Description

string Name of the CAD attribute containing the PDM material ID info of the
current part.

Default is "MID".

@PartNumber

Value Description

string Name of the CAD attribute containing the PDM part number info of the
current part. Default is "DB_PART_NO".

@PID

Value Description

string Name of the CAD attribute containing PDM property ID info of the current
part.

Default is "PID”.

@Revision

Value Description

string Name of the CAD attribute containing PDM major revision info of the
current part.

Default is "Revision”.

@SkipCreationOfSolid
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Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@SplitPeriodicFaces

Value Description

on Split periodic surfaces to improve the quality and robustness of the import
(default).

off Import periodic surfaces as a single surface with a seam edge.

@TagsAsMetadata

Value Description

on
Create entity name as metadata (default).

TAG

FromBody
Take entity from its parent body and create as metadata.

TAG

off Do not read tags.

@TargetUnits
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Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@ThicknessName

Value Description

string Name of the CAD attribute containing the PDM thickness info of the
current part. Default is "P_GAUGE".

@UID

Value Description

string Name of the CAD attribute containing the PDM UID info of the current
part.
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Value Description

Default is "UID".

Supported Metadata
Metadata generated from the JT reader.

BODY_ID

Type Entities Description

string lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
lines

surfs

comps

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on.

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet
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Type Entities Description

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

<name>

Type Entities Description

integer

double

string

comps

assems

The <name> field is the JT attribute name and
the integer/double/string is the value of the JT
attribute.

Generated when @AttributesAsMetadata = all
or <name> is one of the selected attributes.

TAG

Type Entities Description

string
points

lines

surfs

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on
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Type Entities Description

solids

NX Reader
NX import is available through two different readers: UGOpen native reader and a third-party non-
native reader.

NX Native Reader
The NX reader utilizes the UGOpen library to read files from NX. The reader relies on a valid NX
installation and license to access these libraries. Environment variables must be set appropriately
to ensure proper access to these libraries. Any NX file formats not supported by the available NX
installation are not supported.

Supported Entities
Entities supported by the Native reader.

• UF_coordinate_system

• UF_point

• UF_line

• UF_circle

• UF_conic

• UF_spline

• UF_faceted_model

• UF_solid

• When reading an NX assembly or part file with material information, the material information
is read into HyperMesh as Nastran MAT1 material collectors. When @CreationType =
TreeOfComponents if there is more than one material associated to the entities in a given part file,
HyperMesh splits the part into multiple component collectors. When @CreationType = Parts this
happens depending on the split type, that is a material is created and associated to the component
only if there is just one material associated to the entities of that component. A property collector
is always created when importing material information and assigned to the component (see note
below), and the material collector is then associated to the respective property collector.

• The NX Native reader also recognizes midsurface thickness information for each part of an
assembly. After the part is imported, the thickness information is stored in Nastran PSHELL
property collectors. If no thickness information is present but material information does exist, an
empty PSHELL property collector is created and the material is assigned to the property collector.
The property collector is then assigned to the component collector.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.766

• When @creationType = TreeOfComponents, midsurface geometry is organized into a separate
component from the solid geometry it is associated to, using a similar name as the solid
component. When @CreationType = Parts this happens depending on the split type.

Environment Variables
Since the NX reader needs to use the UGOpen library during the run time, it requires that a valid NX
installation and NX license be present and available to the user with the assemblies, gateway and
solid_modeling modules.

Set the following environment variables prior to starting:

Windows

UGII_BASE_DIR

Must point to the NX installation directory1.

UGII_ROOT_DIR

Must point to the NX installation UGII directory1.

PATH
Must include the %UGII_BASE_DIR%\UGII\ directory, and for NX11 and NX12 the

%UGII_BASE_DIR%\NXBIN directory2.

SPLM_LICENSE_SERVER
Must point to the NX license server.

UGS_LICENSE_BUNDLE
Must specify the NX license bundle.

Example: NX installation located at C:\Program Files\Siemens\NX 12.0
UGII_BASE_DIR: C:\Program Files\Siemens\NX 12.0
UGII_ROOT_DIR: %UGII_BASE_DIR%\UGII\
PATH: %UGII_BASE_DIR%\UGII\
SPLM_LICENSE_SERVER: 28000@licsrv
UGS_LICENSE_BUNDLE: NXPTNR100

LINUX

UGII_BASE_DIR

Must point to the NX installation directory.1

UGII_ROOT_DIR

Must point to the NX installation bin directory.1

SPLM_LICENSE_SERVER
Must point to the NX license server.

UGS_LICENSE_SERVER

UGS_LICENSE_SERVER
Must specify the NX license bundle.

Example: NX installation located at /soft/usr/ugs120
UGII_BASE_DIR: /soft/usr/ugs120
UGII_ROOT_DIR: /soft/usr/ugs120/bin/
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UGS_LICENSE_SERVER: 28000@licsrv
UGS_LICENSE_BUNDLE: NXPTNR100

1. UGII_ROOT_DIR is needed only for NX10. NX is very sensitive about the environment variables.
You should NOT have '/' at the end of UGII_BASE_DIR path and you MUST have '/' at the end of
UGII_ROOT_DIR path.

2. It is advisable to specify %UGII_BASE_DIR%\UGII\ at the beginning of the PATH environment
variable to avoid DLL version conflicts.

Import Options
The NX Native reader uses the ug_reader.ini file. The NX reader also includes a browser to control the
import of assemblies, the sorting of entities by component, and various other import details. The NX
Part browser will come up just for GUI import when Creation type is set to Assemblies.

@AssignThicknessToSolids

Value Description

on Assign thickness to a solid if the owning part has an attribute with the
name THICKNESS. The thickness value is the value of this attribute.

off Do not assign thickness to solids (default).

@AttributesAsMetadata

Value Description

on Import all generic attributes (global and related to single entities) as
metadata.

<name>

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

<name>

@BodyIdAsMetadata
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Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@ComponentAttributes

Value Description

string In batch mode, this corresponds to the NX Part Browser Component
attributes option.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@ComponentNameFormat

Value Description

string In batch mode, this corresponds to the NX Part Browser Assign
components by name option; the default value is "default", that is the
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Value Description

standard component naming; to have custom component name one
should set:

@ComponentNameFormat = "custom <custom1><custom2>...<customnn>"

where <customi> could be one of the following:

<Part Name>, <Part Number>, <RID-PDI>, <Layer>, <Category>,
<Instance Name>, <Material Name>, <Thickness>, <UG Body ID>, <UG
Tag>, <Solid Name>.

In GUI import when Creation type” is set to Assemblies, this initializes
the corresponding option in the NX Part browser.

@CoordinateSystem

Value Description

global In batch mode, individual parts in an assembly are imported into the
global coordinate system (default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

local In batch mode, individual parts in an assembly are imported into their
local coordinate system.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@CreateMatsAndProps

Value Description

on Create materials and properties in HyperMesh if material and thickness
data are found in the model (default).

off Do not create materials and properties in HyperMesh.

@CreateWeldsInHypermesh

Value Description

on In batch mode, welds are created in HyperMesh.
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Value Description

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, welds are not created in HyperMesh (default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DisableLayers

Value Description

string This corresponds to the NX Part browser Disable option in Layer filtering
mode.

The layers to disable in the import should be listed with the same rules as
for the NX Part browser entry.

@Display
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Value Description

categories In batch mode, this corresponds to the NX Part browser Categories
selection.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

layerfiltering In batch mode, this corresponds to the NX Part browser Layer filtering
selection (default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@EnabledLayers

Value Description

string This corresponds to the NX Part browser Enable option in Layer filtering
mode.

The layers to enable in the import should be listed with the same rules as
for the NX Part browser entry.

@ExportToMasterWeldFile

Value Description

on In batch mode, a master weld file is created.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, no master weld file is created (default).
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Value Description

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@ImportBlanked

Value Description

on In batch mode, imports entities that are hidden, blanked, or no show.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, do not import entities that are hidden, blanked, or no
show (default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves
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Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@ImportParameters

Value Description

on Import parameters.

Parameters are imported even if they are not associated to any geometry.
See also @ParametersPrefix.

For parameters that have relationships to other parameters, parameter
expressions are created.

In addition, @DoNotMergeEdges is automatically set to "on" when using
this option, to give the best results for edge parameter association.

CADIO_FEAT_PARAM_IDS

FULL_NAME

off Do not import parameters (default).

@ImportWaveLinkedGeometry

Value Description

on Import geometry created by the WAVE Geometry Linker.

off Do not import geometry created by the WAVE Geometry Linker (default).

@IncludeWireFrame
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Value Description

on In batch mode, import free curves and points (default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, do not import free curves and points.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MatchUGAssemblyHierarachy

Value Description

on The assembly hierarchy created in HyperMesh is the same as seen in NX.

off An assembly level is created in HyperMesh for parts contained in an
assembly (default).

@MaterialName
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Value Description

string Name of the CAD attribute containing the material name info of the
current part. Default is "P_MAT".

@MeshFlag

Value Description

string Name of the CAD attribute containing the PDM mesh flag name info of the
current part.

Default is "MeshFlag".

@Merge

Value Description

on In batch mode, the MERGE metadata is generated.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, the MERGE metadata is not generated.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@MID

Value Description

string Name of the CAD attribute containing the PDM material ID info of the
current part.
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Value Description

Default is "MID".

@Midsurface

Value Description

on In batch mode, and when @Display= layerfiltering, midsurfaces are
imported.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, and when @Display= layerfiltering, midsurfaces are
not imported (default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@ModelAttributes

Value Description

string In batch mode, this corresponds to the NX Part browser Model attributes
option.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@OriginalIdAsMetadata

Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@ParametersPrefix
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Value Description

string Only import parameters with this prefix. All others will not be imported.

Default is "HW_"; meaningful only if @ImportParameters = "on".

@PartNumber

Value Description

string Name of the CAD attribute containing the PDM part number info of the
current part.

Default is "PartNumber”.

@PID

Value Description

string Name of the CAD attribute containing PDM property ID info of the current
part.

Default is "PID”.

@PropertyName

Value Description

string Name of the properties created in HyperMesh. It can contain “special”
strings that will be replaced with their meaning: <COMPONENT_NAME>
is the name of the component to which the property is associated,
<PROPERTY_CARD_NAME> is the name of the property card. Default is
<COMPONENT_NAME>

@Revision

Value Description

string Name of the CAD attribute containing PDM major revision info of the
current part.

Default is "Revision”.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.778

@SaveSettingsAsDefault

Value Description

on In batch mode, the ug_reader.ini file is saved with the current settings.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, the ug_reader.ini file is not saved (default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SelectedCategories

Value Description

string This corresponds to the NX Part browser option Categories; they should
be listed as they are written in the command file string: “<name1_length>
<name1> <name2_length> <name2>…”, where <name<i>_length> is a
number representing the string length of the ith category name.

@SelectedParts

Value Description

string This corresponds to the NX Part browser Parts selection; they should be
listed as they are written in the command file string: “<handle1_length>
<handle1> <handle2_length> <handle2>…”, where <handle<i>> is a
string representing the handle of the part as retrieved by UGOpen libraries
and <handle<i>_length> is the string length.

@ShowAllCategories
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Value Description

on In batch mode, when @Display= categories, all categories will be
retrieved and displayed.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, when @Display= categories, only categories in the top
assembly will be retrieved and displayed (default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@Solid

Value Description

on In batch mode, when @Display= layerfiltering, solids are imported
(default).

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

off In batch mode, when @Display= layerfiltering, solids are not
imported.

In GUI import when Creation type is set to Assemblies, this initializes the
corresponding option in the NX Part browser.

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Category Generate category-based component.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.780

Value Description

Layer Generate layer-based component.

Material Generate material-based component.

InstanceName, Part,
PartName, PartNumber,
RID-PDI, UGTag

Generate part-based component (and the name is given based on the
specific split value).

Solid Generate solid-based component.

Thickness Generate thickness-based component.

@SplitPeriodicFaces

Value Description

on Split periodic surfaces to improve the quality and robustness of the import
(default).

off Import periodic surfaces as a single surface with a seam edge.

@StitchDifferentSheets

Value Description

on Stitching across different sheet bodies belonging to the same NX part/
instance is enabled (default).

off Stitching across different NX sheet bodies is disabled.

@TagsAsMetadata

Value Description

on
Create entity name as metadata.

TAG

FromBody
Take entity from its parent body and create as metadata.

TAG
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Value Description

off Do not read tags (default).

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@ThicknessName

Value Description

string Name of the CAD attribute containing the PDM thickness info of the
current part. Default is "P_GAUGE".

@UID
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Value Description

string Name of the CAD attribute containing the PDM UID info of the current
part.

Default is "UID".

@UniqueIdAsMetadata

Value Description

on
Create metadata to track the unique CAD ID.

When a Parasolid body is present in the Parasolid assembly, the Parasolid
instance ID is appended to the ORIGINAL_ID using "-". For each assembly
level, its instance ID will be appended in the same way.

For example:

No body entities present in the assembly: 20

Body entities present in a single level assembly: 1-20

Body entities present in a multiple level assembly: 1-4-2-20

The same identifier can be obtained for two entities when a single entity is
split during import.

UNIQUE_ID

off Do not create metadata to track the unique CAD ID (default).

Supported Metadata
Metadata generated from the NX Native reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

CADIO_FEAT_PARAM_IDS
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Type Entities Description

entity

array

points

lines

surfs

solids

This metadata is assigned to the geometric objects
for which the imported parameters apply. One or
more parameters may control a particular object.

This association is only for parameters that
are directly assigned to the object in NX. The
association is not done for any parameters
that may be part of an expression, since
that relationship can be determined from the
parameter expression itself.

Generated when @ImportParameters = on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

DENSITY

Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

FULL_NAME

Type Entities Description

string params Parameters are named with the NX default name.

This contains the full name of the parameter, as
defined in NX.
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Type Entities Description

Generated when @ImportParameters = on

LAYER

Type Entities Description

integer points

lines

surfs

solids

Value of the layer of an entity.

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MERGE

Type Entities Description

integer comps
Set to 1 if the Merge assemblies option is chosen
in the Part browser.

Generated when @Merge = on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles
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Type Entities Description

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

NX_MIDSURFACE

Type Entities Description

integer comps Generated and set to 1 when
@CreationType="TreeOfComponents", if the
component contains midsurface geometry.

ORIGINAL_ID

Type Entities Description

string
points

lines

surfs

solids

parts

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on

TAG

Type Entities Description

string
points

lines

The tag (name) of the entity as read from the CAD
model, if one exists.
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Type Entities Description

edges

surfs

solids

Generated when @TagsAsMetadata = on

UG_DESCRIPTIVE_PARTNAME

Type Entities Description

string
assems

comps

The NX descriptive part name of the assembly/
comp. For example, its attribute DB_PART_DESC.
This is always generated, if present.

UG_PARTNAME

Type Entities Description

string
assems

comps

The NX part name of the assembly/comp. This is
always generated.

UNIQUE_ID

Type Entities Description

string assems

points

lines

surfs

solids

For assemblies the name of the NX assembly.

For geometrical entities a combination of the body
identifiers and the entity ID.

Generated when @UniqueIdAsMetadata = on

<name>

Type Entities Description

integer points The <name> field is the attribute name and the
integer/double/string is the value of the attribute.
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Type Entities Description

double

string

lines

surfs

solids

comps

assems

Generated when @AttributesAsMetadata = on

NX Part Browser
Use the NX Part Browser to filter and select options for importing NX parts and assemblies. The browser
opens when you import an NX file from the Import browser when Creation type is set to Assemblies.

On the left of the browser is the model tree. The parts listed in the model tree are shown either using
the File name or Instance name options. To select a part import, select its check box. If the root is
selected, all parts are considered selected. Root assembly/part is selected by default.

The NX Part Browser searches all part files for weld information as well as mid-surface definitions.

Parts in the assembly that have welds assembled to them are marked with . Parts with mid-surface

definitions are marked with .

On the right of the browser are the available import options.

Display by
Method used to import parts specified in the model tree.

• Choose Categories to import the selected Categories for the parts specified in the model
tree. Some categories may be available in multiple parts/assemblies and some may be
available in only one. You can choose multiple categories to import. All the categories for the
selected parts are imported.

• Choose Layer filtering to import only selected layers for the parts specified in the model
tree. You can specify specific layers to Enable or Disable for import. To designate more than
one layer or a range of layers, use commas and dashes. For example, 1,4-7 designates layers
1, 4, 5, 6 and 7. An asterisk (*) matches everything. Only one of these two options may
be specified. If any layers are specified for Disable, all other layers containing entities are
imported. The default is to enable all layers.

You can additionally choose to import the Midsurface geometry and/or the Solid geometry.
There are three options for Midsurface import.

◦ Choose Off (default) to not import any midsurface geometry.

◦ Choose on to import only the midsurface geometry that is visible.

◦ Choose always to import all midsurface geometry regardless of visibility.

Include wireframe geometry
Import free curves and points. The default is to import these entities.
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Include invisible geometry
Import geometry contained in invisible layers. The default is to not import these entities.

Assign components by name
Customizes the organization and names of components (NX parts). The naming options are
specified using the Format option.

• Choose <Part Name> to use the string attribute DB_PART_NAME from the part. If that
attribute does not exist, the part file name is used.

• Choose <Part Number> to use the string attribute DB_PART_NUMBER or DB_PART_NO from the
part. If that attribute does not exist, the part filename is used.

• Choose <Category> to creates and name components based off of the NX categories
associated with the geometry.

• Choose <RID-PDI> to use the string attribute DB_PART_REV from the part.

• Choose <Layer> to create and name components based off of the layers of the geometry
being imported.

• Choose <Instance Name> to use the name of the part's instance in an assembly. If the
part is the root of an assembly, the part filename is used.

• Choose <Material Name> to use the name of the material if a material is specified for the
geometry being imported. Otherwise, the name of the component is unaltered.

• Choose <Thickness> to use the thickness value if the geometry being imported is a
midsurface with thickness information. Otherwise, the name of the component is unaltered.

• Choose <UG Body ID> to use the internal numerical ID of each geometric body. This value
is unique for each geometric body imported.

• Choose <UG Tag> to use the internal numerical tag of the part instance. This value is
unique for each part instance imported.

Save settings as default
Save the settings into a customized ug.ini file in the current working directory for future use.

Access additional options for coordinate system, weld creation, merging assemblies, and importing of
attributes by clicking Options at the bottom of the browser.

Co-ordinate system
Import an individual part from an assembly in the global coordinate system or its local coordinate
system. If the whole assembly file is selected, it can only be imported in the global coordinate
system.

Create welds in HyperMesh
Create welds, and organized them in a component named ^weld.

• If the part file has mid-surface definition and the Midsurface option is selected while reading
the part, the welds are created between two mid-surfaces.

• If there is no mid-surface definition or the Midsurface option is not selected while importing
the part, the welds are created as they were initially created in the NX part file.

Export to master weld file
Write a master weld file from the weld data that can later be used to create the welds.
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Merge Assemblies
Merge parts with the existing assembly if some parts of an assembly have been previously loaded
and you want to add additional parts from the same assembly.

Model and component attributes
Select the attributes in the NX part file that are to be imported. Currently, the NX readers
have the ability to import any user-defined attributes attached to a NX part, and attach that
information as metadata to the component corresponding to the NX part. Specify the naming
options by clicking Format.

The values setup and used to populate the NX Part Browser are stored in a file named ughm16.txt,
located in the current working directory.

Load Options
The NX Native reader provides additional customization options for loading of NX models. The
ug_load_options.def file can be used for this purpose.

Behavior of the ug_load_options.def file.

• This file can be setup and written out of NX using the File > Options > Assembly Load Options
dialog.

• The NX Native reader passes the options in this file to UGOpen during import, and NX utilizes the
options accordingly

A default version of the ug_load_options.def file is located in the directory [Altair Home]/io/
afc_translators/bin/[platform]. When the NX Native reader is activated, it first checks the current
working directory for the ug_load_options.def file. If the file is not found, the translator uses the
default ug_load_options.def file in the above directory. In this way the ug_load_options.def file
can have "global" or "local" user scope. For instance, "local" user changes for a current job can be made
by copying and modifying the ug_load_options.def file in the local current working directory.

NX Third Party Reader
The NX Third Party reader does not need a valid NX installation or license to access these libraries.

Supported Entities
Entities supported by the NX Third Party reader.

• Points

• All Types of Curves

• Sheet Bodies

• Solid Bodies

• Assemblies

• Coordinate Systems

Import Options
The NX Third Party reader uses the ct_reader.ini file.

@AttributesAsMetadata
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Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

@AvoidThirdPartyConversion

Value Description

on Avoid using the conversion functions provided by third-party (default).

off Use the conversion functions provided by third-party.

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).
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@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

real
Read color attributes of geometric entities as metadata with real values.

COLOR_RGB

on
Same as integer.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DoNotMergeEdges
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Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@FullNameAsMetadata

Value Description

on
Generate the full CAD name, as retrieved from the CAD part, as metadata.
This consists of assembly name/part name/feature name/entity name.

FULL_IDENTIFIER

off Do not generate full name metadata (default).

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.
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Value Description

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY
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Value Description

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MaterialName

Value Description

string Name of the CAD attribute containing the PDM material name info of the
current part.

Default is "Material".

@MeshFlag

Value Description

string Name of the CAD attribute containing the PDM mesh flag name info of the
current part.

Default is "MeshFlag".

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@MID

Value Description

string Name of the CAD attribute containing the PDM material ID info of the
current part.

Default is "MID".

@OriginalIdAsMetadata
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Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@PartNumber

Value Description

string Name of the CAD attribute containing the PDM part number info of the
current part.

Default is "PartNumber”.

@PID

Value Description

string Name of the CAD attribute containing PDM property ID info of the current
part.

Default is "PID”.

@Revision

Value Description

string Name of the CAD attribute containing PDM major revision info of the
current part.

Default is "Revision”.

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.
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@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@SplitPeriodicFaces

Value Description

on Split periodic surfaces to improve the quality and robustness of the import
(default).

off Import periodic surfaces as a single surface with a seam edge.

@StitchingAcrossBodies

Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).

@TagsAsMetadata

Value Description

on
Create entity name as metadata (default).
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Value Description

TAG

FromBody
Take entity from its parent body and create as metadata.

TAG

off Do not read tags.

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@ThicknessName
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Value Description

string Name of the CAD attribute containing the PDM thickness info of the
current part.

Default is "Thickness".

@UID

Value Description

string Name of the CAD attribute containing the PDM UID info of the current
part.

Default is "UID".

Supported Metadata
Metadata generated from the NX Third Party reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

DENSITY
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Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

FULL_IDENTIFIER

Type Entities Description

string
points

lines

surfs

solids

comps

assems

A string indicating the name in the following
format:

"part_name/name"

Generated when @FullNameAsMetadata = on

LAYER

Type Entities Description

integer points

lines

surfs

solids

Value of the layer of an entity.

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT
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Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

string
points

lines

surfs

solids

parts

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on

TAG

Type Entities Description

string
points

lines

edges

surfs

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on
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Type Entities Description

solids

Parasolid Reader

Supported Entities
Entities supported by the Parasolid reader.

• Free points

• Free curves

• Surfaces

• Quilt bodies

• Solid bodies

• Assemblies

Import Options
The Parasolid reader uses the parasolid_reader.ini file.

@AttributesAsMetadata

Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

@AvoidDisjointShells
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Value Description

on Stitch disjoint sheet body surfaces together (default).

off Do not stitch disjoint sheet body surfaces together.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType
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Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@ExtractManifoldFromGeneralBody

Value Description

on Extract the manifold body from a Parasolid general body that is non-
manifold and/or of mixed topological dimensionality (default).

off Extract Parasolid general bodies as defined.

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.
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Value Description

off Do not import entities that are hidden, blanked, or no show (default).

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY
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Value Description

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MaterialName

Value Description

string Name of the CAD attribute containing the PDM material name info of the
current part.

Default is "Material".

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@OriginalIdAsMetadata

Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@PartNumber

Value Description

string Name of the CAD attribute containing the PDM part number info of the
current part.

Default is "PartNumber”.

@ScaleFactor
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Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@SplitComponentsByBody

Value Description

on
Create one component per third-party body. There might be one or more
third-party bodies per third-party component.

This option cannot be used when @ReadCompositeData is enabled, or in
conjunction with @SplitComponentsByPart.

off Do not consider the division of third-party components into third-party
bodies while creating components (default).

@SplitPeriodicFaces

Value Description

on Split periodic surfaces to improve the quality and robustness of the import
(default).
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Value Description

off Import periodic surfaces as a single surface with a seam edge.

@StitchingAcrossBodies

Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).

@TagsAsMetadata

Value Description

on
Create entity name as metadata (default).

TAG

FromBody
Take entity from its parent body and create as metadata.

TAG

off Do not read tags.

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.
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Value Description

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@ThicknessName

Value Description

string Name of the CAD attribute containing the PDM thickness info of the
current part.

Default is "Thickness".

@UID

Value Description

string Name of the CAD attribute containing the PDM UID info of the current
part.

Default is "UID".

@UniqueIdAsMetadata

Value Description

on
Create metadata to track the unique CAD ID (default).

When a Parasolid body is present in the Parasolid assembly, the Parasolid
instance ID is appended to the ORIGINAL_ID using "-". For each assembly
level, its instance ID will be appended in the same way.

For example:
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Value Description

No body entities present in the assembly: 20

Body entities present in a single level assembly: 1-20

Body entities present in a multiple level assembly: 1-4-2-20

The same identifier can be obtained for two entities when a single entity is
split during import.

UNIQUE_ID

off Do not create metadata to track the unique CAD ID.

Supported Metadata
Metadata generated from the Parasolid reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

DENSITY

Type Entities Description

double solids
The value of the density of a solid.
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Type Entities Description

Generated when @DensityAsMetadata = on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

<name>

Type Entities Description

integer

double

points

lines

The <name> field is the attribute name and the
integer/double/string is the value of the attribute.
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Type Entities Description

string surfs

solids

comps

assems

Generated when @AttributesAsMetadata = on

ORIGINAL_ID

Type Entities Description

ORIGINAL_ID points

lines

surfs

solids

parts

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on

TAG

Type Entities Description

string
points

lines

surfs

solids

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on

UNIQUE_ID

Type Entities Description

string
lines

solids

A combination of the body identifiers and the
Parasolid entity ID.

Generated when @UniqueIdAsMetadata = on
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Type Entities Description

surfs

PDGS Reader

Supported Entities
Entities supported by the PDGS reader.

• Entity #5

Import Options
The PDGS reader uses the pdgs_reader.ini file.

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.
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Value Description

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SplitComponents

Value Description

Part Generate part-based component (only allowed value if
CreationType=Parts).
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Value Description

General Keep component as in CAD (only allowed value if
CreationType=TreeOfComponents).

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

Supported Metadata
Metadata generated from the PDGS reader.

LEGACY_HIERARCHY

Type Entities Description

string points

lines

Hierarchy of an entity within a part.
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Type Entities Description

surfs Generated when
@LegacyHierarchyAsMetadata=on

Rhino Reader

Supported Entities
Entities supported by the Rhino reader.

• B-rep geometry

Import Options
The Rhino reader uses the ct_reader.ini file.

@AttributesAsMetadata

Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

@AvoidThirdPartyConversion

Value Description

on Avoid using the conversion functions provided by third-party (default).

off Use the conversion functions provided by third-party.
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@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Read color attributes of geometric entities as metadata.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.
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Value Description

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly
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Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.819

Value Description

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@OriginalIdAsMetadata

Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@ShrinkSurfaces

Value Description

on For trimmed surfaces, shrink the corresponding base surfaces to only
enclose the extents of the external trimming contour, plus a narrow frame.

off Do not modify the base surfaces (default).

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.820

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@StitchingAcrossBodies

Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.
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Value Description

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

Supported Metadata
Metadata generated from the Rhino reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

DENSITY
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Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

LAYER

Type Entities Description

integer points

lines

surfs

solids

Value of the layer of an entity.

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.823

Type Entities Description

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

ORIGINAL_ID points

lines

surfs

solids

parts

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on

<name>

Type Entities Description

integer

double

string

points

lines

surfs

solids

comps

assems

The <name> field is the attribute name and the
integer/double/string is the value of the attribute.

Generated when @AttributesAsMetadata = on

SolidWorks Reader

Supported Entities
Entities supported by the SolidWorks reader.

• Free points

• Free curves

• Surfaces
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• Solid bodies

• Assemblies

Entities with non-latin characters in their names are supported.

Import Options
The SolidWorks reader uses the ct_reader.ini file.

@AttributesAsMetadata

Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

@AvoidThirdPartyConversion

Value Description

on Avoid using the conversion functions provided by third-party (default).

off Use the conversion functions provided by third-party.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).
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@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

on
Same as integer.

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.
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@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).
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Value Description

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MaterialName

Value Description

string Name of the CAD attribute containing the PDM material name info of the
current part.

Default is "Material".
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@MeshFlag

Value Description

string Name of the CAD attribute containing the PDM mesh flag name info of the
current part.

Default is "MeshFlag".

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@MID

Value Description

string Name of the CAD attribute containing the PDM material ID info of the
current part.

Default is "MID".

@OriginalIdAsMetadata

Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@PartNumber

Value Description

string Name of the CAD attribute containing the PDM part number info of the
current part.
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Value Description

Default is "PartNumber”.

@PID

Value Description

string Name of the CAD attribute containing PDM property ID info of the current
part.

Default is "PID”.

@Revision

Value Description

string Name of the CAD attribute containing PDM major revision info of the
current part.

Default is "Revision”.

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents
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Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@SplitComponentsByBody

Value Description

on
Create one component per third-party body. There might be one or more
third-party bodies per third-party component.

off Do not consider the division of third-party components into third-party
bodies while creating components (default).

@SplitPeriodicFaces

Value Description

on Split periodic surfaces to improve the quality and robustness of the import
(default).

off Import periodic surfaces as a single surface with a seam edge.

@StitchingAcrossBodies

Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).
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Value Description

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@ThicknessName

Value Description

string Name of the CAD attribute containing the PDM thickness info of the
current part.

Default is "Thickness".

@UID

Value Description

string Name of the CAD attribute containing the PDM UID info of the current
part.
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Value Description

Default is "UID".

Supported Metadata
Metadata generated from the SolidWorks reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

DENSITY

Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

LAYER

Type Entities Description

integer points

lines

Value of the layer of an entity.
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Type Entities Description

surfs

solids

Generated when @LayerAsMetadata=on

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

string
points The original CAD entity ID.
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Type Entities Description

lines

surfs

solids

parts

Generated when @OriginalIdAsMetadata = on

TAG

Type Entities Description

string
points

lines

edges

surfs

solids

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on

STEP Reader

Supported Entities
Entities supported by the STEP reader.

• Coordinate systems

• Free points

• Free curves

• Surfaces

• Quilt bodies

• Solid bodies

• Facets/triangles

• Assemblies

Entities with non-latin characters in their names are supported.

Import Options
The STEP reader uses the ct_reader.ini file.

@AttributesAsMetadata
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Value Description

on
Import all generic attributes (global and related to single entities) as
metadata.

off Do not import attributes related to single entities. Only import global
attributes.

%attribute1%attribute2%attribute3
Import specified generic attributes as metadata.

The attribute names are listed, separated by a character that you choose,
and inserted as the first element of the string. The example uses '%' as a
separator. You can choose another character as a separator, in case one of
the listed attribute names contains '%'. HyperMesh will recognize it as it is
the first character of the string.

@AvoidThirdPartyConversion

Value Description

on Avoid using the conversion functions provided by third-party (default).

off Use the conversion functions provided by third-party.

@BodyIdAsMetadata

Value Description

on Assign body identifier as metadata.

BODY_ID

off Do not assign body identifier as metadata (default).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.
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@ColorsAsMetadata

Value Description

integer
Read color attributes of geometric entities as metadata with integer
values.

COLOR_RGB

real
Read color attributes of geometric entities as metadata with real values.

COLOR_RGB

on
Same as integer.

COLOR_RGB

off Do not read color attributes (default).

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DensityAsMetadata

Value Description

on
Read density value as metadata (default).

DENSITY

off Do not read density value.

@DoNotMergeEdges
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Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@FullNameAsMetadata

Value Description

on
Generate the full CAD name, as retrieved from the CAD part, as metadata.
This consists of assembly name/part name/feature name/entity name.

FULL_IDENTIFIER

off Do not generate full name metadata (default).

@ImportBlanked

Value Description

on Import entities that are hidden, blanked, or no show.

off Do not import entities that are hidden, blanked, or no show (default).

@ImportCoordinateSystems

Value Description

on Import CAD coordinate systems as system collectors (default).

off Do not import CAD coordinate systems.

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.
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Value Description

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LayerAsMetadata

Value Description

on Read layer value as metadata.

LAYER

off Do not read layer value (default).

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY
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Value Description

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MaterialName

Value Description

string Name of the CAD attribute containing the PDM material name info of the
current part.

Default is "Material".

@MeshFlag

Value Description

string Name of the CAD attribute containing the PDM mesh flag name info of the
current part.

Default is "MeshFlag".

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.

@MID

Value Description

string Name of the CAD attribute containing the PDM material ID info of the
current part.

Default is "MID".

@OriginalIdAsMetadata
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Value Description

on Import original CAD entity IDs as metadata.

ORIGINAL_ID

off Do not import original CAD entity IDs as metadata (default).

@PartNumber

Value Description

string Name of the CAD attribute containing the PDM part number info of the
current part.

Default is "PartNumber”.

@PID

Value Description

string Name of the CAD attribute containing PDM property ID info of the current
part.

Default is "PID”.

@Revision

Value Description

string Name of the CAD attribute containing PDM major revision info of the
current part.

Default is "Revision”.

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.
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@ShrinkSurfaces

Value Description

on For trimmed surfaces, shrink the corresponding base surfaces to only
enclose the extents of the external trimming contour, plus a narrow frame.

off Do not modify the base surfaces (default).

@SkipCreationOfSolid

Value Description

on Read surfaces, but do not create solid entities.

off Create solid entities (default).

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Layer Generate layer-based component.

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@SplitComponentsByBody

Value Description

on
Create one component per third-party body. There might be one or more
third-party bodies per third-party component.

This option cannot be used when @ReadCompositeData is enabled, or in
conjunction with @SplitComponentsByPart.

off Do not consider the division of third-party components into third-party
bodies while creating components (default).

@StitchingAcrossBodies
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Value Description

on Stitch surfaces belonging to different components.

off Do not stitch surfaces belonging to different components (default).

@TagsAsMetadata

Value Description

on
Create entity name as metadata (default).

TAG

FromBody
Take entity from its parent body and create as metadata.

TAG

off Do not read tags.

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.
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Value Description

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).

@ThicknessName

Value Description

string Name of the CAD attribute containing the PDM thickness info of the
current part.

Default is "Thickness".

@UID

Value Description

string Name of the CAD attribute containing the PDM UID info of the current
part.

Default is "UID".

Supported Metadata
Metadata generated from the STEP reader.

BODY_ID

Type Entities Description

string points

lines

surfs

Identifier of the CAD body containing the entity.

Generated when @BodyIDAsMetadata=on

COLOR_RGB

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.844

Type Entities Description

string
points

lines

surfs

solids

Three RGB values, ranging from 0 to 255,
indicating the color of the entity in the CAD model.

Generated when @ColorsAsMetadata = on

DENSITY

Type Entities Description

double solids
The value of the density of a solid.

Generated when @DensityAsMetadata = on

FULL_IDENTIFIER

Type Entities Description

string
points

lines

surfs

solids

comps

assems

A string indicating the name in the following
format:

"part_name/name"

Generated when @FullNameAsMetadata = on

LAYER

Type Entities Description

integer points

lines

surfs

Value of the layer of an entity.

Generated when @LayerAsMetadata=on
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Type Entities Description

solids

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

MODELUNIT

Type Entities Description

integer comps

parts

Model units specified in the CAD file.

1 = inches

2 = millimeters

4 = feet

5 = miles

6 = meters

7 = kilometers

8 = mils

9 = microns

10 = centimeters

11 = microinches

12 = decimeters

13 = yards

This is always generated.

ORIGINAL_ID

Type Entities Description

string
points

lines

The original CAD entity ID.

Generated when @OriginalIdAsMetadata = on
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Type Entities Description

surfs

solids

parts

TAG

Type Entities Description

string
points

lines

edges

surfs

solids

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on

VDAFS Reader

Supported Entities
Entities supported by the VDAFS reader.

• POINT

• LINE

• PLANE

• PSET

• MDI

• CIRCLE

• CURVE

• SURF

• FACE

Import Options
The VDAFS reader uses the vdafs_reader.ini file.

@BreakAngle
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Value Description

double A negative value (default) indicates that the curves are being split at C1
discontinuities.

A positive value indicates that curves are being split at G1 discontinuities
with an angle greater than the given value (expressed in radians).

@CleanupTol

Value Description

double A negative value (default) indicates to use the auto cleanup tolerance. A
value greater than the calculated auto cleanup tolerance indicates to use
that specific tolerance. Refer to the CAD Cleanup Tolerance.

@CreationType

Value Description

Parts Generate a full part-based hierarchy.

BOMOnly Generate an empty part-based hierarchy.

TreeOfComponents Generate an assemblies/components based hierarchy.

PackIntoSinglePart Consolidate hierarchy into a single part.

@DoNotMergeEdges

Value Description

on Preserve the original geometry edges, instead of merging them together
during the import cleanup phase.

off Merge edges together during the import cleanup phase (default).

@ImportForVisualizationOnly

Value Description

on
Import the model for visualization purposes only.
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Value Description

This skips many of the import steps (cleanup, stitching, solid creation, and
so on) to provide a faster import. The resulting model may not be suitable
for other uses.

off Import the model in the normal fashion (default).

@ImportFreeCurves

Value Description

on Import free curves (wireframe entities) into the model (default).

off Do not import free curves.

@ImportFreePoints

Value Description

on Import free points into the model (default).

off Do not import free points.

@LegacyHierarchyAsMetadata

Value Description

on Generate metadata with the original CAD hierarchy within the part.

LEGACY_HIERARCHY

off Do not generate metadata with the original CAD hierarchy within the part
(default).

@MetadataPrefix

Value Description

string The string is prefixed to all metadata names. No prefix is used by default.

See CAD Metadata Naming for more details.
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@ParameterTolerance

Value Description

Any positive real
number.

The reader considers this tolerance as the parametric tolerance used to
process the CAD data. The default value is 1.00E-06.

@Planes

Value Description

on Treat each surface as found in the CAD file (planes/NURBS).

off Convert planes into NURBS surfaces.

preferred Convert NURBS surfaces to planes if they are within the object space
tolerance of being planar (default).

@ScaleFactor

Value Description

double Define the model scaling factor during import.

Default is 1.0.

@SplitComponents

Value Description

Body Generate body-based component (default if CreationType=Parts).

Part Generate part-based component.

General Keep component as in CAD (default if CreationType=TreeOfComponents).

@StraightPolynomials

Value Description

on Treat each polynomial segment as a straight line segment. This is
necessary for reading some VDAFS files, COMPUTERVISION CADDS 4X in
particular.
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Value Description

off Treat each polynomial as found in the CAD file (default).

@TagsAsMetadata

Value Description

on
Read tags of supported entities as metadata (default).

TAG

off Do not read tags.

@TargetUnits

Value Description

CAD units Keep the units of the CAD files (default for GUI).

MKS [m kg N s] Convert to the corresponding units system.

MMKS [mm kg N s] Convert to the corresponding units system.

MPA [mm t N s] Convert to the corresponding units system.

CGS [cm g dyn s] Convert to the corresponding units system.

MMKNMS [mm kg kN ms] Convert to the corresponding units system.

MMGNMS [mm g N ms] Convert to the corresponding units system.

IPS Std [in pounds lbf
s]

Convert to the corresponding units system.

IPS Grav [in slinch
lbf s]

Convert to the corresponding units system.

FPS Std [ft pounds lbf
s]

Convert to the corresponding units system.

FPS Grav [ft slug lbf
s]

Convert to the corresponding units system.

Scale factor Apply the corresponding scale factor (default for no GUI to allow
supporting legacy scripts).
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@Tolerance

Value Description

Any positive real
number.

The reader considers this tolerance as the object space tolerance used to
process the CAD data. The default value is 0.01.

Supported Metadata
Metadata generated from the VDAFS reader.

LEGACY_HIERARCHY

Type Entities Description

string points

lines

surfs

Hierarchy of an entity within a part.

Generated when
@LegacyHierarchyAsMetadata=on

TAG

Type Entities Description

string
points

lines

surfs

The tag (name) of the entity as read from the CAD
model, if one exists.

Generated when @TagsAsMetadata = on

CAD Import Options
CAD readers provide options for processing data during import.

You can access some of these options from the Import browser, while other options are accessed from a
reader's _reader.ini file.

Hierarchy as
Type of hierarchy to generate.

• Choose Assemblies to generate an assemblies/components based hierarchy.

• Choose BOM Only to generate an empty part-based hierarchy.

• Choose Parts to generate a full part-based hierarchy.

• Choose Single part only to consolidate the hierarchy into a single part.
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Split components by
Strategy used to split components, which is dependent on the CAD format.

• Choose Body to generate a body-based component.

• Choose Layer to generate a layer-based component.

• Choose Part to generate a part-based component.

Target units
Target unit system to be adopted for the imported model.

• Choose a specific unit.

• Choose CAD units to match the unit system to the CAD file being imported. If the target unit
system does not match the CAD file being imported, than the corresponding numbers are
modified to account for the unit change.

• Alternatively, choose Scale Factor to adopt the CAD unit system and scale the entities by
the indicated factor.

Cleanup to
Refer to CAD Cleanup Tolerance.

Import hidden (blanked/no show) entities
Import entities that are hidden, blanked, or no show for relevant formats.
See each format's available import options for details. Not all CAD formats supported.

Import composite data
Read Composite Part Design (CPD) data from CATIA files into HyperMesh.

Restriction:  Only available in CATIA format.

Read hidden ply base surfaces
Read hidden ply base surfaces.

Restriction:  Only available when Import composite data is enabled for the CATIA
format.

Trim ply surfaces
Trim ply base surfaces during import.

Restriction:  Only available when Import composite data is enabled for the CATIA
format.

Ply contour gap tolerance
Ply contour gap tolerance (default 0.3).

Restriction:  Only available when Import composite data is enabled for the CATIA
format.

Import publication data
Create regions from the geometry referenced in the publication.
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Restriction:  Only available in CATIA format.

Do not merge edges
Preserve the original breakdown of edges.
By default edges are merged together, when possible, during import as part of the cleanup phase.

Global Analysis
Create just landing curves for stiffener/beam/ER systems, unless the ini option
@ImportStiffenerMidSurfaces is "on" in which case both landing curves and stiffener/beam/ER
geometry midsurfaces will be created.
When disabled, stiffener/beam/ER geometry is created (complete solid or just midsurfaces
depending on the ini option), while landing curves are not created.

Restriction:  Only available for Intergraph format.

Split periodic faces
Split periodic faces during CAD import (default).

Restriction:  Only available for Inspire, JT, NX native, NX third-party, Parasolid, and
SolidWorks readers.

Use native reader
Enable a native reader, requiring original CAD software and licenses, to be used.

Restriction:  Only available for NX format.

This method of import, along with feature- based meshing technology, provides a robust way to
create high quality CAE solid tetrahedral mesh models without a lot of geometry cleanup.

User defined
Use this GUI field to enter additional options not explicitly exposed in the GUI, in the form
option1_name=option1_value, option2_name=option2_value, and so on. If an option also
exposed in the GUI is mentioned in this field, the value of this field prevails.

Default versions of the _reader.ini files are included in the directory [Altair Home]/io/
afc_translators/bin/[platform] directory and its children. When a CAD reader is activated, each
reader first checks the current working directory for the appropriate _reader.ini file. If the file is not
found, the translators looks in all directories pointed by the HW_CONFIG_PATH environment variable.

As a last resort, the translator uses the default _reader.ini file in the above directory. In this way the
_reader.ini file can have "global" or "local" user scope. For instance, "local" user changes for a current
job can be made by copying and modifying the _reader.ini file in the local current working directory.

Options can take on only one value at a time. Options can also be commented out (ignored) by placing
a # in front of an option, in which case the default value for that option will be used.

The available _reader.ini options are explained in detail within the Import Options sections for each
reader.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
CAD Interfaces p.854

Many CAD translators also import other relevant information as metadata attached to specific entities
(assemblies, components, points, lines, surfaces, solids). Some metadata is generated by default while
other metadata is generated by enabling/disabling certain options in the _reader.ini files. Metadata is
stored in the database and can be used for review or to perform process automation. For example, you
can obtain the tag (name) of a surface from the CAD file and apply certain mesh criteria to that surface
inside HyperMesh. Refer to the Import Options topics for each format and CAD Metadata Naming for
specific details about metadata.

CAD Import Message Files
Each reader reads the CAD file and sends the geometry information to HyperMesh. When a CAD file is
read, a .msg file is created (or appended to) in the current working directory.

For example, the file iges_reader.msg is created for the IGES reader.

Three types of messages appear in the .msg file.

Info
Includes information about the file being read.

Warning
Indicates that data was modified.

Error
Indicates when a geometric entity could not be created.

These files can be useful for debugging errors found during import.

For CATIA and JT formats, those files (respectively ct_raedr.msg and jt_reader.msg) will contain
detailed information about imported assembly files.

CAD Import Difficulties
Learn about possible difficulties you may encounter during CAD import.

If a line does not import correctly and has gaps, the gaps are filled with straight lines. If necessary,
pieces of composite curves are reversed to make the entire line continuous. Lines shorter than the
object space tolerance are rejected.

A line cannot intersect itself. This condition is not detected, and results may be incorrect if this kind of
line is imported. A closed loop can have coincident starting and ending points.

Untrimmed surfaces are corrected if they do not import correctly. Internal gaps (C0-discontinuity)
are removed by blending each edge of the gap together. Breaks at C1-discontinuities are controlled
internally and may accept lower-level continuities depending on the reader's internal tolerance. While
surfaces with one or two dimensions smaller than the object space tolerance are not prohibited, it is
likely that they may be rejected.

Each point in the interior of the surface’s parameter space should map to a distinct point in object
space. This condition is not detected and incorrect results may occur if such a surface is imported. A
surface may be closed in one or both directions.
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Trimmed surfaces are a combination of untrimmed surfaces and one or more lines. The above
restrictions apply to trimmed surfaces. If a surface cannot be trimmed, as much geometry information
as possible is supplied. In most cases, both the underlying surface and its lines are created. It is then
possible to use the Surface Edit panel to trim the surface manually.

It is also useful to refer to the .msg files generated by each CAD reader to find warnings/errors that
may help in resolving import difficulties.

CAD Metadata Naming
The metadata names generated by the CAD readers are composed of a general prefix followed by a
metadata specific name. The prefix is specified using the @MetadataPrefix option in each _reader.ini
file.

The @MetadataPrefix option works as follows:

• The string you specify is appended as a prefix to the metadata name generated by that reader. The
prefix is used explicitly with the metadata name. No . (period) is automatically added if it is not
specified by the option. For example:

@MetadataPrefix = ".ALTAIR.HW"

.ALTAIR.HW<metadata name>

@MetadataPrefix = ".ALTAIR.HW."

.ALTAIR.HW.<metadata name>

• If the option is commented out, or the value is set to null "", no prefix is prepended and only the
names of the metadata are used. For example:

@MetadataPrefix = ""

<metadata name>

• There are some pre-defined strings that have specific meaning. These pre-defined strings are
automatically substituted with specific data where applicable. These strings are as follows:

<FORMAT> - the format of the CAD file (CATIA, STEP, NX, and so on)

<VERSION> - the version of the CAD file. For CATIA, this is V4 or V5. For NX, this is any NX
version (for example, NX 10.0, NX 11.0, and so on). No other format currently supports this
option. In the case where there is no <VERSION> possible, an empty string is substituted.

• All other strings are used verbatim. For example:

@MetadataPrefix = "<MYSTRING>"

<MYSTRING><metadata name>

• By default, the prefix is empty string for all readers. To maintain consistency with metadata names
used by previous versions, a value of ".ALTAIR.HW.<FORMAT>." is appropriate.

Additional Examples:

@MetadataPrefix = ".ALTAIR.HW.<FORMAT>."

.ALTAIR.HW.CATIA.<metadata name>

@MetadataPrefix = "/ALTAIR/HW/<FORMAT>/"

/ALTAIR/HW/CATIA/<metadata name>
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@MetadataPrefix = "<FORMAT><VERSION>."

CATIAV5.<metadata name>

@MetadataPrefix = "<FORMAT>.<VERSION>."

CATIA.V5.<metadata name>
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CAD Export
Learn about the CAD readers supported by HyperMesh and the options available for exporting CAD
geometry data.

CAD writers are dynamically loaded upon demand.

Supported CAD Writers
CAD writers supported by HyperMesh.

Format Latest Version Supported File Extensions Supported

CATIA Composites Link .h5

FiberSim .h5

IGES v6.0

JAMA-IS

.iges

.igs

Inspire 2018.1 .stmod

JT 10.2 .jt

Parasolid v30.0.185 .x_t

.x_b

.xmt_txt

.xmt_bin

STEP AP214 .step
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Format Latest Version Supported File Extensions Supported

.stp

CATIA Composites Link Writer
Use the CATIA Composites Link option to export composite drape data.

FiberSim Writer
Use the FiberSim option to export composite data.

IGES Writer

Supported Entities
Entities supported by the IGES writer.

• Subfigure Definition (308)

• Singular Subfigure Instance (408)

• Composite curve (102)

• Plane (108)

• Line (110)

• Point (116)

• Rational B-spline curve (126)

• Rational B-spline surface (128)

• Curve on a parametric surface (142)

• Trimmed (parametric) surface (144)

• Form 7 group without back pointers (402)

• Transformation Matrix (124)

• Name Property (406 Form 15)

• Color Definition (314)

Fixed points (those associated with lines or surfaces) are not supported by the IGES standard and are
not exported. In order to export fixed points, it is necessary to convert them to free points. Then, after
import, those free points must be projected onto the appropriate lines or surfaces in order to generate
fixed points with the proper association.

Export Options
When IGES data is exported, it writes lines in a form resembling the database. Each segment on the
line becomes a separate curve in IGES. If there is more than one segment in the line, the resulting
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curves in IGES are joined together with a composite curve entity. NURBS curves and ellipses are written
as rational b-spline curves (IGES's rational B-splines are general NURBS).

Surface faces that comprise each surface are written to allow for output type options. NURBS surfaces
are output as rational B-spline surfaces in IGES are cones, spheres, and tori. If necessary, curves on
parametric surfaces and trimmed surface entities are used to trim the NURBS surface.

The IGES writer uses the iges_writer.ini file with the following available options:

@AssemblyMode

Value Description

Parts Create subfigure definition entity (308) and singular subfigure instance
entity (408) from the part entity (default).

Assemblies Create subfigure definition entity (308) and singular subfigure instance
entity (408) from the assembly entity.

Layers Send each component as a different layer (level) in the IGES file. This is
the most efficient format.

Groups Send each component as an associative instance entity (type 402, form
7).

LayersAndGroups Send each component as a different layer (level), and send each set of
faces comprising one surface as an associativity instance (group).

@AuthorName

Value Description

string String to write in the IGES author name field.

Default is Unknown.

@AuthorOrganization

Value Description

string String to write in the IGES author organization field.

Default is Unknown.

@Export
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Value Description

All Export all geometry (default).

Displayed Export displayed geometry only.

@NameFromRepresentation

Value Description

on Assign part name in CAD file from the representation file name and attach
it to the part entity.

Meaningful only if AssemblyMode = "Parts".

off Assign part name in CAD file from the part entity name in HyperMesh.

Meaningful only if AssemblyMode = "Parts".

@OptimizeForCAD

Value Description

on Fix gaps between stitched edges and vertices to make the actual geometry
of the surfaces consistent with the model topology before export, and
check the topology of the model for gaps that are larger than a given
tolerance between shared, non-manifold, or suppressed edges. If the gap
is found to be bigger than the tolerance, the surface and edge geometries
are morphed parametrically and in 3D, if necessary, to make the gap
smaller than the tolerance. In addition, non-essential degenerate edges
are removed. This also modifies the geometry within HyperMesh (default).

off Do not perform the optimization steps.

@OuterLoop

Value Description

Optional1 The IGES 6.0 standard allows you to default to the natural outer loop of
the surface being trimmed. If you are trimming a NURBS surface with
several holes and no exterior trimming, the outer loop can be left out
of the IGES file, making the surface representation shorter and more
accurate. Use this option if it is supported by your IGES post-processor
(default). This is not available with the JAMA-IS standard.
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Value Description

Mandatory2 For those post-processors that do not allow an optional outer loop, this
option forces an outer loop to be written for trimmed surfaces.

@SourceUnits

Value Description

MKS (m kg N s)

MMKS (mm kg N s)

MPA (mm t N s)

CGS (cm g dyn s)

MMKNMS (mm kg kN
ms)

MMGNMS (mm g N ms)

IPS Std (in pounds
lbf s)

IPS Grav (in
slinch lbf s)

FPS Std (ft pounds
lbf s)

FPS Grav (ft slug
lbf s)

Assign unit system to the data present in HyperMesh during export.

@TargetUnits

Value Description

Microns

Millimeters

Centimeters

Meters

Kilometers

Microinches

Mils

Inches

Feet

Units system written in the IGES file.
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Value Description

Miles

1. The most efficient form is JAMA planes and the Outer Loop Optional option; however, this choice
may cause compatibility difficulties.

2. To be JAMA-IS compatible, select the JAMA planes and the Outer Loop Mandatory options.

Inspire Writer

Supported Entities
Entities supported by the Inspire writer.

• Model

• Assembly

• Part

• Solid

• Sheet

• Curve

• Point

• Axis System

Export Option
The Inspire writer uses the inspire_writer.ini file with the following available options:

@AssemblyMode

Value Description

Parts Create part entity hierarchy as assembly and part entity in Inspire.

Assemblies Create assembly and component entity as assembly and part entity in
Inspire.

Flatten Write entities in all components into a single Inspire part.

@Export

Value Description

All Export all geometry (default).
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Value Description

Displayed Export displayed geometry only.

@GeometryMode

Value Description

Standard Write CAD geometry with standard types such as cylinder, cone, circle,
and so on (default).

BSpline Convert all surface geometry data into NURBS. This option may increase
the output file size and be time consuming depending on the actual
geometry.

@NameFromRepresentation

Value Description

on Assign part name in CAD file from the representation file name attached
to part entity.

Meaningful only if AssemblyMode = "Parts".

off Assign part name in CAD file from the part entity name in HyperMesh.

Meaningful only if AssemblyMode = "Parts".

@OptimizeForCAD

Value Description

on Fix gaps between stitched edges and vertices to make the actual geometry
of the surfaces consistent with the model topology before export, and
check the topology of the model for gaps that are larger than a given
tolerance between shared, non-manifold, or suppressed edges. If the gap
is found to be bigger than the tolerance, the surface and edge geometries
are morphed parametrically and in 3D, if necessary, to make the gap
smaller than the tolerance. In addition, non-essential degenerate edges
are removed. This also modifies the geometry within HyperMesh (default).

off Do not perform the optimization steps.

@SourceUnits
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Value Description

MKS (m kg N s)

MMKS (mm kg N s)

MPA (mm t N s)

CGS (cm g dyn s)

MMKNMS (mm kg kN
ms)

MMGNMS (mm g N ms)

IPS Std (in pounds
lbf s)

IPS Grav (in
slinch lbf s)

FPS Std (ft pounds
lbf s)

FPS Grav (ft slug
lbf s)

Unit system assigned to the data present in HyperMesh during export

@TargetUnits

Value Description

MKS (m kg N s)

MMKS (mm kg N s)

MPA (mm t N s)

CGS (cm g dyn s)

MMKNMS (mm kg kN
ms)

MMGNMS (mm g N ms)

IPS Std (in pounds
lbf s)

IPS Grav (in
slinch lbf s)

FPS Std (ft pounds
lbf s)

FPS Grav (ft slug
lbf s)

Units system in the Inspire file.

@TopologyMode
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Value Description

Solid/Shell Export topology data similar to HyperMesh topology data, keeping the
distinction between solids and shells (default).

Surface Export each surface, including solid faces, as a single surface, effectively
neglecting connectivity.

@Version

Value Description

string Inspire version to use for export. Valid versions are 2018.1 (default),
2017.1

JT Writer

Supported Entities
Entities supported by the JT writer.

• Point

• Line

• Surface

• Solid

• Part

• Assembly

• Elements are exported as tessellations as follows:

◦ tria3 elements

◦ quad4 elements, each split into two triangles

◦ tetra4 element faces

◦ penta6 element faces, with each quad face split into two triangles

◦ hex8 element faces, with each face split into two triangles

Export Options
The JT export option is extensively used inside CAD modeling and PLM systems to quickly visualize
a products structure and to compare changes between revisions of CAD and FE models. Select the
JT export option to export all of the model's geometry and FE element information, component
organization, and property color.

The JT writer uses the jt_writer.ini file with the following available options:

@AllowDisjointShells
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Value Description

on Store non-manifold geometry in one disjoint feature.

off Split and store non-manifold geometries as separate joint shell features
(default).

@AssemblyMode

Value Description

Parts Create part entity hierarchy as assembly and part entity in JT.

Assemblies Create assembly and component entity as assembly and part entity in JT.

Flatten Write entities in all components into a single JT Part.

n

@AttributeForMaterialName

Value Description

string Attribute created with the name contains PDM metadata-material name
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Material".

@AttributeForMeshFlag

Value Description

string Attribute created with the name contains PDM metadata-mesh flag
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "MeshFlag".

@AttributeForMID
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Value Description

string Attribute created with the name contains PDM metadata-material ID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "MaterialId".

@AttributeForPartNumber

Value Description

string Attribute created with the name contains PDM metadata-part number
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "PartNumber".

@AttributeForPID

Value Description

string Attribute created with the name contains PDM metadata-property ID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "PID".

@AttributeForRevision

Value Description

string Attribute created with the name contains PDM metadata-revision
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Revision".

@AttributeForThickness
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Value Description

string Attribute created with the name contains PDM metadata-thickness
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Thickness".

@AttributeForUID

Value Description

string Attribute created with the name contains the PDM metadata-UID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "UID".

@CreateTessellation

Value Description

on Create tessellations even when no mesh is exported (default).

off Create just the tessellations corresponding to the exported mesh.

@Export

Value Description

all Export all geometry (default).

displayed Export displayed geometry only.

@FileMode

Value Description

Monolithic Create a single JT file.

PerPart Create a JT file “Per part”.
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Value Description

For example, there is a JT file containing the main assembly and each part
is stored in an individual JT file in a subdirectory with the same name as
the main JT file (default).

@GeometryMode

Value Description

Standard Write CAD geometry with standard types such as cylinder, cone, circle,
and so on (default).

BSpline Convert all surface geometry data into NURBS. This option may increase
the output file size and be time consuming depending on the actual
geometry.

@MetadataPrefixFilter

Value Description

string Prefix to use to find metadata to export. Only metadata with the specified
prefix is exported. Any metadata without this prefix is not exported.
Default is empty, meaning all metadata will be exported.

@NameFromRepresentation

Value Description

on Assign part name in CAD file from the representation file name attached
to part entity.

Meaningful only if AssemblyMode = "Parts".

off Assign part name in CAD file from the part entity name in HyperMesh.

Meaningful only if AssemblyMode = "Parts".

@OptimizeForCAD

Value Description

on Fix gaps between stitched edges and vertices to make the actual geometry
of the surfaces consistent with the model topology before export, and
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Value Description

check the topology of the model for gaps that are larger than a given
tolerance between shared, non-manifold, or suppressed edges. If the gap
is found to be bigger than the tolerance, the surface and edge geometries
are morphed parametrically and in 3D, if necessary, to make the gap
smaller than the tolerance. In addition, non-essential degenerate edges
are removed. This also modifies the geometry within HyperMesh (default).

off Do not perform the optimization steps.

@RemoveMetadataPrefix

Value Description

on Remove the metadata prefix for export.

Meaningful only if @MetadataPrefixFilter is enabled and non-empty.

off Do not remove the metadata prefix for export (default).

Meaningful only if @MetadataPrefixFilter is enabled and non-empty.

@SourceUnits

Value Description

MKS (m kg N s)

MMKS (mm kg N s)

MPA (mm t N s)

CGS (cm g dyn s)

MMKNMS (mm kg kN
ms)

MMGNMS (mm g N ms)

IPS Std (in pounds
lbf s)

IPS Grav (in
slinch lbf s)

FPS Std (ft pounds
lbf s)

FPS Grav (ft slug
lbf s)

Unit system assigned to the data present in HyperMesh during export
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@TargetUnits

Value Description

Microns

Millimeters

Centimeters

Decimeters

Meters

Kilometers

Mils

Inches

Feet

Yards

Miles

Units System in the exported JT file.

@TopologyMode

Value Description

Solid/Shell Export topology data similar to HyperMesh topology data, keeping the
distinction between solids and shells (default).

Surface Export each surface, including solid faces, as a single surface, effectively
neglecting connectivity.

@Version

Value Description

string The JT version to use for export. Valid versions are 10.2 (default), 10.1,
10.0, 9.5, 9.4, 9.3, 9.2, 9.1, 9.0, 8.1, 8.1, 8.0, 7.0 or 6.4.

@WriteColorFrom

Value Description

string Specify colors for the geometrical entities during export. Colors are
supported at the component level only, whereas individual entity colors
(points, lines, surfaces, solids) are not supported.
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Value Description

Valid values are Component (default) and Metadata.

@WriteMetaDataAsColor

Value Description

string Speciify the metadata to use for coloring entities.

Default is COLOR_RGB.

Meaningful only if @WriteColorFrom = "Metadata".

@WriteMetaDataAsName

Value Description

string Specify the metadata to use for naming entities.

Default is TAG.

Meaningful only if @WriteNameFrom = "Metadata".

@WriteNameFrom

Value Description

string Specify names for the geometrical entities during export. Names are
supported at the component level only, whereas individual entity names
(points, lines, surfaces, solids) are not supported.

Valid values are Component and Metadata (default).

Parasolid Writer

Supported Entities
Entities supported by the Parasolid writer.

• Assembly

• Part

• Solid

• Surface
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• Curve

• Free Point

Entities not supported by the Parasolid writer.

• Axis system

• Vector

Export Options
The Parasolid reader uses the parasolid_writer.ini file with the following available options:

@AllowDisjointShells

Value Description

on Store non-manifold geometry in one disjoint feature.

off Split and store non-manifold geometries as separate joint shell features
(default).

@AssemblyMode

Value Description

Parts Create part entity hierarchy as assembly and part entity in Parasolid.

Assemblies Create assembly and component entity as assembly and part entity in
Parasolid.

Flatten Write entities in all components into a single Parasolid part.

@AttributeForMaterialName

Value Description

string Attribute created with the name contains PDM metadata-material name
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Material".

@AttributeForMeshFlag
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Value Description

string Attribute created with the name contains PDM metadata-mesh flag
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "MeshFlag".

@AttributeForMID

Value Description

string Attribute created with the name contains PDM metadata-material ID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "MaterialId".

@AttributeForPartNumber

Value Description

string Attribute created with the name contains PDM metadata-part number
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "PartNumber".

@AttributeForPID

Value Description

string Attribute created with the name contains PDM metadata-property ID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "PID".

@AttributeForRevision
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Value Description

string Attribute created with the name contains PDM metadata-revision
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Revision".

@AttributeForThickness

Value Description

string Attribute created with the name contains PDM metadata-thickness
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Thickness".

@AttributeForUID

Value Description

string Attribute created with the name contains the PDM metadata-UID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "UID".

@Export

Value Description

all Export all geometry (default).

displayed Export displayed geometry only.

@GeometryMode

Value Description

Standard Write CAD geometry with standard types such as cylinder, cone, circle,
and so on (default).
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Value Description

BSpline Convert all surface geometry data into NURBS. This option may increase
the output file size and be time consuming depending on the actual
geometry.

@HMOrignalIdAsAttribute

Value Description

on Write HyperMesh entity Identifier as HM_ORIGINAL_ID attribute

off Do not export HyperMesh entity Identifier (default).

@MetadataPrefixFilter

Value Description

string The prefix to use to find metadata to export. Only metadata with the
specified prefix is exported. Any metadata without this prefix is not
exported. Default is empty, meaning all metadata will be exported.

@NameFromRepresentation

Value Description

on Assign part name in CAD file from the representation file name attached
to part entity.

Meaningful only if AssemblyMode = "Parts".

off Assign part name in CAD file from the part entity name in HyperMesh.

Meaningful only if AssemblyMode = "Parts".

@OptimizeForCAD

Value Description

on Fix gaps between stitched edges and vertices to make the actual geometry
of the surfaces consistent with the model topology before export, and
check the topology of the model for gaps that are larger than a given
tolerance between shared, non-manifold, or suppressed edges. If the gap
is found to be bigger than the tolerance, the surface and edge geometries
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Value Description

are morphed parametrically and in 3D, if necessary, to make the gap
smaller than the tolerance. In addition, non-essential degenerate edges
are removed. This also modifies the geometry within HyperMesh (default).

off Do not perform the optimization steps.

@RemoveMetadataPrefix

Value Description

on Remove the metadata prefix for export.

Meaningful only if @MetadataPrefixFilter is enabled and non-empty.

off Do not remove the metadata prefix for export (default).

Meaningful only if @MetadataPrefixFilter is enabled and non-empty.

@SourceUnits

Value Description

MKS (m kg N s)

MMKS (mm kg N s)

MPA (mm t N s)

CGS (cm g dyn s)

MMKNMS (mm kg kN
ms)

MMGNMS (mm g N ms)

IPS Std (in pounds
lbf s)

IPS Grav (in
slinch lbf s)

FPS Std (ft pounds
lbf s)

FPS Grav (ft slug
lbf s)

Unit system assigned to the data present in HyperMesh during export

@TargetUnits
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Value Description

Meters Units system in the exported Parasolid file. Parasolid stores data in
meters.

@TopologyMode

Value Description

Solid/Shell Export topology data similar to HyperMesh topology data, keeping the
distinction between solids and shells (default).

Surface Export each surface, including solid faces, as a single surface, effectively
neglecting connectivity.

@Version

Value Description

string Parasolid version to use for export. Valid versions are 30.0 (default), 28.1,
28.0, 27.0, 26.1, 26.0, 25.1, 25.0, 24.0, 23.0, 22.0 or 21.0.

@WriteColorFrom

Value Description

string Specify colors for the geometrical entities during export. Colors are
supported at the component level only, whereas individual entity colors
(points, lines, surfaces, solids) are not supported.

Valid values are Component (default) and Metadata.

@WriteMetaDataAsColor

Value Description

string Specify the metadata to use for coloring entities.

Default is COLOR_RGB.

Meaningful only if @WriteColorFrom = "Metadata".

@WriteMetaDataAsName
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Value Description

string Specify the metadata to use for naming entities.

Default is TAG.

Meaningful only if @WriteNameFrom = "Metadata".

@WriteNameFrom

Value Description

string Specify names for the geometrical entities during export. Names are
supported at the component level only, whereas individual entity names
(points, lines, surfaces, solids) are not supported.

Valid values are Component and Metadata (default).

STEP Writer

Supported Entities
Entities supported by the STEP writer.

• Point

• Line

• Surface

• Solid

• Part

• Assembly

Entities not supported by the STEP writer.

• Axis system

• Fixed points. In order to export fixed points, it is necessary to convert them to free points. Then,
after import, those free points must be projected onto the appropriate lines or surfaces in order to
generate fixed points with the proper association.

• Vector

Export Options
The STEP writer uses the step_writer.ini file with the following available options:

@AllowDisjointShells
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Value Description

on Store non-manifold geometry in one disjoint feature.

off Split and store non-manifold geometries as separate joint shell features
(default).

@AssemblyMode

Value Description

Parts Create part entity hierarchy as assembly and part entity in STEP file.

Assemblies Create assembly and component entity as assembly and part entity in
STEP file.

Flatten Write entities in all components into a single STEP part.

@AttributeForMaterialName

Value Description

string Attribute created with the name contains PDM metadata-material name
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Material".

@AttributeForMeshFlag

Value Description

string Attribute created with the name contains PDM metadata-mesh flag
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "MeshFlag".

@AttributeForMID
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Value Description

string Attribute created with the name contains PDM metadata-material ID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "MaterialId".

@AttributeForPartNumber

Value Description

string Attribute created with the name contains PDM metadata-part number
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "PartNumber".

@AttributeForPID

Value Description

string Attribute created with the name contains PDM metadata-property ID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "PID".

@AttributeForRevision

Value Description

string Attribute created with the name contains PDM metadata-revision
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Revision".

@AttributeForThickness
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Value Description

string Attribute created with the name contains PDM metadata-thickness
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "Thickness".

@AttributeForUID

Value Description

string Attribute created with the name contains the PDM metadata-UID
information associated with the part entity.

Meaningful only if AssemblyMode = "Parts".

Default is "UID".

@Export

Value Description

All Export all geometry (default).

Displayed Export displayed geometry only.

@GeometryMode

Value Description

Standard Write CAD geometry with standard types such as cylinder, cone, circle,
and so on (default).

BSpline Convert all surface geometry data into NURBS. This option may increase
the output file size and be time consuming depending on the actual
geometry.

@HMOrignalIdAsAttribute

Value Description

on Write HyperMesh entity Identifier as HM_ORIGINAL_ID attribute
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Value Description

off Do not export HyperMesh entity Identifier (default).

@LayerMode

Value Description

None No special layer handling is performed (default).

ComponentID The entities in each HyperMesh component will be assigned to the
layernumber in the STEP file corresponding to that component ID.

@MetadataPrefixFilter

Value Description

string The prefix to use to find metadata to export. Only metadata with the
specified prefix is exported. Any metadata without this prefix is not
exported. Default is empty, meaning all metadata will be exported.

@NameFromRepresentation

Value Description

on Assign part name in CAD file from the representation file name attached
to part entity.

Meaningful only if AssemblyMode = "Parts".

off Assign part name in CAD file is assigned from the part entity name in
HyperMesh.

Meaningful only if AssemblyMode = "Parts".

@OptimizeForCAD

Value Description

on Fix gaps between stitched edges and vertices to make the actual geometry
of the surfaces consistent with the model topology before export, and
check the topology of the model for gaps that are larger than a given
tolerance between shared, non-manifold, or suppressed edges. If the gap
is found to be bigger than the tolerance, the surface and edge geometries
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Value Description

are morphed parametrically and in 3D, if necessary, to make the gap
smaller than the tolerance. In addition, non-essential degenerate edges
are removed. This also modifies the geometry within HyperMesh (default).

off Do not perform the optimization steps.

@RemoveMetadataPrefix

Value Description

on Remove the metadata prefix for export.

Meaningful only if @MetadataPrefixFilter is enabled and non-empty.

off Do not remove the metadata prefix for export (default).

Meaningful only if @MetadataPrefixFilter is enabled and non-empty.

@SourceUnits

Value Description

MKS (m kg N s)

MMKS (mm kg N s)

MPA (mm t N s)

CGS (cm g dyn s)

MMKNMS (mm kg kN
ms)

MMGNMS (mm g N ms)

IPS Std (in pounds
lbf s)

IPS Grav (in
slinch lbf s)

FPS Std (ft pounds
lbf s)

FPS Grav (ft slug
lbf s)

Unit system assigned to the data present in HyperMesh during export

@StepHeaderAuthorInfo
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Value Description

string String to use for the AUTHOR field in the STEP header.

@StepHeaderAuthorizationInfo

Value Description

string String to use for the AUTHORIZATION field in the STEP header.

@StepHeaderOrganizationInfo

Value Description

string String to use for the ORGANIZATION field in the STEP header.

@TargetUnits

Value Description

Microns

Millimeters

Centimeters

Meters

Kilometers

Microinches

Mils

Inches

Feet

Units System in the exported STEP file.

@TopologyMode

Value Description

Solid/Shell Export topology data similar to HyperMesh topology data, keeping the
distinction between solids and shells (default).

Surface Export each surface, including solid faces, as a single surface, effectively
neglecting connectivity.
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@Version

Value Description

string The STEP version to use for export. Valid versions are AP214 (default).

@WriteColorFrom

Value Description

string Specify colors for the geometrical entities during export. Colors are
supported at the component level only, whereas individual entity colors
(points, lines, surfaces, solids) are not supported.

Valid values are Component (default) and Metadata.

@WriteMetaDataAsColor

Value Description

string Specify the metadata to use for coloring entities.

Default is COLOR_RGB.

Meaningful only if @WriteColorFrom = "Metadata".

@WriteMetaDataAsName

Value Description

string Specify the metadata to use for naming entities.

Default is TAG.

Meaningful only if @WriteNameFrom = "Metadata".

@WriteNameFrom

Value Description

string Specify names for the geometrical entities during export. Names are
supported at the component level only, whereas individual entity names
(points, lines, surfaces, solids) are not supported.
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Value Description

Valid values are Component and Metadata (default).

CAD Export Options
CAD writers provide options for processing data during export.

Some of these options are available from the Export browser, while other options are accessed only
from each writer's _writer.ini file.

Version
Corresponds to the @Version option.

File mode
Corresponds to the @FileMode option.

Export
Corresponds to the @Export option.

Source units
Corresponds to the @SourceUnits option.
Set a source unit before exporting by manually selecting a unit system from a list of units, or
click From Metadata to select a source unit from the MODEL_UNIT metadata attached to the
component/part. If the components/parts have differing MODEL_UNIT metadata values, the most
commonly used value is adopted and a warning message is displayed.

To prevent the frequent, unintended, selection of units, the source units selection is cleared
anytime the export CAD file type is changed and you must reselect the units before exporting.

Target units
Corresponds to the @TargetUnits option. When Target units value is selected as Source units
(default), Target units is assigned a value from Source units and used during export.

Output Loop
Corresponds to the @OuterLoop option.

Layers
Corresponds to the @LayersMode options.

Geom mode
Corresponds to the @GeometryMode option.

Topo mode
Corresponds to the @TopologyMode option.

Assem mode
Corresponds to the @AssemblyMode option.

Naming mode
Corresponds to the @WriteMetaDataAsName and @WriteNameFrom options.
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User defined
Additional options not explicitly exposed in the GUI, in the form option1_name=option1_value,
option2_name=option2_value, and so on. If an option is also exposed in GUI is mentioned in this
field, the value of this field prevails.

Name from representation
Corresponds to the @NameFromRepresentation option.

Optimize for CAD
Corresponds to the @OptimizeForCAD option.

Prompt before overwrite
Prompt the user if the specified file name already exists and will be overwritten.

CAD Export Message Files
When a CAD file is exported from HyperMesh, a .msg file is created (or appended to) in the current
working directory.

For example, the file iges_writer.msg is created for the IGES writer. Three types of messages appear
in the .msg file:

info
Includes information

warning
Indicates all warnings that occurred during the export.

error
Indicates when geometric entities could not be created in the CAD file.

These files can be useful for debugging errors that occured during export.
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Browsers

Browsers supply a great deal of view-related functionality in HyperMesh by listing the parts of a model
in a tabular and/or tree-based format, and providing controls inside the table that allow you to alter the
display of model parts.

This chapter covers the following:

• Basic Browser Operations  (p. 890)

• Assembly Browser  (p. 916)

• Connector Browser  (p. 927)

• Contact Browser  (p. 1009)

• Entity Editor  (p. 1019)

• Entity State Browser  (p. 1045)

• Loadsteps Browser  (p. 1049)

• Mask Browser  (p. 1056)

• Mass Trimming Browser  (p. 1058)

• Matrix Browser  (p. 1075)

• Model Browser  (p. 1097)

• Model Checker  (p. 1192)

• Part Browser  (p. 1301)

• Reference Browser  (p. 1313)

• Solver Browser  (p. 1318)

• Utility Menus  (p. 1325)

• Visualization Controls  (p. 1616)
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Basic Browser Operations
Browsers display information in a Treeview. In Treeviews, collectors such as components or groups
appear at the top level of the hierarchy, while collected entities such as elements or surfaces display
as "children" nested within the collector to which they belong. Each item in a Treeview is commonly
referred to as a "node", regardless of whether it is a Parent Node or a Child Node.

Figure 148: Hierarchy of Entities in the Model Browser

Performing an action on a child node affects only that item, be it a single load or the entire collection
of elements in the model, which, in the example above, are collectively a child node of the components
parent node. However, performing the same action on a parent node applies it to all children of that
node as well. For example, in the image above, turning off the display of elements will not affect the
display of connectors, geometry, or components (the parent node of the elements). However, turning off
the display of components will turn off the display of connectors, elements, and geometry because they
are children of the components node.

Different browsers are customized for usage with regard to the types of parts that you want to work
with. Most browsers have similar basic functionality for sorting entities, filtering entities, and finding
entities. However, most browsers also include a right-click context menu and sets of control buttons,
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similar to toolbars, but unable to be detached to re-docked, that are specific to the browser in which
they appear.

Sorting Entities in the Model Browser

To sort the entities in a folder within the browser:

1. Click the heading of each column.

2. Click Entities to sort alphabetically by name, or click ID to sort numerically by entity ID.

In either case, repeated clicks toggle between ascending and descending order.

Query Builder
Use the query builder to find and filter entities by building advanced filters for attributes listed in
browser columns.

Recent filters are saved and can be quickly accessed by clicking .

Figure 149:

Interactively Build Queries

1. To expose the interactive query builder, click the Expand/Collapse icon .

By default, the name, id, and type attribute fields are exposed.

2. Filter via name and/or id by typing a string into the text field and pressing Enter.

3. Change the entity type by clicking on the type field and selecting a desired entity type.

4. Apply your selection by clicking .

An example of an interactively defined query is shown in the image below. In this example, four
additional attribute fields were added.
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Figure 150:

Tip:

• To select multiple entity types, press and hold Control.

• Add additional attribute fields by clicking . Remove attribute fields by clicking .

Manually Build Queries

Manually build queries by typing into the text field.

The manual query builder syntax follows this basic form: <attribute>:<search pattern>. Use AND, OR,
<, >, operators to refine your search.

Figure 151:

The following table provides examples of query builder syntax and results.

Entering this string... Returns this result...

2 All entities that contain the number 2 in their ID.

"2" All entities with the ID 2.

shell All entities that contain shell in their name.

"shell" All entities with the name shell.

name: shall AND id: 2 All entities that contain shell in their name and 2 in their ID.

id:>10 AND id:<20 AND
name:cent

All entities that contain cent in their name and have an ID greater than
10 and less than 20.
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Entering this string... Returns this result...

1-4 All entities with the IDs 1, 2, 3, and 4.

type:comp AND id:1-4 All components with the IDs 1, 2, 3, and 4.

Display Controls and Browser Modes
These controls affect which entities display in the graphics area, and how they display, such as shaded
or wireframe.

Global Display Controls
Use the global display controls to control the graphical display state of entities listed in the browser.

These controls reside at the left side of the browser, just below the Model Browser View Modes.

Figure 152:

By default, the global display controls will work on all entities listed in the browser, however, these
controls can also work at the folder and individual named entity level. For example, to turn off all
components, highlight the Component folder and click Display None. If an individual component is
highlighted within the Component folder then the global display controls will only work on that specific
entity. To enable the Display All, Display None, and Display Reverse controls to work on all of the
entities listed in the browser, click on the white space within the browser (de-selecting any selected
entities).

A shaded entity icon in the browser indicates that the entity is visible in the graphics area while an
opaque icon indicates that the entity is hidden in the graphics area.

Because these controls work in combination with the filters, only the items displayed in the browser are
affected. The hidden items that are also filtered out of the browser will not be displayed.

 Elements and Geometry

Determines whether the other global display controls will act on elements, geometry, or elements
and geometry.

 Display All

Displays all of the entities listed in the browser.

 Display None

Hides all of the entities listed in the browser.
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 Display Reverse

Reverses the display of all the entities listed in the browser (displays hidden entities, hides
displayed entities).

Note:  These controls only affect the display state of entities; they do not actually remove
entities from the model.

Local Display Controls
Use the Local Display Controls to change visual appearance of individual entities, such as shaded or
wireframe.

These controls are located within the tree list, and each affects the specific entity that it appears beside.

Entity Display Icons
You can display or hide entities by toggling the corresponding icon that is located on the left-hand side
of the entities name. The following rules apply:

• A bold icon next to an entity (components, multibodies, load collector, and so on) represents that
the entity is currently displayed; a dimmed icon next to an unchecked entity represents that the
entity is turned off from display.

• Assemblies containing components or multibodies are considered displayed only when all of the
contents are displayed.

• Activating an assembly’s display control icon displays all of its contents.

• Activating an assembly’s display control icon displays all its components and multibodies.

• Deactivating the display control icon check box for an assembly hides all of its components and
multibodies.

• Deactivating the display control icon for an item hides all of its parent assemblies.

• Deactivating the display control icon for an item does not affect the state of its parent assembly.

• An empty assembly never displays.

Colors
Assemblies, beam section collectors, blocks, components, contact surfaces, curves, groups, load
collectors, materials, properties, shapes, system collectors, tags, titles, and vector collectors can all

be colored individually. In the Model Browser, the  column displays each entity’s assigned color. To

change an entity’s color, click its color icon and select a new color from the palette.

Display Mode
Components have several display states, based on a combination of their elements and their geometry.

In the Model Browser, the  column displays the display mode assigned to each component,

assembly, or load collector. To change the display state, click the entities display mode icon and then
select a new style. Depending on which option you select, the entity displays differently:
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FE Styles

Wireframe mesh

Shaded elements (no mesh)

Shaded elements with mesh lines

Shaded elements with feature lines (no mesh)

Transparent shaded elements without mesh

Geometry Styles

Wireframe geometry

Wireframe geometry with surface lines

Shaded geometry

Shaded geometry with feature lines

Action Mode Tools
Use the action mode tools, on the right side of the Model Browser, to control both entity selection and
the display of the model.

The first two tools determine the type of entity that you wish to manipulate, while the rest perform
specific actions.
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Entity Type

The Entity Type tool ( ) sets functions as a "mode" selector for the rest of the tools by determining 

what type of entity the remaining tools will act on.

For example, if you set the Entity Type to "components", the Selector will only select or deselect 
components.

Click ( ) to open the Entity Type drop-down menu and then select the desired entity type.

Figure 154:

Elements/Geometry

The Elements/Geometry tool ( ) sets functions as a "mode" selector for the rest of the tools, by

determining what type of contained entities the remaining tools will act on.

For example, if you set the mode to "elements", the Selector will only select or deselect elements.

Click ( ) to open the Elements/Geometry drop-down menu and then select the desired contained

entity type. The entity types available from the drop-down include: Elements, Geometry, and Elements
and Geometry.
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Selector

Use the selector ( ) to interactively select supported entities from either the Model Browser or from 

within the graphics area.

The type of entity you are able to select is determined by the entity selection that you made in the 
Entity Type drop-down menu.

Note:  You are only able to select one entity type at a time, but you can select multiple
entities without losing your selection. This is also an efficient way of selecting multiple
entities at once – such as when changing color.

HyperMesh outlines the selected entities with a thick white line in the graphics area, and highlights the
entity names in grey in the Model Browser.

Figure 156:

The selection behavior of ply entities acts differently than other entities. Plies often contain both
geometry and FEs that nearly match. In order to distinguish between the two in the graphics area,
HyperMesh outlines selected geometry with a thick white line and selected FEs with the color that it is
assigned.
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Figure 157:

When you select materials and properties, the visualization mode changes to by Mat or by Prop,
respectively.

Figure 158:

Change the Selection in the Graphics Area Using the Mouse Scroll Wheel
In a Microsoft Windows environment, you can also use a scroll-wheel-equipped mouse to "drill down"
through the model and select parts that may not be immediately visible.

1. To move deeper into the field of view and away from you, hold the left mouse button down while
rolling the scroll wheel forward.
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2. To move the selection closer to you, hold the left mouse button down while rolling the scroll wheel
backward.

Highlighting indicates the component that will be selected once you release the left button.

Note:  This only works in a Windows environment; it will not work in UNIX, Linux, and
so on.

3. You can also use the Selector tool in conjunction with the Hide or Isolate functions to hide or
isolate the entities selected in the graphics area. Once you have made a selection in the Model
Browser or graphics area, using the selector, click the Hide icon (right mouse button) to hide that
selection or click the Isolate icon (left mouse button) to isolate that selection.

Select Entities in the Graphics Area

To select entities in the graphics area, you can:

• Left-click to select entities.

• Left-click and hold to pre-highlight entities; the entity under the selector at any given moment
highlights, but is not selected until you release the mouse button.

• Shift + left-click to use window selection to highlight or select multiple entities.

• Right-click an entity to deselect it.

• Control + right-click to use window selection to deselect multiple entities.

When using a panel with an active collector, each entity selected gets added to the collector, while each
one de-selected gets removed from the collector.
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Select Entities in the Model Browser Tree List

To select entities using the Model Browser, you can:

• Left-click to select and highlight an entity in the browser – the entity is also highlighted in graphics
area.

• Control + left-click to select multiple entities in both the browser and graphics area. Multiple
entities of the same type can be appended to the selection. Left-click can be used to add/remove
components from an active collector on a pane.

• Shift + left-click highlights multiple entities in the browser and the graphics area. You can append
and remove entities from a panel's active collector list depending on which entity entry is selected.

• Right-clicking highlights components in the list and invokes the context menu – no highlighting of
the entity in graphics area will occur with this operation.
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Add to Panel Collector

The Add to Panel Collector ( ) is a function whereby the browser can be used to select and add 

entities to the panel collectors.

This is an alternative method to using the advanced selection capabilities already available in each 
collector's extended entity selection menu. This button is only available when you have a panel open 
that contains at least one entity collector.
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Figure 161:

Note:  The selected entities are only added to the panel's active (blue halo) collector.
Additionally, only entities of the correct type will be added to the active collector; for
example, you cannot add lines to an Elements collector.

There are two ways of using this tool:

1. Use the selector to choose a set of entities beforehand, and then click Add to Panel Collector to
add them to the panel's collector.

In this method, the selector effectively gives a preview of the selection, because the selected
entities are highlighted but only added to the active panel collector when you click Add to Panel
Collector. For example:
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Figure 162:

2. Click Add to Panel Collector first to activate it, then select the entities you wish to add to the
collector. HyperMesh adds each selection to the collector immediately after you release the mouse
button.

You can use either method in the graphics area or the browser tree list. Control-clicks and Shift-clicks 
are supported in the browser list; window selections (Shift+click-and-drag) are supported in the 
graphics area.
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• Right-click (with full shift-, control-, or window-based selection) on individual entities when the Add
to Panel Collector button is active.

Show/Hide

Use Show/Hide ( ) to control the model display by interactively selecting entities within the graphics

area.

This tool is not designed to operate within the browser; therefore, you should only use this tool to select
entities in the graphics area. To control the browser display, use the local entity controls found inside
the browser's tree structure.

Note:  When using window selection (Shift-click-and-drag), an entity is considered selected
if any portion of it falls within the window; you do not need to encompass the entire entity
with the window, only a small portion of it. Also remember that only entities of the types
determined by the Entity Types and Elements/Geometry buttons will be hidden or revealed.

When you select materials and properties, the Visualization mode will change to by Mat
and by Prop respectively. However, no graphics highlighting of material or properties occurs
when using the selector.

Similar to the selector, you can change your selection in the graphics area using the mouse
scroll-wheel for the Show/Hide tools. To show your selection, left-click, hold, and scroll. To
hide your selection, right-click, hold, and scroll.

Pick in Graphics

• Left-click turns on entities to the display that are currently turned off.

• Left-click-and-drag pre-highlights only the entities that are currently turned off in the display
(entities already turned on do not highlight).

• Right-click turns off entities in the display.

You can use either method in the graphics area or the browser tree list. Control-clicks and Shift-
clicks are supported in the browser list; window selections (Shift+click-and-drag) are supported in the
graphics area.

Remove Entities From a Panel Collector

To remove entities from a panel collector, you can either:

• Click the collector's reset button .

• Right-click-and-drag pre-highlights only the entities that are currently turned on in the display
(entities already turned off do not highlight.)
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Single Selection

Figure 163:

• Shift + left-click-and-drag uses window selection to turn on multiple entities in the display.

• Shift + right-click-and-drag uses window selection to turn off multiple entities in the display.
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Window Selection

Figure 164:

Pick in Browser

This tool does not function on line items within the browser's tree list. To control the display of the listed
entities use All/None/Reverse, the individual local display control inside the tree structure, or the show/
hide/isolate functions from the context menu.

isolate that component, while leaving the load collectors untouched in the display. In other words, all
of the other components will be turned off, but the isolated component and the load collectors will still
display.
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The Isolate tool isolates within the entity type. For example, if there are components and load collectors
displayed, and you use Isolate while the Entity Type is set to Component, then HyperMesh will only
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Note:  Isolate can be used in conjunction with the selector. In such a case, after you have
selected the desired entities, clicking Isolate hides everything else except for the selected
entities. However, as described above only entities of the chosen type are hidden – so
connectors and similar entities will still remain visible.

Using the selector may give you more precise control over which entities to retain – but for
simple isolation tasks, direct usage of the Isolate button is generally quicker.

Similar to the selector tool, you can change your selection in the graphics area using the
mouse scroll-wheel for the Isolate Shown/Isolate Not Shown tools. To isolate entities that
are shown, left-click, hold, and scroll. To isolate entities that are not shown, right-click, hold,
and scroll.

Pick in Graphics

In general, use the left mouse button to isolate visible entities, and use the right mouse button to
isolate entities that are already hidden (thus turning the hidden ones back on):

• Left-click will isolate the selected entity from those on display (single-click selection).

• Left-click-and-drag will pre-highlight entities that are currently displayed. It will not highlight
entities that are currently turned off in the display. Upon release, the pre-highlighted entity will be
isolated.

• Shift + left-click-and-drag uses window selection to isolate multiple entities (but only entities
currently visible).

• Right-click will isolate entities from all available entities, whether currently on or off in display.

• Right-click-and-drag will pre-highlight an entity that is displayed or turned off from the display in
the graphics area. Upon release, the pre-highlighted entity will be turned on and isolated.

• Shift + right-click-and-drag uses window selection to isolate entities from all available entities,
whether displayed or turned off from the display.
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Single and Window Selection

Figure 165:

Note:  When using window selection (Shift+click-and-drag), an entity is considered selected
if any portion of it falls within the window; you do not need to encompass the entire entity
with the window, only a small portion of it. Also remember that only entities of the types
determined by the Entity Types and Elements/Geometry buttons will be hidden or revealed.
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Pick in Browser

• In Isolate mode, clicking on an entity folder, such as the Components folder, will isolate all
components, therefore turning every component on.

• Left-click will select/highlight an entity in the list – the entity is isolated and displayed in graphics
area.

• Control + left-click highlights an entity name in the browser and isolates it in the graphics area.
Multiple entities of the same type, components for example, can be appended to the selection, thus
displaying more than one entity but still hiding all non-selected ones. Selected/isolated entities can
be de-selected by Control + left-clicking on them a second time.

• Shift + left-click highlights all entities of the same type, components for example, in the browser
between the first click and the most recent click, and displays the selected entities isolated from
the non-selected ones in the graphics area. You can use additional Shift-clicks or Control-clicks to
modify the selection of displayed entities.
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Context Menu
A context menu of actions is available for any selected item in the browser.

To open the context menu, right-click on either an entity folder, an individual entity, or the white-space
of the browser.

Review
In Review mode you can review selected entities irrespective of their display state, masked, active state
(Entity State Browser), but not outside of the spherical clipping, if enabled.

Review mode is currently supported in the following browsers: Model, Solver, Part, Mechanism, and
Entity State.

Review is currently supported for: Assemblies, Beamsection collectors, Beamsection, Blocks, Bodies,
Boxes, Components, Configuration, Constrained extra nodes, Constrained rigid bodies, Constraints,
Contact surfaces, Control volumes, Cross sections, Design variables, Design variable links, Design
Objective Reference, Design Variable Property Relationship, Elements, Groups, Joints, Laminates, Load
collectors, Loads, Loadsteps, Materials, Mechanisms, Objectives, Optimization constraints, Optimization
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responses, Output blocks, Part, Part Assembly, Part Set, Plies, Properties, Regions, Seatbelts, Sensors, 
Sets, System collectors, Systems, Vector collectors, and Vectors.
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Invoke Review Mode

1. Select valid entities to review.

Note:  You are only able to review one type of entity at a time.

• Select entities in the browser.

• From the action mode tools in the browser, select an entity type and enable the Selector

( ). In the graphics area, select entities.

2. Invoke review mode.

• Right-click on selected entities in the browser and select Review from the context menu.

• Press Q (only when a supported browser is active or the graphics area is active).

Note:  When the graphics area is active and you have two browsers which support
Review mode open simultaneously in the left and right tab areas, pressing Q will
invoke Review mode for the entities selected in the last browser you accessed. If the
Entity State Browser is one of the two browsers opened, then pressing Q will invoke
Review mode for the entities selected in the other browser.
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Tip:

• Append entities to your selection by left-clicking. Remove entities from your selection by
right-clicking.

• Switch your review selection from one entity to another or from one entity type to
another by selecting a new entity. You can also switch your review selection from one
browser to another when you have two browsers, which support Review mode, open
simultaneously in the left and right tab areas. The graphics area will automatically
display your new selection.

• In the browser, use the up and down keys to review.

Figure 166:
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Disable Review Mode

Manually exit review mode by right-clicking on a selected entity in the browser and selecting Review 
from the context menu, or press Q.

When other interaction modes may conflict, Review mode will be automatically turned off.
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Warning:

• Review is reset when:

◦ Switching the Visualization Color mode to any mode except by Thickness or by
Element Quality

◦ Changing Visualization FE and Geom styles

◦ Switching browsers or browser views

◦ Undocking browsers from the tab area

◦ Clicking anywhere in a browser that does not support Review

◦ Enabling an action mode tool

◦ Changing data

• Review is reset and disabled (when Review is on) or disabled (when Review is off)
when:

◦ Any panel or pull-down menu referring to a panel is opened and remains open

◦ Switching the Visualization Color mode to by Thickness or by Element Quality

◦ The Spherical Clipping panel is opened
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Color of Reviewed Entities in the Graphics Area

Entities being reviewed will appear with their current visualization style in the graphics area, while all
other non-reviewed entities will display transparent.
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Figure 167: Two Components Selected in Review Mode
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Entities being reviewed that do not have a visualization style assigned will display yellow.

Figure 168: Sets Selected in Review Mode
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When a single group entity is being reviewed, the contact pair’s master surface will display blue and the
slave surface will display red. When there is only one surface definition being reviewed, it will display
red.

Figure 169: Single Contact Pair Selected in Review Mode

When multiple group entities are being reviewed, they will display in their own entity color.
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Figure 170: Multiple Contact Pairs Selected in Review Mode
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Assembly Browser
Use the Assembly Browser to manage parts and modules during the assembly building process.

This browser can be accessed from the View menu when the Radioss, OptiStruct, Nastran, LS-DYNA and
Abaqus user profiles are loaded.

Currently, Bill-of-Material (BOM) file support is limited to PLMXML assembly files from Teamcenter. For
more details on the required Teamcenter configuration, supported PLMXML file formats, and supported
transfer modes, contact your local Teamcenter support. Once the necessary configuration is made in
Teamcenter, you can import the file in HyperMesh for representation management, batch meshing,
connectors, and exporting the meshes and solver files.

The Assembly Browser structure is laid out in a table format. The different modules are displayed in the
Entities column, and each module’s representation, material, PID, and thickness information is displayed
in the columns that follow.

The Assembly Browser contains advanced filtering tools to filter BOMs based on their properties,

existence of representation, and so on. To display the filtering tools, click .

Figure 171:

To filter BOMs, apply the following advanced filters:

Apply Attribute Filters
Use these filters to determine, which Attribute(s) to filter upon.

1. To select which Attribute(s) to filter upon, select the check box next to the desired Attribute(s).

2. From the Name list, select the attribute you wish to filter upon.

The options available in this list include: Part name, Material, PID, or Thickness.

3. From the Option list, select the one of the following options:

• Contains
• ==
• !=
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• REGEXP
4. In the Value column, specify specific information about the Attribute(s).

5. Optional: To add an additional attribute filter, click .

6. Optional: To remove an attribute filter, click .

Apply Data Filters
Use these filters to determine what data appears in the Assembly Browser.

1. To activate the Representation File filter, select its checkbox.

2. Click the Representation File toggle and select:

• Exists
• Does Not Exist

3. To activate the Representation Loaded filter, select its checkbox.

4. Click the Representation Loaded toggle and select:

• True
• False

Apply Global Filters

From the Apply multiple filters using list, select:

• And:
• Or:

Assembly Browser Context Menu
Access advanced Assembly Browser options from the context menu when you right-click on a module in
the browser.

Load BOM
PLMXML is the exchange format that transports the assembly information between Teamcenter and
HyperMesh.

To load a PLMXML (.xml) file:

1. Right-click in the Assembly Browser and select Load BOM from the context menu.
The XML Import dialog appears.
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Figure 172:

2. In the File Name field, navigate to your working directory and open the .xml file.

3. Click OK.
HyperMesh imports the .xml file into the Assembly Browser.

Note:  In the Assembly Browser, many operations are recursive, meaning that when
you select a module and perform an operation on it, the same applies to all the
children modules.

Representations are various versions associated with any module. You can use any of these at a
given time. Basically, each representation has a file associated with it, and that file for the current
representation will be imported into HyperMesh when you import a module.

A representation cannot have more than one file attached to it.

When you select a representation, it is set as the current representation for that particular
module. When that module is imported into HyperMesh, the file associated with that particular
representation is imported into HyperMesh. If you want to import a different file, change the
representation to the one that contains the desired file and then import that particular module.

Save WIP

To save your work-in-progress data, select Save WIP from the right-click context menu.

Once you select Save WIP, HyperMesh saves a UDMXML file in the assembly working directory. This file
captures the assembly structure state, including the current representations and all metadata values.
After you have saved your work-in-progress to the UDMXML file, you can safely close the Assembly
Browser or HyperMesh.

Note:  Saving the HyperMesh file by clicking File > Save from the menu bar will not save
the assembly structure or state.
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To continue working with a saved UDMXML assembly BOM, load the WIP BOM using the Load BOM
process. Select the saved WIP UDMXML BOM instead of the original PLMXML BOM.

Save PLMXML

In order to import the meshed parts into Teamcenter, an updated PLMXML .xml file is needed. This file
captures any changes that were made to the assembly after it was imported into HyperMesh. If the
original .xml file contained only CAD parts with thickness and material attributes, and if you meshed
these parts in HyperMesh and made changes to the thickness for certain parts, then the delta PLMXML
file will capture the changes made.

To create a delta PLMXML file and a monolithic HyperMesh or solver file, select the Module Model
module and then select Save PLMXML from the right-click context menu.

The type of monolithic file HyperMesh creates is determined by the settings you selected within
Teamcenter prior to exporting the original PLMXML file.

Teamcenter uses the delta PLMXML file to update metadata and files when you upload the updated
assembly file. You cannot use the delta PLMXML file to save work-in-progress information, or load it into
the Assembly Browser.

Note:  You cannot save the HyperMesh file by clicking File > Save from the menu bar
because it will not save the assembly structure or state. To save your work-in-progress data,
select Save WIP from the right-click context menu.

Set Rep

1. To change the representation of a module, right-click on the representation and then select Set
Rep from the context menu.

Figure 173:

2. Select a representation category.

• Choose Geom to set the geometry as the current representation. The type of CAD that is
set as the current representation is based on the order of preference as set in the config file,
which is provided by Teamcenter.
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• Choose Mesh to set the mesh file as the current representation. The last representation in
the list of mesh representations is set to current.

A module can have multiple representations associated with it. The representations are basically
categorized into two types, Geom and Mesh. The Geom representations have CAD files associated
with them and Mesh representations have mesh files associated with them.

Generally, CAD representations are provided along with the BOM file and the representations are
added based on a failing order. The format that is on top of failing order is associated first, and so
on.

Most of the time, the mesh representations are created after operations likes Batchmeshing, mesh
editing, penetration checks, and so on. The last representation of Mesh type is generally the latest
representation and is of primary concern.

When you select Set Rep > Geom, HyperMesh searches for a list of Geom representations and
sets the first one in the list as the current representation. This is in alignment with the failing
order as the representation on top of the failing order is set as current.

When you select Set Rep > Mesh, HyperMesh searches for a list of Mesh representations and
sets the last one in the list as the current representation. This way, you set the last created
representation as current.

There might be representations that do not have any files associated with them, which may come
with a .xml file. HyperMesh ignores these representations when searching for the appropriate
Geom/Mesh representations. In a case where a representation of a selected type is not present,
HyperMesh does not change the current representation. For example, if the current representation
is of type Mesh and there is no Geom representation associated with the module, when you select
Set Rep > Geom, the current representation does not change and HyperMesh leaves it as type
Mesh. If the current representation does change, HyperMesh purges the module, as well.

Purge Rep

To remove all of the contents under the modules from the current HyperMesh session, select Purge
Rep from the right-click context menu.

Before you are able to remove all of the contents under a module, the Confirm delete dialog appears
asking if you want to purge the selected modules.

Figure 174:
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HyperMesh will still maintain the representation in the hierarchy, and you can import when desired.
When you purge a module, all of the changes you have made to the contents of the module will be lost
permanently. HyperMesh will not automatically update the files in the current representation with the
updated content. To retain the changes, you must save the modules as a HM file (or Solver file) before
purging.

Import Rep

To import the associated representation into HyperMesh, right-click on a representation and then select
Import Rep from the context menu.

If there are children modules in the module you select, then all of the children will be imported. In
general, the operations in the right-click context menu work on everything under the selected module.

Set Param-Criteria

1. To set individual mesh parameter and criteria for selected module(s), select Set Param-Criteria
from the right-click context menu.
The Select Mesh Parameters & Criteria dialog appears.

Figure 175:

2. From the Select Parameter list, select a parameter to assign to the selected module.

Batchmesh

1. To batchmesh a module or modules, right-click on a module or modules and then select
Batchmesh from the context menu.
The Batchmesh Representation dialog appears.
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Figure 176:

2. Set the desired operation.

• Choose Generate, if not present to create a new mesh for the given module using the
selected parameter and criteria files, as long as a mesh for the given module and selected
parameter and criteria files does not already exist.

• Choose Force Generate to create a new mesh for the given module using the selected
parameter and criteria files, even if a mesh for the given module and selected parameter and
criteria files already exists.

3. Make a selection for generating mesh.

• Choose Use Current to use the current representation as input to the batch mesher for
creating the new mesh.

• Choose Geom to use the geometry representation as input to the batch mesher for creating
the new mesh.

• Choose Mesh to use the existing mesh representation as input to the batch mesher for
creating the new mesh.

4. Click Advanced Options to edit the following:

Option Description

Respect module
attributes if exist
(discipline and
mesh quality)

If module attributes exist and you would like to leave them as is during
batchmeshing, select this checkbox.
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Option Description

CPUs to use In order to run the Batchmesher faster on a system with multiple
processors, enter the number of CPU values. This will run that many
instances of Batchmesher.

Show Batchmesher To show the Batchmesher GUI instead of running the batchmesh in the
background, select this checkbox.

Keep Batchmesher
open after
completion

To keep the Batchmesher open after the batch meshing process is
finished, select this checkbox.

5. To start Batchmesher, click Run.
The following messages appear during the batch mesh process:

Figure 177:
Message displayed when Batchmesher is running in GUI mode

Figure 178:
Message shown when Batchmesher is running in background

Associate Mesh Files

To associate mesh files for modules shown in the Assembly Browser, right-click on a module and then
select Associate Mesh Files > All files or Latest only from the context menu.
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• Choose All files to assign all files to the module, if several representations exist for a particular
module.

• Choose Latest only to set the latest file, based on time stamp, as the only representation
associated with the module.

Figure 179:

Associate mesh files search the mesh files based on their CAD file name. If the module does not have
any CAD files associated with it, then no file will be associated. When HyperMesh is associating mesh
files, a CAD representation is necessary. For example, when the initial PLMXML file contains only solver/
hm files, nothing can be associated.

The associate mesh file also searches the mesh files based on their extension and CAD file name. If
HyperMesh associates the wrong mesh file, select Associate Mesh Files > All files and then locate
the appropriate file.

Show Contents in Module

To display all of the contents in a selected module, select Show Contents from the right-click context
menu.
HyperMath opens a new Content Browser, which displays all the contents in the selected module.

Export a Model

To export a model for a given module, select Export Model > HM File or Solver File from the right-
click context menu.

• Choose HM File to save all of the information about a particular module into an HyperMesh file and
associates that file as a representation for the selected module.

• Choose Solver File to save all of the information about a particular module into a Solver file and
associates that file as a representation for the selected module. The file format is determined by
the current user profile.
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You are only able to save a file when entities are organized under the module and the current
representation of the module is not empty. After HyperMesh creates the new file, it is set as the current
representation to the module.

Show, Hide and Isolate Modules

To show, hide, or isolate a module in the graphics area, right-click on the module and then select
Show, Hide or Isolate from the context menu.

Show will bring the module to the display; Hide will hide the module; Isolate will turn off all other
modules and display the selected one.

Note:  This operation is recursive, meaning that when you select a module and perform an
operation on it, the same applies to all the children modules.

Realize Connectors

1. To import and realize the connectors from a .mcf file, click  in the Assembly Browser.

The Mcf Import dialog opens.

Figure 180:

2. In the MCF File field, navigate to your working directory and open the connector file.
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Show All Attributes in a Module

To display all of the attributes in a selected module, select Show All Attributes from the right-click
context menu.
HyperMesh opens a dialog that displays all the attributes in the selected module.

Collapse and Expand All Modules in the Assembly Browser

To collapse or expand all of the modules models in the Assembly Browser, select Collapse All or
Expand All from the right-click context menu.

To close all of the modules models in the tree structure and only display the top-most module, select
Collapse All. To open all of the modules models in the entire tree structure and expose every item
nested at every level, select Expand All.

Configure the Assembly Browser

1. To change what columns display in the Assembly Browser, select Configure Browser in the right-
click context menu.
The Column Visibility dialog opens.

2. From this dialog, select the check boxes of the columns you wish to display.
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Connector Browser
Use the Connector Browser to view and modify connectors in the current model.

To invoke the Connector Browser in the tab area, click View > Connector Browser from the menu
bar.

The Connector Browser consists of:

• The Link Entity Browser, located in the first pane of the tab, displays information about all of the
linked entities in the model and Connectors groups.

• The Connector Entity Browser, located in the middle pane of the tab, displays a tree view of all
the connections the model contains. HyperMesh organizes and displays the connectors in different
folders based on their respective realization type. The names of the folders are obtained from the
FE configuration names that are specified for respective solvers in the feconfig.cfg file.

• The Connector Entity Editor, located in the last pane of the tab, displays attributes assigned to the
connector(s) selected in the Connector Entity Browser.
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•

Figure 181:

Use the Connector Browser to:

• Add Links

• Remove links

• Update links
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• Find Connectors from Parts or Links

• Find Connectors from Realizations

• Find Links from Connectors

The actions performed in the Connector Browser, such as selecting, highlighting, showing, or hiding
supported entities, are reflected in the graphics area. For example, when you select an entity in the
Connector Browser, HyperMesh outlines it in white in the graphics area.

The browser and the HyperMesh database synchronize with each other to ensure that all the changes
made to the connector or the supported entities information in the database are reflected correctly in
the browser at all times.

The browser can be configured to only display the information you wish to see. The current
configuration is always saved, so that when the browser is opened in the future it will contain the same
configuration as the last time that it was used.

Connector Browser Tool Sets and Context Menus
Use the different tool sets and context menus in the Connector Browser to access additional options.
The Link Entity Browser and the Connector Entity Browser each contain their own set of tools.

The Link Entity Browser consists of a context menu, global display tool set, and action modes tool set
(rimmed in blue below). Click the toggle buttons to access additional view options (red) and advanced
action options (yellow). A query builder allows to filter down the links to be listed (green).

Figure 182:

The Connector Entity Browser consists of a context menu, global display tool set, and action modes
tool set (rimmed in blue below). Click the toggle buttons to access additional view options (red) and
advanced action options (yellow). A query builder allows to filter down the connectors to be listed
(green).

Figure 183:

Use the Utility tools, at the bottom of the Connector Browser, to access various Connector panels, as
well as export connector data in XML format.
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Figure 184:

Link Entity Browser
The Link Entity Browser displays all of the links that are connected using the connectors in the model.

Predefined browser view modes available in this browser include: Common Top view, Component Link
view, Property Link view, Part Link view and Connector Group view.

Figure 185:

Note:  If a connector uses an element-type link, the component containing the element
is also listed in the Link Entity Browser. Isolating this link displays the whole component
instead of the single element. In the browser configuration window, activating the Show
Primary Links Only option, for example, will list only real component links in the
component link view.

The information displayed in this browser can be used to quickly locate certain links and appropriate
connectors in the graphics area.

The global display tools, action mode tools, and context menu options (show, hide, isolate, and isolate
only) work exactly as they do in the Model Browser, when all of the view options are inactive (contain
a grey background). The only difference is that they will only work on component, property, and part
links.

When one or more of the view options are active (contain an orange background), the show, hide,
isolate, and isolate only options behavior and appearances will change. To indicate a change in their
behavior, a connector symbol will appear in the icon.

Figure 186:

The action mode tools take into account the connector-link-relations, and the display results depend on
the active view options. Therefore, parts of the model are separated into the following three categories
that are based on the link selection:

1st link entity
Selected links

linked connectors
Connectors which reference at least one of the selected links
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2nd link entity
Links which are referenced by the linked collectors

Note:  In this case, connectors and their realizations are treated as being a separate
category from their links, in order to prevent unpredictable cross-references.

HyperMesh only uses this type of categorical separation when one of the view options are active and
you select the show, hide, isolate, and isolate only options from the context menu or from the action
mode tools. No other functionality uses this categorization at all.

The base features in the Link Entity Browser can be changed from the Link Entity Browser configuration
window.

Action Mode Tools
Use the series of action mode tools on the right-hand side of the Link Entity Browser to control both
entity selection and the display of the model in the graphics area.

Figure 187:

The behavior of the action mode tools depends on the settings of the view options. When all of the view
options are inactive (gray background), the core behavior of the action mode tools work exactly as they
do in the Model Browser. If you select one or more of the view options, the behavior of the show, hide,
isolate, and isolate only options change and a connector symbol appears in the icon. In this mode, you
are able to select entity links in the graphics area instead of entities. The entity links you are able to
select depends on the view option you select.

Figure 188:

The table below explains the different action mode tools.

Icon Description

Use the next and previous tools to cycle through the selected links in the Link Entity
Browser. To activate these tools, select link entities in the browser.

These tools will be especially helpful to you when not all of the selected links can be
seen in the partial view of the list.

Use this tool to select a type of entity that the rest of the action mode tools will act
on. For example, when you set this tool to "components", the Selector tools (described
below) will only be able to select or deselect component links.
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Icon Description

This icon is always disabled and set to the entity type that is defined by the view mode
you have selected.

Use this tool to determine whether the rest of the action modes tools will act on:

• elements only

• geometry only

• both

If you select elements only, you can still perform actions on connectors (geometric
entities) by selecting their link entities. However, any actions taken, such as Isolate,
will only affect the entity types specified by this tool. In the case of geometry only,
only the connectors with at least one link state defined as "geometry" are taken into
account.

Since you can define connectors as linking elements, surfaces, or a combination of
both, this tool affects actions taken on them in a similar manner. For example, if you
set the tool to "elements only" but select a connector that only connects geometry, the
actions you might take on that connector will not affect it. However, if the connector
links both geometry and elements, then any actions you might take will still apply to
the connector due to the element links.

Use the Selector tool to interactively select and find any type of supported link entity
in the browser or graphics area. For example, when you select a link entity in the
graphics area, HyperMesh highlights it in the browser. This is an efficient way of
selecting and finding multiple link entities at once.

You can use this tool in conjunction with the show, hide, isolate, and isolate only action
mode tools, as well as with the show/hide connectors between and isolate/isolate only
connectors between advanced action tools. To use the Selector tool in conjunction with
the other tools listed above, select the link entities in the browser or graphics area and
then click the desired action mode tool.

Note:  The advanced action tools are only active when you select at least
two link entities.

In other respects, the Selector tools behaves exactly as it does in the Model Browser.

The Add to Panel Collector is a function whereby the browser can be used to select and
add entities to the panel collectors within HyperMesh. This is an alternative method
to using the advanced selection capabilities already available in each panel collector's
extended entity selection menu. This button only becomes available when you have a
HyperMesh panel open that includes at least one entity collector.

Use the Show/Hide tool to display or hide selected entities. The behavior of this tool
will depend on the view option settings.
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Icon Description

Click this option to activate it, and then select the desired links in the graphics area.
HyperMesh hides the selected links and any other entities found by the view option
settings.

Note:  If you are selecting from the graphics area, this option will only
work on visible links.

Use this option to isolate/isolate only selected entities. The behavior of this tool will
depend on the view options settings.

Click this option to activate it, and then select the desired link entity in the graphics
area.

Isolate
Displays only the selected entities which match the view option toggles, turning
their display state to on and turning all other entities of the same type off.
Isolate works locally within a specific entity type – for example, if component(s)
are isolated, then all display states of other displayable entities, such as load
collectors, remain untouched.

Isolate Only
Works like Isolate, except that it also affects entity types different from the
matching, selected entities. Thus, it turns off ALL displayable entities, regardless
of type, except for the selected one(s) that match the view option settings.

View Option Toggle Buttons

The Link Entity Browser is a tool to easily examine the connections between the different parts of a
model. One strategy to do that is to start the investigation on one part or a certain group of parts, so
each action in the Link Entity Browser starts with a selection of parts. Parts can be considered as links.

These view options affect the Link Entity Browser action modes tools, and thus determine the entities
that display when you select and then show, hide, or isolate a link.

Figure 189:

Each button is modal, that is, you click it once to activate it, and click it again to deactivate it. Active
buttons remain active until you specifically deactivate them, so you do not need to worry about them
"resetting" after you perform an action such as isolate.
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Figure 190: Active

Figure 191: Inactive

The following model illustrates the effects of these search options.

Note:  The highlighted component; this component is the starting point for the following
examples.

Figure 192:
Model provided courtesy of Audi.

In each example below, the selected component has been isolated using only the relevant view option.

Option Name Effect

1st link entity The selected link entity can always be seen as the 1st link
entity, even if the selected part is not referenced by any
connector at all. If the 1st link entity view option button is
active, the selected links will be taken into account for the
action regardless.

This means that in case of the isolation, all selected links
will be isolated.
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Option Name Effect

Figure 193:

Linked connector
entity

If this linked connector entity view option button is active
all connectors linked to the 1st link entities will be taken
into account for the action. It does not matter if the 1st
link entity view option button is active or inactive, its
connectors will still be located. This determination has
nothing to do with any display states.

This means that in case of the isolation, only the
connectors which are referenced by the selected links (1st
link entity) are isolated.

Figure 194:

2nd link entity If the 2nd link entity view option button is active, all link
entities referenced by the determined connectors except
the (selected) 1st link entities will be taken into account
for the action. It does not matter if the 1st link entity or
the linked connector entity view option buttons are active
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Option Name Effect

or inactive; this determination has nothing to do with any
display states.

In the case of isolation, this means that only the links that
share connectors with the selected entities are isolated.

Figure 195:
The selected link is hidden because 1st link entity was not active.

Realization When this option is active, all realizations belonging to
the determined linked connector entities will be taken into
account for the action.

Figure 196:

Cumulative Effect of Multiple Options
These options work accumulatively, for example, when both the 1st link entity and 2nd link entity
buttons are active, then selecting and isolating a component link displays both it and all of the
components connected it. If you had realization, 1st link entity, and 2nd link entity active when you
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isolated the same component link, then the model would display all of the component links connected to
the selected one, as well as graphical representation of the realizations of each connector linking those
component links together.

Figure 197:
The first image shows an isolated view with only 1st link and connectors. The second includes 1st and 2nd links, connectors, and

realizations.

Using the 2nd Link Option to Expand the Selection
You can use the 1st link and 2nd link options together to gradually add more and more links to your
viewable model by starting with a small area, such as a single supported entity, and then selecting
additional supported entities. The example below starts with a single component that has been isolated
using the 1st link and linked connector entity options. Then, using the 1st link, linked connector
entity, and 2nd link options, the Show action mode tool is activated. In each subsequent image, one
component (highlighted) is selected to be shown. Because the 2nd link option is active, all components
connected to the selected one are revealed.

Figure 198:
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The initial isolated component is selected.

Figure 199:
All entities attached to the component are revealed. Another is selected.

Figure 200:
Link entities attached to the selected one are revealed. A third is selected.

Figure 201: Entities now have direct connection to the original part, display.
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Advanced Option Buttons

Located adjacent to the view option toggle buttons, these two buttons allow you to show, hide, isolate 
or isolate only connectors shared by two or more link entities, by picking the links, or other supported 
link entities, that they connect. These advanced actions then select the connectors referenced by the 
selected link entities and perform the desired action (show, hide, and so on) upon them.

Figure 202:

These buttons only enable when you select at least two entities from the graphics area or the Link
Entity browser list, and they perform different actions depending on the mouse button used:

Button Name Left-Click Behavior Right-Click Behavior

Show/Hide Show connectors between
the selected entities.

Hide connectors between
the selected entities.

Isolate/Isolate Only Isolate the selected entities
and the connectors between
them.

Isolate only the
connectors between the
selected entities.

Unlike other action-type buttons, these two are not affected by the link view option toggle buttons
(1st link, 2nd link, or linked connector). However, they do work in conjunction with the realization view
option button.

You can specify how these shared connectors are determined by changing settings in the Link Entity
Browser configuration window.

Global Display Tools
Use this tool set to display or hide the graphics for supported entities in the browser list.

Figure 203:

Icon Description

Elems/Geom/Both (filter for All/None/Reverse and local display control)
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Icon Description

Display All

Display None

Display Reverse

The Elements/Geometry/Both button determines what the other buttons act on; left-click the small
triangular downward arrow to reveal a drop-down menu of options. You can select Elements, Geometry,
or Both.

Use the Display All, Display None, and Display Reverse buttons at the top of the tab to change the
display state of all assemblies, multibodies, components, groups, system cols, load cols, and vector cols
shown in the list. All displays and None hides all of the items shown in the list/tree. Display Reverse
reverses the state of all the entities (displaying the hidden, and hiding the displayed). If you have
multiple link entities selected in the browser list, then HyperMesh will only perform these actions on the
selected entities. To deselect all currently selected entities, left-click in any empty "white space" within
the browser list, such as between columns. To clear the selected entities in the browser, make sure the
browser is active, and then press Esc.

Note:  These buttons only affect the display state. They do not actually remove entities
from the model, but only show or hide them in the graphics area.

Context Menu
In the Common Top View, right-click on an empty space or right-click on an entity to access the context
menu. The options in context menu varies accordingly.

Right-clicking in empty space displays the following:

Option Description

Create Create a new Connector Group.

Reorganize Auto Reorganize
Organize connectors into connector groups based the settings defined in the
Auto Reorganize Settings dialog.

Auto Reorganize Settings
Access settings used to reorganize connectors into Connector groups.

Organize Only Connector(s) from Model
Only reorganize connectors from the Model. Connectors that are
present in other Connector Groups will not be reorganized.
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Option Description

Delete Cleared ConnectorGroup(s)
Delete previous Connector Groups which become empty after
connectors are organized into new Connector Groups based on the
reorganization schema setting.

Reorganization schema
Choose one of the following:

• Select Create one group per link combination to organize
connectors by creating new Connector Groups based on their
connector link information. For example, if connectors are
connecting components with ID 1 and 2, then a new Connector
Group will be created with the name “Comp1_Comp2”, and all
of the connectors that connect those two components will be
organized in to this newly created Connector Group.

• Select Create one group per include to organize connectors by
creating new Connector Groups based on the Include file to which
the connectors belong to. For example, if connectors belong to
the Include file with ID ‘10’, then a new Connector Group will be
created with name “Include10”, and all of the connectors will be
organized in to this newly created Connector Group.

Show All Turn on the display state of all entities supported in the Common Top view.

Reverse Reverse the display state of all entities.

Configure Browser Opens the Configuration Window dialog.

Context menu option change when you right-click on entities. The context menu options vary based
if you right-click on a Connector Group or Component Link/Property Link/Part Link. Right-clicking in
empty space displays the following:

Option Description

Duplicate Create a new, empty Connector Group.

If Duplicate is used on a Connector Group that has the name
“Connecotr_Group_1”, a new, empty Connector Group with the name
“Connecotr_Group_11” is created.

Rename Rename a Connector Group.

XRef Entities Open the Reference browser and review a list of all Connectors Groups and
Connectors that belong to that Connector Group.

Delete Delete selected entity.
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Option Description

In the Confirm dialog, select the Retain Connectors and move to Model
checkbox to only delete the Connector Group, and move the connectors that
belong to the deleted Connector Group to the Model.

By default, both the Connector Group and all the connectors that belong to the
Connector Group are deleted.

Empty Open the Delete Entity dialog, from which you can choose which empty
Connector Groups to delete.

Configure Browser Opens the Configuration Window dialog.

Right-clicking on a Component Link, Property Link, or Part Link opens the following context menu
options:

Option Description

Convert Links(s) Convert existing link type on connectors to: Part, Comp, or Prop.

Connector link conversion requires a clear 1:1 relation between a component and
a property, otherwise the conversion is not unique and cannot be performed.

Remove From
Connectors

Remove links from connectors.

This option works on selected/displayed/all connectors. Use the update layer
option to automatically update layers once links are removed.

Find / Find with FE The selected links and all connectors referencing them are isolated in the graphics
area. The links as well as the linked connectors are highlighted in their browsers.

This Find operation considers only the realization and fit view buttons. When the

realization button  is active, Find changes to Find With FE.

Find Attached /
Find Attached with
FE

The selected links, all connectors referencing them, and all links referenced by
these connectors are isolated in the graphics area. All the found links as well as
the linked connectors are highlighted in their browsers.

This Find Attached operation considers only the realization and fit view buttons.

When the realization button  is active, Find Attached changes to Find Attached

With FE.

Find Between /
Find Between with
FE

The selected links and connectors that link them together are isolated in
the graphics area. All the found links as well as their shared connectors are
highlighted in their browsers.
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Option Description

This Find Between operation considers only the realization and fit view buttons.

When the realization button  is active, Find Attached changes to Find Attached

With FE.

Note:  The type of connector to find by this action can be set in the
options tab of the Link Entity Browser Configuration dialog. By
default, a connector which references at minimum two of the selected
links is treated as a "between" connector.

Show Works exactly like the action button Show. All view option button settings are
considered.

Hide Works exactly like the action button Hide. All view option button settings are
considered.

Isolate Works exactly like the action button Isolate. All view option button settings are
considered.

Tip:  Only show the isolated links in the browser by selecting
(last_celink_review) from the query build drop-down menu.

Isolate Only Works exactly like the action button Isolate Only. All view option button settings
are considered.

Column Visibility Opens the Column Visibility dialog. Checkboxes are used to control, which
columns should be shown in the browser.

Configure Browser Opens the Configuration Window dialog.

Configuration Window
In the Browser Configuration dialog you can alter the columns that display in the Link Entity Browser,
and change how special features, such as the find between, operate.

Access the Browser Configuration dialog by right-clicking in the Link Entity Browser and selecting
Configure Browser from the context menu.

Local Options

Figure 204:
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Show Link Rule Columns
When enabled, each link displays its reconnection rule (use ID, use name, or at fe realize) via the
Rule column. The reconnect rule is set when the connector is created, and determines what the
connector will automatically try to reconnect with when a part is deleted and then replaced.

• If the new part has the same part ID as the deleted one, then use ID will automatically
reconnect.

• If the new part has the same name as the deleted one, then use name will automatically
reconnect.

Figure 205:

Show Link Elems/Geom Columns
When enabled, each link displays its link state (connect to mesh or geometry) via the Elems/
Geom column.

Figure 206:

Max Link Column Viewed
Only display the specified number of columns, regardless of how many links are available in a
connector. The maximum number of supported columns is 30.

Show Primary Links Only
By default, both primary and secondary links are displayed in the Connector Entity browser. To
only display primary links, select the Show Primary link only checkbox.
By default, a node link is also displayed as a component link in the Component link view. For
example, components are shown as a link when a node that belongs to an element belongs to a
component, an element belongs to a component, or a surface belongs to a component.

When Show Primary Link Only is selected, the Part link view only displays real part links and the
Component link view only displays real component links. Use the table below to determine which
link types will be interpreted as a component or park link based on view you are using.
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Link Type Component Link View Part Link View

Show Primary
Links Only: off

Show Primary
Links Only: on

Show Primary
Links Only: off

Show Primary
Links Only: on

Nodes yes no yes no

Elements yes no yes no

Components yes yes yes no

Assemblies yes no no no

Parts no no yes yes

Properties no no no no

Surfaces (geom) yes no yes no

Tags no no no no

Automatic Filter
Filter the link entity list and the connector list simultaneously when performing a show, isolate, or
find operation.
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Figure 208: Query Build Filters for the Connector List
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Tip:  For future filtering via the Query Builder, you can reuse previous filters and
combine previous filters with other attribute filters.

Consider Geometry
Consider geometry along with elements while using Show/Hide/Isolate operations.

Figure 209: Consider Geometry: Off
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Figure 210: Consider Geometry: On

Consider HAZ Elements
Consider HAZ elements while using Show/Hide/Isolate operations. When this option is on, and if
connectors are isolated, HAZ elements are also isolated along with connectors and their links.
Available for Connector Configure browser options.
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Figure 211: Consider HAZ Elements: Off
HAZ elements of hexa Nugget connectors are not isolated along with connectors and linked components.

Figure 212: Consider HAZ Elements: On
HAZ elements of hexa Nugget connectors are isolated along with connectors and linked components.

Find Twin Connectors
Select how two connectors are found:

Minimum two links
Find only the connectors that have two or more matching links.

Exact links
Find only the connectors that have the same links. For example, if you start with a
connector that has two links, than another connector with three links will not be found even
if its first two links matched.

Find Connectors Between With
Select how connectors between selected links are found:

Minimum two selected links
Only connectors that link to at least two selected entities will be affected. Connectors with
only one link to any of the selected entities will be ignored.
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Exact selected links
Only connectors that link to the selected entities will be affected. This can vary from the
Minimum two selected links option, because connectors with three or more links which
link two selected entities with at least one unselected entity, would still be found by the
Minimum two selected links option but not by this one.

All selected links
Any connector shared by the selected entities will be found.

Note:  Connectors which link selected entities to any unselected ones will not be
found, as they are not located between the selected entities.

Filter Links To
Choose which links to filter when performing search/isolation functions.

Projection Components
Isolate the entire link component.

Projection Elements
Isolate only the elements on which a projection falls.

Projection and Attached Elements
Isolate only the elements on which the projection falls and the elements which the
connector FE connects.

Filter Links To Projection
Components

Projection Elements Projection and
Attached Elements

Spots

Figure 213:

Figure 214: Figure 215:

Seams

Figure 216:

Figure 217: Figure 218:

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.950

Filter Links To Projection
Components

Projection Elements Projection and
Attached Elements

Bolts

Figure 219: Figure 220: Figure 221:

Global Options

Figure 222:

Autofit
Use this option in combination with the other view option toggle buttons and show, hide, isolate,
or isolate only, or in combination with the advanced action buttons. After an action is performed,
the newly found connectors are placed in the middle of the screen. If this option is used in
combination with one of the previously mentioned buttons, it works like a pure fit view.

Figure 223:
Link entity isolated with the Autofit option activated.

Autocolor Visualization Mode
With this mode activated, the Connector Browser takes over the control of the element
visualization mode from the Visualization panel. Elements will be colored by component, by
property, or by part, depending on which connector link view is activated.
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Figure 224:

Connector Entity Browser
The middle section of the Connector Browser contains a tree view of all the connections contained in the
model, and has its own set of tools similar to the ones found in the Link Entity Browser.

All the connectors in the model are displayed in folders organized based on the respective realization
types. The names of the folders are obtained from the FE configuration names specified for respective
solvers in the feconfig.cfg file.

Figure 225:
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The connector information in the tree can be used to find link entities connected by specific connectors,
and also to modify certain connector attributes. The columns display a sub-set of connector information
that is important for recognizing connection information easily.

Unless all view option toggle buttons in the global display tool set are inactive, the action mode tool set
and the context menu actions (show, hide, isolate, isolate only) work similarly to their functions in the
Model Browser's component view.

If at least one of the view option toggle buttons is active (appearing in orange), the behavior of
show, hide, isolate and isolate only is different. The image on the action buttons changes to include a
connector symbol, indicating the different behavior.

Figure 226:

The actions take into account connector-link relations, and the display result depends on the active
view options. Therefore parts of the model are separated into three different categories based on the
connector selection:

1st connector entity
Selected connectors.

linked entities
Links which are referenced by one of the selected connectors.

2nd connector entity
Connectors which reference at least one of the linked entities.

Note:  In this case connectors and their realizations are treated as being a separate
category from their links, in order to prevent unpredictable cross-references.

This kind of categorical separation is only used for the actions show, hide, isolate and isolate only, and
only when one of the view option toggle buttons is active, regardless of whether the actions are taken
from the context menu or the action buttons. No other functionality uses this categorization at all.

You can also change the base features of the Connector Entity Browser in the Connector Entity Browser
configuration window.

The following connector details are displayed as column data in the browser tree:

Option Description

Entities ID of the connector and an image that represents the respective connector’s
style (spot, seam, bolt, and so on).

Layer Total number of link entities to be joined by the connector. This is also marked
as thickness layers (2T/3T/4T, and so on).
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Option Description

Tolerance Realization tolerance of the connector. You can change this by right-clicking the
field and typing in a new value, then pressing Enter.

ConnectorGroups Name of the Connector Group to which the connector belongs.

Component Name of the component to which the connector belongs (this column is not
displayed in default view).

 (link type) Type of entity that can be added to the selected connector(s) as a link reference.
Supported entities are assemblies, components, surfaces, elements, tags, and
nodes.

Tip:  Left-click on a link to highlight the relevant entity (part) in the
graphics area.

Figure 227:

Rule Defines how a connector treats an entity added as a link. Adding a link with an
ID or name rule forces the connector to retain the link’s ID or name even if that
link entity no longer exists in the database. This aids in part replacement when
a new part replaces an old part and both share the same ID or name. Adding
a link with the at fe-realize rule ensures that each time a connector is realized
the closest entity of the correct type is found and connected. This is useful when
connectors need to connect to a closest part in an assembly.

Link ID or name of the entity added as a link to a connector.
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Option Description

Structure Defines whether the weld created during connector realization connects to
geometry or mesh on the link. This only applies to assembly, component, and
surface entities that can contain geometry and/or mesh information.

Comment Input comments for a connector.

State Realization state of the connector entity: unrealized, realized, failed, or modified.

Note:  For those writing scripts instead of using the GUI, a more
detailed report can be created by using the following lines in your
script: set error_report [ hm_ce_errorreport CE_ID 1 ].

Functionality is accessed from the global display tool set, an action modes tool set and a right-click
context menu.

Action Mode Tools

The series of icons found on the right side of the Connector Entity Browser control both entity selection
and the display of the model. These buttons behave in two different ways depending on the setting
of the view option buttons. If no view option button is active, the core behavior of the action mode
tools (show/hide/isolate) applies exclusively to the selected connectors, similarly to components in the
component view of the Model Browser. For that reason, this topic focuses on their behavior when a view
option is active.

In this mode the actions like show, hide, isolate or isolate only are not only done on the selection;
based on the selection, the browser performs a process of finding and filtering so that further entities
can be taken into account for the action depending on the setting of the view option toggle buttons.

Use these tool set buttons to advance or step back through multiple selected connectors, pick
connectors from the graphics area, add connectors to an active panel's entity collector, turn the display
of individual connectors on and off, visually isolate specific connectors, or undo any visual modifications
(show/hide/isolate).

Figure 228:

Icon Description

The next and previous buttons cycle through the selected connectors in the tree,
but are only active when entities in the tree are selected (highlighted). These are
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Icon Description

especially helpful when not all selected connectors can be seen in the partial view
of the tree.

These buttons affect how the rest of the tools work, by determining what type of
entity they will act on. For example, when set to "connectors", the Selector tool
(described below) will only select or deselect connectors.

Note:  These icons are disabled and set to their default values
("connectors" and "both geometry and elements") since only
connectors can be selected in the Connector Entity Browser, but
the Connector Browser works with all kinds of connectors – both
geometry and FE-based.

Use the Selector tool to interactively select any type of supported connector
entity via the browser, or by selecting within the graphics area. The Selector
can be used to find connector entities from the graphics area which will then be
highlighted in the list, and is also an efficient way of selecting multiple connector
entities at once.

Finally, the selector can be used in conjunction with the action buttons show,
hide, isolate and isolate only as well as the advanced action buttons show/hide
twin connectors and isolate/isolate only twin connectors; simply select connector
entities from the browser or graphics area using the Selector, then click the
desired action button.

Note:  These advanced action buttons only activate when at least
two connector entities are selected.

In other respects the Selector works exactly the same as described for the Model
Browser.

The Add to Panel Collector is a function whereby the browser can be used to
select and add entities to the panel collectors within HyperMesh. This is an
alternative method to using the advanced selection capabilities already available
in each panel collector's extended entity selection menu. This button only
becomes available when you have a HyperMesh panel open that includes at least
one entity collector.

Show/Hide the currently selected entities, depending on the currently active view
option toggles.

Alternatively, click this mode on and then pick the desired connectors from the
graphics area; connectors and any other entities determined by the view option
toggle settings are hidden as you click on them.
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Icon Description

Note:  When used to select from the graphics area, this button only
works on visible connectors.

Isolate/isolate only the currently selected entities. Alternatively, click this mode
on and then pick the desired connector entity from the graphics area.

Isolate
Displays only the selected entities which match the view option toggles,
turning their display state to on and turning all other entities of the same
type off. Isolate works locally within a specific entity type, for example,
if component(s) are isolated, then all display states of other displayable
entities, such as load collectors, remain untouched.

Isolate Only
Works like Isolate, except that it also affects entity types different from
the matching, selected entities. Thus, it turns off ALL displayable entities
(regardless of type) except for the selected one(s) that match the view
option settings.

Note:  Unlike the normal isolate button, when used in the graphics
area, this button only works on visible connectors.

View Option Toggle Buttons

These options affect the action mode tools, and thus determine the entities that display when you select
and then show, hide, or isolate a supported entity.

Figure 229:

Each button is modal, that is, you click it once to activate it, and click it again to deactivate it. Active
buttons remain active until you specifically deactivate them, so you do not need to worry about them
"resetting" after you perform an action such as isolate.

Figure 230: Active
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Figure 231: Inactive

The following model illustrates the effects of these search options.

Note:  The highlighted connector; this connector is the starting point for the following
examples.

Figure 232:
Notice the small, white-highlighted connector entity on the grey-meshed part. (Model provided courtesy of Audi)

In each case below, the selected connector has been Isolated using only the relevant view option.

Option Name Effect

1st connector entity The selected connector entity can always be seen
as the 1st connector entity, even if the selected
connector doesn’t reference any links at all. If the
1st connector entity view option button is active, the
selected connectors will be taken into account for the
action regardless.

This means that in the case of isolation, all selected
connectors will be isolated.
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Option Name Effect

Figure 233:
The single selected connector is isolated (also shown in magnified

view).

Linked entity Finds the link entities/supported entities to which the
selected connector connects.

If this linked entity view option button is active, all
entities linked to the 1st connector entities will be
taken into account for the action. It does not matter
if the 1st connector entity view option button is
active or inactive, its entities will still be located. This
determination has nothing to do with any display
states.

This means that in case of isolation, only the entities
which are referenced by the selected connectors (1st
connector entity) are isolated.

Figure 234:
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Option Name Effect

The connector does not display because "1st linked entity" is not

active.

2nd connector entity Finds other connectors that are connected to the
chosen connectors' linked entities.

If this 2nd connector entity view option button is
active, all connectors referenced by the determined
linked entities except the originally-selected 1st
connector entities will be taken into account for the
action. It does not matter if the 1st connector entity
or the linked entity view option buttons are active or
inactive; this determination has nothing to do with
any display states.

In the case of isolation, this means that only the
connectors that share links with the selected 1st
connector entities are isolated.

Figure 235:
The entity does not display because "linked entity" is not active.

Realization Finds and displays the realization for the selected
connectors.
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Option Name Effect

Figure 236:

.

Cumulative Effect of Multiple View Options
These options work accumulatively, for example, when both the Linked entity and 2nd connector entity
buttons are active, then selecting and isolating a connector displays the component that it links to,
and all the other connectors that link to that component. If you had Realization, Linked entity, and
2nd connector entity active when you isolated the same connector, then the model would display
the component to which the connector links, all other connectors linking to that component, and the
realizations of each displayed connector.

Figure 237:
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The first image shows an isolated view with linked entity, 2nd connectors, and realizations. The second includes the same options,

but without realizations.

Using Connector Links to Expand the Selection
You can use the Show feature to gradually increase the entities and connectors that display. In the
following example, a single connector's link entities and 2nd connectors have been isolated. By
activating the Show action mode, the components and connectors that display can be expanded by
clicking on connectors that currently display; since the link entities and 2nd connectors view modes are
still active, each clicked connector's link entities and 2nd connectors are added to the view.

Figure 238:
The highlighted connector is selected for Show.

Figure 239:
A new connected component displays. Again, the highlighted connector is clicked...
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Figure 240:
Connected component displays. A third highlighted connector is clicked...

Figure 241:
Third connected component displays.

You can continue revealing more and more parts this way, theoretically eventually revealing the
entire model. The reverse option is also true; by activating the Hide mode instead of Show, you could
gradually "chip away" at the model, removing one connected component at a time – or multiple
components in the case of multi-layer connectors.

Advanced Action Buttons

Located adjacent to the view option toggle buttons, these two buttons allow you to show, hide, isolate
or isolate only "twin" connectors. Twin connectors are connectors which reference at least two matching
link entities. The criteria for exactly how twin connectors must match can be increased in the Connector
Entity Browser Configuration Window to require all links to match exactly, instead of only two or more
matching ones. These advanced actions then select the connectors referencing the same links and
perform the desired action (show, hide, and so on) upon them.
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Figure 242:

These buttons only enable when you select at least one connector entity from the graphics area or
the Connector Entity Browser tree, and they perform different actions depending on the mouse button
used:

Button Name Left-Click Behavior Right-Click Behavior

Show/Hide Show twin connectors Hide twin connectors

Isolate/Isolate Only Isolate twin connectors Isolate only twin connectors

Unlike other action-type buttons, these two are not affected by the view option toggle buttons (1st
connector, 2nd connector, or linked entity). However, they do work in conjunction with the realization
view option button.

Global Display Tools
Use this tool set to control the display of connectors.

Figure 243:

The functionality works at three levels; if nothing is selected, this is called the global level, the display
action will work on all connectors. At the folder level, if the folder is highlighted then the action will only
operate on the connectors within the folder. At the local entity level, if a single or multiple connectors
are selected then the operation will operate only on those selected.

Icon Description

Display All

Display None

Display Reverse
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Note:  These buttons only affect the display state. They do not actually remove entities
from the model, but only show or hide them in the graphics area.

Context Menu

The Connector Entity Browser context menu includes all of the functionality available in the Connector
Entity Browser, including connector creation and deletion, renumbering, updating, finding connectors,
and much more.

Access the Connector Entity Browser's context menu by right-clicking in the tree list.

Note:  If you right-click the Tolerance or Realize to fields of a specific connector, you will
access those fields for edit rather than opening the context menu.

The tools available in the context menu vary depending on what you right-click on; for example, right-
clicking on a connector (in the Entities column) accesses the full menu, but right-clicking a link (in the
Link 1 or Link 2 columns) only presents the Remove Link option.

Depending on the column clicked, the following options may or may not be available as appropriate to
the item clicked:

Option Description

Create Choose the type of connector to create, then define connector settings in
the related connector panel that opens in the HyperMesh panel area, as
well as the FE Absorb user interface.

Delete Delete connectors or connectors and their related FE elements.

Organize Open the Organize Connector(s) dialog, from which you can organize
connectors into different Connector Groups.

Convert Convert connectors to a different type, for example a spot connector into a
bolt connector.

For more information, see Convert Style.

Combine Combine single point connectors into line connectors, for example several
spot connectors into a spotline connector.

For more information, see Combine.

Split Split line connectors into single point connectors, for example a spotline
connector into several spots.

For more information, see Split.
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Option Description

Position Position connectors to the center between the farthest links or back to their
source position.

For more information, see Position.

Renumber Renumber a single connector; the change is permanently recorded in the
database and in the browser.

Update layer Update the Layer field, which becomes editable in Connector Entity
browser, to input the layer value that you wish to assign to the selected
connectors (this function works for multiple selections).

Enter the desired number of layers into the text box and press Enter.
The layer value defines the number of thicknesses (2T/3T/and so on) a
connector connects at its location. The layer value defined in a connector
can be greater than or equal to number of links connected by the
connector. The connectors will be unrealized after this update, but the
change is recorded permanently in the database and in the browser.

Alternatively, you can also update the layer directly by right-clicking on the
field itself rather than using the context menu.

Update tolerance Update the Tolerance field, which becomes editable in Connector Entity
browser, to input the tolerance value that you wish to assign to the selected
connectors (this function works for multiple selections).

You can also do this directly by right-clicking on the field itself rather than
using the context menu.

Update diafactor Update the diafactor field, which becomes editable in Connector Entity
browser, to input the diafactor (diameter factor) value that you wish
to assign to the selected connectors. This function works for multiple
selections.

You can also do this directly by right-clicking on the field itself rather than
using the context menu.

Note:  The diafactor field is shown for any connector of any
type. This value is mainly used for specific bolt realizations;
all others get "NA" by default for this field. Although you
can update "NA" to any value, the value is ignored during
realization.

Update diameter Opens a dialog to enter the diameter value that you wish to assign to the
selected connectors. This function works for multiple selections.

You can also do this directly by right-clicking on the field itself rather than
using the context menu.
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Option Description

Note:  The diameter field is shown for any connector of any
type. This value is not necessary for many realization types;
they get per default NA for this field, though you can update NA
to any value. This value is ignored then during realization.

Add Link Opens a new set of controls in the bottom of the tab to add links to the
selected connectors.

For more information, see Add Link.

Update Link Opens a new set of controls in the bottom of the tab to perform a part
replacement.

Note:  Editing a connector causes it to become unrealized.

Figure 244:

Remove Link Remove the selected link(s) from the selected connectors or all connectors
in the browser. The connectors will be unrealized and the change is
recorded permanently in the database and in the browser.

This option is accessible only from the column(s) that display the link
information.

Remove Links Remove all of the links from the selected connectors. The connectors will
be unrealized and the change is recorded permanently in the database and
in the browser selected connectors or all connectors in the browser. The
connectors will be unrealized and the change is recorded permanently in
the database and in the browser.

Convert Links Convert links to one of the following link types: Part, Comp, or Prop.
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Option Description

For more information, see Convert Links.

Change Link Rule The link rule defines how a connector treats an entity added as a link.
Adding a link with the ID or name rule forces the connector to retain the
link’s ID or name even if that link entity no longer exists in the database.

Change Link Structure The link state defines if the weld created during connector realization
connects to geometry or mesh on the link. This is applicable to only
components and surfaces entities that can contain geometry and/or mesh
information.

Copy Attributes Copy all attributes of selected connectors.

Paste Attributes Paste the copied connector attributes on to another connector.

Rerealize Calls the *CE_Realize command to realize connectors by accepting only
a connector mark. The underlying assumption in the command is that
each connector passed in the mark has the required information to be
successfully realized.

The required information such as tolerance, weld configuration, diameter,
and so on is not defined for connectors created using the FE Absorb utility;
hence the Rerealize feature in the Connector Browser works only for
connectors that were realized through an HyperMesh Connector panel.

Unrealize Unrealizes the selected connectors.

Find Components / Find
Components with FE

The entities that are linked in the selected connectors are isolated in the

display with the connectors. If the realization view option  is turned

on then the realized FE of the connectors is also displayed. The isolated
entities are highlighted in the table.

Show Works exactly like the action button Show. All view option button settings
are considered.

Hide Works exactly like the action button Hide. All view option button settings
are considered.

Isolate Works exactly like the action button Isolate. All view option button settings
are considered.

Tip:  Only show the isolated connectors in the browser by
selecting (last_celink_review) from the Query Build drop-
down menu.
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Option Description

Isolate Only Works exactly like the action button Isolate Only. All view option button
settings are considered.

Collapse All This option closes all the expanded folders in the browser.

Expand All This option expands all the folders to display all the connectors. This
operation may take some time for folders that contain thousands of
connectors.

Configure Browser Opens the Configuration Window which contains options to configure the
Connector Browser's list display and button behavior.

Configuration Window
In the Browser Configuration dialog you can select which columns to display in the browser, and
change the way special tools, such as find twin connectors, operate.

Open the Browser Configuration dialog by right-clicking in the Connector Entity Browser and
selecting Configure Browser from the context menu.

Local Options

Show Link Rule Columns
When enabled, each link displays its reconnection rule (use ID, use name, or at fe realize) via the
Rule column. The reconnect rule is set when the connector is created, and determines what the
connector will automatically try to reconnect with when a part is deleted and then replaced.

• If the new part has the same part ID as the deleted one, then use ID will automatically
reconnect.

• If the new part has the same name as the deleted one, then use name will automatically
reconnect.

Figure 245:
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Show Link Structure Columns
When enabled, each link displays its link state (connect to mesh or geometry) via the Structure
column.

Figure 246:

Max Link Column Viewed
Regardless of how many links a connector might have, the browser will only display the specified
number of columns.

Show Primary Links Only
By default, both primary and secondary links are displayed in the browser. To only display primary
links, select the Show Primary link only checkbox.
By default, a node link is also displayed as a component link in the Component link view. For
example, components are shown as a link when a node that belongs to an element belongs to a
component, an element belongs to a component, or a surface belongs to a component.

When Show Primary Link Only is selected, the Part link view only displays real part links and the
Component link view only displays real component links. Use the table below to determine which
link types will be interpreted as a component or park link based on view you are using.

Link Type Component Link View Part Link View

Show Primary
Links Only: off

Show Primary
Links Only: on

Show Primary
Links Only: off

Show Primary
Links Only: on

Nodes yes no yes no

Elements yes no yes no

Components yes yes yes no

Assemblies yes no no no

Parts no no yes yes

Properties no no no no

Surfaces (geom) yes no yes no

Tags no no no no
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Automatic Filter
Filter the link entity list and the connector list simultaneously when performing a show, isolate, or
find operation.

Figure 247: Isolation of the Windshield Glass Components with Attached Connectors
The strings entered in the Query Builder (last_celink_review) and (last_ce_review) illustrate that the lists have been

filtered.
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Figure 248: Query Build Filters for the Connector List

Tip:  For future filtering via the Query Builder, you can reuse previous filters and
combine previous filters with other attribute filters.

Consider Geometry
Consider geometry along with elements while using Show/Hide/Isolate operations.

Figure 249: Consider Geometry: Off
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Consider HAZ Elements
Consider HAZ elements while using Show/Hide/Isolate operations. When this option is on, and if
connectors are isolated, HAZ elements are also isolated along with connectors and their links.
Available for Connector Configure browser options.

Figure 251: Consider HAZ Elements: Off
HAZ elements of hexa Nugget connectors are not isolated along with connectors and linked components.
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Figure 252: Consider HAZ Elements: On
HAZ elements of hexa Nugget connectors are isolated along with connectors and linked components.
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Find Twin Connectors
Select how two connectors are found:

Minimum two links
Find only the connectors that have two or more matching links.

Exact links
Find only the connectors that have the same links. For example, if you start with a
connector that has two links, than another connector with three links will not be found even
if its first two links matched.

Find Connectors Between With
Select how connectors between selected links are found:

Minimum two selected links
Only connectors that link to at least two selected entities will be affected. Connectors with
only one link to any of the selected entities will be ignored.

Exact selected links
Only connectors that link to the selected entities will be affected. This can vary from the
Minimum two selected links option, because connectors with three or more links which
link two selected entities with at least one unselected entity, would still be found by the
Minimum two selected links option but not by this one.

All selected links
Any connector shared by the selected entities will be found.

Note:  Connectors which link selected entities to any unselected ones will not be
found, as they are not located between the selected entities.

Filter Links To
Choose which links to filter when performing search/isolation functions.

Projection Components
Isolate the entire link component.
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Projection Elements
Isolate only the elements on which a projection falls.

Projection and Attached Elements
Isolate only the elements on which the projection falls and the elements which the
connector FE connects.
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Filter Links To Projection
Components

Projection Elements Projection and
Attached Elements

Spots

Figure 253:

Figure 254: Figure 255:

Seams

Figure 256:

Figure 257: Figure 258:
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Bolts

Figure 259: Figure 260: Figure 261:
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Global Options

Autofit
Use this option in combination with the other view option toggle buttons and show, hide, isolate,
or isolate only, or in combination with the advanced action buttons. After an action is performed,
the newly found connectors and/or entities are placed in the middle of the screen. If this option is
used in combination with one of the previously mentioned buttons, it works like a pure fit view.

Figure 262:
In this example, the 1st connector and the link entity were Isolated with the fit view option.

Autocolor Visualization Mode
Automatically switch the element color mode when accessing different tabs in the Connector Link
Entity Browser.
When enabled, switching to the Part Link view from the Component Link view automatically
changes the element color to by part and vice versa.

Connector Entity Editor
Use the Connector Entity Editor to quickly view and modify attributes assigned to connector(s).

The Connector Entity Editor opens when you select single or multiple connectors from the Connector
Entity Browser. Connector attributes are displayed in the Name column, and the values associated with
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each attribute are displayed in the Value column. The attributes that display in gray text, cannot be
edited.

Once you modify a connector in the Connector Entity Editor, its state changes to modified (blue ). A

modified state indicates that the representation is not the exact same for the new representation, due
to the changes you made. To apply these changes you must rerealize the connector.

For example, assume you have an acm (general) connector with a diameter of 10. If you modify this
connector in the Connector Entity Editor to have a constant thickness, edited the diameter, and applied
an RBE3 radius of 3, the changes will not be applied until the connector is rerealized.

If you modify the Config Name assigned to a connector in the Connector Entity Editor, a new set of
attributes will be assigned. Such a modification will change the connector's state to unrealized (yellow

), and the connector will be placed in a new folder.
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Figure 263:
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Opens a temporary HyperMesh panel in which elements can be selected. Clicking the proceed
button finds all the connectors that have the selected elements as their realized FE, and highlights
them in the browser. This utility can be used to easily find connectors from their realized welds.

Imports mcf connectors.

Rerealize all of the connectors that have been modified in the Connector Entity Editor with their
new settings.

Opens the Spot Panel Connector panel.

Opens the Bolt Panel Connector panel.

Opens the Seam Panel Connector panel.

Opens the Area Panel (Connectors) Connector panel.

Opens the Apply Mass Panel Connector panel.

Opens the FE Absorb Tool Connector GUI.

Utility Tool Set - Connector Browser
This tool set, located at the bottom of the Connector Browser, provides tools for output of a Master 
Connectors File, opening specific connector-related HyperMesh panels, or utilize specialized visualization 
options.

Exports the connector information to a Master Connectors File in XML format (*.xml). All the
connectors in the browser or currently selected connectors can be exported.
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Link Definition
A link is a reference to a separate entity. One or more links are added to a connector. The entities to
which the links refer are connected during realization.

The link definition consists of the following information:

Link Type
Type of entity that can be added to the selected connector(s) as a link reference. Supported
entities are assemblies, components, surfaces, elements, tags, and nodes.

Link Rule
Defines how a connector treats an entity added as a link. Adding a link with an ID or name rule
forces the connector to retain the link’s ID or name even if that link entity no longer exists in the
database. This aids in part replacement when a new part replaces an old part and both share the
same ID or name. Adding a link with the at fe-realize rule ensures that each time a connector
is realized the closest entity of the correct type is found and connected. This is useful when
connectors need to connect to a closest part in an assembly.
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Link ID/name
The ID or name of the entity added as a link to a connector.
In the Update Link and Add Link dialog in the Connector Browser, the Link Select row
corresponds to the link ID and the link name. Clicking into the fields in this row opens a
temporary panel in which a specific entity can be selected. Clicking proceed returns to the
Update Link or Add Link dialog. The selected entity is used to add or update a link reference.

Link State
This defines whether the weld created during connector realization connects to geometry or
mesh on the link. This only applies to assembly, component, and surface entities that can contain
geometry and/or mesh information.

Note:  The link reconnect rule (use name, use id, and so on) and the link state (connect
to mesh or geometry) can be viewed in the link column by selecting the extended link
information checkbox in the Connector Entity Browser configuration window.

The Connector Browser permits the performance of different actions on the links.



Altair HyperMesh 2019 Users Guide
Browsers p.979

Convert Style
Convert connectors of one specific style into a different style, for example a spot connector into a bolt 
connector using the Convert option.

Before you begin, define Convert Settings.
Highlight the connector(s) you want to convert, then right-click and select Convert > Style (spot, bolt, 
seamline) from the context menu.

Figure 264:

Proprietary Information of Altair Engineering

The converted connector(s) will be unrealized and placed in the Undefined folder. Once you convert a 
connector, you will not be able to revert it back to its original state. The only information that will be 
retained includes: number of layers, tolerance, and link information.
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Combine
Combine aligned single point connectors into line connectors or combine several aligned seam line
connectors into larger one(s) using the Combine option.

Before you begin, define Combine Settings.

Highlight the connectors you want to combine, then right-click and select Combine > Style option from
the context menu.

Highlighted connectors of a different style are not considered for the combine operation.

Proprietary Information of Altair Engineering

Convert Settings
Settings used to define how connectors are converted.

Access Convert Settings by right-clicking on a connector and selecting Convert > Convert Settings 
from the context menu.

Table 8:

Option Description

Maintain as Line To keep line connectors as line connectors after the conversion, select the
Maintain as Line checkbox. When this checkbox is off, line connectors will be
converted to single point connectors per each connector point.

Note:  Only applicable when spot or boltlines are being converted to
seamlines.

Figure 265:
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When combining spots or bolts, the exact original connector positions are kept in the combined 
connector line. Combined seam connectors will not keep their original positions, instead they will be 
redistributed along the combined line. This functionality enables realizations to be retained in many 
cases, when combining realized connectors. Combining realized seam connectors will lead to a new 
realization of the combined seam. This behavior can be controlled in the Combine Settings.

Note:  You can only combine connectors that have the same realization type, same link
definition, and same number of layers. Further parameters of individual initial connectors
cannot be retained, therefore a rerealization might defer from the initial realization. It is
recommended that you combine unrealized connectors.

Combine Settings
Settings used to define how connectors are combined.

Access Combine Settings by right-clicking on a connector and selecting Combine > Combine
Settings from the context menu.

Table 9:

Option Description

Unrealize Spot/
Bolt/Seam

Unrealize initial connectors.

Combine Angle Maximum allowed deviation angle measured between three consecutive
connectors.
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Option Description

A combination of these three connectors is allowed only when the angle is smaller
than the defined one.

This describes, why, at least, a minimum of three point connectors must be
selected in order to be combined.

Figure 266:

The creation of looped line connectors is supported.
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Option Description

Figure 267:

Combine Distance Maximum distance two consecutive connectors must be from each other in order
for the connectors to be combined.

Only within one
component

Only combines connectors that are organized in the same component. The
combined connector will remain in the same component.

When combining connectors that are organized in different components, the new
combined connector will be created in the current component.

The image below demonstrates a problematic situation for combining connectors.
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Option Description

Figure 268:

Split
Split spot or bolt line connectors into individual single point connectors using the Split option.

Before you begin, define Split Settings.

Highlight the connector(s) you want to split, then right-click and select Split > Style option from the
context menu.

Highlighted connectors of a different style are not considered for the split operation.

Figure 269:
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Unless requested from the split settings, the split operation of a realized line connector will not
unrealize the individual single point connectors. Newly created split connectors will be created in the
component of the original connector.

Split Settings
Settings used to define how connectors are split.

Access Split Settings by right-clicking on a connector and selecting Split > Split Settings from the
context menu.

Table 10:

Option Description

Unrealize During the Split operation of a realized line connector, the individual single point
connectors will be unealized.

Position
Place a connector in-between the center of the two farthest defined links or its source position using the
Position option.

Before you begin, define Position Settings.

Restriction:  Bolt and area connectors are not supported for the positioning.

Highlight the connector(s) you want to position, then right-click and select Position > <style> from
the context menu.

The source position is the position of the connector before it has been positioned in the center.

Figure 270:
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In the case of line connectors, each individual connector point is centered.

Figure 271:

Note:  The source position of a connector is saved on the connector during the centering,
therefore it is possible to go back to the origin position. There are certain actions, which
reset the source position to the current one. This happens, for example, when splitting or
translating a connector. Also, the source position is only available in the current session; it
will not be saved in either the HyperMesh file or in the .xml file.

If a connector is defined with the link conservation option use extra links, it might be that
positioning to the center provides unexpected results because all of the links with valid
projections are considered, even if they are not needed for the final realization.

Position Settings
Settings used to define how connectors are positioned.

Access Position Settings by right-clicking on a connector and selecting Position > Position Settings
from the context menu.

Table 11:

Option Description

Consider only These settings help to filter down the connector selection to those whom should
be considered for the intended positioning. Exclusively connectors with the
checked attributes are considered.

Spots
Consider spot connectors.

Seam
Consider seam connectors.

Unrealized
Consider unrealized connectors.

Realized
Consider realized connectors.
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Option Description

Failed
Consider failed connectors.

=2t
Consider connectors with a number of layers equal to 2.

>2t
Consider connectors with a number of layers greater than 2.

Upon Positioning Functionality to use for FE representation during or after the positioning of
connectors that have already been realized.

Unrealize
Unrealize all of the connectors being considered for positioning. Registered
FE elements will be deleted.

Rerealize
Realize all of the connectors being considered for positioning, starting from
their new position.

Accept wo Reconfirmation
Place all of the connectors being considered for positioning in their new
location without doing anything to the realized FE.
This option is only recommended for simple realization types with smaller
extensiveness, since these use a similar projection logic than the center
positioning.
There is always the risk that a formerly successful realized connector fails
after the center positioning. The risk increases with the complexity of the
realization type.
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Figure 272:

The Add Link window opens at the bottom of the Connector Browser.

Tip:  All of the connectors highlighted in the connector list at the time the Add Link
tool is enabled will be affected. If you wish to cancel the add link function, click
Reject, located in the upper right-hand corner of the Add Link tool.

The Add Link window is laid out in a table format, with each Add Link option displayed in the
Name column, and the controls and values associated with each option displayed in the Value
column to the right.

Figure 273:

2. Edit the options in the Add Link window.
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Add Link
Add links (component, assembly, surface, element, tag, node) at a time to one or more connectors
using the Add Link option.

1. Right-click on the connector(s) that you wish to add links to, and then select Add Link from the
context menu.
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Option Description

Add Link Determine how you will be adding links.

Click the Value column to select one of the two Add Link options from the
pull-down menu:

From scratch
The connector gets into an unrealized state without any link
information. When selected, previous link definitions have to be
removed, but the Number of Layers and Tolerance can be reused.

To existing
A pure adding of links following the other settings. If no links are
added, the connector will remain untouched and in a realized state, as
long as it was realized before.

Layers Select the number of thicknesses (layers) for the connectors.

Click the Value column to select one of the following Layers options from
the pull-down menu:

Keep previous
Allows you to work with a different number of layers at one time.

Auto by tol.
When this option is set, a tolerance needs to be defined. All link
candidates found in the tolerance will be added as links.

Note:  This option is only available when From scratch is
selected above.

Increment +
Activates the Value column in the following row, where you can enter
the number of additional layers to be added to the current number of
layers for each selected connector.

Note:  This option is only available when To existing is
selected above.

Number
Activates the Value column in the following row, where you can enter
the number of layers to display.

Tolerance Select the tolerance to be used for link detection. If the link candidates
are close enough to the connector (within the tolerance), then they could
become links as long as other conditions are not fulfilled.

Click the Value column to select one of the following Tolerance options from
the pull-down menu:
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Option Description

Keep previous
Allows you to work with different tolerances at one time.

Value
Activates the Value column in the following row, where you can
manually enter a tolerance.

None
Despite how far away the next links are, they will still be added. By
default, the tolerance is set to 0.0.

Link Type Select the type of entity that can be added to the selected connector(s) as a
link reference.

Links Select which entities in the model to which the connector will link to. The
selection made from the Link Type option above will influence what is
displayed in this option.

Click the Value column to select one of the following options from the pull-
down menu:

All
Selects all of the entities in the model to link to.

Displayed
Selects only the entities that are displayed in the model to link to.

Select
Opens the Entities selector in the following row, from which you can
manually select entities to link to.

Link State Determines whether the weld created during connector realization connects
to geometry or mesh on the link. This option is significant for link detection.
Only the entities of the right state, meaning elements or surfaces, will be
taken into account. If the link state is set to geometry, then close elements
will not be considered for link detection.

Click the Value column to select one of the following Link State options
from the pull-down menu:

elems
Specifies that the entity needs to be connected (welded) using its
mesh.

geom
Specifies that the entity needs to be connected (welded) using its
geometry (connect surfaces only).

Link Rule Defines how a connector treats an entity added as a link.
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Option Description

Click the Value column to select one of the following Link Rule options from
the pull-down menu:

At fe realize
Ensures that each time a connector is realized the closest entity of the
correct type is found and connected. This is useful when connectors
need to connect to a closest part in an assembly.

By ID
Forces the connector to retain the link’s ID even if that link entity no
longer exists in the database. This aids in part replacement, when a
new part replaces an old part and both share the same ID.

By name
Forces the connector to retain the link's name even if that link entity
no longer exists in the database. This aids in part replacement when a
new part replaces an old part and both share the same name.

None
No link rule is created.

Remove Links
Remove links from one or more connectors at a time.

Remove Links is available from the Connector Entity Browser's context menu when you right-click in the
Entities or Link columns.

Once links are removed, updated connectors will be unrealized and your changes will be permanently
updated in the database and browser.

Remove All Links From Connectors

1. Select the connectors from the browser for which all the links needs to be removed.

Tip:

The connectors can also be selected from graphics by using the Selector button 

in the Connector Entity Browser Action Mode Tools. The selected connectors in the
graphics area will be highlighted in the browser tree.

2. Open the default context menu by right-clicking in the Entities column of the tree list.

3. Select Remove Links to confirm and execute the operation.
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Figure 274:

Remove Specific Links From Connectors

1. Select the link(s) to remove, then right-click and select Remove Links from the context menu.

2. In the Confirm dialog, click Remove link.

Update Links
Update the attributes associated with a link, such as reconnection rule, link references, and link state.

Update link operations are frequently used for:

• Part replacement

• Modify link rules

• Modify link states

If a part replacement needs to be performed, the browser provides quick tools to update one or more
connectors with the link referencing the new redesigned part. The following sections present steps to
edit and update the link rule and the link state attributes as well as the part replacement.

You can update links in the following ways:

• Directly edit column data in the Connector Browser.

a) In the Connector Browser, select the link(s) or connector(s) to update.

b) Click a field to edit the current value or select a new value.

In the Link Entity Browser, updates can be performed on a single or multiple selected links. When
you update a link in the Link Entity Browser, link references will be automatically updated in the
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Connector Entity Browser. In the Connector Entity Browser, updates can be performed for an
individual link on a single or multiple selected connectors in the Connector Entity Browser.

For example, quickly change the reconnection rule from the Rule column, or change the link state
from the Elems/Geom column. Update links for the purpose of part replacement by entering a new
link ID or link name in the Link Entity Browser. Part replacement can also be performed on single
or multiple selected connectors in the Connector Entity Browser by entering a new link ID or link
name in the Link column.

Figure 275:

• Using the Update Link option in the Connector Browser's right-click context menu.

a) Select the connectors from the browser for which one or more links need to be updated.

The connectors can also be selected from the graphics area by using the Selector button in the
action modes tool set. The connectors selected in the graphics area will be highlighted in the
browser tree.

b) Right-click one of the highlighted connectors and select Update Link from the context menu.
An Update Link dialog opens at the bottom of the Connector Browser. All highlighted
connectors will be affected by the subsequent update link action.

Note:  If the Update Link dialog is still open from a previous update link
operation, all blue highlighted connectors will be affected when the update link
function is performed again.

The lines for Link State and Link Rule are grayed out by default in the Update Link dialog.
When the extended information in the Connector Entity Browser configuration window is
activated, these lines become active as well.
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c) Fill in the fields in the Search column.

Due to this selection, the links of the selected (highlighted) connectors are filtered down to the
links which fit to all given search attributes. Only the remaining links are taken into account
for the subsequent attribute replacement.

Note:  Not all of the search attributes have to be defined; an asterisk can be used.

d) Fill in the fields in the Replace column.

All the remaining links will be updated with the attributes defined by these attributes.

Note:  Not all of the replace attributes have to be defined; an asterisk can be
used. The prior attributes are maintained.

e) Click Update to acknowledge and execute the operation.
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Note:  Not every combination of search and replace attributes are valid. For
example, it is not possible to select the asterisk for the Link Select field in the
Search column and replace it with a concrete link. This helps to prevent global
creation of unwanted modifications.

Figure 276:

Modify Link Rule
The link rule defines how a connector treats an entity added as a link.

Adding a link with the ID or name rule forces the connector to retain the link’s ID or name even if that
link entity no longer exists in the database. Adding a link with the at fe-realize rule ensures that each
time a connector is realized the closest entity of the correct type is found and connected.

Update Link by Directly Editing Column Data in the Connector Browser

In the Connector Browser, select the link(s) or connector(s) to update, then click the Rule column and
select a new link rule.

In the Link Entity Browser, updates can be performed on a single or multiple selected links. When you
update a link in the Link Entity Browser, link references will be automatically updated in the Connector
Entity Browser. In the Connector Entity Browser, updates can be performed for an individual link on a
single or multiple selected connectors in the Connector Entity Browser.
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Figure 277:

Update Link Using the Update Link Option in the Connector Browser's
Right-Click Context Menu

1. In the Options tab of the Connector Entity Browser configuration window, select the extended
information checkbox to activate the lines for Link State and Link Rule in the Update Link
dialog.

2. Select one or more connectors from the browser, then right-click and select Update Link from the
context menu.

Tip:  The connectors can also be selected from graphics by using the Selector button

 in the Connector Browser tool set. The selected connectors in the graphics will be

highlighted in the browser tree.

3. In the Search column's Link Rule list box, select the link rule to search.

4. Under the Replace column Link Rule list box, select the new rule.

5. Click Update.

Note:  The link column for the selected connectors will now display the modified
information. The connector’s state remains unchanged.
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After performing the modification, the current link rule has changed for the selected links.

Figure 278: Starting Link Rule
The starting link rule is underlined in red. Note that use-id is specified as the replacement link rule.

Figure 279: Updated Link Rule
The newly replaced link rule is underlined in blue.
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Modify Link State
The link state defines if the weld created during connector realization connects to geometry or mesh on 
the link.

This is applicable to only components and surfaces entities that can contain geometry and/or mesh 
information.

Update Link by Directly Editing Column Data in the Connector Browser

In the Connector Entity Browser, select the link(s) or connector(s) to update, then click the Structure 
column and select a new link state.

Update Link Using the Update Link Option in the Connector Browser's 
Right-Click Context Menu

1. Select one or more connectors from the browser, then right-click and select Update Link from
the context menu.

Tip:  The connectors can also be selected from graphics by using the Selector button

 in the Connector Browser tool set. The selected connectors in the graphics will be

highlighted in the browser tree.

2. In the Search column's Link State list box, select the link state to search.

3. Under the Replace column Link Sate list box, select the new state.

4. Click Update.

Note:  The link column for the selected connectors will now display the modified
information. The updated connectors will be unrealized and its realized welds will be
permanently removed. If the link state was switched for a link from elems to geom,
then realizing the connector again will result in the weld connecting to a surface
(geometry) contained in that entity.

After performing the modification, the current link state has changed for the selected links.
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Figure 280: Starting Link State
The starting link state is underlined in red. Note that use-id is specified as the replacement link state.

Figure 281: Updated Link State
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The newly replaced link state is underlined in blue.

Replace Part
Update links for the purpose of part replacement (link reference).

Use the Update Link option available in the Connector Entity Browser's context menu to update a
single link reference in one or more connectors. The connectors whose links were modified during this
operation will be unrealized and the connector's realized elements will be permanently removed.

Update Link by Directly Editing Column Data in the Connector Browser

In the Connector Browser, select the connector(s) to update, then click the Link column and enter a
new link ID or link name.

• In the Link Entity Browser, update links for the purpose of part replacement (link reference) by
entering a new link name in the Entities field or link ID in the ID field.

All link references to the old part will be updated to reference the new part in the Connector Entity
Browser.

Figure 282:

• In the Connector Entity Browser, perform part replacement on single or multiple selected
connectors by entering a new link ID or link name in the Link column.
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Figure 283:

Note:  When unresolved entities are referenced in the Link field, a red asterisk will
appear next. Once the entity is resolved, the asterisk will disappear.

Figure 284:

Update Link Using the Replace Link Option in the Link Entity Browser's
Right-Click Context Menu

1. In the Link Entity Browser, right-click on a link and select Replace Link from the context menu.

2. Select a replacement part.

• In the panel area, use the comps selector to select a replacement component.

• In the graphics area, select a component.

3. Click proceed.
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4. In the Confirm dialog, click Replace.
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Update Link Using the Update Link Option in the Connector Browser's
Right-Click Context Menu

1. Optional: Identify and select the connectors referencing to the link entity to be replaced.

This step is not essential, but gives you a better overview; you could also select all connectors.

Using these settings in the Link Entity Browser and right-clicking on the supported entity to be
replaced will isolate the entity and all connectors referencing it in the graphics.

Figure 285:

By using the Selector button  in the Connector Entity Browser you can chose all connectors in a

window selection in the graphics. The selected connectors appear highlighted in the browser.

Figure 286:
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2. Right-click one of the highlighted connectors in the Entities column to get access to the full
context menu and select the Update Link function.
An Update Link dialog opens at the bottom of the Connector Browser. All highlighted connectors
will be affected by the subsequent update link action.

Note:  The lines for Link State and Link Rule are grayed out by default in the
Update Link dialog. When the extended information in the Connector Entity Browser
configuration window is activated, these lines become active as well.

3. For pure part replacements, simply select the supported entity that needs to be replaced from the
entity list by clicking on the Link Select field under the Search column, as shown below.

Figure 287:

4. After selecting the entity, click proceed to return to the Update Link dialog.

Note:  Due to the attributes given in the Search column the links of the selected
(highlighted) connectors are filtered down to the links which fit all given search
attributes. Only the remaining links are taken into account for the following attribute
replacement.

5. Select the supported entity that needs to replace the previously selected one from the entity list
by clicking on the Link Select field in the Replace column, as shown below.
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Figure 288:

6. After selecting the entity, click proceed to return to the Update Link dialog.

7. Click Update to execute the part replacement operation.

Note:  The updated connectors will be unrealized and its realized welds will be
permanently removed. The connectors can be realized again without providing any
inputs by using the Rerealize context menu operation.

Rerealize calls the *CE_Realize command to realize connectors by accepting only a
connector mark. The underlying assumption in the command is that each connector
passed in the mark has the required information to be successfully realized.

The required information such as tolerance, weld configuration, diameter, and so on
is not defined for connectors created using the FE Absorb utility; hence the Rerealize
feature in the Connector Browser works only for connectors that were realized through
the Connector panel.
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Convert Links
Existing connector links can be converted to one of the following link types: Part, Comp, or Prop.
Connector link conversion requests a clear 1:1 relation between a component and a property, otherwise
the conversion is not unique and will not be performed.

Links can be converted in the Connector Entity Browser.

Right-click on the connector icon and select Convert Links from the context menu to convert all of the
links of all the selected connectors at once.

For a single link conversion right-click on the exact link and select Convert Link from the context
menu.
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Figure 289:

The found connectors are also highlighted in the browser making it easy to perform further operation.
Find also isolates the realized welds of a connector if the realization view options button is activated in
the Link browser tool set.
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Find connectors from components can be accessed from the Link Entity Browser's right-click context
menu.

Find Connectors From Supported Entities/Parts

1. Ensure that the Linked Connector view option toggle ( ) is active.

If the realized welds of the connectors also need to be displayed in graphics then activate the

button.

2. Either:

• Ensure that the Show/Hide button ( ) is active in Show mode, and then click the desired

link entity, or

• Use the selector  to pick the desired link entities, and then left-click the Show/Hide button.

Find Connectors Between Two or More Supported Entities/Parts

1. Select two or more supported entities from the link entity table to find their connecting
connectors.

The entities can be easily located in the browser table list by using the Selector button  in the

action mode tools. Click the button and select the entities in the graphics area to highlight it in the
table.

If the realized welds of the connectors also need to be displayed in graphics then activate the

button.

2. Use the Link Entity Browser advanced action buttons to show or isolate the shared connectors.

Find Connectors From Realizations

1. Select the desired link entities from the Link Entity Browser list or the graphics area.

2. Click the  button in the utility tool set (at the bottom of the Connector Browser) to open an

elements selection panel.

3. Select the desired elements.

4. Click proceed in the panel.
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The connectors that contain the selected elements as their realized welds will be highlighted in the
browser.

Find Links From Connectors
The find parts feature in the Connector Browser context menu finds the entities/part(s) connected by
specific connector(s), and isolates them in the graphics area.

The entities found are also highlighted in the Link Entity Browser making it easy to perform further
operations.

The find parts feature will also isolate the realized welds of a connector if the realization toggle button is
activated in the browser.

1. Select one or more connectors in the Connector Entity Browser.

The connectors can also be selected from the graphics area by using the selector button in the
Connector Entity Browser action modes tool set. The connectors selected in the graphics area will
be highlighted in the browser tree.

2. If the realized welds of the connectors also need to be isolated, activate the realization button.

3. Right-click in the browser tree to open the context menu, then click find parts.

Note:  The selected connectors, the entities that are connected by those connectors, and
the realized welds of the selected connectors (if toggle is activated) will be isolated in the
graphics area and the found entities are also highlighted in the Link Entity Browser.
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Contact Browser
Use the Contact Browser to create, review and modify contact interfaces and surfaces in a model.

Contact interfaces and surfaces can be imported, created manually, or generated automatically using
the AutoContact option. Upon importing a solver deck or HyperMesh model, existing contacts are
created and populated in the Contact Browser. Contact interfaces and surfaces are organized into their
respective folders in the browser.

To open the Contact Browser, click View > Browser > HyperMesh > Contact from the menu bar.

Contact Browser Interface

The Contact Browser consists of three panes; the first pane displays the entities needed for contact
definition, the second pane displays the contact information, and the third pane displays the Entity
Editor.

Proprietary Information of Altair Engineering

Figure 290:



Altair HyperMesh 2019 Users Guide
Browsers p.1010

Create Contacts

Create Contacts Manually
In the Contact Browser you can manually create contacts.

1. In the first pane of the Contact Browser, right-click and select Create from the context menu to
create all of the entities needed for contact definition, such as contact surfaces.

2. In the second pane of the Contact Browser, right-click and select Create from the context menu
to create contacts.
The Entity Editor opens and displays the new contact.

Note:  The entities available in the context menu will vary depending on the user
profile loaded.

3. Assign Master and Slave entities when creating contact pairs and contact ties.
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4. Define additional entity parameters and properties accordingly.

Figure 291:
Contact Browser and Entity Editor in the OptiStruct user profile.
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Generate Contacts Automatically
Auto contact generation works independent of whether the model is FE or geometric. When you elect
to generate contacts automatically, contact bodies are detected and contact pairs and contact sets are
created.

1. In the Contact Browser, right-click and select AutoContact from the context menu.
The Create AutoContact dialog opens.

Tip:  To select all of the components in the model, right-click on the Components
folder.

2. In the Pick application region field, select components to create contact interfaces and contact
surfaces between.

Note:  You must select a minimum of two components.

3. Define contact parameters and properties accordingly.
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a) Select a Contact tolerance type.

If Vicinity tolerance is selected, you must enter a vicinity tolerance value.

b) Enter a Reverse angle limit.

This determines the maximum curve angle to identify contacts.

c) Enable Consolidate contact pair to group multiple isolated surfaces into one surface.

d) Select a Contact type to specify the type of contact to be generated. Select Touch to
generate “Contacts”, and Gap/Tie to generate “Tie”.

e) Create and assign, or pick an existing property to attach to the contact pair.

Figure 292:
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4. Click Create.
Based on a vicinity tolerance, the AutoContact tool searches throughout all of the selected
components and automatically creates new Contact interfaces and contact surfaces between
them. All the objects created are populated in the Contact Browser into their respective folders.
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Modify Contact Interfaces and Surfaces
The Contact Browser lists every contact interface and surface within a HyperMesh session and organizes
them into their respective folders. You can modify these contact interfaces and surfaces using the Entity
Editor.

1. In the Contact Browser, click a contact interface or surface.
The Entity Editor opens and displays the entities corresponding data.

Note:  If you select multiple entities in the browser, the Entity Editor displays the
selected entities common corresponding data. The rows that contain ### indicate that
these fields do not contain common data but can still be modified. When you modify
the data, both common and ambiguous, HyperMesh applies the changes to all of the
selected entities. To select multiple entities, left-click entities while pressing Control.
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Figure 294:

2. In the Entity Editor, modify the contact parameters and properties accordingly.

Modifications are automatically applied throughout the model.
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Solver Specific Details

Abaqus

• The Contact Browser supports the following contact and constraint definitions for Standard and
Explicit profiles of Abaqus:

◦ AutoContact

◦ Contact pair

◦ General contact

◦ Contact Tie

◦ Shell to Solid coupling

• The AutoContact option creates contact pairs and tie constraints depending on whether you set
Contact Type to touch or gap/tie.
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• While using AutoContact, you can specify to have the slave surface be created as a node-based
surface.

• All contact pair definitions in Abaqus will require a surface interaction definition.

◦ AutoContact creates a surface interaction property with default solver behavior.

◦ You can choose an existing surface interaction to be used for contact pairs recognized by
AutoContact.

• AutoContact can create contact pair/tie with review status before confirming.

• In the contact information pane (middle pane in the browser), you can interactively add friction,
adjust, and specify other optional parameters.

• Use Advanced delete to delete contact pair/tie. The corresponding master and slave surfaces and
surface property are used for the contact pair unless the surface property is otherwise specified to
be used in other contact pair definitions.

ANSYS

• Creating and managing contact surfaces and pairs is handled by the Contact Browser.

• Both manual contacts and AutoContact options are available. The AutoContact option can be used to 
create Surface to Surface contacts.

• Before creating contact pairs in HyperMesh, it is recommend that you know which ANSYS contacts 
are supported in HyperMesh.

• ANSYS contact regions are modeled like ordinary FE elements over the regions of FE models that 
represent the geometry. In ANSYS terms, both CONTACT and TARGET surfaces are sets of elements 
at contact regions. Prior to HyperMesh 14.0.130, the ANSYS interface supported the same principle 
as ANSYS, therefore both CONTACT and TARGET regions were elements over model geometry in 
HyperMesh.
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Figure 295: HyperMesh 14.0.120 and Earlier Figure 296: HyperMesh 14.0.130

• Starting in HyperMesh 14.0.130, both contact and target regions are identified as CONTACT 
SURFACES. A pair of contact and target surfaces which interact with each other in analysis are 
GROUPS. You need to create contact surfaces for both CONTACT and TARGET regions. They will 
then be paired together under groups to successfully define the contacts. ANSYS solver files (*.cdb 
files) with contacts are imported into HyperMesh, and identify the contact regions from the contact 
elements to show the regions as contact surfaces. Contact pairs can be seen in groups.

• During export, HyperMesh creates contact elements from the contact regions and exports them as 
elements. In ANSYS, they are explained above elements with contact element type.

• The Contact Browser currently supports the creation of edge to edge, surface to surface, and point
o surface contacts with pilot node and symmetry contact options.

Nastran

• The AutoContact option will create new contact cards using their default values.

• When reading legacy models (.bdf, .dat and .hm), old contacts will be mapped to new contact
cards.

• Contact parameters in the BCTABLE card are mapped to equivalent contact properties (BCONPRP
and BCONPRG) in new contact cards.

• Properties associated with BCPROP should be assigned to either elements or respective components
in the contact card.

• You can export old contact cards by enabling the Export old Contact Card checkbox, which can
be accessed in the in the Export-Solver Deck Browser when you click Select Options.

• The Contact group entity is mapped to the BCTABL1 solver card.

• The BCTABL1 solver card contains a list of contact pair (BCONECT) cards.

• The AutoContact option will create a BCONECT card for each pair, and group all pairs in the
BCTABL1 card.
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• BSURF and BCBODY1 solver cards are remapped from group entities to set entities.

• BSURF and BCBODY1 are combined into one entity. Input for BCBODY1 can be defined in the
BSURF card with the Entity Editor.

OptiStruct

• The Contact type Touch creates a contact pair, and the Contact type Gap/Tie creates a Tie contact.

• Master ID and Slave ID types will be as per solver default Set of elements for master ID and Set of
nodes for slave ID.

• Auto contact will honor the entity type in Master and Slave entity type.

• Master entity types have the following mutually exclusive options: Set of elements or SURF.
Similarly Slave entity type will have Set of nodes, Set of elements, and SURF. You can only select
one of the entities.

• The Contact property option is only available when the Contact type is Touch.

• You can assign Touch contacts a Property type (SLIDE, STICK, FREEZE), a Static Friction
Coefficient, or an existing property (PCONT).

Samcef

• Automatically detect the contacts between selected parts.

• Create different type of contacts (.MCT/.STI).

• Modify the contacts already created: add/remove elements/nodes into the master/slave groups,
change the type of the contacts (MCT to STI or STI to MCT).

• Review the contacts in the model.
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Context Menu

The following options are available in the Contact Browser context menu:

Review
Highlights the slave and master surfaces in two different colors, while the rest of the model is
transparent and gray.
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Figure 297:

Show

Hide

Displays the contact's master and slave surfaces in their assigned colors. The rest of the model
display is left unchanged.

Turns off the display the contact's surfaces. The rest of the model display is left unchanged.

Isolate Only
Fits the selected contact to the graphics area, and displays the slave and master bodies in two
different colors. The rest of the model is turned off.

Swap Master-Slave
Switches the contact surfaces identified as master and slave. Upon selecting Swap Master-Slave,
the surfaces switch from places in the master to slave positions in the browser.
To select multiple entities, left-click entities while pressing Control.
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Swap Cp-Tie
Changes the type of interface created. A surface interaction is required for Contact Pairs but not
for a Tie, therefore any surface interaction identified earlier will be lost upon swapping from CP to
TIE. If you switch back from TIE to CP, the surface interaction will not be retained.

Reverse Normals
Flips all the normals of selected elements or surfaces.

Display Normals
Displays the normals of selected elements or surfaces as vectors or in color mode.

Display Base Element Normals
Displays the normals for parent elements of the surface.

Normals Off

Turns off normals if they are displayed.



Altair HyperMesh 2019 Users Guide
Browsers p.1019

Entity Editor
The Entity Editor enables you to quickly view and edit entities in a model and correctly setup solver
information.

The Entity Editor can be accessed from the Model, Reference and Solver browsers. In the Model
Browser, the following view modes are supported: Model, Include, Component, Property and Material.
When accessing the Entity Editor from the Reference Browser, you will only be able to view your entity
selection's corresponding data in a non-editable form.

The Entity Editor opens when you create new entities, as well as duplicate, edit, or select single or

multiple entities in the browser. To expand and collapse the Entity Editor, click  in the top, right-

hand corner. To adjust the height of the Entity Editor, drag  up and down.

Entity parameters are displayed in the Name column, and the values associated with each parameter
are displayed in the Value column. The parameters that display in gray text cannot be edited. Once you
edit an entity in the Entity Editor, the changes will be automatically applied throughout your model.

Figure 298:

Edit Multiple Entities
If you select multiple entities in the browser, the Entity Editor opens and displays the selected entities
common corresponding data that can be modified simultaneously.

The rows that contain ### indicate that these fields do not contain common data but can still be
modified. When you modify the data, both common and ambiguous, HyperMesh applies the changes to
all of the selected entities.

To select multiple entities in the browser, press Shift and begin selecting entities.
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In Figure 299, seven components are selected, and the Entity Editor displays their common
corresponding data. The Color, Card Image, and Prop_Id are different, therefore you see ###. The
Mat_Id is the same for all of the selected components, therefore you see the material name and its ID.

Figure 299:

Edit HyperMesh Specific Data
When you create an entity, it is assigned an unique ID, name and color. Use the Entity Editor to edit this
data.

Open the Entity Editor for the entity to edit.

Option Description

Edit ID and name 1. Click Name or ID and enter a new value for the entity in the editable field.

2. Press Enter.

HyperMesh updates the changes in the Entity Editor and browser automatically.

Figure 300:
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The entities color changes in the Entity Editor, browser and graphics 

area.
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Figure 301:

Edit color 1. For Color, click the color box.

2. From the color pallet, select a new color to represent the entity.
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Edit Solver Specific Data (Template Data)
Every entity is assigned solver specific data, which you can modify using the Entity Editor.

Figure 302:

Assign a Card Image

In the Entity Editor, you can assign a card image to an entity. The card images you are able to assign to
an entity will depend on the user profile you have loaded and the entity type you have selected in the
browser.

1. Click Card Image.
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2. Select a new card image from the drop-down list.
The entity's card image changes, and the Entity Editor displays additional solver related fields.

Figure 303:
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Turn Fields ON or OFF

• Turn fields on and off in the Entity Editor.

Option Description

Turn field off Remove its corresponding value or select OFF from the drop-down list.

If you hover over a field that is turned OFF, its default value will appear in the
Value column.

Turn field on Enter a new value or select a value from the drop-down list.

When a field is turned ON, its corresponding value will always be displayed in the
Value column.

In the example below, assume that initially the field ISOP is turned OFF and has a default value
of FULL. To turn the field ON, click its corresponding Value field and select a value from the drop-
down list. If you want to turn the field OFF, select <OFF> from the drop-down list.
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Figure 304: ISOP Field Off



Altair HyperMesh 2019 Users Guide
Browsers p.1024

Figure 305: ISOP Field On

In the example below, assume that initially the field G is turned OFF and has a default value of
80769.2. To turn the field ON, click the Value field and press Enter. To turn the field OFF, delete
the value and press Enter. If you turn the field OFF, the Entity Editor will retain the previous value
you specified.
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Figure 307: NU Field On

In the example below, assume that initially the field MID4 is turned OFF. You can turn the field on
and then assign it a material. To turn the field ON, click its corresponding Value field and select
materials from the drop-down list. You can then click the yellow selector button and select a
material to assign to the field. If you want to turn the field OFF, select <OFF> from the drop-down
list.
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Figure 308: MID4 Field Off

Figure 309: MID4 Field On
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• Turn card image fields on and off in the Card Editor by clicking the field heading.

When a field is turned ON, an additional field appears under the field heading, from which you can
enter or select a value.

In example below, the card image MAT1 is displayed for a material in OptiStruct. By default, the
field G is turned OFF. To turn the field ON, click its field header. The default value is displayed under
the field heading.

Figure 310: MAT1 Card Image with the Field G Off

Figure 311: MAT1 Card Image with the Field G On

When defining data in tables, certain fields can be turned ON and OFF. To turn a field ON, right-click
on the heading of the disabled field and select Status. In the image below, the NO field is being
turned ON for the load collector TSTEP.
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Assign Entities
In the Entity Editor you can assign certain entities to another entity or a group of entities.

For example, you can assign a property to a component. When an entity has an entity assigned to it,
the name and ID of the assigned entity will be displayed in the Value field. If an entity does not have an
entity assigned to it, the Value field will display <Unspecified>.

In the image below, the Entity Editor is open for the component bottom_bracket. The material
aluminum is assigned to the component, and a property has not yet been assigned.

Figure 313:

In the Entity Editor, you can assign an entity using the Select dialog or the Entity Selector.

• Method 1: Assign Entities Using the Select Dialog

a) Click the entity's corresponding Value field.
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b) Click the yellow selector.

Figure 314:

c) Select an entity in the following ways:

1. In the Select dialog, select an entity.

Tip:  You can search for entities in the Select dialog by entering a name,

ID, or card image in the search field. When you click  or press Enter, the

dialog only displays the entities that match your search string.
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Figure 315:

2. In the graphics area, select an entity. HyperMesh automatically selects the entity in the
Select dialog.
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Figure 316:

d) Click OK.
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• Method 2: Assign Entities Using the Entity Selector

a) Click the entity's corresponding Value field.

b) Click .

c) In the panel area, click the yellow selector.

Figure 317:

d) Select an entity in the following ways:

1. In the panel area, select an entity and click return.

Figure 318:

2. In the graphics area, select a entity. HyperMesh outlines your selection in white.
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Figure 319:

e) Click proceed.
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Resolve Unresolved Entities

The import and export of unresolved entity IDs is supported, in a limited way. If you have an unresolved
entity ID which is referenced by other entities, the Entity Editor displays the phrase "Unresolved Entity"
in the Value field of the unresolved entity.

In the image below, the load collector Fatigue refers to a load collector with id=9, which is unresolved.
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Figure 320:

1. Right-click on the Name field of the unresolved entity and select Clear unresolved entity from the
context menu.

2. Click the entity's corresponding Value field.

3. Click the yellow selector.

4. In the Select dialog, select a new entity.

5. Click OK.
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Keyboard Shortcuts

Function Key Description

Tab Moves from one row to the next in the Entity
Editor.

Shift + Tab Moves to the previous row in the Entity Editor.

Spacebar Activates the Value field of the selected row.

Move up and down in the Entity Editor, a list of
options in drop-down menus, or in a right-click
context menu.
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Enter Accepts the changes made to a parameter in the
Value field, or selects an option in a right-click
context menu.

Esc Dismisses the changes made to a parameter in the
Value field, or closes a right-click context menu.
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Create and Edit Assigned Entities

Create and Assign a New Entity

To create and assign a new entity to an entity or a group of entities:

1. Right-click on the entity assignment field and select Create from the context menu.

2. In the Create dialog, define the new entity.

3. Click Close.
The Entity Editor creates and assigns the new entity.
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Edit an Assigned Entity

To edit an entity that is assigned to an entity or a group of entities in the Entity Editor:

1. Right-click on the entity assignment field and select Edit from the context menu.

2. In the Edit dialog, modify the entity data.

3. When you are finished making changes, click Close.
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Create and Assign Contact Surfaces Using Elements or Nodes

When defining contact entities in the Entity Editor, you can create and assign contact surfaces using
elements or nodes to master and slave entities.

Only available in the Abaqus, ANSYS, and OptiStruct user profile.

1. In the Entity Editor, right-click on the Slave entity or Master entity field and select Create
Contact Surface using Elements or Create Contact Surface using Nodes from the context
menu.

Note:  The options available depend on the solver keyword selected.
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2. In the corresponding panel, select elements or nodes and click add.

3. Click return to exit the panel.
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Create and Edit Parameters

Create and Assign a New Parameter

In the LS-DYNA and Radioss user profiles, certain entities can be defined with parameters.

1. Right-click on the parameter assignment field and select Create and Assign Parameter from the
context menu.

2. In the Create Parameter dialog, define the new parameter by changing the Parameter type and
Expression value.

When the Card Image and Parameter type are set to expression, the Expression value field
becomes active.

Note:  The Entity Editor currently supports the following types of parameters: Double,
Integer, Double Expression, and Integer Expression.

3. In the Expression value field, enter a valid expression value.

4. When you are finished defining the parameter, click Close.
The Entity Editor creates and assigns the parameter to the selected entity.

Note:  These parameters can be used in HyperStudy for design exploration and
optimization.
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Edit a Parameter

1. Right-click on the parameter assignment field and select Edit Parameter from the context menu.

2. In the Edit Parameter dialog, modify the parameter's data.

3. When you are finished making changes, click Close.
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Parameterize and Unparameterize Entities

Parameterize an Entity

For any solver entity, you can parameterize most of the solver template data of a numeric value.

1. Right-click on the solver data field and select Select Parameter/Parameterize from the context
menu.

2. In the Select Parameter dialog, select a parameter from the list of valid types.

3. Click OK.
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Unparameterize an Entity

When a solver data field is parameterized, you can unparameterize it or assign it a different parameter.

Right-click on the field and select Unparameterize from the right-click context menu.
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Figure 327: Parameter Rho is being Unparameterized with the Parameter param1.
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Filter Entities

To filter the entities that are not applicable to the entity displayed in the Entity Editor, activate the entity 
filter in the right-click context menu.

When off, all of the entities available in the model will display in the Select dialog or Entity Selection 
panel.

In the image below, the Entity Editor is activated for the component bumper, which is of type *PART. For 
this example, assume that the Filter is activated. If you were to assign a property to this component 
using the Select dialog, seven properties would be available, even though the model contains a total of 
nine. The two properties that are filtered out cannot be assigned to a *PART of LS-DYNA. The status bar 
also displays a message that says seven of nine properties are being filtered using a filter criteria, and 
in this case it is an IdPool filter.
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If you deactivate the filter, the Select dialog will display all of the properties in the model.
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Warn Upon Entity Type Change

Any changes that you make in the Entity Editor will be automatically applied. Some of the changes may 
be irreversible.

1. To confirm changes before they are made, activate the Warn upon entity type change option in
the right-click context menu.
When this option is activated, a Confirmation dialog will appear every time you make a change in
the Entity Editor.

2. To proceed, you must click Yes or No.

By default, the Warn upon entity type change option is activated. If you do not want to display
this message every time you make a change, you can deactivate this option.
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View an ID List for Set Entities
Set entities are used to define and store lists of entity IDs for a specific entity.

Sets can be generated for nodes, elements, components, assemblies, properties, materials, ellipsoids,
multibody planes, multibody joints, and multibodies which contain entity IDs for that specific entity. In
the Entity Editor, you can view an ID list for set entities. The entity IDs are compacted using ranges,
and segregated using ID pools. If some of the IDs are unresolved, than they will be listed separately
under Unresolved IDs.

1. Right-click on the Entity IDs field and select ID List from the context menu.

2. In the ID List dialog, review a list of all of the entity IDs.

3. When you are finished, click Close.
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View Xref Entities

To open the Reference Browser and view a hierarchical tree structure that displays the relationship of a
selected entity in the Entity Editor to other entities and parameters in the model, right-click on a field
and select Xref entities from the context menu.

In the image below, the Reference Browser displays the entities related to the Property entity of the
component bumper. If you select an entity from the Reference Browser, the Entity Editor will open and
display your entity selection's corresponding data in a non-editable form.
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Entity State Browser
Use the Entity State Browser to set various entity states for entities in a model.

To open the Entity State Browser, from the menu bar, click View > Browsers > HyperMesh > Entity
State.

For example, from this browser you can set an entity's state to active or inactive.

Figure 333:

The active/inactive state is a controllable state whereby the display of inactive entities will be turned
off from the display in the graphics, the browsers, the display panel, and any panel entity collectors. It
is designed to aid users who frequently work with large models and need be able to filter the list and
display, to reduce the number of available or visible entities. Inactive are still present within the model
but are removed from access until they are made active again.

The export/do not export state determines whether entities are exported when using the custom export
option in the Export tab.

Note:  This state does not have any effect on the all and displayed export options.

Furthermore, the active/inactive and export/do not export states are independent of each other – one
does not affect the other. Entities that are set inactive are still eligible for all and custom export. They
are not output when using the displayed export option since they are, by definition, not eligible for
display.
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All entities in the current model that have active and export states are shown in the browser at all
times. The check-boxes in the Active and Export columns indicate the current settings for those entities
and can be clicked to change the state. Each entity is individually controlled via the browser, but all
collected entities contained within a collector are subsequently set to the same state as the parent
collector – control is not available at the individual collected entity level.

Changing the state of an assembly has two functions. First, it sets the state of that assembly directly.
Secondly, it sets the state of all sub-assemblies, components and multibodies referenced by that
assembly to the same state as the parent assembly.

Include files do not directly contain any states that can be controlled by the Entity State Browser.
Operating on an include will, instead, operate on all supported entities that are referenced by that
include.

The Entity State Browser's right-click context menu contains functionality unique to the Entity State
Browser, but much of the basic browser functionality – such as sorting and filtering the tree list as well
as the functions within the tool sets – are shared with the same features in the Model Browser:

• Action Mode Tools

• Query Builder

• Sorting Entities

Context Menu

The Entity State Browser's right-click context menu contains additional browser options:

Option Available for: Description

Set Active Permanently Sets the currently selected entities in the
browser to the active state.

Set Active Only Permanently Sets the entities currently selected in each
folder to the active state and sets the
remaining entities in those folders to the
inactive state.

Set Inactive Permanently Sets the currently selected entities in the
browser to the inactive state.

Set Inactive Only Permanently Sets the entities currently selected in each
folder to the inactive state and sets the
remaining entities in those folders to the
active state.

Set Export Permanently Sets the currently selected entities in the
browser to the export state.

Set Export Only Permanently Sets the entities currently selected in each
folder to the export state and sets the
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Option Available for: Description

remaining entities in those folders to the do
not export state.

Set Do Not Export Permanently Sets the currently selected entities in the
browser to the do not export state.

Set Do Not Export Only Permanently Sets the entities currently selected in each
folder to the do not export state and sets
the remaining entities in those folders to the
export state.

Review Assemblies, Beamsection
collectors, Beamsection,
Blocks, Bodies, Boxes,
Components, Configuration,
Constrained extra nodes,
Constrained rigid bodies,
Constraints, Contact
surfaces, Control volumes,
Crosssections, Design
variables, Design variable
links, Design Objective
Reference, Design Variable
Property Relationship,
Elements, Groups, Joints,
Laminates, Load collectors,
Loads, Loadsteps, Materials,
Mechanisms, Objectives,
Optimization constraints,
Optimization responses,
Output blocks, Part, Part
Assembly, Part Set, Plies,
Properties, Regions,
Seatbelts, Sensors, Sets,
System collectors, Systems,
Vector collectors, Vectors

Invokes Review mode, which displays
selected entities irrespective of their display
state, masked, active state (Entity State
Browser), but not outside of the spherical
clipping (if enabled).

Collapse All All Closes all of the folders in the tree
structure, so that only the top-most level of
items displays.

Expand All All Opens all of the folders in the entire tree
structure, exposing every item nested at
every level.
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Option Available for: Description

Show Find All Turns the browser Find on/off functionality –
see Find section for more information.

Show Filter All Turns the browser Filter functionality on/off
– see Filter section for more information.

Columns All Hides or displays the various columns in the
tree control.

Configure Browser All Opens the Browser Configuration dialog,
from which you can select which entities to
display in the tree as well as which columns
the browser displays.
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Loadsteps Browser
Use the Loadsteps Browser to create, manage and display loadsteps (sub-cases) and the associated
control cards.

The information is arranged into a tree structure for ease of use, with controls for altering the display
of the information and/or exporting it. A right-click menu accesses editing and advanced options, while
popup forms allow you to quickly enter or select relevant information.

The Loadsteps Browser displays in its own tab in the tab area, but may not be active by default. Select
it from the Tools menu to display its tab in the tab area.

The browser includes its own toolbar, used primarily to determine which loadsteps to export but also to
sync the display between the browser and the graphics area.

Table 12: Toolbar Buttons

Function Description

Select all, select none, reverse
selection

Use these to select the items in the tree and mark them for
export. You can also select individual items by clicking on them,
or select multiple items by shift-clicking or control-clicking. When
a loadstep is selected, the export icon next to its name is clear;
when de-selected, the icon has a red "x" to indicate that it will
not be exported.

Note:  Export state is independent of visibility in the
graphics area. Only one loadstep can display in the
graphics area at a time, but any number of loadsteps
can be exported.

Sync browser For large models, keeping the browser in sync with other actions
taken can require considerable processing time. To alleviate this,
the Loadsteps Browser does not automatically sync itself with the
database. Instead, the Sync button becomes active whenever
you make changes to the current database. This allows you to
perform many operations without performance issues, and then
sync the browser with one click.

Filter Filter buttons allow for additional selection control, including a
name filter that uses standard filtering syntax. Use this feature
to limit the tree to display only loadsteps whose names match a
specific text string, either partly or completely.
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OptiStruct and Nastran Profiles

The browser’s tree structure lists relevant control cards and loadstep information, organized into
folders.

Figure 334:

There are many functions available, accessed by right-clicking on the tree background or on individual
or multiple items. For the OptiStruct and Nastran profiles, these options include:

Function Description

New loadstep Create a new loadstep, either from scratch or by creating an exact copy of
an existing loadstep.

Edit options Depending on the entity selected, this will bring up an appropriate GUI for
editing of the loadstep or control card information.

Edit card Review the selected entity in the HM card editor.

Delete Delete the selected entity or entities.

Rename Rename the selected entity.

Renumber Renumber the selected entity.

Summary table Generates a summary table of the selected loadsteps.

Contour Loads This launches the Contour Loads utility and automatically selects the
loadcols associated with the selected loadstep.

Loads summary This launches the Loads Summary utility and automatically selects the
loadcols associated with the selected loadstep.
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Function Description

Collapse all/selection Collapses all selected folders and subfolders, or all folders if none are
selected.

Expand all/selection Expands all selected folders and subfolders, or all folders if none are
selected

Auto-manage load
references

This option is for users who wish to have existing DLOAD, LOAD, MLOAD,
MOTION, MPCADD and SPCADD cards auto-managed. This option creates
a copy of loadcols with these card images and converts them into an auto-
managed naming convention for easy editing/reviewing inside the Edit
options popup.

OptiStruct Opens the OptiStruct panel in HyperMesh.

In addition, every loadstep listed in the tree has a small checkbox next to it as well as an export state
indicator. You can click these to toggle them back and forth:

The loadcols in the loadstep display in the HyperMesh graphics area.

The loadcols in the loadstep do not display in the HyperMesh graphics area.

This loadstep will not be exported.

This loadstep will be exported.

Note:  When you first open the Loadsteps Browser, all of the loadsteps in the model default
to the blank (unchecked) state.

Create a New Loadstep

1. Right-click anywhere in the Loadsteps Browser and select New loadstep.
A pop-up window opens, allowing you to:

• Type in a loadstep name

• Select the same as option, if desired, then pick an existing loadstep to base the new one on.
When this option is active, the new loadstep is an exact copy of the existing one.

2. Click create.
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Another pop-up window opens, allowing you to edit the loadstep.

Edit a Loadstep

1. Right-click on the desired loadstep folder, or any subfolder in the Loadsteps Browser, and select
Edit.

Note:  This step is skipped when you create a loadstep.

A pop-up window opens, allowing you to edit the loadstep. The pop-up has several tabs to gather
the relevant information.

2. To activate an option, check the box next to the desired option and fill in the required fields.

Depending on the Loadstep Type, the list of appropriate Load References will change accordingly.
A tree structure lists the load references that are available for the selected loadstep type.

• A bold reference signifies that the load reference is defined.

• A red indicator signifies that a load reference is mandatory for the loadstep type and requires
attention.

• A green indicator signifies that a load reference is mandatory for the loadstep type and is
defined.

3. The table on the left lists the loadcols that are valid for a particular load reference, depending on
the card image or types of loads contained within.

• Depending on the load reference selected in the tree, the list will change accordingly.

• You can sort the loadcols by clicking on the column heading that you wish to sort by
(repeated clicks alternate between ascending and descending order).

Note:  You cannot sort based on the display column.

• Name, ID, Type, and Color filtering is available by using standard filtering syntax (color
filtering is based on the HyperMesh color ID number).

4. The table on the right lists the loadcols currently selected for that load reference. To add a loadcol
to the load reference, select the loadcol in the left table and use the right arrow to add the loadcol
to the table on the right.

• If a loadcol is assigned and that loadcol is not appropriate for that particular load reference, a
warning message appears to notify you.

• If a loadcol is assigned and that loadcol does not exist in the database, a warning message
appears to notify you.

• When importing a model, it is possible that the loadstep may reference loadcols that have
not been imported (they are in a separate include file). In order to support this, use the Add
<unavailable> load reference ID option to modify a loadstep and add in references to loadcols
that do not exist in the current model. These references are also listed in the right table with
a warning message to notify you that the loadcol does not exist in the database.

5. To remove a loadcol from the load reference, select the loadcol in the right table and use the left
arrow to remove the loadcol.
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6. To select multiple loadcols, use the all/none/reverse buttons where appropriate.

These buttons select loadcols from the currently active table.

7. Right-click options allow for additional functionality depending on the current selection.

Use the Add <unavailable> load reference ID option to add a reference to a loadcol ID that does
not currently exist in the database.

8. Click Accept to apply your changes and close the editing window.

Alternatively, click cancel to close the window, discarding your changes.

You can also edit multiple loadsteps simultaneously by selecting more than one loadstep in the browser,
such as by shift-clicking, before you choose edit options from the right-click menu.

• For each of the options, if the option values are the same for all selected loadsteps, that option is
checked "on" and shown with the appropriate values. If the option values are not the same for all
selected loadsteps, that option is checked "off" and shown with the default values.

• If the loadstep type is not the same for all selected loadstep, it shows a blank value on the
Loadstep Type tab.

• If the loadstep type is not the same, the Load References tab will only display the load reference
types that are in common between all of the loadstep types for the selected loadsteps.

Any edits you make will be applied equally to all of the selected loadsteps. Any values that are checked
"off" will not be modified, but options checked "on" will all be set to the same values.

Display a Loadstep

1. Check/uncheck the display checkbox next to the loadstep of interest.

Additional control is also available at both the Global Options and Loadstep Load References level:

Figure 335:

2. Click the display checkboxes for each desired loadstep to check (display) or clear (hide) it.

• All of the loads contained in a loadcol display regardless of their relevance to the load
reference they are assigned to. It is up to you to organize their loads for proper display.

• Global load references are not checked on/off by selecting or deselecting a loadstep. You must
determine the appropriate loadcols to check on/off depending on the loadstep type.
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Note:  You can also launch the BCs Contour and Loads Summary utilities from the
Loadsteps Browser. The selected utility launches with the loadcols associated with the
selected loadstep automatically selected.

Rename, Renumber, Delete or Edit the Card of a Loadstep

1. Right-click on the appropriate loadstep or loadcol.

2. Select the desired option from the pop-up menu.

3. For renaming and renumbering, an entry box appears so that you can enter the appropriate
information in the browser.

Edit the Global Options

Editing Global Options works exactly like editing a loadstep, except that the first step is to right-click
the Global Options folder or any of its sub-folders, instead of clicking on a specific loadstep’s folder or
sub-folder.

Auto-Manage Load References

This option is recommended for all users. There has traditionally only been one way to create
DLOAD, LOAD, MLOAD, MOTION, MPCADD and SPCADD loadcols: by creating a loadcol, assigning the
appropriate card image, and selecting the appropriate loadcols. However, many users do not want to
be responsible for managing these load collectors, nor are they always aware of their existence. To
satisfy both types of users, the Auto-manage load references option is available. This option does the
following:

1. Looks at each loadstep and at each load reference. If the load reference points to a loadcol with
one of the card images indicated above, it will:

• Create a copy of that loadcol and assign it a new name, based on a fixed naming convention
(auto<CARD IMAGE NAME>_#). For example, if a load reference pointed to an SPCADD
loadcol, a new copy would be created and named "autoSPCADD_1".

• Assign that new loadcol to the original load reference. The original loadcol is not deleted or
modified in any way.

2. Inside the Edit options pop-up, if a load reference points to a loadcol with one of the card images
above and that loadcol has not been converted to the auto-managed naming convention, the
loadcol will not be expanded or editable inside the GUI. The only way to modify the loadcol is via
the card editor (right-click option from the editor GUI).

Inside the Edit options pop-up, if a load reference points to a loadcol with one of the card images
above and that loadcol has been converted to the auto-managed naming convention, the loadcol
is expanded and editable inside the GUI.
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If the loadcol selected for the load reference already has the card image assigned (for users
wishing to manually manage their loadcols and point to an existing loadcol with one of the card
images listed above) no additional action takes place. However, when appropriate, a loadcol is
automatically created and assigned the correct card image when any of these conditions are met:

• More than one loadcol is selected for the load reference

• One loadcol is selected and the local scale factor is not 1.0 (DLOAD and LOAD)

• The global scale factor is not 1.0 (DLOAD and LOAD)
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Mask Browser
In the Mask Browser, set the mask/unmask state for entities at the entity configuration level.

To open the Mask Browser, from the menu bar, click View > Browsers > HyperMesh > Mask.

Figure 336:

The entities are logically organized in the browser to represent the collectors they belong to. Regardless
of the current model, the entities listed in the browser remain the same. The Show/Hide/Isolate
columns contain icons that can be clicked to perform the relevant masking operations. The buttons
perform the masking operations at the selected entity and folder level, and for all entities and sub-
folders that may be contained within that folder. These operations are only valid for entities contained in
collectors that are currently displayed.

The Show column corresponds to the unmask operation. It unmasks the relevant entities for the current
row and sub-folders. For example, the Show icon at the Geometry folder unmasks all points, lines,
surfaces and solids within any displayed components.

The Hide column corresponds to the mask operation. It masks the relevant entities for the current row
and sub-folders. For example, the Hide icon at the 1D folder masks all rod, bar2, bar3, weld, joint and
plot elements within any displayed components.
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The Isolate column corresponds to both a mask and an unmask operation. It performs a Hide on the
top level folder and then a Show on the current row and sub-folders. For example, the Isolate icon at
the 3D folder masks all connectors, geometry, 0D/rigid elements, spring/gap elements, 1D elements
and 2D elements and unmasks all 3D elements within any displayed components. The exception to this
rule is when the Isolate button is selected at a top-level folder; in this case, all sub-folders underneath
the top-level folder are unmasked and all other top-level folders, and their contents, are masked.
For example, the Isolate icon at the Components folder masks all supported entities in any displayed
groups, load collectors, morphing, multibodies and system collectors, and unmasks all supported
entities within any displayed components.

The Mask Browser's context menu contains functionality unique to the browser.

Context Menu

The Mask Browser's right-click context menu contains additional browser options.

Option Available for: Description

Collapse All All Closes all of the folders in the tree structure,
so that only the top-most level of items
displays.

Expand All All Opens all of the folders in the entire tree
structure, exposing every item nested at every
level.

Morph operates on all
elements/Morph operates on
displayed elements

All Determines whether the masking operations
for morph entities apply to all/displayed
elements.
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Mass Trimming Browser
Use the Mass Trimming tool to create, define and realize mass entities.

Mass entities are used to define mass distribution. A mass entity stores information like the mass value,
method of distribution, NSM, Point Mass, or Rigid mass with a mass center, and attached locations and
realization types. These definitions are not associated with physical FE entities. If all of the FE entities
in the model are deleted, the mass information will still be maintained. Mass entities can be saved in an
HyperMesh binary file which can be imported into a new FE model and realized.

Open the Mass Trimming tool from the menu bar by clicking Tools > Mass Trimming.

Mass Trimming Tool Interface

The Mass Trimming tool opens in the browser area.

The toolbar at the top of the Mass Trimming tool consists of tools used to create mass entities and
control their display state.

The first pane displays all of the mass entities in your model, and their associated attributes. The
second pane displays the Entity Editor, which can be used to define the attributes assigned to each
mass entity.
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Figure 337:

Mass Trimming browser tools:

Tool Description

Creates an NSM mass.

Creates a Rigid mass.

Creates a point mass.

Interactively select any type of supported mass entity via the
browser, or by selecting within the graphics area. The Selector can
be used to find mass entities from the graphics area which will then
be highlighted in the list. This is an efficient way of selecting multiple
mass entities at once.
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Tool Description

This tool can be used in conjunction with the Show, Hide, Isolate, and
Isolate Only tools.

Show/hide selected mass entities.

Alternatively, click this mode on and then pick the desired mass from
the graphics area; masses and any other entities determined by the
view option toggle settings are hidden as you click on them.

Note:  When used to select from the graphics area, this
button only works on visible connectors.

Isolate/isolate only selected mass entities.

Alternatively, click this mode on and then pick the desired mass entity
from the graphics area.

Opens the Perform FeAbsorb dialog, from which you can add
(absorb) certain FE information into mass entities.

Finds and displays the realized FE for the selected mass entities.

Finds the entities attached to the selected mass entity. When this tool
is active, all entities attached to the selected mass entity will be taken
into account when a display change is performed.

Context Menu

In the Mass Trimming Browser, right-click to access the context menu. The options available in the
menu are dependent upon whether you right-click on a mass entity, or in the white space of the
browser.

Option Description

Create Create a mass entity.

Delete Delete the selected mass entity.

Rename Rename the selected mass entity.

Xref Entities Opens the References Browser and displays the relationship of
the selected mass entities to other entities in the model in a
hierarchical tree structure.
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Option Description

Realize Realize the selected mass entity.

Re-Realize Re-realize the selected mass entity.

Unrealize Unrealize the selected mass entity.

If certain attachments cannot be made using the tolerance that is
set, then a reconcile will accept the current attachments, ignore
the failed ones, and change the status to green.

Show, Hide, Isolate, Isolate Only Control the display of the selected mass entities.

Review, Reset Review Review will show the mass entity highlighted with the rest of the
displayed content in a grey transparent mode. Reset will restore
the display.

Settings Apply a search order for failed mass attachment locations.

Only applicable for rigid masses with spider connections, and
RBE3-RBE2 and RBE3-RBE2 links.

Supported Entities

Supported mass entities include:

NSM ( )

A non-structural mass that can be distributed to elements, properties, and components, and
defines/updates the required solver cards. A group entity is created for each mass entity. The
group entity can be assigned a NSM1 or NSML1 card depending on the distribution method
chosen. Only supported in OptiStruct and Nastran user profiles.

Rigid ( )

A mass that takes the form of a mass element connected to nodes with rigid elements (Multiple
RBE2, RBE3/RBE2, and so on).
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Point ( )

A single mass element that is created at each selected node. A value is computed based on the
distribution method.

Mass Entity States

There are four states of mass entities. Each mass state is assigned a different color. Color coding
provides an easier way to visualize and filter masses based on state.

unrealized ( )

The initial definition of the mass entity after it is created. Unrealized masses are displayed yellow.

realized ( )

The mass is considered realized only if weld creation at the mass was successful. Realized masses
are displayed green.

modified ( )

The mass is considered modified when one or more of its corresponding attributes have been
edited in the Entity Editor. Modified masses are displayed blue.

failed ( )

The mass is considered failed if the weld creation at the mass was not successful. Failed masses
are displayed red.

Manage Mass Entities
Create, define and realize mass entities.

Create Mass Entities

Create Mass entities in the Mass Trimming Browser using one of the following methods:

• In the browser, right-click and select Create from the context menu.

• Click the Create Mass tool for the appropriate mass type on the toolbar.

Masses are organized by type in the browser.

Define Mass Entities
Define mass entities in the Entity Editor.

You can modify the distribution type, mass value, and total mass in the Mass Trimming Browser.

1. In the Mass Trimming Browser, select the mass to define.
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Altair HyperMesh 2019 Users Guide
Browsers p.1063

Mass Attributes
Supported attributes for Mass entities.

NSM Mass
Mass value

Mass value to be distributed.

NSM Distribution type

• Total Mass. A NSML1 card is created with either an element set or a property set that is
based on the NSM entity type definition.

• Per unit area/length.

Property type
Type of elements or properties used to distribute the mass. Supported property types include
PSHELL, PSHEAR, and PCOMP.

Location

• If NSM entity type is Elements, than elements can be selected in the model and element set
will be created for the NSM solver card.

• If NSM entity type is Properties, than properties can be selected in the model and a property
set will be created to realize the mass entity.

Reconnect rule

Rigid Mass
Calculate node

Calculates the mass location at the CG of the attachment points.

Mass value
Mass value to be put at the mass center.

Realization type

• RBE2. The mass takes the form of a mass element connected to nodes with rigid elements
(multiple RBE2).

• RBE2 link. The mass takes the form of a mass element connected to nodes with a rigidlink
element (single RBE2).

• RBE3. The mass takes the form of a mass element connected to nodes with a RBE3 element.

• RBE3-RBE2. The mass takes the form of a mass element connected to nodes with a RBE3
element connected to RBE2.

• RBE3-RBE2 link. The mass takes the form of a mass element connected to nodes with a RBE3
element connected to RBE2 link.

Location
Position at which the mass is created. If the calculate node option is not selected, then a location
for mass center will need to be selected.
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Attachment point
To define the attachment points, nodes have to be selected in the model. Node selection is not
used as is. A search is performed to see what is attached to the nodes.

• If a node is selected on a hole, then the center of the hole will become the attachment
location. If multiple nodes on a hole are selected, they will still treated as one attachment.

• If a node is selected on a mesh, then the nodes of the attached elements (shell or solid) will
be selected.

• If two or more nodes are selected in close proximity and the attached elements are adjacent,
then the entire patch will be selected.

• If an independent node of a rigid is selected, then the independent node is selected for the
attachment. The second leg is not created for two level rigid masses, such as RBE3-RBE2 or
RBE3-RBE2 links. The first leg is terminated at the independent node.

• If the free end of a CBUSH, with or without a tag, is attached to a rigid on the other end,
then the second leg is not created and the rigid type mass is terminated at the first leg.

Attached Location Tolerance
Tolerance value used to search for nearby FE entities to attach.

Realization zone
Only available when the attachment is on a hole.

• Inside. Use the nodes of the holes.

• Outside. Use the node from the elements that form the hole, without the hole nodes.

• Inside/outside. Use the nodes of the elements at the hole.

Mass Inertia

Rbe2/Rbe2 link

Realized FE in

• Auto

• Realized FE to current comp

• Realized FE to selected comp
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Figure 338: Nodes Selected for Attachment Points

Figure 339: Manual Mode for Single Level Rigid Creation
In this mode, only the selected nodes are used to define the rigid.
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Figure 340: Automatic Mode for Single Level Rigid Creation
If the Manual option is not enabled in the Entity Editor, the nodes of adjacent elements will be used to define the rigid if the

selected nodes are on a hole or are nodes on a mesh.

Figure 341: Two Level Rigid
In the case of a two level rigid, Automatic and Manual mode is not available. Instead, input nodes are processed. If input nodes

are on a hole, then the nodes of the hole are used. If the realization is set to inside or inside/outside, then washer nodes are

used. When the input node is an independent node or the free end of a cbush attached to a rigid, then the second level rigid will

not be created. The RBE3 from the conm is terminated at these nodes.

Point Mass
Mass value

Mass value to be used for defining point masses.
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Location
Position at which the mass is created. Can be nodes, elements, properties, or components. For
elements, only shell elements are supported.

Distribution type

• Apply to all nodes

• Divide mass by nodes

• Divide mass by area (Not available when Location is defined by Components or Properties)

• Unit area distribution (Not available when Location is defined by Components or Properties)

Tolerance
Tolerance value used to search for nodes to create point mass elements. point mass on nodes, the
tolerance value is used for a spherical search.

Threshold for Element Remapping(+-%)
When the old area and tolerance are used to search in the new mesh, the remapping may not
always give 100% of the old area based on mesh size and pattern. A % value like +-10% will
allow you to successfully remap and realize if the difference in area is within 10%.

Mass Inertia

Realized FE in

• Auto

• Realized FE to current comp

• Realized FE to selected comp

Limitations
• For NSM and Point masses defined on elements, if the mass entity is in an unrealized state and

partial elements are deleted, then upon rerealization, the status will be failed. If you translate
the nodes of the elements and try to realize again, the graphics may be misleading because the
failed locations might not reflect the translated location. However, re-realization with appropriate
threshold values or a reconcile will work properly.

• For NSM and Point masses defined on elements, if the mass entity is saved as an HyperMesh file
and realized in a new design that has coincident elements in the same area, then both elements
will be selected which will result in an increase of area of elements; hence the mass entity will
fail, showing a new threshold value that is needed in order to realize properly. In such cases, the
duplicate elements have to be deselected for those mass entities.

• For Rigid masses in automatic mode, if a node on a hole is selected, then the nodes of the hole will
be automatically selected. However, if the node is on the boundary of a mesh, then the nodes of
the entire boundary will be selected even though it is not a hole. In automatic mode, it is advised
that you do not select boundary nodes.

• When performing FE-Absorb on Rigid masses, a rigid mass might be absorbed as a mass entity,
and the realization might fail if the attachment point is not supported. For example, if the Rigid
from a CONM2 mass is connected to a dependent node of another Rigid, FE-Absorb will absorb this
as a mass entity. Re-realization will fail because only the independent node is supported as a valid
node and not a dependent node.
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• For Rigid masses, Rigids will be absorbed during FE-Absorb as a Mass entity when they are
connected to spring elements of any type, and a Rigid will be created during re-realization. If the
FE model is deleted from the current session, realization will fail when you try to reapply the Trim
mass to a new model, and a graphics message that reads “CBUSH node” will be displayed. At this
point, you will only be able to reconnect to CBUSH spring elements.

Realize Mass Entities

In the Mass Trimming Browser, right-click on a mass entity and select Realize from the context menu.

Resolve Failed Connections
Execute the search order to resolve failed connections.

1. In the browser, right-click on a Rigid mass and select Search Order from the context menu.

When defining Rigid masses, the following attachments are defined:

1. Node on a shell mesh

2. Node of a hole on a shell mesh

3. Independent node of a rigid

4. Free end of a CBUSH with or without a tag that is attached to rigid on the other end

Mass entities will fail during realization when:

1. Current mesh is deleted

2. A new model is imported that does not have a hole at the second location

3. There is no independent node and free end of a CBUSH at #3 and #4

2. You can execute a search order to find alternate connection methods at failed locations. The
search order provides the following options which can be selected and ordered in the sequence it
is desired.

Figure 342:

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1069

If you execute the search order, an alternate attachment method will be searched based on the
tolerance in the sequence defined and establish connection at the failed locations. At this point,
the new method will be saved for sub-sequent realizations. If within the tolerance, the search
order does not find an alternate attachment method, then the status will remain failed. However,
if after the search order is executed, and alternate attachment methods are established within the
tolerance, then the status will turn to yellow and the mass entity can be realized.

3. Click Apply.

Below is an example of reapplying Rigid Mass entities to a new mesh with mesh modifications, such that
reapplying fails, but executing a search order finds alternate types of attachments.

1. In the original mesh, the attachment type is a node on a shell mesh which finds nodes of adjacent
elements to create the second level rigid.

Figure 343:

2. When the mesh is deleted and realized, the realization fails. The modeling window indicates what
it is looking for at those attachment locations.
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3. When importing a new mesh, there is no shell mesh near the attachment within the tolerance at
two locations; however, there is a hole and an independent node. After realizing, the mass fails at
the two locations.

Figure 345:

4. Executing a search order with the following settings finds alternate attachment methods. The
search order is set to first look for independent node. If no independent nodes are found it will
then look for a shell mesh. The other options are not selected.
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5. The image below shows the alternate attachments that were found at those locations, which are
realized.

Figure 347:
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6. If the mesh is deleted and realized again, the new attachment method will be used for sub-
sequent realizations. The original attachment method was node on a mesh at all three locations,
but after executing the search order on the new mesh, the attachment methods change.

Figure 348:
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Perform FE Absorption
For FE models, use FE-Absorb to absorb the Trim Mass into the Mass entity.

During FE Absorption, you can only use realization types that are supported by the Mass Trimming tool.
For second level rigids that cannot be absorbed completely, the independent node will be used as the
attachment node.

Rigid Mass

1. In the Mass Trimming Browser, click  on the toolbar.

The Perform FEAbsorb dialog opens.

2. For Mass Type, select Rigid.

3. Set the Entity filter.

• Choose All to checks all elements to find FE.

• Choose Select to open the entity selector, which you can use to select a portion of the model
to find FE.

4. For Realized FE in, select a component to organize realized FE.

During absorption, no reorganizing is done based on this setting.

Only available for realizations

• Auto

• Realized FE to current comp

• Realized FE to selected comp

• Realized FE to original comp

5. Click FeAbsorb.

Proprietary Information of Altair Engineering

In the image below, the second level leg is attached to the node surface of the solid hole, which
is not supported during the realization process. The second leg will instead be used to absorb the
attachment to the independent node. A second level spider will not created during realization.

Figure 349:



Altair HyperMesh 2019 Users Guide
Browsers p.1073

Point Mass

1. In the Mass Trimming Browser, click  on the toolbar.

The Perform FEAbsorb dialog opens.

2. For Mass Type, select Point.
3. Set the Entity filter.

• Choose All to check all elements to find FE.

• Choose Select to open the entity selector, which you can use to select a portion of the model
to find FE.

4. Select an Entity creation rule.

• Choose Based on magnitude to group all CONM's that are located directly on a mesh based
on the magnitude, and creates one mass entity.

• Choose Based on component to group all CONM's that are located directly on a mesh based
on the magnitude and component the mesh is in, and creates one mass entity. If several
meshed components have CONMs with the same magnitude, multiple mass entities will be
created.

5. Select an Apply rule.

• Apply on all nodes

• Total mass

6. Click FeAbsorb.
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Only CONM2 masses will be absorbed since that is the only mass type supported during
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NSM Mass

1. In the ,Mass Trimming Browser click  on the toolbar.

The Perform FEAbsorb dialog opens.

2. For Mass Type, select NSM.

3. Set the Entity filter.

• Choose All to checks all elements to find FE.

• Choose Select to open the entity selector, which you can use to select a portion of the model
to find FE.

4. Select a Reconnect rule.

This option is useful when the entities to be connected will be exchanged in a subsequent process.
When rerealizing mass entities, HyperMesh looks for attachment entities based on the reconnect
rule.

• Choose None to not define a reconnect rule. If the attachment entity is not currently in the
model, the mass with this reconnect rule will fail to realize. If no reconnect rule is defined
for an attachment entity, the attachment will disappear from the mass when the attachment
entity is deleted.

• Choose Use id to reconnect using the IDs of the selected attachment entities. If the
attachment entity is not currently in the model, the mass with this reconnect rule will search
for entities with the same ID.

• Choose Use name to reconnect using the names of the selected attachment entities. If the
attachment entity is not currently in the model, the mass with this reconnect rule will search
for entities with the same name.

5. Click FeAbsorb.
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Matrix Browser
Use the Matrix Browser to explore the HyperMesh and HyperView data entities and export the entities to
external files for further analysis.

To open the Matrix Browser, click Tools > Matrix Browser from the menu bar.

The Matrix Browser is organized into two main sections. The top half of the browser provides a table
view similar to an Excel spreadsheet. The bottom half of the browser shows and allows you to browse
the HyperMesh/HyperView (data source) and its data entity (object) names and their data names
(attributes). The HyperMesh database entities are shown in green and the HyperView database
entities are shown in yellow. When you select a column in the table it becomes an active column and is
highlighted in blue. All of the following searches are conducted on the active column.

The Matrix Browser's context menu contains functionality unique to the browser.
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Figure 350:

Matrix Browser Functionalities

Below is a highlight of the functionalities supported by the Matrix Browser.

• Query and modify HyperMesh and HyperView data entities without writing cumbersome Tcl coding.

• Export HyperMesh and HyperView data to an Excel file for further post-processing and report
generation.
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• Establish a link between HyperMesh and HyperView in order to access model data, such as
material, property, beam section, and results data in a single environment. The browser supports
the selection of multiple load cases from the HyperView results database.

• Create new procedures (macros) to enable automation with minimum Tcl coding and also capture
the automation process as Tcl scripts. These macros can be used external to the Matrix Browser,
like the tools in the Altair script exchange.

Note:  The Matrix Browser does not allow for the creation of new HyperMesh entities. The
tool queries and modifies existing entity data. The browser also does not allow extensive
geometry (lines, surface, solids) data query. It is intended for FE data and results that are
already in the HyperMesh/HyperView databases.

Prepare to Use the Matrix Browser

1. Open an existing HyperMesh model or import solver data.

2. Use the split screen and invoke HyperView.

3. Load the results file for the solved data into HyperMesh.

4. Click Tools > Matrix Browser from the menu bar in HyperMesh.
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Figure 351:
Model opened in HyperMesh and HyperView.
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Note:  HyperView is only needed if the results are accessed from the Matrix Browser.
Use HyperWorks Desktop to access HyperView functions from HyperMesh in the
browser.

Access HyperMesh Data Using the Matrix Browser

1. In the DataSource column, select HMdata.
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2. In the Entities column, select an HyperMesh entity.

3. Click Query.

4. In the panel area, use the entity selector to select HyperMesh entities to add to the matrix.
A new green colored column is added to the matrix.

5. In the matrix, click the elements header to access entity data.
The elements column turns blue when clicked, indicating the entities are active for the search
operation. The Datanames column is populated with entity attributes from the HyperMesh
database for the element IDs shown in the elements column.

Figure 352:

6. Select the material, property, or any other attribute(s) and click Query.
One of more columns will be added. If you selected material, the material IDs will be shown.

7. The next step is to get E, Nu from the material. Activate the material column, and then select E
and Nu from the data names.
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Figure 353:

8. Click Query.

9. Repeat this process for property and get the element thickness.

Derived data is not stored in HyperMesh data. It is calculated by a procedure predefined by the Matrix
Browser to calculate useful data from HyperMesh data. You can create these Tcl procedures and store

them in the Matrix start up. They will show up in the browser as derived_datanames. The pre-installed 
derived_datanames are width, height, radius and adjacent.
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Access HyperView Results From the HyperMesh Database

Access HyperView Results From the HyperMesh Database with 
Multiple Subcases

1. In HyperWorks Desktop, split the graphics area into two windows. In the first screen, use
HyperMesh to load the model files. In the second screen, use HyperView to load results files.

2. From the menu bar, click Tools > Matrix Browser.
The Matrix Browser opens.

3. In the DataSource column, select HMdata.

4. In the Entities column, select the required element directly or select components, material,
property, or sets.

5. In the DataSource column, select HVdata.

6. In the Entities column, select Results.

7. In the Subcase Options column, select multiple_subcases.

Figure 354:

8. Select the results type(s) available in the solver results.



Altair HyperMesh 2019 Users Guide
Browsers p.1081

Proprietary Information of Altair Engineering

Figure 355:

9. Select layer information (if available) and the results system in which the results are to be
interpreted.

User-defined system results are available as long as a system is available in HyperView.

10. By default, the matrix only displays the results for each subcase in separate column. Retrieve
additional information by right-clicking and selecting Show all columns from the context menu.
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Access HyperView Results From the HyperMesh Database with the
Current Subcase

Current_subcase selection is the same as multiple_subcase, except that it provides the ability to create
multiple worksheets when you run the macros.

1. In HyperMesh Desktop, split the graphics area into two windows. In the first screen, use
HyperMesh to load the model files. In the second screen, use HyperView to load results files.

2. From the menu bar, click Tools > Matrix Browser.
The Matrix Browser opens.

3. In the DataSource column, select HMdata.

4. In the Entities column, select the required element directly or select components, material,
property, or sets.

5. In the DataSource column, select HVdata.

6. In the Entities column, select Results.
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7. In the Subcase Options column, select current_subcase.

Figure 356:

8. Select the results type.

9. In the HVSubcases dialog, select layer and system information.
Results for the current subcase display in the column.

Figure 357:
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10. From the Macro pull-down, click Save.

Figure 358:

11. From the Macro pull-down, click Run.

12. After the macro is finished running, you will be asked to select the load case. If you select multiple
load cases, separate worksheets will be created for each load case as in the case of current load
case.
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Figure 359:

13. Select the worksheet corresponding to the simulation.
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Access HyperView Results From the HyperMesh Database with the
Current Contour Results

1. In HyperView, select the required results and contour data.

Figure 360:

Figure 361:

2. From the menu bar, click Tools > Matrix Browser.
The Matrix Browser opens.
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3. In the DataSource column, select HVdata.

4. In the Entities column, select Results.

5. In the Subcase Options column, select current_contour.

Figure 362:

6. The current contour selection does not prompt you for load case, layer, or system information. The
displayed results are queried in HyperView and sent to the matrix.
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Query Max/Min Results for Components/Sets/Materials/Property

When you query max/min results for component/sets/material /property, HyperMesh will search the
max/min values for the elements in that component and provide single values and the element ID/load
case ID where that values occurs.

1. In the DataSource column, select HMdata.

2. n the Entities column, select components, sets, materials, or property.

Figure 363:

3. In the DataSource column, select HVdata.

4. Select results and the required data type.

5. In the HVSubcases dialog, select layer, corner data type, system, and averaging methods.
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Figure 364:

The max/min results for that component display. In a separate column, additional data lines
display the loads case and node/element information for the particular data.
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Figure 365:

Create Notes in HyperView

In the Matrix Browser, you can create and delete annotations (HV-notes) for selected column results
using the right-click context menu option Notes to HV.
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Figure 366:
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Figure 367:

Create and Retrieve User Data in the Matrix Browser

It is often useful to add additional data that is not in the HyperMesh or HyperView databases, which is
known as user data.

1. Click user_data in the Data Source column.

2. Click Create in the user variables GUI column.

3. Click double in the variable types column.

4. Click Query.

5. In the dialog, provide the column label name, select Multiple values, and activate the Create a
column on OK checkbox.
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Figure 368:

6. Click OK.
The user data is added to the Matrix Browser.

7. In the matrix, right-click on the user data you created and select Create Metadata from the
context menu.

8. In the dialog, select entities to create metadata for.
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Figure 369:

9. Retrieve this data using entity based metadata.

Figure 370:
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Work with Microsoft Excel

1. Once the HyperMesh, HyperView and user data is gathered in the Matrix Browser, the data can be
exported to Excel by clicking Excel in the top right-hand corner of the browser.

2. You can hide some of the columns that are not needed for export by right-clicking and selecting
Hide Columns from the context menu.
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Figure 371:

3. You can also add more columns. To import the new column(s) from Excel into the Matrix Browser,
click Matrix.
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Display Data in HyperMesh or HyperView

1. Display data in HyperMesh.

a) Click Correlations > Contour.
A dialog opens.

b) Select elements for the Entity Column label and Net_area for the Column on Y field.

c) Click OK.
The contour appears in HyperMesh.

2. Display data in HyperView.

a) Click Export > HyperView.

b) Select a column to export.

The exported data will appear in HyperView. You can post-process this data in the same
manner as other HyperView data types.
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Figure 372:
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Figure 373: Contourin in both HyperMesh and HyperView.
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Add TCL Calculation Procedure

HyperMesh has a built in scripting language based on Tcl programming language. Tcl is used to access
HyperMesh and HyperView functionalities\methods as well as internal data. The following example
calculates element strain (yy) from element 2D-Force-YY for a shell element.

1. Click user_data in the Data Source column.

2. Click Create in the user variables GUI column.

3. Click Procedure in the variable type column.
A dialog opens.

4. Enter the column and function name.

5. Activate the Create a column on OK checkbox.

6. Add the following Tcl code, based on Matrix and column names, then click OK.

proc Element_strain_calc  { } {
  set force_fyy[::MatrixBrowser::getColumn2D_Element_Force:YY]
  set width [::MatrixBrowser::getColumn Width]
  set young_mod [::MatrixBrowser::getColumn E]
  set thickness [::MatrixBrowser::getColumn PSHELL_T]
 set Strain_yy ""
 set Strain_yy [expr $force_fyy/$width/$thickness/$young_mod]
 return $Strain_yy
}
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Figure 374: Element_strains are calculated and displayed.
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Store and Reuse the Procedures Outside of the Matrix
Browser

The process developed in the previous section can be stored as a macro (script) and can be reused with
another HyperMesh data model or other HyperView databases.

1. Click Macro > Save.

2. Enter the Macro Name in the dialog and click OK.
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This macro can also be added to the menu bar and accessed and run without using the Matrix
Browser. The scripts are stored and can be reused like other HyperWorks scripts without the
Matrix tool.

Figure 375:
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Context Menu
The Matrix Browser's right-click context menu contains additional browser options.

Option Description

Import Import Matrix or CSV.

Export Export HyperView or CSV.

Correlation Select Contour, Shape, Vector, or Plot.

Refresh Refresh the Matrix Browser or HyperMesh session.

Proprietary Information of Altair Engineering

Delete Delete selected rows, columns, or the whole table.

Macro Save or run the macro.

Show all Columns

Show Columns

Hide Columns Hide some of the columns that are not needed for export.

Entity Highlight Select Show all, Show, Hide, Isolate, or Isolate Only.

Clear all Clear the table.

Notes to HV Create or delete notes.

Create Metadata Create and save metadata for user data selected in the matrix.
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Model Browser
Use the Model Browser to view the model structure while providing full find, display and editing control
of entities.

The model structure is viewed as a flat, listed tree structure within the browser. However, if the model
has an assembly hierarchy then the Model Browser accommodates this hierarchical structure. The
browser can list every named entity within the session and places those entities into their respective
folders; however, it does not support non-named entities such as nodes and elements. Some of the
more important entities within the model include: assemblies, components, multibodies, properties,
materials, entity sets, groups, load collectors, system collectors, vector collectors, and beamsectcols, all
of which are placed into a tree-like display.

To open the Model Browser, click View > Model Browser from the menu bar. The browser displays on
one of the tab area sidebars.

Figure 376: Entities Organized in the Model Browser

Multiple entities of the same type are collected into folders in the tree structure. You can expand or
collapse each folder to display or hide its contents. Assemblies can also have sub-folders within the
main Assembly folder, so that the items related to each assembly appear within that assembly’s folder
in the Assembly Hierarchy. Materials, properties, entity sets, groups, load cols, system cols, vector cols,
and beamsectcols cannot be organized into assemblies and are all placed at the top level of the tree,
each in their corresponding folder. For example, all sets are placed as a flat list in the Sets folder.
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Components and Assemblies may appear in multiple places in the tree; for example, a specific
component might appear under Components and again as a sub-item of a specific Assembly. When
appropriate, the color and display style of entities also display in the Model Browser.

The Model Browser tools include:

• Toolbars provide the ability to change model views, show or hide entities within the model, and
add entities to a panel collector. These abilities are collectively referred to as display controls and
browser modes.

• The context menu includes most of the same functions as the toolbars, however only relevant
context menus will appear based on entity(s), folder(s) or white space right-mouse click.

• You can sort, find, and filter entities in the Model Browser's tree list using column header sort
controls and the query builder.

• The tree list within the browser is configurable, so that you can determine which columns and
entity types that display in the tree.

Browser Attributes (Columns)
Each column in the browser displays a different browser attribute.

Add or remove browser attributes by right-clicking on a column header and checking/unchecking the
appropriate attribute from the context menu.

Sort by a particular entity in the browser by clicking on the heading of each column. For fields that are
numeric and/or alphanumeric, repeated clicks toggles between ascending and descending order.

Column Description

Entity Lists every named entity within the session; however, it does not
support non-named entities such as nodes and elements.

ID Unique entity ID

Color Entity color

Include ID of Include file the entity is stored within.

FE-Style Lists the element style applied to each entity. Click the icon to
change the element style.

Geometry Style Lists the geometry style applied to each entity. Click the icon to
change the element style.

Attributes Append entity attributes for components, properties and materials to
the browser as columns to facilitate fast and efficient review, editing,
sorting and filtering in the Component, Material, and Property views.

Right-click on a column heading and select More from the context
menu to access a list of all entity attributes that can be appended to
the browser.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1099

Column Description

Tip:  From the Entity Editor, right-click on an attribute
and select Add to Browser from the context menu to
append the attribute as a new column in the browser.

Filter entity attributes in their respective columns by clicking  in

the column header and entering a search string.

Edit the values displayed in each column by double-clicking the cell
and changing the value.

Create and assign parameters to attributes by right-clicking on the
attribute in the browser and selecting the correct function from the
context menu, such as Create and Assign Parameters.

Tool Button Groups
Many of the Model Browser functions are accessed via the View, Global Display, and Action Modes
groups of buttons. Rest the mouse cursor over a tool set or call-out in Figure 377 to see the name, or
click to jump to help for that tool set.

Figure 377: Model Browser Tool Button Groups
Blue call-out is the View toolbar; green is the Action Modes; and red is the Global Display.

1. elems/geom/both (filter for all/none/reverse and local display control)

2. display all

3. display none

4. display reverse

5. entity selector

6. elems/geom/both (filter for selection controls)

7. selector

8. virtual collector

9. show/hide

10. isolate
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Drag and Drop
Components, multibodies, and assemblies can be dragged and dropped with the left and right mouse
button. Use the left mouse button to move an item into another assembly; use the right mouse button
to open the context-menu and select remove to delete an item from an assembly. If an assembly is
moved, all the items in the assembly are moved to the new location. Items that are not seen in the tree
due to filters are also moved. You can drag and drop multiple items at any time using the standard Shift
and Control keys. When dragging-and-dropping entities, the number of entities you have selected to is
displayed.

Figure 378:

Note:  If an item is dragged out of the tree and dropped onto empty space, it is deleted in
all its parent assemblies and placed at the top level of the tree. A dragged item is added to
the bottom of the list in an assembly.

Model Browser View Modes

The Model Browser consists of the following predefined browser view modes:

Model

Includes

Components

Properties

Materials

Optimization (OptiStruct user profile only)

Assemblies

HyperBeam

The different view modes are located within the first row of icons in the Model Browser.
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Figure 379: Model Browser View Modes in OptiStruct User Profile
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Quickly invoke a view mode by double-clicking on the entity folder or an entity in the browser. For 
example, double-clicking the Components folder or a component entity invokes the Components view. 
Double-clicking on the Beam Section Collectors folder opens the HyperBeam view.

Note:  The Optimization and HyperBeam views can only be invoked by clicking their
respective view mode icon.

Figure 380:

Select the different view modes to quickly display specific entities in the Model Browser and graphics
area. After you select a view mode, HyperMesh provides additional information associated with the
entity in the Model Browser. Use the Optimization view mode to not only control the display, but to also
create optimization problem definitions.

You can use the browser view modes in conjunction with the selector mechanism to easily find and
query entities.

Model View
This is the standard view mode for the Model Browser. All entities within the session will be listed in the
tree.
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Includes View
Lists all Include files in the model. The contents of each Include file is organized (grouped) into folders 
containing each entity type. Each of the folders can be expanded to review the individual entities in that 
folder. For more details, see Model Browser Include View.
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Components View

• Lists only components in a flat list.

• Turns on the FE and Geometry style columns.

• Populates the Indirect Property and Material columns (dependant on user profile).

• Includes the Direct Property column, from which you can toggle between direct/indirect property
assignment.

• Visualization mode is set to By Comp

Figure 383:
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Materials View

• Lists only materials in a flat list.

• Visualization mode is set to By Mat.

Figure 384:
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Properties View

• Lists only properties in a flat list.

• Type and Card Image columns are turned on.

• Visualization mode is set to By Prop.

• A new button for element visualization by direct or indirect property is added.

Figure 385:
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Optimization View

• The optimization view is only available when the OptiStruct user profile is set.

• Lists only optimization related entities.

• Visualization mode is set to By Comp.

For more details, see Model Browser Optimization View.

The optimization view can be used to define optimization problems and objectives.

Figure 386:
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Assemblies View

• Lists all Assemblies in the model. Components are organized (grouped) under the Assemblies they
are assigned to. Components that are not assigned to an Assembly are displayed in a flat list under
the Assemblies.

• Visualization mode is set to By Assembly.

Figure 387:
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HyperBeam View
Unlike other views, the HyperBeam view does not affect the overall model's display; instead, it focuses 
entirely on beam elements and enables the visualization, creation, and editing of beam sections and 
beamsection collectors. For more details, see HyperBeam View.
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Model Browser Optimization View
In the Model Browser, select the Optimization view to only display optimization related entities in the 
browser.

These entities include: Objectives, Objective References, Optimization Tables, Design Equations, 
Responses, Design Variables, Design Variable Relationships, Design Variable Links, Constraints, 
Loadsteps, Optimization Controls and Discrete Design Values.

The Optimization view displays two main folders: the Optimization Repository folder and the 
Optimization Problems folder. The Optimization Repository folder lists all the optimization related 
entities in the model, and the Optimization Problems folder lists all of the defined optimization 
problems.

To choose which problem will be included in the exported file, one (and only one) of the problems must 
be set to export.
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Define a Problem
Use the tools in the context menu to create, delete, and rename optimization problems. To properly 
define a problem, you must drag and drop optimization entities into the problem. You can drag one or 
many entities from either the repository or a previously defined problem into a problem. There are no 
active problems; you must drag and drop to define problems.

Context Menu
The context menu contains tools to create, edit, and assign optimization entities in the same manner 
as the Optimization menu. All newly created optimization entities are placed in the repository and must 
be added to a problem to be considered. There is an option in the context menu to remove any 
optimization entities from a problem without deleting it from the repository. The delete option removes 
the entity from the database completely.

Export Problems
Although multiple problems can be defined with the optimization view, only one can be exported. 
Through the context menu, you can select which problem is set to export. The problem set to export is 
highlighted in bold type and gets written out to the input file. The export state can also be defined in 
the Entity State Browser, the export state is set by simply checking the checkbox next to the required

problem in the export column. The optimization problems can be found under the Bag folder in the 
Entity State Browser.

Known Limitations
Only one objective and one opticontrol can be defined in one session.
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Model Browser Include View
In the Model Browser, select the Include view to create, review, edit, organize and update the contents 
of a model into various include files.

An example of a model in the Include view is shown below.

Figure 390:

The Master Model is at the top level of the Include view. Data which does not have any references to an

include file is stored in the master model. Each include file is represented with an icon  along with its

name and internal HyperMesh ID. The attributes Export, Include Path and Include Type (if applicable,
based on solver user profile) are listed in relevant columns. These extra columns can be turned on/off
using column header context menu.

Export
This column has a checkbox that allows you to turn the export state of an include file on/off; each
Include’ s export state can be distinguished either by the checkbox status or also by a separate

icon; that is the on icon ( ) and the off icon ( ).
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Include Path
This column allows you to define the export location for include files.

Include Type
This column lists the type of include file for applicable user profiles.
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Each include can be expanded to reveal its contents. The contents of each include is organized
(grouped) into folders containing each type, next to which appears the total number of entities of each 
type. Each of the folders can be expanded to review the individual entities in that folder. You can select 
entities (using the standard Shift and Control keys) and drag various entities between two includes or 
between the master model and an include. The browser can be configured to show only specific entities 
of interest.

You can drag-and-drop includes within the tree to nest them within other includes. In addition, when in 
Include view mode, the Model Browser context menu options Make Current and Move to Current 
become available when the menu is invoked by right-clicking on a valid include:

Make Current

Flags the highlighted include to be the default for subsequent Include operations such as Move to
Current.

Move to Current
Organizes the highlighted include(s) to become part of the pre-designated current include. The
selected includes are removed from their original location and added to the current one.

HyperBeam View
Use the HyperBeam View to create and control beamsection data.

HyperBeam view is activated by clicking  in the Model Browser. To exit the HyperBeam View and

return to HyperMesh, click another view in the Model Browser, or click File > Exit from the menu bar.
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Section Browser and Parameter Definition
The Section Browser presents a hierarchical view of all of the beamsections and beamsection collectors
in your database.

HyperBeam displays this hierarchy in a standard tree structure of beamsections residing inside
of beamsection collectors. Click the ID or config column headings to sort the beamsections and
beamsection collectors alphabetically. The Config column lists the type of section: Shell, Solid, Generic
and various types of standard sections including Channel, I-Sect, L-Sect, and so on.
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Use the Section Browser to find a particular section of your model for displaying or editing. When
you click on a beamsection, it becomes highlighted and the results are displayed in the Results pane.
Additionally, when you click on a beamsection, its parameters are listed and available for editing in the
Parameter Definition window.

Figure 392:
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Context Menu
The right-click context menu contains options for creating, editing, deleting, scaling, welding and 
exporting beamsections.

The following options are available from the HyperBeam View context menu:

Option Description

Create Create a new beam collector, as well as standard, shell, solid and generic
beamsections.

Note:  The only standard section libraries listed are those of
the current HyperMesh user profile and the HyperMesh general
standard section library.

Edit Opens the Edit Shell Section dialog. The dialog contains two tabs: Edit
Parts and Reorient.
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Option Description

• From the Edit Parts tab, you are able to control the naming, thickness,
and connectivity order of each part in the beam section. The
Connectivity Order simply lists the order of the vertices that define the
highlighted part.

• From the Reorient tab, you are able to reposition the section with
respect to the local axis.
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Option Description

Figure 393:

Note:  This option is only available for shell sections.

Scale Opens the Scale section dialog, from which you can scale the entire beam
section by a given scale factor.

Copy/Cut/Paste Choose one or multiple beamsections to copy or cut, and then select a
beamsection collector to paste the beamsections to.

Delete Deletes the selected beam collector or standard, shell, solid and generic
beam section.

Rename Activates the Entities column of the selected beam collector or beamsection,
allowing you to enter a new name.

Make Current Flags which beam collector new beamsections will be created in.
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Option Description

Note:  This option is only available for beamsection collectors.

Collapse All Closes all of the folders in the Section Browser, so that only the beamsection
collectors are displayed.

Expand All Opens all of the folders in the Section Browser, exposing every beamsection
nested in every beamsection collector.

Auto-weld Opens the Auto Weld dialog, from which you can set the tolerance
and thickness for the welds. If the segments or any part are within the
tolerance, Auto-weld will create a new part between them with the given
thickness. New vertices might need to be created to make the connection,
which should be centered at the area where the segments are the closest. If
the thickness is given as 0.0, the connection will be set to a thickness equal
to its length.

Auto-weld can also be accessed by selecting the auto-connect shell
sections option, from the HyperBeam panel > section utils subpanel.

Note:  This option is only available for shell sections.

Export CSV... Captures the beamsection name, each part within the section, its thickness
and each vertex number, and positions it all into a CSV file. Multiple shell
sections can be selected and exported using Control+left-click, or by
selecting Export CSV - all shell sections from the File menu.

This option is particularly useful when you select Import CSV from the File
menu, which will read the HyperBeam’s CSV format and create new shell
beamsections. The Import CSV and Export CSV options allow you to read
and write to HyperBeam without using a .hm file.

Note:  This option is only available for shell sections.

Parameter Definition Window
The Parameter Definition window is located below the Section Browser. In this window you can edit
the dimensions of standard, shell, and solid sections, and you can edit the Y and Z values for vertices of
shell and solid sections. The graphics area is updated and the dimension values are automatically saved
upon each entry. Use Tab and Shift+Tab to quickly navigate through the parameters.
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Figure 394: Standard Section Parameter Definition Window

Figure 395: Shell Section Parameter Definition Window

HyperBeam View Toolbar
Access additional tools from the HyperBeam View toolbar.

The toolbar, located at the topic of the HyperBeam View, contains the following functions:

Figure 396:

Grid Toggle Tool
Selecting and unselecting  turns the background grid in the graphics area on and off. When the

background grid is turned on, you are able to quickly resolve the relative size of each section.

Beamsection Orientation Tools
Control the orientation with respect to the local origin of a standard section in the HyperBeam
standard section library. Standard sections within the solver libraries already have a set
orientation that maps to the solver; therefore, the Beamsection Orient options are only available
for the sections that are defined in the HyperBeam library.

Button Function Behavior

Orient 0.0 Sets the orientation to 0.0 degrees.

Orient 90.0 Sets the orientation to 90.0 degrees.

Orient 180.0 Sets the orientation to 1800.0 degrees.
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Button Function Behavior

Orient 270.0 Sets the orientation to 270.0 degrees.

View Controls
Controls the view. All these options are available through Control + mouse and follow the
HyperMesh mouse controls.

Button Function Behavior

Fit to Window Fits the model to the center of the graphics area.

Zoom In/Out Left-click: Zoom in

Right-click: Zoom out

Fit to Circle Draw a circle around the area you would like to zoom
in on in the graphics area.

Move Center This is a panning tool that allows you to grab the
graphics area and move it to a different location.

Editing and Sketching Tools
Create and edit shell and solid sections, as well as, modify section parameters.

Button Function Behavior

Create shell part or
solid perimeter

This tool is activated automatically when defining a
new shell or solid section canvas, and has two distinct
functions:

• For shell sections, this tool will sketch one shell
section part at a time. Left-click to create a
connected vertex, and right-click to remove it.
Once the cursor leaves the screen the section will
be initialized.

• For solid sections, this tool will outline the
perimeter of one continuous solid section at a
time. It can also be used to cut holes in previously
defined solid sections. Left-click to create a
connected vertex, right-click to remove it. Once
the cursor leaves the screen the section will be
initialized.
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Button Function Behavior

Join parts / Split part
at vertex

To join two parts that meet at a common point end,
left-click on the first part, then left-click on the second
part to merge it into the first part.

To split a part at a vertex, left-click on the part that
you wish to split, then right-click on the vertex that
you wish to split the part at. The part splits into two
parts.

Move vertex / Edit
dimension / Edit
thickness

This tool is active for standard, shell and solid sections,
and has three distinct functions:

• For standard sections, this tool allows you to edit
any of the parameters displayed on the section.
Left-click and hold a dimension or thickness on
the screen, and then drag; the section value
and corresponding graphics will change as it is
dragged. Double-click on a dimension, which is
represented in the graphics area as text, to create
a box around the text you want to edit.

Note:  The only available options to
edit the text are backspace to delete
characters, the ten number keys, and
the period. Exponential notation is not
supported.

• For shell sections, this tool allows you to quickly
snap any vertex to the predefined grid. It can
also be used to edit the thickness of a shell
part by left-clicking and dragging the thickness
value. Double-clicking on a thickness, which is
represented in the graphics area as text, will
create a box around the text want can edit it.

Note:  The only available options to
edit the text are backspace to delete
characters, the ten number keys, and
the period. Exponential notation is not
supported.

• For solid sections, this tool allows you to quickly
snap any vertex to the predefined grid.

Add vertex / Delete
vertex

Left-clicking on or near any part (for a shell) or
perimeter (for a solid) will create a new vertex on
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Button Function Behavior

the closest part or perimeter. The part or perimeter
will be diverted to now run through the new vertex.
If a clicked point is closer to the end of a part than a
segment of it, the part will be extended.

To prevent a bend in the part during vertex creation,
select points on the shell parts themselves. If your
cursor is near snap tolerance lines that cross existing
shell parts, a "+" will appear. A relatively small snap
size may make it difficult to tell whether the cursor is
over the shell part or beside it. Increase the snap size
so that it is more clear when the cursor has snapped to
the shell part; or look at the point coordinates, if either
the y or z value is not an even multiple of the snap size
then the cursor is over the shell part and not beside it.

Replace vertices /
Detach a vertex

To replace vertices, left-click on the vertex that you
wish to replace, then left-click on the vertex that you
wish to replace the first vertex with. The second vertex
replaces the first vertex.

To split a vertex into two coincident vertices, right-click
on a vertex.

Delete shell part or
solid perimeter

Left clicking on or near any part (for a shell) or
perimeter (for a solid) will delete the nearest part or
perimeter.

Undo/Redo Tools
Undo and redo changes you have applied to the currently displayed beam section (dimension
changes, part additions, thickness changes, and so on). If you switch to a new beam, the undo/
redo list will be cleared from the previous beam.

Button Function Behavior

Undo all changes Undo all of the changes applied to the currently
displayed beam section.

Undo last change Undo the last change applied to the currently displayed
beam section.

Redo last change Redo the last change applied to the currently displayed
beam section.
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Button Function Behavior

Redo all changes Redo the all of the changes applied to the currently
displayed beam section.

Measuring Tools
Querying beamsection.

Button Function Behavior

Find moments at
mouse location

Selecting this icon activates an interactive mode. When
you click on a point in the graphics area, the Local
moments of inertia dialog appears. From this dialog
you can review the following information:

• The Y and Z coordinates of the point selected.

• The Y and Z offsets from the shear center and
centroid.

• The moments of inertia Iyy, Izz, and Iyz for the
section relative to the selected point.

This tool is useful for determining beam element
offsets or making custom beams. Click Exit to close
the dialog select another point.

Measure section with
ruler

Selecting this icon activates an interactive mode. When
you click two or more points in the graphics area,
lines are created similar to the way a shell section
is created. If two points are selected, the dy and dz
distances between the points are displayed, as well as
the total length of the line. If three or more points are
selected, the total length of the line is displayed. Right-
clicking removes the previously selected point.

Image Capture Tools
Take screen shots of various components in HyperBeam.

Button Function Behavior

Save image to file/
clipboard

Use the toggle to determine whether to save an image
to a file, or to a clipboard. When the toggle is on
(highlighted orange), an image is saved to a file.
When the toggle is off (gray), an image is saved to a
clipboard. Images will be saved as a .bmp.
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Button Function Behavior

Capture full image Captures and saves your entire application frame to
your selected toggle setting.

Capture graphics area Captures and saves the graphics area to your selected
toggle setting.

Capture results area Captures and saves the results area to your selected
toggle setting.

Capture rectangular
area

Captures and saves a selected area to your selected
toggle setting.

Save graphics to jpg Captures and saves the graphics area as .jpg to a
location that you specify.

Graphics Window
The graphics area displays a representation of the geometric layout of the section.

All sections display the following items:

Item Description

Local origin of the beamsection

Section Centroid

Shear Center

Element Axis

Standard sections display the geometric representation of the section based on the parameter values,
which are also listed on the screen.
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Figure 397:

For shell sections each part is drawn with lines connecting the dots that show the section's vertices.
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Figure 398:

Solid sections can be created and edited using the same tools as a shell section, and the mesh that is 
used for the section calculations is displayed.
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Figure 399:

Since generic sections do not inherently have any shape, only a grey box is shown. The centroid and 
shear center graphics location will update.

Figure 400:
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Display Stress Recovery Locations
You can turn the display of stress recovery location's points and/or prop IDs, that are already defined 
within the property solver cards, on and off by modifying the display parameter.

Stress recovery points for shells, solids, and generic sections are only supported in the Nastran, Radioss 
and OptiStruct user profiles.

1. To access these parameters, click Parameters > Display from the menu bar.

2. To accept your changes, click Update before you exit the dialog.

Figure 401:
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Modify Grid Parameters in the Graphics Area
You can change the size of the background grid and vertices in the graphics area, as well as adjust the
behavior of your cursor when it is near snap tolerance lines by modifying the grid parameters.

1. Click Parameters > Grid from the menu bar.

2. Modify the grid parameters.

3. In the Grid Size field, enter the size of the background grid in the graphics area.

4. In the Snap Size field, enter the incremental movement of your cursor over grid points in the
graphics area. If your cursor is not snapping to the nearest grid points when you move your
mouse in the graphics area, increase the snap size.

5. In the Point Size field, enter the size of the vertices in the graphics area. Increasing the point size
makes it easier to select an existing grid point when you are creating a part.

6. To accept your changes, click Update before exiting the dialog.
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HyperBeam Results Pane
Whenever HyperBeam computes the section properties of the current section, it displays them in the
Results pane.

You cannot edit the text in this portion of the window for standard, shell and solid sections, but you can
select it and copy/paste it into another application. The only way to change the parameters of a generic
section is to edit the values in the Results pane.

Proprietary Information of Altair Engineering

Figure 402:
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HyperBeam Sections
Types of HyperBeam sections that can be defined. 

Standard Section

• Use Standard sections to define solver supported sections. Each supported solver has a

• 3D visualization is available in HyperMesh.

Shell Section

• Use Shell sections to define thin cross-sections with geometric lines or 1D elements. To create
shell sections, use the shell and solid creation and editing tools or bring in geometry and
element data from HyperMesh.

• When you create a shell beam section by cutting a cross-section through a shell mesh, any
thickness that was assigned directly to the elements will be given to the shell section. The
thickness applied to the section is equal to the average thickness for all elements in the
component with each element getting equal weight. The number of elements matters, but the
area of the elements does not. For composites, the thickness will be extracted treating the
composites as homogenous.

• 3D visualization is available in HyperMesh.

Solid Section

• Use Solid sections allow to define solid beam cross-sections with continuous 2D elements,
connecting lines that have a closed loop, and continuous surfaces. To create solid sections,
use the shell and solid creation and editing tools or bring in geometry and element data from
HyperMesh.

• 3D visualization is available in HyperMesh.

Generic Section

• Use Generic sections to define sections without defining actual cross-section geometry. Areas,
inertias, centroids, and other coefficients are supported.

• No 3D visualization is available in HyperMesh.
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Example: Create Shell and Solid Sections Using the HyperBeam Sketcher

1. In the Section Browser, right-click and select Create > Shell Section or Solid Section from the
context menu.

2. In the Create dialog define parameters and click Create.

a) In the Thickness field, enter the default thickness for each new part created.

Part thicknesses can be edited later.

b) In the Canvas size field, enter the initial length and width of the sketching area.

c) In the Grid size field, enter the default size of the background grids.

This can be altered in the Parameters pull-down menu.

d) In the Snap size field, enter the smallest interval at which you can define a vertex by clicking
while sketching.

This is also the snap size while moving existing vertices.

e) In the Point size field, enter the size of the vertices in the graphics area.

Tip:  Increasing the point size makes it easier to select an existing grid point
when you are creating a part.

Proprietary Information of Altair Engineering

Figure 403:
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3. Once the defaults are set, the canvas will appear and you can start creating parts with the shell

part / solid perimeter tool ( ).

Once clicked, the button remains highlighted until you move the mouse off of the canvas.

• Left-click to create a new vertex.

• Right-click to remove vertices in the reverse order they were created.

• Once the part is complete, move the mouse off of the canvas to finalize it.

Note:  Each part has only one thickness, and it is common to have a section with
multiple connecting parts.

Proprietary Information of Altair Engineering

Figure 404:

4. Use the Move vertex / Adjust Dimension tool ( ) to click and drag vertices to snap points for

shell and solid sections, or to adjust parameters such as shell thicknesses or standard section
parameters.
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Figure 405:

5. After the parts are created and assembled it is sometimes necessary to revise the connectivity or
change the part thicknesses.

This can be done in the part editor shown above. Each part is listed with its part name, thickness
and connectivity, and as each part is selected it will highlight yellow on the canvas.

The connectivity order is simply the order in which the vertices are drawn for a given part.
Remember to leave a space between each vertex when editing the connectivity order.

6. Redefine the local axis location and angle using the Reorient tab in the Edit shell section dialog.

This becomes useful when comparing HyperBeam shell section properties (results) to more rigidly-
defined sections. Note that changing the local axis in HyperBeam is not the same as using element
offsets in a finite element model.
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Figure 406:

The same toolset can be applied to sketching solid sections as well. You can start by right-clicking the
browser on the left-hand side, creating a new solid section, and defining defaults for Canvas, Grid and
Snap sizes.

The Shell part / Solid perimeter tool can now be used to trace the outline of a solid shape.
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Figure 407:

As before, once the outline is sketched, move the mouse out of the canvas area to finalize the part.
Unlike shell sections, solid sections can only have one part defined, although the same tool can be used
to sketch out a cavity within the solid section.

Note:  Only one cavity can be defined per section.

Figure 408:
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As before, the Move vertex / Adjust dimension tool can be used to move vertices of solid sections. Each 
vertex movement requires a re-mesh of the solid section, so take care when moving vertices of 
complicated parts.

Example: Create and Assign a Standard Section
Create and assign a standard section to an OptiStruct PBARL property.

Before you begin, load the OptiStruct user profile and open the standard_section.hm model, located in 
<installation_directory>\tutorials\hm.

Figure 409:
The grey elements in the image to the left represent a structure that needs to be stiffened by adding I-beams down the length of

it. The image to the right is the 3D visualization of 1D bar elements running along five separate node paths.

1. In the Model Browser, click  to activate the HyperBeam view.

2. Create a Standard Section by right-clicking on the browser and selecting Create > Standard
Section > OptiStruct > I from the context menu.

3. Define the parameters as shown below:

Figure 410:
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Once HyperBeam solves the cross sectional properties, it is necessary to attach the beam section
to a PBARL card image. This can be done by creating a component and assigning it a property that 
references the PBARL card image and beam section.

4. In the Model browser, right-click and select Create > Component from the context menu.
A new component is created, and opens in the Entity Editor.

5. In the Entity Editor, right-click on the Property field and select Create from the context menu.

6. Define the property in the Create Properties dialog and then click Close.

a) In the Name field, enter pbarl.

b) For Card Image, select PBARL.

c) For Beam Section, click <Unspecified> > Beamsection.

d) In the Select Beamsection dialog, select standard I and click OK.

Figure 411:
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7. After the new component and property are created with the beam section attached, the bar
element can be defined in the bars panel in the 1D menu-page.

Figure 412: Bars Panel

Bar element alignment using HyperBeam sections is very straightforward since standard sections
are defined using an absolute y-direction. The direction specified in the Bars panel defines the
alignment of the beamsection’s y-direction. In this case, the positive z-direction in the Bars
panel will align with the y-direction of the HyperBeam section. Since the centerline of a 1D beam
element is defined about the section’s shear center, elemental offsets are frequently required. In
this case, we have added z-offsets at both ends of each element to align the I-beams flush with
the plate.

To fully visualize the 1D element in HyperMesh, find the display option in the Visualization toolbar

( ).
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Example: Create and Assign a Shell Section
Create and assign a shell section to an OptiStruct PBAR property.

Before you begin, load the OptiStruct user profile and open the shell_section.hm model from
<installation_directory>\tutorials\hm.

Figure 413:
The blue lines are plot elements denoting the beam section. Elements or lines can be used to describe a beam cross section. The

purple lines are plot elements used to align the section within HyperBeam.

1. From the 1D page, select the HyperBeam panel, shell section subpanel.

2. Set the selector type to use elems, and then select the blue plot elements.

3. Under cross section plane, toggle to the plane and vector selector.

4. Select N1, N2, and N3 locations.
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Figure 414:

The vector created by N1 to N2 describes the local y-axis used in HyperBeam. N3 describes the
positive sense of the z-axis. It is important to note the alignment of the local axes at this point.
Later, it will be necessary to know this when the beam section is aligned for bar elements.

5. Set section base node to shear center.
6. Click create.

HyperBeam View is invoked.
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Figure 415:

Once selected solves the cross-sectional properties, it is necessary to attach the beam section to a PBAR
card image. This can be done by creating a component and assigning it a property that references the
PBAR card image and beam section.

7. In the Model browser, right-click and select Create > Component from the context menu.
A new component is created, and opens in the Entity Editor.

8. In the Entity Editor, right-click on the Property field and select Create from the context menu.

9. Define the property in the Create Properties dialog and then click Close.

a) In the Name field, enter pbar.

b) For Card Image, select PBAR.

c) For Beam Section, click <Unspecified> > Beamsection.

d) In the Select Beamsection dialog, select shell_section.0 and click OK.
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Figure 416:

10. After the new component and property are created with the beamsection attached, the bar
element can be defined in the bars panel in the 1D menu-page.

Figure 417:
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Bar element alignment using HyperBeam sections is very straightforward if the section has been 
defined using an absolute y-direction. The direction specified in the Bars panel defines the 
alignment of the beamsection’s y-direction. In this case, the positive y-direction in the Bars panel 
will align with the y-direction of the HyperBeam section.

To fully visualize the 1D element in HyperMesh, find the display option in the Visualization toolbar

( ).

Cross Sectional Properties Calculated by HyperBeam
The beam cross section is always defined in a y,z plane.

The x-axis is defined along the beam axis. The coordinate system you define is called the local
coordinate system; the system parallel to the local coordinate system with the origin in the centroid is
called the centroidal coordinate system; the system referring to the principal bending axes is called the
principal coordinate system.

For shell sections, only the theory of thin walled bars is used. This means that for the calculation of the
moments and product of inertia, terms of higher order of the shell thickness t are neglected. Thickness
warping is also neglected.

Area

Area Moments of Inertia

Area Products of Inertia

Radius of Gyration

Elastic Section Modulus

Elastic Section Modulus
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Max Coordinate Extension

Plastic Section Modulus

Torsional Constant

Solid

ω - Warping function
(see below for warping function)

Shell open

t - Shell thickness

Shell closed

- Area enclosed by cell
- Shear flow in cell

Elastic Torsion Modulus

Solid

Shell open

Shell closed

Shear Center
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Warping Constant (normalized to the shear center)

Shear deformation coefficients

Shear stiffness factors

Shear stiffness

Warping Function

For solid sections, the warping function is computed using a finite element formulation. This may
lead to un-physically high stresses in geometric singularities (sharp corners) that get worse with
mesh refinement. This may cause problems computing the elastic torsion modulus.

Nastran Type Notation
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Working with Beamseactions in HyperMesh

Beamsections are handled slightly differently in each HyperMesh user profile, although certain features
remain constant.

Components, Properties, Elements, and Beamsections
HyperMesh offers a range of ways to organize a FEA model. Understanding the connection between
components, properties, elements, and beamsections is important for 1D beam modeling.

The Model Browser allows you to create a component, property and material all at once and verifies
that everything is appropriately assigned. It also allows you to assign an existing beamsection to the
property. This is probably the simplest way to create and organize components for 1D modeling.

When a component is opened in the Entity Editor, right-clicking on the Property field and selecting
Create from the context menu allows you to automatically create and assign a new property to the
component in the Create Properties dialog. Selecting a beam section via the Beam Section attribute
will automatically populate attributes related to the beam section.

Figure 418:

Every element, including beam, bar and rod elements, must exist within a component. A property can
be assigned to a component, or to an individual element. If there is a conflict with properties assigned
directly to elements and properties assigned to components, direct element property assignment
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takes precedence. 1D properties hold the section information such as areas, inertias or even specific
dimensions in the case of standard sections. 1D elements hold the orientation and connectivity
information. Beamsections hold section geometry information and section calculation data, just the
same as a 1D property. In fact when a beamsection is assigned to a property, it will automatically
take over the property and fill in the necessary fields. The 3D visualization operates based on the
beamsection’s stored geometric data. To disassociate a beamsection from a property, right-click the
beamsection selector in the property card image.

Import/Export HyperBeam Comments
Overview of how to import and export HyperBeam comments.

• Import HyperBeam comments.

On import of a FEA model, beamsections are automatically created for all bar, beam, and rod
properties that do not already have beamsections defined. These beam sections automatically
populate bar, beam, and rod property cards and the cross-section should be edited with
HyperBeam. 3D visualization of beams in HyperMesh is only made possible through HyperBeam
beamsections and their association to properties.

To import a FEA model without automatically creating beamsections for each 1D property,
use the custom import feature with beamsections and beamsection collectors unchecked. The
section information on the actual property cards will remain intact, but the geometric and section
calculation data will be missing.

Figure 419:
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• Export HyperBeam commetns.

Exporting a FEA deck in HyperMesh operates in a similar fashion. HyperBeam comments are written
out by default (as are all HyperMesh comments). In order to suppress HyperBeam comments from
being exported, you must use the Custom export feature, or the Solver option to turn off all
comments. Beamsections are stored as HyperBeam comments in an exported deck.

Figure 420:
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Example: Import and Automatic Beamsection Creation
This example illustrates the automatic creation of beam sections on import and the visualization of
these rods, bars and beams in HyperMesh.

Before you begin, load the OptiStruct user profile and open the pbeaml.fem input file from
<installation_directory>\tutorials\hm.

1. Use a text editor to inspect the following file: pbeaml.fem.

Figure 421:

There are no beam sections or HyperBeam comments defined in this input file. When imported,
HyperMesh automatically creates beam sections which allow you to visualize the sections in 3D.

2. Import pbeaml.fem into HyperMesh and make sure the beam visualization ( ) is turned on.

Figure 422:
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Direct/Indirect Property View
Filter elements that display in the graphics area based on their property assignments.

When the Property view is active in the Model Browser, the Direct/Indirect Property view ( ) is

enabled. From this view you can select one of the following:

Both direct and indirect properties

Direct properties only

Indirect properties only

Note:  This feature is not supported by the user profiles for ANSYS, LS-DYNA, Marc, PAM-
CRASH 2G, Radioss, Samcef, and any profile in Manufacturing Solutions.

Selecting one of these options immediately filters the view in the graphics area. These filters are
accumulative with the current component display state, so, for example, if you have only a few
components displayed in the graphics area and the rest are hidden, selecting Direct Properties Only
will filter out any elements from the currently displayed set, but will not cause previously-hidden
elements to become visible again even if they have direct properties assigned. Similarly, Show, Hide,
and Isolate functions work in conjunction with these controls rather than overriding them. If you switch
to a different Model Browser view, the effects of your current direct/indirect property view remain.

Selecting any of these view modes automatically hides any non-element entities, such as boundary
conditions or morphing domains.

Note:  Entities with no property assignments at all will be filtered out of the view by any of
these options.
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Figure 423:

Property View: Both

Figure 424:

Examples
The simple model shown below (using the properties view) has elements organized into four
components, each representing a property state: direct only, indirect only, mixed, and no property.
The mixed component consists of three elements with indirect properties and one element with direct
properties, but this only becomes apparent when using one of the property views.
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Property View: Indirect Only

Figure 425:

Property View: Direct Only

Figure 426:
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Direct/Indirect Property Assignment
Define direct/indirect property assignment.

Many solver user profiles include a column called Direct Property when in Component view. This column
holds checkboxes for each component.

Figure 427:

• When checked, the component uses a direct property assignment.

• When unchecked, the component's direct property assignment is "unassigned" and the component
will use indirect property assignment, if available.

The Direct Property column displays for all solver profiles except ANSYS, LS-DYNA, PAM-CRASH 2G,
Radioss, and any profile in Manufacturing Solutions.

The Indirect Property column displays for all user profiles except PAM-CRASH 2G and Samcef.

The checkbox may be checked or unchecked based on the type of assignment already defined in the
model, but you can change the assignment type by changing the state of the checkbox.

You can check or uncheck multiple components at a time, if you have multiple components selected
before changing the state of the checkbox. The exact results depend on a number of factors:

• If you select more than one component and uncheck the DIRECT checkbox for one of them, then all
selected components should have their property relationship unassigned.

• If you select more than one component and check one of the DIRECT checkboxes for that selection,
then if and only if the INDIRECT properties are common they will be assigned. If there is a mixture
of INDIRECT properties, the operation fails because multiple property assignments are not possible.

• If the component has no INDIRECT property, but does have DIRECT property assignment, and you
uncheck the checkbox, then the component has NO property assignment. This means that if you
then recheck the checkbox, you receive an error stating that no property is available, so automatic
direct property assignment is not possible. The checkbox, in this instance, will be disabled until you
make an indirect/direct property assignment for the relevant components.

Like most browser columns, you can sort components by the state of their Direct Property flag.
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Context Menu
Access additional Model Browser options from its right-click context menu.

These context menus will appear only where they are applicable hence making them smart and 
compact.

Table 13:

Option Available for: Description

Assign Components Opens a dialog from which you can assign
properties and materials to the selected
components. You can view properties by name,
name and ID, or ID only.

Card Edit All You can edit any single item's card. You can edit
multiple items provided that they use identical
card images. This option displays the card
image of the chosen entity for the current solver
template; if a template is not loaded or if the
entity does not have any card images associated
with the loaded template, an error message
displays in the status bar.

Collapse All Folders Closes the selected folder(s) and its children
folders (if any), so that only the selected folder
displays.

Collapse All White space Closes all of the folders in the tree structure, so
that only the top-most level of items displays.

Configure Browser All Opens the Model Browser’s Browser Configuration
window where you can specify the entities the
browser displays in the tree as well as the columns
the browser displays.

Create White space and the
respective folder; user
profile valid entity from
the list: Assembly,
Beam Section Collector,
Block, Box, Component,
ConstrainedExtraNode,
ConstrainedRigidBody,
Contact, Contact Surface,

Opens the Create dialog, from which you can
define and create a new entity. If you are creating
a new entity in the Radioss, OptiStruct, Nastran,
LS-DYNA, Abaqus, ANSYS, PAM-CRASH, Permas,
Samcef, and EXODUS user profiles, HyperMesh
creates the new entity and opens it in the Entity
Editor. Use the Entity Editor to modify entity data.
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Option Available for: Description

Control Volume, Cross
Section, Feature, Field,
Group, Include File,
Laminate, Load Collector,
Load Step, Material,
Multibody, Output Block,
Parameter, Plot, Ply,
Property, Region, Rigid
Wall, Sensor, Set, System
Collector, Transformation,
Vector Collector, View,
Accelerometer, Positions
(Abaqus)

When you create a new Assembly or Include File,
HyperMesh assigns it a unique, generic name and
adds it to the Model Browser.

When you create a View, HyperMesh saves
the current model’s graphics settings in the
browser. Saved views include all of the visible
effects of settings such as masks, zoom/pan, X/
Y/Z orientation, and whether or not any given
component's FE or Geometry is displayed. You can
save multiple views (named view1, view2, and so
on), and then switch back and forth between them
by selecting each view from the browser.

Delete All except the top-level of
Assemblies

Deletes the selected entities. Most items can be
deleted.

• If a component or multibody is present in
more than one assembly in the model, you
have the choice of deleting that item from
the database or deleting it from the present
location only.

• If you entirely delete an assembly, and that
assembly has children that are not present
anywhere else, those children move to the top
level.

Shortcut: To delete an entity that is selected in the
Model Browser, press Delete.

Delete Advanced Components in the
Abaqus, OptiStruct,
Nastran, LS-DYNA user
profile.

Displays a comprehensive preview of the entities
uniquely related to the selected component that
can also be deleted.

Drape Ply Access to the Drape Estimator and Laminate Tool.

• Drape Estimator estimates the draping angles
for structural analysis of composite laminates.

• Laminate Tool changes fiber angles with
respect to an element material system,
creates a distribution of drape angle changes,
changes the thickness of each ply, and
flattens the shape of a ply that needs to be
fabricated before laying on the mold.
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Option Available for: Description

Duplicate User profile valid entity
from the list: Assembly,
Beam Section Collector,
Block, Box, Component,
ConstrainedExtraNode,
ConstrainedRigidBody,
Contact, Contact Surface,
Control Volume, Cross
Section, Feature, Field,
Group, Include File,
Laminate, Load Collector,
Load Step, Material,
Multibody, Output Block,
Parameter, Plot, Ply,
Property, Region, Rigid
Wall, Sensor, Set, System
Collector, Transformation,
Vector Collector, View,
Accelerometer, Position
(Abaqus)

Duplicates a selected entity and opens it in
the Create dialog. If you are duplicating an
entity in the Radioss, OptiStruct, Nastran, LS-
DYNA, Abaqus, ANSYS, PAM-CRASH, Permas,
Samcef, and EXODUS, and EXODUS user profiles,
HyperMesh duplicates the selected entity and then
opens it in the Entity Editor. Use the Entity Editor
to modify entity data.

Shortcut: To duplicate an entity that is selected in
the Model Browser, press Control + D.

Empty Assembly, Beam
Section Collector,
Component, Control
Volume (OptiStruct),
Group, Load Collector,
Load Step, Multibody,
Output Block, Set,
System Collector, Vector
Collector, Accelerometer,
Position(Abaqus),
Ply, Feature, Field,
Rigion, Include file,
Cross-Section, Plot,
ConstrainedRigidBody.

Preview and delete empty collectors.

This operation can be performed on several entity
types at the same time. To append entity types to
the selection, left-click while pressing Control.

Expand All folders Opens the selected folders and children in the
tree structure, exposing every item nested in the
selected folder.

Expand All White space Opens all of the folders in the entire tree
structure, exposing every item nested at every
level.
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Option Available for: Description

Expand All Includes Model Browser Include
View only

Exports all of the includes with their corresponding
content, including the Master model.

Export Model Browser
Component, Material,
and Property views.

Export all entity data and attributes display in the
browser to a CSV or HTML file.

Export All Self
Contained

Model Browser Include
View only

Exports all of the model (master model and
includes) as self-contained files, ensuring that
each exported file contains all of the nodes and
systems that are referenced by entities within the
given include, as described above (see Export Self
Contained option).

Tip:  Activate the Delete duplicate
nodes and Delete duplicate
systems solver import options
to import a model that consists of
multiple Self-Contained includes back
into HyperMesh. This will ensure that
any duplicate nodes and systems
across different includes are merged
together appropriately when the
entire model is imported. Refer to
the Importing Solver Options help for
more details.

This option is only available in the OptiStruct,
Nastran, and Abaqus user profiles.

Export CSV Model Browser Model
View only, and Beam
Section Collector folder

Exports a CVS file of all beam section names, each
part within the section, corresponding thickness
and vertex numbers, and positions.

Note:  Only available for shell
sections.

Export an Include Model Browser Include
View only

Exports the contents of the selected include into
the chosen file name.

Export Self Contained Model Browser Include
View only

Exports the contents of the selected include
into the chosen file name, and ensures that the
exported file contains all of the nodes and systems
that are referenced by entities within the same
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Option Available for: Description

include, even if such nodes and systems belong to
different includes.

Because self-contained includes contain all of the
nodes and systems that are used by entities within
it, they can always be imported into HyperMesh on
their own without requiring the rest of the model.

This option is only available in the OptiStruct,
Nastran, and Abaqus user profiles.

Hide All except Beam Section,
Curve, and Optimization
Entities

Turns off the entity in the graphics area. This
selection affects each item’s local display control,
that is, will make the icon become ghosted
indicating the display state is off.

You can also use this on the entire folder. In such
cases, this hides all of the items within that folder
(for example all components, and so on).

Import CSV Model Browser Model
View only, and Beam
Section Collector folder

Imports new shell beam sections from a
HyperBeam CSV file, without having to use a .hm
file.

Include File Options Model Browser Include
View only

These let you set the options for a selected
include. The available options are:

File name
File name to be exported.

Do not export
Review the contents of an include but not
export it). Includes that have this flag

turned on display the off icon ( ).

File Path
File path to export the include to (absolute
path or path relative to its parent include).

Flag representing the input deck in which the
include belongs

This flag is specific to some solvers such
as OptiStruct, Nastran, and so on, which
subdivide their data deck into various
sections such as Bulk Data, Executive
Control, or Case Control. For the remaining
solvers, this option is not available and does
not display.
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Option Available for: Description

Include type
This flag is specific to LS-DYNA, which
subdivides their includes into various types
such as Include, Include_Transform, and
Include_Compensation_options.

Instance Option
Flag representing the instance relationship
between the includes, allowing you to create
a copy of your include files. This flag is
specific to LS-DYNA, and only applies to
Include files of the "Include_Transform"
type.

Include XRef Include file Any single item or multiple items can be selected.
This option opens a new References Browser that
displays the relationship of the selected include to
other includes in the model in a hierarchical tree
structure.

Isolate Only All except Beam Section,
Curve, and Optimization
Entities

Isolate Only works like Isolate, except that it
affects all entities regardless of type. This option
turns off the display of all entities that are not
selected.

Isolate All except Beam Section,
Curve, and Optimization
Entities

Isolate works locally within a specific entity type;
for example, if component(s) are isolated then
all display states of other entities, such as load
collectors, are unaffected. Isolate displays only the
selected entities, and turns off all other entities of
the same type.

Make Current BeamSection Collector,
Components, Load
Collector, Multibody

Using the pop-up menu, you can make any listed
entities current. The currentcollector status is
indicated in bold. Any new components, loads,
beam sections or multibodies are created within
the respective current collector.

Move to Include Component Opens the Move To Include dialog, from which
you can create a self containing include out of
selected components inside of an include.

Available in the LS-DYNA and Radioss user profile.

Organize All Organizes the selected entities into the current
include. This option is only enabled in the Include
view.
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Option Available for: Description

The Organize dialog opens when system
collectors, vector collectors, load collectors,
beamsection collectors, groups, multibodies, and
components are being organized into the current
include. By default, any additional entities (nodes,
elements, systems, vectors, loads and equations,
or beamsections) will be moved along with
selected parent collectors. If there are entities you
do not want to organize along with the selected
collector(s), clear their corresponding checkbox.

Organize Include Include Files (Include
View only)

Opens the Organize Include dialog, from which
you can move selected entities into a new or
existing include file.

Available only in the LS-DYNA and Radioss user
profile.

Part XRef Include Files (Include
View only)

Opens the Part References tab, from which you
can review all of the part assemblies and parts in
an Include file in a hierarchical view or in a flat
list.

Within the Part References tab there are two
predefined view modes: Hierarchy view and Flat
view. The different view modes are located in the
top, left corner of the tab.

Realize Plies If ply contours are defined by lines, the realize
algorithm will identify elements of an underlying
mesh. If an element centroid lies within the
ply shape defined by lines, it is added to the
particular ply. You can manually define plies on
lines in HyperMesh or import them from a CATIA
Composite Parts Design (CPD) file. Along with this,
if a ply has its shape defined in triangulation mesh
(in the case of fibersim imported data), that data
will be used in projecting on the actual mesh.

Three realization/conversion methods are
available:

Project Normal to target mesh for CPD/Geom
data

If the element centroid projected along
its normal lies within the geometrical ply
definition, it is associated with this ply. This
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Option Available for: Description

method is valid for ply shapes defined in
geometry (lines) coming from the CATIA
CPD file.

FiberSim drape map by proximity method
This method is similar to Project Normal to
target mesh for CPD/Geom data except that
instead of ply geometry in terms of lines,
it uses the triangulation data from fibersim
which is stored in the related table entity. It
also considers/maps drape data to the new
ply elements/shapes. Once an element is
selected for a given ply, drape data closest
to its centroid from the ply table (where the
drape data is stored) is considered.

CATIA Composites Link drape map by
proximity method

Use this method to realize the plies.

Advanced options:

Three options are available for the search criteria:

Centroid
If the element centroid is inside the ply
boundary, the element is added to that ply
set boundary.

All nodes inside
The element will be added to a ply set, if all
of the nodes are inside the ply boundary.

Shrinkage factor of border element edges
Based on the fraction of an element area
intersected by the ply boundary, the element
is added to the ply set.

Input Samle Point
Judging whether elements reside inside of
a ply boundary is sometimes challenging,
especially on a curved surface. Using correct
sample points (or nodes) to indicate if the
elements are inside helps ply realization. You
should use this method for each ply, not for
all of the plies. It is recommended to use ply
realization for all the plies, and then inspect
each ply to make sure it is correct. If the ply
realization is wrong, correct that ply only
using sample points or interactive nodes.
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Option Available for: Description

You can either import the core sample .csv
file, or interactively pick nodes for a ply.

Laminates A laminate can also be realized. In this step,
you create and assign properties to elements to
translate the ply-based composite's definition
into a zone-based one. A template composites
property has to be assigned to the elements
involved in the composites definition prior to this
step. The algorithm copies all settings from this
property to the newly generated ones. Each zone
of elements with a unique set of plies receives its
own property.

If there is drape data available on every ply
(such as fibersim drape data) then thickness
and fiber orientation corrections are applied to
each property layer/ply automatically. Currently
Laminate Realize with drape data results into one
property per element.

To open the Laminate Realize dialog, right-click
on a laminate in the Model Browser, and then
select Realize.

Fields Field realization creates pressures and
temperature loads, and maps properties IDs. In
order to map the spatially varying values stored in
a field entity to the element and node data of the
new target mesh you must realize the field entity.

Define field realization settings in the Field
Realization dialog, which opens when you right-
click on a field in the Model Browser and select
Realize from the context menu.

Remove Components Removes the component from an assembly if
the component is referenced in more than one
assembly.

Note:  This does not delete the
component, but merely removes one
listing of it from the Model Browser
tree.
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Option Available for: Description

Rename All You can rename any item in the name text field,
but the new name must be unique. All instances of
the renamed item update automatically. You can
cancel the rename operation by pressing Esc.

The high-level entity folders are non-editable, but
you can rename folders containing the assembly
hierarchy.

Replace Component Opens the Part Replace dialog, from which you
can quickly replace a part with either an existing
part in your model or a part from an external file.
This option is only available in the LS-DYNA user
profile

Review Assemblies, Beamsection
collectors, Beamsection,
Blocks, Bodies,
Boxes, Components,
Configuration,
Constrained extra
nodes, Constrained rigid
bodies, Constraints,
Contact surfaces, Control
volumes, Crosssections,
Design variables, Design
variable links, Design
Objective Reference,
Design Variable
Property Relationship,
Elements, Groups,
Joints, Laminates,
Load collectors, Loads,
Loadsteps, Materials,
Mechanisms, Objectives,
Optimization constraints,
Optimization responses,
Output blocks, Part,
Part Assembly, Part
Set, Plies, Properties,
Regions, Seatbelts,
Sensors, Sets, System
collectors, Systems,
Vector collectors,
Vectors.

Invokes Review mode, which displays selected
entities irrespective of their display state, masked,
active state (Entity State Browser), but not
outside of the spherical clipping (if enabled).
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Option Available for: Description

Show All except Beam Section,
Curve, and Optimization
Entities

Displays the item in the graphics area. The item's
icon changes to bold indicating that the display
state is on. You can use the Show option on a
folder to display all items within a folder, for
example, all components.

Unrealize Laminates Unassigns properties previously assigned
to elements through the Realizefunction.
These properties are not deleted, but merely
disassociated from the elements.

Unused System, Property, Curve,
Material, Parameter,
Block, Box, Encriptions,
Features, Field, Rigion,
Contact Surf, Ply, Include
file, Set

Preview and delete unused property collectors,
material collectors, curves, and so on.

This operation can be performed on several entity
types at the same time. To append entity types to
the selection, left-click while pressing Control.

XRef Entities Assembly, Beam Section
Collector, Block, Box,
Card, Component,
ConstrainedExtraNode,
Contact, Contact Surface,
Control Volume, Cross
Section, Curve, Field,
Group, Include File,
Laminate, Load Collector,
Load Step, Material,
Multibody, Output
Block, Parameter, Plot,
Ply, Property, Region,
Rigid Wall, Sensor, Set,
System Collector, Table,
Transformation, Vector
Collector

Any single item or multiple items can be selected.
Opens the References Browser and displays
the relationship of the selected entities to other
entities in the model in a hierarchical tree
structure.
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Drape Estimator
Use the Drape Estimator to generate, directly into HyperMesh, draping angles and thickness variations
resulting from the manufacturing process of fibers associated with plies in a composite laminate.

You can use the drape data generated by this tool, based on inverse mapping, to improve the accuracy
of parts modeled with composite materials.

Note:  The Drape Estimator is available in the LS-DYNA, Nastran, OptiStruct and Radioss
user profiles.

Use the Drape Estimator

To open the Drape Estimator, right-click on a single ply or multiple plies in the Model Browser, and then
select Drape > Drape Estimator from the context menu.

Figure 428: The Drape Estimator is being used to generate drape data for all 11 plies in the model

Once the Drape Estimator has finished generating the drape data, HyperMesh creates a drape table for
each selected ply inside the Table folder in the Model Browser.

Figure 429: The Drape Estimator generated 11 drape tables for the 11 plies in the model
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Review and Edit Data Generated by the Drape Estimator

1. Review and edit the data generated by the Drape Estimator in the Entity Editor by selecting a
drape table in the Model Browser.

2.

Figure 430: Entity Editor is Activated for the P001_DrapeTabe

To review the drape data for this table, click .

The drape data available in this table include: DTYPE, DID, T, and THETA.

3. Modify this data by clicking a field and entering a new value.

Figure 431:
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Example: Drape Estimator

1. In the Model Browser, right-click on the Ply folder and select Edit from the context menu.

Figure 432:

2. In the Edit Ply dialog, select the Update system checkbox, and then activate the systems
selector.

3. Click Systems then enter 1 in the id= field.

Figure 433:

4. Click proceed.

5. Click Update.

6. From the 2D page, click composites.

7. Go to the material orientation subpanel and activate the elems selector.

8. In the elements select window, click displayed.

9. Click Systems then enter 1 in the id= field.

10. Click Assign.

11. Click Return.

12. In the Model Browser, right-click on the Ply folder and select Drape Estimator from the context
menu.
The Drape Estimator generates drape data for the 11 plies in the model.

13. From the menu bar, click File > Export > Solver Deck.

14. In the File field, navigate to your working directory and save the drape data.

15. Click Export.
HyperMesh creates a drape card of the data generated by the Drape Estimator and exports it to
the solver deck.
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Figure 434:
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Laminate Tool
Use the Laminate tool to calculate fiber angles and thickness changes with respect to an element
material system.

This tool creates a distribution table of drape angle changes, change the thickness of each ply, and
flatten the shape of a ply that needs to be fabricated before laying on the mold.

Fiber angle changes with respect to a material system when a flat composite sheet is laid on surfaces
of a part which is highly curved in bi-directions. This also changes the ply thickness. It is no longer
the nominal ply angle ( 0,45,-45, 90). If the change in angle or thickness is significant, it will lead to a
change in the stiffness of a part.

Note:  The Laminate tool is available in the OptiStruct and Abaqus user profiles.

1. Create a ply shape (elements) by realizing the plies.

Each ply must have elements associated with it. If it has been draped already, delete the Table
entity associated with that ply.

2. In the Model Browser, right-click on the ply/plies to be draped and select Drape > Laminate
Tools from the context menu.
The Laminate Tools Drape dialog opens.

3. In the Drape Calculation tab, define draping simulation settings.

a) Using the Application Point selector, select a node to indicate where the ply is first placed on
the surface.

b) Using the Reference Direction selector, select two nodes to indicate the reference direction
(zero degree ply direction).

The starting/initial ply angle is automatically determined based on this reference direction.

c) Using the Application Direction selector, select a vector to indicate how a ply is placed. If
this direction (vector) is not selected, the element normal will be used as the application
direction.

Figure 435:
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d) In the Implicit Step field, enter a draping step length.

The average element size at that point could be a good step size.

e) In the Max strain field, enter a value to color the drape lines.

If the % shear is above this value, yellow and red contours will start appearing on the drape
line, which indicates you may need to cut the fiber in order to relieve strain/wrinkling.

f) Click Apply.

4. In the Review tab, select a review option to read the results.

Option

Drape Lines

Description

Initially an unidirectional ply start with a 90 degree angle between
the weft and wrap lines. As the ply is draped over a curved surface,
this angle changes. If the shear is more than max strain, than the
color changes from blue to yellow to red.

Option Description

Figure 436:
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Flat Lines Review the flat ply shape that is needed to cover the surface.

Figure 437:

Drape Thickness Contour the distribution of thickness changes.

Figure 438:
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Drape Orientation
(shear)

Contour the shear (angle changes from 90 degrees).

Figure 439:

5. In the Export tab, export the flatten ply shape as geometry (STEP format).

The Flat ply shape can be exported one ply at a time as STEP geometry.

Figure 440:
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Part Replacement
Use the Part Replacement tool replace one or more parts with an existing part in your model or a part
from an external file.

In ANSYS, surface elements, if created on the component that is being replaced, will not be re-meshed
to match the new mesh. Also, for edge to edge contacts on shell components, if those shell components
are being replaced, then the contact edge surfaces will not be updated.

Note:  Only available for LS-DYNA, OptiStruct, Nastran, Radioss, PAM-CRASH 2G, Abaqus,
ANSYS, and all Engineering Solutions user profiles.

Single Part Replacement

1. From the Model Browser, right-click on the component to replace and select Replace > Manual
from the context menu.
The Part-Replace dialog opens and lists all possible entities affected by the part replacement.

2. In the Replace using field, select the replacement part.

• Choose Comp in Model to select a replacement part in the current model using the
Component selector.

• Choose Comp in File to identify the input file that contains the target, replacement part.

3. In the Tolerance field, enter a tolerance to search for closest nodes and elements to re-establish
the connections and other references between the target part and the model.

The default tolerance is set at 0.01.

Figure 441:
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4. Expand Advanced options to select advanced part replacement options.

Option

Copy existing component
card image to incoming
component

Merge Nodes on incoming
component boundary

Box Approach for Node Sets

Description

copy the element type card from the source to the component
that is being replaced.

Update node sets and/or boundary conditions when replacing a
mesh with a very fine mesh.

Note:  Available for OptiStruct, Nastran, ANSYS,
and Abaqus.

Option

Auto-Preserve the internal
connections

Tolerance (bounding box)
for connecting the 1D
elements from incoming file
to source components

Write log file

Description

Preserve internal connections automatically if there are not
connections present in the target file.

Bounding box used to equivalence free 1D elements from the
target file to the source components.

Write all operations related to the part replacement in a log file.

5. Click Preview to show the status of the reconnection of the target part to the model.

Tip:  If you change the tolerance, you can click Preview to re-examine the effect of
the change before accepting it.

Figure 442:

6. To display connections, click Check Nodes.

Connections are displayed in the Status column and in the graphics area.
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Figure 443:

In the graphics area, green connections are highlighted white and red connections are highlighted 
red.

Figure 444:

7. Adjust the tolerance for the target part as needed, then click Preview to see the status.

In the example below, the tolerance is changed to 5 and all of the connections are re-established.
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Figure 445:

Figure 446:
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8. After adjusting the tolerance, click Accept.
The source part is deleted and the connection of the new part to the model is accepted.

Note:  If the source part is connected by meshless welds, clicking Reject does not
restore the model and welds to their original state prior to the part-replace operation.
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Multicomponent Replacement
Multiple components and their corresponding entities can be replaced simultaneously using the Part
Replacement tool.

Multicomponent replacement enables you to quickly replace components with a different mesh, replace
components with a change in design, or replace components with a different design and internal
connections.

After part replacement has completed, if both the source and target have the same name, the Assembly
structure and Component names will be retained.

1. From the Model Browser, right-click on the components or Include file that contains the
components to replace and select Replace > Manual or Automatic from the context menu.

Note:  When replacing more than one component at a time, all selected components
should be organized in one Include file.

• Choose Manual to automatically pair components. You can manually change the component
pair and decide which entities to retain post replacement.

• Choose Automatic to automatically pair components based on the bounding box or collision
detection approach. You have no control over component pairing.

The Part-Replace dialog opens and lists all possible entities affected by the part replacement.

Figure 447:

2. In the Replace using field, select the replacement part.
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• Choose Comp in Model to select a replacement part in the current model using the
Component selector.

• Choose Comp in File to identify the input file that contains the target, replacement part.

3. In the Tolerance field, enter a tolerance to search for closest nodes and elements to re-establish
the connections and other references between the target part and the model.

The default Tolerance is set at 0.01.

4. Expand Advanced options to select advanced part replacement options.

Description

copy the element type card from the source to the component
that is being replaced.

Update node sets and/or boundary conditions when replacing a
mesh with a very fine mesh.

Note:  Available for OptiStruct, Nastran, ANSYS,
and Abaqus.

Option

Copy existing component
card image to incoming
component

Merge Nodes on incoming
component boundary

Box Approach for Node Sets

Tolerance (bounding box)
for connecting the 1D
elements from incoming file
to source components

Auto-Preserve the internal
connections

Write log file

Bounding box used to equivalence free 1D elements from the
target file to the source components.

Preserve internal connections automatically if there are not
connections present in the target file.

Write all operations related to the part replacement in a log file.

5. Optional: To preserve internal entities so that they will not be deleted after part replacement, in
the Preserve column, enable the checkbox.

Figure 448:
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6. Optional: External and internal preserved connections are preserved automatically during part
replacement. To move the absorbed connectors to the current Include file, click FeAbsorb.

7. Click Preview.

8. If you are manually replacing components in the Component Pairing dialog, modify the
component pairing and click OK.

a) In the Incoming field, select whether to remove the pairing, add a new pairing, select a new
pairing, or select to not replace the references.

b) Review, show (show all), isolate, or reset the components in the pair using the options in the
right-click context menu.

Figure 449:

9. In the Entities Selection dialog, specify replacement methods for incoming/existing entities and
click OK.

• Choose Accept incoming entities (existing entities deleted) to delete all of the internal
entities on accept.

• Choose Accept existing entities (Incoming entities deleted) to delete all of the incoming
entities on accept.

• Choose Merge existing and incoming entities (no entities deleted) to retain both
existing and incoming entities on accept.
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Figure 450:

10. Check the status of each entity.

Note:  All internal entities are deleted, and all external entities are updated.

Figure 451:

11. To display connections, click Check Nodes.

Connections are displayed in the Status column and in the graphics area. In the graphics area,
green connections are highlighted white and red connections are highlighted red.

12. Adjust the tolerance for the target part as needed, then click Preview to see the status.

13. To review the ID ranges of existing components, click ID Manager.
14. After adjusting the tolerance, click Accept.

The source part is deleted and the connection of the new part to the model is accepted.

Note:  If the source part is connected by meshless welds, clicking Reject does not
restore the model and welds to their original state prior to the part-replace operation.
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Move to Include Dialog
This dialog opens when you select Move To Include from the Model Browser context menu.

Figure 452: Move to Include Dialog

Several options allow you to specify the details of what is added to the include:

Move to
Use this drop down list box to either select one of the existing include files in the model, or create
a new one with the name New Include.

Create New
When entities like mass elements or nodal rigid bodies are moved to the new include as part
of selected self-contained entities, they may originate from different components. To help in

visualization functions such as Show or Hide, additional options help organize the selected entities
by creating new components or collectors to assign the moved entities to.
Choose Components to help in visualization for Show/Hide and similar functions when these
entities originate from different components, they need to be grouped together in an HyperMesh
component. This option creates new comps if only a portion of the content needs to be moved. A
new component is created with a prefix Partially isolate. You can use the checkboxes to determine
which types of entities will trigger the creation of a new component.
Choose Collectors to create new collectors if entities are being moved to the include. You can use
the checkboxes to determine which types of entities will trigger the creation of a new component.
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Avoid Moving
Use these options to address situations where the you may have a master include file for material
and load curves, and do not want some cards to be moved to the include along with their
associated entities.
Choose Material and their associate Load Curves to not move the materials to the new
include even if they are used only by the components being moved.
Choose Properties to not move property cards to the include.
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Organize Include Dialog
This dialog opens when you select Organize Include from the Model Browser context menu.

Figure 453: Organize Include Dialog

Use the following options to move selected entities into a new or existing include file.

Move To New Include File
Create a new Include File to move the selected entities into.

Move To Include File
Select an existing Include File from the list to move the selected entities into.

Move To Master

Move the selected entities into the Master Include File.
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Laminate Realize Dialog
Laminate realization is used for converting ply based models into zone based models and creating
properties for each zone.

The Laminate Realize dialog opens when you select Realize when right-clicking on a laminate in the
Model Browser.

Figure 454: Laminate Realize Dialog

There are several options available in the dialog:

Include drape
Currently only FiberSim CAD drape data is supported. CATIA –CPD drape data is not yet available.
The drape data is exported to OptiStruct, Abaqus and ANSYS solvers.

Orientation and Thickness Tolerance
When drape data is used from the CAD system, properties of each element can change from one
to the other. This may create many properties (one for each element). It is possible to reduce
the number of properties created by combining elements with similar properties with a given
tolerance. These two tolerances are used in the reduction of the number of properties.

Core sample validation
Many CAD systems provide core samples (simulating drilling and finding ply stacking sequences
at discrete points) to validate composite modeling. You can export this data from CAD systems
(mainly CATIA-CPD) and use it in HyperMesh to validate the zone property creation. Using
this option, HyperMesh compares the core sample property from a .csv file to the actual
zone property calculated at that specific location element. A report is also generated for the
comparison. Each core sample has a name, and HyperMesh automatically displays it as HM: tag at
that location. In order to view the tags, you need to activate tools/tag/label:body.

Rename properties
When activated, this option assigns the property name to match the core sample name.
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Configuring the Model Browser
Change the columns and entity types that display in the Model Browser and change browser options.

This dialog opens when you select the Configure Browser option from the Model Browser’s context 
menu.

Figure 455: Browser Configuration Dialog

Entities Tab
To select entity types to display in the Model View, activate the checkboxes next to each desired entity
type. A check mark indicates that the entity type will display in the browser. You can also use the select
all, select none, and select reverse buttons in this mode.

Options Tab
To control various behaviors within the Model Browser, use the following Global and Local options.

Global Options

Autofit
Automatically fits the selected entities to the graphics area whether using the context menu
or the Selector, Show/Hide, or Isolate functionality to control the display.

Autoscroll on selection
Automatically opens the folder in the Model Browser, highlights the selected entity in the
browser list, and then adjusts the browser list so that the highlighted entity is shown
automatically. This functionality is only available when you select an entity using the
Selector functionality in the graphics area. If the Autoscroll on selection option is not active,
then HyperMesh will continue to open the folders automatically and highlight the entity in
the browser list, however, the browser list will not adjust to show the selected entity.

Stripe background
Causes the browser tree to display a gray grid lines in the background, making it easier to
distinguish individual lines within the browser. When turned off, the browser background is
flat white.
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Local Options

Autocolor visualization mode
Change the graphics display based on the browser view mode you have selected. If Model
or Component View is selected, then the visualization mode will change to "By Comp". If
Material View is selected, then the visualization mode will change to "By Mat". If Property
View is selected, then the visualization mode will change to "By Prop". If the Autocolor
visualization mode is not active, then the visualization modes will not change automatically
when you are in a certain browser view, instead, you will have to manually change the
visualization mode from the Visualization toolbar.

Delete association
Open the Delete component(s) and unique associations dialog when Delete
Advanced is selected from the context menu. When this box is checked off, the Delete
component(s) and unique associations dialog does not open when Delete Advanced
is selected from the context menu, and the entities uniquely related to the selected
component are automatically deleted. Only available for components in the LS-DYNA user
profile.

Hide attached
Mask the attached elements from the graphics area when you perform the Hide functionality
on the following entities: loads, load collectors, load steps, groups and contact surfaces.
This could be observed if the elements are currently displayed. This will not alter the display
state to off, that is local display icon will not be Dimmed.

Show/hide/isolate Include files with Xref
Show, hide, isolate the contents of the Include files when you Show/Hide/Isolate the
Include file. If you turn this option off, Show/Hide/Isolate will only affect the components
and other HM entities that have graphics (vectors, systems, plies, laminates, loads) in the
Include file of the Model, Solver, and ID Manger browsers.

Show/Isolate/IsolateOnly attached
Bring the attached elements to the graphics area when you perform the Show/Isolate/
Isolate Only functionality on the following entities: loads, load collectors, load steps, groups
and contact surfaces. This could be observed if the elements are currently masked or the
elements belonging to the component's display state is off. This will also turn the local
display icon to Bold if the component is currently with the display state off.

Save view with mask

Command Buttons
Once you finish configuring the browser, click one of the command buttons to close the dialog:

• Click Apply to append the new settings without closing the window.

• Click OK to keep the new settings including those that are not applied and close the window.

• Click Cancel to discard the changes made that are not applied (keeping previous applied settings)
and close the window.
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Model Checker
Check the solver validity of the model, identify modeling issues, and fix modeling issues in an automatic
or manual way.

Using the Model Checker, you can manage the checks as per user requirements, by:

• Interactively creating/editing checks and corrections

• Changing the level of checks

• Organizing checks in custom folders

• Activating/deactivating checks

• Saving/reading Model Check configurations to/from an .xml file

The Model Checker can be accessed from the menu bar by selecting Tools > Model Checker. There
are two levels of checks available:

Elements
Check the quality of elements.

Solver
Check your model for errors and warnings.
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Create/Edit Checks and Corrections
Create new checks and corrections, and edit default checks and corrections.

HyperMesh supports default checks and corrections in the Model Checker. You can use the Check and
Correction entities to create new checks and corrections.

Create Checks

1. In the Model Checker, right-click on an existing check or one of the check folders (ERROR,
WARNING, INFO) and select Create Check from the context menu.
The Entity Editor opens and displays entity attributes corresponding to the check.

Figure 456:
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2. For Name, enter a name for the check.

3. For Config, select a configuration type.

4. Define attributes.

Note:  The attributes available are dependent on the type of Config selected.

Common attributes to define include:

Attribute

Check Entity

Folder

Level

Function Name

Auto Correction

Manual Correction

Description

Type of entity on which the check is applied.

Directory that contains the definition of the grouping or folder name
in which the check is located.

Type of check to perform: ERROR, WARNING, INFO.

Core check function to apply for the check. Core check function name
can be found in Entity Editor of existing checks.

Function to perform when automatically performing check correction.

Function to perform when manually performing check correction.

Default Correction Default automatic correction associated with the check. By default, 
the first chosen auto correction is considered the default value if you 
do not make a selection in this field.

When Config = TclCheck, define the following attributes:

Attribute

Tcl File

Description

External Tcl script to perform the desired check.

When Config = GenericCheck, define the following attributes:

Attribute Description

Number of references Numbers of references to be defined and exposed in the table entity
in which references must be defined.

Number of filters

Number of Value
definition

Number of filters to be defined and exposed in the table entity in
which filter rules must be defined.

Number of value definition to be defined and exposed in the table
entity in which value definition rules must be defined.
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Create Corrections

1. Create a Correction in the following ways:

• In the Model Checker, right-click and select Create Correction from the context menu.

• In the Entity Editor of a Check entity, right-click on a Correction attribute and select Create
from the context menu.

Supported Correction attributes include: Manual Correction, Auto Correction, Default
Correction.

If you created a Correction from the Model Checker, a new Correction opens in the Entity Editor,
and if you created a Correction from a Correction attribute in the Entity Editor, a new Correction
opens in the Create Modelcheckcorrections dialog.

Figure 457:

2. For Name, enter a name for the correction.

3. For Config, select a configuration type.

4. Define attributes.

Note:  The attributes available are dependent on the type of Config selected.

When Config = Automatic, define the following attributes:

Attribute

Tcl File

Function name

Correct value

Description

External Tcl script to perform the desired check.

Core check function to apply for the check. The core check function
name can be found in Entity Editor of existing corrections.

Value to be set when performing auto correction.

When Config = Manual, define the following attributes:

Attribute

Option

Description

Tool used to perform a manual correction.
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Organize Checks
Organize new and existing checks inside of a user-defined Check Folder.

By default, checks are organized into the ERROR, WARNING, and INFO. You can create your own folder
to organize checks in using the Check Folder entity.

ERROR
Checks with ERROR check-level, identifying modeling issues that need to be fixed to ensure the
model to be run by the solver.

WARNING

INFO

Checks with WARNING check-level, identifying modeling recommendations or solver warnings to
improve the quality of the model, but are not critical for the model to be run by the solver.

Generic information on the content of the model.

1. In the Model Checker, right-click and select Create Folder from the context menu.
A new Check Folder is created, and opens in the Entity Editor.

2. In the Name field, enter a folder name.

3. Organize checks inside the newly created Check Folder.

• Create new checks directly in this folder by right-clicking on the folder and selecting Create
Check from the context menu.

• Move existing checks by dragging-and-dropping selected checks into the folder.
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Configure Model Checker
Save configurations for future use, import existing configurations into your current HyperMesh session,
or append configurations on top of existing configurations.

• Save configurations.

a) In the white space of the Model Checker, right-click and select Save Config File from the
context menu.

b) In the Save dialog, specify a file name and directory to save the external .xml configuration
file and click Save.

• Add configurations.

a) In the white space of the Model Checker, right-click and select Add File from the context
menu.

b) In the Add Config File dialog, navigate to the configuration file to add and click Open.

• Import configurations.

a) In the white space of the Model Checker, right-click and select Load File from the context
menu.

b) In the Load Config File dialog, navigate to the configuration file to import and click Open.
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Run Model Check
Find all entities in your model that failed the active checks in the Model Checker.

1. Open the Model Checker.

2. In the Active Status column, select the checkbox of the checks to perform.

Only active checks will be considered.

3. Run checks.

• Run all active checks by right-clicking in the white-space of the Model Checker and selecting
Run from the context menu.

• Run all active checks in a Check Folder by right-clicking on the folder and selecting Run from
the context menu.

• Run a single check by right-clicking on a check and selecting Run from the context menu.

A list of failed checks display, along with the entities in your model that failed the check.

Figure 458:

4. Perform correction.

• Perform automatic correction by right-clicking on the failed check or failed entity and select
Apply Auto Correction from the context menu.

• Perform manual correction by right-clicking on the failed check or failed entity and select
Apply Manual Correction from the context menu.

5. Optional: Export a detailed report of the checks that were run by right-clicking in the white-space
of the Model Checker and selecting Export Results from the context menu.
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Tip:

• Filter the checks that are displayed by right-clicking in the white-space of the Model
Checker and selecting one of the following options from the context menu: Show only
run checks, Show only failed checks, Show only active checks, Show all checks.

• Show, hide, and isolate failed entities in the graphics area by right-clicking on the failed
entity and selecting Show, Hide, Isolate only from the context menu. In case of
element/node checks, this action will be perform on all failed entities associated with
the check.

• Cross reference failed entities by right-clicking on the failed entity and selecting XRef
Entites from the context menu.

• Review failed entities in the graphics area by right-clicking on the failed entity and
selecting Review from the context menu.

• View the failed nodes/elements in a new window provided the failed count is less
than threshold limit(default 1000) by right-clicking on the failed elements/nodes and
selecting View from the context menu.

• Delete selected entities or failed entities by right-clicking on the entity or check and
selecting Delete from the context menu.
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Supported Checks
Supported default checks organized by solver interface.

Abaqus

Errors

Name Description Result Auto correction
action

Manual
correction action

Property
card has NO
material card

Checks for properties
that are assigned to
components or elements,
but without a material
reference.

Lists all
properties
that have
no materials
defined.

Not supported. Opens the
Properties panel

Common
nodes of
RBodies

Checks if the rigid entities
have common nodes.

Lists all of the
rigid entities
with common
nodes.

Not supported. Opens the Rigid
Link Creation
panel.

Duplicate 1D
Elements

Checks if any 1D elements
share the same nodes in
the same order.

Lists the
duplicate 1D
elements.

Deletes the failing
elements.

Not supported.

Duplicate 2D
Elements

Checks if any 2D elements
share the same nodes in
the same order.

Lists the
duplicate 2D
elements.

Deletes the failing
elements.

Not supported.

Duplicate 3D
Elements

Checks if any 3D elements
share the same nodes in
the same order.

Lists the
duplicate 3D
elements.

Deletes the failing
elements.

Not supported.

Component
with solid and
shells

Checks if a component
consists of both solid and
shell elements.

Lists the failing
components.

Not supported. Opens the
Organize panel.
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Warnings

Name Description Result Auto correction
action

Manual
correction action

Negative
density

Checks if any materials
have negative density
defined.

Lists all of the
materials that
have negative
density.

Not supported. Opens the Card
Image panel.

Negative
Young's
Modulus

Checks if any materials
have negative Young's
Modulus defined.

Lists all
materials that
have negative
Young's Modulus

Not supported. Opens the Card
Image panel.

Negative
Poisson Ratio

Checks if any materials
have negative Poisson
Ratio defined.

Lists all
materials that
have negative
Poisson Ratio.

Not supported. Opens the Card
Image panel.

Poisson Ratio
greater than
0.5

Checks if the Poisson
Ratio value for any
material is greater than
0.5.

Lists all
materials that
have Poisson
Ratio greater
than 0.5.

Not supported. Opens the Card
Image panel.

Unused
materials

Checks for any materials
that are not referenced by
a property.

Lists the unused
materials.

Deletes the unused
materials.

Not supported.

Material
Elasticity is not
defined

Checks if Elasticity is
defined for the material.
This check is applicable
for only Isotropic Elastic
Material.

Lists materials
with no Young's
Modulus value.

Not supported. Opens the
Materials panel

Material
density is not
defined

Checks if density is
defined for the material.

Lists materials
with no density
value.

Not supported. Opens the
Materials panel.

Material
Piosson Ratio is
not defined

Checks if Piosson Ratio is
defined for the material.

Lists materials
with no Piosson
Ratio value.

Not supported. Opens the
Materials panel.

Material is
missing a card
image

Checks if the card image
is selected for material.

Lists materials
with no card
image.

Not supported. Opens the
Materials panel.
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Name Description Result Auto correction
action

Manual
correction action

Unused
properties

Checks for properties not
used in the model.

Lists the
properties that
are not used

Deletes the unused
properties.

Not supported.

Mass Property
having zero
mass

Checks for Mass elements
with zero mass value.

Lists all Mass
elements with
zero mass value

Not supported. Opens the Property
panel.

Free mass
elements

Checks for Mass elements
with no property.

Lists all Mass
elements with
no property.

Not supported. Opens the Property
Creation panel.

Empty
components

Checks for components
that do not contain
elements.

Lists the failing
components.

Deletes the empty
components.

Not supported.

Contact ghost
elements
have no base
elements

Checks if the contact
elements created for
interface have a base
element.

Lists all
interface
entities that
have a contact
element
without its base
element.

Not supported. Opens the
Interface panel,
Add page.

Empty Group
Surface

Checks if the surface in
the group has elements.

Lists surface
groups that are
empty.

Not supported. Opens the
Interface panel.

Unused Sets Checks if any sets are
unused.

Lists the unused
sets.

Deletes the empty
sets.

Not supported.

Empty sets Checks if the sets are
empty.

Lists the empty
sets.

Deletes the empty
sets.

Not supported.

Unused
systems

Checks if any systems in
the model are not used.

Lists the unused
systems.

Deletes the unused
systems.

Not supported.

Unused contact
surface

Checks if the contact
surface defined in the
model is unused.

Lists all
unused contact
surfaces.

Deletes unused
contact surfaces.

Not supported.

Checks if any beam
sections are unused.

Lists all the
unused beam
sections.

Deletes the unused
beam sections.

Not supported.
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Info

Name Description Result Auto correction
action

Manual
correction action

Number of
Material

Checks for the number
of material entities in the
model.

Lists all of the
materials.

Not supported. Not supported.

Number of
Properties

Checks for the number of
property entities.

Lists all of the
properties.

Not supported. Not supported.

Number of
Comps

Checks for the number of
component entities.

Lists all of the
components.

Not supported. Not supported.

Number of
Groups

Checks for the number of
group entities.

Lists all of the
groups.

Not supported. Not supported.

Number of
Sets

Checks for the number of
set entities in the model.

Lists all of the
steps in the
model.

Not supported. Not supported.

Number of
Steps

Checks for number of step
entities in the model.

Lists all of the
steps in the
model.

Not supported. Not supported.
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ANSYS

Errors

Name Description Result Auto
correction
action

Manual
correction
action

Remarks

Component
without
HM_COMP

Checks and flags
components that do
not have a HM_COMP
card image.

Lists the
components
that failed the
check.

Supported. Not Supported. The
HM_COMP
card image
should be
attached
to all
components
except those
that have
only RBE3
and RIGID.

Component
without ET
TYPE

Checks and flags
components that have
a card image, but do
not have a sensor
attached.

Lists the
components
that failed the
check.

Not Supported. Opens the Card
Image panel.

ET Type and
Element
config
mismatch

Checks and flags
components whose
ET Type does not
match with any of the
element types in the
component.

Lists the
components
that failed the
check.

Not Supported. Opens the Card
Image panel.

ET Type and
Real sets
or Sections

Checks and flags
components that have
a property type that
does not match the ET
Type. Targe169 and

Lists the
components
that failed the
check.

Not Supported. Opens the
Components
panel.

The
GENERAL
property
can be
attached to
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Name Description Result Auto
correction
action

Manual
correction
action

Remarks

are not
matching

targ170 components
can have a property
type of any of the
related contact types.

Checks and flags
components that have
an ET Type and section
that do not match.

componenets
that have
any ET Type.

Unpaired
contacts

Checks and flags
components of contact
elements which are
single. Components
are identified based on
the property attached
to them.

Lists the
components
that failed the
check.

Not Supported. Not Supported.

Mass
elements
without
property

Checks and flags
MASS21 and/or
MASS71 elements if
they have no property
attached or if the
attached property is
not of type MASS21p
or MASS71p, and if
the values related to
the mass elements are
zero.

Lists the
elements that
failed the
check.

Not Supported. Not Supported. It is
necessary
to define
at least
one of the
mass values
on the
property.

Improper
Entity Set
Names

Checks and flags
entity sets with a
name that is longer
than 32 characters,
contains special
characters other than
an underscore, or that
does not start with a
letter in the alphabet.

Lists the
entity sets
that failed the
check.

Renames the
set by removing
the special
characters,
reducing the
length of the
name to 32
characters, and/
or removing the
non alphabetic
characters from
the start of the
name.

Not Supported. Hypen
and space
are also
considered
special
characters.
The Model
Checker
currently
does not
check to see
if the name
already
exists.
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Name Description Result Auto
correction
action

Manual
correction
action

Remarks

Free Nodes Checks and flags
nodes that are not
connected to a valid
ANSYS element.

Lists the
nodes that
failed the
check.

Deletes the free
nodes.

Not Supported. RBE3,
CERIG,
and CP are
considered
equations by
ANSYS.

Free 1D
elements

Checks and flags 1D
elements that are
not attached to any
structural components.

Lists the
elements that
failed the
check.

Deletes the free
1D elements.

Not Supported.

Duplicate 1D
Elements

Checks and flags 1D
elements that are
connected between
the same two nodes

Lists the
elements that
failed the
check.

Deletes the
duplicate 1D
elements.

Not Supported. The order of
nodes does
not matter.

Duplicate 2D
Elements

Checks and flags 2D
elements that share
common nodes.

Lists the
elements that
failed the
check.

Deletes the
duplicate 2D
elements.

Not Supported.

Duplicate 3D
Elements

Checks and flags 3D
elements that share
common nodes.

Lists the
elements that
failed the
check.

Deletes the
duplicate 3D
elements.

Not Supported.

Pretension
elements
without third
node

Checks and flags
pretension elements
that do not have a
direction node.

Lists the
elements that
failed the
check.

Not Supported. Not Supported.

RBE3,
CERIG and
CP with free
nodes

Checks and flags the
RBE3, CERIG, and CPs
with free, independent
and dependent nodes.

Lists the
RBE3, CERIG
and CPs that
failed the
check.

Not Supported. Not Supported. The nodes
need to be
connected
to a valid
ANSYS
element.

Equation
with free
nodes

Checks and flags
equations that have
nodes which are
not connected to
elements. RBE3 and

Lists the
equations
that failed the
check.

Not Supported. Not Supported. The nodes
need to be
connected
to a valid
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Name Description Result Auto
correction
action

Manual
correction
action

Remarks

RIGIDS are considered
equations in ANSYS.

ANSYS
element.

Invalid pilot
node sets

Checks for pilot node
sets that have more
than one node.

Lists all pilot
node sets
that have
more than
one node.

Not Supported. Opens the
Entity Edit: Sets
dialog.

Invalid
contact
surfaces

Checks for contact
surfaces that have
mixed surfaces.

Cases of mixed
surfaces includes:

• Any shell edge +
any solid face

• First order shell
edge + second
order shell edge

• First order solid
face + second
order solid face

Lists all
contact
surfaces that
have mixed
surfaces.

Not Supported. Opens the
Entity Edit:
Contactsurfs
dialog.

Incomplete
contact pairs

Checks for contact
groups that have
one or more of the
following conditions:

• Missing both
contact and
target surface
attachments.

• Missing a contact
or target surface.

• Missing an ET
Type for either a
contact or target
surface.

• No property card
is assigned.

Lists all
contact
groups that
fail the check.

Not Supported. Opens the Entity
Edit: Groups
dialog.
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Name Description Result Auto
correction
action

Manual
correction
action

Remarks

Invalid
contact pairs

Checks for contact
pairs that have the
following:

1. There is a
mismatch of Et
Type (sensor)
and contact/
target surfaces,
and the correct
match of the
sensor and
contact/target
surface are in the
given below.

2. The Contact
sensor type and
property type in
the contact pair
are different.

3. The contact is a
solid face, and
the target is a
shell edge or vice
versa.

Lists all
contact pairs
that fail the
check.

Not Supported. Opens the Entity
Edit: Groups
dialog.
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Warnings

Name Description Result Auto
correction
action

Manual
correction
action

Remarks

Unused ET
Types

Checks and flags the
ET Types that are not
referenced by any
components.

Lists the ET
Types that
failed the
check.

Deletes the
unused ET
Types.

Not supported.

Unused
materials

Checks and flags the
materials that are not
referenced by any

Lists the
materials that
failed the
check.

Deletes
the unused
materials.

Not supported.

of the entities in the
model.

Material
without E

Checks and flags
materials if EX_FLAG,
EY_FLAG, or EZ_FLAG
is not activated, and
if at least one of the
array values is non
zero.

Lists the
materials that
failed the
check.

Not supported. Opens the Card
Image panel.

Material
without
density

Checks and
flags materials if
DENS_FLAG is not
activated, or if any of
the array values are
not assigned.

Lists the
materials that
failed the
check.

Not supported. Opens the Card
Image panel.

Unused
Real Sets
(properties)

Checks and flags the
properties that are
not referenced by any
of the entities in the
model.

Lists the
properties
that failed the
check.

Deletes
the unused
properties.

Not supported.
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Name Description Result Auto
correction
action

Manual
correction
action

Remarks

Shell
properties
or sections
without
thickness

Checks and flags
properties that have
the first thickness
as zero. If it is a
composite property,
then the first thickness
on each ply should be
greater than zero.

Checks and flags
shell sections that do
not have a thickness
assigned on any of the
plies.

Lists the
properties
and beam
sections that
failed the
check.

Not supported. Opens the Card
Image panel.

Mass
properties
without
mass

Checks for properties
with a mass card
image, but no mass.

Lists all
properties
with a mass
card image,
but no mass.

Not supported. Opens the Card
Image panel.

Empty
components

Checks and flags the
empty components.

Lists the
components
that failed the
check.

Deletes
the unused
components.

Not supported.

Component
with missing
material

Checks and flags the
components that do
not have a material
attached. This is
checked irrespective
of whether there is a
sensor attached to it
or not.

Lists the
components
that failed the
check.

Not supported. Opens the
Components
panel.

Empty sets Checks and flags
empty sets in the
model.

Lists the sets
that failed the
check.

Deletes the
unused sets.

Not supported.
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Name Description Result Auto
correction
action

Manual
correction
action

Remarks

Bar
Elements
with
improper
orientation

Checks and flags bar
elements with an
orientation vector that
is not perpendicular to
the z axes.

Lists the
elements that
failed the
check.

Not supported. Not supported. Bar
elements
in ANSYS
are created
so that the
beam's
y-axes is
parallel to
the global
XY-axes.

Unused
Sections

Checks and
flags sections
(beamsectcols) that
are not referenced by
any components.

Lists the
beamsectcols
that failed the
check.

Deletes
the unused
beamsectcols.

Not supported.

Unused
Contact
surfaces

Checks for contact
surfaces that are not
used in a contact pair.

Lists all
contact
surfaces that
are not used
in a contact
pair.

Deletes
unused contact
surfaces.

Opens the
Interfaces
panel.

Unused
Contact
masses

Checks for contact
mass node sets that
are not used in a
contact pair.

Lists all
contact mass
node sets
that are not
used in a
contact pair.

Deletes unused
contact masses

Opens the
Interfaces
panel.

Unused Pilot
nodes

Checks for pilot node
sets that are not used.

Lists all pilot
node sets
that are not
used.

Deletes unused
pilot nodes.

Opens the
Interfaces
panel.



Altair HyperMesh 2019 Users Guide
Browsers p.1208

Proprietary Information of Altair Engineering

Info

Name Description Result Auto correction
action

Manual
correction action

Components
without
property or
section

Checks and flags
components that have an
ET Type attached which
require, but do not have, a
property or section.

Lists the
components
that failed the
check.

Not supported. Not supported.

SOLVE
without /solu
card

Checks and flags SOLVE
cards to see if it is
activated without the /solu
card.

Lists the SOLVE
control card
that failed the
check.

Not supported. Not supported.

LSSOLVE
without /solu
card

Checks and flags the
LSSOLVE card to see if it is
activated without the /solu
card.

Lists the
LSSOLVE
control card
that failed the
check

Not supported. Not supported.

Properties
without card
image

Checks for properties that
do not have a card image
attached.

Lists all
properties that
do not have
a card image
attached.

Not supported. Not supported.

Empty Contact
Surfaces

Checks for contact
surfaces that do not

Lists all contact
surfaces that do
not contain a

Not supported. Not supported.

contain a single element
surface.

single element
surface.

Empty Contact
Masses

Checks for node sets that
have a contact mass card
image, but do not contain
nodes.

Lists all node
sets that have
a contact mass
card image, but
do not contain
nodes.

Not supported. Not supported.

Empty
PilotNode Set

Checks for node sets that
have a pilot node card
image, but do not contain
nodes.

Lists all node
sets that have
a pilot node
card image, but
do not contain
nodes.

Not supported. Not supported.



Altair HyperMesh 2019 Users Guide
Browsers p.1209

Proprietary Information of Altair Engineering

LS-DYNA

Errors

Name Description Result Auto correction
action

Manual
correction action

Id of material
out of bounds

Checks if there are any
material ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
materials with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.

Sigy and Eps
null in Matl24

Checks if SIGY is defined
on Mat_024. If not, it
checks to see if at least
one EPS value is defined
on it.

Lists all
MAT_024 with
zero SIGY
and zero EPS
values.

Not supported. Opens the Entity
Editor of the
material entity.

Id of property
out of bounds

Checks if there are any
property ids that are
either less than the
min_limit or more than the

List all of the
properties with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.

max_limit of allowable ids
in the ID Manager.

Pida or Pidb is
not defined for
Joint Stiffness

Checks if Pida and Pidb are
defined for joint stiffness.

Lists all joint
stiffness whose
PIDA/PIDB is
not defined.

Not supported. Opens the Entity
Editor of the
property entity.

Pida and Pidb
same in Joint
Stiffness

Checks if Pida and Pidb
are the same for joint
stiffness.

Lists all joint
stiffness whose
Pida/Pidb are
the same.

Not supported. Opens the Entity
Editor of the
property entity.

Parts with
non rigid
material in
Joint stiffness

Checks if both parts,
PIDA, and PIDB in Joint
Stiffness refer to the same
component.

Lists all Joint
stiffness
properties with
PIDA=PIDB.

Not supported. Opens the Entity
Editor of the
property entity.
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Id of element
out of bounds

Checks if there are any
element ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
elements with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.

Name Description Result Auto correction
action

Manual
correction action

Duplicate 1D
elements

Checks if two or more 1D
elements are connected
between the same nodes.

Lists all of the
duplicate 1D
elements.

Deletes failing
elements.

Not supported.

Duplicate 2D
elements

Checks if two or more 2D
elements are connected
between the same nodes.

Lists all of the
duplicate 2D
elements.

Deletes failing
elements.

Not supported.

Duplicate 3D
elements

Checks if two or more 3D
elements are connected
between the same nodes.

Lists all of the
duplicate 3D
elements.

Deletes failing
elements.

Not supported.

Element mass
with no mass

Checks if mass is defined
on the element_mass.

Lists all
element_mass
with zero mass.

Not supported. Opens the Entity
Editor for the
element.

Element mass
with no Node
id

Checks if element_mass is
defined on a proper node
ID.

Lists all
element_mass
with no node
ID.

Not supported. Opens the Entity
Editor for the
element.

Common
nodes of
RBodies

Checks if any keywords
that are mapped to rigids
share a common node.

Lists all all
of the rigid
elements that
share the same
node.

Not supported. Opens the Rigid
panel and updates
the page.

Rbody
connected to
MATL20

Checks if any node of
the component that
is associated with
MAT_RIGID is referred/
used by keywords mapped
rigids.

Lists all of the
rigid elements
that share
node(s) with
the components
associated with
MAT_RIGID.

Not supported. Opens the Rigid
panel and updates
the page.
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Name Description Result Auto correction
action

Manual
correction action

Rbody
xtranode -
common node

Checks if any keyword
mapped to rigids
in HyperMesh and
*CONSTRAINED_EXTRA_NO
defined in the model share *
a common node.

Lists all of
rigid elements
that share
DEnode(s) with
CONSTRAINED_EXTRA_NODE.

Not supported. Opens the Rigid
panel and updates
the page.

0 or 1 slave
nodes in
Constrained
nodal rigid
body

Checks if a
constrained_nodal_rigid_bodcy
has atleast one master
and slave defined.

Lists all
onstrained_nodal_rigid_body

that have one
or zero nodes.

Not supported. Opens the Rigid
panel.

Slavenodes
in other
Constrained
nodal rigid
bodies

Checks if constrained
nodal rigid bodies have
common slave nodes.

Lists all
constrained
nodal rigid
bodies that
have common
slave nodes.

Not supported. Opens the Rigid
panel.

Joint nodes
are non-
coincident

Checks if nodes
defined in any
*CONSTRAINED_JOINTS
that need to be coincident
are actually coincident in
the model.

Lists all of the
joint elements
whose node
definitions are
not coincident.

The nodes are
made coincident.

Not supported.

Gear joint
nodes 1-2
coincident

Checks if a gear joint's
node 1 and node 2 are
coincident.

Lists all gear
joints whose
node 1 and

Not supported. Opens the Joints
panel.

node 2 are
coincident.

Joint universal
1-3 and 2-4
not orthogonal

Checks if a segment
formed by nodes 1-3 and
2-4 are orthogonal for a
universal joint.

Lists all
universal
joints whose
segments are
not orthogonal.

Not supported. Opens the Joints
panel.



Altair HyperMesh 2019 Users Guide
Browsers p.1212

Proprietary Information of Altair Engineering

Name Description Result Auto correction
action

Manual
correction action

Joint nodes
not on rigid

Checks if nodes referred in
*CONSTRAINED_JOINTS
are not referred in
*CONSTRAINED_NODAL_RIGID_Bdefinitions ODY,
or
*CONSTRAINED_EXTRA_NO
or
*CONSTRAINED_NODE_SET
or in the component
that is associated with
MAT_RIGID.

Lists all joint
elements
whose node

are
not associated
DE,with rigids of
LS-DYNA.

Not supported. Opens the Fe joints
panel.

Negative or
zero volume of
solids

Checks if a solid has
volume associated with it.

Lists all of the
solid elements
with zero
or negative
volume.

Deletes failing
elements.

Not supported.

Id of
component out
of bounds

Checks if there are any
component ids that are
either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
components
with ids outside
of the limit.

Not supported. Opens the
Renumbers panel.

Component
has more than
one element
type

Checks if the component
has more than one unique
element type among shell,
solids, beam, discrete and
SPH.

Lists all
components in
the model that
have multiple
element types.

Not supported. Opens the
Organize panel.

Component
does not have
a part card

Checks if the components
defined in HyperMesh
are not assigned with
card image *PART or
*PART_COMPOSITE.

Lists all
components
that do not
have a card
image.

Not supported. Opens the
Components panel.
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Name Description Result Auto correction
action

Manual
correction action

Part has an
incorrect
property card

Checks if the components
with the card image *PART
are associated with the
correct properties based
on their elements content.

Lists all of the
components
that do not
have the correct
properties
associated to
them.

Not supported. Opens the
Components panel.

Part is not
defined with
a proper
material

Checks if the components
with card image *PART
are associated with the
correct material based on
their element content and
associated property.

Lists all
components
that do not
have the correct
materials
associated to
them.

Not supported. Opens the
Components panel.

No property
in Part or Part
composite

Checks if a property is
attached to a part or part
composite.

Lists all
components
with a card
image, but with
no property
attached.

Not supported. Opens the Entity
Editor of the
component entity.

No material
in Part or Part
composite

Checks if a material is
attached to a part or part
composite.

Lists all
components
with a card
image, but with
no material
attached.

Not supported. Opens the Entity
Editor of the
component entity.

Id of group out
of bounds

Checks if there are any
group ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
groups with ids
outside of the
limit.

Not supported. Opens the
Renumber panel.

Master set
not defined or
empty

Checks if there are any
interface entities defined
in the model that have a
valid master.

Lists all
interface
entities that
do not have
either a slave or
master defined.

Not supported. Opens the Entity
Editor of the
interface.
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Name Description Result Auto correction
action

Manual
correction action

Slave set not
defined or
empty

Checks if there are any
interface entities defined
in the model that have a
valid slave.

Lists all
interface
entities that
do not have
either a slave or
master defined.

Not supported. Takes user to the
interface EE.

Tied contacts:
Slave nodes in
master surface

Checks if the slave nodes
of tied contacts are also
present in its master.

Lists all of the
tied contacts
that have slave
nodes that are
also present its
master.

Not supported. Opens the
Interfaces panel.

Parts with non
rigid material
in Interface

Checks if the entities
of the group -
ContRigidSurface,
ConstRigidRbody,
RgdNodeToRgdBody, and
RgdBodyToRgdBody are
rigid entities.

Lists all of the
rigid groups
with non rigid
entities.

Not supported. Opens the Entity
Editor of the group
entity.

Xtranode Pid is
not defined

Checks whether the
component ID is
referred/assigned in the
*
keyword.

Lists all the
*CONSTRAINED_EXTRA_NODE
keywords that

CONSTRAINED_EXTRA_NODEdo not have
part referred in
them.

Not supported. Opens the
*CONSTRAINED_
EXTRA_NODE 
card image.

Nid or Nsid is
not defined for
Constrained
extra node

Checks if NID or NSID is
not defined on constrained
extra nodes.

Lists all of the
constrained
extra nodes that
do not have nid/
nsid defined.

Not supported. Opens the Entity
Editor of the
constrained extra
node entity.

Xtranode set is
not a node set

Checks if the set
referred/used in
*
is not a node set.

Lists all the
*CONSTRAINED_EXTRA_NODE

CONSTRAINED_EXTRA_NODE_SETkeywords that
are associated
with a set that
is not a node
set.

Not supported. Opens the add
page in the
Interface panel.
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Name Description Result Auto correction
action

Manual
correction action

Common
nodes in
Xtranode
entities

Checks if any

defined in the model share
a common node.

Lists all the
*CONSTRAINED_EXTRA_NODES*CONSTRAINED_EXTRA_NODES

that share
common
node(s).

Not supported. Opens the add
page in the
Interface panel

Xtranode
connected to
Matl20

Checks if any node
of a component
that is associated
with MAT_RIGID
is referred/used in
*CONSTRAINED_EXTRA_NODMEAST.

Lists all the
*CONSTRAINED_EXTRA_NODES
keywords
that share
node(s) with

_RIGID.

Not supported. Opens the add
page in the
Interface panel

Xtranode on
non-rigid part

Checks if the component
referred/used in

is not associated with
*MAT_RIGID.

Lists all the
*CONSTRAINED_EXTRA_NODES

*CONSTRAINED_EXTRA_NODEkeywords that
have part
referred in them
and are not
associated with
MAT_RIGID.

Not supported. Opens the
*CONSTRAINED_
EXTRA_NODE 
card image.

Constrained
rigid bodies
with empty
master or
slave

Checks if

has empty master/slave.

Lists all of the
*CONSTRAINED_RIGID_BODIES*CONSTRAINED_RIGID_BODIES

for master/slave
that are empty.

Not supported. Opens the
*CONSTRAINED_
RIGID_BODIES 
card image.

Id of load out
of bounds

Checks if there are any
load ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
loads with ids
outside of the
limit.

Not supported. Opens the
Renumber panel.

Boundary
prescribed
motion rigid
with non-rigid
part

Checks if

is defined on a rigid part.
boundary_prescribed_motion_rigidboundary_prescribed_motion_rigid

on a non rigid
part.

Lists all of the Not supported. Opens the Entity
Editor of the load
entity.

Id of load
collector out of
bounds

Checks if there are any
load collector ids that
are either less than the
min_limit or more than the

List all of the
load collectors
with ids outside
of the limit.

Not supported. Opens the
Renumber panel
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Name Description Result Auto correction
action

Manual
correction action

max_limit of allowable ids
in the ID Manager.

Parts with non
rigid material
in Load rigid
body

Checks if the
load_rigid_body is defined
on a rigid part.

Lists all of the
load_rigid_body
defined on non
rigid parts.

Not supported. Opens the Entity
Editor of the load
collector entity.

Initvel_Gen
part is not
defined

Checks if part ID is
not defined in the
*
keyword.

Lists the
*INITIAL_VELOCITY_GENERATION

INITIAL_VELOCITY_GENERAkeTIyOwNord where
part is not
defined.

Not supported. Opens the
*INITIAL_VELOCI
TY_GENERATION 
card image.

Initvel_Gen
part set is not
defined

Checks if parts set ID
is not defined in the
*
keyword.

Lists the
*INITIAL_VELOCITY_GENERATION

INITIAL_VELOCITY_GENERAkeTIyOwNord where
the part set is
not defined.

Not supported. Opens the
*INITIAL_VELOCI
TY_GENERATION 
card image.

InitVel nodeset
is empty

Checks if the nodeset
referred to in the
*INITIAL_VELOCITY
keyword is empty.

Lists the
*INITIAL_VELOCITY
keyword that is
associated with
an empty node
set.

Not supported. Opens the
*INITIAL_VELOCITY
card image.

Initvel_Gen
nodeset is
empty

Checks if the nodeset
referred to in the
*
keyword is empty.

Lists
*INITIAL_VELOCITY_GENERATION

INITIAL_VELOCITY_GENERAkeTIyOwNord that is
associated with
an empty node
set

Not supported. Opens the
*INITIAL_VELOCI
TY_GENERATION 
card image.

Initvel and
Initvel_Gen
in the same
model

Checks if both
INITIAL_VELOCITY and
INITIAL_VELOCITY_GENERATIandON
are defined

Lists
*INITIAL_VELOCITY

*INITIAL_VELOCITY_GENERATION
defined in the
model.

Deletes the entity. Not supported.

Spc set is not
a node set

Checks if the
set referred in
*BOUNDARY_SPC_NODE_SE
is not a node set.

Lists
*BOUNDARY_SPC_NODE_SET
kTeywords that
are associated
with a set that

Not supported. Opens the
*BOUNDARY_SPC
_NODE_SET card 
image.
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Name Description Result Auto correction
action

Manual
correction action

is not a node
set.

Lcid has not
been defined
for LoadBody

Checks if the curve is not
defined for the variable
LCID in *LOAD_BODY.

Lists all
*LOAD_BODY
keywords that
have no curve
defined for the
variable LCID.

Not supported. Opens the
*LOAD_BODY card
image.

Boundary
prescribed
accel rigid with
non-rigid part

Checks if a
BoundPresAccRigid load
collector is defined on a
rigid part.

Lists all
BoundPresAccRigid
load collectors
not defined on a
rigid part.

Not supported. Opens the Entity
Editor of the entity.

Constrained
rigid body
stopper with
non-rigid part

Checks if a constrained
rigid body stopper is
defined on a rigid part.

Lists all of the
constrained
rigid body
stoppers
defined on non
rigid part.

Not supported. Opens the Entity
Editor of the load
collector entity.

Parts with non
rigid material
in InitVel

Checks if initial velocity is
defined on a rigid part.

Lists all of the
initial velocities
that are not
defined on rigid
part.

Not supported. Opens the Entity
Editor of the load
collector entity.

Parts with non
rigid material
in Dform2Rigid

Checks if PID, PSID,
and MRB are defined on
Dform2Rigid rigid parts

Lists all of the
dform2rigids
whose pid, psid,
or MRB are non
rigid

Not supported. Opens the Entity
Editor of the load
collector entity.

Parts with
non rigid
material in
Dform2RgdInertia

Checks if PID is defined on
Dform2RgdInertia a rigid
parts.

Lists all of the
dform2rigidinertia
whose pid is
non rigid.

Not supported. Opens the Entity
Editor of the load
collector entity.

Id of curve out
of bounds

Checks if there are any
curve ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
curves with ids
outside of the
limit.

Not supported. Opens the
Renumbers panel.
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Name Description Result Auto correction
action

Manual
correction action

Repeated X
values in curve

Checks if any ordinate
values are repeated in
*DEFINE_CURVE keyword.

Lists all curves
defined in the
model that
have repeated
absicca.

Not supported. Opens the Curve
Editor.

Number of
curves not
same as one
defined by
table

Checks if the number of
curves on the table is
equal to the curve ids
defined on it.

Lists all of the
tables with
missing curve
ids.

Not supported. Opens the Entity
Editor of the curve
entity.

Id of set out of
bounds

Checks if there are any
set ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
sets with ids
outside of the
limit.

Not supported. Opens the
Renumbers panel.

NodeAdd set
is not referring
to node set

Checks if
*SET_NODE_ADD refers
to a set other than Node
sets.

Lists all of the
*SET_NODE_ADD
that refer to a
set other than
Node sets.

Not supported. Opens the Sets
panel.

Id of system
out of bounds

Checks if there are any
system ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
systems with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.

Id of system
collector out of
bounds

Checks if there are any
system collector ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of
the system
collectors with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.

Box boundary
not properly
defined

Checks if *DEFINE_BOX
or *DEFINE_BOX_LOCAL
have minimum X,Y, and
Z values larger than
maximum X, Y, and Z
values.

Lists all of the
*DEFINE_BOX;
*
with incorrect
definitions.

Switches the
minimum X, Y, and

DEFINE_BOX_LOZC AvLalues with the
maximum X, Y, and
Z values.

Opens the
corresponding
Block card image
panel.
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Name Description Result Auto correction
action

Manual
correction action

Box definition
with null
length

Checks if there is a length
defined for all three
directions of the box, that
is xmin!=xmax, and so on.

Lists all of the
boxes with a
null length.

Not supported. Opens the Entity
Editor of the block
entity.

Id of contact
surfaces out of
bounds

Checks if there are any
contact surface ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
contact surfaces
with ids outside
of the limit.

Not supported. Opens the
Renumbers panel.

Id of node out
of bounds

Checks if there are any
node ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
nodes with ids
outside of the
limit.

Not supported. Opens the
Renumbers panel.

Accelerometer
nodes are not
on a rigid

Checks if the nodes of
the accelerometer belong
to a part with MAT20,
*
SET, or
*CONSTRAINED_NODAL_RIGID_BODY.

Lists all
accelerometers
whose nodes

.CONSTRAINED_EXTRA_NODES_NODE/are not rigid

Not supported. Opens the Entity
Editor.

Accelerometer
nodes does
not define
system

Checks if the three nodes
of the accelerometer
defines a valid system,
that is they are not co-
incident or co-linear.

Lists all
accelerometer
which do not
define a valid
system.

Not supported. Opens the Entity
Editor.

Id of
beamsection
out of bounds

Checks if there are any
beam section ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
beam sections
with ids outside
of the limit.

Not supported. Opens the
Renumbers panel.

Id of
beamsection
collector out of
bounds

Checks if there are any
beam section collector ids
that are either less than
the min_limit or more than
the max_limit of allowable
ids in the ID Manager.

List all of the
beam section
collectors with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.
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Name Description Result Auto correction
action

Manual
correction action

Id of control
volumes out of
bounds

Checks if there are any
control volume ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
control volumes
with ids outside
of the limit.

Not supported. Opens the
Renumbers panel.

Invalid
chamber id
specified

Checks if an
*AIRBAG_PARTICLE,
*DEFINE_CPM_VENT, or
*DEFINE_CPM_GAS_PROPERTandIES
refer to a non-existing
chamber ID.

Lists all of the
*AIRBAG_PARTICLE,
*DEFINE_CPM_VENT,

*DEFINE_CPM_GAS_PROPERTIES
referring a
non-existing
chamber ID.

Not supported. Opens the
corresponding
control volumes
Card Image panel.

Parts with non
rigid material
in Airbag

Checks if an airbag is
defined on the rigid
material.

Lists all of the
airbags defined
on non rigid
parts.

Not supported. Opens the Entity
Editor of the
control volume
entity.

Sid is missing
for the airbag
definition

Checks if entities, that is,
SID are associated with
airbags.

Lists all of the
airbags with an
empty SID field.

Not supported. Opens the Entity
Editor of the
control volume
entity.

Id of
parameters
out of bounds

Checks if there are any
parameter ids that are
either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
paramters with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.

Id of output
blocks out of
bounds

Checks if there are any
output block ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
output blocks
with ids outside
of the limit.

Not supported. Opens the
Renumbers panel.

Id of cross
sections out of
bounds

Checks if there are any
cross section ids that
are either less than the
min_limit or more than the

List all of the
cross sections
with ids outside
of the limit.

Not supported. Opens the
Renumbers panel.
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Name Description Result Auto correction
action

Manual
correction action

max_limit of allowable ids
in the ID Manager.

Parts with
non rigid
material in
cross section

Checks if database cross
sections are defined
on rigid parts (the ID
attribute).

Lists all of the
database cross
sections defined
on non rigid
parts.

Not supported. Opens the Entity
Editor of the cross
section entity.

ID of rigidwalls
out of Bounds

Checks if there are any
rigidwall ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
rigids with ids
outside of the
limit.

Not supported. Opens the
Renumbers panel.

Id of
hourglasses
out of bounds

Checks if there are any
hourglass ids that are
either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
hourglasses
with ids outside
of the limit.

Not supported. Opens the
Renumbers panel.

Id of
pretensioners
out of bounds

Checks if there are any
pretensioner ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
pretensioner
with ids outside
of the limit.

Not supported. Opens the
Renumbers panel.

Seatbelt
sensors are
not defined for
pretensioners

Checks if a pretensioner
references any
*ELEMENT_SEATBELT_SENS

An error is
displayed a
ORS.pretensioner
references any
*ELEMENT_SEATBELT_SENSORS,
and lists
all failing
pretensioners.

Not supported. Opens the Entity
Editor of the
pretensioner entity.

Id of retractors
out of bounds

Checks if there are any
retractor ids that are
either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
retractors with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.
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Name Description Result Auto correction
action

Manual
correction action

Seatbelt
sensors are
not defined for
retractors

Checks if a retractor
references any
*ELEMENT_SEATBELT_SENSaO RreSt.

An error is
displayed

ractor
references any
*ELEMENT_SEATBELT_SENSORS,
and lists
all failing
retractors.

Not supported. Opens the Entity
Editor of the
retractor entity.

Id of sliprings
out of bounds

Checks if there are any
slipring ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
sliprings with
ids outside of
the limit.

Not supported. Opens the
Renumbers panel.

Curve x axis
values not
ascending

Check if the value of x axis
is not in ascending order

List all the
curves whose x
axis values are
not in ascending
order

Not supported Opens Curve Editor

CRB referring
to non rigid
part

If PIDM or PIDS in
Constrained Rigid Body
is assigned with non rigid
material

List all
Constrained
Rigid Body
referring to non
rigid part

Not supported Opens Curve Editor

Number
of curves
referred by
table should
be more than
1

Check if *DEFINE_TABLE
is referred with one or less
curves

List all
*DEFINE_TABLE
which have one
or less curves

Not supported Opens Entity Editor
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action
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correction action

Mat id exceeds
8 characters

Check if any material id
exceeds 8 characters.

List all of the
materials with

Not supported. Opens the
Renumbers panel.

Proprietary Information of Altair Engineering

ids greater than
8 digits.

Negative or
null density

Checks if any materials
have negative or zero
density defined.

Lists all
materials that
have negative
density.

Not supported. Opens the
corresponding
materials Card
Image panel.

Negative or
null young's
Modulus

Checks if any materials
have negative or zero
Young's Modulus defined;
also checks for EA, EB,
and EC values.

Lists all
materials that
have negative
Young's
Modulus.

Not supported. Opens the
corresponding
materials Card
Image panel.

Negative or
null Nu

Checks if any materials
have negative or zero
Poisson Ratio defined.

Lists all
materials that
have negative
poisson ratio.

Not supported. Opens the
corresponding
materials Card
Image panel.

Nu greater
than 0.5

Checks if any material is
having Nu greater than
0.5.

Lists all
materials in the
model that have
Nu greater than
0.5

Not supported. Opens the Material
panel.

Negative Lcss Checks if any elastic
plastic materials have
negative curve IDs that
describe its flow stress.

Lists all
materials that
have negative
curve IDs.

Not supported. Opens the
corresponding
materials Card
Image panel.

Unused
materials

Checks if any materials
are not referred/used in
any of the keywords.

Lists all unused
materials.

Deletes the
material.

Not supported.

Mat and
referenced
curves not in
same include

Checks if materials and
associated curves are in
the same include file.

Lists all of the
materials whose
curves are not
in same include.

Not supported. Opens the
Components panel.
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Name Description Result Auto correction
action

Manual
correction action

Material Ref
value not
compatible
with Initial
geometry

Checks if a material
has a Ref value
and corresponding
nodes presents in a
initial_foam_reference_geometry.

Lists all
materials with
a Ref value,
but no nodes
associated with
initial geometry.

Removes the
Ref value of the
material.

Not supported.
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Prop id
exceeds 8
characters

Check if any property id
exceeds 8 characters.

List all the
properties with
ids greater than
8 digits.

Not supported. Opens the
Renumbers panel.

Unused
properties

Checks if any
properties (*SECTION,
*HOURGLASS,*EOS,*INTEGERATION,*JOINTSTIFFNESS,
*DAMPING) are not used
in any of the keywords.

Lists all unused
properties.

Deletes the
property.

Not supported.

Property
assigned to
more than one
Part

Check if any property id is
defined in more than one
component.

List all of the
properties
assigned to
more than one
component.

Not supported. Opens the
Components panel.

Area is not
defined for
section beam

Checks if any section
beam property area is not
defined.

Lists all section
beam properties
that have an
area less than
or equal to zero.

Not supported. Opens the Property
panel.

ITT is not
defined for
section beam

Checks if any section
beam property ITT is not
defined.

Lists all section
beam properties
that have ITT
less than or
equal to zero.

Not supported. Opens the Property
panel.

ISS is not
defined for
section beam

Checks if any section
beam property ISS is not
defined.

Lists all section
beam properties
that have ISS
less than or
equal to zero.

Not supported. Opens the Property
panel.
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Name Description Result Auto correction
action

Manual
correction action

Section shell
thickness is
not defined

Checks if any section shell
property thickness is less
than or equal to zero.

Lists all section
shell properties
that have
thickness less
than or equal to
zero.

Not supported. Opens the Property
panel.

Thickness
Thic1s is not
defined

Check if any section beam
properties with ELFORM
1,4,5,7,8, 9, 11 have a

Lists all section
beam properties
that have
thickness

Not supported. Opens the Property
panel.
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thickness THIC1s less than
or equal to zero.

THIC1s less
than or equal to
zero.

Thickness
Thic2s is not
defined

Check if any section beam
properties with ELFORM
1,4,5,7,8, 9, 11 have a
thickness THIC2s less than
or equal to zero.

Lists all section
beam properties
that have
thickness
THIC2s less
than or equal to
zero.

Not supported. Opens the Property
panel.

Thickness
Thic1t is not
defined

Check if any section beam
properties with ELFORM
1,4,5,7,8, 9, 11 have a
thickness THIC1t less than
or equal to zero.

Lists all section
beam properties
that have
thickness
THIC1t less
than or equal to
zero.

Not supported. Opens the Property
panel.

Thickness
Thic2t is not
defined

Check if any section beam
properties with ELFORM
1,4,5,7,8, 9, 11 have a
thickness THIC2t less than
or equal to zero.

Lists all section
beam properties
that have
thickness
THIC2t less
than or equal to
zero.

Not supported. Opens the Property
panel.

Free 1D
elements

checks if 1D elements
in model are free, i.e.
elements whose nodes
are not connected to valid
entities.

lists out the 1D
elements whose
nodes are not
connected to
any FE or to
a constarined
extra node.

Not supported. Opens the Bars
panel
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Name Description Result Auto correction
action

Manual
correction action

Id of elems
greater than
authorized

Checks if element id is
greater than 8 characters.

Lists all of the
elements whose
id is greater
than 8 digits.

Not supported. Opens the
Renumbers panel.

Rigid body
has free slave
nodes

Checks if a rigid body has
slave nodes which are not
attached to any other FE
entity.

Lists all rigid
elements with
free slave
nodes.

Not supported. Opens the Rigids
panel.
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Rigid body
connected to
only one part

Checks if a rigid
bodies slave nodes are
connecting more than one
component.

Lists all rigid
bodies which
are connected
to only one
part.

Not supported. Opens the Delete
panel.

Beam: 3 nodes
aligned

Checks if the axis node
is along the orientation
direction for a beam
element.

Lists all beam
element with
an aligned 3rd
node.

Not supported. Opens the Bars
panel.

Incorrect
seatbelt
material

Checks if a seatbelt
element (2 and 4 noded)
is associated with a
seatbelt material.

Lists all seatbelt
elements not
associated
with a seatbelt
material.

Not supported. Opens the
Components panel.

Check
thickness
and Initial
shell stress of
element

Checks if an
element_shell_thickness
is associated with an
initial_shell_stress.

Lists all
element_shell_thickness
with no
initial_shell_stress
attribute.

Not supported. Opens the Entity
Editor for the
element.

Element and
component
not in same
include

Checks if an element and
its associated component
are in the same Include
file.

Lists all
elements of
components
that are not
in the same
Include file.

Not supported. Opens the
Organize panel.
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Name Description Result Auto correction
action

Manual
correction action

Constrained
nodal rigid
body and
nodes not in
same include

Checks if a
constrained_nodal_rigid_body
and its associated nodes
are in the same Include
file.

Lists all
constrained_nodal_rigid_body
whose nodes
are not in the
same Include
file.

Not supported. Opens the Entity
Editor for the
element.

Empty
components

Checks if any components
are empty (no Element
and no Geometry).

Lists all empty
components.

Deletes the
component.

Not supported.

Component
is referring
to undefined
entity

Checks for undefined
entities that are
referenced by
components.

Checks for
undefined
entities that are

Not supported. Opens the card
image for the
corresponding
component.
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referenced by
components.

Component
is referring
to unresolved
entity

Checks if an unresolved
property or material is
attached to a component.

Lists all
components
attached to
unresolved
properties or
materials.

Not supported. Opens the Entity
Editor for the
component.

Component
and property
have different
id

Checks if the component
has the same id as the
property attached to it.

Lists all of the
components
that fail the
criteria.

Not supported. Opens the Entity
Editor of the
component entity.

Component
and material
have different
id

Checks if the component
has the same id as the
material attached to it.

Lists all of the
components
that fail the
criteria.

Not supported. Opens the Entity
Editor of the
component entity.

Part inertia
Node id shared

Checks if the node id of
part_inertia is attached
to any other component
other than itself.

Lists all of the
part inertia
whose node
id is attached
to any other
component
other than
itself.

Not supported. Opens the Entity
Editor of the
component entity.
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Name Description Result Auto correction
action

Manual
correction action

Component,
material or
property not in
same include

Checks if the part,
material, and section
assigned to a component
are all in the same include
file.

Lists all of the
components
whose material
and property
are not in same
include.

Not supported. Opens the Entity
Editor of the
component entity.

Component
hourglass
not in same
include

Checks if the hourglass
assigned to a component
are all in the same include
file.

Lists all of the
components
whose
hourglass is not
in same include.

Not supported. Opens the Entity
Editor of the
component entity.

Slave nodes
in multiple
interfaces

Checks if the same node is
used as slave in more than
one *CONTACT entity.

Lists all
*CONTACT
entities that

Not supported. Opens the add
page in the
Interface panel.
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share the same
slave nodes.

Common
elements
within the
same Contact

Checks if the same
element is used within the
same contact.

Lists all
interface
entities that
have the same
element used
with the same
contact.

Not supported. Opens the
Interface panel.

Contact ghost
elements
have no base
elements

Checks if the contact
elements created for
interface have a base
element.

Lists all
interface
entities that
have a contact
element
without its base
element.

Not supported. Opens the add
page in the
Interface panel.

Duplicate
base elements
within contact

Checks if there is any
duplicate base element
within contact.

Lists all contacts
that have
duplicate base
elements.

Not supported. Opens the
Interfaces panel.

Un-Tied nodes
in Contact tied

Checks for un-tied nodes
in tied contact definitions.

Lists all contacts
that have
untied-nodes.

Not supported.

Option to
automatically
create un-tied node
sets.

Opens the card
image for the
corresponding
*CONTACT.
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Name Description Result Auto correction
action

Manual
correction action

Undefined
master or
slave in
Contact

Checks if a group contains
undefined entities.

Lists all groups
that reference
undefined
entities.

Not supported. Opens the Entity
Editor for the
entity.

Unresolved
master or
slave in
Contact

Checks if a group contains
unresolved entities.

Lists all groups
that contain
unresolved
entities.

Not supported. Opens the Entity
Editor for the
entity.

Friction not
well defined on
groups

Checks the static and
dynamic friction value
associated with groups.

Lists all groups
that have zero
fs or zero fd
values.

Not supported. Opens the Entity
Editor for the
entity.
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Boxes defined
but not
applicable

Checks if a group has a
slave and master box only
when Sstype and Mstype
is 2/3 correspondingly.

Lists all groups
that have
invalid box
definitions.

Removes invalid
boxes.

Opens the Entity
Editor for the
entity.

Groups,
referenced
Box or other
entities not in
same include

Checks if a slave and
master entities including
sboxid/mboxid are in the
same Include file as that
of the set.

Lists all sets
that have
master/slave
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Empty
Xtranode
entities

Checks for each
constrainedextranode
entity if:

• The PID field is
unspecified or the
specified component
is empty.

• The NID field is
unspecified.

• The NSID is
unspecified or the
specified set is empty.

Lists all
constrainedextran
entities that are
empty.

Deletes empty
coodnestrainedextranode
entities.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Master or
slave distance
greater than
100

Checks if the minimum
distance between master
and slave nodes of each
part of a constrained extra
node is greater than 100.

Lists all
constrained_extra_nodes
whose master
and slave nodes
are greater than
100.

You can change
the max
distance in the
config file.

Not supported. Not supported.

Pidm and
Pids distance
greater than
100

Checks if the minimum
distance between master
and slave nodes of each
part of a constrained rigid
body is greater than 100.

Lists all
constrained_rigid_bodies
whose master
and slave nodes
are greater than
100.

Not supported. Not supported.
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You can change
the max
distance in the
config file.

Multiple spcs
on a node

Checks if more than one
BOUNDARY_SPC are
defined on the same node.

Lists all
*BOUNDARY_SPC
that are defined
on the same
node.

Deletes selected
*BOUNDARY_SPC.

Not supported.

Common
node between
spcset and
node

Checks if the same
node is defined in
*BOUNDARY_SPC_NODE
and
*BOUNDARY_SPC_NODE_SE

Lists all
*BOUNDARY_SPC
that are
defined on the
T.same node as
*BOUNDARY_SPC_SET.

Not supported. Opens the Delete
panel to delete
*BOUNDARY_SPC
_NODE.

Different types
of thermal
load in model

Checks if a model
contains both
*LOAD_THERMAL_CONSTAN
and *
*LOAD_THERMAL_VARIABLE
thermal load types.

Checks if
a model
Tcontains both
LOAD_THERMAL_CONSTANT

and
*LOAD_THERMAL_VARIABLE
thermal load
types.

Deletes the
thermal load of the
second type.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Load node and
node not in
same include

Checks if the nodes of
the load_node and the
load_node are defined in
the same include file.

Lists all of
the loads of
load_node type
whose nodes
are not in same
include.

Not supported. Opens the Entity
Editor of the load
entity.

Boundary
prescribed
motion, comp,
curve not in
same include

Checks if a prescribed
motion load and its
components/curves are in
same include file.

Lists all
boundary
prescribed
motions whose
PID or curves
are not in same
include file.

Not supported. Opens the Entity
Editor of the load
entity.

InitVel_Gen
part set is
empty

Checks if the part
set associated with

Lists all
*INITIAL_VELOCITY_GENERATION

Not supported. Opens the
card image for
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Name Description Result Auto correction
action

Manual
correction action

*INITIAL_VELOCITY_GENERATION
is empty.

that have an
empty part set.

*INITIAL_VELOCITY_GEN
ERATION keyword.

InitVel or
InitVel_Gen
node set is not
defined

Checks if node set ID
is not defined in the
*INITIAL_VELOCITY or
*INITIAL_VELOCITY_GENERATION
keyword.

Lists
*INITIAL_VELOCITY_GENERATION
or
*INITIAL_VELOCITY
keywords
that do not
have nodesets
defined.

Not supported. Opens the
corresponding
*INITIAL_VELOCIT
Y
or
*INITIAL_VELOCIT
Y_GENERATION 
card image.

Initial velocity
set is not a
node set

Checks if the set
associated with
*INITIAL_VELOCITY is
node set.

Lists all
*INITIAL_VELOCITY
keywords that
have a set other
than node set
attached to it.

Not supported. Opens the
card image for
*INITIAL_VELOCITY
keyword.

InitVel or
InitVel_Gen
velocity is not
defined

Checks if the velocity
value is defined in
*INITIAL_VELOCITY or
*INITIAL_VELOCITY_GENERATION
keywords.

Lists all
*INITIAL_VELOCITY
keywords that
have no velocity
defined.

Not supported. Opens the
card image for
*INITIAL_VELOCITY
or

Part set has
not been
defined for
LoadBodyPart

Checks if the part set
is referred to in the
*LOAD_BODY_PARTS
keyword.

Lists all
*LOAD_BODY_PARTS
keywords that
do not have a
part referred to
them.

Not supported.

INITIAL_VELOCITY_GE
NERATION keyword.

Opens the
card image for
*LOAD_BODY_PARTS
keyword.

Boundary
prescribed
accel rigid,
comp not in
same include

Checks if
BoundPresAccRigid and its
associated component are
in the same include file.

Lists all
boundary_prescribed
loadcols whose
component is
not in same
include file.

Not supported. Opens the Entity
Editor of the load
collector entity.

Load gravity,
part or set
not in same
include

Checks if the loadcollector
LOAD_GRAVITY and its
associated part or set
are defined in the same
include file.

Lists all
load_gravity
whose part/
set is not in the
same include.

Not supported. Opens the Entity
Editor of the load
collector entity.
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Name Description Result Auto correction
action

Manual
correction action

Load node set
and set not in
same include

Checks if the loadcollector
LOAD_NODE_SET and its
associated set are defined
in the same include file.

Lists all
load_node_set
whose set is
not in the same
include.

Not supported. Opens the Entity
Editor of the load
collector entity.

Unused curves Checks if the curves
defined model are used/
referred to in other
keywords.

Lists all
unused curves
*DEFINE_CURVE
in the model.

Deletes unused
curves.

Not supported.

Duplicate
value in define
table

Checks if curve IDs on a
table are repeated.

Lists all tables
that have
repeated curve
IDs.

Not supported. Opens the Entity
Editor for the
curve.

Table and
curve not in
same include

Checks if tables and
curves defined on it are in
the same include file.

Lists all tables
whose curves
are not in the
same include
file.

Not supported. Opens the Entity
Editor of the curve
entity.

Set with more
than 100 rows

Checks if a set has
more than 100 rows of
data. The max length
is customizable in the
third row of the config
file. Currently if it is a
formula, then it checks
for the number of formula
clauses. The set doesn't
expand even though it is
expanded in card edit.

Lists all sets
with more than
100 rows.

Not supported. Not supported.

Unused sets Checks if the sets defined
model are used/referred
to in other keywords or in
others sets.

Lists all unused
sets.

Deletes unused
sets.

Not supported.

Empty sets Checks if any sets defined
in the model are empty.

Lists all empty
sets.

Deletes empty
sets.

Not supported.

Sets with no
finite elements
or nodes

Checks if a set contains
valid finite elements/
nodes.

Lists all sets
that do not
contain valid fe
entities, such

Not supported. Opens the Entity
Editor of the entity.
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Name Description Result Auto correction
action

Manual
correction action

Sets listed under "Empty
Sets" are not reported.

as elements or
nodes.

Entity set is
referring to
undefined
entity

Checks if a set references
undefined entities.

Lists all sets
that contain
undefined
entities.

Not supported. Opens the Entity
Editor of the entity.

Entity set is
referring to
unresolved
entity

Checks for unresolved
entities that are
referenced by sets.

Lists all sets
that reference
unresolved
entities.

Not supported. Opens the card
image for the
corresponding set.

Orphan child
set collect

Checks for set collects that
are not referenced by a
master set collect.

Lists all orphan
child set
collects.

Not supported. Opens the Set
panel.

Child set
collect referred
in entities
other than
master

Checks for set collects that
are referenced by entities
other than master set
collects.

Lists all child set
collects that are
referenced by
other entities.

Not supported. Opens the Set
panel.

Set node and
referenced
entities not in
same include

Checks if a set_node
and its associated nodes
or sets are in the same
Include file.

Lists all
set_node whose
nodes/node sets
are not in same
Include file.

Not supported. Opens the Entity
Editor for the Set
entity.

Set part and
referenced
entities not in
same include

Checks if set_part and its
associated components
or sets are in the same
include file.

Lists all
set_part whose
components/
part sets are
not in same
include file.

Not supported. Opens the Entity
Editor of the set
entity.

Unused
systems

Checks if any system
defined in the model is
unused/not referred to in
other keywords.

Lists all unused
systems.

Deletes unused
systems.

Not supported.

Systems with
axis badly
defined

Checks if system axes are
defined correctly.

Lists all systems
with badly
defined axes.

Not supported. Opens the Systems
panel and Update
page.
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Name Description Result Auto correction
action

Manual
correction action

Define
coordinate
nodes and
nodes not in
same include

Checks if the system and
nodes forming the axes
are in the same include
file.

Lists all
define_corodinate_nodes
whose nodes
are not in same
include file.

Not supported. Opens the Entity
Editor of the
system entity.

Define
coordinate
vector and
nodes not in
same include

Checks if
DEFINE_CORDINATE_VECTOR
and optional nodal point
NID are in the same
include file.

Lists all
define_corodinate_vector
whose nodes
are not in same
include file.

Not supported. Opens the Entity
Editor of the
system entity.

Unused blocks Checks if the blocks
(*DEFINE_BOX) defined
in the model are unused /
not referred to in other
keywords.

Lists all unused
blocks.

Deletes unused
blocks

Not supported.

Unused
contact
surface

Checks if the contact
surface (*set_segment)
defined in the model is
unused /not referred to in
other keywords.

Lists all
unused contact
surfaces.

Deletes unused
contact surfaces.

Not supported.

Id of node
greater than
authorized

Checks if id of node is
greater than 8 characters.

Lists all nodes
with ids greater
than 8 digits.

Not supported. Opens the
Renumbers panel.

Free nodes in
the model

Checks if the nodes in the
model are free (not used
by any elements).

Lists free nodes. Deletes free nodes. Not supported.

Accelerometer
and referenced
entities not in
same include

Checks if an accelerometer
and its nodes are in the
same Include file.

Lists all
accelerometers
whose
referenced
entities are not
in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Unused
beamsections

Checks if any Beamsection
defined in the model is
unused.

Lists all unused
Beamsections in
the model.

Delete unused
beamsections.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Airbag and
referenced
entities not in
same include

Checks if an airbag and its
referenced entities are in
the same include file.

Lists all
airbag control
volumes whose
referenced
entities are not
in same include
file.

Not supported. Opens the
corresponding
controlvols EE.

Initial foam
reference
geometry and
nodes not in
same include

Checks if
intial_foam_reference_geometry
and its associated nodes
are in the same include
file.

Lists all
initial_foam_reference_geometry
whose nodes
are not in the
same include
file.

Not supported. Opens the
corresponding
controlvols EE.

Incompatible
Material

Checks if
initial_foam_reference_geometry
nodes are present in the
component associated
with the mat with ref
value.

Lists all
initial_foam_ref_geometry
whose nodes
are not present
in the material
with ref value.

Not supported. Opens the Comps
panel.

Unused
parameters

Checks if there are unused
parameters in the model.

Lists all
parameters
which are not
referenced by
any other entity.

Deletes unused
parameters.

Not supported.

Duplicate
parameter
names in
model

Checks if there are two or
more parameters with the
same name in the model.

Lists all
parameters that
have duplicate
names.

Not supported. Opens the Entity
Editor for the
parameter entity.

Database cross
section, part
or set not in
same include

Checks if a part, set, or
system of a database
cross section are in the
same Include file as the
cross section.

Lists all
database_cross_sections
whose part, set,
or system are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the cross
section entity.

Rigidwall Set
or Box not in
same Include

Checks if the set and box
of a rigid wall are in the
same Include file as the
rigid wall.

Lists all rigid
walls whose
referenced
entities are not

Not supported. Opens the Entity
Editor for the
entity.
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Name Description Result Auto correction
action

Manual
correction action

in the same
Include file.

Rigidwall is
referring to
undefined
entity

Checks if a rigidwall
references undefined
entities.

Lists all
rigidwalls
that contain
undefined
entities.

Not supported. Opens the Entity
Editor of the entity.

Rigidwall is
referring to
unresolved
entity

Checks for unresolved
entities that are
referenced by rigidwalls.

Lists all
rigidwalls that
reference
unresolved
entities.

Not supported. Opens the Entity
Editor of the entity.

Unused
hourglasses

Checks if there are unused
hourglasses in the model.

Lists all
hourglasses
which are not
referenced by
any other entity.

Deletes unused
hourglasses.

Not supported.

Pretensioner
is referring
to unresolved
entity

Checks if a pretensioner
references unresolved
entities.

Lists all
pretensioners
that contain
unresolved
entities.

Not supported. Opens the Entity
Editor of the entity.

Pretensioner
and referenced
entities not in
same include

Checks if a pretensioner
and its referenced entities
are in the same Include
file.

Lists all
pretensioners
whose
referenced
entities are not
in the same
Include file.

Not supported. Opens the Entity
Editor of the entity.

Retractor is
referring to
unresolved
entity

Checks if a retractor
references unresolved
entities.

Lists all
retractors
that contain
unresolved
entities.

Not supported. Opens the Entity
Editor of the entity.

Retractor and
referenced
entities not in
same include

Checks if a retractor and
its referenced entities are
in the same Include file.

Lists all
retractorw
whose
referenced
entities are not

Not supported. Opens the Entity
Editor of the entity.
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Name Description Result Auto correction
action

Manual
correction action

in the same
Include file.

Slipring is
referring to
unresolved
entity

Checks if a slipring
references unresolved
entities.

Lists all sliprings
that contain
unresolved
entities.

Not supported. Opens the Entity
Editor of the entity.

Slipring and
referenced
entities not in
same include

Checks if a slipring and its
referenced entities are in
the same Include file.

Lists all
sliprings whose
referenced
entities are not
in the same
Include file.

Not supported. Opens the Entity
Editor of the entity.

Translational
mass is zero
in Constrained
nodal rigid
body interia

Check if TM value is zero
in Constrained nodal rigid
body interia

List all the
Constrained
nodal rigid body
interia with
TM=0

Not supported Opens Entity Editor

Translational
mass is zero in
Part inertia

Check if TM value is zero
in Part Inertia

List all the Part
Inertia with
TM=0

Not supported Opens Entity Editor

Translational
mass is zero in
Deformable to
rigid inertia

Check if TM value is zero
in Deformable to rigid
inertia

List all the
Deformable
to rigid inertia
TM=0

Not supported Opens Entity Editor

PID and
MID of hex
spotweld
assembly
shared with
hex spotweld

Supported to
create separate
assembly

Not Supported

Scale factor is
zero for define
curve feedback

Not supported Opens Entity Editor

Scale factor is
zero for curves

Not supported Opens Entity Editor
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Name Description Result Auto correction
action

Manual
correction action

Scale factor is
zero for define
table

Check if SFA=0 for
*DEFINE_TABLE,
*DEFINE_TABLE_2D &
*DEFINE_TABLE_3D

List the tables
whose SFA
value is zero

Not supported Opens Entity Editor

Table rate
is not in
ascending
order

Check if input in VALUE
fields are not in ascending
order

List the tables
where input in
VALUE is not in
ascending order

Not supported Opens Entity Editor

Last X-
Axis point
doesnt match
with control
termination

Check the curves whose
X-Axis end value is not
equal to ENDTIM value in
*TERMINATION_TIME

List the curves
whose X-Axis
end value is
not equal to
ENDTIM value in
*TERMINATION_TIME

Not supported Opens Curve Editor

DB history
with repeated
entities

DB history and
referenced
entities not in
same include

No db history
defined on
node N1 of
accelerometer

Info

Name Description Result Auto correction
action

Manual
correction action

Number
of defined
materials

Checks for the number of
defined materials.

Lists all defined
materials.

Not supported. Not supported.

Number of
undefined
materials

Checks for the number of
undefined materials.

Lists all
undefined
materials.

Not supported. Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Number
of defined
properties

Checks for the number of
defined properties.

Lists all defined
properties.

Not supported. Not supported.

Number of
undefined
properties

Checks for the number of
undefined properties.

Lists all
undefined
properties.

Not supported. Not supported.

Number of
Components

Checks for the number of
components.

Lists all
components.

Not supported. Not supported.

Number of
groups

Checks for the number of
groups.

Lists all groups. Not supported. Not supported.

Number of
defined curves

Checks for the number of
defined curves.

Lists all defined
curves.

Not supported. Not supported.

Number of
undefined
curves

Checks for the number of
undefined curves.

Lists all
undefined
curves.

Not supported. Not supported.

Number of
defined sets

Checks for the number of
defined sets.

Lists all defined
sets.

Not supported. Not supported.

Number of
undefined sets

Checks for the number of
undefined sets.

Lists all
undefined sets.

Not supported. Not supported.

Number of
output blocks

Checks for the number of
output blocks.

Lists all output
blocks.

Not supported. Not supported.

Number
of defined
hourglasses

Check for number of
defined HM hourglass
entities in the model.

List all defined
hourglasses.

Not supported. Not supported.

Number of
undefined
hourglasses

Check for number of
undefined hourglass
entities in the model.

List all
undefined HM

Not supported. Not supported.
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Name Description Result Auto correction
action

Manual
correction action

hourglass in the
model

Nastran

Errors

Name Description Result Auto correction
action

Manual
correction action

Material ID
exceeds 8
characters

HyperMesh does not
write out more than eight
characters for IDs, so if
you have more HyperMesh
will write out ***, which
fails the solver. This check
is disabled when using a
long format template.

Lists the failing
materials.

Not supported. Opens the
Renumber panel.

Property
is missing
material

Checks for properties
without a material
reference.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

Property ID
exceeds 8
characters

HyperMesh does not
write out more than eight
characters for IDs, so if
you have more HyperMesh
will write out ***, which
fails the solver. This check
is disabled when using a
long format template.

Lists the failing
properties

Not supported. Opens the
Renumber panel.

Property with
zero cross
section area

Checks if the area of
properties PBEAM, PBAR
and PROD is less than or
equal to zero.

Lists the failing
properties.

Not supported. Opens the Property
panel.

Component
with solids and
shells

Checks if a component
consists of both solid and
shell elements.

Lists the failing
components.

Not supported. Opens the
Organize panel.
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Name Description Result Auto correction
action

Manual
correction action

Node ID
exceeds 8
character

HyperMesh does not
write out more than eight
characters for IDs, so if
you have more HyperMesh
will write out ***, which
fails the solver. This check
is disabled when using a
long format template.

Lists the failing
nodes.

Not supported. Opens the
Renumber panel.

Element ID
exceeds 8
characters

HyperMesh does not
write out more than eight
characters for IDs, so if
you have more HyperMesh
will write out ***, which
fails the solver. This check
is disabled when using a
long format template.

Lists the failing
elements.

Not supported. Opens the
Renumber panel.

Free 1D
elements

Checks for 1D elements
that have one or more
connection missing. This
check does not include
RBE2 or RBE3 elements.

Lists the failing
elements.

Deletes the failing
1D elements.

Not supported.

RBE2 with
constrained
dependent
nodes

Checks for RBE2 with
constraints on dependent
nodes.

Lists the failing
elements.

Not supported. Opens the Rigids
panel.

Free Rigid
elements

Checks for RBE2 elements
that have one or more
connection missing,
typically a leg that is
missing a connection.

Lists the failing
elements.

Deletes the free
arms of the Rigid.

Not supported.

Free RBE3
elements

Checks for RBE3 elements
that have one or more
connection missing,
typically a leg that is
missing a connection or
an independent node
that is not connected to
structure.

Lists the failing
elements.

Deletes the free
arms of RBE3.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

RBE3 elements
are collinear

Checks if the dependent
and independent nodes
of an RBE3 element are
collinear.

Lists the failing
elements.

Deletes the failing
RBE3 elements.

Not supported.

RBE3 dof
connected to
solid

Checks for rotational DOFs
on independent nodes of
an RBE3 connected to a
solid element.

Lists the failing
elements.

Removes rotational
DOFs from affected
independent grids
of failing RBE3
elements.

Not supported.

Zero-length
CBUSH without
CID

Checks if the CBUSH
spring element of zero
length has the element
coordinate system, CID
defined.

Lists the failing
elements.

Not supported. Opens the Springs
panel.

Elements have
a dependency

Checks for rigid elements
that share dependent
nodes with other rigid
elements.

Lists the failing
elements.

Deletes the failing
rigid elements.

Not supported.

Element has
rigid loops

Checks for rigid elements
that form a closed loop;
where the dependent node
of one rigid serves as
independent node of the
next rigid in the loop.

Lists the failing
elements.

Deletes the failing
rigid elements.

Not supported.

Duplicate 1D
Elements

Checks if any 1D elements
share the same nodes in
the same order.

Lists the
duplicate 1D
elements.

Deletes the failing
elements.

Not supported.

Duplicate 2D
Elements

Checks if any 2D elements
share the same nodes in
the same order.

Lists the
duplicate 2D
elements.

Deletes the failing
elements.

Not supported.

Duplicate 3D
Elements

Checks if any 3D elements
share the same nodes in
the same order.

Lists the
duplicate 3D
elements.

Deletes the failing
elements.

Not supported.

NSM field not
defined

Checks for invalid or
missing entries on
NSMADD loadcols.

Lists the failing
loadcols.

Not supported. Opens the Loadcols
panel
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Name Description Result Auto correction
action

Manual
correction action

MPC with free
independent
nodes

Checks for MPC equations
with free independent
nodes.

Lists the failing
equations.

Updates the MPC
by removing the
free independent
node.

Not supported.

Warnings

Name Description Result Auto correction
action

Manual
correction action

Unused
materials

Checks for any materials
that are not referenced by
a property.

Lists the failing
materials.

Deletes unused
materials.

Not supported.

Material E is
not defined

Checks if E of MAT1 or
MAT8 is less than or equal
to zero.

Lists the failing
materials.

Not supported. Opens the
Materials panel.

Material Rho is
not defined

Checks if the Rho of MAT1,
MAT2,MAT4 ,MAT5, MAT8,
MAT9, MAT10,MATHE and
MATHP is less than or
equal to zero.

Lists the failing
materials.

Not supported. Opens the
Materials panel.

Material Nu is
zero

Checks if the Nu of MAT1
and MAT8 is equal to zero.

Lists the failing
materials.

Not supported. Opens the
Materials panel.

Material is
missing a card
image

Checks for defined
materials with no card
image.

Lists the failing
materials.

Not supported. Opens the
Materials panel.

Unused
properties

Checks for properties
that are not assigned to a
component or element.

Lists the failing
properties.

Deletes unused
properties.

Not supported.

Property is
missing a card
image

Checks for defined
properties with no card
image.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

PSHELL
thickness is
not defined

Checks if the property
PSHELL thickness is less
than or equal to zero.

Lists the failing
properties.

Not supported. Opens the
Properties panel.
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Name Description Result Auto correction
action

Manual
correction action

PSHELL and
PSHLN1 with
different MID

Checks if the property
PSHELL has a different
material defined for
PSHELL and PSHLN1.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

PCOMP
thickness is
not defined

Checks if the first
thickness value of Property
PCOMP array is less than
or equal to zero. The
first thickness value is
mandatory.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

1D Prop
beamsection
mismatch

Checks if the 1D property
and the beam section
attached to it have the
same area and area
moments of inertia. A
difference greater than
0.01 will fail the check.

Lists the failing
properties.

Disassociates the
beam section from
the 1D property.

Not supported.

Empty
components

Checks for components
that do not contain
elements.

Lists the failing
components.

Deletes the empty
components.

Not supported.

Empty
assemblies

Checks if assemblies are
empty.

Lists the empty
assemblies.

Deletes empty
assemblies.

Not supported.

Empty sets Checks if sets are empty. Lists empty
sets.

Deletes empty
sets.

Not supported.

Empty contact
surfaces

Checks if contact surfaces
are empty.

Lists empty
contact
surfaces.

Deletes empty
contact surfaces.

Not supported.

Empty groups Checks if groups are
empty.

Lists empty
groups.

Deletes empty
groups.

Not supported.

Empty plys Checks if plys are empty. Lists empty
plys.

Deletes empty
plys.

Not supported.

Empty load
collectors

Checks if load collectors
are empty.

Lists empty load
collectors.

Deletes empty load
collectors.

Not supported.

Empty vector
collectors

Checks if vector collectors
are empty.

Lists empty
vector
collectors.

Deletes empty
vector collectors.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Empty
laminates

Checks if laminates are
not having any ply.

Lists empty
laminates.

Deletes empty
laminates.

Not supported.

CONM1 with
zero diagonal
mass matrix
values

Checks if the diagonal
mass matrix values of
CONM1 are less than or
equal to zero.

Lists the failing
CONM1.

Not supported. Opens the
Elements panel.

CONM2 with
zero mass

Checks if the mass of
CONM2 is less than or
equal to zero.

Lists the failing
CONM2.

Not supported. Opens the Masses
panel.

Orientation
vector along
axis vector

Checks if the orientation
vector of bar elements
CBEAM and CBAR is along
axis vector.

Lists the failing
bar elements.

Not supported. Opens the Bars
panel.

Element
connectivity

Checks for shell elements
connected by one or less
nodes and solid elements
connected by two or less
nodes.

Lists the failing
elements.

Deletes the failing
elements.

Not supported.

Unused
BeamSections

Checks if any
beamsections defined in
the model are unused.

Lists the failing
beamsections.

Deletes the unused
beamsecions.

Not supported.

Unused sets Checks if any sets are not
used.

Lists unused
sets.

Deletes unused
sets.

Not supported.

Unused curves Checks if any curves are
not used.

Lists unused
curves.

Deletes unused
curves.

Not supported.

Unused
systems

Checks if any systems in
the model are not used.

Lists unused
systems.

Deletes unused
systems.

Not supported.

Unused
laminates

Checks if any laminates in
the model are not used.

Lists unused
laminates.

Deletes unused
laminates.

Not supported.

Unused plys Checks if any plys in the
model are not used.

Lists unused
plys.

Deletes unused
plys.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Unused
vectors

Checks if any vectors in
the model are not used.

Lists unused
vectors.

Deletes unused
vectors.

Not supported.

Info

Name Description Result Auto correction
action

Manual
correction action

Components
share the
same property

Checks for two or more
components that have the
same property assigned.

Lists the failing
components.

Not supported. Opens the
Components panel.

Component
does not have
a property

Checks for components
that contain elements but
do not have any properties
assigned.

Lists the failing
components.

Not supported. Opens the
Components panel.

OptiStruct

Errors

Name Description Result Auto correction
action

Manual
correction action

Material ID
exceeds 8
characters

HyperMesh does not
write out more than eight
characters for IDs, so if
you have more HyperMesh
will write out ***, which
fails the solver. This check
is disabled when using a
long format template.

Lists the failing
materials.

Not supported. Opens the
Renumber panel

Property
is missing
material

Checks for properties
without a material
reference.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

Property ID
exceeds 8
characters

HyperMesh does not
write out more than eight
characters for IDs, so if

Lists the failing
properties.

Not supported. Opens the
Renumber panel
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Name Description Result Auto correction
action

Manual
correction action

you have more HyperMesh
will write out ***, which
fails the solver. This check
is disabled when using a
long format template.

Property with
zero cross
section area

Checks if the area of
PBEAM, PBAR and PROD
properties are less than or
equal to zero.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

Component
with solids and
shells

Checks if a component
consists of both solid and
shell elements.

Lists the failing
components.

Not supported. Opens the
Organize panel.

Node ID
exceeds 8
character

HyperMesh does not
write out more than eight
characters for IDs, so if
you have more HyperMesh
will write out ***, which
fails the solver. This check
is disabled when using a
long format template.

Lists the failing
nodes.

Not supported. Opens the
Renumber panel.

Element ID
exceeds 8
characters

HyperMesh does not
write out more than eight
characters for IDs, so if
you have more HyperMesh
will write out ***, which
fails the solver. This check
is disabled when using a
long format template.

Lists the failing
elements.

Not supported. Opens the
Renumber panel.

Free 1D
elements

Checks for 1D elements
that have one or more
connection missing. This
check does not include
RBE2 or RBE3 elements.

Lists the failing
elements.

Deletes the failing
1D elements.

Not supported.

RBE2 with
constrained
dependent
nodes

Checks for RBE2 with
constraints on dependent
nodes.

Lists the failing
elements.

Not supported. Opens the Rigids
panel.

Free Rigid
elements

Checks for RBE2 elements
that have one or more

Lists the failing
elements.

Deletes the free
arms of the Rigid.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

connection missing,
typically a leg that is
missing a connection.

Free RBE3
elements

Checks for RBE3 elements
that have one or more
connection missing,
typically a leg that is
missing a connection or
an independent node
that is not connected to
structure.

Lists the failing
elements.

Deletes the free
arms of RBE3.

Not supported.

RBE3 elements
are collinear

Checks if the dependent
and independent nodes
of an RBE3 element are
collinear.

Lists the failing
elements.

Deletes the failing
RBE3 elements.

Not supported.

RBE3 dof
connected to
solid

Checks for rotational DOFs
on independent nodes of
an RBE3 connected to a
solid element.

Lists the failing
elements.

Removes rotational
DOFs from affected
independent grids
of failing RBE3
elmements.

Not supported.

Zero-length
CBUSH without
CID

Checks if the CBUSH
spring element of zero
length has the element
coordinate system, CID
defined.

Lists the failing
elements.

Not supported. Opens the Springs
panel.

Elements have
a dependency

Checks for rigid elements
that share dependent
nodes with other rigid
elements.

Lists the failing
elements.

Deletes the failing
rigid elements.

Not supported.

Element has
rigid loops

Checks for rigid elements
that form a closed loop;
where the dependent node
of one rigid serves as
independent node of the
next rigid in the loop.

Lists the failing
elements.

Deletes the failing
rigid elements.

Not supported.

Duplicate 1D
Elements

Checks if any 1D elements
share the same nodes in
the same order.

Lists the
duplicate 1D
elements.

Deletes the failing
elements.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Duplicate 2D
Elements

Checks if any 2D elements
share the same nodes in
the same order.

Lists the
duplicate 2D
elements.

Deletes the failing
elements.

Not supported.

Duplicate 3D
Elements

Checks if any 3D elements
share the same nodes in
the same order.

Lists the
duplicate 3D
elements.

Deletes the failing
elements.

Not supported.

NSM field not
defined

Checks for invalid or
missing entries on
NSMADD loadcols.

Lists the failing
loadcols.

Not supported. Opens the Loadcols
panel.

MPC with free
independent
nodes

Checks for MPC equations
with free independent
nodes.

Lists the failing
equations.

Updates the MPC
by removing the
free independent
node.

Not supported.

Warnings

Name Description Result Auto correction
action

Manual
correction action

Unused
materials

Checks for any materials
that are not referenced by
a property.

Lists the failing
materials.

Deletes unused
materials.

Not supported.

Material E is
not defined

Checks if E of MAT1, MAT8
or MAT9ORT is less than or
equal to zero.

Lists the failing
materials.

Not supported. Opens the
Materials panel.

Material Rho is
not defined

Checks if Rho of MAT1,
MAT2,MAT4, MAT5, MAT8,
MAT9,MAT9ORT and
MAT10 is less than or
equal to zero.

Lists the failing
materials.

Not supported. Opens the
Materials panel.

Material Nu is
zero

Checks if Nu of MAT1,
MAT8 and MAT9ORT is
equal to zero.

Lists the failing
materials.

Not supported. Opens the
Materials panel.

Material is
missing a card
image

Checks for defined
materials with no card
image.

Lists the failing
materials.

Not supported. Opens the
Materials panel.
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Name Description Result Auto correction
action

Manual
correction action

Unused
properties

Checks for properties
that are not assigned to a
component or element.

Lists the failing
properties.

Deletes unused
properties.

Not supported.

Property is
missing a card
image

Checks for defined
properties with no card
image.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

PSHELL
thickness is
not defined

Checks if the property
PSHELL thickness is less
than or equal to zero.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

PCOMP
thickness is
not defined

Checks if the first
thickness value of Property
PCOMP array is less than
or equal to zero. The
first thickness value is
mandatory.

Lists the failing
properties.

Not supported. Opens the
Properties panel.

1D Prop
beamsection
mismatch

Checks if the 1D property
and the beam section
attached to it have the
same area and area
moments of inertia. A
difference greater than
0.01 will fail the check.

Lists the failing
properties.

Disassociates the
beam section from
the 1D property.

Not supported.

Empty
components

Checks for components
that do not contain
elements.

Lists the failing
components.

Deletes the empty
components.

Not supported.

Empty
assemblies

Checks if assemblies are
empty.

Lists the empty
assemblies.

Deletes the empty
assemblies.

Not supported.

Empty sets Checks if sets are empty. Lists the empty
sets.

Deletes empty
sets.

Not supported.

Empty contact
surfaces

Checks if contact surfaces
are empty.

Lists the
empty contact
surfaces.

Deletes the empty
contact surfaces.

Not supported.

Empty groups Checks if groups are
empty.

Lists empty
groups.

Deletes empty
groups.

Not supported.

Empty plys Checks if plys are empty. Lists the empty
plys.

Deletes empty
plys.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Empty load
collectors

Checks if load collectors
are empty.

Lists the empty
load collectors.

Deletes empty load
collectors.

Not supported.

Empty vector
collectors

Checks if vector collectors
are empty.

Lists the
empty vector
collectors.

Deletes the empty
vector collectors.

Not supported.

Empty
laminates

Checks if laminates are
not having any ply.

Lists the empty
laminates.

Deletes the empty
laminates.

Not supported.

CONM1 with
zero diagonal
mass matrix
values

Checks if the diagonal
mass matrix values of
CONM1 are less than or
equal to zero.

Lists failing
CONM1.

Not supported. Opens the
Elements panel.

CONM2 with
zero mass

Checks if the mass of
CONM2 is less than or
equal to zero.

Lists failing
CONM2.

Not supported. Opens the Bars
panel.

Element
connectivity

Checks for shell elements
connected by one or less
nodes and solid elements
connected by two or less
nodes.

Lists the failing
elements.

Deletes the failing
elements.

Not supported.

Unused
BeamSections

Checks if any beamsection
defined in the model is
unused.

Lists the failing
beamsections.

Deletes the unused
beamsecions.

Not supported.

Unused sets Checks if any sets are not
used.

Lists unused
sets.

Deletes unused
sets.

Not supported.

Unused curves Checks if any curves are
not used.

Lists unused
curves.

Deletes unused
curves.

Not supported.

Unused
systems

Checks if any systems in
the model are not used.

Lists unused
systems.

Deletes unused
systems.

Not supported.

Unused
laminates

Checks if any laminates in
the model are not used.

Lists unused
laminates.

Deletes unused
laminates.

Not supported.

Unused plys Checks if any plys in the
model are not used.

Lists unused
plys.

Deletes unused
plys.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Unused
vectors

Checks if any vectors in
the model are not used.

Lists unused
vectors.

Deletes unused
vectors.

Not supported.

Info

Name Description Result Auto correction
action

Manual
correction action

Components
share the
same property

Checks for two or more
components that have the
same property assigned.

Lists the failing
components.

Not supported. Opens the
Components panel.

Component
does not have
a property

Checks for components
that contain elements but
do not have any properties
assigned.

Lists the failing
components.

Not supported. Opens the
Components panel.

PAM-CRASH 2G

Errors

Name Description Result Auto correction
action

Manual
correction action

Id of component
out of bounds

Checks if there are
any component ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the
components with
ids outside of the
limit.

Not supported. Opens the
Renumbers panel.

Component
missing material

Checks if the
components with
card image PART /
are associated
with the correct
material based

Lists all
components that
do not have the
correct materials
associated to
them.

Not supported. Opens the
Components panel.
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Name Description Result Auto correction
action

Manual
correction action

on their element
content.

Component does
not have a part
card

Checks if the
components
defined in Altair
HyperMesh are not
assigned with card
image PART / .

Lists all
components that
do not have a card
image.

Not supported. Not supported.

Id of material out
of bounds

Checks if there are
any material ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the
materials with ids
outside of the limit.

Not supported. Opens the
Renumbers panel.

Id of property out
of bounds

Checks if there are
any property ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the
properties with ids
outside of the limit.

Not supported. Opens the
Renumbers panel.

Id of group out of
bounds

Checks if there
are any group ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the
groups with ids
outside of the limit.

Not supported. Opens the
Renumbers panel.

Master entities of
contacts/interfaces
not defined or
empty

Checks if there
are any contact or
interface entities
defined in the
model that do not
have any entities
referred or empty

Lists all contact or
interface entities
that do not have
master entities
defined.

Not supported. Opens the Entity
Editor of the
contact.
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Name Description Result Auto correction
action

Manual
correction action

in the place of
master.

Slave entities of
contacts/interfaces
not defined or
empty

Checks if there
are any contact or
interface entities
defined in the
model that do not
have any entities
referred or empty
in the place of
slave.

Lists all contact or
interface entities
that do not have
slave entities
defined.

Not supported. Opens the Entity
Editor of the
contact.

Slave nodes of
contacts/interfaces
in master surface

Checks if the slave
nodes of contact
or interface are
also present in its
master.

Lists all contacts
that have slave
nodes that are also
present its master.

Not supported. Opens the Entity
Editor of the
contact.

Id of element out
of bounds

Checks if there are
any element ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the
elements with ids
outside of the limit.

Not supported. Opens the
Renumbers panel.

Duplicate 1D
elements

Checks if two or
more 1D elements
are connected
between the same
nodes.

Lists all of the
duplicate 1D
elements.

Deletes failing
elements.

Not supported.

Duplicate 2D
elements

Checks if two or
more 2D elements
are connected
between the same
nodes.

Lists all of the
duplicate 2D
elements.

Deletes failing
elements.

Not supported.

Duplicate 3D
elements

Checks if two or
more 3D elements
are connected
between the same
nodes.

Lists all of the
duplicate 3D
elements.

Deletes failing
elements.

Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Negative or zero
volume of solids

Checks if a solid
has negative
volume associated
with it.

Lists all of the solid
elements with
zero or negative
volume.

Deletes failing
elements.

Not supported.

Beam: 3 nodes
aligned

Checks if the beam
element nodes
IDNOD1, IDNOD2
& IDNOD3 are on
same line or co-
linear. Or, if the
axis node is along
the orientation
direction for a
beam element.

Lists all beam
element with an
aligned 3rd node.

Not supported. Not supported.

Master node
in other Rigid
elements

Checks if node
referred in master
entity is also
referred in rigid
entity.

Lists all of the rigid
entities that share
the node.

Not supported. Opens the Rigid
panel

Slave nodes
in other Rigid
elements

Checks if node
referred in slave
entity is also
referred in rigid
entity.

Lists all of the rigid
entities that share
the node.

Not supported. Opens the Rigid
panel

Rigid element
master shares
slave nodes

Checks if same
node referred in
both master and
slave entity in rigid
entity.

Lists all of the rigid
entities that share
the same node.

Not supported. Opens the Rigid
panel

Degenerated 4
node shells

Checks if quad
(shell) element’s
IDNOD2 and
IDNOD3 shares
same node IDs

Lists all of the quad
(shell) elements
that have IDNOD2
= IDNOD3

Not supported. Not supported.

Zero slave nodes in
Rigid elements

Checks if slave
field of rigid
entities have
empty or zero
nodes referred.

Lists all of the rigid
entities that have
empty slave field.

Not supported. Opens the Rigid
panel
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Name Description Result Auto correction
action

Manual
correction action

Id of node out of
bounds

Checks if there
are any node ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the nodes
with ids outside of
the limit.

Not supported. Opens the
Renumber panel.

Id of system out of
bounds

Checks if there
are any system ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the
systems with ids
outside of the limit.

Not supported. Opens the
Renumber panel.

Id of system
collector out of
bounds

Checks if there
are any system
collector ids that
are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the
system collectors
with ids outside of
the limit.

Not supported. Opens the
Renumber panel.

Id of curve out of
bounds

Checks if there
are any curve ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the
curves with ids
outside of the limit.

Not supported. Opens the
Renumber panel.

Repeated X values
in curve

Checks if any
X coordinate
(abscissa) values
are repeated in
FUNCT keyword.

Lists all curves
defined in the
model that
have repeated
X coordinate
(abscissa) values.

Not supported. Opens the Curve
Editor.
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Name Description Result Auto correction
action

Manual
correction action

Curve X values not
ascending

Checks if X
coordinate
(abscissa)
values are not in
ascending order for
FUNCT keyword.

Lists all curves
defined in the
model that have
X coordinate
(abscissa) values
which are not in
ascending order.

Not supported. Opens the Curve
Editor.

Curve has no point Checks if there are
no X coordinate
(abscissa) and
Y coordinate
(ordinate) values in
FUNCT keyword.

Lists all curves
defined in the
model that doesn’t
have X (abscissa)
& Y (ordinate)
coordinates values.

Not supported. Opens the Curve
Editor.

Id of load out of
bounds

Checks if there
are any load ids
that are either less
than the min_limit
or more than
the max_limit of
allowable ids in the
ID Manager.

List all of the loads
with ids outside of
the limit.

Not supported. Opens the
Renumber panel.

Id of loadcol out of
bounds

Checks if there are
any load collector
ids that are either
less than the
min_limit or more
than the max_limit
of allowable ids in
the ID Manager.

List all of the load
collectors with ids
outside of the limit.

Not supported. Opens the
Renumber panel.

Component does
not have a part
card

Checks if the
components
defined in Altair
HyperMesh are not

Lists all
components that
do not have a card
image.

Not supported. Not supported.
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Name Description Result Auto correction
action

Manual
correction action

assigned with card
image PART / .

Warnings

Name Description Result Auto correction
action

Manual
correction action

Empty components Checks if any
components are
empty (no Element
and no Geometry).

Lists all empty
components.

Deletes the
component.

Not supported.

Component with
zero or negative
thickness

Checks if the
PART with card
image type SHELL,
TSHEL, MEMBR
have zero or
negative element
thickness (H).

Lists all
components with
zero or negative
element thickness
(H).

Not supported. Not supported.

Free nodes in the
model

Checks if the nodes
in the model are
free (not used by
any elements).

Lists free nodes. Deletes free nodes. Not supported.

Unused properties Checks if any
properties are
not referred/
used in any of the
keywords.

Lists all unused
properties.

Deletes the
property.

Not supported.

Unused curves Checks if the
defined curves
(FUNCT & SECURE/
FUNCT) in the
model are not
used/referred to in
other keywords.

Lists all unused
curves (FUNCT &
SECURE/FUNCT) in
the model.

Deletes unused
curves.

Not supported.

Rigid element
connected to only
one part

Checks if slave
nodes of rigid
entity not
connecting

Lists all rigid
entities which are
connected to only
one part.

Not supported. Not supported.
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Name Description Result Auto correction
action

Manual
correction action

more than one
component.

Cascades of Rigid
elements

Checks if any
keywords that are
mapped to rigids
(RBODY, MTOCO,
LINCO, NODCO
and MBYSY_RIGID)
share a slave node
of other rigid entity
master node.

Lists all rigid
entities where
slave node is
also connected or
shared to master
node of other rigids

Not supported. Not supported.

Free 1D elements Checks if 1D
elements in model
are free, i.e.
elements whose
nodes are not
connected to valid
entities.

Lists all 1D
elements whose
nodes are not
connected to any
FE entity.

Deletes failing
elements.

Not supported.

Free Rigid
elements

Checks if rigid
entities in model
are free, i.e. rigid
(RBODY, MTOCO,
LINCO, NODCO
and MBYSY_RIGID)
entities whose
nodes are not
connected to valid
entities.

Lists all rigid
entities whose
nodes are not
connected to any
FE entity.

Deletes failing
entities.

Not supported.

Free RBE3
elements

Checks if RBE3
(OTMCO) entities
in model are free,
i.e. rbe3 rigid
entities whose
nodes are not
connected to valid
entities.

Lists all RBE3
(OTMCO) rigid
entities whose
nodes are not
connected to any
FE entity.

Deletes failing
entities.

Not supported.

Shell elements with
negative thickness

Checks if the shell
elements with card
image type SHELL,
TSHEL have zero or

Lists all shell
elements with
zero or negative

Not supported. Not supported.
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Name Description Result Auto correction
action

Manual
correction action

negative element
thickness (H).

element thickness
(H).

Shell elements with
thickness

Checks if the shell
elements with card
image type SHELL,
TSHEL have non-
zero elemental
level thickness (H)
assigned.

Lists all shell
elements which
have non-zero
element thickness
(H).

Not supported. Not supported.

Spring elements
with zero length

Checks if the
length of SPRING
entities is zero.

Lists all springs
which have zero
length.

Deletes failing
springs.

Not supported.

One slave node in
Rigid elements

Checks if a rigid
(RBODY, MTOCO,
LINCO, NODCO
and MBYSY_RIGID)
entities has only
one slave node
defined.

Lists all rigids that
have one node.

Not supported. Opens the Rigid
panel.

Unused materials Checks if any
materials are not
referred/used
in any of the
keywords.

Lists all unused
materials.

Deletes the
material.

Not supported.

Material with zero
or negative density

Checks if any
materials have
zero or negative
density defined.

Lists all materials
that have zero or
negative density.

Not supported. Opens the
corresponding
materials Card
Image panel.

Material with zero
or negative Young's
modulus

Checks if any
materials have
zero or negative
Young's Modulus
defined.

Lists all materials
that have zero or
negative Young's
Modulus.

Not supported. Opens the
corresponding
materials Card
Image panel.

Material with
Poisson's ratio less
than 0.001

Checks if any
materials have
values less than
0.001 Poisson
Ratio defined.

Lists all materials
that have poisson
ratio <0.001.

Not supported. Opens the
corresponding
materials Card
Image panel.
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Name Description Result Auto correction
action

Manual
correction action

Material Solid with
IMPLICIT flags
under ISINT

Checks if any
solid materials
have implicit flags
or legal values
assigned.

Lists all solid
materials that have
implicit flags.

Not supported. Not supported.

Unused parameters Checks if there are
unused parameters
(PYVAR, PYFINC) in
the model.

Lists all parameters
which are not
referenced by any
other entity.

Deletes unused
parameters.

Not supported.

Unused systems Checks if any
system (FRAME)
defined in the
model is unused/
not referred to in
other keywords.

Lists all unused
systems.

Deletes unused
systems.

Not supported.

Unused
beamsections

Checks if any
Beamsection
defined in the
model is unused.

Lists all unused
Beamsections in
the model.

Delete unused
beamsections.

Not supported.

Contact with
negative thickness
(Hcont)

Checks if Hcont
value is negative in
CNTAC entity.

Lists all CNTAC
entities that have
negative Hcont
value.

Not supported. Not supported.

Slave nodes in
multiple contacts/
interfaces

Checks if the same
node is used as
slave in more than
one CNTAC entity.

Lists all CNTAC
entities that share
the same slave
nodes.

Not supported. Not supported.

Info

Name Description Result Auto correction
action

Manual
correction action

Number of defined
materials

Checks for the
number of defined
materials.

Lists all defined
materials.

Not supported. Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Number of
undefined
materials

Checks for
the number
of undefined
materials.

Lists all undefined
materials.

Not supported. Not supported.

Number of defined
properties

Checks for the
number of defined
properties.

Lists all defined
properties.

Not supported. Not supported.

Number of
undefined
properties

Checks for
the number
of undefined
properties.

Lists all undefined
properties.

Not supported. Not supported.

Number of
Components

Checks for
the number of
components.

Lists all
components.

Not supported. Not supported.

Number of
undefined
Components

Checks for
the number
of undefined
components.

Lists all undefined
components.

Not supported. Not supported.

Number of
elements

Checks for
the number of
elements.

Lists all elements. Not supported. Not supported.

Number of groups Checks for the
number of groups.

Lists all groups. Not supported. Not supported.

Number of nodes Checks for the
number of nodes.

Lists all nodes. Not supported. Not supported.

Nodes not
connected to
elements

Checks if there are
any nodes that are
not connected to
elements.

Lists all of the
nodes in the
model that are
not connected to
elements.

Not supported. Not supported.

Number of defined
curves

Checks for the
number of defined
curves.

Lists all defined
curves.

Not supported. Not supported.

Number of
undefined curves

Checks for
the number of
undefined curves.

Lists all undefined
curves.

Not supported. Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Number of output
blocks

Checks for the
number of output
blocks.

Lists all output
blocks.

Not supported. Not supported.

Permas

Errors

Name Description Result Auto correction
action

Manual
correction action

Youngs
modulus and
poissons ratio
is not defined

Checks if Youngs modulus
has been defined for
materials.

Lists all
materials that
do not have
Youngs modulus
defined.

Not supported. Opens the Material
panel.

Poisson Ratio
is not defined

Check if Poissons ratio has
been defined for materials.

Lists all
materials that
do not have
Poissons ratio
defined.

Not supported. Opens the Material
panel.

Density is not
defined

Checks if density has been
defined for materials.

Lists all
materials that
do not have
density defined.

Not supported. Opens the Material
panel.

Shell
properties
without
thickness

Checks if thickness has
been defined for shell
properties.

Lists all shell
properties
that do not
have thickness
defined.

Not supported. Opens the Property
panel.

Component
with missing
material

Checks if components are
assigned a material.

Lists all
components
that do not
have a material
assigned.

Not supported. Opens the
Component panel.
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action

Manual
correction action

Component
with missing
property

Checks if components are
assigned a property.

Lists all
components
that do not
have a material
assigned.

Not supported. Opens the
Component panel.

Component
with solid and
shells

Checks if a component
consists of both solid and
shell elements.

Lists all failing
components.

Not supported. Opens the
Organize panel.

MPC (RBE2)
with free
dependent
node

Checks if dependent nodes
of MPC (RBE2) are free.

List all failing
MPC (RBE2)
elements.

Not supported. Deletes the link
between the
independent node
and free dependent
node.

MPC (RBE3)
with free
independent
node

Checks if independent
nodes of MPC (RBE3) are
free.

List all failing
MPC (RBE3)
elements.

Not supported. Deletes the link
between the
independent node
and free dependent
node.

Errors

Name Description Result Auto correction
action

Manual
correction action

Unused
materials

Checks for materials that
are not referenced by a
component.

Lists all unused
materials.

Deletes unused
materials.

Not supported.

Unused
properties

Check for properties that
are not used in the model.

Lists all unused
properties.

Deletes unused
properties.

Not supported.

Property is
missing a card
image

Checks for properties that
do not have a card image.

List all
properties that
do not have
card images.

Not supported. Opens the Property
Create panel.

Property
missing mass
value

Checks if mass properties
that do not have element
mass defined.

Lists all Mass
properties that
do not have
mass assigned.

Not supported. Opens the Property
panel.
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action
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correction action

Damper
property
is missing
Damping and
Mass value

Checks if Damper
properties are missing the
Damping or Mass value.

Lists all Damper
properties that
do not have
damping/mass
assigned.

Not supported. Opens the Property
panel.

Beam Property
missing
HyperBeam
Section

Checks if Beam
propertiesare missing
HyperBeam sections.

Lists all Beam
properties that
do not have
beam section
properties
assigned.

Not supported. Opens the Property
panel.

Empty
Components

Checks if components
have one or more
elements.

Lists all
components
that do not
have elements.

Deletes empty
components.

Not supported.

Unsed Sets Check if sets are not used
in the model.

Lists all unused
sets.

Deletes empty
sets.

Not supported.

Empty sets Check if sets are empty. List empty sets. Deletes empty
sets.

Not supported.

Empty groups Checks if groups have
either a master entity
or slave entity that
are assigned a contact
surface/set.

Lists all groups
with missing
master and
slave entities.

Deletes empty
groups.

Not supported.

Empty
contactsurfs

Checks if contactsurfs are
assigned any elements.

Lists all empty
contactsurfs.

Deletes empty
contactsurfs.

Not supported.

Unused
Sections

Check if there are any
unused Beamsections
defined in the model.

List all unused
Beamsection
collectors in the
model.

Deletes unused
beamsections.

Not supported.

Empty
loadcollectors

Checks if there are
any loads in the load
collectors.

Lists all
loadcollectors
that do not
have loads.

Deletes empty
loadcollectors.

Not supported.

Empty
Vectorcollectors

Checks if there are any
empty vector collectors.

Lists all empty
vectors.

Deletes empty
vectors.

Not supported.
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action

Manual
correction action

Empty
assemblies

Checks if there are any
empty assemblies.

Lists all empty
assemblies.

Deletes empty
assemblies.

Not supported.

Info

Name Description Result Auto correction
action

Manual
correction action

Number of
Material

Checks for the number
of material entities in the
model.

Lists all
materials in the
model.

Not supported. Not supported.

Number of
Properties

Checks for the number of
property entities in the
model.

Lists all
properties in the
model.

Not supported. Not supported.

Number of
Comp

Checks for the number of
component entities in the
model.

Lists all
components in
the model.

Not supported. Not supported.

Number of
Groups

Checks for the number
of group entities in the
model.

Lists all groups
in the model.

Not supported. Not supported.

Number of
sets

Checks for the number of
set entities in the model.

Lists all sets in
the model.

Not supported. Not supported.

Number of
Steps

Checks for the number of
step entities in the model.

Lists all steps in
the model.

Not supported. Not supported.

Radioss

Errors

Name Description Result Auto correction
action

Manual
correction action

Id of material
out of bounds

Checks if there are any
material ids that are either
less than the min_limit or
more than the max_limit

List all of the
materials with
ids outside of
the limit.

Not supported. Opens the
Renumber panel.
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Manual
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of allowable ids in the ID
Manager.

Nfunc must be
greater than 0
for LAW36

Checks if LAW36 has a
value defined for N_func.

Lists all
materials of
LAW36 which
have N_func =
0.

Not supported. Open the Entity
Editor of the
material entity.

LAW36 has
empty function
definition

Checks if material LAW36
has curves defined under
NFUNC.

Lists all
materials
of LAW36
which have
empty curve
definitions.

Not supported. Open the Entity
Editor of the
material entity.

Alpha greater
than 1.0 for
LAW37

Checks if materials of
LAW37 have alpha1 values
greater than 1.0.

Lists all
materials of
LAW37 that
have alpha1
values that are
less than or
equal to 1.0.

Not supported. Open the Entity
Editor of the
material entity.

Id of property
out of bounds

Checks if there are any
property ids that are
either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
properties with
ids outside of
the limit.

Not supported. Open the Entity
Editor of the
material entity.

Id of group out
of bounds

Checks if there are any
group ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
groups with ids
outside of the
limit.

Not supported. Opens the
Renumber panel.

Master set not
defined

Checks if there are any
empty master sets in the
interfaces.

List all
interfaces that
have an empty
master.

Not supported. Opens the
Interface panel and
updates the page.

Slave set not
defined

Checks if there are any
empty slave sets in the
interface.

List all
interfaces that

Not supported. Opens the
Interface panel and
updates the page.
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Manual
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have an empty
slave.

Tied contacts:
Slave nodes in
master surface

Checks if the slave nodes
of tied contacts are also
present in its master.

Lists the tied
contacts whose
slave nodes are
also present in
its master.

Not supported. Opens the
Interface panel.

Id of node out
of bounds

Checks if there are any
node ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
nodes with ids
outside of the
limit.

Not supported. Opens the
Renumber panel.

Id of system
out of bounds

Checks if there are any
system ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
systems with
ids outside of
the limit.

Not supported. Opens the
Renumber panel.

Id of system
collector out of
bounds

Checks if there are any
system collector ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of
the system
collectors with
ids outside of
the limit.

Not supported. Opens the
Renumber panel.

Id of curve out
of bounds

Checks if there are any
curve ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
curves with ids
outside of the
limit.

Not supported. Opens the
Renumber panel.

Repeated X
values in curve

Checks if abcissa values
are clashing or repeated in
a curve.

Lists all curves
that have
clashing or
repeated
absicca values,
that is X values.

Not supported. Opens the Curve
editor to edit the
curve fields.

Id of element
out of bounds

Checks if there are any
element ids that are either

List all of the
elements with

Not supported. Opens the
Renumber panel.
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Name Description Result Auto correction
action

Manual
correction action

less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

ids outside of
the limit.

Spring
elements with
zero length

Checks if spring elements
have a length greater than
zero.

Lists all spring
elements with a
null length.

Deletes all spring
elements with a
null length.

Not supported.

Pulley spring
not defined
with 3 nodes

Checks if a spring element
that has a property of /
PROP/SPR_PUL assigned is
defined using three nodes.

Lists all spring
elements that
are not defined
using exactly
three nodes.

Deletes the
element.

Not supported.

Joint nodes
not on
different rigids

Checks if a spring element
that has a property of /
PROP/KJOINT2 assigned to
its component has node1
and node2 on different
rigid elements.

Lists all spring
elements whose
node1 and
node2 are on
the same rigid
elements.

Deletes the
element.

Not supported.

All nodes not
defined for
universal joint

Checks if a spring element
that has a property of /
PROP/KJOINT2 assigned
to its component and is of
type 5 is defined using 4
nodes.

Lists all spring
elements that
are not defined
using all four
nodes.

Deletes the
element.

Not supported.

Third node not
defined for
joint element

Checks if a spring that
has a property of /PROP/
KJOINT2 assigned to
its component and is of
type revolute, cylindrical,
translation, or planar has
a third node defined.

Lists all spring
elements which
are not defined
using three
nodes.

Deletes the
element.

Not supported.

Common
master of
RBody, RLink,
CylJoint

Checks if any rigid bodies
(rigids, rigid links and
cyl. joints) have common
master nodes.

List all rigids
that share
common master
nodes.

Splits the common
master nodes.

Opens the
corresponding
Rigids panel and
updates the page.

Common slave
of RBody,
RLink, CylJoint

Checks if any rigid bodies
(rigids, rigid links and cyl.
joints) have common slave
nodes.

Lists all rigids
that share
common slave
nodes.

Splits the common
slave nodes.

Opens the
corresponding
Rigids panel and
updates the page.
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0 slave nodes
in Rbody

Checks if there are 0 slave
nodes in Rbody.

Lists all Rbodies
that have 0
slave nodes.

Not supported. Opens the
corresponding
Rigids panel and
updates the page.

Rbody master
is also slave

Checks if the master node
of Rbody is also present in
the slave side of the same
Rbody.

Lists all Rbodies
that have
master node
present in slave
definition.

Not supported. Opens the
corresponding
Rigids panel and
updates the page.

Ikrem value is
incompatible
with RWALL

Checks if the flag for
rigidwall deactivation,
Ikrem, is incompatible
with RWALL. It is
incompatible if the value
of Ikrem is equal to one.

Lists all
rigids that
have Ikream
incompatible to
RWALL.

Sets Ikrem to 0. Opens the
corresponding
RBODY card image.

Rbody master
is in box that
defines slave

Checks if Rbody master
node is in the box defined
by slave group of this
RBODY.

Lists all bodies
that have
master node in
the box defined
by slave group
of this RBODY.

Not supported. Opens the
corresponding
Rigids panel and
updates the page.

Rbody master
on element

Checks if the rbody master
element is attached to a
finite element.

Lists all of the
rbodies whose
master element
is on a finite
element.

Not supported. Opens the Rigid
panel.

Cascades of
RBodies

Checks if the rbody master
is also the slave of another
rbody.

Lists all of the
rbodies whose
master is also a
slave.

Not supported. Opens the Rigid
panel.

1D elements
with duplicate
nodes

Checks if 1D elements
consists of two of the
same nodes.

Lists all of the
1D elements
with duplicate
nodes.

Not supported. Opens the Bars
panel.

Duplicate 1D
elements

Checks if two or more 1D
elements are connected
between the same nodes.

Lists all of the
duplicate 1D
elements.

Deletes the failing
elements.

Not supported.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1272

Name Description Result Auto correction
action

Manual
correction action

Duplicate 2D
elements

Checks if two or more 2D
elements are connected
between the same nodes.

Lists all of the
duplicate 2D
elements.

Deletes the failing
elements.

Not supported.

Duplicate 3D
elements

Checks if two or more 3D
elements are connected
between the same nodes.

Lists all of the
duplicate 3D
elements.

Deletes the failing
elements.

Not supported.

Degenerated 4
node Shells

Checks if four node shells
have two of the same
nodes within it.

Lists all of the 4
node shells with
duplicate nodes.

Not supported. Not supported.

Negative or
zero volume of
solids

Checks if a solid has
zero or negative volume;
Ideally when using
HyperMesh you should not
have negative volume.

Lists all of the
solid elements
with a zero
or negative
volume.

Deletes the failed
solid elements.

Not supported.

Box definition
with null
length

Checks if there is a length
defined for all three
directions of a box, that is
xmin!=xmax, and so on.

Lists all of the
boxes with null
lengths.

Not supported. Opens the Entity
Editor for the Block
entity.

N1 and N2 are
not defined on
Box

Checks if N1 and N2 are
defined on box/recta.

Lists all boxes
of primitive type
Rectangle that
do not have N1
and N2 defined.

Not supported. Opens the Entity
Editor for the box
entity.

Id of
component out
of bounds

Checks if there are any
component ids that are
either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
components
with ids outside
of the limit.

Not supported. Opens the
Renumber panel.

Component
has more than
one element
type

Checks if a component
has more than one unique
element type (shell, solids,
beam, discrete, and SPH).

Lists all
components
that have
multiple
element types.

Not supported. Opens the
Organize panel.

Component
does not have
a part card

Checks if any components
are assigned the Part card
image.

Lists all
components
that do not

Not supported. Opens the Entity
Editor for the
component entity.
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have a card
image.

Component
missing
property

Checks if the part
component has a property
attached.

Lists all of the
components
with no
property
attached.

Not supported. Opens the Entity
Editor for the
component entity.

Component
missing
material

Checks if the part
component has a material
attached.

Lists all of the
components
with no material
attached.

Not supported. Opens the Entity
Editor for the
component entity.

Part, mat
and prop
incompatible

Checks if parts, properties,
and materials are
compatible according to
the material compatibility
table, and few other
constraints mentioned in
individual material and
property definitions.

Lists all
components
whose elements
are not
compatible with
the material
and property
attached or
the attributed
defined on
them.

Not supported. Opens the Entity
Editor for the
component entity.

Id of Set out
of bounds

Checks if there are any
set ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
sets with ids
outside of the
limit.

Not supported. Opens the
Renumber panel.

Id of load out
of bounds

Checks if there are any
load ids that are either
less than the min_limit or
more than the max_limit
of allowable ids in the ID
Manager.

List all of the
loads with ids
outside of the
limit.

Not supported. Opens the
Renumber panel.

Id of loadcols
out of bounds

Checks if there are any
load collector ids that
are either less than the
min_limit or more than the

List all of the
load collectors
with ids outside
of the limit.

Not supported. Opens the
Renumber panel.
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max_limit of allowable ids
in the ID Manager.

Initial velocity
of type T+G.

Checks if initial velocity is
of type T+G.

Lists all of the
inivel load
collectors of
type T+G.

Not supported. Opens the Entity
Editor for the load
collector entity.

Skew and
frame defined
in Impvel or
Impdisp

Checks if /IMPVEL and /
IMPDISP have only one
system associated with
them.

Lists the /
IMPVEL and
/IMPDISP
with different
systems present
in skew and
frame.

Not supported. Opens the Entity
Editor for the load
collector entity.

Isensor for
Cload is not
defined

Checks if Isensor is
defined for Cload.

Lists all Cloads
with Isensor not
defined.

Not supported. Opens the Entity
Editor for the
entity.

Grnod id for
Cload is not
defined

Checks if Grnod id is
defined for Cload.

Lists all Cloads
with Grnod ID
not defined.

Not supported. Opens the Entity
Editor for the
entity.

Skew for Cload
is not defined

Checks if skew_csid is
defined for Cload.

Lists all Cloads
with skew_csid
not defined.

Not supported. Opens the Entity
Editor for the
entity.

Curve for
Cload is not
defined

Checks if fun_a1 is defined
for Cload.

Lists all Cloads
with fun_a1 not
defined.

Not supported. Opens the EEntity
Editor for the
entity.

Id of
beamsection
out of bounds

Checks if there are any
beam section ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
beam sections
with ids outside
of the limit.

Not supported. Opens the
Renumber panel.

Id of
beamsection
collector out of
bounds

Checks if there are any
beam section collector ids
that are either less than
the min_limit or more than
the max_limit of allowable
ids in the ID Manager.

List all of the
beam section
collectors with
ids outside of
the limit.

Not supported. Opens the
Renumber panel.
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Id of
parameters
out of bounds

Checks if there are any
parameter ids that are
either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
parameters with
ids outside of
the limit.

Not supported. Opens the
Renumber panel.

ISkew cannot
be a system of
type Frame

Checks if the system
attached to a sensor is of
type Frame.

Lists all of the
sensors that
contain systems
of type Frame.

Not supported. Opens the Entity
Editor for the
sensor entity.

Id of output
blocks out of
bounds

Checks if there are any
output block ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
output blocks
with ids outside
of the limit.

Not supported. Opens the
Renumber panel.

Id of contact
surfaces out of
bounds

Checks if there are any
contact surface ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
contact surfaces
with ids outside
of the limit.

Not supported. Opens the
Renumber panel.

Id of control
volumes out of
bounds

Checks if there are any
control volume ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
control volumes
with ids outside
of the limit.

Not supported. Opens the
Renumber panel.

Monitored
volumes
with empty
surfaces

Checks if surfaces are
defined on the airbag.

Lists all airbags
that do not
have surfaces
defined on
them.

Not supported. Opens the Entity
Editor for the
control volume
entity.

Monitored
volumes with
invalid vent
holes data

Checks if area and surfs
are defined on each vent
of the airbag.

Lists all control
volumes with
zero area or no
surface defined
on any vents.

Not supported. Opens the Entity
Editor for the
entity.
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Id of cross
sections out of
bounds

Checks if there are any
cross section ids that
are either less than the
min_limit or more than the
max_limit of allowable ids
in the ID Manager.

List all of the
cross sections
with ids outside
of the limit.

Not supported. Opens the
Renumber panel.

Sections: N1,
N2, N3 badly
defined

Checks if the nodes of
a cross section define a
plane.

Lists all of the
cross sections
without a plane.

Not supported. Opens the Entity
Editor for the cross
section entity.

Prop17
Incompatible
with /
INISHE_ORTHO_LOC
or /
INISH3_ORTHO_LOC

Checks if the elements
in property of type
P17_STACK is referenced
by /INISHE/ORTHO_LOC
or /INISH3/ORTHO_LOC
tables.

Lists all
properties
linked to
elements
referenced
by /INISHE/
ORTHO_LOC
or /INISH3/
ORTHO_LOC
tables.

Not supported. Opens the Entity
Editor for the
property entity.

Curve x axis
values not
ascending

Check if the value of x axis
is not in ascending order

List all the
curves whose x
axis values are
not in ascending
order

Not supported Opens Curve Editor

Parameter
name length is
greater than 9

Check if the character
length of parameter name
string is greater than 9

Opens Entity
Editor to
rename
parameter
name

Not supported Opens Entity Editor
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Output blocks
with no
variables

Warnings

Name Description Result Auto correction
action

Manual
correction action

Unused
materials

Checks if there any
unused materials in the
model.

Lists all unused
materials.

Not supported. Opens the material
card image of /
MAT/PLAS_TAB.

Strain rate
coefficient
equal to 0 for
LAW2

Checks if the strain rate
coefficient is equal to zero
for material LAW2.

Lists all of the
law2 materials
that have a
strain rate
coefficient equal
to zero.

Not supported. Opens the material
card image of
either /MAT/
PLAS_JOHNS or /
MAT/PLAS_ZERIL.

Bad strain rate
order in Law36

Checks for bad strain rate
order in material Law36.
The strain rate should be
in increasing order.

Lists all the
law36 materials
having bad
strain rate
order.

Not supported. Opens the material
card image of /
MAT/PLAS_TAB.

Material with
zero density

Checks if material density
is equal to zero.

Lists all of
the materials
that have zero
density.

Not supported. Opens the
corresponding
material card
image.

Material with
zero modulus

Checks if material modulus
is equal to zero.

Lists all of
the materials
that have zero
modulus.

Not supported. Opens the
corresponding
material card
image.

Material with
Poisson's
Ratio less than
0.001

Checks if material
Poisson’s Ratio is less than
0.001.

Lists all of the
materials that
have Poisson’s
Ratio less than
0.001.

Not supported. Opens the
corresponding
material card
image.
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Law2,4,15,27:
C and Eps0
defined but F
and F blank

Checks for law2, 4, 15,
27: C and Epsdot0 are
defined, and F and F are
blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

LAW25 Tsai-
Wu: C and
Eps0 defined
but F and F
blank

Checks for law25, TSAI-
WU: C12 and Epsdot0 are
defined, and F and F are
blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

LAW25
Crasurv: any C
and E0 defined
but F, F blank

Checks for law25,
CRASURV: C (or any of
c1t,c1c,c2t,c2c,c12t) and
Epsdot0 are defined, and F
and F are blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

Law36,59,60:
Nfunc > 0 but
F and F blank

Checks for law36, 59, 60:
Nfunct > 0, and F and F
are blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

LAW44: C and
p defined but F
and F blank

Checks for LAW44: C and
p are defined, and F and F
are blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

Law48: C,K
and E0 defined
but F blank

Checks for law48: C, K
and Epsdot0 are defined,
and F is blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

Law52: C and
P defined but F
and F blank

Checks for law52: C and
p are defined, and F and F
are blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

Law65,77:
Nrate or Nload
> 1 but F and
F blank

Checks for law65, 77:
Nrate/Nload > 1, and F
and F are blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

Law70: Nload
> 1 but F and
F blank

Checks for law 70: Nload
> 1, and F and F are
blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

Law74: Eps
rate scale
defined but F
and F blank

Checks for law74:
Epsdot_scale is defined,
and F and F are blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.
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Law80: Ceps
and Peps
defined but F
and F blank

Checks for law80: Ceps
and Peps are defined, and
F and F are blank.

Lists all
materials that
failed the check.

Not supported. Opens the Entity
Editor of the
material entity.

Mat and
referenced
curves not in
same include

Checks if a material and
its referenced curves are
in the same include.

Lists all of the
materials that
have curves
that are not in
same include
file as the
material.

Not supported. Opens the Entity
Editor of the
material entity.

Parameter and
material title
with &

Checks if a material name
has "&" when a parameter
is defined in the model.

Lists all
materials whose
name has
"&" when a
parameter is
defined in the
model.

Not supported. Opens the Entity
Editor of the
material entity.

Material with
invalid name

Checks if a material name
contains no more than 100
characters, and does not
begin with a "/".

Lists all
materials whose
names are
greater than
100 characters
or begin with
"/".

Not supported. Opens the Entity
Editor of the
material entity.

Unused
properties

Checks if there are any
unused properties in the
model.

Lists all of
the unused
properties

Deletes unused
properties.

Not supported.

Section shell
thickness

Checks if section shell
thickness is less than or
equal to zero.

Lists all of the
shell properties
that have
a section
thickness less
than or equal to
zero.

Not supported. Opens the property
card image of /
PROP/SHELL.

Beam or truss
property with
area less than
or equal to 0

Checks if beam and truss
properties have an area
equal to zero.

Lists all of the
beam and truss
properties that
have an area

Not supported. Opens the
corresponding
truss or beam
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less than or
equal to zero.

property card
image.

Beam property
with inertia
less than or
equal to 0

Checks if beam properties
have an inertia less than
or equal to zero.

Lists all of the
beam properties
that have
inertia less than
or equal to zero.

Not supported. Opens the property
card image of /
PROP/BEAM.

Spring
property with
inertia less
than or equal
to 0

Checks if spring properties
have an inertia less than
or equal to zero.

List all
the spring
properties that
have an inertia
less than or
equal to zero.

Not supported. Opens the property
card image of /
PROP/SPRING.

Spring
properties with
null mass

Checks if spring properties
have null mass.

Lists all of
the spring
properties that
have null mass.

Not supported. Opens the property
card image of /
PROP/SPRING.

Invalid Icpre
value on type
6

Checks if I is defined for I,
not equal to 14, 17, and
24.

Lists all
properties
with icpre!=0
and isolid!=
14,17,24.

Not supported. Opens the Entity
Editor of the entity.

Negative Gap
value on type
2

Checks if GAP is negative
on Type 2 properties.

Lists all
properties of
type 2 with a
negative gap
value.

Not supported. Opens the Entity
Editor of the entity.

Parameter and
property title
with &

Checks if a property name
has "&" when a parameter
is defined in the model.

Lists all
properties
whose name
has "&" when
a parameter is
defined in the
model.

Not supported. Opens the Entity
Editor of the entity.

Property with
invalid name

Checks if a property name
has no more than 100
characters and does not
begin with a "/".

Lists all
properties
whose names
are greater than
100 character,

Not supported. Opens the Entity
Editor of the entity.
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or begin with
"/".

Prop and
referenced
entities not in
same include

Checks if a property
and its curve, sensor, or
system are in the same
include.

Lists all
properties
which reference
entities that are
not in the same
include.

Not supported. Opens the Entity
Editor of the entity.

Istf is not
equal to 0 or
1 for interface
type 11

Checks if attribute Istf is
not equal to zero or one
for Inter type 11.

Lists all
interfaces of
type11 that
have istf not
equal to zero or
one.

Not supported. Opens the interface
card image of /
INTER/TYPE11.

Idel is not
equal to 1 for
interface type
7

Checks if attribute Idel
is not equal to one for
interface type 7.

Lists all
interfaces of
type7 that have
Idel not equal
to one.

Not supported. Opens the interface
card image of /
INTER/TYPE7.

Bad Isearch
flag interface
in interface
type 2

Checks if attribute Isearch
is defined badly.

Lists all
interfaces of
type2 that have
Isearch not
equal to zero or
two.

Not supported. Opens the interface
card image of /
INTER/TYPE2.

Bad spotflag in
interface type2

Checks if Spotflag is badly
defined for interface type
2.

Lists all
interfaces of
type2 that have
a spotflag value
not equal to
zero.

Not supported. Opens the interface
card image of /
INTER/TYPE2.

Slave nodes
in multiple
interfaces

Checks if slave nodes are
in multiple interfaces for
TYPE2.

Lists all
interfaces of
type2 that
have common
slave nodes
across multiple
interfaces.

Not supported. Opens the
Interface panel and
updates the page.
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Un-Tied nodes
in interface
type 2

Checks if there are
any free nodes in tied
contacts, that is, contacts
of type 2.

Lists all type2
contacts with
free nodes.

Not supported. Not supported.

Groups and
referenced
entities not in
same include

Checks if group, master,
slave, curves, and rbody
are in the same include.

Lists all
groups whose
referenced
entities are
not in same
include files as
the group.

Not supported. Opens the Entity
Editor of the group
entity.

Undefined
master or
slave in
contact

Checks if groups contain
undefined master or slave
entities.

Lists all groups
that reference
undefined
master or slave
entities.

Not supported. Opens the Entity
Editor of the group
entity.

Unresolved
master or
slave in
contact

Checks if a contact
contains unresolved
entities.

Lists all groups
with unresolved
master or slave
entities.

Not supported. Opens the Entity
Editor of the group
entity.

Parameter and
group title
with &

Checks if a group name
has "&" when a parameter
is defined in the model.

Lists all groups
whose names
have "&" when
a parameter is
defined in the
model.

Not supported. Opens the Entity
Editor of the group
entity.

Group with
invalid name

Checks if a group name
has no more than 100
characters and does not
begin with a "/".

Lists all groups
whose names
are greater than
100 character
or begin with
"/".

Not supported. Opens the Entity
Editor of the group
entity.

Free nodes in
the model

Checks if there are any
free nodes in the model.
Nodes present in EREF
are also not considered
free by the solver. As
they represent the initial
positions.

Lists all of the
free nodes in
the model.

Deletes free nodes. Not supported.
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Incompatible
kinematic
conditions on
nodes

Checks if more than one
type of imposed conditions
is acting on nodes; for
example if nodes are
connected to more than
one of the following -
rigid elements, spotwelds,
boundary conditions and
tied contacts. Based on
skew, attached boundary
condition directions
are checked if they are
constrained in different
dofs.

Lists all of the
nodes that
have more than
one imposed
condition.

Not supported. Opens the Delete
panel.

Systems with
axis badly
defined

Checks if the system axes
are not defined correctly.

Lists all of the
Systs with axis
that are badly
defined.

Not supported. Opens the Systs
panel and updates
the page.

Skew and
nodes not in
same include

Checks if a system and
its nodes are in the same
include.

Lists all of the
systems that
have nodes
which are not
in the same
include.

Not supported. Opens the Entity
Editor of the
system entity.

Parameter and
system title
with &

Checks if a system name
has "&" when a parameter
is defined in the model.

Lists all systems
whose names
have "&" when
a parameter is
defined in the
model.

Not supported. Opens the Entity
Editor of the entity.

Systems with
invalid name

Checks if a system name
has no more than 100
characters and does not
begin with a "/".

Lists all systems
whose names
are greater than
100 character
or begin with
"/".

Not supported. Opens the EEntity
Editor of the entity.

Curve has no
point

Checks if the function
curve has any points
defined.

Lists all of the
function curves
that do not

Creates a (0, 0)
point.

Opens the Curves
panel and updates
the page.
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have any points
defined.

Parameter and
curve title with
&

Checks if a curve name
has "&" when a parameter
is defined in the model.

Lists all curves
whose names
have "&" when
a parameter is
defined in the
model.

Not supported. Opens the Entity
Editor of the entity.

Curve with
invalid name

Checks if a curve name
has no more than 100
characters and does not
begin with a "/".

Lists all curves
whose names
are greater than
100 character
or begin with
"/".

Not supported. Opens the Entity
Editor of the entity.

1 slave node in
Rbody

Checks if there is only one
slave node in a Rbody.

Lists all of the
Rbodies that
have only 1
slave node.

Not supported. Opens the Rigids
panel and updates
the page.

Admas and
nodes not in
same include

Checks if Admas and
nodes are in the same
include.

Lists all pf the
admas that
have nodes
which are not in
same include.

Not supported. Opens the Entity
Editor of the mass
entity.

RBody and
referenced
entities not in
same include

Checks if RBody, nodes,
skew, sensor, and surf are
in the same include.

Lists all of
the rbodies
that reference
entities which
are not in same
include as the
rbody.

Not supported. Opens the Entity
Editor of the
Rbodies.

RLink and
referenced
entities not in
same include

Checks if Rlink, nodes,
and skew are in the same
include.

Lists all pf the
rlinks that have
nodes or skew
which are not in
same include.

Not supported. Opens the Entity
Editor of the Rlink.

Cyclic joint
and nodes
not in same
include

Checks if a cyclic joint and
its nodes are in the same
include.

Lists all of the
cyclic joints
that have nodes

Not supported. Opens the EEntity
Editor of the cyclic
joint.
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which are not in
same include.

Beam: 3 nodes
aligned

Checks that the 3 nodes of
a beam are non collinear.

Lists beams
with 3 nodes
that are
collinear.

Not supported. Opens the Bars
panel.

Small rigid
body with
non-spherical
inertia

Checks if RBODY has non-
spherical inertia.

Lists all small
Rbodies that
have non-
spherical
inertia.

Not supported. Opens the Rigids
panel and updates
the page.

Spring
elements
length greater
than 35

Checks if a spring with
a property of /PROP/
SPR_PUL assigned to its
component has a length
that is less than 35.

Lists all spring
elements with a
length greater
than 35.

Delete the
element.

Not supported.

Rigid body
connected to
only one part

Checks if rigid body slave
nodes are connected
to more than one
component.

Lists all of the
rigid bodies that
are connected
to only one
part.

Not supported. Opens the Delete
panel.

Rigid body
has free slave
nodes

Checks if all dependent
nodes of rigid bodies
are connected to some
element.

Lists all RBODY
that have at
least one free
dependent
node.

Removes the free
end nodes from the
rigid body.

Not supported.

Free spring
elements

Checks if there are free
spring elements

Lists all of the
free spring
elements.

Deletes free spring
elements.

Not supported.

Free bar2
elements

Checks if there are free
bar2 elements.

Lists all the free
bar2 elements.

Deletes free bar2
elements.

Not supported.

Spring elems
with null
length

Checks if spring elements
have a null length.
Excludes those attached to
properties of type 8.

Lists all spring
elements that
have a null
length, other
than those
attached to

Delete the spring
elements.

Not supported.
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properties of
type 8.

Bar2 elems
with null
length

Checks of bar2 elements
have a null length.

Lists all bar2
elements that
have a null
length.

Deletes the bar2
elements.

Not supported.

Mass elements
have zero or
negative mass

Checks if there are any
mass elements that have
zero or negative mass.

Lists all mass
elements that
have zero or
negative mass.

Not supported. Opens the Admas
panel and updates
the page.

Admas not
compatible
with 2D
analysis

Checks if admas is present
in the model, along with
2D analysis.

Lists all admas
elements, if the
2D analysis flag
is set.

Not supported. Opens the Entity
Editor of the entity.

Free mass
elements

Checks if there are free
mass elements.

Lists all of
the free mass
elements.

Deletes free mass
elements.

Not supported.

Joint nodes
are non-
coincident

Checks if a spring element
that has a property of /
PROP/KJOINT2 assigned
to its component has a
node1 and node2 that are
coincident.

Lists all spring
elements with
non-coincident
node 1 and
node 2.

Deletes the
elements.

Not supported.

3-4 Node
shells with
thickness

Checks if 3 or 4 noded
shell elements have a
thickness defined on the
element itself.

Lists all 3 or
4 noded shell
elements with a
thickness.

Not supported. Opens the Entity
Editor of the entity.

Xalea of
Random noise
less than or
equal to zero

Checks for random noise.
You will have a random
noise issue if the attribute
XALEA of RANDOM control
card is not equal to or less
than zero.

Lists all the
RANDOM
control cards
that have an
attribute XALEA
not equal to or
less than zero.

Not supported. Opens the card
image of control
card /RANDOM.

Unused boxes Checks if there are unused
boxes in the model.

Lists all unused
boxes.

Deletes unused
boxes.

Not supported.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1287

Name Description Result Auto correction
action

Manual
correction action

Parameter and
box title with &

Checks if a box name has
"&" when a parameter is
defined in the model.

Lists all boxes
whose names
have "&" when
a parameter is
defined in the
model.

Not supported. Opens the Entity
Editor of the entity.

Boxes with
invalid name

Checks if a box name
has no more than 100
characters and does not
begin with a "/".

Lists all boxes
whose names
are greater than
100 character
or begin with
"/".

Not supported. Opens the Entity
Editor of the entity.

Component
is referring
to undefined
entity

Checks if components
reference undefined
properties or materials.

Lists all
components
containing
undefined
materials or
properties.

Not supported. Opens the Entity
Editor of the entity.

Component
is referring
to unresolved
entity

Checks if components
reference unresolved
properties or materials.

Lists all
components
containing
unresolved
materials or
properties.

Not supported. Opens the Entity
Editor of the entity.

Hourglass
possible on
component

Checks if hourglass is
possible on a component;
if the attached property
has ishell = 1,2 or 3 or
isolid = 1 or 2.

Lists all
components
with property
attributes as
mentioned
earlier.

Not supported. Opens the Entity
Editor of the entity.

Parameter and
component
title with &

Checks if a component
name has "&" when a
parameter is defined in the
model.

Lists all
components
whose names
have "&" when
a parameter is
defined in the
model.

Not supported. Opens the Entity
Editor of the entity.

Comps with
invalid name

Checks if a component
name has no more than

Lists all
components

Not supported. Opens the Entity
Editor of the entity.
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100 characters and does
not begin with a "/".

whose names
are greater than
100 character
or begin with
"/".

Part and
referenced
entities not in
same include

Checks if a part and its
associated entities are in
the same include file.

Lists all parts
which reference
entities that are
not in the same
include file.

Not supported. Opens the Entity
Editor of the entity.

Unused sets Checks if a set is not
referenced by another
entity.

Lists all sets
which are
unused.

Deletes unused
sets.

Not supported.

Empty sets Checks if a set has entity
ids.

Lists all sets
which do not
contain any
entities.

Deletes empty
sets.

Not supported.

Sets with no
finite elements
or nodes

Checks if the defined
set contains valid finite
elements/nodes. This
check does not report sets
already reported under
"empty sets".

Lists all
sets which
have empty
components,
sets, and so
on attached to
them.

Not supported. Opens the Entity
Editor of the entity.

Grspri with
inconsistent
element

Checks if Grspri contains
only spring elements.

Lists all
Grspri that
contain more
than spring
elements.

Not supported. Not supported.

Grbeam with
inconsistent
element

Checks if Grbream
contains only beam
elements.

Lists all
Grbream that
contain more
than spring
elements.

Not supported. Not supported.

Grshel with
inconsistent
element

Checks if Grshel contains
only 4 noded elements.

Lists all Grshel
that contain
more than 4
noded shell
elements.

Not supported. Not supported.
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Grsh3n with
inconsistent
element

Checks if Grsh3n contains
only 3 noded shell
elements.

Lists all Grsh3n
that contain
more than 3
noded shell
elements.

Not supported. Not supported.

Grtruss with
inconsistent
element

Checks if Grtruss contains
only truss elements.

Lists all Grtruss
that contain
more than truss
elements.

Not supported. Not supported.

Grquad with
inconsistent
element

Checks if Grquad contains
only quad elements.

Lists all Grquad
that contain
more than quad
elements.

Not supported. Not supported.

Grbric with
inconsistent
element

Checks if Grbric contains
only brick elements.

Lists all Grbric
that contain
more than brick
elements.

Not supported. Not supported.

Entity set
refers to
undefined
entity

Checks if sets contain
undefined entities.

Lists all sets
that reference
undefined
entities.

Not supported. Opens the Entity
Editor for the
entity.

Entity set is
referring to
unresolved
entity

Checks if a set contains
unresolved entities.

Lists all sets
which refer
to unresolved
entities.

Removes
unresolved entities
from the set.

Not supported.

Parameter and
set title with &

Checks if a set name has
"&" when a parameter is
defined in the model.

Lists all sets
whose names
have "&" when
a parameter is
defined in the
model.

Not supported. Opens the Entity
Editor for the
entity.

Sets with
invalid name

Checks if a set name is no
more than 100 characters
and does not begin with
"/".

Lists all sets
whose names
are greater than
100 characters
or begin with
"/".

Not supported. Opens the Entity
Editor for the
entity.
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Grbeam and
referenced
entity not in
same include

Checks if a Grbeam and its
associated entities are in
the same Include file.

Lists all
Grbeams which
reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Grbric and
referenced
entity not in
same include

Checks if a Grbric and its
associated entities are in
the same Include file.

Lists all Grbrics
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Grnod and
referenced
entity not in
same include

Checks if a Grnod and its
associated entities are in
the same Include file.

Lists all Grnods
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Grpart and
referenced
entity not in
same include

Checks if a Grpart and its
associated entities are in
the same Include file.

Lists all Grparts
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Grquad and
referenced
entity not in
same include

Checks if a Grquad and its
associated entities are in
the same Include file.

Lists all Grquads
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Grsh3n and
referenced
entity not in
same include

Checks if a Grsh3n and its
associated entities are in
the same Include file.

Lists all Grsh3ns
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Grshel and
referenced
entity not in
same include

Checks if a Grshel and its
associated entities are in
the same Include file.

Lists all Grshels
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.
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Grspri and
referenced
entity not in
same include

Checks if a Grspri and its
associated entities are in
the same Include file.

Lists all Grspris
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Grtruss and
referenced
entity not in
same include

Checks if a Grtruss and its
associated entities are in
the same Include file.

Lists all
Grtrusses
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Surf and
referenced
entity not in
same include

Checks if a Surf and its
associated entities are in
the same Include file.

Lists all Surfs
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Bcs, grnod,
skew not in
same include

Checks if Bcs, Grnod, and
skew are in same include.

Lists all bcs that
have nodes or
skew which are
not in same
include.

Not supported. Opens the Entity
Editor of the load
collector entity.

Inivel, grnod
and skew
not in same
include

Checks if Inivel, Grnod
and skew are in same
include.

Lists all inivel
whose nodes or
skew are not in
same include.

Not supported. Opens the Entity
Editor of the load
collector entity.

Impvel, and
referenced
entities not in
same include

Checks if impvel, grnod,
sensor, skew and curves
are in the same include.

Lists all impvel
with nodes,
sensor, skew,
or curves that
are not in same
include as itself.

Not supported. Opens the Entity
Editor of the load
collector entity.

Impdisp, and
referenced
entities not in
same include

Checks if impdisp, grnod,
sensor, skew, and curves
are in the same include.

Lists all impdisp
with nodes,
sensor, skew,
or curves that
are not in same
include as itself.

Not supported. Opens the Entity
Editor of the load
collector entity.
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Pload,
referenced
entities not in
same include

Checks if Pload, Surf,
sensor, Skew, and Curves
are in the same include.

Lists all pload
with surfs,
sensor, contact
surfs, skew,
or curves that
are not in same
include as itself.

Not supported. Opens the Entity
Editor of the load
collector entity.

Grav, and
referenced
entities not in
same include

Checks if Grav, Grnod,
sensor, Skew, and curves
are in the same include.

Lists all grav
with nodes,
sensor, skew,
or curves that
are not in same
include as itself.

Not supported. Opens the Entity
Editor of the load
collector entity.

Parameter and
loadcol title
with &

Checks if a load collector
name has "&" when a
parameter is defined in the
model.

Lists all load
collectors whose
names have
"&" when a
parameter is
defined in the
model.

Not supported. Opens the Entity
Editor for the
entity.

Detpoint and
referenced
entities not in
same include

Checks if a Detpoint and
its associated entities are
in the same Include file.

Lists all
Detpoints
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Activ and
references
entities not in
same include

Checks if an Activ and its
associated entities are in
the same Include file.

Lists all Activs
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Unresolved ids
in Activ

Checks if an Activ contains
unresolved entities.

Lists all Activs
which reference
entities that are
unresolved.

Not supported. Opens the Entity
Editor for the
entity.

Cload and
referenced
entities not in
same include

Checks if a Cload and its
associated entities are in
the same Include file.

Lists all Cloads
which reference
entities that are

Not supported. Opens the Entity
Editor for the
entity.
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not in the same
Include file.

Convec and
referenced
entities not in
same include

Checks if a Convec and its
associated entities are in
the same Include file.

Lists all Convec
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Impacc and
referenced
entities not in
same include

Checks if an Impacc and
its associated entities are
in the same Include file.

Lists all Impaccs
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Imptemp and
referenced
entities not in
same include

Checks if an Imptemp and
its associated entities are
in the same Include file.

Lists all
Imptemps
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Pfluid and
referenced
entities not in
same include

Checks if a Pfluid and its
associated entities are in
the same Include file.

Lists all Pfluids
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Radiation and
referenced
entities not in
same include

Checks if a Radiation and
its associated entities are
in the same Include file.

Lists all
Radiations
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Detline and
referenced
entities not in
same include

Checks if a Detline and its
associated entities are in
the same Include file.

Lists all Detlines
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Waveshapers
and referenced
entities not in
same include

Checks if a Waveshaper
and its associated entities
are in the same Include
file.

Lists all
Waveshapers
which reference
entities that are

Not supported. Opens the Entity
Editor for the
entity.
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not in the same
Include file.

Laser and
referenced
entities not in
same include

Checks if a Laser and its
associated entities are in
the same Include file.

Lists all Lasers
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Inout and
referenced
entities not in
same include

Checks if an Inout and its
associated entities are in
the same Include file.

Lists all Inouts
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Loadcols with
Invalid name

Checks if a load collector
name is not more than
100 characters and does
not begin with a "/".

Lists all load
collectors whose
names are
greater than
100 characters
or begin with
"/".

Not supported. Opens the Entity
Editor for the
entity.

Unused
BeamSections

Checks if any beamsection
defined in the model is
unused.

Lists all of
the unused
beamsections in
the model.

Deletes the unused
beamsections.

Not supported.

Unused
parameters

Checks if there are any
unused parameters in the
model.

Lists all
parameters that
are unused/not
referenced in
another entity.

Deletes unused
parameters.

Not supported.

Parameter
definition in
include file

Checks if parameters are
present in include files. If
yes, then give a warning.
PARAMETER/LOCAL is
currently not supported,
hence the check.

Lists all
parameters that
are defined in
the include file.

Not supported. Opens the Entity
Editor of the
parameter entity.

Fcut is greater
than or equal
to 0 for Accel

Checks if Fcut is greater
than zero on an Accel
card.

Lists all Accels
with Fcut less
than or equal to
zero.

Not supported. Opens the Entity
Editor for the
entity.
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More than one
Accel on the
same node

Checks if more than one
Accel is acting on the
node.

Lists all Accels
repeated on the
node.

Not supported. Opens the Entity
Editor for the
entity.

Accel and
referenced
entities not in
same include

Checks if an Accel and its
referenced entities are in
the same Include file.

Lists all Accels
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Node id and
skew id for
accel card are
unresolved

Checks if node_id and
skew_id are unresolved for
the accel card.

Lists all
Accels with
an unresolved
node_id or
skew_id.

Not supported. Opens the Entity
Editor for the
entity.

Nodes with
same skew in
different TH

Checks if the same node
with the same system is
referenced in more than
one TH.

Lists all output
blocks that
contain a node
that is repeated
with the same
system.

Not supported. Opens the Entity
Editor for the
entity.

TH with
repeated
entities

Checks if entities are
repeated within each TH.

Lists all
output blocks
that contain
repeated node
IDs.

Not supported. Opens the Entity
Editor for the
entity.

Parameter and
output block
title with &

Checks if an output block
name has "&" when a
parameter is defined in the
model.

Lists all output
blocks whose
names have
"&" when a
parameter is
defined in the
model.

Not supported. Opens the Entity
Editor for the
entity.

Output blocks
with invalid
name

Check if an output block
name is no more than 100
characters and does not
begin with "/".

Lists all output
blocks whose
names are
greater than
100 characters
or begin with
"/".

Not supported. Opens the Entity
Editor for the
entity.
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Th and
referenced
entities not in
same include

Checks if Th and its
associated entities are in
the same Include file.

Lists all Th
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Parameter and
contact surf
title with &

Checks if a contact surface
name has "&" when a
parameter is defined in the
model.

Lists all contact
surfaces whose
names have
"&" when a
parameter is
defined in the
model.

Not supported. Opens the Entity
Editor for the
entity.

Contact surfs
with invalid
name

Checks if a contact surface
name is not more than
100 characters and does
not begin with "/".

Lists all contact
surfaces with
names greater
than 100
characters or
begins with "/".

Not supported. Opens the Entity
Editor for the
entity.

Monvol, surfs,
sensors,
curves not in
same include

Checks if a control volume
and its associated surface,
sensor, or curve are in the
same Include file.

Lists all control
volumes which
reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Control vols
with invalid
name

Checks if a control volume
name is not more than
100 characters and does
not begin with "/".

Lists all control
volumes with
names greater
than 100
characters or
begin with "/".

Not supported. Opens the Entity
Editor for the
entity.

Parameter and
control vol title
with &

Checks if a control volume
name has "&" when a
parameter is defined in the
model.

Lists all control
volumes whose
names have
"&" when a
parameter is
defined in the
model.

Not supported. Opens the Entity
Editor for the
entity.
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Incompatible
material

Checks if materials and
properties are compatible
with xref and refsta.

Lists all xref/
refsta with
incompatible
materials or
properties.

Not supported. Opens the Entity
Editor for the
entity.

Eref
incompatible
material

Checks if materials and
properties are compatible
with Eref.

Lists all
Eref with
incompatible
materials or
properties.

Not supported. Opens the Entity
Editor for the
entity.

XRef or Refsta,
and nodes
not in same
include

Checks if Xref/Refsta and
its nodes are in the same
include.

Lists all impdisp
with nodes,
skew, or curves
that are not
in the same
include as itself.

Not supported. Opens the Entity
Editor of the
control volume
entity.

Airbag1 and
referenced
entities not in
same include

Checks if an Airbag1 and
its associated entities are
in the same Include file.

Lists all
Airbag1s which
reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Area and
referenced
entities not in
same include

Checks if an Area and its
associated entities are in
the same Include file.

Lists all Areas
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Commu1 and
referenced
entities not in
same include

Checks if a Commu1 and
its associated entities are
in the same Include file.

Lists all
Commu1s
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Fvmbag1 and
referenced
entities not in
same include

Checks if a Fvmbag1 and
its associated entities are
in the same Include file.

Lists all
Fvmbag1s
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.
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Pres and
referenced
entities not in
same include

Checks if a Pres and its
associated entities are in
the same Include file.

Lists all Pres
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Perfect gas
and referenced
entities not in
same include

Checks if an Perfect gas
and its associated entities
are in the same Include
file.

Lists all Perfect
gases which
reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Airbag and
referenced
entities not in
same include

Checks if an Airbag and its
associated entities are in
the same Include file.

Lists all Airbags
which reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Commu and
referenced
entities not in
same include

Checks if a Commu and its
associated entities are in
the same Include file.

Lists all
Commus which
reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editorfor the entity.

Fvmbag and
referenced
entities not in
same include

Checks if a Fvmbag and its
associated entities are in
the same Include file.

Lists all
Fvmbags which
reference
entities that are
not in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Sections, N1,
N2, N3 not in
same include

Checks if a Cross Section
and its associated nodes
are in the same Include
file.

Lists all Cross
sections which
reference nodes
that are not
in the same
Include file.

Not supported. Opens the Entity
Editor for the
entity.

Sections, sets
and frames
not in same
include

Checks if a Cross section
and its associated sets and
frames are in the same
Include file.

Lists all Cross
sections which
reference sets
and frames that
are not in the

Not supported. Opens the Entity
Editor for the
entity.
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Name Description Result Auto correction
action

Manual
correction action

same Include
file.

Parameter and
cross section
title with &

Checks if a cross section
name has "&" when a
parameter is defined in the
model.

Lists all cross
sections whose
names have
"&" when a
parameter is
defined in the
model.

Not supported. Opens the Entity
Editor for the
entity.

Cross sections
with invalid
name

Checks if a cross section
name has no more than
100 characters and does
begin with "/".

Lists all cross
sections whose
names are
greater than
100 characters
or begin with
"/".

Not supported. Opens the Entity
Editor for the
entity.

Prop17
Incompatible
with /
INISHE_ORTHO_LOC
or /
INISH3_ORTHO_LOC

Lists all
properties
linked to
elements
referenced
by /INISHE/
ORTHO_LOC
or /INISH3/
ORTHO_LOC
tables.

Not supported. Opens the Entity
Editor for the
property entity.

Info

Name Description Result Auto correction
action

Manual
correction action

Number
of defined
materials

Checks for the number of
defined material entities in
the model.

Lists all
materials in the
model.

Not supported. Not supported.

Number of
undefined
materials

Checks for the number of
undefined material entities
in the model.

Lists all of
the undefined
materials.

Not supported. Not supported.
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Name Description Result Auto correction
action

Manual
correction action

Number
of defined
properties

Checks for the number of
defined property entities in
the model.

Lists all of
the defined
properties.

Not supported. Not supported.

Number of
undefined
properties

Checks for the number of
undefined property entities
in the model.

Lists all of
the undefined
properties.

Not supported. Not supported.

Number of
groups

Checks for the number
of group entities in the
model.

Lists all group
entities.

Not supported. Not supported.

Nodes not
connected to
elements

Checks if there are
any nodes that are not
connected to elements.

Lists all of the
nodes in the
model that are
not connected
to elements.

Not supported. Not supported.

Number of
defined curves

Checks for the number of
defined curve entities in
the model.

Lists all of the
defined curves.

Not supported. Not supported.

Number of
undefined
curves

Checks for the number of
undefined curve entities in
the model.

Lists all of
the undefined
curves.

Not supported. Not supported.

Number of
defined sets

Checks for the number of
defined set entities in the
model.

Lists all of the
defined sets.

Not supported. Not supported.

Number of
undefined sets

Checks for the number
undefined set entities in
the model.

Lists all of the
undefined sets.

Not supported. Not supported.

Number of
output blocks

Checks for the number
of output blocks in the
model.

Lists all of the
output blocks.

Not supported. Not supported.
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Part Browser
Use the Part Browser to create, organize and manage the CAE part structure/hierarchy.

To open the Part Browser, click View > Browsers > HyperMesh > Part Browser from the menu bar.

The browser opens in its own tab in the tab sidebar. You can undock the browser so that it appears as a
free-floating dialog.

You can undo and redo actions made in the Part Browser using the Undo and Redo commands on the
toolbar. The undo/redo history will be reset as soon as you create a part or part assembly. Edits made
to parts and part assemblies cannot be undone, whereas edits made to components can be undone.

Part Browser Interface
The Part Browser consists of two panes; the first pane displays the model structure, part assembly, and
part attributes and the second pane displays the Entity Editor.
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By default, the following attributes are listed as columns in the first pane.

Add or remove columns by right-clicking on a column and checking/unchecking the appropriate 
attribute. You can also select Column Visibility from the right-click context menu to invoke the 
Column Visibility dialog, from which you can turn the display of columns on/off.

Sort by a particular entity in the browser by clicking on the heading of each column. For fields that are 
numeric and/or alphanumeric, repeated clicks toggles between ascending and descending order.

Column Description

Entity List of the Model, Part Assemblies, Parts and
Components. By default the browser is displayed
in Hierarchical View.

Proprietary Information of Altair Engineering

Color Displays the Component and Part entity colors.

UID Displays the Part Assembly and Part Unique IDs.

Revision Displays the Major revision, Study revision, and
Library Part revision.

Representation Displays the in-session/loaded representation.

Active Displays the Part entity active status.

For a full description of usage, refer to
Configuration Management.

CID Displays the entity specific Component ID’s.
At the Part level it displays IDs for owned
components. At Component level it shows the ID
of components.

PID Displays the entity specific Property ID’s. At
the Part level it displays IDs for referenced
properties. At Component level it shows the ID of
the referenced property.

MID Displays the entity specific Material ID’s. At
the Part level it displays IDs for referenced
materials. At Component level it shows the ID of
the referenced material.

Material Displays the material name.

Thickness Displays the entity specific thickness. At the Part
level it displays the thicknesses of the referenced
properties. At Component level it shows the
thickness of the referenced property.
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PDM metadata captured upon the importation of a BOM via the Import tab will also be listed as
columns.

Column Description

PDM PID PDM Property ID metadata.

PDM MID PDM Material ID metadata.

PDM Material PDM Material name metadata.
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PDM Thickness PDM Thickness metadata.

PDM MeshFlag PDM Mesh metadata (not case sensitive).

PDM Variant Condition If non-empty, displays the part that is used as a
variant in one or multiple part configurations. It is
user editable in the Entity Editor.

PDM Variant Scope Along with the Variant Condition attribute, displays
which part configurations the part belongs to as a
variant. It is user editable in the Entity Editor.
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View Modes

At the top of the Part Browser, you can access different views to be used to create and organize parts,
part assemblies, part sets and configurations.

Figure 460:

1. Part View. Displays a single view in the Part Browser, from which you can create, organize, and
manage parts, part assemblies, and components in the CAE part structure/hierarchy.

2. Part Set View. Splits the Part Browser into two views: Part Set and Part. In the Part Set view you
can create, organize and, manage part sets.

3. Configuration View. Splits the Part Browser into three vertical views: Configuration, Part Set,
and Part. In the Configuration view you can create, organize and, manage configurations.

4. Configuration View, Split Left. Splits the Part Browser into three views: Configuration, Part Set,
and Part. In the Configuration view you can create, organize and, manage configurations.

Part View Modes
In Part view, change the display of entities in the browser using the predefined browser views.

Figure 461:

1. Hierarchical Part View. Displays all entities, including components, in a hierarchical view.
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2. Flat Part View. Displays all entities, with the exception of components, in a flat list. Part
Assemblies and Parts are logically grouped into their own collectors.

Figure 463:

For example, in Flat View, you can use the Query Builder to isolate part entities. In the example
BOM shown above, setting the entity type filter to Part will result in the following view.

Figure 464:

Query Builder
Use the query builder to find and filter entities by building advanced filters for attributes listed in
browser columns.

Recent filters are saved and can be quickly accessed by clicking .
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Interactively Build Queries

1. To expose the interactive query builder, click the Expand/Collapse icon .

By default, the name, id, and type attribute fields are exposed.

2. Filter via name and/or id by typing a string into the text field and pressing Enter.

3. Change the entity type by clicking on the type field and selecting a desired entity type.

4. Apply your selection by clicking .

An example of an interactively defined query is shown in the image below. In this example, four
additional attribute fields were added.

Figure 466:

Tip:

• To select multiple entity types, press and hold Control.

• Add additional attribute fields by clicking . Remove attribute fields by clicking .
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Manually Build Queries

Manually build queries by typing into the text field.
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Entering this string... Returns this result...

2 All entities that contain the number 2 in their ID.

"2" All entities with the ID 2.

shell All entities that contain shell in their name.

"shell" All entities with the name shell.

name: shall AND id: 2 All entities that contain shell in their name and 2 in their ID.

id:>10 AND id:<20 AND
name:cent

All entities that contain cent in their name and have an ID greater than
10 and less than 20.

1-4 All entities with the IDs 1, 2, 3, and 4.

type:comp AND id:1-4 All components with the IDs 1, 2, 3, and 4.

Context Menu
Use the Part Browser context menu to invoke key functions and visualization options. Options vary
based on the entity type selected.

Option Description

Create Creates a Part Assembly, Part, Part Instance,
or Component. If Create is invoked in the white
space of the browser, the entity will be placed
in the root level (Model). If Create is invoked on
an entity, such as a Part Assembly, the resulting
entity will reside in the selected entity.

If a part contains components, and it is selected
as the current part, then part assemblies and
parts cannot be created from the context menu
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Option Description

when you right-click in the white space of the
browser.

Unused & Empty Delete unused and/or empty part assemblies and
parts.

Create Variants Creates Part Set(s) per PDM Variant Condition
attribute found in the global Part Assembly/Part
hierarchy.

Only available in the Part Set pane of the Part Set
and Configuration views.

Part Set(s) will be recreated on each invoke of the
operation.

Transform Invokes the Transform tool, from which you can
transform the selected Part Assemblies and/or
Parts via the following actions; Translate, Rotate,
and Reflect.

The Transform tool is automatically invoked on the
creation of a Part Instance.

Transformations are performed on the contents of
the Part, but the transformation matrix is updated
on the Part(s).

Figure 468:

Delete Deletes the selected entity.

Select the Delete Part Contents checkbox to
delete the selected entity and all of its contents.
For example, if Delete is invoked on a Part
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Option Description

Assembly that contains a Part (also containing a
Component), then the Part Assembly, Part, and
Component will be deleted from the model.

Rename Enables you to rename the selected entity in the
browser.

Alternatively, entities can also be renamed in the
Entity Editor, General Information section.

Make Current Sets the selected entity to current. The current
collector status is indicated in bold.

Only applicable to parts.

Move under Current Moves the selected entities to the current entity.

Not applicable to PDM parts.

Move Contents to Current Moves the selected part's component(s) to the
current entity.

Only available for parts.

Representations Displays the Representations sub-menu.

Library Displays the Library sub-menu.

Sync
Syncs the in-session version with the latest,
available version in the Part Library. If the
version available in the current session is
out of sync with the Library reversion, use
Sync to update the session version with the
Part Library version.

Libraries
Opens the Libraries dialog for library
management.

Library Viewer
Opens the Library Viewer dialog, which
can be used to explore the contents of your
library.

Save As Saves the currently selected Parts/ Part Assembly
to a HyperMesh binary file. All child Parts and
Components and the Part structure are saved.
Parts under different sub assemblies can be
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Option Description

selected and saved under one HyperMesh binary
file.

XRef Entities Invokes the References Browser for the selected
entities, which displays any referenced entities in
the model.

Review Invokes Review mode, which displays selected
entities irrespective of their display state, masked,
active state (Entity State Browser), but not
outside of the spherical clipping (if enabled).

Show Displays the selected entity in the graphics area.
A shaded entity icon in the Part Browser indicates
that the entity is displayed in the graphics area.

Hide Hides the selected entity in the graphics area

An opaque entity icon in the Part Browser
indicates that the entity is not displayed in the
graphics area.

Isolate Isolates the selected entity in the graphics area,
and hides all other entities.

Collapse/Collapse All Collapses the selected entity folder(s).

Collapse All is only available when you invoke the
context menu by right-clicking in the white space
of the browser.

Expand/Expand All Expands the selected entity folder(s).

Expand All is only available when you invoke the
context menu by right-clicking in the white space
of the browser.
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The attributes available in the Entity Editor vary based on the entity type selected.

Part/Part Assembly
General Data

Displays attributes that are unique to the part or assembly, including part/assembly name, Unique
ID (UID), color, and include file, and Revision data.
Parts and part assemblies require a unique name and a unique identifier (UID), both of which can
contain alphanumeric characters. The UID is an optional field that is utilized in part representation
management and import model entity management. For example, when merging a component
with a part (module), the two entities will be matched using the UID if it exists. If a UID does not
exist, merging will be based on the part name.

Representations Data
Displays attributes that are specific to a part representation, such as representation name, file
location, property ID, material ID/name, and thickness. These attributes are non-editable at the
part level.

Position Data
Displays the 4 x 3 transformation matrix of a part, namely its translation, rotation, and scaling.
These attributes are non-editable.
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Entity Editor
Edit part and component attributes in the Entity Editor.

Edits can be made for a single part or component or multiple parts and components. If a component is
selected, the Entity Editor displays component specific attributes.

Part Set
General Data

Displays attributes that are unique to the part set, including part/assembly name and ID.

Part Assemblies / Parts Data
Displays the number of parts organized into the selected part set.
Click the Part Assemblies/Part field to select parts and part assemblies to organize into the
selected part set. Select entities in the Select Part Assemblies/Parts dialog, or from the
graphics area when the Parts selector is enabled.

Part Sets Data
Displays the number part sets organized into the selected part set.
Click the Part Sets field to select part sets to organize into the selected part set. Select entities in
the Select Part Sets dialog, or from the graphics area when the Partsets selector is enabled.

PDM Data
Displays PDM attributes that were parsed as metadata during the BOM importation, such as PDM
ID, PDM Revision, PDM Variant Condition and PDM Variant Scope. This information, namely the
PDM PID, PDM MID, PDM Material and PDM Thickness, is used to generate the initial component,
property, and material cards upon creation of the common representation. These attributes can be
used to cross-reference common and discipline specific mesh representation attributes.
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Click the Part Assemblies/Part field to select parts and part assemblies to organize into the
selected configuration. Select entities in the Select Part Assemblies/Parts dialog, or from the
graphics area when the Parts selector is enabled.

Configurations Data
Displays the number of configurations organized into the selected configuration.
Click the Configurations field to select other configurations to organize into the selected
configuration. Select entities in the Select Configurations dialog, or from the graphics area
when the Configurations selector is enabled.

Part Sets Data
Displays the number part sets organized into the selected configuration.
Click the Part Sets field to select part sets to organize into the selected configuration. Select
entities in the Select Part Sets dialog, or from the graphics area when the Partsets selector is
enabled.

Active
Indicates the active/inactive state of the selected configuration. This attribute is non-editable. To
activate a configuration, enable the configuration’s associated checkbox in the Active column of
the Configuration view.
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Configuration
General Data

Displays attributes that are unique to the configuration, including name, and ID.

Parts Assemblies / Parts Data
Displays the number of parts organized into the selected configuration.
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Reference Browser
The Reference Browser enables you to quickly understand complex relationships between different
entities that constitute the model.

To navigate and understand the relationships between the different entities, double-click on an entity to
trigger a cross referencing operation.

Cross referencing operations are recorded in the Reference Browser. To navigate between cross
referenced states, click the forward and back buttons in the top, left corner of the browser.

Figure 469:
Forward and back buttons enabled to navigate between cross references states.

Use the Entity Editor to review and edit HyperMesh specific and solver specific data, for one or more of
the entities listed in the browser. To invoke the Entity Editor, select the entities you want to review.

Figure 470:
Entity Editor invoked in the Reference Browser.

Simplified and Detailed View
The Reference Browser consists of two views: Simplified and Detailed. Select which view to display from
the right-click context menu.
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Figure 471: Simplified View

Figure 472: Detailed View

In the Simplified view the name, ID, Type and Include File of the populated entity(s) are displayed. The
selected entity(s) for cross referencing is displayed in bold to differentiate. References of the selected
entity(s) are listed below the entity(s), and cross references are listed above the entity(s).

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1315

Figure 473: References and Cross References of a Component

Cross referenced entities are shown in a flat list. If there is more than five instance of a given entity or
element configuration, then entities will be displayed in a folder. For elements and nodes, the detailed
content of the folders is not exposed, as the number of entities cannot be contained in a folder.

Elements are also segregated by type and configuration. Rigid elements, rbe3 and spotweld are listed
separately.

Figure 474: Segregation of Elements by Type and Configuration

In the Detailed view, related entities are broadly classified into Reference and Cross-reference folders,
and entities are listed accordingly.

References, represented by , correspond to entities that are referenced by the specified entity.

The hierarchy is a view down from the selected entity(s) within the model, listing the entities that are
referred to by the selected entity(s). For example, in the case of a component, the References folder
lists the elements, material, and property assigned to the component.

Cross-references, represented by , correspond to entities that reference the specified entity. The

hierarchy is a view up from the selected entity(s) within the model, listing the entities that refer to
the selected entity(s). For example, in the case of a component, the Cross-references folder lists the
groups, sets, output blocks, and so on that refer to the selected component. For components, the
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Cross-reference folder contains sub folders named Node ( ) and Element ( ), which lists the entities

where the selected component’s node or element is referred.

In the Detailed view, the name, ID, color, Card Image and Include File of the populated entity(s) are
displayed. Nodes and elements are not listed individually in the Reference or Cross-reference folders,
however each entity's count will be displayed next to the folder.

Figure 475: Detailed View in the Reference Browser

Context Menu
The Reference Browser supports its own context menu. To access the context menu, right-click on any
entity.

The available menu options vary based on the entity selected.

XRef Entities
Applies reference on the selected entity and then updates the Reference Browser with new
results.

Show
Displays the selected item in the graphics area if it is currently hidden.
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In cases of card images, such as contacts and boundary conditions, that do not have entities of
their own but refer to another entity, namely sets, the Reference Browser displays the entities
(node, element) that are used in the set that is referred in the selected card image. Also, the
Reference Browser displays any handles, geometric representation, associated with entities.

Hide
Turns off the selected item in the graphics area if it is currently visible.
In cases of card images, such as contacts or boundary conditions, that do not have entities of
their own, but refers to another entity, namely sets, the entities (node, element) that are used in
the set that is referred in the selected card image are hidden. Also, the Reference Browser hides
any handles, geometric representation, associated with entities.

Isolate
Displays only the selected item in the graphics area and hides all of the other items.
In cases of card image, such as contacts and boundary conditions, that do not have entities of
their own but refer to another entity, namely sets, the Reference Browser isolates the entities
(node, element) that are used in the set that is referred in the selected card image. Also, the
Reference Browser shows any handles, geometric representation, associated with selected solver
entity.

Review
Highlights the selected item in the graphics area and greys out all other items. This option works
on all of the individual entities listed in the Reference Browser, except at the folder level.
In cases of card images, such as contacts and boundary conditions, that do not have entities of
their own but refer to another entity (namely sets), the Reference Browser highlights the entities
that constitute the set. The graphics area remains in that review mode until you select Reset
Review.

Card Edit
Opens the Card Editor, from which you can modify any editable input value fields for a selected
entity. The modified fields update in the Entity Editor and in all of the browser.

List References
Turns the display of the References folder on and off in the browser. The Reference folder contains
all of the entities that are referenced by the selected entity(s). By default the References folder is
displayed.

List Cross References
Turns the display of the Cross-references folder on and off in the browser. The Cross-references
folder contains entities that reference the selected entity(s). By default, the Cross-references
folder is displayed.

Merge Results
Groups the results of the selected entities, which may be of different entity types, and lists them
in the browser. By default, the Reference Browser lists each entity separately in the order of its
type.

Detailed View
Enables you to switch between Detailed and Simplified view.
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Solver Browser
The Solver Browser provides a solver centric view of the model structure in a flat, listed tree structure.

Hierarchical structures are only available for card images that allow variations with themselves. For
example, the MAT card image has several different material types and each material has its own entity
defined in HyperMesh, so a hierarchical structure is used to list them all.

The Solver Browser lists every entity mapped to a solver card image within the session and places
those entities into their respective solver card image folders. The total number of entities is displayed
in parenthesis next to the entity name. To display every entity type supported by the solver in the
browser, go to the Browser Configuration dialog, Local Options, and select Show empty folders.

In the LS-DYNA user profile, the Solver Browser supports two view modes: Solver and Include Solver
view. Switch between the two view modes by clicking their respective icons in the top, left corner of the
browser.

Figure 476:

In the Include Solver view, data is organized into Include files. Data which does not have any references
to an Include file is stored in the master model.

Figure 477: Solver View
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Figure 478: Include Solver View

The Solver Browser includes toolbars, a context menu and controls built into the display. Toolbars
provide the ability to show and hide entities (component, material and property) within the model, and
add entities to a panel collector. These abilities are collectively tree referred to as display controls and
browser modes. The context menu provides basic functions such as card editing, creation, deletion,
display control and review.

Browser Attributes (Columns)
By default, the following attributes are listed as columns in the browser.

Add or remove columns by right-clicking on a column and checking/unchecking the appropriate
attribute. You can also select Column Visibility from the right-click context menu to invoke the
Column Visibility dialog, from which you can turn the display of columns on/off.

Sort by a particular entity in the browser by clicking on the heading of each column. For fields that are
numeric and/or alphanumeric, repeated clicks toggles between ascending and descending order.

Column Description

Entity Lists every named entity within the session; however, it does not support
non-named entities such as nodes and elements.

ID Unique entity ID

Color Entity color

Include ID of Include file the entity is stored within.
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Column Description

FE-Style Lists the element style applied to each entity. Click the icon to change the
element style.

Context Menu
A context menu of actions is available for any selected item in the Solver Browser.

To open the context menu, right-click on either an entity folder or an individual entity.

Note:  Some of these options vary depending on which user profile you have loaded.

Table 14:

Option Description

Card Edit Opens the Card Image panel for the selected card. This operation can be
performed on both folder and individual entity levels.

Collapse All Closes all of the folders in the browser, so that only the top-most level of
items displays.

Column Visibility Turns the display of the Color and FE Style columns in the browser on and
off.

Configure Browser Opens the Local View Options dialog, from which you can determine
which entities and columns to display in the browser. Global options includes
options that are common across all user interfaces; Local options includes
solver specific options.

Create Enables you to create an entity. Once you select a solver keyword, the
Entity Editor or panel, applicable to the solver entity, opens.

Delete Deletes selected item from the session. If the selected item has "children"
associated to it, the children are retained and only the entity is deleted.

For example, if a contact has a surface and node set associated with it, and
the contact is deleted, only the contact card image is deleted. The surface
and node set associated with it is retained. This is the same at both folder
and individual entity level.

Delete Advanced Displays a comprehensive preview of the entities uniquely related to the
selected component that can also be deleted.

Only available for components in the LS-DYNA user profile.
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Option Description

Figure 479:

Empty Preview and delete empty collectors.

This operation can be performed on several entity types at the same time.
To append entity types to the selection, left-click while pressing Control.

Only available for the following entity types: Component, Load Collector,
System Collector, Set, Group, Assembly, Vector Collector, Output Block,
Load Step, Beam Section Collector, Control Volume (OptiStruct) and
Multibody.

Figure 480:

Expand All Opens all of the folders in the entire browser, exposing every item nested at
every level.
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Option Description

Find Attached Finds entities attached to the selected card(s) or entity(s). Find attached
is implemented only for card images mapped to component collectors,
namely PART cards and 1D elements that include beams, mass elements,
truss, rigid and joints. Find attached displays elements (0D, 1D)
and components that are connected to the selected entity through
sharing a common node, connectors, and special connection cards like
*CONSTRAINED_EXTRA_NODE, *CONSTRAINED_RIGID_BODY. Only
available in the LS-DYNA, Radioss and PAM-CRASH 2G user profiles.

Hide Turns off the selected item in the graphics area if it is currently visible. In
case of card images like contacts, boundary conditions, and so on, that
do not have entities of its own but refer to another entity, namely sets,
it turns off the entities (node, element) used in the set that is referred
in the selected card image. Also, it turns off any handles, geometric
representation associated with entities.

Isolate only Displays selected item in the graphics area and hides all of the other items.
In cases of card images, such as contacts and boundary conditions, that do
not have entities of its own but refers to another entity, namely sets, the
Solver Browser isolates the entities (node, element) used in the set that
is referred in the selected card image. Also, the Solver Browser shows any
handles, geometric representation, associated with selected solver entity.

Make Current Makes the selected collector entity the current collector. The current
collector status is indicated in bold. New components, loads, beam sections,
or multibodies will be created within the respective current collector.

Rename Enables an editable text field, from which you can rename the selected
entity.

Reset Review Resets the screen from review mode to normal mode.

Review Invokes Review mode, which displays selected entities irrespective of their
display state, masked, active state (Entity State Browser), but not outside
of the spherical clipping (if enabled).

Show Displays the selected item in the graphics screen if it is currently hidden.

In the case of card images (contacts, boundary conditions, and so on)
that do not have entities of their own but reference other entities (namely
sets), the entities (node, element) used in the set that is referenced by the
selected card image are displayed. This operation also displays any handles
as geometric representation associated with entities.

Unused Preview and delete unused property collectors, material collectors, curves,
and so on.
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Option Description

This operation can be performed on several entity types at the same time.
To append entity types to the selection, left-click while pressing Control.

Only available for the following entity types: System, Property, Curve,
Material.

Figure 481:

XRef Entities Opens the Reference Browser and displays the relationship of the selected
card(s) or entity(s) to other entities in the model in a hierarchical tree
structure.

Configure the Solver Browser
Configure the display and behavior of the Solver Browser.

1. Right-click in the browser and select Configure Browser from the context menu.

2. Edit local and global options.

Global options include options that are common across all user interfaces; Local options include
solver specific options.

Local Options

Show empty folders
Display every entity type supported by the solver in the browser.

Maximum number of items
Change the maximum number of items to display in the browser.
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Show/Hide/IsolateOnly Attached
When performing Show/Hide/Isolate Only on loads, load collectors, load steps, groups, and
contact surfaces, attached elements will also be included in the operation in the graphics area.
This can be observed if the elements are currently masked or the elements belonging to the
component's display state is off.

Show/Hide/Isolate Include files with XRef
When performing Show/Hide/Isolate on Include files, the contents in the Include files will also
be included in the operation. If you turn this option off, Show/Hide/Isolate will only affect
components and other entities that have graphics (vectors, systems, plies, laminates, loads) in
the Include file.

Hide Attached
When performing Hide on loads, load collectors, load steps, groups, and contact surfaces,
attached elements will also be masked in the graphics area. This could be observed if the
elements are currently displayed.

Delete association
Open the Delete component(s) and unique associations dialog when Delete Advanced is
selected from the context menu. When this box is checked off, the Delete component(s) and
unique associations dialog does not open when Delete Advanced is selected from the context
menu, and the entities uniquely related to the selected component are automatically deleted. Only
available for components in the LS-DYNA user profile.

Global Options

Autofit
Fit the selected entities to the graphics area whether using the context menu or the Selector,
Show/Hide, or Isolate functionality to control the display.

Stripe background
Turn the white and gray stripe background in the browser on. When off, the browser background
is white.
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Utility Menus
The Utility menu contains options that allow you to customize the standard interface to include function
buttons, radio options, and text that have HyperMesh-supplied and user-defined macros associated with
them.

The menu is located on a tab of the tab area pane(s), and can be shown or hidden from within the View
menu.

The Utility menu includes several pages of its own, each dedicated to different tasks. Thus it is actually
a group of menus, although only one displays at a time. Each page is associated with a button at the
bottom of the Utility menu; clicking one of these buttons opens the page associated with it. Only one
button can be depressed at a time, similar to the way that only one radio button can be active at a time
- selecting a button de-selects all of the other buttons in the group.

A macro file (hm.mac) controls the display and available operations of the Utility menu. Attributes that
you can change include:

• The Utility menu page on which the operations appear

• Text to be displayed on each control

• Location and size of the menu

• The help string to be displayed on the menu bar

• The macro to call when each control is used, with optional arguments to pass

Use page number to create multiple pages, so that you can group the macros by type of operation.

Macros may contain any valid command file command, and are enclosed by the *beginmacro() and
*endmacro() commands. Macros may accept variable arguments, passed to them from a control,
by using the arguments $1, $2, etc. to specify where the arguments should be substituted. The
*callmacro() command calls a macro from within another one, which allows you to create groups of
standard reusable macros.

When HyperMesh starts, it looks for a macro file named hm.mac in the current directory, HOME directory
(UNIX only), or the application’s base directory. If it finds this macro, HyperMesh runs it automatically
to define the attributes and contents of the Utility menu. You may also select and run a macro file after
HyperMesh starts from within the Options panel.

The default hm.mac file sources the following additional macro files:

disppage.mac
Populates the Display page of the Utility menu.

geommeshpage.mac
Populates the Geom/Mesh page of the Utility menu.

globalpage.mac
Creates the button group that allows you to switch pages.

qamodelpage.mac
Populates the QA/Model page of the Utility menu.

userpage.mac
Populates the User page of the Utility menu.
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A userpage.mac file may exist in the installation directory for HyperMesh or in the directory from which
HyperMesh launches. When HyperMesh starts, it first looks for the userpage.mac file in the directory
from which it launches and then in the installation directory. UNIX users also have the option of putting
the userpage.mac file in their home directory. This file defines the attributes and contents of the User
page of the Utility menu.

By default, the Utility menu displays when HyperMesh starts, but display of the menu is controlled by a
command in the HyperMesh Configuration.

Note:  While macros offer a great deal of flexibility, you must remember that once a macro
is executed, there is no way to cancel the execution or reject the results, and a macro may
not be called recursively.

QA/Model Utility Menu
The QA Utility menu contains many tools to help you quickly review and clean up the quality of a pre-
existing mesh.

The element quality criteria used by these tools comes directly from the values entered on the Check
Elements panel. Since the criteria on that panel are customizable, the quality criteria used by these
macros remains consistent with those used throughout the rest of HyperMesh and can be indirectly
adjusted by changing the settings on the Check Elements panel.

There are eight tools to isolate elements that fail certain element check criteria:

Table 15:

Tool Description

Length This macro checks all the displayed elements against the minimum
length criteria. If any elements fail the criteria, it displays the failed
elements and masks the remaining elements. If none of the displayed
elements fail the criteria, it displays a message and leaves the model
display unchanged.

Jacob (Jacobian) This macro checks all the displayed elements against the maximum
Jacobian value. If any elements fail the criteria, it displays the failed
elements and masks the remaining elements. If none of the displayed
elements fail the criteria, it displays a message and leaves the display
unchanged.

Warp (warpage) This macro checks all the displayed elements for their warpage. If any
elements fail the warpage test, it displays the failed elements and masks
the remaining elements. If none of the displayed elements fail the
criteria, it displays a message and leaves the display unchanged.

Aspect (aspect ratio) This macro checks all the displayed elements for their aspect ratio. If any
elements fail the criteria, it displays the failed elements and masks the
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Tool Description

remaining elements. If none of the displayed elements fail the criteria, it
displays a message and leaves the display unchanged.

Max ang: Q (quad) This macro checks all the displayed quad elements against the maximum
internal angle. If any elements fail the criteria, it displays the failed
elements and masks the remaining elements. If none of the displayed
elements fail the criteria, it displays a message and leaves the display
unchanged.

Max ang: T (tria) This macro checks all the displayed tria elements against the maximum
internal angle. If any elements fail the criteria, it displays the failed
elements and masks the remaining elements. If none of the displayed
elements fail the criteria, it displays a message and leaves the display
unchanged.

Min ang: Q (quad) This macro checks all the displayed quad elements against the minimum
internal angle. If any elements fail the criteria, it displays the failed
elements and masks the remaining elements. If none of the displayed
elements fail the criteria, it displays a message and leaves the display
unchanged.

Min ang: T (tria) This macro checks all the displayed tria elements against the minimum
internal angle. If any elements fail the criteria, it displays the failed
elements and masks the remaining elements. If none of the displayed
elements fail the criteria, it displays a message and leaves the display
unchanged.

You can use the following macros to quickly modify any elements that fail the element checks.

Table 16:

Tool Description

Split Warped Checks all displayed quad elements for warp exceeding the acceptable
value. Each element failing this criterion is then split along its diagonal to
form two tria elements instead of the original quad.

Find Attached Finds all elements attached to displayed elements. Attached elements are
those that are physically attached to each other via common nodes.

Find Attached (Tied) Finds all elements tied to displayed elements. Tied elements are those
that are tied to each other, but are not attached physically. See Find
Attached (Tied).
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Tool Description

Remesh Remeshes the selected elements plus one, two, or three attached layers
of elements (one button for each). The remesh uses the current size,
does not break connectivity, and uses the mixed element type.

Smooth Applies the smoothing algorithm to the selected elements plus one, two,
or three attached layers of elements (one button for each).

Quality Report Brings up a user interface, from which you can set the various quality
values and check the quality of all the 2D elements in the model. The
results are shown as the number of elements and percentage of elements
failing each criterion. You can also export the results to a text file using
save as.

Note:  Changing the criteria on this report interface does not
change the settings in the Check Elements panel. They only
affect the report.

Model Tour Opens a macro, from which you can review the selected components
individually. This macro displays the component name, number of
elements in that component and their ID range. It also displays a dialog
from which you can review the free edges of the component and any
elements attached to the component.

BOM Comparison Tool Reads a generic Bill Of Materials file and provides an interface to
manipulate data in the BOM as well as the corresponding FE model.

The model tools included on this page are:

Table 17:

Tool Description

Load Size These numbered buttons represent different display sizes for load
indicators: 0 is the smallest, while 3 is the largest. Since these buttons
affect all loads, including forces, pressures, constraints, and so on, the
numbers do not directly correspond to any specific values or ratios.

Note:  This only affects the graphical display of load
indicators. It does not change the load magnitudes.

Find Elems >> Loads Automatically finds all elements directly attached to any and all load
indicators. If masked, these elements are unmasked.
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Tool Description

Find Comps >> Loads Automatically finds all components directly attached to any and all load
indicators. If masked, these comps are unmasked.

Find Loads >> Comps Automatically finds all loads directly attached to a selected component. If
masked, these loads are unmasked.

Find Elems >> Connectors Automatically finds all elements directly attached to any and all
connectors. If masked, these elements are un-masked.

Find Attached (Tied)
Find elements that are connected to displayed elements using the Find Attached (Tied) option.

Tied elements are those that are tied to each other, but are not attached physically. This option differs
from the Find Attached option, which returns elements that are physically attached to each other via
common nodes.

Find Attached (Tied) is available for the LS-DYNA user profile on the QA/Model Utility menu.
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Figure 482:

The relationship between tied elements is defined using the following CONTACT keywords:

Element Type Contact Keywords

ContactSpotWeld *CONTACT_SPOTWELD

NodesToSurface *CONTACT_TIED_NODES_TO_SURFACE

*CONTACT_TIEBREAK_NODES_TO_SURFACE

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE

SurfaceToSurface *CONTACT_TIEBREAK_SURFACE_TO_SURFACE
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Element Type Contact Keywords

*CONTACT_TIED_SURFACE_TO_SURFACE

SlidingOnly *CONTACT_SLIDING_ONLY

ConstdTieBreak *CONSTRAINED_TIE-BREAK

XtraNode *CONSTRAINED_EXTRA_NODES_NODE

*CONSTRAINED_EXTRA_NODES_SET

TiedNodes *CONSTRAINED_TIED_NODES_FAILURE

ConstRigidRbody *CONSTRAINED_RIGID_BODIES

Features
• Find Attached (Tied) returns any tied elements connected via TIED_CONTACTS as defined using LS-

DYNA.

• You can perform a Find Attached (Tied) operation on one or more displayed elements or
components.

• Element input and output is based on dimension as follows:

•
Input (displayed) Output (attached or tied)

1D/3D elements 2D elements

2D elements 1D/3D elements

2D elements 2D elements

Note:  For ContactSpotweld, the 1st and 2nd use case
is valid.

Use Cases
Use Case 1:

Two independent beam nodes are connected to a common layer.

Result:
If you start with the green shell and 1D beam in image 1., then the Find Attached (Tied) operation
returns the elements in the following sequence:
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Figure 483:

Figure 484:

Figure 485:
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Figure 486:

Use Case 2:
A common node between two 1D elements.

Result:
If you start with the 1D beam in image 1., then the Find Attached (Tied) operation returns the
elements in the following sequence:

Figure 487:
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Figure 488:

Figure 489:

Note:  The Find Attached (Tied) option works with displayed elements only.

BOM Comparison Tool
The BOM Comparison tool, located on the QA/Model Utility menu, reads a generic Bill of Materials (BOM)
file and provides an interface to manipulate data in the BOM and its corresponding FE model.

A BOM is often used as the master document for model meshing, assembly, property assignments,
model comparison, and updates between design iterations as well as other CAE activities. Since users
in different design and analysis groups use BOM information, the formats and content of the BOM can
vary. One BOM may contain more data than another BOM for the same program. BOMs usually use
Microsoft Excel® format (CSV format) or XML format. The HyperMesh BOM Comparison tool focuses
primarily on the Excel format.

The BOM reader includes the following abilities:
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• Reads a generic BOM file of CSV format (comma separated values file)

• Provides a GUI to manipulate data in the BOM and the corresponding FE model

• Provides an option to update attributes in the FE model based on the data available in the BOM

• Provides an option to complete the existing BOM based on the data available from the model

• Filters out all vague information present in the BOM and provides a feature to edit the vague
information into a valid data and move it back to the BOM

• Provides a functionality to export a new BOM file

Note:  The BOM Comparison Tool only applies to the Nastran, LS-DYNA, Radioss and Abaqus
user profiles.

BOM Comparison Tool GUI

The BOM Comparison Tool’s GUI consists of seven sections, as shown below:
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Table 18:

Function Description

Control section Contains menu items and buttons to perform various operations. This
section controls most tool functions.

Tree section Contains a tree structure displaying part names and IDs.

Master column Contains master column selection.

BOM display section This section contains a table to display BOM info as it is seen in the
actual BOM file.

Metadata display section Contains options for metadata management.

Failed records section Displays failed records from a loaded BOM file.
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BOM Comparison Tool Control Section
This portion of the interface contains drop-down menus and the toolbar.

File menu

New
Create a new session.

Open
Browse for and load a new BOM file. HyperMesh checks for the standard headers Part
Name, Part ID, Material, Material ID, and Gauge.
If all are found, details populate the relevant fields in the BOM comparison tool. If any are
missing, you will be prompted to select the heading from the BOM file that corresponds to
each standard header.

Show Failed
Display all the invalid records that the tool encounters while reading a BOM file in a table.
Only valid records from a BOM file display in the BOM Display Section’s table. Invalid
records can be edited to form valid data and can be moved to the BOM Display table.

Save and Export
Save and export the current information shown in the BOM Display section as a new BOM
.csv file in a user selected location.

Exit
Close the BOM Comparison Tool.

Edit menu

Update Model
Update the model attributes to match the BOM.

Complete BOM
Sometimes the BOM doesn’t contain all of the data you want. If the corresponding model
contains the missing data, you can complete the BOM data by querying the database and
extracting the data. Use the Complete BOM operation to either complete an existing BOM,
or generate a new BOM by querying the model in the current session.
This option opens a new window listing the items to be added to the BOM file. You can
select additional items from a combo box, or type a new header into it and add them,
or click an item already in the list and insert the new item just above it. You may also
select items in the list and delete them from the file. Once you have added or deleted all
necessary entries, click Continue to generate the new file.
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View Mode

BOM View
Display section displays BOM info as it appears in the BOM file.

Compare View
Categorizes BOM information into four sections:

• Match: components in BOM whose standard attributes match exactly with those in the
model.

• Different: components in BOM whose standard attributes differ from those in the
model.

• In_BOM_Only: components found in BOM but not in model.

• In_Model_Only: components found in model but not in BOM.

Same function as File > Open.

Same function as File > Save and Export.

Same function as Edit > Update Model.

Same function as Edit > Complete BOM.

Same function as Edit > Check Model.

Same function as File > Show Failed.

BOM Comparison Tool Tree Section

When a BOM file is loaded into the tool, the tool identifies the part name and part id of all valid records.
It then displays the part names, appended with part IDs, in brackets in the form of a tree structure
located on the left side of the tool window. Each tree branch is associated with a row in the BOM display
table containing all standard information for the part in the tree branch.

This section also includes selection and filtering controls, to affect which parts display in the tree and
which parts are selected or deselected. Filter options are given for displaying only the desired part info
in the tree and the associated data in the BOM display table.
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Figure 491:

You can enter a string in the combo box, select the desired header in the options menu, and press
RETURN to display the desired information in the tree and BOM display table. The combo box
remembers previously entered strings until you quit the tool, and can be used to filter the BOM info
anytime in the session.

In addition, there are several filter buttons which are explained below:

Table 19:

Function Description

 (Select All) Displays all the branches in the tree and the associated data in the
BOM display table.

 (Select None) Switch off all the branches in the tree and delete all the data in the
BOM display table.

 (Reverse selection) Switch on all the "off" branches in the tree and vice versa. Data
associated with switched-on branches displays in the BOM display
table.
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Function Description

 (Show displayed) Switch on only those branches in the tree, and associated data in
the BOM display table, that correspond to the displayed parts in the
model.

BOM Comparison Tool Master Column
The central top portion of the tool window contains the master column section. From this section, you
can select the desired master column option.

The master column is the column in the BOM file whose attributes are considered as a key in
comparison and validation operations. Only columns with three attributes can be used as master
columns, such as columns containing part ID, part name and part number. The master column data is
used as a key for the following operations:

• Update model attributes as in BOM

• Complete BOM by querying model

• Check model against BOM

Three master column combinations between the BOM and the model are allowed. The tool queries the
data in the model based on any one of these column combinations:

Compare Part Id in BOM with Part Id in model
The tool compares the attributes of a part in the BOM with the part in the model using part ID as
the key.

Compare by Part Name in BOM with Part Name in model
The tool compares attributes of a part in the BOM with the part in the model using part name as
the key.

Compare by Part Number in BOM with Part Name in model
The tool compares attributes of a part in the BOM with the part in the model using part number as
the key.

BOM Comparison Tool BOM Display Section
BOM info displays in a table in the BOM display section, located in the center of the tool window just
below the master column section. BOM info can be displayed in two different modes: BOM only and
Comparison.

By default information displays in BOM Only view:
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Figure 492:

Use the toggle button located in the top-right portion of the GUI to switch to Comparison mode, which
categorizes the BOM information into four categories:

Match
BOM components whose standard attributes exactly match those in the model

Different
BOM components whose standard attributes differ from those in the model

In_BOM_Only
Components found in the BOM but not in the model

In_Model_Only
Components found in the model but not in the BOM
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Figure 493: Comparison View

Column 1 shows the category name with the number of parts falling under that category enclosed in 
brackets; remaining columns display the BOM info. In the Different category, mismatched attributes 
between BOM and the model are highlighted in light blue.

Right-click menu
Right-clicking on the table opens a menu of functions:

Display selected parts
Displays parts in the model corresponding to the selected rows in the BOM display table.
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Display all parts
Display all the parts in the model.

Create metadata
Creates metadata of all the attributes of the parts in the model corresponding to the selected row
in the table.
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Update metadata
Updates metadata of all the attributes of the parts corresponding to the selected row in the table.

Delete metadata
Deletes metadata of all the attributes of the parts corresponding to the selected row in the table.

Delete
Deletes the selected row in the table.

BOM Comparison Tool Metadata Display Section
You can create, update and delete metadata using some of the menu items on the BOM display table.
Metadata information contains all the attributes for a part in the model.

The metadata display section contains four display options in the form of a combo box. After selecting
a row in the BOM Display table, use this combo box to select the type of information displayed in the
metadata display table:

Table 20:

Item Description

None Clear the table if some data already exists.

Metadata related to BOM Display BOM related metadata for the selected row in the BOM
display table.

All metadata Display all the metadata for the selected row in the BOM display
table.

Differences between BOM/metadata Display two rows of info in the metadata table. First row
corresponds to BOM info, second row corresponds to metadata
associated with the model.

BOM Comparison Tool Failed Records Section
When a BOM file is loaded, the tool checks for the validity of each standard attribute in a record. A
record corresponds to one line of information in the BOM file.

The tool considers the following five terms as standard attributes:

• Part Name

• Part ID
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If at least one attribute is missing or repetitive, the whole record is considered invalid and will be stored
out-of-sight. Click the Show failed menu item or corresponding button in the control section to see the
failed records.

Figure 494: Failed Records
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You have the option to edit each of those failed records to make them valid and move them to the BOM 
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Disp Utility Menu
In the Disp Utility menu, clear temporary nodes if needed.

Click Clear Temp Nodes to automatically remove any temporary nodes in the model.

Geom/Mesh Utility Menu
This menu contains a set of macros related to working with model geometry, as well as a set for 
working with FE mesh.

The geometry macros are:

Table 21:

Function Description

Preserve edges Prevents specific edges from being suppressed during autocleanup or
batchmeshing.

Project points Projects free points to surface edges. Depending on the tolerance
you specify, points may even project to multiple edges. This can be
helpful to achieve uniform meshing with regard to weld points.

Isolate Surface Isolates either an inner or an outer surface layer, based on the user
selected surface, from a 3D model. This macro works only on the
surfaces attached to the selected surface. The other layers and
thickness are then placed in a temp directory and masked.

Washer Scales a copy of a selected circular line to 1.5 times its original size,
and then trims this new line into the surface. This allows a higher
quality mesh around circular holes.

Adj Circ Pts Places four additional fixed points on an inner line, and then projects
those points to a concentric line, creating a higher quality mesh.
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Auto Connectors A pop-up menu opens from which you can create connectors and FE
realize them from a master connection file.

Quick Tetramesh Quickly creates an automatic tetrahedral mesh while meeting the
requirements for minimum element angle and element size.

Fix 2nd Order Midnodes Improves element quality by moving the mid-edge nodes of second
order elements.
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The mesh macros are:

Table 22:

Function Description

Tetra Mesh Optimization utility Fixes slivers and wedges (tetra elements that are so thin as to
be nearly planar) by moving nodes to make them more three-
dimensional and improve their quality criteria.

Add Washer Creates a layer of washer elements around a circular hole in the
mesh.

Trim Hole Creates a circular hole (of a given radius) in the mesh at the
selected node (as the center of the hole). An optional layer of
washer elements can be created along with a rigid spider along the
hole.

Fill Hole Fills the selected hole and remeshes the surrounding mesh to
maintain connectivity. This macro does not remove any rigid spiders
that fill the hole; if necessary, delete the rigid spider before using
this macro.

Box Trim Trims the model along user-defined box and generic box definition.
Model cleanup follows the trimming process for LS-DYNA, Nastran
and OptiStruct user profiles to remove empty and unused FE entities
resulting in an error free solver deck. This feature is useful for
reducing the model size to perform local system level analysis.
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Preserve Edges
Use the Preserve Edges macro to ensure that specific component edges and feature lines do not
accidentally get discarded during autocleanup or batch meshing.

Both the Batchmesher and the autocleanup features seek to improve mesh speed and/or quality by
suppressing minor features, which are assumed to be insignificant. However, sometimes minor features
are still important to your analysis.

1. From the Utility Browser, Geom/Mesh menu, click Preserve Edges.
The Preserve Edges dialog opens.

2. Use the options in the macro to define the edges.

Table 23:

Option Description

Clear at start When this checkbox is active, any previously stored feature lines
will purge each time you click Select Edges or Select Comps.
Thus, picking a new set of lines starts over instead of adding to the
selection.

Select Edges Clicking this button displays a line selector in the panel area. Use the
lines selector to choose the edges you wish preserved.

Show Preserved Click this button to highlight the lines already marked for
preservation.

Comps selection
boundary

When active, this checkbox prevents the auto-cleanup function from
equivalencing the boundaries between adjacent components.

Select Comps Clicking this button displays a component selector in the panel area.
Use the comps selector to choose the components whose boundary
edges you wish preserved.

Note:  This will not preserve lines inside the components,
only the outer boundary edge.

Clear All Edges Removes all edges from the preservation list.
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Option Description

Save Preserved Saves the preservation state, so that autocleanup and Batchmesher
will know which lines must be preserved.

Reset Highlight After clicking Show Preserved, use this button to remove the
highlight from the preserved lines.

The lines remain preserved; only the visual highlighting effect is
removed (until you click Show Preserved again).

OK Accepts any changes you have made and closes the pop-up window.

Cancel Discards any changes and closes the pop-up window.

Project Points
Use this macro to project geometric points, such as weld points, to nearby edges.

1. From the Utility Browser, Geom/Mesh menu, click Project Points.
A surfs selector opens in the panel area.

2. Use the selector to select surfaces whose edges you want to project points to.

3. After selecting surfaces, click proceed.

4. A target element size field is displayed.

5. Type a value into this field, using the same units as your model.

Any points within this distance of the selected surfaces’ edges will be projected to those edges.

Auto Connectors Macro
The Auto Connectors macro automates the importation and FE realization of connectors from either a
Master Connectors File or an older Master Weld File.

Virtually every option available for FE realization in the connectors module is also available in the Auto
Connectors macro.

Input requirements for connector entity creation and FE realization are:

• Master connector/weld file

• FE config

• Projection tolerance
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Note:  In the case of a custom FE config, the custom FE type-to-realize is required. The
custom FE type definitions can be found in the appropriate feconfig.cfg file. This script
automatically reads the default feconfig.cfg file and displays a list of all the appropriate
user-defined FE types (found in the feconfig.cfg file) in the Fe type field.

The property and diameter can be specified, if necessary.

Additional options are:

• Build systems

• Snap to node

• Attach to shells

Master Weld Files
The Master Weld File provides the weld location and parts to be connected.

A format example is shown below.

PointID 1t/2t/3t X Y Z PartID1 PartID2 PartID3

12:: 2:: 2.25:: 2.25:: 1.0:: 2:: 3::

23:: 3:: 3.05:: 3.25:: 0.25:: 2:: 3:: 5::

Diameter vs. Thickness Files
The Diameter Table associates the thickness of flanges with spot weld diameters.

The equivalent area is taken to determine the side of the hexa. The table includes flange thickness
ranges and corresponding spot weld diameters.

The table below is an example of the values assigned in the Diameter Table. If the main flange
thickness is between 1.02 to 1.77, the spot weld diameter will be 4.0.

Table 24:

Flange Thickness Range Spot Weld Diameter

1.02 4.0

1.78 5.0

The Diameter Table as well as the settings that determine the main flange thickness are available in the
Diameter Mapping dialog. You can import or manually define flange thickness ranges and spot weld
diameters in the Diameter Table.
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Note:  If you import a .dvst file from HyperMesh v13.0 or earlier, the data will be converted
to the new file format.

You can save the information defined in the Diameter Mapping dialog to a diameter mapping.txt
file, which can be reused in the future.

Example: Assign Flange Thickness Ranges and Spot Weld Diameters and
Define Main Flange Thickness Settings

1. Open the Spot panel.

2. Set the diameter/use diameter mapping toggle to use diameter mapping.

3. Click .

The Diameter Mapping dialog opens.

4. Import or manually define flange thickness ranges and spot weld diameters in the Diameter Table.

• To import predefined values, click File > Open from the menu bar.

• To manually define values, click  to add a row to the table. Default flange thickness

ranges and spot weld diameter values will be automatically interpolated. Edit these values

accordingly. To remove a range from the table, click .

Figure 495:

5. For all flanges, define which flange thicknesses to consider when assigning diameter values.

Figure 496:

a) From the first pull-down menu, select which flanges to consider.

• Choose All to consider all flanges.

• Choose Inner to consider all of the inside flanges.

• Choose Outer to consider the two outside flanges.
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• Choose Middle to consider the middle flanges. If there is an odd number of flanges, the
very middle flange is considered. If there is an even amount of flanges, the two middle
flanges are considered.

b) From the second pull-down menu, select whether to consider the 1st, 2nd, 3rd, or 4th flange
the meets the criteria in the third pull-down menu.

c) From the third pull-down menu, select whether to consider the thinnest, thickest, or average
(average of all considered flanges, not only the thinnest and thickest) flange.

6. Optional: If you are connecting 2T, 3T, or 4T thicknesses, you can specify specific flange
thicknesses to consider when assigning diameter values to each layer.

Figure 497:

7. Click Apply.

8. To save the diameter mapping table, as well as the settings on how to determine the main flange
thickness to a diameter mapping.txt file, click File > Save from the menu bar.

When the connector is realized, only the flanges that meet the criteria defined in the Diameter
Mapping dialog will be assigned a diameter value. The flange thickness ranges and spot
weld diameter values defined in the Diameter Table will determine the diameter value that is
automatically assigned to the spot weld diameter upon realization.

Example

Consider there are five flanges with the following thicknesses:

Flange 1 = 3.0

Flange 2 = 1.5

Flange 3 = 1.0

Flange 4 = 2.0

Flange 5 = 2.5

In the Diameter Table below, four sets of flange thickness ranges and spot weld diameter values have
been defined. Below the table, the options have been set to only consider and assign a spot weld
diameter to the inner flange with the 2nd thinnest thickness. If there is two layer thicknesses, all of the
flanges will be considered, but only the 1st thickest flange will be assigned a spot weld diameter. In this
example, there is only one layer.

When the connector is realized, flange 2 will be assigned a spot weld diameter of 4.0.
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Figure 498:

ACM Welds
An ACM (Area Contact Method) weld is a special representation of a spot weld.

The weld is defined using a solid (HEXA) element whose cross-sectional area is equivalent to the
area of the weld nugget. The solid element is created at the exact weld location independent of
the shell elements that represent the sheet metal parts. These solid elements are connected to the
corresponding components using RBE3 elements. The size of the solid element is determined using
the Diameter Table or using a specific value that you specify in the Spot panel. The spot weld diameter
corresponding to the thickness ranges of the connecting flanges is obtained from the Diameter Table.
The size of the hexa is calculated to match the cross-sectional area of the weld nugget.

The length of the weld element is calculated using one of the following methods:

(T1 + T2)/2
This creates the hexa elements with a length equal to the average component thickness it is
connecting. T1 and T2 are the component thicknesses. The first figure below shows the ACM weld
created using this method.

Project to shell
This creates the hexa elements between the component/element shell surface. The length of
the hexa element will be equal to the actual distance between the two connecting components/
elements. The second figure below shows the ACM weld created using this method.

The figures below show ACM created using the two currently available methods.
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Figure 499: ACM Creation using (T1+T2)/2.0

Figure 500: ACM Creation using Project to Shell

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1354

The weights of the RBE3 elements are calculated based on the projection of the dependent node on
the shell element. The nodes of the shell element closest to the dependent node are assigned a greater
weight relative to the node that is farther away.

Realize ACM Spotwelds
ACM welds can be created and managed using connectors. Once a connector is created, they can be
realized as ACM spotwelds.

1. Make sure that the connectors are created at each of the weld locations along with connecting
parts information.

2. Make sure all the connecting parts have PSHELL cards with correct thicknesses.

3. Select the connectors to be realized as ACMs in the FE Realize panel of the Connectors module.

4. Choose custom element config and select type = Nastran 70 ACM((T1+T2)/2) or type =
Nastran 71 ACM (Shell Gap) per your requirements.

The appropriate property script is automatically loaded for the selected type.

5. Set the appropriate tolerance (proj tol=) value.

6. Make sure the attach to shell and snap to node options are turned off in fe options.

7. Select a DvsT file, which determines the size of the hexa based on the thicknesses of the
components being connected.

If a DvsT file is not selected, hexas are created with weld nugget diameter =1.0.

8. Click realize.

CWELD Elements
CWELD elements are created as patch-patch, meshless elements.

The 1D element is not connected to the shell element. For details regarding connected shell elements or
nodal information see the element card.

For CWELD elements, the diameter is determined from a DvsT file based on the component thickness.
In addition to the creation of CWELD elements, a corresponding property card (PWELD) is created with
an updated diameter ‘D’ attribute value.
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Figure 501:

Quick TetraMesh
The Quick TetraMesh macro quickly creates a tetramesh of an enclosed volume defined by geometry
and/or elements.

Its main objective is to quickly and automatically create a tetramesh that meets the minimum interior
angle and minimum element size. During the process of quick tetramesh, the mesh may deviate from
the underlying geometry in order to maintain good quality elements. To alleviate this, you can select
Sacred elements so that the tetmeshing function closely follows the original geometry.

1. From the Utility Browser, Geom/Mesh menu, click Quick TetraMesh.
A new tab called Quick Tetra opens in the tab area.
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Figure 502:

2. Use the options in the macro to define the tetramesh.

Option Description

Volume complist Double-click components and use the comps collector that displays in the
panel area to select comps representing the geometry of the solid to be tetra
meshed. Surfaces and/or elements can be used to define the volume. Click
proceed to finalize the selection.

Minimum tria
angle

The surface trias from which the tetramesh will be extrapolated will be
generated with angles that measure at least this many degrees. Use this
control to limit how acute the resulting elements will be.
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Option Description

Maximum
feature angle

The maximum feature angle protects nodes on corners with a feature angle
greater than the value specified, helping to better maintain the geometry.
This applies only to cases where you can maintain features while fixing
minimum element size. For example, if two nodes of an element share
different features (as in thin steps), the features may not be maintained as
they do not pass minimum element criteria.

Maximum
reverse angle

The maximum feature angle allowed between normals of adjacent elements.
If the feature angle exceeds the given value, two adjacent elements are
considered reversed and actions are performed to correct the situation.

Mesh size Average element size of the mesh to be created.

Minimum edge
size

No single edge of any generated element will be shorter than this.

Minimum elem
size

Minimum allowable area for any element.

Sacred surface When element nodes are moved to improved element quality, it gives special
preference to trying to keep the nodes on a sacred surface.

Note:  This does not work if two adjacent surfaces are both
marked as sacred.

Mesh type The mesh type options are Trias Only and Mixed. With the Mixed mesh type,
both trias and quads may be created.

Mesh density Choose between chordal deviation and uniform.

Chordal deviation
Uses smaller elements along curves, feature lines, and edges to
improve accuracy, but requires more computing time.

Uniform
Uses identically-sized elements throughout the mesh, but may produce
low-quality elements along such locations.

Tet from Floating
The quick tetramesher is free to move nodes in a surface tria mesh to
achieve better tetra elements based on them.

Fixed
The mesher must keep the tria mesh unchanged.

Mesher Choose between automesh and batch. This determines the meshing
engine used: the one used by the Automesh panel, or the one used by the
Batchmesher. The Batchmesher generally produces better results, but does
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Option Description

not currently support sacred surfaces or elements, ignores/replaces existing
elements, and always uses uniform density.

Perform mesh
cleanup only

When this option is checked, no tetra elements are created and the macro
simply goes through the cleanup steps for the shell mesh. Some of the
cleanup operations performed are: the suppression of free edges, correction
of sliver elements, splitting of elements, and projections onto the original
geometry. All the cleanup steps are designed to improve the mesh quality.

Debug Surface
Mesh

A series of tools that help you locate problem areas which can cause poor
meshing.

Find Holes
Locate holes in your model.

Find T-Con
Locate T-connections in the model.

Dihedrals
Locate features in the model that have feature angles greater than 150
degrees.

Attached
Locate entities attached to the selected components.

Try TetraMesh
After making adjustments, click this to re-run the meshing operation on
the same components.

3. Click Mesh.
The quick mesh is performed with the specified settings.

Note:  There is no Undo function. You can, however, attempt to re-mesh using
different settings if you do not like the initial results.

The Quick Tetramesh macro meshes the unmeshed surfaces in the model using chordal deviation and
fixes all the elements that fail the criteria provided. You can manually mesh some critical geometry and
select those elements as sacred elements. These sacred elements need to be trias. As a part of the
cleanup, the tool heals small cracks in the model.

Use Quick TetraMesh Effectively
Suggested process for effectively using quick tetramesh.

1. Load the geometry.

2. For critical areas where you want to control the mesh such as bolt holes, manually mesh using
chordal deviation.
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Select these elements as sacred elements. This helps to obtain the desired mesh in critical areas.

3. Launch the Quick Tetramesh macro and run with the desired mesh size.

4. Identify problem areas, if any.

For example, any surface edges that were ignored, or if mesh in certain areas is not satisfactory.

5. Use the Delete panel to delete the tetras, then manually mesh problem areas.

6. Re-launch the Quick Tetramesh macro and select sacred elements to protect.

Fix 2nd Order Mininodes
This macro improves element quality by moving the mid-edge nodes of second order elements.

You select the elements on which you want to improve the quality, and specify the quality constraints:
Minimum Jacobian (evaluated at the corner nodes or integration points), Minimum Ratio between the
minimum and maximum edge length, and Maximum angle.

Note:  Moved midnodes are saved to your save list; this persists until you exit the program.
In addition, moved midnodes lose any pre-existent association with the underlying
geometry.

Typical usage of this utility begins with use of the Check Elems panel to identify poorly-formed
elements, and using that panel’s save failed option. From that point onward, you use the Fix 2nd Order
Midnodes utility.

1. From the Utility Browser, Geom/Mesh menu, click Fix 2nd Order Mininodes.
An element selector and proceed button display in the panel area.

2. Click the elems selector and select retrieve to load the saved failed elements.

3. Click proceed.
The Fix 2nd Order Midnodes window opens. This pop-up window exists independently of the
rest of the environment, so you can click-and-drag it to any desired location.
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Figure 503:

4. In the Fix 2nd Order Midnodes dialog, choose your element quality constraints:

a) Choose a Maximum angle.

The utility will move midnodes such that the angle at the ends of each segment will not
deviate from a straight line by more than this amount (thought of another way, the angle
between the segments at the midnode will not exceed 180 degrees minus this value). See
the figure above for an example using a value of 30 degrees.

b) Specify a limit to the Aspect Ratio (minimum versus maximum length for the segments of the
midnode-bearing edges).

A value of 1 represents perfectly equal segment length, while a length of 0 would mean that
the shorter segment might not exist, so this value must be greater than 0, but no greater
than 1. Remember that this is a minimum ratio, so a value of 0.5 would allow the shorter
segment to be half as long as the longer segment, or longer — but not shorter than half the
length of the longer segment.

c) Specify a Minimum Jacobian value and use the radio buttons to determine whether
HyperMesh should evaluate each element’s Jacobian at the Corner nodes or the
Integration points.
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d) To tell HyperMesh to keep the boundary nodes on the underlying model geometry but
attempt to improve the Jacobian value by moving internal nodes, select the Allow
movement checkbox.

e) To allow nodes on geometry to move along (but not leave) the geometry features before any
other node movement occurs, select the Move along geometry first checkbox.

f) To allow HyperMesh to move boundary nodes off of the underlying geometry if a satisfactory
Jacobian value cannot be achieved by moving along geometry or moving internal nodes,
select the Move off geometry if needed checkbox.

Note:  This feature is always active when Allow movement is unchecked.

5. Click one of the command buttons to perform an action:

• Click Jacobian to check the current selected elements' Jacobian values and displays them in
the results area..

• Click Apply to tell HyperMesh to move the midnodes to try to match the criteria you
specified..

• Click Reject to undo any changes made when you clicked Apply
• Click Close to close the Fix 2nd Order Midnodes dialog.

When you click Apply, a message displays under the Results heading to inform you of exactly
what HyperMesh did to the mesh. The images below illustrate the before-and-after state of a
specific midnode and the criteria used, as well as the overall results:

Figure 504: Before Clicking Apply
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Figure 505: After Clicking Apply

Add Washers
Use the Add Washer utility to create one or more layers of washer elements around a circular hole in an
existing mesh.

1. From the Utility Browser, Geom/Mesh menu, click Add Washer.
A temporary panel displays in the panel area.

2. Select a single node from the edge of a hole.

Figure 506:

3. Click proceed.
All of the nodes on the hole are selected and the utility opens.
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Figure 507:

4. The utility automatically determines the Hole radius. You can specify the Number of layers of
concentric washer elements to add around the hole.

• If you choose to add more than one layer, you can also choose whether or not to have all
layers be Uniform in width, or to allow them to have Varying widths from one another.

• If you choose Varying, each layer displays separately in the table below this option, allowing
you to specify a different value for each layer.

5. Specify a Width (the size of the elements) or a Scale (a factor of the hole's radius – for example,
using a scale of 1.0 produces washer elements whose size is the same as the hole's radius) for
each layer of elements.

Figure 508:
Mesh size 5, 2 washer layers of width 2.
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Figure 509:
Mesh size 5, 1 washer layer of scale 1.0.

6. Activate the checkboxes of any desired creation options.

Option    Description

Create rigid spider along hole

Figure 510:
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Minimum number of nodes 
around hole Prevents the washer from using fewer nodes 

than this around the hole, in order to maintain 
a desired level of granularity.

Note:  A larger number than this may be 
generated in order to generate a uniform 
mesh of washer elements, particularly when 
using smaller numbers for the minimum. 
When active, this also enables the Density 
numeric box, which lets you specify the exact 
minimum number.

7. Click Add to create the washer layers. If the results are not acceptable, click Reject and alter
your settings.

Trim Holes
Create a circular hole of a given radius in the mesh at a node specifying the center of the hole, as well
as specify a number of layers of washer elements to include.

1. From the Utility Browser, Geom/Mesh menu, click Trim Hole.
A node selector panel opens.

2. Pick nodes on your model for the centers of each hole that you wish to create, then click proceed.
The Mesh Trimming with Circular Holes dialog opens.
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3. Edit the options in the dialog to determine the type of hole that is created at each chosen node.

Table 25:

Option Description

Hole Radius Each node will receive a hole of this radius, measured from the node.

Number of layers This is the number of layers of washer mesh elements that you want to
surround each hole.

Uniform/Varying This toggle only applies when the number of layers is more than zero,
and specifies whether you want mesh layers to all be the same width, or
to vary from one another.

No. The number of a specific washer layer. If you chose varying width for
the layers, the table displays one row for each of the number of layers
that you specified. Otherwise, only one row displays because all layers
will be set to the same values.

Scale/Width Determines the width of the washer layers.

Scale
You can specify each layer’s scale relative to the Hole radius. For
example, use "0.5" for a washer layer that’s half as wide as the
hole radius.

Width
Specify a fixed width for each layer.

Value The scale factor or width of the layer(s).

Create rigid spider
along the hole

This checkbox will create a rigid spider in each of the new holes created,
and enables two more options:

individual rigid links
Create rigid elements at each node of the new hole.

single rigid link
Create one rigid element that connects to all of the nodes around
the new hole.

Minimum number of
nodes around the hole

This determines the mesh density around the new hole(s). Each new
hole will be created with at least the number of nodes that you specify
in the density field, evenly spaced around its circumference.

Reject If you do not like the results of the last trim operation, click this button
to undo it.
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Option Description

Note:  This only undoes a single click of the Trim button,
so it can only undo multiple holes if they were created
simultaneously during a single trim operation.

4. Click Trim to create the new hole(s).

Fill Holes
The Fill Hole function fills in one or more holes in your geometry with automatically-generated mesh.

Note:  This macro does not remove any rigid spiders that currently fill the hole; if necessary,
delete the rigid spider before using this macro.

1. From the Utility Browser, Geom/Mesh menu, click Fill Hole.
The Filling holes with mesh dialog opens.

2. Choose a method for filling holes.

Option Description

Manual Use this option to select the holes that you wish
to fill:

1. Click Select Nodes. The panel area
is once again displayed with a nodes
selector active.

2. Select nodes on the edges of the holes
that you wish to fill.

3. Click proceed in the panel area. The
Filling holes with mesh dialog returns.
The Select Nodes button is now green to
indicate that nodes have been chosen.

4. Click Fill to fill the selected holes with
mesh.

Automatic Use this option to select holes automatically
based on size. Type a value into the entry field
labeled Fill circular holes with radius smaller
than. The model is automatically scanned for
holes smaller than this value, and attempt to fill
them with mesh.
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3. Click Fill.
If you do not like the results of the last fill operation, click Reject to undo it.

Note:  This only undoes a single click of the fill button, so it can only undo multiple fills
if they were created simultaneously during a single fill operation.

Box Trim Macro
Use the Box Trim utility to trim the model, or selected subset, along the global axis to fit the selected
3D box.

For example, a full car model can be trimmed along the Y=0 axis to obtain the left or right side of the
car. A fixed boundary condition is applied at the trimmed edges. It also removes the FE entities outside
of the box, and cleans the model so that it is a runnable deck. The axis directions and terminology are
based on modeling standards in the automotive industry.

This option is available in the LS-DYNA, Nastran, Abaqus, OptiStruct and Radioss user profiles.

Different scenarios for using the Box Trim utility include:

• This tool is useful in applications where some types of analyses can be performed on one-half (or
quarter) of the model using symmetry boundary conditions.

• Trimming a full car model into a quarter or half model for further analysis.

• Trimming a model to significantly gain computational time.

• Trimming a model to debug an analysis error in a particular location in order to understand the
cause of the error.

The Box Trim utility is very useful when you are doing a system level analysis, and when portions of a
full vehicle model include few complete subsystems or partial subsystems.

Note:  This macro can only be used for 1st order elements.

Trim Boxes

1. From the Utility Browser, Geom/Mesh menu, click Box Trim.
A warning message appears if you in the LS-DYNA or Nastran user profiles. If you are not in either
of these profiles, then the Box Trim dialog appears.

2. Click Yes.
You are directed to the panel area.

3. Using the elems selector, select the elements that you want to trim.

4. When you are finished, click proceed.
The Box Trim dialog opens.
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5. Edit the options in the dialog.

Table 26:

Option Description

Box trim type Determine how the selected model will be trimmed by selecting one of the
following options from the pull-down menu:

left
Split the model along global Y=ymiddle and save the model between
Y=ymin and Y= ymiddle (ymiddle =(ymin+ymax)/2).

Figure 512:

right
Split the model along global Y=ymiddle and save the model between
Y= ymiddle and Y=ymax.

Figure 513:

front
Split the model along global X=value (selected value) and save the
model between X=xmin and X=value.
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Option Description

Figure 514:

rear
Split the model along global X=value (selected value) and save the
model between X=value and X=xmax.

Figure 515:

frontleft
Split the model along global Y=ymiddle and X=value (selected value)
and save the model between Y=ymin and Y=ymiddle, and X=xmin
and X=value.
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Option Description

Figure 516:

frontright
Split the model along global Y=0.0 and X=value (selected value)
and save the model between Y=0.0 and Y=ymax, and X=xmin and
X=value.

Figure 517:

rearleft
Split the model along global Y=0.0 and X=value (selected value),
and save the model between Y=ymin and Y=0.0, and X=value and
X=xmax.
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Option Description

Figure 518:

rearright
Split the model along global Y=0.0 and X=value (selected value)
and save the model between Y=0.0 and Y=ymax, and X=value and
X=xmax.

Figure 519:

custom
Define the box by either selecting two corner nodes (Corners) or
selecting the center node and dimensions (Distance from center).

X limit Define the trim location by selecting one of the following options:

By node
Directs you to the Node Selection panel where you can select the
node for the box trim location.

By value
Enter the value for the box trim location.

Defined by Define the trim location by selecting one of the following options:

Pick Corner Node
Directs you to the Node Selection panel where you can select the two
corner nodes that define the outer X, Y and Z bounds of the box.

By Center Node
Directs you to the Node Selection panel where you can select the
center node, and then enter Delta X, Delta Y and Delta Z values
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Option Description

which is the distance from the center node to the outer bounds of the
box in global X, Y and Z directions.

Note:  This option is only available when you select custom as
the Box trim type.

Create constraints Create Single Point Constraints (SPCs) for all of the nodes along the
trimmed edges. When this option is activated, the following options are
enabled:

SPC collector
Specify a load collector to store the Single point constraint (SPC)
created along the trimmed edge.
For OptiStruct, Nastran, and Abaqus, all of the nodes along the
trimming plane will be created as a node set.

Box collector
Specify a box collector. A large hexa element that represents the box
will be created for visualization in the specified collector.
Only available in the Radioss user profile.

Remesh options Enables access to additional options that help clean the trimmed edge
elements in order to achieve a better mesh quality.

Min size Defines the minimum size of remeshed elements on the trimmed edge.
Element size can be defined by selecting one of the following options from
the pull-down menu and entering a corresponding value in the elem size
field.

relative
Multiplier of the local element size

absolute
Actual element size

Figure 520:
Min size > 3 (absolute)
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Option Description

Figure 521:
Min size > 5 (absolute)

Delete comps with Enables a filter to delete components after the trim. The components that
are deleted after the trim can be defined by selecting one of the following
options from the pull-down menu and entering a corresponding value.

num elems
If the number of elements remaining after the box trim are lesser
than specified value, then entire component will be deleted.

% area
Specify the percentage of the total area remaining after the trim. If
the area after the trim is lesser than the specified value, then the
component will be deleted.

Feature angle= This option is similar to the global feature angle specified in the mesh
option. This value is used in element cleanup after the trim.

6. Click Trim.

Tip:  Click Preview to view the trim before confirming your selections.

How Entities on a Cutting Plane are Treated

The entities on a cutting plane must be treated as follows:

0D Elements
Delete 0D elements that are defined on the nodes that were deleted.
There are some special cases where the entity set and part are referred in it as a pointer. In these
cases alone retain them.
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1D Elements

Beams, Bars, Springs
Remove the element.

FE Joints
Remove the element.

RBE3
If the dependent node is deleted, remove the element.
If any independent nodes lie on the plane of the box trim, remove the element.

Rigids
If the independent node is deleted, remove the rigids.
If any dependent nodes lie on the trimming line edge, remove the rigids.
In all other cases, retain the rigid.

2D Elements
Trim the element on the cutting plane.

3D Elements
Remove the element on the cutting plane.

Connectors
Remove the connector and it's corresponding FE realized.

Equations
This is mapped to loads in HyperMesh. Delete the equations if one of the nodes are deleted as
part of Box trim.

How the Box Trim Macro Executes a Model Cleanup

The model cleanup includes:

1. Empty deletion

• Deletes empty components (components with no elements), assemblies, sets, contact
surfaces, output blocks, groups, plies, plots, and load steps. The following entities will also
be deleted if there is no card image: load collectors, system collectors, vector collectors, and
section collectors.

• Deletes unused materials, properties, sets, beam sections, curves, systems, vectors,
laminates, plies, tables, tags, and optimization entities.

2. Location based deletion

• Deletes connectors with a FE realization that is located outside of the box and at the box
boundary.

• Deletes all of the morphing entities and blocks that are completely outside of the defined box.

3. Solver specific

• *CONTACT – mapped Group
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◦ Checks if the master or slave surface is selected in the definition. If either of them are
empty, the *CONTACT will be deleted.

• *CONSTRAINED_EXTRA_NODE - Mapped to ConstrainedExtraNode

◦ Checks if the nodes or node sets are defined as the slave entity. If there are not any
nodes or node sets associated, the entity will be deleted.

◦ Checks the card image to see if the PSID assigned is blank. If it is blank, the keyword
itself will be removed.

• *CONSTRAINED_RIGD_BODIES, *CONSTRAINED_TIE-BREAK,
*CONSTRAINED_LAGRANGE_IN_SOLID, *CONSTRAINED_EULER_IN_EULER, and
*ALE_options – Mapped to Group

◦ Checks if the slave or master definition is defined in the Group. If either the slave or the
master definition are empty, then the entity will be deleted.

• *AIRBAG_options – Mapped to control volume

◦ Checks if the entity has a slave definition. If the definition is empty, then the entity will
be deleted.

Note:  This rule does not apply to *AIRBAG_PARTICLE,
*AIRBAG_INTERACTION and *AIRBAG_ADVANCED_ALE.

• *AIRBAG_PARTICLE

◦ Checks if the card image is referenced by part set ID or part ID, corresponding to the
variables SID1 or SID2. If the card image has no reference, then the entity will be
deleted.

• *AIRBAG_INTERACTION

◦ Checks if the variable in the card images AB1 and AB2 are assigned a value. If they are
not assigned a value, then the entity will be deleted.

• *DEFINE_ALEBAG_BAG and *DEFINE_ALEBAG_HOLE

◦ Checks these keywords to see if SID_PART or SID_SET are empty. If either of them are
empty, then the keyword will be deleted.

• *AIRBAG_ADVANCED_ALE

◦ Checks if all of the variables in Bag_ID 1…. and Bag_ID 8 are empty. If they are empty,
then the entity will be deleted.

4. LS-DYNA specific cleanup

• Moves all of the leftover control cards to the box trim include, as they are valid definitions.

• If the following keywords are defined in the model, entire model, and do not require
an explicit definition of entities, then they will need to be gathered and moved to the
box_trim_include.

◦ *CONTACT (If the master or slave type is assigned a value of 5, corresponding to all.)

◦ *LOAD_BLAST

◦ *LOAD_BODY

◦ *LOAD_BRODE
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◦ *INITIAL_VELOCITY_options expect Initial_Velocity_Rigidbody. In cases of
Initial_Velocity_rigidbody, if the PSID is 0, then it will be ignored. This implies that it is
not applicable on any entity, therefore it should not be included back.

◦ *RIGIDWALL_ - If the variable NSID is assigned a value of 0, this indicates all of the
nodes in the model.

• Deletes any remaining entities, except for the entities in the box_trim_include.

• Moves the entities from the box_trim_include to the master file.

5. Abaqus, Nastran, and OptiStruct specific enhancements and cleanup

• Creates a node set from the nodes on the trimming plane while trimming.

• Updates the following contact and contact surface entities:

◦ Abaqus: *SURFACE ELEMENT, *SURFACE NODE, *CONTACT PAIR, and *TIE

◦ Nastran: BSURF, BCBODY, and BCTABLE

◦ OptiStruct: SURF, CONTACT, and TIE

• Limitation: Abaqus, Nastran, and OptiStruct support direct property assignment, therefore
when trimming such models you will be required to assign a property to the elements
remeshed at the trimming plane.

Use the Bead Utility
Use this utility to add a bead between two points in a mesh.

Note:  If you need to make a curved bead, or a bead across jointed or highly-curved
components, this is best accomplished with the sculpting tools in HyperMorph's Freehand
panel.

However, the bead utility presents a quick and easy way to create simple linear beads, such
as those used to initiate crumple zones in vehicular crash mitigation.

Beads can be of any height or radius, and can be sharp (curved or angled along the top) or flat (raised
from the surface, but flat along the top). However, this distinction will only be apparent if the radius and
height are relatively close to the existing element size.

Figure 522:
Radius 20, height 5, either sharp or flat, with mesh size 8
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Figure 523:
Radius 10, height 5, sharp, with mesh size 8

Figure 524:
Radius 10, height 5, flat, with mesh size 8

1. From the Utility Browser, Geom/Mesh menu, click Bead.
A temporary panel is displayed in the panel area.

2. Select two nodes to define the beginning and end of the bead.

Only two nodes are supported by this tool.

3. Click proceed.
The panel closes and the Create Bead - Two Nodes dialog opens.

4. Enter a value for the beam radius.

This value determines the width of the bead at its base. It is best to base this to some degree on
the existing element size.

5. Enter a value for the base height.

This is how far the bead rises above the mesh on which the end nodes reside.

6. Use the bead shape options to determine whether the bead has a flat top, or a peaked or rounded
one.

7. When the characteristics are set, click Create to generate the bead. If the results are not
satisfactory, click Reject and change the characteristics, then create again.
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If you need to change the start and end nodes, you will need to Reject any bead already created,
Close the utility, and then re-open it to select new nodes.

Optimize Tetramesh
Use this tool to modify an existing tetramesh, either by moving nodes or remeshing, to meet required
parameters.

One function is to remove sliver elements – tetrahedral elements which are so flattened that all of their
nodes are very close to planar. If the element's Aspect Ratio (the ratio of its maximum length to its
minimum length) is high, the element is a sliver; otherwise, it is a wedge.

Figure 525:
This sliver is nearly flat in the horizontal plane, while this wedge is nearly flat in the vertical plane.

1. From the Utility Browser, Geom/Mesh menu, click Tetra Mesh Optimization.
A temporary panel is displayed in the panel area.

2. Select a set of elements to fix.

3. Click proceed.
The Tetra Mesh Optimization dialog opens, which contains the tools and settings for fixing
slivers and wedges. The utility also has the ability to constrain trias, feature lines, nodes or
elements within a refinement box.

There are many criteria that you can consider in fixing such elements, each of which is drawn from
the Criteria File Editor.

4. Edit the options in the dialog.

Option Description

Aspect Ratio The ratio of the longest edge of an element to its shortest edge.

Tet Collapse Tetra collapse is calculated by the following procedure. At each of the four nodes
of the tetra, the distance from the node to the opposite side of the element
is divided by the square root of the area of the opposite side. The minimum
value found is normalized by dividing it by 1.24, and then reported. As the tetra
collapses, this value approaches 0.0. For a perfect tetra, this value is 1.0.

Vol Skew Volumetric skew is calculated by the following procedure. A sphere is fit through
the four nodes of the tetra. That sphere defines an ideally shaped equilateral
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Option Description

tetra, whose volume is . The actual volume of the tetra element is then
calculated.

The element's volumetric skew is then (Videal - Vactual)/Videal. This measure
will, normally, equal the skew measure from Tgrid, and equal 1 minus the
equivalent check in Abaqus.

Skew Skew applies to trias, so in this case it is applied to the faces of a tetrahedron.

In trias is calculated by finding the minimum angle between the vector from each
node to the opposing mid-side and the vector between the two adjacent mid-
sides at each node of the element. Ninety degrees minus the minimum angle
found is reported as the skew.

Vol AR Vol AR for tetrahedral elements is calculated using the following procedure: first
it finds the longest edge of the tetrahedron, then it finds the shortest altitude of
the tetrahedron. The element's Vol AR, then, is the length of the longest edge
divided by the length of the shortest altitude. For other types of 3D element, the
ratio of the longest to the shortest edge is reported.

Edit Criteria Opens the Criteria and Parameter File Editor, from which you can change the
element quality requirements.

Triangles The 2D triangles on the outermost surface of the tetrameshed volume, from
which the initial tetramesh is derived. Multiple options for fixing exist:

Fix all
Nodes will be moved to improve tria quality, which will affect any tetras
stemming from those trias.

Edge Swap
Pairs of triangles can have their edges swapped to create better tria
elements:

Figure 526:

Remesh
The current mesh will be discarded and a new mesh generated to fit the
specified criteria. This usually produces the best results.
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Option Description

Constraints Constraints prevent the utility from altering nodes in specific groups of elements.
Four types of constraint can be specified:

Fixed Trias
Click elements and then select trias on the screen that you wish to remain
unchanged during optimization. Only applies during Edge Swap or Remesh.

Feature Line
Click the elements button and then select 1D feature elements (if
present) along one or more feature lines that you wish to preserve during
optimization. These elements may be modified, but not in ways that alter
the feature line. Only applies during Edge Swap or Remesh.

Anchor Nodes
Click the button and then select nodes on the screen that you wish to
remain unchanged; these nodes will not be moved during the optimization
process.

Refinement Box
Only elements inside of the refinement box will be optimized; the
remainder will not. When you click Components, a temporary panel opens
and you can select the refinement box component.

Fix shell
comp
boundaries

When unchecked, nodes on the edges of components will not be moved.

Maintain
geometry
edges

Nodes on the edges of geometric entities will not be moved.

Save to
current
comp

The resulting fixed mesh will be added to the current component. If this option is
left unchecked, the results are saved to the same component they originated in.

Update input
shells

Updates the shell elements attached to modified tetra elements. Only applies
during Edge Swap or Remesh.

Optimize
tetras by
force

Adds a sophisticated node insertion algorithm to the optimization process.
This typically yields higher element quality in the resulting mesh, but can also
increase computation time.

Max tetra
size

Threshold for the maximum tetra element edge length during mesh optimization.

Min tetra
size

Threshold for the minimum tetra element edge length during mesh optimization.
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Maximum
Iteration

The tool will make this number of passes to fix elements; the more iterations, the
better the results are likely to be, but each iteration takes some amount of time
depending on the mesh complexity. Use smaller numbers to limit the amount of
time spent, or larger numbers to achieve better end results.

Feature
Angle

If the angle between the normals of two adjacent shell elements exceeds this
value, the corresponding edge is treated as a feature edge and is preserved
during the optimization process.

Show Failed Isolates only the failed elements in the graphics area.

Check Examine the mesh and count the number of bad elements, according to the
criteria supplied (Jacobian, Volume Skew, and so on.) The results display in the
Status area.

5. Click Apply.
The mesh is scanned and the program will try to fix as many elements as it can in accordance with
the specified settings and criteria.

You can abort the fix attempt early by clicking holding down the right-mouse button.

Note:  There can be a significant delay before HyperMesh finishes its current fix
attempts and stops processing.

Abaqus Utility Menu
Macros are included on the Abaqus page of the Utility menu when you load the Abaqus user profile.

Table 27:

Utility Description

Solid Face Alignment 3 Standard3D, Explicit

Align Faces Determines the default stack or thickness direction for Abaqus composite
solid, gasket and continuum shell elements.

Review Opens the Element Selector panel, from which you to select solid elements.
Selected elements are highlighted. When you click proceed, it highlights
the face1 of selected solids and draws an arrow along the default stack (or
thickness) direction of selected solids.

Reset Deletes the stack (or thickness) direction arrows.
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Utility Description

Dummy Applies to templates: Explicit

Positioning Process
Manager

Tool that guides you through a workflow of positioning a dummy in a seat.

Tools Applies to templates: Standard2D, Standard3D, Explicit

Contact Comparison Activates the Tie-Comparison tool, from which you can compare the Tie-
Contact elements created in HyperMesh to the Tie-Contact elements created
by the Abaqus Solver.

Step Manager Activates the Abaqus Step Manager, from which you can define Abaqus
history (*STEP) information in HyperMesh.

Contact Manager Activates the Abaqus Contact Manager, from which you can create, edit and
review the following cards in HyperMesh:

• *CONTACT

• *CONTACT DAMPING

• *CONTACT PAIR

• *FRICTION

• *PRE-TENSION SECTION

• *SHELL TO SOLID COUPLING

• *SURFACE, TYPE = ELEMENT

• *SURFACE, TYPE = NODE

• *SURFACE, COMBINE

• *SURFACE, CROP

• *SURFACE, TYPE = CUTTING SURFACE

• *SURFACE, TYPE = CYLINDER, REVOLUTION or SEGMENTS

• *SURFACE INTERACTION

• *SURFACE BEHAVIOR

• *TIE

Find and Replace Searches the entity names in your model for every occurrence of a specific
character, and automatically replaces the character with a new one that you
specify.

SPH Mesh Generates SPH elements for selected components in your model.
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Utility Description

(Explicit only)

Compare Contacts
Use the Tie-Comparison tool to compare Tie-Contacts created in HyperMesh to Tie-Contacts created by
the Abaqus solver.

In HyperMesh, Tie-Contact elements are created as RDE (Redundant Dummy Elements) elements,
which correspond to Plotel elements in Nastran. The following types of elements are automatically
converted to RDE elements: COUP_DIS, DCOUP3D, and KINCOUP. Once elements are converted, they
are placed in the ^Master_Rods component.

1. From the Utility Browser, Abaqus menu, click Contact Comparison.
The Tie - Comparison Tool dialog opens.

2. Select the component(s) containing the Tie-Contact elements to compare.

a) Click Component.
b) In the panel area, use the comps selector to select the components that contain the elements

for which the comparison is required.

c) Click proceed.

The ^Master_Rods component appears under Rigid/RBE3 Elements.

3. Create a component for the Tie-Contact elements created by the Abaqus solver.

a) Click Create.

b) In the Select Abaqus dat file containing tie constraints dialog, open the file that
contains the constraints.

The ^Visualization_Rods component appears under Solver Tie Elements, which contains the
RDE elements that were created using the information in the constraint file.

c) To delete a component that was added to the list of Solver Tie Elements, select the
component and click Delete.

4. Click Compare.
The elements in the component from the Rigid/RBE3 Elements list is compared to the elements in
the component from the Solve Tie Elements list. After the comparison, the corner nodes of RDE
elements that have different independent nodes in the components being compared are marked.

5. Review the comparison.

a) To clear the corner nodes that were marked during the comparison, click Clear Nodes.

b) To retrieve and mark the corner nodes that were a result of the comparison, click Retrieve
Nodes.

c) To compare the elements in the component from the Rigid/RBE3 Elements list to the
elements in the component from the Solver Tie Elements list, and mask the elements that
have the same corner node and independent nodes, click Mask Unchanged Elems.

If you click Mask Unchanged Elems again, the masked elements are unmasked.
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d) To display the elements that are in the component from the Rigid/RBE3 Elements list but not
in the component from the Solver Tie Elements list, and mask all of the other elements, click
Solver Missed Elements.

If you click Solver Missed Elements again, the elements that were masked are unmasked.

Contact Manager
Use the Abaqus Contact Manager to create, edit and review cards.

Supported cards include:

• *CAVITY DEFINITION

• *CONTACT

• *CONTACT DAMPING

• *CONTACT PAIR

• *FRICTION

• *PRE-TENSION SECTION

• *SHELL TO SOLID COUPLING

• *SURFACE, TYPE = ELEMENT

• *SURFACE, TYPE = NODE

• *SURFACE, COMBINE

• *SURFACE, CROP

• *SURFACE, TYPE = CUTTING SURFACE

• *SURFACE, TYPE = CYLINDER, REVOLUTION or SEGMENTS

• *SURFACE INTERACTION

• *SURFACE BEHAVIOR

• *TIE

Start the Contact Manager

1. Load the Abaqus user profile.

2. From the Utility Browser, Abaqus menu, click Contact Manager.
The following rules apply when you are using the Abaqus Contact Manager.

• When the Contact Manager is minimized or behind the HyperMesh window, restore it by
clicking Contact Manager in the Abaqus Utility menu.

• To display the bubble help for a button, place the cursor over the button for a few moments.

• Double-click on the interface, surface and surface interaction names in the table to open the
corresponding edit windows. Right-click on the names to display pull-down menu options.

• Table columns can be resized by positioning the cursor along a column border, pressing the
left or right mouse button, and dragging the border to a new position.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1386

• The Shift and Control keys can be used with a left mouse click to select multiple items in a
table.

• Press Control and the left or right arrow key to move the cursor within the active cell. Use the
left, right, up and down arrows to change the active cell.

• Right-click on the Review button to clear the review selections.

• If you create, update or delete components, groups, properties, or entity sets from
HyperMesh panels while the Contact Manager is open, click Sync to update the Contact
Manager with the new changes.

• In the Friction and Surface Behavior tables, right click in the tables to display a pull-down
menu containing copy, cut and paste options. Comma delimited data can be copied, cut, or
pasted in these tables. Relevant hot keys, for example, Control-c, Control-x, and Control-v on
PC, will also work.

• In some fields in the Contact Manager, you can access the Entity Browser, which is available
via the (…) button. The Entity Browser makes it more convenient to view and sort long lists of
components or other entities when selecting them for the field.

Interface Tab
Create, edit, review, and delete interfaces, as welll as edit, review, and delete surfaces and surface
interactions that are displayed on the Interface tab.

The Interface tab contains a description of the *CONTACT PAIR, *TIE, *PRE-TENSION SECTION,
*CONTACT, and *SHELL TO SOLID COUPLING cards with corresponding surfaces and surface
interactions.

The Interface table contains the following columns:

Table 28:

Column Description

Name The contact interface names. These names are not exported to the
Abaqus input file. They are useful for identifying the various interfaces in
HyperMesh.

Interface Type The interface types. The currently supported types are contact pair, tie, pre-
tension section, general contact, and shell to solid coupling.

Slave The names of the slave surfaces in Abaqus Standard (or the first surface in
Abaqus Explicit).

Master The names of the master surfaces in Abaqus Standard (or the second
surface in Abaqus Explicit).

Surface Interaction The names of the surface interaction properties.
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Column Description

Slave display The display on/off check boxes and color change buttons for the surfaces
shown in the Slave column. The color can be changed by clicking the color
button and selecting a color from the menu.

Master display The display on/off check boxes and color change buttons for the surfaces
shown in the Master column. The color can be changed by clicking the color
button and selecting a color from the menu.

• The display on/off check boxes and color change buttons are disabled if the corresponding surface
is defined with sets and no displays are created for them.

• Double-click on the interface, surface, and surface interaction names in the table to open the
corresponding edit windows. Right-click on a name to display menu options.

• Right-click on an interface, surface, and surface interaction name to display menu options. The
available options are:

◦ Edit

◦ Delete

◦ Swap Master-Slave

◦ Swap CP-Tie

◦ Review

◦ Review with underlying entity

◦ Reset review

◦ Review Options (Review by Highlighting, Review by Color Change, Transparency, and Grey
Color)

◦ Display All

◦ Display None

◦ Display Reverse

◦ Draw Rigid Surfaces

The Edit, Review, Delete, Display All, Display None and Display Reverse options work like the
corresponding buttons (described below). Review with underlying entity highlights the surface
along with the attached elements (or nodes). The Reset review button clears the review selections.

• Table columns can be resized by positioning the cursor along a column border, pressing the left or
right mouse button, and dragging the border to a new position.

• The Shift or Control key and a left-click can be used to select multiple items in a table.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1388

The Interface tab contains the following buttons:

Table 29:

Button Action

Auto Launches the Auto Contact dialog, from which you can quickly and easily create
interactions between several parts of your model.

New ... Opens the Create New Interface dialog in which you enter the name and type of
the new interface. Use the Same as option to create an interface by copying from
an existing interface. The Create button in this dialog creates the interface and
opens the corresponding Contact Pair, Tie, Pre-Tension Section, Cavity Definition or
Shell to Solid Coupling dialog.

Edit ... Opens the corresponding dialog for editing the selected interface, surface, or
surface interaction.

Review Reviews the selected interface, surface, or surface interaction as follows:

• For surfaces, the selected surface is highlighted in red in the HyperMesh
window. If the surface is defined with sets, the underlying elements are
highlighted. A right-click on the Review button clears the review selections.

• For interface types, corresponding slave and master surfaces are highlighted
in red and blue in the HyperMesh window. A right-click on the Review button
clears the review selections.

• For surface interactions, the names of all interfaces using the selected surface
interaction in the table are highlighted. There is no graphical review in the
HyperMesh window for surface interaction.

Delete Deletes the selected interfaces, surfaces, or surface interactions. You can delete
single or multiple selections from the table.

Rename Rename the selected interface, surface, or surface interaction.

Sync Updates the Contact Manager with the current HyperMesh database. If you
manually create, update, or delete components, groups, properties, or entity sets
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Button Action

from HyperMesh panels while the Contact Manager is open, click Sync to update
the Contact Manager with the new changes.

Contact Pair
In the Contact Pair dialog, define the *CONTACT PAIR card. Options vary according to the active
template.

The Contact Pair dialog contains the following buttons:

Table 30:

Button Action

OK Updates the HyperMesh database with the changes and closes the
Contact Pair dialog.

Apply Updates the HyperMesh database with the changes without closing the
Contact Pair dialog.

Cancel Closes the Contact Pair dialog without updates.

Contact Pair: Define Tab
In the Define tab, select the slave surface, master surface, and surface interaction for the *CONTACT
PAIR card. You can also review the selected surfaces or create new ones.

The Define tab contains the following options:

Table 31:

Option Description

Auto-generated surface
from component

Select this option for HyperMesh to automatically generate *SURFACE cards
from a selected component.

When this option is selected, the Surface field becomes a Component field,
and you can select a component from the adjacent drop-down list. Click
Slave>> or Master>> to add them to the table of included surfaces as
slave or master, respectively.

Surface The Surface field contains a list of the existing surfaces. Select a slave
surface from the list or use the … button to open the Entity Browser to
select a surface.
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Click Slave>> to add the surface as a slave to the table of selected
surfaces. Click Master>> to add the surface as a master. Click Remove>>
to remove any selected surface from the table. You can add multiple sets of
surfaces to the table.

Click New to create a new surface. Once you have specified the surface
properties, the surface appears in the drop-down list, where you can select
it and add it to the table.

The Review button highlights the selected slave surface in red and displays
it through solid mesh in performance graphics in the HyperMesh window. If
the surface is defined with sets, the underlying elements are highlighted.
Right-click on Review to clear the review selections.

Interaction The Interaction field contains a list of the existing surface interaction
properties. You can select a surface interaction from the list. You can also
use the (…) button to open the Entity browser to select a surface.

The New button opens the Create New Surface Interaction dialog for
creating a new surface interaction. When the new surface interaction has
been defined, the Contact Pair dialog reflects the newly-created surface
interaction as the interaction of the contact pair.

Note:  The surface interaction is optional in explicit template.
The Define tab will show a Surface interaction check box if the
explicit template is loaded. This option should be checked first
if a surface interaction property is intended for the contact pair
card.

If you create multiple pairs of contacts, they will appear on the Interface tab in separate entries using
the same name.

Contact Pair: Parameter Tab
In the Parameter tab, define optional parameters for the contact pair card. Options vary according to
the template loaded.

The supported parameters for the Standard.3d and Standard.2d templates include: Adjust, Extension
zone, Smooth, No thickness, Clearance, Hcrit, Tied, Small sliding and Type. When the Type field is set
to SURFACE TO SURFACE, the Geometric Correction field becomes activated. See the Abaqus Online
Documentation for a detailed description of these parameters.
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The supported parameters for the Explicit template include: Mechanical constraint, CPSET, OP, Weight,
and Small sliding. See the Abaqus Online Documentation for a detailed description of these parameters.

Clearance Tab
In the Clearance tab, you can define an initial clearance value and a contact direction for a contact pair.

The Contact Manager can only be used to create a clearance definition for contact pairs that have one
master-slave pair. If a contact pair has more than one master-slave pairs, then clearance has to be
defined for each master-slave pair in the Entity Editor or in the Interfaces panel.

The Clearance tab is enabled when a master and slave surface are selected in the Define tab, and the
Small sliding and Clearance check boxes are selected in the Parameter tab.

Create Clearance Definition for Contact Pair
Steps for creating a new clearance definition for a contact pair varies based on the type of clearance
you select.
VALUE

1. In the Type field, select VALUE.

2. In the Value field, specify an initial clearance/overclosure for the entire set of slave nodes.

Note:  A positive values specifies an initial clearance, and a negative value specifies an
initial overclosure.

3. Click Apply.

TABULAR WITH INPUT FILE

1. In the Type field, select TABULAR WITH INPUT FILE.

2. In the Input File field, specify an input file that contains the clearance data.

Note:  The input file can be a file name, relative path, or complete file path. A
maximum of eighty characters are allowed in this field.

3. Click Apply.

TABULAR WITH BOLT

When using the TABULAR WITH BOLT clearance type, you can define clearance using nodes, node sets,
or both nodes and node sets. In the example below, clearance is being defined using both nodes and
node sets.

1. In the Type field, select TABULAR WITH BOLT.

2. Specify the following:

• Half Thread Angle

• Pitch

• Major Thread Diameter

• Minor Thread Diameter
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Figure 527:

3. To define clearance with a node, select the node checkbox.

4. To add a data line to the table, click Add.

5. In the first data line, double-click the Node Id field.

Figure 528:

6. Using the node collector, select a node.

7. To apply your selection and go back to the Contact Manager, click proceed.

8. Specify the following:

• Clearance Value

• a(X)

• a(Y)

• a(Z)

• b(X)

• b(Y)

• b(Z)

Figure 529:

9. To define clearance with a node set, select the Node set checkbox.

10. Optional: To create a new node set or edit an existing node set using the Entity Sets panel, click
Create/Edit.
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11. To add a data line to the table, click Add.

12. In the first data line, click the Node Set field and then select a node set from the list.

Figure 530:

13. Specify the following:

• Clearance Value

• a(X)

• a(Y)

• a(Z)

• b(X)

• b(Y)

• b(Z)

14. Click Apply.

TABULAR WITH BOLT AND INPUT

When using the TABULAR WITH BOLT AND INPUT clearance type, you can define clearance using nodes,
node sets, or both nodes and node sets. In the example below, clearance is being defined using both
nodes and node sets.

1. In the Type field, select TABULAR WITH BOLT AND INPUT.

2. To define clearance with a node, select the node checkbox.

3. To add a data line to the table, click Add.

4. In the first data line, double-click the Node Id field.

Figure 531:

5. Using the node collector, select a node.

6. To apply your selection and go back to the Contact Manager, click proceed.

7. Specify the following:
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• Clearance Value

• 1st Normal

• 2nd Normal

• 3rd Normal

8. To define clearance with a node set, select the Node set checkbox.

9. Optional: To create a new node set or edit an existing node set using the Entity Sets panel, click
Create/Edit.

10. To add a data line to the table, click Add.

11. In the first data line, click the Node Set field and then select a node set from the list.

12. Specify the following:

• Clearance Value

• 1st Normal

• 2nd Normal

• 3rd Normal

13. Click Apply.

Edit an Existing Clearance Definition for a Contact Pair

If you created a clearance definition using the Entity Editor, Interfaces panel, or imported a clearance
definition for a given master-slave pair, you can display and edit the clearance details in the Contact
Manager.

1. To read and display an existing clearance definition for a master-slave pair, select the Small
sliding checkbox in the Parameter tab.

2. In the Clearance tab, edit the clearance details.

3. Click Apply.

Delete a Clearance Definition for a Contact Pair

To delete a clearance definition that was linked to a contact pair using the Contact Manager:

1. In the Parameter tab, clear the Small sliding checkbox.

2. Click Apply.

Clearance Tab Options

The following options are available in the Clearance tab:

Table 32:

Option Description

Type Specify a type of clearance to define:

• VALUE

• TABULAR WITH INPUT FILE

• TABULAR WITH BOLT

• TABULAR WITH BOLT AND INPUT
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Option Description

Value Initial clearance/overclosure for the entire set of slave nodes. A positive
value specifies an initial clearance, and a negative value specifies an
initial overclosure.

Input File Input file that contains the clearance data. The input file can be a
file name, relative path, or complete file path. A maximum of eighty
characters are allowed in this field.

Half Thread Angle Angle between the threads.

Pitch Distance between two threads.

Major Thread Diameter The largest extreme diameter of a thread.

Minor Thread Diameter The smallest extreme diameter of a thread.

Node Activates the node table, from which you can specify a node to define
clearance with.

Node set Activates the node set table, from which you can specify a node set to
define clearance with.

Add Adds a data line to the table.

Delete Deletes a data line from the table.

Create/Edit Opens the Entity Sets panel, from which you can create a node set.

Node ID Activates the node collector, which can be used to select a node to
define clearance with.

Node Set Enables a drop-down list from which you can select a node set to define
clearance with.

Clearance Value A positive value indicates an opening between the surfaces, and a
negative value indicates overclosure. If this field is left blank, the
clearance value will be calculated automatically.

a(X) X-coordinate of point a along the axis of the bolt/bolt hole.

a(Y) Y-coordinate of point a along the axis of the bolt/bolt hole.

a(Z) Z-coordinate of point a along the axis of the bolt/bolt hole.

b(X) X-coordinate of point b along the axis of the bolt/bolt hole.

b(Y) Y-coordinate of point b along the axis of the bolt/bolt hole.

b(Z) Z-coordinate of point b along the axis of the bolt/bolt hole.
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Option Description

1st Normal First component of the normal.

2nd Normal Second component of the normal.

3rd Normal Third component of the normal.

Tie
In the Tie dialog, define the *TIE card.

The Tie dialog contains the following buttons:

Table 33:

Button Action

OK Updates the HyperMesh database with the changes and closes the Tie dialog.

Apply Updates the HyperMesh database with the changes without closing the Tie
dialog.

Cancel Closes the Tie dialog without updates.

Tie: Define Tab
In the Define tab, select slave surface and master surface for the *TIE card. You can also review the
selected surfaces or create new ones.

The Define tab contains the following options:

Table 34:

Option Description

Auto-generated surface from
component

Select this option for HyperMesh to automatically generate *SURFACE
cards from a selected component.

When this option is selected, the Surface field becomes a Component
field, and you can select a component from the adjacent drop-down
list. Click Slave>> or Master>> to add them to the table of included
surfaces as slave or master, respectively.

Select slave surface Select this option for HyperMesh to automatically generate *SURFACE
cards from a selected component.
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Option Description

When this option is selected, the Surface field becomes a Component
field, and you can select a component from the adjacent drop-down
list. Click Slave>> or Master>> to add them to the table of included
surfaces as slave or master, respectively.

Select master surface The Surface field contains a list of the existing surfaces. Select a slave
surface from the list or use the … button to open the Entity Browser to
select a surface.

Click Slave>> to add the surface as a slave to the table of selected
surfaces. Click Master>> to add the surface as a master. Click
Remove>> to remove any selected surface from the table. You can
add multiple sets of surfaces to the table.

Click New to create a new surface. Once you have specified the surface
properties, the surface appears in the drop-down list, where you can
select it and add it to the table.

The Review button highlights the selected slave surface in white
and displays it through solid mesh in performance graphics in the
HyperMesh window. If the surface is defined with sets, the underlying
elements are highlighted. Right-click on Review to clear the review
selections.

If you create multiple pairs of ties, they will appear on the Interface tab in separate entries using the
same name.

Tie: Parameter Tab
In the Parameter tab, define optional parameters for the *TIE card.

The supported parameters are: Position tolerance, Tied nset, Cyclic symmetry (standard only),
Constraint ratio, No rotation, Adjust, No Thickness and Type. The Position tolerance and Tied nset are
optional mutually exclusive parameters. Select None if you do not want to select either of them. See the
Abaqus Online Documentation for detailed descriptions of these parameters.

The Parameter tab contains the following options:

Table 35:

Option Description

Tied nset The Tied nset menu contains a list of existing node sets. You can select
a node set from the list.

Review Set The Review Set button reviews the selected node set by highlighting it
in the HyperMesh window.
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Option Description

Create/Edit Set The Create/Edit Set button opens the Entity Sets panel in HyperMesh.
When you finish creating/editing the set, click return. The Tie window
is updated with the new set displayed in node set list.

General Contact (Explicit Template Only)
Use the General Contact option to define the *CONTACT, *CONTACT INCLUSIONS, *CONTACT
EXCLUSIONS and *CONTACT PROPERTY ASSIGNMENT.

The keywords *SURFACE PROPERTY ASSIGNMENT, *CONTACT FORMULATION, *CONTACT CONTROLS
ASSIGNMENT and *SURFACE PROPERTY CONTACT CLEARANCE ASSIGNMENT cards are available for
Explicit template only.

To open the Card Editor and define all of the relevant keywords, parameters and data lines, click Edit in
the Contact Manager. When you are finished, click return.

Pre-Tension Section
In the Pre-Tension Section dialog, define the *PRE-TENSION SECTION section and related assembly
loads and constraints.

The Pre-Tension Section dialog contains the following buttons:

Table 36:

Button Action

OK Updates the HyperMesh database with the changes and closes the Pre-
tension Section dialog.

Apply Updates the HyperMesh database with the changes without closing the
Pre-tension Section dialog.
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Pre-Tension Section: Define Tab
In the Define tab, define a pre-tension section on existing bolts.

These bolts can be modeled by beams, truss or solid elements. This tab offers an automatic and
manual way of defining the pretension section. You can also create loads and constraints applied to the
pretension node from this tab.

Pre-Tension Definition
When the pre-tension definition is modeled by truss or beam elements, use the Select button
to pick the 1D element to which the pre-tension shall be applied. When the Auto generate pre-
tension node option is on, a pretension node in the middle of the selected element will be created.
The same node will be populated in the By Node ID field and will also receive an HyperMesh tag
Pretension_Node_<node id>.

If Auto generate pre-tension node is not active while selecting the 1D element, you can select a pre-
existing node or node set, or as an option, create a node set and select this node set to apply pre-
tension load and boundary conditions on.

When modeling a bolt by solid elements, you can take advantage of some automation as well. In this
case you need to select a surface. If the Auto generate surface and pre-tension node option is enabled
(Text dependent on either Element or Surface option), the only thing to specify is a base and a direction
node.
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The tool then creates a surface (*SURFACE) cutting through the bolt at the location of the base node. It 
also creates a node in the surface plane, outside the bolt and not attached to the model. This node 
automatically gets an HM tag HMpre-tension_node so that it is easier to find.

If you want to use existing surfaces, pre-tension nodes or node sets, you need to disable the automatic 
surface and node generation setting and assemble each part of the pre-tension section manually.

Assembly Load Definition
In the lower part of the dialog, you can directly apply a pre-tension load or constraint onto the pre-
tension node (the node must exist). For the pre-tension load or constraint, a load collector named 
HMpre-tension_load or HMpre-tension_constraint is created or reused, if it already exists.

If you enable Fix assembly load, a second constraint is created in a load collector called HMpre-tension 
fix.

The assembly load/constraint definition part of the dialog can be used for both the manual and 
automatic process.

Pre-Tension Section: Parameter Tab
In the Parameter tab, define optional data lines for the *PRE-TENSION SECTION card.

Check Dataline to activate all three input boxes for the first, second, and third component of the 
normal.

Click Define by vector to define the values in the input boxes by a vector. To create a vector, click 
Create/Edit vector.
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Cavity Definition
In the Cavity Definition dialog, combine several element based surfaces to a heat cavity for heat
transfer analyses.

Surfaces can either be selected from a drop down list, or from the extended entity selection menu. It is
also possible to create a new surface while defining the cavity.

If you want to define thermal properties directly in the cavity definition instead of the surface card itself,
surface properties can be selected for each surface, if the option is enabled with the Set property per
surface option.

The dialog allows for ambient temperature definition as an option.

To add a surface to the cavity, select it from the Surface drop-down list and click Add. Surfaces can be
removed from the definition by selecting it in the table and clicking Remove.

Auto Contact
In the Auto Contact dialog, define the *CONTACT PAIR and *TIE keywords along with the
corresponding *SURFACE cards.

In the Abaqus user profile, use Auto Contact to quickly and easily create interactions between
several parts of your model. Based on a proximity distance, Auto Contact will search the model and
automatically define surfaces from identified components. The interactions and surfaces are placed into
a temporary Auto Contact Browser, where you can review the pairs and make adjustments as needed.

Two types of interactions can be created by the auto contact functionality:

*CONTACT PAIR
Definition of pairs of surfaces, which can contact or interact during an analysis. When selecting
this type of interaction, you must also specify the surface interaction properties.

*TIE
Definition of constraints and interactions between pairs of surfaces. No surface interaction
definition is required.

Do not split interfaces between two components
When enabled, Auto Contact will only create one contact pair or tie contact, even if components
are within proximity distance in several places.
If disabled, Auto Contact will create separate interfaces (CONTACT PAIR or TIE), if common
surfaces between two components are not fully connected.
For example, The yellow and red brackets are a component each and touch each other in two
unconnected areas.
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Figure 533:

With the option disabled both contact areas would result into a separate contact pair/tie
definition, whereas with the option enabled (only one contact pair definition is created by the
algorithm).

Figure 534:

The Auto Contact dialog contains the following buttons:

Button Action

Find Searches the model for interacting components.

Cancel Closes the dialog without updates.

Remove Selection Removes selected components from the table. You can use the Control and
Shift key to select multiple items in the table.

Review Selection Highlights the selected component in the graphic area. All other components
are grayed out. You can use the Control and Shift key to select multiple items
in the table.
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Button Action

Right-click to return the model to normal display.

Help Opens the Auto Contact online help.

Shell to Solid Coupling
In the Shell to Solid Coupling dialog, define the *SHELL TO SOLID COUPLING card.

The Shell to Solid Coupling dialog contains the following buttons:

Table 37:

Button Action

OK Updates the database with the changes and closes the dialog.

Apply Updates the database with the changes without closing the dialog.

Cancel Closes the dialog without updates.

Shell to Solid Coupling: Define Tab
In the Define tab, select the slave surface, master surface, and surface interaction for the *SHELL TO
SOLID COUPLING card. You can also review the selected surfaces or create new ones.

The Define tab contains the following options:

Table 38:

Option Description

Surface The Surface: field contains a list of the existing surfaces. Select a slave
surface from the list or use the … button to open the Entity Browser to
select a surface.

Click Slave>> to add the surface as a slave to the table of selected
surfaces. Click Master>> to add the surface as a master. Click
<<Remove to remove any selected surface from the table. You can add
multiple sets of surfaces to the table.

Click New to create a new surface. Once you have specified the surface
properties, the surface appears in the drop-down list, where you can
select it and add it to the table.

The Review button highlights the selected slave surface in white and
displays it through solid mesh in performance graphics in the window. If
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Option Description

the surface is defined with sets, the underlying elements are highlighted.
Right-click on Review to clear the review selections.

If you create multiple pairs of contacts, they will appear on the Interface tab in separate entries using
the same name.

Shell to Solid Coupling: Parameter Tab
In the Parameter tab, define optional parameters for the contact pair card. Options vary according to
the template loaded.

The supported parameters are:

For Standard.3d/2d template and Explicit template
INFLUENCE DISTANCE and POSITION TOLERANCE. To add them, enable the checkbox and then
add an appropriate value. See the Abaqus Online Documentation for a detailed description of
these parameters.

Set Up an Auto Contact Run

1. Load the Abaqus user profile and select either the 2D or 3D template.

2. From the Utility Browser, Abaqus menu, click Contact Manager.
3. Click Auto.

The Auto Contact dialog opens.

4. Select the type of interface to create in the Type of Interface field.

5. Click the yellow components button and select your components.

The components are automatically placed in the Component table in the Auto Contact dialog.

6. Enter a value in the Proximity Distance field.

The proximity distance is the maximum distance between two selected components. When you
create the pair, any surfaces that are farther away than the value entered here will not be created
as a contact pair. The default value is zero.
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Figure 535:

7. Enter a value in the Maximum reverse angle field.

If the angle between two normals of elements or element faces exceeds this value, the element
will not be added to the master or slave surface.

8. If creating a contact pair, select the type of interaction in the Interaction:field. You can use the

 icon to open a browser to view the options more easily, or you can click New to create a new

interaction.

9. Click Find.
The status bar activates and the Auto Contact Browser opens.

10. Use the Auto Contact Browser to make any necessary adjustments to the interfaces and surfaces.

11. When finished modifying, click Create.
The interfaces and surfaces marked as Accepted are created. The Contact Manager window
reopens with the new information listed.

Auto Contact Browser
The Auto Contact Browser contains options for viewing and modifying the contact pairs identified in the
auto contact process.

Naming Convention
During creation, a name is assigned to each interface and surface identified.

Interface
Contact Pair example: CP:(comp name)_(comp_name)

Tie example: TIE:(comp name)_(comp_name)

Surface
S:(comp name)

If more than one surface is selected, the naming convention uses S:(comp name):<index>
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The Auto Contact browser contains the following columns:

Table 39:

Column Description

Name Lists the name of the interfaces, surfaces and surface interactions that
were assigned.

Underneath the interface name are the temporary surfaces included in
that interface. Red indicates a slave surface, and blue indicates a master
surface.

Accept When the Accept box is checked, the Interface will be included in the
creation process.

Type Type of contact pair created.

Color Color assigned to the interaction and surfaces.

Surface Interaction Opens the Auto Contact online help.

The Auto Contact browser contains the following icons:

Table 40:

Icon Description

Options Opens the Options dialog. Enter a new feature angle or customize the
transparency for a selected entity. Click OK when finished.

Highlight Elements Highlights the elements stored in selected entities in the graphics window.
You can use the Control and Shift key to select multiple items in the table.

Review Elements Review of elements stored in the selected entities. Elements are highlighted
by color, all other components are grayed out. You can use the Control and
Shift key to select multiple items in the table.

Review and Highlight are mutually exclusive. It is also possible to switch both
options off. This is helpful when working with big models.

Fit View to Elements Automatically zooms in to the elements stored in the currently selected
items.

Display All Elements In combination with the Highlight Elements or the Review Elements option,
current contents remain unchanged on the screen.

Display Components

with Elements 

Highlights or reviews the elements referred by an interaction or surfaces and
shows the components they belong to. All other components will be masked.
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Icon Description

Display Only Elements Only elements are highlighted or reviewed. The rest of the component and
other components will be masked.

Select Elements

Manually 

Opens the element selection panel so that individual elements can be added/
removed manually. Click proceed when finished.

Add by Adjacent Adds the elements adjacent to the surface to the selected surface.

Right-click to undo one time.

Add by Face Adds the adjacent face to the selected surface.

Right-click to undo one time.

Recheck Opens the Auto Contact dialog to recheck the select interfaces. Recheck
will either add more contacts to the existing contacts for modify the existing
ones.

You can select interfaces from the browser, and the GUI will automatically
populate the components that the interaction was based on. This helps
modify an existing interface.

Modify Auto Contact Entities

Right-click on an item in the Auto Contact Browser.
A context menu displays which offers options for modifying the surfaces and contact pairs.

The following options are available from the Auto Contact Browser's context menu:

Table 41:

Option Description

Rename Rename an existing entry.

Delete Delete items from the browser.

Swap Master-Slave Switches the surfaces identified as master and slave. When selected, you will
see the surfaces flip from the master/slave positions in the browser.

Select multiple entities by using the Control and Shift keys when clicking on
entities.

Swap CP-Tire Changes the type of interface created. Because a surface interaction is
required for Contact Pair but not for Tie, any surface interaction identified
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Option Description

earlier will be lost upon a swamp from CP to TIE. If you switch back from TIE
to CP, the surface interaction will not be retained.

Edit Faces Opens the Elements Selection panel, from which you can select and deselect
the elements to include on the face of the surface, and edit the faces of the
surfaces.

Add by Adjacent Adds adjacent elements to the selected surface.

Add by Face Adds all elements to a selected surface, until the feature angle exceeds the
value (the feature angle can by set by clicking the Options icon).

Accept All/None Automatically accept or reject all items in the Auto Contact Browser.

Reverse Reverses the current selections in the Accept column.

Expand All/Collapse Expands or collapses folders in the Auto Contact Browser.

Surface Tab
The Surface tab displays a description of the *SURFACE cards with corresponding types. You can create,
edit, review, and delete surfaces from this tab.

The Surface tab contains the following columns:

Table 42:

Column Description

Name The name of surfaces in the HyperMesh database.

Type The types of surfaces. Currently supported types are ELEMENT, NODE, and
ANALYTICAL RIGID (SEGMENTS, CYLINDER or REVOLUTION).

Display The display on/off check boxes and color change buttons for the surface.
The color of a surface can be changed by clicking on the color buttons and
selecting a color from the menu.

• The display on/off check boxes and color change buttons are disabled if the corresponding surface
is defined with sets and a display is not created.

• Double-click on a surface name in the table to open its corresponding editing dialogs.

• Right-click on a surface name to display menu options. The available options are:

◦ Edit

◦ Delete
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◦ Review

◦ Review with underlying entity

◦ Reset review

◦ Review Options (Review by Highlighting, Review by Color Change, Transparency, and Grey
Color)

◦ Display All

◦ Display None

◦ Display Reverse

◦ Draw Rigid Surfaces

The Edit, Review, Delete, Display All, Display None and Display Reverse options work like the
corresponding buttons (described below). Review with underlying entity highlights the surface
along with the attached elements (or nodes). The Reset review button clears the review selections.

• Table columns can be resized by positioning the cursor along a column border, pressing the left or
right mouse button, and dragging the border to a new position.

• The Shift or Control key and a left-click can be used to select multiple items in a table.

The Surface tab contains the following buttons:

Table 43:

Button Action

Auto Launches the Auto Contact dialog, from which you can quickly and easily create
interactions between several parts of your model.

New Opens the Create New Surface dialog, from which you can enter the name
and type of the new surface. Click Create to create the surface and open the
corresponding Element Based Surface, Node Based Surface, or Analytical Rigid
Surface dialog or open the corresponding HyperMesh card image.

Edit Opens the Element Based Surface, Node Based Surface, or Analytical Rigid
Surfac edialog or takes you to the corresponding HyperMesh card image for
editing the selected surface.

Review Reviews the selected surface. Surfaces are highlighted in white and show up
through solid mesh in performance graphics the window. If the surface is defined
with sets (display option disabled), the underlying elements are highlighted.
Right-click Review to clear the review selections.

Delete Deletes selected surfaces. You can delete single or multiple selections from the
Surface table.

Rename Rename the selected surface

Sync Updates the Contact Manager with the current HyperMesh database. If you
manually create, update or delete components, groups, properties, or entity sets
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Button Action

from HyperMesh panels while the Contact Manager is open, click Sync to update
the Contact Manager with the new changes.

Close Closes the Contact Manager.

Display All Displays all surfaces in the graphic area.

Display None Hides all surfaces in the graphic area.

Display Reverse Displays all unchecked surfaces and hides all checked surfaces in the graphic
area.

Draw Rigid Surfaces Shows analytical rigid surfaces in the graphic area.

Element Based Surface
In the Element Based Surface dialog, define and edit the *SURFACE, TYPE = ELEMENT card.

The Element Based Surface dialog contains the following buttons:

Table 44:

Button Action

Surface color Changes the color of the current surface in the display.

Review Reviews the current surface by highlighting in white and displaying it through
solid mesh in performance graphics in the window. If the surface is defined
with sets, the underlying elements are highlighted. Right-click Review to
clear the review selections.

Close Updates the HyperMesh database with the optional parameters specified and
closes the Element Based Surface window.

Element Based Surface: Define Tab
In the Define tab, define surfaces for solid, shell, membrane, rigid, gasket, beam, pipe, or truss
elements. You can also define the surface by specifying the face identifier for an element set.

Available surface definition options for various element types:

• 3D solid, gasket

• 3D shell, membrane, rigid

• 3D solid coated with shell

• 3D shell - edge based
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• 2D solid, axisymmetric, gasket

• Beam, pipe, truss

• Element set

The layout of the Define tab changes, based on your selection (displayed in blue). Some options may be
disabled depending on the current template.

3D Solid or Gasket Elements
Use the 3D solid or gasket elements option to define the *SURFACE card by specifying face identifiers
for individual solid and gasket elements.

These faces are displayed by special face elements.

In order to create surface, you need to select the underlying solid or gasket elements first.

Click Elements to open the Element Selector panel, and then select the underlying 3D solid or gasket
elements from the graphic area. Selected elements are highlighted. Click Reset to resets the selected
elements.

You can then define the face identifiers for the selected solids in two ways: (a) by creating a solid skin
and manually picking the faces from the skin, (b) by picking nodes on a specific face and sweeping
through a break angle. Under Select faces by, select Solid skin for (a) and Nodes on face for (b).

(a) Solid skin enables the following:

Table 45:

Button Action

Faces Creates a temporary skin of the selected solids. Opens the Element Selector
panel, from which you can select face elements from this skin. The selected faces
are highlighted. Click Reset to reset the selected faces and delete the skin.

Note:  by face on the element selector panel can be used to find
all faces within a feature angle of the selected face. The feature
angle setting can be accessed by clicking Preferences > Geometry
Options.

The skin will initially have the same color as the current surface. You can change
the skin color using Solid skin color button.

Add Adds the selected faces to the current surface and creates special face elements
for display. It also checks for duplicate faces and displays a message if any are
found.

Note:  The Delete Face tab contains tools to find and delete duplicate
faces in the current surface.

Reject Rejects the recently added faces.
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(b) Nodes on face enables the following:

Table 46:

Button Action

Nodes Opens the Node Selector panel, from which you can select nodes from the graphic
area. Three nodes (or two corner nodes) from the same solid element must be
picked to define a face of that solid. The selected nodes are highlighted. The
corresponding Reset button resets the selected nodes.

Note:  Several three-node or two-corner-node sets can be selected at
the same time to define faces in different solids.

Add Finds all faces from the selected solids that fall within a specified break angle of
the face(s) defined by nodes. These faces are then added to the current surface
and create special face elements for display. It also checks for duplicate faces and
displays a message if any are found.

Note:  The Delete Face tab contains tools to find and delete duplicate
faces in the current surface.

Reject Rejects the recently added faces.

3D Shell, Membrane or Rigid Elements
Use the 3D shell, membrane, and rigid elements option to define the *SURFACE card by specifying face
identifiers for individual shell, membrane, and rigid elements.

In the graphics area, these faces are displayed by special face elements. These face elements have their
own normals to define the SPOS and SNEG faces. The face with normals along the underlying element
normals define the SPOS faces. In contrast, the face with opposing normals define the SNEG face.

The 3D shell, membrane, or rigid elements enable the following:

Table 47:

Button Action

Elements Opens the Element Selector panel, from which you can select underlying
3D shell, membrane, or rigid elements from the graphic area. The selected
elements are highlighted and their normals are displayed. The corresponding
Reset button resets the selected elements and hides the normals.

Add Adds the selected elements to the current surface and creates special face
elements for display. It also checks for duplicate faces and displays a message
if any are found. By default, SPOS faces are created. In order to create SNEG
faces, activate the Reverse checkbox and click Add.
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Button Action

Reject Rejects the recently added faces.

3D Solid Coated with Shell
Use the 3D solid coated with shell option to define the *SURFACE card by specifying face identifiers for
these 3D solid or gasket elements.

In HyperMesh, surfaces on 3D solid or gasket elements that are coated with shell, membrane, or rigid
elements are treated differently from surfaces on regular solids.

The faces are displayed by special contactsurface elements. Unlike, regular solids, there is only one
way to define the face identifiers for solids with shell coating: by picking nodes on a specific face and
sweeping through a break angle. Therefore, the Nodes on face option is always selected. This option is
valid for Standard.3D template or 3D models in Explicit template only.

3D solid coated with shell enables the following:

Table 48:

Button Action

Elements Opens the Element Selector panel, from which you can select underlying 3D
solid and gasket elements from the graphic area. The selected elements are
highlighted. The corresponding Reset button resets the selected elements.

Nodes Opens the Node Selector panel, from which you can select nodes from
the graphic area. Three nodes (or two corner nodes) from the same solid
element must be picked to define a face of that solid. The selected nodes are
highlighted. The corresponding Reset button resets the selected nodes.

Note:  Several three-node or two-corner-node sets can be selected
at the same time to define faces in different elements.

Add Finds all faces from the selected 3D solids that fall within a specified break
angle of the face(s) defined by nodes. These faces are then added to the
current surface and special contactsurface elements are created for display.

Note:  You cannot add duplicate contactsurfaces for the same
element in HyperMesh. Therefore, the Add button does not check
for duplicates and there is no Reject button.

3D Shell - Edge Based
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Use the 3D shell – edge based option to define the *SURFACE card by specifying edge identifiers for 3D
shell elements.

The edges are displayed by special contactsurface elements. Face identifiers for solids with shell coating
are defined by picking nodes on a specific edge and sweeping through a break angle. Therefore, the
Nodes on edge option is always selected.

3D shell – edge based enables the following:

Table 49:

Button Action

Elements Opens the Element Selector panel, from which you can select underlying 3D
shell elements from the graphic area. The selected elements are highlighted.
The corresponding Reset button resets the selected elements.

Nodes Opens the Node Selector panel, from which you can select nodes from the
graphic area. Two nodes from the same solid element must be picked to define
a edge of that shell. The selected nodes are highlighted. The corresponding
Reset button resets the selected nodes.

Note:  Several two-node sets can be selected at the same time to
define edges in different elements.

Add Finds all edges from the selected 3D shells that fall within a specified break
angle of the edge(s) defined by nodes. These edges are then added to the
current surface and special contactsurface elements are created for display.

Note:  You cannot add duplicate contactsurfaces for the same
element in HyperMesh. Therefore, the Add button does not check
for duplicates and there is no Reject button.

2D Solid, Axisymmetric or Gasket Elements
The 2D solid, axisymmetric or gasket elements option is valid for Standard.2D template or 2D models in
Explicit template only.

Use it to define the *SURFACE card by specifying edge identifiers for individual 2D solid, axisymmetric,
and gasket elements. In the graphic area, these edges are displayed by special contactsurface edge
elements. Unlike, 3D solids, there is only one way to define the face identifiers for 2D solids: by picking
nodes on a specific edge and sweeping through a break angle. Therefore, the Nodes on edge option is
always selected.
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2D solid, axisymmetric, or gasket elements enable the following:

Table 50:

Button Action

Elements Opens the Element Selector panel, from which you can select underlying 2D
solid, axisymmetric, and gasket elements from the graphic area. The selected
elements are highlighted. The corresponding Reset button resets the selected
elements.

Nodes Opens the Node Selector panel, from which you can select nodes from the
graphic area. Two nodes from the same element must be picked to define an
edge of that element. The selected nodes are highlighted. The corresponding
Reset button resets the selected nodes.

Note:  Several node pairs can be selected at the same time to
define edges in different element.

Add Finds all edges from the selected 2D solids that fall within a specified break
angle of the edge(s) defined by nodes. These edges are then added to the
current surface and special contactsurface edge elements are created for
display.

Note:  You cannot add duplicate contactsurface edges for the
same element in HyperMesh. Therefore, the Add button does not
check for duplicates and there is no Reject button.

Beam, Pipe or Truss Elements
Use the Beam, pipe or truss elements option to define the *SURFACE card for individual beam, pipe and
truss elements.

In the graphic area, these faces are displayed by special contactsurface elements. These contactsurface
elements have their own normals to define the SPOS and SNEG faces. The contactsurface with normals
along the underlying element normals define the SPOS faces. In contrast, the face with opposing
normals defines the SNEG face.

Note:  For 3D beam, pipe and truss elements, the SPOS and SNEG faces do not have any
meaning. Therefore, these face identifiers will be ignored by the Standard.3d template.
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Beam, pipe, or truss elements enables the following:

Table 51:

Button Action

Elements Opens the Element Selector panel, from which you can select underlying
beam, pipe or truss elements from the graphic area. The selected elements
are highlighted. The corresponding Reset button resets the selected
elements.

Add Adds the selected elements to the current surface and creates special
contactsurface elements for display. By default, SPOS faces are created. In
order to create SNEG faces, activate the Reverse check box and click Add.

Note:  You cannot add duplicate contactsurfaces for the same
element in HyperMesh. The Add button does not check for
duplicates and there is no Reject button.

Element Set
Use the Element set option to define the *SURFACE card for element sets.

Only one elset is allowed in a surface. It does not support a combination of elsets and individual
elements in the same *SURFACE data line.

The Element set menu contains a list of the existing elsets. You can also use the … button to open
the Entity Browser to select an elset. There are two types of elsets in HyperMesh: Components and
Entity sets. The Abaqus elsets that are linked to sectional property cards, such as *SOLID SECTION
and *SHELL SECTION, become components in HyperMesh. Others become entity sets. To differentiate
between these two types, there is a divider line "- - - - -" in the elset lists that pops up if you click the
Element set menu. The elsets listed below the divider line are components.

Element set option enables the following:

Table 52:

Button Action

Review Set Reviews the selected elsets set by highlighting them in the the graphic area. Right-
click on Review to clear the review selections.

Create/Edit
Sets...

Opens the Entity Sets panel. When you finish creating/editing the set, click return.
The Element Based Surface tab is updated with the new set appearing in the
element set list.

Show Faces Creates a temporary skin of the selected elset, opens the element selector panel,
from which you can select face elements from this skin. When you return from the
Element Selector panel, the selected faces will display color coded face identifier

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1417

Button Action

tags. In the graphic area, these tags are sometimes blocked by the solid mesh. You
may need to rotate the model a little to view the tags.

Update Adds the selected elset into the current surface. By default, HyperMesh does not
create a display for surfaces defined with elsets. However, if you check the Display
option before clicking Update, it creates a special display using contactsurface
elements.

Note:  The special display created with contactsurface elements does
not have links to the elset in the HyperMesh database. Therefore, if you
edit the elset later on, the display will not automatically reflect your
changes. In this case, check the Display option and click Update again.

After selecting an element set, click the arrow keys to move the set into table on the right. Once an
elset has been added to the table, the face column becomes activated and you can manually define
the appropriate face identifier for the selected elset. Select None if you do not want to define a face
identifier for the set. In this case, Abaqus will create a surface with the free faces for the selected
element set.

Element Based Surface: Adjust Normal Tab
In the Adjust Normal tab, you can display and reverse normal direction for surfaces defined on 3D shell,
membrane, rigid and 2D beam, pipe, and truss elements.

For these elements, the normal directions are used to define the SPOS or SNEG face identifiers. In
HyperMesh, surfaces can be displayed in two ways: by special face elements or by contactsurfaces. The
surfaces defined on 3D shell, membrane, rigid elements are displayed by face elements while surfaces
on 2D beam, pipe, and truss elements are displayed by contactsurfaces. The normal directions of the
contactsurfaces are part of their display. However, the normal directions of the faces have to be turned
on for displaying. Use the Display normals checkbox to display the normals of the faces. Use the Size:
entry box to define the size of the normals before selecting the Display normals checkbox.

Note:  3D solid and gasket elements are also displayed by face elements. But, the normal
direction do not have any meaning for them.

There are two options for reversing normals: (a) Reverse all normals at a time, (b) Reverse normals by
individual faces or contactsurfaces.
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(a) Reverse normal all

Table 53:

Button Action

Reverse Reverses normals of all faces for 3D shell, membrane, rigid elements
and all contactsurfaces for 2D beam, pipe, truss elements in the current
surface.

Note:  The normals of the underlying elements are
not reversed. It reverses the normals of the faces or
contactsurfaces only.

(b) Reverse normals: By element

Table 54:

Button Action

Element faces Opens the Element Selector panel. For 3D shell, membrane, rigid
elements, pick the faces (not the underlying elements). However,
for 2D beam, pipe, truss elements, pick the elements themselves
as the contactsurfaces can not be picked from the graphic area. The
corresponding Reset button resets the selected elements.

Reverse Reverses normals of the selected faces for 3D shell, membrane, rigid
elements and contactsurfaces of the selected 2D beam, pipe, truss
elements.

Note:  The normals of the underlying elements are
not reversed. It reverses the normals of the faces or
contactsurfaces only.

Element Based Surface: Delete Face Tab
Use the Delete Face tab to delete faces or contactsurface from all elements types.

Surfaces can be displayed in two ways: by special face elements or by contactsurfaces. The surfaces
defined on 3D solid, gasket, shell, membrane, rigid elements are displayed by face elements while
surfaces on 2D solid, axisymmetric, gasket and all beam, pipe, truss elements are displayed by
contactsurfaces.

This tab contains tools to find and delete duplicate faces for 3D solid, gasket, shell, membrane, or rigid
elements.

There are three options for deletion.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1419

(a) All

Table 55:

Button Action

Delete Deletes all the faces or contactsurfaces in the current surface.

(b) By element

Table 56:

Button Action

Element Faces Opens the Element Selector panel. For 3D solid, gasket, shell, membrane,
and rigid elements, pick the faces (not the underlying elements). However,
for 2D solid, axisymmetric, gasket or all beam, pipe, truss elements, pick
the elements themselves as the contactsurfaces can not be picked from the
graphic area. The corresponding Reset button resets the selected elements.

Delete Deletes the selected faces or contactsurfaces from the selected 2D solid,
axisymmetric, gasket, beam, pipe, truss elements.

(c) Duplicate faces

Table 57:

Button Action

Find Duplicate
Faces

Finds duplicate faces, if any exists, for the current surface and highlights
them in the graphic area. The status bar shows the number of duplicates
found. The corresponding Reset button resets the selected elements.

Delete Deletes the highlighted duplicate faces found.

Note:  Duplicate contactsurfaces cannot be added to the same
surface in HyperMesh. Therefore, Duplicate Faces is only valid
for 3D solid, gasket, shell, membrane, and rigid elements.

Element Based Surface: Optional Parameters Tab
Use the Optional Parameters tab to define optional parameters for the *SURFACE card.

The supported parameters are:

• Standard.3D/2D template: Trimming of open free surface, Property selection
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• Explicit template: Max ratio, Scale thickness, Region type for adoptive meshing, No offset and No
thickness.

Click Update to activate the Optional Parameters selection in the HyperMesh database.

Node Based Surface
Use the Node Based Surface dialog to define and edit the *SURFACE, TYPE = NODE card.

The Node Based Surface dialog contains the following buttons:

Table 58:

Button Action

Surface color Changes the color of the current surface in the graphic area.

Review Reviews the current surface by highlighting it in white and displays it through
solid mesh in the graphic area. If the surface is defined with sets, the
underlying nodes are highlighted. Right-click Review to clear the review
selections.

Close Updates the HyperMesh database with the optional parameters specified and
closes the Node Based Surface window.

Node Based Surface: Define Tab
Use the Define tab to define surfaces with individual nodes and define the surface by specifying a node
set.

The layout of the Define tab changes based on your selections.

Individual Nodes
Use the Individual nodes option to define the *SURFACE, TYPE = NODE card by specifying individual
node IDs.

In the graphic area, these nodes are displayed by special single node elements with a SurfaceNodes
tag.

The Individual nodes option has the following buttons:

Table 59:

Button Action

Pick Nodes Opens the Node Selector panel, from which you can select nodes the graphic
area. The selected nodes will be highlighted. The corresponding Reset button
resets the selected nodes.
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Button Action

Add Adds the selected nodes to the current surface and creates special single-
node SurfaceNodes elements for display. The Add button does not check for
duplicates and there is no Reject button.

Node Set
Use the Node set option to define the *SURFACE, TYPE = NODE card for node sets.

Only one node set is allowed in a surface. A combination of node sets and individual nodes in the same
*SURFACE data line is not supported.

The Node set: menu contains a list of the existing node sets.

Selecting Node set enables the following:

Table 60:

Button Action

Review Set Reviews the selected node sets by highlighting the nodes in the graphic area.
Right-click Review to clear the review selections.

Create/Edit Set Opens the Entity Sets panel. When you finish creating/editing the set, click
return. The Node Based Surface dialog is updated with the new set
appearing in the node set list.

Area Select this check box to define the optional cross-sectional area at each node
of the node set selected.

Note:  The cross-sectional area data item is only supported for
surfaces defined by node sets.

Update Adds the selected node set into the current surface. HyperMesh does not
create a display for surfaces defined with node sets.

Node Based Surface: Delete Surface Node Tab
Use the Delete Surface Node tab to delete the SurfaceNode elements.

Node bases surfaces are displayed by special single node SurfaceNode elements.

There are two options for deletion:
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(a) All

Table 61:

Button Action

Delete Deletes all SurfaceNodes elements from the current surface.

(b) By node

Table 62:

Button Action

Surface nodes Opens the Element Selector panel for you to select SurfaceNodes elements
from the graphic area. The corresponding Reset button resets the selected
elements.

Delete Deletes the selected SurfaceNodes elements from the current surface.

Node Based Surface: Optional Parameter Tab
Use the Optional Parameter tab to define optional parameters for the *SURFACE card.

The supported parameters are:

• Standard.3D/2D template: Trim

• Explicit template: Max ratio, Scale thickness, Region type, No offset and No thickness.

Click Update to activate the optional parameter selection in the HyperMesh database.

Surface Combine or Crop
Use the Surface Combine or Crop option to define the *SURFACE, COMBINE, or CROP.

The current version of Contact Manager does not have a Tcl/Tk dialog to define the surface combine
or crop. Review by highlighting or color change also does not work for these types of surfaces in
HyperMesh. Instead, it takes you to the corresponding Card Image panel for edit or review.

Click edit to go into the Card Editor to define all relevant keywords, parameters, and data lines. When
you are finished, click return to go back to the Contact Manager.

Cutting Surface
Use the Cutting Surface option to define the *SURFACE, TYPE = CUTTING SURFACE.

The current version of Contact Manager does not have a .tcl/Tk dialog to define the cutting surface.
Review by highlighting or color change also does not work for these types of surfaces in the graphic
area. Instead, it takes you to the corresponding Card Image panel for edit or review.
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Click edit to go into the Card Editor to define all relevant keywords, parameters, and data lines. When
you are finished, click return to open the Contact Manager.

Analytical Rigid Surface
Use the Analytical Rigid Surface dialog to define the *SURFACE, TYPE = CYLINDER, REVOLUTION or
SEGMENTS card.

When you click Create, the Analytical Rigid Surface dialog opens.

Each tab of the Analytical Rigid Surface dialog contains the following buttons:

Table 63:

Button Action

Surface color Changes the color of the current surface in the display.

Review Reviews the current surface by highlighting line segments and generated revolute
or swept surfaces in white. Right-click on the Review button to clear the review
selections.

Close Updates the HyperMesh database with the optional parameters that you specified
and closes the Analytical Rigid Surface window.

Analytical Rigid Surface: Define Tab
Specify the main characteristics of the surface on this tab.

Depending on which Abaqus template you have loaded (Standard3D, Standard2D, or Explicit), you can
create surfaces defined by segments, cylinders, or revolutions.

• The Standard3D template enables you to define rigid surfaces of type REVOLUTION and CYLINDER.

• The Standard2D template enables you to define surfaces of type SEGMENTS.

• The Explicit template enables you to define all three types: REVOLUTION, CYLINDER, and
SEGMENTS.

You can define the line segments in three different ways, by picking nodes, by picking existing lines, or
by manually entering the coordinate values. The options on the Define tab vary according to the type
selected.

SEGMENTS Option

Select the following options on the Define tab for planar rigid surfaces:

Plane Definition - Plane/axis
Abaqus does not require the plane/axis definition for SEGMENTS type. In HyperMesh, however,
the XY plane must be used for a 2D model. Therefore, the XY plane is selected by default. If the
model is not in the XY plane, you can choose to select a "User Defined" plane on which the rigid
surface should be defined.
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If you choose to manually define the plane/axis, you must enter values for three points (the
origin, x axis, and y axis) that define the local coordinate system.

You can also use the following buttons to automatically define the plane in the Local System table:

Pick System...
Click to select an existing system from the model. Once you select a plane from the model
and click proceed, the values are populated in the table.

Create/Edit System
Click to create new coordinate systems using the Systems panel.

Line Definition - No. of line segment datalines
In this field you specify the number of datalines needed to define the line segments. The actual
number of line segments is one less than this number.
Start by typing the number of datalines needed to define the line segments and click Set. The
corresponding number of rows appears in the Line Type table below. In this table, specify the
coordinates of the ends of each line segment.
The first entry in the table is always the START node. This value specifies the beginning point of
the first segment. The subsequent segments’ starting point is always the end point of the previous
segment, or the START node if the segment is the first in the definition.
For each line type, select a type from the Line Type column: LINE, CIRCL, or PARAB. Each
selection activates the appropriate number of columns for the segment definition.
The segments can be circles, parabolas, or lines. Enter data in the columns as described below:

• Lines are defined with the x and y coordinates of the end point in the two active columns.

• For circles, specify the x and y coordinate of the end point in the first two columns and then,
define the x and y coordinate of the center in the last two columns.

• For parabolas, specify the x and y coordinate of the mid point in the first two columns and
then, define the x and y coordinate of the end point in the last two columns. You can also
pick nodes or lines from existing geometry using the following buttons:

Pick Nodes...
Click to pick nodes from the HyperMesh model for selected line segments. When you click
proceed, the coordinate values of the selected nodes will appear in selected line segment
cells. In addition, temporary line segments (white color) will also be drawn in the graphic
area from the picked nodes. Ensure that you select two nodes in the correct order for circles
and parabolas.

Pick Lines...
Use this option to define line segments from existing lines in HyperMesh. These lines must
be single curvature, connected and node1 of a line must be same as node2 of the previous
line.

Click to pick a line from the HyperMesh model. When you click proceed, the coordinate
values and line types for the selected lines will appear in the table.

Note:  In HyperMesh, the sequence of node1 and node2 for lines can be
visualized from the Line Edit/Extend Line panel.

Click Update to update the HyperMesh database with your settings.
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CYLINDER Option

Select the following options on the Define tab for cylindrical rigid surfaces:

Plane Definition - Plane/axis
Choose User Defined if you want to create or select the system, or choose XY, YZ, or XZ to define
it in the respective plane.
If you choose to manually define the plane/axis, you must enter values for three points (the
origin, x axis, and generator axis) that define the local plane on which the line segments will be
defined.
You can also use the following buttons to define the plane:

Pick System...
Click to select an existing system from the model. Once you select a plane from the model
and click proceed, the values are populated in the table.

Create/Edit System
Click to create new coordinate systems using the Systems panel.

Line Definition - No. of line segment datalines
In this field you specify the number of datalines needed to define the line segments. The actual
number of line segments is one less than this number.
Start by typing the number of segment datalines to define the surface and click Set. The
corresponding number of rows appears in the Line Type table below. In this table, specify the
coordinates of the ends of each line segment.
The first entry in the table is always the START node. This value specifies the beginning point of
the first segment. The subsequent segments’ starting point is always the end point of the previous
segment, or the START node if the segment is the first in the definition.
For each line type, select a type from the Line Type column: LINE, CIRCL, or PARAB. Each
selection activates the appropriate number of columns for the segment definition.
The segments can be circles, parabolas, or lines. Enter data in the columns as described below:

• Lines are defined with the local x- and local y-coordinates of the end point in the two active
columns.

• For circles, specify the local-x and local-y coordinate of the end point in the first two columns
and then, define the local-x and local-y coordinate of the center in the last two columns.

• For parabolas, specify the local-x and local-y coordinate of the mid point in the first two
columns and then, define the local-x and local-y coordinate of the end point in the last two
columns.

Note:  The local x- and local y-coordinates must be relative to the plane defined in the
Plane/axis table.

You can also pick nodes or lines from existing geometry using the following buttons:

Pick Nodes...
Click to pick nodes from the HyperMesh model for selected line segments. When you click
proceed, the coordinate values of the selected nodes will appear in selected line segment
cells. In addition, temporary line segments (white color) will also be drawn in the graphic
area from the picked nodes. Ensure that you select two nodes in the correct order for circles
and parabolas.
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Pick Lines...
Use this option to define line segments from existing lines in HyperMesh. These lines must
be single curvature, connected and node1 of a line must be same as node2 of the previous
line.

Click to pick a line from the HyperMesh model. When you click proceed, the coordinate
values and line types for the selected lines will appear in the table.

Note:  In HyperMesh, the sequence of node1 and node2 for lines can be
visualized from the Line Edit/Extend Line panel.

Line Definition - Sweep Distance
Abaqus does not need the sweep distance. The CYLINDER type surfaces are swept to infinity
in Abaqus. However, in HyperMesh, you must define a sweeping distance to draw the three-
dimensional surface. Select the Sweep distance check box to specify a sweep distance and type
a value in the adjacent box. Select the Both directions check box to sweep in opposite directions
along the generator vector.

Click Update to update the HyperMesh database with your settings.

REVOLUTION Option

Select the following options on the Define tab for rigid surfaces of revolution:

Plane Definition - Plane/axis
Choose User Defined if you want to create or select the system, or choose XY, YZ, or XZ to define
it in the respective plane.
If you choose to manually define the axis, you must enter values for two points (the origin and
the z axis). Abaqus does not need the x axis values because any plane that passes through the z
axis will define the same revolute surface. However, HyperMesh requires the definition of the x (or
radial) axis to define the plane on which the line segments are drawn.
You can also use the following buttons to automatically define the axis of revolution and x (radial)
axis.

Note:  The coordinate values to define the x axis change if you pick a node (or line)
from HyperMesh as the START node.

Pick System...
Click to select an existing system from the model. Once you select a plane from the model
and click proceed, the values are populated in the table.

Create/Edit System
Click to create new coordinate systems using the Systems panel.

Line Definition - No. of line segment datalines
In this field you specify the number of datalines needed to define the line segments. The actual
number of line segments is one less than this number.
Start by typing the number of line segment datalines to define the surface and click the Set
button. The corresponding number of rows appears in the Line Type table below. In this table,
specify the coordinates of the ends of each line segment.
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The first entry in the table is always the START node. This value specifies the beginning point of
the first segment. The subsequent segments’ starting point is always the end point of the previous
segment, or the START node if the segment is the first in the definition.
For each line type, select a type from the Line Type column: LINE, CIRCL, or PARAB. Each
selection activates the appropriate number of columns for the segment definition.
The segments can be circles, parabolas, or lines. Enter data in the columns as described below:

• Lines are defined with the local-x (or r) and local-y (or z) coordinates of the end point in the
two active columns.

• For circles, specify the local-x (or r) and local-y (or z) coordinate of the end point in the first
two columns and then, define the local-x (or r) and local-y (or z) coordinate of the center in
the last two columns.

• For parabolas, specify the local-x (or r) and local-y (or z) coordinate of the mid point in the
first two columns and then, define the local-x and local-y (or z) coordinate of the end point in
the last two columns.

You can also pick nodes or lines from existing geometry using the following buttons:

Pick Nodes...
Click to pick nodes from the HyperMesh model for selected line segments. When you click
proceed, the coordinate values of the selected nodes relative to the defined plane will
appear in selected line segment cells. In addition, temporary line segments (white color) will
also be drawn in the graphic area from the picked nodes. Ensure that you select two nodes
in the correct order for circles and parabolas.

Pick Lines...
Click to pick a line from the HyperMesh model. When you click proceed, the coordinate
values and line types for the selected lines will appear in the table.

Note:  In HyperMesh, the sequence of node1 and node2 for lines can be
visualized from the Line Edit/Extend Line panel.

Line Definition - Revolution angle
Abaqus does not need the revolution angle. The REVOLUTION type surfaces are revolved around
360 degrees in Abaqus. However, in HyperMesh, you must define a revolution angle to draw
the three-dimensional surface. Select the Revolution angle check box to specify the angle of
revolution and type a value in the adjacent box.
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Click Update to update the HyperMesh database with your settings.

Analytical Rigid Surface: Adjust Normal Tab

Select the following options in the Adjust Normal tab:

Table 64:

Option Description

Display normals Select the Display normals check box to show the normals on the display.
Specify a length for the normals in the Size field. To change the size, toggle
the check box to update the display.

Reverse normals Select one of the radio buttons to reverse the direction of the normals. You can
only choose to reverse the normals of all line segments in this type of surface.
Click Reverse to do this. When reversed, all coordinates and sequence of all
the line segments will be updated.

The analytical rigid surface should be oriented so that the outward normals
point toward any body of contact.

Analytical Rigid Surface: Rigid Body Tab
Associate the surface to an existing *RIGID BODY component or create a new one from this tab.

An analytical rigid surface must have a *RIGID BODY card with a reference node associated with it.
When you create a new rigid surface in the Contact Manager, an empty *RIGID BODY component is
created automatically.

This tab also includes several options related to preparing the model for visualization in HyperView.
HyperView currently does not support geometrical entities like analytical rigid surfaces. If you mesh
analytical rigid surfaces with rigid elements that point to the same *RIGID BODY card, these elements
would not participate in the analysis; they would move with the reference node as a rigid body. These
rigid elements would act like a "display body" in Abaqus, and would be imported in HyperView.

Select the following options on the Rigid Body tab:

Table 65:

Option Description

Select a *Rigid Body Use the drop-down list or the Entity Browser to select a rigid body. You can also
create a new rigid body by clicking Create New.

Reference Node Type the node ID used as a reference to define the rigid body motion. Click
Pick Node to pick a node from the model. Alternatively, type a node value in
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Option Description

the box and click Review to view the location of the node in the model. If you
type a value that does not exist in the model, nothing is highlighted.

Line mesh density Specify the density of the line mesh. Uniform uses the value you specify as the
mesh density for each line segment. Variable brings you to the Line Mesh panel
to create the mesh.

Select either Uniform or Variable and click Mesh to create the line mesh.

Sweep distance/
Sweep angle

The sweep field differs depending on whether the surface is of type CYLINDER
or REVOLUTION.

If the surface is cylindrical, the field is Sweep distance. Type a value for the
distance of the sweep of the mesh. Select the Both direction check box to
extend the sweep in both directions for the specified distance. When the Both
direction check box is selected, the number of layers refers to the depth of
segments in the sweep (number of layers of elements).

If the surface is a revolution, the field is Sweep angle. Type a value for the
angle of the revolution. In the No. of layers field, type the value of how many
segments the rim of the revolution should be divided into.

Analytical Rigid Surface: Optional Parameters Tab

Select the following options on the Optional Parameters tab:

Table 66:

Option Description

Trimming of open free surface Select to specify open free surface trimming. Then click the adjacent
button to select whether to trim.

Max ratio Select to adjust the thicknesses for surface facets in which the
thickness to minimum edge or diagonal length ratio exceeds the
specified value. Then type an adjustment value in the adjacent field.

Scale thickness Select to scale all of the surface facets by a single factor. Then type
the scaling factor in the adjacent field.

Region type for adaptive
meshing

For surfaces defined on the boundary of an adaptive mesh domain,
select to create a boundary region for the surfaces. Click the
adjacent button to select the type of region.

No offset Select for the surface to ignore midplane offsets.
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Option Description

No thickness Select for the surface to ignore thicknesses. Do not select this option
if the surface will be double-sided or a self-contact surface.

Fillet radius Select to define a radius of curvature to smooth discontinuities
between segments. Then type a length in the adjacent field.

Surface Interaction Tab
The Surface Interaction tab displays a description of the *SURFACE INTERACTION cards. You can
create, edit, review and delete surface interactions from this tab.

The Surface Interaction table contains one column, the Name column. The name of the surface
interaction cards in the HyperMesh database are listed in this column.

• Double-click on a surface interaction name in the table to open the corresponding Surface
Interaction dialog. Right-click on a name to display an option menu.

• Table columns can be resized by positioning the cursor along a column border, pressing the left or
right mouse button, and dragging the border to a new position.

• The Shift or Control key and a left-click can be used to select multiple items in a table.

The Surface Interaction tab contains the following buttons:

Table 67:

Button Action

Auto Launches the Auto Contact dialog, from which you can create interactions
between several parts of your model.

New Opens the Create New Surface Interaction dialog in which you enter the name
of the new surface interaction. Click Create to create the surface interaction and
open the corresponding Surface Interaction dialog.

Edit Opens the Surface Interaction dialog for editing the selected surface interaction.

Review Not active on this tab.

Delete Deletes single or multiple surface interactions from the Surface Interaction table.

Rename Rename the selected surface interaction.

Sync Updates the Contact Manager with the current HyperMesh database. If you
manually create, update, or delete components, groups, properties, or entity sets
from HyperMesh panels while the Contact Manager is open, click Sync to update
the Contact Manager with the new changes.
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Button Action

Close Closes the Contact Manager

Surface Interaction
Use the Surface Interaction dialog to define the *SURFACE INTERACTION card.

Supported cards:

Mechanical interaction properties

• *SURFACE BEHAVIOR

• *CONTACT DAMPING

• *FRICTION

Thermal interaction properties

• *GAP CONDUCTANCE

• *GAP HEAT GENERATION

• *GAP RADIATION

The Surface Interaction dialog contains the following buttons:

Table 68:

Button Action

OK Updates the HyperMesh database with the changes and closes the Surface
Interaction window.

Apply Updates the HyperMesh database with the changes without closing the Surface
Interaction window.

Cancel Closes the Surface Interaction window without any update.

Surface Interaction: Define Tab
Use the Define tab to select the surface interaction properties.

The available options are: Surface behavior, Contact damping, Friction and Gap Conductance. Once
you select an interaction property, its corresponding tab will be activated. You can also define optional
parameters (Pad thickness) and data lines (out-of-plane thickness for 2D model or cross-sectional
area at every nodes for node based surface). See the Abaqus Online Documentation for a detailed
description of these parameters.

In addition, the Gap heat generation value can be defined directly in this dialog, it does not require you
to open a new tab, as the other options do. If the Gap heat generation is enabled, the following two
values need to be defined:
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• Dissipated energy fraction - specifies the ratio of how much of the energy in a non thermal contact
such as friction is producing heat

• Weighting factor - decides how much heat goes in one or the other surface of the contact

By default 50 percent of one value is applied to the other (so the default value is 0.5).

Surface Interaction: Surface Behavior Tab
Use the Surface Behavior tab to create *SURFACE BEHAVIOR cards with optional parameters and
corresponding data lines.

The supported optional parameters are: No separation and Pressure overclosure. Options vary according
to the selection made in the Pressure overclosure drop down.

Five types of pressure-overclosures are supported:

Table 69:

Pressure
overclosure

Description

Hard In the 2D/3D template, selecting this option provides four new radio buttons:
Augmented lagrange, Direct, Penalty, and None.

• If Penalty is selected, select whether the penalty is linear or nonlinear and
enter the corresponding information in the fields that appear.

• In the Explicit template, there are no data lines needed for this option.

Exponential There are three fields to define the data line for this option. They are: Clearance at
zero contact pressure, Pressure at zero clearance and Direct (for 2D/3D templates
only) or maximum stiffness (for explicit only).

Linear There are two fields to define the data line for this option. They are Direct (for
2D/3D templates only) and Slope of the pressure-overclosure curve.

Tabular There is a table available for defining the data line values for this option. You need
to input the number of data lines required at the Number of data lines entry box.
Clicking the corresponding Set button will update the table to have the specified
number of rows. For inputting values in the table, click on a cell to make it active
and write down the values from keyboard. The table works like a regular spread
sheet.

You can also read comma delimited data from a text file by clicking Read from file.
This button opens a file browser window. Select the file and click Open to export
the comma delimited data. The row number is set to the number of data lines found
in the file.
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Pressure
overclosure

Description

Note:

• Right-click in the table to display a pull-down menu containing
copy, cut and paste options. Comma delimited data can be copied/
cut into or pasted from the clipboard using these options. Hot keys,
for example, Control-C, Control-X and Control-V on PC, can also be
used.

• Left-click in a cell to activate the cell. Click in an active cell to move
the insertion cursor to the character nearest the mouse.

• The Shift and Control keys can be used with a left mouse click to
select multiple items in a table.

• Press Control and the left or right arrow key to move the cursor
within the active cell. Use the left, right, up and down arrows to
change the active cell.

• Press Backspace to delete the character before the insertion cursor
in the active cell. If multiple cells are selected, Backspace deletes
all selected cells.

• Press Delete to delete the character after the insertion cursor in the
active cell. If multiple cells are selected, Delete deletes all selected
cells.

• Table columns can be resized by positioning the cursor along
a column border, pressing the left or right mouse button, and
dragging the border to a new position.

Scale Factor Modify the default contact stiffness by a scale factors.

Available only in the Explicit user profile.

Surface Interaction: Contact Damping Tab
Use the Contact Damping tab to create *CONTACT DAMPING cards with corresponding parameters and
data lines.

The supported parameters are: Definition and Tangent fraction (explicit only). The two definition types
supported are: Damping coefficient and Critical damping fraction (explicit only). The data item entry
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options change based on the current template. See the Abaqus Online Documentation for a detailed
description of these parameters.

Surface Interaction: Friction Tab
Use the Friction tab to create *FRICTION cards with corresponding parameters and data lines.

The supported friction types (mutually exclusive parameters) are: Default (Coulomb), Elastic slip, Slip
tolerance, Lagrange multiplier, and Rough. Depending on the template loaded and friction type selected,
the window layout changes to show only the relevant options for defining other parameters and data
items. Other supported optional parameters are: Exponential decay, Test data, Anisotropic, Taumax,
and Dependencies. See the Abaqus documentation for detailed descriptions of these parameters.

Note:  The friction type User is not supported in the Contact Manager. However, it is
supported in HyperMeshin the *SURFACE INTERACTION card image.

For all friction types (except Rough), there are four options to define the friction coefficient:

Table 70:

Option Description

Direct This is the default method for defining the friction coefficient. Selecting this
option means that the Exponential decay and Anisotropic parameters will not be
written in the input file.

The No of Dependencies checkbox and corresponding entry box should be used
to define the Dependencies parameter. There is a table available for defining the
corresponding data lines. The available data items are: Friction coefficient, Slip
rate, Contact pressure, Average temperature at the contact point, and average
field variable values.

The column numbers in the table will change based on the setting for No of
Dependencies. The row numbers can be defined at the No of data lines entry
box. Click Set to update the table to reflect the specified number of rows.

To enter values in the table, click on a cell to make it active and write down the
values from keyboard. The table works like a regular spread sheet.

You can also read comma delimited data from a text file by clicking Read From
a File. This button opens a file browser. Select the file and click Open to export
the comma delimited data. The row number will be set to the number of data
lines found in the file.

Anisotropic Defines the data lines for the Anisotropic parameter.

The No of Dependencies check box and corresponding entry box should be used
to define the Dependencies parameter.

There is a table available for defining the corresponding data lines. The available
data items are: Friction coefficient1 (first slip direction), Friction coefficient2
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(second slip direction), Slip rate, Contact pressure, Average temperature at the
contact point, and average field variable values.

The column numbers in the table will change based on the setting for No of
Dependencies. The row numbers can be defined at the No of data lines entry
box. Click Set to update the table to reflect the specified number of rows.

To enter values in the table, click on a cell to make it active and write down the
values from keyboard. The table functions like a regular spread sheet.

You can also read comma delimited data from a text file by clicking Read From
a File. This button opens a file browser. Select the file and click Open to export
the comma delimited data. The row number will be set to the number of data
lines found in the file.

Exponential decay Defines the data lines for the Exponential decay parameter. The available data
items are: Static friction coefficient, Kinetic friction coefficient, and decay
coefficient

Exponential decay,
test data

Defines the data lines for the Exponential decay, test data parameter. The
available data items are: Friction coefficient at point 1 (first data line), Friction
coefficient at point 2 (second data line), Slip rate at point 2 (second data line)
and Kinematic friction coefficient (optional third data line).

When using the Direct and Anisotropic tables:

• Right-click in the table to display a pull-down menu containing copy, cut and paste options. Comma
delimited data can be copied/cut into or pasted from the clipboard using these options. Hot keys,
for example, Control-C, Control-X and Control-V on PC, can also be used.

• Left-click in a cell to activate the cell. Click in an active cell to move the insertion cursor to the
character nearest the mouse.

• The Shift and Control keys can be used with a left mouse click to select multiple items in a table.

• Press Control and the left or right arrow key to move the cursor within the active cell. Use the left,
right, up and down arrows to change the active cell.

• Press Backspace to delete the character before the insertion cursor in the active cell. If multiple
cells are selected, Backspace deletes all selected cells.

• Press Delete to delete the character after the insertion cursor in the active cell. If multiple cells are
selected, Delete deletes all selected cells.

• Table columns can be resized by positioning the cursor along a column border, pressing the left or
right mouse button, and dragging the border to a new position.

Surface Interaction: Gap Conductance Tab
Use the Gap Conductance tab to define the heat transfer between two surfaces.

Two definitions are possible, both of which can be combined:
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• Clearance dependant relationship

• Pressure dependent relationship

If enabled, the upper part of the dialog writes a *GAP CONDUCTANCE card with the distance versus
conductance relationship entered in the table. If you enable the Pressure dependent definition in
the lower part of the dialog, the same card with an additional PRESSURE parameter is written out,
specifying a pressure versus conductance relationship.

For both tables, additional dependencies can be specified by increasing the number in the No of
Dependencies field.

Surface Interaction: Gap Radiation Tab
Use the Gap Radiation tab to define a viewfactor versus distance relationship for heat transfer between
surfaces which are very close to each other.

Emissivities for both involved surfaces can be defined. By default, the dialog offers two datalines to
define a function of the viewfactor depending on the gap with between two surfaces. The length of the
table can be increased by changing the Number of datalines field.

Use the Dummy Positioning Process Manager
The Dummy Positioning Process Manager tool guides you through the workflow of positioning a dummy
in a seat.

The recommended steps include an interactive positioning process, during which you specify the H-point
position of the dummy, as well as the rotation angles of each joint, such as arm and leg. When finished
with this phase, you will be able to store a transformation file which can later be applied on the dummy
only in the next phase, the automatic positioning process. In this phase, you can choose to export only
the nodes, which creates a copy of the original dummy file with the updated nodes. The rest of the
dummy input file remains unchanged with this option.

In the Process Manager tab, you will see the workflow process. As you complete the positioning process,
the boxes will become filled with green check marks to indicate the completion of each step.

Use the H-Point subpanel to position the dummy to the H-Point, or rotate the entire dummy about
the H-Point. For positioning, you can specify either the coordinates or a node for the new H-Point. For
rotating, specify the axis of rotation and the angle. In either case, picking any component in the dummy
is sufficient.

Use the incremental subpanel to rotate an assembly about the coordinate system specified in the tree
structure. In this panel, you have an option to rotate about the child or the parent system. The min
stop and max stop angles for the x, y, z, axis associated with the joint are retrieved from the dummy
database. When the minimum and maximum angles are reached, the assembly is not allowed to rotate
any further.

Note:  Do not use the Rotate panel in the Tools panel to rotate the dummy. Doing so
corrupts the tree structure and produces incorrect results when you reposition the dummy.

1. In the Abaqus Explicit template, open the Utility menu and click PositioningProcess.
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2. Click Create/Open to start a new Process Manager instance.

3. In the panel area, select the Interactive positioning radio button and click Apply.

4. Click the file browser icon to browse for the dummy input file (*.nip) to open.

5. In the Positioner filename field, browse for the *.pos file to load. When both files are established,
click Load .
You can change the default settings for the import options as needed. Default settings include
using free format import and preserving include files upon import.

Note:  The Import Process Message dialog may appear. If it does, click Close and
continue the process. If you are intending to exchange only the nodal coordinates of
the dummy file at the end of the process, eventually reported unsupported cards do
not require action in this case.

6. In the next panel, use the browse button to select the non-dummy files, such as the seat. If you
have more than one file to load, click Add to display more fields. Click Load to load the file(s).

Figure 536:
Use the Load File icon to browse for the file to open.

7. After the files are loaded, click on the H-point  subpanel and position the dummy in the H-Point
using the fields available. Click the comps button and select the dummy graphically. Enter the
coordinates to position the model and rotate as needed.

8. Once the dummy is positioned in the H-point, click on the Incremental subpanel. Make your
changes and click return.

9. In the next panel, you can visualize the stop angles (lower/upper/current) for the elements used
in the dummy. Click the Show Plot button to display the plot in the graphics area. Click Next to
move to the next panel.

10. In the field, enter a name and folder location and click Create.
The transformation file is created. This is needed to automatically position the dummy later when
no other file (such as the seat) is loaded.

11. In the Create documentation panel, you can create an HTML report that lists the document angles
and positions of the dummy, as well as screen shots of the model. Enter a name and location for
the HTML document and click Create.

12. In the Export Files steps, select whether to export the model or save it as an HyperMesh file. You
can also choose to skip this task and export the dummy later, during the automatic process. Click
Export to export the model, or click Next to skip the step.

13. The Automatic Positioning phase now begins. In this panel, the files entered at the beginning of
the InteractivePositioning process are already filled in the fields. Click Load to load the files into
HyperMesh. Click OK to delete the current model.
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Note:  The Import Process Message dialog box may appear. If it does, click Close
and continue the process. If you are intending to exchange only the nodal coordinates
of the dummy file at the end of the process, eventually reported unsupported cards do
not require action in this case.

The Transformation filename is automatically loaded in the panel.

14. Click Execute.

15. Similarly to the InteractivePositioning phase, you can create an HTML document with the model
specifics. Click Create, or click Next to skip the documentation task.

16. The last task is to export the dummy solver format or create an HyperMesh file. If exporting in
solver format, the recommended setting is to select exchange only nodes. This will copy the
original dummy file to a new one that uses a name you specified, and will exchange the node
positions. You’ll find a comment in front of and after the node block to highlight the exchanged
nodes.

The comments are:

** Begin replaced node block by dummy positioning tool

** End replaced node block by dummy positioning tool

The Process Manager tree should now be completed, with each task showing a green check mark.

Solid Face Alignment Utility
Use this tool to align the face1 of selected solid elements (hexa and penta) to match with a planar face.

The Solid Face Alignment utility uses the face1 to face2 direction to determine the default stack or
thickness direction for Abaqus composite solid, gasket and continuum shell elements.

As a result, the default stack (or thickness) directions for all selected elements become normal to a
plane. In addition, you can review the face1 and default stack (or thickness) direction of selected solids.
The utility has three buttons:

Table 71:

Button Action

Align Faces Click Align Faces to open the Element Selector panel, from which you can
select solid elements. Selected elements are highlighted. When you click
proceed, it creates a temporary skin of the selected solids and allows you to
pick face elements from this skin. The selected faces are highlighted. When
you click proceed, the face1 of all selected solid elements will match with the
selected face element and a review of the stack (or thickness) direction will
be shown.

Review Opens the Element Selector panel, from which you can select solid elements.
Selected elements are highlighted. When you click proceed, it highlights
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the face1 of selected solids and draws an arrow along the default stack (or
thickness) direction of selected solids.

Reset Deletes the stack (or thickness) direction arrows.

Abaqus Step Manager Overview
Use the Step Manager to create, edit and review supported keywords.

To access this tool, load the Abaqus user profile and select Step Manager from the Utility menu. Use
the Step Manager to create, edit, and review the following keywords in HyperMesh begins in the Step
tab:

Analysis types:

• *BUCKLE

• *DYNAMIC

• *FREQUENCY

• *HEAT TRANSFER

• *MODAL DYNAMIC

• *STATIC

• *STEADY STATE DYNAMICS

Loads:

• *BOUNDARY

• *CLOAD

• *DLOAD

• *DSLOAD

• *FILM

• *CFILM

• *SFILM

• *TEMPERATURE

• *INERTIA RELIEF

• *INITIAL CONDITIONS {TYPE=TEMPERATURE, VELOCITY}

Output requests:

• *OUTPUT

• *NODE OUTPUT

• *ELEMENT OUTPUT

• *STEP OUTPUT

• *ENERGY OUTPUT

• *NODE FILE
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• *EL FILE

• *STEP FILE

• *ENERGY FILE

• *NODE PRINT

• *EL PRINT

• *STEP PRINT

• *ENERGY PRINT

Interface controls:

• *MODEL CHANGE

• *CONTACT INTERFERENCE

• *CHANGE FRICTION

• *CLEARANCE

• *CONTACT CONTROLS

Others:

• *MONITOR

• *FILE FORMAT

• *PRINT

• *RESTART

• *STEP

Step Manager Dialog Environment
Procedures used to navigate you through the Step Manager dialog.

• When the Step Manager dialog is minimized or it is behind HyperMesh, restore it by clicking Step
Manager in the Abaqus Utility menu.

• Double-click on a cell entry to open the corresponding editing window.

• The first row contains a list of all initial condition (or model) load collectors. Double click on an
Initial Condition name to open the corresponding dialog for defining initial condition loads.

• Right-click on a table to display menu options. Examples of options are Display: all, Display: none,
Display: reverse, Text review, Review Load collectors, Reset review, Review Options, Reorder,
Export: all, and Export: none. The Text review and Review load collectors options work like the Text
and Review buttons, respectively (see Abaqus Step Manager: Load Step Dialog). The Reset review
option clears the highlighted selections.

• Table columns can be resized by positioning the cursor along a column border, pressing the left or
right mouse button, and dragging the border to a new position.

• The Shift or Control key combined with a left-click can be used to select multiple items in a table.

• To display bubble help, place the cursor over a button for a few moments.

• Press Control and the left or right arrow key to move the cursor within the active cell. Use the left,
right, up, and down arrows to change the active cell.

• Right-click on the Review button to clear the highlighted selections.
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• If you create, update or delete steps, load collectors, output blocks, components, groups,
properties, or entity sets from panels while the Step Manager is open, click Sync to update the
Step Manager with the new changes.

• In some fields in the Step Manager, you can access the Entity Browser, which is available via the
(…) button. The Entity Browser makes it more convenient to view and sort long lists of components
or other entities when selecting them for the field.

Entity Browser
Use the Entity Browser to easily sort and select an entity for a field on a dialog.

The Entity Browser is available through the … button and lists the entities of the relevant type for the
selection.

The entities are listed in a tree view. To select an entity, highlight it in the list and click OK. Use the
buttons on the dialog to sort the list to more easily view the choices when there are many entities in the
list. The buttons perform the following actions:

Table 72:

Button Action

Filter Type text in the adjacent field and click Filter to show only the entities with names
that contain the text. You can use the wildcard character (*) to specify that the
text can appear anywhere within the entity name. To clear the results and show all
entities, right-click Filter.

Review Highlights the selected entity in the model.

Sort Lists the entities in alphabetical order. Click again to reverse the order.

OK Selects an entity for the field on the dialog.

Cancel Closes the Entity Browser without making a selection.

Step Manager Tab Environment

• Editable cells have a white background, unless it is the active cell. You can input values using the
keyboard in editable cells. Non-editable cells have a gray background.

• Left-click in an editable (white background) cell to activate it for input. Click in an active cell to
move the insertion cursor to the character nearest the mouse.

• Press Control and the left or right arrow key to move the cursor within the active cell. Use the left,
right, up, and down arrows to change the active cell.

• Press Backspace to delete the character before the insertion cursor in the active cell.

• Press Delete to delete the character after the insertion cursor in the active cell.
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• Table columns can be resized by positioning the cursor along a column border, pressing the left or
right mouse button, and dragging the border to a new position.

• In some fields, you can use the (…) button to open the Entity Browser to select the entity for that
field.

Abaqus Step Manager: Step Tab
You can create, edit, review, rename, reorder, and delete load steps from this tab as well as set the
export and display status of the load steps.

The Abaqus Step Manager opens when you load the Abaqus user profile and click Step Manager in
the Abaqus Utility menu. The Step Manager window is organized into two tabs: Step and Load Case.

The Step tab contains the descriptions of existing load steps with the corresponding analysis types, load
collectors, output requests, and interface controls.

The Step table contains the following columns:

Table 73:

Column Description

Export The export status of the load step. If the export status is on, the load step is
written to the input file when exported from HyperMesh. If the export status
is off, the STEP is not exported to the input file.

Name The name of the load step.

Analysis Type The analysis type of the load step.

Load Collector The list of load collectors in the load step.

Output Block The list of output blocks in the load step.

Interface Controls The list of interface controls in the load step. Interface Controls defines
the following Abaqus keywords: Contact Pair, Surface Interaction, Contact,
Contact Controls, Clearance, Contact Interference, Model Change, Change
Friction, and Controls.

Display Turns the load step display on/off.

The Step tab contains the following buttons:

Table 74:

Button Action

New... Opens the Create New Step dialog. Enter the name of the new load step
in the Name: text box and click Create to create the load step and open the
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corresponding Load Step editing dialog. Use the Same as option to create a new
load step by copying from an existing load step.

Edit... Opens the load step editing dialog for the selected load step.

Review Reviews the selected load collectors. All loads in the load collectors are
highlighted in the graphic area. The highlighted loads show through the solid
mesh in performance graphics. If a load is defined with set, the underlying
nodes or elements are highlighted. Right-click Review to clear the highlighted
selections.

Text Reviews the selected load step in a text window.

Rename Opens the Rename panel for renaming load steps, load collectors, output blocks,
or various interface controls. When you finish renaming, click return to update
the Step Manager with the new names.

Delete Deletes the selected load steps.

Sync Updates the Step Manager with the current HyperMesh database. If you
manually create, update, or delete load steps, load collectors, output blocks,
groups, or entity sets from panels while the Step Manager is open, click Sync to
update the Step Manager with the new changes.

Close Closes the Step Manager.

↑ Moves the selected load steps up one row.

↓ Moves the selected load steps down one row.

Abaqus Step Manager: Load Step Dialog
Use the Load Step dialog to define the *STEP-*END STEP block as well as the associated Abaqus
history keywords.

To open this dialog, double-click on the load step name in the Name: column on the Step tab or select
the load step from the Name column and click Edit. Options vary according to the active template.
There are three vertical sections in this dialog.

Left-Most Section
Contains a tree structure with various Abaqus history options. Selecting an option from the tree
changes the dialog layout.

Middle Section
Contains the corresponding collectors in a table and relevant buttons to create, review, organize,
reorder, rename, or delete these collectors. All loads must be organized into load collectors and all
output requests must be under output blocks. When you select a load type, output request type,
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or interface control from the tree, the load collector table, output block table, or interfaces table is
displayed in the middle section.

Right-Most Section
Contains the various tabs and options to define, edit, review, or delete the currently selected tree
item. If the tree item needs to be organized in a collector, such as a load or output request, a
collector must be selected from the middle section.

Table 75:

Button Action

Review Reviews all load collectors in the current load step. All loads in the load collectors
are highlighted in the graphic area. The highlighted loads show through the
solid mesh in performance graphics. If a load is defined with set, the underlying
nodes or elements are highlighted. Right-click Review to clear the highlighted
selections.

Text... Reviews the current load step in a text window.

Synchronize Updates the Step Manager with the current HyperMesh database. If you
manually create, update, or delete load steps, load collectors, output blocks,
groups, or entity sets from panels while the Step Manager is open, click
Synchronize to update the Step Manager with the new changes.

Close Closes the Load Step window and opens the Step Manager window.

The following options are available on the Load Step dialog tree:

Load Step
Title
Parameter
Analysis procedure
Load collector

• Boundary

• Concentrated loads

◦ CLOAD

◦ CFILM

◦ CRADIATE

• Distributed loads

◦ DLOAD

◦ FILM

◦ RADIATE

• Surface Loads

◦ DSLOAD
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◦ SFILM

◦ SRADIATE

• Temperature

• Inertia Relief

• Interface controls

◦ Contact Pair

◦ Surface Interaction

◦ General Contact

◦ Contact Controls

◦ Clearance

◦ Contact Interface

◦ Model Change

◦ Change Friction

◦ Controls

• Output requests

◦ ODB file

◦ Result file (.fil)

◦ Data file (.dat)

• Monitor

• Print

• File Format

• File Output

• Restart write

• Unsupported cards

Load Step: Load Collector Table
You can create, edit, review, rename, reorder, and delete load collectors from this table. You can also
organize (copy or move) loads into load collectors and edit the load labels here.

Each load or constraint must belong to a load collector. Therefore, when you select load types from the
tree, the load collector table appears in the middle section of the Load Step dialog.

The Load collector table contains a list of the load collectors with their corresponding display, color, and
history status.

The Load collector table contains the following columns:

Table 76:

Column Description

Status The history status of the load collector. If the status is on, the load collector
belongs to the current load step. This means, all loads in the load collector will be
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Column Description

written under the current *STEP block. If the status is off, no loads from the load
collector will be written under the current *STEP block.

Name The name of the load collector. The load collector names are for internal use only.
The Abaqus input file does not need them.

Display The display on/off check boxes and color change buttons for the load collector. The
color can be changed by clicking the color button and selecting a color from the
menu.

Click on a load collector name to set it as the current load collector. All loads created from this point are
placed into the selected load collector.

The Load Type: status bar (below the load collector table) shows all the load types present in the
selected load collector. In addition, these load types are highlighted with bold font in the tree.

See Step Manager Dialog Environment for tips on navigating through the dialogs.

The Load collector table contains the following buttons:

Table 77:

Button Action

New Opens the Create Load Collector dialog in which you enter the name of the
new load collector. Use the Same as option to create a load collector by copying
attributes (except loads created from panels) from an existing load collector. Click
Create to create the load collector and add it to the current load step.

Review Reviews the selected load collector. All loads in the load collector are highlighted in
the graphic area. The highlighted loads show through the solid mesh in performance
graphics. If a load is defined with set, the underlying nodes or elements are
highlighted. Right-click on the Review button to clear the highlighted selections.

Organize... Opens the Organize panel where you can copy/move loads into different load
collectors. When you have finished, click return to update the Step Manager with
the new organization.

Label... Opens the corresponding panel where you can turn on/off load labels or update the
label size.
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Button Action

Delete Opens the Delete panel where you can delete load collectors. When you are
finished, click return to update the Load collector table.

Load Step: Title
Select Title to define a one line title or sub-heading for the load step.

This line appears under the *STEP keyword in the input file. The title is also used in the ODB file to
identify the step. Check the Step Heading option to input the title and click Update to update the
HyperMesh database.

Load Step: Parameter
Select Parameter to define the parameters of the *STEP card.

The supported parameters are: Name, Amplitude, Extrapolation, Unsymmetric, Increment, Nlgeom,
and Perturbation.

Click Update to activate the parameters defined in the HyperMesh database.

Load Step: Analysis Procedure
Select Analysis procedure to define the analysis type of the load step.

The following analysis types with the corresponding parameters and data lines are supported:

Table 78:

Analysis Types Parameter

*FREQUENCY PROPERTY EVALUATION, EIGENSOLVER = {SUBSPACE, LANCZOS,
AMS}, NORMALIZATION = {MASS, DISPLACEMENT}, RESIDUAL MODES,
ACOUSTIC COUPLING, NUMBER INTERVAL, BIAS, USER BOUNDARIES

*BUCKLE EIGENSOLVER = {SUBSPACE, LANCZOS}

*DYNAMIC (Standard) HAFTOL, DIRECT, DIRECT=NO STOP, SUBSPACE, ADIABATIC, ALPHA,
INITIAL, NOHAF

*DYNAMIC (Explicit) EXPLICIT, SCALE FACTOR, ADIABATIC

FIXED TIME INCREMENTATION, DIRECT USER CONTROL, ELEMENT BY
ELEMENT

IMPROVED DT METHOD = YES or NO

*HEAT TRANSFER DELTMX, END = {PERIOD, SS}, STEADY STATE, MXDEM
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Analysis Types Parameter

*MODAL DYNAMIC CONTINUE = YES or NO

*STATIC ADIABATIC, FULLY PLASTIC, RIKS, STABALIZE, DIRECT, DIRECT=NO STOP,
FACTOR, LONG TERM

*STEADY STATE
DYNAMICS

DIRECT, SUBSPACE PROJECTION = {ALL FREQUENCIES, CONSTANT,
EIGENFREQUENCY, PROPERTY CHANGE}, FREQUENCY SCALE, INTERVAL,
REAL ONLY, DAMPING CHANGE, STIFFNESS CHANGE

*COUPLED
TEMPERATURE-
DISPLACEMENT

STEADY STATE, MAXIMUM TEMPERATURE CHANGE DELTMX

*DYNAMIC
TEMPERATURE-
DISPLACEMENT(Explicit)

TIME INCRIMINATION, IMPROVED DT METHOD, SCALE FACTOR

There are two tabs for each analysis type: Parameter and Dataline. The layout of the tabs change,
based on the analysis types selected.

Click Update to activate the optional parameter or data item selection in the HyperMesh database.

Load Step: Boundary
In the Boundary dialog, define and edit the *BOUNDARY card.

To open this dialog, select Boundary from the tree and a load collector from the Load collector table.

Load Step: Boundary: Define Tab
In the Define tab, define *BOUNDARY cards on individual nodes or geometry (surfaces, points, lines).
You can also define the boundary on node sets.

There are five different types of boundary conditions available:

Table 79:

Boundary Types Abaqus Keyword

Default (disp) *BOUNDARY

Velocity *BOUNDARY, TYPE = VELOCITY

Acceleration *BOUNDARY, TYPE = ACCELERATION

Temperature *BOUNDARY on dof 11

Electric potential *BOUNDARY on dof 9
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It is recommended that you use only one boundary type per load collector in HyperMesh. If you need
to use multiple boundary types in the same STEP, define each type in a separate load collector and add
them to the same load step.

You can define a *BOUNDARY card on nodes/geometry or on node sets. For Define Boundary on:, the
following options are available:

• Nodes or geometry

• Node sets

The layout of the Define tab changes, based on your selection.

Define Boundary On: Nodes or Geometry
Use the Define Boundary on: Nodes or geometry option to define various types of boundaries on
individual nodes or geometry.

Boundaries created on nodes have a special graphical display in HyperMesh. Loads created on geometric
entities like surfaces, lines or points are automatically mapped to FEA mesh on export. You can also
map them using the Map Loads on Geometry button.

The Define tab for Define Boundary on: Nodes or geometry has the following buttons:

Table 80:

Button Action

Define from
'Contraints'
panels

Opens the Constraints panel to create/update boundary conditions.

To create a boundary on nodes, go to the create subpanel, select the nodes button,
pick the desired nodes from HyperMesh graphics, check the constrained degrees of
freedoms, and click create.

To create a boundary on geometry, go to the create subpanel, select surfs, points,
or lines using the switch, pick the desired geometry from the HyperMesh graphics,
check the constrained degrees of freedom, and click create.

Note:

• Loads created on geometric entities are automatically mapped to
FEA mesh on export. You can also map them using the Map Loads
on Geometry button.

• An existing boundary can be updated from the updatesubpanel.

• While you are in the constraints panel, press the H key to view
panel-specific help.

• When you are finished creating or updating boundary conditions,
click return to update the Step Manager with the new loads.

Map Loads on
Geometry

Opens the HyperMesh loads on geom panel to map loads on geometry to FEA mesh
entities.

Click Map loads to map all geometric loads in the current load collector to FEA
entities.
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Button Action

Note:

• You can also pick other load collectors by clicking the loadcols
button and map loads in all of them together.

• While you are in the loads on geom panel, press the H key to view
panel-specific help.

• When you are finished, click return to update the Step Manager
with the new loads.

Define Boundary On: Node Sets
The Define Boundary on: Node sets option defines various types of boundaries on node sets.

The node set names are used in the *BOUNDARY data lines instead of the individual nodes. Unlike
Abaqus surfaces in HyperMesh, you can combine node sets with individual node IDs in the same
*BOUNDARY card.

Note:  HyperMesh does not graphically display loads created on sets. Therefore, when you
review a load collector in the Step Manager, only loads created on individual entities are
highlighted. For loads defined on sets, the underlying nodes or elements are highlighted.

This dialog contains a Node sets menu with a list of the existing node sets. It also has a table for data
line input containing the following columns:

Table 81:

Column Description

Nset The name of the node sets. Node sets can only be added or deleted from this
column using the → or ← buttons, respectively.

1st dof The first degree of freedom. You can input any integer or any of the following
types in this column:

XSYMM, YSYMM, ZSYMM, ENCASTRE, PINNED, XASYMM, YASYMM, ZASYMM,
NOWARP, NOOVAL, NODEFORM

Last dof The last degree of freedom

Magnitude The magnitude

Load ID The ID of the load collector
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The Define tab for Define Boundary on: Node sets contains the following buttons:

Table 82:

Button Action

Review Set Reviews the selected node sets by highlighting them in the HyperMesh graphics.
Right-click the Review button to clear the review selections.

Create/Edit Set Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the
set, click return. The Step Manager is updated with the new set appearing in
the element set list.

→ Add the selected node set from the pull down menu to the data line table on the
right.

← Delete the selected node set from the data line table.

Review Reviews the selected node set in the data line table. Right-click Review to clear
the highlighted selections.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

Display/Review
from panel

Opens the appropriate HyperMesh panel. Use the Review button to expand the
loads and constraints on the sets for visualization purposes.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

Load Step: Boundary: Delete Tab
In the Delete tab, delete boundaries and other loads from HyperMesh.

There are three options:

Table 83:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'Boundary' in current collector The Delete button deletes only *BOUNDARY loads from the
current load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.
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Load Step: Boundary: Parameter Tab
In the Parameter tab, define optional parameters for the *BOUNDARY card.

The supported parameters are: Amplitude, OP, Load Case, Fixed, and Region Type.

Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: CLOAD
In the CLOAD-Force dialog, define the *CLOAD card for dofs 1 through 3 and the CLOAD-Moment for
dofs 4 through 6.

In Abaqus, *CLOAD can have degrees of freedom (dof) 1 through 6. In HyperMesh, concentrated loads
with dofs 1 through 3 are called force and those with dofs 4 through 6 are called moments. The force
and moments are two separate entities that are defined from separate panels. Their graphical displays
are also different. As a result, the Step Manager has two distinct tree options for *CLOAD: CLOAD-
Force and CLOAD-Moment.

Open Concentrated loads in the tree, select CLOAD-Force or CLOAD-Moment, and a load collector
from the Load collector table to open the corresponding dialog in the right-most section of the Load
Step window.

It is recommended that you do not use both CLOAD–Force and CLOAD-Moment in the same load
collector in HyperMesh. If you need to use both types of *CLOAD in the same STEP, define each type in
a separate load collector and add them to the same load step.

Load Step: CLOAD: Define Tab
In the Define tab, define *CLOAD (force or moment) cards on individual nodes or geometry (points).
You can also define the *CLOAD on node sets.

You can define CLOAD-Force/Moment on nodes/geometry or on node sets. For Define CLOAD-Force/
Moment on:, the following options are available:

• Nodes or geometry

• Node sets

The layout of the Define tab changes based on your selection.

Define CLOAD-Force/Moment On: Nodes or Geometry
Use the Define CLOAD-Force/Moment on: Nodes or geometry option to define *CLOAD (force or
moment) on individual nodes or geometry.

The concentrated loads created on nodes have special graphical display in HyperMesh. Loads created on
geometric entities such as surfaces, lines, or points are automatically mapped to FEA mesh on export.
They can also be mapped using the Map Loads on Geometry button.
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The Define tab for Define CLOAD-Force/Moment on: Nodes or geometry contains the following buttons:

Table 84:

Button Action

Define from
'Forces'/'Moments'
Panel

Opens the HyperMesh Forces or Moments panel to create/update a CLOAD.

To create a CLOAD on nodes, go to the create subpanel, select nodes using
the switch, pick the desired nodes from HyperMesh graphics, select the
global/local system, select a vector, input a magnitude, and click create.

To create a CLOAD on geometry, go to the create subpanel, select points
using the switch, pick the desired geometry from HyperMesh graphics, select
the global/local system, select a vector, input a magnitude, and click create.

Note:

• Loads created on geometric entities are automatically
mapped to FEA mesh on export. You can also map them
using the Map Loads on Geometry button.

• You can also update an existing force or moments from the
update subpanel.

• While you are in the forces or moments panel, press the H
key to view panel-specific help.

• When you finish creating or updating CLOAD, click return to
update the Step Manager with the new loads.

Map Loads on geometry Opens the HyperMesh Loads on Geom panel to map loads on geometry to
FEA mesh entities.

Click Map loads to map all geometric loads in the current load collector to
FEA entities.

Note:

• You can also pick other load collectors by clicking on the
loadcols button and map loads in all of them together.

• While you are in the Loads on Geom panel, press the H key
to view panel-specific help.

• When you are finished, click return to update the Step
Manager with the new loads.

Define CLOAD-Force/Moment On: Node Sets
The Define CLOAD-Force/Moment on: Node sets option defines CLOAD on node sets.

The node set names are used in the *CLOAD data lines instead of the individual nodes. Unlike Abaqus
surfaces in HyperMesh, you can combine node sets with individual node IDs in the same *CLOAD card.
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Note:  Loads created on sets are not graphically displayed in HyperMesh. Therefore, when
you review a load collector in the Step Manager, only loads created on individual entities
are highlighted. For loads defined on sets, the underlying nodes or elements are highlighted.

This Define tab for Define CLOAD-Force/Moment on: Node sets includes a Node sets menu containing a
list of existing node sets. A data line input table also appears on the Define tab. The table contains the
following columns:

Table 85:

Column Description

Nodeset The name of the node sets. Node sets are added or removed using → or ←,
respectively.

Comp_x The component in x direction. The x-direction indicates dof 1 for force and dof 4
for moment.

Comp_y The component in y direction. The y-direction indicates dof 2 for force and dof 5
for moment.

Comp_z The component in z direction. The x-direction indicates dof 3 for force and dof 6
for moment.

Magnitude The magnitude. This column is non-editable. The magnitude is calculated based
on the Comp_x, Comp_y, and Comp_z defined for each node set when you click
Update.

Load Id The ID of the load collector.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

The Define tab for Define CLOAD-Force/Moment on: Node sets contains the following buttons:

Table 86:

Button Action

Review Set Reviews the selected node sets by highlighting them in the HyperMesh
graphics. Right-click Review to clear the review selections.

Create/Edit Set.. Opens the Entity Sets panel in HyperMesh. When you finish creating/editing
the set, click return. The Step Manager is updated with the new set
appearing in the element set list.

Display/Review from
panel

Opens the appropriate HyperMesh panel. Use the review button to expand
the loads and constraints on the sets for visualization purposes.
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Button Action

→ Add the selected node set from the drop-down menu to the data line table on
the right.

← Delete the selected node set from the data line table.

Define by vector Opens the HyperMeshvector selector panel. Pick a vector and click proceed.
This vector is used to define the Comp_x, Comp_y, Comp_z, and Magnitude
of the CLOAD for the selected node set.

Create/Edit vector Opens the Vectors panel in HyperMesh. When you finish creating/editing the
vector, click return.

Review Creates special review forces or moments in HyperMesh graphics for the
selected node set. These review forces or moments take into consideration
the *TRANSFORM cards that may be associated with nodes in the node set.
Right-click Review to clear the special review loads and highlighting.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not display loads defined with sets.

Load Step: CLOAD: Delete Tab
In the Delete tab, delete *CLOAD and other loads.

There are three deletion options:

Table 87:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'CLOAD' in current collector The Delete button deletes only *CLOAD loads from the current
load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: CLOAD: Parameter Tab
In the Parameter tab, define optional parameters for the *CLOAD card.

The supported parameters are: Amplitude, OP, Load Case, Cyclic Mode, Follower, and Region Type.
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Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: CFILM
In the CFILM dialog, define the *CFILM card on node sets.

To open this dialog from the Load Step dialog, expand Concentrated loads from the tree, select
CFILM, and then select a load collector from the Load Collector table.

Load Step: CFILM: Define Tab
In the Define tab, define a *CFILM card on node sets only.

HyperMesh does not support *CFILM on individual nodes.

Use the Define CFILM-Force/Moment on: Node sets option to define CFILM on node sets. The node set
names are used in the *CFILM data lines instead of the individual nodes. Unlike Abaqus surfaces in
HyperMesh, you can combine node sets with individual node IDs in the same *CFILM card.

Note:  Loads created on sets are not graphically displayed in HyperMesh. Therefore, when
you review a load collector in the Step Manager, only loads created on individual entities
are highlighted. For loads defined on sets, the underlying nodes or elements are highlighted.

This dialog has a node sets menu containing a list of the existing node sets. It also has a data line input
table with the following columns:

Table 88:

Column Description

Nodeset The name of the node sets. Node sets are added or removed using → or ←,
respectively.

Area The area associated with the nodes.

Sink temp Reference sink temperature.

Film coef Reference film coefficient.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

The Define CFILM on: Node sets option has the following buttons:

Table 89:

Button Action

Review Set Reviews the selected node sets by highlighting them in the HyperMesh
graphics. Right-click Review to clear the review selections.
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Button Action

Create/Edit Set.. Opens the Entity Sets panel in HyperMesh. When you finish creating/editing
the set, click return. The Step Manager is updated with the new set
appearing in the node set list.

→ Add the selected node set from the drop-down menu to the data line table on
the right.

← Delete the selected node set from the data line table.

Review Reviews the selected node set in the data line table. Right-click Review to
clear the highlighted selections.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not display loads defined with sets.

Load Step: CFILM: Delete Tab
In the Delete tab, delete *CFILM and other loads.

There are three deletion options:

Table 90:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'CFILM' in current collector The Delete button deletes only *CFILM loads from the current
load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: CFILM: Parameter Tab
In the Parameter tab, define optional parameters for the *CFILM card.

The supported parameters are: Amplitude, Film Amplitude, OP, and Region Type.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1458

Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: CRADIATE
In the CRADIATE dialog, define the *CRADIATE cards on node sets.

To open this dialog from the Load Step dialog, select CRADIATE from the tree and a load collector
from the Load collector table.

Load Step: CRADIATE: Define Tab
In the Define tab, define a *CRADIATE card on node sets only.

*CRADIATE on individual nodes is not supported.

Use the Define CRADIATE on: Node sets option to define *CRADIATE on node sets.

Note:  Loads created on sets are not graphically displayed. Therefore, when you review a
load collector in the Step Manager, only loads created on individual entities are highlighted.
For loads defined on sets, the underlying nodes or elements are highlighted.

This dialog has a node sets drop down menu containing a list of the existing node sets. It also has a
data line input table with the following columns:

Table 91:

Column Description

Nodeset The name of the node sets. Node sets are added or removed using → or ←,
respectively.

Area The area associated with the nodes.

Sink temp Ambient reference temperature.

Emissivity Surface emissivity.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

The Define CRADIATE on: Node sets option has the following buttons:

Table 92:

Button Action

Review/Reset Set Reviews the selected node sets by highlighting them in the HyperMesh
graphics. Right-click Review to clear the review selections.

Create/Edit Set.. Opens the Entity Sets panel in HyperMesh. When you finish creating/editing
the set, click return. The Step Manager is updated with the new set
appearing in the node set list.
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Button Action

→ Add the selected node set from the drop-down menu to the data line table on
the right.

← Delete the selected node set from the data line table.

Review Reviews the selected node set in the data line table. Right-click Review to
clear the highlighted selections.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

Load Step: CRADIATE: Delete Tab
In the Delete tab, delete *CRADIATE and other loads.

There are three deletion options:

Table 93:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'CFILM' in current collector The Delete button deletes only *CRADIATE loads from the
current load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: CRADIATE: Parameter Tab
In the Parameter tab, define optional parameters for the *CRADIATE card.

The supported parameters include: Amplitude curve, OP, and Region Type.

Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: DLOAD
In the DLOAD dialog, define the *DLOAD cards on individual elements or geometry (surfaces). You can
also define the DLOAD on element sets.

To open the dialog in the Load Step window, expand Distributed loads in the tree, select DLOAD,
and select a load collector from the Load collector table.
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Load Step: DLOAD: Define Tab
In the Define tab, define *DLOAD cards on individual elements or geometry (surfaces) as well as on
element sets.

There are seven different DLOAD types available: default (Pressure), centrifugal, rotary acceleration,
gravity, pressure in pipe/elbow, hydro pressure, and hydro pressure in pipe/elbow.

Only default (Pressure) type DLOAD can be created on an individual element or geometry in
HyperMesh. The other types are available only for element sets.

It is recommended that you use only one type of DLOAD in a load collector in HyperMesh. If you need
to use multiple types of DLOAD in the same STEP, define each type in a separate load collector and add
them to the same load step.

You can define DLOAD on elements, geometry, or element sets. For Define DLOAD on:, the following
options are available:

• Elements or geometry

• Element sets

The layout of the Define tab changes, based on your selection.

Define DLOAD On: Elements or Geometry
Use the Define DLOAD on: Elements or Geometry option to define the default (pressure) type of DLOAD
on individual elements or geometric surfaces.

Pressure loads created on elements have special graphical display in HyperMesh. Loads created on
geometric entities such as surfaces are automatically mapped to FEA mesh on export. You can also map
them using the Map Loads on Geometry button.

The Define tab for Define DLOAD on: Elements or Geometry contains the following buttons:

Table 94:

Button Action

Define from Pressures
panel

Opens the Pressures panel to create/update DLOAD.

To create a pressure on elements, go to the create subpanel, select the elems
button, pick the desired elements from the HyperMesh graphics, select nodes
using the switch, pick two or three nodes from a face of a selected element,
input the magnitude, and click create.

To create a pressure on geometry, go to the create subpanel, select the
surfs option from the toggle, pick the desired geometry from the HyperMesh
graphics, input the magnitude, and click create.
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Button Action

Note:

• Loads created on geometric entities are automatically mapped
to FEA mesh on export. You can also map them using the Map
Loads on Geometry button.

• You can also update an existing DLOAD from the update
subpanel.

• While you are in the Pressure panel, press the H key to view
panel-specific help.

• When you finish creating or updating boundary conditions,
click return and the Step Manager is updated with the new
loads.

Map Loads on
Geometry

Opens the Loads on Geom panel to map loads on geometry to FEA mesh
entities.

Click Map loads to map all geometric loads in the current load collector to FEA
entities.

Note:

• You can also pick other load collectors by clicking on the
loadcols and map loads in all of them together.

• While you are in the Loads on Geom panel, press the H key to
view panel-specific help.

• When you finish, click return to update the Step Manager
with the new loads.

Define DLOAD On: Element Sets
Use the Define DLOAD on: Element sets option to define various DLOAD types on element sets.

The element set names are used in the *DLOAD data lines instead of the individual elements. Unlike
Abaqus surfaces in HyperMesh, you can combine element sets with individual element IDs in the same
*DLOAD card.

Note:  There is no graphical display in HyperMesh for loads created on sets. Therefore,
when you review a load collector in the Step Manager, only loads created on individual
entities are highlighted. For loads defined on sets, the underlying nodes or elements are
highlighted.

This dialog contains a element sets menu with a list of the existing element sets. There are two types
of elsets in HyperMesh: components and entity sets. The Abaqus elsets that are linked to sectional
property cards, such as *SOLID SECTION and *SHELL SECTION, become components in HyperMesh.
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Others become entity sets. To differentiate between these two types, there is a divider line "- - - - -" in
the elset list that pops up if you click the element sets menu. The elsets listed below the divider line
are components.

This dialog also contains a table for data line input. The table changes depending on the DLOAD type
selected. The table contains the following columns.

For Default (Pressure) type:

Table 95:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of pressure load. The available labels are: P1, P2, P3, P4, P5, P6, and P.

Magnitude The magnitude of the load.

Load Id The ID of the load collector.

For Centrifugal type:

Table 96:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of centrifugal loads and Coriolis forces. The available labels are:
CENTRIF, CENT, and CORIO.

Magnitude The magnitude of the load.

Coord1 Coordinate 1 of a point on the axis of rotation.

Coord2 Coordinate 2 of a point on the axis of rotation.

Coord3 Coordinate 3 of a point on the axis of rotation.

DirCos1 1-component of the direction cosine of the axis of rotation.

DirCos2 2-component of the direction cosine of the axis of rotation.

DirCos3 3-component of the direction cosine of the axis of rotation.

Load Id The ID of the load collector.
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For Rotary acceleration type:

Table 97:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of the DLOAD type. The available labels are: ROTA.

Magnitude The magnitude of the load.

Coord1 Coordinate 1 of a point on the axis of rotary acceleration.

Coord2 Coordinate 2 of a point on the axis of rotary acceleration.

Coord3 Coordinate 3 of a point on the axis of rotary acceleration.

DirCos1 1-component of the direction cosine of the axis of rotary acceleration.

DirCos2 2-component of the direction cosine of the axis of rotary acceleration.

DirCos3 3-component of the direction cosine of the axis of rotary acceleration.

Load Id The ID of the load collector.

For Gravity type:

Table 98:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of the DLOAD type. The available labels are: GRAV.

Magnitude The magnitude of the load.

Comp1 1-component of the gravity vector.

Comp2 2-component of the gravity vector.

Comp3 3-component of the gravity vector.

Load Id The ID of the load collector.
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For pressure in pipe/elbow type:

Table 99:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of the pressure in pipe/elbow elements. The available labels are: PE, PI,
PENU, and PINU.

Magnitude The magnitude of the load.

Diameter The effective inner or outer diameter.

Condition The end loading condition: CLOSE (default) or OPEN.

Load Id The ID of the load collector.

For hydro pressure type:

Table 100:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of the hydrostatic pressure. The available labels are: HP.

Magnitude The magnitude of the load.

Zero press Z-coordinate of zero pressure level in three-dimensional or axisymmetric cases; Y-
coordinate of zero pressure level in two-dimensional cases.

Press point Z-coordinate of the point at which the pressure is defined in three-dimensional or
axisymmetric cases; Y-coordinate of the point at which the pressure is defined in
two-dimensional cases.

Load Id The ID of the load collector.
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For hydro pressure in pipe/elbow type:

Table 101:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of the hydrostatic pressure in pipe.elbow elements. The available labels
are: HPE, and HPI.

Magnitude The magnitude of the load.

Zero press Z-coordinate of zero pressure level in three-dimensional or axisymmetric cases; Y-
coordinate of zero pressure level in two-dimensional cases.

Press point Z-coordinate of the point at which the pressure is defined in three-dimensional or
axisymmetric cases; Y-coordinate of the point at which the pressure is defined in
two-dimensional cases.

Diameter The effective inner or outer diameter.

Condition The end loading condition: CLOSE (default) or OPEN.

Load Id The ID of the load collector.

The Define tab for Define DLOAD on: Element sets contains the following buttons:

Table 102:

Button Action

Review Set Reviews the selected node sets by highlighting them in the HyperMesh
graphics. Right-click Review to clear the review selections.

Create/Edit Set.. Opens the Entity Sets panel in HyperMesh. When you finish creating/editing
the set, click return. The Step Manager is updated with the new set
appearing in the element set list.

Display/Review from
panel

Opens the appropriate HyperMesh panel. Use the review button to expand
the loads and constraints on the sets for visualization purposes.

→ Add the selected node set from the drop-down menu to the data line table on
the right.

← Delete the selected node set from the data line table.

Show Faces This option is only shown for Default (pressure) type. It is mainly used
to review the face identifiers of elements in the selected set. It creates a
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Button Action

temporary skin of the selected elset, opens the Element Selector panel, from
which you can select face elements from this skin. When you return from the
element selector panel, the selected faces display color-coded face identifier
tags. In performance graphics, these tags are sometimes blocked by the solid
mesh. You may need to rotate the model a little to view the tags.

Right-click the Show faces button to clear the face review.

Define by vector This option is only shown for Gravity type. It opens the HyperMesh vector
selector panel. Pick a vector and click proceed. This vector is used to define
the Comp1, Comp2, Comp3, and Magnitude of the gravity load for the
selected element set.

Create/Edit vector.. This option is only shown for Gravity type. Opens the Vectors panel in
HyperMesh. When you finish creating/editing the vector, click return.

Review Creates special review forces or moments in HyperMesh graphics for the
selected node set. These review forces or moments take into consideration
the *TRANSFORM cards that may be associated with nodes in the node set.
Right-click Review to clear the special review loads and highlighting.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

Load Step: DLOAD: Delete Tab
In the Delete tab, delete *DLOAD and other loads.

There are three deletion options:

Table 103:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'Distributed loads' in current
collector

The Delete button deletes all distributed (*DLOAD, *FILM) loads
from the current load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.
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Load Step: DLOAD: Parameter Tab
In the Parameter tab, define optional parameters for the *DLOAD card.

The supported parameters include: Amplitude, OP, Load Case, Cyclic Mode, and Region Type.

Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: FILM
In the FILM dialog, define the *FILM cards on individual elements or geometry (surfaces). You can also
define the FILM on element sets.

To open this dialog in the Load Step window, select FILM from the tree and a load collector from the
Load collector table.

Load Step: FILM: Define Tab
In the Define tab, define *FILM cards on individual elements or geometry (surfaces) as well as on
element sets.

For Define FILM on, the following options are available:

• Elements or geometry

• Element sets

The layout of the Define tab changes, based on your selection.

Define FILM On: Elements or Geometry
Use the Define FILM on: Elements or geometry option to define FILM on individual elements or
geometric surfaces.

FILM loads created on elements have special graphical display in HyperMesh. Loads created on
geometric entities like surfaces are automatically mapped to FEA mesh on export. You can also map
them using the Map Loads on Geometry button.

The Define tab for Define FILM on: Elements or geometry has the following buttons:

Table 104:

Button Action

Define from
Pressures panel

Opens the Pressures panel, from which you can create and update FILM. It only
allows you to define the reference sink temperature. The film coefficient needs
to be defined separately.

To create a FILM on elements, go to the create subpanel, select elems using the
switch, pick the desired elements from the HyperMesh graphics, click nodes,
pick two or three nodes from a face of a selected element, input the magnitude
(sink temperature), and click create.

To create a pressure on geometry, go to the create subpanel, select surfs using
the switch, pick the desired geometry from the HyperMesh graphics, input the
magnitude (sink temperature), and click create.
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Button Action

Note:

• Loads created on geometric entities are automatically mapped
to FEA mesh on export. You can also map them using the Map
Loads on Geometry button.

• You can also update an existing FILM from the update subpanel.

• While you are in the Pressure panel, press the H key to view
panel-specific help.

• When you are finished creating or updating boundary
conditions, click return and the Step Manager will be updated
with the new loads.

Map Loads on
Geometry

Opens the HyperMesh Loads on Geom panel to map loads on geometry to FEA
mesh entities.

Click the Map loads button to map all geometric loads in the current load
collector to FEA entities.

Note:

• You can also pick other load collectors by clicking the loadcols
button and map loads in all of them together.

• While you are in the Loads on Geom panel, press the H key to
view panel-specific help.

• When you are done, click return and the Step Manager will be
updated with the new loads.

Define FILM On: Element Sets
Use the Define FILM on: Element sets option to define the FILM load on element sets.

The element set names are used in the *FILM data lines instead of the individual elements. Unlike
Abaqus surfaces in HyperMesh, you can combine element sets with individual element IDs in the same
*FILM card.

Note:  There is no graphical display in HyperMesh for loads created on sets. Therefore,
when you review a load collector in the Step Manager, only loads created on individual
entities are highlighted. For loads defined on sets, the underlying nodes or elements are
highlighted.

This dialog contains an element sets menu containing a list of the existing element sets. There are
two types of elsets in HyperMesh: components and entity sets. The Abaqus elsets that are linked to
sectional property cards, such as *SOLID SECTION and *SHELL SECTION, become components in
HyperMesh. Others become entity sets. To differentiate between these two types, there is a divider line
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"- - - - -" in the elset list that pops up if you click the element sets menu. The elsets listed below the
divider line are components.

This dialog also contains a table for data line input, which contains the following columns:

Table 105:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of FILM load. The available labels are: F1, F2, F3, F4, F5, F6, FPOS, and
FNEG.

Sink Temp The reference sink temperature.

Film coeff The reference film coefficient.

Load Id The ID of the load collector.

The Define tab for Define FILM on: Element sets contains the following buttons:

Table 106:

Button Action

Review Set Reviews the selected node sets by highlighting them in the HyperMesh
graphics. Right-click Review to clear the review selections.

Create/Edit Set.. Opens the Entity Sets panel in HyperMesh. When you finish creating/editing
the set, click return. The Step Manager is updated with the new set
appearing in the element set list.

Display/Review from
panel

Opens the appropriate HyperMesh panel. Use the review button to expand
the loads and constraints on the sets for visualization purposes.

→ Add the selected node set from the drop-down menu to the data line table on
the right.

← Delete the selected node set from the data line table.

Show Faces Used mainly to review the face identifiers of elements in the selected set. It
creates a temporary skin of the selected elset, opens the Element Selector
panel, from which you can select face elements from this skin. When you
return from the element selector panel, the selected faces will display color-
coded face identifier tags. In performance graphics, these tags are sometimes
blocked by the solid mesh. You may need to rotate the model a little to view
the tags.
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Button Action

Right-click Show faces to clear the face review.

Review Creates special review FILM loads in HyperMesh graphics for the selected set.
Right-click Review to clear the special review loads and highlighting.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

Load Step: FILM: Delete Tab
In the Delete tab, delete *FILM and other loads.

There are three deletion options:

Table 107:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'Distributed loads' in current
collector

The Delete button deletes all distributed (*DLOAD, *FILM) loads
from the current load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: FILM: Parameter Tab
In the Parameter tab, define optional parameters for the *FILM card.

The supported parameters include: Amplitude, Film Amplitude, OP, and Region Type.

Click Update to activate the optional parameter selection in the HyperMesh database.

Modify the FILM Coefficient
Options for defining film coefficient on FILM created on individual elements or geometry.

By selection
The Pick Loads button opens the HyperMesh load selector panel. Pick the FILM loads to which you
want to assign film coefficient, and click proceed.
The corresponding Reset button resets the selected loads.
The Update button assigns the value specified in the Film coefficient: text box to all selected FILM
loads.
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All FILMS in current collector
The Update button assigns the value specified in the Film coefficient: text box to all the FILM
loads in the current load collector.

Load Step: RADIATE
In the RADIATE dialog, define the *RADIATE cards on individual elements or geometry (surfaces). You
can also define the RADIATE on element sets.

To open this dialog in the Load Step window, select RADIATE from the tree and a load collector from
the Load collector table.

Load Step: RADIATE: Define Tab
In the Define tab, define *RADIATE cards on individual elements or geometry (surfaces) as well as on
element sets.

For Define RADIATE on:, the following options are available:

• Elements or geometry

• Element sets

The layout of the Define tab changes, based on your selection.

Define RADIATE On: Elements or Geometry
Use the Define RADIATE on: Elements or geometry option to define RADIATE on individual elements or
geometric surfaces.

RADIATE loads created on elements have special graphical display in HyperMesh. Loads created on
geometric entities like surfaces are automatically mapped to FEA mesh on export. You can also map
them using the Map Loads on Geometry button.

The Define tab for Define RADIATE on: Elements or geometry has the following buttons:

Table 108:

Button Action

Define from
Pressures panel

Opens the Pressures panel, from which you can create and update RADIATE. It
only allows you to define the reference sink temperature.

To create a RADIATE on elements, go to the create subpanel, select elems using
the switch, pick the desired elements from the HyperMesh graphics, click nodes,
pick two or three nodes from a face of a selected element, input the magnitude
(sink temperature), and click create.

To create a pressure on geometry, go to the create subpanel, select surfs using
the switch, pick the desired geometry from the HyperMesh graphics, input the
magnitude (sink temperature), and click create.
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Button Action

Note:

• Loads created on geometric entities are automatically mapped
to FEA mesh on export. You can also map them using the Map
Loads on Geometry button.

• You can also update an existing RADIATE from the update
subpanel.

• While you are in the Pressure panel, press the H key to view
panel-specific help.

• When you are finished creating or updating boundary
conditions, click return and the Step Manager will be updated
with the new loads.

Map Loads on
Geometry

Opens the HyperMesh Loads on Geom panel to map loads on geometry to FEA
mesh entities.

Click the Map loads button to map all geometric loads in the current load
collector to FEA entities.

Note:

• You can also pick other load collectors by clicking the loadcols
button and map loads in all of them together.

• While you are in the Loads on Geom panel, press the H key to
view panel-specific help.

• When you are done, click return and the Step Manager will be
updated with the new loads.

Define RADIATE On: Element Sets
Use the Define RADIATE on: Element sets option to define the radiation conditions on element sets. It is
possible to apply RADIATE on element sets and components.

Note:  There is no graphical display in HyperMesh for loads created on sets. Therefore,
when you review a load collector in the Step Manager, only loads created on individual
entities are highlighted. For loads defined on sets, the underlying nodes or elements are
highlighted.

This dialog contains a drop down menu containing a list of the existing element sets or components.
There are two types of element sets in HyperMesh: components and entity sets. The Abaqus element
sets that are linked to sectional property cards, such as *SOLID SECTION and *SHELL SECTION,
become components in HyperMesh upon import. To differentiate between these two types, there is a
divider line "- - - - -" in the element set list that pops up if you open up the extended entity selection
([…] – button). The elsets listed below the divider line are components.
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The dialog also contains a table for data line input including the following columns:

Table 109:

Column Description

Elset The name of the element sets. Element sets are added and deleted in this column
using → or ←, respectively.

Label The labels of RADIATE load. The available labels are: R1, R2, R3, R4, R5, R6,
RPOS, and RNEG.

Ref temp The reference ambient temperature.

Emissivity Surface emissivity

Load Id The ID of the load collector.

The Define tab for Define RADIATE on: Element sets contains the following buttons:

Table 110:

Button Action

Review Set Reviews the selected node sets by highlighting them in the HyperMesh
graphics. Right-click Review to clear the review selections.

Create/Edit Set.. Opens the Entity Sets panel in HyperMesh. When you finish creating/editing
the set, click return. The Step Manager is updated with the new set
appearing in the element set list.

Display/Review from
panel

Opens the appropriate HyperMesh panel. Use the review button to expand
the loads and constraints on the sets for visualization purposes.

→ Add the selected node set from the drop-down menu to the data line table on
the right.

← Delete the selected node set from the data line table.

Show Faces Used mainly to review the face identifiers of elements in the selected set. It
creates a temporary skin of the selected elset, opens the Element Selector
panel, from which you can select face elements from this skin. When you
return from the element selector panel, the selected faces will display color-
coded face identifier tags. In performance graphics, these tags are sometimes
blocked by the solid mesh. You may need to rotate the model a little to view
the tags.

Right-click Show faces to clear the face review.
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Button Action

Review Creates special review RADIATE loads in HyperMesh graphics for the selected
set. Right-click Review to clear the special review loads and highlighting.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

Load Step: RADIATE: Delete Tab
In the Delete tab, delete *RADIATE and other loads.

There are three deletion options:

Table 111:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'Distributed loads' in current
collector

The Delete button deletes all distributed (*DLOAD, *RADIATE)
loads from the current load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: RADIATE: Parameter Tab
In the Parameter tab, define optional parameters for the *RADIATE card.

The supported parameters include: Amplitude curve, OP, and Region Type.

Click Update to activate the optional parameter selection in the HyperMesh database.

Modify the Emissivity
Options for defining the emissivity for a RADIATE card created on individual elements or geometry.

By selection
The Pick loads button opens the HyperMesh Load Selector panel. Pick the RADIATE loads to which
you want to assign emissivity, and click proceed.
The corresponding Reset button resets the selected loads.
The Update button assigns the value specified in the Emissivity: field to all selected RADIATE
loads.
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All RADIATE in current collector
The Update button assigns the value specified in the Emissivity: text box to all the RADIATE loads
in the current load collector.

In a similar way, for shell elements, it is possible to change the element face (RPOS or RNEG) on which
the RADIATE load is applied.

Load Step: DSLOAD
In the DSLOAD dialog, define the *DSLOAD card on Abaqus surfaces (*SURFACE).

To open the dialog in the Load Step window, select DSLOAD from the tree and a Load collector from
the table.

You can use Abaqus Contact Manager to create Abaqus surfaces.

Load Step: DSLOAD: Define Tab
In the Define tab, define *DSLOAD card on Abaqus surfaces (*SURFACE).

There are two types of DSLOAD available: Pressure and hydro pressure.

It is recommended that you use only one type of DSLOAD per load collector in HyperMesh. If you need
to use multiple types of DSLOAD in the same STEP, define each type in a separate load collector and
add them to the same load step.

Note:  There is no graphical display in HyperMesh for loads created on Abaqus SURFACEs.
Therefore, when you review a load collector in the Step Manager, only loads created on
individual entities are highlighted. For loads defined on SURFACE, the underlying SURFACE
elements are highlighted.

This dialog also contains a table for data line input. The table changes depending on the DSLOAD type
selected.

The table columns for each DSLOAD type are listed below:

Default (Pressure) type

Table 112:

Column Description

Surface The name of the Abaquss surface. Surfaces are added and deleted in this
column using → or ←, respectively.

Label The labels of pressure load. The available labels are P, PNU, and VP.

Magnitude The magnitude of the load.
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Hydro pressure type

Table 113:

Column Description

Surface The name of the Abaqus surface. Surfaces are added and deleted in this column
using → or ←, respectively.

Label The labels of the hydrostatic pressure. The available label is HP.

Magnitude The magnitude of the load.

Zero press Z-coordinate of zero pressure level in three-dimensional or axisymmetric cases;
Y-coordinate of zero pressure level in two-dimensional cases.

Press point Z-coordinate of the point at which the pressure is defined in three-dimensional
or axisymmetric cases; Y-coordinate of the point at which the pressure is
defined in two-dimensional cases.

The DSLOAD option has the following buttons:

Table 114:

Button Action

Review Surfaces Reviews the selected surface by highlighting them in the HyperMesh graphics.
Right-click Review to clear the review selections.

Create/Edit Surface.. Opens a message with information about surface definition in HyperMesh.

→ Add the selected surface from the drop-down menu to the data line table on
the right.

← Delete the selected surface from the data line table.

Review Reviews the selected surface in the data line table. Right-click Review to
clear the highlighted selections.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

Load Step: DSLOAD: Delete Tab
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In the Delete tab, delete *DSLOAD and other loads.

There are three deletion options:

Table 115:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'DSLOAD' in current collector The Delete button deletes only *DSLOAD loads from the current
load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: DSLOAD: Parameter Tab
In the Parameter tab, define optional parameters for the *DSLOAD card.

The supported parameters include: Amplitude, OP, Load Case, Cyclic Mode and Region Type.

Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: SFILM
In the SFILM dialog, define the *SFILM card on Abaqus surfaces (*SURFACE).

To open the dialog in the Load Step window, select SFILM from the tree and a load collector from the
Load collector table.

You can use the Abaqus Contact Manager to create Abaqus surfaces.

Load Step: SFILM: Define Tab
In the Define tab, define the *SFILM card on Abaqus surfaces (*SURFACE).

Note:  There is no graphical display in HyperMesh for loads created on Abaqus SURFACEs.
Therefore, when you review a load collector in the Step Manager, only loads created on
individual entities are highlighted. For loads defined on SURFACE, the underlying SURFACE
elements are highlighted.
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This dialog contains a Surface menu containing a list of the existing Abaqus surfaces. It also has a table
for data line input. The table contains the following columns:

Table 116:

Column Description

Surface The name of the Abaqus surface. Surfaces are added and deleted in this column
using → or ←, respectively.

Label The SFILM labels. The available labels are F and FNU.

Sink temp Reference sink temperature.

Fillm coef Reference film coefficient.

The SFILM option has the following buttons:

Table 117:

Button Action

Review/Reset Surfaces Reviews the selected surface by highlighting them in the HyperMesh graphics.
Right-click Review to clear the review selections.

Create/Edit Surface.. Opens a message with information about surface definition in HyperMesh.

→ Add the selected surface from the drop-down menu to the data line table on
the right.

← Delete the selected surface from the data line table.

Review/Reset Reviews the selected surface in the data line table. Right-click Review to
clear the highlighted selections.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

Load Step: SFILM: Delete Tab
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In the Delete tab, delete *SFILM and other loads.

There are three deletion options:

Table 118:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'SFILM' in current collector The Delete button deletes only *SFILM loads from the current
load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: SFILM: Parameter Tab
In the Parameter tab, define optional parameters for the *SFILM card.

The supported parameters include: Amplitude, Film Amplitude, OP, and Region Type.

Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: SRADIATE
In the SRADIATE dialog, define the *SFILM card on Abaqus surfaces (*SURFACE).

To open the dialog in the Load Step window, select SRADIATE from the tree and a load collector from
the Load collector table.

You can use the Abaqus Contact Manager to create Abaqus surfaces.

Load Step: SRADIATE: Define Tab
In the Define tab, define *SRADIATE card on Abaqus surfaces (*SURFACE).

Note:  There is no graphical display in HyperMesh for loads created on Abaqus SURFACEs.
Therefore, when you review a load collector in the Step Manager, only loads created on
individual entities are highlighted. For loads defined on SURFACE, the underlying SURFACE
elements are highlighted.
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This dialog contains a Surface menu containing a list of the existing Abaqus surfaces. It also has a table
for data line input. The table contains the following columns:

Table 119:

Column Description

Surface The name of the Abaqus surface. Surfaces are added and deleted in this column
using → or ←, respectively.

Label The *SRADIATE labels.

Ref temp Ambient reference temperature.

Emissivity Surface emissivity.

The SRADIATE option has the following buttons:

Table 120:

Button Action

Review/Reset Surfaces Reviews the selected surface by highlighting them in the HyperMesh graphics.
Right-click Review to clear the review selections.

Create/Edit Surface.. Opens a message with information about surface definition in HyperMesh.

→ Add the selected surface from the drop-down menu to the data line table on
the right.

← Delete the selected surface from the data line table.

Review/Reset Reviews the selected surface in the data line table. Right-click Review to
clear the highlighted selections.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

Load Step: SRADIATE: Delete Tab
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In the Delete tab, delete *SRADIATE and other loads.

There are three deletion options:

Table 121:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'SRADIATE' in current collector The Delete button deletes only *SRADIATE loads from the
current load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: SRADIATE: Parameter Tab
In the Parameter tab, define optional parameters for the *SRADIATE card.

The supported parameters include: Amplitude curve, OP, and Region Type.

Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: Temperature
In the Temperature dialog, define and edit the *TEMPERATURE card.

To open the dialog in the Load Step window, select Temperature from the tree and a load collector
from the Load collector table.

Load Step: Temperature: Define Tab
In the Define tab, define *TEMPERATURE cards on individual nodes or geometry (surfaces, points,
lines). You can also define the temperature on node sets.

It is recommended that you do not use *TEMPERATURE and *BOUNDARY with dof 11 together in a load
collector in =HyperMesh. If you need to use multiple types of temperature in the same STEP, define
each type in a separate load collector and add them to the same load step.

You can define *TEMPERATURE on nodes, geometry, or node sets. For Define Temperature on:, the
following options are available:

• Nodes or geometry

• Node sets

The layout of the Define tab changes, based on your selection.

Define Temperature On: Nodes or Geometry

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1482

Use the Define Temperature on: Nodes or geometry option to define temperature on individual nodes or
geometry.

Temperatures created on nodes have special graphical display in HyperMesh. Loads created on
geometric entities like surfaces, lines or points are automatically mapped to FEA mesh on export. You
can also map them using the Map Loads on Geometry button.

The Define tab for Define Temperature on: Nodes or geometry contains the following buttons:

Table 122:

Button Action

Define from
'Forces'/'Moments'
Panel

Opens the Temperature panel to create/update temperature.

To create a temperature on nodes, go to the create subpanel, select nodes
using the switch, input a value, and click create.

To create a temperature on geometry, go to the create subpanel, select
surfs, points, or lines using the switch, input a value, and click create.

Note:

• Loads created on geometric entities are automatically
mapped to FEA mesh on export. You can also map them
using the Map Loads on Geometry button.

• You can also update an existing force or moments from the
update subpanel.

• While you are in the temperature panel, press the H key to
view panel-specific help.

• When you finish creating or updating temperature, click
return to update the Step Manager with the new loads.

Map Loads on geometry Opens the Loads on Geom panel to map loads on geometry to FEA mesh
entities.

Click Map loads to map all geometric loads in the current load collector to
FEA entities.

Note:

• You can also pick other load collectors by clicking on the
loadcols button and map loads in all of them together.

• While you are in the Loads on Geom panel, press the H key
to view panel-specific help.

• When you are finished, click return to update the Step
Manager with the new loads.
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Define Temperature On: Node Sets
The Define Temperature on: Node sets option defines temperature on node sets.

The node set names are used in the *TEMPERATURE data lines instead of the individual nodes. Unlike
Abaqus surfaces in HyperMesh, you can combine node sets with individual node IDs in the same
*TEMPERATURE card.

Note:  There is no graphical display in HyperMesh for loads created on sets. Therefore,
when you review a load collector in the Step Manager, only loads created on individual
entities are highlighted. For loads defined on sets, the underlying nodes or elements are
highlighted.

This dialog contains a node sets menu with a list of the existing node sets. It also contains a table for
data line input with the following columns:

Table 123:

Column Description

Nset The name of the node sets. Node sets are added or removed using → or ←,
respectively.

Temperature Reference temperature value.

Gradient1 Temperature gradient in the n2-direction for beams or temperature gradient
through the thickness for shells.

Gradient2 Temperature gradient in the n1-direction for beams.

Load Id The ID of the load collector.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

The Define tab for Define CLOAD-Force/Moment on: Node sets contains the following buttons:

Table 124:

Button Action

Review Set Reviews the selected node sets by highlighting them in the HyperMesh
graphics. Right-click Review to clear the review selections.

Create/Edit Set.. Opens the Entity Sets panel in HyperMesh. When you finish creating/editing
the set, click return. The Step Manager is updated with the new set
appearing in the element set list.

Display/Review from
panel

Opens the appropriate HyperMesh panel. Use the review button to expand
the loads and constraints on the sets for visualization purposes.
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Button Action

→ Add the selected node set from the drop-down menu to the data line table on
the right.

← Delete the selected node set from the data line table.

Review/Reset Reviews the selected node set in the data line table. Right-click on Review to
clear the highlighted selections.

Update Updates the HyperMesh database with the data lines defined in the table. By
default, HyperMesh does not create a display for loads defined with sets.

For tips on entering information and navigating in the Define tab, see Step Manager Tab Environment.

Load Step: Temperature: Delete Tab
In the Delete tab, delete boundaries and other loads.

There are three deletion options:

Table 125:

Option Description

All loads in current collector The Delete button deletes all the loads from the current load
collector.

All 'Temperature' in current collector The Delete button deletes only *TEMPETATURE loads from the
current load collector.

By selection The Pick Loads button opens the HyperMesh load selector panel.
Pick the loads you want to delete and click proceed.

The corresponding Reset button resets the selected loads.

The Delete button deletes the selected loads.

Load Step: Temperature: Parameter Tab
In the Parameter tab, define optional parameters for the *TEMPERATURE card.

The supported parameters include: Bstep, Binc, Estep, Einc, Input file, Result file, OP, and
MidSide.
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Click Update to activate the optional parameter selection in the database.

Load Step: Inertia Relief
In the Inertia relief dialog, define and edit the *INERTIA RELIEF card.

To open the dialog in the Load Step window, select Inertia relief from the tree and a load collector
from the Load collector table.

Load Step: Inertia Relief: Define Tab
In the Define tab, define * INERTIA RELIEF cards.

Activate the Inertia relief checkbox to make the *INERTIA RELIEF load active for the current load
collector.

There are two data line options available:

Free direction
Integer list of degrees of freedom identifying the free directions

Reference points
Global X, Y, and Z-coordinates of the reference point.

Click Update to activate the data line selection in the HyperMesh database.

Load Step: Inertia Relief: Parameter Tab
In the Parameter tab, define optional parameters for the * INERTIA RELIEF card.

The supported parameters include: Orientation, Fixed, Remove, and None.

Click Update to activate the optional parameter selection in the HyperMesh database.

Load Step: Interface Controls
The Interface Controls option defines Abaqus keywords.

The following Abaqus keywords are supported: *CONTACT, *CONTACT CONTROLS, *CLEARANCE,
*CONTACT INTERFERENCE, *MODEL CHANGE, *CHANGE FRICTION, and *CONTROLS. It also allows you
to add *CONTACT PAIR and *SURFACE INTERACTION cards created from the Abaqus Contact Manager
to a load step. When you select an interface controls option from the tree, the corresponding table is
displayed in the Load Step window.

The Interface controls: table contains a list of interface controls of the type selected in the tree. You can
create, edit, rename, reorder, and delete interface controls from this table.

The Interface controls table contains the following columns:

Table 126:

Column Description

Status The history status of the interface control. If the status is on, the corresponding
interface control parameters and data lines will be exported in the current load
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Column Description

step. If the status is off, the interface control will not be exported under the current
*STEP block.

Name The name of the interface controls. Some of the interface controls names are for
HyperMesh internal use only. Abaqus input files do not require them.

Note:

• Right-click on the table to display menu options. The available options are Rename and
Reorder.

The Interface controls table contains the following buttons:

Table 127:

Button Description

New Opens the Create dialog for the corresponding interface control. The name of the
new interface control is entered in this dialog. Use the Same as option to create
an interface control by copying attributes from an existing interface control of the
same type. Click Create to create an interface control and add it to the current load
step.

Edit Opens the Card Image panel for the selected interface control. Click edit to open
the Card Editor and define all relevant keywords, parameters, and data lines. When
you are finished, click return twice and the Step Manager is updated.

Load Step: Output Request
Use the Output requests option define output options for ODB, result (.fil) and data (.dat) file
formats.

In HyperMesh, Abaqus output requests are organized into HyperMesh collectors called output blocks.
When you select an output request file format from the tree, the output block table is displayed in the
Load Step window.

The Output block: table contains a list of the output blocks with corresponding history status. You can
create, edit, review, rename, reorder, and delete output blocks from this table.
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The Output block: table contains the following columns:

Table 128:

Column Description

Status The history status of the output block. If the status is on, the output block belongs
to the current load step. This means, all parameter and data line information in the
output block will be written under the current *STEP block. If the status is off, no
parameters or data lines from the output block will be written under the current
*STEP block.

Name The name of the output block. These names are for HyperMesh internal use only.

Note:

• Click on an output block name to set it as the current output block in HyperMesh. All
changes and additions to the parameters and data line will be for the selected output
block.

• The Output type: status bar, below the output block table, shows all the output types
present in the selected output block.

• Right-click on the table to display menu options. The available options are Rename and
Reorder.

See Step Manager Dialog Environment for tips on navigating through the dialogs.

The Output block table contains the following buttons:

Table 129:

Button Action

New... Opens the Create Output block dialog in which you enter the name of the new
output block. The Create button in this dialog creates the output block and adds it
to the current load step.

Review Reviews the selected output block in a text window. All parameters and data lines
associated with the selected output block are listed in the text window.

Delete Opens the HyperMesh Delete panel to delete output blocks. When you are finished,
click return and the Output block table will be updated.

Load Step: Output Request: ODB File
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In the ODB file dialog, define and edit the output requests for the ODB file.

Supported keywords are: *OUTPUT, *NODE OUTPUT, *ELEMENT OUTPUT, *CONTACT OUTPUT, and
*ENERGY OUTPUT. To open the dialog in the Load Step window, select ODB file from the tree and an
Output block from the table.

Load Step: Output Request: ODB File: Output
In the Output tab, define *OUTPUT cards with associated parameters.

Supported parameters are Field and History (in the Output drop down menu), and Name, OP,
Variable, Frequency, Time marks, Number interval, Time interval, and Mode list and Filter
under the Optional parameters list.

Click Update to activate the parameters defined in the HyperMesh database.

To enable the Node Output, Element Output, Contact Output, Energy Output and Radiation output tabs
used to define their respective cards, you must first activate the corresponding checkboxes.

Load Step: Output Request: ODB File: Node Output
In the Node Output tab, define *NODE OUTPUT for the selected Output block.

Nset and Variable parameters are supported. Activate/deactivate the check boxes in the tree on the
Node Output tab to add/remove identifier keys in the table. The data lines added in this manner have a
gray background indicating they cannot be manually edited. You may also add user-defined identifiers,
by typing them directly into the table. User-defined data lines appear with a white background,
indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Node Output tab contains the following buttons:

Table 130:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the set,
click return. The Step Manager is updated with the new set appearing in the node
set list.

Review Reviews the selected node sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: ODB File: Element Output
In the Element Output tab, define *ELEMENT OUTPUT for the selected Output block.

The following parameters are supported: Elset, Position, and Variable. Activate/deactivate the
check boxes in the tree on the Element Output tab to add/remove identifier keys in the table. Data lines
added in this manner have a gray background indicating they cannot be manually edited. You may also
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add user-defined identifiers, by typing them directly into the table. The user-defined data lines appear
with a white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Element Output tab has the following buttons:

Table 131:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the
set, click return. The Step Manager is updated with the new set appearing in the
element set list.

Review Reviews the selected element sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: ODB File: Contact Output
In the Contact Output tab, define *CONTACT OUTPUT for the selected Output block.

The following parameters are supported: Nlset, Master, Slave, General Contact, and Variable.
Activate/deactivate the checkboxes in the tree on the Contact Output tab to add/remove identifier keys
in the table. The data lines added in this manner have a gray background, indicating they cannot be
manually edited. You may also add user-defined identifiers, by typing them directly into the table. The
user-defined data lines appear with a white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Contact Output tab has the following buttons:

Table 132:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the set,
click return. The Step Manager is updated with the new set appearing in the node
set list.

Review Reviews the selected node sets, master surface, or slave surface by highlighting
them in the HyperMesh graphics. Right-click on the Review button to clear the
review selections.
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Button Action

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: ODB File: Energy Output
In the Energy Output tab, define *ENERGY OUTPUT for the selected Output block.

The following parameters are supported: Elset and Variable. Activate/deactivate the checkboxes in
the tree on the Energy Output tab to add/remove identifier keys in the table. The data lines added in
this manner have a gray background, indicating they cannot be manually edited. You may also add
user-defined identifiers by typing them directly into the table. The user-defined data lines appear with a
white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Energy Output tab has the following buttons:

Table 133:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the
set, click return. The Step Manager is updated with the new set appearing in the
element set list.

Review Reviews the selected element sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: Result File (.fil)
In the Result file (.fil) dialog, define and edit the output requests for the Result file.

Supported keywords are *NODE FILE, *ELEMENT FILE, *CONTACT FILE, and *ENERGY FILE. To open
the dialog in the Load Step window, select Result File (.fil) from the tree and an Output block from
the table.

Load Step: Output Request: Result File: Define
In the Define tab, enable the Node File, Element File, Contact File, and Energy File tabs, which are used
to define the *Node File, *Element File, *Contact File, and *Energy File cards, respectively.
Load Step: Output Request: Result File: Node File
In the Node File tab, define *Node file for the selected Output block.

The following parameters are supported: Nset, Frequency, Last mode, Global, and Mode. Activate/
deactivate the checkboxes in the tree on the Node File tab to add/remove identifier keys in the table.
The data lines added in this manner have a gray background, indicating they cannot be manually
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edited. You may also add user-defined identifiers by typing them directly into the table. User-defined
data lines appear with a white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Node File tab contains the following buttons:

Table 134:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the set,
click return. The Step Manager is updated with the new set appearing in the node
set list.

Review Reviews the selected node sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: Result File: Element File
In the Element File tab, define *ELEMENT FILE for the selected Output block.

The following parameters are supported: Elset, Directions, Mode, Frequency, Position, and Last
Mode. Activate/deactivate the check boxes in the tree on the Element File tab to add/remove identifier
keys in the table. The data lines added in this manner have a gray background, indicating they cannot
be manually edited. You may also add user-defined identifiers by typing them directly into the table.
User-defined data lines appear with a white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Element File tab contains the following buttons:

Table 135:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the
set, click return. The Step Manager is updated with the new set appearing in the
element set list.

Review Reviews the selected node sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1492

Load Step: Output Request: Result File: Contact File
In the Contact File tab, define *CONTACT FILE for the selected Output block.

The following parameters are supported: Nset, Master, Slave, and Frequency. Activate/deactivate the
checkboxes in the tree on the Contact File tab to add/remove identifier keys in the table. The data lines
added in this manner have a gray background, indicating they cannot be manually edited. You may also
add user-defined identifiers, by typing them directly into the table. The user-defined data lines appear
with a white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Contact File tab contains the following buttons:

Table 136:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the set,
click return. The Step Manager is updated with the new set appearing in the node
set list.

Review Reviews the selected node sets, master surface, or slave surface by highlighting
them in the HyperMesh graphics. Right-click on the Review button to clear the
review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: Result File: Energy File
In the Energy File tab, define *ENERGY FILE for the selected Output block.

The following parameters are supported: Elset and Frequency.

The Energy File tab contains the following buttons:

Table 137:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the
set, click return. The Step Manager is updated with the new set appearing in the
element set list.

Review Reviews the selected element sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.
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Load Step: Output Request: Data File (.dat)
In the Data file (.dat) dialog, define and edit the output requests for the data file.

Supported keywords are *NODE PRINT, *ELEMENT PRINT, *CONTACT PRINT, and *ENERGY PRINT. To
open the dialog in the Load Step window, select Data File (.dat) from the tree and an output block
from the Output block table.

Load Step: Output Request: Data File: Define
In the Define tab, enable the Node Print, Element Print, Contact Print, and Energy Print tabs, which are
used to define the *Node Print, *Element Print, *Contact Print, and *Energy Print cards.

Load Step: Output Request: Data File: Node Print
In the Node Print tab, define *NODE PRINT for the selected Output block.

The following parameters are supported: Nset, Frequency, Mode, Global, Summary, Last mode, and
Totals. Activate/deactivate the checkboxes in the tree on the Node Print tab to add/remove identifier
keys in the table. The data lines added in this manner have a gray background, indicating they cannot
be manually edited. You may also add user-defined identifiers by typing them directly into the table.
User-defined data lines appear with a white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Node Print tab contains the following buttons:

Table 138:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the set,
click return. The Step Manager is updated with the new set appearing in the node
set list.

Review Reviews the selected node sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: Data File: Element Print
In the Element Print tab, define *Element print for the selected Output block.

The following parameters are supported: Elset, Position, Totals, Frequency, Last mode, Summary,
and Mode. Activate/deactivate the checkboxes in the tree on the Element Print tab to add/remove
identifier keys in the table. The data lines added in this manner have a gray background indicating they
can not be manually edited. You may also add user-defined identifiers by typing them directly into the
table. User-defined data lines appear with a white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.
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The Element Print tab contains the following buttons:

Table 139:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the
set, click return. The Step Manager is updated with the new set appearing in the
element set list.

Review Reviews the selected element sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: Data File: Contact Print
In the Contact Print tab, define *CONTACT PRINT for the selected Output block.

The following parameters are supported: Nset, Master, Slave, Frequency, Totals, and Summary.
Activate/deactivate the checkboxes in the tree on the Contact Print tab to add/remove identifier keys
in the table. The data lines added in this manner have a gray background, indicating they cannot be
manually edited. You may also add user-defined identifiers by typing them directly into the table. User-
defined data lines appear with a white background, indicating they are editable.

Right-click on the Data lines table to display menu options. The available options are Cut, Copy, Paste,
Add row, and Delete row.

The Contact File tab contains the following buttons:

Table 140:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the set,
click return. The Step Manager is updated with the new set appearing in the node
set list.

Review Reviews the selected node sets, master surface, or slave surface by highlighting
them in the HyperMesh graphics. Right-click on the Review button to clear the
review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Output Request: Data File: Energy Print
In the Energy Print tab, define *energy print for the selected Output block.

The following parameters are supported: Elset and Frequency.
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The Energy File tab contains the following buttons:

Table 141:

Button Action

Create/Edit... Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the
set, click return. The Step Manager is updated with the new set appearing in the
element set list.

Review Reviews the selected element sets by highlighting them in the HyperMesh graphics.
Right-click on the Review button to clear the review selections.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Monitor
Select Monitor to define the *MONITOR card.

The supported attributes are: Node, Node Set, DOF, and Frequency.

Click Update to activate the monitor attributes defined in the HyperMesh database.

The following buttons are available on the Monitor dialog:

Table 142:

Button Action

Pick node Opens the node selection panel. When you finish picking a node from the model, click
return. The Step Manager is updated with the selected node number appearing in
the Node entry.

Create/Edit Opens the Entity Sets panel in HyperMesh. When you finish creating/editing the set,
click return. The Step Manager is updated with the new set appearing in the node
set list. For the Abaqus solver, the set must contain one node only.

Update Updates the HyperMesh database with the data lines defined in the table and the
parameters.

Load Step: Print
Select Print in the tree to define the *PRINT card.

The supported attributes are: Contact, Model change, Plasticity, Residual, Solve, Frequency,
Allke, Critical element, Dmass, and Etotal.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1496

Click Update to activate the monitor attributes defined in the HyperMesh database.

Load Step: File Format
Select File format in the tree to define the *FILE FORMAT card.

This option is available when a standard Abaqus template is loaded. The supported attributes are File
format and Zero increment.

Click Update to activate the monitor attributes defined in the HyperMesh database.

Load Step: File Output
Select File output in the tree to define the *FILE OUTPUT card.

This option is available when the Abaqus explicit template is loaded. The supported attributes are File
output, Number interval, and Time marks.

Click Update to activate the monitor attributes defined in the HyperMesh database.

Load Step: Restart Write
Select Restart write in the tree to define the *RESTART, WRITE card.

The supported attributes are Overlay, Frequency, Number interval and Time marks.

Click Update to activate the monitor attributes defined in the HyperMesh database.

Load Step: Unsupported Cards
The Unsupported cards option in the tree enables you to review and edit unsupported history data
within the Step Manager.

Select the checkbox to activate the text area. You can enter the unsupported cards by typing directly or
copying and pasting into the text area. Click Update to include the cards.

Abaqus Step Manager: Load Case Tab
You can create, edit, review, rename, reorder and delete load cases from this tab as well as set the
display status of the load steps.

The Load Case tab contains the descriptions of all existing load cases with the corresponding load
collectors.

See Step Manager Dialog Environment for tips on navigating through the dialogs.
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The Load Case tab contains the following buttons:

Table 143:

Button Action

New... Opens the Create New Load Case dialog. Enter the name of the new load case in the
Name: text box and click Create to create the load step and open the corresponding
Load Case Editing dialog.

Edit... Opens the Load Step Editing dialog for the selected load step.

Review Reviews the selected load collectors. All loads in the load collectors are highlighted
in the HyperMesh graphics. The highlighted loads show through the solid mesh in
performance graphics. If a load is defined with set, the underlying nodes or elements
are highlighted. Right-click Review to clear the highlighted selections.

Text Reviews the selected load step in a text window.

Rename Opens the Rename panel for renaming load steps, load collectors, output blocks, or
various interface controls. When you finish renaming, click return to update the Step
Manager with the new names.

Delete Deletes the selected load steps.

Sync Updates the Step Manager with the current HyperMesh database. If you manually
create, update, or delete load steps, load collectors, output blocks, groups, or entity
sets from HyperMesh panels while the Step Manager is open, click Sync to update
the Step Manager with the new changes.

Close Closes the Step Manager.

↑ Moves the selected load cases up one row.

↓ Moves the selected load cases down one row.

Find and Replace
Use the Find and Replace tool to search the entity names in your model for every occurrence of a
specific character, and automatically replace the character with a new one that you specify.

For example, using " . " may cause errors in certain solvers, therefore you may want to replace it with a
new character.

1. In the Abaqus Utility menu, click Find and Replace.
The Find and Replace dialog opens.

2. In the Replace What field, enter the character you want to find.

3. In the Replace With field, enter the character you would like to replace the existing character with.
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4. Set the Entity Type selector to ALL or to a specific entity type.

Figure 537:

5. Optional: If you set the Entity Type selector to a specific entity type, you can activate the selector
and select specific entities to perform the find and replace on.

6. Click Replace.

ANSYS Utility Menu
The macros on the ANSYS Utility menu simplify some common tasks for the ANSYS user profile.

The ANSYS Utility menu is loaded when you open the ANSYS user profile. The following ANSYS macros
are available.

ANSYS Component Manager
This macro displays components and their associated attributes in an interactive table.

You can also configure the table; only configured items are displayed in the table.

With this macro, you can also create components, select components, assign materials to components,
change component colors, and change component visualization modes. Most actions are available from
shortcut (right-click) menus. You can also find options in the drop-down menus.

Before performing actions such as changing the values of component data, you must select Editable
from the Table menu. Once the components are writable, you can modify the values of existing
components. The following sections describe how to use the Component Manager in both read-only
mode and editable mode.

Use the Component Manager in Read-Only Mode
When you open the Component Manager, existing components are listed in a table using a default
configuration. This configuration displays the name, ID number, ET reference number, element type,
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real set number, material set number, section set number, and number of elements and nodes in each
component.

A sum of elements is shown at the bottom of the table. If a component is invalid for any reason and
cannot be exported to the ANSYS data deck, its row in the table will appear in red.

The display of the data in the Component Manager can be customized according to your preferences.
You can:

• Change which columns are displayed

• Change the order of the columns

• Sort the components by column data, ascending or descending

• Filter which components are displayed based on column data values (see below)

You can save your settings by creating a configuration file.

From the Table menu, open the Configure submenu and select the Save CFG-File option.

This configuration file saves the set of table configuration options so you can use them again. By
default, a configuration file (comptable.cfg) is saved in the working directory for each component table
session and settings from this file are applied each time the table is built.

Use the Component Manager in Editable Mode
When you switch the Component Manager from the default read-only mode to editable mode, you
can perform all the actions described in the section above, plus edit the attributes of the components
listed in the table.

1. Select Editable from the Table menu.

2. To change the value of an attribute, select the attribute in the Assign Values drop-down, type the
new value in the adjacent field, and click Set.

Filter the List of Components
If you have a long list of components and you want to narrow down the list of components that appear
in the table, you can use the filtering feature to specify the criteria for matching components.

1. Select Filter… from the Table menu.
The Filter dialog opens.

2. Type a match value in the box next to the criteria by which you want to filter.

Create a New Component Card with the Component Manager

1. In the ANSYS Component Manager, click the Action menu and select Create New....
The Create Component dialog opens.

2. Type a name for the component in the Component name field.

3. Select an element type in the Element reference number field.

4. Select a real set in the Real set number field.

5. Select a material in the Material reference number field.
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6. Select a section in the Section reference number field.

7. Click the button in the Color field to select a color for the component that will be used in
HyperMesh.

8. Click Create.

9. Click Close to go back to the Component Manager.

Edit a Component Card

1. Click anywhere in the component’s row in the Component Manager table to select it.

2. If not already in Edit mode, click Table and Editable.

3. In the Assign Values drop-down, select a field to modify.

4. In the adjacent field, type or select the new value.

5. Click Set.
A new value appears in the table.

ANSYS Material Macro
The Material macro creates and defines material cards.

This macro lists the existing materials in the model in a table and displays the material Set Number,
Type, and Name for each material. From this macro dialog, you can create a new material, edit an
existing material, or delete a material.

Rows can be sorted by set number, material type and name columns.

The following buttons are available on the Material macro dialog:

Table 144:

Button Action

Help Provides information about the macro.

New... Opens the Create Material dialog, from which you can specify parameters for a
new material and create it.

Edit... Opens the Edit Material dialog, from which you can review and change
parameters for an existing material that is selected in the table.

Refresh Refreshes the HyperMesh database with changes you made through the Material
macro. You must click this button before closing the dialog to successfully export
the ANSYS deck.

Delete Deletes the material that is selected in the table.

Close Closes the Material macro dialog.
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Right-clicking on a row displays a context menu with the option to delete unused materials. Selecting
this option can help you clean up your model by deleting materials.

You can also edit materials, edit material properties, and delete materials from the menu that appears
when you right-click in the table when a row/material is selected.

Create Material Dialog
Create new materials from the Material dialog.

Specify the following options and click Create to create the material and return to the Material macro,
or Create/Edit… to create the material and open the card image panel in HyperMesh to specify the
material’s properties.

The following options are available in the Material dialog:

Table 145:

Option Description

Material Set No Type a number for the material set. If you do not specify a value, a number
will be automatically provided that is one higher than the highest current
material set number.

Material Name Type a name to identify the material.

Material Type Select MP or MPDATA depending on the material card you want to use.

Edit Material Dialog
Edit existing materials from the Edit Material dialog.

Specify the following options and click Update to save the changes. Then click Close to return to
the Material macro. You can also click Edit Material Properties… to open the card image panel in
HyperMesh to modify the material’s properties.

The following options are available in the Material dialog:

Table 146:

Option Description

Material Set No This field is initially populated by the reference number of the material card
that you have chosen to edit. You can change the number to any other
reference number if the number is not already used by an existing material
card.

Material Name This field is initially populated with the current name of the material. You can
modify the name of the material.
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Option Description

Material Type You can change the card image type.

Note:  If you make changes to a material, you must click Update to reflect the changes in
the card image.

ANSYS Section Macro
The Section macro creates and defines section cards for beam and shell sections.

You can create new section, edit existing sections, and use the HyperMesh application to create and edit
beam section and associate them to section cards.

The following buttons are available on the Section macro dialog:

Table 147:

Button Action

Help Provides information about the macro.

New... Opens the Create Section dialog, from which you can specify parameters for a
new section and create it.

Edit... Opens the Edit Section dialog, from which you can review and change
parameters for an existing material that is selected in the table.

Refresh Refreshes the HyperMesh database with changes you made through the Material
macro.

Delete Deletes the section card(s) that is selected in the table.

Close Closes the Section macro dialog.

Right-clicking on a row displays a context menu with the option to delete unused sections. Selecting this
option can help you clean up your model by deleting unused sections.
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You can also edit sections, edit section properties, and delete sections from the menu that appears
when you right-click in the table when a row/section is selected.

Create Section Dialog
Create a new beam, shell or pretension section from the Create Section dialog.

Specify the following options and click Create to create the section card and return to the Section
macro, or Create/Edit… to create the section card and open the Card Image panel in HyperMesh to
specify section properties.

The following options are available in the Create Section dialog:

Table 148:

Option Description

Section Ref No Type a reference number for the section. If you do not specify a value, a
number will be automatically provided that is one higher than the highest
current section ID number.

Section Name Type a name for the section.

Section Type Select the type of section to create: Beam, Taper, Shell or Pretension

Sub Type This selection only applies to beam sections. Choose a subtype from the drop-
down list.

Define by HyperBeam This option is only available if Beam Section is selected. Select the check box
to define the section with HyperBeam. Then select:

• Choose New Section to create a section in HyperBeam and associate it to
the section card image.

• Choose Existing Section to select an available HyperBeam section of
the chosen sub-type in the Sub Type field. When you click Create, a
section card is created with the selected HyperBeam section or if you click
Create/Edit…, the card image is opened in HyperMesh.

When you are in the HyperBeam application, it is possible to create multiple
HyperBeam sections. However, only the most recently created section is
attached the section card.

Edit Section Dialog
Use the Edit Section dialog to edit existing beam, shell or pretension sections.

Modify the following options and click Update to save the changes. Click return to return to the
Section macro. You can also click Edit Properties… to open the Card Image panel in HyperMesh to
edit the section’s properties.
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The following options are available in the Edit Section dialog:

Table 149:

Option Description

Section reference
number:

This field is initially populated by the reference number of the section card that you
have chosen to edit. You can change the number to any other reference number if
the number is not already used by an existing material card.

Section name: This field is initially populated with the current name of the section. You can
modify the name of the section.

Section type: You can change the type of section to create.

Sub type: This selection only applies to beam sections. You can select another subtype from
the drop-down list.

Define by
HyperBeam

This option is only available if Beam Section is selected. Select the checkbox to
modify the section definition with HyperBeam. Then click Edit HyperBeam… to
modify the section in HyperBeam.

If you edit a section card that was created with HyperBeam sections, then this
checkbox is initially selected. However, you can clear the checkbox and make
updates via the card image or vice versa.

If you make changes to a section, you must click Update to reflect the changes in the card image.

Create a SECDATA Card with the Section Macro

1. From the ANSYS Utility menu, click Section....
The Section dialog appears.

2. To create a new section card, click New... at the bottom of the window.
The Create Section dialog appears.

3. Type a reference number for the section in the Section reference number field.

A number will already be provided by HyperMesh, but you can replace this value.

4. Type the name for the section card in the Section name field.

5. Select the type of section you want to create.

• Beam

• Shell

6. If you chose Beam in step 5, then select a Sub type from the pull-down menu.

Shell sections do not have subtypes.

7. At this stage you need to decide if you want to associate a HyperBeam section to the section
card image you are creating. If you do not want to use HyperBeam sections, clear the Define by
HyperBeam checkbox and skip to step 10.
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8. To use a HyperBeam section, select Define by HyperBeam.

9. If you have already created sections in HyperBeam of the selected subtype, you can associate
that section with the new section card image. To create a new section, skip to step 10. Select the
existing section option and choose an existing HyperBeam section from the pull-down menu. Skip
to step 10.

a) To create a new section in HyperBeam and associate it to the section card image you are
creating, select the New section option and click Create to create a section without
properties defined, or Create/Edit... to edit the properties in the section card before saving.
The HyperBeam application opens.

b) Create the section and exit from HyperBeam.

c) Click return in the HyperBeam panel in HyperMesh to go back to the Create Section dialog.
Skip to step 11.

10. Click Create to create a section without properties defined, or Create/Edit... to edit the
properties in the section card before saving.

The following images indicate the location of the value fields in the SECDATA card, such as W1,
W2, t1 and t2.

Figure 538: I Beam
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Figure 539: HREC Beam

Figure 540: T Beam

Figure 541: L Beam

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1507

Figure 542: Z Beam

Figure 543: CHAN Beam
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Figure 544: CTUBE Beam

Figure 545: CSOLID Beam

Figure 546: HATS Beam
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Figure 547: RECT Beam

11. In the Section dialog, click Close to return to HyperMesh.

ANSYS Real Sets Macro
The Real Sets macro creates property card images for all elements that the ANSYS interface supports.

Figure 548:

With this macro, you can view the real constant values of existing real sets, create new real sets, and
edit the properties and reference numbers of existing real sets.

The Real Sets macro dialog displays the real set, reference numbers, element type of the property set,
and the real constant values for that element type.

Rows can be sorted by set name, set ID and the element type column.
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The following buttons are available on the Real Sets macro dialog:

Table 150:

Button Action

Help Provides information about the macro.

New... Opens the Create Real Sets dialog, from which you can specify parameters for a
new real set and create it.

Edit... Opens the Edit Real dialog, from which you can review and change parameters
for an existing real set that is selected in the table.

Export... Allows you to export the table in .csv format

Refresh Refreshes the HyperMesh database with changes you made through the Real
Sets macro.

Delete Deletes the real set(s) that is selected in the table.

Close Closes the Real Sets macro dialog.

Right-clicking on a row displays a context menu with the option to delete unused real constants.
Selecting this option can help you clean up your model by deleting unused real constants.

You can also edit real sets, edit real constants, and delete real sets from the menu that appears when
you right-click in the table when a row/real set is selected.

Create Real Sets Dialog
Use the Create Real Sets dialog to create new real sets.

Specify the following options and click Create to create the real set and return to the Real macro, or
Create/Edit… to create the real set and open the Card Image panel in HyperMesh to specify the real
constants for the element type.

The following options are available in the Create Real Sets dialog:

Table 151:

Option Description

Real Set No Type an identification number for the real set. If you do not specify a value, a
number will be automatically provided that is one higher than the highest current
real set ID number.
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Option Description

Element Type Select an element type from the drop-down list for which a real set is to be created.
The element types are listed in groups sorted by type, as shown in the image below.

Edit Real Sets Dialog
Use the Edit Real Sets dialog to edit existing real sets.

Modify the following options and click Update to save the modified real set. Then click return to return
to the Real Sets macro. You can also modify the real constants by clicking the Edit Real Constants…
button, which opens the Card Image panel.

The following options are available in the Edit Real Sets dialog:

Table 152:

Option Description

Real Set No This field is initially populated by the reference number of the real set that you have
selected to edit. You can change the number to any other reference number that is
not already used by an existing real set.

Element Type This field is initially populated by the element type of the real set that you have
selected to edit. You can change the element type by selecting a new element type
from the drop-down list. The element types are listed in groups sorted by type, as
shown in the image below.

If you make changes to a real set, you must click Update to reflect the changes in the card image.

ANSYS ET Type Macro
The ET Type macro creates HyperMesh card images for ANSYS element types.

The ET Type macro dialog displays the ET type identification number, the element type name, and the
key option values for each element type. From this macro dialog, you can create card images for any
element type that HyperMesh supports, view existing ET types along with their reference numbers and
key options, edit existing element types, or delete element types.

Rows can be sorted by ET Type name, ID and the element type column.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1512

The following buttons are available on the ET Type macro dialog:

Table 153:

Button Action

Help Provides information about the macro.

New... Opens the Create ETType dialog, from which you can specify an element
reference number and key options for a new element type and create it.

Edit... Opens the Edit ETType dialog, from which you can review and change the
reference number and key options for an existing element type that is selected in
the table.

Export... Allows you to export the table in .csv format

Refresh Refreshes the HyperMesh database with changes you made through the
HyperMesh panels.

Delete Deletes the element type(s) that is selected in the table.

Close Closes the ET Type macro dialog.

Right-clicking on a row displays a context menu with the option to delete unused ET types. Selecting
this option can help you clean up your model by deleting unused ET types.

You can also edit element types, edit key options, and delete element types from the menu that
appears when you right-click in the table when a row/element type is selected.

Create ET Type Dialog
Use the Create ETType dialog to create new element types.

Specify the following options and click Create to create the element type and return to the ET Type
macro, or Create/Edit… to create the element type and open the Card Image panel in HyperMesh to
specify the key options for the element type.

The following options are available in the Element Ref No dialog:

Table 154:

Option Description

Real Set No Type an identification number for the real set. If you do not specify a value, a
number will be automatically provided that is one higher than the highest current
real set ID number.
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Option Description

Element Type Select an element type from the drop-down list. The element types are listed in
groups sorted by type, as shown in the image below.

Edit ETType Dialog
Use the Edit ETType dialog to edit existing element types.

Modify the following options and click Update to save the changes to the element type. Then click
return to return to the ET Type macro. You can also click Edit Key Options to modify the key options
for the element type in the HyperMesh Card Image panel.

The following options are available in the Edit ETType dialog:

Table 155:

Option Description

Real Set No This field is initially populated with the reference number of the element type you
have selected to edit. You can change the reference number to any number that is
not already used by an existing element type.

Element Type This field is initially populated with the type of the element type you have selected
to edit. You can select another element type from the drop-down list. The element
types are listed in groups sorted by type, as shown in the image below.

If you make changes to an ET Type, you must click Update to reflect the changes in the card image.

ANSYS Convert to Special 2nd Order Macro
When you run the Convert to Special 2nd Order macro, a mesh matching is used to remove the mid-
side nodes at the shared edges between these first and second order elements.

Models created for the ANSYS solver often contain second-order pyramid and tetra elements in which
most sides contain "mid-side nodes". These types of elements exist in a transition layer between the
first-order hexa and second-order tetra elements, as shown below.
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Figure 549:

Figure 550:
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Figure 551:

Beginning in HyperMesh 8.0, these types of elements are supported and preserved in the model.
HyperMesh can import:

• Pyramid-shaped SOLID95 and SOLID92 elements with side edges containing mid-side nodes and
bottom (base) edges that do not contain mid-side nodes

• Tetrahedron elements with one or more edges that do not contain mid-side nodes

• SOLID95 (special type)

• SOLID187 (special type)

These special elements will be imported as full second-order elements, including mid-side nodes.

Imported full second-order elements are exported as special elements, thereby restoring the original
element configuration. Similarly, special second-order elements created in HyperMesh are also exported
as special second-order elements.

1. Mesh the part for first-order with hexa or penta elements. Place these elements in a collector with
the correct element type (SOLID45).

2. Mesh the mating volume with second-order tetra elements. Place this mesh in a separate
component with the correct element type (SOLID95 or SOLID92).

3. Ensure that the two mesh patterns have a common layer with shared edges between.

4. From the ANSYS Tools page of the Utility menu, click the Convert to Special 2nd Order macro.

5. Select the first-order component from the drop-down menu that shares a common face with the
second-order meshed component.

6. Select the second-order meshed component in the next drop-down menu and click Apply.
The special order elements are generated

7. Export the file. Read it in the solver and check the elements.

The following images show examples of proper meshing for the above practice.
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Figure 552:

ANSYS Surface Manager
Manage existing contact pairs and surface elements, and create new contact pairs and ANSYS thermal
and structural surface elements using the Ansys Surface Manager.

In the Contacts tab you can review a list of existing contact pairs, and in the Surface Elements tab
you can review a list of existing surface element components. Contact pairs are listed according to
their target and master components, color, assigned ET type, property cards, material, and pilot node
name. You can update the data in any of these columns, as well as modify the element key options,
properties, and materials of the contact pairs and surface components. You can view the contact normal
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and reverse it with the buttons provided in the Contacts table. These features are also available for
surface elements.

Create and Edit Contact Pairs
Create 2D and 3D contair pairs, and define contacts.

You can create 2D and 3D contact pairs with the Surface to Surface and Point to Surface options. You
can also define contacts using the Pilot Node option.

1. From the Tools menu, click Surface Manager.
The Ansys Surface Manager opens and the Contact tab is displayed by default.

2. Click New to create a new contact pair.
The Create New Contact Pair dialog opens.

3. Under Creation method, select Flexible or Pilot node.

4. In the Contact type field, select 2D or 3D.

5. Under Create from, select whether to create a surface to surface contact pair or a point to
surface contact pair.

6. Under Symmetric Contact, select Yes or No.

To create two pairs of symmetry contacts, click Yes. In order to create a symmetry pair, the
selected elements must meet all of the element configuration requirements.

• Contact elements in the first pair will be target elements in the second pair.

• Target elements in first pair will be contact elements in the second pair.

• Different properties and ET types will be created for the second pair. You can update the
contact pair with desired properties and contact options later.

7. Click Pick Target to select the target body components.

8. From the panel area, click the comps selector.

9. Select the components that belong to the target component elements.

10. Click select.
11. Click proceed.

12. In the Target Elements Selection dialog, click the Elements selector.

13. In the panel area, verify that the elems selector is active, then select the target elements of the
contact pair.

14. Click proceed.

15. In the Target Elements Selection dialog, click Next.
The Target Component Details dialog opens.
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Note:  This dialog displays a default name and color for the target component, which
can both be modified. You can also modify the ET Type name and the ID of the target
component, as well as the values of the key options. Once Save Keyopts is clicked, all
of your changes will be applied to the target element. The next time you create a new
contact pair, the options you selected in the dialog will be saved and you will not need
to apply them again.

Figure 553:

16. Click Next.
17. In the Contact Components Selection dialog, click the Components selector.

18. In the panel area, click the comps selector.

19. Select the components to assign as the target body.

20. Click select.
21. Click proceed.

22. Click Next.
23. In the Select Contact Elements dialog, click the Elements selector.

24. In the panel area, verify that the elems selector is active, then select the elements to assign as
the contact surface elements.

25. Click proceed.

26. Click Next.
The Contact Component Details dialog opens.
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Note:  This dialog displays a default name and color for the contact component, which
can be modified if desired. The ET type and the ID of the contact component can also
be modified.

27. Click Next.
28. In the Contact Property dialog, enter the values for items shown. You can create a new property,

or create a new one based on an existing property, which helps expedite the process. Click
Save real constants to save the property values you entered. In the future, when the Contact
Property dialog opens, the values you saved will appear by default.

Figure 554:

29. Click Next.
30. In the Contact Material dialog, click New to define a new material or select None to skip

defining a material.
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Figure 555:

31. Click Next.
The Ansys Surface Manager dialog opens and displays a summary of the target and contact
elements. The contact pair you created is displayed.

32. To exit the Ansys Surfaace Manager, click Close.

33. To repeat this process, click Restart.

Create and Edit Surface Elements
Surface elements can be created on the edges of plane elements (2D) or on faces of solid elements
(3D).

Using the Ansys Surface Manager, you can create the thermal surface elements SURF151 and
SURF152, the structural surface elements SURF153 and SURF154, and the radiosity elements SURF251
and SURF252.

1. From the Tools menu, click Contact Manager.
2. In the Ansys Contact Manager, click the Surface Elements tab.

A list of existing surface element components displays.

3. Click New to create new surface elements.
The Surface Effect Elements dialog opens.

4. From the Element Type field, select the type of surface elements to create.

5. Select whether to create 2-D Surface or 3-D Surface elements.

Note:  2D Surface creates surface elements on the edges of a plane element, and 3D
Surface creates surface elements on the faces of solid elements.

6. To create surface elements with extra nodes, select the With Extra Nodes check box.
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Note:  With Extra Nodes is only available for thermal surface elements.

7. If you selected Radiosity Elements as the Element type, you must specify an Emissivity and
Enclosure number value to apply to the edges and faces of base elements.

Note:  Radiosity elements require radiation loads to be applied on the faces of
the elements over which the skin elements are created. The Contact Manager
automatically creates these loads with the emissivity and enclosure values that you
specify.

8. Click Pick Components.

9. In the panel area, click the comps selector.

10. Select components on which surface elements will be created.

11. Click select.
12. Click proceed.

13. In the Elements Selection dialog, click the Elements selector.

14. In the panel area, verify that the elems selector is active, then select elements on which surface
elements will be created.

15. Click proceed.

16. In the Elements Selection dialog, click Next.
17. In the Nodes Selection dialog, click the Nodes selector.

Note:  The Nodes Selection dialog only appears if you selected the With Extra Nodes
checkbox.

18. In the panel area, verify that the Nodes selector is active, then select extra nodes to create
surface elements with.

Note:  A maximum of two nodes can be selected.

19. Click proceed.

20. In the Nodes Selection dialog, click Next.
21. In the Surface Element Component Details dialog, select the appropriate key options.
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Figure 556:

22. Click Next.
23. In the Contact Property dialog, define values for the element real sets (properties).
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Figure 557:

24. Click Next.
25. In the Surf Material dialog, click New to create and define a new material or select None to skip

defining a material.

Note:  The Surf Material dialog only appears if the surface elements being created
needs material properties defined.

26. Click Next.
The Ansys Surface Manager dialog opens and displays the surface elements you created.

27. To exit the Ansys Surface Manager, click Close.

28. To repeat this process, click Restart.

Auto Contact - ANSYS Interface
Use the ANSYS Auto Contact to quickly and easily create interactions between several parts of your
model.

Based on a proximity distance, Auto Contact will search the model and automatically define contact
elements from identified components. The interactions and surfaces are placed into a temporary
browser, where you can review the pairs and make adjustments as needed.

• Each contact element pair will be created with a contact and target element on each selected
element surface.

• Contact element options (ET types) and contact property (REAL sets) are simultaneously created
with the contact pair assigning default values. You have to edit these options and properties using
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the Contact Manager's edit options if you want to assign different values other than the default.
Similar properties (REAL sets) are shared by both contact and target elements.

• Material cards are also generated during the contact pair creation. You have to edit the material
card to set the correct material property values.

• Currently, only surface to surface 3D contact elements can be created. Future releases will be
enhanced to add other contact element types.

The Auto Contact dialog contains the following buttons:

Table 156:

Button Action

Find Searches the model for interacting components.

Cancel Closes the Contact Pair dialog without updates.

Remove Selection icon Removes selected components from the table. You can use the Control and
Shift key to select multiple items in the table.

Review Selection icon Highlights the selected component in the graphic area. All other components
are grayed out. You can use the Control and Shift key to select multiple
items in the table.

Right-click to return the model to normal display.

Help icon Opens the Auto Contact online help.

Set Up an Auto Contact Run

1. Load the ANSYS user profile.

2. From the Tools menu, select Ansys Surface Manager.
3. Click Auto.

The Auto Contact dialog opens.

4. In the Contact Type: field, select the type of contact pair to create.

5. Click the yellow components button to select your components.

The components are automatically placed in the Component table in the Auto Contact dialog. The
proximity distance is the maximum distance between two selected components. When you create
the pair, any surfaces that are farther away than the value entered here will not be created as a
contact pair. The default value is zero.
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Figure 558:

6. In the Maximum reverse angle field, enter a value.

If the angle between two normals of elements or element faces exceeds this value, the element
will not be added to the master or slave surface.

7. Click Find.
The status bar activates and the Auto Contact browser opens.

8. Use the Auto Contact browser to make any necessary adjustments to the interface and surfaces.
When finished modifying, click Create.
The interfaces and surfaces marked as accepted are created. The Contact Manager window
reopens with the new information listed.

Auto Contact Browser
The Auto Contact Browser provides options for viewing and modifying the contact pairs identified in
the auto contact process.

The Auto Contact Browser contains the following columns:

Table 157:

Column Description

Name Lists the name of the interfaces, surfaces and surface interactions that were
assigned.

Underneath the interface name are the temporary surfaces included in that
interface. Red indicates a slave surface, and blue indicates a master surface.

Accept When the Accept box is checked, the Interface will be included in the creation
process.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1526

Column Description

Color Color assigned to the interaction and surfaces

ET Type ET Type

Real Set

Mat Material assigned

The Auto Contact Browser contains the following icons:

Table 158:

Icon Description

Options Opens the Options dialog.

Enter a new feature angle or customize the transparency for a selected entity.
Click OK when finished.

Highlight Elements Highlights the elements stored in selected entities in the graphics window. You
can use the Control and Shift key to select multiple items in the table.

Review Elements Review of elements stored in the selected entities. Elements are highlighted by
color; all other components are grayed out. You can use the Control and Shift
key to select multiple items in the table.

Review and Highlight are mutually exclusive. It is also possible to switch both
options off. This is helpful when working with big models.

Fit View to Elements Automatically zooms in to the elements stored in the currently selected items.

Display All Elements In combination with the Highlight Elements or the Review Elements option,
current contents remain unchanged on the screen.

Display Components

with Elements

Highlights or reviews the elements referred by an interaction or surfaces and
shows the components they belong to. All other components will be masked.

Display Only

Elements 

Only elements are highlighted or reviewed. The rest of the component and
other components will be masked.

Select Elements

Manually 

Opens the Element selection panel so that individual elements can be added/
removed manually. Click proceed when finished.
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Icon Description

Add by Adjacent Adds the elements adjacent to the surface to the selected surface.

Right-click to undo one time.

Add by Face Adds the adjacent face to the selected surface.

Right-click to undo one time.

Recheck Opens the Auto Contact dialog to recheck the select interfaces. Recheck will
either add more contacts to the existing contacts for modify the existing ones.

You can select interfaces from the browser, and the GUI will automatically
populate the components that the interaction was based on. This helps modify
an existing interface.

Modify Auto Contact Entities
Right-clicking on an item in the Auto Contact Browser displays a context menu which offers options for
modifying the surfaces and contact pairs.

The following options are available in the Auto Contact browser's context menu:

Table 159:

Option Description

Rename Rename an existing entry.

Delete Delete items from the browser.

Swap Master - Slave Switches the surfaces identified as master and slave. When selected, you
will see the surfaces flip from the master/slave positions in the browser.

Select multiple entities by using the Control and Shift keys when clicking on
entities.

Edit Faces Opens the elements selection panel where you can select and deselect the
elements to include on the face of the surface. You can also manually edit
the faces of the surfaces using this panel.

Add by Adjacent Adds adjacent elements to the selected surface.

Add by Face Adds all elements to a selected surface, until the feature angle exceeds the
value. The feature angle can by set by clicking the Options icon.

Accept All/None Accept or reject all items in the Auto Contact browser.
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Option Description

Reverse Reverses the current selections in the Accept column.

Expand All/Collapse Expands or collapses folders in the Auto Contact Browser.

LS-DYNA Utility Menu
The LS-DYNA Utility menu contains shortcuts and tools that can help simplify LS-DYNA tasks. Set the
user profile from the User Profiles option of the Preferences menu.

The LS-DYNA Utility menu on the Utility tab is automatically loaded when you select the LS-DYNA user
profile.

The LS-DYNA user profile sets the FE input reader to DYNA KEY and loads the dyna.key (ver 971)
FE output template and LS-DYNA Utility menu. Also, the graphical user interface becomes LS-DYNA
focused, renaming or removing some panels and/or options. The entire ALE Setup is available only
when the LS-DYNA user profile is loaded.

Tools Menu
The LS-DYNA Utility menu contains a Tools menu in addition to the standard HyperMesh Utility menu.
This menu includes special time-saving setup macros and other features that are specific to an LS-DYNA
analysis.

Error Check
The Error Check dialog checks your LS-DYNA deck for potential problems with components, properties,
materials, rigids, joints, boundary conditions, and other entities and reports them on-screen.

The report identifies the problem entity by ID, describes the error, and then enables you to isolate the
entity in the model and quickly make changes.

1. Click Error check on the LS-DYNA Utility menu.
The LsDyna Error Check dialog opens.

2. Select the types of errors for which you want to search and click Check.

When the check is complete, the results appear on the Errors tab of the dialog. Each error in the
list is a hyperlink that, when clicked, highlights the affected visualizations in the model and opens
the relevant card image or panel for correcting the error.

3. Systematically click on each error in the list, correcting them as you go.

4. On the Settings tab, click Check again to verify that the errors were corrected.

5. If you want to restore the full view of the model including all components, click View - Show full
model on the Errors tab of the dialog. To return to the previous view, click View - Restore View.

6. Use the Options menu button to update or save settings for the Error Check dialog.
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You can specify minimum and maximum values for the material check and a maximum value for
the distance of a constrained extra node to its part.

7. To save the current settings, choose Save Settings… from the Options menu button and specify
a file name and location. You can also load previously-saved error check settings.

8. Click Close to exit the Error Check dialog.

Part Info
The Part Info macro summarizes a part’s statistics in a dialog.

1. To start the macro, click Part Info on the Utility menu.

2. Click component on the main menu area to select a component or click a component in the
graphics area to select it.

3. Click proceed.
The Part Information dialog opens, which lists the part ID, name, thickness, and material type.

4. To view additional statistics about the part, click the More Details tab.

5. To display statistics for a different part, select the part in the graphics area or the components
selector and click proceed again.

Tip:  Click the middle mouse button instead of the proceed button to quickly select
components.

Clone Part
The Clone Part macro enables you to quickly create a new part from the properties of an existing part.

1. To start the macro, click Clone Part on the Utility menu.

2. Select the existing part on which to model the new part by clicking the … button.
A dialog opens listing all of the existing components.

3. Select a component from the list and click OK.

4. Type a name for the new part in the New Part field and click the color icon to select a color for the
component.

5. Select whether to duplicate the material and section properties or to re-use the original material
and section properties.

Duplicate means that a new material and section is created (the name is suffixed with .n version
numbers and new IDs are used) with the same properties, while Reuse refers to the same
material and section as the original.

6. Select whether to duplicate the elements.

Duplicate elements will make a copy of the elements from the selected part to new part in the
same location.

7. Click Create to either create or create and edit the card.
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Create Part
Use the Create Part macro to create components on-the-fly.

1. To start the macro, click Create Part on the Utility menu.

2. Type a name for the new component in the Part name field and select a color by clicking the
adjacent color icon.

3. Select a section in the Section field by choosing Create New (create a new section), Same As
(create a new section based on an existing section), or Model (select an existing section) from
the selection menu.

4. Select a material for the component in the Material field by the same method as described above
for the Section field.

5. Click Create to either create or create and edit the card.

Convert to Rigid Macro
Use this macro to convert deformable parts of an LS-DYNA model to rigid.

1. Click Tools in the Utility menu.

2. Click Convert to Rigid.

3. Select the elements to convert to rigid and click proceed.

4. Select an existing rigid component in the model for merging the newly created rigid body and click
Proceed.

5. Click return.

The Convert to Rigid macro performs the following steps when the selected elements are converted to
rigid.

1. For the selected elements, a check is performed on the comps for rigid (MAT_RIGID or matl20)
or deformable materials (all, except matl20). If deformable materials exist, rigid materials
(MAT_RIGID) are created with the properties from the original deformable materials. A check is
performed for rigid materials that are already defined. If rigid materials are found, the comps and
rigid materials are retained.

2. Comps located partially within the window are split into two comps. The new comp has the same
property (section ID) but new material (Material ID). For example, if A-pillar is partially within
the window, then a new comp A-pillar_rig is created. A-pillar_rig is updated with newly created
material.

3. All the spotwelds and rigids located entirely within the window are removed. For
example, *CONSTRAINED_NODAL_RIGID_BODY_option, *CONSTRAINED_NODE_SET,
*CONSTRAINED_SPOTWELD, and *CONSTRAINED_GENERALIZED_WELD_option.

4. For spotwelds that are connected from the deformable body to the rigid body, an extra node is
created and referenced by the master rigid body.

5. A check is performed to detect joints located partially or entirely within the window. Detected
joints are deleted.
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6. A check is performed to detect springs located partially or entirely within the window. Detected
springs are deleted.

7. A check is performed to detect seatbelt elements (seatbelt elements, Retractor, Pretensioner)
located partially or entirely within the window. Detected seatbelt elements are deleted.

8. Master and slave comps are defined, for example, CONSTRAINED_RIGID_BODIES. You are
prompted to select a comp for master rigid body. A slave set is created with the newly created
rigid bodies, except the master rigid body comp.
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9. A message is displayed when the conversion is complete.

Convert to Rigid Flow Chart

Figure 559:
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Figure 560:

The table contains a variety of tools that allow you to review, edit, and update the model. The essential
features are:

• LS-DYNA components with various associated properties and materials are listed in separate
columns.

• You can select the column types from a set of available options.

• There are two modes of operation: review and editable. Use the review mode to review the
component information without changing any values. Use the editable mode to change values for
the selected components.

• There are enhanced selection, review, display, and filter options for components.

• Components can be sorted according to any available column.

• The current configuration is saved automatically to a file at the end of a session and recalled on
reload. You can also save and load a configuration file.

• The table data can be exported in CSV and HTML formats.

• Right-click on the table to display menu options. All pull-down menu options are also available
using a right-click.

• Columns can be moved or swapped by holding the left mouse button on a column title and
dragging it to the desired location.

• Columns can be resized by positioning the cursor along a column border, pressing the left or right
mouse button, and dragging the border to a new position.

• The Shift or Control key combined with a left-click can be used to select multiple rows.

The following tools are available in the LS-DYNA Component Table:

Table

Table 160:

Refresh Regenerates the table with all the parts in the model.

Editable Sets the table mode to editable mode, allowing you to change values for the
selected components.

Filter Enables the filtering GUI.

Configure Specify the number and type of columns listed in the table.
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Save Saves the information listed in the table in CSV or HTML format.

Quit Quit the table function.

Selection

Table 161:

All Selects all rows or parts.

None Selects none or deselects parts/rows that were previously selected.

Reverse Reverses the selection.

Displayed Selects the rows or the displayed parts.

User User graphic interaction to select parts.

Display
By default, the table is invoked with only the displayed parts. You can refresh the table to show a new
part being displayed or use one of the following display commands.

Table 162:

All Displays all the components in the model.

None Turns off every component displayed.

Reverse Reverses the display of the part.

Show selection Displays the components of the selected rows.

Show only Selection Displays only the components of the selected rows.

Hide selection Hides the components of the selected rows from the display.

By Material Displays components sorted by material.

By Properties Displays components sorted by properties.
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By Thickness Displays components sorted by thickness values.

Action

Table 163:

Delete Selection Deletes selected rows (parts) from the model.

User

Table 164:

Set MatDB Path... Opens a dialog on which you can set the location of an external database of
material definitions.

Refresh Material List Updates the list of available materials in the Component Table.

Editable Mode
When the Component Table is in editable mode, you can change values for all selected
components at the same time. Select the Table > Editable option to open the Component
Table in editable mode. Cells with a white background can be manually edited. When you click on
an editable cell, it is selected with a cursor. Once a cell is selected, enter a value and press Enter.

If you want to assign the same value to multiple components at once, select the column type and
value from the Assign Values menu and click Set. All the selected components will be updated
with the assigned values.

Filter
The Component Table supports advanced filtering based on available columns. The Table >
Filter menu option opens the Filter dialog.

You can write any valid string with a wildcard (*) in any of the available column types and click
Apply to filter the table. For example, if you want to show all components that start with letter ‘c’
and use material ‘steel’, you can use the dialog as shown below.

Note:  The filter strings are case sensitive.

Show All turns off the filtering and displays all the components. Select the Table > Configure >
Filter on top option to keep the Filter dialog posted after clicking Apply or Show All.
Otherwise, it closes.
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Configure Columns
Column types can be selected from the Table > Configure > Columns menu option. The table
displays only the selected columns. The available columns types are:

Table 165:

Vis Visualization status. 1 = display on, 0 = display off.

Part name HyperMesh name of the component (maximum 32 characters).

Part id HyperMesh ID of the component.

Material name Material name associated with the component.

Material id Material ID associated with the component.

Material type Material type associated with the component.

Thickness Thickness of elements specified in *section_shell.

Section name *Section name associated with the component.

Section id *Section ID associated with the component.

Section type Type of the *Section associated with the component.

Color Component color.

Int points Number of integration points specified for the *Section_shell.

HGID Hourglass ID associated with component.

Elem form Element formulation for the *section of the component.

Elems Number of elements in the component.

Nodes Number of nodes in the component.

Mass Total mass of the component.

cg_x Center of gravity for the x coordinate.

cg_y Center of gravity for the y coordinate.

cg_z Center of gravity for the z coordinate.

Components All or Displayed mode
The Component Table lists components in two modes: All or Displayed. If All is selected from
the Table > Configure > Components menu, the table will list all the components in the model.
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If Displayed is selected, only the visible components will be shown. Blank components are not
shown in the Displayed mode even though their display status is on.

Material Table
Use the LS-DYNA Material Table to easily create and edit materials.

To access the Material Table, click Material Table on the Utility menu. All the existing materials are
retrieved and populated in the table.

From the Material Table, you can also merge identical materials, search for duplicate materials, and
change the properties of materials.

When you first display the Material Table, all materials are listed in the table, showing the material's
ID, name, type, description, list of components in which it is used, and the RHO, E, and Nu values.

Materials in the table can be selected by clicking the row, which is then highlighted in blue. Many
functions are performed by selecting materials in the table and choosing an option from the context
menu or clicking a button below the table. Shift-click and Control+click can be used to select multiple
rows. Refer to the links below for details about using the Material Table.

Customize Views of the Material Table
The Material Table initially lists all existing materials, but you can sort and filter the list to more easily
identify materials that you want to work with.

Each of the columns in the table can be used to sort the list. Click the column heading to sort by that
characteristic, such as ID number or material type. To view only materials of a particular type, select
that type in the Material type drop-down at the top of the window. For example, if you want to identify
materials that are not used so you can delete them, you can click the Comp used column heading
to quickly group together all materials that contain the value "No", which indicates that none of the
components use the material.

Note:  To view all material properties in the table, select a material type from the drop-
down. When all material types are shown in the table, only the RHO (density), E (Young's
modulus), and Nu (Poisson's ratio) properties appear. However, when a particular material
type is displayed, all the relevant properties for that material type also appear in the table,
as shown in the image below.
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Figure 561:

The Material Table also enables you to view the model's components based on the material used.
These options are available by selecting Display from the menu that appears when you right-click
anywhere in the table. Options include:

• Viewing only the selected materials

• Hiding the selected materials

• Viewing all or none of the materials

• Adding the selected materials to the current display

• Reversing the current display option

Once you make your selection, the corresponding components appear or become hidden in the graphics
area.

Create, Edit and Load Materials
You can create, edit and load materials all from within the Material Table.

Materials can be added or modified with the Create/Load and Edit buttons or by selecting the same
options in the menu that appears when you right-click anywhere inside the table. To save time, you can
choose the Same As selection to begin creating a material with the same properties as the currently-
selected material in the table.

When you create a new material, you specify a name and the type of material. The materials are
conveniently organized into categories, including groups of recently used materials and only materials
that exist in the model. These categories are further listed by the LS-DYNA keyword or type identifier,
as shown in the following image.

You can add the material to the table immediately by clicking Create or by going to the Card Image
panel to specify its properties by clicking Create/Edit.

At any time you can select a material in the table and click Edit to open the material's card image.
In the card image, you can modify values for the keyword's variables. In addition, the material's load
curve appears in a pop-up graph, as shown below.
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Figure 562:

Manage Materials
In addition to viewing, creating, modifying, and deleting materials, you can also identify duplicate
materials, merge like materials into one, and rename materials.

The names of materials and the material IDs can be edited directly in the table. All other values must
be edited with the Edit button, which opens the card image.

Materials that have the same properties can be identified using the Check duplicates button. This
feature, which is only available when all materials are displayed in the table, finds all materials that
have identical properties and returns them in result sets. You can then select each result set to view
the matching materials. Optionally, you can merge the duplicate materials into one material using the
Merge button, which is the same feature as described in the following paragraph.

When you select multiple materials from the table, you can merge them into one of the selected
materials using the Merge As button. Typically this action is performed on materials with like properties
to simplify a model, although it can be performed on dis-similar materials with all selected materials
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taking on the properties of one of the materials. When materials are merged into one, the remaining
materials still exist and appear in the table, but do not have any components assigned to them.

Sort Materials

1. Click the column heading of the criteria by which you want to sort.

2. Click the column heading again to list the materials in reverse order.

See Customize Views of the Material Table to learn about other ways to filter the list of materials in the
table.

Create New Materials
You can create a new material, or create a new material based on an existing material.

Create a New Material

1. Click Create/Load and select New from the menu.
New fields appear at the bottom of the Material Table.

2. Type a name for the material in the New Material Name field.

3. Select a material type from the drop-down list.

The list expands to categories of material types, and also sorts them by keyword or material ID.
You can view the complete list of material types under the All category.

4. Click Create/Edit to open the material card image to specify the properties, or click Create to
add the material to the table without immediately specifying any properties.

5. Click return to exit the Create/Load mode.

Create a New Material Based on an Existing Material

1. Select a material in the table that you want to use as the basis for a new material.

2. Click Create/Load and select Same as from the menu.
New fields appear at the bottom of the Material Table. The material you selected appears in the
Selected material field.

3. Type a name for the material in the New Material Name field.

4. Click Create/Edit to open the material card image to specify the properties, or click Create to
add the material to the table without immediately specifying any properties.

5. Click return to exit the Create/Load mode.

Edit a Material's Properties

1. Select a material in the table that you want to edit.

2. Click Edit.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1541

The card image for the material appears and, if applicable, the load curve appears in a pop-up
window.

3. Modify values in the card image and click return to go back to the Material Table.

Merge Materials

1. In the table, select the materials you want to merge.

Use Shift+click to select multiple, consecutive rows and Control+click to select non-consecutive
rows.

2. Click Merge As.
The Material Table expands to include new fields for merging materials.

3. Select the material ID to use as the new material in the Retain material(id) field.

4. Click Merge.
The components for each of the selected materials are merged into the material you selected.
The remaining materials still exist and are listed in the table, but they are not assigned to any
components.

Find Duplicates

1. Ensure that ALL is selected in the Material type field.

2. Click Check duplicates.
The Material Table expands to include new fields for handling duplicate materials.

3. Choose a group number from the View materials in duplicate group field.
The materials in that group appear in the table. The results for the duplicates check are divided
into consecutively numbered groups of the same material type.

You can easily merge the duplicate materials using the Merge button. See Merge Materials for steps on
using the merge feature.

To view another result group of duplicate materials, select another group number from the View
materials in duplicate groups field. That group’s list of duplicate materials appears in the table.

View the Load Curve for a Material

1. Select a material in the table for which a load curve ID has been defined.

2. Click Edit.
The load curve appears in a pop-up window.

Export Data from the Material Table

1. Select a material type or ALL from the Material type field to export only materials of a particular
type or all materials, respectively.

2. Right-click anywhere in the table and select Save and then CSV for comma- or semicolon-
separated values or HTML for an HTML-based table.
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The Select output file dialog opens.

3. Browse for or type a name in the File name field and click Save.
The file containing material data is saved in the location you specified.

MADYMO Utility Menu
The MADYMO utility contains utilities, tools, macros and shortcuts to display options.

The MADYMO Utility menu (madymo.mac) is loaded when you open the MADYMO user profile. The menu
and its utilities are fully customizable.

The MADYMO Utility menu contains two pages, Tools and Define Entities. Both menu pages contain the
following Display options used to control the display of entities in the graphics window.

Table 166:

Option Description

Body Turns on and off all ellipsoids, planes, cylinders, and joints.

Elems Turns on and off all FE elements.

Triads Turns on and off all coordinate systems.

Shading Set to visualization mode for the entire model. Four modes are available:

0
Performance graphics wireframe

1
Shaded

2
Shaded with mesh lines

3
Shaded with feature lines

Only Comps/MBs Turns off all entities except elements, ellipsoids, planes, cylinders, and joints.

Clear Temp Nodes Removes all temporary nodes (a.k.a. 3D location markers)

Work in Meters Reduces display size of coordinate system and boundary conditions for
modeling in meters.

Autocolor Colors all ellipsoids, planes, cylinders, and joints based on their rigid body
reference. Also colors FE elements by part card.
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The Tools page contains a series of utilities and tools:

Table 167:

Option Description

Set Light Source... Opens a window with button-based light source options. Click the icon button
that corresponds to your preferred direction of the light source, and click
the button that corresponds to your preferred level of specularity. Then click
Close.

Elems to Ellipsoids Converts linear elements to ellipsoids. Each element becomes a new body
with an ellipsoid. A joint is created between each body. The organize, delete,
and mbs joints panels can then be used to move the created ellipsoids to a
single rigid body, delete extra bodies and joints, or change the joint type.

Rotate Systems Used to rotate coordinate systems about their axes.

Resize Ellipsoids Expands/shrinks ellipsoids about their individual axes.

Mesh Ellipsoids Used to mesh ellipsoids. Mesh is created to represent the actual geometry of
the ellipsoid.

Display Syst IDs Turns on numerical ID display for specified coordinate systems. Useful
for seeing which coordinate system is selected when selecting coincident
coordinate systems.

Apply JNTPOS... Applies contents of JNTPOS file to loaded model. Opens the file browser for
selecting the JNTPOS file and applies the Euler parameters for the last time
step on all joints contained in the file.

Body Properties... Opens an editable table of all the rigid bodies in the model listing each body
name, center of gravity, mass, and moment of inertia. Also contains non-
editable fields for reviewing the body ID and parent body.

Both the Define Entities and Tools pages contain Display options, while the Define Entities page also
contains buttons for creating new coordinate systems and location markers in 3D space.

The New Cord Sys options allow you to create the following new coordinate systems:

Parallel Global
Creates new coordinate systems at specified nodes. The created systems are oriented parallel to
the global system.

Parallel Local
Creates new coordinate systems at specified nodes. The created systems are oriented parallel to a
specified local coordinate system.
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From 3 Nodes
Opens the HyperMesh systems panel for created coordinate systems in any orientation by
specifying three nodes or temporary nodes.

The New loc marker options allow you to create the following new temporary nodes, which are used as
location markers throughout HyperMesh:

At Coord System
Creates a new marker at specified coordinate systems.

At Ellipsoids
Creates new markers at specified ellipsoids’ centers and axis.

Cover Ellipsoids
Covers ellipsoids with new markers.

At Body COGs
Creates new markers at specified rigid bodies’ center of gravities.

At Other
Opens the HyperMesh create nodes panel for creating markers by entering coordinates (local or
global), between existing nodes/temp nodes, on a plane, or on CAD geometry.

Nastran Utility Menu
The Nastran user profile contains two macro menus on the Utility menu: Nastran1 and Nastran.

Nastran1 Page
Macros supported by the Nastran1 macro menu.

Auto Contact
Create one or more contact interfaces between parts of your model.

Open the Auto Contact macro by clicking Tools > Auto Contact from the Utility menu. To access this
tool, you must first load the Nastran user profile.

The Auto Contact tool lets you create one or more contact interfaces between parts of your model.
Based on a proximity distance, the Auto Contact tool searches through the parts that you select and
automatically creates new contact surfaces and contact interfaces between them. The Auto Contact tool
displays and organizes the contact entities inside of a temporary Auto Contact Browser where you can
review and adjust the contacts as needed before accepting any changes.

Auto Contact creates Nastran BCBODY-BSURF pairs and puts them into a Nastran BCTABLE card. You
can select a variety of contact types from the drop-down list in the Auto Contact dialog. The interface
type you select is used as the initial configuration for all found interfaces. You can edit the interfaces in
the Auto Contact Browser.

The BCBODY-BSURF surface group pairs are created as master and slave entities per each contact
interface, with the following characteristics:
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• Master and slave surfaces are automatically assigned based on the average element size of each
surface:

◦ The surface with the smallest, average element size is assigned as a slave, and the other as a
master.

◦ You can review and swap the master and slave assignments for each contact in the Auto
Contact Browser.

• For 3D element faces, the surface normal direction points outward from the solid body.

• For 2D elements, the surface normal direction is assigned according to element normals. You can
review and reverse this information in the Auto Contact Browser.

Auto Contact Dialog
The Auto Contact dialog contains the following options:

Table 168:

Option Description

Type of interface This controls the contact type as defined by the IGLUE option inside of the
BCTABLE card. The IGLUE options include:

• Touching

• No Contact

• Regular Glue

• Special Glue

Please refer to the MSC Nastran documentation for a detailed explanation.

Select components This directs you to the Component Selection panel, where you can select the
components you want the Auto Contact tool to search through.

Create full component
BCBODY's

When activated, the Auto Contact tool creates BCBODY-BSURF pairs of the
entire outer surface of the given components, instead of just the elements
inside the contact area. When turned off (default), the BCBODY-BSURF
pairs contain only the elements inside the contact area, as controlled by the
Proximity Distance parameter.

Proximity distance This value specifies that the contact pairs generated between components are
closer to each other by less than the specified proximity distance.

Use shell thickness for
2D elements

If activated, the shell thickness values are used for 2D elements instead of
the specified Proximity distance. 3D elements keep the specified Proximity
distance.

Max reverse angle This is a maximum value that you specify. If the angle between the normals
of two elements, or element faces within the proximity distance, exceeds
the specified value, the elements are excluded from the contact. The default
value is 15 deg.
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Option Description

Consolidate contact
patches between
component pairs

When activated, the Auto Contact tool consolidates any separate contact
patch areas that participate in contacts between the same two components,
so that the final number of BCBODY-BSURF pairs in the model can be
reduced. When turned off (default), each contact patch area is treated as a
separate BCBODY-BSURF pair.

Find Executes the Auto Contact search between all of the components in the list.

Remove Selection Icon Removes the highlighted items from the selected components list. You can
use the Control and Shift keys to select multiple items in the list.

Review Selection Icon Highlights the selected items from the component table in the HyperMesh
graphics area, while graying out other components. You can use the Control
and Shift key to select multiple items in the list.

Right-click to return the model to normal display.

Help Icon Opens the Auto Contact online help.

Remarks
During the Auto Contact process, temporary components may be created for parts containing 3D
elements. These temporary components are named using a preceding ^ symbol, and automatically
contain extracted element faces needed for the contact creation process. Auto Contact cleans up and
removes these temporary components when you finish or cancel the process. If you decide to export
the model before accepting or canceling the process, HyperMesh excludes these temporary components
from export.

Auto Contact Browser
The Auto Contact Browser provides options for reviewing and modifying contact interfaces and surfaces
that the Auto Contact tool finds.

The Auto Contact Browser automatically loads in the HyperMesh tab area as part of the Auto Contact
creation process. All of the entities listed in this browser are temporary, and are not part of the model
until you click the Create button. Clicking Cancel clears all of the temporary entities and closes the
Auto Contact Browser, leaving your model unchanged.
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The Auto Contact Browser contains the following columns:

Table 169:

Column Description

Name Lists the names of all of the contact interfaces and surfaces found by the
Auto Contact tool.

Figure 563:
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Column Description

Underneath each contact interface name is the temporary master and slave
surfaces associated to that interface. Red indicates a slave surface, and blue
indicates a master surface.

Renaming entities, as well as Master/Slave surface swapping is possible via
the context menu.

Accept This checkbox defines whether or not a contact interface is included in the
creation process once you click Create.

Color Color that is assigned to the contacts and contact surface entities.

Type Type of CONTACT assigned to each contact interface. This affects the IGLUE
option for the given BCBODY-BSURF pair inside the BCTABLE card.

Reverse Normal This checkbox defines whether or not the normal direction of the given
surface should be reversed or not. When OFF (default), surfaces on 3D
elements point outwards, and surfaces on 2D elements point in the direction
of the element normal.

Context Menu
Right-clicking an item in the Auto Contact Browser displays a context menu that offers options for
modifying a selected contact interface or surface.

Table 170:

Option Description

Rename Renames the selected entity.

Delete Deletes the selected items from the browser.

Swap Master-Slave Allows you to switch the contact surfaces identified as master and slave.
When executed, you see the surfaces switch position as master and slave in
the browser.

Edit Faces Opens the Element Selection panel, where you can manually add and remove
individual elements from a selected contact surface. Click Proceed when you
are finished.

Note:  Only available when selecting contact surfaces.

Also accessible via the Select Elements Manually icon .
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Option Description

Add by Adjacent Automatically adds all of the immediately adjacent elements to a selected
contact surface.

Note:  Only available when selecting contact surfaces.

Also accessible via the Add by Adjacent icon .

Add by Face Automatically adds all of the elements by face to a selected contact surface.
The feature angle controlling face detection tolerance can be modified inside
the Options dialog.

Note:  Only available when selecting contact surfaces.

Also accessible via the Add by Face icon .

Review Normal Allowed only for surfaces containing 2D elements. For surfaces containing
3D element faces, normal direction is automatically assigned in an outward
direction.

Accept All/None Automatically checks and clears the Accept checkbox for every item in the
Auto Contact Browser.

Reverse Reverses the Accept checkbox status for every item in the Auto Contact
Browser.

Expand/Collapse All Automatically expands and collapses every folder in the Auto Contact
Browser.

Browser Icons and Other Controls
The Auto Contact Browser contains the following icons and controls:

Table 171:

Option Description

 Options Opens the browser's Options dialog. From this dialog you can enter a new
feature angle or customize the transparency for a selected entity. Click OK
when you are finished.

 Highlight Elements When this icon is turned on, the elements that belong to the currently
selected contact interfaces or surfaces are highlighted in the graphics
area. You can use the Ctrl and Shift keys to select multiple items from the
browser.
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Option Description

Highlight Elements is mutually exclusive and may be switched off. This could
be helpful when working with large models.

 Review Elements When this icon is turned on, the elements that belong to the currently
selected contact interfaces or surfaces are reviewed in the graphics area.
Elements are highlighted by color, while all other components are grayed
out. You can use the Control and Shift key to select multiple items in the
browser.

Review Elements is mutually exclusive and may be switch off. This could be
helpful when working with large models.

 Fit View to Elements Automatically zooms in on the elements that belong to the currently selected
contact interfaces or surfaces.

 Freeze Displayed

Components

When this icon is turned off (default), the graphics area will dynamically
update depending on the entities that are selected in the browser. When
turned on, the current display state will remain unchanged, even when you
change your selection in the browser.

 Display

Components with
Elements

When this icon is turned on (default), the elements belonging to the
currently selected contact interfaces or surfaces are highlighted and
reviewed in the graphics area, while also displaying the components they
belong to. All of the other components are masked and will not display in the
graphics area.

 Display Only

Elements

When this icon is turned on, the elements that belong to the currently
selected contact interfaces or surfaces are highlighted and reviewed in the
graphics area, while masking everything else.

 Select Elements

Manually

Opens the Element Selection panel, where you can manually add and
remove individual elements from a contact surface. Click Proceed when you
are finished.

Also accessible via the context menu (Right-Click > Edit Faces).

 Add by Adjacent Automatically adds all of the immediately adjacent elements to a selected
contact surface. Right-click the icon to undo one time.

Also accessible via the context menu (Right-Click > Add by Adjacent).

 Add by Face Automatically adds all of the elements by face to a selected contact surface.
Right-click the icon to undo one time. The feature angle controlling face
detection tolerance can be modified inside the Options dialog.

Also accessible via the context menu (Right-Click > Add by Face).
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Option Description

 Recheck Opens the Auto Contact dialog, so that you can recheck the selected
interfaces.

When you select interfaces from the browser, the GUI will automatically
populate the components that the interaction was based on. This helps
modify an existing interface.

Remarks
During the Auto Contact process, temporary components may be created for parts containing
3D elements. These temporary components will be named using a preceding ^ symbol, and will
automatically contain extracted element faces needed for the contact creation process. Auto Contact will
cleanup and remove these temporary components when you finish or cancel the process. If you decide
to export the model before accepting or canceling the process, HyperMesh will always exclude these
temporary components from export.

Set Up an Auto Contact Run

1. From the menu bar, select Preferences > User Profiles.
The User Profile dialog opens.

2. Select Nastran as the profile name then click OK.

3. From the menu bar, click Tools > Auto-Contact and do the following in the Auto Contact
dialog:

a) Open the Type of interface drop-down list and select the type of interface you want to create.

The interface you select is used as the initial configuration for all found interfaces. You can
edit the interface in the Auto Contact Browser.

b) Double-click Component to open the Component Selection panel.

4. On the Component Selection panel, click comps, select your components, and then click select.
The components you select are added to the Components list inside of the Auto Contact dialog.

5. Click Proceed and enter two values in the Auto Contact dialog.

• For Proximity distance, enter a value to specify the maximum proximity distance between
the components of contact pairs.

• For Max reverse angle, enter a value to specify the maximum angle between the normals
of two elements or element faces within the proximity distance. If this value is exceeded, the
element is not included in the contact. The default value is 15 deg.
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Figure 564: Definition of Proximity Distance and Maximum Reverse Angle

6. Click Find.
The status bar activates. Once it is complete, the Auto Contact Browser automatically opens.

7. Use the Auto Contact Browser to review all of the found interfaces and make any necessary
adjustments to your contacts and contact surfaces. When you are finished, click Create.

Contact pairs are created for all items marked as Accepted. Clicking Cancel will close the Auto
Contact Browser without creating any contacts.

This creates a BCTABLE card with master-slave entities that use the contact types displayed in the
Auto Contact Browser.

BCTABLE Manager
Use the BCTABLE Manager to create, edit and delete BCTABLEs from a convenient tabbed interface.

The three tabs, BCTABLE, Contact Elems, and Parameters, each contain tools related to BCTABLEs.

BCTABLE Tab
The BCTABLE tab lists existing BCTABLEs in the database. For each item in the list, you can choose
whether to display it with the Display checkbox. To view the content of a particular BCTABLE, select the
Status checkbox and click the Contact Elems tab. The following buttons are also available on this tab:

Table 172:

Button Action

Sync Synchronize the settings in the BCTABLE tool and the database.

Delete Delete the selected BCTABLE.

Create Create a new BCTABLE.
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Button Action

Close Exit the BCTABLE Manager.

Contact Elems Tab
The Contact Elems tab lists existing contact elements for the selected BCTABLE. The BCTABLE is
selected on the BCTABLE tab, as described above. The following buttons are also available on this tab:

Table 173:

Button Action

Add Add a row/contact element.

Delete Delete the selected contact element.

Close Exit the BCTABLE Manager.

Parameters Tab
The Parameters tab lists existing parameter values for each pair of contact elements. The following
buttons are also available on this tab:

Table 174:

Button Action

Reset Set to default values.

Update Update the values.

Close Close the tool.

Click Slave and Master to see all the BCBODYs.

Create a Spider
Use the RigidSpider macro to create a spider (RBE2 elements) around holes.

You can create a spider with or without a washer and with one or multiple RBE2 elements.

1. From the Nastran Utility menu, click RigidSpider.
The Generate Rigid Spider dialog opens.

2. Select the components where the spider is needed.

Click ... to access a list of all available components.

3. Select the Spider Type.
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• Normal

• Washer

If you select Washer, an additional field appears on the dialog.

4. In the Rigid Type field, select Single or Multiple.

Single indicates that a single RBE2 element will be created between the independent node and
all dependent nodes. Multiple indicates that multiple RBE2 elements will be created between the
independent node and each dependent node.

5. Click Generate.
The tool redraws the component chosen in step 2 using plotel elements around the holes and
component perimeter.

6. Pick a plotel element around the hole where the spider is needed.

7. Click proceed.

View Part Information
The PartInfo macro summarizes a part’s statistics in a dialog.

1. To start the macro, click PartInfo on the Utility menu.

2. Click component in the main menu area to select a component or click a component in the
graphics area to select it.

3. Click proceed.
The Part Information dialog opens, which lists the part ID, name, thickness, and material type.

4. To view additional statistics about the part, click the More Details tab.

5. To display statistics for a different part, select the part in the graphics area or the components
selector and click proceed again.

Tip:  Click the middle mouse button instead of the proceed button to quickly select
components.

Component Table
With this macro, you can create components, select components, assign materials to components,
change component colors and change component visualization modes.

This macro opens the Nastran Component Table, which displays components and their associated
attributes in an interactive table. You can also configure the table; only configured items are displayed
in the table.

Most actions are available from shortcut (right-click) menus. You can also find options in the drop-
down menus. Before performing actions such as changing the values of component data, you must
select Editable from the Table menu. Once the components are writable, you can modify the values of
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existing components. The following sections describe how to use the Component Table in both read-
only mode and editable mode.

Use the Component Table in Read-Only Mode
When you open the Component Table, existing components are listed in a table using a default
configuration. This configuration displays the component name, component ID number, properties on
component, component color, thickness, property on element, material name, material ID, material
type, and the visualization status of each component. The Nodes and Elems display is turned off by
default. When activated, the total numbers of elements and nodes are shown at the bottom of the
table.

The display of the data in the Component Table can be customized according to your preferences. You
can:

• Change which columns are displayed

• Change the order of the columns

• Sort the components by column data, ascending or descending

• Filter which components are displayed based on column data values (see below)

You can save your settings by creating a configuration file. From the Table menu, open the Configure
submenu and select the Save CFG-File option. This configuration file saves the set of table
configuration options so you can use them again. By default, a configuration file (comptable.cfg) is
saved in the working directory for each component table session and settings from this file are applied
each time the table is built.

Use the Component Table in Editable Mode
When you switch the Component Tablefrom the default read-only mode to editable mode, by selecting
Editable from the Table menu, you can perform all the actions described in the section above, plus
edit the attributes of the components listed in the table. To change the value of an attribute, select the
attribute in the Assign Values drop-down, type the new value in the adjacent field, and click Set.

Create a New Component

1. From the Table menu of the Component Table, select New.
The Component Create dialog opens.

2. Type a name in the Component Name field.

3. Select a material type for the component from the Mat Name drop-down field, or click the
adjacent New button to define a new material and select it.

4. Click Properties to assign a property, or click the adjacent New button to define a new property
and select it.

5. Click Create.
A panel opens on which you must confirm the component creation.

6. Click return.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1556

The new component appears in the Component Table.

Create a New Material or Edit an Existing Material

1. From the Assign Values drop-down field, select Mat Name.

2. Click New to create a new material or select a material from the HM-Mats drop-down field and
click Edit to edit that material.

Assign a Value to Multiple Components

1. Select the components that you want to change.

You can use Control+click and Shift+click to select non-adjacent and adjacent rows in the table,
respectively. Other options are available in the Selection menu.

2. Select the column type you want to change from the Assign Values drop-down field.

3. Type the new value in the adjacent field.

4. Click Assign.
The selected column types are updated to the new value you specified.

Filter the List of Components in the Table
The Component Table includes advanced filtering features based on the available columns of data.

If your model contains a large number of components, you can filter the components to quickly see
components that are of interest to you.

1. From the Table pull-down menu, select Filter….
The Filter dialog opens.

2. Type a search string, with optional wildcard characters (*), in the fields for the columns you want
to search.

For example, to search for all components that begin with the letter ‘c’ and have ‘steel’ as the
material type, you would complete the dialog, as shown below:

Figure 565:

Search strings are case-sensitive.

3. Click Apply in the Filter dialog.
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The filter is applied to the Component Table and only those components that match the search
criteria are shown.

4. To remove filtering and display all the components, click Show All on the Filter dialog. You can
also keep the Filter dialog open after applying filter changes by selecting the Table menu and
selecting Configure and Filter on top.

Customize the Contents of the Table
To customize what appears in the table, you can specify which columns of data appear in the table.

1. From the Table menu, select Configure and Columns….
The Configure dialog opens.

2. The Configure dialog contains a list of column types that are available. Select the checkboxes for
the data you want to view.

3. Click OK.

Export Data in CSV or HTML Format

1. From the Table menu, click Save and then either CSV or HTML, depending on which type of data
file you prefer.

2. If you chose CSV, you must select delimiter Comma (,)… or delimiter Semi-colon (;)…,
depending on which character you want to be the data delimiter in the output file.
The Select Output File dialog opens, on which you can select an existing file to overwrite or type
the name of the file you are creating.

3. Click Save.
The data file is saved in the location you specified.

Property Table
Use this macro to create properties, select properties, assign materials to properties and export the
data in CSV or HTML format.

This macro opens the Nastran Property Table, which is an interactive table of Nastran one-dimensional
properties and their associated materials.

Note:  This table contains 1D properties only. Use the Component Table to create 2D and
3D properties.

Most actions are available from shortcut (right-click) menus. You can also find options in the drop-
down menus. Before performing actions such as changing the values of property data, you must select
Editable from the Table menu. Once the properties are writable, you can modify the values of existing
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properties. The following sections describe how to use the property table in both read-only mode and
editable mode.

Use the Property Table in Read-Only Mode
When you open the Property Table, existing properties are listed in a table using a default
configuration. This configuration displays the name, ID, type, material description, material ID, material
type, number of elements, and visualization status for each property. The total numbers of elements is
shown at the bottom of the table.

The display of the data in the property table can be customized according to your preferences. You can:

• Change which columns are displayed

• Change the order of the columns

• Sort the components by column data, ascending or descending

• Filter which components are displayed based on column data values (see below)

You can save your settings by creating a configuration file. From the Table menu, open the Configure
submenu and select the Save CFG-File option. This configuration file saves the set of table
configuration options so you can use them again. By default, a configuration file is saved in the working
directory for each Property Table session and settings from this file are applied each time the table is
built.

Use the Property Table in Editable Mode
When you switch the Property Table from the default read-only mode to editable mode (by selecting
Editable from the Table menu), you can perform all the actions described in the section above, plus
edit the attributes of the components listed in the table. To change the value of an attribute, select the
attribute in the Assign Values drop-down, type the new value in the adjacent field, and click Set.

Filter the List of Properties in the Table
The Property Table includes advanced filtering features based on the available columns of data.

If your model contains a large number of properties, you can filter the list to quickly see properties that
are of interest to you.

1. From the Table menu, select Filter.
The Filter dialog opens.

2. Type a search string, with optional wildcard characters (*), in the fields for the columns you want
to search.

For example, to search for all properties that begin with the letter ‘P’ and have ‘steel’ as the
material type, you would complete the dialog. Search strings are case-sensitive.

3. Click Apply in the Filter dialog.
The filter is applied to the Property Table and only those properties that match the search
criteria are shown.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1559

4. To remove filtering and display all the properties, click Show All on the Filter dialog. You can also
keep the Filter dialog open after applying filter changes by selecting the Table menu and selecting
Configure and Filter on top.

Create a New Property

1. From the Table menu of the Property Table, select New.
The Property Create dialog opens.

2. Type a name in the Property Name field.

3. Select a property type for the property from the Prop Name drop-down field, or click the adjacent
New button to define a new property and select it.

4. Select the type of property, such as PBAR or PBEAM.

5. Click Create.
A panel opens on which you must confirm the property creation.

6. Click return.
The new property appears in the Property Table.

Assign a Value to Multiple Properties

1. Select the properties that you want to change.

You can use Control+click and Shift+click to select non-adjacent and adjacent rows in the table,
respectively. Other options are available in the Selection menu.

2. Select the column type you want to change from the Assign Values drop-down field.

3. Type the new value in the adjacent field.

4. Click Set.
The selected column types are updated to the new value you specified.

Material Table
The Materials Table is used to review and edit MAT1.

Review MAT1

From the Nastran Utility menu, click Material Table.
All MAT1 in the model are displayed.
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Figure 566:

Create MAT1

1. From the Nastran Utility menu, click Material Table.

2. Click Create MAT1.
The following dialog is displayed.

Figure 567:

3. Fill in the necessary fields.

4. Click Create.
The material is created and added to the Material Table.

Delete MAT1

1. From the Nastran Utility menu, click Material Table.

2. Select the material to be deleted.

Check Select all to select all materials.

3. Check the small X box next to the checkbox to delete the material.

4. Click Close.
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Create an RSSCON Element
The RSSCON Create macro creates an RSSCON element that connects the shell and solid.

Because RSSCON elements are not directly supported, these elements are stored in unsupported Bulk
Data cards.

1. Click the RSSCON Create macro.

2. Pick the elements to be connected in the model.

3. Click proceed.

Note:  When you renumber element or node IDs, RSSCON elements are not also
updated because they are supported only as text.

Create an RSPLINE Element
The RSPLINE Create macro creates RSPLINE elements as Bulk unsupported cards.

1. Click the RSPLINE create macro.

2. Select nodes on the model.

3. Click proceed.

The default value for the third field of this card is 0.1.

Table Create
Use the TABLE Create macro to create a tabular function card or add data to an existing card. You can
use the macro to import XY data or enter the data manually.

Create a New Table Card Manually

1. Click TABLE Create on the Utility menu.

2. Select Create/Edit Table, select the table type, for example, TABLED1, and click Next.
The Create/Edit Table dialog opens.

3. Type values in the XY table for the XY pairs you want to include in the table.

4. Select either Create New Table or Edit Existing Table.

• If you selected Create New Table, type a name for the new load collector in the Name field
and select a color for the load collector with the color selector button. A new load collector will
be created with the table card image including the data from the XY table on the dialog.

• If you selected Edit Existing Table, choose a load collector from the Select drop-down
menu. The data in the XY table will be added to the existing table card that you specified.

5. Click Apply.
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6. Click Exit.

Create or Add Data to a Table Card from a Data File

1. Click TABLE Create on the Utility menu.

2. Select Import Table, select the table type, for example, TABLED1, and click Next.
The Import Table dialog opens.

3. In the File field, specify an XY data file.

This file must be either .csv or .txt format.

4. Select either Create New Table or Edit Existing Table.

• If you selected Create New Table, type a name for the new load collector in the Name field
and select a color for the load collector with the color selector button. A new load collector will
be created with the table card image including the data from the XY table on the dialog.

• If you selected Edit Existing Table, choose a load collector from the Select drop-down
menu. The data in the XY table will be added to the existing table card that you specified.

5. Click Apply.

6. Click Exit.

Nastran2 Page
Macros supported by the Nastran2 macro menu.

Convert Degenerate Second Order Shells
Use the Convert Shells macro to convert degenerate second order shells into first order shells.

1. Select the file for which the second order shell elements are to be converted.

2. Click Convert.
Messages are displayed in the message box, which state the name and location of the new file as
well as the file where all the unconverted second order shells will be placed.

Note:  You can import the Nastran file directly, and all the degenerate second order
shells will be written into the .hmx file. In doing this, you will miss all the degenerate
second order shells in the imported Nastran file.

Display and Expand the SET
Use the Display SETs macro to review and expand (before renumber) SETs.

1. Choose the SETs from the Selection column.

2. Click Display.
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Note:

• "HM SET" means the ID in the SET can be renumbered.

• "TEXT SET" means the ID in the SET cannot be renumbered.

• Empty SET cannot be viewed or renumbered.

Create Tags on Nodes
Use the Tag on Nodes macro to create a tag on every node that has a comment in its 10th field.

1. Choose the color of the tags.

2. Click Create.

Create SPOINTs
Use the SPOINT macro to create SPOINTs.

1. Input nodes in the Node ID(s) window using any the following formats:

• 2

• 100 THRU 200

• 13,24,25

• 13 14 15

• 13 THRU 25,30 50

2. ClickAdd.
The new SPOINTs are created and added to the SPOINTS window.

Note:  SPOINTs are treated as NODEs. Delete them as you would NODEs.
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PAM-CRASH 2G Utility Menu
The PAM-CRASH 2G Utility menu (pamcrash2G.mac) contains shortcuts and tools that help simplify PAM-
CRASH 2G tasks.

Tool Menu
Use the Tool menu options to simplify safety tasks.

Dummy Positioning Tool Start Macro
Use this macro to position dummies.

Once the template is loaded, you will be asked to create a process instance or open an existing process
instance. After this step, you could see a task tree defining the process of dummy positioning in
HyperMesh. You can then traverse through these tasks and position the dummy. Once the dummy is
positioned, this position can be saved as a transformation file and can be later applied to the dummy to
bring it into this final position without user interaction. The following tasks are listed in the process tree
for dummy positioning.

Table 175:

Task Name Action

Configure Process: Select either Interactive positioning or Automatic positioning.
Depending on the selection, the process tree will change.

LoadDummy You are asked for the PAM-CRASH 2G
dummy and the positioner file. When
the PAM-CRASH 2G dummy is loaded
in HyperMesh, the pampostohm tool is
automatically started and the dummy is
prepared for positioning. System collectors,
systems, and assemblies are created and
nodes are associated with the systems.

LoadNoDummyFiles Imports other parts of the model, which
may be required in order to position the
dummy correctly.

Interactive Positioning

SelectJoints Opens the Dummy panel and displays a list
of joints in the model, and allows you to
select a joint for viewing the load curves
associated with that joint. You can select
which curves (x,y,z) should be shown,
the updatePlot utility shows the current
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Task Name Action

position of the joint on the load curve by
drawing a vertical line. The deletePlot utility
deletes the plots created by this tool. If you
exit this task without deleting plots, you
would need to do that in the delete panel
afterwards.

Note:  Only the plots will
be deleted, none of the load
curves will be deleted from the
database.

CreateTransformation Once finished with the positioning of the
dummy, you can save this information into
a transformation file.

CreateDocumentation Update the model documentation as well
as create HTML documentation of the
process. You can also select an image to be
embedded in the HTML file. A browser can
also be selected to display the HTML file. An
.h3d file is also embedded into the HTML
documentation.

ExportFiles Save the model as an HyperMesh database
as well as in PAM-CRASH 2G format. While
exporting in PAM-CRASH 2G format, you
have the choice of specifying whether
you want to delete the additional entities
created by the dummy positioning tool.

LoadOnlyDummy Same as LoadDummy.

ExecuteTransformation Select a transformation file, which will be
executed automatically to position the
dummy.

Documentation Same as CreateDocumentation.

Automatic Positioning:

ExportDummy Same as ExportFiles.
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The same transformation file could be applied to different dummies, provided the tree structure remains
same.

Materials Supported for Dummy Positioning in PAM-CRASH 2G
For the computation of the minimum and maximum angle for the rotation in each direction, the PAM-
CRASH 2G materials 220 and 221 are implemented.

Stop Angle Implementation

Normally, the stop angles are given by load curves. The second and last curve points are used to
determine the stop angle. If a load curve has less than four entries, the first and the last entries are
used. You can find the implementation of the stop angle in the HM_JOINT_INFO function in the function
template of the PAM-CRASH 2G Interface. If load curves are not defined for a joint, default values for
stop angles ( -270°C to +270°C ) will be displayed in the Dummy Positioning panel.

Update Initial Rotation Angle in the JOINT Card
The initial rotation angles in the JOINT cards are updated automatically.

To update them, use the macro Update Jt Angles on the Tool page.

Part Info Macro
The Part Info macro summarizes a part’s statistics in a dialog.

1. To start the macro, click Part Info on the Utility menu.

2. Click component on the main menu area to select a component or click a component in the
graphics area to select it.

3. Click proceed.
The Part Information dialog opens, which lists the part ID, thickness, and material type.

4. To view additional statistics about the part, click More Detail >>.

5. To display statistics for a different part, select the part in the graphics area or the components
selector and click proceed again.

Tip:  Click the middle mouse button instead of proceed to quickly select components.

Substructure Tool Macro
The Substructure Tool macro provides several features for creating and modifying substructures.

Substructures are user-defined sets of finite elements, elements and nodes, or nodes from the initial
model. Information defining the substructures and their boundary node displacements are saved
in a special file during the initial run. In subsequent runs, this saved data is read in and the saved
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displacement time histories are applied as imposed displacements to the boundary nodes. The input
data set for a subrun must contain all the information needed to perform the subrun.

Note:

• The SUBDF card is supported as a vector collector in HyperMesh.

• You must have a pre-existing GES created that contains the nodes/elements of the part
defining the substructure.

When you open the Substructure Tool macro, the existing substructures are listed in a table-based
interface, as shown below.

The substructures are sorted by order of creation. The following columns appear in the table:

Table 176:

Column Description

Keyword Name The name of the substructure.

IDEF Indicates the definition type of the substructure:

0
Only via elements

1
Via elements and boundary nodes

2
Only via boundary nodes

DTSUB Specifies the time intervals for the boundary node displacement time
histories.

Elements Displays the ID of the element-based entity set. You can click GES… to use
the GES Browser to select an entity set.

Boundary Nodes Displays the ID of the boundary node-based entity set. You can click GES…
to use the GES Browser to select an entity set.

Filename SUBURN Name of the file that contains the definition of the substructure and its
boundary node displacements.

Time Factor Time unit scaling factor.
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Column Description

Length Factor Length unit scaling factor.

RBODY Manager Macro
The RBODY Manager is accessible in the PAM-CRASH 2G Tool menu.

The RBODY Manager provides the following features in one convenient tab:

• Display all rigid bodies in the model

• Display all individual rigid bodies

• Create new, and edit existing, simple and complex rigid body formulations

• View and update details of individual rigid bodies, though the card editor and the Rigid panel

The tool is also available in the Radioss user profile and offers similar features.

Existing rigid bodies are explained below. For each rigid body, the display status, ID number, name,
master node ID, and type is shown.

Disp
Indicates whether the rigid body is displayed in the graphics area.

ID
The ID number of the rigid body.

Title
The descriptive name of the rigid body.

Master Node
The ID of the node that serves as the master node of the rigid body.

Type
S or C. S indicates a simple rigid body, which is a typical spider formulation. C indicates a complex
formulation, such as an RBODY that points to a part or a set of sets.

Highlight individual entries or groups of entries to perform an action on the rigid body. Actions are
available from the context menu (by right-clicking over the table entries) or the tool bar buttons. These
actions are described below:

Table 177:

Icon Name Action

Review Options Customize the way the selected rigid bodies are displayed.
Options include transparency and auto-review selections.

Review Highlights the nodes to which the selected RBODY is attached.
The master node is shown in blue and the slave nodes are
shown in red.
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Icon Name Action

Find Attached Highlights the elements that are attached to the selected rigid
body.

Edit Modify the definition of the rigid body through the Rigid panel.

Card Edit Opens the RBODY card in the card editor.

Delete Deletes the selected rigid body.

Refresh Update the table of rigid bodies.

New rigid bodies can be created with the RBODY Manager. The following fields are available at the
bottom of the RBODY Manager tab, which enable you to supply all the basic data needed to create a
new RBODY. Nodes, parts, materials, properties, and GES can be used to define the slave nodes. Once
the RBODY is created, click refresh to list it in the table. Then you can select the RBODY to edit the
card image, display the RBODY, and so on.

Note:

• When a large number of slave nodes are attached to a master node, the connecting
lines are not displayed in the graphical model.

• The table of rigid bodies can be sorted by the ID, title, mater node, and type columns.

• Select Show Details from the context menu to display a summary of details about the
rigid body including the ID, name, master node ID, and number of slave nodes.

• Select Editable from the context menu to make the title column editable. When the
Title column is editable, you can modify the names of the rigid bodies.

Apply Initial Metric Macro
The Apply Initial Metric macro applies the initial metric to the current model for simulating the
inflation of airbags.

Refer to the PAM-CRASH documentation for details about using the initial metric.

Before using this macro, you must specify an .im file in the METRIC control card. This file specifies the
conditions of the airbag inflation.
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Figure 568:

When you click Apply Initial Metric, the macro applies the settings in the .im file to the currently-
loaded model and displays the inflation motion in the graphics area. When the execution is complete,
the macro creates a .log file named initial_metric.nodes that contains the NODAL information.

Organize Xlinks Macro
The XLINK Organizer macro can be used to move and arrange existing LINK type elements (PLINK,
ELINK, LLINK, SLINK) to existing components.

The macro contains the following options:

Table 178:

Option Description

Select element: Select the element type you want to work with.

Prefix: Filter the element results by the text you type in the adjacent text box. Click
Set to run the filter.
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The macro contains the following buttons:

Table 179:

Button Action

Makes only the selected elements visible in the graphics display.

Select a component/part to which the selected elements will be added.

Import a component from a PAM-CRASH 2G input file.

Move an XLINK Element to a Component
1. Select the type of link element from the Select element field.

The list of elements of that link type are listed in the table along with the parts with which they
are associated.

2. Click component to select a component to which you want to add the selected elements.

3. Click Apply.
The selected elements are added to the selected component.

MASS Manager Macro
Displays information about masses in the model.

The MASS Manager is a tool accessible in the PAM-CRASH 2G Tool menu. The MASS Manager
provides the following features in one convenient tab:

• Display all masses in the model

• Display individual masses

• Create new, and edit existing simple and advanced mass formulations

• View, find attached, and update details of individual MASS, though the Card Editor and the MASS
panel

Input Fields in the Show ID Ranges User Interface

The Show ID Ranges User Interface contains the following input fields:

Table 180:

Input Action

Existing Entity Types in
the Model

Select the entity type for which you want to have the ID range information.
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Input Action

SELECT
Displays a list of all entity types present in the model. You can select
a single entity or multiple entities.

all
Displays information for all the entities present in the model. Nodes
and elements are always selected.

Maximum Number of
Ranges

Provides the maximum number of ranges (default is 10) to be displayed
in the output file. If an entity has a larger number of ranges, it will be
truncated.

Display Id's Type Display either the used IDs for an entity or the free IDs for an entity. The
option to output free IDs is valid only when you choose Detailed for the
overview type.

Display Entity Type Select the method in which elements are written to the output file. You can
select either HM_entitytype or Element_type. Selecting Element_type
writes out elements according to the solver definition.

Overview Type Select an overview type.

Condensed
Only the overall maximum and minimum IDs and the total number of
ranges for each entity are displayed. In this case, free IDs will not be
displayed even if it is selected.

Detailed
Maximum and minimum IDs for each range number (subject to the
maximum number of ranges specified) is displayed along with the
corresponding range number. In this case, the overall maximum and
minimum IDs and the total number of ranges for that entity will also
be displayed at the beginning of the information related to the entity.

Id Info for Entities Specify whether you want the information for all the entities in the model or
only for the entities currently displayed.
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Input Action

Comment String for
Solver

Input a string/character that is placed at the beginning of each line in the
output file. This enables you to include the information in the solver deck for
further use.

Find Menu
The Find menu contains options that help you find and visualize data.

Temporary Nodes
CNODE Clr/All/Dis

Clr
Deletes all temp nodes from the model.

All/Dis
Finds CNODEs in the complete/displayed model and highlights the nodes as temp nodes.

Find Components
By Elems

Finds all components which have elements in the current (masked) display.

Rbody Visualization
All/Dis/Sel

Updates the rigid bodies definition by resolving the references to a GES (set/set of set) by
converting them into node lists and displaying the web on the screen.

All
Updates all rigid bodies.

Dis/Sel
Updates displayed or selected rigid bodies, respectively.

Find/Mask
Finds/Masks the respective entities. Review the buttons’ tool tips to see the full entity name.

Card Menu
The Card menu contains options that help display the PAM-CRASH 2G cards in an editor.

PAM-CRASH 2G Cards
PARTS

Shows the 1D, 2D, and 3D PART cards of the displayed components in a viewer.
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MATER
Shows the 1D, 2D, and 3D MATER cards of the displayed components in a viewer.

NSM
Shows the NSM cards of the displayed groups in a viewer.

CNTAC
Shows the CNTAC cards of the displayed groups in a viewer.

GROUP
Shows the GROUP cards of the displayed sets in a viewer.

HyperMesh Entities
Properties

Shows all properties cards of the displayed properties in a viewer.

Sensors
Shows all SENSOR cards of the displayed sensors in a viewer.

Loads
Shows all loads and load collectors cards of the displayed loads and load collectors in a viewer.

Curves
Shows all FUNCT cards of the model in a viewer.

Airbags
Shows all BAGIN and CHAMBER cards of the displayed control volumes in a viewer.

Sum Menu
The Sum menu contains options that execute the PAM-CRASH 2G summary templates and display the
resulting text file in a viewer.

Components All/Dis
Execute the components_txt summary and show the results for the complete/displayed model in a
viewer.

Materials All/Dis
Execute the materials_txt summary and show the results for the complete/displayed model in a
viewer.

Elements All/Dis
Execute the elements_txt summary and show the results for the complete/displayed model in a
viewer.

Center Of Gravity All/Dis
Execute the ctr_of_gravity_txt summary and show the results for the complete/displayed model in
a viewer.

Moment Of Inertia All/Dis
Execute the moment_of_inertia_txt summary and show the results for the complete/displayed
model in a viewer.
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Interfaces All/Dis
Execute the groups_txt summary and show the results for the complete/displayed model in a
viewer.

None Struct Masses All/Dis
Execute the nsmas_txt summary and show the results for the complete/displayed model in a
viewer.

Property ALL
Execute the property_txt summary and show the results for the complete/displayed model in a
viewer.

Sensors ALL
Execute the sensors_txt summary and show the results for the complete/displayed model in a
viewer.

M1 Menu
The M1 menu contains options that set the correct element or load type and enter the appropriate
HyperMesh panel.

PART/
3D/2D/1D/LINK

Enters the Components panel, selects the comps collector, and sets the correct card image.

MATER/
3D/2D/1D/LINK

Enters the Components panel, selects the mats collector, and sets the correct card image.

PLY_DATA
Enters the Components panel, selects the mats collector, and sets the correct dictionary.

Mass Elements
MASS

Sets the element type mass = to MASS and enters the Mass panel.

NSMASS
Enters the Interfaces panel and sets the card image to nsmas.

Constraints
RBODY

Sets the element type rigid = to RBODY and enters the Rigids panel.

NODCO
Sets the element type rigid = to NODCO and enters the Rigids panel.

RWALL
Enters the Rigid Walls panel and set the card image = to RWALL.
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CNTAC
Enters the Interfaces panel and sets the card image = to CNTAC.

TIED
Enters the Interfaces panel and sets the card image = to TIED.

Elements
BAR

Sets the element type 1dele = to BAR and enters the 1d Elems panel.

BEAM
Sets the element type beam = to BEAM and enters the Beams panel.

KJOINT
Sets the element type 1dele = to KJOIN and enters the1d Elems panel.

JOINT
Sets the element type 1dele = to JOINT and enters the 1d Elems panel.

SPRING
Sets the element type spring = to SPRING and enters the Springs panel.

SHELL
Sets the element type tria3 = and quad4 = to SHELL.

MEMBR
Sets the element type tria3 = and quad4 = to SHELL.

TRIA_C
Sets the element type tria3 = to TRIA_C.

SOLID
Sets the element type tetra4, pyramid5, penta6, and hex8 = to SOLID.

BSHELL
Sets the element type hex8 = to BSHEL.

Link Elements
PLINK

Sets the element type mass = to PLINK and enters the Mass panel.

ELINK
Sets the element type 1dele = to ELINK and enters the 1d Elems panel.

LLINK
Sets the element type 1dele = to LLINK and enters the 1d Elems panel.
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SLINK
Sets the element type tria3 = and quad4 = to SLINK.

M2 Menu
The M2 menu contains options that set the correct element or load type and enter the appropriate
HyperMesh panel.

Auxiliaries
FRICT

Enters the Components panel, selects the props collector, and sets card image = to FRICTION.

RUPMO
Enters the Components panel, selects the props collector, and sets card image = to
RUPTURE_MODEL.

SENSO
Enters the Sensors panel.

CURVES
Enters the Edit Curves panel and sets the radio button to modify.

Safety
SLIPR

Sets element type mass = to SLIPRING and enters the Mass panel.

RETRA
Sets element type mass = to RETRACTR and enters the Mass panel.

BAGIN
Enters the Airbag panel and sets the card image to BAGIN.

CHAMB
Enters the Airbag panel and sets the card image to CHAMBER.

GASPC
Enters the Components panel, selects the props collector, and sets card image = to GASPEC.

Plot Output
THNOD

Enters the Output Blocks panel and changes the type to nodes.

THELE
Enters the Output Blocks panel and changes the type to elements.
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SENPT
Sets element type mass = to SENPT and enters the Mass panel.

Nodals
FRAME

Enters the Systems panel.

NODE
Enters the Nodes panel.

INVEL
Sets load type velocity = to INVEL and enters the Velocity panel.

VEL3D
Sets load type velocity = to VEL3D and enters the Velocity panel.

RVE3D
Sets load type velocity = to REV3D and enters the Velocity panel.

ACC3D
Sets load type acceleration = to ACC3D and enters the Acceleration panel.

RDV3D
Sets load type velocity = to RDV3D and enters the Velocity panel.

RDA3D
Sets load type acceleration = to RDA3D and enters the Acceleration panel.

RAC3D
Sets load type acceleration = to RAC3D and enters the Acceleration panel.

BOUNC
Sets load type constraint = to BOUNC and enters the Constraints panel.

DIS3D
Sets load type constraint = to DIS3D and enters the Constraints panel.

DIS3DX
Sets load type constraint = to DIS3DX and enters the Constraints panel.

DIS3DM
Sets load type constraint = to DIS3DM and enters the Constraints panel.

RAN3D
Sets load type constraint = to RAN3D and enters the Constraints panel.

RDD3D
Sets load type constraint = to RDD3D and enters the Constraints panel.
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CONLO
Sets load type constraint = to CONLO and enters the Constraints panel.

Analysis by Keywords
LOADCOLS

Enters the Collector panel, switches the type to loadcols and sets the card image to INVEL.

Conn Menu
The Conn menu contains options that let you manage connectors in the model.

Connector Organize
ByPlinkPart

Organizes the connectors by the parts of the associated Plink elements.

Renumber
NodeID/Plink ID

Node ID
Renumber nodes for displayed plinks such that plinkId = plinkNodeId.

Plink ID
Renumber displayed plinks such that plinkId = plinkNodeId.

Connector Panel
Feabsorb/Quality/Realize

Enters the Connectors panel, and then fe absorb/quality/fe realize panel, depending on the
selected macro.

Find att to P(X)LINKs

Ces
Finds connectors attached to the displayed link entity.

Com
Finds all components attached to the displayed link entity.

Mcom
Finds all master components attached to the displayed link entity.

Scom
Finds all slave components attached to the displayed link entity.

Find att to CE

PL
Finds Plinks attached to the displayed connectors.

Com
Finds all components attached to the displayed connectors.
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Find att to Comps
Finds entities attached to the displayed components.

Find/Mask
Finds/Masks the entities depending upon the selected macros.

GES Macro
The GES macro displays a GES Browser that lets you manage sets in the model.

Because general entity selection is mapped as a set of sets in the PAM-CRASH 2G interface, the need to
manage the sets becomes more crucial for the effective and efficient handling of the model.

Functionalities included in the GES Browser

• Creating a set, group or GES

• Renaming sets

• Modifying sets (drag and drop facility is available)

• Reviewing sets

• Deleting sets

• Adding/deleting entities to sets

• Adding/removing keywords to/from GES (set of set)

• Adding ranges/comments to the sets

• Resolving ranges

• Reviewing as PAM-CRASH 2G card

• Changing the keyword (for example, ELE to DELELE)

• Filter the entities to be displayed in the browser. For example, you can only select sets of sets
or component sets for viewing.

• Filtering by ID and name is also possible. For example, if you enter 1-100; 200; 300-400 in
the Ids field, it will display all GES/Sets (including child items) with IDs 1 to100, 200 and 300
to 400. Similarly in the Name field, you can enter a keyword such as face and the browser
displays all items (including child items) whose name contains face.

• Selecting by name

• Finding and deleting empty GES

• Finding unused GES

• Resolving unresolved groups - This function is useful in case of assembling model from
different files. It may happen that the group referenced in first file is defined in second file.
In this case when first file is loaded, the group is imported as an unresolved group. When the
second file is also loaded, this utility can be used to resolve the unresolved group references.

• Creating/modifying interfaces

• Reviewing interfaces as contact surfaces

• Creating/modifying rigid walls

• Creating/modifying section forces

• Creating/modifying loadcols
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• Direct access to the card editor for interfaces, loadcols and components

DELNOD Card
The following parameters are available via the DELNOD card:

ELE

GRP

PART

NOD

SEG

EDG

ELE > NOD

PART > NOD

GRP > NOD

DELNOD

DELELE

DELPART

DELPART

DELGRP

DELELE > NOD

DELPART > NOD

DELGRP > NOD

When you add a set to the GES using drag and drop functionality of the browser, a new set is created
with the exact copy of the contents of the original set, therefore, the changes made to this new set are
local in effect but in case of adding a group to the GES, only a reference is made to the existing GROUP
definition. You can modify the GROUP by using the references also but there exist only one copy of the
group in the model. Therefore while modifying one of the references, you should always keep in mind
that this change will also affect all the other references to this group and the group itself is modified.
In case the group does not exist in the model, it is created. If you do not want to create the group,
instead use the functionality Unresolved Groups > Edit and add the group there. This will be exported
correctly.

You can also create a config file, which saves all information about various GES Browser options, such
as DisplayComments (Yes/No), DisplayRanges (Yes/No) and confirmChanges (Yes/No). Later on, this
config file can be used to restore these settings. By default, a config file (gesbrowser.cfg) is saved in
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the working directory for each session of the GES Browser and settings from this file are applied every
time the browser is built. These functionalities can be invoked from the buttons LoadCFG/SaveCFG.

Permas Utility Menu
The macros on the Permas Utility menu simplifies some common tasks for the Permas user profile.

The Permas Utility menu is loaded when you open the Permas user profile.

Convert Groups
Use the Convert Groups macro to convert element-based surfaces that were created in Abaqus to
Permas surfaces.

While in the Abaqus user profile, use the Contact Manager to create as many element-based surfaces
(*SURFACE, TYPE=ELEMENT) as needed. When finished, switch to the Permas user profile by clicking
Preferences > User Profile and select the Convert Groups macro. $SURFACE ELEMENTS are created
based on the contact surfaces identified in the model.

Currently, only *SURFACE cards defined on individual element IDs of shells or solids are translated. If a
surface is defined on sets, it will not be translated. Also, it is necessary to have face identifiers defined.

Example of Entities Converted

*SURFACE, NAME = surf_1, TYPE = ELEMENT
1, SPOS
*SURFACE, NAME = surf_2, TYPE = ELEMENT
2, S1

Example of Entities that will not Convert

**Element ID, but no face identifier given
*Surface, Name = surf_3, TYPE = ELEMENT
2,
**Surface definition based on element set
*Surface, NAME = surf_4, TYPE = ELEMENT
Element_set1, SPOS

Create an NLLOAD Card
To create an NLLOAD card, you must first create and edit a loadstep card.

When a loadstep is created, an NLLOAD card can be created by checking the NLLOAD checkbox in the
card image of the loadstep. The NLLOAD card defines the tabular load history for static or transient
analysis. To utilize the NLLOAD card, the LOADING option must be selected. LOADING is set as the
default. The card image lists all the load collectors currently assigned to the load step. Continue
following the steps to set the NLLOAD card time load history:

1. In the Card Editor, ensure that the Analysis Procedure toggle is set to LOADING.
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Figure 569:

2. Place a check next to NLLOAD.

3. Under TIME Selection, choose either TIME/LIST or TIME/dt.
If you select TIME/LIST, the load pattern is determined by individual values entered in the TIME
fields. It will set the iterations to a series of steps at specific points. If you select TIME/dt, you
can specify the time steps in the firLOAst dataline with the start value and increment value. All
subsequent datalines are automatically populated based on this information. The load history is
now set to a series of regular intervals.

4. Enter a value in the NoOfLPATS field.

This determines the number of load patterns (load collectors) you want to add to the NLLOAD
card.

5. Enter the value in the TimeSteps field in the upper part of the card image.

Figure 570:

6. For each TIME/STEP pattern created, enter values in the TIME fields to set the starting value and
the increment values.

7. For each TIME/dt pattern created, enter the starting value in the t field and the increment value in
the dt field.

The TIME fields are automatically populated.
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Figure 571:

Note:  For a better readablility on export, if the columns exceed the line length
(currently set to 80 characters), a new NLLOAD keyword is written. On import NLLOAD
will be written in this format but also if lines of each load pattern is continued with
ampersands.

8. Click return to close the Card Editor.
9. Click return to close the Load Steps panel.

Note:  On export, if the columns exceed the line length (currently set to 80
characters), the lines will be continued by an ampersand (&). This is also the format
the reader can understand from the .dat file only.

Use the PLOT NLLOAD Macro
You can use the PLOT NLLOAD macro on the Utility menu to draw the load history plots.

1. On the Utility menu, click Plot NLLOAD.

The load step just created is displayed and the values entered in the NLLOAD card are shown. You
can edit these values in the $NLLOAD table on the right side of the window, although you cannot
add new columns or new load collectors at this point.

2. Use the Display checkbox to turn the display of particular load steps on and off.
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Figure 572:

OptiStruct Utility Menu
The Utility menu for the OptiStruct user profile contains, in addition to the default Utility menus, three
pages (Summary, FEA and Opti) of specific utilities for OptiStruct.

The Summary page provides a short summary of the entities making up the model. The FEA page
is dedicated to modeling and load setup, while the OPTI page is devoted to optimization. The Utility
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menu is available on the Utility tab when the OptiStruct user profile is loaded. The Utility tab may be
activated/deactivated from the View menu.

Summary Page
The Summary page of the OptiStruct Utility menu lists a short summary using displayed or the
entire model for components, loads, elements, center of gravity, moment of inertia, responses and
constraints.

Figure 573: Summary of Components
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Figure 574: Summary of Elements

FEA Page
Macros available on the FEA page of the OptiStruct Utility menu.

I-DEAS to Radioss
The I-DEAS to Radioss converter utility converts an I-DEAS input file to an OptiStruct input file.

1. Select an I-DEAS file as the source file, or check the Use current HM model box to use the
model loaded in the current session.

2. Select a file name and location to save the OptiStruct file that will be generated, or check the
Apply to current HM session only box to generate the OptiStruct model in the current session.
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3. Click Convert.

Export in MDL
Use the Export in MDL utility to export body and joint definitions in the current database to a Model
Definition Language (.mdl) file that can be opened with MotionView.

Export Bodies and Joints Using the Export in MDL Utility
1. Enter a file name in the Save file as field or click  and, on the Save file pop-up window, choose

where to save the generated .mdl file.

2. Click Accept to export body and joint definitions to an .mdl file.

The Treat flexible bodies as rigid bodies checkbox controls the output of flexible bodies.
Flexible bodies may be exported as either rigid or flexible bodies (flexible body export is not
available at this time). The Use prescribed cog, mass and inertias where available checkbox
controls the output of cog, mass and inertia values for each body. If this checkbox is unchecked,
HyperMesh determines these properties for each body based on the model data. If this checkbox
is checked, the values defined on the parameters subpanel of the bodies panel, should they exist,
will be exported instead. The Select nodes for additional point definitions in MDL checkbox
allows nodes to be selected for which MDL point definitions will be exported to the file.
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Material Table
Use the Material Table utility to review and edit OptiStruct materials.

Figure 575:

Table 181:

Icon Description

Create new material

Refresh table

Toggles between table edit and table display mode

Filter table

Export table to CSV format

Select all

Select none

Reverse selection

Select displayed
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Icon Description

Delete selected

Component Table
The OptiStruct Component Table displays components and their associated attributes in an interactive
table.

The information displayed in the table may be configured.

Figure 576:

This utility also allows you to create components, assign materials to components, change component
colors, and change component visualization modes. Most actions are available either from shortcut
(right-click) menus or from the pull-down menus.

Before performing actions, such as changing the values of component data, you must select Editable
from the Table menu. Once the table is editable, you can modify the values of existing components. The
following sections describe how to use the component table in both read-only mode and editable mode.

Use the Component Table in Read-Only Mode
When you open the Component Table displayed components are listed in a table using a default
configuration. This configuration displays the name, ID number, type, thickness, material name,
material ID, material type, color, and visibility (display) for each displayed component.

The table may be adjusted to display information for all components by selecting Table > Configure >
Components > All.

The display of the Component Table can be customized according to your preferences. You can:
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• Change which columns are displayed

• Sort the components by column data, ascending or descending

• Filter which components are displayed based on column data values (see below)

You can save your settings by creating a configuration file. From the Table menu, open the Configure
sub-menu and select Save CFG-File. This configuration file saves the set of table configuration options
so you can use them again. By default, a configuration file (comptable.cfg) is saved in the working
directory for each component table session and settings from this file are applied each time the table is
built.

Use the Component Table in Editable Mode
When you switch the Component Table from the default read-only mode to editable mode by selecting
Editable from the Table menu, you can perform all the actions described in the section above, plus
edit the attributes of the components listed in the table. To change the value of an attribute, select the
attribute in the Assign Values drop-down, type the new value in the adjacent field, and click Set.

Property Table
The OptiStruct Property Table displays properties and their associated attributes in an interactive
table.

The information displayed in the table may be configured.

Figure 577:

This utility also allows you to create properties, assign materials to properties, and change property
colors. Most actions are available either from shortcut (right-click) menus or from the pull-down menus.
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Before performing actions such as changing the values of property data, you must select Editable
from the Table menu. Once the table is editable, you can modify the values of existing properties. The
following sections describe how to use the Property Table in both read-only and editable modes.

Use the Property Table in Read-Only Mode
When you open the Property Table, all properties are listed in a table using a default configuration.
This configuration displays the name, ID number, type, material name, material ID, material type, color,
number of elements and visibility (display) for each property.

The display of the Property Table can be customized according to your preferences. You can:

• Change which columns are displayed

• Sort the components by column data, ascending or descending

• Filter which components are displayed based on column data values (see below)

You can save your settings by creating a configuration file. From the Table menu, open the Configure
submenu and select the Save CFG-File option. This configuration file saves the set of table
configuration options so you can use them again. By default, a configuration file (comptable.cfg) is
saved in the working directory for each component table session and settings from this file are applied
each time the table is built.

Use the Property Table in Editable Mode
When you switch the Property Table from the default read-only mode to editable mode, by selecting
Editable from the Table menu, you can perform all the actions described in the section above, plus
edit the attributes of the properties listed in the table. To change the value of an attribute, select the
attribute in the Assign Values drop-down, type the new value in the adjacent field, and click Set.

Auto Contact
Use the Auto Contact tool to quickly and easily create one or more contact interfaces at once between
several parts of your model.

This tool's location on the Utility Browser is at Tools > Auto Contact and BCs > Create > Auto
Contact. This tool is only available when the OptiStruct user profile is loaded.

Based on a proximity distance, the Auto Contact tool will search throughout all of the selected
components and automatically create new Contact Surfaces and contact interfaces between them. All of
the contact entities found by the Auto Contact tool are displayed and organized inside a temporary Auto
Contact Browser, where you can review and adjust them as needed before accepting any changes.

Auto Contact creates OptiStruct CONTACT interfaces, with different type options as available from the
Type of Interface pull-down menu in the Auto Contact dialog. The selected Type of Interface will be
used as the initial configuration for all found interfaces. Afterwards, you can individually edit the type of
interface in the Auto Contact Browser.

Two contact surfaces are created as Master and Slave entities per contact interface, with the following
characteristics:

• Master and Slave surfaces are automatically assigned based on the average element size of each
Contact Surface:
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◦ The Contact Surface with the smallest, average element size will be assigned as a Slave, and
the other will be assigned as a Master.

◦ The Master and Slave assignments for each contact can be reviewed and swapped in the Auto
Contact Browser.

• For 3D element faces, the contact surface direction will point outwards from the solid body.

• For 2D elements, the contact surface direction will be assigned according to element normals,
which can be reviewed and reversed in the Auto Contact Browser.

Auto Contact Dialog
The Auto Contact dialog window contains the following options:

Table 182:

Option Description

Type of interface Creates CONTACT interfaces using three different types of interfaces:

SLIDE
Represents a zero-friction sliding contact.

STICK
Represents an infinite-friction sticking contact.

FREEZE
Represents a tied contact.

FRICTION
Represents a contact with friction using a static friction coefficient
(MU1).

Select components Directs you to the Component Selection panel, where you can select the
components to have the Auto Contact tool search through.

Proximity distance Generates contact pairs between components that are closer to each other
by less than the specified proximity distance.

Use shell thickness for 2D
elements

If activated, the shell thickness values will be used for 2D elements
instead of the specified Proximity distance. 3D elements will still use the
specified Proximity distance.

Max reverse angle Excludes elements in the contact when the angle between the normals of
two elements, or element faces within the proximity distance exceeds the
specified reverse angle value.

Default value is 15 deg.

Consolidate contact
patches between
component pairs

Select this checkbox to consolidate any separate contact patch areas
that participate in contacts between the same two components, so that
the final number of contacts in the model can be reduced. When turned
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Option Description

off (default), HyperMesh treats each contact patch area as a separate
individual contact pair.

Find Executes the Auto Contact search between all of the components in the
list.

Cancel Closes the Auto Contact dialog without applying changes.

Remove Selection Icon Removes the highlighted items from the selected components list. You can
use the Control and Shift keys to select multiple items in the list.

Review Selection Icon Highlights the selected items from the component table in the HyperMesh
graphics area, while graying out other components. You can use the
Control and Shift key to select multiple items in the list.

Right-click to return the model to normal display.

Help Icon Opens the Auto Contact online help.

Remarks
During the Auto Contact process, temporary components may be created for parts containing
3D elements. These temporary components will be named using a preceding ^ symbol, and will
automatically contain extracted element faces needed for the contact creation process. Auto Contact will
cleanup and remove these temporary components when you finish or cancel the process. If you decide
to export the model before accepting or canceling the process, HyperMesh will always exclude these
temporary components from export.

Auto Contact Browser
The Auto Contact Browser provides options for reviewing and modifying contact interfaces and surfaces
found by the Auto Contact tool.

This browser will automatically load in the HyperMesh tab area as part of the Auto Contact creation
process. All of the entities listed in this browser are temporary, and are not part of the model until
you click the Create button. Clicking Cancel will clear all of the temporary entities and close the Auto
Contact Browser, leaving your model unchanged. See Remarks below.
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Figure 578:

Auto Contact Browser Columns
The Auto Contact Browser contains the following columns:

Table 183:

Column Description

Name Lists the names of all of the contact interfaces and surfaces found by the
Auto Contact tool.

Underneath each contact interface name is the temporary master and slave
surfaces associated to that interface. Red indicates a slave surface, and blue
indicates a master surface.
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Column Description

Renaming entities, as well as Master/Slave surface swapping is possible via
the context menu.

Accept This checkbox defines whether or not a contact interface will be included in
the creation process once you click Create.

Color Color that will be assigned to the contacts and contact surface entities.

Type Type of CONTACT assigned to each contact interface.

Reverse Normal This checkbox defines whether or not the normal direction of the given
surface should be reversed or not. When OFF (default), surfaces on 3D
elements will be pointing outwards, and surfaces on 2D elements will point in
the direction of the element normal.

Context Menu
Right-clicking on an item in the Auto Contact Browser displays a context menu which offers options for
modifying the selected contact interface or surface.

Table 184:

Option Description

Rename Renames the selected entity.

Delete Deletes the selected items from the browser.

Swap Master-Slace Allows you to switch the contact surfaces identified as master and slave. When
executed, you will see the surfaces switch places in the master/slave positions
in the browser.

Edit Faces Opens the Element Selection panel, where you can manually add and remove
individual elements from a selected contact surface. Click Proceed when you
are finished.

Note:  Only available when selecting contact surfaces.

Also accessible via the Select Elements Manually icon .

Add by Adjacent Automatically adds all of the immediately adjacent elements to a selected
contact surface.

Note:  Only available when selecting contact surfaces.
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Option Description

Also accessible via the Add by Adjacent icon .

Add by Face Automatically adds all of the elements by face to a selected contact surface.
The feature angle controlling face detection tolerance can be modified inside
the Options dialog.

Note:  Only available when selecting contact surfaces.

Also accessible via the Add by Face icon .

Review Normal Allowed only for surfaces containing 2D elements. For surfaces containing
3D element faces, normal direction is automatically assigned in an outward
direction.

Accept All/None Automatically checks and unchecks the Accept checkbox for every item in the
Auto Contact Browser.

Reverse Reverses the Accept checkbox status for every item in the Auto Contact
Browser.

Expand/Collapse All Automatically expands and collapses every folder in the Auto Contact Browser.

Browser Icons and Other Controls
The Auto Contact Browser contains the following icons and controls:

Table 185:

Option Description

 Options Opens the browser's Options dialog. From this dialog you can enter a new
feature angle or customize the transparency for a selected entity. Click OK
when you are finished.

 Highlight Elements When this icon is turned on, the elements that belong to the currently
selected contact interfaces or surfaces are highlighted in the graphics
area. You can use the Ctrl and Shift keys to select multiple items from the
browser.

Highlight Elements is mutually exclusive and may be switched off. This
could be helpful when working with large models.

 Review Elements When this icon is turned on, the elements that belong to the currently
selected contact interfaces or surfaces are reviewed in the graphics area.
Elements are highlighted by color, while all other components are grayed
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Option Description

out. You can use the Control and Shift key to select multiple items in the
browser.

Review Elements is mutually exclusive and may be switch off. This could
be helpful when working with large models.

 Fit View to Elements Automatically zooms in on the elements that belong to the currently
selected contact interfaces or surfaces.

 Freeze Displayed

Components

When this icon is turned off (default), the graphics area will dynamically
update depending on the entities that are selected in the browser. When
turned on, the current display state will remain unchanged, even when you
change your selection in the browser.

 Display Components

with Elements

When this icon is turned on (default), the elements belonging to the
currently selected contact interfaces or surfaces are highlighted and
reviewed in the graphics area, while also displaying the components they
belong to. All of the other components are masked and will not display in
the graphics area.

 Display Only

Elements

When this icon is turned on, the elements that belong to the currently
selected contact interfaces or surfaces are highlighted and reviewed in the
graphics area, while masking everything else.

 Select Elements

Manually

Opens the Element Selection panel, where you can manually add and
remove individual elements from a contact surface. Click Proceed when
you are finished.

Also accessible via the context menu (Right-click > Edit Faces).

 Add by Adjacent Automatically adds all of the immediately adjacent elements to a selected
contact surface. Right-click the icon to undo one time.

Also accessible via the context menu (Right-click > Add by Adjacent).

 Add by Face Automatically adds all of the elements by face to a selected contact
surface. Right-click the icon to undo one time. The feature angle
controlling face detection tolerance can be modified inside the Options
dialog.

Also accessible via the context menu (Right-click > Add by Face).

 Recheck Opens the Auto Contact dialog, so that you can recheck the selected
interfaces.
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Option Description

When you select interfaces from the browser, the GUI will automatically
populate the components that the interaction was based on. This helps
modify an existing interface.

Remarks
During the Auto Contact process, temporary components may be created for parts containing
3D elements. These temporary components will be named using a preceding ^ symbol, and will
automatically contain extracted element faces needed for the contact creation process. Auto Contact will
cleanup and remove these temporary components when you finish or cancel the process. If you decide
to export the model before accepting or canceling the process, HyperMesh will always exclude these
temporary components from export.

Set Up an Auto Contact Run

1. From the menu bar, select Preferences > User Profiles.
The User Profile dialog opens.

2. Select OptiStruct as the profile name and click OK.

3. Open the Auto Contact dialog in one of the following ways:

• From the menu bar, select BCs > Create > Auto-Contact.
• From the menu bar, select Tools > Auto-Contact.
• From the Utility Browser, click the FEA page and select Auto-Contact under the Tools

section.

4. Click the Type of interface menu and then select the type of interface to create.

The type of interface selected here will be used as initial configuration for all found interfaces, but
can be individually edited afterwards in the Auto Contact Browser.

5. Next to Select components, double-click Component.
The Component Selection panel opens.

6. Click Comps then begin to select your components.

7. Click select.
The selected components will be automatically placed in the Components list inside of the Auto
Contact dialog.

8. Click Proceed.
The Auto Contact dialog re-appears.

9. In the Proximity distance field, enter a value for the proximity distance.

Contact pairs will be generated between components that are closer to each other by less than
this proximity distance.

10. In the Max reverse angle field, enter a value for the maximum reverse angle.

If the angle between the normals of two elements or element faces within the proximity distance
exceeds this value, the element will not be included in the contact. Default value is 15 deg.
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Figure 579: Definition of Proximity Distance and Maximum Reverse Angle

11. Click Find.
The status bar activates. Once it is complete, the Auto Contact Browser automatically opens.

12. Use the Auto Contact Browser to review all of the found interfaces and make any necessary
adjustments to contacts and contact surfaces. When you are finished, click Create.

Contact surfaces and contacts are created for all items marked as Accepted. Clicking Cancel will
close the Auto Contact Browser without creating any contacts.

Pretension Manager
Use the Pretension Manager tool to create and edit 1D and 3D pretension bolt loads and bolt sections
for the OptiStruct solver.

This tool's location on the Utility Browser is at Tools > Pretension Manager. This tool is only available
when the OptiStruct user profile is loaded.

For details on how the pretensioned bolt analysis works inside of OptiStruct, refer to Pretensioned Bolt
Analysis in the OptiStruct online help.

Pretension Manager Dialog
The Pretension Manager uses a table format to display all the bolt pretension loads in the model.
Each row represents a pretension load in the model, and each column represents the following:

Table 186:

Column Description Related OptiStruct
Card(s)

Bolt Type Displays the type of bolt the load is applied to. Can be
1D or 3D.

PRETENS
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Column Description Related OptiStruct
Card(s)

Bolt Id Displays the identification number of the Bolt Pretension
section the load is applied to.

PRETENS

EID/SURFID Displays the Element (1D) or Surface (3D) identification
number where the Bolt Pretension section is located.

PTFORCE, PTADJST

Load Type Allows you to review and edit the type of pretension
load, by selecting one of the following options from the
pull-down menu:

• Force

• Adjustment

Use the Control key to select and edit this field in
multiple rows at once.

Click OK or Apply to update the load types in the model.
Click Cancel to exit the Pretension Manager without
saving any changes.

PTFORCE, PTADJST

Allows you to review and edit the Load Collector where
the pretension load is organized in HyperMesh, by
selecting one of the following options from the pull-down
menu:

Select Existing
Takes you to the Load Collector Selector panel.

Create New
Automatically creates a new Load Collector with
the name prefix PRETENS_* to organize the load
into.

Use the Control key to select and edit this field in
multiple rows at once.

Click OK or Apply to update the load types in the model.
Click Cancel to exit the Pretension Manager without
saving any changes.

PTFORCE, PTADJST

Load Id Displays the HyperMesh internal identification number of
the individual loads.

Load Magnitude Allows you to review and edit the pretension load
magnitude.

Use the Control key to select and edit this field in
multiple rows at once. Enter a new value and press
Enter to apply the changes to all of the selected rows.

PTFORCE, PTADJST
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Column Description Related OptiStruct
Card(s)

Click OK or Apply to update the load types in the model.
Click Cancel to exit the Pretension Manager without
saving any changes.

Orientation (Optional) Allows you to review and edit the
determination type of the normal direction of the bolt
pretension section, by selecting one of the following
options from the pull-down menu:

Blank
Solver default

AUTO

GRIDS
Takes you to a G1,G2,G3 node selection dialog.

VECTOR
Takes you to the Direction Selector panel.

CID
Takes you to the System Selector panel.

The Orientation type value will be updated in the model
immediately after editing the selection.

Output DOF ID (Optional) Allows you to review and edit the SPOINT
that contains the pretension deformation and load, by
selecting one of the following options from the pull-down
menu:

Select Existing
Takes you to the Node Selector panel.

Create New
Automatically creates a new SPOINT and assigns it
to the bolt pretension section.

Use the Control key to select and edit this field in
multiple rows at once.

The Output DOF ID value will be updated in the model
immediately after editing selection.

PRETENS
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The Pretension Manager dialog contains the following buttons:

Table 187:

Button Description

Add 1D Bolts Allows you to create one or more 1D Bolt Pretension sections.

To add a 1D Bolt Pretension section:

1. Click Add 1D Bolts.

The Element Selector panel opens.

2. Select one or more beam, bar or rod elements.

3. Click Select.
4. Click Proceed.

The individual 1D Bolt Pretension sections will be created for each selected
element.

Add 3D Bolts Allows you to create one or more 3D Bolt Pretension Sections. Two options are
available when you click Add 3D Bolts:

• Choose Select Existing Surface to open the Contact Surface Selector panel,
where you can select existing surfaces. Once you click Select and Proceed,
the individual 3D bolt Pretension Sections will be created for each selected
contact surface.

• Choose Create New Surface to open the Contact Surface Create (solid
faces) panel, where you need to select elements and face nodes to create the
surface for the bolt pretension section, as depicted in the images below.

Step 1:
Select elements on one side of the bolt:

Figure 580:

Step 2:
Select nodes on the section face:
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Button Description

Figure 581:

When you are using the Create New Surface option, a default name will be
automatically assigned in the panel using the prefix PRETENS_* and the
appropriate card image. Once you click Create and Return, you will be brought
back to the Pretension Manager. The Pretension Manager will now display a
3D Bolt Pretension section for the new contact surface.

Add Load Allows you to add a new pretension load to an existing Bolt Pretension section.

To add a new pretension load to an existing

1. Click the checkboxes in the first column for the Bolt Pretension section that
you want to add a new load to.

2. Click Add Load to add the new load to the selected Bolt Pretension section.

The new load will be added directly below the section you wanted to add the
new load to, and organized using a hierarchical tree-like display fashion.

Bolt Pretension section:

Example
The model below has four Bolt Pretension sections with IDs 1, 2, 3 and
4, and the pretension Force loads of 9500, 10000, 11500, and 9000 are
applied to them, respectively.

Figure 582:

An additional pretension Adjustment load of 0.1 needs to be applied to
Bolt Sections 3 and 4 only. To do this, you must select the checkboxes

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Browsers p.1605

Button Description

for sections 3 and 4 (as shown above), and then click Add Load. One
additional pretension load is added below each of the selected bolt sections.

Figure 583:

Looking at the left side of the table, it is easy to see that there are only four
Pretension Bolt sections in the model, however, some of them have more
than one pretension load applied to them.

In this example, the Force loads on all bolts are organized into Load
Collector PRETENS_1, while the Adjustment loads on Bolts 3 and 4 are
organized into a different Load Collector PRETENS_2, which allows them to
be used in a different Load Step if desired.

Delete Deletes the selected bolt pretension sections and/or pretension loads.

To delete selected bolt pretensions section:

1. Click the checkboxes in the first column for the rows you wish to delete.

2. Click Delete.

When a Bolt Pretension section has more than one load applied to it, deleting the
bolt section at the top level will automatically delete all the loads applied to it.
On the other hand, deleting single additional loads will only remove the selected
loads.

Review Allows you to graphically review the Element/Surface, Load, and SPOINT assigned
to the selected Bolt Pretension section. This button also displays more detailed
information about the selected Bolt Pretension section's Orientation.

To review a Bolt Pretension selection:

1. Click checkboxes in the first column for the Bolt Pretension section you wish
you review.

2. Click Review.

The Review Pretension dialog opens.

3. Click OK in the Review Pretension dialog to return to the Pretension
Manager dialog.

Select All Select all rows in the table.
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Button Description

Select None Deselect all rows in the table.

Select Reverse Reverses row selection in the table.

View Controls the Pretension Manager table's view organization mode. There are two
options available from the pull-down menu:

• Choose By Bolt (default) to apply multiple loads to the same Pretension Bolt
section are displayed directly below it, organized using a hierarchical tree-like
display structure.

Figure 584:

• Choose All to apply multiple loads to the same Pretension Bolt section are
displayed directly below it, using a flat display structure with no hierarchical
organization. The Bolt Pretension section's Type and ID are displayed for all
pretension loads in the model.
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Load Collector Table
Use the Load Collector Table utility to review and edit OptiStruct load collectors.

Figure 586:

Table 188:

Icon Description

Refresh table

Toggles between table edit and table display mode

Filter table

Proprietary Information of Altair Engineering

Export table to CSV format

Select all

Select none

Reverse selection

Select displayed

Delete selected



Altair HyperMesh 2019 Users Guide
Browsers p.1608

Buckling
The Buckling utility allows a buckling subcase to be defined simultaneously with its referenced static
subcase.

1. Enter a name.

2. Provide data for V1, V2 (upper and lower limits for eigenvalue calculation) and/or ND (number of
modes to be calculated).

3. Select appropriate load collectors for LOAD and SPC references.

Only load collectors containing valid loads are displayed in the drop-down menus.

4. Click Create.
The EIGRL load collector is created. The static and buckling load steps are also created.

Opti Page
Macros available on the Opti page of the OptiStruct Utility menu.

Topology
Generate Voxelmesh

Creates voxels (hexa elements) from closed shell meshes.

Hex-core
Creates hybrid mesh for closed volume. The core portion of the volume will be meshed with hex
elements, clearance between boundary and hex mesh will be meshed with BL + tetramesh +
pyramid coupling.

Design Space
Shortcut to the Topology panel.

Proprietary Information of Altair Engineering

Matfrac
Setup a material fraction topology optimization.

Reg. Volfrac
Create regional volfrac responses combining several components, properties or materials.

Topography
Design Space

Shortcut to the Topology panel.

Shape
Create Shapes

Shortcut to the HyperMorph panels.

Shape Variables
Shortcut to the Shape panel.
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Size
Size Variables

Shortcut to the Size panel.

PBAR, PROD Opti.
Define size optimization for multiple PBAR or PROD sections.

CBAR, CROD Opti.
Define size optimization for multiple CBAR or CROD elements with circular section.

Optimization Info
Design Variables

Create, review and edit Size (including Gauge) and Shape Design Variables.

Design Constraints
Review and edit optimization constraints.

Solution
OptiStruct

Shortcut to the OptiStruct panel.

OSSmooth
Shortcut to the OSSmooth panel.

OSSmooth Volume
Compute the volume enclosed by iso-density surface (Elements Displayed)
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After running OSSmooth this helps you to compute the true volume of the geometry recovered.
The iso-surface must be displayed as elements. Use Nastran or STL format when running
OSSmooth.
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Generate Voxelmesh
Fill an enclose volume with voxels (hexas) of a predefined size.

Available for the OptiStruct user profile on Windows, LINUX, IRIX, HPUX and SUN.

This type of mesh is only useful in topology optimization. It does not give meaningful results in a stress
analysis.

To work properly, the volume must be enclosed completely by shell elements (quads and trias) without
T-Connections or free edges. The normals of these elements should point inwards. The voxels (hexa
elements) are stored in the component called hexas.

1. On the Opti page of the Utility menu, under Topology, click Voxelmesh.
A comps collector displays in the panel area.

2. Select components that contain shell elements enclosing one volume.

If more than one volume is selected, normals should be adjusted manually.

3. Click proceed.
The Voxelmesh dialog is launched.

4. Check the relevant boxes.

Option Description

Perform element check Checks for T-connections and free edges. If some are found,
the results are stored in collectors of the corresponding
names.

Adjust normals Automatic adjustment of normals (to inward). This works if
the selection is one connected volume only. The volume may
contain internal voids.

Fill undercuts Areas that are hidden in each coordinate direction are filled
even if they are not touching the enclosed volume. These
elements are stored in the component called hexasfill.

One component for each
number of inner nodes

The voxels created are stored in nine components (hexas0,
hexas1...) depending on the number of nodes that are inside
the volume.

Note:  Zero inner nodes may occur if one edge of
the volume intersects the center of a hexa-face.

Use local coordinates Allows selecting a coordinate system along which to align
the mesh. If no selection is made, the global (basic, screen)
coordinate system is used.
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Option Description

Edge size for hexa elements Choose from Cubes or Rectangles. For cubes, enter a single
value for the edge size; for rectangles enter x, y, and z edge
lengths. Keep in mind that a grid of nodes is created for the
box wrapping the volume, so the memory usage may be high
for unreasonably small values.

5. Click Start.
6. If you checked the Use local coordinates box, you will be prompted to select a coordinate system.

Select the system and click proceed.
The voxelmesh is generated.

Matfrac
Use the Material Fraction optimization utility to set up an optimization problem to minimize the
combined compliance index and constrain the volume fraction to be less than a user-defined value.

1. Click Matfrac.

2. Enter a matfrac value.

3. Click calculate.
The objective is set to minimize COMB for the entire model, while constraining the VOLFRAC for
the entire model to be less than the MATFRAC value entered.

Reg. Volfrac
The Reg. Volfrac utility creates a regional volume fraction response for a number of components,
properties or materials.

1. Click Reg. Volfrac.
You are prompted to select a number of components, properties or materials.

2. Select the entities.

Volume responses are generated for each entity (vol#). An equation is then created to calculate
the total volume fraction over the entire region. A function response is generated using the
equation with reference to the volume responses.

PBAR, PROD Opti.
Use this utility to set-up size optimization for multiple PBAR or PROD properties.

1. Click PBAR, PROD Opti.
You are prompted to select a number of properties.

2. Select properties.

3. Select either a PBAR or a PROD card and a section type.
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4. Enter initial values and bounds.

5. Click calculate.
Depending on the cross section, a number of design variables, equations, and DVPREL2 cards are
generated.

CBAR, CROD Opti.
Use this utility to setup size optimization for multiple CBAR or CROD elements.

1. Click CROD, CBAR Opti.
You are prompted to select 1D elements for topological optimization.

2. Select elements.

3. Select PBAR or PROD.
A new PBAR or PROD property is created for each 1D element selected. These properties are
called DPROP#. A size design variable is created for each 1D element selected.

4. Input the initial value and upper and lower limits for this variable.

The design variables are called DV#. These design variables represent the cross-sectional area of
each 1D element.

A DVPREL1 card is created linking each of the DV#’s to the cross-sectional area of each DPROP#
card. These are called DX#.

For simplicity, assume the 1D elements have solid, circular cross-sections. Two equations are
created to calculate the I and J values if the PBAR property type is chosen:

a) Equation for Ix and Iy values : Y(X1) = 0.0796*X1**2

b) Equation for J values: Y(X1) = 0.1592*X1**2

A DVPREL2 card is created for the I1 value of each DPROP#, referencing equation (a) and the
appropriate design variable. These are named DA#.

A 2nd DVPREL2 card is created for the I2 value of each DPROP#, referencing equation (a) and the
appropriate design variable. These are named DB#.

A 3rd DVPERL2 card is created for the J value of each DPROP#, referencing equation (b) and the
appropriate design variable. These are named DC#.

A 3rd equation is created to calculate the regional volume fraction for all DPROP# properties:

Y(X1,Xi,....,Xn) = (X1+Xi+....+Xn)/(X1o+Xio+...+Xno)

where Xi is the value of DVi, and where Xio is initial value of Xi.

A function response, called BVFRAC, is generated using this equation and referencing all design
variables.
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Design Variables
Use the Design Variables utility to review and edit OptiStruct size, including gauge, and shape design
variables.

All DESVAR design variables are listed in the table.

Figure 587:

Table 189:

Icon Description

Create new design variables

Refresh table

Toggles between table edit and table display mode

Filter table

Export table to CSV format

Select all

Select none

Reverse selection
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Icon Description

Select displayed

Delete selected

Create a Design Variable

1. Click .

The Create Design Variable dialog opens.

2. Fill in the fields as desired.

3. Click Create.

Edit a Design Variable

1. In the table, click the Initial Value, Lower Bound or Upper Bound field of a design variable.

2. Replace the current value with the desired value.

3. Press the Enter key.
The design variable is updated.

Design Constraints
Use the Design Constraints utility to review OptiStruct optimization constraints.

All optimization constraints are listed in the table.
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Figure 588:

Table 190:

Icon Description

Refresh table

Toggles between table edit and table display mode

Filter table

Export table to CSV format

Select all

Select none

Reverse selection

Select displayed

Delete selected
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Visualization Controls
Use the Visualization controls to change many of the visual states in HyperMesh and HyperView.

To access the Visualization controls, click  on the Display toolbar. There are nine different types of

visualization controls:

Connectors
Connector size

Specify a size (in model units) to display connectors in the graphics area.

Color by
Select a Color by scheme (State, Layer, Style, or Component) to change how connectors are
color-coded in the graphics area. You cannot change the colors of each individual item within a
scheme, but you can change what items display. Select or clear the check boxes next to each item
to turn them on and off in the scheme.

Figure 589:
Colors are locked, but clearing an item's check box hides it in the graphics area.

The Color by schemes and their corresponding color items include:

State
Realized, Unrealized, Failed, and Modified

Layer
< 2t, 2t, 3t, > 3t

Style
Apply mass, area, bolt, seam, spot

Component
HyperMesh colors the Connectors based on the color of the component axis they exist in.

State/Layer/Style
HyperMesh only displays the connectors that match the selected checkboxes in the graphics area.
If you clear a checkbox, HyperMesh removes the connectors that match that criteria from the
graphics area. You can use any combination of check boxes at a time.

Cylinder Bolts
Change the display of cylinder bolts in the graphics area using the following controls:

Cylinder transparency
Move the slider to change the level of transparency of cylinder bolts in the graphics area.
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Display status
Toggle the Display status on and off to show or hide cylinder bolts in the graphics area.

CWELDS
Change the display of CWELD defined connectors in the graphics area by switching the CWELD
visualization to on.

Figure 590:

The graphical representation reflects the CWELD definition, and points directly from the connector
to the referenced nodes, nodes of referenced elements, or referenced properties. The graphical
representation is always shown in the appropriate CWELD component color.

Certain CWELD manipulations are not automatically synced. Editing the solver card or organizing
the element into a new component requires you to reactivate the CWELD visualization.

Constraints
Constraint labels

Select this checkbox to display labels on constraint entities in the graphics area.
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Relative constraint size
Specify how large, in model units, constraints are displayed relative to the model size.

Equations
Equation Handles

Select this checkbox to display the handles on equations in the graphics area.

Loads
Template labels (type)

Select this checkbox to display template-specific labels on loads in the graphics area. If you clear
this checkbox, HyperMesh will display general HM labels on loads.

Load labels
Select this checkbox to display the labels of load entities (forces, moments, pressures,
accelerations, velocities, temperatures, fluxes) in the graphics area.

Change load vector (tip/tail) at application point
Select this checkbox to point the load vector away from the load application point (tail) when
the tip of the load vector is attached to the load application point. If you clear this checkbox,
HyperMesh points the load vector toward the load application point (tip) when the tail of the load
vector is attached to the load application point.

Note:  The direction of the vector does not change when you select this option.

Load size
Specify a size (in model units) to display load entities in the graphics area. Use the toggle to
select relative size or Uniform to control the size of load entities. Select Relative size to displays
loads relative to the model size (default 100), or select Uniform to apply a constant size.

Morphing
Handle Size

Specify a size (in model units) to display morphing handles in the graphics area.

Symmetry Size
Specify a size (in model units) to display morphing symmetries in the graphics area.

Colors
To change how morphing domains, faces, volumes and symmetries are color-coded in the
graphics area, click the color boxes and select a new color from the color selector.

Morph volume edges, Edge points
Specify how many points each morph volume edge will use to represent curves in the graphics
area. Use larger numbers for smoother curves and smaller numbers for faster rendering.

Morph volume faves
Use these options to choose how HyperMesh draws the flat faces of morph volumes in the
graphics area:

Wireframe
Face has no color at all; only the morph volume edges and handles are drawn.
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Transparent
(1, 2, or 3) means that the faces are drawn semi-opaque; higher numbers mean more
opacity.

Opaque
Sets the morph volumes’ transparency to zero.

Systems
Relative system size

Specify how large, in model units, systems are displayed relative to the model size.

Tags
Push tags to foreground

Select this checkbox to push all of the active tags to the foreground in the graphics area. If the
entity the tag is attached to is visible in the graphics area, then HyperMesh will also display the
tag. If the entity is not visible in the graphics area, then HyperMesh will hide the tag completely.

Tag text
From the Tag text list, select what type of text to display with the tags in the graphics area. You
can choose from the following: only the Label, only the Body, both (Label:Body), or Description.

Tag icon
From the Tag icon list, select how to display the tag icons in the graphics area. You can choose
from the following: Text Only, Text and Icon, or Icon Only.

Topology
Show line directions

Select this checkbox to display graphics on line entities in the graphics area to indicate the
direction of the line.

Edges/Shaded faces on solid
Control the color-coding of the respective entities in the graphics area, and the display of those
entities that match the selected criteria. The changes you make to the color options will only
apply when used within the relevant geometry shading and color modes.

Solid transparency
Move the slider to change the level of transparency of the solid entities in the graphics area when
they are used within the relevant geometry shading and color modes. The higher the number, the
more transparent the solid entities appear.

Mappable solids
Control the color-coding of mappable solids when used with the relevant geometry shading and
color modes.

Vectors
Vector Handles

Select this checkbox to display handles on vector entities in the graphics area.

Vector labels
Select this checkbox to display labels on vector entities in the graphics area.
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Vector size
Specify a size (in model units) to display vector entities in the graphics area. Use the toggle to
select Vector size % or Uniform to control the size of vector entities. Select Vector size % to
use a percentage of the actual length of the vector to determine the size, or select Uniform to
apply a constant size.
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Geometry

Create and edit geometry.

This chapter covers the following:

• Geometry Settings  (p. 1622)

• Create, Edit, Query Geometry  (p. 1624)

• Dimensioning  (p. 1642)

• Extract and Edit Midsurfaces  (p. 1662)

• Match Topology  (p. 1680)

• Find Intersections and Penetrations  (p. 1682)

• Setup CAD Models with Metadata  (p. 1684)
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Geometry Settings
Overview of settings used when creating and editing geometry.

CAD Cleanup Tolerance
The CAD cleanup tolerance is used to determine if two surface edges are the same and if two surface
vertices are the same.

CAD cleanup tolerance controls:

• The determination of if two surface edges are close enough to be automatically combined (creating
shared edges)

• If a surface is degenerate and should be removed

If you use the automatic setting, the complexity of the surface and edge geometries are taken into
account and a tolerance is selected to maximize the number of shared edges. To specify a manual
cleanup tolerance value, it must be greater than the default value. The readers only modifies data if the
data stays within the original data tolerance.

Increasing the tolerance may cause problems. When this value is modified, any features equal to or
less than the tolerance are eliminated. The readers do not include any edge with a length less than the
tolerance; if there are edges present that are important to the surface, that surface will be distorted, or
will fail to trim properly. Similarly, surfaces smaller than the tolerance may not be imported.

If the file you have read has many very short edges, it may be worthwhile to reread the file using
a larger tolerance. The same holds true if surfaces appear to be "inside out" when surface lines are
displayed.

The tolerance value should not be set to a value greater than the node tol used for your element mesh,
set in the Options panel.

Geometry Cleanup Tolerance
Geometry cleanup tolerance specifies how much the geometry can be modified in the course of cleaning
it, either manually or automatically. Cleaning up refers to fixing geometry data by creating proper
topology, defeaturing, and eliminating extraneous vertices.

Since the geometry is approximated with a finite element mesh, a cleanup tolerance that is less than
the node tolerance used in the mesh generation is required.
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The tolerance value should not be set to a value greater than the node tol used for your element mesh,
set in the Options panel.

Geometry Feature Angle
Geometry feature angle determines when model geometry should have a new vertex added (creating
two surfaces from one) or removed (merging two surfaces into one).

The angle is measured between the positive normal faces of adjacent geometric entities.
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Create, Edit, Query Geometry
Create, edit, and query various geometric features, such as nodes, points, line, and surfaces.

Figure 591:

Nodes
Nodes are the most basic finite element entity. A node represents a physical position on the structure
being modeled.

A nodes is used by an element entity to define the location and shape of that element. It is also used as
temporary input to create geometry entities.

A node may contain a pointer to other geometric entities and can be associated directly to them.

Nodes are considered to be used if they are referenced in the definition of an element, system, vector,
group, load, equation, or are referenced by any card image on any HyperMesh entity. Unused nodes and
any loads that are attached to unused nodes are automatically deleted .

Nodes can not be organized into components. Nodes can also be organized into HyperMesh include files,
which defines the solver include file they will be exported to.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Geometry p.1625

A node as displayed a small circle or sphere, depending on the mesh graphics mode. Its color is always
yellow.

Create Nodes

• xyz - Creates by specifying (x,y,z) coordinates (Nodes panel).

• on geometry - Creates at graphically selected locations on points, lines, surfaces and planes (Nodes
panel).

• arc center - Creates nodes at the center of the arc that best approximates the input set of nodes,
points or lines (Nodes panel).

• extract parametric - Creates nodes at parametric locations on lines and surfaces (Nodes panel).

• extract on line - Creates evenly spaced or biased nodes on a selection of lines (Nodes panel).

• interpolate nodes - Creates evenly spaced or biased nodes by interpolating between existing nodes
in space (Nodes panel).

• interpolate on line - Creates evenly spaced or biased nodes by interpolating between existing nodes
on a line (Nodes panel).

• interpolate on surface - Creates evenly spaced or biased nodes by interpolating between existing
nodes on a surface (Nodes panel).

• intersect - Creates nodes at the intersection of geometric entities: lines/lines, lines/surfaces, lines/
solids, lines/planes, vector/lines, vector/surfaces, vector/solids and vector/plane (Nodes panel).

• temp nodes - Creates nodes by duplicating existing nodes or creating nodes on existing geometry
or elements (Temp Nodes panel).

• circle center - Creates nodes at the center of the circle defined by exactly three nodes (Distance
panel).

• duplicate - Creates nodes by duplicating existing nodes. This is available in many panels when the
"duplicate" advanced entity selector is available on a nodes input collector.

• on screen - Creates nodes by pre-selecting existing geometry or elements and clicking on the
locations to create the nodes. This is available in any panel that has a node or node list input
collector (Picking nodes on geometry or elements).

• Misc. API commands that do not have an associated panel.

Edit Nodes

• clear - Deletes temp nodes (Temp Nodes panel).

• associate - Associates nodes to fixed points, surface edges and surfaces by moving them onto
those entities (Node Edit panel).

• move - Moves nodes along surfaces (Node Edit panel).

• place - Places nodes on a surface at a specified location (Node Edit panel).

• remap - Moves nodes by mapping them from one line or surface edge to another (Node Edit panel).

• align - Aligns/projects nodes to an imaginary line (Node Edit panel).

• find - Create temp nodes by finding FE nodes associated with other FE entities (Find panel).
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• translate - Moves nodes along a vector direction (Translate panel).

• rotate - Rotates nodes about a vector axis (Rotate panel).

• scale - Scales the dimensions of nodes either proportionally or uniformly (Scale panel).

• reflect - Reflects nodes about a plane to create a mirror image (Reflect panel).

• project - Projects nodes onto a plane, vector, line/surface edge or surface (Project panel).

• position - Translates and rotate nodes into new positions (Position panel).

• permute - Switches the coordinates of nodes (Permute panel).

• renumber - Renumbers nodes (Renumber panel).

• Misc. API commands that do not have an associated panel.

Query Nodes

• card editor - With an appropriate template loaded, the card editor can be used to review node
information (Card Editor panel).

• distance - Finds the distance between two nodes (Distance panel).

• shortest distance - Finds the shortest distance between entities (Shortest Distance dialog).

• angle - Finds the angle between three nodes (Distance panel).

• organize - Moves nodes into different include files (Organize panel).

• numbers - Displays the IDs of nodes (Numbers panel).

• count - Counts the total or displayed nodes (Count panel).

• Misc. API commands that do not have an associated panel.

Supported Solver Cards
Solver cards supported for nodes.

Abaqus

Card Description

*NFILL Generates nodes for a region of a mesh by filling
in nodes between two bounds.

Note:  Resolved to individual entities
on import, and are written back on
export the same way.

*NGEN Generates nodes incrementally.
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Card Description

Note:  Nodes can only be created
incrementally between two nodes.

Nodes generated along a parabola or
curve are not supported (LINE=P or C
parameter is not supported).

SYSTEM parameter is currently
unsupported.

Resolved to individual entities on
import, and are written back on export
the same way.

*NODE Defines nodal coordinates.

Note:  The SYSTEM parameter is
created automatically during export
based upon the type of reference
coordinate system that is assigned to
the nodes.

The card image for a node is displayed
in global Cartesian coordinates in
HyperMesh.

ANSYS

Card Description

N Defines a node.

N Defines a node.

N Defines a node.
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Card Description

NBLOCK Defines a node.

EXODUS

Card Description

NODE

LS-DYNA

Card Description

*NODE Defines a node and its coordinates in the global
coordinate system.

Note:  Card can be previewed, but not
edited.

*NODE_RIGID_SURFACE Defines a rigid node and its coordinates in the
global coordinate system.

Note:  Card can be previewed, but not
edited.

Nastran

Card Description

GRID Defines the location of a geometric grid point, the
directions of its displacement, and its permanent
single-point constraints.

Note:  Permanent single point
constraint field supported for feinput
only. On export, equivalent SPC cards
are output.

SPOINT Defines scalar points.
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Card Description

Note:  Supported the same way GRID
is supported. On import or export,
all nodes that are designated to be
SPOINT will be converted to nodes at
the origin.

OptiStruct

Card Description

GRID Defines the location of a geometric grid point
of the structural model, the directions of its
displacement, and its permanent single-point
constraints.

Note:  Bulk Data Entry

Exported in large field format by the
optistructlf template.

SPOINT Defines sets of single-point constraints, enforced
displacements for static analysis, and thermal
boundary conditions for heat transfer analysis.

Note:  Bulk Data Entry

Ideally a scalar point has no location,
but in HyperMesh it is represented as
a node.

PAM-CRASH

Card Description

CNODE/ Defines a common node.

NODE/ Defines a node.
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Note:  Use the find_cnodes summary template to highlight all CNODE nodes as temporary
nodes.

Permas

Card Description

$COOR Defines nodal points and their coordinates.

Radioss

Card Description

/CNODE Defines the coordinate of common node, which
could be merged to the nearest selected NODE or
CNODE.

Note:  Block Format Keyword

/NODE Defines the coordinate of node, which is
fundamental unit of graphic in structure.

Note:  Block Format Keyword

Samcef

Card Description

.NOE Defines the coordinates of the nodes of the
structure.

Points
A point is a zero-dimensional geometric entity.

A free point is a zero-dimensional geometry entity in space that is not associated with a surface. It is
displayed as a small "x", and its color is determined by the component collector to which it belongs.
These types of points are typically used for weld locations and connectors.
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A fixed point is a zero-dimensional geometry entity that is associated with a surface. It is displayed as
a small "o", and its color is determined by the surface to which it is associated. The automesher places
a node at each fixed point on the surface being meshed. A fixed point that is placed at the junction
of three or more non-suppressed edges is called a vertex or vertex point. Such vertices cannot be
suppressed (removed).

Create Points

Create Free Points

• xyz - Creates free points by specifying (x,y,z) coordinates (Points panel).

• arc center - Creates at the center of the arc that best approximates the input set of nodes, points
or lines (Points panel).

• extract parametric - Creates free points at parametric locations on lines and surfaces (Points
panel).

• intersect - Creates free points at the intersection of geometric entities: lines/lines, lines/surfaces,
lines/solids, lines/planes, vector/lines, vector/surfaces, vector/solids and vector/plane (Points
panel).

• suppressed fixed points - Creates free points at suppressed fixed point locations (Point Edit panel).

• circle center - Creates free points at the center of the circle defined by three free or fixed points
(Distance panel).

• duplicate - Creates free points by duplicating existing free or fixed points. This is available in many
panels when the "duplicate" advanced entity selector is available on a points collector.

• Misc. API commands that do not have an associated panel.

Create Fixed Points

• by cursor - Creates fixed points at cursor locations on surfaces and surface edges (Point Edit panel,
Quick Edit panel).

• on edge - Creates fixed points at uniform locations on a surface edge (Point Edit panel, Quick Edit
panel).

• on surface - Creates fixed points at existing node/free point locations on/near a surface (Point Edit
panel).

• project - Creates fixed points on surface edges by projecting existing free or fixed points (Point Edit
panel, Quick Edit panel).

• defeature pinholes - When defeaturing pinholes, fixed points are created at the center of the each
removed pinhole (Defeature panel).
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• Misc. API commands that do not have an associated panel.

Edit Points

Edit Free Points

• delete - Deletes free points (Delete panel).

• translate - Moves free points along a vector direction (Translate panel).

• rotate - Rotates free points about a vector axis (Rotate panel).

• scale - Scales the dimensions of free points either proportionally or uniformly (Scale panel).

• reflect - Reflects free points about a plane to create a mirror image (Reflect panel).

• project - Projects free points onto a plane, vector, line/surface edge or surface (Project panel).

• position - Translates and rotate free points into new positions (Position panel).

• permute - Switches the coordinates of free points (Permute panel).

• renumber - Renumbers free points (Renumber panel).

• Misc. API commands that do not have an associated panel.

Edit Fixed Points

• suppress/remove - Suppresses non-vertex fixed points (Point Edit panel, Quick Edit panel).

• replace - Combines multiple fixed points by moving them to one fixed point location (Point Edit
panel, Quick Edit panel).

• release - Releases fixed point vertices such that any shared edges attached to the point become
free edges (Point Edit panel, Quick Edit panel).

• renumber - Renumbers fixed points (Renumber panel).

• Misc. API commands that do not have an associated panel.

Query Points

Query Free Points

• distance - Finds the distance between two free points (Distance panel).

• shortest distance - Finds the shortest distance between entities (Shortest Distance dialog).

• angle - Finds the angle between three free points (Distance panel).

• organize - Moves free points into different component collectors (Organize panel).

• numbers - Displays the IDs of free points (Numbers panel).

• count - Counts the total or displayed free points (Count panel).

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Geometry p.1633

• Misc. API commands that do not have an associated panel.

Query Fixed Points

• distance - Finds the distance between two fixed points (Distance panel).

• shortest distance - Finds the shortest distance between entities (Shortest Distance dialog).

• angle - Finds the angle between three fixed points (Distance panel).

• numbers - Displays the IDs of fixed points (Numbers panel).

• count - Counts the total or displayed fixed points (Count panel).

• Misc. API commands that do not have an associated panel.

Lines
A line represents a curve in space and is not attached to any surface or solid. A line is a one-
dimensional geometric entity.

The color of a line is determined by the component collector to which it belongs.

A line can be composed of one or more line types. Each line type in a line is referred to as a segment.
The end point of each line segment is connected to the first point of the next segment. A joint is the
common point between two line segments. Line segments are maintained as a single line entity, so
operations performed on the line affect each segment of the line. In general, HyperMesh automatically
uses the appropriate number and type of line segments to represent the geometry.

All lines in HyperMesh are represented mathematically with the following formulations:

• straight

• elliptical

• NURBS

Lines are different from surface edges and are sometimes handled differently for certain operations.

Create Lines

• xyz - Create lines by specifying (x,y,z) coordinates (Lines panel).

• linear nodes - Creates linear lines between nodes (Lines panel).

• standard nodes - Creates standard lines between nodes (Lines panel).

• smooth nodes - Creates smooth lines between nodes (Lines panel).

• controlled nodes - Creates controlled lines between nodes (Lines panel).

• drag along vector - Creates lines by dragging nodes a specified distance along a vector (Lines
panel).

• arc center and radius - Creates arcs by specifying the center and radius (Lines panel).

• arc nodes and vector - Creates arcs by specifying two nodes and a vector (Lines panel).

• arc three nodes - Creates arcs by specifying three nodes on the circumference (Lines panel).
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• circle center and radius - Creates circles by specifying the center and radius (Lines panel).

• circle nodes and vector - Creates circles by specifying two nodes and a vector (Lines panel).

• circle three nodes - Creates circles by specifying three nodes on the circumference (Lines panel).

• conic - Creates conic lines by specifying the start, end and tangent locations (Lines panel).

• extract edge - Creates lines as copies of surface edges (Lines panel).

• extract parametric - Creates lines at parametric locations on surfaces (Lines panel).

• intersect - Creates lines at the intersection of geometric entities: plane/lines, plane/surfaces,
plane/elements, plane/plane and surfaces/surfaces (Lines panel).

• manifold - Creates linear and smooth lines on surfaces using nodes (Lines panel).

• offset - Creates lines by offsetting lines a uniform or variable distance (Lines panel).

• midline - Creates lines by interpolating between existing lines (Lines panel).

• fillet - Creates fillet lines between free lines (Lines panel).

• tangent - Creates tangent lines between a line and a node list or line (Lines panel).

• normal to geometry - Creates lines perpendicular to lines, surfaces and solids from node or point
locations (Lines panel).

• normal from geometry - Creates lines perpendicular from node or point locations on lines, surfaces
and solids (Lines panel).

• normal 2D on plane - Creates lines that lie on a plane, are perpendicular to a line, and are defined
from node or point locations (Lines panel).

• features - Creates lines from element features (Lines panel).

• duplicate - Creates lines by duplicating existing lines. This is available in many panels when the
"duplicate" advanced entity selector is available on a lines collector.

• Misc. API commands that do not have an associated panel.

• Additional capabilities are available in solidThinking and solidThinking Inspire.

Edit Lines

• delete - Deletes lines (Delete panel, Lines panel).

• combine - Combines two lines into one (Line Edit panel).

• split at point - Splits lines at graphically selected locations (Line Edit panel).

• split at joint - Splits lines at segment end points (Line Edit panel).

• split at line - Splits lines by using a cut line (Line Edit panel).

• split at plane - Splits lines at plane intersection locations (Line Edit panel).

• smooth - Smooths segmented lines (Line Edit panel).

• extend - Extends lines by either a specified distance, or to meet an existing node, point, line/
surface edge or surface (Line Edit panel).

• translate - Moves lines along a vector direction (Translate panel).

• rotate - Rotates lines about a vector axis (Rotate panel).

• scale - Scales the dimensions of lines either proportionally or uniformly (Scale panel).

• reflect - Reflects lines about a plane to create a mirror image (Reflect panel).
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• project - Projects lines onto a plane, vector or surface (Project panel).

• position - Translates and rotate lines into new positions (Position panel).

• permute - Switches the coordinates of lines (Permute panel).

• renumber - Renumbers lines (Renumber panel).

• Misc. API commands that do not have an associated panel.

• Additional capabilities are available in solidThinking and solidThinking Inspire.

Query Lines

• shortest distance - Finds the shortest distance between entities (Shortest Distance dialog).

• length - Finds the total length of selected lines/surface edges (Lines panel).

• organize - Moves lines into different component collectors (Organize panel).

• numbers - Displays the IDs of lines/surface edges (Numbers panel).

• count - Counts the total or displayed line/surface edges (Count panel).

• Misc. API commands that do not have an associated panel.

Surfaces
A surface represents the geometry associated with a physical part. A surface is a two-dimensional
geometric entity that may be used in automatic mesh generation.

The color of a surface is determined by the component collector to which it belongs.

A surface is comprised of one or more faces. Each face contains a mathematical surface and edges to
trim the surface, if required. When a surface has several faces, all of the faces are maintained as a
single surface entity. Operations performed on the surface affect all the faces that comprise the surface.
In general, HyperMesh automatically uses the appropriate number of and type of surface faces to
represent the geometry.

The perimeter of a surface is defined by edges. There are four types of surface edges.

Surface edges are different from lines and are sometimes handled differently for certain operations.

The connectivity of surface edges constitutes the geometric topology.

Free Edges
A free edge is an edge that is owned by only one surface.
Free edges are colored red by default.
On a clean model consisting of surfaces, free edges appear only along the outer perimeter of
the part and around any interior holes. Free edges that appear between two adjacent surfaces
indicate the existence of a gap between the two surfaces. The automesher will leave a gap in the
mesh wherever there is a gap between two surfaces.

Shared Edges
A shared edge is an edge that is owned, or shared, by two adjacent surfaces.
Shared edges are colored green by default.
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When the edge between two surfaces is a shared edge, there is no gap or overlap between the
two surfaces - they are geometrically continuous. The automesher always places seed nodes
along the length a shared edge and will produce a continuous mesh without any gaps along that
edge. The automesher will not construct any individual elements that cross over a shared edge.

Suppressed Edges
A suppressed edge is shared by two surfaces but it is ignored by the automesher.
Suppressed edges are colored blue by default.
Like a shared edge, a suppressed edge indicates geometric continuity between two surfaces but,
unlike a shared edge, the automesher will mesh across a suppressed edge as if it were not even
there. The automesher does not place seed nodes along the length of a suppressed edge and,
consequently, individual elements will span across it. By suppressing undesirable edges you are
effectively combining surfaces into larger logical meshable regions.

Non-Manifold Edges
A non-manifold edge is owned by three or more surfaces.
Non-manifold edges are colored yellow by default.
They typically occur at "T" intersections between surfaces or when two or more duplicate surfaces
exist. The automesher always places seed nodes along their length and will produce a continuous
mesh without any gaps along that edge. The automesher will not construct any individual
elements that cross over a T-joint edge. These edges cannot be suppressed.

Create Surfaces

• square - Creates two-dimensional square surface primitives (Surfaces panel, Planes panel).

• cylinder full - Creates three-dimensional full cylinder surface primitives (Surfaces panel, Cones
panel).

• cylinder partial - Creates three-dimensional partial cylinder surface primitives (Surfaces panel,
Cones panel).

• cone full - Creates three-dimensional full cone surface primitives (Surfaces panel, Cones panel).

• cone partial - Creates three-dimensional partial cone surface primitives (Surfaces panel, Cones
panel).

• sphere center and radius - Creates three-dimensional sphere surface primitives by specifying the
center and radius (Surfaces panel, Spheres panel).

• sphere four nodes - Creates three-dimensional sphere surface primitives by specifying four nodes
(Surfaces panel, Spheres panel).

• sphere partial - Creates three-dimensional partial sphere surface primitives (Surfaces panel,
Spheres panel).

• torus center and radius - Creates three-dimensional torus surface primitives by specifying the
center, normal direction, minor radius and major radius (Surfaces panel, Torus panel).

• torus three nodes - Creates three-dimensional torus surface primitives by specifying three nodes
(Surfaces panel, Torus panel).

• torus partial - Creates three-dimensional partial torus surface primitives (Surfaces panel, Torus
panel).

• spin - Creates surfaces by spinning lines or a node list around an axis Surfaces panel, Spin panel).
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• drag along vector- Creates surfaces by dragging lines or a node list along a vector (Surfaces panel,
Drag panel).

• drag along line - Creates surfaces by dragging lines or a node list along a line (Surfaces panel, Line
Drag panel).

• drag along normal - Creates surfaces by dragging lines along their normal (Surfaces panel).

• ribs - Creates and modifies simple ribs between two surfaces (Ribs panel).

• ruled - Creates surfaces by interpolating linearly between lines or nodes (Surfaces panel, Ruled
panel).

• spline/filler - Creates surfaces by filling in gaps, such as a hole in an existing surface (Surfaces
panel, Spline panel, Quick Edit panel).

• skin - Creates surfaces by skinning lines (Surfaces panel, Skin panel).

• fillet - Creates constant radius fillet surfaces across surface edges (Surfaces panel).

• from FE - Creates surfaces that closely fit a selection of shell elements (Surfaces panel).

• meshlines - A toolkit for creating lines associated to shell elements for advanced selection or
surface creation (Surfaces panel).

• auto midsurface - Creates midsurface geometry automatically from multiple surfaces or solids
(Midsurface panel).

• surface pair - Creates midsurface geometry from one surface pair (Midsurface panel).

• duplicate - Creates surfaces by duplicating existing surfaces. This is available in many panels when
the "duplicate" advanced entity selector is available on a surfaces collector.

• Misc. API commands that do not have an associated panel.

• Additional capabilities are available in solidThinking and solidThinking Inspire.

Edit Surfaces

• delete - Deletes surfaces (Delete panel, Quick Edit panel).

• trim - Trims surfaces using nodes, lines, surfaces and planes (Surface Edit panel, Quick Edit panel).

• untrim/unsplit - Removes various trim/split lines from surfaces (Surface Edit panel, Edge Edit
panel, Quick Edit panel).

• offset - Offsets surfaces along their normal directions while maintaining topological connectivity
(Surface Edit panel).

• extend - Extends the edges of surfaces to meet or intersect other surfaces (Surface Edit panel,
Midsurface panel).

• shrink - Shrinks surfaces by drawing in all surfaces edges (Surface Edit panel).

• defeature - Removes pinholes, surface fillets, edge fillets and duplicate surfaces (Defeature panel,
Edge Edit panel).

• midsurfaces - Modifies and edits extracted midsurfaces (Midsurface panel).

• surface edges - Toggles, suppresses, unsuppresses and equivalences surface edges (Edge Edit
panel, Quick Edit panel).

• washer - Trims surfaces using free edge closed loop or shared edge offsets (Quick Edit panel).
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• autocleanup - Performs basic automatic geometry cleanup functions in preparation for meshing
(Autocleanup panel).

• dimensioning - Modifies dimensions of or between surfaces (Dimensioning panel).

• morphing - Morphs surfaces that have had associated nodes morphed away from them (Morph
panel).

• translate - Moves surfaces along a vector direction (Translate panel).

• rotate - Rotates surfaces about a vector axis (Rotate panel).

• scale - Scales the dimensions of surfaces either proportionally or uniformly (Scale panel).

• reflect - Reflects surfaces about a plane to create a mirror image (Reflect panel).

• position - Translates and rotate surfaces into new positions (Position panel).

• permute - Switches the coordinates of surfaces (Permute panel).

• renumber - Renumbers surface edges and surfaces (Renumber panel).

• Misc. API commands that do not have an associated panel.

• Additional capabilities are available in solidThinking and solidThinking Inspire.

Query Surfaces

• shortest distance - Finds the shortest distance between entities (Shortest Distance dialog).

• interference check - Finds penetrations/intersections between geometries (Geometry
Interference Check dialog).

• normal - Reviews the normal direction of surfaces (Normals panel).

• organize - Moves surfaces into different component collectors (Organize panel).

• numbers - Displays the IDs of surface edges and surfaces (Numbers panel).

• count - Counts the total or displayed surfaces (Count panel).

• area - Queries the total area of the selected surfaces (Mass Calc panel).

• dimensioning - Queries dimensions of or between surfaces (Dimensioning panel).

• Misc. API commands that do not have an associated panel.

Solids
Solids are closed volume of surfaces that can take any shape. Solids are three-dimensional entities that
can be used in automatic tetra and solid meshing.

The surfaces defining a solid can belong to multiple component collectors. The display of a solid and its
bounding surfaces are controlled only by the component collector to which the solid belongs.

Bounding Surface
A bounding surface defines the outer boundary of a single solid.
Bounding surfaces are shaded green by default.
A bounding surface is unique and is not shared with any other solid. A single solid volume is
defined entirely by bounding surfaces.
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Fin Surface
A fin surface has the same solid on all sides, that is, it acts as a fin inside of a single solid.
Fin surfaces are shaded red by default.
A fin surface can be created when manually merging solids or when creating solids with internal
fin surfaces.

Full Partition Surface
A full partition surface defines a shared boundary between one or more solids.
Full partition surfaces are shaded yellow by default.
A full partition surface can be created when splitting a solid or when using Boolean operations to
join multiple solids at shared or intersecting locations.

Figure 592:

Create Solids

• block - Creates three-dimensional block-shaped solid primitives (Solids panel).

• cylinder full - Creates three-dimensional full cylinder solid primitives (Solids panel).

• cylinder partial - Creates three-dimensional partial cylinder solid primitives (Solids panel).

• cone full - Creates three-dimensional full cone solid primitives (Solids panel).

• cone partial - Creates three-dimensional partial cone solid primitives (Solids panel).
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• sphere center and radius - Creates three-dimensional sphere solid primitives by specifying the
center and radius (Solids panel).

• sphere four nodes - Creates three-dimensional sphere solid primitives by specifying four nodes
(Solids panel).

• torus center and radius - Creates three-dimensional torus solid primitives by specifying the center,
normal direction, minor radius and major radius (Solids panel).

• torus three nodes - Creates three-dimensional torus solid primitives by specifying three nodes
(Solids panel).

• torus partial - Creates three-dimensional partial torus solid primitives (Solids panel).

• bounding surfaces - Creates solids by converting closed surface shells which define the solid
boundary (Solids panel).

• spin - Creates solids by spinning surfaces around an axis (Solids panel).

• drag along vector - Creates solids by dragging surfaces along a vector (Solids panel).

• drag along line - Creates solids by dragging surfaces along a line (Solids panel).

• drag along normal - Creates solids by dragging surfaces along their normal (Solids panel).

• ribs - Creates and modifies simple ribs between two surfaces (Ribs panel).

• ruled linear - Creates solids by interpolating linearly between surfaces (Solids panel).

• ruled smooth - Creates solids by interpolating smoothly between surfaces (Solids panel).

• duplicate - Creates solids by duplicating existing solids. This is available in many panels when the
"duplicate" advanced entity selector is available on a solids collector.

• Misc. API commands that do not have an associated panel.

• Additional capabilities are available in solidThinking and solidThinking Inspire.

Edit Solids

• delete - Deletes solids (Delete panel).

• trim - Trims solids using nodes, lines, surfaces and planes (Solid Edit panel).

• merge - Combines two or more solids into a single solid (Solid Edit panel).

• detach - Detaches solids that have shared fin faces from each other (Solid Edit panel).

• boolean - Performs complex merge and split functions on solids (Solid Edit panel).

• dimensioning - Modifies dimensions of or between surfaces (Dimensioning panel).

• translate - Moves solids along a vector direction (Translate panel).

• rotate - Rotates solids about a vector axis (Rotate panel).

• scale - Scales the dimensions of solids either proportionally or uniformly (Scale panel).

• reflect - Reflects solids about a plane to create a mirror image (Reflect panel).

• position - Translates and rotate solids into new positions (Position panel).

• permute - Switches the coordinates of solids (Permute panel).

• renumber - Renumbers solids (Renumber panel).

• Misc. API commands that do not have an associated panel.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Geometry p.1641

• Additional capabilities are available in solidThinking and solidThinking Inspire. See tutorial HM-2080
for an example.

Query Solids

• shortest distance - Finds the shortest distance between entities (Shortest Distance dialog).

• interference check - Finds penetrations/intersections between geometries (Geometry Interference
Check dialog).

• normal - Reviews the normal direction of solid surfaces (Normals panel).

• organize - Moves solids into different component collectors (Organize panel).

• numbers - Displays the IDs of solids (Numbers panel).

• count - Counts the total or displayed solids (Count panel).

• area - Queries the total area of the selected solids' surfaces (Mass Calc panel).

• volume - Queries the total volume of the selected solids (Mass Calc panel).

• dimensioning - Queries dimensions of or between surfaces (Dimensioning panel).

• Misc. API commands that do not have an associated panel.

Faces
A face is a single Non-uniform Rational B-Spline (NURBS) and is the smallest area entity. It has a
separate underlying mathematical definition, specified when it was created.

All faces are represented mathematically with the following formulations:

• plane

• cylinder/cone

• sphere

• torus

• NURBS

A surface can be made up of a single face type or of multiple face types. Multiple types are used for
more complex surfaces that contain sharp corners or highly complex shapes.
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Dimensioning
Change the dimensions of existing geometry, thus changing the basic shape of solids and other
enclosed volumes.

Figure 593: Initial Dimensions Figure 594: Modified Dimensions

Edit Dimensions
Dimensioning is accomplished with features, parameters and dimension manipulators.

When changing several dimensions, each dimension change is performed separately using the
respective manipulator. However, if multiple dimensions are linked to the same parameter or parameter
expression, they will be updated simultaneously.

When dimensions are modified, a very limited check for mutual penetrations of the repositioned
surfaces is performed. It is the your responsibility to ensure that the new dimensions are appropriate.

The locked end of the dimension manipulator defines the direction in which the affected surfaces move
when the dimension is modified. For a dimension to be modified, one or both ends of the dimension
manipulator must unlocked.

When dimensions cannot be modified, the locked side is set to Both and you may use the Sides
Selection advanced option to specify how the dimension should be changed, when possible.

1. Create dimension feature.

a) In the Model Browser, right-click and select Create > Feature from the context menu.
The Feature dialog opens.

b) In the Name field, enter a name for the dimension.

Proprietary Information of Altair Engineering

c) In the Point1 and Point2 fields, use the entity selector to select two fixed points (vertices) 
between the opposite surfaces where the dimension is defined.
A dimension manipulator is then created between these fixed points (Point1 and Point2).

d) In the Parameterization field, select a parameterization method.



Altair HyperMesh 2019 Users Guide
Geometry p.1643

Note:

A new parameter can be created and assigned to an existing dimension feature at
any time via the Create Parameter option in the Entity Editor context menu.

• Choose Create Parameter to create and assign a new parameter to a dimension
feature.

• Choose Select Parameter to assign an existing parameter to the new dimension
feature.

• Choose No Parameter if you do not want to assign a parameter to the dimension
feature.

e) Click Create.

2. In the Entity Editor, define dimension feature attributes.

3. Edit dimension.

• In the modeling window, click the dimension's corresponding label and enter a new value.

• In the Model Browser, select the parameter assigned to the dimension feature. In the Entity
Editor, enter a new value.

Figure 595:

Dimensioning Concepts
Learn about basic dimensioning concepts, such as continuous surface offset functionality and tolerance 
and accuracy.

Continuous Surface Offset Functionality
Dimensioning is based on a continuous surface offset functionality. It provides assistance in the 
selection of the surfaces to offset so that a change to the selected dimension can occur, and calculates 
the offset values required for each surface to achieve the specified dimension.
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The continuous offset modifies both the surfaces you selected for the offset and the adjacent involved
surfaces that must also be modified so that the result will remain as continuous as the initial input.

These "selected" and "involved" surfaces are modified with different rules.

• Selected surfaces

◦ Offset by a constant value that is normal, or in some cases almost normal, to the surface at
each point. For example, a standalone surface is offset by the given constant distance exactly
normal to itself.

Figure 596: Normal Offset of a Standalone Surface

◦ When the adjacent surfaces form a corner between them, the exact normal offset will result
in either disconnected surfaces or in intersecting surfaces, for example if the offset was
performed in the opposite direction.

Figure 597: Exact Normal Offset of the Adjacent Surfaces Creates a Rupture

◦ A continuous result that is consistent with the given offset distance is obtained by reconciling
the offset vectors of the vertices shared by the surfaces being offset.
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Figure 598: Reconciled Offset Vectors at Shared Edge

• Involved Surfaces

◦ The edges of the involved surfaces that are shared with the selected surfaces move with the
selected surfaces.

◦ The edges of the involved surfaces that do not have a common point with the selected surfaces
do not move, for example they are locked.

◦ The offset of the edges that connect both the moving and the locked involved surface edges is
defined by interpolation. Different interpolation methods are available.

In general cases, the target dimension between the selected vertices is achieved by offsetting the
surfaces that contain the vertices in an infinite number of ways. To avoid this, the following rules are
implemented.

• If both dimension ends (both vertices) are allowed to move, an attempt is made to move them by
the same distance whenever possible.

• If possible, the dimension ends are moved in such a way that the direction of the dimension will not
change.

In the following example, the initial positions of the vertices are marked with temp nodes to enable the
changes can be easily seen. The locked state of the dimension manipulators is indicated by the lock
icons.

Note:  These examples are not cumulative, so no two images are directly related. The first
image, showing the dimensions of 3, 4, and 5, is the starting point from which all of the
other examples derive.
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Figure 599: Original Model
3 dimensions selected.

Figure 600: Dim 4 Changed to 5
Top and bottom move.

Figure 601: Dim 4 Changed to 5
Top moves, bottom is locked.
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Figure 602: Dim 5 (Diagonal)
Changed to 6
All sides move.

Figure 603: Dim 5 Changed to 6
Only top moves.

Figure 604: Dim 5 Changed to 6 
Only right side moves.

Tolerances and Accuracy
All geometry transformation tools are numerical tools that operate with some accuracy defined by
the tolerances, such as the geometry cleanup tolerance set in the Options panel. Curved surfaces and
lines have internal structures in 3D that are invisible to you. Significantly reducing the size of such an
entity so that these structures fall below the tolerances may result in a structure simplification that
you cannot notice at first; the structural data will be lost. When this occurs any subsequent increase in
the size will not restore the initial structures. For example, reducing a cylinder diameter 100 times and
then increasing the diameter 100 times may not lead to the same cylinder; in some cases, a complex
internal representation of the cylinder may lead to a corrupt surface. In general, transformation of a
curved entity may result in both the simplification or complication of its internal structure. It is therefore
not recommended to perform multiple transformations on curved entities.

Dimension Manipulators
Dimension manipulators are used to alter selected dimensions of solid entities.

A dimension manipulator consists of:

Dimension line
A segment parallel to the line that connects the selected points, but is shifted off the selected
points for visibility. The terms manipulator direction and manipulator ends are also used, which
are the same as the dimension line direction and the dimension line ends.

Pullout lines
Two parallel segments that connect the ends of the dimension line with the selected points.
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Lock icons
Arrow (movable) and block (locked) icons indicate the lock state of a manipulator end.

Lock controls
Sphere handles, located near the lock icons, enable the lock state of a manipulator end to be
modified.

Display/input field
Displays the current dimension value, which can be modified or deleted. This value can be
modified or deleted. Deleting the value deletes the the manipulator. For dimensions that are
parameterized, an "&" symbol will appear before the dimension. Editing a parameterized
dimension directly edits the parameter, or parameter expression.

Figure 605: Dimension Manipulator

Dimension Feature Attributes
Attributes associated with dimension features can be modifed in the Entity Editor.

Attribute Action

Lock Side Select the locked end of the dimension manipulator, which defines
the direction in which the affected surfaces move when the dimension
is modified. For a dimension to be modified, one or both ends of the
dimension manipulator must unlocked.

When dimensions cannot be modified, the locked side is set to Both and
you may use the Sides Selection advanced option to specify how the
dimension should be changed, when possible.

Surfaces Interpolation
System

Automatic
A heuristic algorithm is used to try and decide which of the two
interpolation methods to apply for each individual, applicable involved
surface.

Local
A Local Coordinate System (LSC) 2D interpolation method that
"slides" along the surfaces to determine the offset vectors, which are
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Attribute Action

then interpolated and combined into the interpolated offset at each
point. Selected surfaces are always interpolated using this method.

Global
A global coordinate system 1D linear interpolation method that
stretches/compresses a surface proportionally in a global 1D. Only
applicable when all of the offset vectors at the surface's vertices
are collinear and proportional to the distance parameter along their
common direction.

Figure 606: Interpolation of the Same Offset Vectors at the Vertices for both
Methods

Minimum Slide Angle When a selected surface is offset, the involved surfaces must be modified
to keep the continuity of the model.

Surfaces can be modified by dragging the involved surface behind the
selected surface, or by defining it as a "slider" along which the selected
surface slides.

The Minimum Slide angle determines which method is used. If the slide
angle is more than the specified value, then the involved surface will slide;
otherwise it will drag.

When the involved surface is a slider, the orientation of the surface does
not change for planar surfaces. However, for curved involved surfaces,
the sliding directions are defined by the tangents to the surface where it
is adjacent to the selected surface. Sliding of the selected and involved
surfaces along these directions may also result in some change to the
shape of the involved surface.
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Attribute Action

Figure 607: Original Model

Figure 608: Involved Surface Dragged 
Dimension modified to D=0.4.

Figure 609: Involved Surface as 

Slider Dimension modified to D=0.4.

Remove Collapsed
Surfaces

Remove portions of the offset surfaces that fold into themselves or adjacent
surfaces (portions of surfaces that penetrate themselves or adjacent
surfaces along the edges they are adjacent over).

For example, suppose that the slide angle is greater than the Minimum
Slide Angle and the value in the dimension manipulator is set to 1. If this
option is off, the involved surface will slide and ignore the self-penetration,
resulting in a corrupt model. If this option is on, the involved surface will
slide as far as possible without causing self-penetration. This may not
allow the specified dimension to be reached, but will not result in a corrupt
model.
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Attribute Action

Figure 610: Remove Collapse Surfaces
Off
Dimension modified to D=1.

Figure 611: Remove Collapse Surfaces
On
Dimension modified to D=1.

Another useful application is for the removal of holes. If the hole diameter
is set to 0 and this option is on, the hole will be removed. If the option is
off, a small "straw surface" will still remain.

In general, unless it is known that collapsed surfaces will result, it is better
to keep this option off for performance reasons, as this option has no effect
on general cases that do not result in penetration.

Sides Selection Auto
Automatically select the surfaces to offset using the following rules:

1. Surfaces adjacent to the manipulator ends are selected if the
angle between the normal to the surface at the dimension end
and the dimension direction is less than the Max Pick Tilt.

If surfaces are selected at both ends for the specified Max
Pick Tilt value, then the lock control handles will allow for the
manual manipulation of the offset scenario.
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Attribute Action

Figure 612: Angle between the Normal to the Surface and the
Manipulator Direction

2. Surfaces adjacent to the selected surfaces are appended,
provided that they are planar and the angle along the edge over
which they are adjacent to the already selected surface is less
than the Max Expand Angle.

3. The total area of the selected surfaces at each end is calculated.
If the area of the selected surfaces at one end is more than
the Side Selection Area Ratio and larger than the area of the
selected surfaces at the other end, then the surfaces on the
larger area side are unselected. In this case, only the surfaces
at the smaller area side are used to offset.
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Attribute Action

Figure 613: Side Selection Area Ratio
The image on the left has a side selection area ratio = 3, and the image on right 

has a side selection area ratio = 1.5. The bottom surface area is twice as much 

as the top surface, therefore the bottom will not move (note the lock indicator).

The ends of the dimension lines that are allowed to move are marked
with arrows, while the locked ends are marked with blocks.

Figure 614: Example of Lock Icons

When both sides have surfaces that satisfy rule 1 above, rule 3 can 
be manually overridden. In this case the lock controls (spheres near 
the icons) define the offset scenario. Clicking the lock control handles 
will toggle the lock state between locked and unlocked for that end. 
If a lock control state is manually specified, then rule 3 is ignored for
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Attribute Action

that dimension manipulator and the Side Selection Area Ratio option
no longer applies.
When Sides Selection is set to Manual, the surfaces to offset are
selected using the Surfaces to Move selector. The manual surface
selection is then governed by the lock state of the dimension
manipulator ends.

Note:  Out of the selected surfaces, only those that are
linked to at least one of the dimension manipulator ends
by a continuous selection are actually used in the offset.

With the manual selection, the use of Separator Lines is also available
(see the surface edit subpanel for details).

Manual
Manually select the surfaces to offset.
With manual side selection, surfaces are selected erroneously, and
the results can be unexpected or catastrophic.

Figure 615: Dim 50.5 Changed to 70 to Move the Wall
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Attribute Action

The three highlighted surfaces are selected in order to change the dimension from 50.5

to 70 and move the wall to a new position.

Advanced Considerations
Advanced considerations to keep in mind when changing the dimensions of existing geometry.

In practice, changing of a linear dimension in a model normally implies either stretching/compressing
in the direction of the modified dimension or changing of a diameter/radius. With dimensioning
funtionality, a combination of both modification types is provided.

In the example below, one of the two D=52 dimensions is changed to D=60. How the offset is
performed will give different results, both of which may be valid, depending on which of the two
dimension manipulators is changed.

Figure 616: Original model Figure 617: Edge Fillet Surfaces
Selected
The fillet radius is scaled.

Figure 618: Edge Fillet Surfaces
Involved
Linear scaling only, fillet curvature

changes.

When the value of the upper dimension manipulator is modified from 52 to 60, the edge fillet surfaces
are adjacent to the modified manipulator and are offset as selected surfaces. As such, they are offset
with the LSC interpolation, which results in a preservation of their shape along with the change in radii.

When the value of the lower dimension manipulator is modified from 52 to 60, the edge fillet surfaces
are not adjacent to the modified dimension manipulator and are curved, so they are offset as involved
surfaces. Using automatic interpolation, it is recognized that these two curved surfaces can be simply
stretched to provide the model continuity via the global interpolation method.

When using manual surface selection and changing the same lower dimension, a variety of results are
obtainable depending on the selected surfaces. Some of the possible results are shown below.
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Note:  In each row of the three images, the first two show the initial selection from two
angles, to reveal all of the selected surfaces, while the third shows the results of the
dimension change based on those selected surfaces.

Figure 619: Original model, 3
surfaces selected

Figure 620: Original model, 3
surfaces selected

Figure 621: Result of the dimension
52 change to 60

Figure 622: Original model, 4
surfaces selected

Figure 623: Original model, 4
surfaces selected

Figure 624: Result of the dimension
52 change to 60
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Figure 625: Original model, 5
surfaces selected

Figure 626: Original model, 5
surfaces selected

Figure 627: Result of the dimension
52 change to 60

Figure 628: Original model, 6
surfaces selected

Figure 629: Original model, 6
surfaces selected

Figure 630: Result of the dimension
52 change to 60

Figure 631: Original model, 7
surfaces selected

Figure 632: Original model, 7
surfaces selected

Figure 633: Result of the dimension
52 change to 60
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The following steps are used to calculate the offset values of the selected surfaces.

1. The required shift in the dimension manipulator direction is calculated as a difference between the
requested distance and the actual distance between the dimension manipulator ends.

2. If both dimension manipulators ends are allowed to move, the required shift is divided by two.

When Sides Selection is set to Auto, an end is allowed to move if it belongs to a surface that is
automatically selected to move. When this can be overridden manually by you, the lock controls
appear.

When Sides Selection is set to Manual, an end is allowed to move if it belongs to a manually
selected surface, and the surface normal at the dimension manipulator end forms an angle with
the dimension manipulator direction that is less than arccos(0.05) (87.134016 degrees).

For example, the right end of the dimension manipulator belongs to only the selected surface
2. The normal to surface 2 at the right end creates a 90-degree angle with the dimension
manipulator and thus the end is not allowed to move. The left dimension manipulator end belongs
to both selected surfaces 1 and 2. The normal to surface 1 at the left end makes a 0-degree angle
with the dimension manipulator direction, and thus the left end is allowed to move.

Figure 634:

Figure 635:
In this example, the right end belongs to selected surfaces 2 and 7, with the left end belonging to selected surfaces 1 and

2. Thus, both ends are allowed to move.

3. When only planar surfaces are selected, the absolute value of its normal offset is defined as the
absolute value of the required shift multiplied by the cosine between the normal to the surface
and the dimension manipulator direction.
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Figure 636:

For a planar surface, this provides that its shift in the dimension manipulator direction is equal to
the required shift.

When curved surfaces are included and the Sides Selection is set to Manual, the rules of the
offset value calculations are more complex. The problem in this case originates from the fact
that a selected curved surface can provide a smooth link between the selected planar surfaces
that are tilted by different angles versus the dimension manipulator direction. When smooth,
adjacent surfaces are offset, they must be offset by the same value to ensure continuity of the
result, because in this case it is not possible to reconcile the different offset values as discussed
earlier. This means that the planar surfaces with a different tilt towards the dimension manipulator
direction cannot be offset by different distances, as shown above, when the planar surfaces are
smoothly linked by a selected surface.

The current algorithm to define the offset value in the general case, for both curved and planar
surfaces, is as follows. For a selected surface adjacent to the dimension manipulator end, its offset
is calculated as shown in the image above, based on the normal to the surface at the dimension
manipulator end. For a selected surface that is not adjacent to the dimension manipulator end, a
chain of selected surfaces that links it to the related end is detected, and the offset is calculated
along the chain, from the previous surface to the next. The calculation along the chain is based on
the following:

• If the surfaces are smoothly adjacent, the offset value is directly passed from one surface to
the next.

• If the surfaces are not smoothly adjacent, the offset is calculated in such a way that for a
planar surface the result as shown in the image above is obtained.

The problem here is that when several chains of selected surfaces connect a selected surface
with the related dimension manipulator end, the offset results for the surface obtained along
the different chains can contradict each other. Then the dimensioning result may be corrupt.
Therefore, it is important to make appropriate manual surface selections.
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Figure 637:
Surfaces 1, 2, and 4 selected, D=52 changed to D=60. Surfaces 1, 2, and 4 offset by 8.

Figure 638:
Surfaces 1, 3, and 4 selected, D=52 changed to D=60. Surface 1 offset by 8, Surfaces 3 and 4 by 0.

Figure 639:
Surfaces 1, 2, 3, and 4 selected, D=52 changed to D=60. The result is corrupt.

4. For each selected surface the sign of the offset is defined so that it will move in the same direction
as the dimension manipulator end to which it is related.

A surface can be related to one, and only one, of the dimension manipulator ends. For this, first,
the dimension manipulator end must be allowed to move. Second, the surface should be linked to
the dimension manipulator end over a chain of adjacent selected surfaces. Third, in the case when
the surface is linked to both dimension manipulator ends which are allowed to move, the surface
will be related to the end that is closer to it.

As an example, selected surface 2 will have an offset of 0, because cos(90) = 0. The purpose for
selection of this surface is just to provide a link from the dimension manipulator ends to the other
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selected surfaces. Surface 1 is at the moving dimension manipulator end, and surface 3 moves as 
surface 1.

Following the same rules, surfaces 1 and 7 are at the moving dimension manipulator ends.
Surfaces 3 and 5 move as surface 1, and surfaces 4 and 6 move as surface 7.

Figure 641:

Proprietary Information of Altair Engineering

Figure 640:



Altair HyperMesh 2019 Users Guide
Geometry p.1662

Extract and Edit Midsurfaces
Extract the midsurface of thin solids, and review and edit midsurface plates.

Extract Midsurfaces
Midsurfaces can be extracted for sheet metal stampings, molded plastic parts with ribs, and other parts
that have thickness clearly smaller than width and length.

During midsurface extraction, the original geometry that you select to extract the midsurface from
remains unchanged, and the new geometry that represents the midsurface is created. The (variable)
thickness of each middle surface is calculated and stored with the surface definition.

1. From the Geom page, select the midsurface panel.

2. Select auto midsurface.

3. Select the auto extraction subpanel.

4. Using the selector, select surfaces or solids to extract the midsurface from.

5. Define all of the midsurface extraction options accordingly.

6. Click extract.
A midsurface representation of a solid part or a finite element shell representation of solid
geometry is generated and organized in a new component collector called Middle Surface, or in
the current component, depending on your choice.

7. Review and modify the midsurface as needed.

Edit Plates, Base Surfaces, and Collapsed Lines
Plates, base surfaces, and collapsed lines on the midsurface can be modified using the interim edit tools
in the midsurface panel.

The modifications you make to the midsurface using the interim edit tools are not automatically applied.
You must delete and re-extract the midsurface in the auto extraction subpanel to apply your changes.

Edit Plates
Plates are a group of surfaces in the model in which the middle surface will be inserted.

Each plate has two sides: blue and green. The middle surface is inserted between the two sides of each
plate. When you click show/edit all, surfaces are organized into components that reflect their plate
type. To display the plates as per their component color, change the geometry display mode to Mixed on
the Visualization toolbar.

When the automatic detection of plates is not correct, click show/edit all to manually edit plates.

Plate information will only be created upon extracting midsurface using the offset+planes+sweeps and
offset+planes methods.
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Any changes made to the midsurface using the Plate Edit tools will not be visible until you click update
within the same panel, or after you extract the midsurface using the offset+planes+sweeps or offset
+planes methods.

1. From the Geom page, select the midsurface panel.

2. Select the interim edit tools.

3. Select the edit plates subpanel.

4. Click show/edit all.
5. Edit plates.

To edit plates by Do this

Creating new plates
out of surfaces

1. Using the single surface selector, select surfaces to create new
plates from.

2. On the left side of the panel, select a type of plate to create.

3. Click new plate.

A new plate is created out of the selected surfaces.

4. Continue modifying the midsurface, or click update to re-extract
the midsurface.

Creating transition
surfaces

Transition surface provide more information to the algorithm regarding
inserting surface where two regular plates are intersecting. An
algorithm calculates how far intersecting plates can be extended based
on the transition surface.

1. Using the single surface selector, select surfaces.

2. Click transition surface.

The selected surfaces are used as transition surfaces during
midsurface extraction.

3. Continue modifying the midsurface, or click update to re-extract
the midsurface.

Selecting trim
surfaces to ignore
during midsurface
extraction

1. Using the single surface selector, select surfaces that you do not
want to be considered trim surfaces.

2. Click not a trim surface.

The selected surfaces are placed in the component, ^Not a trim
surface.

3. Continue modifying the midsurface, or click update to re-extract
the midsurface.

During midsurface extraction, the surfaces in the ^Not a trim
surface component will be ignored.
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To edit plates by Do this

Switching the offset
side

Each plate has two sides (blue and green) between which the
midsurface is inserted. By default, the midsurface is generated by
offsetting the green side of the plate.

1. Using the single surface selector, select surfaces to switch the
offset side.

2. Click switch sides.

3. Continue modifying the midsurface, or click update to re-extract
the midsurface.

During midsurface extraction, the midsurface will be offset
from the opposite side that it was originally offset from. If the
midsurface was generated by offsetting the green side of the
plate, the midsurface will now be generated by offsetting the new
green side which was blue before using switch side.

Assigning trimming
surfaces

Plate edges act as trimming surfaces for all plate types, and are used to
trim inserted midsurfaces.

1. Using the single surface selector, select surfaces to serve as
trimming surfaces.

2. Click plate edge.

3. Continue modifying the midsurface, or click update to re-extract
the midsurface.

During midsurface extraction, the midsurface is trimmed using
the surfaces you selected.

Merging plates 1. Using the full plate selector, select plates to merge.

2. On the left side of the panel, select a new plate type to create.

3. Click merge plates.

All of the selected plates are merged into a single plate.
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To edit plates by Do this

4. Continue modifying the midsurface, or click update to re-extract
the midsurface.

Edit Base Surfaces
In certain situations, you may need to extract a midsurface from multiple solids as if they were a single
solid.

Figure 642:

Normally, this would result in multiple midsurfaces, each one at the middle of the solid it was extracted
from, and therefore not aligned with each other.

In the edit base surfaces subpanel you can specify a distance from the base surfaces of multiple solids,
that you wish to treat as if they were continuous, to generate separate-but-aligned midsurfaces for
during extraction.

You can create aligned midsurfaces for non-aligned solids, by selecting each solid and specifying its
offset separately, using a different offset for each. You must know the exact dimensions of each solid to
do this accurately.

Figure 643:
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If use base surfaces is disabled, new midsurfaces will not be generated at the specified distance from
the selected base surfaces. The setup of the base surfaces that you modified will be retained for future
use as long as you do not delete them.

1. From the Geom page, select the midsurface panel.

2. Select the interim edit tools.

3. Select the edit base surfaces subpanel.

4. Select the use base surfaces checkbox.

5. Using the surfs selector, select base surfaces.

Note:  If both sides of a plate are selected as the base surface, the side which is used
will be random.

6. In the distance to base field, specify a distance to create new midsurfaces from the selected base
surfaces.

Note:  If align steps (extraction options subpanel) and use base surfaces are both
used for the same solids, then the base surface distance will overwrite the align steps
distance.

7. Click add base.

8. Select the auto extraction subpanel.

9. Click extract.

The original midsurface is deleted and a new midsurface is generated. Separate-but-aligned
midsurfaces are generated at the specified distance from the bases of the surfaces that you modified.

Figure 644:

Edit Collapsed Lines
Enable visualization settings to display point associations on the midsurface after extraction, and
manually define lines and line chains to establish the linkage between points that should collapse to the
same location.

Automatically extracted midsurfaces may include gaps, which are caused by a failure to correctly
interpret relatively complex topology. In many cases, this can occur when a solid part has a fillet on one
side but not on the other, or a fillet has a step or "ledge" at one end of its curve. In the image below, a
gap in the midsurface is caused by a step in the fillet.
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Figure 645:

The auto midsurface extraction tool attempts to determine where each point on the geometry should
collapse to meet the generated midsurface. Errors occur when the extraction tool collapses points to the
wrong corresponding locations on the midsurface. This often happens when the two end-points on a line
collapse to separate points instead of to the same point.

Figure 646:
The curved lines on each fillet are correctly associated with each other.

Figure 647:
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The step in the fillet caused the extraction tool to associate the two points at the end of the step's edge with each other and

collapse (correctly) toward the T-joint of the midsurface, while the remaining points at the other ends of the curved lines were

then incorrectly collapsed in a normal direction instead of to the same point.

1. From the Geom page, select the midsurface panel.

2. Select the interim edit tools.

3. Select the edit collapsed lines subpanel.

4. Select the allow rerun checkbox.

5. Edit collapsed lines.

To edit collapsed
lines by

Do this

Displaying point
associations on the
midsurface

Pre-requisite: Reject the current midsurface.

1. Set the switch to prepare for rerun.

2. Select the auto extraction subpanel.

3. Click extract.

The midsurface is extracted, and the lines that connect associated
points are highlighted blue.

Figure 648:

Collapsing lines 1. Set the switch to do rerun.

2. Activate the lines to collapse selector.

3. Select each line segment that you wish to collapse to a single
point on the midsurface.

4. Click collapse.

The selected line segments collapse and are highlighted light
blue, indicating that they are new collapsed lines.
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To edit collapsed
lines by

Do this

Figure 649:

5. Select the auto extraction subpanel.

The collapsed lines that were automatically found during the
initial midsurface extraction and the lines that you manually
collapsed remain highlighted blue and flagged for collapse.

6. Click extract.

The original midsurface is deleted and a new midsurface is
generated using all of the lines that are flagged for collapse.

Note:  If allow rerun is disabled or the allow rerun
switch is set to no rerun or prepare for rerun, then
the lines that you manually collapsed will not be used
when a new midsurface is extracted.

Figure 650:

Deleting collapsed
lines

Pre-requisite: Display point associations on the midsurface.

1. Set the switch to do rerun.

2. Activate the lines to collapse selector.

3. Select collapsed lines to delete.
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To edit collapsed
lines by

Do this

4. Click delete.

Trimming surfaces
to create additional
points and lines

1. Set the switch to do rerun.

2. Activate the trim surfaces with cut line selector.

3. Select surfaces to trim.

4. Click drag a cut line.

5. Click where you wish the line to begin, then click one or more
times where you wish the lines to either end or change direction.

6. Press Esc.

The line is generated and any selected surfaces it crosses are
trimmed.

Repair Surfaces, Modify Targets, Imprint Surfaces
After you have extracted the midsurface and do not need to make further changes that require the
midsurface to be re-extracted, repair surfaces, modify targets, and imprint surfaces using the final edit
tools in the midsurface panel.

Repair Surfaces
Create midsurfaces for failed parts by extracting a midsurface from two faces that represent the two
sides.

This function creates one surface that forms the midsurface.

1. From the Geom page, select the midsurface panel.

2. Select the final edit tools.

3. Select the surface pair subpanel.

4. Using the side 1: surfs selector, select a surface that represents one side of the solid.

5. Using the side 2: surfs selector, select a surface that represents the second side of the solid.

6. Select extraction options accordingly to define which surfaces to take into account when
constructing midsurface.

By default, only two surfaces that are selected with the side1 and side2 surf selectors are
considered.

• To take into account offset directions of the adjacent pre-existing midsurfaces, select the use
adjacent midsurfaces checkbox.
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• To allow modifying pre-existing adjacent midsurfaces, select the combine with adjacent
midsurfaces checkbox.

7. Using the toggle, specify where to store midsurface geometry after extraction.

8. Click extract.

Modify Targets
Repair or edit a midsurface by correcting its targets.

Targets are the red and green segments that connect the points on the initial surface with the points
where the surface must be offset. You can modify a midsurface that was created earlier, or a surface
that is part of the solid.

The appearance of new temporary entities are displayed in different colors.

Figure 651:

Surface to offset (yellow)
Original surface from which the middle surface was created by an offset with a variable direction
and distance.

Midsurface to edit (cyan)
Midsurface (in-progress) that you can modify by reassigning targets.

Targets (red)
Handles that can be used to change the direction and distance of the offset. Targets are red
segments that connect points on the initial surface with the points where the surface must be
offset. The offset is interpolated inbetween the assigned targets.

New targets (green)
Targets that have not been accepted, thus they do not affect the midsurface.

Targets being combined (purple)
New and existing targets that will be combined once they are accepted.

Target planes
Planes parallel to the offset surface drawn at target points, which can be displayed for reference.

1. From the Geom page, select the midsurface panel.

2. Select the final edit tools.
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3. Select the assign target subpanel.

4. Modify targets.

To modify targets by Do this

Reassigning target 1. Using the point to point/edge to edge toggle, specify whether to
select points or edges.

2. Verify that the surf selector is active, then select a midsurface
that was created earlier or a surface that is part of a solid.
Temporary components are created for the midsurface to edit, the
surface to offset, and targets.

Figure 652:

3. Using the point/edge to offset selector, select an existing point/
edge or create a new point on the original surface (yellow) to
offset. This point serves as the beginning point of the target.

Note:  To create a new point, hold your mouse on the
edge of the surface (yellow) until the cursor turns into
a square and the edge is highlighted. Release your
mouse and left-click on the highlighted edge where
you want to create a new point (target). A red circle
is drawn around the point or at the center of the edge
to indicate the selection.
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To modify targets by Do this

Figure 653:

4. Using the pilot point/edge selector, select an existing point/edge
or create a new point to serve as the end point of the target.

Note:  Targets are created at the same location as
the pilot point selected (as selected) or in the middle
of the point/edge to offset and the pilot point/edge
(midpoint). Use the target location toggle to specify
where targets are created.

Figure 654:

5. To accept the location of the targets, click accept targets.

6. Click offset.

The midsurface is redrawn with updated targets.

7. When you are satisfied with the results of your modifications, click
accept.
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To modify targets by Do this

Figure 655:

Removing targets 1. Using the point to point/edge to edge toggle, select point to
point.

2. Verify that the surf selector is active, then select a midsurface
that was created earlier or a surface that is part of a solid.
Temporary components are created for the midsurface to edit, the
surface to offset, and targets.

Figure 656:

3. Using the point/edge to offset selector, select a point on the
original surface (yellow), which is the beginning point of a target.
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To modify targets by Do this

Figure 657:

4. Using the pilot point/edge selector, select a point that serves as
the end point of the target.

Figure 658:

5. Click remove target.
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To modify targets by Do this

Figure 659:

Imprint Surfaces
Imprint solid geometry pockets, fillets and other feature boundaries on the midsurface.

Imprinting makes midsurface thickness calculations more accurate by creating mesh boundaries that
match the feature boundaries on the original solid, and improves the meshing quality by capturing the
features of the solid model.

You are not required to select the midsurface as HyperMesh automatically recognizes the midsurface
corresponding to the solid/surface component from which it was derived, and imprints the lines on the
surfaces in the midsurface component.

1. From the Geom page, select the midsurface panel.

2. Select the final edit tools.

3. Select the imprint subpanel.

4. Imprint surfaces.

To imprint Do this

Lines 1. Set the lines/surfs to imprint selector to lines.

2. Select lines to imprint.

3. Using the line extend switch, specify how to extend lines.

4. To keep line endpoints, select keep line endpoints.

5. Using the target surfaces toggle, automatically or manually select
target surfaces to imprint.

6. Click imprint.
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To imprint Do this

Surfaces Surfaces (faces of solids) can be used to imprint on the midsurface
instead of lines.

1. Set the lines/surfs to imprint selector to surfs.

2. Select surfaces to imprint.

3. Using the line extend switch, specify how to extend lines.

4. To keep line endpoints, select keep line endpoints.

5. Using the surfs imprint toggle, specify which surface edges to
imprint.

Note:  If surface edges are close to the Midsurface
T edges or boundary, imprint all may produce bad
element quality, in which case consider using smart
imprint.

6. Using the target surfaces toggle, automatically or manually select
target surfaces to imprint.

7. Click imprint.

Review and Modify Surface Thicknesses
Review the thickness of surfaces (including midsurfaces) and assign new fixed, uniform thicknesses to 
surfaces.

Surfaces that have thickness data stored are drawn with lines (probes) extending from each vertex 
of the surface. The length of these probes represent the thickness at those locations. By default, only 
surfaces created in the midsurface panel have thickness information defined.
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Figure 660:
The center surface (with probes at corners) has thickness data; the lower-left one does not.
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1. From the Geom page, select the midsurface panel.

2. Select review thickness.

3. Edit surface thicknesses.

Option Description

Review the thickness of
surfaces

Using the view thickness: surfs selector, select surfaces to
review.

The average thickness, maximum thickness, and minimum
thickness for the selected surfaces are displayed.

Figure 661:
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Assign thicknesses to 
surfaces

1. Using the assign thickness: surfs selector, select surfaces to
assign thicknesses to.

2. In the new thickness field, enter a thickness value.

3. Click assign.

4. To reject the thickness, click reject before leaving the
panel.
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Sort Midsurfaces
Manually sort midsurfaces after extraction.

1. From the Geom page, select the midsurface panel.

2. Select sort.
3. Select a method for sorting midsurfaces.

• Choose <~[o]riginal name> comp to create new components by removing the first
letter of the original component name and replacing it with a ~ and sorts the midsurfaces
accordingly. For example, my_comp -> ~y_comp.

• Choose <Midsurface #nn> comp to create components with the name Midsurface #, where
# increases for each component that exists for the input surfaces/solids.

• Choose original comp to organize the midsurfaces into their parent surface/solid
components.

• Choose <original name~> comp to create components using the original component name
and adds ~ at the end.

• Choose <original nameN> comp to create new components by incrementing the name of
the original.

4. Click sort.
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Match Topology
Fix gaps between stitched edges and vertices to make the actual geometry of the surfaces consistent
with the model topology.

1. From the menu bar, click Geometry > Geom Match Topology.
The Geom Match Topology dialog opens.

2. Using the Entities selector, select geometry to check.

3. In the Tolerance field, enter a tolerance to use when checking the topology of the model for gaps
between shared, non-manifold, or suppressed edges.

If a gap is found to be bigger than the specified tolerance, then the surface and edge geometries
will be morphed parametrically and in 3D, if necessary, to make the gap smaller than the
tolerance. In addition, non-essential degenerate edges are removed.

4. Click Apply.

The original geometric entity IDs are also preserved. The same functionality is used for the Optimize for
CAD option in the Export - Geometry Browser.

Example: Match Topology

This example demonstrates the difference in results when using the Geom Match Topology tool
to update geometry that has previously been repaired with topology-based geometry cleanup
operations, for example, toggle/equivalence/replace edges, replace points, and so on.

Figure 662: Unrepaired Geometry

The geometry below was repaired using only topology-based geometry cleanup operations.
After the geometry was meshed, you can see that some of the elements have become distorted.
After untoggling the edges, there is still a large gap in the geometry.

Figure 663: Repaired Geometry
not Updated with the Geom
Match Topology Tool

Figure 664: Meshed Geometry Figure 665: Geometry with
Edges Untoggled
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The geometry below was repaired using topology-based geometry cleanup operations and then
updated with the Geom Match Topology tool. After the geometry was meshed, you can see that
there are no distorted elements. After untoggling the edges, there is not a gap in the geometry.

Figure 666: Repaired Geometry
Updated with the Geom Match
Topology Tool

Figure 667: Meshed Geometry Figure 668: Geometry with
Edges Untoggled
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Find Intersections and Penetrations
Find intersections and penetrations between geometric surfaces and solids.

1. Open the Geometry Interference Check tool.

• Click Geometry > Checks > Surfaces.

• Click Geometry > Checks > Solids.

2. In the Check Type field, select a type.

• Choose All to check all of the input entities against each other. There is only a single input
collector. This is useful when it is not known specifically what entities should be checked.
Optionally, self-interference can be included.

• Choose By pair to checks entities in the first collector against those in the second. This is
generally useful when it is known what specific entities should be checked against which other
entities, for example, surfaces in component 1 vs surfaces in component 2. Self-interference
cannot be included.

3. Use the entity selector to select geometry to check.

4. In the Interference type field, select a type.

• Choose All to check for both penetrations and intersections.

• Choose Intersections only to check for intersections.

• Choose Penetrations only to check for penetrations.

5. Define thickness options to use when calculating penetrations.

Restriction:  Only available when Interference type is set to All or Penetrations
only.

Penetration can only occur between two entities when one or both of them have an assigned
thickness. Only surfaces not associated with solids utilize a thickness.

• Choose Component to determine the thickness from the property assigned to the
component. Each component can have a different thickness.

• Choose uniform to manually enter a thickness. All surfaces will be assigned a constant
thickness value.

6. To consider the edge effects of thickness, select the Include edge effects checkbox.

Figure 669: Include Edge Effects On

By default, the edge effects of thickness are not considered.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Geometry p.1683

Figure 670: Include Edge Effects Off

7. In the Isolate only failed field, select a method for managing the display of entities that failed the
check.

• Choose None to not change the display.

• Choose Components to isolate the components that contain failed surfaces, and hide all
other entities.

• Choose Surfaces to isolate failed surfaces (and any associated solids), and hide all other
entities.

8. In the Save failed field, select a method for saving entities that failed the check.

Tip:

Use the retrieve option in other panels' advanced entity selection menus to retrieve
the saved entities.

• Choose None to not save any failed entities to the user mark.

• Choose Components to save the components that contain failed surfaces to the user mark.

• Choose Surfaces to save failed surfaces to the user mark.

• Choose Both to save both components and surfaces to the user mark.

9. Click Run.
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Setup CAD Models with Metadata
Use metadata generated as part of the CAD import process to setup CAE models.

Rename Components from Metadata Attached to
Components

1. From the menu bar, click Geometry > Metadata to CAE.
The Metadata to CAE dialog opens.

2. For Create, select Part Names.

3. For From, select Components.

4. For Metadata, select a specific metadata name.
A list of entities is generated.

5. In the table, select entities to operate on.

6. Click Apply.

The new names are taken as the values of the specified metadata attached to each selected component.
If there are duplicate names, an incremental name is generated.

Renumber Components from Metadata Attached to
Components

1. From the menu bar, click Geometry > Metadata to CAE.
The Metadata to CAE dialog opens.

2. For Create, select Part IDs.

3. For From, select Components.

4. For Metadata, select a specific metadata name.
A list of entities is generated.

5. In the table, select entities to operate on.
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6. Click Apply.

The new IDs are taken as the values of the specified metadata attached to each selected component. If
there are duplicate IDs, the entities will not be renumbered.

Create Regions from Geometry with Associated Metadata
1. From the menu bar, click Geometry > Metadata to CAE.

The Metadata to CAE dialog opens.

2. For Create, select Regions.

3. For From, select a type of geometry.

4. For Metadata, select a specific metadata name.
A list of entities is generated.

5. In the table, select entities to create regions from.

6. Click Apply.

Create Spot Connectors from Points with Associated
Metadata

1. From the menu bar, click Geometry > Metadata to CAE.
The Metadata to CAE dialog opens.

2. For Create, select Connectors.

3. For From, select Points.

4. For Metadata, select a specific metadata name.
A list of points is generated.

5. In the table, select the points to create spot connectors from.

6. Click Apply.

Spot connectors are created from the selected points using components as links based on proximity. By
default, HyperMesh uses two links. You can modify and/or realize the connectors using the Connector
Browser or connector panels.

Create Seam Connectors from Lines with Associated
Metadata

1. From the menu bar, click Geometry > Metadata to CAE.
The Metadata to CAE dialog opens.

2. For Create, select Connectors.

3. For From, select Lines.

4. For Metadata, select a specific metadata name.
A list of lines is generated.
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5. In the table, select the lines to create seam connectors from.

Figure 671:

6. Click Apply.

Seam connectors are created from selected lines using components as links based on proximity. By
default, HyperMesh uses a spacing of 1.0. You can modify and/or realize the connectors using the
Connector Browser or connector panels.

Create Area Connectors from Surfaces with Associated
Metadata

1. From the menu bar, click Geometry > Metadata to CAE.
The Metadata to CAE dialog opens.

2. For Create, select Connectors.

3. For From, select Surfaces.

4. For Metadata, select a specific metadata name.
A list of surfaces is generated.

5. In the table, select the surfaces to create area connectors from.
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Figure 672:

6. Click Apply.

Area connectors are created from selected surfaces using components as links based on proximity. You
can modify and/or realize the connectors using the Connector Browser or connector panels. By default,
a quad mesh with an element size of 10.0 is used.
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Meshing

Learn about the different types of mesh you can create in HyperMesh.

This chapter covers the following:

• Elements  (p. 1689)

• Criteria and Parameter Settings  (p. 1777)

• SPH Meshing  (p. 1808)

• Line Meshing  (p. 1816)

• Surface Meshing  (p. 1823)

• Volume Meshing  (p. 1882)

• Mesh Controls  (p. 1917)

• Check Mesh Quality  (p. 1992)

• Edit Mesh  (p. 2042)

• Batchmesher  (p. 2082)

Models are typically meshed automatically, but individual elements can also be modified manually to
improve element quality in problem areas.

Meshing is organized by the type of mesh operation involved.
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Elements
Elements are FE idealizations for a portion of a physical part.

Every element must be organized into one component, and therefore are mutually exclusive to a
component.

Element Configurations
Each element has an associated element configuration. An element configuration tells HyperMesh how
to draw, store, and work with the element.

Bar Elements
1D elements created in a space between two or three nodes of a model where beam properties are
desired.

The nodes are related to each other based on the properties of the bar or beam element connecting
them. Properties associated with bar elements include vector orientation, offset vectors that end at A
and B, or at A, B, and C, and pin flags to tell it what degree of freedom should carry through the beam.

Bar elements are displayed as a line between two nodes with BAR2 or BAR3 written at the centroid of
the element.

Bar2
Configuration 60 - 1D (1st order) elements with 2 nodes used to model axial, bending, and
torsion behavior. Bar2 elements have a property reference, an orientation vector, offset vectors
and ends A and B, and pin flags at ends A and B.

Bar3
Configuration 63 - 1D (2nd order) elements with 3 nodes used to model axial, bending, and
torsion behavior. Bar3 elements have a property reference, an orientation vector, offset vectors
and ends A and B, and pin flags at ends A and B.

Gap Elements
Configuration 70 - 1D elements created in a space between two nodes, or between a node and an
element, of a model where contact may occur.

Create a gap element when you want to impose a nonlinear constraint on a model; this constraint will
limit the amount of movement possible during analysis.

Gap elements have a property reference and an orientation vector.

Gap elements are displayed as a line between two nodes with GAP written at the centroid of the
element.
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Gap elements can translate to CGAP or CGAPG elements in OptiStruct, CGAP element in Nastran or *GAP
option in Abaqus.

Hex Elements
3D hexahedra elements.

Hex8
Configuration 208 - 3D (1st order) hexahedra elements with 8 nodes ordered HyperMesh.

Figure 673:

Hex20
Configuration 220 - 3D (2nd order) hexahedra elements with 20 nodes ordered in HyperMesh.
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Figure 674: Element Configuration 220, 20-Noded Hexa

Joint Elements
Configuration 22 - 1D elements with 2, 4, or 6 nodes which have a property and orientation systems or
nodes.

Joint element is a definition of a connection between two rigid bodies. Joint elements store a property
and orientation information.

Joint elements are displayed with lines between the appropriate nodes and the letter J between nodes 1
and 3 of the element.

Only certain types of elements can be used to create joint elements. The type of the element controls
the number of nodes used in the element and the permissible orientations of the element.

Table 191: Types of Joint Elements

Type Type Name Number of
Nodes

Orientation Solver Interface

1 Spherical joint 2 None

Systems

Nodes

LS-DYNA

PAM-CRASH

2 Revolute joint 4 None

Systems

LS-DYNA

3 Cylindrical joint 4 None

Systems

LS-DYNA

4 Planar joint 4 None

Systems

LS-DYNA
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Type Type Name Number of
Nodes

Orientation Solver Interface

5 Universal joint 4 None

Systems

LS-DYNA

6 Translational joint 6 None

Systems

LS-DYNA

7 Locking joint 6 None

Systems

LS-DYNA

8 Ball joint 2 None OptiStruct

9 Fixed joint 2 None OptiStruct

10 Revolute joint 2 Node

Vector

Coordinates

OptiStruct

11 Translational1 joint 2 Node

Vector

Coordinates

OptiStruct

12 Cylindercal 1 joint 2 Node

Vector

Coordinates

OptiStruct

13 Universal joint 2 Node

Vector

Coordinates

OptiStruct

14 Constant_velocity joint 2 Node

Vector

Coordinates

OptiStruct

15 Planar joint 2 Node

Vector

Coordinates

OptiStruct

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1693

Type Type Name Number of
Nodes

Orientation Solver Interface

16 Inline joint 2 Node

Vector

Coordinates

OptiStruct

17 Perpendicular joint 2 Node

Vector

Coordinates

OptiStruct

18 Parallel axes joint 2 Node

Vector

Coordinates

OptiStruct

19 Inplane joint 2 Node

Vector

Coordinates

OptiStruct

20 Orient joint 2 Node

Vector

Coordinates

OptiStruct

21 Point_to_curve joint 2 Node

Vector

Coordinates

OptiStruct

22 Curve_to_curve joint 2 Node

Vector

Coordinates

OptiStruct

23 Point_to_deformable_curve
joint

2 Node

Vector

Coordinates

OptiStruct

24 Point_to_deformable_surface
joint

2 Node

Vector

Coordinates

OptiStruct
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Type Type Name Number of
Nodes

Orientation Solver Interface

25 Translational_2N joint 2 None

Systems

PAM-CRASH

26 Revolute_2N joint 2 None

Systems

PAM-CRASH

27 Cylindrical_2N joint 2 None

Systems

PAM-CRASH

28 Universal_2N joint 2 None

Systems

PAM-CRASH

29 Flexion-Torsion joint 2 None

Systems

PAM-CRASH

30 Planar_2N joint 2 None

Systems

PAM-CRASH

31 General joint 2 None

Systems

PAM-CRASH

32 Bracket joint 2 None

Systems

PAM-CRASH

33 Free joint 2 None

Systems

PAM-CRASH

Mass Elements
Configuration 1 - 0D elements with a single node that allow you to assign concentrated mass to the
model in order to represent a physical part that may not be modeled with another FE idealization.

Mass elements are displayed as a dot with the letter M written at the centroid of the element.

Master Elements
Master interface elements.
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Master3
Configuration 123 - Master interface elements with 3 nodes. (Must be Type 1).

Master4
Configuration 124 - Master4 elements are master interface elements with 4 nodes. (Must be Type
1).

Penta Elements
3D triangular prism pentahedra elements.

Penta6
Configuration 206 - 3D (1st order) triangular prism pentahedra elements with 6 nodes ordered in
HyperMesh.

Figure 675: Element Configuration 206, 6-Noded Penta

Penta15
Configuration 215 - 3D (2nd order) triangular prism pentahedra elements with 15 nodes ordered
in HyperMesh.

Figure 676: Element Configuration 215, 15-Noded Penta

Plot Elements
Configuration 2 - 1D elements with 2 nodes used for display purposes.
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Plot elements are displayed as a line between two nodes.

Pyramid Elements
3D pyramid pentahedra elements.

Pyramid5
Configuration 205 - 3D (1st order) pyramid pentahedra elements with 5 nodes ordered in
HyperMesh.

Figure 677: Element Configuration 205, 5-Noded Pyramid

Pyramid13
Configuration 213 - 3D (2nd order) pyramid pentahedra elements with 5 nodes ordered in
HyperMesh.

Figure 678: Element Configuration 213, 13-Noded Pyramid

Quad Elements
2D quadrilateral elements.
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Types of pyramid elements include:

Quad4
Configuration 104 - 2D (1st order) quadrilateral elements with 4 nodes ordered in HyperMesh.

Figure 679: Element Configuration 104, 4-Noded Quad

Quad8
Configuration 108 - 2D (2nd order) quadrilateral elements with 8 nodes ordered in HyperMesh.

Figure 680: Element Configuration 108, 8-Noded Quad

RBE3 Elements
Configuration 56 - Rigid elements with one dependent node and variable independent nodes typically
used to define the motion at the dependent node as a weighted average of the motions at the
independent nodes.

Both the dependent node and independent nodes contain a coefficient (weighting factor) and user-
defined degrees of freedom. The dependent degrees of freedom and weighting factors can be specified
or automatically calculated based on the geometry.

RBE3 elements are displayed as lines between the dependent node and the independent node(s) with
RBE3 displayed at the dependent node of the element.

RBE3’s are typically used to distribute loads applied on the dependent node amongst the selected
independent nodes.
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Note:  The dependent node cannot be directly constrained, as this would lead to a double-
dependency for that node.

Rigid Elements
Configuration 5 - Rigid 1D elements with 2 nodes used to model rigid connections.

Rigid elements are displayed as a line between two nodes with the letter R written at the centroid of the
element.

Rigids can translate to RBE2 in Nastran or *MPC in Abaqus.

Rigidlink Elements
Configuration 55 - Rigid elements with one independent node and variable dependent nodes typically
used to model rigid bodies.

Rigidlink elements have user-defined degrees of freedom which apply to all dependent nodes.

Rigidlink elements can be created with dependent nodes attached to an element as a SET. If a rigid link
with a dependent node set is deleted, the associated node set is also deleted. If the dependent node
set is deleted, the connected rigid link element is also deleted. Dependent node sets are automatically
created when rigid link elements are created. A node set can be connected as a set of dependent nodes
to a rigid link element independent node.

Note:  Two-node rigids with a dependent node set attached are always created as rigid link
elements

Rigidlink elements are displayed as lines between the independent node and the dependent node(s)
with RL displayed at the independent node of the element.

Rod Elements
Configuration 61 - 1D elements with 2 nodes used to model axial behavior only.

The two nodes are related to each other based on the properties of the rod element connecting them.
Rod elements have property pointers.

Rod elements are displayed as a line between two nodes with ROD written at the centroid of the
element.

Rods can translate to CTUBES in Nastran or a C1D2 element in Abaqus.

Slave Elements
Slave interface elements.

Slave1
Configuration 135 - Slave interface elements with 1 node. (Must be Type 1).

Slave3
Configuration 133 - Slave interface elements with 3 node. (Must be Type 1).
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Slave4
Configuration 134 - Slave interface elements with 1 node. (Must be Type 1).

Spring Elements
Configuration 21 - 1D elements used to model spring connections.

Spring elements have user-defined degrees of freedom, an orientation vector, and a property reference.

Spring elements are displayed as a line between two nodes with the letter K written at the centroid of
the element.

Spring
1D elements with 2 nodes used to model spring connections.

Spring2N
1D elements with 2 nodes used to model spring connections.

Spring3N
1D elements with 3 nodes used to model spring connections.
The third node serves as the direction node.

Spring4N
1D elements with 4 nodes used to model spring connections.
This type of element will mostly be considered as joints, based on the property it is assigned.

Springs can translate to CELAS2 in Nastran or *SPRING in Abaqus.

Tetra Elements
3D tetrahedra elements.

Tetra4
Configuration 204 - 3D (1st order) tetrahedra elements with 4 nodes ordered in HyperMesh.

Figure 681: Element Configuration 204, 4-Noded Tetra

Tetra10
Configuration 210 - 3D (2nd order) tetrahedra elements with 10 nodes ordered in HyperMesh.
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Figure 682: Element Configuration 210, 10-Noded Tetra

Tria Elements
2D triangular elements.

Tria3
Configuration 103 - 2D (1st order) triangular elements with 3 nodes ordered in HyperMesh.

Figure 683: Element Configuration 103, 3-Noded Tria

Tria6
Configuration 106 - 2D (2nd order) triangular elements with 6 nodes ordered in HyperMesh.
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Figure 684: Element Configuration 106, 6-Noded Tria

Weld Elements
Configuration 3 - Rigid 1D elements with 2 nodes used to model welded connections.

Weld elements are displayed as a line between two nodes with the letter W written at the centroid of
the element.

Xelems
1D multi-strand elements.

Supported Solver Cards
Solver cards supported for elements.

Abaqus Cards

Card Supported Element
Configurations

Description

*COUPLING Rigid/RBE3 Define a surface-based coupling constraint where
the *SURFACE card points to elements.

Note:  The *COUPLING is also
supported as rigid elements
(COUP_KIN) and RBE3 (COUP_DIS)
when *SURFACE points to nodes.

*ELEMENT Bar2

Bar3

Gap (Standard
2D/3D)

Defines elements by giving their nodes.
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Card Supported Element
Configurations

Description

Hex20 (Standard
3D)

Hex8 (Standard 3D/
Explicit)

Mass

Penta15 (Standard
3D)

Penta6 (Standard
3D/Explicit)

Pyramid13
(Standard 3D)

Pyramid5 (Standard
3D/Explicit)

Quad4

Quad8 (Standard
2D/3D)

RBE3

Rigid

Rod

Spring

Tetra10 (Standard
3D/Explicit)

Tetra4 (Standard
3D/Explicit)

Tria3

Tria6 (Standard
2D/3D)

*ELGEN Generates elements incrementally.

These cards are resolved to individual entities on
import and are written back on export the same
way.

Note:  Standard 2D only.

*MPC Rigid Defines multi-point constraints.

*RELEASE Bar2 Releases rotational degrees of freedom at one or
both ends of a beam element.
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Bar3 For 2D problems, only dof6 (M1) is active.

Add a *RELEASE card to this element by clicking
pins a = and pins b = and type in the HyperMesh
dof code for the Abaqus release combination code
you want.

HyperMesh dof Code

Abaqus Release Combination Code

4
T

5
M2

45
M2-T

6
M1

46
M1-T

56
M1-M2

456
ALLM

For 2D problems, only dof6 (M1) is active.

AC1D2 Bar2 2-node acoustic link

AC1D3 Bar3 3-node acoustic link

AC2D3 Tria3 3-node linear 2-D acoustic triangle

AC2D4 Quad4 4-node linear 2-D acoustic quadrilateral

AC2D6 Tria6 6-node quadratic 2-D acoustic triangular prism

AC2D8 Quad8 8-node quadratic 2-D acoustic quadrilateral

AC3D10 Tetra10 10-node quadratic acoustic tetrahedron

AC3D15 Pyramid13

Penta15

15-node quadratic acoustic triangular prism
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Configurations
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AC3D20 Pyramid13

Hex20

20-node quadratic acoustic brick

AC3D4 Tetra4 4-node linear acoustic tetrahedron

AC3D6 Penta6 6-node linear acoustic triangular prism

AC3D8 Hex8 8-node linear acoustic brick

AC3D8R Hex8

ACAX3 Tria3 3-node linear axisymmetric acoustic triangle

ACAX4 Quad4 4-node linear axisymmetric acoustic quadrilateral

ACAX6 Tria6 6-node quadratic axisymmetric acoustic triangle

ACAX8 Quad8 8-node quadratic axisymmetric acoustic
quadrilateral

ACIN3D3 Tria3 3-node linear 3D acoustic infinite element

ACIN3D4 Quad4 4-node linear 3D acoustic infinite element

ACIN3D6 Tria6 6-node quadratic 3D acoustic infinite element

ACIN3D8 Quad8 8-node quadratic 3D acoustic infinite element

B21 Bar2 2-node linear beam in a plane

B21H Bar2 2-node linear beam in a plane, hybrid formulation

B22 Bar3 3-node quadratic beam in a plane

B22H Bar3 3-node quadratic beam in a plane, hybrid
formulation

B23 Bar2 2-node cubic beam in a plane

B23H Bar2 2-node cubic beam in a plane, hybrid formulation

B31 Bar2 2-node linear beam

B31H Bar2 2-node linear beam, hybrid formulation

B31OS Bar2 2-node linear open-section beam
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B31OSH Bar2 2-node linear open-section beam, hybrid
formulation

B32 Bar3 3-node quadratic beam in space

B32 Bar3 3-node quadratic beam

B32H Bar3 3-node quadratic beam, hybrid formulation

B32OS Bar3 3-node quadratic open-section beam

B32OSH Bar3 3-node quadratic open-section beam, hybrid
formulation

B33 Bar2 2-node cubic beam

B33H Bar2 2-node cubic beam, hybrid formulation

BEAM Rigid

C3D10 Tetra10 10-node quadratic tetrahedron

C3D10E Tetra10 10-node quadratic piezoelectric tetrahedron

C3D10H Tetra10 10-node quadratic tetrahedron, hybrid, constant
pressure

C3D10HS Tetra10

C3D10I Tetra10 10-node general-purpose quadratic tetrahedron,
improved surface stress visualization

C3D10M Tetra10 10-node modified tetrahedron, hourglass control

C3D10MH Tetra10 10-node modified quadratic tetrahedron, hybrid,
linear pressure, hourglass control

C3D10MP Tetra10 10-node modified displacement and pore pressure
tetrahedron, hourglass control

C3D10MPH Tetra10 10-node modified displacement and pore pressure
tetrahedron, hybrid, linear pressure, hourglass
control

C3D10MT Tetra10 10-node thermally coupled modified quadratic
tetrahedron, hourglass control

C3D10S
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C3D15 Pyramid13

Penta15

15-node quadratic triangular prism

C3D15E Pyramid13

Penta15

15-node quadratic piezoelectric triangular prism

C3D15H Pyramid13

Penta15

15-node quadratic triangular prism, hybrid, linear
pressure

C3D20 Pyramid13

Penta15

Hex20

20-node quadratic brick

C3D20E Pyramid13

Hex20

20-node quadratic piezoelectric brick

C3D20H Pyramid13

Hex20

20-node quadratic brick, hybrid, linear pressure

C3D20HT Pyramid13

Hex20

20-node thermally coupled brick, triquadratic
displacement, trilinear temperature, hybrid, linear
pressure

C3D20PH Hex20 20-node brick, triquadratic displacement, trilinear
pore pressure, hybrid, linear pressure

C3D20R Pyramid13

Penta15

Hex20

20-node quadratic brick, reduced integration

C3D20RE Pyramid13

Hex20

20-node quadratic piezoelectric brick, reduced
integration

C3D20RH Pyramid13

Hex20

20-node quadratic brick, hybrid, linear pressure,
reduced integration
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Configurations

Description

C3D20RHT Pyramid13

Hex20

20-node thermally coupled brick, triquadratic
displacement, trilinear temperature, hybrid, linear
pressure, reduced integration

C3D20RP Hex20 20-node brick, triquadratic displacement, trilinear
pore pressure, reduced integration

C3D20RPH Hex20 20-node brick, triquadratic displacement, trilinear
pore pressure, hybrid, linear pressure, reduced
integration

C3D20RT Pyramid13

Hex20

20-node thermally coupled brick, triquadratic
displacement, trilinear temperature, reduced
integration

C3D20T Pyramid13

Hex20

20-node thermally coupled brick, triquadratic
displacement, trilinear temperature

C3D30P Hex20 20-node brick, triquadratic displacement, trilinear
pore pressure

C3D4 Tetra4 4-node linear tetrahedron

C3D4E Tetra4 4-node linear piezoelectric tetrahedron

C3D4H Tetra4 4-node linear tetrahedron, hybrid, linear pressure

C3D4P Tetra4

C3D4T Tetra4 4-node thermally coupled tetrahedron, linear
displacement and temperature

C3D6 Pyramid5

Penta6

6-node linear triangular prism

C3D6E Pyramid5

Penta6

6-node linear piezoelectric triangular prism

C3D6H Pyramid5

Penta6

6-node linear triangular prism, hybrid, constant
pressure

C3D6P Penta6
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C3D6T Penta6 6-node thermally coupled triangular prism, linear
displacement and temperature

C3D8 Pyramid5

Penta6

Hex8

8-node linear brick

C3D8E Pyramid5

Hex8

8-node linear piezoelectric brick

C3D8H Pyramid5

Hex8

8-node linear brick, hybrid, constant pressure

C3D8HS Hex8

C3D8HT Pyramid5

Hex8

8-node thermally coupled brick, trilinear
displacement and temperature, hybrid, constant
pressure

C3D8I Pyramid5

Hex8

8-node linear brick, incompatible modes

C3D8IH Pyramid5

Hex8

8-node linear brick, hybrid, linear pressure,
incompatible modes

C3D8P Hex8 8-node brick, trilinear displacement, trilinear pore
pressure

C3D8PH Hex8 8-node brick, trilinear displacement, trilinear pore
pressure, hybrid, constant pressure

C3D8R Pyramid5

Penta6

Hex8

8-node linear brick, reduced integration, hourglass
control

C3D8RH Pyramid5

Hex8

8-node linear brick, hybrid, constant pressure,
reduced integration, hourglass control

C3D8RHT Pyramid5 8-node thermally coupled brick, trilinear
displacement and temperature, reduced
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Hex8 integration, hourglass control, hybrid, constant
pressure

C3D8RHT Pyramid5 8-node thermally coupled brick, trilinear
displacement and temperature, reduced
integration, hourglass control, hybrid, constant
pressure

C3D8RP Hex8 8-node brick, trilinear displacement, trilinear pore
pressure, reduced integration

C3D8RPH Hex8 8-node brick, trilinear displacement, trilinear pore
pressure, reduced integration, hybrid, constant
pressure

C3D8RT Pyramid5

Hex8

8-node thermally coupled brick, trilinear
displacement and temperature, reduced
integration, hourglass control

C3D8S Hex8

C3D8T Pyramid5

Hex8

8-node thermally coupled brick, trilinear
displacement and temperature

CAX3 Tria3 3-node linear axisymmetric triangle

CAX3E Tria3 3-node linear axisymmetric piezoelectric triangle

CAX3H Tria3 3-node linear axisymmetric triangle, hybrid,
constant pressure

CAX3T Tria3 3-node axisymmetric thermally coupled triangle,
linear displacement and temperature

CAX4 Quad4 4-node bilinear axisymmetric quadrilateral

CAX4E Quad4 4-node bilinear axisymmetric piezoelectric
quadrilateral

CAX4H Quad4 4-node bilinear axisymmetric quadrilateral, hybrid,
constant pressure

CAX4HT Quad4 4-node axisymmetric thermally coupled
quadrilateral, bilinear displacement and
temperature, hybrid, constant pressure
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CAX4I Quad4 4-node bilinear axisymmetric quadrilateral,
incompatible modes

CAX4IH Quad4 4-node bilinear axisymmetric quadrilateral, hybrid,
linear pressure, incompatible modes

CAX4R Tria3

Quad4

4-node bilinear axisymmetric quadrilateral,
reduced integration, hourglass control

CAX4RH Quad4 4-node bilinear axisymmetric quadrilateral, hybrid,
constant pressure, reduced integration, hourglass
control

CAX4T Quad4 4-node axisymmetric thermally coupled
quadrilateral, bilinear displacement and
temperature

CAX6 Tria6 6-node quadratic axisymmetric triangle

CAX6H Tria6 6-node quadratic axisymmetric triangle, hybrid,
linear pressure

CAX6M Tria6 6-node modified axisymmetric triangle, hourglass
control

CAX6MH Tria6 6-node modified quadratic axisymmetric triangle,
hybrid, linear pressure, hourglass control

CAX8 Quad8 8-node biquadratic axisymmetric quadrilateral

CAX8H Quad8 8-node biquadratic axisymmetric quadrilateral,
hybrid, linear pressure

CAX8HT Quad8 8-node axisymmetric thermally coupled
quadrilateral, biquadratic displacement, bilinear
temperature, hybrid, linear pressure

CAX8R Quad8 8-node biquadratic axisymmetric quadrilateral,
reduced integration

CAX8RH Quad8 8-node biquadratic axisymmetric quadrilateral,
hybrid, linear pressure, reduced integration

CAX8RHT Quad8 8-node axisymmetric thermally coupled
quadrilateral, biquadratic displacement, bilinear
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temperature, hybrid, linear pressure, reduced
integration

CAX8RT Quad8 8-node axisymmetric thermally coupled
quadrilateral, biquadratic displacement, bilinear
temperature, reduced integration

CAX8T Quad8 8-node axisymmetric thermally coupled
quadrilateral, biquadratic displacement, bilinear
temperature

CAXA41 Quad4

CAXA4H1 Quad4

CAXA4R1 Quad4

CAXA4RH1 Quad4

CAXA81 Quad8

CAXA8H1 Quad8

CAXA8P1 Quad8

CAXA8R1 Quad8

CAXA8R4 Quad8

CAXA8RH1 Quad8

CAXA8RH4 Quad8

CAXA8RP1 Quad8

CCL12 Hex8 12-node cylindrical brick

CGAX3 Tria3 3-node generalized linear axisymmetric triangle,
twist

CGAX3H Tria3 3-node generalized linear axisymmetric triangle,
hybrid, constant pressure, twist

CGAX4 Quad4 4-node generalized bilinear axisymmetric
quadrilateral, twist

CGAX4H Quad4 4-node generalized bilinear axisymmetric
quadrilateral, hybrid, constant pressure, twist
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CGAX4R Quad4 4-node generalized bilinear axisymmetric
quadrilateral, reduced integration, hourglass
control, twist

CGAX4RH Quad4 4-node generalized bilinear axisymmetric
quadrilateral, hybrid, constant pressure, reduced
integration, hourglass control, twist

CGAX6 Tria6 6-node generalized quadratic axisymmetric
triangle, twist

CGAX6H Tria6 6-node generalized quadratic axisymmetric
triangle, hybrid, linear pressure, twist

CGAX8 Quad8 8-node generalized biquadratic axisymmetric
quadrilateral, twist

CGAX8H Quad8 8-node generalized biquadratic axisymmetric
quadrilateral, hybrid, linear pressure, twist

CGAX8R Quad8 8-node generalized biquadratic axisymmetric
quadrilateral, reduced integration, twist

CGAX8RH Quad8 8-node generalized biquadratic axisymmetric
quadrilateral, hybrid, linear pressure, reduced
integration, twist

CGAX8T Quad8 8-node generalized axisymmetric thermally
coupled quadrilateral, biquadratic displacement,
bilinear temperature, twist

COH2D4 Quad4 4-node two-dimensional cohesive element

COH3D6 Penta6 6-node three-dimensional cohesive element

COH3D8 Hex8 8-node three-dimensional cohesive element

COHAX4 Quad4 4-node axisymmetric cohesive element

CONN2D2 Mass

Rod

Connector element in a plane between two nodes
or ground and a node

CONN3D2 Mass

Rod

Connector element in space between two nodes or
ground and a node
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COUP_DIS rbe3

COUP_KIN Rigid

CPE Quad4

CPE3 Tria3 3-node linear plane strain triangle

CPE3E Tria3 3-node linear plane strain piezoelectric triangle

CPE3H Tria3 3-node linear plane strain triangle, hybrid,
constant pressure

CPE4E Quad4 4-node bilinear plane strain piezoelectric
quadrilateral

CPE4HT Quad4 4-node plane strain thermally coupled
quadrilateral, bilinear displacement and
temperature, hybrid, constant pressure

CPE4I Quad4 4-node bilinear plane strain quadrilateral,
incompatible modes

CPE4IH Quad4 4-node bilinear plane strain quadrilateral, hybrid,
linear pressure, incompatible modes

CPE4P Quad4 4-node plane strain quadrilateral, bilinear
displacement, bilinear pore pressure

CPE4PH Quad4 4-node plane strain quadrilateral, bilinear
displacement, bilinear pore pressure, hybrid,
constant pressure

CPE4R Quad4 4-node bilinear plane strain quadrilateral, reduced
integration, hourglass control

CPE4RH Quad4 4-node bilinear plane strain quadrilateral, hybrid,
constant pressure, reduced integration, hourglass
control

CPE4RP Quad4 4-node plane strain quadrilateral, bilinear
displacement, bilinear pore pressure, reduced
integration, hourglass control

CPE4RPH Quad4 4-node plane strain quadrilateral, bilinear
displacement, bilinear pore pressure, hybrid,
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constant pressure, reduced integration, hourglass
control

CPE4T Quad4 4-node plane strain thermally coupled
quadrilateral, bilinear displacement and
temperature

CPE6 Tria6 6-node quadratic plane strain triangle

CPE6H Tria6 6-node quadratic plane strain triangle, hybrid,
linear pressure

CPE6M Tria6 6-node modified quadratic plane strain triangle,
hourglass control

CPE6MH Tria6 6-node modified quadratic plane strain triangle,
hybrid, linear pressure, hourglass control

CPE6MP Tria6 6-node modified displacement and pore pressure
plane strain triangle, hourglass control

CPE6MPH Tria6 6-node modified displacement and pore pressure
plane strain triangle, hybrid, linear pressure,
hourglass control

CPE8 Quad8 8-node biquadratic plane strain quadrilateral

CPE8H Quad8 8-node biquadratic plane strain quadrilateral,
hybrid, linear pressure

CPE8P Quad8 8-node plane strain quadrilateral, biquadratic
displacement, bilinear pore pressure

CPE8PH Quad8 8-node plane strain quadrilateral, biquadratic
displacement, bilinear pore pressure, hybrid,
linear pressure stress

CPE8R Quad8 8-node biquadratic plane strain quadrilateral,
reduced integration

CPE8RH Quad8 8-node biquadratic plane strain quadrilateral,
hybrid, linear pressure, reduced integration

CPE8RP Quad8 8-node plane strain quadrilateral, biquadratic
displacement, bilinear pore pressure, reduced
integration

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1715

Card Supported Element
Configurations

Description

CPE8RPH Quad8 8-node biquadratic displacement, bilinear pore
pressure, reduced integration, hybrid, linear
pressure

CPEG3 Tria3 3-node linear generalized plane strain triangle

CPEG4R Quad4 4-node bilinear generalized plane strain
quadrilateral, reduced integration, hourglass
control

CPH4H Quad4

CPS3 Tria3 3-node linear plane stress triangle

CPS3E 3-node linear plane stress piezoelectric triangle

CPS4 Quad4 4-node bilinear plane stress quadrilateral

CPS4E Quad4 4-node bilinear plane stress piezoelectric
quadrilateral

CPS4I Quad4 4-node bilinear plane stress quadrilateral,
incompatible modes

CPS4R Quad4 4-node bilinear plane stress quadrilateral, reduced
integration, hourglass control

CPS4T Quad4 4-node plane stress thermally coupled
quadrilateral, bilinear displacement and
temperature

CPS6 Tria6 6-node quadratic plane stress triangle

CPS6M Tria6 6-node modified second-order plane stress
triangle, hourglass control

CPS8 Quad8 8-node biquadratic plane stress quadrilateral

CPS8R Quad8 8-node biquadratic plane stress quadrilateral,
reduced integration

DASHPOT1 Mass Dashpot between a node and ground, acting in a
fixed direction

DASHPOT2 Spring Dashpot between two nodes, acting in a fixed
direction
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DASHPOTA Spring Axial dashpot between two nodes, whose line of
action is the line joining the two nodes

DC1D2 Bar2 2-node heat transfer link

DC1D3 Bar3 3-node heat transfer link

DC2D3 Tria3 3-node linear heat transfer triangle

DC2D3E Tria3 3-node linear coupled thermal-electrical triangle

DC2D4 Quad4 4-node linear heat transfer quadrilateral

DC2D4E Quad4 4-node linear coupled thermal-electrical
quadrilateral

DC2D6 Tria6 6-node quadratic heat transfer triangle

DC2D6E Tria6 6-node quadratic coupled thermal-electrical
triangle

DC2D8 Quad8 8-node quadratic heat transfer quadrilateral

DC2D8E Quad8 8-node quadratic coupled thermal-electrical
quadrilateral

DC3D10 Tetra10 10-node quadratic heat transfer tetrahedron

DC3D10E Tetra10 10-node quadratic coupled thermal-electrical
tetrahedron

DC3D15 Penta15 15-node quadratic heat transfer triangular prism

DC3D15E Penta15 15-node quadratic coupled thermal-electrical
triangular prism

DC3D20 Hex20 20-node quadratic heat transfer brick

DC3D20E Hex20 20-node quadratic coupled thermal-electrical brick

DC3D4 Tetra4 4-node linear heat transfer tetrahedron

DC3D4E Tetra4 4-node linear coupled thermal-electrical
tetrahedron

DC3D6 Penta6 6-node linear heat transfer triangular prism
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DC3D6E Penta6 6-node linear coupled thermal-electrical triangular
prism

DC3D8 Hex8 8-node linear heat transfer brick

DC3D8E Hex8 8-node linear coupled thermal-electrical brick

DCAX3 Tria3 3-node linear axisymmetric heat transfer triangle

DCAX3E Tria3 3-node linear axisymmetric coupled thermal-
electrical triangle

DCAX4 Quad4 4-node linear axisymmetric heat transfer
quadrilateral

DCAX4E Quad4 4-node linear axisymmetric coupled thermal-
electrical quadrilateral

DCAX6 Tria6 6-node quadratic axisymmetric heat transfer
triangle

DCAX6E Tria6 6-node quadratic axisymmetric coupled thermal-
electrical triangle

DCAX8 Quad8 8-node quadratic axisymmetric heat transfer
quadrilateral

DCAX8E Quad8 8-node quadratic axisymmetric coupled thermal-
electrical quadrilateral

DCC3D8 Hex8 8-node convection/diffusion brick

DCC3D8D Hex8 8-node convection/diffusion brick, dispersion
control

DCCAX4 Quad4 4-node axisymmetric convection/diffusion
quadrilateral

DCCAX4D Quad4 4-node axisymmetric convection/diffusion
quadrilateral, dispersion control

DCOUP2D rbe3 Two-dimensional distributing coupling element

DCOUP3D rbe3 Three-dimensional distributing coupling element

DS3 Tria3 3-node heat transfer triangular shell

DS4 Quad4 4-node heat transfer quadrilateral shell
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DS6 Tria6 6-node heat transfer triangular shell

DS8 Quad8 8-node heat transfer quadrilateral shell

EC3D8R Hex8

EC3D8RT Hex8

ELBOW31 Bar2 2-node pipe in space with deforming section,
linear interpolation along the pipe

ELBOW31B Bar2 2-node pipe in space with ovalization only, axial
gradients of ovalization neglected

ELBOW31C Bar2 2-node pipe in space with ovalization only, axial
gradients of ovalization neglected

ELBOW32 Bar3 3-node pipe in space with deforming section,
quadratic interpolation along the pipe

F2D2 Bar2

F3D3 Tria3 3-node linear 3-D triangular hydrostatic fluid
element

F3D4 Quad4 4-node linear 3-D quadrilateral hydrostatic fluid
element

FAX2 Bar2 2-node linear axisymmetric hydrostatic fluid
element

FC3D4 Tetra4

FC3D5 Pyramid5

FC3D6 Penta6

FC3D8 Hex8

GAPCYL Gap Cylindrical gap between two nodes

GAPSPHER Gap Spherical gap between two nodes

GAPUNI Gap Unidirectional gap between two nodes

GK2D2 Rod 2-node two-dimensional gasket element
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GK2D2N Rod 2-node two-dimensional gasket element with
thickness-direction behavior only

GK3D12M Penta6 12-node three-dimensional gasket element

GK3D12MN Penta6 12-node three-dimensional gasket element with
thickness-direction behavior only

GK3D18 Hex8 18-node three-dimensional gasket element

GK3D18N Hex8 18-node three-dimensional gasket element with
thickness-direction behavior only

GK3D2 Bar2 2-node three-dimensional gasket element

GK3D2N Bar2 2-node three-dimensional gasket element with
thickness-direction behavior only

GK3D4L Quad4 4-node three-dimensional line gasket element

GK3D4LN Quad4 4-node three-dimensional line gasket element with
thickness-direction behavior only

GK3D6 Penta6 6-node three-dimensional gasket element

GK3D6N Penta6 6-node three-dimensional gasket element with
thickness-direction behavior only

GK3D8 Hex8 8-node three-dimensional gasket element

GK3D8N Hex8 8-node three-dimensional gasket element with
thickness-direction behavior only

GKPE4 Quad4 4-node plane strain gasket element

GKPS4 Quad4 4-node plane stress gasket element

GKPS4N Quad4 4-node two-dimensional gasket element with
thickness-direction behavior only

HMCONN Mass

ITS

ITSCYL Rod Cylindrical geometry tube support interaction
element

ITSUNI Rod Unidirectional tube support interaction element
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ITT21 Mass Tube-tube element for use with first-order, 2-D
beam and pipe elements

ITT31 Mass Tube-tube element for use with first-order, 3-D
beam and pipe elements

JOINTC Spring Three-dimensional joint interaction element

KINCOUP Rigid

LINK Rigid

M3D3 Tria3 3-node triangular membrane

M3D4 Quad4 4-node quadrilateral membrane

M3D4R Quad4 4-node quadrilateral membrane, reduced
integration, hourglass control

M3D6 Tria6 6-node triangular membrane

M3D8 Quad8 8-node quadrilateral membrane

M3D8R Quad8 8-node quadrilateral membrane, reduced
integration

MASS Mass Point mass

MGAX1 Rod 2-node linear axisymmetric membrane, twist

MGAX2 Bar3 3-node quadratic axisymmetric membrane, twist

PC3D Mass

PIN Rigid

PIPE21 Bar2 2-node linear pipe in a plane

PIPE21H Bar2 2-node linear pipe in a plane, hybrid formulation

PIPE22 Bar3 3-node quadratic pipe in a plane

PIPE22H Bar3 3-node quadratic pipe in a plane, hybrid
formulation

PIPE31 Bar2 2-node linear pipe

PIPE31H Bar2 2-node linear pipe in space, hybrid formulation
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PIPE32 Bar3 3-node quadratic pipe in space

PIPE32H Bar3 3-node quadratic pipe in space, hybrid formulation

R2D2 Rigid

R3D3 Tria3 3-node 3-D rigid triangular facet

R3D4 Quad4 4-node 3-D bilinear rigid quadrilateral

RAX2 Rigid

RB2D2 Rigid

RB3D2 Rigid 2-node 3-D rigid beam

RDE Rigid

rbe3

2-node linear axisymmetric rigid link (for use in
axisymmetric planar geometries)

ROTARYI Mass Rotary inertia at a point

S3 Tria3 3-node triangular general-purpose shell, finite
membrane strains

S3R Tria3 3-node triangular general-purpose shell, finite
membrane strains

S3RS Tria3

S3RT Tria3 3-node thermally coupled triangular general-
purpose shell, finite membrane strains

S4 Quad4 4-node general-purpose shell, finite membrane
strains

S4R Quad4 4-node general-purpose shell, reduced integration,
hourglass control, finite membrane strains

S4R5 Quad4 4-node thin shell, reduced integration, hourglass
control, using five degrees of freedom per node

S4RS Quad4

S4RSW Quad4
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S4RT Quad4 4-node thermally coupled general-purpose shell,
reduced integration, hourglass control, finite
membrane strains

S4T Quad4 4-node thermally coupled general-purpose shell,
finite membrane strains

S8R Quad8 8-node doubly curved thick shell, reduced
integration

S8R5 Quad8 8-node doubly curved thin shell, reduced
integration, using five degrees of freedom per
node

S8RT Quad8 8-node thermally coupled quadrilateral general
thick shell, biquadratic displacement, bilinear
temperature in the shell surface

SAX1 Bar2 2-node linear axisymmetric thin or thick shell

SAX2 Bar3 3-node quadratic axisymmetric thin or thick shell

SC6R Penta6 6-node triangular in-plane continuum shell wedge,
general-purpose continuum shell, finite membrane
strains

SC6RT Penta6 6-node linear displacement and temperature,
triangular in-plane continuum shell wedge,
general-purpose continuum shell, finite membrane
strains

SC8R Hex8 8-node quadrilateral in-plane general-purpose
continuum shell, reduced integration with
hourglass control, finite membrane strains

SC8RT Hex8 8-node linear displacement and temperature,
quadrilateral in-plane general-purpose continuum
shell, reduced integration with hourglass control,
finite membrane strains

SFM3D3 Tria3 3-node triangular surface element

SFM3D4 Quad4 4-node quadrilateral surface element

SFM3D4R Quad4 4-node quadrilateral surface element, reduced
integration
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SFM3D6 Tria6 6-node triangular surface element

SFM3D8 Quad8 8-node quadrilateral surface element

SFM3D8R Quad8 8-node quadrilateral surface element, reduced
integration

SFMAX1 Rod 2-node linear axisymmetric surface element

SFMAX2 Bar3 3-node quadratic axisymmetric surface element

SFMGAX1 Rod 2-node linear axisymmetric surface element, twist

SFMGAX2 Bar3 3-node quadratic axisymmetric surface element,
twist

SPRING1 Mass Spring between a node and ground, acting in a
fixed direction

SPRING2 Spring Spring between two nodes, acting in a fixed
direction

SPRINGA Spring Axial spring between two nodes, whose line of
action is the line joining the two nodes

STRI3 Tria3 3-node triangular facet thin shell

STRI65 Tria6 6-node triangular thin shell, using five degrees of
freedom per node

T2D2 Rod 2-node linear 2-D truss

T2D2E Rod 2-node 2-D piezoelectric truss

T2D2H Rod 2-node linear 2-D truss, hybrid

T2D2T Rod 2-node 2-D thermally coupled truss

T2D3 Rod 3-node quadratic 2-D truss

T3D2 Rod 2-node linear 3D truss

T3D2E Rod 2-node 3D piezoelectric truss

T3D2H Rod 2-node linear 3D truss, hybrid

T3D2T Rod 2-node 3D thermally coupled truss
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Card Supported Element
Configurations

Description

TIE Rigid

ANSYS Cards

Card Supported Element
Configurations

Description

BEAM3 Bar2 2D Elastic Beam

Config 60, Type 2

BEAM4 Bar2 3D Elastic Beam

Config 60, Type 1

BEAM23 Bar2 2D Plastic Beam

Config 60, Type 9

BEAM24 Bar2 3D Thin-walled Beam

Config 60, Type 6

BEAM44 Bar2 3D Elastic Tapered Unsymmetric Beam

Config 60, Type 7

BEAM54 Bar2 2D Elastic Tapered Unsymmetric Beam

Config 60, Type 10

BEAM188 Bar2 3D Linear Finite Strain Beam

Config 60, Type 8

BEAM189 Bar3 3D Quadratic Finite Strain Beam

Config 63, Type 1

CERIG Rigid Ldof, Ldof2, Ldof3, Ldof4, Ldof5

Config 5, Type 1, 2

CIRCU124 Rod General circuit element applicable to circuit
simulation.

COMBIN14 Spring Spring-Damper
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Card Supported Element
Configurations

Description

Config 21, Type 1

COMBIN39 Spring Nonlinear Spring

Config 21, Type 2

COMBIN40 Spring Combination

Config 21, Type 3

CONTA171 Plot 2D 2-Node Surface-to-Surface Contact

Config 2, Type 3

CONTA172 Bar3 2D 3-Node Surface-to-Surface Contact

Config 63, Type 12

CONTA173 Tria3

Quad4

3D 4-Node Surface-to-Surface Contact

Config 103, Type 13

Config 104, Type 13

CONTA174 Tria6

Quad 8

3D 8-Node Surface-to-Surface Contact

Config 106, Type 10

Config 108, Type 10

CONTA175 Mass 2D/3D Node-to-Surface Contact

Config 1, Type 14

CONTA177 Bar2

Bar3

3D Line-to-Surface Contact

CONTA178 Gap 3D Node-to-Node Contact

Config 70, Type 3

CONTAC12 Gap 2D Point-to-Point Contact

Config 70, Type 2

CONTAC48 Tria3

CONTAC49 Tria3

Quad4
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Card Supported Element
Configurations

Description

CONTAC52 Gap 3D Point-to-Point Contact

Config 70, Type 1

CP Rigid Defines (or modifies) a set of coupled degrees of
freedom.

Config 55, Type 1, 2

CP_ELEC Rigid

CP_STRUC Rigid

CP_THERM Rigid

ELBOW290 Bar3

FLUID29 Tria3

Quad4

2D Axisymmetric Harmonic Acoustic Fluid

FLUID30 Tetra4

Penta6

Hex8

3D Acoustic Fluid

FLUID80 Hex8 3D Contained Fluid

Config 208, Type 9

FLUID116 Rod Coupled Thermal-Fluid Pipe

Config 61, Type 12

FLUID220 Hex20

Penta15

Pyramid13

Tetra10

FLUID221 Tetra10

HF118 Tria6

Quad8

2D High-Frequency Quadrilateral Solid

Config 106, Type 25

Config 108, Type 25
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Card Supported Element
Configurations

Description

HF119 Tetra10 3D High-Frequency Tetrahedral Solid

Config 210, Type 11

HF120 Pyramid13

Penta15

Hex20

3D High-Frequency Brick Solid

Config 213, Type 3

Config 215, Type 3

Config 220, Type 3

HYPER58 Tetra4

Penta6

Hex8

3D 8-Node Mixed u-P Hyperelastic Solid

Config 204, Type 11

Config 206, Type 11

Config 208, Type 11

INFIN9 Rod

INFIN110 Quad4

Quad8

INTER192 Quad4

Tria3

INTER193 Quad8

INTER194 Hex20

Penta15

INTER195 Hex8

Penta6

INTER205 Hex8

Penta6

LINK1 Rod 2D Spar (or Truss)

Config 61, Type 5

LINK8 Rod 3D Spar (or Truss)

Config 61, Type 1
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Card Supported Element
Configurations

Description

LINK10 Rod Tension-only or Compression-only Spar

Config 61, Type 2

LINK11 Bar2 Linear actuator

Config 61, Type 25

LINK31 Rod Radiation Link

Config 61, Type 6

LINK32 Rod 2D Conduction Bar

Config 61, Type 7

LINK33 Rod 3D Conduction Bar

Config 61, Type 8

LINK34 Rod Convection Link

Config 61, Type 9

LINK68 Rod Coupled Thermal-Electric Line

Config 61, Type 14

LINK180 Rod 3D Finite Strain Spar (or Truss)

Config 61, Type 11

MASS21 Mass Structural Mass

Config 1, Type 1

MASS71 Mass Thermal Mass

Config 1, Type 2

MESH200 Bar3

Rod

Tria3

Tetra4

Tetra10

Quad4

Hex8

Meshing Facet

Config 63, Type 26

Config 61, Type 26

Config 103, Type 26

Config 204, Type 26

Config 210, Type 26

Config 104, Type 26

Config 208, Type 26
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Card Supported Element
Configurations
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Tria6

Quad8

Hex20

Config 106, Type 26

Config 108, Type 26

Config 220, Type 26

MPC184 Rod Multipoint Constraint Elements: Rigid Link, Rigid
Beam, Slider, Spherical, Revolute, Universal

Config 61, Type 13

PIPE16 Bar2 Elastic Straight Pipe

Config 60, Type 3

PIPE18 Bar2 Elastic Curved Pipe (Elbow)

Config 60, Type 4

PIPE20 Rod Plastic Straight Pipe

Config 61, Type 4

PIPE60 Bar2 Plastic Curved Pipe (Elbow)

Config 60, Type 5

PIPE288 Bar2

PIPE289 Bar3

PLANE2 Tria6 2D 6-Node Triangular Structural Solid

Config 106, Type 21

PLANE13 Quad4

Tria3

2D Coupled-Field Solid

Config 103, Type 3

Config 104, Type 3

PLANE25 Tria3

Quad4

Axisymmetric-Harmonic 4-Node Structural Solid

Config 103, Type 6

Config 104, Type 6

PLANE35 Tria6 2D 6-Node Triangular Thermal Solid

Config 106, Type 7

PLANE42 Tria3 2D Structural Solid
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Card Supported Element
Configurations

Description

Quad4 Config 103, Type 4

Config 104, Type 4

PLANE53 Tria6

Quad8

2D 8-Node Magnetic Solid

Config 106, Type 9

Config 108, Type 9

PLANE55 Tria3

Quad4

2D Thermal Solid

Config 103, Type 5

Config 104, Type 5

PLANE67 Tria3

Quad4

2D Coupled Thermal-Electric Solid

Config 103, Type 21

Config 104, Type 21

PLANE75 Tria3

Quad4

Axisymmetric-Harmonic 4-Node Thermal Solid

Config 103, Type 9

Config 104, Type 9

PLANE77 Tria6

Quad8

2D 8-Node Thermal Solid

Config 106, Type 2

Config 108, Type 2

PLANE78 Tria6

Quad8

Axisymmetric-Harmonic 8-Node Thermal Solid

Config 106, Type 8

Config 108, Type 8

PLANE82 Tria6

Quad8

2D 8-Node Structural Solid

Config 106, Type 1

Config 108, Type 1

PLANE83 Tria6

Quad8

Axisymmetric-Harmonic 8-Node Structural Solid

Config 106, Type 3

Config 108, Type 3

PLANE121 Tria6

Quad8

2D 8-Node Electrostatic Solid

Config 106, Type 22
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Card Supported Element
Configurations

Description

Config 108, Type 22

PLANE145 Tria6

Quad8

2D Quadrilateral Structural Solid p-Element

Config 106, Type 23

Config 108, Type 23

PLANE146 Tria6 Config 106, Type 31

PLANE162 Tria3

Quad4

Explicit 2D Structural Solid

Config 103, Type 22

Config 104, Type 22

PLANE182 Tria3

Quad4

2D 4-Node Structural Solid

Config 103, Type 23

Config 104, Type 23

PLANE183 Tria6

Quad8

2D 8-Node Structural Solid

Config 106, Type 19

Config 108, Type 19

PLANE223 Tria6

Quad8

2D 8-Node Coupled-Field Solid

PRETS179 Bar2 Define a 2D or 3D pretension section within a
meshed structure.

Config 60, Type 17

RBE3 RBE3 Distributes the force/moment applied at the
master node to a set of slave nodes, taking into
account the geometry of the slave nodes as well
as weighting factors.

SHELL28 Quad4 Shear/Twist Panel

Config 104, Type 12

SHELL41 Tria3

Quad4

Membrane Shell

Config 103, Type 19

Config 104, Type 19
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Card Supported Element
Configurations
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SHELL43 Tria3

Quad4

4-Node Plastic Large Strain Shell

Config 103, Type 2

Config 104, Type 2

SHELL51 Bar2 Axisymmetric Structural Shell

Config 60, Type 14

SHELL57 Tria3

Quad4

Thermal Shell

Config 103, Type 7

Config 104, Type 7

SHELL61 Bar2 Axisymmetric-Harmonic Structural Shell

Config 60, Type 15

SHELL63 Tria3

Quad4

Elastic Shell

Config 103, Type 1

Config 104, Type 1

SHELL91 Tria6

Quad8

Nonlinear Layered Structural Shell

Config 106, Type 6

Config 108, Type 6

SHELL93 Tria6

Quad8

8-Node Structural Shell

Config 106, Type 4

Config 108, Type 4

SHELL99 Tria6

Quad8

Linear Layered Structural Shell

Config 106, Type 5

Config 108, Type 5

SHELL131 Tria3

Quad4

4-Node Layered Thermal Shell

Config 103, Type 25

Config 104, Type 25

SHELL132 Tria6

Quad8

8-Node Layered Thermal Shell

Config 106, Type 24

Config 108, Type 24
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Card Supported Element
Configurations

Description

SHELL143 Tria3

Quad4

4-Node Plastic Small Strain Shell

Config 103, Type 10

Config 104, Type 10

SHELL150 Tria6

Quad8

8-Node Structural Shell p-Element

Config 106, Type 20

Config 108, Type 20

SHELL157 Tria3

Quad4

Thermal-Electric Shell

Config 103, Type 20

Config 104, Type 20

SHELL163 Tria3

Quad4

Explicit Thin Structural Shell

Config 103, Type 17

Config 104, Type 17

SHELL181 Tria3

Quad4

4-Node Finite Strain Shell

Config 103, Type 11

Config 104, Type 11

SHELL208 Bar2 2-Node Finite Strain Axisymmetric Shell

SHELL209 Bar2 3-Node Finite Strain Axisymmetric Shell

SHELL281 Tria6

Quad8

8-Node Finite Strain Shell

SOLID5 Penta6

Hex8

3D Coupled-Field Solid

Config 206, Type 2

Config 208, Type 2

SOLID45 Tetra4

Penta6

Hex8

3D Structural Solid

Config 204, Type 1

Config 206, Type 1

Config 208, Type 1

SOLID46 Tetra4

Penta6

3D 8-Node Layered Structural Solid

Config 204, Type 6
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Card Supported Element
Configurations

Description

Hex8 Config 206, Type 6

Config 208, Type 6

SOLID62 Tetra4

Pyramid5

Penta6

Hex8

3D Magneto-Structural Solid

Config 204, Type 15

Config 205, Type 15

Config 206, Type 15

Config 208, Type 15

SOLID64 Tetra4

Penta6

Hex8

3D Anisotropic Structural Solid

Config 204, Type 7

Config 206, Type 7

Config 208, Type 7

SOLID69 Tetra4

Penta6

Hex8

3D Coupled Thermal-Electric Solid

Config 204, Type 4

Config 206, Type 4

Config 208, Type 4

SOLID70 Tetra4

Penta6

Hex8

3D Thermal Solid

Config 204, Type 3

Config 206, Type 3

Config 208, Type 3

SOLID72 Tetra4

SOLID73 Tetra4

Penta6

Hex8

SOLID87 Tetra10 3D 10-Node Tetrahedral Thermal Solid

Config 210, Type 5

SOLID90 Tetra10

Pyramid13

Penta15

Hex20

3D 20-Node Thermal Solid

Config 210, Type 2

Config 213, Type 2
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Card Supported Element
Configurations

Description

SOLID92 Tetra10 3D 10-Node Tetrahedral Structural Solid

Config 210, Type 3

SOLID95 Tetra10

Pyramid13

Penta15

Hex20

3D 20-Node Structural Solid

Config 210, Type 1

Config 213, Type 1

Config 215, Type 1

Config 220, Type 1

SOLID96 Tetra4

Pyramid5

Penta6

Hex8

3D Magnetic Scalar Solid

Config 204, Type 5

Config 205, Type 5

Config 206, Type 5

Config 208, Type 5

SOLID97 Tetra4

Pyramid5

Penta6

Hex8

3D Magnetic Solid

Config 204, Type 8

Config 205, Type 8

Config 206, Type 8

Config 208, Type 8

SOLID98 Tetra10 Tetrahedral Coupled-Field Solid

Config 210, Type 4

SOLID117 Tetra10

Pyramid13

Penta15

Hex20

3D 20-Node Magnetic Solid

Config 210, Type 8

Config 213, Type 8

Config 215, Type 8

Config 220, Type 8

SOLID147 Penta15

Hex20

3D Brick Structural Solid p-Element

SOLID148 Penta15

Tetra10

Hex20

3D Tetrahedral Structural Solid p-Element

Config 215, Type 9

Config 210, Type 9
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Card Supported Element
Configurations

Description

Config 220, Type 9

SOLID164 Tetra4

Pyramid5

Penta5

Hex8

Explicit 3D Structural Solid

Config 204, Type 14

Config 205, Type 14

Config 206, Type 14

Config 208, Type 14

SOLID168 Tetra10 Explicit 3D 10-Node Tetrahedral Structural Solid

SOLID185 Tetra4

Penta6

Hex8

3D 8-Node Structural Solid

Config 204, Type 13

Config 206, Type 13

Config 208, Type 13

SOLID186 Tetra10

Pyramid13

Penta15

Hex20

3D 20-Node Structural Solid

Config 210, Type 7

Config 213, Type 7

Config 215, Type 7

Config 220, Type 7

SOLID187 Tetra10 3D 10-Node Tetrahedral Structural Solid

Config 210, Type 6

SOLID191 Tetra10

Penta15

Hex20

3D 20-Node Layered Structural Solid

Config 210, Type 10

Config 215, Type 10

Config 220, Type 10

SOLID226 Tetra10

Pyramid13

Penta15

Hex20

3D 20-Node Coupled-Field Solid

SOLID227 Tetra10 3D 10-Node Coupled-Field Solid

SOLID278 Hex8

Penta6
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Card Supported Element
Configurations

Description

Tetra4

SOLID279 Hex20

Penta15

Pyramid13

Tetra10

SOLID285 Tetra4

SOLSH190 Penta6

Hex8

3D 8-Node Layered Solid Shell

Config 206

Config 208, Type 17

SURF151 Bar2 2D Thermal Surface Effect

Config 60, Type 12

SURF152 Quad4

Quad8

Tria6

3D Thermal Surface Effect

Config 104, Type 14

Config 108, Type 14

SURF153 Bar2

Bar3

2D Structural Surface Effect

Config 60, Type 16

Config 63, Type 16

SURF154 Quad4

Quad8

Tria6

3D Structural Surface Effect

Config 104, Type 18

Config 108, Type 18

SURF156 Bar3 3D Structural Surface Line Load Effect

SURF251 Rod 2D Radiosity Surface

Config 61, Type 25

SURF252 Tria3

Quad4

3D Radiosity Surface

Config 103, Type 36

Config 104, Type 36

TARGE169 Mass 2D Target Segment
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Card Supported Element
Configurations

Description

Bar2

Bar3

Config 1, Type 13

Config 60, Type 9

Config 63, Type 16

TARGE170 Mass

Tria3

Quad4

Tria6

Quad8

3D Target Segment

Config 103, Type 16

Config 104, Type 16

Config 106, Type 16

Config 108, Type 16

VISCO88 Tria6

Quad8

2D 8-Node Viscoelastic Solid

VISCO107 Tetra4

Penta6

Hex8

3D 8-Node Viscoplastic Solid

Config 204, Type 16

Config 206, Type 16

Config 208, Type 16

EXODUS Cards

Card Supported Element
Configurations

Description

BEAM bar2

BEAM2 bar2

BEAM3 bar3

CIRCLE mass

HEX20 hex20

HEX8 hex8

PYRAMID13 pyramid13

PYRAMID5 pyramid5

QUAD4 quad4
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Card Supported Element
Configurations

Description

QUAD8 quad8

RBAR weld

RJOINT rigid

RROD rigid

SHELL3 tria3

SHELL4 quad4

SHELL6 tria6

SHELL8 quad8

SPHERE mass

SPRING spring

TETRA10 tetra10

TETRA4 tetra4

TRI3 tria3

TRI6 tria6

TRIANGLE3 tria3

TRIANGLE6 tria6

TRUSS rod

WEDGE15 penta15

WEDGE6 penta6

LS-DYNA Cards

Card Supported Element
Configurations

Description

*CONSTRAINED_GENERALIZED_WELD_BUTT_(ID)Rigid Define butt welds.

Spot(default)/type 1, Fillet/type 2, and Butt/type
3 failure modes are supported. Failure information
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Card Supported Element
Configurations

Description

is based on weld type selected. Coordinate System
ID can be selected.

No Failure/Type 0 Card 36 entities are defined
as *CONSTRAINED_NODAL_RIGID_BODIES in
Keyword. They are a separate element type.

*CONSTRAINED_GENERALIZED_WELD_COMBINED_(ID)Rigid Define combined welds.

*CONSTRAINED_GENERALIZED_WELD_CROSS_FILLET_(ID)Rigid Define cross fillet welds.

*CONSTRAINED_GENERALIZED_WELD_FILLET_(ID)Rigid Define fillet welds.

*CONSTRAINED_GENERALIZED_WELD_SPOT_(ID)Rigid Define spot welds.

*CONSTRAINED_INTERPOLATIONRBE3 Define an interpolation constrain.

*CONSTRAINED_JOINT_CONSTANT_VELOCITYJoint

*CONSTRAINED_JOINT_CYLINDRICALJoint Define a joint between two rigid bodies.

*CONSTRAINED_JOINT_CYLINDRICAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_CYLINDRICAL_LOCAL(ID)Joint

*CONSTRAINED_JOINT_CYLINDRICAL_LOCAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_GEARSJoint

*CONSTRAINED_JOINT_LOCKING(ID)Joint

*CONSTRAINED_JOINT_LOCKING_FAILURE(ID)Joint

*CONSTRAINED_JOINT_LOCKING_LOCAL(ID)Joint

*CONSTRAINED_JOINT_LOCKING_LOCAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_PLANAR(ID)Joint

*CONSTRAINED_JOINT_PLANAR_FAILURE(ID)Joint

*CONSTRAINED_JOINT_PLANAR_LOCAL(ID)Joint

*CONSTRAINED_JOINT_PLANAR_FAILURE_LOCAL(ID)Joint

*CONSTRAINED_JOINT_PULLYJoint

*CONSTRAINED_JOINT_RACK_AND_PINION_IDJoint
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Card Supported Element
Configurations

Description

*CONSTRAINED_JOINT_REVOLUTEJoint

*CONSTRAINED_JOINT_REVOLUTE_LOCAL(ID)Joint

*CONSTRAINED_JOINT_REVOLUTE_FAILURE(ID)Joint

*CONSTRAINED_JOINT_REVOLUTE_LOCAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_ROTATIONAL_MOTORJoint

*CONSTRAINED_JOINT_SCREW

*CONSTRAINED_JOINT_SPHERICAL(ID)Joint

*CONSTRAINED_JOINT_SPHERICAL_LOCAL(ID)Joint

*CONSTRAINED_JOINT_SPHERICAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_SPHERICAL_LOCAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_STIFFNESS_TRANSLATIONALJoint Define optional rotational and translational
joint stiffness for joints defined by
*CONSTRAINED_JOINT_OPTION.

*CONSTRAINED_JOINT_TRANSLATIONAL(ID)Joint

*CONSTRAINED_JOINT_TRANSLATIONAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_TRANSLATIONAL_LOCAL(ID)Joint

*CONSTRAINED_JOINT_TRANSLATIONAL_LOCAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_TRANSLATIONAL_MOTORJoint

*CONSTRAINED_JOINT_UNIVERSAL(ID)Joint

*CONSTRAINED_JOINT_UNIVERSAL_FAILURE(ID)Joint

*CONSTRAINED_JOINT_UNIVERSAL_LOCAL(ID)Joint

*CONSTRAINED_JOINT_UNIVERSAL_LOCAL_FAILURE(ID)Joint

*CONSTRAINED_NODAL_RIGID_BODYRigid Define a nodal rigid body.

*CONSTRAINED_NODAL_RIGID_BODY
(2-Noded)

Rigid

*CONSTRAINED_NODAL_RIGID_BODY_INERTIARigid Used when inertial properties are defined rather
than computed.
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Card Supported Element
Configurations

Description

*CONSTRAINED_NODAL_RIGID_BODY_INERTIA
(2-Noded)

Rigid

*CONSTRAINED_NODAL_RIGID_BODY_INERTIA
_SPC

Rigid

*CONSTRAINED_NODAL_RIGID_BODY_INERTIA
_SPC (2-Noded)

Rigid

*CONSTRAINED_NODAL_RIGID_BODY_SPCRigid

*CONSTRAINED_NODAL_RIGID_BODY_SPC
(2-Noded)

Rigid

*CONSTRAINED_NODE_SETRigid Define nodal constraint sets for translational
motion in global coordinates.

*CONSTRAINED_NODE_SET
(2-Noded)

Rigid

*CONSTRAINED_NODE_SET_IDRigid

*CONSTRAINED_RIVET Weld Define massless rivets between non-contiguous
nodal pairs.

*CONSTRAINED_SHELL_TO_SOLIDRigid Define a tie between a shell edge and solid
elements.

*CONSTRAINED_SPOTWELD_IDWeld Define massless spot welds between non-
contiguous nodal pairs.

Normal and shear failure values can be edited.

*CONSTRAINED_SPOTWELD_FILTERED_FORCE_IDWeld

*ELEMENT_BEAM Bar Define two node elements including 3D beams,
trusses, 2D axisymmetric shells and 2D plane
strain beam elements.

Thickness option can be added. This allows you
to edit the parameters based on the element
formulation in the property to which the beam
points.

*ELEMENT_BEAM_OFFSETBar

*ELEMENT_BEAM_OFFSET_PIDBar
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Card Supported Element
Configurations

Description

*ELEMENT_BEAM_OFFSET_THICKNESSBar

*ELEMENT_BEAM_ORIENTATIONBar

*ELEMENT_BEAM_PID Bar

*ELEMENT_BEAM_PID_ORIENTATIONBar

*ELEMENT_BEAM_PID_SCALARBar

*ELEMENT_BEAM_SCALARBar

*ELEMENT_BEAM_SCALAR_ORIENTATIONBar

*ELEMENT_BEAM_SECTIONBar

*ELEMENT_BEAM_SECTION_ORIENTATIONBar

*ELEMENT_BEAM_SECTION_PIDBar

*ELEMENT_BEAM_THICKNESSBar

*ELEMENT_BEAM_THICKNESS_ORIENTATIONBar

*ELEMENT_BEAM_THICKNESS_PIDBar

*ELEMENT_BEAM_THICKNESS_SCALARBar

*ELEMENT_DISCRETE Spring Define a discrete (spring or damper) element
between two nodes or a node and ground.

Scale factor, printing flags, and offset values can
be edited.

*ELEMENT_INERTIA Mass Define a lumped inertia element assigned to a
nodal point.

*ELEMENT_INERTIA_OFFSETMass

*ELEMENT_MASS Mass Define a lumped mass element assigned to a
nodal point or equally distributed to the nodes of a
node set.

*ELEMENT_MASS_NODE_SETMass Mass elements defined on node set

*ELEMENT_MASS_PART Mass Define additional non-structural mass to be
distributed by an area weighted distribution to all
nodes of a given part ID.
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Card Supported Element
Configurations

Description

*ELEMENT_MASS_PART_SETMass Mass elements defined on part set.

*ELEMENT_PLOTEL Plot Define a null beam element for visualization.

*ELEMENT_SEATBELT Rod Define a seat belt element.

*ELEMENT_SEATBELT_SENSORSensors Define seat belt sensor.

*ELEMENT_SHELL Tria3

Quad4

Define three, four, six and eight node elements
including 3D shells, membranes, 2D plane stress,
plane strain, and axisymmetric solids.

Thickness and beta options can be added
singularly or together. This allows you to edit the
thickness and material angles to override the
SECTION card.

*ELEMENT_SHELL_BETA Tria3

Quad4

*ELEMENT_SHELL_BETA_OFFSETTria3

Quad4

*ELEMENT_SHELL_COMPOSITETria3

Quad4

*ELEMENT_SHELL_DOF Tria3

Quad4

*ELEMENT_SHELL_MCID Tria3

Quad4

*ELEMENT_SHELL_MCID_OFFSETTria3

Quad4

*ELEMENT_SHELL_OFFSET Tria3

Quad4

*ELEMENT_SHELL_THICKNESSTria3

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1745

Card Supported Element
Configurations

Description

Quad4

*ELEMENT_SHELL_THICKNESS_BETATria3

Quad4

*ELEMENT_SHELL_THICKNESS_BETA_OFFSETTria3

Quad4

*ELEMENT_SHELL_THICKNESS_MCIDTria3

Quad4

*ELEMENT_SHELL_THICKNESS_MCID_OFFSETTria3

Quad4

*ELEMENT_SHELL_THICKNESS_OFFSETTria3

Quad4

*ELEMENT_SOLID Tetra4

Penta6

Hex8

Tetra10

Define three-dimensional solid elements including
4 noded tetrahedrons and 8-noded hexahedrons.

*ELEMENT_SOLID_ORTHO Tetra4

Penta6

Hex8

Tetra10

Define a local coordinate system for orthotropic
and anisotropic materials.

*ELEMENT_SOLID_TET4TOTET10Tetra4 Converts 4 node tetrahedron solids to 10 node
quadratic tetrahedron solids.

*ELEMENT_SPH Mass Define a lumped mass element assigned to a
nodal point

*ELEMENT_TSHELL Penta6

Hex8

Define an eight node thick shell element which is
available with either fully reduced or selectively
reduced integration rules.

*INITIAL_MOMENTUM Tetra4

Penta6

Defines initial momentum in the solid element at
the start of analysis. This momentum could be
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Hex8

Tetra10

from previous analysis/step carried forward to
next analysis/step.

This is supported as an attribute to an element to
maintain its associativity with element inside HM.

*INITIAL_STRAIN_SHELL Tria3

Quad4

Defines stress in the shell element at the start
of analysis. This stress could be from previous
analysis/step carried forward to next analysis/
step.

This is supported as an attribute to an element to
maintain its associativity with element inside HM.

*INITIAL_STRAIN_SOLID Tetra4

Penta6

Hex8

Tetra10

Defines stress in the solid element at the start
of analysis. This stress could be from previous
analysis/step carried forward to next analysis/
step.

This is supported as an attribute to an element to
maintain its associativity with element inside HM.

*INITIAL_STRESS_BEAM Bar Defines stress in the beam element at the start
of analysis. This stress could be from previous
analysis/step carried forward to next analysis/
step.

This is supported as an attribute to an element to
maintain its associativity with element inside HM.

*INITIAL_STRESS_SHELL Tria3

Quad4

Defines stress in the shell element at the start
of analysis. This stress could be from previous
analysis/step carried forward to next analysis/
step.

This is supported as an attribute to an element to
maintain its associativity with element inside HM.

*INITIAL_STRESS_SOLID Tetra4

Penta6

Hex8

Tetra10

Defines stress in the solid element at the start
of analysis. This stress could be from previous
analysis/step carried forward to next analysis/
step.
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This is supported as an attribute to an element to
maintain its associativity with element inside HM.

Nastran Cards

Card Supported Element
Configurations

Description

CAABSF Mass

Rod

Tria3

Quad4

Defines a frequency-dependent acoustic absorber
element in coupled fluid-structural analysis.

CACINF3 Tria3 Defines an acoustic conjugate infinite element with
triangular base.

CACINF4 Quad4 Defines an acoustic conjugate infinite element with
quadrilateral base.

CAERO1 Quad4 Defines an aerodynamic macro element (panel)
in terms of two leading edge locations and side
chords. This is used for Doublet-Lattice theory for
subsonic aerodynamics and the ZONA51 theory for
supersonic aerodynamics.

CAERO2 Rod Defines aerodynamic slender body and
interference elements for Doublet-Lattice
aerodynamics.

CBAR Bar Defines a simple beam element.

CBEAM Bar Defines a beam element.

CBEND Bar Defines a curved beam, curved pipe, or elbow
element.

CBUSH Mass

Spring

Defines a generalized spring-and-damper
structural element that may be nonlinear or
frequency dependent.

Both elements with grounded terminals are
supported.
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CBUSH1D Mass

Spring

Defines the connectivity of a one-dimensional
spring and viscous damper element.

Both elements with grounded terminals are
supported.

CDAMP1 Mass

Spring

Defines a scalar damper element.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.

CDAMP2 Mass

Spring

Defines a scalar damper element without
reference to a material or property entry.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.

CDAMP3 Mass

Spring

Defines a scalar damper element that is connected
only to scalar points.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.

CDAMP4 Mass

Spring

Defines a scalar damper element that connected
only to scalar points and without reference to a
material or property entry.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.

CELAS1 Mass

Spring

Defines a scalar spring element.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.

CELAS2 Mass

Spring

Defines a scalar spring element without reference
to a property entry.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.

CELAS3 Mass

Spring

Defines a scalar spring element that connects only
to scalar points.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.
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CELAS4 Mass

Spring

Defines a scalar spring element that is connected
only to scalar points, without reference to a
property entry.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.

CFAST Mass

Rod

Defines a fastener with material orientation
connecting two surface patches.

CGAP Gap Defines a gap or friction element.

CHACAB Hex8 Defines the acoustic absorber element in coupled
fluid-structural analysis.

CHBDYE Slave3

Slave4

Defines a boundary condition surface element with
reference to a heat conduction element.

This element is supported as GROUP.

CHBDYG Slave3

Slave4

Defines a boundary condition surface element
without reference to a property entry.

This element is supported as GROUP.

Creation from scratch is not yet supported.

CHBDYP Mass

Rod

Defines a boundary condition surface element with
reference to a PHBDY entry.

CONVM is supported as a continuation card inside
CHBDYP.

CHEXA (20-noded) Hex20 Defines a second order solid element, composed
of 6 quadrilateral faces.

In Nastran, you can define a second order
element with missing mid-side nodes. Input data
decks containing such elements are read by the
translator as a first-order element. A message
is written to the nastran.msg file indicating the
corresponding element ID.

CHEXA (8-noded) Hex8 Defines a first order solid element, composed of 6
quadrilateral faces.

CMASS1 Mass Defines a scalar mass element.
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Spring

CMASS2 Mass

Spring

Defines a scalar mass element without reference
to a property entry.

CMASS3 Mass

Spring

Defines a scalar mass element that is connected
only to scalar points.

CMASS4 Mass

Spring

Defines a scalar mass element that is connected
only to scalar points, without reference to a
property entry.

CONM1 Mass Defines a 6 x 6 symmetric mass matrix at a
geometric grid point.

CONM2 Mass Defines a concentrated mass at a grid point.

CONROD Rod Defines a rod element without reference to a
property entry.

CPENTA (6-noded) Penta6 Defines the connections of a five-sided solid
element with six to fifteen grid points.

CPENTA (15-noded) Penta15 Defines the connections of a five-sided solid
element with six to fifteen grid points.

In Nastran, you can define a second order
element with missing mid-side nodes. Input data
decks containing such elements are read by the
translator as a first-order element. A message
is written to the nastran.msg file indicating the
corresponding element ID.

CQUAD4 Quad4 Defines an isoparametric membrane-bending or
plane strain quadrilateral plate element.

CQUAD8 Quad8 Defines a curved quadrilateral shell or plane strain
element with eight grid points.

In Nastran, you can define a second order
element with missing mid-side nodes. Input data
decks containing such elements are read by the
translator as a first-order element. A message
is written to the nastran.msg file indicating the
corresponding element ID.
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CQUADR Quad4 Defines an isoparametric membrane and bending
quadrilateral plate element. However, this element
does not include membrane-bending coupling.
This element is less sensitive to initial distortion
and extreme values of Poisson’s ratio than the
CQUAD4 element. It is a companion to the CTRIAR
element.

CROD Rod Defines a tension-compression-torsion element.

CSHEAR Quad4 Defines a shear panel element.

CSEAM Rod

CTETRA (4-noded) Tetra4 Defines the connections of the four-sided solid
element with four grid points.

CTETRA (10-noded) Tetra10 Defines the connections of the four-sided solid
element with ten grid points.

In Nastran, you can define a second order
element with missing mid-side nodes. Input data
decks containing such elements are read by the
translator as a first-order element. A message
is written to the nastran.msg file indicating the
corresponding element ID.

CTRIA3 Tria3 Defines an isoparametric membrane-bending or
plane strain triangular plate element.

CTRIA6 Tria6 Defines a curved triangular shell element or plane
strain with six grid points.

In Nastran, you can define a second order
element with missing mid-side nodes. Input data
decks containing such elements are read by the
translator as a first-order element. A message
is written to the nastran.msg file indicating the
corresponding element ID.

CTRIAR Tria3 Defines an isoparametric membrane-bending
triangular plate element. However, this element
does not include membrane-bending coupling. It is
a companion to the CQUADR element.

CTRIAX Tria3 Defines an axisymmetric triangular element with
up to 6 grid points for use in fully nonlinear (i.e.,
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Tria6 large strain and large rotations) hyperelastic
analysis

CTRIAX6 Tria3

Tria6

Defines an isoparametric and axisymmetric
triangular cross section ring element with midside
grid points.

CTUBE Rod Defines a tension-compression-torsion tube
element.

CQUADX Quad4

Quad8

Defines an axisymmetric quadrilateral element
with up to nine grid points for use in fully
nonlinear (i.e. large strain and large rotations)
analysis or a linear harmonic or rotor dynamic
analysis. The element has between four and eight
grid points.

Ninth grid selected in card edit of the element.

CVISC Spring Defines a viscous damper element.

Elements CDAMP1 and CDAMP2 with grounded
terminals are not supported.

CWELD Mass

Rod

Defines a weld or fastener connecting two surface
patches or points.

Node-Node, Node-Patch, or Patch-Patch weld
elements can be read. CWELD element is stored
as an element of the rod configuration. CWELD
elements using the ELEMID option not created
in HyperMesh will be displayed as zero length.
Currently, the Spotweld panel can only create
Node-Node and Patch-Patch CWELD elements.

HyperMesh always calculates the location of GA
and GB by projecting GS in the normal direction of
surface patch A and surface patch B, respectively.

GENEL RBE3 Defines a general element.

HM_SPRING Spring Defines a spring element, which is converted to
Nastran entities on export, in a manner similar to
that explained in Using HM_ELAS.

MBOLT Mass Defines a bolt for use in SOL 600 in countries
outside the USA.
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MBOLTUS Mass Defines a bolt for use only in SOL 600 and only in
the USA.

PLOTEL Plot Defines a one-dimensional dummy element for
use in plotting.

RBAR Weld Defines a rigid bar with six degrees-of-freedom at
each end.

RBAR CNA field defaults to 123456. To edit the
CNA, CNB, CMA, or CMB fields, you must view the
card image for the RBAR element.

RBE2 Rigid

Rigidlink

Defines a rigid body with independent degrees-of-
freedom that are specified at a single grid point
and with dependent degrees-of-freedom that are
specified at an arbitrary number of grid points.

An RBE2 element with one dependent node is
identified as a rigid element, while an element
with multiple dependent nodes is identified as a
rigid link element.

RBE3 RBE3 Defines the motion at a reference grid point as the
weighted average of the motions at a set of other
grid points.

Individual weight factors can be created on the
independent nodes of RBE3 using the update
functionality in the RBE3 panel. See the on-line
help for the RBE3 panel for more information.

RJOINT Defines a rigid joint element connecting two
coinciding grid points.

RBE2

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1754

Card Supported Element
Configurations

Description

RROD Defines a rigid pin-ended element connection.

OptiStruct Cards

Card Supported Element
Configurations

Description

BMFACE Tria3

Quad4

Defines quad or tria faces that are in turn used to
define a barrier to limit the total deformation for
free-shape design regions.

CAABSF Mass

Rod

Tria3

Quad4

Defines the frequency-dependent fluid acoustic
absorber element in coupled fluid-structural
analysis.

CBAR Bar2 Defines a simple beam element (BAR) of the
structural model.

CBEAM Bar2 Defines a beam element (BEAM) of the structural
model.

CBUSH Spring Defines a generalized spring-damper structural
element.

CBUSH1D Mass

Spring

Defines a one-dimensional spring-damper
structural element.

CDAMP1 Mass

Spring

Defines a scalar damper element.

Represented as a spring element type or as a
mass element type (grounded CDAMP1).

CDAMP2 Mass

Spring

Defines a scalar damper element without
reference to a property entry.

Represented as a spring element type or as a
mass element type (grounded CDAMP2).

CDAMP3 Mass

Spring

Defines a scalar damper element that is connected
only to scalar points.
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Represented as a spring element type or as
a mass element type (when a coordinate is
constrained).

CDAMP4 Mass

Spring

Defines a scalar damper element that is connected
only to scalar points and is without reference to a
material or property entry.

Represented as a spring element type or as
a mass element type (when a coordinate is
constrained).

CELAS1 Mass

Spring

Defines a scalar spring element of the structural
model.

Represented as a spring element type or as a
mass element type (grounded CELAS1).

CELAS2 Mass

Spring

Defines a scalar spring element of the structural
model without reference to a property entry.

Represented as a spring element type or as a
mass element type (grounded CELAS2).

Exported in large field format by optistructlf
template.

CELAS3 Mass

Spring

Defines a scalar spring element that connects only
to scalar points.

Represented as a spring element type or as
a mass element type (when a coordinate is
constrained).

CELAS4 Mass

Spring

Defines a scalar spring element that is connected
only to scalar points without reference to a
property entry.

Represented as a spring element type or as
a mass element type (when a coordinate is
constrained).

CFAST Mass

Rod

Define a fastener with material orientation
connecting two shell surfaces.

Represented as a mass or rod element type,
depending on fastener configuration.
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CGAP Gap Defines a gap or friction element.

The type of gap elements (either CGAP or CGAPG)
is automatically determined based on whether the
element is node-to-node or node-to-elem.

CGAPG Gap

Mass

Defines a node-to-obstacle gap element. The
obstacle may be an element face or a patch of
nodes.

The type of gap elements (either CGAP or CGAPG)
is automatically determined based on whether the
element is node-to-node or node-to-elem.

CGASK6 Penta6 Defining the connections of the GASK6 solid
gasket element.

CGASK8 Hex8 Defining the connections of the GASK8 solid
gasket element.

CGASK12 Penta15 Defining the connections of the GASK12 solid
gasket element.

CGASK16 Hex20 Defining the connections of the GASK16 solid
gasket element.

CHACAB Hex8 Defines the acoustic absorber element in coupled
fluid-structural analysis.

CHBDYE Slave1 Defines a surface element for application of
thermal boundary condition.

Defined using the Interfacespanel with the
CONDUCTION or CONVECTION type.

CHEXA (8-noded) Hex8 Defines a first order solid element, composed of 6
quadrilateral faces.

CHEXA (20-noded) Hex20 Defines a second order solid element, composed
of 6 quadrilateral faces.

A second order element with missing mid-side
nodes can be defined in OptiStruct. Input data
decks containing such elements are read by the
translator as a first-order element. A message is
written to the OptiStruct.msg file indicating the
corresponding element ID.
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CMASS1 Spring

Mass

Defines a scalar mass element.

Represented as a spring element type or as a
mass element type (grounded CMASS1).

CMASS2 Spring

Mass

Defines a scalar mass element without reference
to a property entry.

Represented as a spring element type or as a
mass element type (grounded CMASS2).

CMASS3 Spring

Mass

Defines a scalar mass element that is connected
only to scalar points.

Represented as a spring element type or as
a mass element type (when a coordinate is
constrained).

CMASS4 Spring

Mass

Defines a scalar mass element that is connected
only to scalar points, without reference to a
property entry.

Represented as a spring element type or as
a mass element type (when a coordinate is
constrained).

CMBEAM Bar2 Defines a beam element for multibody dynamics
solution sequence without reference to a property
entry.

CMBUSH Spring Defines a bushing element without reference to a
property entry.

CMBUSHC Spring

CMBUSHE Spring

CMBUSHT Spring

CMSPDP Spring Defines a spring damper element without
reference to a property entry for multibody
solution sequence.

CMSPDPC Spring Defines a spring damper element without
reference to a property entry for multibody
solution sequence.
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CMSPDPE Spring Defines a spring damper element without
reference to a property entry for multibody
solution sequence.

CMSPDPT Spring Defines a spring damper element without
reference to a property entry for multibody
solution sequence.

CONM1 Mass Defines a 6x6 mass matrix at a geometric grid
point.

CONM2 Mass Defines a concentrated mass at a grid point of the
structural model.

Exported in large field format by optistructlf
template.

CONROD Rod Defines a rod element without reference to a
property entry.

CONV Slave1 Defines a free convection boundary condition for
heat transfer analysis through connection to a
surface element (CHBDYE card).

Represented as a continuation to CHBDYE slave
element card.

CPENTA (6-noded) Penta6 Defines a first order solid element, composed of 3
quadrilateral and 2 triangular faces.

CPENTA (15-noded) Penta15 Defines a second order solid element, composed
of 3 quadrilateral and 2 triangular faces.

A second order element with missing mid-side
nodes can be defined in OptiStruct. Input data
decks containing such elements are read by the
translator as a first-order element. A message is
written to the OptiStruct.msg file indicating the
corresponding element ID.

CPYRA (5-noded) Pyramid5 Defines a first order solid element, composed of 1
quadrilateral and 4 triangular faces.

CPYRA (13-noded) Pyramid13 Defines a second order solid element, composed
of 1 quadrilateral and 4 triangular faces.

A second order element with missing mid-side
nodes can be defined in OptiStruct. Input data
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decks containing such elements are read by the
translator as a first-order element. A message is
written to the OptiStruct.msg file indicating the
corresponding element ID.

CQUADR Quad4 Equivalent to CQUAD4. Unlike other Nastran codes,
a 6 degree-of-freedom per node formulation is
used for all shell elements.

CQUAD4 Quad4 Defines a quadrilateral plate element (QUAD4)
of the structural model. This element uses a 6
degree-of-freedom per node formulation.

CQUAD8 Quad8 Defines a curved quadrilateral shell element with
eight grid points.

CROD Rod Defines a tension-compression-torsion element
(ROD) of the structural model.

CSHEAR Quad4 Defines a shear panel element.

CTAXI Tria3 Defines an axisymmetric triangular cross-section
ring element for use in linear analysis.

CTETRA (4-noded) Tetra4 Defines a first order solid element, composed of 4
triangular faces.

CTETRA (10-noded) Tetra10 Defines a second order solid element, composed
of 4 triangular faces.

A second order element with missing mid-side
nodes can be defined in OptiStruct. Input data
decks containing such elements are read by the
translator as a first-order element. A message is
written to the OptiStruct.msg file indicating the
corresponding element ID.

CTRIAR Tria3 CTRIAR entry is equivalent to CTRIA3. Unlike other
Nastran codes, a 6 degrees-of-freedom per node
formulation is used for all shell elements.

CTRIAX6 Tria6 Defines an axisymmetric triangular cross-section
ring element for use in Linear Analysis.
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CTRIA3 Tria3 Defines a triangular plate element (TRIA3) of the
structural model. This element uses a 6 degree-of-
freedom per node formulation.

CTRIA6 Tria6 Defines a curved triangular shell element with six
grid points.

CTUBE Rod Defines a tension-compression-torsion element
(TUBE) of the structural model.

CVISC Spring Defines a viscous damper element.

Represented as a spring element type.

CWELD Mass

Rod

Defines a weld or fastener connecting two surface
patches or points.

Represented as a rod element type.

DHEXA8 Hex8

DQUAD4 Quad4

DPENTA6

DTETRAA4 Tetra4

DTRIA3 Tria3

HMSPRING Spring Defines a spring element, which is converted to
OptiStruct entities on export, in a manner similar
to that explained in Using HM_ELAS.

JOINT Joint Defines a joint.

PLOTEL Plot Defines a one-dimensional dummy element for
use in plotting.

PLOTEL3 Tria

Quad4

Defines a three-noded, two-dimensional dummy
element for use in plotting.

PLOTEL4 Tria

Quad4

Defines a four-noded, two-dimensional dummy
element for use in plotting.

QBDY1 Flux Defines a uniform heat flux for CHBDYE elements.
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RBAR Weld Defines a rigid bar with six degrees-of-freedom at
each end.

RBE2 Rigid

RigidLink

Defines a rigid body whose independent degrees-
of-freedom are specified at a single grid point
and whose dependent degrees-of-freedom are
specified at an arbitrary number of grid points.

An RBE2 element with one dependent node
is represented as a rigid element type, while
an element with multiple dependent nodes is
represented as a rigid link element type.

RBE3 Rbe3 Defines the motion at a "reference" grid point as
the weighted average of the motions at a set of
other grid points.

RROD Rod Defines a pin-ended rod that is rigid in extension.

PAM-CRASH Cards
The component of the element refers to a material, which contains the material definition for PAM-
CRASH.

FE input reader will not create connectors for Plinks, instead you must use the FE absorb functionality to
create connectors from PLINKs.

Card Supported Element
Configurations

Description

ASSOCIATE Rigids Defines entities to be converted from deformable
to rigid.

BAR / Rod Bar element.

BASE_BODY Rigid Rigid bodies on which the boundary conditions are
defined, used in Multibody systems.

BEAM / Bar2 Beam element.

If the orientation vector is defined via vectors,
the string VECTOR is displayed in the N3 field,
and a zero is written in the exported deck. If the
y-direction node is directly specified, its ID is
displayed in the N3 field.
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BSHEL / Hex8 8-noded brick shell element.

EDG Rod

ELINK / Rod Link element.

The element must be edited in the card previewer
to define the connections.

JOINT / Rod Joint element.

The element must be edited in the card previewer
to define element orientation.

KJOIN / Rod Kinematic joint element.

The element must be edited in the card previewer
to define element orientation.

LLINK / Rod Link element.

The element must be edited in the card previewer
to define the connections.

MASS Mass Added mass.

MEMBR / Tria3

Quad4

Membrane element.

MTJOIN / FE Joint Multiple node to one node Kinematic joint
element.

MTOCO / Rigid Rigid element.

NODCO / Rigid Nodal constraint definition.

This configuration allows you to create nodal
constraints via entity sets. The element must be
edited in the card previewer. Degrees of freedom
are ignored.

OTMCO / RBE3 One node to multiple node constraints.

PLINK / Mass Plink element.

The element must be edited in the card previewer.
Mass value is ignored. Use the following templates
to handle the welds:
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find_welds

find_master_comps_welds

find_slave_comps_welds

find_comps_welds

PLINK_VI Rod These elements are created during connector
realization to show the actual connections. They
are not exported.

RETRA / Mass The element must be edited in the card previewer.
Mass value is ignored.

RBODY / Weld Rigid body with 2 nodes.

When created, the default value for rigid body
type is 1.

RBODY / Rigid This configuration allows you to create rigid bodies
via entity sets. The element must be edited in the
card previewer. Degrees of freedom are ignored.

SEG Tria3

Quad4

The elements are used in entity selection. With
this keyword, only nodes of these elements are
output along with SEG keyword.

SENPT / Mass

SHELL / Mass Shell element.

Mass value is ignored. Mass defined with a
keyword other than NOD is not supported.
The reader creates one mass element for each
NOD definition in the MASS card, therefore the
exported deck will contain the same number of
MASS/cards as many NOD definitions.

SHELL / Tria3 The default behavior for tria3 elements is Coo
triangles.

To output standard triangles (N3 = N4).

SHELL / Quad4

SLINK / Tria3

Quad4

The element must be edited in the card previewer
to define the connections.
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SLIPR / Mass The element must be edited in the card previewer.
Mass value is ignored.

SOLID / Tetra4

Pyramid5

Penta6

Hex8

8-noded brick element.

SPH / Mass

SPRING / Spring Spring element.

The element must be edited in the card previewer
to define element orientation.

SPRGBM / Spring Spring beam element.

The element must be edited in the card previewer
to define element orientation.

TETRA / Tetra10 10-noded tetra element.

Local frame definition.

TETR4 / Tetra4 4-noded tetra element.

TSHEL / Quad4 4-noded thick shell element.

The element must be edited in the card previewer
to define the connections.

Permas Cards

Card Supported Element
Configurations

Description

BEAM2 Bar2 2 noded straight general beam.

BECOC Bar2 2 noded straight thin-walled tube.

BECOS Bar2 2 noded straight solid beam.

CONAX2 Bar2
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Card Supported Element
Configurations

Description

CONAX3 Bar3

CONA3 Tria3 3 noded triangular surface convection and
radiation element.

CONA4 Quad4 4 noded quadrilateral surface convection and
radiation element.

CONA6 Tria6 6 noded triangular surface convection and
radiation element.

CONA8 Quad8 8 noded quadrilateral surface convection and
radiation element.

CONS3 Tria3 3 noded triangular shell surface convection and
radiation element.

CONS4 Quad4 4 noded quadrilateral shell surface convection and
radiation element.

CONS6 Tria6 6 noded triangular shell surface convection and
radiation element.

CONS8 Quad8 8 noded quadrilateral shell surface convection and
radiation element.

DAMP1 Spring Translational viscous damper.

DAMP3 Spring Viscous damper for three degrees of freedom.

DAMP6 Spring Viscous damper for six degrees of freedom.

FLA2 Rod 2 noded straight flange (rod).

FLA3 Bar3 3 noded straight flange (rod).

FLHEX8 Hex8 8 noded fluid hexahedron.

FLHEX20 Hex20 20 noded fluid hexahedron.

FLPENT6 Penta6 6 noded fluid pentahedron.

FLPENT15 Penta15 15 noded fluid pentahedron.

FLPYR5 Pyramid5 5 noded fluid pyramid.

FLTET4 Tetra4 4 noded fluid tetrahedron.
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Card Supported Element
Configurations

Description

FLTET10 Tetra10 10 noded fluid tetrahedron.

FSINTA3 Tria3 3 noded triangular fluid structure interface
element.

FSINTA4 Quad4 4 noded quadrilateral fluid structure interface
element.

FSINTA6 Tria6 6 noded triangular fluid structure interface
element.

FSINTA8 Quad8 8 noded quadrilateral fluid structure interface
element.

GKHEX8 Hex8 8 noded solid hexahedron.

GKHEX20 Hex20 20 noded solid hexahedron.

GKPNT6 Penta6 6 noded solid pentahedron.

GKPNT15 Penta15 15 noded solid pentahedron.

HEXE8 Hex8 8 noded solid hexahedron.

HEXE20 Hex20 20 noded solid hexahedron.

LOADA3 Tria3 3 node triangular load carrying membrane
element.

LOADA4 Quad4 4 node quadrilateral load carrying membrane
element.

LOADA6 Tria6 6 node triangular load carrying membrane
element.

LOADA8 Quad8 8 node quadrilateral load carrying membrane
element.

MASS3 Mass Point mass.

MASS6 Mass Rigid mass.

$MPC ASSIGN Rigid Dependent nodes are forced to have the same
displacement as an independent node. User can
specify degrees of freedom for dependent and
independent nodes.

$MPC JOIN Rigid Pairwise identical displacements.
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Card Supported Element
Configurations

Description

$MPC RIGID Rigid Rigid regions.

$MPC SAME Rigid Identical corresponding displacements.

$MPC WLSCON RBE3 Weighted averaged connection.

NLDAMP Spring Nonlinear translational viscous damper.

NLDAMPR Spring Nonlinear rotational viscous damper.

NLSTIFF Spring Nonlinear translational spring.

NLSTIFFR Spring Nonlinear rotational spring.

PENTA6 Penta6 6 noded solid pentahedron.

PENTA15 Penta15 15 noded solid pentahedron.

PLOTA3 Tria3 3 noded triangular plot element.

PLOTA4 Quad4 4 noded quadrilateral plot element.

PLOTA6 Tria6 6 noded triangular plot element.

PLOTA8 Quad8 8 noded quadrilateral plot element.

PLOTL2 Plot 2 noded straight line plot element.

PLOTL3 Bar3 3 noded straight line plot element.

PYRA5 Pyramid5 5 noded solid pyramid.

QUAD4 Quad4 4 noded quadrilateral shell element.

QUAM4 Quad4 4 noded quadrilateral plane membrane element.

QUAM8 Quad8 8 noded quadrilateral plane membrane element

QUAMS4 Quad4 4 noded quadrilateral solid shell element

QUAMS8 Quad8 8 noded quadrilateral solid shell element

QUAX4 Quad4 4 noded quadrilateral axisymmetric solid element

QUAX8 Quad8 8 noded quadrilateral axisymmetric solid element

SHEAR4 Quad4 4 noded quadrilateral plane shear panel element.

SHELL3 Tria3 3 noded triangular shell element for laminates.
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Card Supported Element
Configurations

Description

SHELL4 Quad4 4 noded quadrilateral shell element for laminates.

SPRINGX1 Spring

SPRINGX2 Spring

SPRINGX3 Spring

SPRING1 Spring Translational spring.

SPRING3 Spring Spring with three translational stiffnesses

SPRING6 Spring Spring with three translational and three rotational
stiffnesses.

TET4 Tetra4 4 noded solid tetrahedron.

TET10 Tetra10 10 noded solid tetrahedron.

TRIA3 Tria3 3 noded triangular shell element.

TRIA3K Tria3 3 noded triangular thin shell element.

TRIM3 Tria3 3 noded triangular plane membrane element.

TRIM6 Tria6 6 noded triangular plane membrane element.

TRIMS3 Tria3 3 noded triangular solid shell element

TRIMS6 Tria6 6 noded triangular solid shell element.

X1DAMP3 Mass Scalar viscous damper at one node with three
degrees of freedom.

X1DAMP6 Mass Scalar viscous damper at one node with six
degrees of freedom.

X1GEN6 Mass General element at one node with six degrees of
freedom.

X1MASS3 Mass Scalar mass at two nodes with three degrees of
freedom.

X1MASS6 Mass Scalar mass at one node with six degrees of
freedom.

X1STIFF3 Mass Scalar spring at one node with three degrees of
freedom.
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Card Supported Element
Configurations

Description

X1STIFF6 Mass Scalar spring at one node with six degrees of
freedom.

X2DAMP3 Spring Scalar viscous damper at two nodes with three
degrees of freedom.

X2DAMP6 Spring Scalar viscous damper at two nodes with six
degrees of freedom.

X2GEN6 Mass General element at two nodes with six degrees of
freedom.

X2STIFF3 Spring Scalar spring at two nodes with three degrees of
freedom.

X2STIFF6 Spring Scalar spring at two nodes with six degrees of
freedom.

Radioss Cards

Note:

• Shell thickness is included with the connectivity data. The default value is contained in
the property set.

• The time history is provided for the elements.

• 3D elements are supported.

• Degenerated 3D solid elements (from Hexa), such as Tetra and Penta, are included with
the present 3D elements.

Card Supported Element
Configurations

Description

/ADMAS Mass Assign additional non-structural mass to nodes or
a group of nodes. Optionally the total additional
non-structural mass of a part or a group of parts
can be defined (applied to shells and solids only)
or a surface mass can be assigned to a surface
and Radioss would then compute the added node
based mass value using area (volume) - weighted
distribution.

/BEAM Bar Describes the beam elements. Two properties
(/PROP/TYPE3 (BEAM) and /PROP/TYPE18
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Card Supported Element
Configurations

Description

(INT_BEAM)) are available for this beam element.
The properties describing a beam element are all
defined in a local beam coordinate system.

/BRIC20 Hex20 Describes 3D solid elements (20 Node Brick
Elements). This quadratic element should be used
with the property /PROP/SOLID.

/BRICK Hex8

Penta6

Pyramid5

Tetra4

Defines a hexahedral solid element and thick shell
element with 8 nodes.

/CYL_JOINT Rigid Defines cylindrical joints.

/QUAD Quad4 Describes the 2D solid elements. QUAD elements
must be defined in the global YZ plane.

/RBE2 Rigid Defines a rigid body whose independent degrees
of freedom are specified at a single master node
and whose dependent degrees of freedom are
specified at an arbitrary number of slave nodes.

/RBE3 RBE3 Defines the motion of a reference (slave) node
as the weighted average of the motions of sets of
master nodes.

/RBODY Rigid Defines rigid bodies.

/RLINK Rigid Defines a rigid link. The rigid link imposes the
same velocity on all the slave nodes in one or
more directions.

/SHELL Quad4 Describes input for 4-node shell elements.

/SH3N Tria3 Describes the triangular 3-node shell elements.

/SPHCEL Mass Describes the SPH cells.

/SPRING2N Spring2N Describes the 2-noded spring elements.

/SPRING3N Spring3N Describes the 3-noded spring elements.

/SRPING4N Spring4N Describes the 4-noded spring elements.
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Card Supported Element
Configurations

Description

/TETRA4 Tetra4 Describes a tetrahedral solid element with 4
nodes.

/TETRA10 Tetra10 Describes a tetrahedral solid element with 10
nodes.

/TRUSS Rod Describes one dimension truss elements, which
could be used with property /PROP/TYPE2
(TRUSS). Truss could only carry axial load (like for
bar).

/XELEM Xelem Describes the multi-strand elements.

Samcef Cards

Card Supported Element
Configurations

Description

AXISYM Bar2

Tria3

Tria6

Quad4

Quad8

BUSH Spring

COMP AXISYM Tria3

Tria6

Quad4

Quad8

COMP DEFO PLAN Tria3

Tria6

Quad4

Quad8

COMP MEMB BIDIM Tria3

Tria6

Quad4
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Card Supported Element
Configurations

Description

Quad8

COMP PLAN GENE Tria3

Tria6

Quad4

Quad8

COMP VOLU Hex8

Hex20

Penta6

Penta15

Pyramid5

Pyramid13

Quad4

Quad8

Tria3

Tria6

COMP VOLU COQUE Hex8

Hex20

Penta6

Penta15

COQU DEFO PLAN Bar2

Rod

Tria3

Tria6

Quad4

Quad8

DEFO GENE Tria3

Tria6

Quad4

Quad8

DEFO PLAN Bar2
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Card Supported Element
Configurations

Description

Rod

Tria3

Tria6

Quad4

Quad8

FLUX THERMIQUE Rod

Tria3

Quad4

Tria6

Quad8

FOUR MULT HARM Bar2

Tria3

Tria6

Quad4

Quad8

FOURIER Bar2

Tria3

Tria6

Quad4

Quad8

HETEROSIS Quad8

Tria6

HYBR VOLU Bar2

Hex8 Hex20

Penta6

Penta15 Pyramid5

Pyramid13

Rod Tetra4

Tetra10

Tria3 Tria6

Quad4
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Card Supported Element
Configurations

Description

Quad8

HYBRID VOLU COQUE Hex8

Hex20

Penta6

Penta15

MEMB AXISYM Bar2

MEMB BIDIM Bar2

Rod

Tria3

Tria6

Quad4

Quad8

MEMB FLEXION Tria3

Tria6

MEMB FOURIER Bar2

MEMB MULT HARM Bar2

MINDLIN Bar2

Rod

Tria3

Quad4

Tetra4

Pyramid5

Penta6

Hex8

Tria6

Quad8

Tetra10

Pyramid13

Penta15

Hex20
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Card Supported Element
Configurations

Description

RBE3 RBE3

SAND VOLU Quad4

Quad8

Tria3

Tria6

SOLID SHELL Hex8

Hex20

Penta6

Penta15

THER AXISYM Bar2

Tria3

Tria6

Quad4

Quad8

THER COQU Rod

Tria3

Quad4

Tria6

Quad8

THERMIQU Rod

Tria3

Quad4

Tetra4

Pyramid5

Penta6

Penta15

Hex8

Tria6

Quad8

Tetra10

Pyramid13
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Card Supported Element
Configurations

Description

Penta15

Hex20

TUYAU Rod

TUYAU THERMIQUE Rod

VOLU COQUE Hex8

Hex20

Penta6

Penta15

VOLUMIC Bar2

Hex8

Hex20

Rod

Tetra4

Tetra10

Tria3

Quad4

Tria6

Quad8

Penta6

Penta15

Pyramid5

Pyramid13

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1777

Criteria and Parameter Settings
Configure criteria and parameter settings.

See Also
Edit Criteria and Parameter Files

Criteria Settings
Setup the quality index (QI) mesh criteria in the Criteria and Parameters Files Editor, Criteria tab.

This criteria is used in QI and batch meshing, and in QI-based element checks. Criteria definitions can
be saved to a file, and loaded for subsequent editing.

The editor is laid out in a table format, with each check displayed in the first column, and the controls
and values associated with each check in subsequent columns to the right.
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Figure 685:

Target element size
Desired element size for the mesh.

CAUTION:  Modifying this value may generate errors in the Min Size and Max Size,
which will show up as red text.

Turn checks on/off
In the On column, use the checkbox to turn each individual check on/off.

Fail value
In the Fail column, edit the fail value for each specific check.
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Good, warn, worst, and weight value
The Good, Warn, and Worse fields are interpolated or extrapolated automatically.
Select the Advanced Criteria Table checkbox to access the Weight, Good, Warn and Worst
columns and edit each check's corresponding value.
Such changes modify how the quality index value is calculated, but do not significantly impact the
final mesh. Weight factors are also adjustable, but they also do not make a large difference in the
final mesh, unless they are set to an order of magnitude higher than the others. Default values for
the weight factors are recommended.

Calculation methods
In the last column, select a calculation method to apply for certain checks. Available methods may
vary for each check.
To use more than one solver’s method, select the Individual Methods option from the first list
box in the last column. The different solver calculation methods are described in How Element
Quality is Calculated. The Chordal Deviation check is currently ignored when performing batch
meshing or QI meshing. It is only used to calculate the QI value from the Quality Index panel.

Minimum length calculator
Below the table is a minimum length calculator, based on time step, which can be used to
calculate the suggested minimum length, based on a material, time step, and a scale factor.
A pre-defined material can be selected, or a custom material can be defined.
Apply the calculated minimum length by selecting the Use min length from timestep
calculator checkbox.

Parameter Settings
Setup the geometry cleanup and defeaturing parameters in the Criteria and Parameters Files Editor
dialog, Parameter tab.

These parameters are used to define things such as washer layers around holes, defeaturing pinholes
and solid holes, rows of elements along fillets, and many other options.

The Parameters tab is divided into multiple sections. Each section can be toggled to show or hide its

options via the small triangular arrow ( ) to the right of it. Each section represents a specific type of

operation, which can be enabled or disabled at several levels.

Element/Import

Figure 686:

Target element size
Desired element size for meshing and optimization.
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Note:  The element size defined here should match the ideal value for min length and
max length as defined in the criteria file. If this does not match, Batchmesher may not
be able to produce meshes that adhere to the target quality requirements.

Import model with tolerance
Tolerance value to be used while importing the CAD model.
Select auto (recommended) to automatically calculate the tolerance based on the type and
dimensions of the model.

Extract Midsurface
The Extract midsurface parameters define the tasks that are performed by Batchmesher when
extracting the midsurface.

Select the Extract midsurface checkbox to extract the midsurface before meshing using the selected
extraction method. Only the midsurface geometry is meshed and the original geometry is deleted.

Note:  For parameter files saved before 14.0, the midsurface extraction method used is
"offset", which matches with what was used in earlier releases before the option to select
the method was available.

Figure 687:

Method
Select method to use when extracting the midsurface before meshing.

Sheet metal only
Only consider geometry for midsurface extraction that meets the user defined settings for the
options specific to sheet metal.

Note:  If this option is disabled, it will result in a time savings, but all parts will be
attempted to have a midsurface extracted.

Maximum thin solid thickness to width ratio
Maximum ratio between the approximate thickness of the thin solid part (shortest dimension) and
its approximate width (2nd shortest dimension). This parameter is used to limit the midsurface
extraction to parts for which the thickness is clearly smaller than the length and width.
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Maximum thin solid thickness
Ignore thin solids with a thickness less than the specified value during midsurface extraction.

Minimum feature angle between the solid’s edge and its faces
Minimum angle used to distinguish top and bottom faces of a thin solid from its sides. Angles less
than the specified value will be treated as if they were flat for purposes of midsurface extraction.

Pre-Midsurface Geometry cleanup
Perform geometry cleanup steps on the model before midsurface extraction.

Direct Midmesh
The Direct Midmesh parameters defines settings used to create direct midmesh.

Select the Allow direct midmesh checkbox to create direct midmesh for the parts where midsurface
extraction is difficult or not possible for example plastics, castings and machined parts. Additional
options are also enabled once this checkbox is enabled.

Figure 688:

Ignore flat edges
Do not imprint flat edges from the input geometry onto the midmesh.

Flatten connections
Align/flatten the midmesh at ribs/connections.

Defeature openings with width <
Remove small holes and openings less than the specified width.

Suppress proximity edges factor
Remove 1D topology edges within the given factor of the minimum size from the criteria file.

Combine non-manifold edges factor
Join non-manifold edges within the given factor of the minimum size from the criteria file.
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Geometry Cleanup
Geometry cleanup parameters define a variety of geometry feature recognition and preparation tasks
performed by Batchmesher.

Geometry cleanup behaviors and options provide excellent feature capture with more user control
resulting in more predictability, consistency and ease of use.

Batchmesher recognizes classified features like beads, dimples, flat bottom bosses/depressions, flanges,
fillets, holes (2d and 3d), and so on. These features are treated following user defined criterias, allowing
the preservation of the main feature edges providing excellent feature capture.

The main tools for geometry cleanup include:

• Flat feature suppression level, a curvature based feature suppression.

• Suppress edges by proximity, allows to handle feature edges in close proximity, generally based on
minimum element size.
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Controlling the above parameters can result in good feature capture with minimum quality index
failures. However, features are given more importance which might increase the failed element count
based on geometry and the cleanup parameter values. It is important to define all of the settings
appropriately.

Select the Geometry cleanup checkbox to enable additional cleanup parameters that can be turned on
and off independently.

Surface Hole Recognition

Figure 689:

When Surface hole recognition is activated, surface holes of different sizes are recognized and
treated appropriately. A table becomes enabled to define the radii ranges and additional options.

Surface hole recognition table data

Define radii ranges and additional options in the table. Click  to add a row to the table, or click

 to remove a row from the table.

Table 192: Surface Hole Recognition Table Data

Column Action

R< Maximum radius of the current hole range. The minimum value is
taken as 0.0 for the first row, or as the maximum value from the
previous row. For slotted holes, the radius is measured at the tip of
the hole.

Range Radius range for the current row. This value is read-only.

Mark center Create a node and tag at the center of the hole, or do nothing.

Remove Remove (defeature) the hole. For slotted holes, the hole is removed
only if the tip radius is less than the specified radius threshold, and
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Column Action

the length of the hole is less than 1.4 times the target element size.
If Remove is disabled, additional options are available.

Target radius Adjust holes in the range to have the specified target radius. The
radius can be specified as an exact value, for example 5.0, or as
an expression based on the original radius, for example radius*1.1,
radius-0.5, radius+0.5.

# elems Enter the minimum/exact number of elements to create around the
holes, or set to auto to automatically select the number of elements
so that the min and max element size requirements are satisfied,
with the best possible representation of the hole shape.

Tip:  Auto is not recommended for holes with washer
layers.

Elems mode Choose whether # elems setting defines the minimum or exact
number of elements.

Washer Create washer layers around holes. If specified, one or two layers
can be created.

1st washer/2nd
washer/3rd washer

Sets the width of the first, second, third washer as a constant value
(select the blank entry in the drop down and enter a value), a scale
of the hole radius, for example 0.6*radius, a subtraction formula,
for example 14.0-radius, or an automatic determination based on
element quality.

Priority Set the priority of one radii range over the others. For example, to
ensure all bolt holes (radii 10-15) have correct washers but other
holes are not critical, holes with radii 10-15 will receive higher
priority than others. This ensures that if two holes close to each
other in the model have overlapping/conflicting washers, the hole
with higher priority gets the washer while the other does not, or the
hole with the lower priority may get a modified washer instead. In
addition, when a hole is set to high priority, washer elements are
not modified to correct for failed element quality. If a hole is set to
normal priority, washer nodes are allowed to move to correct the
quality.
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Figure 690:

Clear this checkbox to attempt to generate a mesh using the pattern indicated in Figure 691,
which has six elements, two on each long side and one on each end.

Figure 691:

Add circumferencial trim lines for washer
Keep geometry trim lines for washers.

Figure 692: Add circumferencial trim lines for
washer - Off

Figure 693: Add circumferencial trim lines for
washer - On
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Suppress flanged holes with height <
Recognize holes with small downward flanges and eliminate those flanges with a height less than
the specified value. Flanges with a height less than the minimal element size are extended to the
minimal element size if not removed.

Use File for Hole Recognition

Figure 694:

Select Use file for hole recognition to provide a file containing X, Y, Z center locations of all of the
holes to consider. This is useful for special treatment of specific holes, usually bolt holes.

Batchmesher compares the defined locations to the holes in the model, and prioritizes the holes that
match. All of the options for Surface hole recognition are available for these holes. If one or more holes
files are defined, Batchmesher looks for the found holes in each file, in the order the files are defined. If
found, it applies the washer table linked to the first found file to the corresponding holes. If a hole is not
found in any file, the settings from the default general surface holes table are used.

Multiple files can be specified, each with their own definitions. The order of the files determines the
order of precedence in the case where there are overlapping or conflicting definitions.

Click Add table to add a new table for creating a new hole file. Click Delete table to delete the
specified hole file table.

The holes file must contain one line for each hole, with the values either space, tab or comma
separated. Each line contains a line number followed by the X, Y, Z locations of each hole center.

1 1420 -839 65
2 1724 -846 212
3 1683 -845 265
4 1660 -841 308

Figure 695: Spaces/Tabs with Line Numbers

1,1420,-839,65
2,1724,-846,212
3,1683,-845,265
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Figure 697:

Select Solid hole recognition to recognize and treat solid holes (cylindrical surfaces in volumes) of
different sizes. A table becomes enabled to define the radii ranges and additional options.

Click  to add a row to the table, or click  to remove a row from the table.

Table 193: Solid Hole Recognition Table Data

Column Action

R< Maximum radius of the current hole range. The minimum value is taken as 0.0
for the first row, or as the maximum value from the previous row.

Range Radius range for the current row. This value is read-only.

Mark center Create a node and tag at the center of the hole, or to do nothing.

Remove Removes (defeature) the hole. If Remove is disabled, you must specify the
minimum/exact # elems to create around the holes.

Surface Fillet Recognition

Figure 698:
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Select Surface fillet recognition to recognize surface fillets in order to perform one or more of the
following options:

• Prevent the main (long) edges of the fillets from being suppressed, and also prevent the nodes of
those edges from moving while fixing element quality.

• Remove/defeature fillets. Gaps may result if complicated fillets cannot be removed.

• Split the fillets along the mid-line and suppress the edges.

• Specify the number of elements across the width of the fillets for given fillet radii.

• Specify the chordal deviation to be achieved while meshing.

A table becomes enabled to define a desired number of element rows for specific ranges of average fillet
radii, width, or both. The width value is defined is the arc length of the fillet.

In Figure 699, uniform fillet strips with an average radius between 3 and 5 and an average width
between 2.0 to 9.0 will be meshed with one row of elements; uniform fillet strips with an average
radius between 5 and 20 and an average width between 9.0 to 16.0 will be meshed with two rows of
elements; and uniform fillets strips with an average radius between 20 and 30 and an avarage width
between 16.0 to 24.0 will be meshed with three rows of elements. This rule does not apply to fillets
with an average element width below or above the defined ranges of non-uniform fillet strips (when
minimal and maximal width of fillets exceed 30%).

Figure 699:

If the width or number of rows columns in the surface fillet recognition table are empty, the next default
value will be applied. In this example, that means uniform fillet strips with an average fillet width
between the element sizes of 0 to 2.0 will be meshed with one row of elements.

A fillet can be meshed with enforced rows of elements, or split at its midline and meshed accordingly
based on element quality.

The mesh settings can be defined as an exact number of rows when Minimize transitions is disabled.
This allows the Suppress tangency edges option to also become available. When enabled, fillets are
treated by making a midline and suppressing the fillet itself. This combination may be selected to
defeature very narrow fillets. Midline spliting without suppressing tangency edges can be used for wide
fillets to ensure that the fillet mesh will be symmetrical. Enabling Minimize transitions helps to reduce
trias. The mesh settings are then provided either as a minimum number of elements and/or determined
based on a maximum chordal deviation criterion. Batchmesher calculates the required number of
elements as the maximum of the user-specified number of rows and the number of elements required
to meet the maximal chordal deviation.
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Note:  The minimal element size and aspect ratio criteria requirements are always honored.
This means that the element quality restrictions have the highest priority when calculating
the element density for a fillet range.

Flange Recognition

Figure 700:

When Flange recognition is activated, geometry that represents flanges on sheet metal parts is
recognized and the below options become enabled. Flanges may be modified to suppress construction
lines, subdivide them into rectangular areas, or otherwise prepare them for proper meshing. As this
functionality is not supported for solid geometries, it should be disabled for such models to improve
performance.

Elements across flange width
Minimum number of elements to be created across the flange width.

Maximum width of flange
Maximum flange width to consider for flange recognition.

Minimum width of flange
Minimum flange width to consider for flange recognition.

Delete flange narrow surfaces with width <
Controls the removal of narrow flange surfaces to avoid creation of sliver elements and
disruptions in the mesh flow.

Auto
Delete narrow flange surfaces when the maximal narrow surface width is the minimum of
0.2*element_size and min_element_size.

<value>
Delete narrow flange surfaces when the maximal narrow surface width is the minimum of
the specified value.
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Figure 701: Flange Narrow Surface Width Figure 702: Narrow Surface Removed

Bead Recognition

Figure 703:

When Bead recognition is activated, geometry that represents beads on sheet metal parts is
recognized and the below options become enabled.

Suppress beads with height <
Enable bead recognition and suppress any beads with a height less than the specified value. This
helps eliminate small elements and aids in creating a good mesh flow.

Preserve rounded bead midline
Enforce node placement along the midline of a rounded bead.

Logo Recognition

Figure 704:
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Use the Logo Recognition parameters to remove small geometric features that represent logos in the
model design.

Figure 705: Logo Recognition Parameters

Remove logo with size <
Maximal size of a letter in the logo, as measured along/parallel to the "shiny" surface.

and height <
Maximal height/depth of a letter in the logo, as measured normal to the "shiny" surface.

Concavity factor
Creates a filter that provides more flexible control of automatic logo recognition. As this is
a heuristic tool, it may remove real features, such as flat bottom round dimples, that were
not intended for removal. The Concavity factor is a quantitative measure of a letters shape
complexity, formally defined as:

The contour_accumulated_turn_angle is the sum of angles between a letters contour straight
parts. Curved parts of a contour letter are approximated by a segmented line composed of
short straight segments. For completely concave contour, such as circles, quads, and hexagons,
concavity factor contour_accumulated_turn_angle = 360 degrees and concavity factor = 0.

Tip:  Extend the recognition and removal of a logo by reducing the Concavity factor.

Thread Recognition
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When Thread Recognition is activated, geometry that represents threads is recognized and the below
options become enabled.

Figure 706: Thread Recognition Parameters

Remove threads with depth <
Remove cylindrical or conical threads with a depth less than the specified value, and replaces
them with a smooth cylinder or cone surface.

and replacing cylinder diameter
Method used to define the diameter of the replacing cylinder or cone.

autodecide
Automatically determine diameter based on the diameter of a blank before thread cutting
begins.
For inner (hole) threads, it corresponds to the thread minor diameter. For outer (bold)
threads, it corresponds to the thread major diameter.

major
Use diameter of the thread major.

mean
Use diameter of the thread mean.
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Other Options

Figure 707:

When Other Options is activated, the following options become enabled:

Delete duplicated surfaces / with tolerance
Define which duplicate surfaces to delete before meshing.
For Delete duplicated surfaces, choose a method to find duplicate surfaces

All
Consider all of the surfaces in all of the components against each other.

Within components only
Consider all surfaces within components only. Duplicate surfaces between components are
not found.

None
Do not remove duplicate surfaces.

For With tolerance, define the tolerance used when finding duplicates.

Auto
Automatically calculate the tolerance from the model size and other relevant geometric
parameters.

<value>
Enter a tolerance. This is more useful when the auto tolerance is not sufficient to find all of
the duplicates.

Edges equivalencing with tolerance <
Tolerance to use for equivalencing (stitching) edges, in conjunction with the options below.

auto
Calculate the tolerance internally.
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<value>
Enter a tolerance. This is more useful when the auto tolerance is not sufficient to make all of
the necessary connections.

Allow T-connections
Allow T-connections (non-manifold edges) to be created during the stitching process.

Within components only
Allow stitching only within components. Stitching between edges of different components is not
allowed.

Fix overlapped surfaces with tangency angle <
Fix overlapping surfaces.

Auto
Calculate the tangency angle internally.

<value>
Enter a maximal tangency angle to fix overlapped surfaces.

Figure 708: Overlapped Surfaces Tangency Angle Figure 709: Overlapped Surfaces Fixed

Note:  This option may remove the surfaces that should not be deleted. For example,
it may happen to surfaces with T-connections. Setting the angle to < 45 may help
reduce such side effects.
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Figure 710: Possible Side Effects of Fixing Overlapped Surfaces

Remove edge fillet with radius <
Square off any fillets/rounded edges located on free edges and having radii below the specified
value. This helps to create a good mesh pattern in such areas. For concave fillets, this means
material is removed. For convex fillets, this means material is added.

Flat feature suppression level
Suppresses feature edges based on curvature break angle. For the ease of use, you can select a
curvature break angle range, which varies from very low to very high.
The curvature break angle is calculated based on Feature character size.
Choose different levels of suppression from very low to very high for more flexibility and control
over capturing feature edges. very low suppression level corresponds to keeping maximum
feature edges, while very high suppression level subjects the geometry to more feature edge
suppression.
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Figure 711: Flat feature suppression level: Very Low Figure 712: Flat feature suppression level: Very High

If you are not satisfied with the result, choose user defined to enter a custom angle in the
Custom feature angle field.

Note:  The user defined and recognized features options are excluded from this
suppression to enable you to capture and protect important features.

Feature character size
Calculate the curvature break angle, which is defined by an element size or calculated
automatically based on characteristic dimensions of the part.

Custom feature angle
Custom feature angle.

Suppress edges by proximity <
Suppress full or partial feature edges within the defined proximity value.
This option allows geometry cleanup to consider a minimum element size defined in the criteria
file, which helps to avoid minimum size quality failures. You can choose to enter an absolute value
for proximity, or you can choose to use the minimum element size or its factor.
When two or more feature edges come in proximity the following guidelines or rules are used in
general to determine which feature edge gets suppressed to get more consistent and predictable
results:

• Full or partial feature edges within proximity are suppressed.
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Figure 713:

• Feature edges that have higher curvature values are retained.

Figure 714:

• Boundary (free) edges are given priority.

Figure 715:

• Base and top feature edges are given a priority while doing proximity cleanup for features like
bead, bosses, and so on.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1798

Figure 716:

Note:  The proximity value is generally kept less than the minimum element size
considering node movement tolerance.

Preserve Boundaries between Components

Figure 717:

Preserve boundaries between components
Do not suppress or remove components' boundary edges during geometry cleanup, and do not
move elements nodes across the components' boundaries. In some cases, maintaining boundaries
for adjacent components that do not have any structural meaning would significantly worsen the
element quality results.

Mesh Options
The Mesh Options parameters are used by Batchmesher to generate a mesh on the cleaned-up
geometry.

This is one of the main functions of Batchmesher and is turned on by default. You can choose to turn off
this parameter if you only want to perform geometry feature recognition and cleanup without meshing.
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Figure 718:

Batchmesher has a powerful mesh flow algorithm which considers the shape of the geometry and aligns
the mesh to create orthogonal meshes automatically. It also helps to reduce number of trias and places
them strategically to avoid bad mesh patterns. Batchmesher is able to control the average element size
in order to generate a more uniform mesh.

When Mesh options is activated, the following options become enabled.

These parameters control the behavior of the post-mesh element cleanup operations. They are intended
to fix elements failing the quality criteria, to reduce number of tria elements for mixed/quad meshes,
to correct bad mesh patterns, and to fix mesh flow for fillets. All of the element cleanup operations are
compliant with the quality criteria, in that they should improve or at least not worsen the mesh quality.

All element cleanup behaviors are based either on nodal movement (smoothing), changing element
connectivity (collapsing, splitting, and so on) or local remeshing.

Element type
Type of elements to create.

Element order
Create first or second order elements.

Place elements in
Organize new elements in either the current component or the original surfaces’ component(s).

Apply optimized smoothing
After the surfaces are appropriately meshed, the nodes are optimized towards a target smoothing
value to improve the element quality while maintaining geometry features.

none
Do not perform smoothing.
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within surfaces
Smooth the nodes within surfaces. Nodes on surface edges are not moved.

along edges
Smooth nodes both within a surface and along edges. Nodes on edges are allowed to move
only along the edge to improve element quality.

across edges
Smooth nodes both within a surface and across edges. Nodes on edges are allowed to move
both along and across the edge to the neighboring surface to improve element quality.

Smooth target
A composite Quality Index rating, ranging from 0 (perfect elements) to 1.0 (failed elements). The
default of 0.2 is ideal for most cases, producing elements of good quality without taking too long
to optimize, but can be altered if necessary.

Move across shared edges, max dist <
Move nodes across or away from the geometry's shared edges by less than the specified distance.

Move across free edges, max dist <
Move nodes across or away from the geometry's free edges by less than the specified distance.

Allow nodes to move on plateau feature top edges
Do not allow nodes to move off the top/bottom edges of recognized embosses, particularly those
containing central bolt holes to fix failed elements.

Figure 719:
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Figure 720: Allow Nodes to Move on Plateau Feature
Top Edges = On

Figure 721: Allow Nodes to Move on Plateau Feature
Top Edges = Off

Keep nodes on edges for free round holes with <=
Do not allow any nodes to move off the edges of free holes (without washers) with less than a
specified number of elements. This is useful if distortion of the holes is not allowed.

Figure 722: Keep Nodes on Edges for Free Round
Holes with <= On

Figure 723: Keep Nodes on Edges for Free Round
Holes with <= Off
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Divide quads into trias
Split quads into trias to meet the element criteria defined in the criteria file.

Feature angle during element cleanup
Element feature angle to maintain while performing element cleanup.

Folding angle
Elements whose angle exceeds this value are considered folded over, and BatchMesher attempts
to clean them up.

Special Component Selection
The Special component selection parameters define a method for selecting special components.

Figure 724:

When Special component selection is activated, the following options become enabled:

Mesh selected components without geometry cleanup
Mesh the listed components but will not perform any geometry cleanup on them before meshing.
Any remaining components that are not listed will be batch meshed using the normal process,
including geometry cleanup.
This is useful for models in which some components do not require geometry cleanup but the rest
might. Models in which no components require cleanup can be batch meshed with the Geometry
Cleanup checkbox turned off.

Mesh selected components while maintaining connectivity to external mesh
Mesh the listed components while maintaining connectivity to any existing mesh.
This is useful when components are to be meshed with multiple element sizes but transitions
at the common edges of the different sizes are required. Each component should be meshed
individually with its own parameter and criteria files with this option enabled.

Ignore selected components while maintaining connectivity to meshed components
Ignore the listed components while maintaining connectivity to any existing mesh. The mesh and
geometry of the ignored components are not touched during batch meshing. The mesh created on
other adjacent components is connected to any existing mesh on the ignored components.
This is useful for batch meshing of different components with different criteria/parameters files,
or when pre-meshing components interactively or with some other procedure, followed by batch
meshing of other components.
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Click  to add the name of a component specified in the drop down to the table. To provide a new

name, select the empty entry in the drop down and type a new name. Click  to remove the selected
row from the table.

As an example, a model may have two components named front_10 and rear_20, which share common
surface edges. The component front_10 is to be meshed with element size 10 and rear_20 with element
size 20. This can be accomplished as follows:

1. Create two sets of parameter/criteria files.

• The first should have a target element size of 10 and the appropriate parameters. In
this parameter file, turn on the Special component selection option, Mesh selected
components while maintaining connectivity to external mesh sub-option, and add
front_10 to the component list.

• The second file should have a target element size of 20 and the appropriate parameters.
In this parameter file, turn on the Special component selection option, Mesh selected
components while maintaining connectivity to external mesh sub-option, and add
rear_20 in the component list.

2. Create a mesh type and assign the first set of criteria and parameter files.

3. Create a second mesh type with the same name as the first, and assign the second set of criteria
and parameter files.

4. Choose the geometry file to be batch meshed, assigning it the mesh type from above, and submit
the job.

This will mesh front_10 first with the first mesh type, and then take the results of this and mesh
rear_20 with the second mesh type, while maintaining connectivity with the mesh created on front_10.

Guidelines and Recommended Practices

Criteria File
• When defining the Target element size, it is recommend to use either the Minimal height or the

Minimal normalized height methods. These methods do not affect the quality of quads, and for the
same mesh only the tria quality will be reduced with the minimum height method. Moreover, the
use of the Shortest edge method may result in the creation of rhombus-like quads, which are only
useful for special kinds of meshes.

• After the Target element size, the most important aspects are the Min Size and Max Size. These
have the highest impact on the final mesh output.

◦ The Min Size should not be too big with respect to the Target element size. The recommended
size is 33% of the Target element size. On the upper end, a value of 40%-50% of the Target
element size is also acceptable. A larger than recommended Min Size may trigger intensive
cleanup that disrupts the mesh flow.

◦ The Max Size should not be too small. A value of 175% of the Target element size is
reasonable.
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◦ The range between Min Size and Max Size should not be too tight, otherwise there is limited
ability to improve the mesh result.

• A Warpage value between 20°-25° is recommended. A value of 15° may be too tight, over
constraining the mesh generation. With a value of 15° or lower, violating quads may have some
nodes be moved away from the geometry, or may be split into two trias, depending on the
parameter file settings.

• Skew, Min Angle, and Max Angle are dependent on each other. The Jacobian value also has an
effect on the element shape. An element with a small Jacobian value, for example, will have poor
angles. Calculating the Jacobian at the corner points is a more strict setting.

• Taper is used for orthogonality. In some way, it controls the same outcome that angles and
Jacobian also account for. Taper is most useful for solvers that have a direct requirement for it.

• The reduction of tria elements is performed automatically by the Batchmesher, even when the
criterion % of Trias is not enabled. Therefore, you will not see a large difference when changing this
value with respect to the default Batchmesher result.

• Careful consideration should always be given when changing criteria values. As many criteria are
interdependent, over-constrained values can lead to poor mesh flow and mesh adherence to the
geometry is likely to be disturbed.

Parameters File
Midsurface Extraction

• The skin offset method is recommended whenever constant thickness parts without ribs/t-
connections require mid-surface generation. This method is the fastest and most efficient for
such models.

Geometry Cleanup - Surface Hole Recognition

• For improved mesh flow, an even number of elements should be specified. Usually, this value
is set to comply with the min and max element size requirements. While not recommended,
it is permissible to set this so that the element size violates the min or max element size
restrictions. The use of the auto setting is not recommended for holes with washers.

◦ The following formula can be used to calculate the resulting element size S given a hole
radius R and number of elements around the hole N:

For example, a hole with a 2.5 mm radius and 6 elements around the hole will result in a
mesh size of 2.5 mm.

◦ To not have elements smaller than the min element size around holes, use a radius
threshold for removal > = 0.708*min element size.

• Incompatible settings for holes with washers can lead to the creation of failed elements and/
or outer washer ring elements with lengths significantly different from the target mesh size.
This can lead to bad mesh flow and bad transitions to the regular mesh.

◦ It is not recommended to set the number of elements for a hole with washers to less
than 6.

◦ Using minimal mode for # elems and auto mode for washers is recommended whenever
possible, as it gives the most flexibility. With these settings, the outer washer element
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size is close to the target element size, and the washer elements comply with the quality
criteria. However, washers will not be built if it is not possible to create elements of
permissible quality, or the outer washer ring element size appears significantly larger
than the target element size. Another side effect is that as a last resort, a washer may
be built with an odd number of elements in order to build a good quality washer.

◦ When specifying an exact number of elements for holes and/or a fixed number of
elements, or radius fraction, for washers, consider the implication to the element quality,
aspect ratio, min/max size, Jacobian, and the outer washer ring element size, using the
formula as above.

◦ It is possible to create washers with failed elements and/or with an outer washer
element size different from the target element size. This is done by defining washers as
a fixed number or as a radius fraction. Use exact mode for # elems if it is expected that
the outer ring element size is more than 140% or less than 60% of the target element
size. In addition, when a hole is set to high priority, washer elements are not modified
to correct for failed element quality. If a hole is set to normal priority, washer nodes are
allowed to move to correct the quality.

• Use the Attempt to maintain narrow slots rounded ends using >= 6 elements option only
if absolutely necessary. Meshing of small areas produced by this option will often have a
negative impact on the mesh flow.

Geometry Cleanup - Solid Hole Recognition

• This should be disabled for models having only shell geometry, as the recognition of the solid
holes is potentially time consuming.

• Define even numbers of elements around holes, trying to comply with the min element size
criterion and trying to have the element size as close to the target element size as possible.

Geometry Cleanup - Surface Fillet Recognition

• The following formulas define how the fillet geometry parameters and the mesh density are
related:

W
Fillet arc width

R
Fillet radius

Fillet arc angle (radians)

Wch
Fillet chordal width

S
Element size across the fillet

N
Element density across the fillet
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D
Chordal deviation

• Enabling the Minimize transitions option is highly recommended. However, in very rare
occasions it may create rows of strongly skewed elements. This may happen for fillets having
multiple irregular fixed points on the fillet sides, or multiple intersections of those edges. For
such cases, it may be disabled to improve the result.

Geometry Cleanup - Flange Recognition

• It is recommended to use a minimum of two elements across the flange width. The actual
number of elements is determined internally by accounting for restrictions on the min and
max element sizes, as well as the aspect ratio.

• A reasonable upper limit for the maximum flange width is around (N + 1.5) * element size,
where N is the number of elements across the flange. Similarly, a reasonable lower limit is
two times the min element size.

Geometry Cleanup - Bead Options

• The Suppress beads with height < value is dependent on specific modeling requirements.
Typically, this is set around 20% of the target element size, but not larger than the criteria
minimal element size.

Geometry Cleanup - Logo Options

• For logo removal, a Concavity factor value of 2.0 is recommended for logos with complex
lettering. For logos with simple shapes, though, a value of 1.0 or even 0.0 may be used. In
this case, to reduce the danger of removing valid features, assign height < a value no greater
than the Suppress beads with height < value.

Geometry Cleanup - Other Options

• The Remove edge fillet with radius < recommended upper limit is between the min element
size and the target element size.

• Flat feature suppression level is recommended to be set at “low” with “element size” as
Feature character size.

• Suppress edges by proximity value is generally kept less than minimum element size
considering node movement tolerance.

Meshing Cleanup

• For most applications, it is recommended to use the mixed type for Create mesh with
element type.

Note:  When the quad type is set, a specific algorithm is used which may have
negative effects on the mesh flow and may create undesirable mesh patterns, for
example, three quads sharing a node.

◦ Enabling both the align and size mesh flow options is highly recommended, as they have
minimal negative side effects.

• All the feature edges kept after geometry cleanup are respected during meshing and post
meshing cleanup. Nodes are moved only for the failed elements considering allowable limit
defined in parameters controlling the node movement (across shared and free edges).
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• The method chosen for Apply optimized smoothing effects the capabilities of all post-
mesh element cleanup operations. The across edges mode is set by default and is strongly
recommended, as it allows for the most flexibility in correcting the mesh. Other options are
likely to result in a high rate of failed elements because:

◦ Geometry cleanup and defeaturing cannot address all problems.

◦ The across edges mode attempts cleanup steps in the following order:

∙ Move nodes only along surface edges.

∙ Move nodes only across non-feature edges.

• Remaining failed elements are fixed using small constrained node movements for feature
edges, including strong feature edges. The only exception is that user preserved edges are
excluded from such movement. The Correct features parameters provide control over these
movements.

◦ For Move nodes across shared edges, max dist <, the suggested value is 10% of the
target element size.

◦ For Move nodes across free edges, max dist <, the suggested value is 5% of the target
element size.

• For correcting warpage of quad elements, it is recommended to enable the Offset nodes from
surfs, max dist <, and Divide quads into trias options.

◦ The recommended value for the offset distance is 10% of the target element size.

◦ When both options are enabled, warped elements are first fixed by nodal movements
normal to the geometry, followed by splitting any remaining failed quads.

• The recommended value for Feature angle during elements cleanup is 20-30. A lower value
may help with better feature representation, but a value lower than 15 may significantly
increase the rate of failed elements.
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SPH Meshing
Smooth Particle Hydrodynamics (SPH), Finite Point Method (FPM) is a technique used to analyze bodies
that do not have high cohesive forces among themselves and undergo large deformation, such as
liquids and gases.

Typical applications that use SPH FPM include: airbag modeling in crash, fuel tank slosh, bird strikes,
and explosion analysis.

In SPH FPM, a given volume of the body of interest is discretized into particles, called SPH elements.
SPH elements (called particles) are like nodes which do not have any geometric connectivity among
themselves. Each SPH element has an effective mass. The mass sum of all particles in the filled volume
of the body should be equal to the mass of the filled volume.

SPH elements are currently supported as 0D MASS elements.

0D Elements
Supported 0D elements.

0D elements are essentially mesh nodes with an additional value attached to them.

SPH Elements
Node-like particles which have no geometric connectivity among themselves. Each SPH element has an
effective mass.

Mass Elements
Configuration 1 - 0D elements with a single node that allow you to assign concentrated mass to the
model in order to represent a physical part that may not be modeled with another FE idealization.
Masses have the ability to store one node, a value of mass, and a property reference.

Mass elements are displayed as a dot with the letter M written at the centroid of the element.

SPH Element Mapping
The generated SPH elements are mapped specific cards.

Radioss
• SPHCEL

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1809

• A new property card PROP/SPH is also created.

LS-DYNA
• *ELEMENT_SPH

PAM-CRASH 2G
• SPHEL

Abaqus
• *SECTION CONTROLS

Create SPH Mesh (LS-DYNA, Radioss, PAM-CRASH 2G)
Create a SPH mesh using existing elements, components, surfaces, or solids in your model.

Before you begin, it is recommended that you create a new component collector before starting the SPH
mesh generation so that the generated mesh is stored in a separate collector.

Restriction:  The SPH panel is only available in the LS-DYNA, Radioss, PAM-CRASH 2G
solver interfaces.

1. From the 1D page, click sph.

2. Use the entity selector to select the input which defines the volume to be filled with SPH elements.

Elements, components, surfaces and solids are supported as input to the SPH mesher. Selected
elements can be shell or solid elements; however, the selected elements need to form a closed
volume.

Selected components can contain either a FE mesh or geometry; however, the FE mesh or
geometry must also form a closed volume. More than one component can be selected to form
a closed volume for SPH meshing. If the selected components are such that one is completely
contained within another, SPH elements are created within the volume between the two selected
components.
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Figure 725: SPH Elements Created within the Volume between Two Selected Components.

3. To specify which point the generation of cubes should be started, select the use reference
checkbox.

SPH elements are generated at the corners/face centers of the cubes which fall within the user
defined criteria

• Choose global origin to use the default coordinates (0,0,0) for the reference point.

• Choose local origin to manually enter node coordinates for the reference point.

4. Under mesh orientation, define the orientation of SPH elements.

• Choose global system to use the default global system to align generated SPH elements.

• Choose local system to manually select reference systems local to the model orientation.
Generated SPH elements are aligned using the user defined local system.

5. Under pitch, select a mesh type and enter a pitch value.

Pitch is the distances between each SPH particle. Smaller numbers will result in more elements
within the same space, but this will not affect the mass or density of the substance (gas, fluid, and
so on) that the particles represent.

• Choose simple cubic to arrange SPH particles in groups of 8, each particle being a corner of
a cube.

• Choose face centered cubic to arrange the particles in groups of 14, forming the corners
and the center of each face of a cube.

Note:  This is similar to a hexagonal close packed (HCP) structure and is
recommended for use in Radioss models.
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Figure 726: Pitch (h) for Simple Cubic Figure 727: Pitch (h) for Face Centered Cubic

6. Define the quantity of fluid.

Each SPH element must have an effective mass. The effective mass of each SPH element is
determined by entering either a material density of the material which fills the volume; or the
total mass of the material in the filled volume, called the filled volume mass.

• Choose material density to enter its density.

The SPH mesher determines the effective mass for each SPH element from material density,
volume to be filled with SPH elements, and number of SPH elements generated.

• Choose filled volume mass to enter its total mass.

The SPH mesher calculates effective mass for each SPH element from filled volume mass, and
number of SPH elements generated.

7. Under volume definition, specify which elements to generate SPH elements for.

• Choose all to generate SPH elements in all of the volumes in the model.

• Choose enclosed to generate SPH elements in the volumes enclosed by the defined nodes,
and ignores the remaining volumes.

• Choose Nth Largest to enter which volumes to generate SPH elements in by defining the
wrap size index in terms of volume size.

To specify the largest volume, enter 1 in the index field; to specify the second largest volume,
enter 2 in the index field.

• Choose exclude enclosed to ignore the volume(s) enclosed by the defined nodes and
generate SPH elements in the remaining volumes.

8. Optional: Model a fluid or gas that does not completely fill the selected volume.
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a) Select the partial fill checkbox.

b) Enter either a percentage or depth of the volume to fill.

Calculation of the volume is based on the lowest point of the model, parallel to the user
defined plane.

c) Use the plane and vector selector to specify the direction of fill, which is generally the
opposite of the direction of gravity when the filled volume is installed in the real world.

d) If the particle mass is filled along the correct axis, but in the wrong direction (for example
from the top of a fuel tank downward), select the reverse direction checkbox to resolve this
issue.

Figure 728: Partial Fill

Figure 729: Fill Direction

9. Optional: Create SPH particles up to a distance that you specify.

The thickness of SPH elements is created from input. The distance between the SPH particles is
driven by the pitch.

a) Select the wall offset checkbox.

b) Enter a distance to offset.
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c) To create SPH particles outside of the defines volume, select the external to volume
checkbox.

10. To create SPH particles from a specified distance, enable the wall clearance checkbox.

This option is useful when you are trying to avoid contact of SPH elements with walls at the
beginning of the solver run (1st iteration) and want the solver to run smoothly.
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Figure 730:

11. Click create.

Tip:

Generated SPH elements (particles) are elements of mass configuration. In the modeling
window, SPH elements have a spherical representation and possibly an element handle with
an additional label of the element's configuration. To improve visualization of the generated
SPH elements (particles), turn off the display of element handles by clicking  on the Display
toolbar.

Create SPH Mesh (Abaqus)
Create a SPH mesh using existing components in your model.

Restriction:  The SPH tool is only available in the Abaqus solver interfaces.

1. From the menu bar, click Tools > SPH.
The SPH Meshing Tool opens.

2. Select the component(s) to generate SPH elements for.

a) Click the components selector.

b) In the panel area, click comps.

c) Select the component(s).

d) Click select.
e) Click proceed.

The components you selected are displayed in the Component Name field.

3. Click the Meshing Method field, and select a meshing method.
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• Choose Simple cubic to arrange the SPH particles into groups of 8, with each particle being a
corner of a cube.

• Choose Face centered cubic (FCC) to arrange the SPH particles into groups of 14, forming
the corners and the center of each face of a cube.

This method is similar to a hexagonal close packed (HCP) structure.

• Choose Node to SPH to manually select a node and convert it into a SPH element.

4. In the Pitch field, enter the distance you would like placed between each SPH element in the
component.

Tip:

Smaller pitch values will result in the creation of more elements within the same
space, whereas, larger pitch values will result in the creation of less elements.

5. In the Material Density field, a density that will be used to generate the material and property.

6. To create a *solid section and *material keyword for each component that you mesh, select the
Create Property and Material checkbox.

7. To create a *surface (node based) for each component that you mesh, select the Create surface
checkbox.

HyperMesh uses this surface later for contact definition.

8. In the Selection column, select the checkbox of the component(s) you wish to mesh.

Notice:

In the Status field, notice the red status boxes. A red status box indicates that the
component has not been meshed.

9. Click Mesh.

SPH elements are generated for the selected component(s).

Notice:  In the Status field, the components that were meshed now display a green status
box. A green status box indicates that the component has been meshed. If the Status field
contains a yellow status box, this indicates that the component you meshed already contains
SPH elements.

If you would like to remove components from the SPH Meshing tool, select their corresponding

checkbox in the Selection field, and then click .
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Line Meshing
1D mesh that allows accurate testing of connectors, such as bolts, and similar rod-like or bar-like
objects that can be modeled as a simple line for FEA purposes.

1D Elements
Supported 1D elements.

Bar Elements
1D elements created in a space between two or three nodes of a model where beam properties are
desired.

The nodes are related to each other based on the properties of the bar or beam element connecting
them. Properties associated with bar elements include vector orientation, offset vectors that end at A
and B, or at A, B, and C, and pin flags to tell it what degree of freedom should carry through the beam.

Bar elements are displayed as a line between two nodes with BAR2 or BAR3 written at the centroid of
the element.

Bar2
Configuration 60 - 1D (1st order) elements with 2 nodes used to model axial, bending, and
torsion behavior. Bar2 elements have a property reference, an orientation vector, offset vectors
and ends A and B, and pin flags at ends A and B.

Bar3
Configuration 63 - 1D (2nd order) elements with 3 nodes used to model axial, bending, and
torsion behavior. Bar3 elements have a property reference, an orientation vector, offset vectors
and ends A and B, and pin flags at ends A and B.

Gap Elements
Configuration 70 - 1D elements created in a space between two nodes, or between a node and an
element, of a model where contact may occur.

Create a gap element when you want to impose a nonlinear constraint on a model; this constraint will
limit the amount of movement possible during analysis.

Gap elements have a property reference and an orientation vector.

Gap elements are displayed as a line between two nodes with GAP written at the centroid of the
element.

Gap elements can translate to CGAP or CGAPG elements in OptiStruct, CGAP element in Nastran or
*GAP option in Abaqus.

Joint Elements
Configuration 22 - 1D elements with 2, 4, or 6 nodes which have a property and orientation systems or
nodes.
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Joint element is a definition of a connection between two rigid bodies. Joint elements store a property
and orientation information.

Joint elements are displayed with lines between the appropriate nodes and the letter J between nodes 1
and 3 of the element.

Only certain types of elements can be used to create joint elements. The type of the element controls
the number of nodes used in the element and the permissible orientations of the element.

Table 194: Types of Joint Elements

Type Type Name Number of Nodes Orientation Solver Interface

1 Spherical joint 2 None

Systems

Nodes

LS-DYNA

PAM-CRASH

2 Revolute joint 4 None

Systems

LS-DYNA

3 Cylindrical joint 4 None

Systems

LS-DYNA

4 Planar joint 4 None

Systems

LS-DYNA

5 Universal joint 4 None

Systems

LS-DYNA

6 Translational joint 6 None

Systems

LS-DYNA

7 Locking joint 6 None

Systems

LS-DYNA

8 Ball joint 2 None OptiStruct

9 Fixed joint 2 None OptiStruct

10 Revolute joint 2 Node

Vector

Coordinates

OptiStruct
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Type Type Name Number of Nodes Orientation Solver Interface

11 Translational1 joint 2 Node

Vector

Coordinates

OptiStruct

12 Cylindercal 1 joint 2 Node

Vector

Coordinates

OptiStruct

13 Universal joint 2 Node

Vector

Coordinates

OptiStruct

14 Constant_velocity
joint

2 Node

Vector

Coordinates

OptiStruct

15 Planar joint 2 Node

Vector

Coordinates

OptiStruct

16 Inline joint 2 Node

Vector

Coordinates

OptiStruct

17 Perpendicular joint 2 Node

Vector

Coordinates

OptiStruct

18 Parallel axes joint 2 Node

Vector

Coordinates

OptiStruct

19 Inplane joint 2 Node

Vector

Coordinates

OptiStruct
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Type Type Name Number of Nodes Orientation Solver Interface

20 Orient joint 2 Node

Vector

Coordinates

OptiStruct

21 Point_to_curve
joint

2 Node

Vector

Coordinates

OptiStruct

22 Curve_to_curve
joint

2 Node

Vector

Coordinates

OptiStruct

23 Point_to_deformable_curve
joint

2 Node

Vector

Coordinates

OptiStruct

24 Point_to_deformable_surface
joint

2 Node

Vector

Coordinates

OptiStruct

25 Translational_2N
joint

2 None

Systems

PAM-CRASH

26 Revolute_2N joint 2 None

Systems

PAM-CRASH

27 Cylindrical_2N joint 2 None

Systems

PAM-CRASH

28 Universal_2N joint 2 None

Systems

PAM-CRASH

29 Flexion-Torsion
joint

2 None

Systems

PAM-CRASH

30 Planar_2N joint 2 None PAM-CRASH
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Type Type Name Number of Nodes Orientation Solver Interface

Systems

31 General joint 2 None

Systems

PAM-CRASH

32 Bracket joint 2 None

Systems

PAM-CRASH

33 Free joint 2 None

Systems

PAM-CRASH

Plot Elements
Configuration 2 - 1D elements with 2 nodes used for display purposes.

Plot elements are displayed as a line between two nodes.

RBE3 Elements
Configuration 56 - Rigid elements with one dependent node and variable independent nodes typically
used to define the motion at the dependent node as a weighted average of the motions at the
independent nodes.

Both the dependent node and independent nodes contain a coefficient (weighting factor) and user-
defined degrees of freedom. The dependent degrees of freedom and weighting factors can be specified
or automatically calculated based on the geometry.

RBE3 elements are displayed as lines between the dependent node and the independent node(s) with
RBE3 displayed at the dependent node of the element.

RBE3’s are typically used to distribute loads applied on the dependent node amongst the selected
independent nodes.

Note:  The dependent node cannot be directly constrained, as this would lead to a double-
dependency for that node.

Rigidlink Elements
Configuration 55 - Rigid elements with one independent node and variable dependent nodes typically
used to model rigid bodies.

Rigidlink elements have user-defined degrees of freedom which apply to all dependent nodes.

Rigidlink elements can be created with dependent nodes attached to an element as a SET. If a rigid link
with a dependent node set is deleted, the associated node set is also deleted. If the dependent node
set is deleted, the connected rigid link element is also deleted. Dependent node sets are automatically
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created when rigid link elements are created. A node set can be connected as a set of dependent nodes
to a rigid link element independent node.

Note:  Two-node rigids with a dependent node set attached are always created as rigid link
elements

Rigidlink elements are displayed as lines between the independent node and the dependent node(s)
with RL displayed at the independent node of the element.

Rigid Elements
Configuration 5 - Rigid 1D elements with 2 nodes used to model rigid connections.

Rigid elements are displayed as a line between two nodes with the letter R written at the centroid of the
element.

Rigids can translate to RBE2 in Nastran or *MPC in Abaqus.

Rod Elements
Configuration 61 - 1D elements with 2 nodes used to model axial behavior only.

The two nodes are related to each other based on the properties of the rod element connecting them.
Rod elements have property pointers.

Rod elements are displayed as a line between two nodes with ROD written at the centroid of the
element.

Rods can translate to CTUBES in Nastran or a C1D2 element in Abaqus.

Spring Elements
Configuration 21 - 1D elements used to model spring connections.

Spring elements have user-defined degrees of freedom, an orientation vector, and a property reference.

Spring elements are displayed as a line between two nodes with the letter K written at the centroid of
the element.

Spring
1D elements with 2 nodes used to model spring connections.

Spring2N
1D elements with 2 nodes used to model spring connections.

Spring3N
1D elements with 3 nodes used to model spring connections.
The third node serves as the direction node.

Spring4N
1D elements with 4 nodes used to model spring connections.
This type of element will mostly be considered as joints, based on the property it is assigned.
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Springs can translate to CELAS2 in Nastran or *SPRING in Abaqus.

Weld Elements
Configuration 3 - Rigid 1D elements with 2 nodes used to model welded connections.

Weld elements are displayed as a line between two nodes with the letter W written at the centroid of
the element.
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Surface Meshing
A surface mesh or "shell mesh" represents model parts that are relatively two-dimensional, such as
sheet metal or a hollow plastic cowl or case.

Surface meshes placed on the outer faces of solid objects are used as a baseline mapping point when
creating more complex 3D meshes (the quality of a 3D mesh largely depends on the quality of the 2D
mesh from which it is generated).

2D Elements
Supported 2D elements.

Tria Elements
2D triangular elements.

Tria3
Configuration 103 - 2D (1st order) triangular elements with 3 nodes ordered in HyperMesh.

Figure 731: Element Configuration 103, 3-Noded Tria

Tria6
Configuration 106 - 2D (2nd order) triangular elements with 6 nodes ordered in HyperMesh.
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Figure 732: Element Configuration 106, 6-Noded Tria
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Quad Elements
2D quadrilateral elements.

Types of pyramid elements include:

Quad4
Configuration 104 - 2D (1st order) quadrilateral elements with 4 nodes ordered in HyperMesh.

Figure 733: Element Configuration 104, 4-Noded Quad

Quad8
Configuration 108 - 2D (2nd order) quadrilateral elements with 8 nodes ordered in HyperMesh.
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Automatic Meshing
Automatic meshing generates a mesh of plate elements according to your specifications using surface
geometry or existing shell elements.

Mesh Modes
Mesh modes are used during automatic meshing to determine the type of meshing to perform.

Size and Bias
Uses elements of a uniform size that you specify to create mesh. When using existing finite elements
as the basis for mesh generation, feature recognition settings allow the mesher to break up the areas
defined by the selected elements into logical groupings with mesh controls set for each group boundary.

QI Optimize
An iterative automatic mesh generation method driven by element quality criteria. During the mesh
generation process, the quality index of the mesh is determined by evaluating each element against a
set of element quality tests. If all required element quality criteria are passed, then that element has a
perfect quality index of zero. As the element quality deteriorates, the quality index value increases; so a
lower quality index score indicates an element more closely meets the ideal quality requirements.

The compound quality index is the sum of the quality index values for each of the elements that are
included in the current meshing area. The quality index value itself has no direct physical meaning; it is
a way to compare one generated mesh pattern against another pattern generated for that same area.
The quality index based mesh optimization routine attempts to modify the mesh pattern and apply node
smoothing routines to obtain a lower overall quality index value.

Edge Deviation
Determines how far the mesh elements can deviate from the actual edges of the surfaces meshed,
or when in the case of re-meshing elements, deviation from inferred edges based on features. Edge
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deviation normally occurs on curved edges, because individual elements have straight edges and
therefore can only approximate a curve.

Figure 735: When meshing curved surfaces, the planar elements (tan color) can deviate from the curved grey geometry.
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Edge deviation applies to both surface geometry and when re-meshing elements. Automeshing with 
edge deviation automatically selects the best element size to approximate a curve, within the limits that 
you specify. The maximum deviation and maximum feature angle parameters are the primary controls 
for this effect.

This method can produce a mesh in which the element size varies, even within the same surface. Areas 
of high curvature will tend to have smaller elements than areas of low or no curvature. The element size 
boundaries controls this effect.

Figure 736:
Edge deviation control when meshing creates smaller elements and spaces nodes closer together to limit how much the elements

can deviate from the surface edges.

Surface Deviation
Creates mesh within the limits of element deviation from a surface.
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Similarly to edge deviation, meshing is driven by distances between flat elements and model geometry.
When flat elements are used to approximate a curved surface, there is always a discrepancy between
each element and the actual curve of the surface, because the element uses a straight line between two
nodes.

Figure 737:
A gap is visible between the curved edge of the surface and the element edges.
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Surface deviation meshing chooses the mesh density based on the severity of this deviation. Where the 
threshold deviation would be exceeded, smaller elements are used to reduce the deviation.

Figure 738:
With surface deviation meshing, smaller elements are used to accurately represent curved surfaces. Larger elements are used

where the geometry shows less curvature.

Use refinement to set a specific desired mesh size for a point, line or surface face.

Rigid Body Mesh
Creates mesh to represent the topology of a rigid object.

Rigid bodies are surfaces that are expected to be treated as undeformable in the solution. One example
of a rigid body is in metal-forming. When modeling the results of a die pressing down on a metal sheet,
it is important to model the shape of the die because that determines the shape of the metal sheet after
being pressed. However, during a forming analysis the stresses and deformations of the die itself are
not of interest, only those of the formed metal sheet. Other applications for rigid bodies include the
impactors used in vehicle crash simulation.

A mesh that accurately represents the rigid geometry is important for such simulations to allow the
solver collision detection routines to work effectively and accurately. Since stress and deformation of
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the rigid body are not calculated by the solver, the rigid body mesh focuses on accurately modeling the
shape of the body rather than on producing a high-quality mesh. To this end, Rigid Body meshing uses
the same faceting and shading routines that are used for drawing the model graphics. The resulting
mesh may have high aspect ratio or extremely tapered elements that would not be suitable for solution,
but can accurately represent the geometry.

The images below illustrate the differences between surface deviation meshing and rigid body meshing.
Both meshes were generated using the same parameters in terms of min/max element size, maximum
deviation and feature angle, and mesh type.
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Figure 739:
When creating a surface deviation based mesh on this cone, many small elements are required to capture the geometry, even so,

the elements exhibit a lot of warpage and those at the tip are distorted and do not accurately represent the geometry.

Figure 740:
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With the rigid body mesh, the shape of the object can be accurately modeled using fewer larger elements since the element shape 

is not a concern.
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Mesh Generation Algorithms
The mesh generation algorithms are divided into two types: those that require the presence of a surface 
to provide a context of operation, or those working entirely from node and/or line data.

Autodecide
If you are meshing a surface, the default mesh generation algorithm is Autodecide. In this case, the 
geometry of each face and the element densities specified for each edge is analyzed, and the algorithm 
that will give the best results is selected. For most configurations, the Free algorithm is chosen.

Free
The Free meshing algorithm is a general-purpose formula that works for most meshing conditions. The 
surface can have interior holes or edges and any number of sides. If quads or trias is the selected 
element type, an advancing front algorithm is used. If mixed is the element type, a sub-mapping 
algorithm is used.

The advancing front algorithm uses the following process:

• Traverses the perimeter of the region, placing elements along the edges as it proceeds. Each site
where an element could be placed is measured and one of several possible elements is chosen.
Eventually the entire region is filled with elements.

• Examines the groups of elements to see if a local change in the connectivity might improve element
quality.

• Applies repeatedly the selected smoothing algorithm until no node is moved farther than the
specified smoothing tolerance.

If quads is the selected element type for the current face, HyperMesh attempts to produce an all-quads
mesh, but there are some situations in which one or more trias are included:

• If the total number of elements specified for the perimeter of the face is odd, at least one tria
always needed.

• If there is a tight corner on the boundary that would require a poor quality quad, a single tria is
used.

• Sometimes two or more trias are needed because of the particular order in which the elements
were generated; if that is the case, you can usually eliminate them by changing some of the
meshing parameters and then remeshing the region.
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Figure 741:

If quads only is the selected element type, a mesh is created consisting entirely of quads; no trias will
be used.

Note:  This method is more likely to fail to mesh than the quads option, and may produce
some poor elements.

Figure 742:

If trias is the selected element type, a streamlined version of this algorithm that is optimized for the
different shape and connectivity requirements of tria elements is used. These two examples show the
difference between conventional and right-trias.
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Figure 743:

Figure 744:

Map as Triangle, Rectangle, Pentagon, or Circle
If the region is free from internal holes and the boundary is clearly triangular, rectangular, or pentagonal
in shape, the best choice of algorithm is usually to map a standard mesh onto the region using
transfinite interpolation. Such an operation is exceedingly fast, and where applicable, gives quality
results rapidly. A standard template based on the element densities around the perimeter of the region
is chosen. Ignoring rotations, more than 18 different configurations requiring distinct templates are
recognized. To make tria elements, first a quads mesh is created and then each element is divided
along its shortest diagonal.

In general this decision can be left to autodecide, but there may be some cases in which a manual
decision is necessary to produce the best results.
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Note:  If no mesh can be generated using the specified mapping method, one will be
generated using autodecide as a fall-back measure.

On the Automesh secondary panel, a white icon denotes the mapping algorithm used for each meshed
surface.

Figure 745: Map as Triangle, Mixed Mesh Type

Figure 746: Map as Rectangle, Mixed Mesh Type
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Figure 747: Map as Pentagon, Mixed Mesh Type

Figure 748: Map as Circle, Mixed Mesh Type

Map without Surface
If you are creating a mesh entirely from line and/or node data, with no surface, the mesh generation
algorithm is decided by the tool that was used to describe the desired operation. If you use the Drag
panel, the algorithm is to drag. If you use the Spin panel, the algorithm is to spin, and if you use the
Spheres panel, the algorithm is to map a sphere-covering mesh. You can still use the density and
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biasing manipulation tools but some edges will be linked together, so that the configuration always
satisfies the balancing requirements of the intended mapping.

Mesh Types
The mesh type determines the type of elements used to create mesh during automatic meshing.

Advanced
Enables you to select a Mapped Type for elements on surfaces that can be mapped to simple
geometric shapes and a Free Type for elements that cannot easily be mapped to simple shapes to use
when creating mesh.

Mixed
Uses quad elements to create mesh, but inserts tria elements when making density transitions to
improve mesh quality.

Figure 749: Mixed

Quads
Uses quad elements to create mesh, however if the sum of the element densities around the perimeter
of the face or surface is odd then at least one tria element must be created. Adjusting the element
densities while meshing interactively can usually eliminate all tria elements.

Figure 750:
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The sum of element densities on the perimeter of the lower surface is odd, resulting in a tria as indicated.

Figure 751:
Adjusting the bottom edge density from 11 to 10 makes the sum even and generates all-quads.

Quads Only
Uses a subdividing routine that tends to generate more orthogonal quad elements to create mesh. Tria
elements may still used depending on the density settings as with the quads type.

Figure 752: Quads Only

R-Trias
Uses right-angle triangular elements to create mesh.
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Figure 753: R-Trias

Trias
Uses all tria elements to create mesh.

Figure 754: Trias

Element Biasing
The automeshing process enables you to bias the placement of nodes so that their intervals are not
uniform in size.

You can designate that the smaller intervals go near the start of the edge, near the end of the edge,
near both ends with larger intervals in the middle, or near the middle of the edge.

Within the automesher, you may want to use biasing to improve element quality when transitioning
from smaller to larger element sizes. When you use the Drag and Solid Offset panels, you can use
biasing to cluster several layers of elements near the surface of a solid. In Linear Solids, the mesh
at one end could be scaled several times larger than at the other end. Element biasing allows you to
moderate the changes in aspect ratio from the start to the end.

Linear Biasing
In linear biasing, the biasing intensity corresponds to the positive slope of a straight line over the
interval [0,1] of the Real Line. This interval is uniformly divided into as many subintervals as specified
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by the element density and they are mapped along the edge so that the length of the image interval
is proportional to the height of the line over the midpoint of the source interval. Each image interval
corresponds to the side of an element.

Specifically, let n be the element density and let .

We want a node placement function x(s) taking values in [0,1] with x(0) = 0 and x(1) = 1. If m is the
slope of the line, and b is its y-intercept, then:

.

Using x(0) = 0, and x(1) = 1, we find:  so,

.

For this, m is the absolute value of the biasing intensity. If the biasing intensity is negative, the nodes
are placed according to 1 - x(s). Thus, a positive biasing intensity puts small elements at the start of
the interval.

We can use b to scale the behavior of the function so that convenient values are in the range [0,20].
The value used is b = 1.5.

Exponential Biasing
In exponential biasing, the sizes of the intervals grow geometrically, progressing along the edge, with
each successive interval being a constant factor larger than the previous. That factor is 1.0 plus 1/10
of the absolute value of the biasing intensity. This formula was chosen so that an intensity of zero will
still represent no biasing, and convenient values will fall in the range [0,20]. Negative biasing intensities
just reverse the edge, placing the smaller elements at the end instead of the beginning.

Specifically, let n be the element density and let .

We want a node placement function x(s) taking values in [0,1] with x(0) = 0 and x(1) =1.

Let  be the geometric growth factor.

We need a function  so that: 

Let  then:

 which gives the proper interval lengths,

then x(s) scales them to the range of [0,1]. Thus, .

Bellcurve Biasing
In bellcurve biasing, nodes are distributed long the edge in a pattern that is symmetric across the
midpoint of the edge. If the biasing intensity is positive, the smaller intervals are placed at the
beginning and end of the edge, and if it is negative, they are placed at the middle of the edge.

Specifically, let n be the element density and  .
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We need  so that 

takes values in [0,1] with x(0) = 0, x(1) = 1, and has the behavior noted above. If we use:

 for positive biasing intensity r, then x(s) becomes:

 where erf() is the statistical error function,

.

Linked vs. Locked Edges
Most of the surface-less mesh generation algorithms require that some edges have exactly the same
element density and biasing values as other edges. Those edges are automatically linked together so
that they stay balanced.

Any change to one of the edges is immediately applied to all others that are linked to it.

Some of the surface creation panels allow you to use a node list to define one or more sides of a
surface. In these circumstances, those nodes are used directly to make elements within the Automesh
Secondary panel. The resulting edge is locked and you cannot change the element density or biasing.
If you try to adjust the element density numbers corresponding to these locked edges, it has no effect.
The error message, "The value of this number cannot be changed" is displayed.

Figure 755:
Use the Automesh secondary panel to prepare input for solid offset.

Smoothing Algorithms
Supported smoothing algorithms.

Autodecide
By default, the perimeter of the region is traversed looking for variations in element edge length
and choose between size-correcting and shape-correcting smoothing algorithms.
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Size Corrected
Evens out the sizes of the elements at the cost of some element quality, usually in the form of
worsened aspect ratios from the stretching of elements. A modified Laplacian over-relaxation
that can correctly handle mixtures of quads and trias is used. If the element spacing around the
perimeter is roughly uniform, this choice usually gives the best results.

Shape Corrected
Corrects the elements’ shapes, allowing variation in element size. HyperMesh uses a modified
isoparametric-centroidal over-relaxation that can correctly handle mixtures of quads and trias. If
there is a transition from small elements to large elements in the region, this choice usually gives
the best results.

Create Midsurface Mesh
Create a midsurface mesh with a thickness from 3D geometry.

Restriction:  Only available in the OptiStruct, Radioss, Abaqus, LS-DYNA, ANSYS, and
Nastran solver interfaces.

1. From the menu bar, click Mesh > Create > MidSurf Mesh.
The Midsurface Mesh tool opens.

2. Select a solid geometry to create the mid-mesh for.

a) Under Input selection, click Geometry.

Figure 756:

b) In the panel area, use the selector to select solid geometry.

c) Click proceed.

3. Select Pre-Midsurface Cleanup to define pre-midsurface cleanup options.

• To equivalence edges on the input surface, select the Edges equivalencing checkbox. Edges
can be equivalenced using an automatic or manual tolerance.

• To fix gaps between stitched edges and vertices to make the actual geometry of the surfaces
consistent with the model topology, select the Match topology checkbox. Topology can be
matched using an automatic or manual tolerance.

• To remove logos that appear on geometry, select the Delete logo checkbox. This is based on
settings from the parameter file.
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Figure 757:

4. Setup midsurface extraction.

This step is mandatory unless midsurfaces have previously been generated manually.

a) If midsurfaces were previously generated and organized into the Middle Surface component,
select Skip if Midsurface component exist to skip the midsurface extraction step and
preserve the current mesh.

For example, if you manually extracted the Middle Surface and manually meshed some
of its part (disconnected from others), then select Skip if Midsurface component exist to
preserve the current Midsurface mesh and only mesh the unmeshed surfaces. If you clear
this checkbox, the entire Middle Surface will be remeshed, and you will lose your current
mesh.

b) To preserve the mesh of the disconnected parts in the Middle Surface component that contain
a mesh and only mesh the disconnected parts in the Middle Surface component that are not
meshed, select the Keep existing mesh checkbox.

If you clear this checkbox, all of the disconnected parts in the Middle Surface component will
be remeshed. This option is enabled when you select Skip if Midsurface component exist.

a) To define advanced auto-midsurfacing options, click Options.

b) For Methods, select a method for extracting the midsurface.

• Choose offset + planes + sweeps to use a midsurfacing algorithm to identify the
places where a piece of plane or a piece of a sweep surface can be used as a middle
surface. A middle surface is constructed at the remaining places in the model, for
example the places where planar or sweep surface pieces cannot be used as a middle
surface, by the same algorithm as in offset via the offset of the model's sides.

• Choose offset + planes to use a midsurfacing algorithm to identify the places in the
model where a piece of plane can be used as a middle surface. At the remaining places
in the model, for example the places where planar pieces cannot be used as a middle
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surface, the same algorithm as in offset is used to construct the middle surface via the
offset of the model's sides.

• Choose offset to create pieces of the middle surface by offsetting the model's side
surfaces towards the middle. This is the traditional approach for midsurfacing in
HyperMesh.

• Choose skin offset to generate a midsurface by duplicating and offsetting the inner skin
surfaces (those with the smallest area) and assigning them a constant thickness. The
parts you provide to the algorithm must be relevant. T-connections, constant thickness,
or internal ribs/features/creases are not relevant.

5. Define geometry cleanup and meshing criteria.

a) Select the type of geometry cleanup and meshing to perform, and define the parameters and
criteria accordingly.

• Choose Auto to automatically cleans up geometry, and enables you to define an element
size and a mesh type.

• Choose Custom to define topology cleanup parameters and element quality criteria. The
parameters and criteria options are the same as in the Autocleanup panel, and is based
on settings from the parameter file.

b) To sort the midsurface to the original component or to <original name~> component, select
Sort Midsurfmesh component to.

6. Optional: Assign a thickness to the midsurface mesh.

a) Select Thickness assignment.

Figure 758:

b) Click Thickness Parameters.

c) In the Map Mid-Mesh Thickness dialog, calculate the thickness of a mid-mesh from the
solid geometry.

7. To pause the generation of the midsurface mesh at any step, select Step before next to the
desired step to stop.

By default, once you click Start, all of the above steps are executed.

Figure 759:

8. Click Start.

While the process is running the Proceed buttons change colors, indicating the progress of the
process.
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Blue
Complete step

Yellow
Currently running step

Green
Next step to be performed (when the Stop before checkbox is selected)

The midsurface mesh is generated.

Generate Midmesh
Automatically generate a mesh at the midplane location, directly from the input geometry (components,
elements, solids or surfaces), without first creating a midsurface.

The midmesh functionality in HyperMesh saves significant time over the traditional midsurface-based
approach.

Figure 760: Midmesh Result Example

Direct midmesh is supported for a large majority of parts including cast, machined, injection molded
and extruded as shown in Figure 761.
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Figure 761: Direct Midmesh Supported Parts

The resulting output consists of 2D shell elements created with the user-provided target size, as well
as 1D elements defining the topology of the mesh (vertices/edges/faces). Midmesh generation is also
multithreaded to take advantage of multi-core environments.

Midmesh Generation Workflow
There are several steps involved in generating a good quality midmesh. Following the workflow shown
in Figure 762 helps guarantee the best result with minimal manual effort.

Nominal Run
Extract the base midmesh.

Cleanup Resulting Topology
Use the semi-automated midmesh edit edge and edit face tools to correct the 1D topology and fix
any bad/missing faces. The goal is to prepare the model for final remeshing.

Rebuild Mesh
Remesh to the final size and quality using the rebuild mesh functionality, and correct any
remaining mesh quality issues.

Apply Thickness
Map the thickness from the original solid to the midmesh via the Map Thickness tool.
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Figure 762: Midmesh Workflow

Create Midmesh
Midmesh generation is possible on dirty geometry, but a cleaner output can be obtained by removing
duplicate or overlappinng surfaces, stitching free edges, removing logos and other small features that
are not of interest, and merging any solids that should be topologically connected.

It is recommended to use a smaller extraction size (for example, 2 or 4mm depending on model
scale) in order to get a good sampling of the input geometry. The final rebuild mesh step takes care
of remeshing to the desired size and quality. Using an extraction size smaller than the representative
feature size will not necessarily give better results and will take significantly more run time.

1. From the 2D page, click the Midmesh panel.

2. Select the create subpanel.

3. Define options accordingly to control the resulting midmesh output.

Option Action

ignore flat edges Do not imprint flat edges from the input geometry to the midmesh.
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Option Action

Figure 763: Option Disabled Figure 764: Option Enabled

flatten connections Align/flatten the midmesh at ribs/connections.

Figure 765: Option Disabled Figure 766: Option Enabled

suppress proximity
edges factor

Remove 1D topology edges within the given factor of the minimum size
from the criteria file.

Figure 767: Option Disabled Figure 768: Option Enabled

Proprietary Information of Altair Engineering

combine non-
manifold edges 
factor

Join non-manifold edges within the given factor of the minimum size 
from the criteria file.

Figure 769: Option Disabled Figure 770: Option Enabled
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Option Action

defeature openings
with width <

Remove small holes and openings less than the specified width.

Figure 771: Option Disabled Figure 772: Option Enabled

4. Optional: Edit the min size and target element size settings in the criteria file to control the
resulting midmesh output by clicking edit criteria.

Option Action

Target element size Target element size for the finalized mesh. This can be different from

Min size

extraction size. It is used for internal calculations for the output mesh to 
be ready for rebuilding with the same criteria.

Minimum size allowed in the finalized mesh. This in combination with the 
‘suppress proximity edges factor’ and 'combine non-manifold edges 
factor’ can ensure that the output mesh is ready for rebuild with the 
same criteria.
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Edit Midmesh
Once the midmesh is generated, there may be problem areas that need to be corrected. The 1D
topology is important for the rebuild mesh operation, and care must be taken to prepare it accordingly.
In addition, making sure the faces do not have intersected, overlapped, or missing elements, and that
they have proper alignment, is also essential. Specialized midmesh edit tools streamline the process of
repairing the 1D topology edges, and correcting issues with the midmesh faces.

• Select the edit edge subpanel access tools which can be used to repair 1D topology edges.

Option Action

create mid-edge Create a new mid-edge, using the input geometry as a guide.

Figure 773: Before Figure 774: After

split by two nodes Create a new edge between two nodes.
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split by node-edge Create a new edge between a node and an edge, using a shortest,
tangential or mixed path.

Figure 777: Before

Figure 778: After

delete edge Delete an edge.
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Figure 779: Before Figure 780: After

t-edge align Align/flatten a t-connection edge to a surface.

Figure 781: Before Figure 782: After
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by geom edge align Align mesh edges to input geometry lines, and smooth the mesh, or
imprint new geometry edges onto the midmesh.

Figure 783: Before Align Figure 784: After Align
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• Select the edit face subpanel to access tools which can be used to correct issues with midmesh
faces.

Option

fill face

Action

Create a mesh within a closed 1D topology loop, attempting to keep
tangency.

Figure 785: Before Figure 786: After

repair face Attempt to fix topological problems (holes/gaps/cracks, intersections,
slivers, overlaps) in the mesh and remesh the face.

Figure 787: Before Figure 788: After
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detect intersections/
gaps

Detect intersecting element clusters and holes/gaps/cracks, and create
element sets for further handling.

Figure 789: Before

Figure 790: After

align face Align a selection of elements to an input geometry face, with optional
offset.

Figure 791: Before Figure 792: After
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Batchmesher Midmesh Generation Rules
Midmesh generation is also supported from within Batchmesher.

This functionality allows for generating midmesh representations via the standalone Batchmesher, via 
the Part Browser, and interactively via the Automesh panel and Mesh Controls Browser.
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Assign Thickness to Midsurface
Assign a thickness to shell elements that represent the middle surface of a solid part.

Geometric surfaces that represent the mid-plane of a part have thickness information stored in their 
definition if they are extracted using the midsurface function. Thickness data can be a single value for 
the entire part or a varying function.

The Midsurface Thickness Map script maps thickness data from surfaces to the associated nodes/
elements via properties. You can also review the contour plot of thickness data with this script.

1. From the menu bar, click Mesh > Assign > Midsurface Thickness.
The Midsurface Thickness Map browser opens.

2. For Assign thickness to, select which entities to assign thicknesses.
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• Choose Nodes, properties on elements to assigns\ the thickness values directly to the 
node cards, with a single property assigned to the selected elements. The nodes are found 
from all of the selected 2D elements.

• Choose Nodes, properties on components to assign the thickness values directly to the 
node cards, with a single property assigned to the selected components. The nodes are found 
from all of the 2D elements in the selected components.

• Choose Elements to assign the thickness and Z-offset values (where supported) directly to 
the element cards. For each solver interface, the values will be updated on the element card 
for that solver.

• Choose Properties or elements to group elements that fall within user-specified thickness 
intervals into common ranges, then create and assign to each of those elements in each range 
a property with the range thickness value assigned to the property card image. Most solvers 
only have Z-offset defined on the element card, so this value will always be populated on the 
element cards for any solver that supports Z-offset. In order to execute this mode,
a base property named t0 must be defined. The t0 property definition will be used for all 
created properties based on the option specified in the Organization Method section. This 
option performs the following generic steps:

1. Create properties with name "t[thickness value]" by copying the properties of the
base property t0 and assigning the appropriate thickness based on the value of the 
Organization Method.

2. Assign to the elements that have thickness values within the specified ranges, based on 
the value of the Organization Method, the relevant property.

• Choose Properties/Sections on components to group elements that fall within user-
specified thickness intervals into common components, then create and assign to each of 
those components a property/section with the thickness value assigned to the property/
section card image. Most solvers only have Z-offset defined on the element card, so this value 
will always be populated on the element cards for any solver that supports z-offset. In order 
to execute this mode, a base property/section must be assigned to a component named t0. 
The t0 component property/section will be used as the baseline for all newly created 
properties/sections based on the option specified in the Organization Method section. This 
option performs the following generic steps:
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1. Create components and properties with name "t[thickness value]" by copying the 
properties of the base property t0 and assigning the appropriate thickness based on the 
value of the Organization Method.

2. Assign a property/section to its corresponding component.

3. Remove any property assignments to the elements.

4. Organize the elements that have thickness values within the specified ranges into the 
new components based on the value of the Organization Method.

• Choose Organize only to create new components and sort the selected elements into them 
according to the Organization Method selected.

3. To take z-offsets into account and assign z-offset values to the element cards for supported
solvers, select the Use Z-offset values checkbox.
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HyperMesh uses z-offsets when midsurfacing parts that have variable thickness; the z-offset,
which is saved as part of the midsurface data, tells a solver how much of a positive-normal offset
exists between the actual part surface and the midsurface.

Figure 794:

4. For Thickness calculation method, select a method.

• Choose Nodal values to calculate multiple thickness values for each element by finding the 
thickness at each of the element nodes. It is possible for a node to have multiple thickness 
values at a single location (shared surface edge where the surfaces have different thickness). 
The thickness calculated using that node for an element is dependent on which surface that 
element is associated to.

• Choose Average to calculate a single thickness value for each element by averaging the 
thickness at each of the element nodes.

• Choose Centroid to calculate a single thickness value for each element by calculating the 
thickness at the centroid of the element.

• Choose Max to calculate a single thickness value for each element by calculating the 
thickness at each node of the element and taking the max value.

• Choose Min to calculate a single thickness value is for each element by calculating the 
thickness at each node of the element and taking the min value.

5. For Organization method, select an organization method to specify the thickness range intervals 
used to generate properties based on their thickness values.
Based on the Assign thickness to option, the properties and components are generated for certain 
thickness ranges. Any element with a thickness value within that range is assigned that property 
or organized into that component.
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4. For Organization method, select an organization method to specify the thickness range intervals 
used to generate properties based on their thickness values.
Based on the Assign thickness to option, the properties and components are generated for certain 
thickness ranges. Any element with a thickness value within that range is assigned that property 
or organized into that component.

• Choose Gauge file to specify the thickness range intervals in a Gauge File.

• Choose Range Interval to specify a thickness tolerance.
Thickness range intervals are automatically generated based on the thickness tolerance using 
the following formula. The thickness assigned to each created component is n*tolerance.

• Lower limit = (tolerance / 2) + (tolerance* i )

• Upper limit = (tolerance / 2) + (tolerance* (i + 1))

• Assigned value = tolerance*(i+1)

• Where i = 0……n, n is determined by the maximum thickness in model divided by the

user specified tolerance and then rounding to up to the next integer.

6. Click Apply.

The thickness is assigned from the surface definition to the selected elements, based on the options
specified.
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Create a contour plot of the thicknesses on the selected elements/nodes based on the options specified 
by clicking Contour. This option does not assign the thickness to the nodes or elements; it is a review/
display function only. It is very useful for visualizing and verifying the results of the utility before 
applying the Midsurface Thickness Map mapping operation.

If you choose Properties on elements, Properties on components, or Organize only under the Assign 
thickness to option, HyperMesh honors the Organization method settings during the contour process 
and the contour value is assigned based on that organization. This allows the contour to match with the 
applied results.

If you choose Elements or Properties on components for the Assign thickness to option, and choose
to use Nodal values for the Thickness calculation method, the values may not exactly match the nodal 
values that are actually applied. There can be multiple thicknesses associated to a node if it shares
an edge with multiple surfaces. Since HyperMesh can only provide one value for the contour, it always 
chooses the first value which might not match exactly with all of the applied values in these situations.
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Example: Gauge File Format
Formatting for a gauge file.

Number of Gauges
[Number of Gauge Data Lines]
Gauges
Begin End Assigned Value
[min Thk] [max Thk] [Assigned Thk]
…

Figure 795: Gauge File Format

If the Assigned Value is not specified, then the average of the upper and lower limits will be used as
Assigned Value.

Number of Gauges
4

Gauges
Begin End Assigned Value
0.0 0.05 0.05
0.05 0.1 0.1
0.1 0.15 0.15
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0.15 0.2 0.2

Figure 796: Gauge File Example
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Midsurface Thickness Assignment Behavior
Common and solver interface specific behavior for assigning thicknesses to the 
midsurface.

General
Organize only

• Creates new components based on the Organization method.

• Organizes elements into these components.

Contour

• Creates a contour of the thickness values of nodes and elements, based on the specified
options.

• If you chose Properties on elements, Properties/Sections on components, or Organize only
under the Assign thickness to option, HyperMesh honors the Organization method settings
during the contour process and the contour value is assigned based on that organization. This
allows the contour to match with the applied results.

• If you chose Elements or Properties/Sections on components for the Assign thickness to
option, and choose to use Nodal values for the Thickness calculation method, the values
may not exactly match the nodal values that are actually applied. There can be multiple
thicknesses associated to a node if it shares an edge with multiple surfaces. Since HyperMesh
can only provide one value for the contour, it always chooses the first value which might not
match exactly with the applied values in these situations.

Abaqus
Nodes, properties on elements

• Creates a single property named tNodalThickness.

• Creates a single node set named tNodalThickness with Nodal_Thickness card image.

• Assigns the property to the selected 2D elements.

• Adds the relevant nodes to the node set.

• Assigns a single thickness to each node using attribute ThicknessValue.

Nodes, properties on components

• Creates a single property named tNodalThickness.

• Creates a single node set named tNodalThickness with Nodal_Thickness card image.

• Assigns the property to the selected components.

• Adds the relevant nodes to the node set.

• Assigns a single thickness to each node using attribute ThicknessValue.
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• Clears any element property references for any 2D elements in the selected components.

ANSYS
Properties/Sections on components – nodal values

• Creates new components based on ordered nodal thickness values.

• Creates new properties and sections based on ordered nodal thickness values. Properties are
created for those shell elements where thickness is assigned from properties. Shell sections
are created for those shell elements where thickness is assigned from shell sections.

• Assigns the properties or shell sections to the corresponding components.

• Assigns multiple thicknesses to each property, using real values. In case of shell sections,
only one thickness will be assigned.

• Organizes elements into the corresponding components.

Properties/Sections on components – all others

• Creates new components based on the Organization method.

• Creates new properties or shell sections based on the Organization method. Properties are
created for those shell elements where thickness is assigned from properties. Shell sections
are created for those shell elements where thickness is assigned from shell sections.

• Assigns the properties or shell sections to the corresponding components.

• Assigns a single thickness to each property or shell section based on the Thickness calculation
method, using real values.

• Organizes elements into the corresponding components.

LS-DYNA
Elements

• Assigns multiple thicknesses to each element, based on the nodal thickness values for that
element.

◦ For tria3 elements, uses attributes: Elem_Option, LSD_ELEM_T1, LSD_ELEM_T2,
LSD_ELEM_T3

◦ For quad4 elements, uses attributes: Elem_Option, LSD_ELEM_T1, LSD_ELEM_T2,
LSD_ELEM_T3, LSD_ELEM_T4

Properties/Sections on components

• Creates new components based on the Organization method.

• Creates new properties/sections based on the Organization method.

• Assigns the properties/sections to the corresponding components.

• Assigns a single thickness to each properties/sections based on the Thickness calculation
method, using property attribute LSD_T1.

• Organizes elements into the corresponding components.

Marc
Properties on elements

• Creates new properties based on the Organization method.
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• Assigns a single thickness to each property based on the Thickness calculation method, using
component attribute TK.

• Assigns the properties to the corresponding elements.

Moldflow
Properties on components

• Creates new components based on the Organization method.

• Assigns a single thickness to each property based on the Thickness calculation method, using
component attribute T.

• Organizes elements into the corresponding components.

Nastran
Elements

• Assigns multiple thicknesses to each element, based on the nodal thickness values for that
element.

◦ For tria elements, uses attributes: CTRIA3_T1T2T3, CTRIA3_T1, CTRIA3_T2, CTRIA3_T3,
CTRIA3_ZOFFS [if requested], ZOFFS [if requested]

◦ For quad elements, uses attributes: CQUAD4_T1T2T3T4, CQUAD4_T1, CQUAD4_T2,
CQUAD4_T3, CQUAD4_T4, CQUAD4_ZOFFS [if requested], ZOFFS [if requested]

• Turns off the TFLAG option when necessary.

Properties/Sections on components

• Creates new components based on the Organization method.

• Creates new properties/sections based on the Organization method.

• Assigns the properties/sections to the corresponding components.

• Assigns a single thickness to each properties/sections based on the Thickness calculation
method, using property attribute PSHELL_T.

◦ For tria elements, uses z-offset attributes [if requested]: CTRIA3_ZOFFS, ZOFFS

◦ For quad elements, uses z-offset attributes [if requested]: CQUAD4_ZOFFS, ZOFFS

• Organizes elements into the corresponding components.

• Clears any element property references for the selected elements.

Properties on elements

• Creates new properties based on the Organization method.

• Assigns a single thickness to each property based on the Thickness calculation method, using
property attribute PSHELL_T.

◦ For tria3 elements, uses z-offset attributes [if requested]: CTRIA3_ZOFFS, ZOFFS

◦ For quad elements, uses z-offset attributes [if requested]: CQUAD4_ZOFFS, ZOFFS
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• Assigns the properties to the corresponding elements.

OptiStruct
Elements

• Assigns multiple thicknesses to each element, based on the nodal thickness values for that
element.

◦ For tria elements, uses attributes: CTRIA3_T1T2T3, CTRIA3_T1, CTRIA3_T2, CTRIA3_T3,
CTRIA3_ZOFFS [if requested], ZOFFS [if requested]

◦ For quad elements, uses attributes: CQUAD4_T1T2T3T4, CQUAD4_T1, CQUAD4_T2,
CQUAD4_T3, CQUAD4_T4, CQUAD4_ZOFFS [if requested], ZOFFS [if requested]

Properties/Sections on components

• Creates new components based on the Organization method.

• Creates new properties/sections based on the Organization method.

• Assigns the properties/sections to the corresponding components.

• Assigns a single thickness to each properties/sections based on the Thickness calculation
method, using property attribute PSHELL_T.

◦ For tria elements, uses z-offset attributes [if requested]: CTRIA3_ZOFFS, ZOFFS

◦ For quad elements, uses z-offset attributes [if requested]: CQUAD4_ZOFFS, ZOFFS

• Organizes elements into the corresponding components.

• Clears any element property references for the selected elements.

Properties on elements

• Creates new properties based on the Organization method.

• Assigns a single thickness to each property based on the Thickness calculation method, using
property attribute PSHELL_T.

◦ For tria elements, uses z-offset attributes [if requested]: CTRIA3_ZOFFS, ZOFFS

◦ For quad elements, uses z-offset attributes [if requested]: CQUAD4_ZOFFS, ZOFFS

• Assigns the properties to the corresponding elements.

PAM-CRASH 2G
Elements

• Assigns a single thickness at the element level based on the Thickness calculation method.

◦ Uses element attribute ELEM_THK

Thickness on components

• Creates new components based on the Organization method.

• Assigns a single thickness to each component based on the Thickness calculation method,
using component attribute MAT_THK.
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• Organizes elements into the corresponding components.

Permas
Properties/Sections on components – Nodal values

• Creates new components based on ordered nodal thickness values.

• Creates new properties/sections based on ordered nodal thickness values.

• Assigns the properties/sections to the corresponding components.

• Assigns multiple thicknesses to each properties/sections, using property attributes:
ThicknessSelEnumField, Thick_value_shell1, Thick_value_shell2, Thick_value_shell3,
Thick_value_shell4

• Organizes elements into the corresponding components.

Properties/Sections on components – all others

• Creates new components based on the Organization method.

• Creates new properties/sections based on the Organization method.

• Assigns the properties/sections to the corresponding components.

• Assigns a single thickness to each properties/sections based on the Thickness calculation
method, using property attributes: ThicknessSelEnumField, Thick_value_shell1

• Organizes elements into the corresponding components.

Radioss
Elements

• Assigns a single thickness at the element level based on the Thickness calculation method.

◦ Uses element attribute THICK.

Properties/Sections on components

• Creates new components based on the Organization method.

• Creates new properties/sections based on the Organization method.

• Assigns the properties/sections to the corresponding components.

• Assigns a single thickness to each properties/sections based on the Thickness calculation
method, using property attribute THICK.

• Organizes elements into the corresponding components.

Shrink Wrap Meshing
Shrink wrap meshing is a method to create a simplified mesh of a complex model when high-precision
models are not necessary, as is the case for powertrain components during crash analysis.

The model's size, mass, and general shape remains, but the surface features and details are simplified,
which can result in faster analysis computation. You can determine the level of detail retained by
determining the mesh size to use, among other options.
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Figure 797:

You can shrink wrap elements, components, surfaces, solids, node clouds, or point clouds.

• Shrink wrap allows for wrapping of multiple components if they are selected.

• Selection provides the option to wrap all nodes, elements, components, surfaces, points, or solids,
or only a certain portion of the model if desired. The input to the shrink wrap, that is, the model
parts that you wish to wrap, can consist of 2D or 3D elements along with surfaces or solids.

One use case for shrink wrapping is when you need to convert an .stl representation of a model into a
tria/quad mesh; using shrink wrap provides a quick and efficient way of achieving this. Similarly, crash
analysis does not require a highly-detailed powertrain model; in such cases you can use the shrink wrap
mesh to quickly generate a simplified approximation of a detailed powertrain model. Crash analysts can
then use that coarser shrink wrap representation within the crash simulation model.

Other reasons to use the shrink wrap include being able to stitch over very bad geometry to generate
an enclosed volume mesh for tetra-meshing. The shrink wrap tool can work from elements, whether 2D
or 3D, or geometry. Thus, in the case of an "unclean" geometry model with many released (free) edges,
you can either generate any arbitrary mesh on the unclean geometry using the automesh functionality
beforehand and then creating shrink wrap or you can simply select the surface or solid without meshing
the geometry first; either of these steps will yield good output mesh. The key in such cases is to ensure
that the element size used for the shrink wrap is large enough to stitch over the unclean surface edge
splits so that an enclosed volume can be created.

Shrink wrap mesh can be generated as a surface mesh, using a loose or tight wrapping, or as a full-
volume hex mesh by use of the Shrink Wrap panel. The distinction between surface or volume mesh is
an option labeled generate solid mesh.
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Loose Shrink Wrap Mesh
Loose wrap wraps the selected elements or components, surfaces, or solids with the target element size
specified, and outputs an outer-volume mesh which approximately adheres to the original FE topology.

A smaller element size generates a shrink wrap mesh that more closely approximates the original
FE representation and adheres to more features; a larger element size produces a more basic mesh
which ignores more features. The loose wrap does not project the nodes of the shrink wrap mesh to the
original mesh, and typically the shrink wrap mesh will have an offset from the original mesh, again, the
offset is dependent on the target element size used.

Once the shrink wrap meshing process has completed the new elements will be created in the current
component. For every new run of the shrink wrap mesh, both loose and tight, it may be necessary to
create a new component collector if you wish the elements to be placed in another collector other than
the current component collector.

Comparison of Varying Mesh Sizes (Shell Output)

Figure 798: Original .stl Model
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Figure 799: 2mm Mesh Figure 800: 5mm Mesh

Comparison of Altering the Jacobian Value for Solid Mesh Generation
Within both tight and loose wrap algorithm’s there is an option to generate solid mesh. This will
generate an all Hexa mesh on completion of the shrink wrap. When the generate solid mesh
checkbox is selected it will expose a minimum jacobian input; this option essentially hexa meshes the
part with this element quality critieria defined. It controls the hexa quality, which is directly linked to the
adherence to the topological features of the original component. The jacobian value must be between
0 and 1. The nearer the value is to 1, the cruder the output will appear, the mesh will be more heavily
voxelised. When the value is closer to 0, you are allowing the shrink wrap solid mesh algorithm to
smooth and adhere to more features, while still maintaining the solid mesh minimum jacobian element
quality. By default the minimum jacobian value is 0.3.
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Figure 801: Original .stl Model

Figure 802: 2mm Solid Mesh, Jacobian=1.0 Figure 803: 2mm Solid Mesh, Jacobian=0.3

Shrink Wrapping with Feature Recognition
An additional option can be used to manually define features which will be adhered to during the 
meshing process. Typically, when using shrink wrap the mesh attempts to follow features, but has 
some freedom to break away from original edges of the part. However, when the features are manually 
selected within the panel, the resultant shrink wrap mesh will follow the chosen features. This can be 
important when defining a face of a component that may be in contact with other parts, or there may 
just be a feature that needs to be recognized and adhered to and cannot be approximated for whatever 
reason.
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There is also an advanced option to control the mesh orientation. If you have a non-uniform part and
you want to re-orientate the mesh so that it follows the features of the original component better then
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you can use this option. By default the mesh orientation always adheres to the global system, however,
you can generate a local coordinate system and override the default behavior.

In the example below, you can see the original mesh, the default shrink wrap mesh using the global
system, and the new re-orientated mesh using the local coordinate system.

Figure 805: Original .stl Model

Figure 806: Shrink Wrap Output using Global System
Default shrink wrap mesh using the global system.

Figure 807: Shrink Wrap Output using Local System
Rows of elements in the reoriented mesh run along the tubes

rather than at angles across them.
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that it projects the nodes of the shrink wrap to the original mesh, hence it is able to more accurately
capture features.

Comparison of Tight and Loose Meshing
Notice the differences between tight and loose meshing, especially in the pulleys on the front of the
engine and the resulting width of the individual cylinder exhaust pipes.

Figure 808: Original Model
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Tight Shrink Wrap Mesh
Tight wrap creates a wrapped surface mesh which adheres as closely as possible to the original FE
topology representation, automatically detecting and following the surface features of the model.

The accuracy of the output is dictated by the element size: the larger the element size the less detail,
the smaller the element size the more detail. This algorithm works differently than the loose wrap in

Figure 809: 2mm Tight Wrap Figure 810: 2mm Loose Wrap
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Comparison of Altering the Jacobian Value for Solid Mesh Generation
Within both tight and loose wrap algorithms there is an option to generate solid mesh. This will
generate an all-hexa mesh on completion of the shrink wrap. When the generate solid mesh checkbox
is active it exposes a minimum jacobian input; this option essentially hexa meshes the part with this
element quality critieria defined. It controls the hexa quality which is directly linked to the adherence to
the topological features of the original component. The jacobian value must be between 0 and 1. The
nearer the value is to 1 the cruder the output will appear (the mesh will be more heavily voxelised).
When the value is closer to 0, you allow the shrink wrap solid mesh algorithm to smooth and adhere
to more features while maintaining the solid mesh minimum jacobian element quality. By default the
minimum jacobian value is 0.3.
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Figure 811: Original Model

Figure 812: 2mm Solid Mesh, Jacobian=1.0 Figure 813: 2mm Solid Mesh, Jacobian=0.3
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Shrink Wrapping with Feature Recognition
An additional option can be used to manually define features which will be adhered to during the 
meshing process. Typically, when using the shrink wrap the mesh attempts to follow features, but has 
some freedom to break away from original edges of the part. However, when the features are manually 
selected within the panel the resultant shrink wrap mesh will follow the chosen features. This can be 
important when defining a face of a component that may be in contact with other parts, or there may 
just be a feature that needs to be recognized and adhered to and cannot be approximated for whatever 
reason.
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There is also an advanced option to control the mesh orientation. If you have a non-uniform part and
you want to re-orientate the mesh so that it follows the features of the original component better then
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you can use this option. By default the mesh orientation always adheres to the global system, however,
you can generate a local coordinate system and override the default behavior.

In the example below, you can see the original mesh, the default shrink wrap mesh using the global
system, and the new re-orientated mesh using the local coordinate system.

Figure 815: Original .stl Model

Figure 816: Shrink Wrap Output using Global System
Default shrink wrap mesh using the global system.

Figure 817: Shrink Wrap Output using Local System
Rows of elements in the reoriented mesh run along the tubes

rather than at angles across them.

EM Lattice Meshing
EM Lattice meshing is a method to create an axis-parallel mesh for 2D and 1D geometry input.

Create EM Lattice Mesh

1. From the menu bar, click Mesh > Create > EM Lattice Mesh.
The EM Lattice Mesh tool opens.

2. Use the Lines and/or Surfaces selector to select 1D and/or 2D entities.
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3. In the Origin fields, enter the origin that defines the left most corner of the domain bounding box
within which input entities have to be considered.

4. In the Voxel size fields, enter the size discretization for Lattice along the x, y, and z axes,
respectively.

5. In the Num voxels fields, enter the number of voxels that define the right most corner of the
domain bounding box.

The values you enter define the length, breadth, and height of the bounding box in terms of the
number of voxels along the axes. The rightmost extreme of the domain bounding box is calculated
as:

voxelszx * meshextx,voxelszy * meshexty,voxelszz * meshextz

6. Click Mesh.
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The Lattice mesh is created within the specified bounding box.

2D BL Meshing
2D BL meshing is a method to create a 2D mesh with or without boundary layers on planar sections
defined by sets/groups of edges defining closed loops.

A region is considered closed if it is entirely bounded by edge elements (edge elements should be of
type PLOTEL). Element configurations generated by 2D BL meshing are linear quadrilateral (quad4) and
triangular (tria3).

Create 2D BL Mesh
Mesh 2D planar areas with boundary layers.

Restriction:  Only available in Engineering Solutions when the CFD user profile is loaded.

1. Open the Utility Browser by clicking View > Utility menu from the menu bar.

2. Under Generate Mesh, click Generate 2D BL Mesh.
The 2D Boundary Layer Mesh dialog opens.

3. Select the 2D Native BL (planar) tab.

4. In the Default Value fields, enter the default values that apply to most components.

a) For 1st Layer Thickness, enter the thickness for the first layer of elements.

b) For Growth Rate, enter the boundary layer thickness growth rate from layer to layer.

c) For Bound Type, select a boundary layer type.

Choose Wall to generate boundary layers along the component edges. No boundary layers
are generated when Bound Type is set to Farfield, In/Outlet, and Symmetry.

Note:

Edge elements in collectors having Bound Type defined as Farfield, In/Outlet, and
Symmetry will be used to define the geometry, but they will not dictate element
size/density.
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Figure 818:

5. Click Add collector to select or add components containing edge elements (elem type PLOTEL) that
define the boundaries of the 2D section.

Default values (1st Layer Thickness, Growth Rate and Bound Type ) are assigned to the selected
components.

Figure 819:

6. To maintain the node seeding on the edge without BL as much as possible, select the Retain
node seeding on edge w/o BL checkbox.

The nodes on the non-BL boundary, which are located inside the BL, will not be maintained. Only
the nodes which are located inside of the BL will be maintained.

7. In the Number of boundary layers field, enter the number of boundary layers to generate.

8. To control the aspect ratio of boundary layer elements by refining the edges to generate boundary
layer elements that satisfy the Max perimeter element aspect ratio value, select the Allow
boundary node insertion checkbox.
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Figure 820:

9. To control the aspect ratio of boundary layer elements by boundary node movement so that
generate boundary layer elements will satisfy the Max perimeter element aspect ratio value, select
the Allow boundary node movement checbox.
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10. Click Generate 2D BL mesh.

The 2D BL mesh is generated.
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Figure 822:
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Periodic Meshing
Periodic meshing is a method to create a grid containing rotational and/or translational symmetric 
boundaries, for example rotating machinery.

Create Periodic Mesh

Before you begin, generate a mesh on the source geometry using any of the HyperMesh meshing 
algorithms, for example 2D mesh with BL.

1. From the menu bar, click Mesh > Create > 2D Elements > Periodic Mesh.
The Periodic Mesh dialog opens.

2. Select surfaces.

a) Use the Source: Surfaces selector to select source geometry.

b) Use the Target: Surfaces selector to select target geometry.

3. Use the Symmetry options to describe the mesh transformation between source and target
geometry.

Note:  The Translation and Rotation options can be used simultaneously for one
transformation.

• To define the translation vector, select the Translation checkbox.

• To define the rotation by an arc, defined by three nodes, or by an axis and a rotation angle,
select the Rotation checkbox.

4. Check mesh and geometry.
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• To whether source and target geometry are rotational and/or translational symmetric or not,
click Check/Modify Geometry.

• To check for source and target mesh to determine if symmetry exists, click Check Mesh.

5. Click Map Mesh.

The mesh from the source geometryis mapped onto the target geometry.

After a successful mapping step, information about the transformation is plotted in the log region of the
dialog.
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Volume Meshing
Volume mesh or "solid meshing" uses three-dimensional elements to represent fully 3D objects, such
as solid parts or sheets of material that have enough thickness and surface variety that solid meshing
makes more sense than 2D shell meshing.

3D Elements
Supported 3D elements.

Tetra Elements
3D tetrahedra elements.

Tetra4
Configuration 204 - 3D (1st order) tetrahedra elements with 4 nodes ordered in HyperMesh.

Figure 823: Element Configuration 204, 4-Noded Tetra

Tetra10
Configuration 210 - 3D (2nd order) tetrahedra elements with 10 nodes ordered in HyperMesh.
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Figure 824: Element Configuration 210, 10-Noded Tetra
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Penta Elements
3D triangular prism pentahedra elements.

Penta6
Configuration 206 - 3D (1st order) triangular prism pentahedra elements with 6 nodes ordered in
HyperMesh.

Figure 825: Element Configuration 206, 6-Noded Penta

Penta15
Configuration 215 - 3D (2nd order) triangular prism pentahedra elements with 15 nodes ordered
in HyperMesh.
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Figure 826: Element Configuration 215, 15-Noded Penta
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Hex Elements
3D hexahedra elements.

Hex8
Configuration 208 - 3D (1st order) hexahedra elements with 8 nodes ordered HyperMesh.

Figure 827:

Hex20
Configuration 220 - 3D (2nd order) hexahedra elements with 20 nodes ordered in HyperMesh.
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Figure 828: Element Configuration 220, 20-Noded Hexa



Altair HyperMesh 2019 Users Guide
Meshing p.1885

Solid Map Meshing
Solid Map meshing is a method that creates a mesh of solid elements in a solid geometric volume.

Solid Map Meshing Multiple Solids
You can select multiple solids for solid map meshing provided that each individual solid is in fact
mappable. However, the meshing engine cannot always mesh every selected solid in a single operation,
even when all the selected solids display as mappable.

This may happen if the mappable constraints from different solids within the selection contradict each
other. For example, one type of mappable constraint is that certain surfaces (along faces) of a mappable
solid must be of the map-mesh type. When such constraints are in conflict, faces that caused meshing
to fail are marked with a red square icon.

In Figure 829, both solids can be map-meshed individually, but solid 1 (the triangular one) must have
all of the marked faces (5, 6, and 9) map-meshed. This, however, causes a conflict for solid 2, which
can only be map-meshed by using the shared surface (6) as a destination. This conflicts since this
shared surface must match the meshes on surfaces 4 and 8 in order to mesh solid 2.

In such a case, you can mesh the remaining solids by deselecting the ones that are marked with the
red icon but retaining the others in your selection. This either allows you to mesh the unmarked solids
in a single action, or helps you further diagnose the problem. The remaining solids, unfortunately, will
require individual meshing or further partitioning before they can be solid-map meshed as a group.
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Partition Solids for Mappability
Before you can successfully solid mesh a model, ensure that the solids have been partitioned so that 
they are either one directional or three directional mappable.

Solid (3D) meshing can be done automatically, just like 2D shell meshing, but often requires that 
complex parts be partitioned into groups of smaller, simpler, connected solids instead of one large 
complex solid. In solid meshing, the ability to be meshed is referred to as mappability.

Mappability is directional and can be likened to putting a surface mesh on one face of the solid, then 
extending that mesh along a vector through the solid volume. So, for example, a perfect cylinder is 
mappable in one direction, the axis between its top and bottom faces, while a perfect cube is mappable 
in three, the axes between each pair of its identical faces. However, a combustion engine's cylinder 
head consisting of two cylinders of different radius joined together into a single solid entity would need 
to be partitioned to divide the two cylinders. Once partitioned, each cylinder would become mappable in 
one direction.

Note:  Even when all partitioned sections of the solid are mappable, this does not
necessarily mean that they can all be meshed at once. In some cases they may need to be
meshed a few at a time, or even individually in extreme cases. Mappability only ensures that
the partitioned section can be meshed.

Use the Mappable visualization mode to review solid partitioning for mappability. The “Mappable” mode
color codes the solids within the model according to whether the solids are solid meshable. The ignored
map, not mappable, 1 directional map, and 3 directional map all relate to the mappable state of the
solids.
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Tip:  Change the color coding for the mappable state from the Options panel, Colors
subpanel.

When reading in a new model with solids, the model will be colored blue after you activate the
Mappable visualization mode, which indicates that the mappability is currently being ignored. It is then
necessary to partition the model so that the state of the solids changes to 1 directional or 3 directional.

Note:  If the model does not include any solids, for example, only surfaces are present, you
can use the Solids panel on the Geom page to create solids from the surfaces.

If some partitioning has already occurred from a previous session when the .hm file has been read
in with the Mappable visualization mode already active, it will still be displayed as "ignored" map. To
invoke the mappable algorithm calculation, change to another visualization mode, such as By Topo and
then change back to Mappable again. This recalculates the state of all solids within the model.
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1. From the Visualization toolbar, set the geometry visualization mode to Mappable.
The solid is color codes according to its mappability state.

Blue

Solid has not been edited, and therefore cannot evaluated for mappability.

Orange

Solid has been edited, but remains completely unmappable (further partitioning may enable
mapping).

Yellow

Solid is mappable in 1 direction.

Green

Solid is mappable in three directions. This is very rare.

Figure 830:
The first cube is mappable in 3 directions, but if a corner is split off it becomes mappable in only 1 direction, and the

corner is not mappable without further partitioning.

2. Partition solids for mappability.
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Any solid edit operation will update the display of the solid entities automatically.
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Partitioning Solids for Mappability

Figure 831 shows that one trim of the model by a single surface (the top surface of the
rectangular shaft, in this case) has created two additional solids within the model. One solid
remains in the ignored map state (blue), one is now not mappable (orange) and one is one
directional mappable (yellow - transparent).

Figure 831:

After additional partitioning the model using the tools found in the Solid Edit panel, the model
has transformed from having an ignored map and non-mappable states to having only one
directional and three directional mappable states. Figure 832 shows one three directional
mappable solid, as indicated by the green transparent solid at the base of the shaft where it
joins the part's main body.

Figure 832:

Once partitioning is successful, meshing can commence. Accessing the Multi-Solids subpanel
and selecting all of the solids, plus the required meshing options, yields a complete 3D mesh for
the entire complex part, as shown in Figure 833.
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Figure 833:

Selecting and masking a section of the elements confirms that the mesh is a complete 3D mesh,
as opposed to just a surface mesh, as shown in Figure 834.

Figure 834:

Create Solid Map Mesh

Before you being, ensure that the solids have been partitioned so that they are either one directional or
three directional mappable. Refer to, Partition Solids for Mappability.
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Also, make sure you have an existing 2D mesh, which will be used to extrapolate the 3D solid map
mesh.

This topic uses the General subpanel, but the Line Drag, Linear Solid, and Ends Only subpanels all draw
from the same set of input controls. The Line Drag, Linear Solid, and Ends Only subpanels panels simply
filter out the controls that do not apply to their mapping techniques.

• Use the Line Drag subpanel to select a 2D mesh, and then select a line from the model geometry to
use as the mapping direction.

• Use the Linear Solid subpanel to select two existing 2D meshes and extrapolate a 3D mesh that
connects them.

• Use the Ends Only subpanel to select two opposing surfaces and one 2D mesh, then extrapolate the
mesh between the surfaces.

You can omit the source, the destination, or the along geometry by setting either one of the entity
selectors to (none). Only one of these selections can be set to (none); the other two selections are then
required to define the volume to fill.

1. From the 3D page, click solid map.

2. Select the General subpanel.

3. For source geom, select a geometry type and then select the source geometry that defines the
source face of the 3D volume.

• Choose surfs to select surfaces that define the source face of the volume/solid.

• Choose lines to select lines that define the periphery of the source face.

• Choose nodes to select multiple lists of nodes, each representing the periphery of the source
face.

• Choose none if you do not want to define source geometry. The geometry inferred from the
elems to drag is considered as source geometry.

4. Use the elems to drag selector to select the elements/mesh that correspond to the source face
extruded to create the solid mesh.

5. For dest geom, select a geometry type and then select the destination geometry that defines the
destination face of the 3D volume.

• Choose surfs to select surfaces that define the destination face of the volume/solid.

• Choose lines to select lines that define the periphery of the source face.

• Choose nodes to select multiple lists of nodes, each representing the periphery of the source
face.

• Choose none if you do not want to define destination geometry.

6. Select elems to match.

• Choose elems to select elements on the desitnation surface that you wish the 3D mesh to
match up with.

• Choose none to access the smooth dest checkbox, which when selected, smooths the mesh
that is mapped on the destination face when your destination geometry varies greatly from
the source geometry.

7. For along geom, select a geometry type and then select the geometry that defines the face of the
3D volume along which you wish to map the mesh.
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• Choose surfs to select surfaces to define the mapping face of the volume/solid.

• Choose lines to select lines that define the periphery of the source face.

• Choose nodes to select a node list that defines a line along which to map.

• Choose mixed to select any combination of surfaces, lines, 2D elements/shell faces, and/
or nodelist/nodepath. When elements are used, the mapped solid mesh maintains the nodal
positions with selected elements. They can be equivalenced to have common nodes. While
selecting nodelist/nodepath, each selection should represent an edge that connects the
source and destination.

• Choose none if you do not want to define geometry.

8. For along parameters, define the parameters required for the mesh along the solid map.

This determines the number of elements along the depth of the mapping. If the size or density is
set to "0", the element size/density is calculated based on the average element size of the source
elements (elems to drag).

9. For along bias style, choose the type of biasing to use while creating nodes in the along direction.

The biasing style works in conjunction with biasing intensity. If intensity is "0", biasing is not
applied.

10. In the intensity field, enter a biasing intensity.

11. Click mesh.

HyperMesh displays the progress of the solid map meshing process in the status bar. Upon completion,
HyperMesh displays a report of the mesh quality. The element quality value reported is the worst scaled
Jacobian in the mesh. The scaled Jacobian's value may range from 0.0 to 1.0(best). An elem's scaled
Jacobian is a ratio of the elem Jacobian over the Jacobian of an ideal elem of the same configuration.

Create Solid Map Mesh from One Volume
Create a new 3D mesh from a single, mappable solid volume.

Before you being, ensure that the solids have been partitioned so that they are either one directional or
three directional mappable. Refer to, Partition Solids for Mappability.

Also make sure you have an existing 2D mesh, which will be used to extrapolate the 3D solid map
mesh. When creating mesh from the One Volume subpanel, a 3D mesh can be automatically created
directly on solids as long as the solids you select are already mappable.

1. From the 3D page, click solid map.

2. Select the One Volume subpanel.

3. For volume to mesh, select the solid/surface to mesh.

4. Define the direction of mesh mapping.

a) For source hint, select the “beginning” surface.

b) For dest hint, select the “ending” surface.

5. For source shells, select the type of elements to use when creating the resulting output solid
mesh.

This defines the 2D mesh on the initial surface of the solid, and will dictate the output element
type when meshing the solids.
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• Choose mixed to use hexa and penta elements.

• Choose quad to create hexa elements.

• Choose trias or R-trias to create only penta elements (right-angle pentas in the case of R-
trias).

6. Select which component to put the newly-created elements.

• Choose elems to solid/surf comp to organize elements in the same component that
contains the solid and its surfaces.

• Choose elems to current comp to organize new elements in the current component.

7. To smooth the elements on the resulting face of the solid to improve the resulting mesh quality,
select the smooth dest checkbox.

8. For along parameters, define the parameters required for the mesh along the solid map.

This determines the number of elements along the depth of the mapping. If the size or density is
set to "0", the element size/density is calculated based on the average element size of the source
elements (elems to drag).

9. For along bias style, choose the type of biasing to use while creating nodes in the along direction.

The biasing style works in conjunction with biasing intensity. If intensity is "0", biasing is not
applied.

10. In the intensity field, enter a biasing intensity.

11. Click mesh.

HyperMesh displays the progress of the solid map meshing process in the status bar. Upon completion,
HyperMesh displays a report of the mesh quality. The element quality value reported is the worst scaled
Jacobian in the mesh. The scaled Jacobian's value may range from 0.0 to 1.0(best). An elem's scaled
Jacobian is a ratio of the elem Jacobian over the Jacobian of an ideal elem of the same configuration.

Create Solid Map Mesh from Multiple Solids
Create a new 3D mesh from multiple, mappable solids.

Before you being, ensure that the solids have been partitioned so that they are either one directional or
three directional mappable. Refer to, Partition Solids for Mappability.

Also make sure you have an existing 2D mesh, which will be used to extrapolate the 3D solid map
mesh. When creating mesh from the Multi Solids subpanel, a 3D mesh can be automatically created
directly on solids as long as the solids you select are already mappable.

HyperMesh can create volume meshes on multiple shapes at the same time, allowing you to mesh solid
parts faster.

Note:  Complex parts must still be partitioned into multiple simpler solids. Creating volume
meshing on multiple shapes simultaneously does not always work for a large numbers of
solids, even if they are all mappable. In some cases you may need to mesh them a few at a
time or even, in extreme cases, individually.

1. From the 3D page, click solid map.
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2. Select the Multi Solids subpanel.

3. Use the solids selector to select the desired solids.

4. Define the direction of mesh mapping.

a) For source hint, select the “beginning” surface.

b) For dest hint, select the “ending” surface.

5. Select the meshing mode.

• Choose automatic to automatically create the 3D solid mesh.

• Choose interactive to manually define mesh density and element mesh patterns before
creating a final mesh.

6. In the elem size field, enter the size to be used when initially distributing the nodes to the edges.

7. For source shells, select the type of elements to use when creating the resulting output solid
mesh.

This defines the 2D mesh on the initial surface of the solid, and will dictate the output element
type when meshing the solids.

• Choose mixed to use hexa and penta elements.

• Choose quad to create hexa elements.

• Choose trias or R-trias to create only penta elements (right-angle pentas in the case of R-
trias).

8. Select which component to put the newly-created elements.

• Choose elems to solid/surf comp to organize elements in the same component that
contains the solid and its surfaces.

• Choose elems to current comp to organize new elements in the current component.

9. To smooth the elements on the resulting face of the solid to improve the resulting mesh quality,
select the smooth dest checkbox.

10. To keep the solid elements generated more perpendicular to the surface faces in the along
direction, select the apply orthogonality to along checkbox.

11. To halt the meshing routines upon the creation of a bad jacobian solid element, select the stop
meshing on bad jacobian checkbox.

12. To force the mesh to honor any prior edge node density settings when creating the temporary
surface mesh, select the previous settings checkbox.

13. Click mesh.
If the automatic mesh mode is selected, a solid mesh is created. If interactive mesh mode is
selected, temporary 2D shell meshes are created and the node seeding density is assigned to all
of the along edges and the Density subpanel opens.

Tetra Meshing
Tetra meshing fills an enclosed volume with first order or second order tetrahedral elements.

A region is considered enclosed if it is entirely bounded by a shell mesh (tria and/or quad elements).
Hexahedral, wedge, and pyramid element configurations can also be generated during tetra meshing.
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These elements are typically generated when you need boundary layer type meshes on certain areas of
the volume surface.

Create Tetra Meshes with the Tetramesh Panel
You can specify some elements to be fixed, and others to be floatable.

A fixed tria-quad element is one that must be exactly represented as a face of a tetra/penta-pyramid/
hexa element in the final mesh. A floatable element is one whose nodes locations are used, but the
exact connectivity of those nodes can be modified if it produces a better mesh. Unless you need a
special mesh type, such as surface layers of pentas/hexas, you should select as fixed only those
elements that must match a pre-existing mesh, leaving the rest floatable. If the bounding surface
contains quad elements, and if these quad elements are defined as fixedelements, then a first layer
of elements is generated on the boundary, and pyramid elements are generated from the quad faces.
However, when quad elements are defined as float elements, they are split into two trias, and the tetra
meshing proceeds normally.

You can also specify various growth options in order to control the tradeoff between the number of
tetras generated and their quality. Higher, more aggressive growth rates produce fewer elements, but
they may be of poorer quality.

In the Tetramesh panel you can choose from three different mesh generation priorities. The generate
mesh normally option applies in most cases, but if your solver is particularly sensitive to element
quality, use the optimize element quality option. This directs the tetramesher to spend more time
trying to generate better quality elements. In particular, it employs the volumetric ratio (CFD "skew")
measurement for rating potential tetras. For some applications, element quality considerations are less
important than mesh generation time. In those cases, choose the optimize meshing speed option.

1. From the 3D page, click Tetramesh.

2. Access different types of tetra meshing from the subpanels.

Subpanel Description

Tetra mesh Fills an arbitrary volume, defined by its surface using tria/quad
elements, with tetrahedral elements.

Tetra remesh Regenerates the mesh for a single volume of tetrahedral elements.

Volume tetra Given a solid entity or a set of surfaces representing a closed volume,
this meshing option generates a shell mesh and fills the enclosed
volume with solid elements. You can choose to create a shell mesh
(2D) using quads, trias, or mixed elements and a solid mesh (3D)
using tetrahedral elements only or mixed (tetras and penta) elements.
In addition, you can use proximity meshing, which refines the mesh in
areas where the features are small and closer together.
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Subpanel Description

Figure 835:

You can also use surface curvature as a function of element density as
shown below. This option creates finer mesh in areas of high surface
curvature.

Figure 836:

When you select quads or mixed as your 2D element type, HyperMesh
creates quad elements and splits them diagonally into two trias during
tetra face creation. This can create tetra elements whose triangular
faces are right triangles (90-45-45 angles) instead of equilateral
triangles (60-60-60 angles).

Figure 837:
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Subpanel Description

Note:  Sometimes the meshing may fail to correctly
interpolate from the surface mesh; when this occurs,
the shell elements are cleaned up according to the same
settings used in the Quick TetraMesh macro on the Utility
menu, and a second attempt is made. This means that
some of the features in a model may be smoothed over.

Tetramesh parameters Sets general qualities of the tetrameshing engine, such as a maximum
element size, growth rate, the balance between speed and element
quality, or whether to perform smoothing operations after initial
meshing.

Refinement box Lets you define a specific box-shaped volume within an existing
teramesh in which to generate finer mesh.

Create Tetra Mesh with the Tetramesh Process Manager
Navigate through the different steps necessary to create a high quality tetramesh quickly using the
Process Manager.

Not every step in the process is mandatory; you can follow the entire process or just a few steps, based
on your requirements.

Note:  Execute steps only once, unless a reject option is available within the current step. If
you are not sure about the outcome of the next step, save the process before going further.

Effective tetrameshing requires a standard surface mesh to use as a base from which the 3D tetras are
built, therefore the beginning steps of the process revolve around achieving quality surface meshes.

Specific geometry cleanup and meshing algorithms are implemented in the Tetramesh Process Manager
template to handle complex parts efficiently.

A specific tetramesh process instance can be saved in a process manager template file (*.pmi) so its
parameters can be reused later on similar parts, allowing for increased efficiency and implementation
standards. The Tetramesh Process template can be used for automated geometry and element cleanup
(Batchmesher).

Create New Session

1. From the menu bar, click Mesh > Create > TetraMesh Process > Create New.

2. In the Create New Session dialog, enter a session name and location where the template and
related files will be saved and click Create.
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The Process Manager browser and panel open.

Tip:

You can go back and forth between template panels and core panels to take advantage of
core functionality by undocking the The Process Manager browser and panel open. panel. To

dock and undock the The Process Manager browser and panel open. panel, click .

Import Geometry

Before you begin, make sure the Process Manager, Import Geometry panel is open.

1. Select geometry.

To import Do this

Geometry 1. For Import Type, select Geometry.

2. For File Type, select the type of geometry to import.

3. In the Import Filename field, navigate to the desired file.

4. To automatically save an imported CAD file as an HyperMesh
file after the import completes, select the Save HM File After
Import checkbox.

5. In the Scale Factor field, enter a scale factor if the imported
model is in a spatial scale other than what you want to work
with.

This feature can also be used to convert the model's
measurements between metric and English units, for example.

Note:  Only spatial units are affected, mass and
similar qualities are not.

6. For Cleanup tol, choose a method to perform cleanup on
imported geometry.

• Choose Automatic to use the global cleanup tolerance
specified on the Options panel, Geometry subpanel.

• Choose Manual to enter your own tolerance.

7. To move all entities marked as blank to a special component,
select the Import blanked (no show) components
checkbox. By default, the translator ignores all of the blank
flags in the file.

HyperModel Model 1. For Import Type, select HM Model.
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To import Do this

2. In the Import Filename field, navigate to the desired file.

2. Click Import.
3. Click Next.

Cleanup Geometry

Before you begin, make sure the Process Manager, Geometry Cleanup panel is open.

1. Cleanup geometry.

To cleanup geometry by Do this

Equivalencing free edges 1. Click the Free Edges tab.

2. In the Tolerance field, enter the maximum distance across
which surfaces can be made equivalent.

Surfaces with a gap between them greater than this value
will not be made equivalent.

3. Click Equivalence.

Edges and other features that fall within the tolerance value of
each other are combined.

Displaying free edges by
edge type

1. Click the Edge Tools tab.

2. Select the checkboxes (Free Edges / T-junctions) for the
edge types to display.

3. Adjust display.

• Click Isolate to display only the surfaces attached to
the selected edge types.

• Click Display All to remove the mask and view all
surfaces.

Create filler surfaces 1. Click the Edge Tools tab.

2. Click Create to generate filler surfaces for all the free edge
loops.

This functionality helps to eliminate issues caused from
missing surfaces by creating the closed volumes necessary for
tetrameshing.
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2. Click either Accept or Next to continue.

Organize and Cleanup Holes
Isolate holes based on diameter ranges. Isolating and meshing holes separately from other geometry
features is a very important step during tetra meshing; failing to do so can drastically affect the overall
mesh quality. You may also wish to use this step even when there are no specific meshing requirements
for holes just to organize your model.

Before you begin, make sure the Process Manager, Cleanup and Organize Holes panel is open.

1. Click + to add additional rows to the table if you require multiple sets of hole criteria.

2. In the D< field, enter diameter values to consider when selecting holes.

Holes with diameters less than the value you specify will be automatically selected. If you add
multiple lines to the table, HyperMesh generates non-overlapping ranges from them.

Tip:  If you have no specific requirements for hole meshing, you can use a single
diameter value that is larger than the largest holes in the model, in order to select all
of the holes.

3. In the Num Circumference Elems field, enter the number of elements to place around the
circumference of any holes of the specified diameter range.

Higher numbers result in a smoother mesh that better approximates a hole's shape and curvature,
but could impact tetramesh quality if they result in smaller elements around the hole's edges than
the enforced element size for other surfaces.

Tip:  If you have no specific requirements for hole meshing, it is recommend that you
use at least 6 elements for each hole's circumference.

4. In the Longitudinal Elem Size field, enter the desired element size in the longitudinal direction.

Longitudinal direction is the direction traveled along the depth of the hole.

Tip:  If you have no specific requirements for hole meshing, it is best to use the same
element size as the rest of the model.

5. Click Auto Organize to automatically organize the holes into separate components based on the
input parameters, diameter, and so on.

One component will be created for each row in the table, and the holes are placed into the
components that their diameter and other criteria match. The model holes, and corresponding
table rows, are color-coded according to the component that they have been sorted into.

Clicking one of these buttons selects the entire row, making it the "active" row. To deselect an
active row, click the colorless button at the very top-left corner of the table (the one in the header
row along with the column names).
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Figure 838:

6. Click Organize to manually organize any holes that were missed by Auto Organize into
components using the Organize panel.

7. Click either Accept or Next to continue.

Mesh Holes

Before you begin, make sure the Process Manager, Mesh Holes panel is open.

1. From the Mesh Type column, select the mesh type to use when meshing the holes.

There are two meshing options available: R-tria regular and R-tria union jack.

Figure 839: R-tria regular Figure 840: R-tria union jack

2. Mesh holes.

Each row has a color button on its left which corresponds to the component holding hole surfaces.
Clicking one of these buttons selects the entire row, making it the "active" row. To deselect an
active row, click the colorless button at the very top-left corner of the table (the one in the header
row along with the column names).

• To mesh a single group of hole, select it's corresponding row and click Mesh.
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• To mesh all of the holes simultaneously, click Mesh All.

Figure 841:

3. Click either Accept or Next to continue.

Note:  To delete the mesh created for a group of holes, select it's corresponding row and
click Delete Mesh.

Organize and Cleanup Features
Organize and cleanup user defined features such as water jackets, inlets, outlets and contact surfaces.

Before you begin, make sure the Process Manager, Organize & Cleanup Features panel is open.

Auto cleanup operations are based on the criteria set in the Batchmesher criteria file. Cleanup
operations include equivalencing free edges, fixing of small surfaces (relative to the element size), and
detection of features such as beads. It also performs specified surface editing/defeaturing operations
like removal of pinholes below a specified size, removal of edge fillets, and the addition of a layer of
washer elements around holes.

The Autocleanup panel performs the entire geometry cleanup portion of the Batchmesher. Since it
performs a variety of geometry cleanup tasks, the results will not be instantaneous and can take a
few minutes for large models. Cleanup criteria is determined by the Batchmesher parameter and
element quality criteria files, both of which can be edited from within this panel using the Batchmesher
Parameter Editor.

1. Create a feature by clicking +.

2. In the dialog that opens, enter a name for the feature and click OK.

3. Use the surfs selector to select the surfaces associated with the feature, which will be added to a
new component.

When selecting surfaces, surfaces are added "by face" to the selection to allow all of the surfaces
associated with the same face in the model to be added simultaneously.
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4. Click proceed to finish adding surfaces to the component.

Features are sorted into color-coded components and the corresponding table rows are colored to
match.

5. Select a feature's corresponding row to make it active, then click Auto Cleanup.

6. In the Autocleanup panel, perform automated geometry cleanup operations on the geometry
contained in the selected component.

7. Click either Accept or Next to continue.

Organize and Cleanup Fillets
Defeature fillets, and replace the rounded corner where two lines come together with a point. Tangents
are calculated at the beginning and at the end of each fillet, then those tangents are intersected to
create a corner.

Before you begin, make sure the Process Manager, Fillets and Organize panel is open.

1. Use the Components selector to select the components that contain the fillets that require
cleanup.

2. In the Min Radius field, enter a minimum fillet radius to cleanup.

Any fillets in the model with radii of less than this value will be ignored, while fillets with radii
greater than this will be cleaned up (removed so that the relevant lines meet at a sharp corner.)

3. In the Max Radius field, enter a maximum fillet radius to cleanup.

Fillets with radii greater than this value will be ignored and remain.

4. To suppress such edges after the fillet removal process, select the Suppress fillet tangent
edges checkbox.

Because fillets are removed by generating tangent lines to replace them, these lines often result in
extra edges in model geometry.

Figure 842: Suppress Fillet Tangent Edges On Figure 843: Suppress Fillet Tangent Edges Off

5. Click Cleanup.
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The fillet midline split routine is executed based on what you have specified for the radius range
and tangent suppression.

6. Click either Accept or Next to continue.

Mesh Features

Before you begin, make sure the Process Manager, Mesh Features panel is open.

1. For Mesh Type, select the type of elements used to generate the mesh for each feature.

2. In the Elem Size field, enter the element size used to generate the mesh for each feature.

3. Create mesh.

• To create mesh for the selected/active row, click Mesh.

• To create mesh for all rows, click Mesh All.
4. Click either Accept or Next to continue.

Note:

Delete the mesh from a specific component by selecting the desired row and clicking Delete
Mesh.

Organize and Cleanup Global Surfaces
Organize and clean up all remaining global surfaces, that is, surfaces that were not already covered by
holes and user-defined features.

Before you begin, make sure the Process Manager, Global Organize and Cleanup panel is open.

1. In the Min Element Size field, enter a minimum element size for all such components to prevent
the autocleanup process from accidentally suppressing very small surfaces. Smaller values result
in more aggressive geometry cleanup, but could potentially result in loss of some features.

2. Optional: Click Organize to organize remaining surfaces into appropriate components using the
Organize panel.

3. Click Auto Cleanup.
The Autocleanup panel opens, which can be used to clean all remaining surfaces.

4. Click either Accept or Next to continue.

Mesh/Remesh Global Surfaces
Mesh all remaining global surfaces, that is, surfaces that were not already covered by holes and user-
defined features.

Before you begin, make sure the Process Manager, Mesh/Remesh panel is open.

1. In the Element Size field, enter the element size to use when meshing.

2. For Mesh Type, choose the type of element to use when meshing.

3. Click Mesh.
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A mesh is created using the specified element size and type on all remaining "global" geometry.

Note:

If you do not like the results, click Delete Mesh to remove mesh from all such
geometry, without affecting the specific items already meshed in previous stages, such
as holes or user-defined features.

4. Click either Accept or Next to continue.

Cleanup Elements
Optimize the quality of the elements created during each of the previous meshing stages.

Before you begin, make sure the Process Manager, Element Cleanup panel is open.

• Perform automatic cleanup.

Note:

The nodes of features, such as ridges, will not be preserved if their angle is less than
the specified minimum angle. In addition, element quality requirements may override
feature angle preservation regardless of the angle specified.

a) Click the Auto tab.

b) Use the Components selector to select the components that contain the elements to cleanup.

c) In the Min Size field, enter the minimum size that is acceptable for any given elements.

d) In the Max Feature Angle field, enter the maximum feature angle to preserve.

Figure 844: Minimum Feature Angle (Low Value) Figure 845: Minimum Feature Angle (High Value)

e) In the Normals Angle field, enter the maximum allowable angle between the normals of
adjacent elements.

When possible, adjacent elements whose normals exceed this angle will be split into multiple
smaller elements with less-extreme normal angles.

f) Click AutoCleanup.

g) Click either Accept or Next to continue.
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The mesh is examined within each component individually, removing elements of poor quality and
stitching the mesh together to fill the resulting gaps. Cleaning up the mesh on a per-component
basis prevents mesh overlap between adjacent surfaces that belong to different components.

Figure 846: Before Element Cleanup
Notice the "sliver" elements along midline.

Figure 847: After Element Cleanup
Notice the small, sliver elements are removed.

• Perform manual cleanup.

a) Click the Manual tab.

b) Choose the type of edges to find.

• Choose Free to find edges which are associated with only 1 surface.

• Choose T-Connections to edges which are associated with three edges.

c) Click Find to find edges.

d) In the Tolerance field, enter the tolerance to use when identifying nodes associated with free
edges and try to stitch them, leaving nodes outside the tolerance unchanged.

e) Click Fix to fix free edegs.

f) Click Display Normals to open the Normals panel, which can then be used to review
normals.

g) Click either Accept or Next to continue.
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Generate the 3D mesh from the existing surface meshes.

Before you begin, make sure the Process Manager, Tetra Meshing panel is open.
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By default, all elements belonging to holes and user-defined features will be set to tetramesh as Fixed
trias/quads, while the rest of the model will be meshed using the "floatable" method.

Create Tetra Meshes with the Tetramesh Panel

Volume Shrink Wrap Meshing
Produce an all-hexa or all-tetra mesh based on the selected elements or geometry, then use the shrink
wrap functionality as a quick mechanism to generate solid meshes.

Note:  When generating such a mesh, the Jacobian value has a large effect on the
coarseness of the resulting volume mesh, as described below.
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Using the shrink wrap mesh to achieve improved FE output from OptiStruct topology runs has also 
provided very good results which allow for quick tetra-meshing and, therefore, quick re-analysis after 
the optimization run.

Comparison of Altering the Jacobian Value for Solid Mesh Generation
Within both tight and loose wrap algorithm’s there is an option to generate solid mesh. This will 
generate an all hexa mesh on completion of the shrink wrap. When the generate solid mesh checkbox 
is selected it will expose a minimum jacobian input, this option essentially will hexa mesh the part 
with this element quality critieria defined, it controls the hexa quality which is directly linked to the 
adherence to the topological features of the original component. The jacobian value must be between 
0 and 1. The nearer the value is to 1 the cruder the output will appear, the mesh will be more heavily 
voxelised. When the value is closer to 0, you are allowing the shrink wrap solid mesh algorithm to 
smooth and adhere to more features while maintaining the solid mesh minimum jacobian element 
quality. By default the minimum jacobian value is 0.3.

Figure 848: 2mm Solid Mesh, Jacobian=1.0 Figure 849: 2mm Solid Mesh, Jacobian=0.3
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Acoustic Cavity Meshing
Acoustic Cavity meshing generates a fluid volume mesh used to calculate the acoustic modes (or
standing waves) inside the air spaces of a vehicle or similarly enclosed structural model.

Acoustic cavity meshing is primarily used by Noise, Vibration, and Handling (NVH) engineers to design
quieter interiors.

Figure 850:
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Acoustic cavity meshing can be a CPU-intensive process, especially with fine and/or complex meshes, 
but this can be offset by additional CPU cores. The Acoustic Cavity Mesher is multithreaded to take 
advantage of multi-core environments.

How Cavities are Identified
Hole and gap patching is a critical part of defining cavities enclosed in the structure model. The process 
refers to patching over inconsequential gaps and holes that inevitably exist in the structure model, such 
as speaker holes.

Gaps are defined as elongated openings based on their longest dimensions. Holes are openings defined 
by the radius of a sphere that can pass through them. By specifying the size of the hole and gap 
patches, you can control how the cavities are defined through auto search.

Typically, a cavity model is intended to be meshed right up to the outer body panel. Plastic and fiber 
trim panels are often included in a trimmed body model, but not meant to be used for cavity meshing. 
However, if the trim panels are selected during the AC meshing process they can be confused as outer 
body panels, leading to incorrect cavity definition. Therefore, it is important to ensure that only the 
exterior body panels are selected as the structure components to be included in the auto cavity search.
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Include the cavity between the inner and outer door panels as a part of the interior by specifying
a hole patch size smaller than that of the largest opening in the inner panel, so that the opening
is not patched. This allows interior mesh to flow into the door cavity.

Instrument Panel (IP)
Model the cavity behind the Instrument Panel as a part of the interior cavity by excluding the
IP parts from the structure component selection during the auto cavity search. This forces the
auto cavity search to ignore the existence of the sealed IP cluster when determining the interior
volume of the passenger compartment. If the IP panel needs to be treated as a radiating source,
a fluid boundary needs to be created at the location of the IP, similar to the how a package tray
can be included as a structure part.

Pillar
Include large pillar cavities, such as a D pillar cavity, as a part of the interior cavity by ensuring
that the gap and hole patch size specified are smaller than that of the largest opening. This
prevents the opening from being patched and allows interior mesh to flow into the pillar cavity.

Under Seat
Ensure the under-seat spaces are meshed by specifying an element size smaller than the smallest
dimension of the space, thus allowing the interior mesh to fill the cavity.
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Types of cavities you may wish to model:

Door

Trim Component
Special functionalities are required to mesh these cavities.
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Factors that Influence Cavity Meshing
The ability to model the acoustic cavity and predict acoustic response inside it is a critical part of NVH
analysis, as noise level and quality become key product quality differentiators in the marketplace. A
number of factors need to be considered when meshing an acoustic cavity model.

Adequate mesh size.
A rule of thumb is that at least six elements are needed per acoustic wavelength. Based on this
rule, the minimum acoustic element sizes at various frequencies are:

500 Hz
114 mm

1000 Hz
57 mm

Smaller elements mean a more complex cavity model, which takes longer to run and generates a
larger output file, particularly when fluid grid participation output is requested. Recall, however,
that the mesher is multithreaded to take advantage of multiple CPU cores.
Mesh size can also affect whether smaller cavity areas, such as the cavities underneath seats, get
filled. Mesh size should be selected by considering the size of the smallest cavity that needs to be
filled.

Mesh quality as defined by Jacobian value, Tetra Collapse, and similar measures.
Poor mesh quality may cause problems when submitted to the solver, or lead to less-accurate
results.

How closely the cavity shape matches the actual structure.
This impacts how accurately the cavity model captures acoustic modes, and how difficult it is
to obtain good coupling between the fluid and structure. It is important to define the structure
panels intended to be coupled to the cavity.

Aesthetics of the cavity mesh.
The model may appear too jagged if the cavity mesh matches the structure closely. Some users
prefer a smooth looking mesh for presentation purposes, but care must be taken so that this
does not adversely affect the modes calculated or the quality of coupling generated when default
ACMODL search parameters are used.

Interior response definition.
Interior response points need to be defined so that they become a part of the mesh definition
when cavity mesh is generated.

Seat Foam Cavity definition and coupling.
Seat foams are typically modeled as denser air cavities. Their geometry definition can come
in either as CAD data or existing FE mesh. Some seat models contain detailed foam curvature
definition, while others may just be blocky boxes. The acoustic mesher can generate a new seat
foam mesh and use congruent grids to connect to the interior cavity elements, or generate fluid
MPCs to connect grids on a existing foam cavity mesh to the interior cavity mesh.
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Trunk Cavity separated from the Interior Cavity.
For passenger sedans, the trunk cavity is typically modeled as a separate cavity from the interior,
separated by the rear seat back foam cavity.

Package Tray properly coupled to both interior and trunk cavities.
For passenger sedans, the "package tray" or "parcel shelf" is situated behind the rear seat backs,
between the interior cavity on the top and the trunk cavity below. Its vibration should be coupled
into both cavities. This means a boundary (or gap) needs to exist in the cavity model where the
package tray is located. This is typically accomplished by the two cavities not sharing grids at the
boundary.

Once generated, fluid cavities must be coupled to the structure. OptiStruct creates this coupling
automatically during solver analysis, storing the information in the ACMODL card. In addition, Radioss
generates an .interface file which can be loaded into HyperMesh to verify fluid surface and structure
wetted surfaces.

Figure 851:

Create an Acoustic Cavity Mesh
Creating an acoustic cavity mesh is two-staged. First, create a voxel-based preview mesh. Second,
select individual volumes, set element quality requirements, and create a smoother, more refined
computational mesh for the selected volumes.

Acoustic Cavity meshing begins with the Acoustic Cavity Mesh panel. This panel accepts the
necessary base input data to generate a voxelated preview mesh for one or more acoustic cavities.
Once the preview mesh exists, however, the Acoustic Cavity browser displays in the tab area; you can
use this tool to modify element quality checks, select specific volumes that have a preview mesh, and
create the computational mesh for each selected cavity.

1. Open the AcousticCavity browser and Acoustic Cavity Mesh panel by selecting Mesh >
Create > Acoustic Cavity Mesh from the menu bar.

2. Define acoustic cavity meshing parameters.

a) In the Acoustic Cavity browser, click .

b) In the Options dialog, define acoustic cavity meshing parameters accordingly.

3. Using the Acoustic Cavity Mesh panel, generate preview mesh.
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a) Use the structure: comps selector to select the components that surround the desired
cavity.

Select all of the components that enclose the air spaces. You can create meshes for multiple
air spaces simultaneously, depending on which components you initially select.

b) Use the seats: comps selector to select the solid bodies representing the seats.

Acoustic cavity meshing takes seating into account, and generates a separate volume mesh
for each seat (bench seats are correctly treated as a single assembly, not broken up into
individual seats based on the number of humans who could sit on them). This distinguishes
the seats from the mesh that represents the air space.

c) Select a method for seat coupling.

• Choose node to node remesh to obtain new node-connected cavities for the seats,
matching seat nodes, and cavity nodes on a 1:1 basis.

• Choose MPC no remesh to connect the input seat components to the found cavities
using MPCs, which allows node mapping at a ratio other than 1:1. Only use this option if
the seat components are composed of solid elements. For proper MPC creation, the seat
mesh size must be relatively similar to the size used to create the acoustic cavity mesh;
in general, the size difference should be no more than 30%.

d) In the max element size field, enter a desired element size.

The max frequency will be populated automatically depending on the specified max
element size and No. elements per wavelength specified in Options dialog. It is also
possible to specify the max frequency value, and then max element size will be calculated
accordingly.

Note:  A small, fine mesh may take a considerable amount of time to generate.

e) In the gap patch size field, enter how large of a gap in the geometry the mesher will ignore.

f) In the hole patch size field, enter how large of a hole in the geometry the mesher will
ignore.

g) Optional: Create permanent elements from the temporary elements used to patch over the
holes, and store them in their own collector called ^patched_holes by selecting the create
hole elements checkbox.

h) Click preview.

A simple preview mesh is generated.

Figure 852: Simple Preview Mesh
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4. In the AcousticCavity browser, select individual volumes, set element quality requirements, and
create a smoother, more refined computational mesh for the selected volumes.

Figure 853: Final Acoustic Cavity Mesh

Voxel Meshing
Voxel meshing fills an enclosed volume with voxels (hexas) of a predefined size.

This type of mesh is only useful in topology optimization. It does not give meaningful results in a stress
analysis.

To work properly, the volume must be enclosed completely by shell elements (quads and trias) without
T-Connections or free edges. The normals of these elements should point inwards. The voxels (hexa
elements) are stored in the component, hexas.

Create Voxel Mesh

1. From the menu bar, click Mesh > Create > Voxel Mesh.

2. Select the components that contain shell elements enclosing one volume.

Note:  If more than one volume is selected, normals should be adjusted manually.

a) In the panel area, use the comps selector to select components.

b) Click proceed.

The Voxelmesh dialog opens.

3. Define options.

• To check for T-connections and free edges, select the Perform element check checkbox.

If found, the results are stored in collectors of the corresponding names.

• To automatically adjust normals (to inward), select the Adjust normals checkbox.

This works if the selection is one connected volume only. The volume may contain internal
voids.

• To fill areas that are hidden in each coordinate direction, even if they are not touching the
enclosed volume, select the Fill undercuts checkbox.

These elements are stored in the component, hexasfill.
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• To create are store the voxel meshes in nine components (hexas0, hexas1...) depending
on the number of nodes that are inside the volume, select the One component for each
number of inner nodes checkbox.

Note:  Zero inner nodes may occur if one edge of the volume intersects the center
of a hexa-face.

• To select a coordinate system along which to align the mesh, select the Use local
coordinates checkbox.

If no selection is made, the global (basic, screen) coordinate system is used.

4. Set the edge size for hexa elements.

Note:  A grid of nodes is created for the box wrapping the volume, therefore the
memory usage may be high for unreasonably small values.

• Choose Cubes to enter a single value for the edge size.

• Choose Rectangles to enter x, y, and z edge lengths.

5. Click Start.
6. If you selected the Use local coordinates checkbox, you will be prompted to select a coordinate

system. Select the system and then click proceed.

Gasket Meshing
Gasket elements are used to model components with a very thin thickness, with their main purpose
being to act as a sealing between structural components.

Gasket elements have a different node order compared to first or second order hex and penta elements.
Gasket elements have nodes on their top and bottom face, and no mid-side nodes along their thickness.

Figure 854: Node Order for Gasket Elements of Type GK3D18
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Restriction:

Gasket elements are only supported in the Abaqus solver interface, and you can only create
gasket elements of type GK3D18 and GK3D13 with the Gasket Elements tool.

Create Gasket Elements

1. From the menu bar, click Mesh > Create > 3D Elements > Gasket Elements.
The Create Special Elements dialog opens.

2. Select Create Mesh.

3. Use the Source selector to select the face of the 3D volume.

4. Use the Target selector to select target face of the 3D volume.

5. In the Element Size field, enter the average element size to make elements.

6. In the Number of Layers field, enter the number of elements (layers) to create between source
and target layer.

7. For Destination Comp, choose where newly created elements are organized.

• Choose New Component to organize elements in a new component.

• Choose Current Component to organize elements in the current, active component.

• Choose Elems to Surf Component to organize elements in the component to which the
surface belongs.

8. For Assign Property & Material, choose a method for assigning properties to newly created
elements.

• Choose New Property to assign a new property.

• Choose Existing Property to select an existing property.

9. Click Apply.

10. Click OK to close the dialog.

Tip:  Highlight the nodes of the newly created gasket elements by clicking Review.
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Figure 855: Original Geometry

Figure 856: Mesh with Gasket Elements Figure 857: Gasket Elements with Review Enabled

Update Gasket Elements

1. From the menu bar, click Mesh > Create > 3D Elements > Gasket Elements.
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The Create Special Elements dialog opens.

2. Select Update Elements.

3. Use the Source selector to select the face of the 3D volume.

4. For Element Type, select an element type.

5. Click Apply.

6. Click OK to close the dialog.

Tip:

Highlight the nodes of the newly created gasket elements by clicking Review.
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Mesh Controls
Mesh controls are used to automate and streamline the meshing process.

Manage mesh controls from the Mesh Controls Browser, which can be accessed by clicking Mesh >
Mesh Controls from the menu bar.

You can define one model mesh control, as well as an unlimited number of local mesh controls. Meshing
is supported for Batchmesher, surface meshing, adaptive wrap meshing and volume meshing.

Model mesh controls define mesh settings for all of the entities which need to be meshed in one
meshing job. In general, model mesh controls reflect the mesh settings on a majority of the model.
In order to run a meshing job, at least one model mesh control must be defined. Multiple model mesh
controls can be defined, but only one can be active and used to run a meshing job.

Local mesh controls define mesh settings for specific areas of a model, and take precedence over model
mesh controls. Local mesh controls are not mandatory, but are useful when local mesh settings need to
be defined for a meshing job. An unlimited number of local mesh controls can be defined and used to
run a meshing job. Local mesh controls have an on/off state which can be enabled and disabled. When
a meshing job is submitted, enabled mesh controls are considered and used to automate the meshing
process.

Mesh controls are HyperMesh entities that are stored in the database. Mesh controls can also be saved
to an external .xml template file for re-use in other models.

Mesh Control Types
You can create mesh controls specific to the different meshing types and refinement zones.

Batchmesher Mesh Controls
Model and local mesh controls for BatchMesh meshing.

Note:  In order to run a meshing job, at least one model mesh control must be defined.

When defining model and local mesh controls, select a parameter mode to determine how criteria and
parameters are generated. Batchmesher mesh controls are run using a single CPU.
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When generating the mesh, local controls are applied first, starting from the smallest target element
size, up to the largest. The model control is then applied.

Normal Parameter Mode
The Normal parameter mode generates criteria and parameters using an existing set of files.

Table 195: Parameters

Parameter Description

Criteria File Specify a criteria file that will be used to automatically generate criteria.

Parameters File Specify a parameters file that will be used to automatically generate
criteria.

Mesh Connectivity Determines how newly created elements and any adjacent existing
elements are connected.

Keep
Use existing nodes on any shared boundary edges.

Break
Ignore existing adjacent elements and generates mesh according to
the element size and type you specified.

Scaled Parameter Mode
The Scaled parameter model generates criteria and parameters on-the-fly by scaling an existing set of
files. This parameter mode is useful when you want to evaluate mesh size changes using minimal effort.

Table 196: Parameters

Parameter Description

Element Size Element size used when scaling criteria and parameters.

Criteria File Specify a criteria file that will be used to automatically generate criteria.

The "min size" and "max size" thresholds are created by simple
proportional scaling of the base thresholds to the requested element size.
All other criteria is not changed.

Parameters File Specify a parameters file that will be used to automatically generate
criteria.

All dimensionless parameters and options are not changed.

All parameters having a length dimension are proportionally scaled using
the scale factor target size/original size.

• Element size

• Max thin solid thickness (for midsurface extraction)
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Parameter Description

• Surface holes table: radii ranges and washers widths, target radii if
given directly ( not as a radius fraction )

• Solid holes table: radii ranges

• Surface fillet table: radii and widths ranges, maximal chordal deviation

• Flanges recognition: max and min flanges width, maximal width for
narrow surface width allowed to be deleted

• Duplicated surfaces search tolerance – scaled if 0.5 < scale_factor < 2

• Edges equivalencing tolerance – scaled if 0.5 < scale_factor < 2

• Narrow fillets merging width threshold

• Beads to be removed maximal height

• Flanged holes to be removed maximal height

• Edge fillets defilleting - max radius

• Logos to be removed : maximal height and depth

• Threads to be removed max depth

• Trias reduction maximal and minimal elements size

• Elements warpage fix – maximal offset normally to surfaces

Mesh Connectivity Determines how newly created elements and any adjacent existing
elements are connected.

Keep
Use existing nodes on any shared boundary edges.

Break
Ignore existing adjacent elements and generates mesh according to
the element size and type you specified.

Auto Generate Parameter Mode
The Auto Generate parameter mode generates criteria and parameters on-the-fly using very basic and
limited input parameters. This parameter mode is useful for basic and simple use cases, where existing
parameter and criteria files do not exist and you do not have strict mesh requirements.

Mesh control input parameters are automatically populated within specific Criteria file fields. The Min
Size - Good/Warn/Worst and Max Size - Good/Warn/Worst are internally calculated. All other Criteria file
settings are hard-coded.

Table 197: Criteria

Mesh Control Input
Parameter

Criteria File Field

Element Size Target element size
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Mesh Control Input
Parameter

Criteria File Field

Min Size - Ideal

Max Size - Ideal

Minimum Element Size Min Size - Fail

Maximum Element Size Max Size - Fail

Mesh control input parameters are automatically populated within specific Parameter file fields. All other
parameters and behaviors are kept as default.

Table 198: Parameters

Mesh Control Field Parameter File Field

Element Size Target element size

Element Type Create mesh with element type, with “align” and “size” checkboxes
enabled.

Element Order Element order

Element Feature Angle Feature angle during element cleanup

Geometry Cleanup Enables or disables, in its entirety, the Geometry cleanup section

When Geometry Cleanup is enabled, two threshold radii are defined as:

• min_rad = max(0.4*Element Size, 0.8*Minimum Element Size)

• mid_rad = max(0.6*Element Size, min_rad)

◦ max_rad = 3.0*Element Size

Enabling the Geometry Cleanup parameters listed below, facilitates the following behaviors.

Remove Small Holes
Removes small surface and solid holes with a radii range of 0 – min_rad.

Create Washers
Create one layer of washers with a minimum of 6 elements and an auto-defined width for surface
holes in the min_rad – max_rad range.

Seed Holes
Enable hole seeding for surface and solid holes, per the rules below. If Create Washers is enabled,
this is ignored for surface holes.

• min_rad – mid_rad = 4 elements minimum

• mid_rad – max_rad = 6 elements minimum
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Allow Movement Across Edges
Enable major post-mesh element cleanup operations to improve the final element quality at the
expense of edge capturing and performance.

Advanced Feature Capture
Enable improved feature capturing at the expense of element quality and performance.

In the Parameters file, the following parameters are automatically defined. All other parameters are
kept as default.

• Extract midsurfaces is enabled with the Method set to skin offset.

• Geometry Cleanup

◦ Surface fillet recognition

The following thresholds are defined:

∙ min_rad = 0.7*max(0.4*Element Size, Minimum Element Size)

∙ min_wid = 0.49*Pi*min_rad

∙ mid_rad = 1.307*max(0.5*Element Size, Minimum Element Size)

∙ mid_wid = 0.5*Pi*mid_rad

∙ max_rad = 1.5*Element Size

∙ max_wid = 0.51*Pi*max_rad

The following number of elements rows are enforced:

∙ min_rad – mid_rad and min_wid – mid_wid = 1 element across

∙ mid_rad – max_rad and mid_wid – max_wid = 2 elements across

◦ Flange recognition is enabled with:

∙ Elements across flange width = 2

∙ Maximum width of flange = 3.5*Element Size

∙ Minimum width of flange = max(0.5*Element Size, Minimum Element Size)

∙ Delete flange narrow surfaces with width < = auto

◦ Other options

∙ Suppress beads with height < = min( 0.2*Element Size, Minimum Element Size)

∙ Suppress flanged holes with height < = min(0.15*Element Size, Minimum Element Size)

∙ Remove edge fillets with radius < = 0.9*Element Size

∙ Remove logo with size < = 3.0*Element Size, and height < = min(0.15*Element Size,
Minimum Element Size)

◦ Element Cleanup

∙ Apply tria reduction with min elem size > = 0.5*Element Size and max size <
1.5*Element Size
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∙ Move across free edges, max dist < = 0.0025 * element size

Surface Meshing Mesh Controls
Model, local, refinement, and feature mesh controls for surface meshing.

When generating the mesh, the following behaviors apply:

• Feature mesh controls are applied first.

• Model and local mesh controls are applied second, in the following order, according to their
configuration. If any mesh controls have the same configuration, meshing is applied starting from
the smallest size up to the largest:

◦ Rigid body (surface-based only)

◦ QI optimize

◦ Size and bias

◦ Edge deviation

◦ Surface deviation (surface-based)/Adaptive (element-based)

Model and Local
Model and local mesh controls define the meshing mode, element size, element type, and additional
parameters used to create a mesh of shell elements using surface geometry or existing shell elements.

Note:  In order to run a meshing job, at least one model mesh control must be defined.

When defining model and local mesh controls, select a mesh mode to use during automatic meshing to
determine the type of meshing to perform. For more information on the different mesh modes, refer
to Mesh Modes. The mesh mode for model controls can be changed at any time. However, for local
controls, the mesh mode is defined only at the time of creation.

Size and Bias
Generates mesh using elements of a uniform size that you specify.

Main Parameters

Table 199: Parameters

Parameter Description

Use Model Settings Set all of the main parameters from the model control.

For local controls only.

Element Size Average element size. The length of any active (shared or free)
surface edge divided by the element size determines the number of
elements to place along that edge.
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Parameter Description

Element Type Type of elements used to create mesh during automatic meshing.

For more information, see Mesh Types.

Element Order First
Create elements using a linear shape function.

Second
Create elements using a polynomial shape function.

For local controls, this is inherited from the model control and cannot
be set independently.

Advanced Parameters

Table 200: Parameters

Parameter Description

Organization

Destination Component Original
Store newly created elements in the component to which the
surface belongs.

Current
Store newly created elements in the "current" active component.

Valid only for model controls.

Mesh Connectivity Determines how newly created elements and any adjacent existing
elements are connected.

Keep
Use existing nodes on any shared boundary edges.

Redo
Re-seed existing nodes along the boundary of the newly created
mesh to optimize mesh quality.

Break
Ignore existing adjacent elements and generates mesh
according to the element size and type you specified.

Valid only for model controls.

Flow

Align Produces a more orthogonal quad-dominant mesh.

Only available when the Element Type is set to Mixed.
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Parameter Description

Figure 858: Flow Alignment Off

Figure 859: Flow Alignment On
Notice a straighter row of elements is produced.

Size Enforces the global mesh element size with minimal min/max element
size variations.

Only available when Element Type is set to Mixed and Flow: Align is
enabled.

Mapping

Size Keeps elements roughly the same size.

Skew Prevents mesh from producing highly-skewed elements.

Other - Surface Based Automeshing Only

Link Opposite Edges Links mesh settings on opposing edges of rectangular surfaces.
Changes applied to one linked edge will be applied to the other. By
default, the maximum aspect ratio (AR) to allow between large and
small edge sizes of linked edges is 2.11.

Manually specify an aspect ratio by setting Aspect Ratio Less Than to
User Specified. Increasing the value adds more surfaces to the linked
chain, whereas decreasing the value removes some surfaces from the
linked chain.
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Parameter Description

Figure 860: Link Opposite Edges Selected

Figure 861: Link Opposite Edges Selected and Aspect Ratio Less Than = Auto

Figure 862: Link Opposite Edges Selected, Aspect Ratio Less Than = 8.0
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Features - Element Based Automeshing Only Parameters

Table 201: Parameters

Parameter Description

Auto Features Defines logical faces when using existing finite elements as a basis for
automeshing.

Connected
Detect features based on the specified feature angle, and make
additional effort to void any "orphan" or non-closed feature
lines.
It works similarly to Auto Detect, but includes a more rigorous
check to combine small areas and avoid creating features that
end abruptly or do not connect to any other features.

Auto Detect
Detect features based on the specified feature angle.

Surface Edges
Automatically detect and utilize geometric lines associated with
selected elements as features in the re-meshing operation.

Figure 863: Before Re-Meshing Figure 864: After Re-Meshing,
Surface Edges Selected

None
Ignore extra features defined by any of the above methods.

User Features A selection of user-created 1D elements which define features that
need to be captured along with any feature angle-based features. Only
1D elements should be selected here, as any other element selections
are ignored.
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Parameter Description

Anchor Nodes Nodes that will remain and be re-used in the new mesh. Anchor nodes
are "fixed" so that the automesher cannot move or replace them; in
essence, they are exceptions to the re-meshing operation, and the
new mesh must utilize them.

QI Optimize
An iterative automatic mesh generation method driven by element quality criteria.

Main Parameters

Table 202: Parameters

Parameter Description

Use Model Settings Set all of the main parameters from the model control.

For local controls only.

Element Size Average element size. The length of any active (shared or free)
surface edge divided by the element size determines the number of
elements to place along that edge.

Element Type Type of elements used to create mesh during automatic meshing.

For more information, see Mesh Types.

Element Order First
Create elements using a linear shape function.

Second
Create elements using a polynomial shape function.

For local controls, this is inherited from the model control and cannot
be set independently.

Criteria File Specify a criteria file that will be used to automatically generate
criteria.

Advanced Parameters

Table 203: Parameters

Parameter Description

Organization
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Parameter Description

Destination Component Original
Store newly created elements in the component to which the
surface belongs.

Current
Store newly created elements in the "current" active component.

Valid only for model controls.

Mesh Connectivity Determines how newly created elements and any adjacent existing
elements are connected.

Keep
Use existing nodes on any shared boundary edges.

Redo
Re-seed existing nodes along the boundary of the newly created
mesh to optimize mesh quality.

Break
Ignore existing adjacent elements and generates mesh
according to the element size and type you specified.

Valid only for model controls.

Flow

Align Produces a more orthogonal quad-dominant mesh.

Only available when the Element Type is set to Mixed.

Figure 865: Flow Alignment Off
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Parameter Description

Figure 866: Flow Alignment On
Notice a straighter row of elements is produced.

Size Enforces the global mesh element size with minimal min/max element
size variations.

Only available when Element Type is set to Mixed and Flow: Align is
enabled.

Mapping

Size Keeps elements roughly the same size.

Skew Prevents mesh from producing highly-skewed elements.

Other - Surface Based Automeshing Only

Smooth Across Common
Edges

Node smoothing moves nodes across adjacent surface edges whose
feature angle is less than the value specified. When selected, strict
adherence to the geometry of the surface edges in not enforced for
non-feature edges; some deviation from the geometry can occur.

Features - Element Based Automeshing Only

Table 204: Parameters

Parameter Description

Auto Features Defines logical faces when using existing finite elements as a basis for
automeshing.

Connected
Detect features based on the specified feature angle, and make
additional effort to void any "orphan" or non-closed feature
lines.
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Parameter Description

It works similarly to Auto Detect, but includes a more rigorous
check to combine small areas and avoid creating features that
end abruptly or do not connect to any other features.

Auto Detect
Detect features based on the specified feature angle.

Surface Edges
Automatically detect and utilize geometric lines associated with
selected elements as features in the re-meshing operation.

Figure 867: Before Re-Meshing Figure 868: After Re-Meshing,
Surface Edges Selected

None
Ignore extra features defined by any of the above methods.

User Features A selection of user-created 1D elements which define features that
need to be captured along with any feature angle-based features. Only
1D elements should be selected here, as any other element selections
are ignored.

Anchor Nodes Nodes that will remain and be re-used in the new mesh. Anchor nodes
are "fixed" so that the automesher cannot move or replace them; in
essence, they are exceptions to the re-meshing operation, and the
new mesh must utilize them.

Edge Deviation
Determines how far the mesh elements can deviate from the actual edges of the surfaces meshed, or
when in the case of re-meshing elements, deviation from inferred edges based on features.
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Main Parameters

Table 205: Parameters

Parameter Description

Use Model Settings Set all of the main parameters from the model control.

For local controls only.

Minimum Size Minimum allowable element size.

Maximum Size Maximum allowable element size.

Maximum Deviation Allowable deviation between the element edge and the surface edge.
To meet this requirement, element edge lengths along a curved
surface edge are reduced as needed down to a lower limit set by the
minimum element size.

Maximum Feature Angle Maximum angle across which elements can be maintained. When two
adjacent elements’ normals exceed this angle, a new set of nodes is
created between them to maintain clean feature lines. Using higher
value results in elements spanning the feature line.

Figure 869:
With an appropriate value, the features lines are preserved.

Figure 870:
If the feature angle is too high, the feature lines are blurred.

Element Type Type of elements used to create mesh during automatic meshing.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1932

Parameter Description

For more information, see Mesh Types.

Element Order First
Create elements using a linear shape function.

Second
Create elements using a polynomial shape function.

For local controls, this is inherited from the model control and cannot
be set independently.

Advanced Parameters

Table 206: Parameters

Parameter Description

Organization

Destination Component Original
Store newly created elements in the component to which the
surface belongs.

Current
Store newly created elements in the "current" active component.

Valid only for model controls.

Mesh Connectivity Determines how newly created elements and any adjacent existing
elements are connected.

Keep
Use existing nodes on any shared boundary edges.

Redo
Re-seed existing nodes along the boundary of the newly created
mesh to optimize mesh quality.

Break
Ignore existing adjacent elements and generates mesh
according to the element size and type you specified.

Valid only for model controls.

Flow

Align Produces a more orthogonal quad-dominant mesh.

Only available when the Element Type is set to Mixed.
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Parameter Description

Figure 871: Flow Alignment Off

Figure 872: Flow Alignment On
Notice a straighter row of elements is produced.

Mapping

Size Keeps elements roughly the same size.

Skew Prevents mesh from producing highly-skewed elements.

Other - Surface Based Automeshing Only

Link Opposite Edges Links mesh settings on opposing edges of rectangular surfaces.
Changes applied to one linked edge will be applied to the other. By
default, the maximum aspect ratio (AR) to allow between large and
small edge sizes of linked edges is 2.11.

Manually specify an aspect ratio by setting Aspect Ratio Less Than to
User Specified. Increasing the value adds more surfaces to the linked
chain, whereas decreasing the value removes some surfaces from the
linked chain.
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Parameter Description

Figure 873: Link Opposite Edges Selected

Figure 874: Link Opposite Edges Selected and Aspect Ratio Less Than = Auto

Figure 875: Link Opposite Edges Selected, Aspect Ratio Less Than = 8.0
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Features - Element Based Automeshing Only

Table 207: Parameters

Parameter Description

Auto Features Defines logical faces when using existing finite elements as a basis for
automeshing.

Connected
Detect features based on the specified feature angle, and make
additional effort to void any "orphan" or non-closed feature
lines.
It works similarly to Auto Detect, but includes a more rigorous
check to combine small areas and avoid creating features that
end abruptly or do not connect to any other features.

Figure 876: Refore Re-Meshing Figure 877: After Re-Meshing,
with Connected Features

Auto Detect
Detect features based on the specified feature angle.

Surface Edges
Automatically detect and utilize geometric lines associated with
selected elements as features in the re-meshing operation.
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Parameter Description

Figure 878: Before Re-Meshing Figure 879: After Re-Meshing,
with Surface Edges Selected

None
Ignore extra features defined by any of the above methods.

User Features A selection of user-created 1D elements which define features that
need to be captured along with any feature angle-based features. Only
1D elements should be selected here, as any other element selections
are ignored.

Anchor Nodes Nodes that will remain and be re-used in the new mesh. Anchor nodes
are "fixed" so that the automesher cannot move or replace them; in
essence, they are exceptions to the re-meshing operation, and the
new mesh must utilize them.

Surface Deviation
Generates mesh within the limits of element deviation from input elements.

Main Parameters

Table 208: Parameters

Parameter Description

Use Model Settings Set all of the main parameters from the model control.

For local controls only.

Minimum Size Minimum allowable element size.
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Parameter Description

When there are model and local mesh controls for surface deviation,
and the minimum size of neighboring mesh controls are different, the
minimum size will automatically propagate from the smaller mesh size
to neighboring surfaces.

Maximum Size Maximum allowable element size.

Growth Rate Determines how rapidly elements can increase in size as they are
created further and further away from features.

Figure 880: Growth Rate
Elements further from the features grow larger with each row.

Span Angle Controls the element size at curve input. The smaller the angle, the
more refined curvature will be and the more preserved the input shape
will be. By default span angle is 25.0 degrees.

Valid only for element-based controls

Figure 881: Span Angle
β is the span angle of the edge ab. The length of ab is less than 2R( sin β/2 ).
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Parameter Description

Feature Angle Determines which features to preserve. The mesher identifies features
internally and preserves/refine them based on the defined feature
angle.

Valid only for element-based controls.

Element Order First
Create elements using a linear shape function.

Second
Create elements using a polynomial shape function.

For local controls, this is inherited from the model control and cannot
be set independently.

Advanced Parameters

Table 209: Parameters

Parameter Description

Organization

Mesh Connectivity Determines how newly created elements and any adjacent existing
elements are connected.

Keep
Use existing nodes on any shared boundary edges.

Redo
Re-seed existing nodes along the boundary of the newly created
mesh to optimize mesh quality.

Break
Ignore existing adjacent elements and generates mesh
according to the element size and type you specified.

Valid only for model controls.

Features - Element Based Automeshing Only

Table 210: Parameters

Parameter Description

Auto Features Defines logical faces when using existing finite elements as a basis for
automeshing.
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Parameter Description

Connected
Detect features based on the specified feature angle, and make
additional effort to void any "orphan" or non-closed feature
lines.
It works similarly to Auto Detect, but includes a more rigorous
check to combine small areas and avoid creating features that
end abruptly or do not connect to any other features.

Figure 882: Refore Re-Meshing Figure 883: After Re-Meshing,
with Connected Features

Auto Detect
Detect features based on the specified feature angle.

Surface Edges
Automatically detect and utilize geometric lines associated with
selected elements as features in the re-meshing operation.
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Parameter Description

Figure 884: Before Re-Meshing Figure 885: After Re-Meshing,
with Surface Edges Selected

None
Ignore extra features defined by any of the above methods.

User Features A selection of user-created 1D elements which define features that
need to be captured along with any feature angle-based features. Only
1D elements should be selected here, as any other element selections
are ignored.

Refine Features Apart from capturing the features if refine feature is turned enabled,
you can define the mesh size to be applied to features selected/found
by any of the above methods.

Rigid Body Mesh
Generates mesh to represent the topology of a rigid object. Available only for surface-based meshing.

Main Parameters

Table 211: Parameters

Parameter Description

Use Model Settings Set all of the main parameters from the model control.

For local controls only.

Minimum Size Minimum allowable element size.
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Parameter Description

Maximum Size Maximum allowable element size.

Maximum Deviation Allowable deviation between the element edge and the surface edge.
To meet this requirement, element edge lengths along a curved
surface edge are reduced as needed down to a lower limit set by the
minimum element size.

Maximum Feature Angle Maximum angle across which elements can be maintained. When two
adjacent elements’ normals exceed this angle, a new set of nodes is
created between them to maintain clean feature lines. Using higher
value results in elements spanning the feature line.

Figure 886:
With an appropriate value, the features lines are preserved.

Figure 887:
If the feature angle is too high, the feature lines are blurred.

Element Type Type of elements used to create mesh during automatic meshing.

For more information, see Mesh Types.

Element Order First
Create elements using a linear shape function.

Second
Create elements using a polynomial shape function.
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Parameter Description

For local controls, this is inherited from the model control and cannot
be set independently.

Advanced Parameters

Table 212: Parameters

Parameter Description

Organization

Destination Component Original
Store newly created elements in the component to which the
surface belongs.

Current
Store newly created elements in the "current" active component.

Valid only for model controls.

Refinement
Refinement controls allow the definition of element refinement based on geometry, proximity and angle.

This is supported only for surface deviation meshing.

Geometric
Geometric refinement mesh controls define the refinement size of selected entities on the following
types of geometry: points, lines and surfaces.

Note:  Geometric refinement mesh controls only apply to surface deviation meshing
(surface-based only).

Table 213: Parameters

Parameter Description

Refinement Size Element size applied to selected entities.
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Parameter Description

If the refinement size is less than the minimum size defined by
the model mesh control, then the minimum size will override the
refinement size.

Proximity
Proximity refinement mesh controls define refinement based on the proximity of surfaces and elements.

Note:  Proximity refinement mesh controls only apply to Surface Deviation meshing (both
surface and element based).

Table 214: Parameters

Parameter Description

Maximum Search Angle Defines the maximum normal angle between elements and surfaces to
be considered for the proximity candidate search.

Maximum Proximity Distance Performs refinement if the surfaces/elements proximity is below this
value.

Minimum Proximity Distance Performs refinement if the surfaces/elements proximity is above this
value.

Proximity Within Defines how the proximity search should be performed.

Local Selection Only
Check the proximity refinement candidates within the selection
of this mesh control only.

Local and Model Selections
Check the proximity refinement candidates within the selection
of this mesh control and the model mesh control.

Proximity Check Direction Defines the direction in which to consider proximity.

Along Normal
Consider only surfaces/ elements which facing same normal for
the proximity candidate search.

Inverse Normal
Consider only surfaces/ elements which facing opposite normal
for the proximity candidate search.

Both Sides
Consider any normal orientation of surfaces/elements for the
proximity candidate search.
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Parameter Description

Volume Outward
Consider outwards direction of the solids for the proximity
candidate search.

Volume Inward
Consider inwards direction of the solids for the proximity
candidate search.

Refinement Method Method used to refine proximity elements.

Constant Size
Refine the close proximity candidates with the defined constant
size.

Size/Proximity Ratio
Refine the close proximity candidates based on the proximity
of the input. Refinement size = ratio * proximity distance.
For example, if the proximity distance between two surface/
element faces is 10, and a ratio of 0.1 has been defined, then a
refinement size of 1 will be applied to the proximity area. Thus
refinement will vary based on the variation of the proximity
distance. This is very useful when you want a certain number of
tetra layers in close proximity areas.

Proximity Curve
Populate a table of proximity verses refinement sizes. All the
intermediate values will be interpolated.

Angle-Based
Angle-based refinement mesh controls define refinement based on the angle between entities.
Surfaces/elements selected to be defined by this mesh control will be refined if they fall within the
threshold angle limit.

Note:  Angle-based refinement mesh controls only apply to surface deviation meshing (both
surface and element-based).

Table 215: Parameters

Parameter Description

Direction Defines the concave or convex angle with any direction to be refined.
Convex and concave angles are related to a polygon and measured
between surfaces/element faces. If Both is selected, both types of
angles will be refined.
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Parameter Description

Figure 888:

Minimum Angle Limit Minimum angle limit. The Refinement Size specified below this
parameter in the Entity Editor will be assigned this angle.

Maximum Angle Limit Maximum angle limit. The Refinement Size specified above this
parameter in the Entity Editor will be assigned this angle.

Feature
Feature mesh controls define the mesh density and quality of specific geometric features. These can be
used to generate a high quality tria mesh on supported feature types.

Feature controls can be run standalone by right-clicking on the Feature folder and selecting the Mesh
operation from the context menu. In this scenario:

• If a feature global control only exists, on-the-fly selection is prompted.

• If a feature body control only exists, it must have a pre-defined selection and on-the-fly selection is
not allowed.

• If both a feature global and body control exist, the body control will always be used and the global
control will be ignored.

Feature controls can also be utilized along with other Surface Mesh controls by right-clicking on the
Surface Mesh folder and selecting the Mesh operation from the context menu. In this scenario:

• A surface mesh model control is required.

• The selection strictly comes from the surface mesh model control, either as a pre-defined selection
or on-the-fly.

• Only the surface mesh model control selection that overlaps with any feature selection (including
body or local controls) is considered.

• Feature global control will always be ignored in this case.
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It is recommended that feature controls be run standalone. Combined usage with other surface mesh
controls may result in a non-conformal mesh.

Global and Body
Global mesh controls define the mesh for all geometry in the model, whereas body mesh controls define
the mesh of selected local bodies.

Mesh Size Parameters

Table 216: Parameters

Parameter Description

Average Element Size The 2D element size in the model which controls the average element
size.

Minimum Element Size Minimum length of elements to generate in the mesh.

Coarse Mesh Reduces the number of solid elements and the number of nodes. On
an average, coarse mesh generates about 20 percent less nodes/
elements compared to a regular volume mesher.

Use Maximum Element
Size

Define the maximum element size instead of the average element
size. Maximum element size = 1.4 * Average element size.

Only available for Global mesh controls.

Geometry Curvature Parameters

Table 217: Parameters

Parameter Description

Maximum Angle per
Element

The approximation of a geometry is related to the angle made by
an element edge on a perfect circle. For example, if the angle is
45 degrees this will approximate a circle by 8 elements. This same
measurement is extended to an arbitrary curved surface.

Curvature Minimum
Element Size

The mesh approximates the geometry by varying the mesh size as a
function of the curvature. This geometry approximation cannot result
in a mesh size smaller than the Curvature minimum element size.
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Mesh Quality Parameters

Table 218: Parameters

Parameter Description

Aspect Ratio Determines the quality of the mesh. The value varies from 1
(equilateral element) to infinity (flat element). The default aspect
ratio value is 10.

Mesh Grading The variation of the mesh in the face from the boundary to the
interior is controlled by the surface mesh grading. The default value
is 1.5.

Mesh Type Parameters

Table 219: Parameters

Parameter Description

Element Type Use Tria3 or Tria6 elements to create mesh.

Project Mid-node Enables the projection of mid-nodes onto the faces and edges of the
geometry.

Mesh Pattern Determines the mesh pattern.

Auto
Determine the faces that will be isomeshed automatically. All
regular four edged faces and faces that are four sided will be
isomeshed.

Regular 4-Sided Faces
Isomesh all regular four edged faces, even if the edges are not
of similar size.

None
Force a free mesh on all faces in the body, even if it is a regular
four edged face.

Cylinder
Cylinder mesh controls define the mesh both axially and in circular direction on selected cylindrical
surfaces.
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Figure 889: Cylinder

Table 220: Parameters

Parameter Description

Axial Mesh Size Define the element size along the length of the selected cylindrical faces.

Divisions The number of nodes along the circular direction of the cylindrical face
can be controlled by specifying the number of circular mesh seeds.

Edge
Edge mesh controls define the mesh on an edge.

Table 221: Parameters

Parameter Description

Divisions Edge seeds are applied by specifying the number of elements.

Face
Face mesh controls define the mesh on the selected local faces. A uniform mesh is generated on the
face that has the face mesh control specified. The curvature is ignored.

Mesh Size Parameters

Table 222: Parameters

Parameter Description

Average Element Size The 2D element size in the model which controls the average element
size.
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Parameter Description

Minimum Element Size Minimum length of elements to generate in the mesh.

Geometry Curvature Parameters

Table 223: Parameters

Parameter Description

Maximum Angle per
Element

The approximation of a geometry is related to the angle made by
an element edge on a perfect circle. For example, if the angle is
45 degrees this will approximate a circle by 8 elements. This same
measurement is extended to an arbitrary curved surface.

Curvature Minimum
Element Size

The mesh approximates the geometry by varying the mesh size as a
function of the curvature. This geometry approximation cannot result
in a mesh size smaller than the Curvature minimum element size.

Mesh Quality Paraemters

Table 224: Parameters

Parameter Description

Aspect Ratio Determines the quality of the mesh. The value varies from 1
(equilateral element) to infinity (flat element). The default aspect
ratio value is 10.

Mesh Grading The variation of the mesh in the face from the boundary to the
interior is controlled by the surface mesh grading. The default value
is 1.5.

Use Local Uses the local settings when enabled. The settings from the global
control will be used when disabled.

Fillet
Fillet mesh controls define the mesh over fillets along the length and the curve direction. You can apply
fillet mesh controls to selected faces or bodies.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1950

Figure 890: Fillet

Axial Mesh Size Parameters

Table 225: Parameters

Parameter Description

Length Along Fillet Defines the element length along the length of the fillet.

Geometry Curvature Parameters

Table 226: Parameters

Parameter Description

Specification Defines the element size along the fillet curvature direction.

Number
Enables the Number of Elements option to explicitly indicate
the number of elements along the curvature direction.

Curvature
Enables the Maximum Angle per Element and Curvature
Minimum Element Size options for defining the mesh based on
these values.

Mesh Quality Parameters

Table 227: Parameters

Parameter Description

Ignore Fillet Width Less
Than

Specifies the minimum fillet width to consider. Fillets with a width
below this value are ignored.

Aspect Ratio Determines the quality of the mesh. The value varies from 1
(equilateral element) to infinity (flat element). The default aspect
ratio value is 10.
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Parameter Description

Merge Small Fillets Merges adjacent small fillets before meshing in order to improve the
mesh quality.

Adjust Axial Length to
Aspect Ratio

Adjusts the length along the fillet to make sure that the aspect ratio
is satisfied.

Imprint Circle
Imprint circle mesh controls create a circular edge on a face with specified radius and seeds.

Mesh Seeds Parameters

Table 228: Parameters

Parameter Description

Radius Calculated using radius and scale factor values.

Scale Scales the user defined radius by this factor.

Divisions Number of seeds along the circle.

Center Parameters

Table 229: Parameters

Parameter Description

Circle Center Defines the center of the circular edge.

Isoline
Isoline mesh controls place mapped mesh on cylindrical/conical faces that are trimmed. The mapped
mesh is created for a given size/seed in axial and circular directions.

Axial Mesh Size Parameters

Table 230: Parameters

Parameter Description

Specification Defines the given size/seed in axial and circular directions to create
the mapped mesh.
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Geometry Curvature Parameters

Table 231: Parameters

Parameter Description

Specification The number of nodes along the circular direction can be controlled by
using maximum angle or mesh seeds.

The maximum angle refers to the angle subtended by a circular
spanning element edge from the axis of cylindrical face.

Merge Faces Merges selected faces to a single face. Use this parameter to avoid
the creation of a thin layer of elements when meshing.

Mesh Quality Parameters

Table 232: Parameters

Parameter Description

Aspect Ratio Determines the quality of the mesh. The value varies from 1
(equilateral element) to infinity (flat element). The default aspect
ratio value is 10.

Curvature Minimum
Element Size

The mesh approximates the geometry by varying the mesh size as a
function of the curvature. This geometry approximation cannot result
in a mesh size smaller than the Curvature minimum element size.

Preserved Entity
Preserved Entity mesh controls define the features to preserve while meshing. Tiny features on edges or
surfaces may be collapsed if the minimum element size is larger than the feature. Entities selected here
will be preserved from such collapsing.

Symmetry
Symmetry mesh controls are used to get identical mesh between the master face and symmetry face. If
there are any discontinuous edges, select three nodes/vertices for both the master and symmetry face.

Table 233: Parameters

Parameter Description

Master Surface Defines the surface to considered as the master/source for reflecting the
mesh.
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Parameter Description

Symmetry Surface Defines the surface to considered as the slave/target for reflecting the
mesh.

Master Points Defines points on the Master surface to be mapped in case there are any
discontinuous edges.

Symmetry Points Defines points on the Symmetry surface to be mapped in case there are
any discontinuous edges.

Washer
Washer mesh controls define rings around a circle. The circle has to be inside of a face.

Figure 891: Washer

Table 234: Parameters

Parameter Description

Washer Width Define the width of the washer around the circle.
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Parameter Description

Number of Layers Defines the number of mesh layers to create around the circle.

Adaptive Wrap Mesh Controls
Model, local, proximity and leak detection mesh controls for adaptive wrap meshing.

Optional automatic surface re-meshing of the wrapping result ensures good surface mesh quality.

Model and Local
Model and local controls define the wrap type, wrap selection, and wrap settings. Local controls defines
wrap settings and will override those defined in the model control.

Note:  In order to run a meshing job, at least one model mesh control must be defined.
For surface/region selection, all mesh controls created for adaptive wrapper should have
surface/region selection only. Mesh controls with component and surface selection will not be
compatible.

Wrap Selection

Table 235: Parameters

Parameter Description

Wrap Type Specifies whether to wrap the exterior or cavity of the selected entities.

Wrap Selection Specifies which volumes to wrap.

All
Wrap all of the volumes in the model.

Wrap Enclosed
Wrap the volumes enclosed by the defined nodes and ignores the
remaining volumes.

Wrap Nth Largest
Specify the volume to be wrapped by specifying the wrap size index
in terms of volume size. To wrap the largest volume, enter 1 in the
wrap size index field; to wrap the second largest volume, enter 2 in
the wrap size index field.
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Parameter Description

Exclude Enclosed
Ignore the volume(s) enclosed by the defined nodes and wraps the
remaining volumes.

Wrap Mesh

Table 236: Parameters

Parameter Description

Average Element Size The 2D element size in the model which controls the average element size.

Minimum Element Size Minimum element size to be used to control how features are refined.

Define the minimum element size accordingly to precisely preserve
features.

Feature Edges Specifies which features in the model to refine.

All
Extract features based on the defined feature angle. Open or closed
loop features are considered and can be extracted.

Connected
Extract features based on the defined feature angle. Only closed loop
features are considered and can be extracted.

User Defined
Manually select features to refine. If you have a large model and do
not want to refine feature everything, this option is useful.

Hole Patch Tolerance Determine which holes to patch.

Closed loop free edges spanned within one or more components are
considered.

Gap Patch Tolerance Determine which gaps to patch.

If two components/element groups have a gap between them and
are within the gap patch tolerance, then the gap between them will
be patched. Override the functionality of the gap patch at specific
components/element groups by defining a proximity control for them.

Baffle Thickness Define the thickness assigned to baffles in the model. A baffle represents
open – zero thickness shell face. Baffle thickness parameters inflate the
baffle with defined thickness during wrapping.
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Parameter Description

Organize as Input
Components

Split wrapped elements so that they are organized based on input
components.

Duplicate naming is not allowed, therefore wrapped components will be
named the original component name followed by _Wrap. If this option is
not enabled, a component called Adaptive Wrapper will be created and will
contain all wrapped elements.

Remesh after Wrapping Remesh the entire wrapped component with the defined growth rate and
span angle. The element size used for remeshing will be automatically
detected.

If this parameter is enabled along with the parameter organize wrap
elements by base comps, then wrapped components will be remeshed and
named with the original component name followed by _Wrap_Remesh.

Separate assemblies will be created for wrapped and remeshed
components.

Refinement

Table 237: Parameters

Parameter Description

Element Average Size Refine based on the average element size in the model.

Curvature Based Specify a maximum chordal deviation, which determines which features
are refined. When this parameter is disabled, features will not be refined
even though features are defined in wrapper parameters.

Global Proximity
Refinement

Enable proximity refinement at a global level. All input elements for
proximity refinement within the defined tolerance are considered. If this
parameter is disabled, proximity refinement at a global level will not take.

Intersection Line Refine wrapped mesh at the intersecting lines of input elements.

Rough patch smoothing Smooth out rough/zig-zag patches which are a result of the wrapper. This
option will only operate on rough patches, and preserves features as much
as possible.
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Parameter Description

Figure 892: Rough Patch Smoothing Off Figure 893: Rough Patch Smoothing On

Proximity
Proximity mesh controls define element refinement based on proximity. Use proximity mesh controls to
avoid contact between selected components and any refinement gaps between them.

Global and local proximity mesh controls can be defined. Global proximity mesh controls can only be
created from the Adaptive Wrap > Model > Refinement section, whereas local proximity mesh controls
can only be created from the Adaptive Wrap > Proximity section.

Table 238: Parameters

Parameter Description

Group Selection Determines how proximity is defined.

Within Group
Consider proximity refinement for all of the components/surfaces/
regions you selected as long as the gap or proximity between the
components is above the specified Proximity Tolerance.

Across Group
Only consider proximity refinement for all components/surfaces/
regions across Group 1 and Group 2 as long as the gap or proximity
between the components is above the specified Proximity Tolerance.
Proximity for the components within one group will not be
considered.
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Parameter Description

Note:  For surface/region selection, all mesh controls created
for adaptive wrapper should have surface/region selection only.

Proximity Tolerance Resolve all proximity above this value.

Self Proximity Refine the proximity of elements within one component above the
Proximity Tolerance. Only available when Group Selection is set to Within
Group.

Leak Detection
Leak detection mesh controls check if the resulting wrapped surface mesh creates a desired cavity
before the wrapping process starts. For example, for an external aero/underhood analysis, leak
detection mesh controls can help make sure a cabin, engine, and fuel tank are properly sealed,
prohibiting mesh from being created there.

Once leak detection mesh controls are defined, right-click on the Adaptive Wrap folder and select Run
Leak Detection. Depending upon the model size and parameters defined, leak detection can take
several minutes.

Table 239: Parameters

Parameter Description

Enclosed Node Define the node within shells to be enclosed by the wrapper. This node
should be enclosed by a possible volume.

Destination Nodes Destination nodes enable leak detection paths to be found between the
enclosed node and destination nodes. 1D elements are generated to show
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Parameter Description

the leak detection path. If a leak detection path is not found, 1D elements
will not be generated.

Volume Meshing Mesh Controls
Model, local and volume selector mesh controls for volume meshing.

Model
Model mesh controls define boundary layer and/or tetrameshing parameters.

BL + Tetra
BL + Tetra model mesh controls define boundary layer and tetrameshing parameters.

Entity Selection Parameters
In the Entities field, use the entity selector to select the entities that the mesh control applies to.
The following entities can be selected using the entity selector:

• Components

• Elements

• Regions (solid selection only)

• Solids

Note:  If you have changed your selection to solid or region in model volume mesh
controls, existing local controls that have elements or components selected will be
made inactive. Any new local mesh controls will have surfaces set for their default
selection.

If regions are selected, final volume mesh controls will be placed in a component with
the same name as the region.

Meshing will only work if surfaces or solids have mesh associated with them.

Boundary Layer Parameters
Available parameters vary depending on the Method you select: Simple, Advanced, User Defined.
For Simple and Advance mesh controls, refer to Link to CFD Tetramesh Panel.

Table 240: Parameters

Parameter Description

Basic Surface Mesh
Treatment

Fixed
Prohibit selected elements from being modified.
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Parameter Description

Float
Enable 2D base elements to be modified, if necessary. Generally
2D base elements with NoBL are modified when refinement
zones are defined and/or when the BL imprints on them.

BL Definition When enabled, parameters will be editable and will be applied to all
selections. When disabled, a BL definition will not be applied at model
level.

Local controls will override the BL definition at the model level.

First Layer Thickness Specify the thickness of the first boundary layer.

First Layer Thickness
Method (A)

Constant
Enable a constant thickness to be defined for the first boundary
layer of the selection.

As Factor of Base 2D Elements
Enable a factor, which will be multiplied by the average element
size, to be defined. The first layer height for each element
equals the average element size multiplied by the factor. This
option is useful when the size of 2D elements varies significantly
and a constant first layer height is not needed. With this factor,
a smooth BL to tetramesh transition for all elements can be
achieved.

Figure 894: First Layer Thickness Method (A)

Growth Rate Determine how rapidly elements can increase in size as they are
created further and further away from features.
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Parameter Description

Figure 895: Growth Rate

Elements further from the features grow larger with each row.

BL Growth Rate Method
(A)

Constant
Enable a constant ratio to be defined, which determines how
boundary layers grow.

Acceleration
Enable a growth acceleration for boundary layers to be defined
beyond the first few layers. This option acts as a growth rate
on the growth rate, but only after the first few initial boundary
layers. A Start Acceleration from Layer must be defined first,
and then from that layer the acceleration will be started. An
Acceleration to the initial growth rate and a Maximum Growth
Rate must also be defined.
By default, the first two boundary layers grow by the growth
rate described above. However, subsequent layers grow by the
growth rate multiplied by the acceleration factor. Thus, if d is
the initial thickness, r is the initial growth rate, and a is the
acceleration rate, then the thicknesses of the successive layers
are d, d*r, d*r*(r*a), d*r*(r*a)^2, and so on.

Aspect Ratio Based
Enable the growth rate definition for boundary layers to be
based on the defined aspect ratio of the final layer. After the first
few initial boundary layers, if this type of growth rate method is
selected, the rest of the BL will grow to achieve the user defined
Final layer height / base ratio.

BL Thickness Control
(UD)

Enable this option to enter either the Number of layers or the Total BL
thickness.
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Parameter Description

Second Group (UD) Help to get a smooth transition between BL layers and the tet core
more quickly, by defining a higher growth rate.

Final Layer Height/Base
Ratio

Define the ratio between the total boundary layer thickness and the
average element size of the base surface elements.

BL Stopping Criteria (A) Determine what to do when BL has reached the defined criteria for
Final Layer Height/Base Ratio.

Chop Off Layers
Chop off the BL if elements reach the aspect ratio criteria.

Keep Growing Gr=1
Allow the BL to grow until the neighboring elements begin to
grow, even if elements reach the aspect ratio criteria with GR
=1.

Number of Layers (S) Define the total number of layers to be generated using the specified
first layer thickness and growth rate.

Hexa Transition Mode Simple Pyramid
Transition from a BL hexahedral’s quad face to a tetrahedral
core mesh using one pyramid element. The height of pyramid
elements is controlled by a simple transition ratio parameter,
which represents the ratio between the transition pyramid height
and the characteristic size of the base quad.

All Prism
Split quad elements in the surface mesh into two trias each
so that there will be no need to transition from quad faces to
tria faces when transitioning from the last boundary layer to
the tetrahedral core. This mode is very important when there
are quad elements on areas with (low) distributed BL thickness
ratios, because in such areas the thickness of the transition
elements, for example simple pyramid, was not taken into
account when doing the interference study to assign distributed
BL thickness ratio to those elements.

All Tetras
Generate tetra elements only in the boundary layer and splits
the quad elements of the surface mesh into tria elements.

Boundary Layer Only Generate only the boundary layer, stopping before the tetrahedral
core is generated. Adjacent surface meshes are also modified to
reflect changes introduced by the boundary layer thickness. A collector
named ^CFD_trias_for_tetramesh is created and is typically used
to generate the inner core tetrahedral mesh using the Tetramesh
parameters subpanel.
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Parameter Description

Boundary layer elements are placed in a collector named
CFD_boundary_layer; core tetrahedral elements are placed in
a collector named CFD_Tetramesh_core. Both collectors are
automatically created if they do not exist. However, if these collectors
do exist, it is recommended that you empty them before meshing;
otherwise there will be more than one set of elements occupying the
same physical volume. If you mesh the volume in several steps (multi-
volume meshing), it is recommended that you empty the collector
before generating the mesh for the next adjacent volume.

Core Mesher Parameters
Available options will direct how the core domain should be meshed. All options will also rely on
option in “Tetra Mesh” section.

Table 241: Parameters

Parameter Description

Core Mesh Tetra Mesh
Will create tetra mesh in core.

Hex Dominant
Will create hex elements in core and create pyramids/
tetrahedral in transition region. All elements will have conformal
connectivity.
Core Hex elements will be created based on user defined Hexa
Size. Height of tetra/pyramid transition region can be controlled
using Tet-core Layer Height Factor.

Octree Dominant
Will create octree elements in core and create pyramids/
tetrahedral in transition region. All elements except core octree
elements will have conformal connectivity.
Core Octree elements will be creates based on user defined
Max Octant Size and Min Octant Size. Height of tetra/pyramid
transition region can be controlled using Tet-core Layer Height
Factor.
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Figure 896: Core Octree Element

Tetra Mesh Parameters
The tetramesher is multi-threaded and will utilize available threads for meshing similar. This
behavior is similar to that of boundary layer meshing.

Table 242: Parameters

Parameter Description

Element Size Limits Specify the average, minimum, maximum, or minimum/maximum size
of the tetramesh.

None
The maximum element size will be determined by the input 2D
elements size and growth rate.

Average Size
Enter the average element size for the tetramesh. If you enter
10, the element sizes will range between 6.6 and 14.

Maximum Size
Tetra element will not be above this size.

Minimum Size
Tetra elements will not be below this size.
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Minimum/Maximum Size
Tetra elements will not be below or above this size.

Maximum element size guidelines:

• When the input shell element size is close to the user defined
maximum tetra size, then the maximum tetra size is used in
averaged sense (therefore the actual maximum size may be
larger than defined). This prevents a large number of elements
from being created.

• When the input shell element size is sufficiently different then
the user defined maximum tetra size, the maximum size will be
enforced.

Quality Normal
Use the standard tetra-meshing algorithm.

Optimize Speed
Use an algorithm for faster meshing. Use this option if element
quality considerations are less important than mesh generation
time.

Optimize Quality
Spend more time optimizing element quality, and employs the
volumetric ratio, or CFD skew measurement for tetras as a
quality measure. Use this option if your solver is sensitive to
element quality.

Tetra Mesh Method Select a tetra mesh method:

Delaunay
Enable a mesher, which is implemented based on the delaunay
approach. This method is recommended for improved
performance.

Advancing Front
Enablesthe legacy tetra mesher.

Octree Based
Enable an octree structured based tetrameshing. Smoothing
near boundaries will be performed with this method.

Growth Rate The Growth rate parameter works as follows: if d is the initial
thickness and r is the initial growth rate, then the thicknesses of the
successive layers are d, d*r, d*r^2, d*r^3, d*r^4, and so on.

If element quality is important and you are not concerned with the
total number of elements being created, then Interpolate will produce
the best results because the element size changes smoothly and
therefore the element quality is better.
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Different default values are specified for the various growth rate
options:

Standard
1.2

Aggressive
1.35

Gradual
1.08

Interpolate
1.08

User Controlled, Octree based, Delaunay
Define your own value when you select this option.

Tetramesh Height Factor
Near Boundary

The Delaunay method allows options to control the height of tetra
mesh near boundary. Tetra transition from boundary layer or surfaces
can be controlled using this factor.

Figure 897: Height Factor = 1

Figure 898: Height Factor = .5
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Pyramid Transition Ratio Define the relative height of pyramid elements used for the transition
from hexa elements in the boundary layer to the tetra elements in the
core.

Smoothing Apply an extra stage of calculation to improve overall mesh quality.
Additional smoothing and swapping steps will be performed and tetra
elements will be split to achieve a smoother mesh transition. If tetra
elements are used in the boundary layer, then those elements will be
excluded from smoothing to maintain the original distribution.

Use Number of Layers Define the number of tetrahedral layers to generate.

When enabled, the Tetramesher ensures the tetracore contains, at
minimum, the specified number of tetra layers in the model. This
functionality ensures a certain mesh resolution in case of close
proximity or thin channels.

When generating multiple tetrahedral layers, keep the following
restrictions in mind:

• Do not generate more than three or four layers, unless you refine
the surfaces to have a fine mesh at close proximity areas.

• Layer meshes will not be created near narrow strip surfaces, as
the current algorithm does not alter the surface mesh given.

Advanced Parameters

Table 243: Parameters

Parameter Description

Boundary Layer Propagation

Treatment at Sharp
Edges

Node collapse
Collapse BL at baffles or sharp corners below the defined angle.

Figure 899: Node Collapse
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The baffle is colored yellow.

Multiple normal
Grow multiple normals around baffles or sharp corners below the
defined angle. If two adjacent elements enclose an angle smaller
than the threshold (sharp edge pointing into the volume),
normals will be computed on that edge and the boundary layer
will consider those normals.

Figure 900: Multiple Normal
The baffle is colored yellow.

Sharp Edge Angle Define the threshold of angles below which the BL should be collapsed.

Minimum Imprint Angle
from BL to Non-BL

Control which cases to imprint BL entities on without BL components.
If the angle between the BL component and the non BL component
is high, imprinting will create high aspect ratio elements. If the angle
between BL and Non-BL entities (component elements) is less than
the imprint angle or greater than (180-imprint angle), then the BL will
collapse rather than imprinting on non-BL entities.

Recommended range: 6-10

Max Layer Difference
Between Neighbors

Control the maximum layer difference between neighboring elements.
This parameter helps avoid situations where all BLs collapse at once,
and also provides smooth BL transitions in cases of BL truncation. A
good value for this parameter is 1/4 of the total BL layers. The value
specified also depends on layer height.

Recommended range: Depends on how many layers you are growing.

Proximity

Maximum BL
Compression

Enable BL compression, or squeezing, when there is not enough space
available for the BL to grow. The BL will try to compress by the max
BL compression factor first. For example, if the original total BL height
is defined as 1, with a 0.4 max BL compression, the BL layers will try
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to be compressed until 0.6 of the total height is reached. Once the BL
is compressed to this value, the mesher will start chopping off layers if
there is not enough space.

A value of zero enforces no BL compression, which is useful when you
want to maintain the BL height; a value of one enables the maximum
possible compression.

Recommended range: 0-0.6

Minimum BL Thickness/
Base Ratio

Due to close proximity, the BL will sometimes only be able to generate
one to two layers (a very small total BL height at that location). At
that location, it might be possible that the transition between BL layers
and the tetra core is bad. With this factor, if the total BL height is less
than the defined factor base size, all of the BL layers will be chopped
off.

By default, this value is zero, which disables the effects of this
parameter.

Minimum Tetcore/Final
Layer Height Ratio

Control the minimum height of the tet core as a factor of the final
layer height.

After creating the BL in close proximity, there will be a small space
available for tetramesh. This results in high aspect ratio tetra
elements.

Recommend value: 1.3 (default)

Boundary Layer Quality

Generation Method Controls the growth of boundary layers.

Optimize Quality
Use a set of meshing parameters, which ensures a good quality
boundary layer in most cases.

Optimize Speed
Choose meshing parameters in a way that the meshing time is
minimized and an acceptable boundary layer quality is achieved.

Maximum Cell Skewness Chop off BL cells exceeding the defined maximum cell skewness. This
parameter prevents the generation of highly skewed elements.

The tetra mesher sometimes creates better quality elements compared
to the BL mesher. If your input 2D mesh has bad element quality and
topology, it is recommended that you define a higher value.

Recommended range: 0.8 - 0.95
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Minimum Normalized
Jacobian

Chop off BL cells exceeding the defined minimum normalized Jacobian.
This parameter prevents the generation of negative elements.

Recommended range: 0.05 - 0.2

Tetra Quality

Element Quality Target Select an element criteria and threshold. After the tetrameshing
step, a mesh optimization step will be performed to fulfill the defined
threshold for the selected element criteria.

Available quality criteria include: Volume Skew, Tetra Collapse, and
Cell Squish.

Volume Setup

Validate 2D Input Check BL elements before tetrameshing to rectify if there is anything
wrong with the input (intersecting elements) provided for the
tetramesh.

Fix Invalid 2D Element Fix invalid elements (at present only unoffsettable nodes) before
volume meshing.

For unoffsettable nodes (where BL collapses if not smooth), the
connected elements will be smoothed where the BL will be generated.

Fix Component
Boundaries

Anchor nodes are maintained during CFD tetrameshing, so that the
new mesh adheres to them. 1D elements can be selected instead of
nodes if you need a tetra element edge at a certain location. Select
this option when certain mesh nodes or edges are required on a
certain location, such as for post-processing purposes.

If the Float option is selected for some boundary regions, surface shell
edges will be swapped during mesh generation. However, this prevents
the swapping of edges between two components.
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Figure 901:

Update Input Shells Automatically update the shells on all boundaries after meshing.
Updated shell elements are placed in the initial boundary shell
components.

Fill Void Mesh all volumes. If your geometry includes volumes inside of another
volume, enable this parameter.

For example, if you had a sphere inside of a larger sphere, enabling
this parameter would cause the volume of the inner sphere as well as
the volume between the two spheres to be meshed.

Other

Anchor Node Node that will remain and be re-used in the new mesh. Anchor nodes
are "fixed" so that the automesher cannot move or replace them; in
essence, they are exceptions to the re-meshing operation, and the
new mesh must utilize them.

Tetra
Tetra mesh controls define tetrameshing parameters.

Entity Selection Parameters
In the Entities field, use the entity selector to select the entities that the mesh control applies to.
The following entities can be selected using the entity selector:
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• Components

• Elements

• Regions (solid selection only)

• Solids

Note:

If you have changed your selection to solid or region in model volume mesh controls,
existing local controls that have elements or components selected will be made
inactive. Any new local mesh controls will have surfaces set for their default selection.

If regions are selected, final volume mesh controls will be placed in a component with
the same name as the region.

Meshing will only work if surfaces or solids have mesh associated with them.

Tetra Mesh Parameters

Table 244: Parameters

Parameter Description

Base Surface Mesh
Treatment

Fixed
Prohibit selected elements from being modified.

Float
Modify 2D base elements, if necessary. Generally 2D base
elements with NoBL are modified when refinement zones are
defined and/or when the BL imprints on them.

Element Size Limits Specify the average, minimum, maximum, or minimum/maximum size
of the tetramesh.

None
The maximum element size will be determined by the input 2D
elements size and growth rate.

Average Size
Enter the average element size for the tetramesh. If you enter
10, the element sizes will range between 6.6 and 14.

Maximum Size
Tetra element will not be above this size.

Minimum Size
Tetra elements will not be below this size.

Minimum/Maximum Size
Tetra elements will not be below or above this size.

Maximum element size guidelines:

• When the input shell element size is close to the user defined
maximum tetra size, then the maximum tetra size is used in
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averaged sense (therefore the actual maximum size may be
larger than defined). This prevents a large number of elements
from being created.

• When the input shell element size is sufficiently different then
the user defined maximum tetra size, the maximum size will be
enforced.

Quality Normal
Use the standard tetra-meshing algorithm.

Optimize Speed
Use an algorithm for faster meshing. Use this option if element
quality considerations are less important than mesh generation
time.

Optimize Quality
Spend more time optimizing element quality, and employs the
volumetric ratio, or CFD skew measurement for tetras as a
quality measure. Use this option if your solver is sensitive to
element quality.

Tetra Mesh Method Select a tetra mesh method:

Delaunay
Enable a mesher, which is implemented based on the delaunay
approach. This method is recommended for improved
performance.

Advancing Front
Enablesthe legacy tetra mesher.

Octree Based
Enable an octree structured based tetrameshing. Smoothing
near boundaries will be performed with this method.

Growth Rate The Growth rate parameter works as follows: if d is the initial
thickness and r is the initial growth rate, then the thicknesses of the
successive layers are d, d*r, d*r^2, d*r^3, d*r^4, and so on.

If element quality is important and you are not concerned with the
total number of elements being created, then Interpolate will produce
the best results because the element size changes smoothly and
therefore the element quality is better.

Different default values are specified for the various growth rate
options:

Standard
1.2
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Aggressive
1.35

Gradual
1.08

Interpolate
1.08

User Controlled, Octree based, Delaunay
Define your own value when you select this option.

Tetramesh Height Factor
Near Boundary

Delaunay method allow option to control height of tetra mesh near
boundary. Tetra transition from boundary layer or surfaces can be
controlled using this factor.

Figure 902: Height Factor = 1

Figure 903: Height Factor = 0.5

Pyramid Transition Ratio Define the relative height of pyramid elements used for the transition
from hexa elements in the boundary layer to the tetra elements in the
core.
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Smoothing Apply an extra stage of calculation to improve overall mesh quality.
Additional smoothing and swapping steps will be performed and tetra
elements will be split to achieve a smoother mesh transition. If tetra
elements are used in the boundary layer, then those elements will be
excluded from smoothing to maintain the original distribution.

Use Number of Layers Define the number of tetrahedral layers to generate.

When enabled, the Tetramesher ensures the tetracore contains, at
minimum, the specified number of tetra layers in the model. This
functionality ensures a certain mesh resolution in case of close
proximity or thin channels.

When generating multiple tetrahedral layers, keep the following
restrictions in mind:

• Do not generate more than three or four layers, unless you refine
the surfaces to have a fine mesh at close proximity areas.

• Layer meshes will not be created near narrow strip surfaces, as
the current algorithm does not alter the surface mesh given.

Advanced Parameters

Table 245: Parameters

Parameter Description

Tetra Quality

Element Quality Target Select an element criteria and threshold. After the tetrameshing
step, a mesh optimization step will be performed to fulfill the defined
threshold for the selected element criteria.

Available quality criteria include: Volume Skew, Tetra Collapse, and
Cell Squish.

Volume Setup

Validate 2D Input Check BL elements before tetrameshing to rectify if there is anything
wrong with the input (intersecting elements) provided for the
tetramesh.

Fix Invalid 2D Element Fix invalid elements (at present only unoffsettable nodes) before
volume meshing.

For unoffsettable nodes (where BL collapses if not smooth), the
connected elements will be smoothed where the BL will be generated.
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Fix Component
Boundaries

Anchor nodes are maintained during CFD tetrameshing, so that the
new mesh adheres to them. 1D elements can be selected instead of
nodes if you need a tetra element edge at a certain location. Select
this option when certain mesh nodes or edges are required on a
certain location, such as for post-processing purposes.

If the Float option is selected for some boundary regions, surface shell
edges will be swapped during mesh generation. However, this prevents
the swapping of edges between two components.

Figure 904:

Update Input Shells Automatically update the shells on all boundaries after meshing.
Updated shell elements are placed in the initial boundary shell
components.

Fill Void Mesh all volumes. If your geometry includes volumes inside of another
volume, enable this parameter.

For example, if you had a sphere inside of a larger sphere, enabling
this parameter would cause the volume of the inner sphere as well as
the volume between the two spheres to be meshed.

Other

Anchor Node Node that will remain and be re-used in the new mesh. Anchor nodes
are "fixed" so that the automesher cannot move or replace them; in
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essence, they are exceptions to the re-meshing operation, and the
new mesh must utilize them.

Local
Local mesh controls define regions where boundary layers are desired, or are not desired.

No BL
No BL local mesh controls define components/elements on which boundary layers mesh is not required.

Entity Selection Parameters
In the Entities field, use the entity selector to select the entities that the mesh control applies to.
The following entities can be selected using the entity selector:

• Components

• Elements

• Regions (solid selection only)

• Solids

Note:

If you have changed your selection to solid or region in model volume mesh controls,
existing local controls that have elements or components selected will be made
inactive. Any new local mesh controls will have surfaces set for their default selection.

If regions are selected, final volume mesh controls will be placed in a component with
the same name as the region.

Meshing will only work if surfaces or solids have mesh associated with them.

Boundary Layer Parameters

Table 246: Parameters

Parameter Description

Basic Surface Mesh
Treatment

Fixed
Prohibit selected elements from being modified.
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Float
Enable 2D base elements to be modified, if necessary. Generally
2D base elements with NoBL are modified when refinement
zones are defined and/or when the BL imprints on them.

Local BL
Local BL local mesh controls define local boundary layer settings. Any settings defined in the model
mesh controls will be overridden with the BL settings defined in local mesh controls.

Entity Selection Parameters
In the Entities field, use the entity selector to select the entities that the mesh control applies to.
The following entities can be selected using the entity selector:

• Components

• Elements

• Regions (solid selection only)

• Solids

Note:

If you have changed your selection to solid or region in model volume mesh controls,
existing local controls that have elements or components selected will be made
inactive. Any new local mesh controls will have surfaces set for their default selection.

If regions are selected, final volume mesh controls will be placed in a component with
the same name as the region.

Meshing will only work if surfaces or solids have mesh associated with them.

Boundary Layer Parameters
Available parameters vary depending on the Method you select: Simple, Advanced, User Defined.

Table 247: Parameters

Parameter Description

Base Surface Mesh
Treatment

Fixed
Prohibit selected elements from being modified.

Float
Modify 2D base elements, if necessary. Generally 2D base
elements with NoBL are modified when refinement zones are
defined and/or when the BL imprints on them.

First Layer Thickness Specify the thickness of the first boundary layer.
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First Layer Thickness
Method

Constant
Define a constant thickness for the first boundary layer of the
selection.

As Factor of Base 2D Elements
Enable a factor, which will be multiplied by the average element
size, to be defined. The first layer height for each element
equals the average element size multiplied by the factor. This
option is useful when the size of 2D elements varies significantly
and a constant first layer height is not needed. With this factor,
a smooth BL to tetramesh transition for all elements can be
achieved.

Figure 905: First Layer Thickness Method

Growth Rate Determines how rapidly elements can increase in size as they are
created further and further away from features.

Figure 906: Growth Rate

Elements further from the features grow larger with each row.

BL Growth Rate Method Constant
Define a constant ratio, which determines how boundary layers
grow.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1980

Parameter Description

Acceleration
Define a growth acceleration for boundary layers beyond the
first few layers. This option acts as a growth rate on the growth
rate, but only after the first few initial boundary layers. A Start
Acceleration from Layer must be defined first, and then from
that layer the acceleration will be started. An Acceleration to the
initial growth rate and a Maximum Growth Rate must also be
defined.
By default, the first two boundary layers grow by the growth
rate described above. However, subsequent layers grow by the
growth rate multiplied by the acceleration factor. Thus, if d is
the initial thickness, r is the initial growth rate, and a is the
acceleration rate, then the thicknesses of the successive layers
are d, d*r, d*r*(r*a), d*r*(r*a)^2, and so on.

Aspect Ratio Based
Define the growth rate definition for boundary layers based on
the defined aspect ratio of the final layer. After the first few
initial boundary layers, if this type of growth rate method is
selected, the rest of the BL will grow to achieve the user defined
Final layer height / base ratio.

BL Thickness Control Enables this option to enter either the Number of layers or the Total BL
thickness.

Second Group Help to get a smooth transition between BL layers and the tet core
more quickly, by defining a higher growth rate.

Final Layer Height /
Base Ratio

Define the ratio between the total boundary layer thickness and the
average element size of the base surface elements.

Number of Layers Define the total number of layers to be generated using the specified
first layer thickness and growth rate.

BL Stopping Criteria Determine what to do when BL has reached the defined criteria for
Final Layer Height/Base Ratio.

Chop Off Layers
Chop off the BL if elements reach the aspect ratio criteria.

Keep Growing Gr=1
Grow BL until the neighboring elements begin to grow, even if
elements reach the aspect ratio criteria with GR =1.
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Table 248: Parameters

Parameter Description

Use Global Values Values defined for advanced parameters will be taken from the
advanced parameters defined for the model mesh control.

Maximum BL
Compression

Enable BL compression, or squeezing, when there is not enough space
available for the BL to grow. The BL will try to compress by the max
BL compression factor first. For example, if the original total BL height
is defined as 1, with a 0.4 max BL compression, the BL layers will try
to be compressed until 0.6 of the total height is reached. Once the BL
is compressed to this value, the mesher will start chopping off layers if
there is not enough space.

A value of zero enforces no BL compression, which is useful when you
want to maintain the BL height; a value of one enables the maximum
possible compression.

Recommended range: 0-0.6

Minimum BL Thickness /
Base Ratio

Due to close proximity, the BL will sometimes only be able to generate
one to two layers (a very small total BL height at that location). At
that location, it might be possible that the transition between BL layers
and the tetra core is bad. With this factor, if the total BL height is less
than the defined factor base size, all of the BL layers will be chopped
off.

By default, this value is zero, which disables the effects of this
parameter.

Volume Selector
Volume Selector mesh controls define which volumes should be meshed and how mesh should be
generated. Only one instance of a volume selector mesh control is allowed.

The parameters defined for Volume Selector mesh controls are applicable to both BL + Tetra and Tetra
model mesh controls.

Table 249: Parameters

Parameter Description

Select Volumes Defines which volumes to mesh.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.1982

Parameter Description

All Volumes
Mesh all of the volumes in the model. This option is also affected by
the parameter Fill Void, which fills of the voids (volume completely
enclosed in another volume) when enabled.
Example: When this option is enabled, and there is a sphere inside
of a larger sphere, the volume of the inner sphere as well as the
volume between the two spheres will be meshed.

Exclude Enclosed
Mesh all of the volume except for the volumes enclosed by the
defined seed node. The seed node should be enclosed in the volume.

Nth Largest
Select volumes to mesh based on size. Specify whether to select
the 1st largest, 2nd largest, ... using the volume index "N", which is
volume number. If you do not specify N, the smallest volume will be
meshed by default.

By Seed Nodes/Elems
Select volumes to be meshed by either specifying a seed node (the
seed node should be enclosed in the volume) or touching elements
or geometric solids (if input is solid). All can be defined at same
time. If there is a conflict between fluid and solid volumes, the fluid
volume will take precedence.

Mesh to File Store the generated mesh in a .nas or .hmx file after meshing is finished.
When enabled, specify a location to export the mesh.

BL and Tetras in One
Component

Store BL elements and tetra elements in one component. When disabled,
BL elements and tetra elements will be stored in separate components,
which is useful when you need to define morphing constraints on BL
elements.

Generate BL Contours Generate a .res file in your working directory of BL result contours
(Number of layers, first layer height, total BL thickness) for each input
element after volume meshing is finished. This file will automatically be
assigned the same name as the HyperMesh model file, but it will have a
.resextension. BL contours help you visualize how BLs are generated.

View this file in the Contour panel, or by clicking File > Load > Results
from the menu bar. Scroll through the available results.
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Only applicable to BL + Tetra model mesh controls.

Volume Mesh Control Options
Check mesh quality using tools accessed from the context menu that opens when you right-click on a
Volume Mesh folder in the Mesh Controls browser.

Check 2D Mesh
Validate the input surface mesh before performing volume mesh generation using the Boundary
Shell Checker tool.

Solid Mesh Optimization
Fix 3D elements in the following ways using the Solid Mesh Optimization tool.

• Fix hexa and tetra element quality with respect to several element criteria.

• Fix second order element's maximum angle, and minimum and maximum length ratio and
Jacobian.

Refinement Zone Mesh Controls
Refinement zones are used to refine mesh with a defined size.

Create refinement zones for surface meshing (surface deviation only), adaptive wrap meshing, and
volume meshing (BL+ Tetra and Tetra).

Table 250: Parameters

Parameter Description

Enabled for Volume
Mesh / Surface Mesh /
Wrapping Mesh

Enable refinement zones for volume meshing, surface meshing, and/or
adaptive wrap meshing.

Element Size Define the target element size for mesh inside of the refinement box.

Note:  The actual mesh size will vary in order to maintain
mesh connectivity at the edges of the box.

In the example below, the boundary region has been selected as With BL
(float) and remesh, therefore the region included in the refinement box
has been remeshed with the elements size assigned to the refinement box.
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Figure 907:

Shape Define the refinement zone shape.

Box
Is defined by:

By Center and Size
Use the selector to select a center node and specify the x, y,
and z dimensions of each side of the box.
Example: A size of 5 creates a 5 x 5 x 5 box centered around
the center node.

By Two Nodes
Use the selector to select two nodes which represent opposite
corners of a cubic volume.

By Four Nodes
Use the selector to select a base node and three additional
nodes. The four selected nodes cannot be coplanar. The base
node, N1, and N2 form a triangle, which is then flipped 180
degrees to form a rectangular base for the refinement box.
The vector from base node to N3 defines the refinement box's
height and direction from the base.

By Eight Nodes
Use the selector to select all eight nodes of the refinement
box. The order of the box will be corrected internally if defined
incorrectly.

By Element Volume
Use the elems selector to select the elements that define the
volume. Define a scaling factor to scale the elements enclosed
in the box. A scale factor of 1 creates the smallest possible box
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that can still enclose the selected elements, whereas a factor
of 2 creates a box twice as large in every dimension.

Cone
Defined by the lower circular face center (as a node or coordinates),
lower circular face radius, cylinder height, and normal axis of the
cylinder.

Cylinder
Defined by the lower circular face center (as a node or coordinates),
lower circular face radius, cylinder height, and normal axis of the
cylinder.

Ellipsoid
Defined by four nodes: the center node and three other nodes which
define the radius in each direction and also the orientation.

Frustum
Defined by the lower circular face center (as a node or coordinates),
lower circular face radius, top circular face radius, cylinder height,
and normal axis of the cylinder.

Sphere
Defined by the center (as a node or coordinates) and radius.

Regions
Regions store information used to facilitate and automate modeling practices and processes.

Regions enable a selection which can be common across design changes or other models, provided
region data is the same. Regions currently support two configurations of input: By ID and By Metadata.
Both inputs are supported for geometry only, and can be used for selection purposes.

For example, when using mesh controls, it is possible to mesh a surface which has been tagged with
metadata (or ID). If the design changes and a new version is authored, then you can quickly reapply
the same mesh controls as long as the metadata (or ID) is still applied to the new CAD version. Regions
enables an automated re-meshing process that is consistently repeatable.

Create Basic Regions
Create basic regions and define them in the Entity Editor.

1. In the Mesh Controls Browser, right-click on the Region folder and select Create > Basic from
the context menu.
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2. In the Entity Editor, select region parameters accordingly.

Create Regions from Features
Create regions by selecting entities based on their feature type using the Regions from Feature
Selection tool.

Regions will be created with the given region name, and will reference the specific entities found by the
tool based on the defined feature type.

1. In the Mesh Controls Browser, right-click on the Region folder and select Create > From
Feature Selection from the context menu.

2. In the Regions from Feature Selection dialog, enter a region name.

3. Select a feature type.

• Choose Circles to select surface edges that represent closed circles within a min and max
radius range, optionally limited to only internal edges.

The edges are found from either the selected surface edges, or from all of the edges of the
selected surfaces.

• Choose Cylinders to select surfaces that represent cylinders within a min and max radius
range.

Cylinders may be both closed and partial, or can be optionally limited to only closed.

• Choose Fillets to select surfaces that represent fillets within a min and max radius range.

Create Regions from Metadata to CAE
Create regions from points, lines and surfaces with metadata.

1. In the Mesh Controls Browser, right-click on the Region folder and select Create > From
Metadata to CAE from the context menu.
The Metadata to CAE dialog opens.

2. Set Create to Regions.

3. Set From to Points, Lines or Surfaces.

4. In the Metadata field, select a specific metadata name.
A list of entities is generated.

5. In the table, select entities from which to create regions.
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6. Click Apply.

Import/Export Mesh Controls
Mesh controls can be saved and reused across different models by exporting them to a template file
(*.xml) and then importing them into a new HyperMesh session from the Mesh Controls Browser.

All defined mesh controls are exported to a single .xml file, which can be utilized as a template. The
mesh control parameters are saved to the file, while any entity selection is not.

From the Mesh Controls Browser, right-click on the Mesh Controls folder and select Import or Export
from the context menu.

Figure 908:

Create and Edit Mesh Controls
Mesh controls can be created for batch meshing, surface meshing, adaptive wrap meshing, volume
meshing and refinement zones.

Model and local mesh control entity selection behaves as follows:

• If entities are selected in the model control, they will be directly used and you will not be prompted
for any additional selection.

• If no entities are selected in the model control, you will be prompted for an “on-the-fly” entity
selection:

◦ The entity type set for the model control is the type of entity you will be prompted to select.

For example, a size and bias control for surfaces can refer to surfaces, components, and
regions. Whatever is set as the current type in the active model control is what you will be
promoted to select on-the-fly.

• Entities must be defined for local controls. Entities that are part of the local control selection must
also be part of the model/on-the-fly selection. Any local entities that are not part of the model/on-
the-fly selection are ignored.
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• The use of regions for selection is recommended wherever possible for ease of use and best
compatibility with future workflows.

1. From the Mesh Controls Browser, right-click and select Create from the context menu.

The mesh control is created, and its corresponding parameters are displayed in the Entity Editor.

2. In the Entity Editor, define mesh control parameters.

a) In the Name field, enter a name for the mesh control.

b) Under Entity Selection, use the entities selector to select entities to associate with the mesh
control.

c) Define additional parameters accordingly.

You can edit mesh controls at any time by selecting them in the Mesh Controls Browser and modifying
them in the Entity Editor.

Tip:

• Create mesh controls specific for the different meshing types and refinement zones by
right-clicking on a corresponding folder in the Mesh Controls tab.

• Duplicate mesh controls by right-clicking on a mesh control and selecting Duplicate
from the context menu. You can only duplicate one mesh control at a time.
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Figure 909:

Enable Mesh Controls
When a meshing job is submitted, enabled mesh controls are considered and used to automate the
meshing process.

In the Mesh Controls Browser, enable and disable mesh controls.

Option Description

Model mesh controls Multiple instances of model mesh controls can be defined, but only one
can be enabled.

1. Enable a model mesh control by selecting its corresponding radio
button in the Enabled column.
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Option Description

Figure 910: Enabled Model Mesh Controls

Local mesh controls An unlimited number of local mesh controls can be defined and enabled.

• Enable a local mesh control by selecting its corresponding checkbox
in the Enabled column.

• Disable a local mesh control by clearing its corresponding checkbox.

Figure 911: Enabled Local Mesh Controls

Refinement Zone controls An unlimited number of refinement zone mesh controls can be defined
and enabled. Each refinement zone can be independently enabled or
disabled for surface meshing (surface deviation only), adaptive wrap
meshing, and volume meshing as required.

Figure 912: Refinement Zone Controls

• Enable a refinement zone for all meshers by selecting its
corresponding checkbox in the Enabled column.
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Option Description

• Disable a refinement zone for all meshers by clearing its
corresponding checkbox in the Enabled column.

If a refinement zone is disabled for any mesher but enabled for others, a
tristate checkbox is displayed.

Figure 913: Refinement Zone Control with Tristate Status

Create Mesh
Once you are finished creating mesh controls, generate the mesh from the Mesh Controls Browser.

In the Mesh Controls Browser, right-click on the BatchMesher, Surface Mesh, Adaptive Mesh, or Volume
Mesh folders and select Mesh from the context menu.

Note:

A mesh cannot be independently created for Refinement Zone controls.

Figure 914:
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Check Mesh Quality
Evaluate the overall quality of a mesh, and resolve criteria violations.

Element Quality Calculations
After you build your model, calculate the quality of elements in a mesh.

How Element Quality is Calculated
The quality of elements in a mesh can be gauged in many ways, and the methods used often depend
not only on the element type, but also on the individual solver used.

When possible, the most common or standard methods are used, but there is no truly standardized
set of element quality checks. When a solver does not support a specific check within HyperMesh,
HyperMesh uses its own method to perform the check.

HyperMesh
When possible, HyperMesh checks strive to maintain compatibility with popular solvers.

2D and 3D Element Checks
The following checks apply to both types of elements, but when applied to 3D elements they are
generally applied to each face of the element. The value of the worst face is reported as the 3D
element’s overall quality value.

Aspect Ratio
Ratio of the longest edge of an element to either its shortest edge or the shortest distance from
a corner node to the opposing edge ("minimal normalized height"). HyperMesh uses the same
method used for the Length (min) check.
For 3D elements, each face of the element is treated as a 2D element and its aspect ratio
determined. The largest aspect ratio among these faces is returned as the 3D element’s aspect
ratio.
Aspect ratios should rarely exceed 5:1

Chordal Deviation
Largest distance between the centers of element edges and the associated surface.
Second order elements return the same chordal deviation as first order, when the corner nodes
are used due to the expensive nature of the calculations.
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Figure 915: Chordal Deviation

Interior Angles
Maximum and minimum interior angles are evaluated independently for triangles and
quadrilaterals.

Jacobian
Deviation of an element from its ideal or "perfect" shape, such as a triangle’s deviation from
equilateral.
The Jacobian value ranges from 0.0 to 1.0, where 1.0 represents a perfectly shaped element. The
determinant of the Jacobian relates the local stretching of the parametric space which is required
to fit it onto the global coordinate space.
HyperMesh evaluates the determinant of the Jacobian matrix at each of the element’s integration
points (also called Gauss points) or at the element’s corner nodes, and reports the ratio between
the smallest and the largest. In the case of Jacobian evaluation at the Gauss points, values of
0.7 and above are generally acceptable. You can select which method of evaluation to use (Gauss
point or corner node) from the Check Element settings.

Length (min)
Minimum element lengths are calculated using one of two methods.

• The shortest edge of the element. This method is used for non-tetrahedral 3D elements.

• The shortest distance from a corner node to its opposing edge (or face, in the case of tetra
elements); referred to as "minimal normalized height".

Figure 916: Length Check

You can choose which method to use in the Check Element settings.
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Note:  This setting affects the calculation of the Aspect Ratio check.

Minimum Length / Size
Minimum element size is calculated using:

Shortest edge
Length of the shortest edge of each element is used.

Minimal normalized height
Is a more accurate, but more complex height.
For triangular elements, each corner node (i) HyperMeshHyperMesh calculates the closest
(perpendicular) distance to the ray including the opposite leg of the triangle, h(i). MNH =
min(hi) * 2/sqrt(3.0). The scaling factor 2/sqrt(3.0) ensures that for equilateral triangles,
the MNH is the length of the minimum side.

Figure 917: Minimal Normalized Height for Triangular Elements

For quadrilateral elements, each corner node, HyperMesh calculates the closest
(perpendicular) distances to the rays containing the legs of the quadrilateral that do not
include this node. The figure above depicts these lengths as red lines. Minimal normalized
height is taken to be the minimum of all eight lines and the four edge lengths, thus, the
minimum of 12 possible lengths.

Figure 918: Minimal Normalized Height for Quadrilateral Elements

Minimal height
The same as minimal normalized height, but without a scaling factor.

Skew
Skew of triangular elements is calculated by finding the minimum angle between the vector from
each node to the opposing mid-side, and the vector between the two adjacent mid-sides at each
node of the element.
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Figure 919: Skew of Triangular Elements

The minimum angle found is subtracted from ninety degrees and reported as the element’s skew.

Note:  Skew for quads is part of the HyperMesh-Alt quality check.

Taper
Taper ratio for the quadrilateral element is defined by first finding the area of the triangle formed
at each corner grid point.

Figure 920: Taper for Quadrilateral Element

These areas are then compared to one half of the area of the quadrilateral.
HyperMesh then finds the smallest ratio of each of these triangular areas to ½ the quad element’s
total area (in the diagram above, "a" is smallest). The resulting value is subtracted from 1, and
the result reported as the element taper. This means that as the taper approaches 0, the shape
approaches a rectangle.

Triangles are assigned a value of 0, in order to prevent HyperMesh from mistaking them for
highly-tapered quadrilaterals and reporting them as "failed".

Warpage
Amount by which an element, or in the case of solid elements, an element face, deviates from
being planar. Since three points define a plane, this check only applies to quads. The quad is
divided into two trias along its diagonal, and the angle between the trias’ normals is measured.
Warpage of up to five degrees is generally acceptable.
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Figure 921: Warpage

3D Element Only Checks
Minimum Length / Size

Two methods are used to calculate the minimum element size.

Shortest edge
Length of the shortest edge of each element is used.

Minimal normalized height
More accurate, but more complex.
HyperMesh calculates the closest (perpendicular) distances to the planes formed by the
opposite faces for each corner node.

Figure 922:

The resulting minimum length/size is the minimum of all such measured distances.

Tetra Collapse
The height of the tetra element is measured from each of the four nodes to its opposite face, and
then divided by the square root of the face’s area.

Figure 923:

The minimum of the four resulting values (one per node) is then normalized by dividing it by
1.24. As the tetra collapses, the value approaches 0.0, while a perfect tetra has a value of 1.0.
Non-tetrahedral elements are given values of 1 so that HyperMesh will not mistake them for bad
tetra elements.
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Vol. Aspect Ratio
Tetrahedral elements are evaluated by finding the longest edge length and dividing it by the
shortest height (measured from a node to its opposing face). Other 3D elements, such as hex
elements, are evaluated based on the ratio of their longest edge to their shortest edge.

Volume Skew
Only applicable to tetrahedral elements; all others are assigned values of zero. Volume Skew is
defined as 1-shape factor, so a skew of 0 is perfect and a skew of 1 is the worst possible value.
The shape factor for a tetrahedral element is determined by dividing the element’s volume by the
volume of an ideal (equilateral) tetrahedron of the same circumradius. In the case of tetrahedral
elements, the circumradius is the radius of a sphere passing through the four vertices of the
tetrahedron.

Figure 924:

HyperMesh-Alt
HyperMesh includes some alternate methods of calculating certain element types, which only apply to
quads or rectangular faces of solids, and only include alternate checks for Aspect Ratio, Skew, Taper
and Warpage.

Note:  Because these methods apply only to certain quality checks, in order to use them
you must choose the set individually option in the Check Element settings.

Aspect Ratio
ratio1 = V1/H1
ratio2 = V2/H2
Skew value is larger of ratio1 or ratio2.
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Figure 925: Aspect Ratio

Skew
First, HyperMesh constructs lines connecting the midpoints of each edge of the quad, dotted
in the picture below. Next, HyperMesh constructs a third line, green in the picture below,
perpendicular to one of the initial lines, then finds the angle between this third line and the
remaining initial line – with which is it most likely not perpendicular, unless the quad is a perfect
rectangle.
α is the skew (angle) value.

Figure 926: Skew

Taper
First, the quad’s nodes are projected to plane defined by the orthonormal vectors U-V found as
follows:

Z = X × Y

V = Z × X

U = X
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Figure 927:

Figure 928:

In HyperMesh Taper angle is defined as: .

The optimal value is 0°, and a generally acceptable limit is. <= 30°. The The ultimate limit, which
the Taper angle cannot exceed is 45°.

Warpage
Only applies to quads or rectangular faces of solids.

Figure 929:

Warpage = 100 * h / max { Li }, where h is the minimum distance between the diagonals.

OptiStruct
For the most part, OptiStruct uses the same checks as HyperMesh. However, OptiStruct uses its own
method of calculating Aspect Ratio, and it does not support 3D element checks.

Aspect Ratio
Ratio between the minimum and maximum side lengths.
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3D elements are evaluated by treating each face of the element as a 2D element, finding the
aspect ratio of each face, and then returning the most extreme aspect ratio found.

Chordal Deviation
Chordal deviation of an element is calculated as the largest distance between the centers of
element edges and the associated surface. 2nd order elements return the same chordal deviation
as 1st order, when the corner nodes are used due to the expensive nature of the calculations.

Figure 930: Chordal Deviation

Interior Angles
Maximum and minimum values are evaluated independently for triangles and quadrilaterals.

Jacobian
Deviation of an element from its ideal or "perfect" shape, such as a triangle’s deviation from
equilateral. The Jacobian value ranges from 0.0 to 1.0, where 1.0 represents a perfectly shaped
element. The determinant of the Jacobian relates the local stretching of the parametric space
which is required to fit it onto the global coordinate space.
HyperMesh evaluates the determinant of the Jacobian matrix at each of the element’s integration
points, also called Gauss points, or at the element’s corner nodes, and reports the ratio between
the smallest and the largest. In the case of Jacobian evaluation at the Gauss points, values of
0.7 and above are generally acceptable. You can select which method of evaluation to use, Gauss
point or corner node, from the Check Element settings.

Length (min)
Minimum element lengths are calculated using one of two methods:

• The shortest edge of the element. This method is used for non-tetrahedral 3D elements.

• The shortest distance from a corner node to its opposing edge (or face, in the case of tetra
elements); referred to as "minimal normalized height".

Figure 931: Length (Min)

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.2001

Skew
Skew of triangular elements is calculated by finding the minimum angle between the vector from
each node to the opposing mid-side, and the vector between the two adjacent mid-sides at each
node of the element.

Figure 932: Skew of Triangular Element

The minimum angle found is subtracted from ninety degrees and reported as its skew.

Warpage
Amount by which an element, or in the case of solid elements, an element face, deviates from
being planar. Since three points define a plane, this check only applies to quads. The quad is
divided into two trias along its diagonal, and the angle between the trias’ normals is measured.
Warpage of up to five degrees is generally acceptable.

Figure 933: Warpage

Abaqus
Abaqus specific checks used to calculate element quality for 2D and 3D elements.

2D and 3D Element Checks
These checks apply to both types of elements, but when applied to 3D elements they are generally
applied to each face of the element. The value of the worst face is reported as the 3D element’s overall
quality value.

Additional element checks not listed here are not part of the solver’s normal set of checks, and
therefore use HyperMesh check methods.

Aspect Ratio
Ratio of the longest edge of an element to its shortest edge.
When applied to 3D elements, the same method is used (longest edge divided by shortest edge)
rather than evaluating each face individually and taking the worst face result.

Interior Angles
Maximum and minimum values are evaluated independently for triangles and quadrilaterals.
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Jacobian
Deviation of an element from its ideal or "perfect" shape, such as a triangle’s deviation from
equilateral. The Jacobian value ranges from 0.0 to 1.0, where 1.0 represents a perfectly shaped
element. The determinant of the Jacobian relates the local stretching of the parametric space
which is required to fit it onto the global coordinate space.
HyperMesh evaluates the determinant of the Jacobian matrix at each of the element’s integration
points, also called Gauss points, or at the element’s corner nodes, and reports the ratio between
the smallest and the largest. In the case of Jacobian evaluation at the Gauss points, values of
0.7 and above are generally acceptable. You can select which method of evaluation to use (Gauss
point or corner node) from the Check Element settings.

Length (min)
Minimum element lengths are calculated using one of two methods:

• The shortest edge of the element. This method is used for non-tetrahedral 3D elements.

• The shortest distance from a corner node to its opposing edge (or face, in the case of tetra
elements); referred to as "minimal normalized height".

Skew (tria only)
Defined by shape factor. Abaqus determines triangular element shape factor by dividing the
element’s area by the area of an ideally shaped element. The ideally shaped element is defined as
an equilateral triangle with the same circumradius—the radius of a circle that passes through the
three vertices of the triangle—as the element.

Figure 934:

This shape factor converts to skew by subtracting it from 1. Thus, a perfect equilateral tria
element has a skew of 0 and the worst tria has a value of 1.0.
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Quadrilaterals are simply assigned a value of 0.

3D Element Only Checks
Volume Skew

Only applicable to tetrahedral elements; all others are assigned values of zero.
Volume Skew is defined as 1 minus the shape factor, so a skew of 0 is perfect and a skew of 1 is
the worst possible value.
The shape factor for a tetrahedral element is determined by dividing the element’s volume by the
volume of an ideal (equilateral) tetrahedron of the same circumradius. In the case of tetrahedral
elements, the circumradius is the radius of a sphere passing through the four vertices of the
tetrahedron.

Figure 935: Volume Skew

ANSYS
ANSYS specific checks used to calculate element quality for 2D and 3D elements.

2D and 3D Element Checks
These checks apply to both types of elements, but when applied to 3D elements they are generally
applied to each face of the element. The value of the worst face is reported as the 3D element’s overall
quality value.

Additional element checks not listed here are not part of the solver’s normal set of checks, and
therefore use HyperMesh check methods.

Aspect Ratio (tria)
For tria elements, a line is drawn from one node to the midpoint of the opposite edge. Next,
another line is drawn between the midpoints of the remaining two sides. These lines are typically
not perpendicular to each other or to any of the element edges, but provide four points (three
midpoints plus the vertex).

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.2004

Figure 936:

Then, a rectangle is created for each of these two lines, such that one line perpendicularly
meets the midpoints of two opposing edges of the rectangle, and the remaining edges of the
rectangle pass through the end points of the remaining line. This results in two rectangles, one
perpendicular to each of the two lines.

Figure 937:

Third, this process is repeated for each of the remaining two nodes of the tria element, resulting
in the construction of four additional rectangles (six in total).
Finally, each rectangle is examined to find the ratio of its longest side to its shortest side. Of these
six values—one for each rectangle—the most extreme value is then divided by the square root of
three to produce the tria aspect ratio.
The best aspect ratio (an equilateral tria) is 1. Higher numbers indicate greater deviation from
equilateral.

Aspect Ratio (quad)
If the element is not flat, it’s projected to a plane which is based on the average of the element’s
corner normals. All subsequent calculations are based on this projected element rather than the
original (curved) element.
Next, two lines are created which bisect opposite edges of the element. These lines are typically
not perpendicular to each other or to any of the element edges, but they provide four midpoints.

Figure 938:
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Third, a rectangle is created for each line, such that the line perpendicularly bisects two opposing
edges of the created rectangle, and the remaining two edges of the rectangle pass through the
remaining line’s endpoints. This creates two rectangles—one perpendicular to each line.

Figure 939:

Finally, the rectangles are compared to find the one with the greatest length ratio of longest
side to shortest side. This value is reported as the quad’s aspect ratio. A value of one indicates a
perfectly equilateral element, while higher numbers indicate increasingly greater deviation from
equilateral.

Interior Angles
Maximum and minimum values are evaluated independently for triangles and quadrilaterals.

Jacobian
Deviation of an element from its ideal or "perfect" shape, such as a triangle’s deviation from
equilateral. The Jacobian value ranges from 0.0 to 1.0, where 1.0 represents a perfectly shaped
element. The determinant of the Jacobian relates the local stretching of the parametric space
which is required to fit it onto the global coordinate space.
HyperMesh evaluates the determinant of the Jacobian matrix at each of the element’s integration
points, also called Gauss points, or at the element’s corner nodes, and reports the ratio between
the smallest and the largest. In the case of Jacobian evaluation at the Gauss points, values of
0.7 and above are generally acceptable. You can select which method of evaluation to use (Gauss
point or corner node) from the Check Element settings.

Length (min)
Minimum element lengths are calculated using one of two methods:

• The shortest edge of the element. This method is used for non-tetrahedral 3D elements.

• The shortest distance from a corner node to its opposing edge (or face, in the case of tetra
elements); referred to as "minimal normalized height".

Figure 940:
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Angle Deviation (Skew)
Only applicable to quadrilateral elements, and relies upon the angles between adjacent legs at
each corner node (that is, the interior angles at each corner). Each angle is compared to a base
of 90 degrees, and the one with the largest deviation from 90 is reported as the angle deviation.
Triangular elements are given a value of zero.

Warping Factor
Only applicable to quadrilateral elements as well as the quadrilateral faces of 3D bricks, wedges,
and pyramids.
Calculated by creating a normal from the vector product of the element’s two diagonals. Next,
the element’s area is projected to a plane through the average normal. Finally, the difference in
height is measured between each node of the original element and its corresponding node on the
projection. For flat elements, this is always zero, but for warped elements one or more nodes will
deviate from the plane. The greater the difference, the more warped the element is.

Figure 941:

The warping factor is calculated as the edge height difference divided by the square root of the
projected area.

3D Element Only Checks
ANSYS does not use any exclusively 3D checks within HyperMesh, but HyperMesh does use its own
when ANSYS is set as the solver. For details on 3D checks, refer to HyperMesh.

I-deas
I-deas specific checks used to calculate element quality for 2D and 3D elements.

Additional element checks not listed here are not part of the solver’s normal set of checks, and
therefore use HyperMesh check methods.

2D and 3D Element Checks
These checks apply to both types of elements, but when applied to 3D elements they are generally
applied to each face of the element. The value of the worst face is reported as the 3D element’s overall
quality value.

Stretch (Aspect Ratio)
Stretch is evaluated differently depending on whether the element is triangular or quadrilateral:

• For trias, the radius of the largest circle that fits within the element is divided by the longest
edge, then multiplied by the square root of 12.
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Figure 942: Stretch for Trias

• For quads, the minimum edge length is divided by the maximum diagonal length. The result
is multiplied by the square root of 2.

Note:  The inverse of stretch displays on-screen in HyperMesh as the aspect.

Chordal Deviation
Largest distance between the centers of element edges and the associated surface. Second order
elements return the same chordal deviation as first order, when the corner nodes are used due to
the expensive nature of the calculations.

Figure 943: Chordal Deviation

Jacobian
Deviation of an element from its ideal or "perfect" shape, such as a triangle’s deviation from
equilateral. The Jacobian value ranges from 0.0 to 1.0, where 1.0 represents a perfectly shaped
element. The determinant of the Jacobian relates the local stretching of the parametric space
which is required to fit it onto the global coordinate space.
HyperMesh evaluates the determinant of the Jacobian matrix at each of the element’s integration
points, also called Gauss points, or at the element’s corner nodes, and reports the ratio between
the smallest and the largest. In the case of Jacobian evaluation at the Gauss points, values of
0.7 and above are generally acceptable. You can select which method of evaluation to use (Gauss
point or corner node) from the Check Element settings.

Length (min)
Minimum element lengths are calculated using one of two methods:
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• The shortest edge of the element. This method is used for non-tetrahedral 3D elements.

• The shortest distance from a corner node to its opposing edge (or face, in the case of tetra
elements); referred to as "minimal normalized height".

Figure 944: Length (min)

Skew
Deviation of an element’s corners from 90 degrees (for quads) or 60 degrees (for trias).
The check calculates skew by finding:

 for quadrilaterals

 for triangular elements

Where alpha is the angle of each corner. An ideal/equilateral element has a skew of zero, as none
of its corners deviate from the target (90 or 60 degrees).

Taper
Taper ratio for the quadrilateral element is defined by first finding the area of the triangle formed
at each corner grid point.

Figure 945: Taper

These areas are then compared to one half of the area of the quadrilateral.
HyperMesh then finds the smallest ratio of each of these triangular areas to ½ the quad element’s
total area. In the diagram above, "a" is smallest. The resulting value is subtracted from 1, and
the result reported as the element taper. This means that as the taper approaches 0, the shape
approaches a rectangle.

Triangles are assigned a value of 0, in order to prevent HyperMesh from mistaking them for
highly-tapered quadrilaterals and reporting them as "failed".
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Warpage
The amount by which an element, or in the case of solid elements, an element face, deviates
from being planar. Since three points define a plane, this check only applies to quads. The quad is
divided into two trias along its diagonal, and the angle between the trias’ normals is measured.

3D Element Only Checks
Stretch (volume aspect ratio)

Stretch is evaluated differently depending on whether the element is a tetrahedron, Wedge, Brick,
or Pyramid.

Tetras
The radius of the largest sphere that fits within the element is divided by the longest edge.
This value is then multiplied by the square root of 24.

Wedges
Each face is evaluated for its 2D stretch, and the worst value is reported. This means that
the value reported for vol AR should always be the same as that reported for aspect.

Bricks
The minimum edge length is divided by the maximum diagonal length. The result is
multiplied by the square root of 3.

Pyramids
No check is defined, so HyperMesh performs its standard check in which each face is
evaluated as a 2D object and the worst result reported.

Medina
Medina specific checks used to calculate element quality for 2D and 3D elements.

Additional element checks not listed here are not part of the solver’s normal set of checks, and
therefore use HyperMesh check methods.

2D and 3D Element Checks
These checks apply to both types of elements, but when applied to 3D elements they are generally
applied to each face of the element. The value of the worst face is reported as the 3D element’s overall
quality value.

Aspect Ratio (Edge Ratio)
Edge Ratio is calculated as the ratio between an element’s shortest edge and its longest edge; For
the sake of consistency, HyperMesh inverts this result, effectively making it the ratio of longest to
shortest, and reports the result as the element’s aspect ratio.

Interior Angles
Maximum and minimum values are evaluated independently for triangles and quadrilaterals.

Jacobian
Deviation of an element from its ideal or "perfect" shape, such as a triangle’s deviation from
equilateral. The Jacobian value ranges from 0.0 to 1.0, where 1.0 represents a perfectly shaped
element. The determinant of the Jacobian relates the local stretching of the parametric space
which is required to fit it onto the global coordinate space.
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HyperMesh evaluates the determinant of the Jacobian matrix at each of the element’s integration
points, also called Gauss points, or at the element’s corner nodes, and reports the ratio between
the smallest and the largest. In the case of Jacobian evaluation at the Gauss points, values of
0.7 and above are generally acceptable. You can select which method of evaluation to use (Gauss
point or corner node) from the Check Element settings.

Length (min)
Minimum element lengths are calculated using one of two methods:

• The shortest edge of the element. This method is used for non-tetrahedral 3D elements.

• The shortest distance from a corner node to its opposing edge (or face, in the case of tetra
elements); referred to as "minimal normalized height".

Figure 946: Length (min)

Maximum Angle
Largest angle between adjacent edges of the element is reported.

Minimum Angle
Smallest angle between adjacent edges of the element is reported.

Skew
Element’s interior corner angles are compared to 90 degrees (for quads) or 60 degrees (for trias).
The absolute values of these deviations are summed and reported.

Taper
Quadrilateral elements are split into two triangles.

Figure 947: Taper

The area of the smaller of the two triangles is compared to the total area of the quadrilateral. In

Figure 947, .
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Note:  To improve consistency with other taper checks, HyperMesh displays a value
of 0.5 minus this value so that 0 implies no taper. However, this is not completely
consistent with other taper checks, because in this case taper ranges from 0 (no
taper) to 0.5 (full taper), whereas HyperMesh’s own taper check reports a 1.0 for full
taper.

Warpage
Elements with more than three nodes are split into triangles. The largest angle between the
normals of triangle pairs is reported as the warpage.

3D Element Only Checks
Medina does not use any 3D specific checks. HyperMesh uses its own checks instead.

Moldflow
Moldflow specific checks used to calculate element quality for 2D and 3D elements.

Additional element checks not listed here are not part of the solver’s normal set of checks, and
therefore use HyperMesh check methods.

2D and 3D Element Checks
These checks apply to both types of elements, but when applied to 3D elements they are generally
applied to each face of the element. The value of the worst face is reported as the 3D element’s overall
quality value.

Aspect Ratio
Only applied to triangles, with quadrilaterals given a value of:

This is the same value obtained from an equilateral triangle, and is assigned to quads to prevent
HyperMesh from misinterpreting a quad as a badly formed triangular element.
MoldFlow calculates a triangle’s aspect ratio by squaring the longest edge of the triangle, and
dividing the result by twice the triangle’s area. 1.0 denotes a perfect equilateral triangle.
When applied to 3D elements, the aspect ratio is the ratio between the longest and shortest edges
of the tetrahedral element.

3D Element Only Checks
Vol. Aspect Ratio

Finds the perpendicular height h of each node, and then dividing the longest edge length L by the
shortest height h and multiplying by the square root of 1.5:
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This results in an equilateral tetrahedron having a volume aspect ratio of 1.5. Non-tetrahedral
elements are assigned a value of 1.0.

Nastran
Nastran specific checks used to calculate element quality for 2D and 3D elements.

Additional element checks not listed here are not part of the solver’s normal set of checks, and
therefore use HyperMesh check methods.

2D and 3D Element Checks
Interior Angles

Maximum and minimum values are evaluated independently for triangles and quadrilaterals.

Jacobian
Deviation of an element from its ideal or "perfect" shape, such as a triangle’s deviation from
equilateral. The Jacobian value ranges from 0.0 to 1.0, where 1.0 represents a perfectly shaped
element. The determinant of the Jacobian relates the local stretching of the parametric space
which is required to fit it onto the global coordinate space.
HyperMesh evaluates the determinant of the Jacobian matrix at each of the element’s integration
points, also called Gauss points, or at the element’s corner nodes, and reports the ratio between
the smallest and the largest. In the case of Jacobian evaluation at the Gauss points, values of
0.7 and above are generally acceptable. You can select which method of evaluation to use (Gauss
point or corner node) from the Check Element settings.

Skew
Nastran creates lines between the midpoints of opposite sides of the element, then measures the
angles between these lines. The angle with the greatest deviation from the ideal value is used to
determine skew.

Taper
Nastran finds the taper of quadrilateral elements by treating each node as the corner of a triangle,
using one of the quad’s diagonals as the triangle’s third leg. The areas of each of these four
"virtual" triangles are compared to one half of the total area of the quadrilateral element to
produce a ratio; the largest of these ratios is then compared to the tolerance value. A value of 1.0
is a perfect quadrilateral, and higher numbers denote greater taper.
However, for the sake of consistency within HyperMesh, an equivalent taper is reported instead.
This means that the smallest area ratio found (instead of the largest ratio) is subtracted from 1,
so that 0 represents a perfect quadrilateral element instead of 1.0, and greater deviation from 0
indicates greater taper. Triangle elements are simply assigned a value of 0 to prevent HyperMesh
from incorrectly identifying them as failed (highly-tapered) quads.

Warpage
First, Nastran constructs a plane based on the mean of the quad’s four points. This means that
the corner points of a warped quad are alternately H units above and below the constructed
plane. This value is then used along with the length of the element’s diagonals in the following
equation:
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Where WC is the Warping Coefficient, H is the "height" or distance of the nodes from the
constructed plane, and D1 and D2 are the lengths of the diagonals. Thus, a perfect quad has a
WC of zero.

3D Element Only Checks
Vol. Aspect Ratio

Nastran evaluates Tetrahedral elements by finding the longest edge length and dividing it by the
shortest height, measured from a node to its opposing face. Other 3D elements, such as hex
elements, are evaluated based on the ratio of their longest edge to their shortest edge.

Warpage
Nastran evaluates warpage on solid element faces by dividing the quad face into two trias along
its diagonal, and measuring the cosine of the angle between the trias’ normals. This value will be
1.0 for a face where all nodes lie on the same plane.

Patran
Patran specific checks used to calculate element quality for 2D and 3D elements.

Additional element checks not listed here are not part of the solver’s normal set of checks, and
therefore use HyperMesh check methods.

2D and 3D Element Checks
These checks apply to both types of elements, but when applied to 3D elements they are generally
applied to each face of the element. The value of the worst face is reported as the 3D element’s overall
quality value.

Aspect Ratio (triangle)
The length of a side is divided by the height of the triangle from that side to its opposite node,
then multiplied by ½ of the square root of 3. In a perfect equilateral triangle, this formula
produces a value of 1. The process is performed for each of the three sides, and the largest value
of the three is reported as the aspect ratio.

Figure 948: Aspect Ratio for Triangles
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Aspect Ratio (quads)
If the element is not flat, it is projected to a plane which is based on the average of the element’s
corner normals. All subsequent calculations are based on this projected element rather than the
original (curved) element.
Next, two lines are created which bisect opposite edges of the element. These lines are typically
not perpendicular to each other or to any of the element edges, but they provide four midpoints.
Third, a rectangle is created for each line, such that the line perpendicularly bisects two opposing
edges of the created rectangle, and the remaining two edges of the rectangle pass through the
remaining line’s endpoints. This creates two rectangles—one perpendicular to each line.

Figure 949: Aspect Ratio for Quads

Finally, the rectangles are compared to find the one with the greatest length ratio of longest
side to shortest side. This value is reported as the quad’s aspect ratio. A value of 1 indicates a
perfectly equilateral element, while higher numbers indicate increasingly greater deviation from
equilateral.

Interior Angles
Maximum and minimum values are evaluated independently for triangles and quadrilaterals.

Jacobian
Deviation of an element from its ideal or "perfect" shape, such as a triangle’s deviation from
equilateral. The Jacobian value ranges from 0.0 to 1.0, where 1.0 represents a perfectly shaped
element. The determinant of the Jacobian relates the local stretching of the parametric space
which is required to fit it onto the global coordinate space.
HyperMesh evaluates the determinant of the Jacobian matrix at each of the element’s integration
points, also called Gauss points, or at the element’s corner nodes, and reports the ratio between
the smallest and the largest. In the case of Jacobian evaluation at the Gauss points, values of
0.7 and above are generally acceptable. You can select which method of evaluation to use (Gauss
point or corner node) from the Check Element settings.

Length (min)
Minimum element lengths are calculated using one of two methods:

• The shortest edge of the element. This method is used for non-tetrahedral 3D elements.

• The shortest distance from a corner node to its opposing edge (or face, in the case of tetra
elements); referred to as "minimal normalized height".
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Figure 950: Length (min)

Skew (triangle)
Patran evaluates triangular skew by constructing a line from one of the triangle’s nodes to the
midpoint of its opposite side, and another line connecting the midpoints of the remaining two
sides.

Figure 951: Skew for Triangles

An angle between these created lines is compared to 90 degrees to find its deviation from square.
This process is then repeated for each of the remaining two nodes, and the largest of the three
computed angle deviations is reported as the element’s skew.

Skew (Quad)
The skew test begins by bisecting the four element edges. This creates an origin at the vector
average of the four corners, with the x-axis extending from the origin to the bisector on edge 2.
Next, finding the cross-product of the x-axis and the vector that stretches from the origin to the
midpoint of edge 3 defines the z-axis. With the x and z axes defined, their cross-product defines
the y-axis.

Figure 952: Skew for Quads

Finally, subtracting the angle α (located between the y axis and the line bisecting edges 1 and 3)
from 90 degrees reveals the element skew.
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Taper
Patran calculates taper by first averaging the corner nodes to find the element center, and
creating lines between this center and the corner nodes to split the element into four triangles.

The taper calculation is simply the smallest triangle’s area divided by the average of all the
triangle areas—or, put another way, the taper is quadruple the area of the smallest triangle,
divided by the sum of the areas of all four triangles:

Note:  For the sake of display compatibility, HyperMesh reports an equivalent value
for Taper. Taper is determined as above, but is then subtracted from 1 to produce a
number between zero and one. Thus, as the element taper decreases, the reported
value approaches zero (a perfect square). Triangles are assigned a value of zero to
prevent them from showing up as failed quads.

Warpage
The warpage test bisects the element edges, creating a point at the vector average of the element
corners. This point serves as the base node for a plane, with the plane’s x-axis extending from the
base node to the bisector on edge 2 of the element. The plane normal (z-axis) is in the direction
of the cross-product of this x-axis and the vector from the origin to the bisector of edge 3. Each
corner of the quad is then the same distance, h, from the plane. Next, Patran measures the
length of each half-edge, and calculates the arcsine of the ratio of h to the shortest half-edge
length (L):

3D Element Only Checks
Vol. Aspect Ratio (Tetrahedron)

Patran finds the aspect ratio of Tetra elements by finding the ratio between a vertex height and
½ the area of the opposing face. This process is repeated for each vertex, and the largest ratio
found.

Figure 953: Vol. Aspect Ratio for Tetrahedrons
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Next, Patran multiplies the largest ratio found by 0.805927, the corresponding ratio of an
equilateral tetrahedron. The result is reported as the element’s aspect ratio, with a value of 1
representing a perfect equilateral tetrahedron.

Vol. Aspect Ratio (pyramid)
Ratio of the element’s longest edge length to its shortest edge length.

Vol. Aspect Ratio (wedge)
This test begins by averaging the triangular faces of the element to create a triangular mid-
surface. Next, it finds the aspect ratio of the mid-surface, as for a tria element. Then it compares
the average height (h1) of the wedge element to the mid-surface’s maximum edge length (h2).

Figure 954: Vol. Aspect Ratio for Wedges

If the wedge height h1 exceeds the edge length h2, the wedge’s aspect ratio equals the mid-
surface aspect ratio multiplied by h2, then divided by the average distance between the triangular
faces (h3).
If the wedge height h1 is less than the edge length h2, the wedge aspect ratio equals either
the mid-surface aspect ratio, or the maximum edge length h2 divided by the average distance
between the triangular faces (h3), whichever is greater.

Vol. Aspect Ratio (hexahedron)
Each face of the hex element is treated as a warped quadrilateral, and its center point found. The
volume aspect ratio is simply the ratio of the largest distance h between the center points of any
two opposing faces, to the smallest such distance.
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Figure 955: Vol. Aspect Ratio for Hexahedrons

Quality Index Calculations
The Quality Index value is a function of twelve criteria with user-defined weight factors. Each criterion
has five rating levels.

HyperMesh assigns a penalty value to each element according to its rating for individual criteria. The
elements that fail a criterion are assigned a penalty of 1.0 to 10.0 as a linear function of how far the
element is from satisfying the criterion. The elements that pass a criterion are assigned a penalty value
of 0.0 to 1.0 for that criterion. The quality index (Q.I.) is a function of individual criteria penalty values.
Each element is assigned the corresponding element Q.I. color.

element Q.I.
(weighted average of penalties that pass) + (weighted sum of penalties that fail)

criteria Q.I.
(weighted average of penalties of elements that pass) + (weighted sum of penalties of elements
that fail)

compound Q.I
(weighted average of criteria Q.I. that pass) + (weighted sum of criteria Q.I. that fail)

All of this means that higher compound Q.I. values indicate worse quality.

Each criterion has five levels. The elements are assigned a penalty depending on where they fall in
these levels.

Figure 956: Criterion Levels
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Ideal
The absolute best/ideal value that an element can achieve. For example, an ideal element would
have an aspect ratio of 1.0, warpage of 0.0, jacobian of 1.0, and so on. Some criteria may not
have an ideal, for example the ideal minimum element size is the same as average element size.
Similarly, for simulations that require all triangular mesh, "% of trias" is not applicable. Thus
the ideal "% of trias" depends on the analysis type, and should be set by you. Elements that
fall in this level are drawn in their default color, not highlighted. Ideal elements have no penalty
assigned to them.

Good
This level is slightly worse than ideal, but is still considered good for the required analysis. All
elements whose criteria are equal to or better than this level are considered good and no penalty
is assigned to them. You set all the good level thresholds. Elements that fall in this level, between
good and warn, are drawn in their default color, not highlighted. The elements that fall between
good and warn are assigned a penalty between 0-0.79.

Warn
An intermediate level between good and fail. This level is used to highlight the elements that have
not failed the criteria, but are close to it. HyperMesh sets these values at 80 percent between
good and fail levels. The elements that are in this level, that is, falling between warn and fail, are
drawn in cyan by default and are assigned a penalty value between 0.8 – 0.99.

Fail
Determines the elements that are considered to be unacceptable for analysis, thus failed. It
is recommended that you fix these elements before performing the analysis. You can specify
the fail levels. All the elements that fail are given a penalty greater than 1.0. The penalty value
is calculated depending on the severity of the failure. The elements that have failed, between
fail and worst, are drawn in yellow by default and are given a penalty value between 1.0-10.0.
Therefore, elements that passed all criteria have a penalty less than 1.0.

Worst
Highlights elements that failed the criteria by a large margin, and which require immediate
attention. The worst levels are set by HyperMesh as a factor of good and fail values. The elements
that fall in and beyond this worst level are drawn in red and given a flat penalty value of 10.0.

In addition to these levels, you can also turn on/off individual criteria according to your analysis
requirements. You can also set different weights for individual criteria. For example, if jacobian is
relatively more important than warpage, you can choose to set jacobian comp weight to 2.0. The Comp
QI calculated will then give jacobian twice the weight as the remaining criteria.

Element Quality View
The Element Quality view allows you to investigate each specific element criteria, view a breakdown of
all failed and worst elements, resolve all criteria violations at one time, and evaluate the over all quality
of a mesh.

Element Quality View is a permanent visualization mode that HyperMesh displays in the upper left-hand
corner of the graphics area when you select By Element Quality on the Visualization toolbar.
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Multiple Criteria Legend
When you select Element Quality View, HyperMesh displays the Multiple Criteria legend by 
default.

In this legend, you can:

• Review the different 2D element criteria's.

• Adjust the initial threshold values assigned to each 2D element criteria.

• Select specific criteria's to investigate further.

The Element Quality View tool bases the initial threshold values on the ideal, good, warn, fail (default),
and worst values that are defined in the current 2D element criteria settings. By default, this tool bases
the initial threshold values on the fail column. You can directly edit these values from the Element
Quality View or you can edit them in the Criteria File Editor.

Note:  Any changes that you make in the Element Quality View will impact all of the other
Element Quality View settings. The changes that you make to the threshold values in the
Element Quality View will not effect the values in the criteria file, but any changes that you
make to the criteria file will effect the Element Quality View.

When you click a criteria in the Multiple Criteria legend, a single criteria specific legend appears to the
right of the threshold values. The elements are color coded according to how well they adhere to the
quality requirements in the graphics area.

Single Criteria Legend
Each 2D element criteria, in the Multiple Criteria legend, has its own single criteria legend. The single
criteria legends consists of a color coded sliding scale, which you can use to evaluate the elements in
the graphics area and resolve all criteria violations.

The colors exhibited in the sliding scale reflect the quality of each element in the graphics area. The 
elements that are of the best quality will always display in blue, whereas, the elements that are of the 
worst quality will always display in red. The Element Quality View tool determines the quality of each 
element using the 2D element criteria that you defined in the Multiple Criteria legend.
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The Element Quality View tool always lists the values in the sliding scale from low to high, with the
lowest value always being at the bottom of the scale and the highest value always being at the top. This
tool always defines the first and last values in the legend with the minimum and maximum values. You
cannot edit the minimum and maximum values.

The second and second to last values are the initial legend range coverage, based on the good to worst,
warn to worst (default), fail to worst, and min to max values. These values are taken from the criteria
file, and can be edited. The Element Quality View tool interpolates the values in between these.

Each single criteria legend contains a slider that is located, by default, at the exact, current threshold
position. If the initial legend range coverage does not provide the threshold value set defined in the
settings, then the slider will be positioned to the closest available value. To view a breakdown of all of
the failed and worse elements, move the slider up and down.

Element Quality View Options and Settings
Overview of the options and settings used to control the Element Quality view.

Multiple Criteria Context Menu
To access the Multiple Criteria context menu, right-click on the Multiple Criteria legend.

No Result As
Change how elements that fail all of the 2D element criteria appear in the graphics area. By
default, these elements are shaded in gray. To make these elements invisible, click transparent.

Set Threshold Values
Set the threshold values to one of the following levels: worst, fail (default), warn, good, and ideal.

Note:  When you select a different level to set the threshold values to, the values will
reset to the values that are read from the current criteria file settings.

Edit Criteria
Opens the Criteria File Editor, from which you can edit the current 2D element criteria in the
criteria file.

Note:  As long as the Criteria File Editor is open, you cannot modify the legends in the
Element Quality View.

Configure Quality View

Opens the Element Quality View Configuration dialog, from which you can:

• Change the color assigned to each criteria.

• Select which element criteria you would like to display in the Multiple Criteria legend.

• Rearrange the order of the element criteria in the Multiple Criteria legend

Single Criteria Context Menu
To access the Single Criteria context menu, right-click on a single criteria legend.
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Close XXX Legend
Closes the single criteria legend that is currently open, and activates the Multiple Criteria legend.

Set Legend Range
Set the legend range of the threshold values by selecting one of the following options: good to
worst, warn to worst, fail to worst, and min to max. This option is not enabled when the Quality
Index legend is open.

Beyond Threshold As
Changes how the elements that have no results or have higher/lower values are displayed in the
graphics area. The following display options are available: Transparent, Feature Lines, and Off
(default).

Edit Criteria
Opens the Criteria File Editor, from which you can edit the current 2D element criteria in the
criteria file.

Note:  As long as the Criteria File Editor is open, you cannot modify the legends in the
Element Quality View.

Configure Quality View
Opens the Element Quality View Configuration dialog, where you can:

• Change the color assigned to each criteria.

• Select which element criteria you would to display in the Multiple Criteria legend.

• Rearrange the order of the element criteria in the Multiple Criteria legend

Element Quality Configuration Dialog
In the Element Quality View Configuration dialog, you can customize the appearance of the Element
Quality View tool, and select the criteria that appears in the Multiple Criteria legend. Open this dialog by
clicking Configure Quality View from the right-click element quality view context menu.

The Element Quality View Configuration dialog contains a list of all possible 2D element criteria that
you can display in the Multiple Criteria legend. To select which 2D element criteria you would like to
display in the Multiple Criteria legend, select or clear each element criteria's checkbox. Click the blue up
and down arrows to rearrange the order the 2D element criteria will appear in, in the Multiple Criteria
legend.

Note:  If you change the order of the element criteria after you have adjusted the threshold
values in the Multiple Criteria legend, the threshold values will reset to their fail values. It is
best to change the order of the element criteria first, and then change the threshold values
in the Multiple Criteria legend.

You can also change the display color of each criteria in this dialog by selecting a new color from the
color pallet.
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Figure 961:

Check Element Quality
After you build your model, check the quality of the elements in the model.

You can check your model for connectivity and duplicate elements.

• Use the Check Elems panel, 1D subpanel to:

• Check one-dimensional elements for free ends

• Determine if a group of rigid elements form a loop

• Check weld and rigid elements for double dependency

• Check all elements for a minimum length of a side

• Use the Check Elems, 2D panel to:

• Check elements for warpage, aspect ratio, skew, and jacobian ratio

• Check the maximum and minimum interior angles of quad and tria elements

• Check all elements for a minimum length of a side

• Check a mesh of elements for its maximum chordal deviation from a real or inferred surface

• Use the Check Elems, 3D panel to:

• Check elements for warpage, aspect ratio, skew, and jacobian ratio

• Check the maximum and minimum interior angles of quad and tria elements

• Check all elements for a minimum length of a side

• Check tetra elements for collapse, CFD-style volumetric skew, and Nastran-style aspect ratio
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• Use the Check Elems, Time subpanel to check for elements whose small size might cause problems
for an explicit solver.

• Use the Check Elems, Group subpanel to check for and eliminate group or interface elements
whose underlying structural element has changed and left them detached.

• Use the Check Elems, User subpanel to verify element quality by using a template file that checks
for user-specified conditions.

Create Mesh Quality Report
Create an HTML mesh quality report for the current model or for multiple models.

The standard HyperMesh criteria file is used as input. The mesh quality report summarizes the Quality
Index (QI) calculations, along with information on the number of elements that fall into each QI range.

A report consists of:

• A single summary HTML page that gives a brief summary of several key metrics for all selected
models. This page links to pages with detailed information about the mesh quality of each model.

• A directory containing HTML pages for each model. These pages contain detailed mesh quality
information. This page contains a link to the input HyperMesh file as well as the criteria file used.

The HTML files and directory are named based on the input file and the date/time the report was
generated.

1. From the menu bar, click Mesh > Checks > Elements > Quality Report and select:

• Choose Current Model to create a report for the current model.

• Choose Multiple Models to create a report for multiple models.

2. In the Browser for Folder dialog, select the output directory where the report will be located and
click OK.

3. If you are creating a report for multiple Files, in the Select model file(s) dialog, select the
database files to generate the report for and click Open.

4. In the Select criteria file dialog, select a criteria file and click Open.

If you are creating a report for the current model, when the current model is not saved as an .hm file,
instead of using the HyperMesh model name in the HTML, the name CurrentModel is used. There is no
link from the detailed report to the model file, as one does not exist.

If you are creating a report for multiple models, each HyperMesh file is loaded one at a time into the
current HyperMesh session, and the report is generated for each file.
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Restriction:  HyperMesh files should not contain any special HTML characters like #. This
will prevent the HTML links from working properly.

Review Shell Thickness
The Thickness view allows you to investigate the shell thicknesses in your model.

The Thickness view is a permanent visualization mode that HyperMesh displays in the upper left-hand
corner of the graphics area when you select By Thickness on the Visualization toolbar. Both element
thickness as well as node thickness is supported. The thickness colors can be shown along two different
legend styles, discrete and ranged.

Figure 962:

Discrete Thickness Legend
When you select Thickness View, the Discrete Thickness legend displays by default.

In the Discrete Thickness legend each individual thickness value has its own exclusive color and hence
the thickness values are not editable. This legend allows the evaluation of the element thicknesses in
the graphics area.
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The Discrete Thickness legend always lists the thickness values from lowest to highest. If further
elements are displayed and these elements have a thickness assigned, which is not yet shown in the
legend, the legend will be updated appropriately and the new thickness value will be properly sorted
among the other thickness values.

Note:  When the number of different thicknesses to be displayed exceeds 25, HyperMesh
automatically switches to the Ranged Thickness legend.

The slider, in the upper-left corner of the Discrete Thickness legend, can be used to change the display
of elements beyond the threshold value. Elements can be hidden, or can be shown as transparent or
wireframe. Clicking on the Operator Sign below the color bar changes it from ‘smaller than’ to ‘larger
than’ and vice versa.

Reposition the slider by clicking-and-dragging it to the desired value on the legend. Same can be
reached by clicking onto the thickness threshold value next to the operator sign and entering a new
value. The value will be rounded to the next available thickness value.

Modify colors by clicking a color in the legend and selecting a new one from the color palette.

Figure 963:
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Figure 964:

Ranged Thickness Legend
The Ranged Thickness legend consists of a color coded sliding scale. The colors exhibited reflect the
thicknesses of each 2D element in the graphics area.

The Ranged Thickness legend always lists the thickness values from lowest to highest. Edit these values
by clicking on them and entering a new value. The remaining thickness values are interpolated between
other edited values and the lowest and highest value in the legend.

Note:  Reset a value by clicking it and leaving the field empty. The value will be re-
interpolated.

You can also edit the lowest and highest values, but the values cannot exceed the minimum and
maximum thicknesses in the range.

The slider, in the upper-left corner of the Ranged Thickness legend, can be used to change the display
of elements beyond the threshold value. Elements can be hidden, or can be shown as transparent or
wireframe. Clicking on the Operator Sign below the color bar changes it from ‘equal or smaller than’ to
‘equal or larger than’ and vice versa.

Reposition the slider by clicking-and-dragging it to the desired value on the legend. Same can be
reached by clicking onto the thickness threshold value next to the operator sign and entering a new
value. The value will be rounded to the next available thickness value.
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Modify colors by clicking a color in the legend and selecting a new one from the color palette.

Figure 965:
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Figure 966:
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Figure 967:

Thickness View and Plies
The Discrete Thickness legend and the Ranged Thickness legend are both capable of showing ply
thicknesses. Any combination of 2D Detailed Element Representation and Composite Layer Visualization
is supported.
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Figure 968:

Figure 969:

Thickness View Context Menu
Use the right-click context menu to dictate the Thickness View. To access the Thickness View context
menu, right-click on the ranged or discrete legend.

Beyond Threshold As
Change how the elements that have no results or have higher/lower values are displayed in the
graphics area. The following display options are available: Transparent, Feature Lines, and Off
(default).

Ranged Legend
Set/unset the check for the Ranged Legend.
When this option is set or the number of thicknesses to be shown exceeds 25, the Ranged Legend
is used. When Ranged Legend is unset, the Discrete Legend is used.
This option is only available when the number of visible thicknesses is equal or less than 25.
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Reset
Restores the legends to their initial default settings, that is colors, values, and number of levels.

Number of Levels
The number of levels describe how many colors the colorbars are displayed. It can be set to any
value between 2 and 15 (Ranged legend only).

Check and Fix Boundary Shell Intersections
Validate the input surface mesh before performing volume mesh generation using the Boundary Shell
Checker.

Before you can invoke the Boundary Shell Checker, select the input shell mesh, forming the closed
volume.

1. Open the Boundary Shell Checker.

• In the CFD tetramesh panel, click check 2D mesh.

• In the tetramesh panel, click check 2D mesh.

• In the Mesh Controls browser, right-click on a Volume Mesh control and select Check 2D
Mesh from the context menu.

2. Check your mesh by defining check options and clicking Check.

Option Description

Proximity
tolerance

Perform a proximity check for the selected shell elements forming one
volume. This check will detect a penetration (for example two elements
cutting each other) as well as an "almost" penetration (for example one
node is very close to an element). To detect the latter situation, a proximity
tolerance can be specified. The actual search tolerance is relative to the
local minimum edge length and is defined by search tol. = (proximity tol) *
(local min. edge length). The failed elements are duplicated and are placed
in the component ^error_elems.

Figure 970: Penetration Example
A penetration, where two or more elements are cutting each other.
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Option Description

Figure 971: Almost Intersection
A "almost" interaction, where one mesh node is very close to the shell elements. The node and

shell elements belong to the same volume.

Dihedral angle < Check the selected input mesh for adjacent elements which form a sharp
angle, for example a needle pocket. The threshold angle is user defined.
The failed elements are duplicated and are placed in the component
^error_elems.

Figure 972: Needle Pocket
The involved elements form a sharp pocket pointing outwards of the volume.

Per vol check Find the intersections that are only within the shell volumes. Intersections
across volumes and open shells will not be found. If this checkbox is
disabled, intersections will be checked for all of the input elements/
components even if the input shells do not form closed volume.

Along with intersecting and diehedral elements, all duplicate elements and
close proximity elements within the user defined tolerance will also be
found. All of the failed elements will be placed into a separate component
for review.
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Option Description

^err_x_elems
Contains intersecting elements.

^err_agl_elems
Contains failed dihedral angle check elements.

^err_prx_elems
Contains close proximity elements within the user defined tolerance.

^minus_prx_elems
Contains close proximity elements for a per volume check which has
opposite orientation. These elements are safe for volume meshing.

^minus_agl_elems
Contains dihedral angle check elements for a per volume check
which has opposite orientation. These elements are safe for volume
meshing.

^err_dup_elems
Contains duplicate elements.

Results to sets Find issues in sets, and create new components.

Results by cluster Create separate error element components/sets according to how they are
clustered.

3. Fix your mesh by defining fix options and clicking Fix.

Option Description

Fix intersection Resolve intersections identified within selected components. This option is
useful when you want to remove localized intersections within your model
before tetrameshing

Fix aspect ratio > Fix elements organized within selected components that are higher than
the defined aspect ratio. Surface elements that have a high aspect ratio can
result in a poor quality tetramesh.

Fix surface
element

Fix elements organized within selected components that are higher than
user defined height.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.2035

Option Description

minimum height
<

Solid Mesh Optimization
The Solid Mesh Optimization tool can be used to improve the quality of a tetra, hexas, and second order
meshes with respect to several element criteria.

Solid Mesh Optimization Tetras
This topic covers solid mesh optimization for tetras.

In this task you will learn about tetra meshing.

1. To access this utility, click Mesh > Check > Elements > Solid Mesh Optimization.

2. Select a set of elements to fix using the Input selection collector.

3. Complete the Tetras table items by entering the appropriate values.

For more information on table items, refer to the Altair HyperMesh Element Quality Calculation
section.

4. Select a Triangles option.

Fix All
All triangles are fixed during optimization.

Edge Swap
Edges of boundary triangles can be swapped during optimization. Node locations of
boundary triangles are not modified.

Remesh
Boundary triangles can be remeshed during optimization. This option usually yields the best
results.

5. Set Constraints options according to the following table.

Constraint Action

Fixed Trias Set this constraint to Elements if you do not want to modify tria
elements during the optimization step. This constraint is only
available if Edge Swap or Remesh is selected under Boundary
triangles.

Feature Line Set this constraint to Elements to mark feature lines by 1D
plot elements that coincide with element edges. Selecting those
1D edges ensures that the corresponding element edges are
not modified during the optimization step. This option is only
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Constraint Action

available if Edge Swap or Remesh is selected under Boundary
triangles.

Anchor Nodes Set this constraint to Nodes so that selected mesh nodes are not
modified during the optimization process.

Refinement Box Set this constraint to Elements so that elements inside the
refinement box are remeshed and optimized with respect to the
defined thresholds.

6. Check the Fix Shell Comp Boundaries option to maintain the edges between two components
during the optimization step.

This is useful when the interface between a solid and a fluid component has to be maintained.

7. Check the Maintain Geometry Edges option so that nodes on a geometry edge are not modified
during optimization.

8. Check the Save to Current Comp option to save elements generated during optimization to the
current component.

9. Check the Update Input Shells option to update shell elements attached to modified tetra
elements.

This option is only available if Edge Swap or Remesh is selected under Boundary triangles.

10. Check the Optimize Tetras by Force option to include a node insertion algorithm.

This usually yields a higher element quality in the resulting mesh, but in return might also
increase the computation time.

11. Enter the maximum number of optimization steps in the Maximize Iteration field.

12. Enter an angle in the Feature Angle field that will be considered a feature edge and that will be
preserved during the optimization step.

If the angle of two adjacent shell elements is greater than this angle, the edge will be preserved.

13. To show elements that have failed, click Show Failed.

Only the elements that have failed the selected element criteria will be displayed. Click this button
again to redisplay all elements.

14. To perform an element check based on the defined parameters in the Criteria Editor, click
Check.

Mesh statistics will be displayed in the table.

15. To start the optimization process, click Fix.

16. To re-establish the initial tetra mesh and reject the modified mesh, click Reject.
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17. When you are finished, click Close.

Solid Mesh Optimization Hexas
This topic covers solid mesh optimization for hexas.

In this task you will learn about hexas meshing.

1. To access this utility, click Mesh > Check > Elements > Solid Mesh Optimization. Then click
the Hexas tab.

2. Select a set of elements to fix using the Input selection collector.

3. Complete the Hexas table items by entering the appropriate values.

4. Define the relative weight for the active quality criteria.

Criteria with a higher weight will get higher preference in case of conflict.

5. Check the Allow Boundary Node Movement option to allow for node movement on or normal to
the boundary.

If you check this option, you can define the following fields:

Option Description

On Geometry: Maximum Node Movement/
Element Size

Enter a value in this field that defines the
maximum node movement allowed on
geometry to fix hex quality as a factor of the
hex element.

Away From Geometry: Maximum Node
Movement/Element Size

Enter a value in this field that defines the
maximum node movement allowed away from
geometry to fix hex quality as a factor of the
hex element.

Feature Angle Enter a value in this field that identifies the
feature edges on which node movement will be
restricted along the edges only.

6. Enter a value in the Maximum Iterations field that defines the number of maximum iterations to
go through to fix quality.

Hex quality improvement will terminate if quality is not fixed within the defined iterations.

7. Check the Show Original Face Node Location option to create temporary nodes showing input
node positions that were moved during optimization.

8. To show elements that have failed, click Show Failed.

Only the elements that have failed the selected element criteria will be displayed. Click this button
again to redisplay all elements.

9. To perform an element check based on the defined parameters in the Criteria Editor, click
Check.

Mesh statistics will be displayed in the table.
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10. To start the optimization process, click Fix.

11. To re-establish the initial hexa mesh and reject the modified mesh, click Reject.
12. When you are finished, click Close.

Solid Mesh Optimization Second Order
This topic covers second order mesh optimization.

In this task you will learn about second order meshing.

1. To access this utility, click Mesh > Check > Elements > Solid Mesh Optimization. Then click
the Second Order Elements tab.

2. Select a set of elements to fix using the Input selection collector.

3. Define the element maximum angle, minimum and maximum length ratio, and Jacobian
thresholds.

4. Select the appropriate option in the Evaluate Jacobian at field.

5. Select the appropriate options in the Middle Nodes Repositioning field:

a) Check Internal Nodes to allow mid tetra nodes located interior to volume mesh.

b) Check Boundary Node options to allow mid tetra nodes located on the boundary. Move
Along Geometry First enables tetra mid nodes along geometry to fix quality. Move Off
From Geometry enables tetra mid nodes away from geometry to fix quality.

Tetra mid nodes will only be moved away from geometry, if moving nodes along geometry
does not fix quality.

6. To perform an element check based on the defined parameters in the Criteria Editor, click
Check.

Mesh statistics will be displayed in the table.

7. To start the optimization process, click Fix.

8. To re-establish the initial second order mesh and reject the modified mesh, click Reject.
9. When you are finished, click Close.

Check for Element Penetrations/Intersections
Penetration is defined as the overlap of the material thickness of shell elements, while intersection is
defined as elements that actually pass completely through one another.

Figure 973: Penetration and Intersection
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Restriction:  Penetration checking is supported by all of the impact solver interfaces, such
as LS-DYNA, Radioss and PAM-CRASH, and works best with a solver interface that supports
thickness data for modeled shell elements. The default HyperMesh solver interface does not
support modeled element thickness, but the penetration checking tools can still be used to
specify a uniform thickness when performing a check.

• You can only set up and initiate the check in the Penetration panel; the majority of the checking
tool actually resides in a special tab that opens in the tab area. However, this tab only displays after
you complete the panel and run an initial check.

• When the penetration check runs, it automatically masks (hides) everything in your model except
for the penetrating or intersecting elements. It then fits the view to these elements’ components.
You can show or hide additional elements using toolbar buttons located in the Penetration tab, and
you can make other entity types, such as ellipsoids, visible again via the Display panel or the Mask
panel.

• Solid entities never register penetrations between each other; instead, any overlap between solids
registers as intersections, because one or more of each the solid’s faces intersect. A solid that is
completely contained within another solid will not be detected as an intersection or penetration,
because its faces will not intersect any of the larger (containing) solid’s faces. In addition, only
surface elements register penetrations; the tool cannot find penetrations between internal, that is,
tetra- or hexa-, elements.

Figure 974: Intersections Found Figure 975: No Intersections

• Solids can register penetrations with respect to adjacent shell elements, based on the thickness of
the shell elements.

1. From the Tools page, click Penetration.

2. Use the entity selector to select entities to be checked for penetrations or intersections.

In any case, the penetrating elements will be found; for example, picking two components locates
elements from each component that penetrate elements of the other.

3. Select the type of interferences to check for.

Choose all interferences, intersections only, or penetrations only.
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Note:  Solid entities only register penetrations in conjunction with shell elements. With
other solids, they only register intersections.

4. Select the type of elements to check.

Choose 2D and 3D elements, 2D only elements, or 3D only elements.

If you choose 2D only elements or 3D only elements, HyperMesh only checks elements of the
specified type for penetration. Elements in the selected entities which are not of that dimensional
type will be ignored, even if they penetrate or intersect another entity.

5. To enter a tolerance for penetration checking, select the allowable interference depth
checkbox.

For example, if you check a model of a part measured in millimeters, and are not concerned
about penetrations of less than a tenth of a millimeter, you could set this field to a value of 0.1.
The penetration tool would then ignore any elements that penetrated each other by 1/10 of a
millimeter or less, but still locate and highlight elements with a penetration depth greater than
1/10 mm.

Some solvers will not permit direct, adjacent contact between elements, for example a penetration
depth of exactly zero, with no space between elements. For such solvers, you should set this
field to any negative value, such as -0.1. This allows the penetration tool to locate and display
elements that are exactly adjacent to one another as if they were penetrating each other, so that
you can use the penetration fixing tools to add some space between them.

6. Select a method adjusting thickness.

Not available when you run the check on groups, because a group’s thickness is defined by its
control card.

• Choose Component thickness to use the thickness value specified in a component’s
property card for each element within that component.

• Choose thickness multiplier to enter a value to multiply the selected entities’ thickness by
for purposes of the penetration check. Fractional numbers are acceptable, but negative ones
are not.

• Choose uniform thickness to enter a thickness value.

This can be used to work around the lack of thickness information in the default HyperMesh
user profile, or when working with models that do not have a thickness specified.

You can also use this option to determine the proximity between non-penetrating parts by
specifying a thickness greater than the minimum distance between the selected elements.

7. To check for components that intersect or penetrate themselves, for instance, due to high
curvature in the component, select the include self interference checkbox.

This option is computationally intensive, therefore it is not recommend that you use it when
checking large numbers of elements for penetration.

8. Click check.

The selected components, elements, or groups are checked for penetration and/or intersection. A
message in the status bar displays the percentage progress of each step in the check.
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If for some reason you wish to abort a check, you can do so by right-clicking in the graphics area and
holding the button down. The exact length of time that you must hold the button depends on the size
and complexity of the check you are running; the check will cancel once its completion percentage
increments. When the check aborts, the status bar turns red and displays a message stating that the
check was canceled.

Once the penetration/intersection check is complete, view the results of the check and make
adjustments.
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Edit Mesh
Modify your mesh by detect holes, locating edges or features, refining mesh pattern, and so on.

Detect Holes
Locate holes in a model, and potentially all of them, define them, and add them as geometry to a new
component or to the current one.

You can specify many types of criteria to define specific types of holes that you wish to find.

1. From the menu bar, click Check > Components > Hole Detection.
The Hole Detection dialog opens.

2. Prepare for hole detection.

a) Click the Preparation tab.

b) For Select entities, use the selector to select the components to scan for holes.

c) For Detect holes in, select the types of elements to find holes.

d) In the 2D adjacent face deviation angle field, enter the maximal angle deviation of the holes
axial direction of adjacent element normals.

Acceptable values range between 0.0 and 90.0 degree. Lesser values will result in a default
of 45.0 degrees.

e) For 3D solid hole feature detection, select a method for detecting holes.

• Choose By specified angle to enter the exact angle of holes you wish to detect.

• Choose Auto using angle to enter upper and lower limits of hole angles that you wish
to detect. Holes with feature angles beyond either of these numbers will be ignored.

Holes in 3D solids are assumed to have an opening on one or more faces of the solid. You
can base detection on each hole's feature angle, that is, the angle at which the hole deviates
from the face in which its opening appears.

Figure 976:

In either case the values must be more than zero (zero would be perfectly collinear with
the face) but no greater than 90 degrees, which represents a hole that runs perfectly
perpendicular to the face.

f) Click Run.
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3. Define the type of holes to find in 2D mesh.

a) Click the 2D Holes tab.

b) For Hole type, select the type of opening for the 2D shape.

Options include circular, including ovals, square, rectangular, and general (all shapes).

c) To define a specific hole width to find, regardless of shape, select the Minimum dimension
and/or Maximum dimension checkboxes and enter a dimension.

If set at or below zero, these checks are not run.

Figure 977:

d) To check each node on the edge of a hole, relative to the plane that best approximates all
of the nodes on the hole's edge, select the Offset plane deviation checkbox and enter a
distance measurement.

Any nodes further than this distance from the midplane of the bounding box will cause the
tool to ignore the hole. If this value is set to zero or less, the check is not run at all on any
holes.

e) Choose which component the found holes are placed into.

• Choose Auto to organize holes in the ^edges_holes_shell component.

• Choose Elems to current comp to organize holes in the current component.

f) Click Find.

All 2D holes matching the criteria are located.

4. Define the type of holes to find in 3D mesh.

a) Click the 3D Holes tab.

b) For Hole type, select the type of opening for the 3D shape.
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Options include circular, square, rectangular, and general (all shapes).

c) To define a specific width of the hole's opening to find, regardless of shape, select the
Minimum dimension and/or Maximum dimension checkboxes and enter a dimension.

This carries over from the 2D tab because the openings themselves are 2D edges. If set at or
below zero, these checks are not run.

Figure 978:

d) To define the depth of the hole, regardless of shape, select the Minimum height and/or
Maximum height checkboxes and enter a height.

If set at or below zero, these checks are not run.

Figure 979:

e) To check each node on the edge of a hole, relative to the best-fit bounding box that
encompasses all of the nodes on the hole's edge, select the Offset plane deviation
checkbox and enter a distance measurement.

Any nodes further than this distance from the midplane of the bounding box will cause the
tool to ignore the hole. If this value is set to zero or less, the check is not run at all on any
holes.

Figure 980:
With very low plane deviation, the red node might invalidate this hole.
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f) To search for specific tapered holes; this is the maximum angle between the hole's sides, and
a planar cross-section that is perpendicular to its length, select the Cone angle checkbox
and enter an angle.

A value of 90 represents a hole that does not taper at all. Holes with a taper at or below the
specified angle, that is, tapers sharper than the specified angle, will be found, while tapers
above it, that is, closer to being a straight shaft, will be ignored. The default value is 80.0
degrees; if less than or equal to 0.0 the cone angle check is not run.

Figure 981:

g) Choose which component the found holes are placed into.

• Choose Auto to organize holes in the ^edges_faces_solid component.

• Choose Elems to current comp to organize holes in the current component.

h) To generate elements around the perimeter of the hole edge, select the Create edges
checkbox.

These new elements are organized into a component called ^edges_holes_shell.

i) For Hole Handling, choose whether to find Open holes, Capped holes, or All holes.

Figure 982:

j) Click Find.

All 3D holes matching the criteria are located.

Refine Mesh by Pattern
Create a regular orthogonal mesh.

Before you begin, make sure the initial mesh is a regular mapped quad mesh, and not a free quad
mesh.
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Figure 983: Pattern Based Mesh Refinement

1. From the menu bar, click Mesh > Edit > Elements > Refine by Pattern.
The Mesh Refinement dialog opens.

2. Use the Select node: Nodes selector to select the center node to start the uniform mesh
refinement.

Figure 984:

3. For Select system, select a global or local system to be used for mesh propagation and box
alignment directions.

4. Define the Refinement box, which determines the constant refinement zone.

Elements inside this box should be the same size.

a) In the mesh size field, enter the fine mesh size.

The size should be smaller than the initial mesh.

b) In the Length field, enter the length of the refinement box.

c) To preview the box, click Review.
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Figure 985:

5. Define the Transition box.

a) In the Length field, enter the length of the transition box.

The mesh will be transitioned to match the initial mesh.

Note:  The transition box should enclose the refinement box. The size of
the transition box determines how aggressive the transition will be. It is
recommended that you limit the transition to 1 element connection 3 elements
(1:3).

b) To preview the box, click Review.

6. Click Mesh.
Attached 1D elements are refined.
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Figure 986:

Scale Element Thickness
Scale the thickness of elements in your model.

Restriction:  Only available in the LS-DYNA, Radioss and PAM-CRASH 2G solver interfaces.

1. From the menu bar, click Mesh > Edit > Elements > Scale Thickness.
The Scale Thickness dialog opens.

2. Under Thickness location, define the thickness location of the entities you want to scale. By
defining the minimum thickness and/or the maximum thickness, the scaled thickness will not
go below the minimum and beyond the maximum thickness mentioned.

a) In the Minimum thickness field, enter a thickness the scaled thickness will not go below.

b) In the Maximum thickness field, enter a thickness the scaled thickness will not exceed.

Note:  Nodal thickness on elements is only available in the LS-DYNA solver interface.

Figure 987:

3. Under Selection, select entities to scale.

• Choose All to select all of the entities in your model.

• Choose Entities to use the Elements selector to manually select entities.
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Figure 988:

4. Under Scale by, choose whether to multiply, add, or subtract the existing thickness with a desired
value.

To subtract from the thickness, select Add and enter a negative value.

Note:  You cannot multiply with a negative value.

Figure 989:

5. Click Calculate.
Thickness is scaled.

Scale Thickness Behavior
Solver interface specific behavior for scaling the thickness of elements.

LS-DYNA
You can only perform thickness operations on *ELEMENT_SHELL_THICKNESS
and *ELEMENT_SHELL_COMPOSITES elements. If the card image of elements is
*ELEMENT_SHELL_COMPOSITES, then the total thickness will be calculated using the sum of all the
THICK attributes. Scaling will be done in proportion with all the thickness attributes.

For example, consider the number of plies is four and the THICK attributes are: THICK(1) = 2,
THICK(2) = 4, THICK(3) = 6, THICK(4) = 8. The total thickness will equal 20. If you add two to this
thickness, then after scaling the thickness of these attributes will be: THICK(1) = 2.2, THICK(2) = 4.4,
THICK(3) = 6.6, and THICK(4) = 8.8. After scaling, the total thickness will become 22.

Radioss
You can only perform thickness operations on /SHELL/ and /INISHE cards. /INISHE supports the
following three cards: /INISHE/EPSP_F, /NISHE/STRA_F, and /INISHE/STRS_F. If the thickness
attribute of /SHELL is not defined and /INISHE is not available, then the thickness will either be defined
by the Property or Component. As of now, the thickness of Property and Component entities cannot be
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assigned using the Scale Thickness tool, therefore thickness will be assigned to the /SHELL thickness
attribute.

PAM-CRASH 2G
You can perform thickness operations on elements with card image SHELL and TSHEL for the attribute
"T". You also perform thickness operations on components that have the card image SHELL, TSHEL, or
MEMBR for the attribute H. There is no impact on thickness for the TCONT contact.

Calculate and Assign Midmesh Thicknesses
Calculate and assign the thickness of a midmesh from solid geometry using the Midmesh Thickness
tool.

The thickness will be assigned to the midmesh either on node card, element card, nodal thickness on
element card, or as properties on elements or components depending on the solver profile you are
using.

Restriction:  Only available in the OptiStruct, Radioss, Abaqus, LS-DYNA, PAM-CRASH 2G,
or Nastran solver profiles.

From the menu bar, click Mesh > Edit > Elements > Midmesh Thickness.

Select Midmesh and Solid Inputs
The midmesh and solid can be specified by manually selecting entities from the current HyperMesh
session, or by selecting external geometry or FE solver decks as input.

Figure 990: FE and Geometry with Traditional Element Visualization

Select midmesh and solid inputs.
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To select input from Do this

External geometry/FE
solver decks

1. For input, choose From file.

2. For Solid geom/mesh, choose whether to select geometry or FE
(mesh), then navigate to the file that contains the input.

3. For Midmesh, navigate to the file that contains the midmesh.

Existing entities 1. For input, choose Select entities.

2. Use the Solid geom/mesh selector to select input.

3. Use the Midmesh selector to select input.

Define Thickness Output
Calculate and assign a thickness on the midmesh.

1. Select a Thickness output.

Output Description Solver Profile

Nodes Assign a thickness on node cards. Abaqus

Elements Assign a single thickness on the element card. Abaqus

LS-DYNA

PAM-CRASH
2G (TSHELL
and SHELL card
image)

Radioss

Nodal thickness on
elements

Assign multiple thicknesses on elements for
each node.

LS-DYNA

Nastran

OptiStruct

Properties on elements Create properties for groups of elements, and
assign a thickness to each property.

Abaqus

Nastran

OptiStruct

Samcef

Properties on
components

Create components and properties for groups
of elements, assign a thickness to each

Abaqus
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Output Description Solver Profile

property, and then assign the property to
the corresponding component. The original
components are duplicated, thus maintaining
relevant information and attributes.

ANSYS

LS-DYNA

Nastran

OptiStruct

Samcef

Select card image

Select property/section
card image

Select property card
image

Select the card image to use for the relevant
thickness assignment.

This varies depending on the solver profile and
the type of thickness output selected.

Abaqus

ANSYS

LS-DYNA

OptiStruct

Radioss

Components

Contact thickness

Assign thickness/contact thickness on PART. PAM-CRASH 2G

Prefix Define the prefix for generating property
names.

Abaqus

ANSYS

LS-DYNA

Nastran

OptiStruct

PAM-CRASH 2G

2. Define thickness options.

Option Action

Minimum thickness/
Maximum thickness

Define a thickness to assign calculated thicknesses.

• To enter a minimum thickness to assign calculated thicknesses
below a specified value, select the Minimum thickness
checkbox.

• To enter a maximum thickness to assign calculated thicknesses
above a specified value, select the Maximum thickness
checkbox.

Assign offset to
elements/sections

To assign an offset value to elements if they are not in the middle
of the selected geometry, select the Assign offset to elements/
sections checkbox.
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Option Action

Figure 991: 2D Detailed Element Representation On, No Element Offset On
The mesh deviates from the geometry; the midmesh node is equidistant from mesh

corners, but not from the nodes on the geometry corners.

Figure 992: 2D Detailed Element Representation On, Element Offset On
Offset has caused the mesh to match the geometry, though the initial midmesh node

remains unchanged, such that it now matches the geometry.

Assign average
thickness to element
groups

To approximate the thickness values on individual elements to be an
average value representing a group of elements, select the Assign
average thickness to element groups checkbox.
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Option Action

Note:

Only available when Thickness output is set to
Elements.

Consider a model which has a thickness variation as shown in
Figure 993. If you assign thickness on elements, by default you will
get a highly variable distribution.

Figure 993:

Each row of elements is assigned a different thickness, resulting in 
various thicknesses, even if the solid was captured accurately.

Enabling Assign average thickness to element groups groups 
elements with similar thicknesses together, and assigns an average 
thickness to the groups. In Figure 994, the middle region of the
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Option Action

model is assigned a single thickness and the right section is assigned
fewer steps. The accuracy of the model captured is reduced.

Figure 994:

Note:  This is the default behavior if the Thickness
output option is set to Properties on elements or
Properties on components.

Maximum thickness
range interval

Control how similar thickness elements are grouped together.

• Choose Rel (relative interval value) to specify a relative interval
value, which defines the relative width of each thickness band.

For example, suppose you enter a Rel value of 0.2. Starting
from the element with the smallest thickness, elements with
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Option Action

similar thickness are grouped together, such that the difference
between maximum and minimum thickness in one group does
not exceed 0.2 times the maximum thickness in the group.
The thickness values of elements in a group is averaged and
assigned to all of the elements in the group (or to the property.)

• Choose Abs (absolute interval value) to specify a value to use
as the cut off for the maximum range of the thickness in a
group.

If this value is 0.5, the difference between maximum and
minimum of the thickness values in a group / property will be a
maximum of 0.5.

Smaller values result in a larger number of properties that will
be created, allowing the thickness variation to be captured more
accurately.

Figure 995:
Assign average thickness to element groups: On / Maximum thickness range interval: 

Rel = 0.5.
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Option Action

Figure 996:
Assign average thickness to element groups: On / Maximum thickness range interval:

Rel = 0.2.

Note:  Available when Assign average thickness to
element groups is enabled, or if thickness output
is set to Properties on Elements or Properties on
Components.

Fixed interval with start
thickness

Control thickness properties at constant intervals.

Enter a desired thickness value in the Start thickness field, and a
thickness interval value in the Interval field. All elements will be
grouped into properties/components with fixed increments to the
thickness specified by the interval value, beginning with the start
thickness value.

Truncate thickness to
range interval

Round the thickness values up or down to have the same number
of decimal digits as the input value in the Maximum thickness range
interval field..

There are three modes available. Automatic determines an optimal
truncation.

3. To save the information logged during the computation in a specified file, select the Save log file
checkbox.

4. Define advanced options.
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Option Action

Correction method Select a correction method to perform on elements or nodes where
the thickness could not be computed correctly.

• Choose Interpolate from Neighbors to interpolate an
appropriate thickness value from the neighboring element/node
thickness.

• Choose Adjust to min/max values to assign either minimum
or maximum thickness, if they are defined, to the corrected
elements.

Scaling at corners
[0,10]

Enter a scaling factor to use when interpolating thickness values
near t-junctions or corners.

A value less than 1 will result in linear decrease in the thickness
values nearer to the junction/corners. A value of zero will result in
an approximate mass-conserved thickness estimation. When equal
to 1, the thickness is extrapolated / interpolated without any scaling.
When greater than 1, the thickness will increase as you go closer to
the junction.

Only available when the Correction method is set to Interpolate
from Neighbors.

Figure 997: Scaling at corners
= 0, Thickness Contour Applied,
Traditional Element Visualization

Figure 998: Scaling at corners =
0, Thickness Contour Applied, 2D
Detailed Element Representation
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Option Action

Figure 999: Scaling at corners
= 1, Thickness Contour Applied,
Traditional Element Visualization

Figure 1000: Scaling at corners =
1, Thickness Contour Applied, 2D
Detailed Element Representation

Max midmesh / solid
angle [0.1,90]

Enter the cut-off angle in degrees.

Enter the maximum angle (0 to 90) that the mid-mesh makes with
the solid, beyond which the estimated thickness will be ignored and
corrected.

For example, the images below show the midmesh in blue, and the
solid in black. In the first image the midmesh and the solid form a
moderate angle. However in the second image the midmesh and the
solid form a larger angle. It is possible that this area is a junction,
located at the solid edge, or the solid may contain some noisy
features, therefore you may want to ignore the calculated thickness
and interpolate that value from surroundings.

Figure 1001:
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Option Action

Max thickness gradient
[0, 10]

Measures the change in adjacent thickness values, and restricts the
gradient.

Enter the maximum change in thickness allowed across two adjacent
measurement locations, as a factor of the distance between the
locations. Allowable factors range from 0 to 10.

For example, the image below shows a tiny projected boss in an
otherwise planar area, which you may want to ignore. Defining
the Max thickness gradient specifies the cut-off for the ratio of
difference in thickness at two locations to the distance between
the two locations. If the ratio is more than the given value,
the measured thickness is discarded, and interpolated from its
neighbors.

Figure 1002:

Max relative faceting
error

Enter a maximum relative faceting error to use during faceting
calculations.

When HyperMesh computes the proximity with a solid, it does not
actually compute with the surface geometry. Instead, HyperMesh
computes with the tessellated approximation (facets) of the
geometry. In case of curved geometry, the facets may not exactly
match the geometry, and hence the thickness is computed, causing
faceting errors. Specifying the Max relative faceting error enables
you to control the accuracy of the tessellation used, as a factor of
the estimated thickness. The Max relative faceting error is the
ratio of the maximum error of facets to the estimated thickness. If
it exceeds this value, facets are further refined to better capture the
geometry.

Max search distance Enter the maximum distance which will be considered for searching
solid proximity. This value is also used to restrict the maximum
distance from which a good thickness value is considered for
correcting an incorrect thickness estimate. You can also used this
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Option Action

option to restrict the algorithm from assigning incorrect thicknesses
for the mid-mesh that is out of the solid proximity.

Do not assign thickness
to midmesh outside
solid

Do not assign a thickness to the midmesh outside of the solid.

5. Click Calculate Thickness.

The thickness is computed and assigned on the midmesh.

Define Visualization Settings
Define visualization settings for the midmesh.

Define visualization settings for the midmesh.

Option Action

Element coloring by
thickness

Set the Element Color mode to By Thickness resulting in a contour
plot of thickness.

Figure 1003: Thickness Contour Applied, 2D Detailed Element Representation

2D detailed element
representation

Display midmesh elements as 2D with the assigned thickness as depth.
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Option Action

Figure 1004: 2D Detailed Element Representation

Assigning a thickness for each individual node or element, enables
you to assign a variable thickness to elements. You can visualize both
the element and nodal thickness in the graphics area by selecting 2D
Detailed Element Representation from the Visualization toolbar.

The behavior of 2D Detailed Element Representation depends on what
you assigned a thickness to. For example, if you assign a component
an element thickness, then the element thickness representation will
be displayed. If you assign a nodal thickness to an element node, then
each individual node thickness will be plotted and you will be able to
see the first and second order trias and quad elements. When you
assign a nodal thickness, you can select the By Thickness option in the
Visualization toolbar to display each node value. If you assign a nodal
thickness, and offset is on, then the element thickness from the nodes
will be calculated, the element will be offset, and the nodal thickness 2D
Detailed Element representation on the offset elements will be plotted.

Restriction:  Composites with variable thickness are not
added for this feature.

Highlight corrected
elements

Highlight the elements whereby the thickness could not be calculated
from solid, and deploy the correction method.
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Option Action

Figure 1005: 2D Detailed Element Representation, Corrected Elements
Highlighted

Midmesh Thickness Assignment Behaviors
Common and solver interface specific behavior for assigning thicknesses to the midmesh.

Abaqus
In Abaqus, you can use the Map Midmesh Thickness tool to estimate and assign a midmesh thickness
to nodes, elements, or properties. The midmesh thickness behavior is very similar amongst all of
the entity types except elements. In cases of elements, tables with element IDs and thicknesses are
created.

Nodes

• Creates a single node set named HM_NodalThickness with a Nodal_Thickness card image.

• You need to create a property and assign it to the selected 2D elements.

• Adds the relevant nodes to the node set.

• Assigns a single thickness to each node using the attribute ThicknessValue.

Elements

• Creates a single table named HM_ElementThicknesss with a Nodal_Thickness card image
Distribution_Table.

• You need to create a property and assign it to the selected 2D elements.

• Assigns a single thickness to each element using the attribute ThicknessValue.

Properties on elements

• Based on the thickness, multiple properties with either SHELLSECTION or SHELLGENRALSECT
card images are created.

• Creates corresponding materials and properties named thickness_t.
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Note:  During creation, you are able to enter a name for the property and
material.

• Assigns a property to the selected 2D elements.

Properties on components

• All the options mentioned above, are applicable for Properties on components, except the
properties are assigned to components instead of elements.

ANSYS
In Ansys, you can use the Map Midmesh Thickness tool to estimate and assign a midmesh thickness
to properties.

Properties on components

• Based on the thickness, multiple properties/sections with the REAL SET or SECTYPE card
images are created.

• Creates corresponding properties/sections named thickness_t.

Note:  During creation, you are able to enter a prefix for the property/section.

• Assigns a property to the components.

LS-DYNA
In LS-DYNA, you can use the Map Midmesh Thickness tool to estimate and assign a midmesh
thickness to elements or to each node on corresponding elements.

Nodal Thickness onn Elements

• If you select Nodal thickness on elements, a thickness is assigned to each node on
corresponding elements. A thickness will be assigned to nodes that have the following THIC
attributes of the *ELEMENT_SHELL_THICKNESS card: THIC1, THIC2, THIC3 and THIC4.

Elements

• If you select Elements, a thickness is assigned to the THIC1, THIC2, THIC3, and THIC4
fields of the card *ELEMENT_SHELL_THICKNESS. A single value thickness will be assigned to
all of the thickness attributes of the element.

Note:  If the element is of type TRIA, then a THIC3 thickness will be assigned to
THIC4. If you change the view to 2D Detailed Element Representation from the
Visualization toolbar, then THIC4 will be ignored for TRIA elements.

Properties on Components

• Based on the thickness, multiple properties with SHELLSECTION card images are created.

• Creates corresponding materials and components named thickness_t.
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Note:  During creation, you are able to enter a name for the property and
component.

• Assign a property to the components that were created.

Write INCLUDE_STAMPED_PART

• If you select this checkbox, an include file is created for each component selected for the run.
A system collector is also created with the card image includeStampedPart, and associate it
to the created include file.

Note:  Only valid for the Thickness output options Elements and Nodal
thickness on elements. It is not supported for Properties on Components.

Nastran
In Nastran, you can use the Map Midmesh Thickness tool to estimate and assign a midmesh thickness
to properties or each node on corresponding elements.

Nodal Thickness on Elements

• If you select Nodal thickness on elements, a thickness is assigned to each node on
corresponding elements. A thickness will be assigned to the T1, T2, T3 and T4 attributes.

Properties on elements

• Based on the thickness, multiple properties with either PSHELL or PCOMP card images are
created.

• Creates corresponding materials and properties named thickness_t.

Note:  During creation, you are able to enter a name for the property and
material.

• Assigns a property to the selected 2D elements.

Properties on components

• All the options mentioned above, are applicable for Properties on components, except the
properties are assigned to components instead of elements.

Altair OptiStruct
In OptiStruct, you can use the Map Midmesh Thickness tool to estimate and assign a midmesh thickness
to properties or each node on corresponding elements.

Nodal Thickness on Elements

• If you select Nodal thickness on elements, a thickness is assigned to each node on
corresponding elements. A thickness will be assigned to the T1, T2, T3 and T4 attributes.

Properties on elements

• Based on the thickness, multiple properties with either PSHELL or PCOMP card images are
created.
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• Creates corresponding materials and properties named thickness_t.

Note:  During creation, you are able to enter a name for the property and
material.

• Assigns a property to the selected 2D elements.

Properties on components

• All the options mentioned above, are applicable for Properties on components, except the
properties are assigned to components instead of elements.

PAM-CRASH 2G
In PAM-CRASH 2G, use the Map Midmesh Thickness tool to estimate and assign a midmesh thickness
to elements or components. You can also maintain the thickness for a contact (TCONT) to be the same
as element thickness (H).

Elements

• If you select Elements, a thickness is assigned to the attribute T of the card SHELL and
TSHEL.

Components

• If you select Components, a thickness is assigned to the attribute H of the card PART based
on SHELL, TSHEL, and MEMBR.

Contact thickness

• If you enable the Contact thickness checkbox under Components, a thickness value is
assigned to the TCONT attribute, which is the same as the thickness value of H of the card
PART on SHELL, TSHEL, and MEMBR.

Altair Radioss
In RADIOSS, you can use the Map Midmesh Thickness tool to estimate and assign a midmesh
thickness to elements only. This option requires you to select one of the following options from the
Select Card Image list.

Shell

• Assigns a thickness on the thickness attribute of the /SHELL keyword for quads or on the /
SH3N keyword for trias.

EPSP_F / STRA_F / STRS_F

• When you select any of these options, a table is created that contains element IDs and
corresponding thickness information.

Note:  Depending on the type of elements in your model, there
may be two tables created, one for tria elements and one for
quad elements. The naming convention for tria tables will be
tkTable_INISH3_{optionName}_{tableIndx}, and the naming convention for quad
tables will be tkTable_INISHE_{optionName}_{tableIndx}.
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For example, if you select EPSP_F from the Select Card Image list, the Map Midmesh
Thickness tool creates and names the first table tkTable_INISH3_EPSP_F_1 and
tkTable_INISHE_EPSP_F_1.

Samcef
In Samcef, you can use the Map Midmesh Thickness tool to estimate and assign a midmesh thickness
to properties.

Properties on elements

• Based on the thickness, multiple properties with the SHELLPHP card images are created.

• Creates corresponding materials and properties named thickness_t.

Note:  During creation, you are able to enter a prefix for the property and
material.

• Assigns a property to the selected 2D elements.

Properties on components

• All the options mentioned above, are applicable for Properties on components, except the
properties are assigned to components instead of elements.

Coarsen Mesh
Simplify a mesh by combining many small elements into a smaller number of larger ones.

An existing mesh may be finer and more complex than your simulation requires. This can result in the
simulation, or other utilities that depend on existing elements, taking an unnecessarily long time to run,
especially when your goal is to view real-time animations for NVH (Noise, Vibration, and Handling) or
similar analyses.

Figure 1006: Before Coarsening
The mesh size is 30.
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Figure 1007: After Coarsening
The mesh size is 200.

When a mesh is coarsened like this, it is important to note that every node in the coarse mesh
corresponds exactly to one of the nodes in the original mesh, although many nodes are removed,
the ones that remain are still the same nodes from the original model. No locations or qualities are
changed. Similarly, any nodes or points with special information, such as comments, in the 10th column
of their deck will be preserved.

It is best to filter out components that are not relevant to your analysis. In the example above, the
wheels and suspension were removed from consideration.

1. From the menu bar, click Mesh > Create > Coarsen Mesh.
The Coarsen Mesh dialog opens.

2. Use the Select entities: Components selector to select the components to simplify.

3. Use the Select hard points: Nodes selector to select any hard points, such as those defining a
hole or ridge, that must be preserved.

4. In the Element size field, enter a new element size.

5. To prevent the coarsened mesh from exceeding a target number of nodes, select the Maximum
Node Count checkbox.

This is an iterative process and will adjust the mesh size you specified accordingly.

Tip:  This option is helpful when you have large models and want to better control
the size of the output for NVH models. The maximum node count will apply to all of
the selected components. If you would like greater control of a specific component,
coarsen that component separately.

6. For Mesh type, select a mesh type.

7. To eliminate and mesh over features with angles smaller than the specified value, while preserving
features with angles greater than the specified value so that the mesh aligns with the feature line
rather than allowing elements to cross over it, select the Feature angle checkbox.

The coarsening process uses two stages; if the first stage fails on some elements, the second
stage is run. The feature angle setting only applies to the second stage; it is irrelevant to the
initial stage.
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8. To mesh over holes smaller than the specified value, but preserve holes that are at least the
specified value, select the Minimum fill hole diameter checkbox.

9. To remove most features that become detached during the coarsening process, which are
underneath the target input size that you specified, select the Delete small parts checkbox.

The entire feature must be within this limit. For example, a free bolt hole that is 3 units in
diameter but 25 units in length will remain if this amount is less than 25.

10. Define advanced options.

Option Description

Delete 1Ds before
meshing

Consider any 1D elements that are part of the input selection for
this operation. If those 1D elements are attached to a hard point or
are part of a 1D path back to the 2D/3D structure, those elements
are not deleted. Any other 1D elements that are part of the input
selection are deleted

Retain input mesh Generate a new component containing the coarsened elements,
leaving the original component and its elements untouched. The
coarsened elements will share nodes with the original input mesh.

Delete masses before
meshing

Consider any 0D elements that are part of the input selection for
this operation. If those 0D elements are attached to a hard point
or are part of a 1D path back to the 2D/3D structure, then those
elements are not deleted. Any other 1D elements that are part of
the input selection are deleted.

Delete free 1Ds and
masses after meshing

The coarsening operation itself includes making sure the relevant
rigidlink/RBE3/mass elements are connected back to the structure
accordingly. For this option rigidlink/RBE3/mass elements
are considered free only if all legs are free after coarsening/
reconnection is complete.

Delete free rigidlink/
RBE3 legs after meshing

Delete any free legs after coarsening and reconnection are
complete. As mentioned above, a rigidlink/RBE3 element is only
free if all legs are free for the purpose of this tool.

Convert existing 1D to
PLOTELs

Convert remaining 1D elements that were part of the input
selection to PLOTEL, once all of the above rules have been
completed. This includes all legs of rigidlink/RBE3 elements. Every
leg of these elements needs to be converted to a separate PLOTEL
(for example, a 10 leg RBE3 will be 10 PLOTELs).

Create PLOTELs along 2D
edges

Create PLOTELs along all 2D element edges and 2D mesh will be
deleted.

If Convert coarsened 2Ds to PLOTEL3/4 is enabled, then
PLOTEL3/4 are also created.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.2070

Option Description

Convert coarsened 2D to
PLOTEL 3/4

Convert all Tria and Quad elements to PLOTEL3 or PLOTEL4 element
types configurations.

Restriction:  Only available in the OptiStruct user
profile.

Component size factor Component size factor to convert.

Auto reduce factor Auto reduce factor to convert.

11. Click Mesh.
The selected components are meshed.

If the results are not satisfactory, you can Reject the new coarse mesh, change the options, and try
again.

Connect Intersecting 2D Elements
Connect intersecting triangular and quadrilaaterial 2D elements.

Several components\elements can be connected simultaneously. Components defined as master entities
will be preserved. It is suggested that you ensure that 2D elements are properly intersecting.

1. From the menu bar, click Mesh > Boolean Operation.
The Boolean Operation dialog opens.

2. Choose the type of boolean operation to perform.

• Choose Union.
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Figure 1008: Union

• Choose Subtract.

Figure 1009: Subtract

3. Use the All entities to Boolean selector to select all components or elements that will be involved
in the boolean operation.

Entities defined that are not present in master entities to preserve are considered as slaves. If you
define all entities for boolean as master entities to preserve, entities will intersect and connect
components but will not remove any internal shells. The boolean operation will only remove
internal shells if they are enclosed and if they belong to an entity not defined as master entities to
preserve. If both of these conditions are not satisfied the internal shells will not be removed.

4. Use the Master entities to preserve selector to select components that you do not want to remove
internal shells for.

5. If you have components with open shells but they are connected to other components and create
closed shells together, select the Consider connected components as one shell checkbox
to consider the closeness of the connected shells while deciding which internal shells will be
removed.

6. To create connection edges, select the Keep intersect edges checkbox.

7. To remesh elements near the intersection of inputs based on the defined parameters, select the
Local remesh at contacts checkbox.
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In a case of tria element input, tria elements of first order will be remeshed. In a case of quad
elements input, remeshing will be done with mixed elements.

8. In the Number of layers field, enter the number of additional layers next to the intersect edge to
remesh.

9. In the Feature angle field, enter the feature angle to use for the remeshed elements to be
captured.

10. In the Growth rate field, enter a growth rate to use for remeshing.

11. Click Run.

Fuse Mesh
Connect close proximity, overlapping and intersecting parts.

Input assemblies can have intersecting/partial intersecting parts, overlapping parts, or close proximity
parts.

Use the fuse tool to connect close proximity, overlapping, and intersecting parts.

1. Open the Fuse tool by clicking Mesh > Fuse from themenu bar.

2. Use the Source entities selector to select source entities.

Source entities will move to the target.

3. Use the Target entities selector to select target entities.

Target entities will not move.

4. Decide whether to perform Open Shell or Close Shell fusing.

The fuse algorithm treats open shells (not closed input) and closed shells (water tight shells)
differently.

5. Define additional Open Shell and Close Shell fusing options accordingly.

Options vary based on the fusing type selected.

6. Click Fuse to start the fuse operation.

Open and Close Shell Fusing Options
The following tables list options and actions for the Mesh > Fuse dialog box.

Open Shell Fusing

Option Action

Proximity Search Threshold Type the maximum search distance to find proximity elements
between source and target into this field. Fusing will be
performed between them.
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Open Shell Fusing

Option Action

Note:  You are not required to enter a precise
distance, but it is recommended that you do not
define too big of a value compared to the average
distance between the source and target in order
to avoid performance issues.

Perform Remesh Select this checkbox to remesh elements near the connection
based on the user-defined parameters.

Triangle element inputs of the first order will be remeshed.
Quad element inputs will be remeshed with mixer elements.

Feature Angle Type the feature angle for the remeshed elements to be
captured into this field.

Connect Source Free Edge Only Select this checkbox to connect only the free edges within the
user-defined proximity threshold.

Fusing Direction Select a direction to which the source will be projected to the
target:

• Along Source Normal: Choose this option to project
source elements to the target based on the source
element normal or the shortest distance direction from
the source.

• Along Source Edge Tangent: Choose this option
to project proximity source elements in a tangential
direction to the source. Tangency is only calculated for
free edges. For other inputs, it will project to the target
based on shortest distance direction from source.

Create Patch at Connection Select this checkbox to create new patch elements between
source and target. If this option is unchecked, source element
nodes will be projected and stitched to the target.

Remove Redundant Patches from
Target

Select this checkbox to remove redundant patches after
fusing is performed that are within the user-defined patch
maximum width factor. The value of the maximum width
factor is calculated by multiplying the factor with the
proximity search threshold.

Snap to Features Select this checkbox to fuse source elements to target
elements if the features fall within the user-defined feature
snapping tolerance factor. The value of the snapping tolerance

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.2074

Open Shell Fusing

Option Action

is calculated by multiplying the factor with the proximity
search threshold.

This feature includes free edge, non-manifold edges (t-
connection / x-connection), and features based on the feature
angle defined in preferences.

Close Shell Fusing

Option Action

Proximity Search Threshold Type the maximum search distance to find proximity elements
between source and target into this field. Fusing will be
performed between them.

Note:  You are not required to enter a precise
distance, but it is recommended that you do not
define too big of a value compared to the average
distance between the source and target in order
to avoid performance issues.

Keep Interface Select this checkbox to keep common shells between source
and target as they are. Uncheck to remove common shells.

Figure 1010: Keep Interface Enabled
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Close Shell Fusing

Option Action

Figure 1011: Keep Interface Disabled

Maximum Search Angle Type the maximum angle value that is used to detect close
proximity between the source and target into this field.

Fusing Direction Select a direction to which the source will be projected to the
target:

• Along Source Normal: Choose this option to project
source elements to the target based on the source
element normal or the shortest distance direction from
the source.

• Along Source Edge Tangent: Choose this option
to project proximity source elements in a tangential
direction to the source. Tangency is only calculated for
free edges. For other inputs, it will project to the target
based on shortest distance direction from source.

Remove Redundant Patches from
Target

Select this checkbox to remove redundant patches after
fusing is performed that are within the user-defined patch
maximum width factor.

Note:  This is only useful in cases of open shells.

Collapse Patches Select this checkbox to collapse created patches and directly
connect the source nodes to the target nodes. When enabled,
you can select a destination component for patch: Source
Component, Current Component, or New Component.
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Close Shell Fusing

Option Action

Figure 1012: Collapse Patches Enabled

Figure 1013: Collapse Patches Disabled

Perform Remesh Select this checkbox to remesh elements near the connection
based on the user-defined parameters.

Triangle element inputs of the first order will be remeshed.
Quad element inputs will be remeshed with mixer elements.

Number of Layers Type the number of additional layers next to the intersect
edge that need to be remeshed into this field.

Feature Angle Type the feature angle for the remeshed elements to be
captured into this field.
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Close Shell Fusing

Option Action

Growth Rate Type the growth rate for remeshing into this field.

Fuse Mesh Examples
The Fuse tool can be used with several types of analyses where mesh connections are required.

CFD Fluid Analysis Model Preparation
Create a water tight, fluid volume for CFD analysis by connecting shell and solid parts.

Figure 1014:

Thermal Analysis Model Preparation
Prepare the model for thermal analysis by connecting closed shells across the assembly.

Figure 1015:

Electromagnetic Analysis Model Preparation
Define connections across part assemblies by connecting the midmesh of shell parts.
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Figure 1016:

Fill Holes, Gaps, Patches
Fill holes, gaps, and patches in first order and second order elements.

1. From the menu bar, click Mesh > Hole/Gap Fill.
The Hole/Gap Fill dialog opens.

2. Select a Fill Type.

• Choose Hole fills to fills holes and edge loops. Holes can be free edge loops or feature edge
loops.

Figure 1017: Free Edge Holes Figure 1018: Free Edge Holes Filled
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Figure 1019: Feature Edge Holes Figure 1020: Feature Edge Holes Filled

• Choose Gap fills to fill the gaps between a set of elements.

Figure 1021: Gap between Element Sets Figure 1022: Gap Filled between Element Sets

• Choose Patch fills to fill partial edge loops; fills gaps and holes as a pre step for wrapper,
where a non-conformal patch can be created to provide a proper input to wrapper.

Figure 1023: Partial Edge Loop Figure 1024: Partial Edge Loop Filled
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Figure 1025: Gaps and Holes Figure 1026: Gaps and Holes Filled (Non-
Conformal Patch)

3. Use the selector(s) to select the entities which surround holes, gaps, or patches to fill.

For gaps use the first selector to select entities along one side of the gap, then use the second
selector to select entities along the other side of the gap.

Note:  Selection options change based on the Fill Mode selected.

Figure 1027: Node Lists to Detect the Gap

4. In the Max width field, enter the maximum hole width or gap width to fill.

Holes/gaps that have a width greater than the specified value will not be filled. Only available
for Hole Fill and Gap Fill. In gap fill when node lists is selected, the maximum gap will try to be
detected based on the average distance between selected node groups.

5. Choose a destination component.

• Choose Current Component to organize newly created patches in the current component. If
no current component is defined, a new component “auto” will make created and set as the
current component.

• Choose Adjacent Component to organize the filled/patched elements to the adjacent
components. If the hole or gap is shared by more than two components, then newly created
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elements will be organized in the component with the higher number of nodes around hole/
gap.

• Choose New Component to organize newly created patches in a new component named
^patch.

6. Define additional options.

• To remesh the hole/gap/patch around the surrounding elements, select the Remesh
checkbox.

During remeshing, element size, type, and order is determined by the surrounding element's
size and type.

• To mesh/remesh feature loops in holes/gaps, select the Consider Feature checkbox.

While filling holes, feature holes are also consider and filled. In the Auto detect fill mode, filled
feature/free edge holes create intersecting elements with their neighbors, therefore they are
discarded and the operation is marked as failed.

• To fill holes/gaps based on neighboring elements normal, select the Curved Fill checkbox.

7. Use the Guide Node Pair selector to select two nodes to determine along which direction to fill the
hole or gap.

This is useful when the dimensions of a hole/gap are in two different directions.

8. Click Fill.

.

Figure 1028: Gap F and Remeshed with Adjacent Components
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Batchmesher
Batchmesher is a tool that performs geometry feature recognition, cleanup and automatic meshing in
batch mode for given CAD files.

Batchmesher can read geometry files and perform a variety of geometry cleanup operations to facilitate
better mesh creation for the selected element size and type. Cleanup operations include, but are not
limited to equivalencing free edges, fixing small surfaces, relative to the element size, and detecting
features such as beads, fillets and flanges. Batchmesher also performs surface editing/defeaturing
operations like removing pinholes smaller than a specified size, removing edge fillets, and adding
washer layers around holes.

Batchmesher uses criteria set by you to determine the quality index (QI) of a model, uses this QI
rating to assess the potential value of each geometry cleanup and meshing tool, and then applies the
tools accordingly. QI optimized meshing and node placement optimization are performed to obtain the
best quality meshing. Final results are stored in a HyperMesh binary database file containing both the
cleaned-up geometry and the resulting finite element mesh.

The required inputs are set within a parameter file and a criteria file. The parameter file contains the
average element size and type, as well as any special handling of geometry features. The criteria file
contains the target element quality requirements for tests like Jacobian, warpage, and more.

User-defined Tcl procedures can also be supplied to perform both run-based (pre-run, post-run) as
well as model-based (pre-geometry load, post-geometry load, pre-batchmesh, post-batchmesh)
customizations.

On output, Batchmesher creates a unique directory for each run in the results directory where it stores
output files. The directories are named bm_date_001, bm_date_002, and so on.

For each CAD/HM input file, there are several output files generated:

modelname_critername_paramname.hm
This is the main output of Batchmesher and contains both the cleaned-up geometry and the
resulting finite element mesh.

modelname_critername_paramname_res.txt
This is a text file that reports the progress and status of Batchmesher at various steps in the
meshing process. It reports information such as the number of surfaces (total, unmeshable,
and so on), the number of elements, the percentage of trias, the mesh QI value, and so forth.
COMPLETE at the end of this file indicates successful completion of the Batchmesher process for
the model.

For each Batchmesher run, there are also several output files generated:

run_results.txt
This is a text file that reports the progress and status of the jobs submitted to the batch meshing
process. It reports the number of jobs submitted, any waiting in the queue, whether the job is
complete, and similar details. For completed jobs, it provides summary information such as the
time taken to complete the job, the number of surfaces in the model, the number of elements
created, and so forth.
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RunView.log
This file maintains a log of submitted runs. This .log file can be loaded into the Batchmesher GUI
to review the results at a later time.

In addition to the files mentioned above, additional output files may be created due to customization
procedures performed at various stages of the Batchmesher process.

Start Batchmesher
Batchmesher can be started on various platforms.

Start Batchmesher on Windows or Linux

Start Batchmesher on Windows
Start Batchmesher on Windows from the Start menu or system command prompt.

• Start Batchmesher from Start menu.

Startup options can be supplied to the application by modifying the shortcut, or creating a new one,
and adding the required options.

a) From the Start menu, select BatchMesher 2019.

• Start Batchmesher from command prompt.

a) Launch the system command prompt.

b) cd to the directory from which the Batchmesher application should be run.

c) Enter the full path of the Batchmesher application start script, along with any startup options.

For example, enter <altair_home>\hm\batchmesh\hw_batchmesh.bat.

Start Batchmesher on Linux

1. Launch the system terminal.

2. cd to the directory from which the Batchmesher application should be run.

3. At the prompt, enter the full path of the Batchmesher application start script, along with any
startup options.

For example, enter <altair_home>/altair/scripts/hw_batchmesh.

Batchmesher Startup Options
Startup options allow Batchmesher to be launched with a specific behavior or with specific settings
defined.

The options are provided as command line options to the application startup script.

For example, on Windows:
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<altair_home>\hm\batchmesh\hw_batchmesh.bat -nogui -cad_translator catia -cad_model_dir
C:\work\models -cad_model_ext CATPart -criteria_file C:\work\10mm.criteria -

param_file
C:\work\10mm.param -user_procedure PRE_GEOMETRY_LOAD C:\work\mytcl.tcl

myprocedure "myarg1 myarg2" -user_procedure POST_BATCHMESH C:\work
\NastranOutput.tcl

nastranexport

<altair_home>\hm\batchmesh\hw_batchmesh.bat -config_file C:\work\bm.cfg -multicpu 4
-batch

For example, on Linux:
<altair_home>/altair/scripts/hw_batchmesh -nogui -cad_translator catia -cad_model_dir

/work/models -cad_model_ext CATPart -criteria_file /work/10mm.criteria -
param_file

/work/10mm.param -user_procedure PRE_GEOMETRY_LOAD /work/mytcl.tcl
myprocedure "myarg1 myarg2" -user_procedure POST_BATCHMESH /work/

NastranOutput.tcl
nastranexport

<altair_home>/altair/scripts/hw_batchmesh -config_file /work/bm.cfg -multicpu 4
-batch

Batchmesher GUI Startup Options
-batch

Run jobs automatically via a config file.

Restriction:  Must be used with the -config_file option.

-config_file <path>
Specifies the full path and file name of the config file to use.
If used without -batch, this configures the Batchmesher GUI.
If used with -batch, this configures the Batchmesher GUI and automatically runs the jobs.

-file_wait_timeout <minutes>
Model loading and PRE_GEOMETRY_LOAD user procedure run time.
May be required if some models need more than the default time (20 minutes) to load. Also may
be required if the user specified PRE_GEOMETRY_LOAD procedure has a long run time. See also -
timeout_scale.

-help
Print out the Batchmesher usage message.

-multicpu <number>
Number of CPUs to use for simultaneous Batchmesher jobs.
Overrides any value set in -config_file.

-relocate_to_input
Move all .hm output files to the corresponding directory of the input model.

-submit_time <time>
Define the future submission time of the current GUI configuration.
Time format depends on the OS and localization settings on the machine. Refer to the value of
the Submit At button on the Batch Mesh tab to see an example of the format required for your
environment. An example is "8/8/11 12:27:00 PM".
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-time_limit_default <minutes>
Model batch meshing step timeout.
May be required if some steps need more than the default time (15 minutes). The actual timeout
is the maximum of -time_limit_default and the value read from the time_limit.txt file (updated
automatically after each step). This is ignored if <=0. See also -timeout_scale.

-timeout_scale <scale>
Proportionally increase/decrease -file_wait_timeout, -time_limit_default and the value read from
the time_limit.txt file.
Default value is 1.0. Ignored if <=0.0.

-total_timeout <minutes>
Total timeout for whole batch mesh job.
May be required if model batch meshing require more than the default time (240 minutes).

-work_dir <path>
Specify the directory where the output files are to be written.

Batchmesher "Watchdog" Startup Options
This mode runs a single Batchmesher job with no GUI. This is useful for grid computing job submission.

-cad_model_dir <directory>
Specify the directory where CAD/HM input files are located. This is used for multiple file jobs.

Restriction:  Must be used with the -cad_model_ext option, and cannot be used with
the -cad_model_file option. This is a mandatory argument if -cad_model_file is not
specified.

-cad_model_ext <extension>
Specify the file extension to use when scanning the -cad_model_dir for CAD/HM input files. All
input files found with this extension will be batch meshed. This should be simply the extension,
not including the period (.) For example, CATPart instead of .CATPart.

Restriction:  Must be used with the -cad_model_dir option, and cannot be used with
the -cad_model_file option. This is a mandatory argument if -cad_model_file is not
specified.

-cad_model_file <path>
Specify the full path and file name of the CAD/HM input file.

Restriction:  Cannot be used with the -cad_model_dir and -cad_model_ext options.
This is a mandatory argument if -cad_model_dir is not specified.

-cad_translator <type>
Specify the CAD file type being used.
Valid values include:

acis

catia

ct-ug
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Detect

dxf

hm

iges

inspire

intergraph

jt

pdgs

parasolid

proe

step

solidworks

tribon

ug

vdafs

-criteria_file <path>
Specify the full path and file name of the criteria input file. This is a mandatory argument.

-file_wait_timeout <minutes>
Model loading and PRE_GEOMETRY_LOAD user procedure run time. May be required if some
models need more than the default time (20 minutes) to load. Also may be required if the user
specified PRE_GEOMETRY_LOAD procedure has a long run time. See also -timeout_scale.

-help
Print out the Batchmesher usage message.

-nobg
Force Batchmesher to run in the foreground on Linux.

-nogui
Run Batchmesher in no GUI mode. This is a mandatory argument.

-param_file <path>
Specify the full path and file name of the parameter input file. This is a mandatory argument.

-recurse <value>
A true|false value that specifies whether to include sub-directories when using the -cad_model_dir
option.

Tip:  Not recommended for use in grid computing job submission.

-qi_post_procedure <value>
A true|false value that specifies whether to generate the HTML quality reports for the run.

-run_results <path>
Specify the full path and file name of the results output file to write/append to.
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-run_tcl_file <path>
Specify the full path and file name of the Tcl script containing a procedure to run. If this option is
used, then all other options except -run_tcl_proc are ignored.

Restriction:  Must be used in conjunction with the -run_tcl_proc option.

-run_tcl_proc <proc>
Specify the name of the Tcl procedure to run.

Restriction:  Must be used in conjunction with the -run_tcl_file option.

-time_limit_default <minutes>
Model batch meshing step timeout. May be required if some steps need more than the default
time (15 minutes). The actual timeout is the maximum of -time_limit_default and the value read
from the time_limit.txt file (updated automatically after each step). This is ignored if ≤ 0. See
also -timeout_scale.

-timeout_scale <scale>
Proportionally increase/decrease -file_wait_timeout, -time_limit_default and the value read from
the time_limit.txt file.
Default value is 1.0. Ignored if ≤0.0.

-total_timeout <minutes>
Total timeout for whole batch mesh job. May be required if model batch meshing require more
than the default time (240 minutes).

-user_procedure <type> <path> <proc> <args>
Specify user-registered procedures. This option can be used multiple times, once for each type.

type
Type of procedure to register.
Valid values are PRE_GEOMETRY_LOAD, PRE_BATCHMESH, POST_BATCHMESH.

path
Full path and file name of the Tcl script containing a procedure to run.

proc
Name of the Tcl procedure to run.

args
List of arguments to pass into the procedure. This can be empty. If there are multiple
arguments, they must be enclosed in quotes.

-work_dir <path>
Specify the directory where the output files are to be written.

Enable Grid Computing
Batchmesher supports grid-based computing.

The default grid is "PBS Pro".
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By default, the "Grid" option is disabled in Batchmesher's base configuration (loaded from the
<altair_home>\hm\batchmesh\hw_batchmesh.cfg file).

1. Enable Batchmesher grid computing by selecting File > Load Config from the Batchmesher menu
bar, and loading the <altair_home>\hm\batchmesh\hw_batchmesh_grid.cfg file.
After loading hw_batchmesh_grid.cfg, a new Grid option displays alongside Local in the File
menu’s Run Options sub-menu. Once this option is activated, it will remain even if you load
subsequent configuration files.

2. To use the Grid option, you must configure the qsub.tcl, qstat.tcl, and qdel.tcl default
scripts.

All default scripts are located in <altair_home>\hm\batchmesh.

The exact script configuration depends on the grid system you use, and requires detailed
knowledge of your current grid system.

Grid Computing Default Scripts
Overview of the default scripts used for grid computing.

The three default scripts were created for use with Unix PBS Pro clusters and will work without
modification if your cluster configuration is similar to the default configuration.

qsub.tcl
qsub.tcl -batch_args {args} -work_dir dir

The qsub.tcl script creates a node-side script and submits the job to the computing grid. If an error
is encountered at job submission, this script returns the word "error". Otherwise, it returns the unique
JobID for the submitted job.

args
Command line for one Batchmesher job, contained in curly braces. This line is created by the
Batchmesher GUI, and has to be written to the node-side script.

dir
Specify the directory where the output files are to be written.

qsub.tcl -batch_args
{/soft/hw/altair/scripts/hw_batchmesh -nogui -cad_translator hm -criteria_file
/homes/username/configs/nvh10.criteria -param_file /homes/username/configs/

nvh10.param
-cad_model_file /homes/username/models/model.hm -nobg} -work_dir
/homes/username/results/bm_060209_001/

Returns JobID: 1234

Figure 1029: Example: qsub.tcl

qstat.tcl
qstat.tcl JobIDList

The qstat.tcl script obtains status information for jobs with specified JobIDs. It returns a list of JobIDs
paired with status mnemonics.
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R
Job is running

Q
Job is queued, eligible to run

E
Job is exiting after having run

W
Job is waiting for idle resource

U
Status undefined (if status not R, Q, E or W)

none
Information about job was not found

The list of unique JobIDs for submitted jobs:
qstat.tcl 1234 1235 1236 1239

Returns JobID status list of:
1234 none
1235 R
1236 R
1239 Q

Figure 1030: Example: JobIDList

qdel.tcl
qstat.tcl JobIDList

The qdel.tcl script terminates jobs with specified JobIDs. It returns 0 if the jobs terminated without
errors or "none" if the jobs cannot be terminated or there was a termination error.

The List of unique JobIDs for submitted jobs:
qdel.tcl 1234 1235

Returns termination status:
0

Figure 1031: Example: JobIDList

Error Codes
Error codes encountered in Batchmesher.

101
Wrong number of arguments provided to hw_batchmesh. Used only in the command line.

102
Missing required arguments for hw_batchmesh. Used only in the command line.

103
The specified output directory does not exist. (See –work_dir option in hw_batchmesh).

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.2090

104
Undefined required environment variable.

105
The specified input directory contains no model files (see -cad_model_dir in hw_batchmesh).

106
The custom pre-run or post-run Tcl procedure generated an error.

107
At least three critical errors occurred during the meshing of one model.

111
The HyperMesh executable (hmopengl) is in an incorrect path or is inaccessible.

112
The input geometry file is in an incorrect path or is inaccessible from hw_batchmesh.

113
The criteria file is in an incorrect path or is inaccessible from hw_batchmesh.

114
The parameter file is in an incorrect path or is inaccessible from hw_batchmesh.

121
Either the time_limit.txt or result (*_res.txt) file was not created after the specified timeout.

132
Result file (*_res.txt) not found.

133
Error while reading the time_limit.txt file.

134
Abnormal termination of the HyperMesh process.

135
The HyperMesh process is frozen, possibly waiting for user input.

141
The input geometry file is in an incorrect path or is inaccessible from HyperMesh.

142
The criteria file is in an incorrect path or is inaccessible from HyperMesh.

143
The parameter file is in an incorrect path or is inaccessible from HyperMesh.

144
An error occurred while reading the input file (see HyperMesh *readfile command).

145
An error occurred while importing the input file (see HyperMesh *feinputwithdata2 command).

146
An error occurred while reading the criteria file (see HyperMesh *readqualitycriteria
command).
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147
An error occurred while running hw_batchmesh.

148
The custom pre-geom, pre-mesh or post-mesh Tcl procedure generated an error.

151
Licensing error.

Customize with User Procedures
Customize Batchmesher by providing user-defined Tcl procedures that run at specific times during the
Batchmesher process.

Procedures can be customized for pre-run, post-run, pre-geometry load, post-geometry load, pre-
batchmesh, and post-batchmesh.

These scripts can perform a wide range of tasks, such as:

• Exporting a mesh in solver format.

• Generating the midsurface of a thin solid geometry.

• Performing a surface offset to move a sheet geometry to a midsurface location.

• Naming and numbering parts to user-specific requirements.

Batchmesher has the ability to specify user-specified procedures at the following steps for each job:

Pre-geometry load
Executed immediately after the job begins, before the input model is imported.

Pre-batch mesh
Executed immediately after the input model is imported, before the batch mesh begins. Examples
include extracting a midsurface or performing a surface offset.

Post-batch mesh
Executed immediately after the batch mesh process is complete. Examples include creating solver
specific cards, or exporting the mesh in a specific format.

Access to model-specific variables is possible within user-registered procedures. The array
::hmbm::gVarArray contains variables accessible by you.

CADImportOpt
String of CAD import options.

cadtype
Type of model file.

critername
Criteria file name, excluding the path.

criterpath
Criteria file name, including the path.

CurrentEventName
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modelname
Input model file name, excluding the path.

modelpath
Input model file name, including the path.

outmodelname
Output model file name, excluding the path.

outpath
Output file path.

paramname
Parameter file name, excluding the path.

parampath
Parameter file name, including the path.

POST_BATCHMESH,tclparameters
Parameters passed to the post-batch mesh procedure. Only available when such a procedure is
defined.

POST_BATCHMESH,tclprocedure
Post-batch mesh procedure name. Only available when such a procedure is defined.

POST_BATCHMESH,tclscriptpath
Post-batch mesh script name, including the path. Only available when such a procedure is
defined.

PRE_BATCHMESH,tclparameters
Parameters passed to the pre-batch mesh procedure. Only available when such a procedure is
defined.

PRE_BATCHMESH,tclprocedure
Pre-batch mesh procedure name. Only available when such a procedure is defined.

PRE_BATCHMESH,tclscriptpath
Pre-batch mesh script name, including the path. Only available when such a procedure is defined.

PRE_GEOMETRY_LOAD,tclparameters
Parameters passed to the pre-geometry load procedure. Only available when such a procedure is
defined.

PRE_GEOMETRY_LOAD,tclprocedure
Pre-geometry load procedure name. Only available when such a procedure is defined.

PRE_GEOMETRY_LOAD,tclscriptpath
Pre-geometry load script name, including the path. Only available when such a procedure is
defined.

resfilename
Output result file name, excluding the path.

By default, Batchmesher additionally passes in the name of the model file as the last argument to the
Tcl procedures.
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Note:

Tcl scripts must not automatically run any procedures, as this is handled by Batchmesher.
Doing so will generate an error or unexpected results.

Save the model after running user procedures, as this is not done automatically. For
example:
hm_answernext "yes"
*writefile "$::hmbm::gVarArray(outmodelname)" 0

proc nastran_export { modelName args }  {
set outputDir $::hwbm::gVarArray(modelpath)
set template_dir [ hm_info -appinfo SPECIFIEDPATH TEMPLATES_DIR]
set template [file join $template_dir "feoutput" "nastran" "general"]
*feoutput "$template" ${outputDir}/${modelName}.dat 1 1 1
}

Figure 1032: Example: Post-Mesh User Procedure
This example exports the generated mesh to a NASTRAN file named <modelname>.dat in the same directory as the original

input model.

Procedures can also be specified at the run level to enables you to perform operations such as reading
all the batch-meshed parts into a single model, creating properties or materials, or creating connections
such as welds between the parts. Customization options at the run level can be set to execute at two
points in the batch mesh process:

Pre-run
Executed before the first model/job starts.

Post-run
Executed after the last model/job completes.

In the pre-run and post-run scripts, the model-specific variables are not available.

Batch Mesh
Typical workflow for creating a mesh using Batchmesher.

1. Define a mesh type.

A mesh type consists of a Criteria File and a Parameter File.

a) Click the Configurations tab.

b) Click  to add a new configuration entry to the table.

c) In the Mesh Type field, enter a name.

d) In the Criteria File and Parameter File fields, browse to select the criteria and parameter files
that define the mesh type.

2. Choose the models to batch mesh.

a) Click the Run Setup tab.

b) In the Input model directory field, browse to select the directory that contains the geometry
to batch mesh.
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c) Click  to select model files.

d) In the Select Model Files dialog, select all of the relevant geometry files and click Select.

Tip:

In the Type of geometry field, select a geometry type to only list the files of that
type.

The selected geometry files display in the table along with their geometry type.

3. Click the Mesh Type field for each file and select a relevant mesh type.

Tip:  Quickly apply the same mesh type to all files above or below the current row by
right-clicking and selecting Propagate Up or Propagate Down.

Figure 1033:

4. In the Output directory field, browse to select the directory where Batchmesher will save all
results files.

If no output directory is specified, the results will be saved to the Input model directory.

5. Click Submit to start the Batchmesher run.

6. In the Run Status tab, monitor the job and run statuses.

All runs are listed in the Run Status tab, along with the status of job in the run. A Batchmesher
run creates a unique directory inside of the Output directory where it stores its meshed results.
This unique directory name displays in the tree for each run.

Tip:

Advanced details of a job with a COMPLETE or WORKING status can be monitored by
highlighting the item of interest and clicking Details.

Advanced details for a run can be monitored by clicking Run Details.
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7. Once a job is complete in the Run Status tab, load the final mesh into HyperMesh by selecting the
job in the tree and clicking Load Mesh.

Run Setup
Define settings for a batch mesh run and the jobs it contains in the Run Setup tab.

In the Run Setup tab, a table layout is used to specify each job, along with options that apply to the
entire run.

Figure 1034:

For each geometry file in the table, a geometry type must be chosen in the Geom Type field. If you 
select files using the Select Model Files dialog, than the geometry type is automatically set based on 
the value in the dialog. Manually select a geometry type by left-clicking the Geom Type field. Select 
the Auto geometry type to automatically attempt to detect the model type during import.

Additionally, each file requires a mesh type to be chosen in the Mesh Type field. The available mesh 
types are defined in the Configurations tab. Select a mesh type by left-clicking the Mesh Type field. 
Clear the mesh type by selecting the empty row in the drop down list.

Job dependencies can be defined, where the output of one model is used as the input to another. This 
is useful, for example, when creating a common mid-surface geometry model that is then used as input 
to generate domain specific mesh models. Such dependencies can be defined using the Previous Mesh 
Type field. When a previous mesh type value is selected, Batchmesher will find another Geometry File 
with the same name and specified Mesh Type, and run that model first. The output from that model 
will then be used as the input for the dependent model. The order of the definitions does not matter, as 
Batchmesher will decide the appropriate order to run any dependent jobs. If there is no other Geometry 
File that has the specified Previous Mesh Type, Batchmesher will not execute the dependent model.
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Further, if there is an error in generating the previous model, Batchmesher will also not execute the
dependent model.

Each entry can have user-defined procedures specified. The available procedures are defined in the User
Procedures tab. To set a procedure, left click in the corresponding Pre-geom Load, Pre-Mesh or Post-
Mesh field and select from the drop down list. To clear the procedure, select the empty row in the drop
down list. Additional procedures for pre- and post-run can be specified in the User Procedures tab as
well.

The name of the .hm file that is generated by Batchmesher can be customized using the Output Name
cell. If this field is empty, the default output name is used, which is a concatenation of the Geometry
File name, the criteria file name, and the parameter file name. If the value is set to Input model name
the input model name is taken, and any file extension is replaced with .hm. Finally, a user-defined value
can be entered. The name will be taken exactly as defined, including any file extension. If multiple files
are given the same output name, the files will be overwritten and only the last one saved will remain.

Tip:  Quickly assign the same option to all of preceding or following entries in the table by
right-clicking in the corresponding field and selecting either Propagate Up or Propagate
Down.

Table 251: Run Setup Options

Option Description

Input model directory Directory that contains the geometry/CAD files for batch meshing.

Note:  You must select the directory containing the CAD files
and not the CAD files themselves.

The Include subfolders option additionally lists CAD files in all the
subfolders of the selected directory.

CAD import options CAD import strings can be provided to override default import behaviors,
for example "SplitComponentsBy=Parts". The provided strings apply to
all CAD import, regardless of format.

Valid strings can be found in Supported CAD Readers.

Launch the Select Model Files dialog to selecting the individual files to
be batch meshed.

Tip:  Use the Shift and Ctrl keys to select or deselect
multiple files from the list.

If the Include subfolders checkbox is selected, matching files in
subdirectories are also listed. Once the selection is complete, click
Select to add the selected files to the table.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Meshing p.2097

Option Description

All files of the selected geometry type in the source directory are
selected by default. The process can be repeated to add more files from
different directories or to add the same files multiple times to generate
different sizes/types of mesh. A new directory can also be specified and
files can be selected from that location. In addition, double clicking in a
row in the Geometry File column allows direct editing of the file name
and path.

Launch the Select Folder with Model Files dialog to select an entire
directory to be batch meshed. Once a directory is selected, all of the
files matching the specified geometry type are listed. If the Include
subfolders checkbox is selected, matching files in subfolders are also
listed. No selection of individual files needs to be made. After review,
click Select to add the selected directory to the table.

All files of the selected geometry type in the directory are included. The
process can be repeated to add more directories or to add the same
directories multiple times to generate different sizes/types of mesh. In
addition, double clicking in a row in the Geometry File column allows
direct editing of the directory name and path.

Add an empty row to the end of the table.

Remove the selected row/rows from the table.

Move the selected rows up in the table.

Move the selected rows down in the table.

Output directory Directory where the Batchmesher output files should be written. The
results of the run are saved in a subdirectory named bm_<date>_<run>.
For example, a first run on Aug. 4, 2011 will be named bm_110804_001.
The next run on the same day would be bm_110804_002.

If no output directory is specified, the Input model directory will be used.

Relocate .hm files to input
model directory

Move all .hm output files to the corresponding directory of the input
model.

Generate quality report Generate HTML quality reports for each model, and a summary report for
each job. The reports can be loaded from the Run Status tab.

Exit upon completion Close the Batchmesher GUI after all jobs are complete.
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Option Description

Number of CPU Maximum number of simultaneous jobs that can be run. If set to "auto"
for multi-CPU machines, this will default to the number of CPUs minus 1.

Submit Start the Batchmesher run and automatically open the Run Status tab. A
run can also be started at a later time using the Submit At option.

Submit At Start the Batchmesher run at a specified time, and automatically open
the Run Status tab. The job status is listed as "Waiting" until the time
the run starts.

Run Status
Once an Batchmesher run is initialized, the Run Status tab reports on the status of the run and its jobs.

Each run is listed as a sub-folder in a tree, along with the exact path of the results location. Each job,
corresponding to one geometry file, is listed as a node of the tree, along with its geometry and mesh
types, and its current status. Additional details can be queried for each job and for the entire run.

Figure 1035:

The Status field will display one of the following:

Working
Batch meshing is currently being performed on this model.

Pending
This model is currently in the queue and has not started the Batchmesher process yet. Any
models with the status can be canceled.

Waiting
The job will begin automatically at a user-specified date and time.
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Done
The batch meshing process is complete, and results can be reviewed.

Table 252: Run Status Options

Option Description

Load a .log file from a previous run to be reviewed.

Remove a run from the tree.

Note:  This only affects the user interface; it does not delete any
files.

Load Mesh Select a single job from the tree and use this button to invoke interactive
HyperMesh and load the final batch meshed model. The corresponding
criteria file is also loaded in the QI panel so that the quality checks represent
the meshing requirements set in Batchmesher.

Note:  This can only be performed on models that have a status
of Done.

Details Select a single job from the tree and use this button to obtain more details
on the status.

The details include:

• Date and time the job began.

• Complete path of the geometry model file.

• Complete path of corresponding criteria file.

• Complete path of corresponding parameter file.

• Time taken to load the geometry model.

• Table containing information on relevant steps in the batch meshing
process.

• Status of the run. A value of COMPLETE indicates success. A value of
ERROR indicates a failure.

Click Refresh to manually refresh the window with the latest details. Click
Auto Refresh to automatically update the window with the latest details
while the job is running.

Run Details Select a run from the tree and use this button to obtain more details on the
status.

The details include:

• Date and time the run began.
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Option Description

• For completed jobs, statistics such as the time required to complete the
job, the final number of faces/elems/failures, and the quality index.

• Number of jobs completed, in process and waiting.

Click Refresh to manually refresh the window with the latest details. Click
Auto Refresh to automatically update the window with the latest details
while the job is running.

Quality Report Generate HTML quality reports for each job, and a summary report for each
run.

Restriction:  Only valid if the Generate quality report checkbox
was enabled on the Run Setup tab for the run.

Pause Pause all pending jobs. This does not affect currently running jobs, which
cannot be paused.

Resume Now Resume all paused jobs.

Resume At Resume all paused jobs at a future date and time.

Cancel Cancel a single run. Runs that are Pending or Working can be canceled.

Configurations
Define the available mesh types that can be used in Batchmesher jobs in the Configurations tab.

A mesh type is a name given to a set composed of one criteria file and one parameter file.

A table layout is used to specify each mesh type and its files.
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There are several pre-defined mesh types provided in the installation.

crash 5mm
Sample template file for crash analysis with average element size of 5mm.

crash 10mm
Sample template file for crash analysis with average element size of 10mm.

durability 5mm
Sample template file for durability analysis with average element size of 5mm.

general 8mm
Sample template file for general use cases with average element size of 8mm.

general 10mm
Sample template file for general use cases with average element size of 10mm.

NVH 10mm
Sample template file for NVH analysis with average element size of 10mm.

NVH 15mm
Sample template file for NVH analysis with average element size of 15mm.

Option Description

Launch a dialog, from which you can select a criteria or parameter file,
depending on the selected cell. In addition, double click a row in the
Criteria File or Parameter File columns to edit the file name and path.

Add an empty row to the end of the table.

Remove the selected row/rows from the table.

Launch the Criteria and Parameters Editors, from which you can edit the
criteria and parameters files in the selected row.

Note:  It may not be possible to edit the default parameter
and criteria files provided in the installation due to file
permissions.
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User Procedures
User procedures that can be specified in Batchmesher for jobs and runs in the User Procedures tab.

Figure 1037:

There are several pre-defined procedures provided in the installation.

nastran_mesh
Write out the resulting mesh in Nastran format.

nastran_mesh_rename
Write out the resulting mesh in Nastran format, but renames the output file.

For each user procedure in the table, the Name must be specified after selecting the file. Double-click in 
the cell to edit the name.
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Note:  It is recommended to use a unique name for each entry, but it is not required.

Additionally, each user procedure requires a Tcl Procedure to be selected. To set the procedure, left-click
in the Tcl Procedure cell and select from the drop down list. To clear the procedure, select the empty
row in the drop down list.

Procedures can be specified that apply to all jobs by default. These can then be manually overridden on
the Batch Mesh tab.

Pre-geometry load
Select a user procedure to execute immediately after the job begins, before the input model is
imported.

Pre-batch mesh
Select a user procedure to execute immediately after the input model is imported, before the
batch mesh begins. Examples include extracting a midsurface or performing a surface offset.

Post-batch mesh
Select a user procedure to execute immediately after the batch mesh process is complete.
Examples include creating solver specific cards, or exporting the mesh in a specific format.

Procedures can also be specified that apply to the entire run. These cannot be manually overridden
elsewhere.

Pre-Run
Select a user procedure to execute before the first model/job starts.

Post-Run
Select a user procedure to execute after the last model/job completes.

Table 253: User Procedure Options

Task Description

Open a dialog, from which you can select a .tcl file. In addition, double-
click a row in the Tcl File column to edit the file name and path.

Add a empty row to the end of the table.

Remove the selected row/rows from the table.
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HyperMesh uses the same editor for both types of files; criteria and parameters display on separate
tabs within the editor.

1. In Batchmesher, click the Configurations tab.

2. Right-click the entry of the configuration to modify and select Edit File from the context menu.

3. In the Criteria and Parameters Files Editor, edit criteria and parameters.

• Click the Criteria tab to setup the quality index (QI) mesh criteria.

• Click the Parameters tab to setup geometry cleanup and defeaturing parameters.

4. Save your changes by clicking File > Save/Save As from the menu bar.

• Click Save to saves the currently loaded file. If no file is loaded, a prompt will be given for a
new name.

• Click Save As save the current settings to a new or different file name.

See Also
Criteria and Parameter Settings
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Set the appropriate parameters/options to obtain the desired mesh from Batchmesher by editing the
criteria and parameter files.

Use the Criteria and Parameters Editor to create and modify mesh criteria files as well as geometry
cleanup parameter files.
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Connectors

Create connections between parts of your model.

This chapter covers the following:

• Connector Entity  (p. 2106)

• Connector Definition  (p. 2107)

• Connector Terminology  (p. 2109)

• Realization Methods  (p. 2116)

• Special Realization Types  (p. 2149)

• Projection Control Methods for Area Connectors  (p. 2233)

• Connector Review  (p. 2234)

• Connectors User Control Mode  (p. 2235)

• Master Connectors File  (p. 2236)

• Multiple Weld File Format  (p. 2238)

• Spotweld Interface  (p. 2239)

• FE Configuration File  (p. 2241)

• Autopitch  (p. 2410)

• Create Connector Realizations using the FEMSITE Utility  (p. 2412)

Connectors define which parts of a model have to be fastened to each other and how the connections
have to be performed.

Connectors are geometric entities (not FE) used to create connections between components. Connectors
are used to realize FE idealizations of the physical connection. Just as you create an FE mesh on a
surface, you create FE connections by realizing a connector.

In HyperMesh, connectors can take into account the mechanical and structural conditions of the model.

Connectors, in the form of mass connectors, are used to distribute masses on certain areas in a model.
These connectors define both the area and the type of mass in such cases.
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Connector Entity
Connectors are geometric entities (not FE) used to create connections between components. Connectors
are used to realize FE idealizations of the physical connection. Just as you create an FE mesh on a
surface, you create FE connections by realizing a connector.
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Connector Definition
A connector definition describes the connection between multiple entities at a specific location.

Entities that are to be connected are referred to as link entities. The connector location can be defined
as:

• node

• node list

• geometric point

• line

• line list

• surface

• elements

• tags

Any number of link entities of differing types can be added to a connector in any order. The connector
sets the order of link entities during the realization process.

Example: Connect Assemblies
The projection behavior for connecting assemblies.

In this example, the model file has two assemblies that each have two components:

Assem 1 contains Comp 1 and Comp 2

Assem 2 contains Comp 3 and Comp 4

A connector is created with the Links as Assem 1 and Assem 2, and the number of layers set to 3.

During realization the closest found components residing inside the 2 assemblies will be retained as the
component links.

Inside each assembly, the closest component to the connector is determined to satisfy a 2T connection,
and for the third layer (3T) the closest component to the connector in either of the assembly links is
utilized.

Note:  The same projection behavior is used for parts containing components.
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Figure 1038:
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Connector Terminology
Overview of connector terminology.

Connector Location
The position in space at which a connector entity is created.

Entities that can be used to define the connector location depend on the connector type.

Spots
Nodes

Connector is created at the node location.

Points
Connector is created at the point location.

Lines
Connector is created at the center of the selected line.
Only one connector is created for each line, but the line may be split into multiple projection
locations as specified by the offset, spacing, and density values.

Nodelist
The nodelist can be considered as to be a line. The treatment is the same.

Bolts
Nodes

Connector is created at the node location.

Points
Connector is created at the point location.

Lines
Connector is created at the center of the selected line.
Only one connector is created for each line, but the line may be split into multiple projection
locations as specified by the offset, spacing, and density values.
This connector is only used for repetitive holes in a certain, constant distance along the selected
line.

Seams
Lines, Linelist

Connector is created at the center of the selected line.
Only one connector is created for each line, but the line may be split into multiple projection
locations as specified by the offset, spacing, and density values.
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Nodelist
The nodelist can be considered as to be a line. The treatment is the same.

Areas
Elems

Connector is created at the elements location.
Only one connector is created for each group of elements, but the area may be subdivided into
multiple projection locations as specified by the nodes of the selected elements.
The area can be re-meshed to get different projection locations.

Surfs
Connector is created at the surface location.
Only one connector is created for each surface, but the area may be subdivided into multiple
projection locations as specified by the mesh type and element size values.
The area can be re-meshed to get different projection locations.

Linelists/Lines
One connector is created for each line. The line is extruded to an area considering the width and
the offset values. The area may be subdivided into multiple projection locations as specified by
the mesh type and element size values.
If line combine is enabled, adjacent lines are treated as one line and produce one area
connector.
The area can be re-meshed to get different projection locations.

Nodepath
The nodelist can be considered as to be a linelist. The treatment is absolutely the same.

Masses
Nodes

Connector is created at the node location.

Points
Connector is created at the point location.

Connector Realization
During connector realization, welds are created using the connector definition.

In HyperMesh, the only form of realization currently supported is FE realization (weld creation). For
successful realization, the connector must be populated with all the relevant details required for its
realization type. For example, FE realization requires the connector to be populated with a projection
tolerance and an FE configuration type.
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Figure 1039: Connector Realization
Connector seven realized with a valid tolerance value, and a config value of type 70 (acm detached).

One advantage of separating weld FE realization from the connector definition is that a connector can
be re-realized as a weld of a different configuration, or possibly, a user-defined weld, without having to
redefine the connector. If you edit the connector definition, for example, add or delete a link entity from
the connector, the connector removes the welds it created, and reverts back to an unrealized state. The
connector is unrealized only if its user-control mode is turned off. By default, the connector mode is off
but it can be turned on by registering custom FE with a connector. Connectors store all FE information
that they create, allowing advanced find, mask, delete, and organizational functionality in a number
of common panels. If the weld creation is unsuccessful, due to low tolerance, insufficient link entities,
and so on, the connector icon is displayed as failed (red). An unrealized connector is yellow, a realized
connector is green, and a failed connector is red.

Connector State
Status of the connector before and after realization.

The color of the connector changes based on their state to allow you to quickly visualize and filter
connectors.

Unrealized
The initial definition of the connector entity after it is created.
The connector is displayed in yellow.

Realized
The connector is considered realized only if weld creation at the connector was successful.
The connector is displayed in green.
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Modified
The connector is considered modified when one or more of its corresponding attributes have been
edited in the Connector Entity Editor.
The connector is displayed blue.

Failed
The connector is considered failed if the weld creation at the connector was not successful.
The connector is displayed in red.

Link Entity State
The link entity state specifies if the entity referenced by the link entity is meshed or unmeshed.

Geom
Specifies that the entity needs to be connected (welded) using its geometry (connect surfaces
only).

Elems
Specifies that the entity needs to be connected (welded) using its mesh.

Both states are applicable to assemblies, components and surfaces only. The elems state connects the
mesh on the assembly, component, or surface. The geom state connects the geometry on the assembly,
component, or surface. For all other link entities only the elems state is applicable. The states are added
to the connector entity.

After establishing link entities, they can only be modified and edited in the lower part of the Connector
Browser. The functions to add link, update links and remove links is found in the browser's right-click
context menu.

The link entity state options for assemblies, component, and surfaces are set when creating the
connector, or on the Add Links panel. The state can be edited/updated in the lower part of the
Connector Browser, as well. Therefore, the extended information has to be activated in the browser
configuration.

Link Entity
A link entity is a reference to a separate entity that can be added to a connector.

The entities, or a subset of them, to which the link entities refer are welded together during realization.

Supported link types include:

Assemblies
Connect elements or surfaces.
A group of parts that needs to be welded is often represented as an assembly.

Components
Connect elements or surfaces.
A part that needs to be welded is often represented as a component.
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Elements
Facilitates a patch-patch weld connector.

Nodes
Facilitates a node-node weld connector.

Parts
Connect elements or surfaces.

Properties
Connect elements.

Surfaces
Create welds to connect geometry before meshing; the welds create fixed points for the mesh.
The connected surfaces may be either meshed or unmeshed.

Tags
Define a weld connector for a node or an element that it holds.

Note:  Only nodes, tags, elements, surfaces, components, properties, and assemblies can
be added to connectors. The connectors can hold a single entity or a combination of these
entities.

After link entities are established, they can only be modified and edited in the lower part of the
Connector Browser. The functions to add link, update links and remove links is found in the browser's
right-click context menu.

The link entity options are set when creating the connector, or on the Add Links panel. The link entity
can be edited/updated in the lower part of the Connector Browser as well.

Number of Layers
The number of layers defines how many thicknesses (layers) have to be connected at the connector
position.

For seam and area connectors the number of layers is predefined as two.

For most spot connectors you will set the number of layers to two or three; though any higher number
is possible. For spot connectors it is also possible to set the number of layers to auto. Then the exact
number of layers is identified during the link detection and is written to each individual connector.

Bolt connectors can additionally be set to unlimited. This is for cases when the exact number of layers
is not known. In this case, the number of layers is limited by other conditions like tolerance and cylinder
dimensions.

For apply mass connectors a limit for entities can be set; this is optional.

The number of layers has to be defined for:

• Combined connector creation/realization in the top subpanel for spots, bolts, seams and areas.

• Pure connector creation in the create subpanel for spots, bolts, seams and areas.

• Adding links in the Add links panel.
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If connect when is set to now, a link detection is performed during connector creation. With respect
to the given tolerance, the selected link candidates and options like non-normal projection the valid
connector links are established. By default, if excess link candidates have been selected, the links are
reduced to the minimum needed to fulfill the request for the number of layers. The request for the
number of layers has to be fulfilled for each connector test point; this leads, for example, to seam
connectors typically having more than just two link entities.

Note:  The number of layers should not be mistaken for number of referenced links of a
connector. In many cases the number of layers and the number of referenced links are
equal, but that’s not mandatory. The number of referenced links can be less, equal or more
than the number of layers, although the connector might be realized successfully if the
links are provided in a manner that the request for the number of layers can be fulfilled.
That means not all referenced links necessarily need to be used for the connection, and
remain unused, or sometimes only one link is used twice, for example in the case of a flap.
For spot and seam connectors extra links can be stored. This can be set individually on the
appropriate option subpanels below links conservation.

The link entity options are set when creating the connector, or on the Add Links panel. The link entity
can be edited/updated in the lower part of the Connector Browser, as well.

Re-Connect Rules
Defines how a connector should protect its link entity information.

The re-connect rules can be defined in different ways:

• During pure connector creation in the create subpanel for spots, bolts, seams and areas, if connect
when is set to now.

• During adding links to an existing connector in the Add links panel, if connect when is set to now.

• During adding links to an existing connector in the lower part of the Connector Browser.

In the Connector Browser, link entities can be precisely edited, provided that the extended information
option is activated in the Browser Configuration dialog.

None
If a link entity references an entity that is removed from the database, the link entity is then
removed from the connector.

by id
If a link entity references a entity that is removed from the database, the link entity retains the ID
of the entity. The link entity remains in the connector.

by name
Same as the by id rule except that the entity name is retained.

by UID
Works the same as the other rules except that the part unique identifier is retained.
Only available for part links.
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The link entity options are set when creating the connector, or on the Add Links panel. The link entity
can be edited/updated in the lower part of the Connector Browser, as well; therefore, the extended
information has to be activated in the browser configuration.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2116

Realization Methods
Overview of the process used to select the best routine for realization.

Spot Realization
Overview of the spot connector realization process and methods.

Spot Realization Process
Overview of the spot realization process.

1. Select the realization type.

mesh independent
Use for realizations that do not need a node connection, and the connection is primarily
defined via a solver-specific card, such as CWELDs for Nastran.

mesh dependent
Use for all other cases.

2. If mesh dependent is selected, you must decided whether or not to adjust the mesh or the
realization.

Adjust mesh
Projection is done in a perpendicular way, and the mesh has to be adapted to the projection
points.

Adjust realizations
The mesh will not be modified, at the expense of non-normal or incomplete realizations.
Many realization types are defined with head elements attached to body elements. In the
case of these realization types, the head elements realize the connection without modifying
the mesh. Then the body element is still created in a normal direction.

3. Select a method for performing adjustments.

Adjust mesh
Sub-options include: quad transition and remesh.

Adjust realizations
Sub-options include: find nearest nodes, project and find nodes, and ensure projection.

4. Choose whether or not the imprint should be skipped for quad transition.

In stage 1, select the type of realization:
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Figure 1040: Spot Realization Process

Spot Realization Methods
Overview of the different options for spot realization methods.

Mesh Independent
The mesh independent option is normally used for solver-specific realization types. A post-script is
performed during realization to define the solver specific connection. For example, for the Nastran
CWELD of ELEMID option, the shells which are in contact are observed and defined in the CWELD card.
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Figure 1041: Mesh Independent

Mesh Dependent – Adjust Mesh – Quad Transition – Imprint

Figure 1042: Mesh Dependent, Adjust Mesh, Quad Transition, Imprint

Quad Transition
The quad transition option creates perfectly shaped quad elements around the projection points.
By default, the quad size is determined by the average mesh size. Alternatively, you can specify a
specific quad size in the quad size field.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2119

Figure 1043: Connectors Realized with Quad Transition using Different Quad Pattern Sizes
The top, left image illustrates the initial model situation. The remaining images illustrate connectors that have been

realized with quad transition using different quad pattern sizes: average, coarse, small. The regular quad pattern size is

highlighted and the red lines illustrate which nodes have been snapped to a relevant feature or free edge.

For spot quad transition, automatic snapping and feature detection is enabled by default via
the allow snapping checkbox. This prevents the creation of elements that are too small, and
ensures that the geometry is not modified too much.
Free edges and features with an angle greater than 25° are always taken into account. If
smaller feature angles should be considered, decrease the value in the feature angle field
(Preferences > Meshing Options). Feature angles smaller than 5° will not be considered.
By default, snapping is allowed by a distance of one third of the quad pattern element size. In the
case of a predefined quad pattern element size of 10.0, the outer nodes can snap to features in a
distance of 3.3. The algorithm also tries to snap all three nodes of a quad pattern or none.
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Figure 1044: Connector Realized with Quad Transition using Adequate Quad Pattern

A spot connector line is created when quad transition is used and a line or a node list is selected
as the connector position, unless the split to points checkbox is activated.
In Figure 1045, spot connectors are at the same exact position, though there is a notable
difference. In both images, the connectors have been created along a line, but in the left image
the split to points checkbox was enabled. In the left image, the quad transition pattern is
aligned to the mesh; in the right image the quad transition pattern is oriented along the spot
connector line. All elements around the spot connector line belong to the regular pattern. The
number of element pairs created along the spot connector line between the spot positions
depends on the average or selected mesh size, which can be from one to many. The quad
elements are distributed equidistant along the line.
In curved regions the inner and outer lengths of the element edges differ.

Figure 1045: Split to Points Example
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Imprint
When creating mesh-dependent realizations with quad transitions, the quad transition meshes
can overlap and disturb each other if more than one set of connectors is created too close to
each other. Select the imprint option to reconcile such transitions with each other and modify
the underlying mesh to match the results, creating a final result that is seamless and properly
meshed.
To allow smaller imprint conflicts to be automatically resolved when connectors are realized,
the resolve conflicting imprints checkbox is enabled by default. Overlapping elements are
released, and a normal remesh of that area is performed as long as the overlapping area is
smaller than half the regular quad transition element size. Larger conflicts may require a manual
imprint.

Mesh dependent – Adjust Mesh – Quad Transition – Skip Imprint
Quad Transition

The quad transition option creates perfectly shaped quad elements around the projection points.
By default, the quad size is determined by the average mesh size. Alternatively, you can specify a
specific quad size in the quad size field.
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Figure 1046: Connector Realized with Quad Transition using Adequate Quad Pattern
The top, left image illustrates the initial model situation. The remaining images illustrate connectors that have been

realized with quad transition using different quad pattern sizes: average, coarse, small. The regular quad pattern size is

highlighted and the red lines illustrate which nodes have been snapped to a relevant feature or free edge.

For spot quad transition, automatic snapping and feature detection is enabled by default via
the allow snapping checkbox. This prevents the creation of elements that are too small, and
ensures that the geometry is not modified too much.
Free edges and features with an angle greater than 25° are always taken into account. If
smaller feature angles should be considered, decrease the value in the feature angle field
(Preferences > Meshing Options). Feature angles smaller than 5° will not be considered.
By default, snapping is allowed by a distance of one third of the quad pattern element size. In the
case of a predefined quad pattern element size of 10.0, the outer nodes can snap to features in a
distance of 3.3. The algorithm also tries to snap all three nodes of a quad pattern or none.
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Figure 1047: Connector Realized with Quad Transition using Adequate Quad Pattern

A spot connector line is created when quad transition is used and a line or a node list is selected
as the connector position, unless the split to points checkbox is activated.
In Figure 1048, spot connectors are at the same exact position, though there is a notable
difference. In both images, the connectors have been created along a line, but in the left image
the split to points option was enabled. In the left image, the quad transition pattern is aligned
to the mesh; in the right image the quad transition pattern is oriented along the spot connector
line. All elements around the spot connector line belong to the regular pattern. The number
of element pairs created along the spot connector line between the spot positions depends on
the average or selected mesh size, which can be from one to many. The quad elements are
distributed equidistant along the line.
In curved regions the inner and outer lengths of the element edges differ.

Figure 1048: Split to Points Example

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2124

Skip Imprint
The skip imprint option prevents the last step of quad transition from being performed. The
component ^conn_imprint is created instead, which contains the element pattern. These
elements can be modified and manually imprinted later using the Connector Imprint panel.
Skip imprint allows you to realize such mesh-dependent realizations in very complex areas of the
model where the automatic imprint fails because of issues such as conflicting spots.

Figure 1049: Skip Imprint

Mesh Dependent – Adjust Mesh – Remesh
The remesh option takes the projection points into account and uses snap and split capabilities to
connect the weld to the links.
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Mesh Dependent – Adjust Realization – Find Nearest Nodes
The find nearest nodes option searches for the nearest nodes within the given tolerance only, making 
it possible to connect t-joints and similar areas. This option is also very useful in situations where the 
connectors are not positioned perfectly. The realizations are allowed to be non-normal.

Find nearest node does not perform projections.

Figure 1051: Mesh Dependent, Adjust Realization, Find Nearest Nodes

Mesh Dependent – Adjust Realization – Project and Find Nodes
The project and find nodes option requires a valid normal projection onto the link entities in the first
step. In the second step, the nodes closest to the projection points will be used for the connection. If
the normal projection is not possible, the realization fails.
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Figure 1052: Failed Realization

An angle of less than five degrees is considered normal. Activating the non-normal projection
checkbox omits the requirement for a normal projection, and permits links to only be found in the
connector tolerance. The result is exactly the same as it is for the find nearest node option.
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Figure 1053: Non-Normal Projection

Mesh Dependent – Adjust Realization – Ensure Projection
When the ensure projection option is selected, the minimum condition for the realization is a possible
projection. The realization will be performed in the direction from one projection point to the next. If the
projection point is coincident with a shell node they will be equivalenced.

Ensure projection is comparable to the older use shell node option, which is no longer available.
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Note:  Ensure projection can lead to incompletely defined connections from a solver
perspective unless the connector positions are not aligned to the mesh. The advantage of
this projection method is the exact determination of the projection points.

Figure 1054: Ensure Projection

Enabling the non-normal projection checkbox allows the realization to be performed from one
projection point to the next.
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Figure 1055: Ensure Projection with Non-Normal Projection
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Bolt Realization
Overview of the spot connector realization process and methods.

Bolt Realization Process
Overview of the bolt realization process.

1. Select the realization type.

mesh independent
Use for realizations which do not need a node connection, and the connection is primarily
defined via a solver-specific card or the nodes which need to be connected are defined by a
cylinder, such as Bolt (cylinder spring) for Radioss.
For all mesh independent bolt realization types a cylinder is defined. Bolt hole detection
is not performed because holes are not required. All of the nodes inside the cylinder are
considered part of the bolt realization unless they also belong to a link defined on the
connector.
The cylinder dimension is primarily defined by its diameter, length L1 and L2.

• L1 points in the same direction as the connector vector and describes the distance from
the connector position to the first end of the cylinder.

• L2 points in the opposite direction and measures the distance between the connector
position and the second end of the cylinder.

Therefore, the connector vector is essential for these types of realizations.
If a vector is not predefined and is determined dynamically, the vector will always point from
the connector position to the projection point on the farthest link.
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Figure 1056: Connector Vector
Dynamic vectors have been used in the first two cylinder. Interchanging the values for L1 and L2 leads to very 

different realizations. By comparison, the third cylinder uses the same values for L1 and L2 as in the second 

cylinder, but the result looks better because of the predefined connector vector in the global z-direction.

In some automated processes the cylinder diameter is automatically set to the bolt shaft 
diameter. This leads to failed cylinder bolts when the holes are properly modeled because 
the defined cylinder does not contain nodes. In such cases the cylinder diameter factor 
has been introduced; this factor is set to 1.0 by default and is a multiplier for the cylinder 
diameter to increase the final cylinder diameter when necessary.
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Note:  The cylinder diameter as well as the cylinder diameter factor can be
reviewed and modified in the Connector Browser. Connectors can also be
rerealized with modified cylinder diameters and cylinder diameter factors without
updating L1 or L2 in the browser. This is not possible from the panel.

Figure 1057: Cylinder Diameter Factor

mesh dependent
Use for all other cases.

2. If you selected mesh dependent, you must determine:

• Is the existence of holes in each layer requested upfront?

• How should the 2D mesh be prepared before the final realization is performed?
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In the past a bolt realization always required a hole for each layer in the initial mesh. This is no
longer necessary for 2D meshes because the imprint capability punches the needed holes into the
mesh before the final realization is performed, enabling the mesh to be manipulated in a pre-step.
This makes it possible to punch holes, move holes, close holes, create washers, and so on.

Select one of the following:

Consider existing holes only
A minimum of one hole per layer must be available in the origin mesh. If holes do not exist
the realization will fail. This is the default method and must be used for any type of solid
meshes.

Figure 1058: Consider Existing Holes Only

Create hole, if none
If there are not any holes on a certain layer, they will be punched into that layer at the
position of the projection point. The diameter of the new hole is defined on the Realization
Details subpanel. This method is used if the model does not contain the appropriate amount
of holes per bolt, but holes are required for specific realization types.

Figure 1059: Create Hole, if None

Use hole, if available
Creates hybrids (hole on one side only), but other combinations are allowed. On the mesh
side (no hole), the connection is realized via the head elements defined in the chosen
realization type. The head element(s) is/are created between the appropriate body element
node and the nodes inside the diameter (no hole connection dia) defined on the Realization
Details subpanel. This option is used for realization types which are not eager for holes.

Proprietary Information of Altair Engineering

Figure 1060: Use Hole, if Available



Altair HyperMesh 2019 Users Guide
Connectors p.2132

Fill & remesh hole, if available
Use this option when you do not want the shape of holes to interfere with the mesh flow in
the bolt region. The detected holes are closed and a remesh of the new elements and a few
additional rows of adjacent elements is performed. The connection is realized via the head
elements defined in the chosen realization type. The head elements are created between the
appropriate body element nodes and the nodes inside the diameter (no hole connection dia)
defined on the Realization Details subpanel.

Figure 1061: Fill & Remesh Hole, if Available

Note:  The hole detection mechanism for the last three options takes into account a
cylinder which is defined in the Hole Detection Details subpanel. The hole consideration
cylinder option can be defined as a factor of the no hole connection dia option or as
an exact diameter. Principally holes which are inside or touching the cylinder can be
detected, but the hole consideration is reduced to one hole per link per connector.
Additionally holes need to fit to the requested dimensions, which are also defined in
the Hole Detection Details subpanel.

3. For the create hole, if none, and use hole options, a mesh modification including a hole movement
is allowed. Therefore, you can determine whether to adjust the hole(s) or to adjust the realization.

Adjust hole position (2D)
Moves the center of a hole into the position of the projection point.
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Adjust realization
Hole positions are not modified, enabling the realized elements to compensate the
nonaligned centers of holes.

Figure 1063: Adjust Realization

4. This stage cannot be skipped, as it has great influence on stages 2 and 3, which is expressed by
the large arrow underlying those stages in the flow chart.

This stage contains all realize and hole detection details which need to be known before the final
realization is done. The realize and hole detection subpanel can be accessed by clicking realize
& hole detect details in the bolt and realize subpanels. This subpanel is organized into two
additional subpanels: hole detection details and realization details.
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Figure 1064: Bolt Realization Process

Figure 1064: Bolt Realization Process
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Bolt Realization Methods
Overview of the different options for bolt realization methods.

Hole Detection Details
Dimension and Feature Angle

The minimum and maximum dimensions define which holes should be considered during bolt
realization. The minimum and maximum feature angle define the features to be considered as
hole edges for solid elements.

Hole Consideration Cylinder
Not all of the holes found in the given connector tolerance can be considered for the various bolt
realizations.

• The connector tolerance, especially when set to a large value, detects many holes. To prevent 
detecting holes which are far away from the connector position and are not aligned with the 
other hole(s), the consideration cylinder excludes outer holes from the detection.

• Since the existence of a hole is not necessarily requested anymore, a space has to be defined 
where the holes are expected to be. It is no longer sufficient to use just the connector 
tolerance, therefore the hole consideration cylinder option performed along the projection 
path becomes necessary. All of the holes the cylinder touches or contains can be considered 
for the various bolt realizations.
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Define cylinder diameters in the following ways:

auto cylinder diameter (factor)
Factors given diameters, which include: create hole diameter (2D), create/adjust hole
diameter (2D), adjust hole diameter (2D), and no hole connection diameter. The first
available diameter is used. The default factor is 1.5.

exact cylinder diameter
Specify an exact diameter. The default diameter is 15.0

Proprietary Information of Altair Engineering

Note:  The hole consideration cylinder option is not offered when using the
consider existing holes only option.

Realization Details
The realization details subpanel contains additional information about the exact treatment of holes and
no holes, if bolt realization is performed. Dependent on the options selected in stage 2, varying subsets
of the options are offered.

Diameter and adjustments options include:

create hole diameter (2D)
Create new holes with the specified diameter. Used if holes are required by the create hole, if
none option.

Figure 1066: Create Hole Diameter (2D

create and adjust hole diameter (2D)
Create new holes with the specified diameter and adjust existing holes with the specified
diameter, which leads to bolt realizations with the exact same diameter on all links. Used if holes
are required by the create hole, if none option.

Figure 1067: Create and Adjust Hole Diameter (2D
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adjust hole diameter (2D)
Adjust existing holes to the specified diameter. The do not adjust hole diameter option switches
off the adjustment and uses the holes with their origin size. Used if holes are not necessarily
required when using the use hole, if available option, but the existing holes need to have a
specific diameter.

Figure 1068: Adjust Hole Diameter (2D)

no hole connection diameter
Connect a link without an available hole by joining the nodes found inside the circle with the
specified diameter around the projection point via head elements. Used if holes are not required
when using the use hole, if available option or fill and remesh hole, if available option.
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Hole filling and number of nodes around holes options include:

fill holes (2D)
Fill detected holes during bolt realization. There are various quad patterns available, which cause
a remeshing of the area around the hole.

Figure 1069: Quad Patterns

Holes can also be filled with pie pieces. If the number of pie pieces is defined, the surrounding
mesh is remeshed. The pie pieces preserve option also creates pie pieces, but takes the existing
hole nodes into account and prevents the remeshing.

Note:  Activating the fill holes (2D) option deactivates the no. of nodes around hole
option.

Figure 1070: Pie Pieces Preserve

no. of nodes around hole

preserve
Use the number of nodes of the appropriate origin hole. This is the default option which
prevents the surrounding mesh from being remeshed. For new holes, the auto option is
used.

density
Specify the exact number of nodes (default is 8). The surrounding mesh gets remeshed.

elem size

auto

Specify an element size (default is 5.0). The number of elements around the hole is
calculated based on this size. This is the preferred option for extremely different hole
diameters. The surrounding mesh gets remeshed.

Perform a node distribution based on the underlying mesh size. The number of nodes is
always rounded to an equal number.
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For 2D holes, one or two washer layers can be created, after which the surrounding mesh gets
remeshed.

The width of the washer can be defined by:

• Factoring the hole radius.

• Directly specifying the exact width.

Figure 1071: Define Washer Width
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Create washer layer options:

Seam Realization
Overview of the spot connector realization process and methods.

Seam Realization Process
Overview of the seam realization process.

1. Select the realization type.

mesh independent
Use for realizations which do not need a node connection and the connection is primarily
defined via a solver-specific card, such as LLINKs for PAM-CRASH.

mesh dependent
Use for all other cases.

2. If mesh dependent is selected, you must decide whether or not to adjust the mesh or the
realization.

Adjust mesh
Projection is done in a perpendicular way, and the mesh has to be adapted to the projection
points.

Adjust realization
The mesh will not be modified, at the expense of non-normal or incomplete realizations.
Many realization types are defined with head elements attached to body elements. In the
case of these realization types, the head elements realize the connection without modifying
the mesh, and the body elements are created in a normal direction.

3. Choose how the adjustments should take place.

Adjust mesh
Sub-options include: quad transition and remesh.

Adjust realizations
Sub-options include: find nearest nodes, project and find nodes, and ensure projection.

4. Choose whether or not the imprint should be skipped for quad transition.
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Figure 1072: Seam Realization Process
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Seam Realization Methods
Overview of the different options for seam realization methods.

Mesh Independent
The mesh independent option is normally used for solver-specific realization types, then a post script is 
performed during realization to define the solver specific connection. For example, for the PAM-CRASH 
LLINK all necessary solver specific cards are created along with the realization.

Figure 1073: Mesh Independent

Mesh Dependent – Adjust Mesh – Quad Transition - Imprint
Quad Transition

The quad transition option creates perfectly shaped quad elements around the projection line. The
quad size is determined by the average mesh size. From one projection point to the next, exactly
one pair of elements is created. You can also use this option to create seams from quad elements,
and realize the connections to the links through perfectly modeled t-edges.
In certain limits, the mesh automatically snaps to important features. This prevents the creation
of elements that are too small, and ensures that the geometry is not modified too much.
The considered feature angle can be defined individually for each connector. Feature edges below
10.0° will not be taken into account, whereas features above 25.0° and free edges will always be
taken into account.
By default, snapping is allowed by a distance of one third of the quad pattern element size. In the
case of a predefined quad pattern element size of 10.0, the outer nodes can snap to features in a
distance of 3.3. The algorithm also tries to snap all three nodes of a quad pattern or none.
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Imprint
When creating mesh-dependent realizations with quad transitions, the quad transition meshes 
can overlap and disturb each other if more than one set of connectors is created too close to each 
other. The imprint option reconciles such transitions with each other and modifies the underlying 
mesh to match the results to create a final result that is seamless and properly meshed.
To enable smaller imprint conflicts to be automatically resolved when connectors are realized, the 
resolve conflicting imprints option is activated by default. Overlapping elements are released, and 
a normal remesh of that area is performed as long as the overlapping area is smaller than half the 
regular quad transition element size. Larger conflicts may require a manual imprint.
To allow smaller imprint conflicts to be automatically resolved when connectors are realized,
the resolve conflicting imprints checkbox is enabled by default. Overlapping elements are 
released, and a normal remesh of that area is performed as long as the overlapping area is 
smaller than half the regular quad transition element size. Larger conflicts may require a manual 
imprint.
The size of the imprint can be determined using the pitch size (use pitch size to imprint) or using 
the average size of the underlying mesh (use avg. mesh size to imprint). If you want to define a 
specific imprint size, select size to imprint.



Altair HyperMesh 2019 Users Guide
Connectors p.2143

Proprietary Information of Altair Engineering

Figure 1074: Imprint
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one pair of elements is created. You can also use this option to create seams from quad elements,
and realize the connections to the links through perfectly modeled t-edges.
In certain limits, the mesh automatically snaps to important features to prevent the creation of
elements that are too small, and to ensure that the geometry is not modified too much.
The considered feature angle can be defined individually for each connector. Feature edges below
10.0° are not taken into account, whereas features above 25.0° and free edges are always taken
into account.
By default, snapping is allowed by a distance of one third of the quad pattern element size. In the
case of a predefined quad pattern element size of 10.0, the outer nodes can snap to features in a
distance of 3.3. The algorithm also tries to snap all three nodes of a quad pattern or none.

Skip Imprint
The skip imprint option prevents the last step of quad transition from being performed. The
component ^conn_imprint is created instead, which contains the element pattern. These
elements can be modified and manually imprinted later using the Connector Imprint panel.
Skip imprint enables you to realize such mesh-dependent realizations, even in very complex areas
of the model where the automatic imprint fails because of issues such as conflicting seams.
The size of the imprint can be determined using the pitch size (use pitch size to imprint) or using
the average size of the underlying mesh (use avg. mesh size to imprint). If you want to define a
specific imprint size, select size to imprint.

Figure 1075: Skip Imprint

Mesh Dependent – Adjust Mesh – Quad Transition – Skip Imprint
Quad Transition

The quad transition option creates perfectly shaped quad elements around the projection line. The
quad size is determined by the average mesh size. From one projection point to the next, exactly
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Figure 1076: Remesh

Mesh Dependent – Adjust Realization – Find Nearest Nodes
The find nearest node option searches for the nearest nodes within the given tolerance, making
it possible to connect t-joints and similar areas. This option is very useful in situations where the
connectors are not positioned perfectly. These realizations are allowed to be non-normal. Find nearest
nodes does not do any projection.

Note:  If the connector points are close to each other and two of these points find the same
closest nodes the connector fails.

Mesh Dependent – Adjust Mesh – Remesh
The remesh option uses snap and split capabilities to connect 1D welds to the links in the position of the
projection points. In the case of a quad realization, remesh looks for a correct t-edge.
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Figure 1079: Ensure Projection

Figure 1077: Find Nearest Nodes

Mesh Dependent – Adjust Realization – Project and Find Nodes
The project and find nodes option produces the same exact result as find nearest node because a
non-normal projection for seams is always allowed. Principally, project and find nodes requires a valid
projection onto the link entities in the first step. In the second step, the nodes closest to the projection
points will be used for the connection. If the projection (connector tolerance) is not possible, the
realization fails.
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Mesh Dependent – Adjust Realization – Ensure Projection
When using the ensure projection option, the minimum condition for the realization is a possible normal 
projection. The realization will be performed in the direction from one projection point to the next. If the 
projection point is coincident with a shell node they will be equivalenced.

Ensure projection can lead to incompletely defined connections from a solver perspective unless the 
connector positions are not aligned to the mesh. The advantage of this projection method is the exact 
determination of the projection points.

The ensure projection option is comparable to the older use shell node option, which is no longer 
available.Note:  The realization fails when the connector points are close to each other, and two of

these points find the same nodes.

Figure 1078: Project and Find Nodes
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Figure 1080: Area Realization Process

Area Realization
Overview of the area connector realization process and methods.

Area Realization Process
Overview of the area realization process.

Each test point can be considered as a single spot. The methods are the same and the results look 
identical.

Note:  The quad transition is not yet implemented for area connectors, even though the
panel offers these options. Instead of quad transition, a simple adjust realization – ensure
projection is performed.
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Special Realization Types
Learn about special connector realization types.

Hexa Nugget
Use the Hexa Nugget realization to create hexa clusters between shell components.

Contacts are defined between the shell components and the appropriate hexa nodes. A heat affected 
zone for the shells from ultra-high strength steel material is also created.

Hexa Nugget realizations can be used for any amount of parallel combinations of shell components.

Note:  The Hexa Nugget realization is only available in Radioss and LS-DYNA user profiles,
and can only be selected and defined in the Connector Entity Editor on existing spot
connectors.

Define the heat affected zone dimensions using the parameters available in the Connector Entity Editor.
The dimension and property of each heat affected zone (HAZ) can be separately defined. Each setting is
stored and considered per individual connector.
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Figure 1081: HAZ Dimensions

Figure 1081: HAZ Dimensions
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General Info

Table 254: General Info Parameters

Parameter Action

Tolerance Specify a distance from the connector location. Only the entities
within this tolerance can be taken into account for the final realization.
The tolerance is used to verify whether adequate link candidates are
available to be connected with respect to the number of layers.

Weld Shape

Table 255: Weld Shape Parameters

Parameter Action

Hexa Number Create a hexa cluster of 4 hexas, arranged in a predefined pattern.

Note:  By default, Hexa Number is set to 4 hexa. You
cannot edit this field.

Coats Specify the number of hexa elements required along the thickness.
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Note:  By default, Hexa Coats is set to 1 for a hexa
nugget connector. You cannot edit this field.
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Realization Details
Use the Realization Detail parameters to define the dimension of the welds.

Table 256: Realization Details Parameters

Parameter Action

Diameter Option Choose how the diameter is defined. This field is used for realizations
based on hexa elements, where the size of the realized element
(hexa) is created based on the diameter value.

diameter
Specify a single diameter value.

diameter mapping file
Use a diameter mapping file to calculate the diameter.
The diameter mapping file obtains diameter values that you
assigned to a range of flange thicknesses in the Diameter Table.
Along with flange thickness ranges, you can also specify the
main flange thicknesses to consider when assigning diameter
values.

Hexa Thickness Option Project the hexa spot to touch the shell elements. The position is
independent from any thickness.

Note:  By default, Hexa Thickness Option is set to shell
gap. You cannot edit this field.

Connectivity Info

Table 257: Connectivity Info Parameters

Parameter Option

Connectivity
Note:  By default, Connectivity is set to contact. You cannot
edit this field.
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Parameter Option

HAZ Create the quad weld elements and stitch them to both links by
adjusting their mesh. Perform all required HAZ.

Enable Condition HAZ Control which parts need to receive heat affected zones during the
realization.

Skip Imprint Create the quad weld elements, but do not change the meshes of the
links.

Instead, create additional elements to represent the requested HAZ.
These elements are organized in the ^conn_imprint component.

You can use these elements for a later manual imprint after they have
been manipulated to your need. This can be helpful in more complex
areas, where the standard imprint functionality fails, for example, when
working with conflicting connectors.

Note:  The quad weld elements are not attached to the
links. The connection needs further attention.

Contact Info

Table 258: Contact Info Parameters

Parameter Action

Contact Creation Option Choose a method for creating contacts.

one contact per link
Create one exclusive contact with two exclusive sets per each
link.
Create the contact between the link and the hexa nugget nodes
laying on this link. The nodes of one hexa nugget belong to two
different contact definitions.

• Groupname(s): hexa_nugget_contact_Linkname

• Setname(s) Master:
hexa_nugget_master_part_set_Linkname

• Setname(s) Slave: hexa_nugget_slave_node_set_Linkname

one contact per link pairing
All hexa nugget connectors using the same links are sharing the
same contact and sets.

• Groupname(s): hexa_nugget_contact_Linkname1_Linknam
e2_Linkname3(when 3 layer)
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Parameter Action

• Setname(s) Master:
hexa_nugget_master_part_set_Linkname1_
Linkname2_Linkname3

• Setname(s) Slave:
hexa_nugget_slave_node_set_Linkname1_L
inkname2_Linkname3

single contact
Create one contact and two sets for this realization type in the
model.

• Groupname: hexa_nugget_singlecontact

• Setname Master: hexa_nugget_single_master_part_set

• Setname Slave: hexa_nugget_single_slave_node_set

Auto Correction

Table 259: Auto Correction Parameters

Parameter Option

Allow Reposition Reposition hexa elements and HAZ elements. If the option is
deselected, the connector will fail when the connector is too close to
free or feature edges where the nugget and HAZ elements cannot be
accommodated.

Reposition Tolerance Specify a maximum allowable distance by which hexa elements and
HAZ elements are repositioned based on connector location to edge.

Control Distance Choose a method for controlling distance.

for close free edges
Only consider the connectors which are positioned close to free
edges for repositioning at the time of realization.

for close free and feature edges
Only consider connectors for repositioning at the time of
realization which are positioned close to free edges as well as
feature edges.

Requested Distance Choose whether the distance to reposition is based on minimum
distance to imprint or a minimum distance to connector projection.
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Parameter Option

Distance Choose whether to manually specify a distance or use the minimum
element size from the element criteria file.

HAZ Info

Table 260: HAZ Info Parameters

Parameter Option

HAZ Material Condition Enable the selection of UHSS material which controls which parts need to
receive heat affected zones during the realization.

UHSS Material Option Choose a method for selecting UHSS material.

From current model
Select an existing material from current model.
In the Connector Entity Editor, the UHSS Material Entity ID’s field is
populated with the number of the materials selected.

From search file (default)
Select material from a search file.
For Hexa Nugget Connector realizations the material search file
name is materialsnippets.txt. HyperMesh searches for this file in
the following locations and in the following order:

1. Installation: [hm_scripts_dir]/ connectors/
materialsnippets.txt

2. User directory: [USER_HOME]/ materialsnippets.txt

3. HyperWorks configuration path folder: [HW_CONFIG_PATH]/
materialsnippets.txt

4. Current working folder: [CURRENTWORKINGDIR]/
materialsnippets.txt

In the Connector Entity Editor, the UHSS Material File field is
populated with the name of the file that was found last.
The text file contains snippets from the material names, which need
to receive heat affected zones during the realization.

From connector metadata
Once a connector is realized with the UHSS Material Option
“From search file”, the folder name is written as metadata to
the connector in a relative manner to allow the exact same
rerealization in a different work environment as long as the same
materialsnippets.txt files are saved in according folders.

HAZ Dimension Scheme Choose a setting for defining HAZ diameters.
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Parameter Option

HAZ Inner Diameter values
Specify an absolute value for the HAZ Inner Diameter.

Note:  This value must be greater than the value used
for defining the nugget diameter.

scale factors
Calculated as a scale factor from the nugget diameter.

Note:  This value must be greater than or equal to 1.0.

offsets
Specify a HAZ Inner Diameter which is offset from the nugget
diameter.

HAZ Outer Diameter values
Specify an absolute value for the width of the first layer around the
HAZ Inner Diameter.

scale factors
Specify a width for the first layer around the HAZ Inner Diameter.
Calculated as a scale factor from the nugget diameter.

offsets
Specify a width for the first layer around the HAZ Inner Diameter
which is offset from the HAZ Inner Diameter.

Note:  For values and scale factors, this value must be
greater than the value used for defining the HAZ Inner
Diameter.

HAZ Layer 2 Enables you to specify the HAZ Outer Diameter 2. By default, this
checkbox is cleared and the HAZ Outer Diameter 2 cannot be defined.

HAZ Outer Diameter 2 values
Specify an absolute value for the width of the second layer around
the HAZ Outer Diameter.

scale factors
Specify a width for the second layer around the HAZ Outer
Diameter. Calculated as a scale factor from the nugget diameter.

offsets
Specify a width of the second layer around the HAZ Outer Diameter,
which is offset from the HAZ Outer Diameter.
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Parameter Option

Note:  For values and scale factors, this value must be
greater than the value used for defining the HAZ Outer
Diameter.

Property and Material Info
Use the Property and Material Info parameters to define the properties and materials of the welds and
the heat affected zones (HAZ).

Table 261: Property and Material Info Parameters

Parameter Option

HAZ Material Option Choose a method for assigning material for the HAZ.

Use original material
Assign a new HAZ component with the same material that was
assigned to the original components.

Use copy of original material
Duplicate the original materials and assign them to new
components.
The original material is duplicated.
The new material name will be the same as the original
material with _HAZ_mat as a postfix.

Select a material
Select a material from the current model via the select material
for HAZ option. HAZ components are created with the same
name as the selected material with property ID as a postfix.
When set to <unspecified>, a default material is taken
from the [hm_scripts_dir]/connectors/hexa_nugget/
dyna/hexa_nugget_HAZ_material_default.ini
file. HAZ components are created with name
hexa_nugget_HAZ_mat_default_ and with the property ID as a
postfix.

HAZ Property Option Choose a method for assigning a property to HAZ.

Use original property
Assign a new HAZ component with the same property that was
assigned to the original components.

Use copy of original material
Duplicate the original properties and assign them to new
components.
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The original property is duplicated.
The new property name will be the same as the original
property with _HAZ_prop as a postfix.

Scale original thickness
Create a new property and component for each link that has a
HAZ imprinted.
The property is a copy of the original. Properties are named
as <originalname>_<HAZ_prop>_<scaled thickness>, and
components are named as <matname>_<scaled property
name>.

Input thickness
Create a new property and component for each link that has a
HAZ imprinted.
The property is a copy of the original. Property is named
as <hexa_nugget_HAZ_prop>_<thickness_value>, and
components are named as <matname>_<Input thichness
prop name>.

Select a property
Select a property from the current model via the select
property for HAZ option.
HAZ components are created and named using the UHSS
material with the property ID as a postfix. For example, <UHSS
matname>_<prop ID>.

Nugget Material Option Choose a method for creating and assigning material to nuggets.

Create one material per each link combination
Create one material for each link combination.
The weld material is named <hexa_nugget_weld_mat>_<link
1 ID/name>_<Link 2 ID/name>.
If the link with ID 1 and the link with ID 2 are connected,
than the weld material which gets created will be named
hexa_nugget_weld_mat_1_2.

Create one material per each number of layer
Create one material based on the number of layers the weld is
connecting to.
The weld material is named <hexa_nugget_weld_mat>_<link
1 ID/ name>_<No. of layers>.
If it is a 2T weld, than the mat name will be
hexa_nugget_weld_mat_2L.
If it is a 3T weld, than it will be named
hexa_nugget_weld_mat_3L.
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Parameter Option

Use one single weld material
Select a weld material from the current model using Select
Nugget Material Option. The selected material will be assigned
to all weld elements.

Itemize Multilayer Connections Itemize a multilayer connection. For example, in the case of a three
layer connection, the two hexa clusters will be handled separately
and will be assigned two different materials. At the same time, a two
layer connection between the same two links will be assigned another
material.

Names are created as following:

hexa_nugget_weld_material_link1_link2_(link3)
Ideally the links are ordered as <outer involved
link>_<inner involved link>_(<uninvolved comp>), so
that the two links involved come first, and the link(s) that are
not involved are written in brackets.

hexa_nugget_weld_material_link3_link2_(link1)
Ideally the links are ordered as <outer involved
link>_<inner involved link>_(<uninvolved comp>), so
that the two links involved come first, and the link(s) not
involved are written in brackets.

hexa_nugget_weld_material_link1_link2,
hexa_nugget_weld_material_link2_link3

All materials are derivatives from [hm_scripts_dir]/
connectors/hexa_nugget/radioss/
hexa_nugget_weld_material_default.ini

Note:  Only available when Nugget Material Option is set
to Create one material per each link combination.

Select Nugget Property Select a property from the current model.

Behavior

Table 262: Behavior Parameters

Parameter Option

Non-normal Attempt to realize connectors if the shell layers are not normal to each
other.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2159

Parameter Option

Project Hexa Faces To Shell Investigate and project each individual node, enabling you to expect and
accept penetrations.

In some border cases, during realization not all nodes of the appropriate
hexa(cluster)-side are positioned exactly on the shell. This is due
to some simplifications during the projection routine because it is
estimated that the shells will not be too curvy and will be pretty plain.
Therefore, not every node is individually investigated and projected to
the same plane as the first one.

Ensure Hexa Projection When enabled, all hexa node projections to a link that are beyond the
specified tolerance (0.01*diameter) are marked as an error.

Tip:  Enable this checkbox when working with connections
that use a contact definition.

Preserve Washer Choose a method for preserving washers during the realization. Initial
situation with perfectly meshed washers.

Figure 1082: Original

After realization, with no washer preservation. The washers have been
opened.

Figure 1083: No Washer Preservation

After realization, with washer preservation and remesh allowed. The
washers are still intact, but the mesh seeding has been changed.
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Figure 1084: Preserve Washer, Allow Remesh

After realization, with washer preservation and no remesh allowed. The
washers have been fully preserved.

Figure 1085: Preserve Washer, No Remesh

Feature Angle Specify a value used to determine important features, which need to be
kept when doing the imprint.

Note:  Features crossing the HAZ and close by cannot be
kept.

Post Collector Name Setting While realizing a hexa nugget connector, choose to name the collectors
created after the realization with link names or link IDs.
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Post Collector Name
Separator

Choose a separator to use between collector names.

HiLock
The HiLock realization type can be used for any more or less parallel combination of PSHELL and PCOMP
elements, and creates a 1D element construct consisting of RBAR, CBAR and CBUSH elements.

Restriction:  Available for Nastran and OptiStruct solver interfaces.

The outer extensions represent the thicknesses of the outer shell elements. The inner nodes of the
RBAR element are connected to the shell elements whereas the inner nodes of the CBAR elements are
coincident to the shell nodes. Between the appropriate connected and coincident nodes CBUSH elements
are created. Each outer node connects one CBAR and one RBAR.

Each HiLock connection gets its own coordinate system with the z-axis collinear to the HiLock direction.
All affected nodes are assigned to this coordinate system, which is taken into account for the DOF
definition of the CBAR elements, the stiffness calculation of the CBUSH elements, and the DOF of the
node constraint.

This realization uses the shell properties and materials (PSHELL or PCOMP) and a definable HiLock
material to calculate the exact position of the outer nodes and the stiffness of the PBUSH elements.
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Figure 1086:
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Figure 1087:

Details and Requirements
Certain conditions must be met for reliable realization.

• In the case of composites, only PCOMP cards in which the laminate option is either blank or set to
SYM (symmetric) are supported. MEM, BEND, SMEAR, and SMCORE options are not supported for
HiLock realization, and will cause realization to fail if used.

• The joined shells should be parallel to each other and planar.

• The fastener should be perpendicular to the shells.

• The z-axis of the element system, the material system, and the fastener system should be
collinear.

• Stiffness is calculated assuming that the shells are perfectly planar and parallel. Small deviations
will produce insignificant changes in predicted stiffness, but larger ones would require a system
transformation.

• The shell elements which share a node with the HiLock (separate for each layer) should have the
same properties, same materials, same material orientations, and similar sizes. The attributes of
the element upon which the projection falls is assumed to be the same as the other surrounding
elements (no averaging method is used.)
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If attributes necessary for the stiffness calculation are missing, the connector fails and an error
message displays in the status bar.

The realization requires available nodes near the connector position. If sufficient nodes are not
available, the created elements are not collinear anymore and the HiLock gets a questionable geometry.

Organization and Definition of HiLock Realization
All HiLock elements (RBARs, CBARs, CBUSHs) created during the realization process are organized into a
component named HiLock.

The following property collectors are created:

HiLock_PBAR_<diameter>
Created with the PBAR card associated with it. The RBAR elements reference this property. The
attributes are calculated depending on the diameter specified in the Spot panel during realization.

HiLock_PBUSH_<translational stiffness>_<rotational stiffness>
Created with the PBUSH card associated with them. The CBUSH elements reference this property.
The attributes are calculated depending on the chosen HiLock material and the properties and
materials of the connected shells (PSHELL and/or PCOMP).

The following load collector is created:

HiLock_SPC6
SPCs are created for each HiLock are moved into it.

The following system collector is created:

HiLock
Systems created during the realizations will be moved into this collector. If this system collector
already exists, any newly created systems will be moved into the same collector.

If a HiLock material is not selected, a default material is created.

HiLock_MAT1
This material will be assigned to the PBAR cards, and can be found in the following folder of the
installation directory: [hm_scripts_dir]/connectors/HiLock_Mats.
The predefined values are:

set E 1.8+07

set G 4.7e+04

set NU 0.330

set RHO 8.9e-09set A 1.7e-05

HiLock Material Option
When defining a HiLock connector, the HiLock Material Option can be selected for individual connectors
using the Connector Entity Editor.

From current model
Select an existing material from the current model.
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Figure 1088:

From search folder (default)
For HiLock realizations the material search folder is HiLock_Mats. HyperMesh searches for this
folder in the following locations and in the following order:

1. Installation: [hm_scripts_dir]/connectors/Hilock_Mats

2. User directory: [USER_HOME]/HiLock_Mats

3. HyperWorks Configuration Path folder: [HW_CONFIG_PATH]/Hilock_Mats

4. Current working folder: [CURRENTWORKINGDIR]/HiLock_Mats

In the Connector Entity Editor, the HiLock Material Folder field is populated with the name of the
folder that was found last. Only the files in this HiLock_Mats folder are considered and can be
selected in the HiLock Material File field.
By default, the first file listed (alphabetical order) in the folder is automatically populated in the
HiLock Material File field, and will be used when realizing a connector from the panel. For this
reason, it is important that you only keep valid material files in the HiLock_Mats folders.
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Figure 1089:

From connector metadata
Once a connector is realized with the HiLock Material Option “From Search Folder”, the folder and
file name is written as metadata to the connector. Folder data is saved in a relative manner to
allow the exact same rerealization in a different work environment as long as the materials are
saved in according folders.
If the materials are not available as the metadata states, the realization will fail and the following
message with be displayed: Material file/id not found.
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Figure 1090:

Calculation of Bearing Stiffness in Composite Parts
Combined translational bearing stiffness at composite plate with the fastener contact

These values are defined for every composite plate in the joint.
After summation of bearing stiffness of plies where n = number of plies in the composite plate:
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Combined translational bearing stiffness of the joint at ply i location in directions x and y

Transformed reduced stiffness in x and y-direction for ply i

Where,

(theta = angle of orientation for ply i)

Nonzero components of the reduced stiffness matrix for ply i

(1)
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Angle of ply i orientation in a CQUAD4 element

Figure 1091:
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Material orientation of a CQUAD4 defined by a coordinate system

Figure 1092:

Rotational bearing stiffness in plate-fastener contact

Figure 1093:

Calculation of Bearing Stiffness in Metallic Parts
Combined translational bearing stiffness at metallic plate with the fastener contact

After summation of bearing stiffness of plies where n = number of plies in the composite plate:
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Where,

t
Thickness of metallic part

E
Elastic compression modulus of metallic (isotropic) part

v
Poisson's ratio

Rotational bearing stiffness at metallic plate with the fastener contact

Where,

t
Thickness of metallic part

E
Elastic compression modulus of metallic (isotropic) part
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RBE3 Load Transfer
Use the RBE3 Load Transfer realization to create MPC’s using RBE3 elements between the nodes of
shell-shell, shell-solid or solid-solid groups by using spot connectors.

Restriction:  Available for OptiStruct, Nastran and Abaqus solver interfaces.

Solid-Solid

Figure 1094:

Shell-Shell (Face to Face)

Figure 1095:

Shell-Shell (Edge to Face)
For successful realization of these connectors, the non-normal projection option needs to be active.
Otherwise the projection onto an edge does not work.
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Figure 1096:

Shell-Shell (Edge to Edge
For successful realization of these connectors, the non-normal projection option needs to be active. 
Otherwise the projection onto an edge does not work.
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Figure 1097:

Shell-Beam
This situation is a very specific and requires some preparation to be successful, since the projection
onto 1D elements is not supported. In this situation, you need to enable the non-normal projection
checkbox for the projection onto the edge. In addition, the node of the 1D element needs to be defined
directly as a link. Normally this is done during connector creation by activating add node location as
link.

Note:  This option is only available for nodes as connector location, and only if the center
definition is set to use connector position for center.
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Figure 1098: Shell-Beam

Center definition options include:

use shortest projection for center
The closest node becomes the center of the RBE3 element.
During the realization, based on the connector position and the tolerance, the closest links are
determined up to the number of required layers (num layer). All other link candidates are not
taken into account for the next step. The closest node is also determined and becomes the center
of the RBE3 element. Based on this center position, all nodes within the given tolerance (distance
center to node) and belonging to the remained links are attached to the RBE3 element.

Note:  If the connector has been created with the option add location node as link, the
use shortest projection for center option is ignored and the linked node becomes the
center of the RBE3 element.
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Figure 1099: Use Shortest Projection For Center

use connector position for center
The exact position of the connector becomes the center of the RBE3 element.

Figure 1100: Use Connector Position For Center

use coarse mesh for center
During the realization, based on the connector position and tolerance, the closest links are
determined up to the number of required layers (num layer). All other link candidates are not
taken into account for the next step.
From the remaining links, the one with the coarsest mesh is identified and a node on this mesh
(close to the perpendicular connector projection) becomes the center of the RBE3 element.
Based on this center position, all nodes within the given tolerance (distance center to node) and
belonging to the remaining links are attached to the RBE3 element.
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Note:  If the connector has been created with the add location node as link option, the
use shortest projection for center option is ignored and the linked node becomes the
center of the RBE3 element.

Figure 1101: Use Coarse Mesh For Center

Seam Hexa Adhesives
The Seam Hexa Adhesives realization creates a continuous or discontinuous hexa weld with a
predefined pattern.

All defined information is stored on the connector, and can be exported into the connector .xml file.

Figure 1102: Seam Hexa Adhesives

Seam Hexas are created from the Seam panel.

The HEXA elements will be centered about the seam connector if the seam connector is not close to a
free edge. If the distance between the seam connector and free edge of a component is less than half
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the width of the HEXA, then the realization of HEXA elements will start from the seam connector and
will be extruded in the direction away from the edge.

Figure 1103:

For OptiStruct and Nastran solvers, the HEXA elements are tied to a shell using RBE3’s at locations
where the HEXA nodes and shell nodes are non-coincident. If the HEXA nodes and shell nodes are
coincident then RBE2's will be used to tie them.

For the LS-DYNA solver only, the shell gap thickness option is supported. If the HEXA nodes are
coincident with shell nodes, then those shell nodes will be used to create HEXA elements. The HEXA
elements at some or all nodes will be tied directly to the shells.

This realization type is intended to work on meshes, both shells and solids.

The hexa dimension depends on the following settings:

• The length of a hexa is predefined by the distribution of the test points along the seam connector.
This is defined by spacing or density during the connector creation.

• The width of the single hexa depends on the number of strips and the defined total width of the
seam, which is measured perpendicular to the seam direction.

• The thickness of a single hexa depends on the number of defined coats and the selected thickness
option.

The available thickness options interact with the consider shell thickness option and offset for hexa
positioning option. In the figures below, the green seams on the left take into account the thickness
as well as the shell offset. This information is used for dimensioning and positioning the hexas. For the
pink seams on the right side, the hexas are always positioned around the exact middle between the
current shell positions. The shell thicknesses are taken into account only for the hexa height, but not
for the positioning. The orange lines and arrows in the figures below illustrate the dependencies for the
positioning.

shell gap
The seam completely and exactly fills the gap between the two shells. Shell thicknesses and
offsets are not considered.
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Figure 1104: Shell Gap

maintain gap
The seam is positioned in the exact middle between the shells. The seam thickness is adjusted,
that on both sides the gap between shell and seam fits the defined gap size. Shell thicknesses and
offsets are not considered.

Figure 1105: Maintain Gap

(t1+t2)/2
The seam thickness is calculated by averaging both shell thicknesses. On the left side the offsets
and thicknesses are taken into account, so that the seam is positioned around the middle of the
air gap. On the right side the seam is just positioned around the middle of the shell positions.
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Figure 1106: (t1+t2)/2

midthickness
On the left side the exact air gap is determined and filled with the seam. On the right side
the seam thickness is calculated by subtracting half the thickness of both shells from the total
distance of the shells.

Figure 1107: Midthickness

const. thickness
The thickness of the seam is predefined for both; on the left side the seam is positioned around
the middle of the air gap, on the right side around the middle of the two shells.
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Figure 1108: Const. Thickness

Radioss ACM (Shell Gap Contact and Coating)
The Radioss acm (shell gap contact and coating) realization creates hexa clusters between shell
components. Contacts get defined between the shell components and the appropriate hexa nodes. A
heat affected zone for the shells from ultra high strength steel material is also created.

The Radioss acm (shell gap contact and coating) realization can be used for any amount of parallel
combinations of shell components.

Figure 1109: Heat Affected Zone Dimensions

Organization and Definition of ACM (Shell Gap Contact and Coating)
1. For each connected link the contact /inter/TYPE2/ gets created and is named

TYPE2_CONTACT_PID_<link ID>. The following sets are created and referenced.

• MASTERPART_SET_PID_<link ID>: In this set, which is referenced as the master by the
above mentioned contact, the link entities like the component get organized.

• SLAVENODE_SET_PID_<link ID>: In this set, which is referenced as the slave by the above
mentioned contact, the hexa nodes projecting onto the master entities get organized.
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2. For each link combination the hexa clusters are organized into separate components and named
RAD_SOLID_SPOTWELD_PID_<link1 ID>_<link2 ID>. All components are assigned the following
material and property:

• RAD_SOLID_SPOTWELD_DEFAULT_MAT. This material is defined as /MAT/LAW59/.

• RAD_SOLID_SPOTWELD_DEFAULT_PROP. This property is defined as /PROP/CONNECT/.

The default values are read from uhss_washersolid_matprop.rad in the installation.

3. The heat affected zone elements (washer) are organized into one separate component for each
link from the ultra high strength steel material and named RAD_WASHER_PID_<link ID>. All
components are assigned the following material and property:

• RAD_WASHER_MAT. This material is defined as /MAT/PLAS_JOHNS/.

• RAD_WASHER_PROP. This property is defined as /PROP/SHELL/.

The material and property values are read from uhss_washersolid_matprop.rad in the
installation.

Defining Materials for Heat Affected Zone Treatment
You must specify which materials are considered as ultra high strength materials. When defining an
acm (shell gap contact and coating) connector, the UHSS Material Option can be selected for individual
connectors using the Connector Entity Editor.

From current model
Select an existing material from the current model.

Proprietary Information of Altair Engineering
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Figure 1110: From Current Model

From search file (default)
For acm (shell gap contact and coating) realizations the material search file name is
materialsnippets.txt. HyperMesh searches for this file in the following locations and in the
following order:

1. Installation: [hm_scripts_dir]/connectors/materialsnippets.txt

2. User directory: [USER_HOME]/materialsnippets.txt

3. HyperWorks Configuration Path folder: [HW_CONFIG_PATH]/materialsnippets.txt

4. Current working folder: [CURRENTWORKINGDIR]/materialsnippets.txtv

Proprietary Information of Altair Engineering
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Figure 1111: From Search File

In the Connector Entity Editor, the UHSS Material File field is populated with the name of the file
that was found last.
The text file contains snippets from the materialnames, which need to recieve heat affected zones
during the realization.

From connector metadata
Once a connector is realized with the UHSS Material Option “From search file”, the folder name is
written as metadata to the connector in a relative manner to allow the exact same rerealization
in a different work environment as long as the same materialsnippets.txt files are saved in
according folders.

Proprietary Information of Altair Engineering
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Figure 1112: From Connector Metadata

Seam-Quad LTB
The seam-quad LTB realization serves and realizes t-welds, lap-welds, and butt-welds simultaneously.

This weld type is identified automatically based on the orientation of the links to each other.

The dimensions and properties assigned to all heat affected zones (HAZ) can be defined separately.
Normal directions of quad weld elements and HAZ elements can be controlled. An edge treatment can
be defined for t-welds and butt-welds to move the edge a precise distance from the opposite link.

Restriction:  Available in the OptiStruct and Nastran solver interfaces, and can only be
selected and defined in the Connector Entity Editor.

Proprietary Information of Altair Engineering
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Figure 1113: Seam-Quad LTB

General Info
Weld Type

Defines weather to setup a configuration exclusively for a T, L, or B connection, or automatically
setup a configuration for each connection based on the angle.
In any case, the connection type is dependent on the:

• B/L classification angle

• L/T classification angle

Both types of angles are defined in the Behavior section.

Figure 1114: T Connection Figure 1115: L Connection

Proprietary Information of Altair Engineering
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Figure 1116: B Connection

Tolerance
Defines the distance from the connector location.
Only entities within this tolerance can be taken into account for the final realization. The tolerance
is used to verify whether adequate link candidates are available to be connected with respect to
the number of layers.

Weld Shape
T Weld Shape

Defines how the T weld is created.

Figure 1117: Vertical T weld Figure 1118: Angled T weld

Proprietary Information of Altair Engineering
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Figure 1119: Vertical and angled T weld

L Weld Shape
Defines how the L weld is created.

Figure 1120: Vertical L weld Figure 1121: Angled L weld

Proprietary Information of Altair Engineering
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Figure 1122: Vertical and angled L weld

B Weld Shape
B welds are always created in a straight manner.

Figure 1123: Straight B weld

With Caps
When enabled, seams are closed with a tria element.
The Caps settings determines how the caps are created.

Proprietary Information of Altair Engineering
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Figure 1124: Tria cap element for T weld Figure 1125: Tria cap element for L weld

Realization Details
The Realization Details settings position the yellow marked nodes in the Figure 1126, Figure 1127, and
Figure 1128.

Figure 1126: T Dimensions Figure 1127: L Dimensions

Proprietary Information of Altair Engineering
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Figure 1128: B Dimensions

The dimension of the welds are dependent on the Weld Shape settings.

Dimensioning Scheme
Defines the dimensioning scheme for the dimensions of the T weld, L weld, and B weld
connections.

input
Manually define discrete values for the weld dimensions, shown in black in Figure 1126,
Figure 1127, and Figure 1128, with the exception of thickness. The horizontal dimensions
can be defined using a length or an angle.

thickness dependent
Choose a formula to define the weld dimensions, shown in black in Figure 1126,
Figure 1127, and Figure 1128, with the exception of thickness. The provided formulas are
all dependent on the thicknesses t1 and t2. A formula can be chosen individually for each
verticalV and horizontalH distance, or the same formula can be used for T, L and B.

weldsize dependent
Manually define discrete values for the weld dimensions, shown in red in the Figure 1126,
Figure 1127, and Figure 1128. The verticalV and horizontalH distances are defined with
formulas reflecting the weld sizes and the t1 and t2 thicknesses.

DIM T (Dimensioning T)

Input Thickness
dependent

Weldsize dependent

Horizontal Lengths LTH by angle

by length

(t1+t2)/2

3*(t1+t2)/2

t1+t2

t1/2+wh/2 (fix)
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Input Thickness
dependent

Weldsize dependent

Vertical Length LTV by length

by edge

(t1+t2)/2

3*(t1+t2)/2

t1+t2

by edge

t2/2+wv/2

by edge

DIM L (Dimensioning L)

Input Thickness
dependent

Weldsize dependent

Horizontal Lengths LTH by length

by angle

(t1+t2)/2

3*(t1+t2)/2

t1+t2

wh/2 (fix)

DIM B (Dimensioning B)

Input Thickness
dependent

Weldsize dependent

Lengths LB by length

by angle

(t1+t2)/2

3*(t1+t2)/2

t1+t2

by edge

wb

by edges

Edge Treatment (T/B)
When discrete lengths are requested for T and B connections, it is sometimes necessary to move
the edges.
Edge treatment is not needed when the different length dimension settings are set to by edge.
When enabled, edges are allowed to move. See Edge Treatment Options for more information.

Max Length Value
Defines the maximum length value.
This setting is useful when lengths are calculated based on thicknesses. If a length is greater than
the Max Length Value, then the Max Length Value will be used instead.

Caps
Determines how caps are created.
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Figure 1129: Cap Angle and Runoff Angle

Figure 1130: Sharp Corner Enabled Figure 1131: Sharp Corner Disabled

Element Details
The Element Details settings control the normal directions of the weld, as well as the HAZ elements.

Vertical Element Normal, Angled Element Normal, and HAZ Element Normal can be set to either:

Towards welder
Shows the normal directions

Proprietary Information of Altair Engineering

Away from welder
Shows the exact opposite.
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Figure 1132: Towards welder Figure 1133: Away from welder

Connectivity Info
imprint (default)

Creates quad weld elements, and stitches them to both links by adjusting their mesh. All required
HAZ are performed.

skip imprint
Creates quad weld elements, but does not change the meshes of the links. Instead, additional
elements are created to represent the requested HAZ. These elements are organized in the
^conn_imprint component, and can later be used for a manual imprint after they have been
manipulated to the users needs. This option can be helpful when working with more complex
areas, where the standard imprint functionality fails, for example, conflicting connectors.

imprint/no HAZ
Creates quad weld elements, and stitches them to both links by adjusting their mesh. Mesh
modifications are as minimal as possible, and no HAZ are performed.

Proprietary Information of Altair Engineering

none
Creates quad weld elements only. Quad weld elements will not be attached to the links. The
connection will need further attention.

HAZ Info
The HAZ Info settings define the lengths of the different heat affected zones (HAZ), which are
dependent on the HAZ lengths for T, L and B (defined in Realization Details). The HAZ length settings
vary depending on the defined weld shapes (vertical, angled, vertical and angled, caps).

HAZ Scheme
Choose a dimensioning scheme for the HAZ lengths of T, L, and B.

input
Enables you to decide if the HAZ lengths should be defined individually, or if all HAZ lengths
are determined using the same approach (same as all).
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weldsize dependent
Only available if weldsize dependent has been chosen for the Dimensioning Scheme as well.

HAZ Lengths

same as all
Assigns the same length to all HAZ lengths.

individual
Assign HAZ lengths individually.

HAZ Lengths (various)
The following options are available in the various HAZ length settings.

input
Requires a discrete value be specified for the length.

average meshsize
Length is dependent on the average mesh size in the local area where the imprint is
performed.

by thickness
Sets the length to the same value as the thickness of the link getting the HAZ.

LTH
Horizontal length for T connections, which is the length between the foot points of the
vertical and angled part of a seam.

LLH
Horizontal length for L connections, which is the length between the foot points of the
vertical and angled part of a seam.

LB
Butt weld length.

skip HAZ
Skips individual HAZ that are not required.

Proprietary Information of Altair Engineering

same as positive side
Assigns the same length as the positive side to the negative side.

wh or wh/2
Length is dependent on the horizontal weld size. Only available when HAZ Scheme is set to
weldsize dependent.

wv or wv/2
Length is dependent on the vertical weld size. Only available when HAZ Scheme is set to
weldsize dependent.

wb or wb/2
Length is dependent on the butt weld size. Only available when HAZ Scheme is set to
weldsize dependent.
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LTVedge

Choose between skip HAZ and LTVedge. Only available for the HAZTvedge length.

HAZ Length Factor (Avg. Meshsize/Thickness)
Factor that increases or decreases the HAZ lengths, which have been defined using the average
meshsize or by thickness length options.

Max HAZ Length
Maximum length for all HAZ lengths. If the HAZ length is greater than this value, then the Max
HAZ Length is used.

Dimensioning and Heat Affected Zones (HAZ):

Dimensioning T

Figure 1134: Dimensioning T

Proprietary Information of Altair Engineering

Figure 1135: Vertical T Weld HAZ
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Figure 1136: Angled T Weld HAZ

Figure 1137: Vertical and Angled T Weld HAZ

Dimensioning L

Figure 1138: Dimensioning L

Proprietary Information of Altair Engineering
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Figure 1139: Vertical L Weld HAZ

Figure 1140: Angled L Weld HAZ

Figure 1141: Vertical and Angled L
Weld HAZ

Dimensioning B

Figure 1142: Dimensioning B

Proprietary Information of Altair Engineering
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inherit property
Inherits the elements of the HAZ from the links in which the HAZ elements are imprinted.

general property
Assigns the same HAZ property throughout one link, or throughout all links.
Use the subsequent options to define how the properties are determined.

individual property
Assigns individual properties to each HAZ.

HAZ Component Option

stay in original
Keeps HAZ elements in the component they were imprinted into. No additional properties
get created.

new component per original one
Creates a new component for each component that gets a HAZ imprinted. The direct
property assignment setting is ignored when this option is selected.

HAZ Property Option
The options available are dependent on the HAZ Organize Scheme selected.

assign original property
Assigns the same property that was assigned to the original components to new
components.

assign duplicated property
Duplicates the original properties and assigns them to new components.

select
Select a property from the current model via the Select Property For HAZ option. Unless
direct property assignment is activated, a component named ltb_seam_quad_haz_ with the
property ID as a postfix is created.

same as original
Assigns HAZ elements the same property as the original. No further properties are created.
HAZ elements are organized into components named ltb_seam_quad_haz_ with the
property ID as postfix.

Proprietary Information of Altair Engineering

Figure 1143: Straight B Weld HAZ

Property and Material Info
The Property and Material Info parameters define the properties and materials of the welds and the
heat affected zones (HAZ).

HAZ Organize Scheme
Choose a HAZ organize scheme:
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group same thickness
Groups HAZ elements with the same thickness into one property and
component. HAZ elements of T, L, and B welds are also grouped together if they
have the same thickness.
Properties are named ltb_seam_quad_haz_<scaled thickness> or
ltb_seam_quad_haz_<property ID>, and components use the same name as
properties.

group same thickness within T, L, and B
Groups all HAZ elements with the same thickness into one property and
component, as long as they have the same weld type of T, L, B.
Properties are named ltb_seam_quad_<t or l or b>_<thickness>, and
components use the same name as properties.

input thickness
Creates a new property and component for each link that has a HAZ imprinted.
The property is a copy of the original. Properties are named
ltb_seam_quad_haz_<linkname>_<scaled thickness>, and components are named the
same as the properties.
In addition, you can define the following:

HAZ thickness
Enables a factor for thickness to be entered.

HAZ Property Grouping
Groups properties in order to reduce the amount of properties created.

do not group
Prevents grouping.

group same thickness
Groups all HAZ elements with the same thickness into one property and
component. HAZ elements of T, L, and B welds are also grouped together if they
have the same thickness.
Properties are named as ltb_seam_quad_haz_<scaled thickness> or
ltb_seam_quad_haz_<property ID>, and components use the same name as
properties.

Proprietary Information of Altair Engineering

scaled original thickness
Creates a new property and component for each link that has a HAZ imprinted.
The property is a copy of the original. Properties are named as
ltb_seam_quad_haz_<linkname>_<scaled thickness>, and components are named the
same as the properties.
In addition, you can define the following:

HAZ thickness factor
Enables entering a factor to scale the thickness.

HAZ Property Grouping
Groups properties in order to reduce the amount of properties created.

Do not group
Prevents grouping.
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Weld Property
Define how the thicknesses for the different parts of the weld are determined. Appropriate PSHELL
properties are created.

Property Option For Vertical Quads

select
Select a property from the current model via the Select Property For Vertical Quad
field. Unless direct property assignment is activated, a component with the the name
ltb_seam_quad_weld_ and the property ID as postfix is created.

Lh/sqrt(2)
Determines the thicknesses of welds.

0.5*Lh/sqrt(2)
Options are dependent on the weld type (T, L, B) and the selected weld shapes (vertical,
angled, vertical and angled).

(Lh/sqrt(2)+Lv/sqrt(2))/4
Properties are named ltb_seam_quad_weld_<weldshape>_<link1>_<link2>_<thickness>,
and components are named the same as the properties and host the weld elements.
Lh is the superset of LLH and LTH (see dimensions above). Lv is the superset of LLV and LTV
(see dimensions above).

same as edge
Inherits the property of the link with the free edge for the vertical weld. Unless direct
property assignment is activated, a component with the name ltb_seam_quad_weld_ with
the property ID as postfix is created.

input thickness
Creates properties with the required thicknesses for each link combination and weld shape
(vertical, angled, straight).
The properties are named
ltb_seam_quad_weld_<weldshape>_<link1>_<link2>_<thickness>, and the corresponding
components are named the same as the properties and host the weld elements.

Proprietary Information of Altair Engineering

group same thickness
Within T, L, and B groups all HAZ elements with the same thickness into one
property and component as long as they have the same weld type of T, L, B.
Properties are named as ltb_seam_quad_<t or l or b>_<thickness>, and
components use the same name as properties.

same as positive side
Guarantees the HAZ on the positive and negative side of the T or L weld are assigned the
same property.

same as the other size
Guarantees the HAZ on both sides of the B weld are assigned the same property.
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(t1+t2)/2
Lh is the superset of LLH and LTH (see dimensions above). Lv is the superset of LLV and LTV
(see dimensions above).

input thickness
Creates properties with the required thicknesses for each link combination and weld shape
(vertical, angled, straight).
The properties are named
ltb_seam_quad_weld_<weldshape>_<link1>_<link2>_<thickness>, and the corresponding
components are named the same as the properties and host the weld elements.

Property Option for Capped Quads

select
Select a property from the current model via the Select Property For Vertical Quad
field. Unless direct property assignment is activated, a component with the the name
ltb_seam_quad_weld_ and the property ID as postfix is created.

Lh/sqrt(2)
Determines the thicknesses of welds.

0.5*Lh/sqrt(2)
Options are dependent on the weld type (T, L, B) and the selected weld shapes (vertical,
angled, vertical and angled).
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(t1+t2)/2
Properties are named ltb_seam_quad_weld_<weldshape>_<link1>_<link2>_<thickness>,
and components are named the same as the properties and host the weld elements.
Lh is the superset of LLH and LTH (see dimensions above). Lv is the superset of LLV and LTV
(see dimensions above).

Property Option for Angled Quads

select
Select a property from the current model via the Select Property For Vertical Quad
field. Unless direct property assignment is activated, a component with the the name
ltb_seam_quad_weld_ and the property ID as postfix is created.

Lh/sqrt(2)
Determines the thicknesses of welds.

0.5*Lh/sqrt(2)
Options are dependent on the weld type (T, L, B) and the selected weld shapes (vertical,
angled, vertical and angled).

(Lh/sqrt(2)+Lv/sqrt(2))/4
Properties are named ltb_seam_quad_weld_<weldshape>_<link1>_<link2>_<thickness>,
and components are named the same as the properties and host the weld elements.
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The properties are named
ltb_seam_quad_weld_<weldshape>_<link1>_<link2>_<thickness>, and the corresponding
components are named the same as the properties and host the weld elements.

Weld Property Grouping
Reduce the number of properties created by grouping them, except when using the select and
same as edge options.

do not group
No grouping will take place. Properties are created as described in previous options.

group same thickness
Groups all weld elements with the same thickness into one property and one associated
component. Vertical, angled, and straight weld elements that have the same thickness are
also grouped together.
Properties are named ltb_seam_quad_weld_<thickness>, and their associated components
are named the same as the property.

group same thickness within vertical, angled + capped and straight quads
Groups all weld elements with the same thickness and weld shape (vertical, angled +
capped, straight) into one property and one associated component.
Properties are named ltb_seam_quad_<vertical or angled_capped or
straight>_<thickness>, and their associated components are named the same as the
property.

Direct Property Assignment
Stops additional components from being created, and directly assigns created or selected
properties to individual weld or HAZ elements.

Proprietary Information of Altair Engineering

input thickness
Creates properties with the required thicknesses for each link combination and weld shape
(vertical, angled, straight).
The properties are named
ltb_seam_quad_weld_<weldshape>_<link1>_<link2>_<thickness>, and the corresponding
components are named the same as the properties and host the weld elements.

Property Option for Straight Quads

(t1+t2)/2
Determines the thicknesses of welds.
Options are dependent on the weld type (T, L, B) and the selected weld shapes (vertical,
angled, vertical and angled).
Properties are named ltb_seam_quad_weld_<weldshape>_<link1>_<link2>_<thickness>,
and components are named the same as the properties and host the weld elements.
Lh is the superset of LLH and LTH (see dimensions above). Lv is the superset of LLV and LTV
(see dimensions above).

input thickness
Creates properties with the required thicknesses for each link combination and weld shape
(vertical, angled, straight).
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positive side/negative side
The positive and negative side can be determined as long as the links are not perfectly
perpendicular to each other.

Figure 1144:
Overview of how the positive and negative side is determined. When links are perfectly perpendicular, the edge

quad normal option is automatically used.

edge quad normal

Figure 1145:
Overview of how the side for the angled weld is determined. If the normal directions are reversed, the side of the

angled weld changes.
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L/T classification angle
Angle that is automatically determined for each individual seam connector, whether it is to be
considered a lap weld or a t-weld. Default is set to 10.0°.

Angle Direction
Defines which side the angled weld elements are created.

connector side
Angled weld elements are created on the side where the connector is located, as long as the
connector is not perfectly on the free edge.
If the connector is on the free edge, the edge quad normal option will be automatically
used.

Behavior
B/L classification angle

Angle that is automatically determined for each individual seam connector, whether it is to be
considered a butt weld or a lap weld. Default is set to 10.0°.
If the angle of the two links is smaller than the B/L classification angle, then it will be considered
a butt weld and a lap weld; a further check determines whether the links overlap. If the links do
not overlap, a butt-weld is performed.
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Figure 1146: Original Model before Realization Initial situation with one 

element row marked for the lap weld and two element rows for the t weld.

Figure 1147: Edge Snapping Enabled

Figure 1148: Edge Snapping Disabled
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Snapping to Edge

Automatic edge snapping can be used to precisely position connectors. First, the connector snaps 
to, for example, the closest free edge, then the projection and FE creation starts.
The snapping distance can be defined separately for T, L and B connections.
You can choose whether to snap to:

• maximum 1 element row

• maximum 2 element rows

• no (connector does not snap)
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Figure 1149: Original Model before Realization

Figure 1150: Realization using Edge Treatment
Free edges were contracted or extended.

Edge Treatment Options
Choose whether to:

• extension and contraction

• extension

• contraction

Edge Treatment Limit
Edge treatment is a pure node movement; therefore, the maximum movement needs to be
limited to prevent the elements at the edge from being destroyed. Movement is limited to a
maximum of 0.5 times the element size at the edge. 0.5 is the maximum allowed value and
default value.

Preserve Washer
Controls how washers are preserved during the seam imprint realization.

Proprietary Information of Altair Engineering

Edge Treatment (T/B)
Attempts to create specific vertical lengths for T connections LTV, and specific lengths for B
connections LB.
Only enabled when the Edge Treatment setting is enabled from the Realization Details settings.
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Figure 1151: Original Mode with Perfectly Meshed
Washers

Figure 1152: No Washer Preservation Enabled
Washers have been opened.

Figure 1153: Washer Preservation and Remesh
Enabled
Washers are still intact, but the mesh seeding has been

modified.

Figure 1154: Washer Preservation and No Remesh
Enabled
The washers have been fully preserved.
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Don't Share Zone Elements
Seam imprint allows heat affected zones (HAZ) to be merged in close areas. In this situation,
one element might touch the weld elements from two different connectors. Do not share zone
elements prevents zone elements from being shared.

Quad In Corner
Controls whether a single or double element is created in corners of quad seam connectors with a
certain vertex.
A angle must be defined for a single quad corner. If the corner angle is greater than the defined
angle, a double quad corner is created.
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Figure 1155: Quad in Corner
A double quad corner is shown on the right, and a single quad corner is shown on the left.

Quad Control
Controls the maximum deviation from the perfect quad element for the heat affected zone (HAZ).
It can be controlled, if the element size or the element skew is more important to retain.

Proprietary Information of Altair Engineering

Max Quadsize Reduction In % / Max Quad Skew In Degrees

Figure 1156: Max Quad Size Reduction: 80.0 / Max
Quad Skew: 5.0

Figure 1157: Max Quad Size Reduction: 5.0 / Max
Quad Skew: 45.0
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Silver Elements
Sliver elements are small elements that you may not want in your model. In the images below,
a perfect perpendicular projection resulted in sliver elements. The Sliver Elements setting can be
used to manage sliver elements in your model. In the images below, the red elements represent
the HAZ elements.

Figure 1158: Allow Figure 1159: Prevent by Moving Projection Points
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Figure 1160: Prevent by Moving Edge Figure 1161: Delete Sliver Elements

Element length<
This length controls which elements to treat as sliver elements.

Feature Angle
Determines important features to retain during the imprint. Features that cross the HAZ, as well
as near by features cannot be retained.
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Seam-Rigid LTB
The Seam-Rigid LTB realization serves and realizes t-welds, lap-welds and butt-welds at the same time.

The weld type is identified automatically based on the orientation of the links to each other.

The dimensions and property for all heat affected zones (HAZ) can be defined separately. An edge
treatment can be defined for t-welds and butt-welds to move the edge a precise distance from the
opposite link.

Restriction:  Available in the OptiStruct and Nastran solver interfaces, and can only be
selected and defined in the Connector Entity Editor.
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Figure 1162: Seam-Rigid LTB

General Info
Weld Type

Defines weather to setup a configuration exclusively for a T, L, or B connection, or automatically
setup a configuration for each connection based on the angle.
In any case, the connection type is dependent on the:

• B/L classification angle

• L/T classification angle

Both types of angles are defined in the Behavior section.
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Figure 1163: T Connection

Figure 1164: L Connection

Figure 1165: B Connection
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Tolerance
Defines the distance from the connector location.

Proprietary Information of Altair Engineering

Only entities within this tolerance can be taken into account for the final realization. The tolerance
is used to verify whether adequate link candidates are available to be connected with respect to
the number of layers.

Weld Shape
T Weld Shape

Defines how the T weld is created.
The image below shows where the master and slave nodes of the rigid elements will be placed.

Figure 1166: Vertical T Weld

Figure 1167: Angled T Weld, Connected to Edge
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Figure 1168: Vertical and Horizontal T Weld

Figure 1169: Angled T Weld, Connected at a Defined
Vertical Height LTV
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L Weld Shape
Defines how the L weld is created.
The image below shows where the master and slave nodes of the rigid elements will be placed.

Figure 1170: Vertical L Weld

Figure 1171: Angled L Weld

Proprietary Information of Altair Engineering
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Figure 1172: Vertical and Angled L Weld

B Weld Shape
B welds are always created in a straight manner.
The image below shows where the master and slave nodes of the rigid elements will be placed.
The nodes can also be placed the opposite direction, but their position will always be consistent
throughout each seam.

Proprietary Information of Altair Engineering

Figure 1173: Straight B Weld
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Realization Details
The Realization Details settings position the yellow marked nodes in Figure 1174, Figure 1175, and
Figure 1176.

Proprietary Information of Altair Engineering

Figure 1174: T Dimensions

Figure 1175: L Dimensions



Altair HyperMesh 2019 Users Guide
Connectors p.2217

Figure 1176: B Dimensions

The dimension of the welds are dependent on the Weld Shape settings.

Dimensioning Scheme
Defines the dimensioning scheme for the dimensions of the T weld, L weld, and B weld
connections.

Proprietary Information of Altair Engineering

input
Manually define discrete values for the weld dimensions, shown in black in Figure 1174,
Figure 1175, and Figure 1176, with the exception of thickness. The horizontal dimensions
can be defined using a length or an angle.

thickness dependent
Choose a formula to define the weld dimensions, shown in black in Figure 1174,
Figure 1175, and Figure 1176, with the exception of thickness. The provided formulas are
all dependent on the thicknesses t1 and t2. A formula can be chosen individually for each
verticalV and horizontalH distance, or the same formula can be used for T, L and B.

weldsize dependent
Manually define discrete values for the weld dimensions, shown in red in Figure 1174,
Figure 1175, and Figure 1176. The verticalV and horizontalH distances are defined with
formulas reflecting the weld sizes and the t1 and t2 thicknesses.
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DIM T (Dimensioning T)

Input Thickness
dependent

Weldsize dependent

Horizontal Lengths LTH by angle

by length

(t1+t2)/2

3*(t1+t2)/2

t1+t2

t1/2+wh/2 (fix)

Vertical Length LTV by length

by edge

(t1+t2)/2

3*(t1+t2)/2

t1+t2

by edge

t2/2+wv/2

by edge

DIM L (Dimensioning L)

Input Thickness
dependent

Weldsize dependent

Horizontal Lengths LTH by length

by angle

(t1+t2)/2

3*(t1+t2)/2

t1+t2

wh/2 (fix)

Proprietary Information of Altair Engineering

DIM B (Dimensioning B)

Input Thickness
dependent

Weldsize dependent

Lengths LB by length

by angle

(t1+t2)/2

3*(t1+t2)/2

t1+t2

by edge

wb

by edges
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Edge Treatment (T/B)
When discrete lengths are requested for T and B connections, it is sometimes necessary to move
the edges.
Edge treatment is not needed when the different length dimension settings are set to by edge.
When enabled, edges are allowed to move. See Edge Treatment Options for more information.

Max Length Value
Defines the maximum length value.
This setting is useful when lengths are calculated based on thicknesses. If a length is greater than
the Max Length Value, then the Max Length Value will be used instead.

Element Details
The DOF parameter controls the setting for the Degrees of Freedom for the RBE2 elements, which are
created during the realization.

Connectivity Info
imprint (default)

Creates quad weld elements, and stitches them to both links by adjusting their mesh. All required
HAZ are performed.

skip imprint
Creates quad weld elements, but does not change the meshes of the links. Instead, additional
elements are created to represent the requested HAZ. These elements are organized in the
^conn_imprint component, and can later be used for a manual imprint after they have been
manipulated to your needs. This option can be helpful when working with more complex areas,
where the standard imprint functionality fails, for example, conflicting connectors.

imprint/no HAZ
Creates quad weld elements, and stitches them to both links by adjusting their mesh. Mesh
modifications are as minimal as possible, and no HAZ are performed.

Proprietary Information of Altair Engineering

none
Creates quad weld elements only. Quad weld elements will not be attached to the links. The
connection will need further attention.

HAZ Info
The HAZ Info settings define the lengths of the different heat affected zones (HAZ), which are
dependent on the HAZ lengths for T, L and B, defined in the Realization Details parameters. The HAZ
length settings vary depending on the defined weld shapes (vertical, angled, vertical and angled, caps).

HAZ Scheme
Choose a dimensioning scheme for the HAZ lengths of T, L, and B.

input
Enables you to decide if the HAZ lengths should be defined individually, or if all HAZ lengths
are determined using the same approach (same as all).
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weldsize dependent
Only available if weldsize dependent has been chosen for the Dimensioning Scheme, as
well.

HAZ Lengths

same as all
Assigns the same length to all HAZ lengths.

individual
Assign HAZ lengths individually.

Assign HAZ lengths individually
The following options are available in the various HAZ length settings.

input
Requires a discrete value be specified for the length.

average meshsize
Length is dependent on the average mesh size in the local area where the imprint is
performed.

by thickness
Sets the length to the same value as the thickness of the link getting the HAZ.

LTH
Horizontal length for T connections, which is the length between the foot points of the
vertical and angled part of a seam.

LLH
Horizontal length for L connections, which is the length between the foot points of the
vertical and angled part of a seam.

LB
Butt weld length.

skip HAZ
Skips individual HAZ that are not required.

Proprietary Information of Altair Engineering

same as positive side
Assigns the same length as the positive side to the negative side.

wh or wh/2
Length is dependent on the horizontal weld size. Only available when HAZ Scheme is set to
weldsize dependent.

wv or wv/2
Length is dependent on the vertical weld size. Only available when HAZ Scheme is set to
weldsize dependent.
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wb or wb/2
Length is dependent on the butt weld size. Only available when HAZ Scheme is set to
weldsize dependent.

LTVedge

Choose between skip HAZ and LTVedge. Only available for the HAZTvedge length.

HAZ Length Factor (Avg. Meshsize/Thickness)
Factor that increases or decreases the HAZ lengths, which have been defined using the average
meshsize or by thickness length options.

Max HAZ Length
Maximum length for all HAZ lengths. If the HAZ length is greater than this value, then the Max
HAZ Length is used.

Dimensioning and Heat Affected Zones (HAZ):

Dimensioning T

Figure 1177: Dimensioning T

Proprietary Information of Altair Engineering

Figure 1178: Vertical T Weld HAZ
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Figure 1179: Angled T Weld HAZ

Figure 1180: Vertical and Angled 
T Weld HAZ

Dimensioning L

Figure 1181: Dimensioning L

Proprietary Information of Altair Engineering
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Figure 1182: Vertical L Weld HAZ

Figure 1183: Angled L Weld HAZ

Figure 1184: Vertical and Angled L
Weld HAZ

Dimensioning B

Figure 1185: Dimensioning B

Figure 1186: Straight B Weld HAZ

Proprietary Information of Altair Engineering
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inherit property
Inherits the elements of the HAZ from the links in which the HAZ elements are imprinted.

general property
Assigns the same HAZ property throughout one link, or throughout all links.
Use the subsequent options to define how the properties are determined.

individual property
Assigns individual properties to each HAZ.

HAZ Component Option

stay in original
Keeps HAZ elements in the component they were imprinted into. No additional properties
get created.

new component per original one
Creates a new component for each component that gets a HAZ imprinted. The direct
property assignment setting is ignored when this option is selected.

HAZ Property Option
The options available are dependent on the HAZ Organize Scheme selected.

assign original property
Assigns the same property that was assigned to the original components to new
components.

assign duplicated property
Duplicates the original properties and assigns them to new components.

select
Select a property from the current model via the Select Property For HAZ option. Unless
direct property assignment is activated, a component named ltb_rigid_quad_haz_ with the
property ID as a postfix is created.

same as original
Assigns HAZ elements the same property as the original. No further properties are created.
HAZ elements are organized into components named ltb_rigid_quad_haz_ with the property
ID as postfix.

scaled original thickness
Creates a new property and component for each link that has a HAZ imprinted.
The property is a copy of the original. Properties are named as
ltb_rigid_quad_haz_<linkname>_<scaled thickness>, and components are named the 
same as the properties.

Proprietary Information of Altair Engineering

Property and Material Info
The Property and Material Info settings define the properties and materials of the welds and the heat
affected zones (HAZ).

HAZ Organize Scheme
Choose a HAZ organize scheme:



Altair HyperMesh 2019 Users Guide
Connectors p.2225

group same thickness
Groups HAZ elements with the same thickness into one property and
component. HAZ elements of T, L, and B welds are also grouped together if they
have the same thickness.
Properties are named ltb_rigid_quad_haz_<scaled thickness> or
ltb_rigid_quad_haz_<property ID>, and components use the same name as
properties.

group same thickness within T, L, and B
Groups all HAZ elements with the same thickness into one property and
component, as long as they have the same weld type of T, L, B.
Properties are named ltb_rigid_quad_<t or l or b>_<thickness>, and
components use the same name as properties.

input thickness
Creates a new property and component for each link that has a HAZ imprinted.
The property is a copy of the original. Properties are named
ltb_rigid_quad_haz_<linkname>_<scaled thickness>, and components are named the
same as the properties.
In addition, you can define the following:

HAZ thickness
Enables you to enter a factor for thickness.

HAZ Property Grouping
Groups properties in order to reduce the amount of properties created.

do not group
Prevents grouping.

group same thickness
groups all HAZ elements with the same thickness into one property and
component. HAZ elements of T, L, and B welds are also grouped together if they
have the same thickness.
Properties are named as ltb_rigid_quad_haz_<scaled thickness> or
ltb_rigid_quad_haz_<property ID>, and components use the same name as
properties.

group same thickness
Within T, L, and B groups all HAZ elements with the same thickness into one
property and component as long as they have the same weld type of T, L, B.
Properties are named as ltb_rigid_quad_<t or l or b>_<thickness>, and
components use the same name as properties.

Proprietary Information of Altair Engineering

In addition, you can define the following:

HAZ thickness factor
Enables you to enter a factor to scale the thickness.

HAZ Property Grouping

Groups properties in order to reduce the amount of properties created.

do not group
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Direct Property Assignment
When activated, additional components will not be created, and created or selected properties will
be directly assigned to individual weld or HAZ elements.
Used for HAZ and weld property assignment.

Behavior
B/L classification angle

Angle that is automatically determined for each individual seam connector, whether it is to be
considered a butt weld or a lap weld. Default is set to 10.0°.
If the angle of the two links is smaller than the B/L classification angle, then it will be considered
a butt weld and a lap weld; a further check determines whether the links overlap. If the links do
not overlap, a butt-weld is performed.

L/T classification angle
Angle that is automatically determined for each individual seam connector, whether it is to be
considered a lap weld or a t-weld. Default is set to 10.0°.

Angle Direction
Defines which side the angled weld elements are created.

connector side
Angled weld elements are created on the side where the connector is located, as long as the
connector is not perfectly on the free edge.
If the connector is on the free edge, the edge quad normal option will be automatically
used.

positive side/negative side
The positive and negative side can be determined as long as the links are not perfectly
perpendicular to each other.

Figure 1187:
Overview of how the positive and negative side is determined. When links are perfectly perpendicular, the edge

quad normal option is automatically used.

Proprietary Information of Altair Engineering

same as positive side
Guarantees the HAZ on the positive and negative side of the T or L weld are assigned the
same property.

same as the other size
Guarantees the HAZ on both sides of the B weld are assigned the same property.
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Snapping To Edge
Automatic edge snapping can be used to precisely position connectors. First, the connector snaps
to, for example, the closest free edge, then the projection and FE creation starts.
The snapping distance can be defined separately for T, L and B connections.
You can choose whether to snap to:

maximum 1 element row

maximum 2 element rows

no (connector does not snap)

Figure 1189: Original Model before Realization Initial situation with one element 

row marked for the lap weld and two element rows for the t weld.

Figure 1190: Edge Snapping Enabled
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edge quad normal

Figure 1188:
Overview of how the side for the angled weld is determined. If the normal directions are reversed, the side of the

angled weld changes.
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Figure 1191: Edge Snapping Disabled

Edge Treatment (T/B)
The Edge Treatment(T/B) setting attempts to create specific vertical lengths for T connections LTV, 
and specific lengths for B connections LB.

Figure 1192: Original Model before Realization Figure 1193: Realization using Edge Treatment
Free edges were contracted or extended.

Edge Treatment Options
Choose whether to:

extension and contraction

Proprietary Information of Altair Engineering

extension

contraction

Edge Treatment Limit
Edge treatment is a pure node movement; therefore, the maximum movement needs to be
limited to prevent the elements at the edge from being destroyed. Movement is limited to a
maximum of 0.5 times the element size at the edge. 0.5 is the maximum allowed value and
default value.
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Preserve Washer
Controls how washers are preserved during the seam imprint realization.

Figure 1194: Original Mode with Perfectly Meshed
Washers

Figure 1195: No Washer Preservation Enabled
Washers have been opened.
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Figure 1196: Washer Preservation and Remesh
Enabled
Washers are still intact, but the mesh seeding has been

modified.

Figure 1197: Washer Preservation and No Remesh 
Enabled
The washers have been fully preserved.
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Don't Share Zone Elements
Seam imprint allows heat affected zones (HAZ) to be merged in close areas. In this situation, one
element might touch the weld elements from two different connectors. Don't share zone elements
prevents zone elements from being shared.

Quad in Corner
Controls whether a single or double element is created in corners of quad seam connectors with a
certain vertex.
A angle must be defined for a single quad corner. If the corner angle is greater than the defined
angle, a double quad corner is created.

Proprietary Information of Altair Engineering

Figure 1198: Quad in Corner
A double quad corner is shown on the right, and a single quad corner is shown on the left.

Quad Control
Controls the maximum deviation from the perfect quad element for the heat affected zone (HAZ).
It can be controlled, if the element size or the element skew is more important to retain.

Max Quadsize Reduction In % / Max Quad Skew In Degrees

Figure 1199: Max Quad Size Reduction: 80.0 / Max
Quad Skew: 5.0

Figure 1200: Max Quad Size Reduction: 5.0 / Max
Quad Skew: 45.0
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Sliver Elements
Sliver elements are small elements that you may not want in your model. In the images below,
a perfect perpendicular projection resulted in sliver elements. The Sliver Elements setting can be
used to manage sliver elements in your model. In the images below, the red elements represent
the HAZ elements.

Figure 1201: Allow Figure 1202: Prevent by Moving Projection Points

Figure 1203: Prevent by Moving Edge Figure 1204: Delete Sliver Elements

Element length<
This length controls which elements to treat as sliver elements.

Feature Angle
Determines important features to retain during the imprint. Features that cross the HAZ, as well
as near by features cannot be retained.
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Projection Control Methods for Area Connectors
Use the projection control methods to control how projection should be performed for area connectors.

You can define the projection control method in the Connector Entity Editor. With these controls you can
easily realize adhesive beads.

Figure 1205:

Figure 1206:

Proprietary Information of Altair Engineering
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Connector Review
There are many advantages to the way connectors store information. Not only does this local storage
allow you to edit the connector definition, it also allows you to review connector details and the quality
of the realization.

There are a number of tools that can be useful in the review process. Use the connector visualization
controls to update the visual appearance of a connector based on its state, thickness (number of
layers), style (connector types), or the component in which it is located. In addition, you can use the
visualization controls to filter the displayed connectors by various criteria, such as thickness. This filter
can then be used store the "displayed" connectors for use in other functions.

The Connector Browser contains a list of all of connectors and their definitions, as well as a list of
connector links. Use the Quality panel to check the quality of welds created from the connectors. The
connector database can also be queried through Tcl functions.

Proprietary Information of Altair Engineering
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Connectors User Control Mode
Each individual connector can be placed in a user control mode using either the
*CE_SetSpecificDetailById or *CE_SetSpecificDetail commands.

This user control mode is most useful for automated Tcl scripts. Once in user control mode, the
following procedures are possible for a given connector:

• Pre-existing FE can be registered as a given connector’s realization by using the *CE_FE_Register
command.

• Connectors can be edited without automatically unrealizing, as happens most notably when a link is
added or removed from a connector, or when an FE realization entity is deleted.

• A connector’s state can be manually changed from realized to failed, or from failed to realized
by using either the *CE_SetSpecificDetailById or *CE_SetSpecificDetail commands. A
connector’s state will not change to or from the unrealized state using this method.

Once a connector is placed into your control mode, your control mode remains active until an unrealize
command is called, such as *CE_Unrealize, an already realized connector is re-realized, or your control
mode is manually turned off with either the *CE_SetSpecificDetailById or *CE_SetSpecificDetail
commands. While a given connector is in user control mode, it may not behave the same as a normal
connector. Specifically, there are a number of scenarios where a user-controlled connector will not auto
unrealize in response to database changes that would cause a normal connector to auto unrealize.

Note:  It is strongly recommended that when FE is registered to a user-controlled connector,
that the connector links and other necessary details should also be set with a given
connector, so that the connector can properly re-realize if you interactively request it to. At
the bare minimum, connectors should know which links they are to connect.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2236

Master Connectors File
Most of the information stored in the connector entity can be exported to a master connectors file,
which contains connector entity information such as location, link entity, link entity state, link entity
rules. The exported file may also contain metadata information stored in the connector.

The master connectors file contains welding information at a given location and also assists in the weld
automation process. An exported master connectors file can be re-imported using the connectors reader
to re-create connectors.

The master connectors file is exported in a single format. Master connectors files can have comments
beginning with the characters # or $, or there can be blank lines in between. The format of the file is
fixed and the order of heading definitions cannot be changed. The column information includes:

• Index (ID)

• Number of Layers

• X coordinate

• Y coordinate

• Z coordinate

• FE Config

• FE Type

• Number of Links

• Link Type

• Link ID and Link Name

• Link State

• Link Rule

• METADATA

The header at the beginning of the file specifies information about the column data.

Number of layers defines the thickness to connect at the specified location (X, Y, Z). The data between
the brackets are repeated for each link entity.

For standard FE types such as ACM and CWELD, the FE Config will have a number of 1001, which
defines your defined type number specified in FE Config File. The FE Type will be the number defined in
the FE Config File. For CWELD it is 72.

The data between the brackets (link entity information) in the table are repeated for the number of links
(NumLinks). The NumLinks variable must be equal to the number of link entities.

Metadata is an attribute type that can be stored on a entity. User-defined information, such as Station
ID or Gun ID, can be stored on the connector entity as Metadata. The Metadata is defined by a name-
value pair and is supported for multiple data types, such as int, double and string. The Metadata name
is written to the master connectors file in the following format ~<Struct><DataType>Name. <Struct>
represents whether the value associated is a single variable or an array. <DataType> represents the
type of data stored in the value. For example, a Metadata of name Assembly containing an array of
integers is written out as ~AIAssembly.

The only delimiter supported in the entire file is the double semicolon "::".
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The entire column of data in the file should be of the same type.

The connectors reader uses the Templex template to read the master connectors file.

By default, the file is read through the HMIN function call, HMIN_CE_CreateDefined.

The connector entity is created with the information specified in the master connectors file and
displayed as unrealized (yellow).

Proprietary Information of Altair Engineering
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Multiple Weld File Format
In addition to the master connectors file, the connectors reader also supports master weld file formats
previously supported by the spotweld reader.

Proprietary Information of Altair Engineering
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Spotweld Interface
The spotweld feinput translator reads weld information from an ASCII file, such as a Master Weld File.

HyperMesh supports multiple formats for master weld files through weld templates. The weld template
is specific for a given format. The spotweld translator registers the template through a spotweld
configuration file. The currently supported master weld file format templates and the configuration
file can be found in the spotweld_format directory. In order to use a different format you must create
a weld template and add its name and path to the configuration file. Existing weld templates can be
copied and modified to support the new format.

The outline of a generic master weld file is:

• Point ID

• Layer information (the number of thickness it connects 2T/3T/4T. Max layers supported 4T)

• Spotweld location (X, Y, Z)

• Connector part IDs (HyperMesh Component/Part IDs)

• The delimiter between fields can be ":", ",", " ".

• ASCII files can have comments beginning with the characters # or $, or there can be blank lines in
between.

The spotweld translator reads information from the master weld file and stores it in the database. At
each of the weld locations, an HM_POINT is created.

Example: Weld Template and Master Weld File

The example below helps create a weld template for specific formats.

#Weld format 1.
#Point Id::  T:: X:: Y:: Z:: PID1:: PID2::  
      PID3::

1::      2:: 2.000:: 3.000::  4.000: : 12::      
  14:: 20::

Figure 1207: Master Weld File

int num
header
{
    type "SPOTWELDS"
    set mark
    find "[0-9]+::"
    rewind
    set num = 0
    if
    {

do 1000000
{

if
{

isdigit
}
then
{
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Altair HyperMesh 2019 Users Guide
Connectors p.2240

set num = sum(num, 1)
}
readln null

}
    }
    set numrecords = num
    set numrequests = 9
    requests "ID/T/X/Y/Z/PID1/PID2/PID3/PID4"
    set numcomponents = 1
    components "Value"
}
record
 if
    {

do 1000000
{

if
{

isdigit
}
then

isalpha
            }
     readln null

}
    }
    read request // ID
    qfind "::"
 set mark
    read request  //T
 rewind
 read num
    qfind "::"
    read request // X
    qfind "::"
    read request // Y
    qfind "::"
    read request // Z
    do num
    {

qfind "::"
read request // PID

    }
    set num = diff(4, num)
    do num
    {

read constant 0 // fake PID
    }
    readln null
}

Figure 1208: Weld Template

Proprietary Information of Altair Engineering
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FE Configuration File
The FE configuration file (feconfig.cfg) is used to define custom welds such as ACM (Area Contact
Method) and other special types.

Weld definitions are solver dependant (Nastran, LS-DYNA, and so on). The weld definition in the file
includes the type of weld to create and the surrounding connector to shells. The specific solver template
for the type of weld must be loaded before the welds can be created using a connector entity. When
HyperWorks Desktop or HyperMesh launches, it searches for feconfig.cfg in the following locations,
listed in search order:

1. The product installation path

2. HW_CONFIG_PATH (a specified environment variable)

3. Your home directory (in UNIX, for example)

4. The current working directory.

By default, the feconfig.cfg file from the <install_directory>/hm/bin directory is loaded in each
of the panels related to each connector type, such as Spot, Seam and Area. It is not recommended to
have more than one config file of the same name, even in different directories, as the results can be
unpredictable as to which one will be used by default.

Weld Definition Template

CFG <SOLVER> <USER_FE_TYPE> <USER_FE_NAME>
*filter <FILTER_TYPE > [<FILTER_TYPE>]
*style < STYLE_TYPE> <STYLE_NUM>
*head
<HM_FE_CONFIG> <HM_FE_TYPE> <RIGID_FLAG>
*body <BODY_FLAG>
<HM_FE_CONFIG> <HM_FE_TYPE> <LENGTH_LOCATION_FLAG> [<DOFS>]
[<HM_FE_CONFIG> <HM_FE_TYPE> <LENGTH_LOCATION_FLAG> [<DOFS>]]
*post <POST_SCRIPT_NAME>

Figure 1209: Weld Definition Template

Where,

CFG
Keyword to start a custom weld definition.

SOLVER
The solver template for which FE needs to be created.
Supported solvers are: Abaqus, ANSYS, LS-DYNA, Nastran, OptiStruct, PAM-CRASH, or
PAM-CRASH 2G.

USER_FE_TYPE
A unique (with respect to a solver) user defined configuration type ID. Customer-defined
CFGs should use numbers greater than 10,000 to ensure no collisions with future native HM
CFGs.
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USER_FE_NAME
The user-specified name for the FE configuration. The specified name is saved and displayed
in the Connector Browser.

Note:  This should be the first line in the custom weld definition.

*filter
Allows only the specified connector types to realize the configuration.
For example, *FILTER spot seam indicates that this configuration can be realized only by the
spot and seam connector types. In addition, this option is used as a filter when displaying FE
configurations in the type = field of respective realize panels.
*filter lines also set which panel the CFG is visible in.

CE_TYPE
The connector type, spot, bolt, seam, area, and so on.

*style
Indicates that the configurations have specific behaviors associated during realization, and that
they are native types.

Note:  The style definition line for these configurations must not be edited.

For example, *style bolt 1 indicates that this is a bolt connection of type 1 that creates a specific
bolted connection between the parts.

STYLE_TYPE
The connector style name, such as "adhesive", "bolt", "acm", "quad", "continuous", and so
on.

STYLE_NUM
The connector style number:

• Adhesive:

"1" mesh independent adhesive nodes tie to shells with RBE3/RBE2.

"2" force shell gap length on. Adhesive (HEXA element) shares nodes with shell at
co-incident locations.

• Bolt:

"0" normal bolt: "wagon wheels" in the holes.

"1" symmetrical spider bolt.

"2" unsymmetrical spider bolt: the middle node is biased towards one hole.

"3" cylinder bolt: ties together all nodes within virtual cylinder.

• ACM:

"1" share the nodes of HEXA element for consecutive layers (> 2T) and the length
of HEXA is average of part thickness.

"2" HEXA elements in consecutive layers have unique nodes and the length of
HEXA is average of part thickness.
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"3" share the nodes of HEXA elements for consecutive layers and the length of
HEXA is the gap distance between parts.

"5" HEXA nodes are not equivalenced with the shell nodes/washer nodes, if a
washer is present.

• Quad

"1" create two sets of QUAD4 elements, first along projection direction and second
at an orientation determined by average part thickness.

"2" create one set of QUAD4 elements at an orientation determined by average
part thickness.

*head
The string head is required to specify that a rigid is to be created to connect the weld node to the
surrounding shell element.
*head lines must be followed with at most one HM_FE_CONFIG line.

HM_FE_CONFIG
The config for the rigid currently supported.
The various types supported are "bar2", "bar3", "equations", "gap", "hex8"(3D), "plot",
"mass"(0D), "rigid", "rigidlink", "rbe3", "rod", "spring", "weld", "quad4"(2D seam only), or
"penta6"(3D adhesive only).

HM_FE_TYPE
Unique (with respect to a solver) user defined configuration type id defined in the solver
template.

RIGID_FLAG
Defines the number and arrangement of rigids.

"0" is a single rigid

"1" is multiple rigids

"2" is multiple rigids to outer shell nodes (for 2D bolt washers only)

"3" is multiple rigids to outer alternate shell nodes (for 2D bolt washers only)

"10" is multiple rigids with a 0 length leg connecting with body (for bolt only)

"12" is multiple rigids to inner and outer shell nodes (for 2D bolt washers only)

"13" is multiple rigids to inner and outer alternate shell nodes (for 2D bolt washers
only)

DOFS (Optional)
Degrees of freedom of the rigid (1-6).

*body
Specifies that a weld is to be created to connect the link entities added to the connector.
*body lines may be followed by one or more HM_FE_CONFIG lines

BODY_FLAG
The body flag is used to calculate the length of the weld. If the body flag = 0, the length is
calculated based on the distance between the connecting layers (link entities). If the body
flag = 1, the length is calculated based on the average thickness of the connecting layers
(link entities).
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HM_FE_CONFIG
The config for the rigid currently supported. The various types supported are "bar2", "bar3",
"equations", "gap", "hex8"(3D), "plot", "mass"(0D), "rigid", "rigidlink", "rbe3", "rod",
"spring", "weld", "quad4"(2D seam only), or "penta6"(3D adhesive only).

HM_FE_TYPE
The solver defined type for the HyperMesh config. For example, CBUSH is of config spring
and type 6. The type number is defined in respective solver templates and differs, based on
the solver.

LENGTH_LOCATION_FLAG
0D element details.

"0" place the 0D element along the proposed 1D element path. If this 0D element is
the only config given in the *body, then it is placed at the center of the proposed 1D
element path.

"1" has the same behavior as "0" except only a single 0D element is created even if
multiple bodies are created (as happens in >2T welds)

"2" place the 0D element at the connector location.

1D element details.

"0" force zero length welds.

>"0" but <"1" denote a percentage of the distance between shells the length of a given
weld should be. To create series welds, all the PERCENT_LENGTH_FLAG variables for a
given *body must add up less than or equal to 1.0. Example: 0.33 or 0.50

"1" force each body weld to have a length equal to the distance between the shells,
which can be used for parallel welds.

"2" place the 1D element at the connector location, with both nodes coincident.

"3" place multiple (thickness-1) 1D elements at the connector location connected end-
to-end, with all nodes coincident.

3D element details.

"0" force a floating hexa element to have a length equal to half the distance specified
by the BODY_FLAG.

"1" force the hexa element's length to be equal to the full distance specified by the
BODY_FLAG.

DOFS (Optional)
The degrees of freedom (1-6) of the rigid.

*post
*post lines are optional, but if specified, they must be followed by the name, excluding path, of a
valid TCL script with a .tcl extension. HyperMesh searches for the TLC script in the locations and
order specified below:

1. Current working directory

2. Users home directory

3. Paths in HW_CONFIG_PATH environment variable

4. Installation directory
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5. hm/bin directory

6. hm/scripts directory

7. hm/scripts/connectors/ directory

This post script will be automatically executed post FE realization, and can be used to edit weld
properties, attributes, and other solver specific details.

FE Specification Rules
Each solver will have a specific definition so the same user-defined types can be repeated for each
solver.

The head and the body definition must begin with a "*" to define rigid and weld definitions.

Multiple solid element combinations are not currently supported. Therefore, an ACM can have only one
hexa weld element specified in the definition.

1D and 3D element combinations are not supported.

The total length of series welds cannot exceed 1.0 (100 percent). Hence there cannot be three welds
specified in series having a length factor of 0.5 (50 percent) each.

Series and parallel weld element combinations are not supported.

Series welds are not supported where the link entities are coincident. Series welds are not created when
the distance between the connecting link entities is zero.

User comments should start with a hash character "#".

FE Configuration Examples
FE configuration examples for washers, ACM welds, series welds, parallel welds, and 0D welds.

Washers

CFG nastran 56 bolts
*filter bolt
*style bolt 0
*head
rigidlink 1 1 dofs=123
rigidlink 1 3
*body 0
rigid 1 1 dofs=456

ACM Welds
ACMs with HEXA8 solid elements as welds and RBE3 elements as rigids are created. The length of the
hexa is equal to the distance between the connecting shell elements.
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Figure 1210:

CFG nastran 71 acm
*head
rbe3 0 0
*body 1
hex8 1 1

Series Welds
Two series welds are created with a length equal to half the distance between the link entities.

Figure 1211:

CFG nastran 101 series
*head
plot 0 0
*body 0
spring 6 0.5
spring 6 0.5

Series Welds
The series weld is created at the center with length equal to half the distance between the link entities.
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Figure 1212:

CFG nastran 101 series
*head
plot 0 0
*body 0
spring 6 0.5

Parallel Welds
Bar elements are created at the same location and connect the same link entities.

Figure 1213:

CFG dyna 101 parallel
*head
plot 0 0
*body 0
bar2 1 1
bar2 1 1

0-D Welds
Supported values for the length location flag are "0", "1", or "2". The behavior for each value is as
follows, "0" places the 0D element along the proposed 1D element path. If this 0D element is the only
config given in the *body, then it is placed at the center of the proposed 1D element path. "1" has the
same behavior as "0" except only a single 0D element is created even if multiple bodies are created (as
happens in >2T welds) and "2" places the 0D element at the connector location.

CFG pamcrash2g 1 plink (ce loc)
*head
plot 0 0
*body 0
mass 5 2
plot 0 1
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*post prop_plink.tcl

Abaqus Connector Types
Supported Abaqus connector types and property scripts.

Connector Types
Abaqus Fastener

Creates a CONN3D2 element.

This realization uses the prop_fastener.tcl5 property script.

Figure 1214:

CFG abaqus 3 fastener
*filter spot
*head
*body 0
rod 13 3
*post prop_fastener.tcl

Abaqus acm (equivalenced-(T1+T2)/2)
Creates hexa element with DCOUP3D elements projecting and connecting to the surrounding
shell elements. This realization uses the shell thickness to calculate the hexa offset from the shell
elements. In the case where the model is a 3T connection, the acm (equivalenced-(T1+T2)/2)
realization will join the hexa elements.

This realization uses the prop_abaqus_acm.tcl4 property script.
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Figure 1215:

CFG abaqus 4 acm (equivalenced-(T1+T2)/2)
*filter spot
*style acm 1
*head
rbe3 1 0
*body 0
hex8 1 1
*post prop_abaqus_acm.tcl
cfg_abaqus_4_acm

Abaqus sealing
Creates DCOUP3D elements for the head and element for the body. The head elements project
and connect to the nodes of the adjoining shell elements.

Figure 1216:

CFG abaqus 5 sealing
*filter spot
*head
rbe3 1 0
*body 0
rod 13 1
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Abaqus bush
Creates KINCOUP elements for the head and element for the body. The head elements project and
connect to the nodes of the adjoining shell elements.

Figure 1217:

CFG abaqus 6 bush
*filter spot
*head
rigidlink 1 1
*body 0
rod 13 1

Abaqus bolt (b31)
Creates KINCOUP elements for the head and B31 element for the body. The head elements
project and connect to the nodes of the adjoining shell elements that form the hole, and also to
the second row of nodes to form the washer layer. The connector location can be on the edge of
the hole, center of the hole, midpoint in between the two, holes or on the second row of nodes
which form the washer layer.

This connector also uses the script prop_abaqus_b31.tcl3.

Figure 1218:

CFG abaqus 7 bolt (b31)
*filter bolt
*style bolt 0
*head
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rigidlink 1 12
*body 0
bar2 9 1
*post prop_abaqus_b31.tcl
cfg_abaqus_7_bolt

Abaqus hinge (b31)
Creates KINCOUP elements for the head and B31 element for the body. The rot x degree of
freedom is constrained. The head elements project and connect to the nodes of the adjoining shell
elements that form the hole, and also to the second row of nodes to form the washer layer. The
connector location can be on the edge of the hole, center of the hole, midpoint in between the two
holes, or on the second row of nodes which form the washer layer.

This connector also uses the script prop_abaqus_b31.tcl3.

Figure 1219:

CFG abaqus 8 hinge (b31)
*filter bolt
*style bolt 0
*head
rigidlink 1 12
*body 0
bar2 9 1 dofs=4
*post prop_abaqus_b31.tcl

Abaqus Adhesives
Creates a row of hexa/penta elements for the body and numerous DCOUP3D/KINCOUP elements
for the head. The head elements project and connect to the nodes of the adjoining shell elements.
If there is a direct normal projection then a KINCOUP element will be used, if there are only non-
normal projections then DCOUP3D elements will be created. The size (thickness) for the hexa
and/or penta elements depends on the chosen option: shell gap, (T1+T2)/2, mid thickness, const.
thickness, maintain gap.
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Note:  The exact hexa position is also influenced by the option consider shell thickness
and offset for hexa positioning. See hexa positioning for hexa adhesives and ACMs for
details.

This realization uses the prop_abaqus_acm.tcl4 property script.

Figure 1220:

CFG abaqus 9 adhesives
*filter area
*style adhesive 1
*head
rbe3 1 0
rigid 1 0
*body 1
hex8 1 1
penta6 1 1
*post prop_abaqus_acm.tcl
cfg_abaqus_9_adhesive

Abaqus rbe3 (load transfer)
Creates DCOUP3D elements for the body. The degrees of freedom are constrained in the x, y, and
z axes for the dependant nodes.
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Figure 1221:

CFG abaqus 31 rbe3 (load transfer)
*filter spot
*style mpc 1
*head
*body 0
rbe3 1 1 dofs=123
cfg_abaqus_31_rbe3

Abaqus clip
Creates a KINCOUP element. The element projects and connects to the nodes of the adjoining
shell elements that form the hole, and also the nodes that form the washer layer. The connector
location can either be on the edge of the hole, center of the hole, midpoint in between the two
holes, or on the second row of nodes which form the washer layer.

Figure 1222:

CFG abaqus 50 clip
*filter bolt
*style bolt 1
*head
*body 0
rigidlink 1 2
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Abaqus bolt (washer 1) cbar
Creates KINCOUP elements for the head and B31 element for the body. The head elements
project and connect to the nodes of the adjoining elements, forming the hole and also the second
row of nodes which form the washer layer. The connector location can either be on the edge of the
hole, center of the hole, midpoint in between the two holes, or on the second row of nodes which
form the washer layer.

Figure 1223:

CFG abaqus 51 bolt (washer 1) cbar
*filter bolt
*style bolt 0
*head
rigidlink 1 12
*body 0
bar2 9 1

Abaqus bolt (spider)
Creates a KINCOUP element, which projects and connect to the nodes of the adjoining elements
which form the hole. The connector location can either be on the edge of the hole, center of the
hole, midpoint in between the two holes, or on the second row of nodes which form the washer
layer.

Figure 1224:

CFG abaqus 54 bolt (spider)
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*filter bolt
*style bolt 1
*head
*body 0
rigidlink 1 1

Abaqus bolt (washer 2)
Creates KINCOUP elements for the head and the body. There are two individual KINCOUP
elements at the head of the connection, one to connect to the inner row of nodes, and a second to
connect to the washer layer nodes. The connector location can either be on the edge of the hole,
center of the hole, midpoint in between the two holes, or on the second row of nodes which form
the washer layer.

Figure 1225:

CFG abaqus 55 bolt (washer 2)
*filter bolt
*style bolt 0
*head
rigidlink 1 1
rigidlink 1 2
*body 0
rigid 1 1
cfg_abaqus_55_bolt_washer2

Abaqus bolt (washer 2 alt)
Creates KINCOUP elements for the head and the body. There are two individual KINCOUP
elements at the head of the connection, one to connect to the inner row of nodes, and a second
to connect to the washer layer nodes. The KINCOUP head element that connects to the washer
layer nodes only connects to every other node on the washer layer. The connector location can
either be on the edge of the hole, center of the hole, midpoint in between the two holes, or on the
second row of nodes which form the washer layer.
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Figure 1226:

CFG abaqus 56 bolt (washer 2 alt)
*filter bolt
*style bolt 0
*head
rigidlink 1 1
rigidlink 1 3
*body 0
rigid 1 1

Abaqus bolt (washer 1)
Creates KINCOUP elements for the head and body. The head elements project and connect to the
nodes of the adjoining elements, forming the hole and also the second row of nodes which form
the washer layer. The connector location can either be on the edge of the hole, center of the hole,
midpoint in between the two holes, or on the second row of nodes which form the washer layer.

Figure 1227:

CFG abaqus 57 bolt (washer 1)
*filter bolt
*style bolt 0
*head
rigidlink 1 12
*body 0
rigid 1 1
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cfg_abaqus_57_bolt_washer1

Abaqus bolt (washer 1 alt)
Creates KINCOUP elements for the head and body. The head elements project and connect to the
nodes of the adjoining elements, forming the hole and also the second row of nodes which form
the washer layer. The head only connects to every other node on the washer layer. The connector
location can either be on the edge of the hole, center of the hole, midpoint in between the two
holes, or on the second row of nodes which form the washer layer.

Figure 1228:

CFG abaqus 58 bolt (washer 1 alt)
*filter bolt
*style bolt 0
*head
rigidlink 1 13
*body 0
rigid 1 1

Abaqus bolt (cylinder bolt)
Creates a KINCOUP element for the body as well as for the head elements.

This realization uses the prop_cylinder.tcl6 property script.

Figure 1229:

CFG abaqus 60 bolt (cylinder rigid)
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*filter bolt
*style bolt 4
*head
rigidlink 1 1
*body 0
rigid 1 1
*post prop_cylinder.tcl
cfg_abaqus_60_cylinderbolt

Abaqus bolt (cylinder bar)
Creates a B31 element for the body and KINCOUP elements for the head elements.

This realization uses the prop_cylinder.tcl6 property script.

Figure 1230:

CFG abaqus 61 bolt (cylinder bar)
*filter bolt
*style bolt 4
*head
rigidlink 1 1
*body 0
bar2 9 1
*post prop_cylinder.tcl
cfg_abaqus_61_bolt_clinderbar

Abaqus acm (detached-(T1+T2)/2)
Creates a hexa element with DCOUP3D elements projecting and connecting to the surrounding
shell elements. This realization uses the shell thickness to calculate the hexa offset from the
shell elements. In the case where the model is a 3T connection, the acm (detached-(T1+T2)/2)
realization will not join the hexa elements.

This realization uses the prop_abaqus_acm.tcl4 property script.
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Figure 1231:

CFG abaqus 70 acm (detached-(T1+T2)/2)
*filter spot
*style acm 2
*head
rbe3 1 0
*body 1
hex8 1 1
*post prop_abaqus_acm.tcl
cfg_abaqus_70_acm

Abaqus acm (shell gap)
Creates a hexa element with DCOUP3D elements projecting and connecting to the surrounding
shell elements. This realization does not use the shell thickness to calculate the hexa offset,
therefore the hexa will project and be touching the shell elements.

This realization uses the prop_abaqus_acm.tcl4 property script.

Figure 1232:

CFG abaqus 71 acm (shell gap)
*filter spot
*style acm 3
*head
rbe3 1 0
*body 0
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hex8 1 1
*post prop_abaqus_acm.tcl
cfg_abaqus_71_acm

Abaqus acm (shell gap + coating)
Creates one hexa cluster per connector and realizes a node to node connection to the linked
shell meshes by adjusting it (shell coating). Different patterns are available. This is driven by
the number of hexas. The appearance can be influenced via the diameter and the washer layer
activation.

Figure 1233:

CFG abaqus 72 acm (shell gap + coating)
*filter spot
*style acm 4
*body 0
hex8 1 1
acm_shellgap_coating_2

Abaqus acm (general)
Consolidates several ACM definitions into one general, flexible ACM definition. Besides mid
thickness, constant thickness, and maintain gaps, the definition of several coats with different
hexa patterns is available.

This realization uses the prop_abaqus_acm.tcl4 property script.
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Figure 1234:

CFG abaqus 73 acm (general
*filter spot
*style acm 3
*head
rbe3 1 0 dofs=123
*body 0
hex8 1 1
*post prop_abaqus_acm.tcl
cfg_abaqus_73_acm_general

Abaqus seam-quad (angled+capped+L)
Creates a quad row with tria caps at the seam ends. In addition, a certain pure quad element
pattern is created around the seam elements, shown here in red. These elements normally get
imprinted into the shell links. The exact geometry of the seam can be influenced by certain
attributes in the Seam panel.
This realization is mainly intended to be used for lap welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction checkbox in the Seam panel.
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Figure 1235:

CFG abaqus 101 seam-quad (angled+capped+L)
*filter seam
*style quad 4
*head
*body 0
quad4 1 1

Abaqus seam-quad (angled+capped+T)
Creates a quad row with tria caps at the seam ends. In addition, a certain pure quad element
pattern is created around the seam elements, shown here in red. These elements normally get
imprinted into the shell links. The exact geometry of the seam can be influenced by certain
attributes in the Seam panel.
This realization is mainly intended to be used for lap welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction checkbox in the Seam panel.

Figure 1236:

CFG abaqus 102 seam-quad (angled+capped+T)
*filter seam
*style quad 5
*head
*body 0
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quad4 1 1

Abaqus seam-quad (vertical+angled)
Description: Creates two quad rows-the first one perpendicular to the opposite shell link, and the
second one with a certain angle to the first one. In addition, a certain pure quad element pattern
is created around the seam elements, shown here in red. These elements normally get imprinted
into the shell links. The exact geometry of the seam can be influenced by the angle value.
This realization is can be used for both lap- and T-welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction checkbox in the Seam panel.

Figure 1237:

CFG abaqus 103 seam-quad (vertical+angled)
*filter seam
*style quad 1
*head
*body 0
quad4 1 1

Abaqus seam-quad (angled)
Creates one quad row under a certain angle. The angle is measured between the quad row and
the perpendicular projection from the free edge to the opposite shell link. In addition, a certain
pure quad element pattern is created around the seam elements, shown here in red. These
elements normally get imprinted into the shell links. The exact geometry of the seam can be
influenced by the angle value.
This realization is can be used for both, lap- and T-welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction checkbox in the Seam panel.
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Figure 1238:

CFG abaqus 104 seam-quad (angled)
*filter seam
*style quad 2
*head
*body 0
quad4 1 1

Abaqus Mastic
Creates SPRING elements for the body, and projects and connects to the adjoining shell/solid
elements with DCOUP3D elements.

The realization uses the prop_mastic.tcl2 property script.

Figure 1239:

CFG abaqus 105 Mastic  
*filter spot
*head
rbe3 1 0
*body 0
spring 1 1
spring 1 1
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spring 1 1
*post prop_mastic.tcl

Abaqus hexa (adhesive)
Creates a row of hexa elements for the body, and numerous DCOUP3D elements for the head. The
head elements project and connect to the nodes of the adjoining shell/solid elements. The hexa
elements are projected so that they touch the shell/solid elements of the connecting components.

This realization also uses the prop_abaqus_acm.tcl4 property script.

Figure 1240:

CFG abaqus 106 hexa (adhesive)
*filter seam
*style continuous 3
*head
rbe3 1 0
rigid 1 0
*body 0
hex8 1 1
*post prop_abaqus_acm.tcl
cfg_abaqus_106_hexa_adhesive

Abaqus seam (vectors)
Creates perpendicular and parallel vectors to the surface along a line/nodelist. On exporting the
connector file, a vector file (.asc format) containing the vector information is also exported for
this realization.
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Figure 1241:

CFG abaqus 107 seam (vectors)
*filter seam
*style continuous_vec 1
*head
*body 0
quad4 1 1

Abaqus hexa (tapered T)
Intended to be used for t-cases. The size and exact position can be defined thickness dependent,
or the exact dimension and position parameters can be given.

Figure 1242:

CFG abaqus 108 hexa (tapered T)
*filter seam
*style continuous 6
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*head
rbe3 1 0
rigid 1 0
*body 0
hex8 1 1
hexa_tapered_t

Abaqus fastener-nodes
Creates a Node Set that contains the nodes that are selected to create the connector element,
and creates an empty Element Set. Connector elements are not created for this realization type.
Abaqus creates the required connector elements on its own.

This realization uses the prop_fastener_nodes.tcl1 property script.

Figure 1243:

CFG abaqus 110 fastener-nodes
*filter spot
*head
*body 0
mass 99 2
*post prop_fastener_nodes.tcl
cfg_abaqus_110_fastener_nodes
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Abaqus bolt (step hole)

Figure 1244:

This realization creates a B31 element for the bolt shaft and connects to the solids' nodes with
numerous KINCOUP rigid elements based on the given bolt/hole parameters. It connects two
solids through holes, or it connects one solid through a hole with a solid blind hole.

CFG abaqus 114 bolt (step hole)
*filter bolt
*style bolt 6
*head
rigidlink 1 1
*body 0
bar2 9 1

Abaqus bolt (threaded step hole)
Connects two solids through holes, or connects one solid through a hole with a solid blind hole. A
thread length can be defined to define the dimensions of the rigid elements connecting the bolt
shaft models as a bar.
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Figure 1245:

CFG abaqus 115 bolt (threaded step hole)
*filter bolt
*style bolt 7
*head
rigidlink 1 1
*body 0
bar2 9 1

Abaqus hexa (spot tie)
Creates hexa (C3D8) elements between shell and/or solid elements in order to connect them
using a tie contact definition. The hexa element nodes will project and touch the shell and/or
solid element faces. During the realization, a default tie contact and referencing master and slave
surfaces are created; unless defined differently, the hexas are assigned a default property and
material, and are organized into a component with the same name base as the property.
The default tie contact and material parameters can be changed in the files below this path: ..
\Altair\2019\hm\scripts\connectors\Hexa_Tie\abaqus\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1246:

CFG abaqus 152 hexa (spot tie)
*filter spot
*style spot_tie 1
*head
*body 0
hex8 1 1

Abaqus rod (spot tie)
Creates rod (CONM3D2) elements between shell and/or solid elements in order to connect them
using a tie contact definition. The rod element nodes will project and touch the shell and/or solid
element faces. During the realization, a default tie contact and referencing master and slave
surfaces are created; unless defined differently, each rod is assigned a property, which references
a default material (CONNECTOR BEHAVIOR) and an individual coordinate system. By default, the
property is directly assigned to the element so that all rods can be hosted in one component.
The default tie contact and material parameters can be changed in the files below this path: ..
\Altair\2019\hm\scripts\connectors\Rod_Tie\abaqus\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1247:

CFG abaqus 153 rod (spot tie)
*filter spot
*style spot_tie 3
*head
*body 0
rod 13 1

Abaqus hexa (seam tie)
Creates hexa (C3D8) elements between shell and/or solid elements in order to connect them
using a tie contact definition. The hexa element nodes will project and touch the shell and/or
solid element faces. During the realization, a default tie contact and referencing master and slave
surfaces are created; unless defined differently, the hexas are assigned a default property and
material, and are organized into a component with the same name base as the property.
The default tie contact and material parameters can be changed in the files below this path: ..
\Altair\2019\hm\scripts\connectors\Hexa_Tie\abaqus\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1248:

CFG abaqus 154 hexa (seam tie)
*filter seam
*style seam_tie 1
*head
*body 0
hex8 1 1
os_hexa_seam_tie

Abaqus hexa (area tie)
Creates hexa (C3D8) elements between shell and/or solid elements in order to connect them
using a tie contact definition. The hexa element nodes will project and touch the shell and/or
solid element faces. During the realization, a default tie contact and referencing master and slave
surfaces are created; unless defined differently, the hexas are assigned a default property and
material, and are organized into a component with the same name base as the property.
The default tie contact and material parameters can be changed in the files below this path: ..
\Altair\2019\hm\scripts\connectors\Hexa_Tie\abaqus\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1249:

CFG abaqus 155 hexa (area tie)
*filter area
*style area_tie 1
*head
*body 0
hex8 1 1

Property Scripts
1. prop_fastener_nodes.tcl

Used while creating Abaqus Fasteners-Nodes in the Spot panel. It performs the following tasks:

• Organizes the realized weld elements into their respective components, based upon the link
they are connected to. Thus, if a weld is created between comp_1(1) and comp_2(2), the
script creates a component collector with the name HM_HMCONN_<id> and organizes all the
welds (Dummy element) created as links between these two components into this collector.
This collector is later referenced as the element set while creating Groups (Interfaces).

• Creates groups with the card image *FASTENER, and assigns them the name
HM_FastenerInteraction_<id>. The fastener connects two component collectors and refers to
the fastener property card. The Automatic_Surface_from_components option is used to show
the elements to which the weld elements are linked to.

• Creates the following properties/material collectors:

HM_ConnectorBehavior<id>
This material collector is created with the *CONNECTOR BEHAVIOR card assigned to it.

HM_FastenerProperty_r_<radius in property>
This property collector is created with the *FASTENER PROPERTY card assigned to it.
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HM_ConnectionSection_<id>
This property collector is created once per model (card image *CONNECTOR SECTION).
The property is assigned to each HM_CONN3D2 component collector and carries the
material HM_ConnectorBehavior.

• Creates the following sets:

HM_FastenerNodes_Node_Set1
Contains the selected nodes for the Fastener.

HM_HMCONN_<id>
This is the dummy elset. The connector element is created and collected based on the
nodeset HM_FastenerNodes_Node_Set1 assigned to this elset. You can refer the elset to
outputblock.

2. prop_mastic.tcl

Performs the following tasks:

• Organizes the SPRING elements into components with the names SPRING_X, SPRING_Y and
SPRING_Z.

• Organizes the DCOUP3D elements into the component DCOUP_3D_no_prop.

• Creates properties with the SPRING card image, and names the properties
spring_prop_K1_ElemId-##, spring_prop_K2_ElemId-##, and spring_prop_K3_ElemId-##
(where ## is the element ID of the SPRING element).

Note:  New components will only be created if their are not any components with
the same names that already exist; otherwise the existing components are used.

3. prop_abaqus_b31.tcl

Updates the direction nodes of a group of bar elements created during realization to use the y
axis. The *bardirectionupdate command is called to update the orientation node of bar element
along Y-axis.

4. prop_abaqus_acm.tcl

Used while creating acm (equivalenced-(T1+T2)/2) / (detached-(T1+T2)/2) /shell gap in the Spot
panel and adhesives in the Area panel. It performs the following tasks.

• Organizes the realized weld elements [acm Equivalence-(T1+T2/2)] into the respective
components based upon the *HEAD and the *BODY information of the weld. During
realization of this configuration type a solid hexa element [C3D8] is connected to the shell
elements by the rbe3 elements [DCOUP3D].

◦ A collector with the name C3D8_comp_<id> is created with the SOLIDSECTION card
image associated with it. This component contains all of the solid C3D8 elements which
are created during realization.

◦ A collector with the name DCOUP3D_comp_<id> is created, containing all of the
DCOUP3D elements created as the heads to the weld element.

• If this script is called during the realization of adhesives in the Area panel, this script creates
the above two components by different names:
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hexa_comp_<id>
For the Hexa elements

rbe2_comp_<id>
For the rbe elements

• The script also creates a property collector named prop_<id>, with the SOLIDSECTION card
image associated to it. This property collector is referenced to the component containing the
Hexa elements created during realization process (i.e. C3D8_comp_<id> in the case of spots,
or hexa_comp_<id> in the case of adhesives).

5. prop_fastener.tcl

Used while creating Abaqus Fasteners in the Spot panel. It performs the following tasks.

• Organizes the realized weld elements into their respective components, based upon the link
they are connected to. Thus, if a weld is created between comp_1(1) and comp_2(2), the
script creates a component collector with the name HM_CONN3D2<id> and organizes all the
welds created as links between these two components into this collector. This collector is later
referenced as the element set while creating the Groups (Interfaces).

• Creates the following properties/materials collectors:

HM_ConnectorBehavior<id>
This material collector is created with the *CONNECTOR BEHAVIOR card associated with
it.

HM_ConnectionSection_<id>
This property collector is created once per model (card image CONNECTOR SECTION).
The property is assigned to each HM_CONN3D2 component collector and carries the
material HM_ConnectorBehavior.

HM_FastenerProperty_r_<radius in property>
This property collector is created with the *FASTENER PROPERTY card associated with
it. It defines the RADIUS and the degree of freedom definition of the fastener.

• Creates Groups (HM Interfaces) with the name HM_FastenerInteraction<id> and with the
*FASTENER card associated with it. The fastener connects two component collectors and
refers to the fastener property card mentioned above. It can also show the link elements to
which the weld elements are linked via the Automatic_Surface_from_components option.

◦ If any system option (Single System ,1- System per layer or 2- Systems per layer) is
used in the Spot panel during realization, this script creates ORIENTATION systems
in the current collector with the name HM_ORI<weld_id>_n<node_id>. A property
HM_ConnectorSection_<CONN3D2 element id> is created and assigned per element.
Depending on whether one or two systems per layer are created the property points to
one or both systems.

6. prop_cylinder.tcl

Used while creating bolt (cylinder rigid) and bolt (cylinder bar) in the Bolt panel (Abaqus, Nastran,
OptiStruct). It organizes the realized bolt elements into the respective components based upon
the*HEAD and the *BODYinformation of the bolt:

• A collector with the name Rigid_M<diameter> is created. This component contains all of the
rigid head elements and the rigid body elements, if available.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2276

• A collector with the name Beam_M<diameter> is created. This component contains all of
the bar2 head elements, if available. This component then gets a property Beam_M assigned
(*BEAMSECTION or PBEAM).

ANSYS Connector Types
Supported ANSYS connector types.

hexa (tapered T)
Intended to be used for t-cases. The size and exact position can be defined thickness dependent,
or the exact dimension and position parameters can be given.

Figure 1250:

CFG ansys 105 hexa (tapered T)
*filter seam
*style continuous 6
*head
*body 0
hex8 1 1

Bolt (link10)
Creates a body with element type ‘Link10’ element. CERIG elements will be created at the head.
Head elements project and connect to the adjoining elements that form the hole. Properties and
materials for the Link10 element are also created.
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Figure 1251:

CFG ansys 112 bolt
*filter bolt
*style bolt 0
*head
rigid 1 1
*body 0
rod 2 1
*post prop_ansys.tcl
cfg_ansys_boltlink10

Bolt(BEAM44)
Creates a body with element type ‘Beam44’ element. CERIG elements will be created at the
head. Head elements project and connect to the nodes of adjoining elements that form the hole.
Properties and materials for the Beam44 element are also created.

Figure 1252:

CFG ansys 113 bolt (BEAM44)
*filter bolt
*style bolt 0
*head
rigid 1 1
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*body 0
bar2 7 1
*post prop_ansys.tcl
cfg_ansys_boltlink10

Clip
Creates CERIG and Mass21 elements. Mass21 element is created at the center location of bolt
body. CERIG elements connect Mass21 to the nodes of adjoining elements of the shell that form
hole. CERIG elements, from Mass21 also connect to the nodes of the element that represent the
washer of the bolt. Properties and materials are also created for the Mass21 element type. The
connector location can either be on the edge of the hole, center of the hole, midpoint in between
the two holes, or on the second row of nodes which form the washer layer.

Figure 1253:

CFG ansys 114 clip
*filter bolt
*style bolt 1
*head
*body 0
rigidlink 1 2
*post prop_ansys.tcl

Bolt (spider)
Creates many individual CERIG elements. The element projects and connects to the nodes of the
adjoining shell elements which form the hole, the CERIG elements are joined at the midpoint of
the bolted connection. A MASS21 element is created at this location. The connector location can
either be on the edge of the hole, center of the hole, midpoint in between the two holes or on
the second row of nodes which form the washer layer. Properties and materials for the MASS21
element is also created.
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Figure 1254:

CFG ansys 115 bolt (spider)
*filter bolt
*style bolt 1
*head
*body 0
rigid 1 1
*post prop_ansys.tcl

Bolt (Washer1) link10
Creates CERIG element for the head and LINK10 for body. The head elements project and connect
to the nodes of the adjoining shell elements which form the hole and also the second row of nodes
which form the washer layer. The connector location can either be on the edge of the hole, center
of the hole, midpoint in between the two holes or on the second row of nodes which form the
washer layer. Properties and materials are also created for the LINK10 element.

Figure 1255:

CFG ansys 116 bolt (washer 1)
*filter bolt
*style bolt 0
*head
rigidlink 1 12
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*body 0
rod 2 1
*post prop_ansys.tcl
cfg_ansys_boltwasher1link10

Bolt (Washer1 alternate) link10
Creates CERIG element for the head and LINK10 element for body. The head elements project
and connect to the nodes of the adjoining shell elements which form the hole and also the second
row of nodes which form the washer layer. The head only connects to every other node on the
washer layer. The connector location can either be on the edge of the hole, center of the hole,
midpoint in between the two holes or on the second row of nodes which form the washer layer.
Properties and materials are also created for the LINK10 element.

Figure 1256:

CFG ansys 117 bolt (washer 1 alt) LINK10
*filter bolt
*style bolt 0
*head
rigidlink 1 13
*body 0
rod 2 1
*post prop_ansys.tcl
cfg_ansys_boltwasher1alternatelink10

Bolt (Washer 1) BEAM44
Creates CERIG elements for the head and BEAM44 element for the body. The head elements
project and connect to the nodes of the adjoining shell elements which form the hole and also
the second row of nodes which form the washer layer. The connector location can either be on
the edge of the hole, center of the hole, midpoint in between the two holes or on the second row
of nodes which form the washer layer. Property and material cards for the BEAM44 element are
created.
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Figure 1257:

CFG ansys 118 bolt (washer 1) BEAM44
*filter bolt
*style bolt 0
*head
rigidlink 1 12
*body 0
bar2 7 1
*post prop_ansys.tcl
cfg_ansys_boltwasher1beam44

Bolt (Washer 2) LINK10
Creates CERIG elements for the head and the LINK10 element for body. There are two individual
CERIG elements at the head of the connection, one to connect to the inner row of nodes, the
other to connect to the washer layer nodes. The connector location can either be on the edge of
the hole, center of the hole, midpoint in between the two holes or on the second row of nodes
which form the washer layer. Property and material cards are created for the LINK10 element.

Figure 1258:

CFG ansys 119 bolt (washer 2) LINK10
*filter bolt
*style bolt 0
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*head
rigidlink 1 1
rigidlink 1 2
*body 0
rod 2 1
*post prop_ansys.tcl
cfg_ansys_boltwasher2link10

Bolt (Washer 2 alt) LINK10
Creates CERIG elements for the head and the LINK10 element for body. There are two individual
CERIG elements at the head of the connection, one to connect to the inner row of nodes, the
other to connect to the washer layer nodes. The CERIG head element that connects to the washer
layer nodes only connects to every other node on the washer layer. The connector location can
either be on the edge of the hole, center of the hole, midpoint in between the two holes or on the
second row of nodes which form the washer layer. Property and material cards are created for the
LINK10 element.

Figure 1259:

CFG ansys 120 bolt (washer 2 alt) LINK10
*filter bolt
*style bolt 0
*head
rigidlink 1 1
rigidlink 1 3
*body 0
rod 2 1
*post prop_ansys.tcl
cfg_ansys_boltwasher2altlink10

LS-DYNA Connector Types
Supported LS-DYNA connector types and property/post scripts.

Connector Types
dyna rigid (crbody)

Creates a RgdBody element for the body.
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The dyna rigid (crbody) exists in exactly the same configuration with the following additional
names:

• HC mig weld

• HC laser

This is in order to keep the realization names from HyperCrash.

This realization also uses the prop_rigid_crbody.tcl1 property script.

Figure 1260:

CFG dyna 5 rigid (crbody)
*filter spot
*head
*body 0
rigid 2 1
*post prop_rigid_crbody.tcl

dyna ConNode (spider)
Creates a ConNode rigidlink element for the body. It connects to the nearest node to the
connector position and then projects to the nearest nodes on the adjoining elements of the
connected components.
The dyna ConNode (spider) exists in exactly the same configuration with the following additional
names:

• HC cylinder rigid bolt

• HC cylinder rigid clip

This is in order to keep the realization names from HyperCrash.

Figure 1261:

CFG dyna 56 ConNode (spider)
*filter bolt
*style bolt 2
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*head
*body 0
rigidlink 1 1

dyna RgdBody (spider)
Creates a RgdBody rigidlink element for the body. It connects to the nearest node to the
connector position and then projects to the nearest nodes on the adjoining elements of the
connected components.
If holes are detected the nodes on the edges are connected.

Figure 1262:

CFG dyna 57 RgdBody (spider)
*filter bolt
*style bolt 2
*head
*body 0
rigidlink 2 1

dyna RgdBody (spider+washer)
Creates a RgdBody rigidlink element for the body. It connects to the nearest node to the
connector position and then projects to the nearest nodes on the adjoining elements of the
connected components.
If holes are detected the nodes on the edges and the washer nodes are connected.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2285

Figure 1263:

CFG dyna 58 RgdBody (spider+washer)
*filter bolt
*style bolt 21
*head
*body 0
rigidlink 2 1

dyna acm (shell gap + coating)
This realization creates one hexa cluster per connector, and realizes a node to node connection
to the linked shell meshes by adjusting it (shell coating). Different patterns are available. This
is driven by the number of hexas. The appearance can be influenced via the diameter and the
washer layer activation.

This realization uses the prop_acm_coating.tcl2 property script.
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Figure 1264:

CFG dyna 72 acm (shell gap + coating)
*filter spot
*style acm 4
*body 0
hex8 1 1
*post prop_acm_coating.tcl

dyna mat100
Creates a BEAM element for the body and plot elements for the head, the plot elements are
created for visualization purposes and find operations.
The dyna mat100 exists in exactly the same configuration with the following additional names:

• HC beam spotweld

• HC glue

• HC glue structural adhesive

• HC welding line

• HC hemming

This is in order to keep the realization names from HyperCrash.

This realization also uses the prop_dyna_matnum.tcl3 property script.
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Figure 1265:

CFG dyna 100 mat100
*filter spot
*head
*body 0
bar2 1 1
*post prop_dyna_matnum.tcl

dyna mat100 (hexa)
Creates hexa element with plot elements projecting and connecting to the surrounding shell
elements. This realization does not use the shell thickness to calculate the hexa offset, therefore
the hexa will project and be touching the shell elements.
The dyna mat100 (hexa) exists in exactly the same configuration with a HC hexa spotweld.
This is in order to keep the realization names from HyperCrash.

This realization also uses the prop_dyna_matnum.tcl3 property script.

Figure 1266:

CFG dyna 101 mat100 (hexa)
*filter spot
*head
*body 0
hex8 1 1
*post prop_dyna_matnum.tcl

dyna mat196
Creates a BEAM element for the body and plot elements for the head, the plot elements are
created for visualization purposes and find operations. This realization is the same as the “CFG
dyna 100 mat100” realization except it uses Mat196 as opposed to Mat100.
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This realization also uses the prop_dyna_matnum.tcl3 property script.

Figure 1267:

CFG dyna 102 mat196
*filter spot
*head
*body 0
bar2 1 1
*post prop_dyna_matnum.tcl

dyna hexa (tapered T)
Intended to be used for t-cases. The size and exact position can be defined thickness dependent,
or the exact dimension and position parameters can be given.

Figure 1268:

CFG dyna 105 hexa (tapered T)
*filter seam
*style continuous 6
*head
*body 0
hex8 1 1

dyna hexa (adhesive - shell gap)
This realization creates rows of HEXA elements for the body. The HEXA elements project and
connect to the adjoining shell/solid elements by touching them.
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Note:  Uses the default parameters, material thickness lookup table, and material
strength lookup table from the weld_config.ini config file to set the default
attributes for the the created MATL100 material.

The dyna hexa (adhesive - shell gap) exists in exactly the same configuration with the following
additional names:

• HC glue mastic sealer

• HC glue spot sealer

• HC glue glass adhesive

This is in order to keep the realization names from HyperCrash.

The realization uses the prop_dyna_matnum_seamarea.tcl4 post script.

Figure 1269:

CFG dyna 106 hexa (adhesive - shell gap)
*filter seam
*style continuous 2
*head
*body 0
hex8 1 1
*post prop_dyna_matnum_seamarea.tcl

dyna HC cylinder rigid bolt
This realization creates a single ConNode rigidlink element for the body, and projects and
connects to nodes of the adjoining shell/solid within the prescribed cylinder diameter, L1 (cylinder
height along the vector from the connector location) and L2 (cylinder height in the opposite
direction of the vector from the connector location).

The realization uses the prop_dyna_rigidbolts.tcl5 property script.
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Figure 1270:

CFG dyna 115 HC cylinder rigid bolt
*filter bolt
*style bolt 4
*head
*body 0
rigidlink 1 1
*post prop_dyna_rigidbolts.tcl

dyna adhesive (shell gap)
This realization creates a DISCRETE element for the body, and projects and connects to nodes of
the adjoining shell/solid elements with ConNode rigidlink elements within the prescribed cylinder
diameter, L1 (cylinder height along the vector from the connector location) and L2 (cylinder height
in the opposite direction of the vector from the connector location).

The realization uses the prop_dyna_rigidbolts.tcl5 property script.

Figure 1271:

CFG dyna 116 HC cylinder spring bolt
*filter bolt
*style bolt 4
*head
rigidlink 1 1
*body 0
spring 1 1
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*post prop_dyna_rigidbolts.tcl

dyna HC cylinder spring bolt
Creates a row of hexa/penta elements. The hexa/penta elements are projected so that they touch
the shell elements of the connecting components.

Figure 1272:

CFG dyna 121 adhesive (shell gap)
*filter area
*style adhesive 2
*head
*body 1
hex8 1 1
penta6 1 1

dyna - adhesive (shell gap)
This realization creates rows of HEXA and PENTA elements for the body. The HEXA and PENTA
elements project and connect to the adjoining shell/solid elements by touching them.

Note:  Uses the default parameters, material thickness lookup table, and material
strength lookup table from the weld_config.ini config file to set the default attributes
for the the MATL100 material that was created.

This realization uses the prop_dyna_matnum_seamarea.tcl4 post script.
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Figure 1273:

CFG dyna 121 adhesive (shell gap)
*filter area
*style adhesive 1
*head
*body 1
hex8 1 1
penta6 1 1
*post prop_dyna_matnum_seamarea.tcl

dyna - mat196 (single row)
This realization creates a single row of BEAM elements for the body.

Note:  Use the init_dyna_mat196.ini config file to set the default attributes for the
created MATL196 material.

This realization uses the prop_dyna_matnum_seamarea.tcl4 post script and the weld_config.ini
and init_dyna_mat196.ini config file.

Figure 1274:

CFG dyna 122 mat196 (single row)
*filter seam
*style continuous 4
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*head
*body 0
bar2 1 0
*post prop_dyna_matnum_seamarea.tcl

Automatic Exclusion of Special Nodes During Rigid Bolt Realization
HyperMesh automatically excludes special nodes as potential slave nodes for any rigid bodies created
during bolt realization, even though they fall with the virtual Bolt Cylinder diameter. Nodes that are
shared by the following entities are considered special nodes:

• rigid links

• Rigids

• Rbe3 nodes

• boundaries condition

• IMPDISP

• IMPVEL

• IBVEL

• IMPACC

• FXBODY

• Nodes inside the Interfaces with Type2

Property and Post Scripts
1. prop_rigid_crbody.tcl

Updates mesh-dependent rigid welds > 2T into rigidlinks sharing a node. This is a requirement for
the LS-DYNA *CONSTRAINED_NODAL_RIGID_BODY definition.

2. prop_acm_coating.tcl

Performs the following task:

• Organizes the HEXA elements into a set with the name CE_HEXSW_# (# starts with 1 and
increments as 1, 2, 3, and so on for every new connector).

3. prop_dyna_matnum.tcl

Used during the creation of mat100/mat100 (hexa)/mat196 custom config welds in the Spot
panel.

This script performs the following tasks:

• Organizes the realized weld elements to the respective components based upon the link they
are connected to and based upon the realization used.

If a weld is created as mat100 between comp_1(id1) and comp_2(id2), it will create a
component collector with the name C_^_<id1_id2>_BEAM_100 and organize all of the welds
created as links between these two components into this collector.

If a weld is created as mat100 between the three components comp_1(id1), comp_2(id2) and
comp_3(id3), it will create two component collectors, C_^_1W_<id1_id2>_BEAM_100 and
C_^_1W_<id2_id3>_BEAM_100. The suffix is based on the realization type:
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Mat100
_BEAM_100

Mat100 (hexa)
_SOLID

Mat196
_BEAM_196

This collector is later referenced as the weld element set while creating the groups (contact)
definition.

• This script will create the following properties/materials collectors:

◦ M_^<id1_id2>_< MAT100 or MAT196> or M_^_1W_<id1_id2_id3>_<MAT100 or
MAT196>: These material collectors are created upon the selection of the configuration
type by you with the MAT100 or the MAT196 card. The values for the cards are read from
the *.ini file. These material collectors are referenced in the above created appropriate
components.

#MATERIAL STRENGTH LOOKUP TABLE
# FIRST NUMBER INDICATES NUMBER OF LEVELS
# SECOND NUMBER INDICATES MULTIPLIER FOR SIGY OF NUGGET
#MIN MAX k n a b
#LAST LINE:
#MIN        MAX k n a b
 NUMBER
*SIGY       4 1.85
0           0.20 4.0000      1.9000      10.5000     -4.000
0.20 0.40 4.2000      1.9500      12.000      -3.000
0.40 0.80 4.5000      1.9500      14.200      -2.000
0.80 0.90 4.7000      1.9900      16.500      -1.0000
 9.00

◦ P_^<id1_id2>_<BEAM or SOLID> or P_^_1W<id1_id2_id3>_<BEAM or SOLID>: These
property collectors are created with the *SECTION_BEAM or *SECTION_SOLID card
associated with them. These property collectors are referenced in the above created
appropriate components.

# SAMPLE MATERIAL THICKNESS LOOKUP TABLE:
# NUMBER INDICATES NUMBER OF LEVELS
#LAST LINE:
*THICKNESS      5
 0 0.1 0.125
 0.1 0.5 .25
 0.5 1.0 .75
 1.0 1.5 1.25
 1.5 2.0 17.75 2.0
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• This script also creates the necessary group (contact) definition upon the selection of the
configuration type. For mat100 and mat196 a group named C_Contact_Spotweld_<group id>
and/or for mat100 (hexa) a group named C_Contact_Tied_Shell_Edge_To_Surface_<group
id> is/are created. These interfaces are defined with the appropriate solver cards and
reference the following master (MSID) and slave (SSID) sets:

◦ For the *CONTACT_SPOTWELD_ID card the following FS and FD are set to 0.1.

◦ For the *CONTACT_TIED_SHELL_EDGE_TO_SURFACE_ID card FS and FD are set to 0.1
as well. Additionally the values for variable SST and MST in the card image are set to
0.010. These values will override the thickness and establish the tied connection.

• The script creates sets by the name C_S_^Part_<set id>_Contact_<group id> and
C_S_^Weld_<set id>_Contact_<group id>. The configuration types mat100 and mat196
share the same sets, while the configuration type mat100 (hexa) gets a different pair of sets.
The former set contains the parts to which the welds are connected and the latter contains
the weld components created during realization process. The part sets is defined as master in
the appropriate contact definition, the weld set as slave.

In addition, for the mat100 (hexa) realization a set for each hexa cluster is created and
named CE_HEXSW_<set id>.

All these sets get a card *DEFINE_HEX_SPOTWELD_ASSEMBLY_<# hexa> associated with
them.

Note:  This script is called if the CFG type is mat100/mat100 (hexa)/mat196

4. prop_dyna_matnum_seamarea.tcl

This script performs the following tasks:

• Creates NodesToSurface(Tied interfaces) and names them ADHESIVE_SEAM_CONTACT_PID
_# , which references the independent/dependent links' master sets and the nodes' slave sets
(# is the ID of the link components).

• Organizes the link components into a set with name
ADHESIVE_SEAM_MASTER_PART_SET_PID_#, which is referenced by the above interface
group (# is the ID of the link component).

• Organizes the solids‘ nodes on the links into a set with the name
ADHESIVE_SEAM_SLAVE_NODE_SET_PID _#, which in turn is referenced by the above
interface group (# is the ID of the link component).

• Creates a component with the name ADHESIVE_SEAM_MAT100_COMP_PID_#_# for the
connector SOLID elements (# is the ID of the link component).

• Creates a property with the name ADHESIVE_SEAM_MAT100_PROP_PID _#_# and SectSld
card image, and assigns it to the SOLID component (# is the ID of the link component).

• Creates a material with the name ADHESIVE_SEAM_MAT100_MAT_PID_#_# and MATL100
card image, and assigns it to the SOLID component (# is the ID of the link component).

Note:  Uses the default parameters, material thickness lookup table, and material
strength lookup table from the weld_config.ini config file to set the default
attributes for the created MATL100 material.
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5. prop_dyna_rigidbolts.tcl

The script performs the following tasks:

• Organizes the ConNode rigidlink elements into a component with the name Realize#001 (#
starts with 2 and increments as 2, 4, 6, and so on for each new connector).

• Creates a view with the name dyna_rigid_bolts.

Nastran Connector Types
Supported Nastran connector types and property scripts.

Nastran sealing
Creates RBE3 elements for the head and CBUSH element for the body. The head elements project
and connect to the nodes of the adjoining shell elements.

Figure 1275:

CFG nastran 5 sealing
*filter spot
*head
rbe3 1 0
*body 0
spring 6 1

Nastran bush
Creates RBE2 elements for the head and CBUSH element for the body. The head elements project
and connect to the nodes of the adjoining shell elements.

Figure 1276:

CFG nastran 6 bush
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*filter spot
*head
rigidlink 1 1
*body 0
spring 6 1

Nastran rbe3 (load transfer)
Creates RBE3 elements for the body. The degrees of freedom are constrained in the x, y, z for the
dependant nodes.

Figure 1277:

CFG nastran 31 rbe3 (load transfer)
*filter spot
*style mpc 1
*head
*body 0
rbe3 1 1 dofs=123

Nastran clip
Creates a single RBE2 element for the body. The element projects and connect to the nodes of the
adjoining shell elements which form the hole and also the nodes which form the washer layer. The
connector location can either be on the edge of the hole, center of the hole, midpoint in between
the two holes or on the second row of nodes which form the washer layer.

Figure 1278:

CFG nastran 50 clip
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*filter bolt
*style bolt 1
*head
*body 0
rigidlink 1 2

Nastran bolt (washer 1) cbar
Creates RBE2 elements for the head and CBAR element for the body. The head elements project
and connect to the nodes of the adjoining shell elements which form the hole and also the second
row of nodes which form the washer layer. The connector location can either be on the edge of the
hole, center of the hole, midpoint in between the two holes or on the second row of nodes which
form the washer layer.

Figure 1279:

CFG nastran 51 bolt (washer 1) cbar
*filter bolt
*style bolt 0
*head
rigidlink 1 12
*body 0
bar2 1

Nastran bolt (general)
Creates RBE2 elements for the head and the body. The head elements project and connect to the
nodes of the adjoining shell elements which form the hole. The connector location can either be
on the edge of the hole, center of the hole, midpoint in between the two holes or on the second
row of nodes which form the washer layer.
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Figure 1280:

CFG nastran 52 bolt (general)
*filter bolt
*style bolt 0
*head
rigidlink 1 1
*body 0
rigid 1 1

Nastran bolt (CBAR)
Creates RBE2 elements for the head and CBAR element for the body. The head elements project
and connect to the nodes of the adjoining shell elements which form the hole. The connector
location can either be on the edge of the hole, center of the hole, midpoint in between the two
holes or on the second row of nodes which form the washer layer.

Figure 1281:

CFG nastran 53 bolt (CBAR)
*filter bolt
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*style bolt 0
*head
rigid 1 1
*body 0
bar2 1 1

Nastran bolt (spider)
Creates a many individual RBE2 elements. The element projects and connect to the nodes of the
adjoining shell elements which form the hole, the RBE2 elements are joined at the midpoint of
the bolted connection. The connector location can either be on the edge of the hole, center of the
hole, midpoint in between the two holes or on the second row of nodes which form the washer
layer.

Figure 1282:

CFG nastran 54 bolt (spider)
*filter bolt
*style bolt 1
*head
*body 0
rigid 1 1

Nastran bolt (washer 2)
Creates RBE2 elements for the head and the body. There are two individual RBE2 elements at
the head of the connection, one to connect to the inner row of nodes, the other to connect to the
washer layer nodes. The connector location can either be on the edge of the hole, center of the
hole, midpoint in between the two holes or on the second row of nodes which form the washer
layer.
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Figure 1283:

CFG nastran 55 bolt (washer 2)
*filter bolt
*style bolt 0
*head
rigidlink 1 1
rigidlink 1 2
*body 0
rigid 1 1

Nastran bolt (washer 2 alt)
Creates RBE2 elements for the head and the body. There are two individual RBE2 elements at
the head of the connection, one to connect to the inner row of nodes, the other to connect to
the washer layer nodes. The RBE2 head element that connects to the washer layer nodes only
connects to every other node on the washer layer. The connector location can either be on the
edge of the hole, center of the hole, midpoint in between the two holes or on the second row of
nodes which form the washer layer.
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Figure 1284:

CFG nastran 56 bolt (washer 2 alt)
*filter bolt
*style bolt 0
*head
rigidlink 1 1
rigidlink 1 3
*body 0
rigid 1 1
cfg_nastran_56_bolt

Nastran bolt (washer 1)
Creates RBE2 elements for the head and body. The head elements project and connect to the
nodes of the adjoining shell elements which form the hole and also the second row of nodes which
form the washer layer. The connector location can either be on the edge of the hole, center of the
hole, midpoint in between the two holes or on the second row of nodes which form the washer
layer.
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Figure 1285:

CFG nastran 57 bolt (washer 1)
*filter bolt
*style bolt 0
*head
rigidlink 1 12
*body 0
rigid 1 1
cfg_nastran_57_bolt

Nastran bolt (washer 1 alt)
Creates RBE2 elements for the head and body. The head elements project and connect to the
nodes of the adjoining shell elements which form the hole and also the second row of nodes which
form the washer layer. The head only connects to every other node on the washer layer. The
connector location can either be on the edge of the hole, center of the hole, midpoint in between
the two holes or on the second row of nodes which form the washer layer.
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Figure 1286:

CFG nastran 58 bolt (washer 1 alt)
*filter bolt
*style bolt 0
*head
rigidlink 1 13
*body 0
rigid 1 1
cfg_nastran_58_bolt

Nastran hinge
Creates RBE2 elements for the head and the body. The head elements project and connect to the
nodes of the adjoining shell elements which form the hole. The connector location can either be
on the edge of the hole, center of the hole, midpoint in between the two holes or on the second
row of nodes which form the washer layer. The degrees of freedom are constrained in the x, y, z,
rot x, rot z for the dependant nodes.

This realization also uses the prop_hinge.tcl1 property script.
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Figure 1287:

CFG nastran 59 hinge
*filter bolt
*style bolt 0
*head
rigidlink 1 1
*body 0
rigid 1 1 dofs=12356
*post prop_hinge.tcl
cfg_nastran_59_hinge

Nastran bolt (cylinder rigid)
Creates an RBE2 element for the body as well as for the head elements.
See the mesh independent realization methods in the Bolt panel for further information on
cylinder-type bolts.

This realization uses the prop_cylinder.tcl2 property script.

Figure 1288:

CFG nastran 60 bolt (cylinder rigid)
*filter bolt
*style bolt 4
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*head
rigidlink 1 1
*body 0
rigid 1 1
*post prop_cylinder.tcl
cfg_nastran_60_bolt_cylinder_rigid

Nastran bolt (cylinder bar)
Creates a CBEAM element for the body and RBE2 elements for the head elements.
See the mesh independent realization methods in the Bolt panel for further information on
cylinder-type bolts.

This realization uses the prop_cylinder.tcl2 property script.

Figure 1289:

CFG nastran 61 bolt (cylinder bar)
*filter bolt
*style bolt 4
*head
rigidlink 1 1
*body 0
bar2 2 1
*post prop_cylinder.tcl
cfg_nastran_61_bolt_cylinder_bar

Nastran acm (equivalenced-(T1+T2)/2)
Creates hexa element with RBE3 elements projecting and connecting to the surrounding shell
elements. This realization uses the shell thickness to calculate the hexa offset from the shell
elements. In the case where the model is a 3T connection, the acm (equivalenced-(T1+T2)/2)
realization will join the hexa elements.

This realization also uses the prop_nastran_acm.tcl3 property script.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2307

Figure 1290:

CFG nastran 69 acm (equivalenced-(T1+T2)/2)
*filter spot
*style acm 1
*head
rbe3 1 0
*body 0
hex8 1 1
*post prop_nastran_acm.tcl
cfg_nastran_69_acm

Nastran acm (detached-(T1+T2)/2)
Creates hexa element with RBE3 elements projecting and connecting to the surrounding shell
elements. This realization uses the shell thickness to calculate the hexa offset from the shell
elements. In the case where the model is a 3T connection, the acm (detached-(T1+T2)/2)
realization will not join the hexa elements.

This realization also uses the prop_nastran_acm.tcl3 property script.

Figure 1291:

CFG nastran 70 acm (detached-(T1+T2)/2)
*filter spot
*style acm 2
*head
rbe3 1 0
*body 1
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hex8 1 1
*post prop_nastran_acm.tcl
cfg_nastran_70_acm

Nastran acm (shell gap)
Creates hexa element with RBE3 elements projecting and connecting to the surrounding shell
elements. This realization does not use the shell thickness to calculate the hexa offset, therefore
the hexa will project and be touching the shell elements.

This realization also uses the prop_nastran_acm.tcl3 property script.

Figure 1292:

CFG nastran 71 acm (shell gap)
*filter spot
*style acm 3
*head
rbe3 1 0
*body 0
hex8 1 1
*post prop_nastran_acm.tcl
cfg_nastran_71_acm

Nastran acm (shell gap + coating)
This realization creates one hexa cluster per connector and realizes a node to node connection
to the linked shell meshes by adjusting it (shell coating). Different patterns are available. This
is driven by the number of hexas. The appearance can be influenced via the diameter and the
washer layer activation.
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Figure 1293:

CFG nastran 72 acm (shell gap + coating)
*filter spot
*style acm 4
*body 0
hex8 1 1
acm_shellgap_coating_2

Nastran pie (rigid spider)
This realization prepares a circled shell mesh from a certain number of segments for each link,
so the mesh is adjusted to a rigid element created with the independent node centered in the
circular arranged dependent nodes. The independent nodes themselves are connected by an
additional rigid element.
Different numbers of elements lead to a different pattern. In addition, the appearance can be
influenced via the diameter and the washer layer activation.

Figure 1294:

CFG nastran 73 pie (rigid spider)
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*filter spot
*head
rigidlink 1 4
*body 0
rigid 1 1
pie_rigid_spider_processed

Nastran acm (general)
This realization type consolidates several ACM definitions into one general, flexible ACM definition.
Besides mid thickness, constant thickness, and maintain gaps, the definition of several coats
with different hexa pattern is available. Each hexa node pointing towards the link elements is
connected to the links by using RBE3 elements. The independent nodes get different weighting

factors. See the formulas in the prop_nastran_acm.tcl3 property script.

The realization also uses the prop_nastran_acm.tcl3 property script.

Figure 1295:

CFG nastran 74 acm (general)
*filter spot
*style acm 3
*head
rbe3 1 0 dofs=123
*body 0
hex8 1 1
*post prop_nastran_acm.tcl
acm_general2

Nastran penta (mig+L)
This realization supports Lap-joints and creates PENTA element for the body. Surrounding shell/
solid elements are projected and connected with RBE3 elements. This realization supports the
creation of PENTA elements on one side or on both sides of the joint. A fitted/equilateral option is
also provided for the PENTA creation.
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Figure 1296:

CFG nastran 76 penta (mig + L)
*filter spot
*style mig 1
*head
rbe3 1 0
*body 0
penta6 1 1

Nastran penta (mig+T)
This realization supports T-joints and creates PENTA element for the body. Surrounding shell/solid
elements are projected and connected with RBE3 elements. This realization supports the creation
of PENTA elements on one side or on both sides of the joint, and provides a right-angled option.

Figure 1297:

CFG nastran 77 penta (mig + T)
*filter spot
*style mig 2
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*head
rbe3 1 0
*body 0
penta6 1 1

Nastran penta (mig+B)
This realization supports Butt-joints and creates PENTA element for the body. Surrounding shell/
solid elements are projected and connected with RBE3 elements. This realization supports the
creation of PENTA elements on one side or on both sides of the joint. The non-normal option
needs to be ON/Active for this realization.

Figure 1298:

CFG nastran 78 penta (mig + B)
*filter spot
*style mig 3
*head
rbe3 1 0
*body 0
penta6 1 1
cfg_nastran_78_penta_mig_b

Nastran cweld (GA-GB PARTPAT)
Creates 1D CWELD element via GA-GB PARTPAT.

This realization also uses the prop_cweld.tcl4 property script.
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Figure 1299:

CFG nastran 80 cweld (GA-GB PARTPAT)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl
cfg_nastran_80_cweld

Nastran cweld (GA-GB ELPAT)
Creates 1D CWELD element via GA-GB ELPAT.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1300:

CFG nastran 82 cweld (GA-GB ELPAT)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl
cfg_nastran_82_cweld

Nastran cweld (GS ELPAT)
Creates 0D CWELD element via GS ELPAT.

This realization also uses the prop_cweld.tcl4 property script.
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Figure 1301:

CFG nastran 83 cweld (GS ELPAT)
*filter spot
*head
*body 0
mass 11 0
*post prop_cweld.tcl
cfg_nastran_83_cweld

Nastran cweld (GA-GB ELEMID)
Creates 1D CWELD element via GA-GB ELEMID.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1302:

CFG nastran 84 cweld (GA-GB ELEMID)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl
cfg_nastran_84_cweld

Nastran cweld (GS ELEMID)
Creates 0D CWELD element via GS ELEMID.

This realization also uses the prop_cweld.tcl4 property script.
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Figure 1303:

CFG nastran 85 cweld (GS ELEMID)
*filter spot
*head
*body 0
mass 11 0
*post prop_cweld.tcl
cfg_nastran_85_cweld

Nastran cweld (GA-GB GRIDID)
Creates 1D CWELD element via GA-GB GRIDID.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1304:

CFG nastran 86 cweld (GA-GB GRIDID)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl
cfg_nastran_86_cweld

Nastran cweld (GS GRIDID)
Creates 0D CWELD element via GS GRIDID.

This realization also uses the prop_cweld.tcl4 property script.
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Figure 1305:

CFG nastran 87 cweld (GS GRIDID)
*filter spot
*head
*body 0
mass 11 0
*post prop_cweld.tcl
cfg_nastran_87_cweld

Nastran cweld (GA-GB ALIGN)
Creates 1D CWELD element via GA-GB ALIGN.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1306:

CFG nastran 88 cweld (GA-GB ALIGN)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl
cfg_nastran_88_cweld

Nastran rbe3-celas1-rbe3
Creates RBE3 element for the head and zero length CELAS1 element for the body. The head
elements project and connect to the nodes of the adjoining shell elements. The degrees of
freedom are constrained in the x, y, z, rot x, rot y, rot z for the dependant nodes.
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Figure 1307:

CFG nastran 89 rbe3-celas1-rbe3
*filter spot
*head
rbe3 1 0 dofs=123456
*body 0
spring 1 0
cfg_nastran_89_rbe3_celas1_rbe3

Nastran seam-quad (angled+capped+L)
Creates a quad row with tria caps at the seam ends. In addition, a certain pure quad element
pattern is created around the seam elements, shown here in red. These elements normally get
imprinted into the shell links. The exact geometry of the seam can be influenced by certain
attributes in the Seam panel.
This realization is mainly intended to be used for lap welds. You can revert the direction of quad
seam connectors during the next realization by activating the reverse direction check box in the
Seam panel.

Figure 1308:

CFG nastran 101 seam-quad (angled+capped+L)
*filter seam
*style quad 4
*head
*body 0
quad4 1 1

Nastran seam-quad (angled+capped+T)
Creates a quad row with tria caps at the seam ends. In addition, a certain pure quad element
pattern is created around the seam elements, shown here in red. These elements normally get
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imprinted into the shell links. The exact geometry of the seam can be influenced by certain
attributes in the Seam panel.
This realization is mainly intended to be used for lap welds. You can revert the direction of quad
seam connectors during the next realization by activating the reverse direction check box in the
Seam panel.

Figure 1309:

CFG nastran 102 seam-quad (angled+capped+T)
*filter seam
*style quad 5
*head
*body 0
quad4 1 1

Nastran seam-quad (vertical+angled)
Creates two quad rows-the first one perpendicular to the opposite shell link, and the second one
with a certain angle to the first one. In addition, a certain pure quad element pattern is created
around the seam elements, shown here in red. These elements normally get imprinted into the
shell links. The exact geometry of the seam can be influenced by the angle value.
This realization is can be used for both lap- and T-welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction check box in the Seam panel.
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Figure 1310:

CFG nastran 103 seam-quad (vertical+angled)
*filter seam
*style quad 1
*head
*body 0
quad4 1 1

Nastran seam-quad (angled)
Creates one quad row under a certain angle. The angle is measured between the quad row and
the perpendicular projection from the free edge to the opposite shell link. In addition, a certain
pure quad element pattern is created around the seam elements, shown here in red. These
elements normally get imprinted into the shell links. The exact geometry of the seam can be
influenced by the angle value.
This realization is can be used for both lap- and T-welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction checkbox in the Seam panel.

Figure 1311:

CFG nastran 104 seam-quad (angled)
*filter seam
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*style quad 2
*head
*body 0
quad4 1 1

Nastran penta (mig)
Creates penta elements with RBE3 elements projecting and connecting to the surrounding shell
elements. This realization supports many different use cases, including T-joint, angled T-joint, lap
joint and butt joint.

Figure 1312:

CFG nastran 105 penta (mig)
*filter seam
*style continuous 3
*head
rbe3 1 0
*body 0
penta6 1 1
cfg_nastran_105_penta

Nastran hexa (adhesive)
Creates a row of hexa elements for the body and numerous RBE2/RBE3 elements for the head.
The head elements project and connect to the nodes of the adjoining shell elements. If there
is a direct normal project then an RBE2 elements will be used, if there are only non-normal
projections then RBE3 elements will be created. The hexa elements are projected so that they
touch the shell elements of the connecting components.

This realization also uses the prop_nastran_acm.tcl3 property script.
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Figure 1313:

CFG nastran 106 hexa (adhesive)
*filter seam
*style continuous 3
*head
rbe3 1 0
rigid 1 0
*body 0
hex8 1 1

Nastran cfast_elem (GA-GB)
Creates 1D CFAST element of type ELEM.

This realization also uses the prop_opt_nas_cfast.tcl5 property script.

Figure 1314:

CFG nastran 107 cfast_elem (GA-GB)
*filter spot
*head
*body 0
rod 7 1
*post prop_opt_nas_cfast.tcl
cfg_nastran_107_cfast

Nastran cfast_elem (GS)
Creates 0D CFAST element of type ELEM.

This realization also uses the prop_opt_nas_cfast.tcl5 property script.
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Figure 1315:

CFG nastran 108 cfast_elem (GS)
*filter spot
*head
*body 0
mass 23 0
*post prop_opt_nas_cfast.tcl

Nastran cfast_prop (GA-GB)
Creates 1D CFAST element of type PROP.

This realization also uses the prop_opt_nas_cfast.tcl5 property script.

Figure 1316:

CFG nastran 109 cfast_prop (GA-GB)
*filter spot
*head
*body 0
rod 7 1
*post prop_opt_nas_cfast.tcl
cfg_nastran_109_cfast

Nastran cfast_prop (GS)
Creates 0D CFAST element of type PROP.

This realization also uses the prop_opt_nas_cfast.tcl5 property script.
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Figure 1317:

CFG nastran 110 cfast_prop (GS)
*filter spot
*head
*body 0
mass 23 0
*post prop_opt_nas_cfast.tcl
cfg_nastran_110_cfast

Nastran HILOCK
Creates 1D element construct existing out of RBAR, CBAR and CBUSH elements. The outer
extensions represent the thicknesses of the outer shell elements. The inner nodes of the RBAR
element are connected to the shell elements whereas the inner nodes of the CBAR elements
are coincident to the shell nodes only. Between the appropriate connected and coincident
nodes CBUSHes are created. Each outer node connects one CBAR and one RBAR. Each HILOCK
connection gets an own coordinate system which z-axis is collinear to the HILOCK direction.
All affected nodes are assigned to this coordinate system. This coordinate system is taken into
account for the DOF definition of the CBAR elements, for the stiffness calculation of the CBUSH
elements and for the DOF of the node constraint.
This realization uses the shell properties and materials (PSHELL or PCOMP) and the HILOCK
material you select to calculate the exact position of the outer nodes and the stiffness of the
PBUSH elements.

This realization also uses the prop_opt_nas_hilock.tcl6 property script.
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Figure 1318:

CFG nastran 111 HILOCK
*filter spot
*style fastener 1
*head
*bodyext 0
bar2 1 1
weld 1 1 dofs=1456
*body 0
spring 6 0 dofs=2356
bar2 1 1
weld 1 1 dofs=156
spring 6 0 dofs=2356
*post prop_opt_nas_hilock.tcl
cfg_nastran_111_HiLock

Nastran clip (washer nodes)
Creates a single RBE2 element for the body. The element projects and connects to the nodes
which form the washer layer. The connector location can either be on the edge of the hole, center
of the hole, midpoint in between the two holes or on the second row of nodes which form the
washer layer.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2325

Figure 1319:

CFG nastran 112 clip (washer nodes)
*filter bolt
*style bolt 12
*head
*body 0
rigidlink 1 1

Nastran bolt (step hole)
This realization creates a CBAR element for the bolt shaft, and connects to the solids' nodes with
numerous RBE2 based on the given bolt/hole parameters. It also, connects two solids through
holes, or it connects one solid through a hole with a solid blind hole.

This realization uses the prop_stepboltholes.tcl7 property script.

Figure 1320:

CFG nastran 114 bolt (step hole)
*filter bolt
*style bolt 6
*head
rigidlink 1 1
*body 0
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bar2 1 1
*post prop_stepboltholes.tcl

Nastran bolt (threaded step hole)
Connects two solids through holes or connects one solid through a hole with a solid blind hole. A
thread length can be defined to define the dimensions of the rigid elements connecting the bolt
shaft models as a bar.

Figure 1321:

CFG nastran 115 bolt (threaded step hole)
*filter bolt
*style bolt 7
*head
rigidlink 1 1
*body 0
bar2 1 1
*post prop_stepboltholes.tcl

Nastran adhesive-hemmings
This realization type is used for modeling roll hemmings, where the outer shell is bent around the
inner shell. The inner shell is connected to the outer shell on one side with simple hexa adhesive,
and the other side is connected with RBE2 elements. A definable orientation node decides which
side the hexa adhesive should be used. This seam realization type is capable of connecting three
layers that contains two components.
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Figure 1322:

CFG nastran 116 adhesive-hemmings
*filter area
*style adhesive 3
*head
rbe3 1 0
*body 1
hex8 1 1
rigid 1 0
*post prop_nastran_acm.tcl

Nastran penta continuous (mig+L)
This realization supports Lap-joints and creates PENTA element for the body. Surrounding shell/
solid elements are projected and connected with RBE3 elements. This realization supports the
creation of PENTA elements on one side or on both sides of the joint, and provides a fitted/
equilateral option for the PENTA creation.
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Figure 1323:

CFG nastran 117 penta (mig + L)
*filter seam
*style continuous_mig 1
*head
rbe3 1 0
*body 0
penta6 1 1

Nastran penta continuous (mig+T)
This realization supports T-joints and creates PENTA element for the body. Surrounding shell/solid
elements are projected and connected with RBE3 elements. This realization supports the creation
of PENTA elements on one side or on both sides of the joint, and provides a right-angled option.
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Figure 1324:

CFG nastran 118 penta (mig + T)
*filter seam
*style continuous_mig 2
*head
rbe3 1 0
*body 0
penta6 1 1

Nastran penta continuous (mig+B)
This realization supports Butt-joints and creates PENTA element for the body. Surrounding shell/
solid elements are projected and connected with RBE3 elements. This realization supports the
creation of PENTA elements on one side or on both sides of the joint.

Figure 1325:

CFG nastran 119 penta (mig + B)
*filter seam
*style continuous_mig 3
*head
rbe3 1 0
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*body 0
penta6 1 1

Nastran wagonwheel
This realization creates RBE2 elements for the body, and projects and connects to the hole edge
nodes with RBE3 elements.

Figure 1326:

CFG nastran 120 wagonwheel
*filter bolt
*style bolt 0
*head
rbe3 1 0
*body 0
rigid 1 1
cfg_nastran_120_wagonwheel

Nastran adhesives

This realization also uses the prop_nastran_acm.tcl3 property script.
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Figure 1327:

CFG nastran 121 adhesives
*filter area
*style adhesive 1
*head
rbe3 1 0
rigid 1 0
*body 1
hex8 1 1
penta6 1 1
*post prop_nastran_acm.tcl
cfg_nastran_121_adhesives

Nastran hemming
Creates RBE3 elements for the body, the head elements project and connect to the nodes of the
adjoining shell elements.

Figure 1328:

CFG nastran 122 hemming
*filter area
*style adhesive 1
*head
*body 0
rbe3 1 1
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Nastran bolt (collapse Rigid)
This realization creates a single RBE2 element for the body. The element projects and connect to
the nodes of the adjoining shell/solid elements which form the hole.

Figure 1329:

CFG nastran 123 bolt (collapse Rigid)
*filter bolt
*style bolt 14
*head
*body 0
rigidlink 1 12

Nastran seam-quad LTB
Serves and realizes t-welds, lap-welds and butt-welds simultaneously. The weld type is identified
automatically based on the orientation of the links to each other.
The dimensions and property for all heat affected zones (HAZ) can be defined separately.
Normal directions of quad weld elements and HAZ elements can be controlled.
An edge treatment can be defined for t-welds and butt-welds to move the edge a precise distance
from the opposite link.

Figure 1330: T-weld Figure 1331: Lap-weld
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Figure 1332: Butt-weld

CFG nastran 128 seam-quad LTB
*filter seam
*style quad 7
*head
*body 0
quad4 1 1

Nastran seam-rigid LTB
Serves and realizes t-welds, lap-welds and butt-welds at the same time. The weld type is
identified automatically based on the orientation of the links to each other.
The dimensions and property for all heat affected zones (HAZ) can be defined separately.
An edge treatment can be defined for t-welds and butt-welds to move the edge a precise distance
from the opposite link.

Figure 1333: T-weld Figure 1334: Lap-weld
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CFG nastran 129 seam-rigid LTB
*filter seam
*style rigid 1
*head
*body 0
rigid 1 1

Nastran cbush (rigid)
Creates bush (CBUSH) elements between shell and/or solid elements in order to connect them
using rigid (RBE3) elements. The bush element nodes will project and touch the shell and/or
solid element faces. Unless defined differently, the bushs are assigned a default property, and
are organized into a component with the same name base as the property. If no specific bush
coordinate system is defined, the bush elements are defined with a vector x1, x2, and x3 normal
to it.
The default property parameters can be changed in the files below this path: ..\Altair\2019\hm
\scripts\connectors\Bush_Rigid\nastran\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1336:

CFG nastran 156 cbush (rigid)
*filter spot
*style bush_rigid 1
*head
rbe3 1 0
*body 0
spring 6 1
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Automatic Exclusion of Special Nodes During Rigid Bolt Realization
HyperMesh automatically excludes special nodes as potential slave nodes for any rigid bodies created
during bolt realization, even though they fall with the virtual Bolt Cylinder diameter. Nodes that are
referred in the constraints are considered special nodes.

Property Scripts
1. prop_hinge.tcl

This script is called while creation of HINGE– custom config welds in the connector bolts panel.
This script performs the tasks when the Systems option is active in the Connector Bolt panel, such
as “Single System”,”1- System per layer” or 2- Systems per layer.

This Script Assigns both reference and analysis systems ID to weld element nodes of each Bolt
(Hinge) created during realization process.

2. prop_cylinder.tcl

Proprietary Information of Altair Engineering

Used while creating bolt (cylinder rigid) and bolt (cylinder bar) in the Bolt panel (Abaqus, Nastran,
OptiStruct). It organizes the realized bolt elements into the respective components based upon
the*HEAD and the *BODYinformation of the bolt:

• A collector with the name Rigid_M<diameter> is created. This component contains all of the
rigid head elements and the rigid body elements, if available.

• A collector with the name Beam_M<diameter> is created. This component contains all of
the bar2 head elements, if available. This component then gets a property Beam_M assigned
(*BEAMSECTION or PBEAM).

3. prop_nastran_acm.tcl

This script is used in the Nastran and OptiStruct user profiles during the creation of the following
configurations:

• acm – equivalence/detached –(T1+T2)/2, and shell gap custom config welds in the Spot
panel,

• seam hexa adhesive and seam hexa (RBE2-RBE3) in the Seam panel, and

• Area adhesives in the Area panel.
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The script performs the following tasks:

• Organizes the realized Solid Hexa weld elements created during realization process into
components with names based on the realization, such as solid_spot_acm_detached,
solid_seam_hexa_adhesive_shell_gap, or solid_area_hexa_adhesive_shell_gap. Components
and the connected RBE’s created as the *HEAD type are organized into components
using similar naming, such as rbe3_spot_acm_detached, rbe3_seam_hexa_adhesive, or
rbe3_area_hexa_adhesive.

• This script creates property collectors, again using names based on the realization
such as solid_spot_acm_detached, solid_seam_hexa_adhesive_shell_gap, or
solid_area_hexa_adhesive_shell_gap.

◦ These property collectors are created with the PSOLID card associated with them,
and are referenced in the above created components containing the Solid Hexa weld
elements.

• In addition, this script also updates the weights of any RBE3 that is almost zero, because
weight factors close to 0.0 cause Nastran and OptiStruct solvers to generate incorrect results.
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Note:  New components and properties will only be created if they do not already
exist; otherwise the existing components and properties are used. For this reason,
comps/props will not always follow the naming conventions given here, because
preexisting ones might already have different names.

Also, when creating realizations with a mid-thickness option, the naming conventions
include the presence of the mid-thickness. For example, when creating a hexa (RBE2-
RBE3) configuration using a mid-thickness option:

• Solid elements will be organized into a Component named solid_seam_
hexa_RBE2_RBE3_mid_thick

• RBE3 elements will be organized into a Component named rbe3_seam_
hexa_RBE2_RBE3_mid_thick

• RBE2 elements will be organized into a Component named rbe2_seam_
hexa_RBE2_RBE3_mid_thick

• Properties will be created with the name solid_seam_ hexa_RBE2_RBE3_mid_thick

• Materials will be created with the name solid_seam_ hexa_RBE2_RBE3_mid_thick
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4. prop_cweld.tcl

This script is called while creation of all the CWELD GA-GB and GS– custom config welds in the
Spot panel. Theses include PARTPAT, ELPAT, ELEMID, GRIDID, ALIGN. It performs the following
tasks:

• Assigns the attributes to the CWELD weld element created during the realization process,
which is either a rod element [GA-GB] or mass Element [GS] of the types PARTPAT, ELPAT,
ELEMID, GRIDID or ALIGN.

• Creates the property collector with the name prop_<id> with the PWELD card associated with
it. This property is referenced to the CWELD element created during realization.

• This script also updates the weld radius value in the CWELD card. The diameter value is either
defined by you on the Spot panel, or is taken from the dvst (diameter versus thickness) file.

Note:  This script is called if the CWELD GA-GB and GS– custom config welds and shell
gap custom config welds across Nastran and OptiStruct user profiles.

5. prop_opt_nas_cfast.tcl

This script is called while creation of all the CFAST GA-GB and GS– custom config welds in the
Spot panel. Theses include ELEM, and PROP. It performs the following tasks:

• Assigns the attributes to the CFAST weld element created during the realization process,
which is either a rod element [GA-GB] or mass Element [GS] of the types ELEM or PROP.

• Creates the property collector with the name PFAST_<diameter> with the PFAST card
associated with it. This property is referenced to the CFAST element created during
realization.

• This script also updates the weld diameter value in the CFAST card. The diameter value is
either defined by you on the Spot panel, or is taken from the dvst (diameter versus thickness)
file.
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Note:  This script is called for the CFAST GA-GB and GS– custom config welds across
Nastran and OptiStruct user profiles.
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6. prop_opt_nas_hilock.tcl

This script is used while creation of HILOCK custom config welds in the Spot panel from the
Nastran and OptiStruct user profile.

This script does the following tasks:

• Organizes the realized 1D weld elements (RBAR, CBAR, CBUSH) created during realization
process into a component named HiLock components.

• This script will create the following property collectors:

◦ HiLock_PBAR_<diameter>: This property collector is created with the PBAR card
associated with it. The RBAR elements reference to this property. The attributes are
calculated depending on the used diameter in the Spot panel during realization.

◦ HiLock_PBUSH_<translational stiffness>_<rotational stiffness>: These property
collectors are created with the PBUSH card associated with them. The CBUSH elements
reference to this property. The attributes are calculated depending on the HILOCK
material you select and the properties and materials of the connected shells (PSHELL
and/or PCOMP).

• This script will create the following load collector:

HiLock_SPC6
This load collector is created and the SPCs, which are created for each HiLock will be
moved into this collector.

• This script will create the following system collector:

HiLock
This system collector is created and the systems created during the realizations will be
moved into this collector. If the system collector exists already the new created systems
will be moved into the same collector.

• If a HiLock material is not chosen, a default material is created:

HiLock_MAT1
This material will be assigned to PBAR cards, and can be found in the following folder of
the installation directory: [hm_scripts_dir]/connectors/HiLock_Mats.
The predefined values are:

set E 1.8e+07

set G 4.7e+04

set NU 0.330

set RHO 8.9e-09

set A 1.7e-05.

Note:  This script is called if the realization CFG Nastran 111 HILOCK or CFG
OptiStruct 111 HILOCK is used.
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7. prop_stepboltholes.tcl

The script performs the following tasks:

• Organizes the CBAR elements into a component with the name HM_Bolt_CBAR.

• Organizes the RBE2 elements into a component with the name HM_Bolt_RBE2.

• Creates a property with the name HM_PBAR and assigns it the PBAR card image.

Note:  New components and properties will only be created if their are not any
components and properties with the same names that already exist; otherwise the
existing components and properties are used.

Nastran Non-Structural Mass Connector (NSM)
HyperMesh handles non-structural masses for Nastran as group entities with a card image NSM1 or
NSML1 assigned to them. Whereas normally a connector creates a specific element construct during
realization, the NSM connector does not create any element. Instead, each NSM connector receives one
group with the appropriate NSM1 or NSML1 card assigned.

Creation and Realization
The non-structural mass connectors can be created and realized in the Apply Mass panel in the
Connectors module. The connector location is arbitrary and does not have any influence.

The created NSM connectors are listed in the Connector Browser in a folder named app_mass_ns.
The Mass column lists the lumped mass values corresponding to the appropriate NSM solver card the
connector is referenced to.

Figure 1337:
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Even though the connector is referenced to one specific group, it does not recognize whether this group
is manually modified. This means that adding elements to the group will not automatically lead to
updated link definitions on the connector. In addition, editing the lumped mass value on the NSM solver
card is not synchronized with the connector mass. Deleting the group causes the connector to become
unrealized.

Updating the connector links would unrealize the connector. Then the appropriate group is deleted.

Figure 1338:

The groups created along the NSM connector realization are named as
nsm_group_<CE_ID>.nsm_group_<CE_ID>, and placed in the current include. A new component
named CE_Mass_inc_<include name> is created which contains all the connector information for that
include. Each include is meant to host its own CE_Mass_inc_<include name> component, and HM will
produce a warning if the component name already exists in a different include. This helps ensure that
unrealizing and rerealizing nsm connectors will keep the FE data in its original include.
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The assigned NSM solver card can be of either the PROPERTY or ELEMENT type. This strongly depends
on the NSM entity type attribute, which is defined in the panel. The attribute used during creation is
written to the connector and is reused for a realization.

With these attributes you can define whether you want to create property- or element-based NSM
groups during connector realization. In certain cases, if the defined links cannot be referenced by
exclusive properties, a realization as property-based NSM group is not possible. In such cases the
connector fails, or can optionally be realized as an element-based NSM group.

Figure 1339: Groups belonging to Connectors 4-8 in Review Mode

Absorption
The absorption works on all different types like PSHELL, PCOMP, PBAR, PBARL, PBEAM, PBEAML,
PBCOMP and PROD.

During absorption the group definition is not modified. The connector is created in the center of a virtual
box bounding all referenced elements. Upon NSM absorption, connectors are created inside newly
created components (CE_Mass_inc_<include name>), which are created in each include that holds nsm
entities. The absorbed connector contains the following information:

• Reference to a certain group

• Lumped mass value in the appropriate NSM solver card

• All elements listed in the NSM solver card. These elements are all defined somehow as connector
links. If possible, the single elements are condensed in component links.
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Figure 1340: Dashboard, Front Floor and Trunk Groups Absorbed into Connectors 1-3

OptiStruct Connector Types
Supported OptiStruct connector types and property scripts.

OptiStruct Sealing
Creates RBE3 elements for the head and CBUSH element for the body. The head elements project
and connect to the nodes of the adjoining shell elements.

Figure 1341:

CFG optistruct 5 sealing
*filter spot
*head
rbe3 1 0
*body 0
spring 6 1
cfg_optistruct_5_sealing

OptiStruct bush
Creates RBE2 elements for the head and CBUSH element for the body. The head elements project
and connect to the nodes of the adjoining shell elements.
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Figure 1342:

CFG optistruct 6 bush
*filter spot
*head
rigidlink 1 1
*body 0
spring 6 1
cfg_optistruct_6_bush

OptiStruct rbe3 (load transfer)
Creates RBE3 elements for the body. The degrees of freedom are constrained in the x, y, z for the
dependant nodes.

Figure 1343:

CFG optistruct 31 rbe3 (load transfer)
*filter spot
*style mpc 1
*head
*body 0
rbe3 1 1 dofs=123

OptiStruct clip
Creates a single RBE2 element for the body. The element projects and connects to the nodes
of the adjoining shell elements which form the hole and also the nodes which form the washer
layer. The connector location can either be on the edge of the hole, center of the hole, midpoint in
between the two holes or on the second row of nodes which form the washer layer.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2344

Figure 1344:

CFG optistruct 50 clip
*filter bolt
*style bolt 1
*head
*body 0
rigidlink 1 2

OptiStruct bolt (washer 1) cbar
Creates RBE2 elements for the head and CBAR element for the body. The head elements project
and connect to the nodes of the adjoining shell elements which form the hole and also the second
row of nodes which form the washer layer. The connector location can either be on the edge of the
hole, center of the hole, midpoint in between the two holes or on the second row of nodes which
form the washer layer.

Figure 1345:

CFG optistruct 51 bolt (washer 1) cbar
*filter bolt
*style bolt 0
*head
rigidlink 1 12
*body 0
bar2 1 1
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OptiStruct bolt (general)
Creates RBE2 elements for the head and the body. The head elements project and connect to the
nodes of the adjoining shell elements which form the hole. The connector location can either be
on the edge of the hole, center of the hole, midpoint in between the two holes or on the second
row of nodes which form the washer layer.

Figure 1346:

CFG optistruct 52 bolt (general)
*filter bolt
*style bolt 0
*head
rigidlink 1 1
*body 0
rigid 1 1

OptiStruct bolt (CBAR)
Creates RBE2 elements for the head and CBAR element for the body. The head elements project
and connect to the nodes of the adjoining shell elements which form the hole. The connector
location can either be on the edge of the hole, center of the hole, midpoint in between the two
holes or on the second row of nodes which form the washer layer.
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Figure 1347:

CFG optistruct 53 bolt (CBAR)
*filter bolt
*style bolt 0
*head
rigid 1 1
*body 0
bar2 1 1
cfg_optistruct_53_bolt

OptiStruct bolt (spider)
Creates a many individual RBE2 elements. The element projects and connect to the nodes of the
adjoining shell elements which form the hole, the RBE2 elements are joined at the midpoint of
the bolted connection. The connector location can either be on the edge of the hole, center of the
hole, midpoint in between the two holes or on the second row of nodes which form the washer
layer.
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Figure 1348:

CFG optistruct 54 bolt (spider)
*filter bolt
*style bolt 1
*head
*body 0
rigid 1 1
cfg_optistruct_54_bolt

OptiStruct bolt (washer 2)
Creates RBE2 elements for the head and the body. There are two individual RBE2 elements at
the head of the connection, one to connect to the inner row of nodes, the other to connect to the
washer layer nodes. The connector location can either be on the edge of the hole, center of the
hole, midpoint in between the two holes or on the second row of nodes which form the washer
layer.

Figure 1349:

CFG optistruct 55 bolt (washer 2)
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*filter bolt
*style bolt 0
*head
rigidlink 1 1
rigidlink 1 2
*body 0
rigid 1 1
cfg_optistruct_55_bolt

OptiStruct bolt (washer 2 alt)
Creates RBE2 elements for the head and the body. There are two individual RBE2 elements at
the head of the connection, one to connect to the inner row of nodes, the other to connect to
the washer layer nodes. The RBE2 head element that connects to the washer layer nodes only
connects to every other node on the washer layer. The connector location can either be on the
edge of the hole, center of the hole, midpoint in between the two holes or on the second row of
nodes which form the washer layer.

Figure 1350:

CFG optistruct 56 bolt (washer 2 alt)
*filter bolt
*style bolt 0
*head
rigidlink 1 1
rigidlink 1 3
*body 0
rigid 1 1

OptiStruct bolt (washer 1)
Creates RBE2 elements for the head and body. The head elements project and connect to the
nodes of the adjoining shell elements which form the hole and also the second row of nodes which
form the washer layer. The connector location can either be on the edge of the hole, center of the
hole, midpoint in between the two holes or on the second row of nodes which form the washer
layer.
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Figure 1351:

CFG optistruct 57 bolt (washer 1)
*filter bolt
*style bolt 0
*head
rigidlink 1 12
*body 0
rigid 1 1
cfg_optistruct_57_bolt

OptiStruct bolt (washer 1 alt)
Creates RBE2 elements for the head and body. The head elements project and connect to the
nodes of the adjoining shell elements which form the hole and also the second row of nodes which
form the washer layer. The head only connects to every other node on the washer layer. The
connector location can either be on the edge of the hole, center of the hole, midpoint in between
the two holes or on the second row of nodes which form the washer layer.

Figure 1352:

CFG optistruct 58 bolt (washer 1 alt)
*filter bolt
*style bolt 0
*head
rigidlink 1 13
*body 0
rigid 1 1
cfg_optistruct_58_bolt_washer1_alt

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2350

OptiStruct hinge
Creates RBE2 elements for the head and the body. The head elements project and connect to the
nodes of the adjoining shell elements which form the hole. The connector location can either be
on the edge of the hole, center of the hole, midpoint in between the two holes or on the second
row of nodes which form the washer layer. The degrees of freedom are constrained in the x, y, z,
rot x, rot z for the dependant nodes.

This realization also uses the prop_hinge.tcl1 property script.

Figure 1353:

CFG optistruct 59 hinge
*filter bolt
*style bolt 0
*head
rigidlink 1 1
*body 0
rigid 1 1 dofs=12356
*post prop_hinge.tcl
cfg_optistruct_59_hinge

OptiStruct bolt (cylinder rigid)
Creates an RBE2 element for the body as well as for the head elements.
See the mesh independent realization methods in the Bolt panel for further information on
cylinder-type bolts.

This realization uses the prop_cylinder.tcl2 property script.
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Figure 1354:

CFG optistruct 60 bolt (cylinder rigid)
*filter bolt
*style bolt 4
*head
rigidlink 1 1
*body 0
rigid 1 1
*post prop_cylinder.tcl
cfg_nastran_60_bolt_cylinder_rigid

OptiStruct (cylinder bar)
Creates a CBEAM element for the body and RBE2 elements for the head elements.
See the mesh independent realization methods in the Bolt panel for further information on
cylinder-type bolts.

This realization uses the prop_cylinder.tcl2 property script.

Figure 1355:

CFG optistruct 61 bolt (cylinder bar)
*filter bolt
*style bolt 4
*head
rigidlink 1 1
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*body 0
bar2 2 1
*post prop_cylinder.tcl
cfg_nastran_61_bolt_cylinder_bar

OptiStruct acm (equivalenced-(T1+T2)/2)
Creates hexa element with RBE3 elements projecting and connecting to the surrounding shell
elements. This realization uses the shell thickness to calculate the hexa offset from the shell
elements. In the case where the model is a 3T connection, the acm (equivalenced-(T1+T2)/2)
realization will join the hexa elements.

This realization also uses the prop_nastran_acm.tcl3 property script.

Figure 1356:

CFG optistruct 69 acm (equivalenced-(T1+T2)/2)
*filter spot
*style acm 1
*head
rbe3 1 0
*body 0
hex8 1 1
*post prop_nastran_acm.tcl
cfg_optistruct_69_acm

OptiStruct acm (detached-(T1+T2)/2)
Creates hexa element with RBE3 elements projecting and connecting to the surrounding shell
elements. This realization uses the shell thickness to calculate the hexa offset from the shell
elements. In the case where the model is a 3T connection, the acm (detached-(T1+T2)/2)
realization will not join the hexa elements.

This realization also uses the prop_nastran_acm.tcl3 property script.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2353

Figure 1357:

CFG optistruct 70 acm (detached-(T1+T2)/2)
*filter spot
*style acm 2
*head
rbe3 1 0
*body 1
hex8 1 1
*post prop_nastran_acm.tcl

OptiStruct acm (shell gap)
Creates hexa element with RBE3 elements projecting and connecting to the surrounding shell
elements. This realization does not use the shell thickness to calculate the hexa offset, therefore
the hexa will project and be touching the shell elements.

This realization also uses the prop_nastran_acm.tcl3 property script.

Figure 1358:

CFG optistruct 71 acm (shell gap)
*filter spot
*style acm 3
*head
rbe3 1 0
*body 0
hex8 1 1
*post prop_nastran_acm.tcl
cfg_optistruct_71_acm

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2354

OptiStruct acm (shell gap + coating)
This realization creates one hexa cluster per connector and realizes a node to node connection
to the linked shell meshes by adjusting it (shell coating). Different patterns are available. This
is driven by the number of hexas. The appearance can be influenced via the diameter and the
washer layer activation.

Figure 1359:

CFG optistruct 72 acm (shell gap + coating)
*filter spot
*style acm 4
*body 0
hex8 1 1

OptiStruct pie (rigid spider)
This realization prepares a circled shell mesh from a certain number of segments for each link,
so the mesh is adjusted to a rigid element created with the independent node centered in the
circular arranged dependent nodes. The independent nodes themselves are connected by an
additional rigid element.
Different numbers of elements lead to a different pattern. In addition, the appearance can be
influenced via the diameter and the washer layer activation.
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Figure 1360:

CFG optistruct 73 pie (rigid spider)
*filter spot
*head
rigidlink 1 4
*body 0
rigid 1 1

OptiStruct acm (general)
This realization type consolidates several ACM definitions into one general, flexible ACM definition.
Besides mid thickness, constant thickness and maintain gaps, the definition of several coats with
different hexa pattern is available.

The realization also uses the prop_nastran_acm.tcl3 property script.

Figure 1361:

CFG optistruct 74 acm (general)

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2356

*filter spot
*style acm 3
*head
rbe3 1 0 dofs=123
*body 0
hex8 1 1
*post prop_nastran_acm.tcl

OptiStruct penta (mig+L)
This realization supports Lap-joints and creates PENTA element for the body. Surrounding shell/
solid elements are projected and connected with RBE3 elements. This realization supports the
creation of PENTA elements on one side or on both sides of the joint, and provides a fitted/
equilateral option for the PENTA creation.

Figure 1362:

CFG optistruct 76 penta (mig + L)
*filter spot
*style mig 1
*head
rbe3 1 0
*body 0
penta6 1 1

OptiStruct penta (mig+T)
This realization supports T-joints and creates PENTA element for the body. Surrounding shell/solid
elements are projected and connected with RBE3 elements. This realization supports the creation
of PENTA elements on one side or on both sides of the joint, and provides a right-angled option.
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Figure 1363:

CFG optistruct 77 penta (mig + T)
*filter spot
*style mig 2
*head
rbe3 1 0
*body 0
penta6 1 1

OptiStruct penta (mig+B)
This realization supports Butt-joints and creates PENTA element for the body. Surrounding shell/
solid elements are projected and connected with RBE3 elements. This realization supports the
creation of PENTA elements on one side or on both sides of the joint. The non-normal option
needs to be ON/Active for this realization.

Figure 1364:

CFG optistruct 78 penta (mig + B)
*filter spot
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*style mig 3
*head
rbe3 1 0
*body 0
penta6 1 1

OptiStruct cweld (GA-GB PARTPAT)
Creates 1d CWELD element via GA-GB PARTPAT.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1365:

CFG optistruct 80 cweld (GA-GB PARTPAT)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl
cfg_optistruct_80_cweld

OptiStruct cweld (GS PARTPAT)
Creates 0D CWELD element via GS PARTPAT.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1366:

CFG optistruct 81 cweld (GS PARTPAT)
*filter spot
*head
*body 0
mass 11 0
*post prop_cweld.tcl
cfg_optistruct_81_cweld
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OptiStruct cweld (GA-GB ELPAT)
Creates 1D CWELD element via GA-GB ELPAT.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1367:

CFG optistruct 82 cweld (GA-GB ELPAT)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl
cfg_optistruct_82_cweld

OptiStruct cweld (GS ELPAT)
Creates 0D CWELD element via GS ELPAT.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1368:

CFG optistruct 83 cweld (GS ELPAT)
*filter spot
*head
*body 0
mass 11 0
*post prop_cweld.tcl
cfg_optistruct_83_cweld

OptiStruct cweld (GA-GB ELEMID)
Creates 1D CWELD element via GA-GB ELEMID.

This realization also uses the prop_cweld.tcl4 property script.
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Figure 1369:

CFG optistruct 84 cweld (GA-GB ELEMID)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl
cfg_optistruct_84_cweld

OptiStruct cweld (GS ELEMID)
Creates 0D CWELD element via GS ELEMID.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1370:

CFG optistruct 85 cweld (GS ELEMID)
*filter spot
*head
*body 0
mass 11 0
*post prop_cweld.tcl
cfg_optistruct_85_cweld

OptiStruct cweld (GA-GB GRIDID)
Creates 1D CWELD element via GA-GB GRIDID.

This realization also uses the prop_cweld.tcl4 property script.
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Figure 1371:

CFG optistruct 86 cweld (GA-GB GRIDID)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl

OptiStruct cweld (GS GRIDID)
Creates 0D CWELD element via GS GRIDID.

This realization also uses the prop_cweld.tcl4 property script.

Figure 1372:

CFG optistruct 87 cweld (GS GRIDID)
*filter spot
*head
*body 0
mass 11 0
*post prop_cweld.tcl
cfg_optistruct_87_cweld

OptiStruct cweld (GA-GB ALIGN)
Creates 1D CWELD element via GA-GB ALIGN.
This realization also uses a property script, please see prop_cweld.tcl for further details.

This realization also uses the prop_cweld.tcl4 property script.
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Figure 1373:

CFG optistruct 88 cweld (GA-GB ALIGN)
*filter spot
*head
*body 0
rod 4 1
*post prop_cweld.tcl

OptiStruct rbe3-celas1-rbe3
Creates RBE3 element for the head and zero length CELAS1 element for the body. The head
elements project and connect to the nodes of the adjoining shell elements. The degrees of
freedom are constrained in the x, y, z, rot x, rot y, rot z for the dependant nodes.

Figure 1374:

CFG optistruct 89 rbe3-celas1-rbe3
*filter spot
*head
rbe3 1 0 dofs=123456
*body 0
spring 1 0

OptiStruct seam-quad (angled+capped+L)
Creates a quad row with tria caps at the seam ends. In addition, a certain pure quad element
pattern is created around the seam elements (shown here in red). These elements normally
get imprinted into the shell links. The exact geometry of the seam can be influenced by certain
attributes in the Seam panel.
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This realization is mainly intended to be used for lap welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction check box in the Seam panel.

Figure 1375:

CFG optistruct 101 seam-quad (angled+capped+L)
*filter seam
*style quad 4
*head
*body 0
quad4 1 1

OptiStruct seam-quad (angled+capped+T)
Creates a quad row with tria caps at the seam ends. In addition, a certain pure quad element
pattern is created around the seam elements, shown here in red. These elements normally get
imprinted into the shell links. The exact geometry of the seam can be influenced by certain
attributes in the Seam panel.
This realization is mainly intended to be used for lap welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction check box in the Seam panel.
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Figure 1376:

CFG optistruct 102 seam-quad (angled+capped+T)
*filter seam
*style quad 5
*head
*body 0
quad4 1 1

OptiStruct seam-quad (vertical+angled)
Creates two quad rows-the first one perpendicular to the opposite shell link, and the second one
with a certain angle to the first one. In addition, a certain pure quad element pattern is created
around the seam elements, shown here in red. These elements normally get imprinted into the
shell links. The exact geometry of the seam can be influenced by the angle value.
This realization is can be used for both lap- and T-welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction check box in the Seam panel.

Figure 1377:

CFG OptiStruct 103 seam-quad (vertical+angled)
*filter seam
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*style quad 1
*head
*body 0
quad4 1 1

OptiStruct seam-quad (angled)
Creates one quad row under a certain angle. The angle is measured between the quad row and
the perpendicular projection from the free edge to the opposite shell link. In addition, a certain
pure quad element pattern is created around the seam elements, shown here in red. These
elements normally get imprinted into the shell links. The exact geometry of the seam can be
influenced by the angle value.
This realization is can be used for both, lap- and T-welds.

Note:  You can revert the direction of quad seam connectors during the next
realization by activating the reverse direction check box in the Seam panel.

Figure 1378:

CFG OptiStruct 104 seam-quad (angled)
*filter seam
*style quad 2
*head
*body 0
quad4 1 1
cfg_optistruct_104_seam_quad_angled

OptiStruct penta (mig)
Creates penta elements with RBE3 elements projecting and connecting to the surrounding shell
elements. This realization supports many different use cases, including T-joint, angled T-joint, lap
joint and butt joint.
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Figure 1379:

CFG OptiStruct 105 penta (mig)
*filter seam
*style continuous 3
*head
rbe3 1 0
*body 0
penta6 1 1
cfg_optistruct_105_penta

OptiStruct hexa (adhesive)
Creates a row of hexa elements for the body and numerous RBE2/RBE3 elements for the head.
The head elements project and connect to the nodes of the adjoining shell elements. If there
is a direct normal project then an RBE2 elements will be used, if there are only non-normal
projections then RBE3 elements will be created. The hexa elements are projected so that they
touch the shell elements of the connecting components.

This realization also uses the prop_nastran_acm.tcl3 property script.

Figure 1380:

CFG OptiStruct 106 hexa (adhesive)
*filter seam
*style continuous 3
*head
rbe3 1 0
rigid 1 0
*body 0
hex8 1 1

OptiStruct cfast_elem (GA-GB)
Creates 1D CFAST element of type ELEM.

This realization also uses the prop_opt_nas_cfast.tcl5 property script.
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Figure 1381:

CFG optistruct 107 cfast_elem (GA-GB)
*filter spot
*head
*body 0
rod 7 1
*post prop_opt_nas_cfast.tcl
cfg_nastran_107_cfast

OptiStruct cfast_elem (GS)
Creates 0D CFAST element of type ELEM.

This realization also uses the prop_opt_nas_cfast.tcl5 property script.

Figure 1382:

CFG optistruct 108 cfast_elem (GS)
*filter spot
*head
*body 0
mass 23 0
*post prop_opt_nas_cfast.tcl
cfg_nastran_108_cfast

OptiStruct cfast_prop (GA-GB)
Creates 1D CFAST element of type PROP.

This realization also uses the prop_opt_nas_cfast.tcl5 property script.
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Figure 1383:

CFG optistruct 109 cfast_prop (GA-GB)
*filter spot
*head
*body 0
rod 7 1
*post prop_opt_nas_cfast.tcl

OptiStruct cfast_prop (GS)
Creates 0D CFAST element of type PROP.

This realization also uses the prop_opt_nas_cfast.tcl5 property script.

Figure 1384:

CFG optistruct 110 cfast_prop (GS)
*filter spot
*head
*body 0
mass 23 0
*post prop_opt_nas_cfast.tcl
cfg_nastran_110_cfast

OptiStruct HILOCK
Creates 1D elements that are constructed out of existing RBAR, CBAR, and CBUSH elements.
The outer extensions represent the thicknesses of the outer shell elements. The inner nodes of
the RBAR element are connected to the shell elements, whereas the inner nodes of the CBAR
elements are coincident to the shell nodes only. CBUSHes are created between the appropriate
connected and coincident nodes. Each outer node connects one CBAR and one RBAR. Each HLOCK
connection gets its own coordinate system which has a z-axis that is collinear to the HILOCK
direction. All affected nodes are assigned to the coordinate system. The coordinate system is
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taken into account for the DOF definition of the CBAR elements, for the stiffness calculation of the
CBUSH elements, and for the DOF of the node constraint.
This realization uses shell properties and materials (PSHELL or PCOMP) and a HILOCK material
that you select to calculate the exact position of the outer nodes and the stiffness of the PBUSH
elements.

This realization also uses the prop_opt_nas_hilock.tcl6 property script.
For a more detailed examination of the HiLock realization, refer to Special Realization Types.

Figure 1385:

CFG optistruct 111 HILOCK
*filter spot
*style fastener 1
*head
*bodyext 0
bar2 1 1
weld 1 1 dofs=1456
*body 0
spring 6 0 dofs=2356
bar2 1 1
weld 1 1 dofs=156
spring 6 0 dofs=2356
*post prop_opt_nas_hilock.tcl
cfg_optistruct_111_HiLock

OptiStruct clip (washer nodes)
Creates a single RBE2 element for the body. The element projects and connects to the nodes
which form the washer layer. The connector location can either be on the edge of the hole, center
of the hole, midpoint in between the two holes or on the second row of nodes which form the
washer layer.
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Figure 1386:

CFG optistruct 112 clip (washer nodes)
*filter bolt
*style bolt 12
*head
*body 0
rigidlink 1 1

OptiStruct bolt (step hole)
This realization creates a CBAR element for the bolt shaft, and connects to the solids' nodes with
numerous RBE2 based on the given bolt/hole parameters. It also, connects two solids through
holes, or it connects one solid through a hole with a solid blind hole.

This realization uses the prop_stepboltholes.tcl7 property script.

Figure 1387:

CFG optistruct 114 bolt (step hole)
*filter bolt
*style bolt 6
*head
rigidlink 1 1
*body 0
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bar2 1 1
*post prop_stepboltholes.tcl

OptiStruct bolt (threaded step hole)
Connects two solids through holes or connects one solid through a hole with a solid blind hole. A
thread length can be defined to define the dimensions of the rigid elements connecting the bolt
shaft models as a bar.

Figure 1388:

CFG optistruct 115 bolt (threaded step hole)
*filter bolt
*style bolt 7
*head
rigidlink 1 1
*body 0
bar2 1 1
*post prop_stepboltholes.tcl

OptiStruct adhesive-hemmings
This realization type is used for modeling roll hemmings, where the outer shell is bent around the
inner shell. The inner shell is connected to the outer shell on one side with simple hexa adhesive,
and the other side is connected with RBE2 elements. A definable orientation node decides which
side the hexa adhesive should be used. This seam realization type is capable of connecting three
layers that contains two components.
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Figure 1389:

CFG optistruct 116 adhesive-hemmings
*filter area
*style adhesive 3
*head
rbe3 1 0
*body 1
hex8 1 1
rigid 1 0
*post prop_nastran_acm.tcl

OptiStruct penta continuous (mig+L)
This realization supports Lap-joints and creates PENTA element for the body. Surrounding shell/
solid elements are projected and connected with RBE3 elements. This realization supports the
creation of PENTA elements on one side or on both sides of the joint, and provides a fitted/
equilateral option for the PENTA creation.
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Figure 1390:

CFG optistruct 117 penta (mig + L)
*filter seam
*style continuous_mig 1
*head
rbe3 1 0
*body 0
penta6 1 1

OptiStruct penta continuous (mig+T)
This realization supports T-joints and creates PENTA element for the body. Surrounding shell/solid
elements are projected and connected with RBE3 elements. This realization supports the creation
of PENTA elements on one side or on both sides of the joint, and provides a right-angled option.
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Figure 1391:

CFG optistruct 118 penta (mig + T)
*filter seam
*style continuous_mig 2
*head
rbe3 1 0
*body 0
penta6 1 1

OptiStruct penta continuous (mig+B)
This realization supports Butt-joints and creates PENTA element for the body. Surrounding shell/
solid elements are projected and connected with RBE3 elements. This realization supports the
creation of PENTA elements on one side or on both sides of the joint.

Figure 1392:

CFG optistruct 119 penta (mig + B)
*filter seam
*style continuous_mig 3
*head
rbe3 1 0
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*body 0
penta6 1 1

OptiStruct wagonwheel
This realization creates RBE2 elements for the body, and projects and connects to the hole edge
nodes with RBE3 elements.

Figure 1393:

CFG optistruct 120 wagonwheel
*filter bolt
*style bolt 0
*head
rbe3 1 0
*body 0
rigid 1 1
cfg_nastran_120_wagonwheel

OptiStruct adhesives
Creates a row of hexa/penta elements for the body and numerous RBE2/RBE3 elements for the
head. The head elements project and connect to the nodes of the adjoining shell elements. If
there is significant curvature in the area connector then penta elements will be created, otherwise
hexa elements will normally be created. If there is a direct normal project then an RBE2 elements
will be used, if there are only non-normal projections then RBE3 elements will be created.

This realization also uses the prop_nastran_acm.tcl3 property script.
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Figure 1394:

CFG optistruct 121 adhesives
*filter area
*style adhesive 1
*head
rbe3 1 0
rigid 1 0
*body 1
hex8 1 1
penta6 1 1
*post prop_nastran_acm.tcl
cfg_optistruct_121_adhesives_t1t22

OptiStruct hemming
Creates RBE3 elements for the body, the head elements project and connect to the nodes of the
adjoining shell elements.

Figure 1395:

CFG OptiStruct 122 hemming
*filter area
*style adhesive 1
*head
*body 0
rbe3 1 1
cfg_optistruct_122_hemming

OptiStruct CGAP(G)
This realizations creates a CGAP element for the body, which projects and connects to the
adjoining shell/solid nodes.
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Figure 1396:

CFG optistruct 123 CGAP(G)
*filter spot
*head
*body 0
gap 1 1
*post prop_opti_gap.tcl

This realization uses the prop_opti_gap.tcl property script.

OptiStruct bolt (collapse rigid)
This realization creates a single RBE2 element for the body. The element projects and connects to
the nodes of the adjoining shell/solid elements which form the hole.

Figure 1397:

CFG optistruct 124 bolt (collapse Rigid)
*filter bolt
*style bolt 14
*head
*body 0
rigidlink 1 12
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OptiStruct seam-quad LTB
Serves and realizes t-welds, lap-welds and butt-welds simultaneously. The weld type is identified
automatically based on the orientation of the links to each other.
The dimensions and property for all heat affected zones (HAZ) can be defined separately.
Normal directions of quad weld elements and HAZ elements can be controlled.
An edge treatment can be defined for t-welds and butt-welds to move the edge a precise distance
from the opposite link.
For more information, see seam-quad LTB.

Figure 1398: T-Weld Figure 1399: Lap-Weld

Figure 1400: Butt-Weld

CFG optistruct 128 seam-quad LTB
*filter seam
*style quad 7
*head
*body 0
quad4 1 1

OptiStruct seam-rigid LTB
Serves and realizes t-welds, lap-welds and butt-welds at the same time. The weld type is
identified automatically based on the orientation of the links to each other.
The dimensions and property for all heat affected zones (HAZ) can be defined separately.
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An edge treatment can be defined for t-welds and butt-welds to move the edge a precise distance
from the opposite link.
For more information, see seam-rigid LTB.

Figure 1401: T-Weld Figure 1402: Lap-Weld

Figure 1403: Butt-Weld

CFG optistruct 129 seam-rigid LTB
*filter seam
*style rigid 1
*head
*body 0
rigid 1 1

OptiStruct hexa (adhesive - shell gap)
This realization creates rows of HEXA elements for the body. The HEXA elements project and
connect to the adjoining shell/solid elements by touching them.

This realization uses the prop_opt_tie_contacts.tcl9 post script.
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Figure 1404:

CFG optistruct 138 hexa (adhesive - shell gap)
*filter seam
*style continuous 2
*head
*body 0
hex8 1 1
*post prop_opt_tie_contacts.tcl

OptiStruct hexa (spot tie)
Creates hexa elements between shell and/or solid elements in order to connect them using a tie
contact definition. The hexa element nodes will project and touch the shell and/or solid element
faces. During the realization, a default tie contact and referencing master and slave sets are
created; unless defined differently, the hexas are assigned a default property and material, and
are organized into a component with the same name base as the property.
The default tie contact and material parameters can be changed in the files below this path: ..
\Altair\2019\hm\scripts\connectors\Hexa_Tie\optistruct\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1405:

CFG optistruct 152 hexa (spot tie)
*filter spot
*style spot_tie 1
*head
*body 0
hex8 1 1

OptiStruct cbush (spot tie)
Creates bush (CBUSH) elements between shell and/or solid elements in order to connect them
using a tie contact definition. The bush element nodes will project and touch the shell and/or
solid element faces. During the realization, a default tie contact and referencing master and
slave sets are created; unless defined differently, the bushs are assigned a default property, and
are organized into a component with the same name base as the property. If no specific bush
coordinate system is defined, the bush elements are defined with a vector x1, x2, and x3 normal
to it.
The default tie contact and material parameters can be changed in the files below this path: ..
\Altair\2019\hm\scripts\connectors\Bush_Tie\optistruct\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1406:

CFG optistruct 153 cbush (spot tie)
*filter spot
*style spot_tie 2
*head
*body 0
spring 6 1

OptiStruct hexa (seam tie)
Creates hexa elements between shell and/or solid elements in order to connect them using a tie
contact definition. The hexa element nodes will project and touch the shell and/or solid element
faces. During the realization, a default tie contact and referencing master and slave sets are
created; unless defined differently, the hexas are assigned a default property and material, and
are organized into a component with the same name base as the property.
The default tie contact and material parameters can be changed in the files below this path: ..
\Altair\2019\hm\scripts\connectors\Hexa_Tie\optistruct\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1407:

CFG optistruct 154 hexa (seam tie)
*filter seam
*style seam_tie 1
*head
*body 0
hex8 1 1

OptiStruct hexa (area tie)
Creates hexa elements between shell and/or solid elements in order to connect them using a tie
contact definition. The hexa element nodes will project and touch the shell and/or solid element
faces. During the realization, a default tie contact and referencing master and slave sets are
created; unless defined differently, the hexas are assigned a default property and material, and
are organized into a component with the same name base as the property.
The default tie contact and material parameters can be changed in the files below this path: ..
\Altair\2019\hm\scripts\connectors\Hexa_Tie\optistruct\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1408:

CFG optistruct 155 hexa (area tie)
*filter area
*style area_tie 1
*head
*body 0
hex8 1 1

OptiStruct cbush (rigid)
Creates bush (CBUSH) elements between shell and/or solid elements in order to connect them
using rigid (RBE3) elements. The bush element nodes will project and touch the shell and/or
solid element faces. Unless defined differently, the bushs are assigned a default property, and
are organized into a component with the same name base as the property. If no specific bush
coordinate system is defined, the bush elements are defined with a vector x1, x2, and x3 normal
to it.
The default property parameters can be changed in the files below this path: ..\Altair\2019\hm
\scripts\connectors\Bush_Rigid\optistruct\.

Note:  IDs, names, and card type cannot be changed.
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Figure 1409:

CFG optistruct 156 cbush (rigid)
*filter spot
*style bush_rigid 1
*head
rbe3 1 0
*body 0
spring 6 1
os_ns_bush_rigid

Automatic Exclusion of Special Nodes During Rigid Bolt Realization
HyperMesh automatically excludes special nodes as potential slave nodes for any rigid bodies created
during bolt realization, even though they fall with the virtual Bolt Cylinder diameter. Nodes that are
referred in the constraints are considered special nodes.

Property Scripts
1. prop_hinge.tcl

This script is called while creation of HINGE– custom config welds in the connector bolts panel.
This script performs the tasks when the Systems option is active in the connector Bolt panel (such
as “Single System”,”1- System per layer” or 2- Systems per layer).

This Script Assigns both reference and analysis systems ID to weld element nodes of each Bolt
(Hinge) created during realization process.

2. prop_cylinder.tcl
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Used while creating bolt (cylinder rigid) and bolt (cylinder bar) in the Bolt panel (Abaqus, Nastran,
OptiStruct). It organizes the realized bolt elements into the respective components based upon
the*HEAD and the *BODYinformation of the bolt:

• A collector with the name Rigid_M<diameter> is created. This component contains all of the
rigid head elements and the rigid body elements, if available.

• A collector with the name Beam_M<diameter> is created. This component contains all of
the bar2 head elements, if available. This component then gets a property Beam_M assigned
(*BEAMSECTION or PBEAM).

3. prop_nastran_acm.tcl

This script is used in the Nastran and OptiStruct user profiles during the creation of the following
configurations:

• acm – equivalence/detached –(T1+T2)/2, and shell gap custom config welds in the Spot
panel,

• seam hexa adhesive and seam hexa (RBE2-RBE3) in the Seam panel, and

• Area adhesives in the Area panel.

The script performs the following tasks:

• Organizes the realized Solid Hexa weld elements created during realization process into
components with names based on the realization, such as solid_spot_acm_detached,
solid_seam_hexa_adhesive_shell_gap, or solid_area_hexa_adhesive_shell_gap. Components
and the connected RBE’s created as the *HEAD type are organized into components
using similar naming, such as rbe3_spot_acm_detached, rbe3_seam_hexa_adhesive, or
rbe3_area_hexa_adhesive.

• This script creates property collectors, again using names based on the realization
such as solid_spot_acm_detached, solid_seam_hexa_adhesive_shell_gap, or
solid_area_hexa_adhesive_shell_gap.

◦ These property collectors are created with the PSOLID card associated with them,
and are referenced in the above created components containing the Solid Hexa weld
elements.

• In addition, this script also updates the weights of any RBE3 that is almost zero, because
weight factors close to 0.0 cause Nastran and OptiStruct solvers to generate incorrect results.
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Note:  New components and properties will only be created if they do not already
exist; otherwise the existing components and properties are used. For this reason,
comps/props will not always follow the naming conventions given here, because
preexisting ones might already have different names.

Also, when creating realizations with a mid-thickness option, the naming conventions
include the presence of the mid-thickness. For example, when creating a hexa (RBE2-
RBE3) configuration using a mid-thickness option:

• Solid elements will be organized into a Component named solid_seam_
hexa_RBE2_RBE3_mid_thick

• RBE3 elements will be organized into a Component named rbe3_seam_
hexa_RBE2_RBE3_mid_thick

• RBE2 elements will be organized into a Component named rbe2_seam_
hexa_RBE2_RBE3_mid_thick

• Properties will be created with the name solid_seam_ hexa_RBE2_RBE3_mid_thick

• Materials will be created with the name solid_seam_ hexa_RBE2_RBE3_mid_thick

4. prop_cweld.tcl

This script is called while creation of all the CWELD GA-GB and GS– custom config welds in the
Spot panel. Theses include PARTPAT, ELPAT, ELEMID, GRIDID, ALIGN. It performs the following
tasks:

• Assigns the attributes to the CWELD weld element created during the realization process,
which is either a rod element [GA-GB] or mass Element [GS] of the types PARTPAT, ELPAT,
ELEMID, GRIDID or ALIGN.

• Creates the property collector with the name prop_<id> with the PWELD card associated with
it. This property is referenced to the CWELD element created during realization.

• This script also updates the weld radius value in the CWELD card. The diameter value is either
defined by you on the Spot panel, or is taken from the dvst (diameter versus thickness) file.

Note:  This script is called if the CWELD GA-GB and GS– custom config welds and shell
gap custom config welds across Nastran and OptiStruct user profiles.

5. prop_opt_nas_cfast.tcl

This script is called while creation of all the CFAST GA-GB and GS– custom config welds in the
Spot panel. Theses include ELEM, and PROP. It performs the following tasks:

• Assigns the attributes to the CFAST weld element created during the realization process,
which is either a rod element [GA-GB] or mass Element [GS] of the types ELEM or PROP.

• Creates the property collector with the name PFAST_<diameter> with the PFAST card
associated with it. This property is referenced to the CFAST element created during
realization.

• This script also updates the weld diameter value in the CFAST card. The diameter value is
either defined by you on the Spot panel, or is taken from the dvst (diameter versus thickness)
file.
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Note:  This script is called for the CFAST GA-GB and GS– custom config welds across
Nastran and OptiStruct user profiles.

6. prop_opt_nas_hilock.tcl

This script is used while creation of HILOCK custom config welds in the Spot panel from the
Nastran and OptiStruct user profile.

This script does the following tasks:

• Organizes the realized 1D weld elements (RBAR, CBAR, CBUSH) created during realization
process into a component named HiLock components.

• This script will create the following property collectors:

◦ HiLock_PBAR_<diameter>: This property collector is created with the PBAR card
associated with it. The RBAR elements reference to this property. The attributes are
calculated depending on the used diameter in the Spot panel during realization.

◦ HiLock_PBUSH_<translational stiffness>_<rotational stiffness>: These property
collectors are created with the PBUSH card associated with them. The CBUSH elements
reference to this property. The attributes are calculated depending on the HILOCK
material you select and the properties and materials of the connected shells (PSHELL
and/or PCOMP).

• This script will create the following load collector:

HiLock_SPC6
This load collector is created and the SPCs, which are created for each HiLock will be
moved into this collector.

• This script will create the following system collector:

HiLock
This system collector is created and the systems created during the realizations will be
moved into this collector. If the system collector exists already the new created systems
will be moved into the same collector.

• If a HiLock material is not chosen, a default material is created:

HiLock_MAT1
This material will be assigned to PBAR cards, and can be found in the following folder of
the installation directory: [hm_scripts_dir]/connectors/HiLock_Mats.
The predefined values are:

set E 1.8e+07

set G 4.7e+04

set NU 0.330

set RHO 8.9e-09

set A 1.7e-05.

Note:  This script is called if the realization CFG Nastran 111 HILOCK or CFG
OptiStruct 111 HILOCK is used.
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7. prop_stepboltholes.tcl

The script performs the following tasks:

• Organizes the CBAR elements into a component with the name HM_Bolt_CBAR.

• Organizes the RBE2 elements into a component with the name HM_Bolt_RBE2.

• Creates a property with the name HM_PBAR and assigns it the PBAR card image.

Note:  New components and properties will only be created if their are not any
components and properties with the same names that already exist; otherwise the
existing components and properties are used.

8. 2019

The script performs the following tasks:

• Organizes the CGAP elements into a component with the name Realize2001.

• Creates a property with the name PGapProp, and assigns the card image PGAP.

Note:  New components and properties will only be created if their are not any
components and properties with the same names that already exist; otherwise the
existing components and properties are used.

9. prop_opt_tie_contacts.tcl

The script performs the following tasks:

• Creates TIE interfaces (groups) with the name ADHESIVE_HEXA_TIE_CONTACT_PID _# and
the card image TIE. The groups reference the independent/dependent links' master sets and
the nodes' slave sets (# is the ID of the link components).

• Organizes the links' component elements into sets with the name
ADHESIVE_HEXA_MASTER_PART_SET_PID_# and the card image SET_ELEM. The sets are
referenced by the above interface groups (# is the ID of the link component).

• Organizes the solids‘ nodes on the links into sets with the name
ADHESIVE_HEXA_SLAVE_NODE_SET_PID _# and the card image SET_GRID. The sets are
referenced by the above interface groups (# is the ID of the link component).

• Creates components with the name ADHESIVE_HEXA_COMP_PID _#_# for the connector
SOLID elements (# is the ID of the link component).

• Creates properties with the name ADHESIVE_HEXA_PROP_PID_ #_# and the PSOLID
cardimage, and assigns them to respective SOLID components (# is the ID of the link
component).
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• Creates a material with the name ADHESIVE_HEXA_MAT_PID _#_# and the card image
MAT1, and assigns it to respective SOLID properties (# is the ID of the link component).

OptiStruct Non-Structural Mass Connector (NSM)

Description, Creation, and Realization:
HyperWorks Desktop handles non-structural masses for OptiStruct as group entities with a card image
NSM1 or NSML1 assigned to them. Whereas normally a connector creates a specific element construct
during realization, the NSM connector does not create any element. Instead, each NSM connector
receives one group with the appropriate NSM1 or NSML1 card assigned.

The non-structural mass connectors can be created and realized in the Apply Mass panel in the
Connectors module. The connector location is arbitrary and does not have any influence.

The created NSM connectors are listed in the Connector Browser in a folder named app_mass_ns.
The Mass column lists the lumped mass values corresponding to the appropriate NSM solver card the
connector is referenced to.

Note:  Even though the connector is referenced to one specific group, it does not recognize
whether this group is manually modified. This means that adding elements to the group will
not automatically lead to updated link definitions on the connector. In addition, editing the
lumped mass value on the NSM solver card is not synchronized with the connector mass.
Deleting the group causes the connector to become unrealized.

Updating the connector links would unrealize the connector. Then the appropriate group is deleted.

The groups created along the NSM connector realization are named as
nsm_group_<CE_ID>.nsm_group_<CE_ID>, and placed in the current include. A new component
named CE_Mass_inc_<include name> is created which contains all the connector information for
that include. Each include is meant to host its own CE_Mass_inc_<include name> component, and
HyperMesh will produce a warning if the component name already exists in a different include. This
helps ensure that unrealizing and rerealizing nsm connectors will keep the FE data in its original include.

The assigned NSM solver card can be of either the PROPERTY or ELEMENT type. This strongly depends
on the NSM entity type attribute, which is defined in the panel. The attribute used during creation is
written to the connector and is reused for a realization.

With these attributes you can define whether you want to create property- or element-based NSM
groups during connector realization. In certain cases, if the defined links cannot be referenced by
exclusive properties, a realization as property-based NSM group is not possible. In such cases the
connector fails, or can optionally be realized as an element-based NSM group.

Absorption
The absorption works on all different types like PSHELL, PCOMP, PBAR, PBARL, PBEAM, PBEAML,
PBCOMP and PROD.

During absorption the group definition is not modified. The connector is created in the center of a virtual
box bounding all referenced elements. Upon NSM absorption, connectors are created inside newly
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created components (CE_Mass_inc_<include name>), which are created in each include that holds nsm
entities.The absorbed connector contains the following information:

• Reference to a certain group

• Lumped mass value in the appropriate NSM solver card

• All elements listed in the NSM solver card. These elements are all defined somehow as connector
links. If possible, the single elements are condensed in component links.

PAM-CRASH 2G Connector Types
Supported PAM-CRASH 2G connector types and property scripts.

Connector Types
PAM-CRASH 2G plink (connector position)

Creates a PLINK element. The PLINK is created at the connector location.

This realization also uses the prop_plink.tcl1 property script.

Figure 1415:

CFG pamcrash2g 1 plink (connector position)
*filter spot
*head
*body 0
mass 5 2
*post prop_plink.tcl

PAM-CRASH 2G plink (middle of the gap)
Creates a PLINK element. The PLINK is created at the center location between the two
components and is offset from the connector location.

This realization also uses the prop_plink.tcl1 property script.
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Figure 1416:

CFG pamcrash2g 2 plink (middle of the gap)
*filter spot
*head
*body 0
mass 5 1
*post prop_plink.tcl

PAM-CRASH 2G bolt (spider)
Creates an RBODY element. The body element projects and connect to the nodes of the adjoining
shell elements.

Figure 1417:

CFG pamcrash2g 54 bolt (spider)
*filter bolt
*style bolt 1
*head
*body 0
rigidlink 1 1

PAM-CRASH 2G link
Creates LLINK elements. The LLINK elements are created along the line connector.
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Figure 1418:

CFG pamcrash2g 55 llink
*filter seam
*style parallel 1
*head
*body 0
rod 5 1
*post prop_llink.tcl

PAM-CRASH 2G adhesives(contact)
This realization creates rows of HEXA and PENTA elements for the body. The HEXA and PENTA
elements project and connect to the adjoining shell/solid elements by touching them.

The realization uses the prop_pam_rad_adhesives.tcl2 property script.

Figure 1419:

CFG pamcrash2g 56 adhesives (contact)
*filter area
*style adhesive 1
*head
*body 1
hex8 1 1
penta6 1 1
*post prop_pam_rad_adhesives.tcl

PAM-CRASH 2G hexa (adhesive-shell gap)
Creates a row of hexa elements for the body. The hexa elements are projected so that they touch
the elements of the connecting components.

This realization uses the prop_acm_adhesives.tcl3 property script.
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Figure 1420:

CFG pamcrash2g 57 hexa (adhesive - shell gap) 
*filter seam
*style continuous 2
*head
*body 0
hex8 1 1
*post prop_pam_adhesives.tcl

PAM-CRASH 2G hexa (adhesive)
Creates a row of hexa elements for the body and numerous RBE2/RBE3 elements for the head.
The head elements project and connect to the nodes of the adjoining elements. If there is a direct
normal project then RBE2 element will be created, if there are only non-normal projections then
RBE3 elements will be created. The hexa elements are projected so that they touch the elements
of the connecting components.

Figure 1421:

CFG pamcrash2g 58 hexa (adhesive)
*filter seam
*style continuous 3
*head
rbe3 1 0
rigid 1 0
*body 0
hex8 1 1

PAM-CRASH 2G hexa (tapered T)
Intended to be used for t-cases. The size and exact position can be defined thickness dependent,
or the exact dimension and position parameters can be given.
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Figure 1422:

CFG pamcrash2g 105 hexa (tapered T)
*filter seam
*style continuous 6
*head
*body 0
hex8 1 1

Property Scripts
1. prop_plink.tcl

This script is called while creation of PLINK– custom config welds in the Spot panel inside PAM-
CRASH 2G user interface.

This script does the following tasks:

• Organizes the PLINK weld elements created during realization process into
C_PLINK_PSCRIPT_<id1_id2> component with the PART_LINK card image associated to
it. The id1 and id2 shown above refers to the ids of the link components with which the
connector is connected to.

• Creates the M_PLINK_PSCRIPT_<id1_id2> material collector, with the MAT_LINK card image
associated with it. This material collector is referenced in the above created component
containing the PLINK weld elements.

• Updates the various attributes to the above created material/ property cards.

2. prop_pam_rad_adhesives.tcl

The script performs the following tasks:

• Creates TYPE2 interfaces (groups) with the names ADHESIVES_CONTACTS_PID_=_#, which
reference the independent/dependent links' master sets, and the nodes' slave sets (# is the
ID of the links).

• Organizes the link entities (components, and so on) into sets with the names
MASTER_PART_SET_PID, which in turn are referenced by the above interface groups (# is the
ID of the link entity).
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• Organizes the solids' nodes on links into sets with the names SLAVE_NODE_SET_PID_=_#,
which in turn are referenced by the above interface groups (# is the ID of the link entity).

• Creates and assigns a property with the name Adhesive_Solid_Property and the card image
P43_CONNECT to the solid component.

• Creates and assigns a material with the name Adhesive_Solid_Material and card image
M59_CONNECT to the solid component.

• Creates a Failure Model with the name Failure_CONNECT_# and card image
FAIL_CONNECT. The curves Adhesive_Solid_Material_YsvsNormalElong and
Adhesive_Solid_Material_YsvsTangentialElong are required for the material definition.

Note:  For Radioss versions less than Block100 (Block51 and Block90), HyperMesh
creates a property definition with the P14_SOLID card image, and a material definition
with the M1_ELAS card image.

3. prop_acm_adhesives.tcl

The script performs the following tasks:

• Organizes the HEXA elements and nodes into a component with the name ADHESIVES_#_@
(# is the entity ID of the independent link and @ is the entity ID of the dependent link).

• Creates groups with the names ADHESIVES_CONTACTS_PID_=_#, which reference the
independent/dependent links' master sets and the nodes' slave sets (# is the ID of the links).

• Organizes the link entities (components, and so on) into a set with the
name MASTER_PART_SET_PID_=_#_parts, which is referenced by set
MASTER_PART_SET_PID_=_#, which in turn is referenced by above link group (# is the ID of
the link entity).

• Organizes the solids' nodes on links into a set with the name
SLAVE_NODE_SET_PID_=_#_nodes, which is referenced by the set
SLAVE_NODE_SET_PID_=_#, which in turn is referenced by the above link group (# is the ID
of the link entity).

Note:  The names of the dependent links node sets are SLAVE NODE SET
PID_=_#_nodes and SLAVE NODE SET PID_=_#.

Radioss Connector Types
Supported Radioss connector types and property scripts.

Connector Types
Radioss type2 (spring)

Creates a SPRING2N element for the body and plot elements for the head, the plot elements are
created for visualization purposes and find operations.

This realization also uses the prop_type2.tcl1 property script.
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Figure 1423:

CFG radioss 2 type2 (spring)
*filter spot
*head
plot 1 0
*body 0
spring 1 1
*post prop_type2.tcl

Radioss bolt (general)
Creates RBODY elements for the head and SPRING2N body. The head elements project and
connect to the nodes of the adjoining shell elements which form the hole. The connector location
can either be on the edge of the hole, center of the hole, midpoint in between the two holes or on
the second row of nodes which form the washer layer.

This realization also the prop_radioss_rigidupdate.tcl2 property script.

Figure 1424:

CFG radioss 52 bolt (general)
*filter bolt
*style bolt 0
*head
rigidlink 1 10
*body 0
spring 1 1
*post prop_radioss_rigidupdate.tcl

Radioss hinge
Creates RBODY elements for the head and SPRING2N body. The rot x degree of freedom is
released so that the RBODY can rotate. The head elements project and connect to the nodes of
the adjoining shell elements which form the hole. The connector location can either be on the
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edge of the hole, center of the hole, midpoint in between the two holes or on the second row of
nodes which form the washer layer.

This realization also the prop_radioss_rigidupdate.tcl2 property script.

Figure 1425:

CFG radioss 53 hinge
*filter bolt
*style bolt 0
*head
rigidlink 1 10
*body 0
spring 1 1 dofs=4
*post prop_radioss_rigidupdate.tcl

Radioss bolt (spider)
Creates an RBODY element. The element projects and connect to the nodes of the adjoining
shell elements which form the hole, the RBODY element is joined at the midpoint of the bolted
connection. The connector location can either be on the edge of the hole, center of the hole,
midpoint in between the two holes or on the second row of nodes which form the washer layer.

This realization also the prop_radioss_rigidupdate.tcl2 property script.

Figure 1426:

CFG radioss 54 bolt (spider)
*filter bolt
*style bolt 1
*head
*body 0
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rigidlink 1 1
*post prop_radioss_rigidupdate.tcl

Radioss bolt (cylinder rigid)
Creates an RBODY element. Please reference “Cylinder Bolt” help for further details.

This realization also the prop_radioss_rigidupdate.tcl2 property script.

Figure 1427:

CFG radioss 60 bolt (cylinder rigid)
*filter bolt
*style bolt 3
*head
*body 0
rigidlink 1 1
*post prop_radioss_rigidupdate.tcl

Radioss bolt (cylinder spring)
Creates an RBODY elements and a zero length SPRING2N element. Please reference “Cylinder
Bolt” help for further details.
The Radioss bolt (cylinder spring) exists in exactly the same configuration with the following
additional names:

• HC deformable cylinder bolt

• HC deformable cylinder clip

This is in order to keep the realization names from HyperCrash.

This realization also the prop_radioss_rigidupdate.tcl2 property script.

Figure 1428:

CFG radioss 61 bolt (cylinder spring)
*filter bolt
*style bolt 3
*head
rigidlink 1 1
*body 0
spring 1 1
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*post prop_radioss_rigidupdate.tcl

Radioss type2 (adhesive-spring)
Creates multiple SPRING2N elements for the body and plot elements for the head, the plot
elements are created for visualization purposes and find operations.

This realization also uses the prop_type2.tcl1 property script.

Figure 1429:

CFG radioss 62 type2 (adhesive-spring)
*filter area
*head
plot 1 0
*body 0
spring 1 1
*post prop_type2.tcl

Radioss rigidlnk (midnode)
Creates an RBODY with the independent node located in the middle between the two parts.
Both parts are connected to the RBODY via independent nodes. The needed sets are created
automatically.

Figure 1430:

CFG radioss 63 rigidlnk (midnode)
*filter spot
*style mpc 2
*head
*body 0
rigid 1 1
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Radioss HC cylinder rigid bolt
This realization creates a single RBE2 for the body, and projects and connects the element to
nodes of the adjoining shell/solid within the prescribed cylinder diameter, L1 (cylinder height
along the vector from the connector location) and L2 (cylinder height in the opposite direction of
the vector from the connector location).

The realization uses the prop_radioss_rigidbolts.tcl3 property script.

Figure 1431:

CFG radioss 64 HC cylinder rigid bolt
*filter bolt
*style bolt 4
*head
*body 0
rigidlink 1 1
*post prop_radioss_rigidbolts.tcl

Radioss HC cylinder spring bolt
This realization creates a SPRING element for the body, and projects and connects the element
to nodes of the adjoining shell/solid elements with RBE2 elements within the prescribed cylinder
diameter, L1 (cylinder height along the vector from the connector location) and L2 (cylinder height
in the opposite direction of the vector from the connector location).

The realization uses the prop_radioss_rigidbolts.tcl3 property script.

Figure 1432:

CFG radioss 65 HC cylinder spring bolt
*filter bolt
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*style bolt 4
*head
rigidlink 1 1
*body 0
spring 1 1
*post prop_radioss_rigidbolts.tcl

Radioss type2 (spring multiple row)
Creates a certain pattern of SPRING2N elements.

Figure 1433:

CFG radioss 66 type2(spring multiple row)
*filter seam
*style continuous 4
*head
*body 0
spring 1 0
*post prop_type2radioss.tcl

Radioss type2 (spring single row)
Creates a certain pattern of SPRING2N elements.

Figure 1434:

CFG radioss 67 type2(spring single row)
*filter seam
*style continuous 4
*head
*body 0
spring 1 0
*post prop_type2radioss.tcl
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Radioss bolt (2 cylinder rigid)
Creates a RBODY per part with the center nodes connected to the SPRING2N element.
Which nodes belong to the RBODY is determined with a defined cylinder volume. If a hole per
part can be found in the defined cylinder, only the nodes of the holes are connected. Otherwise all
nodes in the cylinder belong to the RBODY element (per part).

Figure 1435:

CFG radioss 68 bolt (2 cylinder rigid)
*filter bolt
*style bolt 5
*head
rigidlink 1 1
*body 0
spring 1 1
*post prop_boltsradioss.tcl

Radioss HC hexa spotweld
This realization creates various configurations of hexas for the body, and the hexas project and
connect to the adjoining shell/solid elements by touching the shell/solid elements.

This realization uses the prop_radiosshexa.tcl4 property script.

Figure 1436:

CFG radioss 69 HC hexa spotweld
*filter spot
*head
*body 0
hex8 1 1
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*post prop_radiosshexa.tcl

Radioss adhesive(contacts)
This realization creates rows of HEXA and PENTA elements for the body. The HEXA and PENTA
elements project and connect to the adjoining shell/solid elements by touching them.

This realization uses the prop_pam_rad_adhesives.tcl5 property script the
HC_HexaAdhesive.rad config file.

Figure 1437:

CFG radioss 70 adhesive(contact)
*filter area
*style adhesive 1
*head
*body 1
hex8 1 1
penta6 1 1
*post prop_pam_rad_adhesives.tcl

Radioss acm(shell gap contact and coating)
This realization creates hexa clusters between shell components. Contacts get defined between
the shell components and the appropriate hexa nodes. A heat affected zone for the shells from
ultra high strength steel material is created.

This realization uses the prop_rad_acm_shellgapcoating.tcl6 property script and the
uhss_washersolid_matprop.rad config file.
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CFG radioss 71 acm (shell gap contact + coating)
*filter spot
*style acm 5
*body 0
hex8 1 1
*post prop_rad_acm_shellgapcoating.tcl

Radioss hexa(adhesive - shell gap)
This realization creates rows of HEXA elements for the body. The HEXA elements project and
connect to the adjoining shell/solid elements by touching them.

This realization uses the prop_pam_rad_adhesives.tcl5 property script and the
HC_HexaAdhesive.rad config file.

Figure 1439:

CFG radioss 72 hexa (adhesive - shell gap)
*filter seam
*style continuous 2
*head
*body 0
hex8 1 1
*post prop_pam_rad_adhesives.tcl
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Radioss hexa (tapered T)
Intended to be used for t-cases. The size and exact position can be defined thickness dependent,
or the exact dimension and position parameters can be given.

Figure 1440:
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CFG radioss 105 hexa (tapered T)
*filter seam
*style continuous 6
*head
*body 0
hex8 1 1

Automatic Exclusion of Special Nodes During Rigid Bolt Realization
HyperMesh automatically excludes special nodes as potential slave nodes for any rigid bodies created
during bolt realization, even though they fall with the virtual Bolt Cylinder diameter. Nodes that are
shared by the following entities are considered special nodes:

• rigid links

• Rigids

• Rbe3 nodes

• boundaries condition

• IMPDISP

• IMPVEL

• IBVEL

• IMPACC

• FXBODY

• Nodes inside the Interfaces with Type2

Property Scripts
1. prop_type2.tcl

This script is used while creation of RADIOSS [Type2 Spring] in the Spot panel.

This script does the following tasks:
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• Organizes the realized weld elements to the respective components based upon the link they
are connected to. For example, if a weld is created between comp_1(1) and comp_2(2) it
creates a component collector with the name RW^^_<id1_id2> and organizes all the welds
created as links between these two components into this collector.

• Creates the following properties collectors:

RW^^_<id1_id2>
This property collector (with the P13_SPR_BEAM in case of R-BLOCK and SectBemSpr in
case of R-FIX solver subtype) is associated with it as the card image.

• Creates sets in the following order:

I1_M_<id1_id2>
This contains the master as the FIRST link component ID to which the weld is
connected to.
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I1_S_<id1_id2>
This set contains the node ID of the projected spring element to the above component
link as the slave node N1.

I2_M_<id1_id2>
This contains the master as the SECOND link component ID to which the weld is
connected to.

I2_S_<id1_id2>
This set contains the node ID of the projected spring element to the above component
link as the slave node N2.

• Creates two interfaces Groups (interfaces) for the spring weld elements created between the
same component links by the name

RW^^1_<id1_id2>
This references the above created sets that contain the ids of first node NI and first
component Link C1.

RW^^1_<id1_id2>
This references the above created sets that contain the ids of second node N2 and
second component Link C2.

• Creates a plot named Shear_Normal_Force_Plot with two curves from the Normal Force
Function [named RW^^FN_1.0] and Shear Force Function [named RW^^FS_2.5], the values
of which are read from the Radiossweld_config.ini file.

2. prop_radioss_rigidupdate.tcl

This script is run for all the rigid/rigidlink weld configurations in the Radioss user profile. It creates
the sets of all the slave node ids of the rbodies created during the realization process, and assigns
the GRNOD card image to them. It also updates some attributes of these cards.

3. prop_radioss_rigidbolts.tcl

The script performs the following tasks:

• Organizes the SPRING element into a component with the name HM_Bolt_SPRING.

• Organizes the RBE2 elements into a component with the name Realize#001 (# is a number
starting with 2 and increments as 2, 4, 6, and so on).
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• Creates a view with the name radioss_rigid_bolts.

Note:  A new component HM_Bolt_SPRING will only be created if their is not a
component with the same name that already exists; otherwise the existing component
will be used.

4. prop_radiosshexa.tcl

The script performs the following tasks:

• Organizes the hexas into a component with the name Realize_#001 (# is a number starting 
with 2 and incrementing as 2, 4, 6 for every new component).
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4. prop_pam_rad_adhesives.tcl

The script performs the following tasks:

• Creates TYPE2 interfaces (groups) with the names ADHESIVES_CONTACTS_PID_=_#, which 
reference the independent/dependent links' master sets, and the nodes' slave sets (# is the 
ID of the links).

• Organizes the link entities (components, and so on) into sets with the names
MASTER_PART_SET_PID, which in turn are referenced by the above interface groups (# is the 
ID of the link entity).

• Organizes the solids' nodes on links into sets with the names SLAVE_NODE_SET_PID_=_#, 
which in turn are referenced by the above interface groups (# is the ID of the link entity).

• Creates and assigns a property with the name Adhesive_Solid_Property and the card image 
P43_CONNECT to the solid component.

• Creates and assigns a material with the name Adhesive_Solid_Material and card image 
M59_CONNECT to the solid component.

• Creates a Failure Model with the name Failure_CONNECT_# and card image
FAIL_CONNECT. The curves Adhesive_Solid_Material_YsvsNormalElong and
Adhesive_Solid_Material_YsvsTangentialElong are required for the material definition.

Note:  For Radioss versions less than Block100 (Block51 and Block90), HyperMesh
creates a property definition with the P14_SOLID card image, and a material definition
with the M1_ELAS card image.

6. prop_rad_acm_shellgapcoating.tcl

This script performs the following tasks:

• For each connected link the contact /inter/TYPE2/ gets created and is named
TYPE2_CONTACT_PID_<link ID>. The following sets are created and referenced.

MASTERPART_SET_PID_<link ID>
In this set, which is referenced as the master by the above mentioned contact, the link
entities like the component get organized.

SLAVENODE_SET_PID_<link ID>
In this set, which is referenced as the slave by the above mentioned contact, the hexa
nodes projecting onto the master entities get organized.
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• For each link combination the hexa clusters are organized into separate components and
named RAD_SOLID_SPOTWELD_PID_<link1 ID>_<link2 ID>. All components are assigned
the following material and property:

RAD_SOLID_SPOTWELD_DEFAULT_MAT.
This material is defined as /MAT/LAW59/.

RAD_SOLID_SPOTWELD_DEFAULT_PROP
This property is defined as /PROP/CONNECT/.

The default values are read from uhss_washersolid_matprop.rad in the installation.
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• The heat affected zone elements (washer) are organized into one separate component for
each link from the ultra high strength steel material and named RAD_WASHER_PID_<link
ID>. All components are assigned the following material and property:

RAD_WASHER_MAT
This material is defined as /MAT/PLAS_JOHNS/.

RAD_WASHER_PROP
This property is defined as /PROP/SHELL/.

The material and property values are read from uhss_washersolid_matprop.rad in the
installation.
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Autopitch
Create weld points at a predefined pitch distance so that the model build process can continue without
the need to wait for the published weld data from CAD.

Figure 1441:
Starting with a CAD model, the Autopitch tool creates unrealized connectors (yellow) which are then realized via the Spot panel.
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1. From the menu bar, click Connectors > Create > Autopitch.
The Autopitch dialog opens.

2. Using the Components selector, select the components to automatically add connectors to.

All selected components receive connectors with the same qualities to help you perform a
blanket application of connectors-using the same pitch-to all components that need them as a
single operation. Be wary of simply selecting the whole model, however, as this could result in
undesirable actions, such as adding welds to a cars tires.

3. To use shell meshes that enclose a volume (some small gaps are allowed) as input, enable the
Consider closed shell thin solids checkbox.

For example, the outer skin of a solid part can be shell meshed and used as input to create
connectors. Standard mid-plane meshes are also still considered when this option is used.

4. To create connectors in the middle of the found flanges, enable the Create in middle checkbox.

By default, connectors are created on either one of the flanges. This applies to both mid-plane and
closed shell thin solid inputs, when appropriate.

5. Define settings.

a) In the Search distance field, enter the distance to consider between components.

b) In the Spot pitch distance field, enter the distance between each connector.

c) In the Spot pitch end offset field, enter the distance from the end of an edge/flange to the
connector.

d) In the Distance from free edge field, enter the distance from the free edge to the
connector.

e) In the Feature angle field, enter the angle used to segregate the model into faces that are
planar within its specified value.

f) In the Max deviation from avg dist (%) field, enter the average distance that can be
calculated based on the estimation that the distance between two flanges does not change
too much in the areas where connectors should be placed.

If the distance at the position where a connector is planned exceeds the given deviating
value, no connector will be created at that position.

This segregation is used to identify where autopitch connectors are placed. For example,
faces found to have significant topological complexity are not used to create autopitch
connectors.
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Note:  By reducing its value, the complexity of some of these faces is generally
reduced. Of course, flat regions are unaffected by the parameter.

6. Click create.

The created output is a series of connectors with the appropriate pitch distance and other associated
parameters. These connectors are in the unrealized state, thereby allowing the connector to be realized
to a configured state.

The output is organized in the current component collector. If there is no current component collector,
then a new collector called ^autopitch is created.
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Figure 1442:
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Create Connector Realizations using the FEMSITE
Utility
Create specialized connector realization types which can be used in fatigue calculations with the third
party FEMSITE tool.

In HyperMesh, use the FEMSITE utility to preprocess models and submit connection information to the
FEMSITE generator.

Setup the FEMSITE Utility
Use the third party FEMSITE utility to preprocess models and submit connection information to the
FEMSITE generator.

The FEMSITE options will only appear if you have an installation of FEMSITE on your computer.

Restriction:  The FEMSITE utility is only available in the Nastran user profile for Windows
and Linux platforms.

Add the hmfemsite.ini initialization file to one of the following locations:

HyperMesh searches all locations for the hmfemsite.ini file in the order listed above, and uses the last
found existing file to parse the variables pointing to your FEMSITE installation.

• $INSTALL_HOME/hm/bin/win64/hmfemsite.ini (win64 or linux64)

• HW_CONFIG_PATH/hmfemsite.ini

• $HOME/hmfemsite.ini

• $WORKING_DIR/hmfemsite.ini

Example hmfemsite.ini File

Lines that do not contain the strings FEMSITE_DATA_DIR=, FEMSITE_LINUX_DATA_DIR=,
FEMSITE_EXE=, or FEMSITE_LINUX_EXE= will be ignored, and can be treated as a comment. If
HyperMesh does not locate the FEMSITE exe or the data directory, the FEMSITE options will not
load.

Welds need to have a minimum amount of metadata in order to be realized within FEMSITE.
The Define Spotweld, Define Robscan, and Define Rivet options in the FEMSITE utility allow the
assignment of this metadata from within HyperMesh (instead of via CONN file) for spotwelds,
Robscans and Rivets.

This file can be edited to point Hypermesh to the FEMSITE installation:
This is the path to the FEMSITE data directory:
FEMSITE_DATA_DIR=W:\FEMSITE\installfemsite31\src\BOTH\english
FEMSITE_LINUX_DATA_DIR=W:\FEMSITE\installfemsite31\src\BOTH\english

This is the path to the executable:
FEMSITE_EXE=W:\FEMSITE\installfemsite31\src\BOTH\english\femsite_swv31.exe
This is the path to the executable:

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2413

FEMSITE_LINUX_EXE=/apps/FEMSITE/femsite_swv31

Define Spotwelds
Define a spotweld with the FEMSITE utility ensures that you will be able to create a FEMSITE spotweld
within HyperMesh, and assign the proper metadata to the connector for successful realization.

Before you begin, Setup the FEMSITE Utility.

1. From the menu bar, click Connectors > FEMSITE > Define Spotweld.
The Create Spotweld Connectors Interactive dialog opens.

2. Using the Select Connectors selector, select input.

• Choose Nodes to create new connectors with nodes.

• Choose Connectors to change existing connectors to FEMSITE connectors.

3. In the Element Label field, enter a label to be used in FEMSITE.

4. In the Property ID field, enter an ID to be sent to the FEMSITE executable.

5. In the Nugget Diameter field, enter a diameter to be sent to the FEMSITE executable.

6. Define part search parameters.

a) For RefMode, choose to use the Property or Part ID as the reference mode for connector
assignment.

b) Using the Select Components selector, select the components that contain the parts to
search.
The RefList field lists the assigned IDs that are found after components are selected.

c) In the Max number of interactions field, enter the maximum number of connector links to
create.

d) In the Maximum distance field, enter the search tolerance the FEMSITE executable should
use for realization.

7. Click Define.

Define Robscan Weld
Defining a robscan weld with the FEMSITE utility.

Before you begin, Setup the FEMSITE Utility.

1. From the menu bar, click Connectors > FEMSITE > Define Robscan.
The Rob Scan Data dialog opens.

2. Using the Select Connectors selector, select input.

• Choose Nodes to select a node location as input.

• Choose Connectors to select an exiting connector, for example a connector imported from a
connector file.

3. In the Property ID field, enter an ID to be sent to the FEMSITE executable.
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4. Select a weld pattern.
The values in the Width, Length, Seam Width, and Gap Size fields are populated after a Weld
Pattern has been selected.

5. Define part search parameters.

a) For RefMode, choose to use the Property or Part ID as the reference mode for connector
assignment.

b) Using the Select Components selector, select the components that contain the parts to
search.
The RefList field lists the assigned IDs that are found after components are selected.

c) In the Max number of interactions field, enter the maximum number of connector links to
create.

d) In the Maximum distance field, enter the search tolerance the FEMSITE executable should
use for realization.

6. Define the orientation of the weld.

a) In the Pattern Orientation Vector (X) fields, enter the triad (x,y,x) and orientation angle.

b) To reverse both direction inputs, enable the Invert robscan direction (Z) checkbox.

c) To reverse the pattern orientation, enable the Invert pattern Orientation checkbox.

d) To preview the orientation of the weld, click ?.

7. Click Define.

Define Rivets
Define a rivet configuration with the FEMSITE utility.

Before you begin, Setup the FEMSITE Utility.

1. From the menu bar, click Connectors > FEMSITE > Define Rivet.
The Self Piercing Rivet Data dialog opens.

2. Using the Select Connectors selector, select input.

3. Define the rivet and die.

a) For Rivet, select a Label.
The values in the Shaft Diameter, Head Diameter, Length, Hardness, and Geometry fields are
dependent on the Label selected.

b) For Die, select a Label.
The values in the Diameter and Depth field are dependent on the Label selected.

4. Define part search parameters.

a) For RefMode, choose to use the Property or Part ID as the reference mode for connector
assignment.

b) Using the Select Components selector, select the components that contain the parts to
search.
The RefList field lists the assigned IDs that are found after components are selected.

c) In the Max number of interactions field, enter the maximum number of connector links to
create.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Connectors p.2415

d) In the Maximum distance field, enter the search tolerance the FEMSITE executable should
use for realization.

5. To reverse the default direction input, enable the Invert Rivet Direction checkbox.

The rivet direction is defined by the normal of the shells.

6. Click Define.

Import Metadata and Connectors from a *.conn File
Import metadata and connectors from a *.conn file with the FEMSITE utility.

Before you begin:

• Setup the FEMSITE Utility

• Properly format and define connectors and metadata in the *.conn file. For more information, refer
to Required *.conn File Format and Guidelines.

, .

You do not need to import a FE model into HyperMesh prior to importing a *.conn file.

1. From the menu bar, click Connectors > FEMSITE > Import CONN.

2. In the Select conn-File dialog, open the *.conn file.
The connectors and metadata that are correctly and completely defined are imported and
translated to a XML connector format.

3. If there were unsupported or incorrectly defined connectors, the Editor dialog opens, from which
you can save these connectors in a separate file by clicking Save.

Note:  You can add this information again during export.

Required *.conn File Format and Guidelines
In order for *.conn files to be successfully imported, they must be properly formatted, and connectors
and metadata must be properly defined.

• The separator must be a semicolon.

• The line containing the definition and description of the Format (content of the columns) must start
with the type of connector, and must have 25 entries.

• Lines with a "&" can only be used within a connector definition.

• Connector IDs must be higher than 10,000, and can only have a maximum of 5 digits.

• Supported connector types: spotwelds, weldlines, and bondlines.

• Supported methods: RS1, SN, LASER, FILLER, MIGMAG, BL_ST, and BL_SR.

• The following options must be specified for the supported connectors: first dimension of tangent,
second dimension of tangent, and dimension of normal vector.
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• A reference mode must be specified: Part-ID or property-ID. The reference mode defines which
components or property IDs are connected.

• The x, y, and z position, and the tangent and normal vector must be defined.

• Only 2 parts are allowed for spotwelds and weldlines.

• Parts must exist in the model.

• MAX_NUMB_CONN_PARTS must be defined for spotweld connectors that have a reference mode of
AUTO.

• SELF_PIERCING* must be defined for spotweld connectors that have PROC=SN.

• ROB_SCAN_SEAM_WIDTH, ORIENTATION_ANGLE, and GAPSIZE must be defined for spotweld
connectors that have PROC=ROBSCAN.

• MAXIMUM_DISTANCE must be defined for spotweld, weldline, and bondline connectors.

• ADJUST_LIMIT must be defined for spotweld, weldline, and bondline connectors.

• POSITION_IN_PART_TREE must be defined.

• WELD_POSITION_ID and WELD_ANGLE must be defined for weldline connectors.

If *.conn files are missing important parameters, the following attributes are set:

• TYPE is set to spotweld (for spotwelds) or bondlines (for seamwelds).

• JEID is set to the ID of the connector in HyperMesh.

• PROC is set to 21 (for spotwelds) or bl (for seamwelds).

• REFMODE is set to PROPERTY.

• TAN_DIM1 is set to 5.0.

The internal HyperMesh parameter ce_diameter is synchronized with TAN_DIM1 during import. This
parameter is used for realization in HyperMesh (diameter).

Import PART/PID Mapping Files
Import PART/PID mapping *.csv files generated by the BOM tool into the FEMSITE utility,

Before you begin, Setup the FEMSITE Utility.

This function is used with tailored blanks, where one part consists of several property IDs. REFMODE is
set to PROPERTY when referencing two properties, or it is set to PART when referencing parts.

For every PID, there is a corresponding component which is used to reference a connector. For every
PART, there is a corresponding assembly which is used to reference a connector.

The mapping of components/assemblies (PID/PART) can be done using an external file. The external file
specifies the assembly structure in HyperMesh.

A2126120114;QUERTRAEGER UNTER FAHRERSITZ VO LI;26120114;Shell  ;1700200;HT700T;Stahl
 EN 10336-  HT700T +ZE+A+O;1,50;;;;;;;;;;;;Stahl EN 10336-  HT700T +ZE+A
+O;1,5;;;;;;;;;;;;
A2126160516;VERSTAERKUNG LI VO HPT.BODEN;26160516;Shell  ;1100500;HC340LA;Stahl
 HC340LA EN10268-1.0548+ZE+A+O / DBL:4062.51;1,00;;;;;;;;;;;;Stahl HC340LA
 EN10268-1.0548+ZE+A+O / DBL:4062.51;1;;;;;;;;;;;;
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A2126160716;VERSTAERKUNG HI LI / HAUPTBODEN;26160716;Shell  ;1100500;HC340LA;Stahl
 HC340LA EN10268-1.0548+ZE+A+O / DBL:4062.51;1,00;;;;;;;;;;;;Stahl HC340LA
 EN10268-1.0548+ZE+A+O / DBL:4062.51;1;;;;;;;;;;;;

1. From the menu bar, click Connectors > FEMSITE > Import PART/PID mapping.

2. In the Select Part/Property File dialog, open the *.csv file.
Only the parts that are correctly and completely defined are imported.

3. If there were parts that could not be converted, the Editor dialog opens, from which you can
save these parts in a separate file by clicking Save.

Note:  You can add this information again during export.

Export Connector Data
Connector data that has been imported or defined in HyperMesh can be exported to *.conn files.

Before you begin, Setup the FEMSITE Utility.

1. From the menu bar, click Connectors > FEMSITE > Export CONN.

2. In the Select conn-File dialog, save the *.conn file to your working directory.

The supported connector information and the unsupported connector information that you saved during
import is converted to CONN format and exported to a *.conn file.

Filter Connectors using Metadata
Filter connectors in the modeling window based on metadata using the FEMSITE Filter tool.

Before you begin, Setup the FEMSITE Utility.

1. From the menu bar, click Connectors > FEMSITE > Filter.
2. In the Filter connectors dialog, define connector criteria accordingly.

3. Click Submit.

Connectors that do not meet the filter criteria are masked in the modeling window.

Check Connector Connections
Check if the connection partners of connectors are available in the HyperMesh database.

Before you begin, Setup the FEMSITE Utility.

From the menu bar, click Connectors > FEMSITE > Check Connected.

After a check is performed, the number of connectors that have no existing connector partners in the
HyperMesh database is reported, and failed connectors are displayed.

There is no geometrical check done if a projection is possible, only the availability is checked.
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When REFMODE is set to Part, only assemblies are checked. PIDS are not checked.

Review and Edit Connector Metadata
Review and edit connector metadata that was created during import using the FEMSITE Review Conn
tool.

Before you begin, Setup the FEMSITE Utility.

All of the supported connector metadata that can be imported is listed in the parameter.cfg file, which
can be found in the installation: /config/parameter.cfg.

Tip:  If certain metadata is not applicable to you, create comments for them using "#".
HyperMesh will ignore metadata commented with "#".

1. From the menu bar, click Connectors > FEMSITE > Review CONN.

2. In the panel area, use the connectors selector to select one or more connectors.

3. Click proceed.

4. In the Edit params dialog, review and edit the corresponding metadata of the selected
connector(s).

Note:  If you selected multiple connectors, only identical metadata is displayed. Blank
fields indicate that metadata was not identical for the selected connectors. If metadata
was not defined, field will read "not defined".

5. Click Submit.

Assign Metadata to Existing Connectors Imported from a
*.conn File
Resolve undefined custom type connectors imported from a *.conn by assigning them metadata.

Before you begin, Setup the FEMSITE Utility.

If you are working with an HyperMesh model that contains existing connectors that were imported from
a *.conn file, they will appear in the Connector browser as undefined custom types. In order for these
connectors to appear with the correct connector type, they must be assigned metadata.

From the menu bar, click Connectors > FEMSITE > Assign Metadata to assign metadata.
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Model Build and Assembly

Create, organize, and manage the CAE parts.

This chapter covers the following:

• Manage Parts  (p. 2420)

• Manage Representations  (p. 2424)

• Manage Part Revisions  (p. 2441)

• Manage Configurations  (p. 2445)

• Teamcenter - HyperMesh Integration  (p. 2452)
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Manage Parts

About Parts, Part Assemblies, Part Instances
A part is an engineering representation of a physical part, and a part assembly is a group of part
assemblies and/or parts. Part Instances, which are recognized from PDM, are automatically converted to
Part Instances on import into HyperMesh.

Parts and Part Assemblies

HyperMesh supports CAE parts (  ) and part assemblies (  ) and PDM parts ( ) and part

assemblies (  ).

Parts assemblies and parts facilitate the one-to-one mapping of a CAD hierarchy into the HyperMesh
environment as a CAE hierarchy. The CAE hierarchy can be created manually or can be imported from a
PDM system via a neutral file format such as PLMXML.

Figure 1443: PDM BOM Figure 1444: HyperMesh BOM

If a part is comprised of multiple components, such as cast parts or tailor-welded blanks, you can
perform actions such as visualization view modes, model management, and connector link definition at
the part level.

Parts can be used to organize a physical part that is made up of multiple components in a CAE model as
a single part.

When using a part, you can organize multiple components that represent physical parts into a single
part.
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Figure 1445: Cast Part in Part Browser

In the Part Browser, collapsing all folders at the part level enables you to see all owned and referenced
entities. Expanding folders at the part level displays a nested list of all referenced components and their
entity specific attribute values which are shown in the respective columns.

Part Instances
The Part browser provides limited support for part instances of externally sourced BOMs.

Part Instances ( ) share UID and Part names. The name assigned to child instances is incremented

by *.ixx, where xx indicates the number of the child instance. The positioning of Part Instances is
dictated by the transformation matrix applied to the Part in the PDM system. Part Instances can also be
created interactively in a session. Upon creation, you will automatically be prompted to transform the
part via the Transform tool.

In circular, symmetric, or rectangular patterns, certain parts may appear in a BOM multiple times.
Typical examples include bolts, hinges, and symmetric parts.

Creating or saving part representations for instantiated parts saves a single representation in
the repository. Importing instantiated parts positions them according to their respective 4 x 3
transformation matrices.

Create Parts, Part Assemblies, and Part Instances
Only CAE parts and part assemblies can be manually created in HyperMesh. PDM parts and part
assemblies must be imported imported into HyperMesh.

In the Part Browser, right-click and select Create > <entity type> from the context menu.

The new part, part assembly, or part instance is created and displayed in the browser. Part assembly or
part level entities cannot be modified or deleted.

Upon the creation of a part instance, you will automatically be prompted to transform the part via the
Transform tool.

Import Parts, Part Assemblies, and Part Instances

PDM parts and part assemblies can be imported into HyperMesh via a PDM generated PLMXML file.

1. From the menu bar, click File > Import > BOM.
The Import browser opens.

2. In the File field, navigate to the file that contains the parts, part assemblies, and part instances to
import.
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3. Define additional options as needed.

4. Click Import.

Organize Part Assemblies and Parts
Organize part assemblies, parts, and components in your model.

Entity organization rules are as follows:

• The Model is the root of the hierarchy in the browser. It represents the contents of the HyperMesh
binary file and can contain part assemblies, parts, and components.

• A part assembly can contain part assemblies and parts. These can be both assemblies and parts.

• A part can only contain components.

• Reorganize part assemblies, parts, and components in the Part Browser.

a) From the Part Browser, left-click on an entity and drag and drop it to a new location.

In Figure 1446, Component B is being reorganized into Part B.

Figure 1446:

• Reorganize components into a new part using the Organize panel.

a) From the Tool page, click the Organize panel, Parts subpanel.

b) Use the comps selector to select the component(s) to move.

c) In the dest part field, select the part to move the selected components into.

d) Click move.

Save Assemblies as HyperMesh Binary Files
The part assembly binary file is self-contained and includes the part assembly based hierarchy and
attributes such as components, properties, and materials.

You can perform all necessary tasks such as geometry updates and meshing in the distributed
HyperMesh binary file. The completed file can then be imported into the master HyperMesh session by
importing a model.

1. In the Part Browser, right-click on a part assembly and select Save As from the context menu.

2. In the Save As dialog, save the binary in the representations directory for the current binary file.

In Figure 1447, the LeftRail_A_000433_Safety part assembly in the Frame_Assembly_000495 part
assembly is being saved as an HyperMesh binary file.

Tip:  Alternatively, you can select multiple Parts in different assemblies and select Save As
from context menu.
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Figure 1447:

Because the saved part assembly is self-contained, all HyperMesh entities shown in the Part Browser
are saved to the binary file. Opening the saved binary file in a new HyperMesh session results in the
Part Browser view shown in Figure 1448.

Figure 1448:
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Manage Representations

About Representations
The CAD representation forms the basis of the Common representation, which in turn is the basis of all
subsequent discipline specific mesh representations. A part can contain multiple representations.

Figure 1449: Hierarchical Relationship of Representations

The Common representation component typically contains geometry, though it can also consist of FE
mesh.

A folder based Representation repository stores all CAE data that is required during the model build
and assembly process. CAE data stored in the Representation repository includes the geometric and FE
representation of the parts that comprise the subsystem specific model hierarchy.

You can import a BOM via a neutral file format such as PLMXML or manually create a part structure
using the Part Browser context menu.

Common Representation
The Common representation is derived from the CAD representation and forms the basis of all
subsequent discipline specific mesh representations.

For sheet metal parts, the Common representation consists of midsurfaced geometry or FE. The CAD is
sent to the Batchmesher for midsurface extraction; upon completion it is saved into the repository and
you can elect to immediately import the representation into the session.

HyperMesh entities are generated from the PDM metadata, if available, in the post-run procedure of the
BatchMesh operation. The PDM PID is assigned to the component and property, the PDM MID and PDM
material is assigned to the material and the PDM Thickness is assigned to the Thickness attribute of the
property. If the PDM Thickness is blank, the CAD Thickness calculated during the midsurface operation
is automatically assigned to the Thickness attribute of the property.
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For parts such as castings and tailor-welded blanks, you can save CAD representations as Common
models.

Alternatively, you can send solid parts to the Batchmesher. If thin-solid detection is enabled
in the Common representation parameter file, then solids will be detected and saved as the
Common representation without processing. By default, the midsurface algorithm skin is used.
CAD representation does not need to be loaded into the session in order to generate the Common
representation since it is sent directly to the Batchmesher for processing.

When you select a discipline specific mesh representation from the Change Representation dialog,
Create tab, the Common representation residing in the repository is automatically sent to the
Batchmesher for processing. If the Common representation does not exist it will be automatically
generated.

Discipline Specific Mesh Representations
Common representations form the basis of all discipline specific representations. When you select
a discipline specific mesh representation from the Create Representation dialog, the Common
representation residing in the repository is automatically sent to the Batchmesher for processing. The
Common representation does not need to be loaded in the session to generate discipline specific mesh
representations.

Figure 1450: PDM Column Data in Part Browser

Create Representations

Representations utilize the mesh parameter and criteria files that are included with HyperMesh. You can
find these files in the Batchmesher. The Param File and Criteria File fields display the representation
specific mesh parameter and criteria file.

Common representations form the basis of all subsequent discipline specific mesh representations.
When you select a discipline specific mesh representation from the Change Representation dialog,
Create tab, the Common representation residing in the repository is automatically sent to the
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Batchmesher for processing. If the Common representation does not exist it will be automatically
generated.

1. In the Part Browser, right-click on part assemblies or parts and select Representations > Create
from the context menu.

2. In the Change Representation dialog, Create tab, select a desired representation.
The availability of the selected representation in the repository is displayed next to the
representation type within parentheses.

Figure 1451: Available Representations
(0/11) common representations available in the repository.

3. Optional: To save the newly created representations to the Part Library select the Save to Library
checkbox.

4. Select the Midsurface method (default is Skin).

5. Click OK.
All representations are sent to the Batchmesher for processing in parallel. Upon completion, all
representations are automatically saved to the repository.
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Figure 1452: BatchMesher Processing

6. In the BatchMesh dialog, specify how representations are imported.

• Click Yes to import all representations into the session.

• Click No to not import the representations into the session.

Note:  The representations will be available in the Load Representation dialog.

Define Representations
Create your own user defined representation. User defined representations are saved to the settings
and will be available in subsequent HyperMesh sessions.

1. In the Part Browser, right-click on part assemblies or parts and select Representations >
Settings > User Representations from the context menu.

2. In the User Representation dialog, click + to add a new representation.

3. In the Representation field, enter a name for the representation.

4. In the Param File and Criteria File fields, select the appropriate mesh parameter and criteria file.

5. If the representation is for solids, select the Solid checkbox.
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Add Representations
Part representations can be added from external sources such as solver decks and HyperMesh binary
files or from the Part Library.

Add Representations from External Sources
Add representations from external sources for a single part or for multiple parts and part assemblies.

When selecting a part assembly or multiple parts, the Add Representations dialog enables you to
map and associate representation files to multiple parts simultaneously.

If appropriate metadata is available in the BOM, then the alias values will be preselected. After choosing
a Representation Folder, representation files will be mapped according to the HyperMesh naming
convention. You can then manually select or update any of the alias and representation file values.

Indicators are displayed for each part to indicate the status of that row.

Skip.
Any Part which does not have a mapped or selected representation.

OK.
Alias and representation are chosen for the part.

Overwrite.
Part already has a representation which will be overwritten by the selected mapping.

Duplicated.
The same representation file is chosen for more than one part, or the chosen representation file
is already used by another part in the same BOM. You cannot click OK to add the representations
when representations are duplicated.

1. In the Part Browser, right-click on the part assemblies or part(s) and select Representations >
Add > from Files the context menu.

2. In the Add Representation(s) dialog, define options accordingly.

To add
representations for

Do this

Single part 1. From the Representation field, specify a desired representation type
to which a representation file will be added.

• Choose a default representation type.

• Enter your own user defined representation into the field.

2. If you entered your own representation, select the appropriate mesh
parameter and criteria files.

User defined representations with defined mesh parameter and criteria
files created in the Add Representation dialog will be available
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To add
representations for

Do this

in the Change Representation dialog, Create tab. User defined
representations with undefined mesh parameter and criteria files created
in the Add Representation dialog will not be available in the Change
Representation dialog, Create tab, but will appear in the Load tab if a
representation is found in the repository.

The availability of the selected representation in the repository is
displayed next to the representation type within parentheses.

Figure 1453:

Multiple part or
part assemblies

1. In the Representation Folder field, navigate to the representation
file.

2. Select the parts to map and associate with the representation file.

Note:

• You cannot add CAD or connectors.

• You can select Part or Part Assembly for adding the
representation.
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To add
representations for

Do this

Figure 1454:

3. To save the representations to the Part Library select the Save to Library checkbox.

4. Click OK.

Add Representations from the Part Library

1. In the Part Browser, right-click on a part/part assembly and select Representations > Add >
from Library from the context menu.

2. In the Add Representations from Library dialog, select representations to add.

3. Optional: To simultaneously add and load representations, select representations to load from the
Load Added Representations list.

4. Click OK.
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Add Representations to the Part Library
After importing a BOM, you can add CAD representations to the Part Library.

1. In the Part Browser, right-click on a part/part assembly and select Representations > Add > to
Library from the context menu.

2. In the Add Representation to Library dialog, select representations and click OK.

The Add Representation to Library dialog displays information regarding the availability of
representations in library, session, and overwrite details.

In Figure 1456, CAD representations are being added to the Part Library. The Library column
displays 0/8, which indicates there are no CAD representations available in the Part Library. The
Session column displays 6/8, which indicate 6 out of 8 representations are currently available in
the active HyperMesh session. The Overwrite column displays 0/8, which indicates none of the
representations will need to be overwritten.
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Browse Library Content
Review library content using the Library Viewer.

1. In the Part Browser, right-click on the part assemblies or part(s) and select one of the following:

• Representations > Add > browse Library the context menu.

• Library > Library Viewer the context menu.

The Library Viewer opens.

2. Select the Part that contains the representations you would like to review.
A list of properties associated with the Part are displayed in the Properties pane.
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Load Representations
Part representations can be loaded from your current HyperMesh session or from the Part Library.

Load Representations from Current HyperMesh Session

1. In the Part Browser, right-click on part assemblies or parts and select Representations >
Load > from Session from the context menu.

2. In the Change Representation dialog, Load tab, select a type of representation to load.
Representations that exist in the repository are shown in the Representations column, and their
availability is indicated in the Available column.
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Figure 1458:

3. To send unavailable representations to the Batchmesher directly from the Change
Representation dialog, select the Batch Mesh Unavailable checkbox.

Note:  Available representations will also be loaded when you click OK if the Batch
Mesh Unavailable checkbox is selected.

4. To save the representations to the Part Library select the Save to Library checkbox.

5. Click OK.

6. In the Confirm Load Representation dialog, specify how representations are loaded.

• Click Load All to load all available representations into the current session for selected parts.

• Click Skip Loaded to ignore representations that are already loaded for selected parts.

As representations are created and saved to the repository they are displayed in the Available 
Representations pane.
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Load Representations from the Part Library
After importing a BOM that has representations saved in the Part library, you can load the saved 
representations.

1. In the Part Browser, right-click on a part/part assembly and select Representations > Load >
from Library from the context menu.

2. In the Change Representation dialog, Library tab, select representations and click OK.

The selected representations are loaded to the Representation folder on the file system. Similarly, every
time a BOM is imported, files are loaded to the Representations folder, if you retrieve them from the
Part Library.
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Reload Representations
Restore part representations to their original state.
In the Part Browser, right-click on parts or part assemblies and select Representation > Reload from 
the context menu.

Representations are reloaded from the repository.

Unload Representations
Unload part representations from a session.

1. In the Part Browser, right-click on the model, part assemblies, or parts and select
Representation > Unload from the context menu.

2. In the Confirm Unload Representation dialog, click Yes to unload the selected representations.
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Update Metadata From PDM
1. In the Part Browser, right-click on a part or parts to update and select Representations >

Update from the context menu.

2. Update metadata.

• Rename the selected parts or part's component, or create if it does not already exist.

• Create a material based on PDM Material and PDM MID.

If a material of the given ID already exists, then it will not be overwritten or recreated in
order to avoid overwriting any existing material properties.

Only linear attributes are updated. Default steel attributes are used with the following unit
system: millimeter, second, tonne, and Newton.

• Create a property based on PDM PID and PDM Thickness*.

If a property of the given PID already exists, its thickness will be updated based on PDM
Thickness; however, the existing property will not be recreated. Only relevant metadata will
be updated in order to avoid overwriting any existing property card values.

Note:  *If the PDM MeshFlag attribute is set to SMT (Solid Mesh Tetra) or SMH (Solid
Mesh Hexa), than a solid card image will be assigned to the property.

Sync Metadata To PDM
Sync PDM metadata (PDM PID, PDM Thickness, PDM Material, and PDM MID) based on a selected part
or part's metadata (PID, Thickness, Material, MID).

In the Part Browser, right-click on a part or parts and select Representations > Sync Metadata from
the context menu.
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*When a part has multiple properties, only the first property will display in the PID PDM field when you
select Sync Metadata.

Save Representations
After importing a BOM and creating respective representations, you can save the representations locally
or in the Part Library.

Parts without a UID cannot be saved to the Library. Considering this, the UID field in the Save
Representation dialog is user editable.
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1. In the Part Browser, right-click on part assemblies or parts and select Representations > Save
from the context menu.

A checkmark in the Available column indicates that the representation already exists in the
repository. A checkmark in the Library column indicates that a revision is already available in the
Part Library.

The Save Representation dialog opens.

2. Edit the Major Revision and Study Revision columns to reflect the intended revisions.

3. To overwrite representations that already exist in the repository or Part Library, select the
Overwrite available checkbox.

Note:  Original CAD representations will not be overwritten because the original
file location is stored as a link on the part. Enabling Overwrite available saves an
HyperMesh binary file of the modified CAD representation in the repository.

4. To only save parts locally, disable the Save to Library checkbox.

5. Click OK.

Unavailable parts are saved, and available parts are overwritten and saved if Overwrite available was
selected.
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Delete Representations
Part representations can be deleted from the current HyperMesh session and from the Part 
Library.

Delete Representations from the Current HyperMesh Session

1. In the Part Browser, right-click on part assemblies or parts and select Representations >
Delete > from Session from the context menu.

2. In the Delete Representations dialog, select representations to be deleted.

3. To remove representations from the Part Library, select the Delete representation from library
checkbox.

Note:  The Study version will be incremented if a representation is deleted from the
Library.

4. Click OK.
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Delete Representations from the Part Library

1. In the Part Browser, right-click on part assemblies or parts and select Representations >
Delete > from Library from the context menu.

2. In the Delete Representations From Library dialog, select representations to be deleted.

3. Click OK.

Figure 1463:

Representation Load Settings
Settings to configure the representation entity management behavior.

Open the Representation Load Settings dialog by right-clicking in the Part Browser and selecting
Representations > Settings > Load Settings.

The representation entity management settings work independent of the import binary and import deck
entity management settings.

The following options are available for components, properties, and materials.

Offset ID.
Merges incoming attributes with conflicting IDs into the session, and offsets their IDs.
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Keep Existing Attributes.
Maintains existing in-session entity attributes and incoming conflicting entity IDs.

Keep Incoming Attributes (default).
Maps incoming entity attributes to the in-session entities.

When Offset ID is selected for components, both incoming and existing geometry and FE residing in
the component with conflicting IDs are kept. When Keeping Existing Attributes or Keep Incoming
Attributes are selected for components, incoming geometry and FE that resides in the component with
conflicting IDs are kept.
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Manage Part Revisions
Manage, control and update Major, Study and Library Part revisions using the Part Library.

About Part Library and Revisions
The Part Library is an integral part of data management and revision control within the Part Browser.

Part Library
By default, a Part Library is generated when the Part Browser is enabled. There are two modes:

Unmanaged
Local file management

Managed
Uses the Part Library

The default Part Library is located at <user home>\AltairLibraries\2019.

The Part Library serves as a centralized library of HyperMesh parts, which in turn facilitates the
collaboration between simulation teams both locally and abroad.

You must be connected to a Part Library to access all Part Library related options.

Parts without a UID cannot be saved to the Library. Considering this, the UID field in the Save
Representation dialog is user editable.

Revisions
In the Part Browser, the Revision column displays the Major revision, Study revision, and Library Part
revision. All of the appropriate workflows have entry or access points to the part library, enabling quick
and easy access to previous revisions or simply generating new revisions.

Major Revision
Depicts a change or set of changes that have been finalized and released for further review. In
most cases the Major Revision is mapped to the PDM Revision, but you can modify it.

Study Revision
Created locally to track experimental changes or prototyping changes that may or may not be
published. The purpose of the Study Revision is to manage design and prototype exploratory
concepts. You can modify the Study Revision.

Library Part Revision
Locally, published revision within the Part Library. You cannot modify the Library Part Revision.

You can review and edit a part's Major Revision, Study Revision, and Library Part Revision in Entity
Editor.
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Figure 1464: Revisions for the LeftOuter_A_000435_Safety.c01 Part
Major Revision = A (mapped to the PDM revision, user editable), Study Revision = 1 (can be any letter or numerical value, user

editable), Library Part Revision = 1 (library version, not editable)

Register and Connect Libraries
Register and connect to new libraries of your choice.

A default Part Library is generated when the Part Browser is enabled, and is located at <user home>
\AltairLibraries\2019.

1. In the Part Browser, right-click and select Library > Libraries from the context menu.
The Libraries dialog opens.

2. Register new library.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Build and Assembly p.2443

a) Click +.

b) Select Library type.

• Local

• Shared (see PostGres installation for a shared Library)

c) Enter Library host/port.

If you are working with a shared Library, enter a Library port.

d) Enter a Library Name and Library Path.

e) Click Add.

3. Disconnect currently connected library.

Before you can connect to a new library, you must disconnect from the currently connected library.

a) Select the currently connected library.

b) Click Disconnect.
4. Connect library.

a) Select a disconnected library.

b) Click Connect.

Figure 1465:

Sync Library Revisions
Sync the in-session version with the latest, available version in the Part Library.

If the version available in the current session is out of sync with the Library reversion, use Sync to
update the session version with the Part Library version.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Build and Assembly p.2444

Before you can sync library revisions, you must Register and Connect Libraries.

In the Part Browser, right-click on a part/part assembly and select Library > Sync from the context
menu.

Edit Study Revisions
Study Revisions are a way to explore design space, and can be promoted to a Major Revision as
required.

Assign and edit Study Revisions in the Entity Editor.

1. In the Part Browser, select a part/part assembly.

2. In the Entity Editor, edit the Study Revisions field.
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Manage Configurations
Group common and unique parts/part assemblies together in part sets, and organize parts and part sets
that are unique to a configuration.

In the traditional model build and assembly workflow, subsystems that contain multiple variants are
stored in multiple HyperMesh binary files. This complicates the model build and update process as part
updates and revisions will need to be performed on each binary file.

An example of a subsystem that may contain multiple configurations is a vehicle body-in-white (BIW). A
typical sedan BIW may have the following configurations:

• Left-hand drive (LHD)

• Right-hand drive (RHD)

• Fixed roof (Fixed)

• Panoramic roof (Pano)

Figure 1466:

All common and unique parts that appear in all configurations for a given subsystem are stored in a
single HyperMesh binary file, known as a Layered Model. In a Layered Model, common parts are active
in all configurations. Unique parts are active only in a specific configuration. You must deactivate unique
parts not appearing in a configuration.
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Figure 1467:

About Part Sets and Configurations
Part sets group common or unique parts, and configurations organize parts and part sets that are
mutually exclusive to a configuration.

Example: Configuration Management Workflow
Configuration management workflow for a Dash and Cowl subsystem.

The configuration management workflow for a Dash and Cowl subsystem is shown in Figure 1468, along
with the Left-hand drive (LHD) and Right-hand drive (RHD) configurations contained in the Layered
HyperMesh binary file.
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Figure 1468:

Common parts are active in all configurations and unique parts are active only in a specific
configuration. The model hierarchy is shown in Figure 1469.

Figure 1469:

To activate the LHD configuration of the Dash and Cowl assembly, perform one of the following:
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• Clear the Active column for the following individual, unique parts that belong to the RHD
configuration.

◦ Dash Panel RHD

◦ Dash Bracket Large RHD

◦ Dash Inner Bracket RHD

◦ Dash Cross Member RHD

• If all unique parts are nested in a single part assembly, clear the Active column for Dash RHD
Assembly.

• If all parts and part sets that are unique are organized in a configuration, enable the LHD
configuration’s associated checkbox in the Active column of the Configuration view.

All RHD unique parts are removed from the modeling window and are automatically set to do not
export. Export the solver deck for the LHD configuration using the Export Solver Deck Browser.

Figure 1470:

Create Part Sets
1. Open the Part Browser.

2. In the Part Set view, right-click and select Create > Part Set from the context menu.
A new part set is created.
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3. From the Part view, click-and-drag parts and part assemblies that are common and/or unique onto
the part set.

Tip:  Dragging-and-dropping selected parts/part assemblies into the white space of the Part
Set view automatically creates a new part set for the selected.

Create Configurations
1. Open the Part Browser.

2. In the Configuration view, right-click and select Create > Configuration from the context menu.

3. From the Part and/or Part Set views, click-and-drag parts, part assemblies, and part sets that are
unique to a configuration onto the configuration.

Tip:  Dragging-and-dropping selected parts, part assemblies, and part sets into the white
space of the Configuration view automatically creates a new Configuration for the selected.

Remove Contents of Part Sets and Configurations
In the Part Browser, remove the contents of part sets and configurations in the following:

• Right-click on the entity and select Remove from the context menu.

• Drag the entity into the white space of the respective browser view.

Activate/Deactivate Configurations
Control the display and export state of parts and part assemblies by changing the active/inactive state
of configurations.

Entities set to inactive are still visible in the Part Browser. Deactivated components will not be visible in
the Model Browser, Display panel, and panel entity collectors.

• Set configuration to active.

a) Go to the Part Browser, Configuration view.

b) In the Active column, select the configuration's checkbox.

Note:  Only one configuration can be activated.

Tip:  For simple models you can activate a configuration in the Part view by setting all
unique parts not appearing in the configuration to inactive.

• All of the parts, part assemblies, components, and part sets organized in the active
configuration are isolated in the modeling window.
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• All of the parts, part assemblies, components, and part sets not associated with the active
configuration become inactive and their display is turned off in the modeling window.

• Inactive components are set to do not export.

• Set part assembly to inactive.

• Removes all nested parts and owned components from the modeling window.

• Sets all owned components to do not export.

• Set part to inactive.

• Removes the part and its owned components from the modeling window.

• Sets all owned components to do not export.

Create and Organize Part Sets from PDM Variants
1. In the Part Browser, Part Set view, right-click on a part set entity (if available) or in the white

space and select Create Variants from the context menu.

2. In the Confirm Create Variants dialog, click Yes.

The created part sets are nested under a Variants Part Set.

Note:  Part sets are recreated on each invoke of the Create Variants operation.
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Figure 1471:

PDM Variant Conditions
PDM Variant Conditions are utilized in PDM systems, such as Teamcenter, to mark similar parts in BOMs
that may contain multiple variants, such as an automotive BIW.

Attributes supported in the Part Browser via BOM Import and user editing via the Entity Editor include:

PDM Variant Condition
If non-empty, the part is used as a variant in one or more part configurations.

PDM Variant Scope
Along with the Variant Condition attribute, it describes which part configurations the part belongs
to as a variant.

Part sets are created per PDM Variant Condition attribute found in the global part assembly/part
hierarchy. The operation can be invoked at model, part assembly, or part level.

You can organize part sets from PDM Variants in any view of the Part Browser.
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Teamcenter - HyperMesh Integration
All BOM-related information, including part/assembly hierarchy, part attributes, and representation
information is organized and displayed in the Part Browser.

Figure 1472:

Representation (HyperMesh session) attributes are now displayed independent of the PDM attributes.
Attribute columns can be turned on/off in the Column Visibility dialog, which can be accessed by
right-clicking in the Part Browser and selecting Column Visibility from the context menu.
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InFigure 1472, the session attributes (PID, MID, Material, Thickness) are blank because representations
have yet to be created or loaded. The corresponding PDM attributes, from the imported PLMXML BOM
file, show their values from Teamcenter.

Representation Options

Option Description

Create Creates HyperMesh representation(s) via Batchmesher.

Save Saves representations for selected part(s) based on the chosen alias and file
type.

Add Adds representations for selected part(s) based on the chosen alias and file type
or from the Part Library.

When adding representations for multiple parts or part assemblies from external
sources, the Add Representations dialog enables you to map and associate
representation files to multiple parts simultaneously.

Figure 1473:

If appropriate metadata is available in the BOM, then the alias values will be 
preselected. After choosing a Representation Folder, representation files will be 
mapped according to the Teamcenter naming convention. You can then manually 
select or update any of the alias and representation file values.

Indicators are displayed for each part to indicate the status of that row.

Skip.
Any Part which does not have a mapped or selected representation.
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Option Description

OK.
Alias and representation are chosen for the part.

Overwrite.
Part already has a representation which will be overwritten by the selected
mapping.

Duplicated.
The same representation file is chosen for more than one part, or the
chosen representation file is already used by another part in the same
BOM.

You cannot click OK to add the representations when representations are
duplicated.

Load Load part representations from your current Teamcenter-HyperMesh session or
from the Part Library.

If any of the selected parts currently have a representation loaded in the
session, you will be prompted whether or not to unload them before loading new
representations.

If representations are not unloaded first, incoming representations will be
imported on top of the existing representations, and Load Settings will be used.

Unload Unloads representations for selected part(s).

Delete Deletes representations for selected part(s) from your current
Teamcenter-HyperMesh session or from the Part Library.

Reload Restores part representations to their original state.

Settings Displays the current load settings, which are used when representations are
imported.

Setup the Teamcenter - HyperMesh Environment
The Teamcenter integration environment requires an additional layer, on top of the out-of-the-box Part
Browser behavior.

When launching HyperMesh via Teamcenter, the environment will be set automatically. However, all of
the integration features may be accessed by manually setting the environment.

To manually set the Teamcenter-HyperMesh environment:

1. Locate the Teamcenter-HyperMesh custom layer in your installation.
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By default, the custom layer is located in <ALTAIR_HOME>\hm\scripts\br\views\modules\custom
\TC, where <ALTAIR_HOME> refers to the base installation folder where HyperWorks is installed, for
example C:\Program Files\Altair\HW2019.

2. Set the environment variable HW_CONFIG_PATH=<ALTAIR_HOME>\hm\scripts\br\views
\modules\custom\TC\properties.

3. Set the environment variable HM_CAT_CUSTOM=<ALTAIR_HOME>\hm\scripts\br\views\modules
\custom\initTC.tcl.

Note:  For customer-specific customization that are above and beyond the standard
Teamcenter-HyperMesh integration, set HM_CAT_CUSTOM to the init<XYZ>.tcl file,
where XYZ refers to customer “XYZ’s” individual custom layer.

Update Teamcenter

Update Teamcenter via Teamcenter-HyperMesh Integration
If HyperMesh was launched via the Teamcenter - HyperMesh Integration, you will be prompted to
import updated data back to Teamcenter.

Figure 1474:

Update Teamcenter via Manual PLMXML Import in Teamcenter
If the BOM was loaded manually, for example HyperMesh was not launched via the
Teamcenter-HyperMesh Integration, then the updated PLMXML package can be manually imported into
Teamcenter.

1. Copy the exported BOM PLMXML, along with the folder(s) containing the monolithic file, if saved,
and any saved/updated representations to a convenient folder accessible by Teamcenter.

2. Select Import PLMXML to import the updates.
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Figure 1475:

Import BOMs

Import BOMs in HyperMesh via Teamcenter - HyperMesh
Integration

Directly launch HyperMesh and import the selected BOM.

The selected BOM and associated files will be exported from Teamcenter and automatically loaded in the
HyperMesh Part Browser, which replaces the Assembly Browser used in previous versions.

Figure 1476:

Import BOMs in HyperMesh via the HyperMesh Import - BOM Tab

1. In Teamcenter, select the Pre-Processor Integration option to export the PLMXML package to
the last run folder, which Teamcenter continues to interact with until the HyperMesh session is
closed.

Once closed, Teamcenter prompts you to accept or reject updates. The last run folder is then
automatically cleaned up.

2. Export the PLMXML package so that you can work on it over time by selecting the Export
PLMXML for Pre-Processor option.
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Figure 1477:

3. The resulting PLMXML BOM file, along with its associated data files, will be exported to the last
data folder and can be imported directly into HyperMesh via the Import - BOM tab.

Figure 1478:

The BOM is displayed in the Part Browser.

Import BOMs in HyperMesh via Teamcenter - HyperMesh
Integration

Directly launch HyperMesh and import the selected BOM.

The selected BOM and associated files will be exported from Teamcenter and automatically loaded in the
HyperMesh Part Browser, which replaces the Assembly Browser used in previous versions.
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Figure 1479:

Import BOMs in HyperMesh via the HyperMesh Import - BOM Tab

1. In Teamcenter, select the Pre-Processor Integration option to export the PLMXML package to
the last run folder, which Teamcenter continues to interact with until the HyperMesh session is
closed.

Once closed, Teamcenter prompts you to accept or reject updates. The last run folder is then
automatically cleaned up.

2. Export the PLMXML package so that you can work on it over time by selecting the Export
PLMXML for Pre-Processor option.

Figure 1480:

3. The resulting PLMXML BOM file, along with its associated data files, will be exported to the last
data folder and can be imported directly into HyperMesh via the Import - BOM tab.

Figure 1481:
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The BOM is displayed in the Part Browser.

Export BOMs
1. In the Part Browser, right-click on the Model part assembly and select Export PLMXML from the

context menu.
You will automatically be directed to the Export - BOM tab, where the correct name and path will
be set, using the lst_output.xml file name expected by the Teamcenter-HyperMesh integration.

2. For File Type, choose to export BOM files as either PLMXML or UDMXML.

For the Teamcenter-HyperMesh process, PLMXML will be used.

3. In the File field, enter the path to exported BOM file.

For the Teamcenter-HyperMesh process, the file should be named lst_output.xml, and the file
should be saved to the same location as the original BOM file, lst_input.xml.

4. To warn you before saving a BOM file over an existing file, select Prompt before overwrite.

5. To save the assembly monolithic file, according to the PLMXML Master Format attribute value,
while exporting the BOM, select Save Monolithic file.

6. To update PDM attributes based on part attributes prior to writing the exported BOM file, select
Update Attributes to PDM.

Using this option assures that attribute updates made in the session will be sent back to
Teamcenter.

Load CAD Representations
Load part representations from your current Teamcenter-HyperMesh or from the Part Library.

When CAD representations are loaded, components are created for the loaded CAD representations.
Materials and properties, if available in the CAD file would also be created, and their values would
be displayed in the Part Browser columns. Component naming conventions are not yet imposed,
nor are the materials and properties created automatically at this time, therefore you can review
information within the CAD files themselves prior to mesh representation creation. According to the
Teamcenter-HyperMesh naming conventions, component naming and material and property handling
will occur during the meshing process.

Load Representations from Current HyperMesh Session

1. In the Part Browser, right-click on part assemblies or parts and select Representations >
Load > from Session from the context menu.

2. In the Change Representation dialog, Load tab, select a type of representation to load.
Representations that exist in the repository are shown in the Representations column, and their
availability is indicated in the Available column.
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Figure 1482:

3. To send unavailable representations to the Batchmesher directly from the Change
Representation dialog, select Batch Mesh Unavailable.

Note:  Available representations will also be loaded when you click OK if Batch Mesh
Unavailable is selected.

4. To save the representations to the Part Library, select the Save to Library checkbox.

5. Click OK.

6. In the Confirm Load Representation dialog, specify how representations are loaded.

• Click Load All to load all available representations into the current session for selected parts.

• Click Skip Loaded to ignore representations that are already loaded for selected parts.

As representations are created and saved to the repository they are displayed in the Available
Representations pane.

Load Representations from the Part Library
After importing a BOM that has representations saved in the Part library, you can load the saved
representations.

1. In the Part Browser, right-click on a part/part assembly and select Representations > Load >
from Library from the context menu.

2. In the Change Representation dialog, Library tab, select representations and click OK.

The selected representations are loaded to the Representation folder on the file system. Similarly, every
time a BOM is imported, files are loaded to the Representations folder, if you retrieve them from the
Part Library.
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Figure 1483:

Create Mesh Representations
1. In the Part Browser, right-click and select Representation > Create from the context menu.

2. In the Change Representation dialog, Create tab, select the NVH_Standard_8 representation.

Each representation is uniquely identified by its alias and file type. For example,
“NVH_Standard_8/HyperMesh” and “NVH_Standard_8/Nastran” representations.

The appropriate representation will automatically be selected, based on the available PLMXML
metadata: discipline, mesh representation, and mesh density. If the appropriate metadata
is unavailable, then you can select the desired representation type to create. In the Change
Representation dialog, Create tab, only HyperMesh representations can be created.

Per the current Teamcenter-HyperMesh integration rules, only one representation per file type is
allowed per part. This means that you can only have a single HyperMesh file type representation,
Nastran file type representation, CAD representation, and so on for each part. For example,
if you create a NVH_Standard_8/HyperMesh representation and then subsequently create a
NVH_Coarse_15/HyperMesh representation, the NVH_Coarse_15/HyperMesh representation will
become the only HyperMesh representation for the given part.
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Figure 1484:

3. To save the newly created representations to the Part Library select the Save to Library
checkbox.

4. Click OK.

Batchmesher is invoked, and meshes are created using the appropriate batch meshing parameter and
criteria files.

The parameter and criteria file mappings are configurable based on the batchmesher_config.cfg file
available in the installation.

As part of the post-batchmeshing process, each part’s components are created, using the
Teamcenter-HyperMesh naming convention. In addition, the loaded representation (NVH_Standard_8
in this case) is displayed, and the component ID (CID), property ID (PID), Material, and Thickness are
created, per the values available in the PLMXML BOM.
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Figure 1485:

Update Metadata from PDM
1. In the Part Browser, right-click on the part(s) to update and select Representations > Update

from the context menu.

2. Update metadata accordingly.

• Rename the selected parts or part's component, or create if it does not already exist.

• Create a material based on PDM Material and PDM MID.

If a material of the given ID already exists, then it will not be overwritten or recreated in
order to avoid overwriting any existing material properties.

Only linear attributes are updated. Default steel attributes are used with the following unit
system: millimeter, second, tonne, and Newton.

• Create a property based on PDM PID and PDM Thickness*.

If a property of the given PID already exists, its thickness will be updated based on PDM
Thickness; however, the existing property will not be recreated. Only relevant metadata will
be updated in order to avoid overwriting any existing property card values.
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Note:

*If the PDM MeshFlag attribute is set to SMT (Solid Mesh Tetra) or SMH (Solid
Mesh Hexa), than a solid card image will be assigned to the property.

Sync Metadata to PDM
Sync PDM metadata (PDM PID, PDM Thickness, PDM Material, and PDM MID) based on a selected part
or part's metadata (PID, Thickness, Material, MID).

In the Part Browser, right-click on the part(s) to sync and select Representations > Sync Metadata
from the context menu.

*When a part has multiple properties, only the first property will display in the PID PDM field when you
select Sync Metadata.

Save and Open HyperMesh Models
You can save the HyperMesh file at any time. The HyperMesh session stores all of the BOM-related
information, including hierarchy, metadata, and representations. The original PLMXML BOM file is no
longer required to load, view, or modify any of this information.

Save the Current HyperMesh Models

1. From the menu bar, click File > Save > Model.
2. In the Save Model As dialog, save the model to your working directory.

Open HyperMesh Models

1. From the menu bar, click File > Open > Model.
2. In the Open Model dialog, open the recently saved HyperMesh model.

All of the BOM-related information is retained with the most recently loaded representations loaded in
the session.
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Figure 1486:
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Model Verification

Perform automatic checks on CAD models, and identify potential issues with geometry that may slow
down the meshing process using the Verification and Comparison tools.

This chapter covers the following:

• Launch Verification Browser  (p. 2468)

• Launch Comparison Browser  (p. 2471)

• Import Models  (p. 2475)

• Perform Model Checks  (p. 2476)

• Configure Model Verification Settings  (p. 2507)

• Save Reps  (p. 2569)

• Configure Parts  (p. 2570)

• Review in HyperView Player  (p. 2571)

• Review in HyperMesh  (p. 2572)

• Export Parts  (p. 2573)

• Rename Parts  (p. 2574)

• Renumber Parts  (p. 2575)

• Count Parts  (p. 2576)

• Batch Mode  (p. 2577)

• Limitations  (p. 2593)

The Verification and Comparison tools performs intersection, spot weld, connection and part comparison
checks on the CAD models, and exports a clear report that highlights the issues in MS-Excel
spreadsheet and PowerPoint slides, with embedded HyperView Player.

This solution can drastically decrease the meshing process by enabling you to identify and correct
problems with CAD data at early stages before the meshing process begins. Current users of the Model
Verification and Comparison tools have reported time savings up to 90% compared to the traditional
process.
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Figure 1487: Supported Checks
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Launch Verification Browser
Use the Verification browser to inspect CAD data supplied from your design or CAD team.

The Verification browser supports Offset, Intersection, Spot Weld, Connection, Spot Comparison, and
Free Part checks. After performing the verification, results are exported to reports.

From the menu bar, select View > Browsers > HyperMesh > Verification.

The Verification browser opens.

Browser User Interface
Overview of the Verification and Comparison browser user interface.

The Verification and Comparison browser consists of a search, filter, column data, and Entity Editor.

You can switch to the Part browser any time to perform detailed operations on a part.

Column Details
By default, the following attributes are listed as columns in the first pane.

Name

Description

ID
Part assembly and model IDs.

Color
Part entity colors.

MVD Part Name
Part entity name.

MVD PID
Entity specific property ID’s. At the part level, the IDs for referenced properties are displayed. At
Component level, IDs of the referenced properties are displayed.

UID
Part assembly and part Unique IDs.

MVD Revision
Major revision, Study revision, and Library Part revision.

MVD Material
Material name of the part

MVD Thickness
Entity specific thickness. At the part level it displays the thicknesses of the referenced properties.
At component level it shows the thickness of the referenced property.

MVD Action
Type of operation for the part entity.
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MVD Modeling Type
Type of modeling either mid-plan or skin mesh for the part entity.

MVD Mesh Size
Mesh size for the part entity.

MVD Error
Errors accrued in respective operation on the part.

MVD Function Name
Sub assembly name of the part.

MVD Assembly Name
Assembly name of the part.

MVD Counter Parts
Matching or intersecting part’s UDMID.

MVD Bounding Box
Bounding box of the part.

MVD Oriented Bounding Box
Oriented bounding box of the part.

MVD Weight
Weight of the part.

MVD Delta Weight
Weight difference between part and counter part.

MVD Load Collectors
Load collector card name of the part.

MVD Contacts
Contact card names of the part.

MVD Boundary Conditions
BCs card names of the part.

MVD Representation File
Default representation file path of the part.

Context Menu
Overview of the Verification and Comparison browser context menu.

Name

Description

Import
Import CAD or FEM as a BOM file into the Verification browser for manual cleanup, and then run
verifications. It is recommended to use a respective check in case no data cleanup in necessary,
as this Import function is integrated into each verification function.
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Export
Export an .xml file to a specified location. You can use this .xml file to run Model verification
using the XML option.

Check
Check functions. For more information, refer to Perform Model Checks.
“Check (Comparison, Representation Comparison)”, “Multiple Checks".

Parts
Consists of part functions.
“Count”,”Rename”, “Renumber” “Export”, “Delete” , “Load”, “Load in other”, “Load in HyperView
Player”, “Unload".

Representations
Consist of representation import options “Load”, “Load in other HM”, “Load in Hyper View Player”,
“Unload”, and “Save”.

Review Results
Comparison and Intersection results are directly displayed in HyperMesh graphics. For Comparison
function, you can right-click on Base Part and select review to display the base part and
matched variant parts in the graphics area along with mismatched area with temp nodes.

CSV

Compare
Compare and identify unmatched information between a CSV file and the imported BOM file.
Results will be populated in the Error column. The CSV file header details can be configured
through the Configuration option, under the CSV comparison section.

Export
Export selected parts and children parts in to a CSV file.

Update
Read a CSV file exported with the Export function, and update the information displayed
in the Verification browser. The Entities column is the reference column considered for
updating the BOM.

Tools
Consist of “Divide Slides”, “Open In Explorer”, “Reset Results”, “Get Revision menus”, details are
available in the functional detail sections.

Configuration
Open the configuration dialog.
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Launch Comparison Browser
Use the Comparison browser to compare and identify the topology difference between two model/part
assembly/parts.

The Comparison browser supports CAD Offset and Comparison check. After the comparison check,
the results are reported in PowerPoint, Excel and CSV file, in addition the results can be reviewed and
modified directly in HyperMesh.

From the menu bar, select View > Browsers > HyperMesh > Comparison.

The Comparison browser opens.

Browser User Interface
Overview of the Verification and Comparison browser user interface.

The Verification and Comparison browser consists of a search, filter, column data, and Entity Editor.

You can switch to the Part browser any time to perform detailed operations on a part.

Column Details
By default, the following attributes are listed as columns in the first pane.

Name

Description

ID
Part assembly and model IDs.

Color
Part entity colors.

MVD Part Name
Part entity name.

MVD PID
Entity specific property ID’s. At the part level, the IDs for referenced properties are displayed. At
Component level, IDs of the referenced properties are displayed.

UID
Part assembly and part Unique IDs.

MVD Revision
Major revision, Study revision, and Library Part revision.

MVD Material
Material name of the part

MVD Thickness
Entity specific thickness. At the part level it displays the thicknesses of the referenced properties.
At component level it shows the thickness of the referenced property.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2472

MVD Action
Type of operation for the part entity.

MVD Modeling Type
Type of modeling either mid-plan or skin mesh for the part entity.

MVD Mesh Size
Mesh size for the part entity.

MVD Error
Errors accrued in respective operation on the part.

MVD Function Name
Sub assembly name of the part.

MVD Assembly Name
Assembly name of the part.

MVD Counter Parts
Matching or intersecting part’s UDMID.

MVD Bounding Box
Bounding box of the part.

MVD Oriented Bounding Box
Oriented bounding box of the part.

MVD Weight
Weight of the part.

MVD Delta Weight
Weight difference between part and counter part.

MVD Load Collectors
Load collector card name of the part.

MVD Contacts
Contact card names of the part.

MVD Boundary Conditions
BCs card names of the part.
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MVD Representation File
Default representation file path of the part.

Context Menu
Overview of the Verification and Comparison browser context menu.

Name

Description

Import
Import CAD or FEM as a BOM file into the Verification browser for manual cleanup, and then run
verifications. It is recommended to use a respective check in case no data cleanup in necessary,
as this Import function is integrated into each verification function.

Export
Export an .xml file to a specified location. You can use this .xml file to run Model verification
using the XML option.

Check
Check functions. For more information, refer to Perform Model Checks.
“Check (Comparison, Representation Comparison)”, “Multiple Checks".

Parts
Consists of part functions.
“Count”,”Rename”, “Renumber” “Export”, “Delete” , “Load”, “Load in other”, “Load in HyperView
Player”, “Unload".

Representations
Consist of representation import options “Load”, “Load in other HM”, “Load in Hyper View Player”,
“Unload”, and “Save”.

Review Results
Comparison and Intersection results are directly displayed in HyperMesh graphics. For Comparison
function, you can right-click on Base Part and select review to display the base part and
matched variant parts in the graphics area along with mismatched area with temp nodes.

CSV

Compare
Compare and identify unmatched information between a CSV file and the imported BOM file.
Results will be populated in the Error column. The CSV file header details can be configured
through the Configuration option, under the CSV comparison section.

Export
Export selected parts and children parts in to a CSV file.

Update
Read a CSV file exported with the Export function, and update the information displayed
in the Verification browser. The Entities column is the reference column considered for
updating the BOM.
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Tools
Consist of “Divide Slides”, “Open In Explorer”, “Reset Results”, “Get Revision menus”, details are
available in the functional detail sections.

Configuration
Open the configuration dialog.
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Import Models
Import a model using Model Verification.

1. In the Comparison/Verification browser, right-click and select Import from the context menu.
The Import - Model Verification dialog opens.

2. Select Import Type for Base Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD section)

• FE (Refer Config / FE section)

• Multiple Assembly (Multiple CAD assembly files)

• Spot Files (Refer Config / FE / Connector section)

3. Select a datatype.

Respective data types will be listed.

4. Click the folder icon and navigate to the model to import (Folder/File selections).

Figure 1488:

5. Choose a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode.

6. The Processes drop-down list becomes active when you select Background, and it also depends
on the processor. The Model Verification tool launches as many hmbatch processes selected.

• Choose Check to execute only the comparison without the report generation.

• Choose Report to generate only the Reports (Check executed previously).

• Choose Both to perform the comparison report generation sequentially.

7. Click Run to execute the function.

8. Click Stop to stop all the operation.
This will close front and background HyperMesh sessions. The Comparison/Intersection browser is
populated with the parts structure.

Note:  This function can be used to create XML or to review the model. This function is
included in all Verification and Comparison function.
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Perform Model Checks
Perform various model checks in the Comparison Browser.

Offset
Offset is mainly used to offset surface to mid plane location and to convert the CAD files to .hm format.

Before you begin, it is expected that the BOM or CAD data contains thickness information in order to
perform offset. If a thickness value does not exist, you can input a constant thickness for offset.

1. In the Comparison browser, right-click and select Comparison/Verification > Offset from the
context menu.
The Offset dialog opens.

2. Select an Import Type for Base Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD section)

• FE (Not Applicable)

• Multiple Assembly (Multiple CAD assembly files)

• Spot Files (Refer Config / FE / Connector section)

3. Select a datatype.

Respective data types will be listed.

4. Click the folder icon and navigate to the model to import (Folder/File selections).

Figure 1489:

5. In the Thickness[%] field, enter the thickness percentage used to offset/move the geometry.

6. In the Thickness field, enter the constant component thickness in case thickness value does not
exist in the CAD data or BOM file.

Offset distance = 50%*Thickness

7. Choose a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode.

8. The Processes drop-down list becomes active when you select the Background option and it
also depends on the processor.

The Model Verification tool launches as many hmbatch processes selected.
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• Choose Check to execute only the comparison without the report generation.

• Choose Report to generate only the Reports (Check executed previously).

• Choose Both to perform the comparison report generation sequentially.

9. Click Run to execute the function.

10. Click Stop to stop all the operation.
This will close front and background HyperMesh sessions. The browser is populated with offset
data in .hm format. The remainder of the check will use these .hm files.

Comparison
Comparison is used to compare two models using the Model Verification tool.

1. In the Comparison browser, right-click and select Check from the context menu.

2. Select Import Type for Base Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD files)

• FE (Solver deck file)

• Multiple Assembly (Multiple CAD assembly files)

• Spot Files (Not applicable)

3. Select a datatype (Respective data types will be listed).

4. Click the folder icon and navigate to the model to import (Folder/File selections).

Figure 1490:

5. Select Import Type for Variant Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD section)

• FE (nastran, pam, radioss, abaqus, optistruct, hyperMesh)

• Multiple Assembly (Multiple CAD assembly files)

• Spot Files (Not applicable)

6. Select a datatype.

Respective data types will be listed.

7. Click the folder icon and navigate to the model to import (Folder/File selections).
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Figure 1491:

8. In the Tolerance field, enter a value between 0.1 to 5mm to display unmatched entities.

9. Enter the Threshold[%] value.

Its min match percentage value, parts that are matching less than this value is treated as
Mismatching and parts that are matching above this value will be treated as Matching parts.

If the match percentage value is greater than the threshold value, then the two entities are shown
in report as overlaid image.

10. In the Report Path, field navigate to the directory where the reports generated by the Model
Verification tool will be stored.

11. In the Project Name field, enter a name for the project.

12. In the Slide Number field, enter a starting number of the slides to use in the PowerPoint report.

13. Select a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode.

14. The Processes drop-down list becomes active when the user selects the Background option and
it also depends on the processor.

The Model Verification tool launches as many hmbatch processes selected.

• Choose Check to execute only the comparison without the report generation.

• Choose Report to generate only the Reports (Check executed previously).

• Choose Both to perform the comparison report generation sequentially.

15. Click Run to execute the function.

16. Click Stop to stop all the operation.
This will close front and background HyperMesh sessions.

17. Click View Report to display the Summary PowerPoint report.
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Figure 1492: PowerPoint Summary
(Stored in Report Path)

The slide shows the comparison between a source assembly and the target assembly. The left
half of the image shows the source assembly and the right half of the image shows the target
assembly. In the example illustrated above, the source assembly has a total of 39 parts. The
target assembly has a total of 38 parts. The matching parts (between the source and target
assemblies) are highlighted in black and the unmatched parts are shown in red.

The second slide shows the matched and unmatched results for individual parts, number of parts
are limited to 40 which matches Excel report. This limitation can edited in configuration.
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Figure 1493: Matched and Unmatched Results
(from 2nd slide of Summary PowerPoint Report)

Output
Overview of the output generated from a Comparison check.

Excel
The contents of the Excel report depend on the number of parts/models that are being compared.
The report consists of the details of matched and unmatched parts from the assemblies selected for
comparison.
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Figure 1494:

The information in the Excel reports can be classified into different sections.

Base Model Input
Input information about each of the parts of the CAD model that the tool uses for performing the
a comparison check. The Base Model Input is the first assembly shown in the Part Browser, and
can be cross checked at row 5.

Variant Model Input
Results of the comparison check. The match percentage column shows a part vise match
percentage. If the value of match percentage for a part is 0 or less than the threshold percentage,
then the part is said to be unmatched with the corresponding part of the other assembly. If the
match percentage is above the threshold value, then the parts are considered matching. The error
is reported in the error column. Variant model’s Material name or Thickness values are compared
against Base model, mismatch values are shown in red text. Variant Model Input increases
depending on the number of Variant model found in the Variant Input folder. Variant model name
can be cross checked at row 5.

Image Type
Shortcut to the image the part.

• If the image type is JPG, then this shortcut opens the full sized image for viewing.
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• If the image type is H3D, then the shortcut opens in the part in H3D format in a new
HyperMesh window.

Comparison with Browser Selection
Compare CAD vs. CAD models, FE vs. FE models, and CAD vs. FE models with a Comparison check.

In the Comparison browser, you can select two modules that are required to be compared from the
Assembly browser. Use the Import Models function to import data into the browser, and then perform
the comparison.

Figure 1495: Import Data to Compare

Comments

• During a Comparison check, the part files may get reloaded several times. Converting all
models to the HyperMesh format can improve performance. It is recommended that you
perform a No-Offset operation before starting the comparison process by selecting Config >
Offset > <action>.

• During a Comparison check, the part files may get reloaded several times. It is recommended
that all models be in HyperMesh format to improve performance. Use the Offset operation
before performing a comparison.

• When generating reports, Excel or PowerPoint reports may open several times. It is
recommended that you do not to launch or close any Microsoft Office application or use the
keyboard during this operation.

• Translation or Smetry comparison runs using 1 CPU. A single CPU is automatically utilized,
even when you manually set multiple CPUs.
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• If more than one input model is found in the variant folder, a multiple model comparison is
activated.

• The folder structure is to be maintained when organizing variant model files. CAD files must
be managed under variant folders, and you must select the variant root folder. If the variant
root contains more than one sub folder (variants), a multiple model (variant) comparison is
activated.

Troubleshoot Model Verification Comparison Check Problems
Approaches used to troubleshoot Model Verification comparison check problems.

Comparison check results depend on the following Model Verification settings:

1. The type of CAD files and the corresponding license required to import the CAD files into Model
Verification.

2. The tolerance value specified in the GUI (Thickness/2.0).

3. Filters specified, such as those in the following list:

• Connection Name Filter

• Area Filter

• CG Filter

• Match % Filter

4. Availability of license when using the multiple CPU option. The unit requirement can be calculated
using this formula: 40 + ((No. of CPUs * 21) - 21)

Find which filter parts that are excluded from during comparison.

1. Turn on the debug log in the Configuration panel by selecting Tools > Configuration > Log.

2. Select log > add.

Figure 1496:

3. Restart HyperMesh.

4. Run the check again.

5. Check the Tk Console of the stdout files.
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Figure 1497:

6. Based on the information in the log file, identify the filters applied on the concern parts/PID.

Example: 5 vs 109 comparison is ignored due to the centroid distance between these parts are
more then value set in the config “cgtolerable-distance” value. In case these two parts need to be
compared, increase the “cgtolerable-distance” from 200 to desired value.

Intersect
Intersect checks provide information in Power Point reports on all the inter-part intersection/overlapping
in the CAD parts.

Once the model is done with the Intersection check, the tool locates the point of intersection as a cross-
hair and summarizes all the intersections found in the PowerPoint report.

1. In the Comparison browser, right-click and select Check > Intersect from the context menu.
The Intersection dialog opens.

2. Select Import Type for Base Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD files)

• FE (nastran, pam, radioss, abaqus, optistruct, hyperMesh)

• Multiple Assembly (Multiple CAD assembly files)

• Spot Files (Not applicable)

3. Select a datatype.

Respective data types will be listed.

4. Click the folder icon and navigate to the model to import (Folder/File selections).

The folder or the selected location must contain the spot weld file. The spot weld file type must be
set in the config file.
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Figure 1498:

5. In the Allowance field, enter a value between 0.1 to 5mm to display unmatched entities.

6. In the Report Path field, navigate to the directory where the reports generated by the Model
Verification tool will be stored.

7. In the Project Name field, enter a name for the project.

8. In the Slide Number field, enter a starting number of the slides to use in the PowerPoint report.

9. Choose a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode.

10. The Processes drop-down list becomes active when the user selects the Background option and
it also depends on the processor.

The Model Verification tool launches as many hmbatch processes selected.

• Choose Check to execute only the comparison without the report generation.

• Choose Report to generate only the Reports (Check executed previously).

• Choose Both to perform the comparison report generation sequentially.

11. Click Run to execute the function.

12. Click Stop to stop all the operation.
This will close front and background HyperMesh sessions.

13. Click View Report to display the Summary PowerPoint report.
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Figure 1499: PowerPoint Summary
(Stored in Report Path)

Figure 1500: PowerPoint Detailed Report (Stored in Report Path)
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Output
Overview of the PowerPoint report generated from the Intersection check.

A PowerPoint report is separated into several sections.

Report Header
Project name, assembly name, and slide number.

Assembly Picture
Image of the components that have intersection issues.

H3D Image
Section can be viewed in the HyperView Player, and shows the CAD model with the intersection
marked with Cross Hairs.

Issue Details
Details of components which have intersection issues.

User Review
Add additional information when exchanging information with designers/engineers.

Additional Info
Occurrences of the issue shown in the current slide. The number of instances show the number of
occurrences of the issue.

Spotweld
Spot Weld checks identify problems with spot welds in the model and shows them in the report.

The identified problems in spot welds are highlighted using a cross-hair in the images.

1. In the Comparison Browser, right-click and select Check > Spotweld from the context menu.
The Spotweld dialog opens.

2. Select Import Type for Base Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD files)

• FE (nastran, pam, radioss, abaqus, optistruct, hyperMesh)

• Multiple Assembly (Multiple CAD assembly files)

• Spot Files (Not applicable)

3. Select a datatype.

Respective data types will be listed.

4. Click the folder icon and navigate to the model to import (Folder/File selections).
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The folder or the selected location must contain the spot weld file. The spot weld file type must be
set in the config file.

Figure 1501:

5. In the Angle field, enter a value between 15 to 30 degrees for feature recognition.

6. In the Report Path field, navigate to the directory where the reports generated by the Model
Verification tool will be stored.

7. In the Project Name field, enter a name for the project.

8. In the Slide Number field, enter a starting number of the slides to use in the PowerPoint report.

9. Choose a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode.

10. The Processes drop-down list becomes active when the user selects the Background option and it
also depends on the processor.

The Model Verification tool launches as many hmbatch processes selected.

• Choose Check to execute only the comparison without the report generation.

• Choose Report to generate only the Reports (Check executed previously).

• Choose Both to perform the comparison report generation sequentially.

11. Click Run to execute the function.

12. Click Stop to stop all the operation.
This will close front and background HyperMesh sessions.

13. Click View Report to display the Summary PowerPoint report.
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Figure 1502: PowerPoint Summary
(Stored in Report Path)

Figure 1503: PowerPoint Detailed Report (Stored in Report Path)
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Output
Overview of the PowerPoint report generated from the Spot Weld check.

A PowerPoint report is separated into several sections.

Report Header
Project name, assembly name, and slide number.

Assembly Picture
Image of the components that have spot weld issues.

H3D Image
Section can be viewed in the HyperView Player, and shows an H3D image shows the FE model
with the spot weld marked with Cross Hairs.

Issue Details
Details of components which have spot weld issues.

User Review Section
Used to add additional information when exchanging information with designers/engineers.

Additional Info
Occurrences of the issue shown in the current slide. The number of instances show the number of
occurrences of the issue.

Supported Spotweld Checks
Overview of the spotweld checks available to perform in the model.

Closest
Detects the spot welds which are too close to each other. The closeness tolerance is used as the
criteria for deciding if two spot welds are considered as too close.

Figure 1504:

Gap
Detects the spot welds in which the distance between the spot weld location and the connected
components lie outside the given maximum and minimum gap limits.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2491

Figure 1505:

Single Layer
Detects the spot welds which are connected to only one part. The second part is missing from the
spot weld definition.

Figure 1506:

Multiple Layers
Detects the spot welds which are connected to more parts than what is specified as the threshold
number for multiple parts.

Figure 1507:

HyperMesh Issues
Detects the spot welds that failed during realization.
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Figure 1508:

Non-Parallel Flanges
Detects the spot welds that are connecting the non-parallel flanges. Flanges are said to be non-
parallel if there is a gap or step of the flanges diverge.

Figure 1509:

Incorrect Location
The Model Verifications creates feature lines internally to check the distance between the
connector and the feature line. When the distance between the connector and feature line is less
that the specified tolerance, the location of the connector is said to be incorrect. The feature angle
used to create feature lines is specified in the Feature Angle field.

Figure 1510:

Few Connections
Detects the possible locations where the spot welds may be missing. This detection is done based
on the adjacent spot welds in that area.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2493

Figure 1511:

Flange Gap
Detects if the gap between the flanges is within the minimum and maximum limit of the average
of the component thicknesses being connected by the weld.

Figure 1512:

Spotweld Intersection
Detects if a spot weld has an intersection with an unconnected component.

Figure 1513:
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Spotweld on Fillet
Detects if any spot weld is located on fillet features.

Figure 1514:

Reflect Spotweld
Detects if any spot weld can be realized on reflecting its location about a plane defined by the
user.

Figure 1515:

Connection
Connection check detects problems with parts/components such as bolts, nuts, clips, plates and reports
the problems in a PowerPoint file.

There are multiple checks that can be performed, depending on the selection, the tool perform the
checks and results of the checks are written out to the report files.

1. In the Comparison Browser, right-click and select Check > Connection from the context menu.
The Connection dialog opens.

2. Select Import Type for Base Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD files)

• FE (nastran, pam, radioss, abaqus, optistruct, hyperMesh)

• Multiple Assembly (Multiple CAD assembly files)

• Spot Files (Not applicable)
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3. Select a datatype.

Respective data types will be listed.

4. Click the folder icon and navigate to the model to import (Folder/File selections).

The folder or the selected location must contain the spot weld file. The spot weld file type must be
set in the config file.

Figure 1516:

5. In the Report Path field, navigate to the directory where the reports generated by the Model
Verification tool will be stored.

6. In the Project Name field, enter a name for the project.

7. In the Slide Number field, enter a starting number of the slides to use in the PowerPoint report.

8. Choose a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode.

9. The Processes drop-down list becomes active when the user selects the Background option and
it also depends on the processor.

The Model Verification tool launches as many hmbatch processes selected.

• Choose Check to execute only the comparison without the report generation.

• Choose Report to generate only the Reports (Check executed previously).

• Choose Both to perform the comparison report generation sequentially.

10. Click Run to execute the function.

11. Click Stop to stop all the operation.
This will close front and background HyperMesh sessions.

12. Click View Report to display the Summary PowerPoint report.
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Figure 1517: PowerPoint Summary
(Stored in Report Path)

Figure 1518: PowerPoint Detailed Report
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(Stored in Report Path)

Output
Overview of the PowerPoint report generated from the Connection check.

A PowerPoint report is separated into several sections.

Report Header
Project name, assembly name and slide number.

Full Assembly Picture
Image of the components that have connection issues.

H3D Image
Section can be viewed in the HyperView Player, and shows an H3D image shows the FE model
with the connections marked with Cross Hairs.

Issue Details
Details of components which have connection issues.

User Review Section
Used to add additional information when exchanging information with designers/engineers.

Additional Info
Occurrences of the issue shown in the current slide. The number of instances show the number of
occurrences of the issue.

Supported Connection Checks
Types of checks to perform on connections in the model.

Free Hole
Detects the holes in the model which do not have connectors around them.

Figure 1519:

Free Bolt-Nut
Detects the bolts and nuts which do not have corresponding holes to fit in.
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Figure 1520:

Bolt Hole Mismatch
Detects the bolts which have a hole around it, but the distance between the bolt center and hole
center is more than the threshold value.

Figure 1521:

Nut Hole Mismatch
Detects the nuts which have a hole around it, but the distance between the nut center and the
hole center is over the threshold.

Bolt-Nut Mismatch
Detects the bolt nut pairs whole location or alignment direction do not match properly.

Figure 1522:

Bolt-Nut Size Mismatch
Detects the bolt nut pairs whose sizes are different from each other.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2499

Note:  The diameters of bolt, nut and clip are found through a CSV file.

Figure 1523:

Holes Mismatch
Detects pairs of holes whose center axes do not match.

Figure 1524:

Holes Pair Missing
Detects the holes that do not have a corresponding pairing hole within the specified tolerance.

Figure 1525:
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Clip Mismatch
Detects the clips which have a hole around it but the distance between the clip center and the
hole center is over the threshold.

FreePart
FreePart check detects the components in a model that are not connected to any other component
through ID connectors or shared nodes.

1. In the Comparison Browser, right-click and select Check > FreePart from the context menu.
The Freepart dialog opens.

2. Select Import Type for Base Model (Supported types are below).

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD files)

• FE (nastran, pam, radioss, abaqus, optistruct, hyperMesh)

• Multiple Assembly (Multiple CAD assembly files)

• Spot Files (Not applicable)

3. Select a datatype.

Respective data types will be listed.

4. Click the folder icon and navigate to the model to import (Folder/File selections).

The folder or the selected location must contain the spot weld file. The spot weld file type must be
set in the config file.

Figure 1526:

5. In the Gap field, enter the gap to use between two components to check if they are connected or
disconnected.

6. In the Report Path field, navigate to the directory where the reports generated by the Model
Verification tool will be stored.

7. In the Project Name field, enter a name for the project.

8. In the Slide Number field, enter a starting number of the slides to use in the PowerPoint report.

9. Choose a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode.

10. The Processes drop-down list becomes active when the user selects the Background option and it
also depends on the processor.
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The Model Verification tool launches as many hmbatch processes selected.

• Choose Check to execute only the comparison without the report generation.

• Choose Report to generate only the Reports (Check executed previously).

• Choose Both to perform the comparison report generation sequentially.

11. Click Run to execute the function.

12. Click Stop to stop all the operation.
This will close front and background HyperMesh sessions.

13. Click View Report to display the Summary PowerPoint report.

Figure 1527: PowerPoint Summary and Detailed Report
(Stored in Report Path)
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Figure 1528: PowerPoint Detailed Report
(Stored in Report Path)

Output
Overview of the PowerPoint report generated from the FreePart check.

A PowerPoint report is separated into several sections.

Report Header
Project name, assembly name, and slide number.

Assembly Picture
Image of the components that have free part issues.

H3D Image
Section can be viewed in the HyperView Player, and shows an H3D image shows the FE model
with the free parts marked with Cross Hairs.

Free Part Details
Details of components which have free part issues.
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User Review Section
Used to add additional information when exchanging information with designers/engineers.

Spot Comparison
Spot Comparison check compares two spot connector files using the Model Verification tool.

Supported Model Verification formats include:

1. In the Comparison Browser, right-click Check > Spot Comparison from the context menu.
The Spotcompare dialog opens.

2. Select Import Type for Base Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD files)

• FE (nastran, pam, radioss, abaqus, optistruct, hyperMesh)

• Spot Files (.vip, .mwf, .mcf, and .xml)

3. Select a datatype.

Respective data types will be listed.

4. Click on the folder icon and navigate to the model to import (Folder/File selections).

Figure 1529:

5. Select Import Type for Variant Model.

• XML (PLMXML or UDMXML)

• Assembly (CAD assembly files: UG Assembly, CATProduct, JT Assembly…)

• CAD (Refer Config / CAD files)

• FE (nastran, pam, radioss, abaqus, optistruct, hyperMesh)

• Spot Files (.vip, .mwf, .mcf, and .xml)

6. Select a datatype.

Respective data types will be listed.

7. Click on the folder icon and navigate to the model to import (Folder/File selections).

8. In the Report Path, navigate to the directory where the reports generated by the Model
Verification tool will be stored.

9. In the Project Name field, enter a name for the project, if applicable.
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10. In the Slide Number field, enter a starting number of the slides to use in the PowerPoint report,
if applicable.

11. Choose a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode.

12. The Processes drop-down list becomes active when the user selects the Background option and it
also depends on the processor.

The Model Verification tool launches as many hmbatch processes selected.

• Choose Check to execute only the comparison without the report generation.

• Choose Report to generate only the Reports (Check executed previously).

• Choose Both to perform the comparison report generation sequentially.

13. Click Run to execute the function.

14. Click Stop to stop all the operation.
This will close front and background HyperMesh sessions.

15. Click View Report to display the Summary PowerPoint report.

Figure 1530: PowerPoint Summary Report
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(Stored in Report Path)

CSV-Comparison
CSV comparison tool compares CAD/FE attributes against CSV file column.

Supported attributes are Part name, PID, Part Number, Material Name, Thickness, File name. It has 3
options, “compare”, “compare-update” and create “new XML”.

1. In the Comparison Browser, right-click on CSV Comparison from the context menu.

2. Click on Compare.
The File Selection window opens.

3. CSV file must be selected.
Check will proceed.

It generates reports showing the updated information in Excel report same as comparison.

Multiple Checks
Multiple Checks perform multiple checks using single interface.

If Offset check is ON, CAD data will be offset using thickness value. Offset CAD data will be used
to check all other checks. Check and Reports are sequentially executed for each check. Offset,
Intersection, Spotweld, Connection, Free Part check uses Base Model selection alone and ignore Variant
model selections. Comparison function uses both Base Model and Variant Model selections. Check items,
input rules are as per individual checks explained in respective check functions.

1. In the Comparison Browser, right-click on Check > Multiple_Checks from the context menu.
The Model Verification dialog opens.

2. Upload the base model using the Base Model options.

a) Select an import type.

b) Select a data type.

c) Navigate to the model to import.

3. Upload the variant model using the Variant Model(s) options.

a) Select an import type.

b) Select a data type.

c) Navigate to the model to import.

Figure 1531:
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4. Select the type of checks to perform, and define additional settings as needed.

5. In the Report Path, navigate to the directory where the reports generated by the Model
Verification tool will be stored.

6. In the Project Name field, enter a name for the project.

7. In the Slide Number field, enter a starting number of the slides to use in the PowerPoint report.

For example, if you enter a value of 1 for the slide number, then the slide numbers in the report
starts from 0001.

8. Choose a method for running the model.

• Choose Interactive to run the model in the same HyperMesh session.

• Choose Background to launch a new HyperMesh session in batch mode and perform the
operation. The Background run mode is faster than the Interactive mode and also allows you
to utilize multiple processors that are available on the machine to complete the operation
faster. Each pair of models are divided and handled in multiple HyperMesh sessions depending
on the number of processes selected.

9. For Action, choose to an operation to perform.

• Choose Check to only perform a check.

• Choose Report to generate a PowerPoint report.

• Choose Both to perform a check and generate a report.

10. Click Run.
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Configure Model Verification Settings
Overview of various settings that can be configured for Model Verification.

1. In the Comparison/Intersection browser, right-click and select Configuration from the context
menu.
The Configuration dialog opens.

2. Configure settings as needed.

3. Click OK to save and load the new settings in current session.

log
Specify default values for Model Verification log file settings.

Settings
type

Type of log information output.
Default: file or channel

destination
Log information file name.
Default: stdout, path , stderr

level
Level of messages to be written in the log file.
Extension: debug, info, notice, warn, error, critical, alert or emergency

Remove Log Information
Right-click on log and select - > Cut Item

Display Log Information
Right-click on log and select Add Item

cad
Specify defaults for CAD model import - file extensions.

Settings
type

Supported CAD file format.
Default allowed: catia, iges, jt, parasolid, proe, step, ug or hypermesh

catia
File extension of CATIA children file, user, can add many extensions for this type.
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extension
CATPart

iges
File extension of IGES children file.

extension
.igs or .iges

jt
File extension of JT children file.

extension
.jt

parasolid
File extension of Parasolid children file.

extension
.x_t, .x_b or .xml_txt

proe
File Extension of Creo children file.

extension
.prt

ug
File extension of UG children file

extension
.prt

step
File extension of STEP children file.

extension
.step or .stp

hypermeshcad
File extension of HyperMesh children file.

extension
.hm

Import Settings

readMultipleParts
Single CAD file will be the input and each part inside the file will be physically separated and
exported to create part structure.
Default/Allowed: ON or OFF
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readmetadata
Reads metadata from the IGS file and displays those information like PID, Name in the Parts
attribute column.
Default/Allowed: ON or OFF

readFileHeader
Reads information stored in the IGS file header and displays the information in the Part
attribute column.
Default/Allowed: ON or OFF

readTransformation
Takes care of reading and managing transformation or part position information. It also
takes care of the parts position while CAD offset. Parts will not be in the correct position, if
this option is OFF, while executing surface offset.
Default/Allowed: ON or OFF

thickness-update
If this option is ON, thickness value from Offset function’s GUI will be used as standard
thickness for all parts during surface offset. This is done to assign clearance between parts
while checking Intersection.
Default/Allowed: ON or OFF

fe
Specify defaults for FE model solver types, version and file extensions.

Settings
type

Supported CAD file format.
Default/Allowed: dyna, nastran, pam, radioss, abaqus, optistruct, connector or hypermesh.

dyna
File extension of LS-DYNA input file, user can add many extensions for this type.
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version
971

extension
.k, .key, .dat, .dyn*, or .dynain.

nastran
File extension of Nastran input file, user can add many extensions for this type.

extension
.bdf, .bulk, .blk, .dat, .nas or .nastran

pam
File extension of PAM-CRASH input file, user can add many extensions for this type.

version
2015

extension
.pc or .dat

radioss
File extension of Radioss input file, user can add many extensions for this type.

version
120

extension
.d00, .d01, .rad or ._000.d01

abaqus
File extension of Abaqus input file, user can add many extensions for this type.

version
Explicit, Standard.2d or Standard.3d

extension
.imp or .pes

optistruct
File extension of OptiStruct input file, user can add many extensions for this type.

extension
.fem

connector
File extension of Connector input file used for Spot weld check and Spot comparison function.
If the type specified here and the actual file extension are not matching, the Check will not be
executed.

version
971

extension
.vip, .mcf (HM format), .mwf, .xml (HM format)
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hypermeshcad
File extension of HyperMesh file contains only Mesh.

extension
.hm

Import Settings
fe-attached

Parts with node sharing are organized to one part if the thickness of these parts are not same.
The organization will not be executed if the thickness of these parts are same.
Default/Allowed: ON or OFF

fe-dettach
LH and RH parts will be separated two separated physical part incase these two parts are
organized in to one part.
Default/Allowed: ON or OFF

importby
While importing fe data in to HyperMesh creating components by reading HyperMesh Comments
or by reading HyperMesh information managed in HyperMesh file.
Default/Allowed: hmcomments or property

Include-stamping
Reads stamping results information like Element shell thickness from the solver deck. This
information will be used for mass calculation. Property thickness will be ignoredm if this option is
ON.
Default/Allowed: ON or OFF

dummy-thickness
Assigns a dummy thickness for the FE data in case the thickness no thickness or property
assigned to the part. This dummy thickness is needed for CAD solid vs FE comparison in case no
thickness exist from the original FE.
Default/Allowed: ON or OFF.

general
General defaults for the Model Verification instance.

GUI Settings
project

Project name displayed in PowerPoint report
Default/Allowed: 2015-ModelX

action
Type or Run to be selected.
Default/Allowed: check, report or both

auto-close
After the check and report is complete the GUI will be closed automatically if this is ON.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2512

Default/Allowed: 0 or 1

number-of-processes
Number of parallel processing to be executed. It is advised to keep 2 CPUs for System purpose.
Default/Allowed: 1 to 32

number-of-processes-max
Maximum number of parallel processor allowed (Total # CPUs – 2).
Default/Allowed: 2 to 32

assembly-level
This value indicates the number of level above the part to be considered as Assembly Name.
Assembly name is used in Intersection, Comparison, Reports. Parts will be skipped if the base,
variant assembly names are not same during Comparison.
Default/Allowed: 0 - 10

metalTrim-level
This value indicates the number of level above the part to be considered as Sheet Metal or TRIM
Name.

METAL-METAL
All the parts inside the METAL folder will be checked.

TRIM-TRIM
All the parts inside the TRIM folder will be checked.

METAL-TRIM
Parts across METAL and TRIM folder will be checked. No check will be executed inside the
METAL or TRIM folders.

Default/Allowed: 0 - 10

port
This value to be edited incase of specific port is needed for Thread communication.
Default/Allowed: 0

timezone
Not valid.

deleteLogFiles
Deletes all of the scratch files after the report generation. All of the XML, HM, Image files will
remain if this is OFF.
Default/Allowed: ON or OFF

maxloopcount
Maximum number of recovery limits in case of crash or application hanging.
Default/Allowed: 2 - 50

wait-time
Maximum wait time for a process to wait for a check per part or pair of part.
Default/Allowed: 400 - 3200 (seconds)

progress-time-scale
Progress bar interval, do not reduce but can increase the value.
Default/Allowed: 2000
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configa-application
File extension of Parasolid children file.
Default/Allowed: C:/windows/System32/notpad.exe

Model / Preview / Import-type
When preview huge CAD data, the CAD option allow to read the CAD as it is. The Facet option
reads CAD by converting to Facets, this is done for the performance and visualization purpose.
Default/Allowed: CAD or Facets

Representation Settings
reptype-name / CAD

Allowable representation type for original CAD data read. Do not change.
Default/Allowed: common

reptype-name / Common Midsurface
Allowable representation type for Midsurface data. Do not change.
Default/Allowed: common Midsurface

reptype-name / FE
Allowable representation type for FEM data. Do not change.
Default/Allowed: Mesh FE

Solid Recognition
model / close-shell / free-edge-allowance

Allowable number of free edges, if actual number of free edges in the CAD is less than this value
is solid CAD data.
Default/Allowed: 1 to 4

model / close-shell / mesh / free-edge-allowance
Allowable distance between two nodes to be automatically equivalenced or stitched.
Default/Allowed: 0.01 to 0.1

auto-rename
tool / auto-rename

CAD Name will be assign to Part Name of the browser by considering below string pattern.
Default/Allowed: ON or OFF

auto-renumber
tool / auto-renumber

CAD Name will be assign to PID of the browser by considering below string pattern. By default the
IDs will be renumbered from 1. This must be turned OFF if the PID and Part Names are managed
in CAD attributes.
Default/Allowed: ON or OFF

type
Part name subexpression along with PID value will be assigned.
Default/Allowed: $sub() $pid
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start-with
Part name subexpression along with PID value will be assigned.
Default/Allowed: $sub() $pid

increment
Part name subexpression along with PID value will be assigned.
Default/Allowed: $sub() $pid

rename / part-id / pattern
Decimal value, except excluding first 0 will be read from file name and assigned as PID.
Default/Allowed: 0*(\d+)

rename / part-id / format
Regular subexpression will be used.
Default/Allowed: $sub(0)

rename / part-name / pattern
String value will be read from file name and assigned as PartName.
Default/Allowed: (\w+)

rename / part-name / format
Part name subexpression along with PID value will be assigned.
Default/Allowed: $sub(0) $pid

pName To PID map
Below Letter to Integer table is used while renumbering the PID if ON. The normal auto-renumber
will be applied if OFF.
Default/Allowed: ON or OFF

Letter to integer map
Mapping table to change string value to decimal value for the PID Column.
Default/Allowed: Alphabet(A-Z): Decimal value (1-1000)

String-length
Number of digits to be considered for the Renumber using mapping table.
Default/Allowed: 5 to 8

comparisonunified
Defaults for the offset functionality of Model Verification.

GUI Default Settings
tolerance

Search tolerance for searching nearest parts as well as search tolerance for finding matching
entities.
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In case of Solid CAD vs FE, FE data must have correct thickness on property and the tolerance
can be from 0.1 to 0.5mm. In case of sheet metal parts, the recommended tolerance is 1.0mm.
Default/Allowed: 0.1 to 5.0 mm

threshold
Cut off percentage for judging matched or unmatched parts. Too low value like 5% are not
recommended while checking huge number of parts.
Default/Allowed: 15 to 30%

base-directory
Initial director for Base model.
Default/Allowed: C:/temp

base-filetype
Input model types.

XML
BOM file or UDMXML file saved from HyperMesh.

CAD
CAD geometry,1 part/file (folder contains multiple CAD).

FE
Solver Deck file (single file).

Assembly
CAD Assembly file (CatProduct/JT Assembly).

Multiple Assembly
Multiple Assembly files.

Spot File
Spot weld files (.vip, .mwf, .mcf, or .xml).

Default/Allowed: XML/CAD/FE/Assembly/../Spot File

variant-directory
Initial director for Variant model.
Default/Allowed: C:\temp

variant-filetype
Input model types.
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XML
BOM file or UDMXML file saved from HyperMesh.

CAD
CAD geometry,1 part/file (folder contains multiple CAD).

FE
Solver Deck file (single file).

Assembly
CAD Assembly file (CatProduct/JT Assembly).

Multiple Assembly
Multiple Assembly files.

Spot File
Spot weld files (.vip, .mwf, .mcf, or .xml).

Default/Allowed: XML/CAD/FE/Assembly/../Spot File

report
Initial director for report out path.
Default/Allowed: C:/temp

report option
Output report formats. After check is completed, user can change this option to generate report
any number of times. Excel report is faster than PowerPoint report.
Default/Allowed: Excel, PowerPoint or both

scope
Output result types.

Matched
30.0 (threshold) to 100% matched parts

Unmatched
0.0 to 30% matched parts

Both
0.0 to 100% parts

Default/Allowed: matched, unmatched or both

imageType
Output image types.

.jpg
Light weight 2D

Default/Allowed: .h3d or .jpg

mode
Default radio button options for Run type.

interactive
Checks will be run in the front ground HyperMesh session.
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background
Checks will be executed in the background HyperMesh sessions, if error occurs recovery will
be executed, the errors will be displayed in the browser as “Crash” key word.

Default/Allowed: interactive or background

Comparison Settings
Check elems in Surf Hole

CAD holes vs FE holes are compared, displays if any mismatches in the holes via comparison
report.

Check
Compares FE holes vs surface holes or surface holes vs FE holes.
Default/Allowed: ON or OFF

Min Dia of Hole
The minimum hole diameter for checking the holes mismatch. Big diameter holes are taken care
by default.
Default/Allowed: 0.5 to 5.0

Max Dia of Hole
The maximum hole diameter for checking the holes mismatch.
Default/Allowed: 5 to 20.0

free-edge-check
Compares free edge of FE data against free edges of CAD surface boundary lines, mismatch will
be displayed in the comparison report.

Default/Allowed: ON or OFF

free-edge-tolerance
Free edges in FE data less than this tolerance will be ignored.
Default/Allowed: 0.0. to 0.1mm
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find-cad-thickness
Calculates thickness from cad by using Volume and Area of the CAD, the Thickness column will
display the results. This calculated thickness value will be given preference over GUI tolerance for
judging the match percentage.
Default/Allowed: ON or OFF

use-fe-thickness
Thickness from FE data be given preference over GUI tolerance for judging the match percentage.
Default/Allowed: ON or OFF

delete-fefiles
Deletes the temporary FE folder created my MVD during the CAD-FE comparison. Once this folder
is deleted, Result review may not be possible.
Default/Allowed: ON or OFF

bomcomparison
Compares PID, MATERIAL, THICKNESS, WEIGHT values, except the shape comparison.
With bomcomparison=ON, and same-id-only=ON options, BOM comparison is executed,
PowerPoint and Excel Reports are generated.
Default/Allowed: ON or OFF

contactcomparison
Comparison of contact cards for the parts, it checks for card names and number of contact cards.
Limited to Radioss, Nastran, PAM-CRASH, LS-DYNA.
Default/Allowed: ON or OFF

loadcomparison
Comparison of Load collector cards for the parts, it checks for card names and number of contact
cards. Limited to Radioss, Nastran, PAM-CRASH, LS-DYNA.
Default/Allowed: ON or OFF

remove-pinhold
Removes small diameter in holes on CAD surface, applicable only on CAD-FE comparison.
Default/Allowed: ON or OFF

pinhold-radius
Pin hole radius, holes less than this value will be physically removed while comparison.
Default/Allowed: 0.1 to 5.0

modeassembly
After comparison for unmatched parts below, process is automatically executed.

• Group parts based on match% and report threshold%

• Execute Batchmesher

• Replace CAD with Batch Meshed FEs

• Assign material and property

• Load assembly (old + new mesh) import
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• Parts Group (Part Browser / Part Set View)

Default/Allowed: ON or OFF

loopLimit
Each time two parts will be compared if the value is 0. # of parts are loaded at once in one
HyperMesh session and comparison will be executed, if the value is more than 0.
Default/Allowed: 0 to 1000

samelocation
Parts will be searched at same location of base part, along with the tolerance value. Parts far from
each other will be ignored. Works fine with small offset between both parts.

Default/Allowed: ON or OFF

translation
Parts will be searched at same location of base part, if the same shape part is not found, the
variant part is translated, then translated comparison will be executed. Translation distance will be
automatically calculated.
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Default/Allowed: ON or OFF

symmetry
Parts will be searched at same location of base part, if the same shape part is not found variant
part is reflected, then symmetry comparison will be executed. Symmetry plane will be calculated
by parameter below.

Default/Allowed: ON or OFF

symmetryPlane
Plane to be considered for symmetryPlane comparison.
Default/Allowed: xy, yz or zx

Filters
cgtolerance-distance

Distance between centroid of base mode part and variant model part. Parts will not be compared,
if the parts centroid are more than this value. Recommended value is around 200mm.
Default/Allowed: 10 to 1000
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min-areapercent
Minimum area ratio of base and variant parts. Parts will not be compared, if the parts ratio is less
than this value. Recommended value is around 60%.
Default/Allowed: 1 to 60%

max-areapercent
Maximum area ratio of base and variant parts. Parts will not be compared, if the parts ratio is
more than this value. Recommended value is around 140%.
Default/Allowed: 101 to 140%

same-pid-only
Parts with same PID will be compared and Parts with different PIDs will be ignored, if the value
is ON. There is not much gain in the performance, but 1% match will be reported, in case this
option is ON. This must be turned OFF in case not all the parts PID are NOT matching.
Default/Allowed: ON or OFF

same-partname-only
Parts with same PartName will be compared and Parts with different PartName will be ignored, if
the value is ON. This must be turned OFF in case not all the parts Name are NOT matching.
Default/Allowed: ON or OFF

compare-midsurf
Solid CAD vs Mid Mesh comparison will happen if this value is ON. This will affect only CAD-FE
only when CAD is solid or closed volume surface.
Default/Allowed: ON or OFF

seamtreatment
Seam nodes are excluded from the unmatched percentage calculation. This must be turned OFF in
case Seam welds are not used in FE model.
Default/Allowed: ON or OFF

bbox-view
Bounding boxes for each part are displayed in the HyperMesh graphics for reference after the
check and report is done. User can check if both of CAD or FE is at same place or same size.
Default/Allowed: ON or OFF

Representation Comparison
Check

Single BOM comparison will be executed, if this parameter is ON, inside single part multiple
representations will be compared and reports generated. Two model comparisons will be
executed, if this parameter is OFF.
Default/Allowed: ON or OFF

base-reptypes
Representations available in the Part Browser. CAD represents the Original CAD data, Mesh
represents the FE data created by Batchmesher.
Default/Allowed: CAD, Mesh or Common

Variant-reptypes
Representations available in the Part Browser. CAD represents the Original CAD data, Mesh
represents the FE data created by Batchmesher. Usually this can be Mesh or Common.
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Default/Allowed: CAD, Mesh or Common

Rep Comparison Output (stored in Report folder

Match-area
cad-fe, cad-cad, fe-fe

Matched
Matched results will be calculated only if the entities are at exact location.

matched-overlapped
Matched results will be the sum of matched and Overlapped entities.

matched-overlap-intersected
Matched results will be the sum of matched, Overlapped and Intersected entities.

Default/Allowed: matched, matched-overlapped, or matched-overlapped-intersected

match-value
Match % output type.
Default/Allowed: source, target or average

round-off
Match % display format.
Default/Allowed: up, down, nearest, or %.2f

Details on the Calculation Method
Matched

Occurs when a source or target surface is within the given tolerance of a compared surface using
a direct surface to surface comparison. All points and lines comprising each surface must match
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between the surfaces. Each matched surface is placed in a separate match type group with the
surface it matches.

Unmatched
Occurs for surfaces and elements when the matched criteria are not met.

Overlapped
Occurs when all facet nodes of a source or target surface are within the given tolerance of the
compared surfaces and all of the facet nodes on the nearest compared surfaces' exterior edges
are within the given tolerance of the source or target surface's exterior edges.

Intersected
Occurs when at least one but not all facet nodes on a source or target surface are within the given
tolerance of the compared surfaces or at least one of the facet nodes on the nearest compared
surfaces' exterior edges is outside the given tolerance of the source or target surface's exterior
edges.
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intersection
Configurations for the intersection check functionality.

GUI Default Settings
tolerance

Depth of the intersection to be filtered. Intersection less than this value will not be reported in the
PowerPoint.

Default/Allowed: 0.1 to 1.0 mm

slide-number
The starting number is shown in right top corner of PowerPoint file.

Default/Allowed: 1 to 10000

report
Initial directory for report output path.
Default/Allowed: C:/temp

action
User action type to be executed.
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Check
Only intersection check will be executed, no reports.

Report
Only Reports will be generated from the previous check

Both
Check and Report generation will be executed in a sequence.

Default/Allowed: Check, Report or Both

mode
Default opitons for Run type.

interactive
Check executed in the front ground HyperMesh session

background
Check executed in the background HyperMesh sessions, automatic restart executed, if
errors occur, the errors will be displayed in the browser as "Crash" keyword.

Default/Allowed: interactive or background

logic
Algorithm used for the checks.

allcomp
All parts will be imported, and check will be executed. Faster than “loop” logic but it requires
good PC hardware.

loop
Two part will be imported at once and check will be executed, very slow but with less
memory full model can be checked.

subsystem
Checks are executed across two subsystems, if two or more subsystems are selected from
the tree or selected via assembly-level option. All parts will be checked, if one sub-assembly
is selected from tree or assembly-level is 0.

Default/Allowed: allcomp, loop or subsystem

Clearance_Zone (CL)
Clearance value will be assigned on the CAD data during the intersection check. Half of the value
will be assigned on each side of the CAD data. Increasing the value might increase the execution
time.
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Default/Allowed: 0.0. to 5.0 mm

Filter Settings
revision-check

New revisioned CAD data and its surrounding CAD data will be checked for intersection, if this
option is ON. All the CAD parts irrespective of revision will be checked, if this option is turned OFF.
Default/Allowed: ON or OFF

revision-folder
Initial directory for selecting the revision CAD data. File name is compared against files in the
selected folder and CAD files will be replaced and revision flag is ON for that part.
Default/Allowed: C:/temp

body-type
Special treatment based on the name.

METAL-METAL
All the parts inside the METAL folder will be checked.

TRIM-TRIM
All the parts inside the TRIM folder will be checked.

METAL-TRIM
Parts across METAL and TRIM folder will be checked. No check will be executed inside the
METAL or TRIM folders.

Default/Allowed: METAL-METAL, TRIM-TRIM or METAL-TRIM

Max-number-solids
Parts will not be considered for the check, if the number of solid CAD inside a part exceeds this
number. This is done to avoid check on solid spot welds or harness cables.
Default/Allowed: 2 to 150

loopLimit
Each time two parts will be compared if the value is 0. If more than 0, parts (specified # of parts)
are loaded at once in one HyperMesh session and comparison will be executed.
Default/Allowed: 0 to 1000

min-areapercent
Minimum area of part that must be considered for the check. Area of the part less than this will be
ignored in the check. This is implemented to avoid small parts that do not have proper Name or
Part Number.
Default/Allowed: 1.0 to 1000.0 mm square

min-Diagonal-BBox
Minimum bounding box diagonal length of part that must be considered for the check. Diagonal
length of the part less than this will be ignored in the check. This is implemented to avoid small
parts that do not have proper Name or Part Number.
Default/Allowed: 1.0 to 10.0 mm

bbox-view
Bounding boxes for each part are displayed in the HyperMesh graphics for reference after the
check and report is done. You can check if both of CAD or FE is at same place or same size.
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Grey box
Indicates # CPUs

Green box
Indicates bounding box of the parts.

Default/Allowed: ON or OFF

spotweld
Specify defaults for the spotweld check functionality of Model Verification.

General Settings
angle

Feature angle of the faces of FE.
Default/Allowed: 25 to 30 degrees

Slide-number
The starting number shown in right top corner of PowerPoint file.

Default/Allowed: 1 to 10000

input
Initial directory for the Input file path.
Default/Allowed: C:/temp

output
Initial directory for report output path.
Default/Allowed: C:/temp
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action
User action type to be executed.

Check
Only intersection check will be executed, no reports.

Report
Only Reports will be generated from the previous check.

Both
Check and Report generation will be executed in a sequence.

Default/Allowed: Check, Report or Both

mode
Default options for Run type.

interactive
Check executed in the front ground HyperMesh session

background
Check executed in the background HyperMesh sessions, automatic restart executed, if
errors occur, the errors will be displayed in the browser as "Crash" keyword.

Default/Allowed: interactive or background

vip-format
Space or 8-digit separated format.
Default/Allowed: space or 8-digit

resolveconflictingpid
5 digits or 7 digits format correction.
Default/Allowed: ON or OFF

realize-check
Ignores failed spot welds during the check.
Default/Allowed: ON or OFF

allow-multiple-issues
All check on all spot welds, there may be many issues on same welds.
Default/Allowed: ON or OFF

extract-spot-cad
Converts CAD points / solids to spot weld file. A copy of the spot weld vip file will be stored in
CAD folder.
Default/Allowed: ON or OFF

extract-spot-cad-option
Converts point/solid entities to spot weld file.
Default/Allowed: points or solids

realize-tolerance (tol)
Allow searching nearest spot on same Layer or different layer or bot / all duplications.
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Default/Allowed: 1.0 to 10.0

Closest
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

Tolerance (tol)
Distance between two spot welds less than/equal to this tolerance are reported as duplicates.
Distance are calculated after projecting to normal direction.

Default/Allowed: 0.1 to 20.0

checktypes
Allow searching duplicate spot welds on same layer (Same weld plates) or different layer or bot /
all duplications.
Default/Allowed: sameStack, DifferentStack or Both

Spot weld found with the search radius of tolerance is identified.
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Gap
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

min
Minimum gap between Spot location and the weld plates.

Default/Allowed: 1.0 to 10.0

max
Maximum gap to be considered between Spot location and the weld plates. This value is added to
filter some spotwelds which are too far from the model.
Default/Allowed: 10.0 to 100.0

Spot weld between min and max distance from the nearest flange is identified, perpendicular distance is
checked.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2531

Single-Layer
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

Self-welded spot welds are identified for reference. The link component 1 and link component 2 is
same.

Multi-Layer
do-check

Turn OFF or ON the check
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Default/Allowed: ON or OFF

threshold
Maximum allowed spot weld layers.
Default/Allowed: 2 to 4

Spot welds that has layers more than threshold value are identified for reference. It is expected to have
a notch to allow Spot gun.

hm-issue
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

Spot welds that are far from the Sheet metal part by “tolerance” search are identified and Part missing
issues are directly identified by HyperMesh.

Tol
realize-tolerance (tol)
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Parallel-flanges
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

angle
Maximum angle between two plates at spot location.
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Default/Allowed: 2.0 to 15.0

max-gap
Maximum physical gap between two plates at Spot location.
Default/Allowed: 1.0 to 5.0

Non-Parallel flanges are identified at Spot weld location, if the angle between two sheet metal parts is
more than angle value and more than gap value are identified.

Incorrect-Location
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

min-distance (min)
Minimum distance allowed from feature-line to the spot location.
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Default/Allowed: 1.0 to 5.0

Issue is Identified, if the distance between Spot weld and the nearest feature edge is more than the
tolerance value. The tolerance refers to Spot gun “radius+gap”.

Few-Connections
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

Proximity (a)
Search tolerance for realizing spot weld on the flanges, it is global pitch.
Default/Allowed: 1.0 to 5.0 mm

pitch-spacing (b)
Average pitch distance for creating spot weld on flange.
Default/Allowed: 15.0 to 30.0
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pitch-offset (c)
End offset distance on both side of the flange.
Default/Allowed: 5.0 to 8.0

pitch-edge-distance (d)
Offset distance from the edge of the flange.
Default/Allowed: 5.0 to 8.0

search tolerance (e)
Tolerance for searching Virtua connectors from existing connectors created from above parameter.
Default/Allowed: 30.0

hole-diameter (f)
Search tolerance for finding nearest Bolt holes to avoid finding the issue.

Default/Allowed: 4.0 to 40.0

Creating virtual spot (VS) welds with above parameter. For every virtual connector (VC) search nearest
existing spot weld (blue) with “search tolerance” value, identify location (yellow), if blue spot weld not
found.
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Flange-gap
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

limit
+/- ratio of shortest gap between flanges at connector to average component thickness value. It
is also % of deviation.

Calculation : abs( D - d ) ≤ limit
Default/Allowed: 0.1 to 0.5 mm

This ratio of flange gap to average thickness of the component is compared with tolerance value. Issue
is identified if the difference is same or less than the limit value.

Note:  No Error will be reported if thickness does not exist or offset is not done.
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Intersection
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

spot-layers
Maximum number of layers considered for this check.

Default/Allowed: 2 to 3

Intersection on Spot realized FE data is found here or 2 layer to 3 layer or 3 layer to 4 layer conversion
possible welds are identified.
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Fillets
Fillet identification angle

do-check
Turn OFF or ON the check
Default/Allowed: ON or OFF

fillet-connelem-tol
Search tolerance for searching nearest fillet edges to the connector.

Default/Allowed: 10.0

If Spot welds location less than the fillet-connelem-tol distance from the nearest feature, line is
identified here.
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Reflect
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

reflect-plane
Reflecting plane for the model which the spot welds are reflected and checked again for
realization.

Default/Allowed: zx

origin
Origin value. (for XY plane, origin is constant Z value)
Default/Allowed: 0 to 1000.0

Failed spot welds are reflected at reflect-plane and re-realized, if successful in realization, it is identified
as issue.

Issues will be ignored if surface offset is not executed and another spotweld exist at reflected location.
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surrounding
do-check

Turn OFF or ON the check
Default/Allowed: ON or OFF

spot-layers
Maximum number of layers considered for this check.

Default/Allowed: 2 to 3

Intersection on Spot realized FE data is found here or 2 layer to 3 layer or 3 layer to 4 layer conversion
possible welds are identified.
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connection
Connection check configurations.

GUI Default Settings
slide-number

Initial slide # displayed on the report.
Default/Allowed: 1

action
Action items.
Default/Allowed: check, report or both (default)

mode
Execution mode, interactive mode will be slower than background mode.
Default/Allowed: interactive or background

input
Initial director for CAD Input.
Default/Allowed: C:/temp

output
Initial director for results output.
Default/Allowed: C:/temp

Hole Detection
min-diameter

Minimum diameter for surface hole recognition. Holes below this diameter will be ignored.
Default/Allowed: 1.0 to 10.0

max-diameter
Maximum diameter for surface hole recognition. Holes above this diameter will be ignored.
Default/Allowed: 1.0 to 10.0
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min-nodes
Minimum number of nodes to recognize FE hole. Hole with nodes less than this number will be
ignored.
Default/Allowed: 4 to 10

max-nodes
Maximum number of nodes to recognize FE hole. Hole with nodes greater than this number will be
ignored.
Default/Allowed: 30 to 50

adjacent-tolerance
Distance to judge duplicate holes for the same plate. If the Holes to Holes distance is less than
this value is considered as duplicate hole.
Default/Allowed: 3.0 to 5.0

Free Hole
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

elem-adj-bbox-tolerance
Search tolerance for searching nearest bolts/nuts from the hole center.

Default/Allowed: 10.0

If there is no bolt, nut or screw nearby, the holes are considered as free holes.
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freeboltnut
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

bolt-box-tolerance
Search tolerance for searching nearest plates from the bolt outer surfaces.

Default/Allowed: 1.0 to 5.0

nut-box-tolerance
Search tolerance for searching nearest plates from the nut outer surface.

Default/Allowed: 5.0 to 10.0
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allowed-plate-comps
These named parts will not be considered as plates.
Default/Allowed: string names of special parts

Bolt or Nut CAD data that are not passing through the plates or floating in the space without the plates
are found.

bolthole-mismatch
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

input-type
Continuous CAD lines or CAD solids.
Default/Allowed: lines or solids

centernode-search-tolerance
Search tolerance for searching holes from bolt CAD surface.

Default/Allowed: 1.0 to 2.0

elem-adj-bbox-tolerance
Tolerance for searching nearest plates from the bolt outer surface.
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Default/Allowed: 5.0 to 10.0

min-dist
Allowable mismatch distance between bolt axis and hole axis.

Default/Allowed: 0.1 to 1.0

max-dist
Maximum search distance between bolt axis and the hole axis.
Default/Allowed: 5.0 to 10.0

Mismatch issues is found if the mismatch is between min-dist to max-dist value.

nuthole-mismatch
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF
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input-type
Continuous CAD lines or CAD solids.
Default/Allowed: lines or solids

centernode-search-tolerance
Search tolerance for searching holes from bolt/nut CAD surface.

Default/Allowed: 1.0 to 2.0

elem-adj-bbox-tolerance
Tolerance for searching nearest plates from the nut outer surface.

Default/Allowed: 5.0 to 10.0

min-dist
Allowable mismatch distance between nut axis and hole axis. If the mismatch is less than this
value issues will not be reported.

Default/Allowed: 0.1 to 1.0

max-dist
Maximum search distance between nut axis and the hole axis. If the mismatch is greater than this
value, issues will not be reported.
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Default/Allowed: 5.0 to 10.0

Issues are found if the mismatch distance is between min-dist to max-dist range.

boltnut-mismatch
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

elem-adj-bbox-tolerance
Tolerance for searching nearest plates from the nut outer surface.

Default/Allowed: 5.0 to 10.0

threshold-angle
Allowable angle between center axis of bolt and the nut. More than this angle, the check will be
ignored for that pair of connection parts.

Default/Allowed: 10.0 to 30 deg

min-dist
Allowable mismatch distance between nut axis and hole axis. If the mismatch is less than this
value, issues will not be reported.
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Default/Allowed: 0.1 to 1.0

max-dist
Maximum search distance between nut axis and the hole axis. If the mismatch is greater than this
value, issues will not be reported.
Default/Allowed: 5.0 to 10.0

Bolt-nut mismatch issues will be reported if the Bolt and Nut sizes are not within min-dist and max-dist
range.

boltnutsize-mismatch
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

elem-adj-bbox-tolerance
Tolerance for searching nearest bolt, plates from the nut outer surface.

Default/Allowed: 5.0 to 10.0
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min-dist
Allowable mismatch distance between nut axis and hole axis. If the mismatch is less than this
value, issues will not be reported.

Default/Allowed: 0.1 to 1.0

min-nut-tol-bolt-ratio
Allowable minimum ratio between bolt and nut size. If the ratio is less than this value, issue is
reported.

Default/Allowed: 0.8 to 0.9

max-nut-tol-bolt-ratio
Allowable maximum ratio between bolt and the nut size. If the ratio is greater than this value,
issue is reported.

Default/Allowed: 1.1 to 1.3
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Issues will be reported if the Bolt size and Nut size are not in within the range of min-nut-tol-bolt-ratio
and the max-nut-tol-bolt-ratio.

holes-mismatch
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

min-dist
Allowable mismatch distance between nut axis and hole axis. If the mismatch is less than this
value, issues will not be reported.

Default/Allowed: 0.1 to 1.0

max-dist
Maximum search distance between hole center node axis.
Default/Allowed: 5.0 to 10.0

centernode-search-tolerance
Tolerance for searching nearest plates from the hole center.

Default/Allowed: 1.0 to 2.0

elem-adj-bbox-tolerance
Tolerance for searching nearest plates from the hole center.
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Default/Allowed: 5.0 to 10.0

Issues will be reported if the center axis distance between two holes are not with the min-dist and max-
dist.

holespair-mismatch
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

elem-adj-bbox-tolerance
Tolerance for searching nearest plates from the hole center.

Default/Allowed: 5.0 to 10.0

centernode-search-tolerance
Tolerance for searching nearest plates from the hole center.
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Default/Allowed: 1.0 to 2.0

Holes not found in the nearest plates are reported as an issue nearest plates. Plate holes are searched
with centernode-search-tolerance tolerance.

Clip-mismatch
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

input-type
Continuous CAD lines or CAD solids.
Default/Allowed: lines or solids

centernode-search-tolerance
Search tolerance from center clip to holes center.

Default/Allowed: 1.0 to 2.0

min-dist
Allowable mismatch distance between clip axis and hole axis.
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Default/Allowed: 0.5 to 1.0

max-dist
Maximum distance between clip axis and the hole axis. Greater than this value the clip parts are
ignored in the check.
Default/Allowed: 5.0 to 15.0

Issues will be reported if the center axis of clip data and the center axis of the hole node is greater than
the min-dist and less than max-dist.

Arc/Seam/Adhesive/Seal/Hemming -mismatch
do-check

Turn OFF or ON the check.
Default/Allowed: ON or OFF

input-type
Continuous CAD lines or CAD solids.
Default/Allowed: lines or solids

elem-adj-bbox-tolerance (tol)
Search tolerance for finding nearest weldable plates. If less than 2 parts found, then issue is
reported.

Default/Allowed: 10.0
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min-dist
Minimum distance between arc weld to the nearest parts. If less than 2 parts found, then issue is
reported.

Default/Allowed: 0.1 to 5.0

max-dist
Maximum distance between weld lines to the nearest parts.
Default/Allowed: 5.0 to 10.0

Finds shape mismatch between the weld lines against the plates with the given min and max distance.

The mismatches are measured from the end points of the line.

spot comparison
Spot comparison check configurations.

GUI Default Settings
tolerance

Distance between two spot welds less/equal to this tolerance are considered matching. Distance
more than this tolerance is reported as positional difference.

Default/Allowed: 1.0 to 10.0
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slide-number
The start number displayed on the top right corner of the PowerPoint slide.
Default/Allowed: 1 to 10000

input-1
Spot weld file 1.
Default/Allowed: C:/temp

input-2
Spot weld file 2 (same file cannot be selected).
Default/Allowed: C:/temp

report
Initial directory for report out path.
Default/Allowed: C:/temp

action
User action type to be executed.

Check
Only intersection check will be executed, no reports.

Report
Only Reports will be generated from the previous check.

Both
Check and Report generation will be executed in a sequence.

Default/Allowed: Check, Report or Both

extract-spot-cad-option
CAD lines, points or solids are converted to spot weld file. A copy of the spot weld file is stored in
the input folder.

Default/Allowed: lines, points or solids

extract-spot-method
Logic to convert CAD to spot file.

compname
CAD names are used to recognize CAD spot data. These names are recognized via
configuration file, name, connection and spot inputs.

bbox
Based on the location and surrounding parts, CAD is converted to spot weld file.

Default/Allowed: compname or bbox
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position
Position (Coordinates) difference between spot weld 1 and spot weld 2 will be reported if ON.
Allowable positional difference is less than tolerance value.

Default/Allowed: ON or OFF

part-id
Part ID differences between spot weld 1 and spot weld 2 will be reported if ON.

Default/Allowed: ON or OFF

layer
#Layer, #Stack or #Link Components differences between spot weld 1 and spot weld 2 will be
reported if ON.

Default/Allowed: ON or OFF

free part
Free park check configurations.

GUI Default Settings
gap

Allowable distance between two parts. Example, a bolt and the bolt hole clearance distance.
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Default/Allowed: 0.1 to 5.0 mm

slide-number
The start number displayed on the top right corner of the PowerPoint slide.
Default/Allowed: 1 to 10000

inputdir
Initial director for the input data.
Default/Allowed: C:/temp

outputdir
Initial director for report output path.
Default/Allowed: C:/temp

action
User action type to be executed.

Check
Only intersection check will be executed, no reports.

Report
Only Reports will be generated from the previous check.

Both
Check and Report generation will be executed in a sequence.

Default/Allowed: Check, Report or Both

mode
Default options for Run type.

interactive
Check executed in the front ground session.

background
Check executed in the background HyperMesh sessions, automatic restart executed if error
occurs, the errors will be displayed in the browser as “Crash” keyword.

Default/Allowed: interactive or background

Settings
contact-tolerance

Allowable contact thickness between two parts. Example, for exhaust pipe press fit clearance
distance.
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Default/Allowed: 0.01 to 1.0mm

unconnected_count_min
Allowable unconnected parts. Issue will be found if few parts interconnected but the # of
interconnected parts are less than this value will be reported.

Default/Allowed: 1 to 5

min-area
Minimum area of part that must be considered for the check. Area of the part less than this will be
ignored in the check. This is implemented to avoid small parts that do not have proper Name or
Part Number.
Default/Allowed: 1.0 to 1000.0 mm square

color
Color of the unconnected parts in the PowerPoint report.
Default/Allowed: Red

csv-comparison
CSV comparison tool compares CAD/FE attributes against CSV file column.

Settings
mapattributes

displayname
Displays the Part Number.

PID
Displays the entity specific Property ID’s. At the Part level it displays IDs for referenced
properties. At the Component level it shows the ID of the referenced property.

Part Name
Displays the Part entity name.
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Material
Displays the material name of the Part.

Thickness
Displays the entity specific thickness. At the Part level it displays the thicknesses of the
referenced properties. At the Component level it shows the thickness of the referenced
property.

Function Name
Displays sub assembly name of the Part.

Assembly Name
Displays assembly name of the Part.

Weight
Displays weight of the Part.

Configuration Options

csvcomparison/compare
Compares only the attributes between CSV and MVD attributes and results will be displayed
in Error column.

csvcomparison/compare-update
Compares and updates the attributes if mismatch exist in the attributes.

csvcomparison/NewXML
CSV file will be converted to BOM and added as Variant BOM for future topology
comparison.

reference-item
It is Common attribute name between FE/CAD model and CSV file header.

string-match-format

Generic
Full string vs string will be compared.

Prefix
Pre-fix, base-name, post-fix will be compared in the CSV file part name.

report
Excel report will be generated with model image in JPEG/H3D.
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report-dir
Output path for report.

names
Naming conventions used in various Model Verification Modules.

Settings
module

Name settings for the modules within Model Verification.

comparison-base
Identify FE Model in CAD-FE Comparison.
Supported values: “*base_model*”

spotweld
Naming pattern for component to be identified as spot weld component.
Supported values: “*-w-*”

part
Naming conventions for components.

connection
Naming convention for classifying the component as various connecting components.

bolt
Supported values: “*bolt*”, “!*plate*”

nut
Supported values: “*nut*”, “!*plate*”

clip
Supported values: “*clip*”

rivet
Supported values: “*rivet*”

stud
Supported values: “*stud*”

screw
Supported values: “*screw*”, “*scr*”

pin
Supported values: “*pin*”

arc
Supported values: “*arc*”, “*weld*”, “!*bolt*”, “!*nut*”

spot
Supported values: *spot*
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other
Supported values: “*”, “!101-*”, “!102-*”, “!103-*”, “!104-*”

unwanted
Supported values: “f/j_boot”, “f/j_b/band”, “s/j_boot”, “s/j_b/band”, “*bane*”,
“*cable*”, "*fulcrum*”, “*spring*”, “*surf*”, “*valve*”“*wstrip*”, “*zone*”

Add and Remove List Items
Steps on how to add and remove list items.

• Add new list item.

a) Right-click on a Category with the list item and select Add item from the context menu.

b) Enter the values.

c) Click Save to save the addition.

Note:

Add is not allowed for Categories with no list items or sub-items.

• Remove list item.

a) Right-click on the item and select Cut item from the context menu.

b) Click Save to save the deletion.

Examples:

• Category - bolt, nut, unwanted or others.

• Property - *bolt, *nut or *clip.

report
Report outputs and visualization configuration.

Settings
advance

true = Advance style report with MultiCPU, false = Normal style report with 1CPU.
Supported values: true

avoid_duplicate_slide
true = duplicate slides avoided, #duplicate issues shown under instance, false = all of the issues
for single pairs will be reported.
Supported values: true

visualization settings define configurations related to visualization.

bg
Background colors to be used for creating H3D files and images.
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h3d
The background color to be used when creating H3D files.
Supported values: 255, 255, 255, 255, 255 255

jpg
The background color to be used when creating JPG image files.
Supported values: 49, 111, 255, 95, 181 266

color
Default colors for various check results. Click here for more information about color numbers.

comparison
Default colors for comparison check.

master
Color number for Master component.
Supported values: Color Number, ex - 12

slave
Color number for Master component.
Supported values: Color Number, ex - 6

unmatched
Color number for unmatched entities.
Supported values: Color Number, ex - 33

WT-Calculation
Option to display the weight in the reports. true - will enable the display and false -
will disable the display.
Supported values: true or false

WT-Comparison
Option to display the delta weight in the reports. true - will enable the display and
false - will disable the display.
Supported values: true or false

WT-Graph
Option to display the weight graph in the reports. true - will enable the display and
false - will disable the display.
Supported values: true or false

WT-Graphtype
Option to choose the waterfall graph type. The values 0 / 1 / 2 / 3 represent the
available graph types.
Supported values: 0, 1, 2, 3

WT-Scalefactor
Multiplies the weight with the specified multiplication factor.
Supported values: A desired multiplication factor. Default is 1.

intersection
Default colors for intersection test. Click here for more information about color numbers.
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master
Color number for Master component.
Supported values: Color Number, ex - 55

slave
Color number for Master component.
Supported values: Color Number, ex - 21

master-intersecting
Color number for intersecting elements on the master component.
Supported values: Color Number, ex - 62

slave-intersecting
Color number for intersecting elements on the slave component.
Supported values: Color Number, ex - 47

transparency
Transparency settings.

intersection
Transparency settings for intersection check.

master
The choice to turn on transparency for the master component. True enables
transparency and false makes the component opaque.
Supported values: true or false

slave
The choice to turn on transparency for the master component. True enables
transparency and false makes the component opaque.
Supported values: true or false

level
The level of transparency on a scale of 0 to 10. 0 being no transparency and 10 being
completely transparent.
Supported values: Number, ex - 3

intersection
Visualization related settings for intersection reporting.

cross
Settings related to Cross.

length
The length of the cross as a percentage of the model length.
Supported values: Percentage, ex - 8

width
The width of the cross as a percentage of the model length.
Supported values: Percentage, ex - 0.15

sphere
Sphere dimension for the sphere.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2565

radius
The radius of the sphere as a percentage of the cross length.
Supported values: Percentage, ex - 2

color
The color to be used for the sphere by specifying the corresponding color number
from the palette.
Supported values: Percentage, ex - 3

reportgroup
multiple = Multiple slides in single PPT.
Supported values: single / multiple

spotweld
Setting related to spot weld check reporting.

cross
Settings related to cross.

length
The length of the cross as a percentage of the model length.
Supported values: Percentage, ex - 8

width
The width of the cross as a percentage of the model length.
Supported values: Percentage, ex - 0.15

sphere
Sphere dimension for the sphere.

radius
The radius of the sphere as a value in model units.
Supported values: Percentage, ex - 2

color
The color to be used for the sphere by specifying the corresponding color number
from the palette.
Supported values: Percentage, ex - 3

clip
Clip dimensions.

radius
Attribute - TBD.
Supported values: Value in model units, ex - 150

hvp
DO NOT CHANGE.
Supported values: Text Value, ex – HvpLeft, HvpRight

bordercolor
Border color of the HVP title note.
Supported values: Color Number, ex - 2
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titlefontsize
Title font size.
Supported values: Color Number, ex - 2

titlecolor
Title Color.
Supported values: Color Number, ex - 4

titlefont
Title Font.
Supported values: Color Number, ex - 1

comparisonunified settings:

max-record
Supported values: 50

template
The file name of the MS PowerPoint template to be used for reporting.
Supported values: File name, ex – “Template_compare.potx”

template-sheet
Name given to template.

skip-assembly-image
Parameter to skip assembly image in Comparison PowerPoint (check box).

template-ppt
Path of the power point template.

percentage-sequence
This is parameter for arranging the order of thumb nail images of components in the PowerPoint.
Supported values:

0 – Dfault order.

1 – Match percent in decreasing order.

2 – Part IDs in decreasing order.

resultslide
This is parameter to get the default multiple slides for multi-variant comparison or to get single
slide which shows best match result.
Supported values:

Default – Multiple slides are shown.

Best match – Best matches for each components are shown from the multiple variants.

threshold_report
This is an intermediate percentage value to be given between threshold value and maximum
value. The components having match percent value between threshold and threshold_report value
is shown in green color and the components with value between threshold_report and maximum
value in grey color.

intersection settings are related to reporting for intersection check.
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text-static
User can enter the information.
Supported values:

object: “Text left”
description: “Intersection Check”
object: “Text right”
description: “Answer:”
object: “Info3”
description: “_”
object: “Info4”
description: “_”
object: “Info5”
description: “_”
object: “Info6”
description: “_”

spotweld settings:

max-slide
Maximum number of slides to be included in the PPT file.
Supported values: Number,ex-50

text-static
User can enter the information.
Supported values:

object: “Text left”
description: “Spotweld Check”
object: “Text right”
description: “Answer:”
object: “Info3”
description: “_”
object: “Info4”
description: “_”
object: “Info5”
description: “_”
object: “Info6”
description: “_”

spot-comparison settings:

max-slide
Maximum number of slides to be included in the PPT file.
Supported values: Number,ex-50

template
The file name of the MS PowerPoint template to be used for reporting.
Supported values: File name, ex – “Template.potx”

text-static
User can enter the information.
Supported values:

object: “Text left”
description: “Spotweld Comparison”
object: “Text right”
description: “Answer:”
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object: “Info3”
description: “_”
object: “Info4”
description: “_”
object: “Info5”
description: “_”
object: “Info6” 
description: “_”

freepart settings:

max-slide
Maximum number of slides to be included in the PPT file.
Supported values: Number,ex-50

template
The file name of the MS PowerPoint template to be used for reporting.
Supported values: File name, ex – “Template.potx”

layout
DO NOT CHANGE.
Supported values: Number, ex – 2

text

description
DO NOT CHANGE.
Supported values: Text Value, ex – “Text1”

project
DO NOT CHANGE.
Supported values: Text Value, ex – “Info1”

id
DO NOT CHANGE.
Supported values: Text Value, ex – “Info7”

date
DO NOT CHANGE.

text-static
User can enter the information.
Supported values:

object: “Text left”
description: “Connection Check”
object: “Text right”
description: “Answer:”
object: “Info3”
description: “_”
object: “Info4”
description: “_”
object: “Info5”
description: “_”
object: “Info6”
description: “_”
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Save Reps
Save Representations in the input folder.

In the Comparison Browser, right-click on Model and select Representation > Save from the context
menu.
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Configure Parts
Configure any part.

1. From the Verification browser, right-click and select Tools > Part Configuration from the context
menu.

2. Select the Data Type from the drop-down list.

3. Enter or browse for the Representation path.

4. Select the FE or CAD type from the drop-down list.

5. Select the new path for Representation folder.

6. Select the base configuration

7. Select the Part Name or Part ID from the drop-down list.

8. Click Close to exit the configuration.

9. Click Check to check and update the Representation.

10. Click Update to update the Representation with new settings.

11. Click Import to import the Representation.
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Review in HyperView Player
Review the selected Part Assembly/Part in HyperView Player.

This review function uses parallel processing and is used in case of huge number of selected parts and it
takes time in normal import operation.

From the Verification browser, right-click and select Representations  > Load in HyperView Player
from the context menu.

Once the model is displayed in the HyperView Player, user can perform the following:

• Review all the displayed parts.

• Right-click to cross check the details.

A copy of the H3D file is stored in working folder.

• Drag and drop this file on PowerPoint / Excel / Word to review the model in business meetings.

Note:  The number CPU set in the configuration general section is used for parallel
processing.

Import happens by filtering connection parts set in config GUI / Names. After review the parts in
HyperView Player, it is expected to close the HyperView Player to proceed with other operation in
HyperMesh.

Figure 1532:
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Review in HyperMesh
Review the selected Part Assembly/Part in HyperMesh graphics.

This review function uses parallel processing and is used in case of huge number of selected part and it
takes time in normal import operation.

Once the model is displayed in the graphics, user can select unwanted parts in the graphics and delete
them, simultaneously the Part Browser gets updated.

Note:  The number CPU set in the configuration general section is used for parallel
processing.

It is recommended to use this function before CAD Intersection or Comparison is executed for full car
model where it is not sure the parts are in right position.

Figure 1533: Intersection Check on Each CPU

From the Verification/Comparison browser right-click context menu, select Review Results.
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Export Parts
Export part representations.

1. From the Verification browser, right-click and select Parts > Export from the context menu.

2. In the Browse for Folder dialog, select the folder to export the Part Representation and click OK.

Selected parts are exported along with the XML file.
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Rename Parts
Rename and set PIDs for all parts.

Part name and PIDs are extracted from file name displayed in Representation File column. For CAD
inputs it is automatically executed during Intersection or Comparison.

From the Verification browser, right-click and select Parts > Rename from the context menu.
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Renumber Parts
Renumber PIDs for all parts.

PIDs are renumbered based on configuration setting under GUI > general > tool > Renumber. For
CAD inputs, it is automatically executed during Intersection or Comparison. You can turn off the auto-
renumber options in case the PIDs to be preserved.

From the Verification browser, right-click and select Parts > Renumber from the context menu.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2576

Count Parts
Get the count of the selected Part Representations.

Multiple Parts and Part Assemblies can be selected.

From the Verification browser, right-click and select Parts > Count from the context menu.
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Batch Mode
Run Model Verification operations in batch mode.

Batch Command
Batch command to load all the functionalities of Model Verification into the batch mode of HyperMesh.

<altair_home>/hm/bin/<platform>/hmbatch.exe –tcl <mvd/src\main>/batch.tcl

Batch Options
Syntax and the description of the available options when using Model Verification in batch mode.

Intersection Check
Supported Batch options for Intersection checks.

Mandatory Arguments
"%hmbatch%"

File path of hmbatch.exe
Value: hmbatch.exe

-tcl
File path of batch.tcl
Value: batch.tcl

-mvd-feature
Function name
Value: intersection

-mvd-input
Folder / File name
Value: "%input%"

-mvd-input-type
Cad/Fe/XML file type of %input%
Value: " iges"

-mvd-output
Result xml file name
Value: "intresult.xml"

-mvd-report
Report output path

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Verification p.2578

Value: "%report%"

Optional Arguments
-nocommand

No input needed
Value: Blank

-nouserprofiledialog
No input needed
Value: Blank

-mvd-action
Action type
Value: check/report/both

-mvd-bg
No input needed
Value: Blank

-mvd-ncpu
# of cores in current machine
Value: 2

-mvd-log
File name / File name
Value: mvdLog.log

-mvd-project-name
Any string value display in report
Value: “Name”

-mvd-slide-number
Any integer value display in report
Value: “1”

-mvd-progress
File name / File name
Value: mvdprogress.log

Example
Example of a batch command.

"%hmbatch%" -nocommand -nouserprofiledialog -tcl "%tcl_file%" -mvd-feature
 intersection 
-mvd-input "%input%" -mvd-input-type "iges" -mvd-output "%output%" -mvd-report
"%report%"
-mvd-action both -mvd-report-scope both -mvd-bg -mvd-ncpu 1 -mvd-log mvdLog.log -mvd-
progress
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mvdprogress.log

Comparison Check
Supported Batch options for Comparison checks.

Mandatory Arguments
"%hmbatch%"

File path of hmbatch.exe
Value: hmbatch.exe

-tcl
File path of batch.tcl
Value: batch.tcl

-mvd-feature
Function Name
Value: intersection

-mvd-base
Folder path / File name
Value: "%base%"

-mvd-base-type
Cad/Fe/XML file type of %input%
Value: “iges”

-mvd-variant
Folder path / File name
Value: "%variant%"

-mvd-variant-type
Cad/Fe/XML file type of %input%
Value: “radioss”

-mvd-output
Result xml file name
Value: "compresult.xml"

-mvd-report
Report output path
Value: "%report%"

Optional Arguments
-nocommand

No input needed
Value: Blank

-nouserprofiledialog
No input needed
Value: Blank
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-mvd-action
Action type
Value: check/report/both

-mvd-report-scope
Report Option
Value: Excel / PPT / both

-mvd-bg
No input needed
Value: Blank

-mvd-ncpu
# of cores in current machine
Value: 2

-mvd-log
File name / File name
Value: mvdLog.log

-mvd-progress
File name / File name
Value: mvdprogress.log

Example
Example of a batch command.

"%hmbatch%" -nocommand -nouserprofiledialog -tcl "%tcl_file%" 
-mvd-feature comparison -mvd-base "%base%" -mvd-base-type iges -mvd-variant
"%variant%" -mvd-variant-type dyna -mvd-output "%output%" -mvd-report "%report%"
-mvd-action both -mvd-report-scope both -mvd-bg -mvd-ncpu 1 -mvd-log mvdLog.log
-mvd-progress mvdprogress.log

Spotweld Check (Fe)
Supported Batch options for Spotweld checks (Fe).

Mandatory Arguments
"%hmbatch%"

File path of hmbatch.exe
Value: hmbatch.exe

-tcl
File path batch.tcl
Value: batch.tcl

-mvd-feature
Function name
Value: spotweld
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-mvd-input
Folder path of spot file & Fe file
Value: "%input%"

-mvd-input-type
Fe file type of %input%
Value: "optistruct/radioss/pam"

-mvd-output
Report output path
Value: "%output%"

Note:  The Spot file type is read from the configuration file.

Optional Arguments
-nocommand

No input needed
Value: Blank

-nouserprofiledialog
No input needed
Value: Blank

-mvd-action
Action needed
Value: check/report/both

-mvd-bg
No input needed
Value: Blank

-mvd-ncpu
# of cores in current machine
Value: 2

-mvd-log
File name / File name
Value: mvdLog.log

-mvd-project-name
Any string value display in report
Value: “Name”

-mvd-slide-number
Any integer value display in report
Value: “1”

-mvd-progress
File name / File name
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Value: mvdprogress.log

Example
Example of a batch command.

"%hmbatch%" -nocommand -nouserprofiledialog -tcl "%tcl_file%" 
-mvd-feature spotweld -mvd-input "%input%" -mvd-input-type “pam” -mvd-output
"%output%" -mvd-action both -mvd-report-scope both -mvd-bg -mvd-ncpu 1 -mvd-log
mvdLog.log -mvd-progress mvdprogress.log

Spotweld Check (CAD)
Supported Batch options for Spotweld checks (CAD).

Mandatory Arguments
"%hmbatch%"

File path of hmbatch.exe
Value: hmbatch.exe

-tcl
File path batch.tcl
Value: batch.tcl

-mvd-feature
Function name
Value: spotweld

-mvd-input
Folder path contains spot file
Value: "%input%"

-mvd-spotweld-bom
XML file path
Value: "%bomfile%"

-mvd-output
Report output path
Value: "%output%"

Note:  The Spot file type is read from the configuration file.

Optional Arguments
-nocommand

No input needed
Value: Blank

-nouserprofiledialog
No input needed
Value: Blank
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-mvd-action
Action type
Value: check/report/both

-mvd-bg
No input needed
Value: Blank

-mvd-ncpu
# of cores in current machine
Value: 2

-mvd-log
File name / File name
Value: mvdLog.log

-mvd-project-name
Any string value display in report
Value: "Name"

-mvd-slide-number
Any integer value display in report
Value: “1”

-mvd-progress
File name / File name
Value: mvdprogress.log

Example
Example of a batch command.

"%hmbatch%" -nocommand -nouserprofiledialog -tcl "%tcl_file%" 
-mvd-feature spotweld -mvd-input "%input%" -mvd-spotweld-bom "%bomfile%"
-mvd-output "%output%" -mvd-action both -mvd-report-scope both -mvd-bg
-mvd-ncpu 1 -mvd-log mvdLog.log -mvd-progress mvdprogress.log

Connector Check (CAD)
Supported Batch options for Connection checks (CAD).

Mandatory Arguments
"%hmbatch%"

File path of hmbatch.exe
Value: hmbatch.exe

-tcl
File path batch.tcl
Value: batch.tcl

-mvd-feature
Function Name
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Value: connection

-mvd-input
Folder path
Value: "%input%"

-mvd-connection-bom
XML file path
Value: "%bomfile%"

-mvd-output
Report output path
Value: "%output%"

Optional Arguments
-nocommand

No input needed
Value: Blank

-nouserprofiledialog
No input needed
Value: Blank

-mvd-action
Action type
Value: check/report/both

-mvd-bg
No input needed
Value: Blank

-mvd-ncpu
# of cores in current machine
Value: 2

-mvd-log
File name / File name
Value: mvdLog.log

-mvd-project-name
Any string value display in report
Value: “Name”

-mvd-slide-number
Any integer value display in report
Value: “1”

-mvd-progress
File name / File name
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Value: mvdprogress.log

Example
Example of a batch command.

"%hmbatch%" -nocommand -nouserprofiledialog -tcl "%tcl_file%" 
-mvd-feature connection -mvd-input "%input%" -mvd-connection-bom "%bomfile%"
-mvd-output "%output%" -mvd-action both -mvd-report-scope both -mvd-bg -mvd-ncpu
1 -mvd-log mvdLog.log -mvd-progress mvdprogress.log

Free-Part Check (CAD)
Supported Batch options for Free-Part checks (CAD).

Mandatory Arguments
"%hmbatch%"

File path of hmbatch.exe
Value: hmbatch.exe

-tcl
File path batch.tcl
Value: batch.tcl

-mvd-feature
Function name
Value: freepart

-mvd-input
Folder path (contains Spot file)
Value: "%input%"

-mvd- freepart-bom
XML file path
Value: "%bomfile%"

-mvd-output
Report output path
Value: "%output%"

Note:  The Spot file type is read from the configuration file.

Optional Arguments
-nocommand

No input needed
Value: Blank

-nouserprofiledialog
No input needed
Value: Blank
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-mvd-action
Action type
Value: check/report/both

-mvd-bg
No input needed
Value: Blank

-mvd-ncpu
# of cores in current machine
Value: 2

-mvd-log
File name / File name
Value: mvdLog.log

-mvd-project-name
Any string value display in report
Value: “Name”

-mvd-slide-number
Any integer value display in report
Value: “1”

-mvd-progress
File name / File name
Value: mvdprogress.log

Example
Example of a batch command.

"%hmbatch%" -nocommand -nouserprofiledialog -tcl "%tcl_file%" 
-mvd-feature freepart -mvd-input "%input%" -mvd-output "%output%" -mvd-freepart-bom
"%bomfile%" -mvd-action both -mvd-report-scope both -mvd-bg -mvd-ncpu 1 -mvd-log
mvdLog.log -mvd-progress mvdprogress.log

Spot Comparison Check
Supported Batch options for Spot Comparison checks.

Mandatory Arguments
"%hmbatch%"

File path of hmbatch.exe
Value: hmbatch.exe

-tcl
File path batch.tcl
Value: batch.tcl

-mvd-feature
Function name
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Value: spotweld-comparison

-mvd-base
File path of spot file A
Value: "%base%"

-mvd-variant
File path of spot file B
Value: "%variant%"

-mvd-spotcompare-bom
XML file path
Value: "%bomfile%"

-mvd-report
Report output path
Value: "%report%"

Note:  The Spot file type is read from the configuration file.

Optional Arguments
-nocommand

No input needed
Value: Blank

-nouserprofiledialog
No input needed
Value: Blank

-mvd-action
Action type
Value: check/report/both

-mvd-bg
No input needed
Value: Blank

-mvd-ncpu
# of cores in current machine
Value: 2

-mvd-log
File name / File name
Value: mvdLog.log

-mvd-project-name
Any string value display in report
Value: “Name”

-mvd-slide-number
Any integer value display in report
Value: “1”
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-mvd-progress
File name / File name
Value: mvdprogress.log

Example
Example of a batch command.

"%hmbatch%" -nocommand -nouserprofiledialog -tcl "%tcl_file%" 
-mvd-feature spotweld-comparison -mvd-base "%base%" -mvd-variant "%variant%"
-mvd-spotcompare-bom "%bom%" -mvd-report "%report%" -mvd-action both
-mvd-report-scope both -mvd-bg -mvd-ncpu 1 -mvd-log mvdLog.log -mvd-progress
mvdprogress.log

Batch Mode Error Codes
Error messages displayed when you use incorrect input argument.

SL Error Code Function and Message

1 1001 Import: Missing CAD file to XML converter

2 1002 Import: Failed to import CAD

3 1003 Import: Failed to export the FE part to the file

4 1004 Import: Problem obtaining HyperMesh version

5 1005 Import: Unable to find the result file

6 1006 Import: Unable to find the XML file

7 1007 Import: Failed to export the FE part to the file

8 1008 Import: Unable to find the result file in Import BG

9 1009 Import: Select only one module.

10 1010 Import: Invalid directory name specified

12 2001 Offset: Failed in license checkout for Offset

13 2002 Offset: Unknown action type in Offset

14 2003 Offset: Failed to export the FE part to the file in Offset

15 2004 Offset: No valid modules selected

17 3001 Comparison: Unable to find the result file in BG
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SL Error Code Function and Message

18 3002 Comparison: No valid modules selected

19 3003 Comparison: Select two or more modules for reporting

20 3004 Comparison: No files in module selected. Please import the modules
for comparison

21 3005 Comparison: Unable to compare two modules in parental relationship

22 3006 Comparison: Children found for Selected Module - Import cannot be
done. For Compare Check - Select two or more modules

23 3007 Comparison Report: No template file specified in the configuration for
excel

24 3008 Comparison Report: No template worksheet specified in the
configuration for excel

25 3009 Comparison Report: Template file not found in Comparison for excel

26 3010 Comparison Report: Worksheet not found in the template for excel

27 3011 Comparison Report: Failed in license checkout

28 3012 Comparison Report: Record/Result file not found

29 3013 Comparison Report: No template row specified in the configuration

30 3014 Comparison Report: Invalid variant index

31 3015 Comparison Report: Problem obtaining HyperMesh version

32 3016 Comparison Report: No template file specified in the configuration for
PPT

33 3017 Comparison Report: No layout specified in the configuration for PPT

34 3018 Comparison Report: Template file not found in PPT

36 4001 Intersection: Failed in license checkout

37 4002 Intersection: No valid modules selected in Intersection

38 4003 Intersection Report: No template file specified in the configuration for
PPT

39 4004 Intersection Report: No layout specified in the configuration for PPT

40 4005 Intersection Report: Template file not found in PPT
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SL Error Code Function and Message

42 5001 Spotweld: Failed in license checkout

43 5002 Spotweld: Unable to find connector files

44 5003 Spotweld: Unable to load FE model files

45 5004 Spotweld: Unable to import model, Check Configuration

46 5005 Spotweld: Unable to merge the hm file in HyperMesh

47 5006 Spotweld: Unable to load result file

48 5007 Spotweld: Unable to load model file

49 5008 Spotweld: Unexpected action type

50 5009 Spotweld: No connector files found in the input path

51 5009 Spotweld: No valid modules selected

52 5010 Spotweld Report: Error in sphere creation

53 5011 Spotweld Report: Result Model not saved successfully. Backup in
output path

54 5012 Spotweld Report: No template file specified in the configuration for PPT

55 5013 Spotweld Report: No layout specified in the configuration for PPT

56 5014 Spotweld Report: Template file not found in PPT

58 6001 Connection: Failed in license checkout

59 6002 Connection: Unable to calculate the centroid from surfaces of
component

60 6003 Connection: Unable to create lines between centroid and surfaces of
component

61 6004 Connection: Unable to calculate the center line direction from surface
edges of component

62 6005 Connection: Unable to find the appropriate line to determine the center
line direction

63 6006 Connection: Unable to read the boltnut.hm file in HyperMesh

64 6007 Connection: Unable to find the result file in BG
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SL Error Code Function and Message

65 6008 Connection: Unable to load result file

66 6009 Connection: Unable to load model file

67 6010 Connection Unexpected action type

68 6010 Connection Report: Check Result does not exist

69 6011 Connection Report: No template file specified in the configuration for
PPT

70 6012 Connection Report: No layout specified in the configuration for PPT

71 6013 Connection Report: Template file not found in PPT

73 7001 Freepart: Failed in license checkout

74 7002 Freepart: Unable to load FE model files

75 7003 Freepart: Unable to read the freepartmodel.hm file in HyperMesh

76 7004 Freepart: No Model loaded

77 7005 Freepart: Unable to find the result file in BG

78 7006 Freepart: Unable to find connector files

79 7007 Freepart: Unexpected action type

80 7008 Freepart: Unable to load result file

81 7008 Freepart: Unable to load model file

82 7009 Freepart: No connector files found in the input path

83 7010 Freepart Report: No template file specified in the configuration for PPT

84 7011 Freepart Report: No layout specified in the configuration for PPT
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SL Error Code Function and Message

85 7012 Freepart Report: Template file not found in PPT

Batch File Example
Example of a Model Verification batch file.

Note:

You must edit “ALTAIR_HOME”, “datapath” path in the following example.

set ALTAIR_HOME=C:\Program Files\Altair\2019
set dataPath=G:\BVT\2019\data
set hmbatch=%ALTAIR_HOME%\hm\bin\win64\hmbatch.exe
set tcl_file=%ALTAIR_HOME%\hm\scripts\MVD\mvdMain\src\main\batch.tcl
set base=%dataPath%\batch\iges
set variant=%dataPath%\batch\dyna
set output=%dataPath%\comparisonres.xml
set report=%dataPath%

cd /d g:
cd %dataPath%
IF not exist %report% (mkdir %report%)

"%hmbatch%" -nocommand -nouserprofiledialog -tcl "%tcl_file%" -mvd-feature comparison
-mvd-base "%base%" -mvd-base-type iges -mvd-variant "%variant%" -mvd-variant-type
dyna -mvd-output "%output%" -mvd-report "%report%" -mvd-action both -mvd-report-
scope both -mvd-bg -mvd-ncpu 1 -mvd-log mvdLog.log -mvd-progress mvdprogress.log
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Limitations
Limitations of the Model Verification tool.

• Supported only for Windows OS.

• Translation and Symmetry comparison runs in single CPU.

• UDMXML/BOM with No PID, Part name information may lead no result, it is expected to provide
clean BOM file.

• Solid CAD vs Midmesh comparison needs thickness value in FE data.

• HyperView Player must be registered for the first time use or if user login changes.

• Office 2010 and above is supported for report generation.
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Crash and Safety

Tools used for crash and safety analysis.

This chapter covers the following:

• Dummy Positioning  (p. 2595)

• Seat Mechanism  (p. 2607)

• Pre-Simulation (Seat Deformer) Setup  (p. 2621)

• Create and Route Seatbelts  (p. 2626)
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Dummy Positioning
Position a dummy model using the Dummy Browser.

Dummy Browser
Overview of the Dummy Browser.

The Dummy Browser can be accessed from the menu bar by clicking Tools > Dummy.

Restriction:  The Dummy Browser is available in the LS-DYNA and Radioss user profiles.

This browser is compatible with all LS-DYNA and Radioss Humanetics dummies (encrypted or not
encrypted) and also with LSTC dummies.

You can undo and redo actions made in the browser using the Undo and Redo commands on the Restore
toolbar.

The Dummy Browser consists of two panes. The first pane displays the dummy structure which consists
of the different bodies defining the dummy model. The second pane displays the Entity Editor in which
positioning parameters for each dummy articulations can be defined.

Figure 1534:

The following data is displayed in the Dummy Browser:
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Column Description

Entity List of the dummies and dummy bodies.

ID Displays the dummies and bodies IDs.

Color Displays the body entity colors.

Body color is different from the component color defined in the
Model Browser. The body color is activated when a body is in Review
mode or when display mode is set on “By Body”.

Entity Editor

The Entity Editor is used to assign, modify and quickly view the attributes defined inside Dummy
Browser entities.

In the Entity Editor you can define the H-Point coordinates or apply Global rotations on the dummy
to position the dummy in space. The H-Point coordinates can be directly specified in the fields, or by
clicking on the blue arrow, which then enables you to select a target location by picking a node in the
graphics area.

Figure 1535:

Global rotations on the dummy can also be defined. The magnitude of the rotation can be modified,
using the up and down arrow buttons. Moreover, you can control the increments of the operations by
changing the Increment value.
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Figure 1536:

The Entity Editor is also used to modify the position of bodies. You can directly define the angle of
rotation to apply in each axis of rotations in which the selected body is able to move.

The magnitude of the rotation can be also modified, using the up and down arrow buttons. Moreover,
you can control the increments of the operations by changing the Increment value.

Figure 1537:

Context Menu

Option Available for Description

Define Position Dummy Save the displayed position of
the dummy by creating a New
position or by overwriting an
existing position.
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Option Available for Description

Retrieve Position Dummy Position the dummy to its initial
position or to another position
by selecting this in the list of the
saved positions.

Move Limbs Dummy Open the Entity Editor to define
the position of the dummy using
the automatic move to target
functionality.

Positioning File Dummy Import or export a positioning
file (*.daf) containing the
position values of the dummy.

Pre-Simulation Dummy Export an input deck, for the
appropriate solver, in order to
simulate the deformation of the
dummy.

Show Dummy and Bodies Displays the entity in the
graphics area. The entities icon
changes to bold indicating that
the display state is on.

Hide Dummy and Bodies Turns off the entity in the
graphics area. This selection
affects each entities local display
control, that is, will make the
icon become ghosted indicating
the display state is off.

Isolate Dummy and Bodies Displays only the selected
entities, and turns off all other
entities of the same type.

Review Dummy Display the dummy articulations
and bodies in a simplified display
mode.
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Option Available for Description

Reset Review Dummy Resets the review of the
previously selected entity.

Supported Entities

The Dummy ( ) is the root of the hierarchy in the Dummy Browser. A dummy is defined by bodies

( ) representing the different kinematic assemblies of the dummy.

Position Dummies

Position the Body Manually

1. In the Dummy Browser, select a body.

2. In the graphics area, click-and-drag the manipulator to interactively modify the position of the
selected body.

Figure 1538:
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Position the Body Automatically

1. In the Dummy Browser, right-click on a body and select Move Limbs from the context menu.
The Entity Editor opens.

Figure 1539:

2. In the Multiple pairs field, select No (apply option to a single node) or Yes (apply option to a set
of nodes and targets).

3. If Multiple pairs is set to Yes, click Select pairs to open the Select multi nodes dialog and select
nodes and target point pairs.

4. Define a Node of a body.

5. Define the Target location.

6. Click Select Bodies to open the Dummy Bodies DOF dialog and select the bodies and degrees
of freedom of the active bodies that will be able to move during automatic positioning.

Select bodies by activating their corresponding checkbox, or picking them in the graphics area
(right-click or left-click to activate/deactivate a body). Lock/unlock degrees of freedom by
clicking the lock icon, or by picking the DOF arrows in the graphics area (right-click or left-click to
activate/deactivate a DOF).
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Figure 1540:

7. Click Move to start the automatic positioning process.

8. Click Save to save the achieved position.
A name will be appended to the New position name field.

Setup Pre-Simulation
Export an input deck to simulate the deformation of the dummy.

Before you begin, Position Dummies.

Figure 1541:

The simulation result files can be imported to update the initial FE model and thus remove the
intersections and penetrations between the dummy components.

1. In the Dummy Browser, right-click and on the dummy and select Pre-Simulation from the
context menu.
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2. In the PreSimulation Tool dialog, define settings accordingly.

a) In the PreSimulation type field, select a unit system.

The unity system will automatically set the default simulation parameters to the correct unit.
In any case, you can still modify these values manually.

b) In the Reference Position field, select the Position that will define the starting position of
the dummy in the pre-simulation.

Per default, the Initial Position of the dummy is selected.

c) In the Export File field, enter the pre-simulation deck name and directory.

Per default, a deck with name “result” is exported into ~…/Local/Temp directory.

3. Define PreSimulation Tool Options accordingly.

4. Optional: Import the simulation result file to update the initial model, which allows the dummy
node's coordinates to be updated and element initial stress state to be defined.

• For LS-DYNA, click Import dynain File to find the .dynain file.

• For Radioss, click Import h3d File to find the .h3d file.

5. Click Export.

The pre-simulation deck is exported to the specified location.

During the export process of the dummy pre-simulation deck, HyperMesh exports the complete dummy
model only, positioned in the selected Reference Position, per default, the Initial Position of the dummy.

The method used for the pre-simulation is known as the “cable” method, which uses 1D elements
connected to dummy bodies, in order to pull them from their initial position to their final position.

All “cables” are automatically created on each dummy body and all boundary conditions needed for the
pre-simulation.

Figure 1542: Exported Dummy Pre-Simulation Model, with Cable Elements Attached to Dummy Bodies
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The attachment nodes of the cables, nodes “N1; N2; N3” in the dummy assembly keyword are used, if
they are defined.

Figure 1543: Radioss

Figure 1544: LS-DYNA
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In case the nodes “N1; N2; N3” in the dummy assembly keyword are not defined, HyperMesh
automatically detects the best three nodes to use on each body. In this case, you will receive a
message.

Figure 1545: Altair HyperMesh Message

After the simulation of the dummy positioning, the components are deformed and intersections between
components are removed.

Figure 1546:

The "cable" method guarantees a perfect final position matching with the final position defined in the
Dummy Browser.
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Figure 1547:

PreSimulation Tool Options
Overview of supported options in the PreSimulation Tool.

LS-DYNA
Simulation Parameter

Simulation Time
Define the total simulation time in *CONTROL_TERMINATION for the pre-simulation.
Default value = 250ms.

Time Step
Define the control time step value in *CONTROL_TIMESTEP for the pre-simulation.
Default value = 0.001ms.

Force in cables
Define the pre-tension force to be applied on the cable elements in
*MAT_CABLE_DISCRETE_BEAM.
Default value = 1.0 kN.

Force ramp up time
Define the ramp-up time for the pre-tension force in *MAT_CABLE_DISCRETE_BEAM.
Default value = 10.0ms.
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Damping on cables
Define the damping value on the discrete elements in *MAT_DAMPER_VISCOUD.
Default value = 0.5.

Global damping value
Define the system damping constant in *DAMPING_GLOBAL.
Default value = 0.05.

Initial Stress Results

Import *INITIAL_STRESS_SOLID
Import the initial stresses for solid elements from the .dynain file.

Import *INITIAL_STRESS_SHELL
Import the initial stresses for shell elements from the .dynain file.

Import *INITIAL_STRESS_BEAM
Import the initial stresses for beam elements from the .dynain file.

Radioss
Simulation Parameters

Generate XREF for initial stresses
Create /XREF cards for the dummy components which are compatible with this RADIOSS
feature in terms of material type and element formulation. The XREF cards are generated
within the original session during the export of the pre-simulation deck, and not during
import of .h3d file.

Simulation time
Define the total simulation time in /RUN card for the pre-simulation.
Default value = 250ms

Time Step
Define the control time step value in /DT/NODA/CST card for the pre-simulation.
Default value = 0.001ms.

Global damping value
Define the system damping constant in /DAMP card.
Default value = 0.05

Create rigids for end bodies
Automatically rigidify the end bodies (feet, hands, head) of the dummy during the pre-
simulation.

Read Positioning Files

In the Dummy Browser, right-click on the dummy root name and select Positioning File > Import
from the context menu.
Once the positioning file (*.daf) is read, the dummy will automatically be positioned according to the
imported position data.
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Seat Mechanism
Create and articulate a kinematic mechanism based on FE mesh using the Mechanism Browser.

Mechanism Browser
Overview of the Mechanism Browser.

Access the Mechanism Browser from the menu bar by clicking Tools > Mechanism.

Restriction:  The Mechanism Browser is available in the LS-DYNA and Radioss user profiles.

You can undo and redo actions made in the Mechanism Browser using the Undo and Redo commands on
the Restore toolbar.

The Mechanism Browser consists of two panes. The first pane displays the mechanism structure which
consists of joints, bodies, and constraints. The second pane displays the Entity Editor.

Figure 1548:

The following data is displayed in the Mechanism Browser:

Column Description

Entity Lists the mechanism, joints, bodies, and constraints in your model.
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Column Description

ID Displays the mechanism, joints, bodies, and constraints IDs.

Type Displays the joint or constraints type.

Color Displays the joint and body entity colors.

Body color is different from the component color set-up in the Model
Browser. The body color is activated when a body is in Review mode.

Lock level Displays the lock level of a joint (green = free joint, yellow = locked
joint).

Entity Editor
The Entity Editor is used to assign, modify and quickly view the attributes defined inside Mechanism
Browser entities.

For example, once you create a new body or select a body in the browser, the Entity Editor opens and
displays the bodies corresponding attributes, which you can view and modify.

From the Entity Editor, you can also create or edit an entity assigned to the selected body by right-
clicking on the entity assignment field and selecting Create or Edit, respectively.
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Figure 1549:

Context Menu

Option Available for Description

Actuate Mechanism Mechanism Gives the ability to articulate a
mechanism by defining one of the
following actions:

• Translate a node

• Rotate a body

• Move a node to a target location

Check Mechanism Mechanism Enables you to check the validity of a
mechanism, looking for common nodes,
empty bodies, and redundant joints.

Collapse All entities Closes all of the folders for the selected
mechanism, so that only the mechanism
item displays.

Collapse All In Mechanism Browser Closes all of the folders in the browser, so
that only the mechanism items display.

Column Visibility Mechanism and in Mechanism
Browser

Enables you to hide or show the ID, Type,
Color, Lock, Common nodes, Empty Body
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Option Available for Description

and Redundant Joint columns in the
browser.

Create Mechanism and in Mechanism
Browser

Create a new mechanism, body, or
constraint.

You can only create a body or constraint
by right-clicking on a mechanism in the
browser.

Delete All entities Deletes the selected entity.

Shortcut: To delete a selected entity in
the Mechanism Browser, press Delete.

De-Link Dummy Mechanism When a dummy has been linked to a
mechanism, this option is activated in
order to remove the link between the
dummy and the mechanism.

Expand All entities Opens the selected folder, exposing every
entity nested at every level.

Expand All In Mechanism Browser Opens all of the folders in the browser,
exposing every entity nested at every
level.

Export Position Mechanism Opens the Export Position dialog, from
which you can export a saved position
of the selected mechanism into a solver
file containing the corresponding solver
transformation cards.

Hide All entities Turns off the entity in the graphics area.
This selection affects each item’s local
display control, that is, it will make the
icon become ghosted indicating the
display state is off.

Isolate All entities Displays only the selected entities, and
turns off all other entities of the same
type.

Link to Dummy Mechanism In case a dummy is present in the
session, this option is activated in order
to link the dummy, for example, to a seat
mechanism.
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Option Available for Description

Lock/Unlock Joint Joint Block (Lock) all degrees of freedom of
the selected joint or make them free
again (Unlock).

Move Joint Opens the Entity Editor to define the
positioning values of the selected joint
and activate the joint manipulator in the
display that can be used to interactively
move the joint.

Move Mechanism To Mechanism Moves the selected mechanism to its
initial position or other positions, which
have been previously saved.

Review All entities Invokes Review mode, which displays
selected entities irrespective of their
display state, masked, active state
(Entity State Browser), but not outside of
the spherical clipping (if enabled).

By selecting a body, it will be displayed
with its body color while other entities
are grayed out and displayed with
transparency.

By selecting a joint or a mechanism,
the joint marker with the bodies links
between will be displayed.

Reset Review All entities Resets the review of the previously
selected entity.

Rename All entities Rename an entity in the Name field.
The new name must be unique. All
instances of the renamed entity will
update automatically. You can cancel the
rename operation by pressing Esc.

Save Position as Mechanism Save the displayed mechanism position
as a new position or replace an already
existing position.

Show All entities Displays the selected entity in the
graphics area. The entities icon changes
to bold indicating that the display state
is on. Using the Show option on a
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Option Available for Description

mechanism or joint will display all nested
entities inside.

XRef Entities All entities Opens the References Browser and
displays the relationship of the selected
entities to other entities in the model in a
hierarchical tree structure.

Any single entity or multiple entities can
be selected.

Supported Entities

A Mechanism ( ) is the root of the hierarchy in the Mechanism Browser. To create a Mechanism, right

click in the Mechanism Browser and select Create > Mechanism from the context menu. A mechanism
is defined by the following entities:

• Bodies ( ) define a kinematic assembly made of FE parts or nodes, which can be selected in the

Entity Editor. To create a body, right-click on the Mechanism and select Create > Body from the
context menu.

• Joints ( ) define the kinematic relationship between two bodies (for the following joint types:

Ball, Cylinder, Revolute, Slider) or three bodies (for the DoubleSlider joint). To create a joint, select
two bodies to connect in the browser, then right-click and select Connect from the context menu.
For the DoubleSlider joint, the third body has to be defined in the Entity Editor.

• Constraints ( ) define kinematical constraints on a body at a specified node or point location.

Supported Keywords Exported in Solver Deck

The mechanism information is embedded in the input deck using keywords following the /END (for
Radioss) or *END (for LS-DYNA).

For Radioss, a mechanism is defined between the /MECHANISM_START and /MECHANISM_END keywords,
and is composed of:

• /ASSEMBLY defines a body with the following attributes:

◦ Assembly ID

◦ Assembly name

◦ Number of part sets and related set IDs

◦ Number of parts and related part IDs

◦ Number of node sets and related set IDs
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◦ Locked degrees of freedom

◦ Optional local coordinate system

• /CONNECTION defines a joint between assemblies with the following attributes:

◦ Connection name

◦ Assembly ID #1

◦ Assembly ID #2

◦ Connection position (defined by Node IDs or connection position coordinates)

◦ Joint limits in + and - directions

◦ Current joint distance/angle value

◦ Lock level

◦ Assembly ID #3 (for the Double Slider only)

◦ Scale factors for relative displacement between Assembly #3 and Assembly #1 and #2

• /POSITION defines, for a stored position, the position information for the mechanism’s assemblies
with the following attributes:

◦ Position name

◦ Assemblies position matrixes

Note:  The Reference and Initial positions should never be deleted inside the
mechanism.

• /CHILD_DUMMY defines the coupling between a mechanism and a dummy with the following
attributes:

◦ Name

◦ Master assembly ID of the mechanism

◦ Dummy ID

◦ Number of child assemblies of the dummy

◦ Degrees of freedom linking master to child

◦ Child assembly IDs of the dummy

The following connection keywords can be defined, depending on the type of joint created in the
Mechanism Browser:

• /CONNECTION_PIN defines a ball joint

• /CONNECTION_HINGE defines a revolute joint

• /CONNECTION_LINE defines a cylindrical joint, or a double slider joint if assembly ID #3 is defined
or a slider joint has the #HM_SLIDER_JOINT comment defined before the name of the connection
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For LS-DYNA, the same keywords are used but their syntax begins with * and not /.

Creating a Mechanism
This task explains how to create a mechanism.

In HyperMesh 2019 there are two ways to create a mechanism: Manual and Auto Generate. In this task,
you will create a mechanism using the Auto Generate method.

• Using the Manual approach, you create the mechanism manually by defining the bodies and joints.

• Using the Auto Generate approach, HyperMesh will automatically create bodies and joints based on
a selection of components and elements of the FE model.

In the Mechanism Browser, right-click and select Create > Mechanism > Auto Generate.

Figure 1550:

When you select Auto Generate, you will see the Mechanism Builder dialog box.
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Figure 1551:

To enable an extraction of the mechanism, each field in the dialog must be defined or selected. Set the
options according to the Mechanism Builder Options table.

Mechanism Builder Options Table
Use this table to set options for the Mechanism Builder.

Mechanism Builder Options

Option Action

Mechanism Type Select the type of mechanism, either Seat or General. Your
selection will affect other options in the dialog box.

Mechanism Name Type the name you want to give to the mechanism after the
extraction is completed.
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Mechanism Builder Options

Option Action

Entities Select the FE components that define the mechanism. You can
choose Components, Mechanisms, Assemblies, or Sets.

Node Selection on Lower Track When the Mechanism Type is set to Seat, you can select nodes on
the lower track components of the seat.

Node Selection on Upper Track When the Mechanism Type is set to Seat, you can select nodes on
the upper track components of the seat.

Sliding Vector on Upper Track When the Mechanism Type is set to Seat, you can specify the
translation direction of the joint defined for the seat track.

Seat Track with Roller Balls When the Mechanism Type is set to Seat, you can specify whether
the seat track contains roller balls. If you check this option,
HyperMesh will automatically create a double slider joint for the
seat track, and an additional selector for the seat track roller will
appear.

Track Roller Balls When the Mechanism Type is set to Seat, and Seat Track with
Roller Balls is checked, this option allows you to select the roller
ball components that will be defined as 3rd body in the double
slider joint.

Joint Elements Select the FE elements (springs or beams) that have to be created
as joints in the mechanism extraction process.

Excluded Elements Select the FE elements that should be excluded from the
extraction process of the mechanism.

For example, nodal rigid bodies that are used to link components
in the FE model but that are not physical conditions, can be
selected here and will not be considered in the extraction process.

Excluded Contacts Select to exclude tied contacts that may be defined on the FE
model but don't represent physical connections. This excludes
them from the extraction logic.

Detect Holes Select to activate the hole detection parameters. This allows
you to detect joint positions by looking for concentric holes in
components.

Relative Search Distance When Detect Holes is checked, this option defines the distance of
search for concentric holes that define a joint location.

Components for Hole Search When Detect Holes is checked, this option allows you to select the
components on which the hole detection must be performed.
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Mechanism Builder Options

Option Action

Preferred Revolute Joint Axis Type the vector that defines the revolute joint axis. This will
overwrite the direction of the joint elements.

Angular Tolerance Type the angular tolerance into this field. The joint axis within
this angle will be overwritten by the Preferred Revolute Joint Axis
value.

Position Mechanisms and Joints
Overview of how to modify the position of mechanism and joints.

Modify the Position of Mechanisms

1. In the Mechanism Browser, right-click on a mechanism and select Actuate Mechanism from the
context menu, then choose from one of the following:

• Choose Translate to open the Entity Editor and select a Node/Constraint, give a Direction of
motion, and define the Magnitude of the translation to apply.

The Magnitude can also be modified, using the up and down arrow buttons. Moreover, you can
control the increments of the operations by changing the Increment value.

Figure 1552:

• Choose Rotate to open the Entity Editor, select a Body, define a Rotation axis, a rotation
center (Base point), and provide the Magnitude of the rotation to apply to the body.

The Magnitude can also be modified, using the up and down arrow buttons. Moreover, you can
control the increments of the operations by changing the Increment value.
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Figure 1553:

• Choose Target Point to open the Entity Editor, select a Node and define its Target location.
Click Move to calculate the position of each body to bring the selected node to the target
location or the nearest location, depending on joints limit values.

This option can be applied on a set of nodes and targets, by setting Multiple pairs to Yes.

Figure 1554:

2. Click Save to save the achieved position.
A name will be appended to the New position name field.

Modify the Position of Joints

1. In the Mechanism Browser, right-click on a joint and select Move from the context menu.

2. Modify the position of the joint.

• In the graphics area, click-and-drag the manipulator.
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Figure 1555:

• In the Entity Editor, modify the Current angle of the joint.

Figure 1556:

3. Change the Increment value to control the increments of the operation.

Link a Dummy to a Mechanism
In a vehicle FE model, quickly and efficiently set kinematic systems such as seats, steering wheels and
pedals in different positions using the Mechanism Browser.

A dummy can then be positioned on the seat and may have its hands placed on the steering wheel and
feet on the pedals. To couple a dummy to a seat mechanism the degree of freedom of one or more
bodies of the dummy (“child” bodies) must be linked to a body of the seat mechanism (“master” body).
The motion of the master body will drive the motion of the child bodies; however, the motion of the
master body may be limited by the angle limits of the dummy joints.

1. In the Mechanism Browser, right-click on the seat mechanism and select Link to Dummy from
the context menu.

2. In the Dummies dialog, select a dummy to link to the seat mechanism and click Next.
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3. In the Mechanism bodies (Master body) dialog, select the master body from the seat and click
Next.

Note:  For this use case, it is common to select a seat cushion.

4. In the Dummy bodies (child bodies) dialog, select the dummy slave bodies and the linked
degrees of freedom and click Close.

Note:  For this use case, it is common to link to the lower torso of the dummy in
degrees of freedom Tx, Ty, and Tz (selected per default).

5. To fix some of the bodies of the dummy, for example, hands and feet, define constraints on those
bodies by selecting Create > Constraint > Point Node or Point Location from the context
menu.

6. Position the seat mechanism.

The position of the dummies limbs will be automatically updated.

Figure 1557: Initial State

Figure 1558: After Translation of 100mm of the Seat
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Pre-Simulation (Seat Deformer) Setup
Export an input deck, for the appropriate solver, in order to simulate the deformation of the seat under
the dummy. The simulation result files can be imported to update the initial FE model and remove the
intersections and penetrations between the dummy and the seat.

When a dummy is positioned to its H-Point location on a seat, intersections between the dummy and
seat foam parts generally occurs.

1. From the menu bar, click Tools > Pre-Simulation (Seat Deformer).

Restriction:  Only available in the LS-DYNA and Radioss user profiles.

The PreSimulation tool opens.

2. Define pre-simulation setup settings.

3. Click Export.

Figure 1559:
Shows the initial model with the dummy positioned at its correct H-Point location, and shows intersections with the seat.

The selected dummy components move following the direction that you move them in until no
penetrations between the dummy and seat components are detected. The dummy components are
rigidified. A contact between the seat and dummy is automatically created with user defined parameters
as well as a fix boundary condition on the selected fixed nodes of the seat. Finally, an imposed
displacement is applied on the dummy components to bring them back to the initial position.

Figure 1560:

The pre-simulation load case is ready and the dedicated input deck is exported to the user specified
location, as shown below. When the solver analysis is done, you can import the dedicated solver output
file to update the initial model with the deformed geometry and initial stresses of the seat parts.
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Figure 1561:

PreSimulation Tool
Overview of the PreSimulation Tool user interface.

LS-DYNA

Option Description

Unit System Selecting a unit system will automatically set up the default simulation
parameters to the correct unit. In any case, you can still modify these values
manually.

Dummy Dummy components that are selected in contact with the seat will be
exported for the pre-simulation. The selection can be done via:

Components

Mechanism
Opens a dialog to select a complete dummy

Assemblies

Set
Opens a dialog to select a set of type *SET_PART_LIST

Seat Select the seat components that will be exported for the pre-simulation. The
selection can be done via:

Components

Mechanism
Opens a dialog to select a mechanism defining the seat. Only the
bodies that are defined by components or sets of components will be
taken into account.

Assemblies

Set
Opens a dialog to select a set of type *SET_PART_LIST
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Option Description

Fixed Nodes of Seat Select the nodes that will be fixed during the simulation. The selection can
be done via:

Nodes

Set
Opens a dialog to select a set of type *SET_NODE_LIST

Dummy Displacement
Direction

Defines the vector in which the dummy components will be moved to the
starting simulation position when penetrations with the seat are no longer
detected.

Export Files Defines the pre-simulation deck name and location.

Dummy Velocity Defines the imposed velocity value applied on the dummy parts during the
simulation. Default value = 0.1mm/ms.

Time Step Defines the control time step value. Default value = 0.001ms.

Scale Materials Density Scale factor to scale the material density values in order to increase the
critical time step of the model. Default value = 10.

Dummy Displacement
Step

Displacement increment used to move the selected dummy components
along the prescribed vector. After each increment, the penetration check
between the dummy and seat will be performed and the dummy motion will
be stopped when penetrations are no longer detected. Default value = 10.

Soft Defines the Soft parameter value in the generated contact between the
dummy and seat. Default value = 2.

Friction Defines the FS parameter value in the generated contact between the
dummy and seat. Default value = 0.0.

Imposed Contact
Thickness

Defines the value of parameters SST, MST and SLDTHK in the generated
contact between the dummy and seat. Default value = 0.0.

Contact Stiffness Scale
Factor

Defines the value of parameter SFS in the generated contact between the
dummy and seat. Default value = 0.0.

Import
*INITIAL_STRESS_SOLID

If this checkbox is activated, initial stresses for solid elements will be
imported from the dynain file. This option is activated by default.

Import
*INITIAL_STRESS_SHELL

If this checkbox is activated, initial stresses for shell elements will be
imported from the dynain file. This option is deactivated by default.

Import
*INITIAL_STRESS_BEAM

If this checkbox is activated, initial stresses for beam elements will be
imported from the dynain file. This option is deactivated by default.
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Option Description

Export Starts the export process of the pre-simulation deck at the specified
location.

Import dynain File Allows the LS-DYNA simulation to update the initial model.

Close Closes the dialog.

Radioss

Option Description

Unit System Selecting a unit system will automatically set up the default simulation
parameters to the correct unit. In any case, you can still modify these values
manually.

Dummy Dummy components that are selected in contact with the seat will be
exported for the pre-simulation. The selection can be done via:

Components

Mechanism
Opens a dialog to select a complete dummy.

Assemblies

Set
Opens a dialog to select a set of type /GRPART.

Seat Select the seat components that will be exported for the pre-simulation. The
selection can be done via:

Components

Mechanism
Opens a dialog to select a mechanism defining the seat. Only the
bodies that are defined by components or sets of components will be
taken into account.

Assemblies

Set
Opens a dialog to select a set of type /GRPART.

Fixed Nodes of Seat Select the nodes that will be fixed during the simulation. The selection can
be done via:

Nodes

Set
Opens a dialog to select a set of type /GRNOD.
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Option Description

Dummy Displacement
Direction

Defines the vector in which the dummy components will be moved to the
starting simulation position when penetrations with the seat are no longer
detected.

Export File Defines the pre-simulation deck name and location.

Generate XREF for initial
stresses

Enables the creation of /XREF cards for the seat components that are
compatible with this Radioss feature in terms of material type and element
formulation. This checkbox is activated by default.

Dummy Velocity Defines the imposed velocity value applied on the dummy parts during the
simulation. Default value = 0.1mm/ms.

Time Step Defines the control time step value. Default value = 0.001ms.

Scale Materials Density Scale factor to scale the material density values in order to increase the
critical time step of the model. Default value = 10.

Dummy Displacement
Step

Displacement increment used to move the selected dummy components
along the prescribed vector. After each increment, the penetration check
between the dummy and seat will be performed and the dummy motion will
be stopped when penetrations are no longer detected. Default value = 10.

Friction Defines the friction value in the generated contact between dummy and
seat. Default value = 0.0.

Stmin Defines the minimum contact stiffness in the generated contact between
dummy and seat. Default value = 1.0kN/mm.

Gap_Min Defines the minimum gap in the generated contact between dummy and
seat. Default value = 0.5.

IGAP Defines the IGAP value for the generated contact between dummy and seat.
Default value = 2.

Export Starts the export process of the pre-simulation deck at the specified
location.

Import h3d File Allows the Radioss simulation to update the initial model.

Close Closes the dialog.
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Create and Route Seatbelts
Create and route seatbelts onto a dummy using the Seatbelt panel.

1. Go to the Analysis page, and click the safety module.

2. Click the seatbelt panel.

3. Select the Create subpanel.

4. Use the node list selector to select the nodes which define the first endpoint, orientation nodes
(used to guide the initial belt position) and the last end point of the seatbelt.

Multiple nodes can be selected as orientation nodes to guide a smooth belt.

5. Use the wrap around selector to select the entities that you want the seatbelt to be wrapped
around.

6. Choose which type of elements to use when creating the seatbelt.

• Choose 1D to create the seatbelt with no width, and so on.

• Choose 2D/1D to create the seatbelt with a combination of 2D and 1D elements.

7. In the gap field, enter a gap between the belts and the dummy components to avoid any initial
penetration.

8. In the orient sensitivity field, enter value can be modified when in orient mode to change the
sensitivity of the interactive movement of the belt segments to mouse movement.

9. If you selected 2D/1D, define the following settings:

a) For end type, select whether the end length of the seatbelt will be rigid links (default) or
tria surfaces.

b) In the element size field, enter the density of the mesh for seatbelts.

c) For mesh type, select whether the mesh of the seatbelt will be quads only (default) or R-
trias.

d) In the belt width field, enter the width (in model units) of the belt.

e) In the 1d length at start field, enter a distance the 1D elements must extend from the first
endpoint of the seatbelt.

f) In the 1d length at end field, enter a distance the 1D elements must extend from the last
endpoint of the seatbelt.

g) Specify when to display the full seatbelt segment.

• Choose on release (default) to display the full seatbelt segment upon release of the
mouse.

• Choose real time to display the full seatbelt segment instantaneously.

h) In the place 1D elems in field, select a collector to place 1D elements that are created.

i) In the place 2D elems in field, select a collector to place 2D elements that are created.

10. After you select the desired end list and the wrap-around entities (components, elements, or
ellipsoids), click orient or accept.

• Click Orient to draw a full segment belt representation, which previews the orientation of the
final belt. The two red end segments are linear and connect the end points selected to the
previous intersection points on the dummy. The middle line segments follow the contour of

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Crash and Safety p.2627

the dummy and connect the two end segments. You can select each of the line segments and
interactively orient them to a specific location. Once the final position is achieved, release the
mouse to create a mesh that follows the specified path. The Update subpanel enables you to
interactively change/update the element density and biasing.

• Click accept to eliminate the belt segment preview and directly create a mesh on the belt.
You can then interactively change or update the element density and so on.

11. Click return to exit the panel.
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Model Setup

Overview of how to build a finite element model.

This chapter covers the following:

• HyperLaminate  (p. 2629)

• Import Geometry  (p. 2652)

• Create Collectors  (p. 2654)

• Create Geometry Data  (p. 2655)

• Temporary Nodes  (p. 2658)

• Select Surfaces  (p. 2659)

• Edit Surfaces  (p. 2660)

• Associativity  (p. 2662)

• Geometry Cleanup  (p. 2663)

• Apply Loads  (p. 2664)

• Create Systems  (p. 2666)

• Tools  (p. 2667)

• Control Cards  (p. 2786)

• Boundary Conditions  (p. 2787)
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HyperLaminate
HyperLaminate is an HyperMesh module that facilitates the creation, review and edition of composite
laminates.

In support of this process certain materials and design variables are also supported by the
HyperLaminate module.

The HyperLaminate Solver (HLS), which is accessed through the HyperLaminate module, uses classical
laminated plate theory for simple in-plane analysis of composite laminates.

The current HyperMesh database is only updated with information from the current HyperLaminate
session on exit from HyperLaminate, except with Abaqus materials, which are updated simultaneously
in HyperMesh and HyperLaminate, so while it is possible to work in HyperMesh while HyperLaminate
is running, this is not advisable. Any changes made to those entities which HyperLaminate touches
(materials, component collectors and design variables) may result in synchronization problems and loss
of data.

HyperLaminate is launched from within HyperMesh either from the HyperLaminate button on the 2D
page of the main menu, or by selecting HyperLaminate from the Materials or Properties pull-down
menus.

The HyperLaminate module is supported for the OptiStruct, Nastran, ANSYS and Abaqus user profiles.

HyperLaminate Environment
Overview of the HyperLaminate environment.

HyperLaminate Menus
The HyperLaminate menu bar provides access to menus that allow you to manage files, edit materials,
laminates, HLS loadcases and design variables, change views, and access online help.

File Menu
New

Generates a new entity, depending on the selected sub-topic in the Laminate Browser.

Export to file
Exports material and laminate information to a text file. This text file can be printed.

Exit
Exit HyperLaminate.
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At this point the current HyperMesh database is updated with the information in the current
HyperLaminate session.

Edit Menu
Cut

Removes the selected data from an entry field and places it on the clipboard for pasting.
Can also remove rows from a ply lay-up order table and place these on the clipboard for pasting.

Copy
Places selected data from an entry field on the clipboard for pasting.
Can also place rows from a ply lay-up order table on the clipboard for pasting.

Paste
Pastes data from the clipboard in selected entry fields.
Can also paste rows from the clipboard above selected rows on a ply lay-up order table.

Delete
When the cursor is active in the Laminate Browser, this deletes the selected entity from the
Laminate Browser. A dialog is displayed to confirm the deletion.
When the cursor is active in the Define/Edit pane, this deletes the selected text from a text box or
the selected rows from a ply lay-up order table.

Tools Menu
Laminate Options

Displays the Laminate Options dialog, which can be used to select defaults for new Laminates
for:

• color

• Convention

• Repetitions

• Ply thickness

• Common thickness

HLS Options
Displays the HLS Options dialog, which allows you to retain the input and result files for the
HyperLaminate Solver. You can also choose the location these files are written to.
The default behavior is to delete these files once HLS is run.

Help Menu
Toolbar

Display/hide toolbar.

Status Bar
Display/hide status bar.

Help Menu
About HyperLaminate

Displays version, contact, and copyright information.
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Help Topics
Activates the HyperLaminate online help.

HyperLaminate Toolbar
The HyperLaminate toolbar contains tools that allow you to generate new materials, laminates, HLS
loadcases or design variables, and to cut, copy, paste, and delete entries in text boxes.

The HyperLaminate toolbar is located below the menu bar and its display is controlled by the Toolbar
option under the View pull-down menu.

New 

Generates a new entity, depending on the selected sub-topic in the Laminate Browser.

Cut 

Removes the selected data from an entry field and places it on the clipboard for pasting.
Can also remove rows from a ply lay-up order table and place these on the clipboard for pasting.

Copy 

Places selected data from an entry field on the clipboard for pasting.
Can also place rows from a ply lay-up order table on the clipboard for pasting.

Paste 

Pastes data from the clipboard in selected entry fields.
Can also paste rows from the clipboard above selected rows on a ply lay-up order table.

Delete 

When the cursor is active in the Laminate Browser, this deletes the selected entity from the
Laminate Browser. (A dialog is displayed to confirm the deletion).
When the cursor is active in the Define/Edit pane, this deletes the selected text from a text box or
the selected rows from a ply lay-up order table.

Laminate Browser
The Laminate Browser provides a vertical tree view of the materials, laminates, and HLS loadcases in
your model.

For the OptiStruct and Nastran user profiles the browser also includes size design variables.

The Laminate browser is located on the left side of the HyperLaminate window.
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On launching HyperLaminate, the Laminate Browser is populated with all the relevant materials,
laminate definitions, HLS loadcases, and size design variables existing in the HyperMesh database, for
the active user profile. The data is presented in a slightly different format for the various user profiles.

Figure 1562: OptiStruct & Nastran Figure 1563: ANSYS Figure 1564: Abaqus

The Laminate Browser is organized in a three-level hierarchy.

1. At the highest level are the entity types: Materials, Laminates, HLS loadcases, and Design
Variables.

2. At the intermediate level are the entity sub-types or card images. These are:

• for OptiStruct and Nastran:

◦ Materials: MAT1, MAT2 and MAT8

◦ Laminates: PCOMP and PCOMPG

◦ HLS loadcases: In-plane loads and In-plane strains

◦ Design variables: DESVAR

• for ANSYS:

◦ Materials: MATERIAL and MPDATA

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2633

◦ Laminates: SHELL91, SHELL99, SOLID46 and SOLID 191

◦ HLS loadcases: In-plane loads and In-plane strains

• for Abaqus:

◦ Materials: ABAQUS_MATERIAL

◦ Laminates: SOLIDSECTION, SHELLSECTION and SHELLGENERALSECTION

◦ HLS loadcases: In-plane loads and In-plane strains

3. At the lowest level are the entities, displayed with the names as defined by you.

Left- or right-clicking on a branch in the browser selects that branch and it becomes highlighted. When
an entity (lowest level branch in the tree hierarchy) is selected, the Define/Edit and Review/Results
panes are populated with details related to that entity. It is then possible to alter and update the entity
definition.

Right-clicking on an already selected (highlighted) branch offers context-sensitive operations for that
branch.

• At the highest level (entity types) no operations are available.

• At the intermediate level (entity sub-types) only one operation is available: New, which will create
a new entity of the selected sub-type. For example, if MAT1 is selected and you right-click it and
choose New; a new MAT1 entity is created.

• At the lowest level (entities) three operations are available; Rename, which allows the entity to be
renamed; Duplicate, which creates a copy of the selected entity; and Delete, which will delete the
selected entity.

• For Laminates a fourth operation is available: to export HLS results for the selected laminate to a
file.

Create Entities
Methods to create new entities in HyperLaminate.

• In the browser, right-click on an intermediate level branch (an entity sub-type or card image) and
select New from the context menu.

• Select an intermediate level branch (an entity sub-type or card image) from the browser tree, then
select New from the File menu.

• Select an intermediate level branch (an entity sub-type or card image), then click  (New) on the

toolbar.

A new entity appears under the selected branch.

A default name and ID are assigned to each newly created entity.

Review and Update Entities

1. In the Laminate browser tree, right-or left-click an entity (lowest level in tree hierarchy).
The selected entity is highlighted.

The Define/Edit and Review/Results panes are populated with details of that entity.
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2. In the Define/Edit pane, make the desired changes to the entity definition.

3. Click Apply or Update Laminate to update the entity.

Rename Entities

1. In the Laminate Browser tree, right-click an entity (lowest level in tree hierarchy), and select
Rename from the context menu.
The name of the selected entity in the Laminate Browser switches to a text box.

2. Enter the desired new name in the text box.

You can also rename an entity by altering the relevant field in the Define/Edit pane and then
clicking Apply or Update Laminate.

Duplicate Entities

In the Laminate Browser tree, right-click an entity (lowest level in tree hierarchy), and select Duplicate
from the context menu.

A duplicate of the entity is created and appears in the Laminate Browser.

Delete Entities

1. Delete entity.

• In the Laminate Browser tree, right-click an entity (lowest level in tree hierarchy), and select
Delete from the context menu.

• In the Laminate Browser tree, left-click an entity (lowest level in tree hierarchy), and select
Delete from the Edit menu.

• In the Laminate Browser tree, left-click an entity (lowest level in tree hierarchy), and click

(Delete) from the toolbar.

2. In the confirmation dialog, click Yes.

The entity is deleted and disappears from the Laminate Browser.
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Note:  Abaqus materials that are created but not defined (they appear in a red font
in Laminate Browser) may not be deleted, as they do not really exist. To delete these
undefined materials, either complete their definition (by clicking Edit – which takes you to
the HyperMesh material card previewer) or exit and restart HyperLaminate, in which case
the undefined materials are purged.

HyperLaminate Solver
The HyperLaminate Solver (HLS) uses classical laminated plate theory to analyze composite laminates
subject to various in-plane and thermal loading conditions.

The solver is integrated into the HyperLaminate module of HyperMesh. The following functionalities are
provided:

• to define and edit HLS loadcases

• to select a subset of HLS loadcases for analysis for each laminate

• to perform the analysis

• to review the results of the analysis for each laminate

• to export the results to an external file

When a laminate is selected from the Laminate browser, an Assign LoadCases button is present in the
lower left corner of the Define/Edit pane. This button launches the LoadCase Definition GUI, allowing
you to select which HLS loadcases the current laminate will be analyzed for.

Figure 1565:
The LoadCase Definition dialog allows you to select loadcases for the current laminate.

Once the desired loadcases are selected, the analysis can be performed for the current laminate by
clicking Calculate. Once the analysis is complete several results tabs will appear in the Review/Results
pane, namely:

• Stiffness/Material Matrix

• Mid-Plane Results

• Global System Results
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• Material System Results

• Principal Results

• Invariant Results

These results will remain so long as the laminate is not updated. Once a laminate is updated, the
results will no longer be valid and therefore the results tabs are removed. Clicking Calculate will re-
launch the HyperLaminate Solver and populate the results tabs for the updated laminate definition.

Select HLS Loadcases for the Current Laminate

1. Click Assign LoadCases.
The LoadCase Definition dialog opens.

2. Check the boxes corresponding to the loadcases to be selected.

3. Click Assign to save the information.

4. Click Close to close the dialog.

Define/Edit Pane
The Define/Edit Pane, the central pane of the HyperLaminate window, allows you to edit the definition of
the selected entity.

On selecting an entity in the Laminate Browser the Define/Edit pane is populated with the current
definition. The configuration of the Define/Edit pane differs for different user profiles and sub-types
(card images).

Materials
For OptiStruct, Nastran and ANSYS materials, all material property information for the selected material
may be edited in the Define/Edit pane. Once the desired changes have been made, clicking Apply
will save those changes for the current HyperLaminate session (it is important to remember that the
HyperMesh database is only updated upon exiting HyperLaminate). To reset all material property fields
to zero you can click Clear. Below are screenshots showing the Define/Edit pane for an OptiStruct MAT8
definition and an ANSYS MATERIAL definition.
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Figure 1566: OptiStruct Materials – MAT8

Figure 1567: ANSYS Materials – MATERIAL

For Abaqus materials, you may rename or redefine the color of the material in the Define/Edit pane, 
but to fully define the material properties you must click Edit. Clicking Edit takes you to the material 
card previewer in the HyperMesh GUI, where you can review and alter the definition of the selected 
material. Once you have finished reviewing/editing the material, clicking return will return you to the 
HyperLaminate GUI. As with the other user profiles, to reset all material property fields to zero you can 
click Clear.
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Laminates
For laminates, the Define/Edit pane allows the laminate name, HyperMesh entity color, stacking 
sequence convention, and the ply lay-up order to be edited. In addition, HLS loadcases may be selected 
(through the Assign LoadCases button) and solved (through the Calculate button) for the current 
laminate. This is for all supported user profiles and laminate sub-types.
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Figure 1569: Abaqus Laminates – SOLIDSECTION

There are a number of options for Convention for the stacking sequence:

Total
The Ply lay-up order table describes the laminate in its entirety.

Symmetric
The Ply lay-up order table describes the bottom half of the laminate. The top half of the laminate
is the mirror image of the bottom half. The ply angles used for the top half are the same as the
ply angles used in the bottom half.
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Antisymmetric
The Ply lay-up order table describes the bottom half of the laminate. The top half of the laminate
is the mirror image of the bottom half. The ply angles used for the top half have the opposite sign
to the ply angles used in the bottom half (but 0, 90, 180, 270, and 360 remain as 0, 90, 180,
270, and 360, respectively).

Symmetric-Midlayer
The Ply lay-up order table describes the bottom half of the laminate and a midlayer (or core). The
midlayer is the last ply defined in the table. The top half of the laminate is the mirror image of
the bottom half. The midlayer is not reflected. The ply angles used for the top half are the same
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as the ply angles used in the bottom half. Due to the midlayer, the total number of plies is always
odd.

Antisymmetric-Midlayer
The Ply lay-up order table describes the bottom half of the laminate and a midlayer (or core). The
midlayer is the last ply defined in the table. The top half of the laminate is the mirror image of the
bottom half. The midlayer is not reflected. The ply angles used for the top half have the opposite
sign to the ply angles used in the bottom half (but 0, 90, 180, 270, and 360 remain as 0, 90, 180,
270, and 360, respectively). Due to the midlayer, the total number of plies is always odd.

Repeat
The Ply lay-up order table describes a single sub-laminate which is repeated a number of times.
The number of repetitions is determined by the number entered in the Repetitions: field (which is
activated when this Convention is chosen).

It is possible to choose between constant and variable ply thickness for certain user profiles; variable
ply thickness allows up to four nodal thicknesses to be defined for each ply.

Figure 1570: ANSYS Laminates – SHELL99
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It is also possible to choose a common thickness for all plies. Common thickness gives every ply in the 
laminate the same thickness.

The Ply lay-up order table describes the laminate from the bottom ply (most negative Z) moving 
upwards (increasing in positive Z direction). Each row of the table defines the material, ply thickness 
and ply orientation for a number of plies (defined by the No. of repetitions field and based on the 
selected Convention). The number of integration points for each ply (or group of plies) is also provided 
in the table. This number is used by the HyperLaminate Solver, as well as the external FEA solver when 
applicable.

Rows are added to the table by completing the Add/Update plies: entry fields and clicking Add New 
Ply. Rows may be inserted in the table, either above or below selected rows (choose from the Above 
Selected or Below Selected radio buttons), by clicking the Insert New Ply button. Rows may be cut, 
copied from, pasted to, or deleted from the table using the Toolbar, pull-down Edit menu, or Ctrl+X, Ctrl
+C, Ctrl+V, and Ctrl+D respectively. Select multiple rows by selecting one row and then, with the Ctrl 
key held down, selecting other rows (alternatively, multiple rows may be selected with the Shift key 
held down; this will retain the current selection and add all the rows between the current selection and 
the newly selected row). Rows are always pasted above the selected rows when multiple rows are 
selected the clipboard contents are pasted above each selected row.

All fields in the Ply lay-up order table may be edited. It is also possible to edit multiple rows at once. 
Select multiple rows as described in the previous paragraph. When multiple rows are selected, the Add/
Update plies: fields are populated with the information common to the selected rows. Blank fields 
indicate that not all of the selected rows contain the same values for that field. Changes can be made to 
the Add/Update plies: fields and Update Selection can be clicked to update the selected rows with the 
updated information (no changes occur to the selected rows for blank fields).

For the OptiStruct and Nastran user profiles it is possible to request stress and failure theory output. 
Each row of the Ply lay-up order table has an SOUT field, which when set to YES includes the plies 
described by that row in the stress output and the failure theory calculation. It is possible to set the 
SOUT field individually for each row, or for all rows at once through the Output ply stress results: field 
under the Stress and failure theory output: heading. Once one or more SOUT fields are set to YES it is 
possible to activate failure theory calculation, by checking the Failure Theory check-box, selecting a 
theory from the pull-down list and defining an Interlaminar shear allowable: value.
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Figure 1571: OptiStruct Laminates – PCOMPG

The Ply lay-up order table for the OptiStruct and Nastran PCOMPG laminate sub-type is different from 
other laminate sub-types in that it has a GPLYID field. This field is used to assign a global ply ID to a 
ply definition (the global ply ID is a post-processing aid). As this ID should not be repeated within the 
same laminate, the No. of repetitions field is not available for PCOMPG. For PCOMPG each row in the Ply 
lay-up order table should represent a single ply so only the Total stacking convention should be used for 
PCOMPG, but this is not enforced in the GUI.

For the OptiStruct and Nastran user profiles it is possible to assign a design variable to a thickness or 
orientation field in the Ply lay-up order table. Checking the Optimization checkbox expands the Ply lay-
up order table, adding extra fields to the right of the Thickness T1 and Orientation 0 fields. Design 
variables may be selected in these extra fields. Selecting a design variable to the right of a thickness or 
orientation assigns the selected design variable to that thickness or orientation.
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Click Update Laminate to apply all the changes for the current HyperLaminate session (it is important 
to remember that the HyperMesh database is only updated on exit from HyperLaminate).

The Define/Edit pane for Laminates also provides access to the HyperLaminate Solver. A number of 
inplane loading scenarios (HLS loadcases) may be solved for a given laminate. The HLS loadcases are 
selected on the LoadCase Definition dialog, which is launched by clicking Assign LoadCases.

Figure 1572: LoadCase Definition GUI

HLS loadcases with a check in the Active column are selected for the current laminate. Different HLS
loadcases may be selected for different laminates. Having selected the appropriate loadcases, click
Apply and then Close to exit the dialog.

Once the loadcases are selected, clicking Calculate launches the HyperLaminate Solver. The Review/
Results pane is then populated with several tabs containing the HyperLaminate Solver results.
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Figure 1573: Hyperlaminte Solver results

HLS Loadcases
For all user profiles the HLS loadcases branch allows various in-plane loading scenarios to be defined
and stored. The loading scenarios can be either load based or strain based. All information for the
selected HLS loadcase may be edited in the Define/Edit pane. Once the desired changes have been
made, clicking Apply will save those changes for the current HyperLaminate session. It is important to
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remember that the HyperMesh database is only updated on exit from HyperLaminate. To reset all fields
for the selected HLS loadcase to zero, you can click Clear.

Design Variables
For the OptiStruct and Nastran user profiles, the DESVAR design variable card is supported in
HyperLaminate. All information for the selected design variable may be edited in the Define/Edit pane.
Once the desired changes have been made, clicking Apply will save those changes for the current
HyperLaminate session. It is important to remember that the HyperMesh database is only updated on
exit from HyperLaminate. To reset all fields for the selected design variable to their default values, you
can click Clear.

Create and Edit HyperLaminate Solver Loadcases
Methods to create and edit HyperLaminate solver loadcases.

Create HyperLaminate Solver Loadcases

1. Create loadcase.

• In the browser, right-click on a sub-type under the HLS loadcases branch and select New
from the context menu.

• In the browser, right-click on a sub-type under the HLS loadcases branch, then select New
from the File menu.

• In the browser, right-click on a sub-type under the HLS loadcases branch, then click  (New)
on the toolbar.

A new loadcase appears under the selected branch.

A default name and ID are assigned to newly created HLS loadcases.

The newly created loadcase is automatically selected in the Laminate Browser and the Define/Edit
pane takes on the appropriate configuration.

2. If desired, a new name for the laminate may be entered in the Loadcase field.

3. Provide the loadcase definition by filling in the entry fields in the Define/Edit pane.

4. Click Apply to save the changes for the current HyperLaminate session.

Note:  The HyperMesh database is only updated on exit from HyperLaminate.

Edit HyperLaminate Solver Loadcases

1. In the Laminate Browser, select the loadcase to be edited.
The Define/Edit and Review/Results panes are populated with the selected loadcase definition.

2. Edit the data fields.

Data may be cut, copied from, pasted to, or deleted from the data fields using the toolbar, pull-
down Edit menu, or Ctrl+X, Ctrl+C, Ctrl+V, and Ctrl+D respectively.
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Clicking Clear will reset all fields to zero.

Each change is reflected in the Review/Results pane.

3. If desired, a new name for the loadcase may be entered in the Loadcase field.

4. Click Apply to save the changes for the current HyperLaminate session.

Note:  The HyperMesh database is only updated on exit from HyperLaminate.

The final loadcase definition is displayed on the Review tab.

Review/Results Pane
The Review/Results pane allows you to review the information pertaining to the selected entity as well
as displaying HyperLaminate Solver results for laminates.

The Review/Results pane is located on the right-hand pane of the HyperLaminate window.

On selecting an entity in the Laminate Browser, the Review/Results pane displays the current definition
of that entity.

Materials
For OptiStruct, Nastran and ANSYS materials, all material property information for the selected material
is displayed in the Review/Results pane. This information is updated as the definitions are altered in the
Define/Edit pane.

For Abaqus materials, no information is displayed in the Review/Results pane.

Laminates
For laminate definitions for all user profiles, the Review/Results pane a Review tab and several results
tabs:

• Stiffness/Material Matrix

• Mid-Plane Results

• Global System Results

• Material System Results

• Principal Results

• Invariant Results

Information displayed on these results tabs is for the saved laminate definition, and is removed when
you click Update Laminate. The results tabs reappear if you run the HyperLaminate Solver for the
updated definition by clicking Calculate.

The Review tab is headed by the laminate name, the total number of plies in the laminate, and the total
thickness of the laminate. This is followed by a description of the laminate, listing the plies in order
from the bottom ply (most negative z), showing a graphical representation of each ply’s orientation and
listing the referenced material, thickness, and orientation.
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The Stiffness/Material Matrix tab provides the two sets of matrices. The first set of matrices are the
composite shell stiffness matrices, more commonly referred to as the ABD matrices. The second set
of matrices are the equivalent material matrices. These are used by many finite element solvers to
represent the laminated composite as a homogenized shell.

The remaining results tabs present results of the HyperLaminate Solver.

HLS Loadcases
For all user profiles, information for the selected HLS loadcase is displayed in the Review/Results pane.
This information is updated as the definitions are altered in the Define/Edit pane.

Design Variables
For OptiStruct and Nastran user profiles, information for the selected design variable is displayed in the
Review pane. This information is updated as the definitions are altered in the Define/Edit pane.

Create and Edit Materials
Methods to create and edit materials in HyperLaminate.

Create Materials

1. Create material.

• In the browser, right-click on a sub-type under the Material branch and select New from the
context menu.

• In the browser, right-click on a sub-type under the Material branch and select New from the
File menu.

• In the browser, right-click on a sub-type under the Material branch, then click

(New) on the toolbar.

A new material appears under the selected branch.

A default name and ID are assigned to newly created materials.

The newly created material is automatically selected in the Laminate Browser and the Define/Edit
pane takes on the appropriate configuration for the selected material sub-type.

2. Define material.

Option Description

For the OptiStruct,
Nastran and ANSYS user
profiles

1. If desired, a new name for the material may be entered in
the Material field or the material color may be altered by
clicking the color swatch and selecting a new color from the
pop-up color palette.
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Option Description

2. Provide the material definition by filling in the entry fields in
the Define/Edit pane.

3. Click Apply to save the changes for the current
HyperLaminate session.

Note:  The HyperMesh database is only updated
on exit from HyperLaminate.

For the Abaqus user
profile

1. Click Edit and provide the material definition in the
HyperMesh card previewer.

2. Click return.

This returns you to the HyperLaminate .

3. If desired, a new name for the material may be entered in
the Material field or the material color may be altered by
clicking the color swatch and selecting a new color from the
pop-up color palette.

4. Click Apply to save the changes.

Note:  It is not possible to rename an Abaqus
material until after it has been defined (edited).
Also it is not possible to create a new Abaqus
material if an undefined material definition
already exists (appears in a red font in Laminate
Browser).

Edit Materials

1. In the Material Browser, select the material to edit.
The Define/Edit and Review/Results panes are populated with the selected material definition.

2. Edit material.

Option Description

For the OptiStruct,
Nastran and ANSYS user
profiles

1. Edit the data fields in the Define/Edit pane.

2. Data may be cut, copied from, pasted to, or deleted from
the data fields using the toolbar, pull-down Edit menu, or
Ctrl+X, Ctrl+C, Ctrl+V, and Ctrl+D respectively.

3. Clicking Clear will reset all fields to zero.
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Option Description

Each change is reflected in the Review/Results pane.

4. If desired, a new name for the material may be entered in
the Material: field, or the material color may be altered by
clicking the color swatch and selecting a new color from the
pop-up color palette.

5. Click Apply to save the changes for the current
HyperLaminate session.

Note:  The HyperMesh database is only updated
on exit from HyperLaminate.

The final material definition is displayed in the Review tab.

For the Abaqus user
profile

1. Click Edit to see the material definition in the HyperMesh
card previewer.

2. Make all desired changes to the material definition in the
card previewer.

3. Click return.

This returns you to the HyperLaminate GUI.

4. If desired, a new name for the material may be entered in
the Material: field or the material color may be altered by
clicking the color swatch and selecting a new color from the
pop-up color palette.

5. Click Apply to save the changes.

Create and Edit Laminates
Methods to create and edit laminates in HyperLaminate.

Create Laminates

1. Create laminate.

• In the browser, right-click on a sub-type under the Laminate branch and select New from the
context menu.

• In the browser, right-click on a sub-type under the Laminaate branch and select New from
the File menu.

• In the browser, right-click on a sub-type under the Laminate branch, then click  (New) on
the toolbar.
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A new laminate appears under the selected branch.

A default name and ID are assigned to newly created laminate.

The newly created laminate is automatically selected in the Laminate Browser and the Define/Edit
pane takes on the appropriate configuration for the selected material sub-type.

2. If desired, a new name for the laminate may be entered in the Laminate name: field or the
component color may be altered by clicking the color swatch and selecting a new color from the
pop-up color palette.

3. For OptiStruct and Nastran user profiles, define the Stress and failure theory output: information
as desired.

4. For all user profiles, define the Stacking sequence convention: information.

5. For Convention:, select a stacking sequence conventions.

6. If you select Repeat, specify how many times you want to repeat the entire block of entry rows.

7. For Ply thickness, select a thickness method.

• Choose Constant to have the Ply lay-up order table include a single thickness column:
Thickness T1.

• Choose Variable to have the Ply lay-up order table include multiple thickness columns.

Note:  The option to switch between constant or variable thickness is only available for
certain laminate sub-types.

8. For Constantply thickness, you can check the Common Thickness checkbox and specify a
thickness to be used by all the entry rows.

Having checked the Common Thickness checkbox and entered a common thickness value, if
you now uncheck the box, the thickness fields retain the common thickness value, but are now
editable.

9. Complete the Ply lay-up order table.

10. Add/insert rows by completing the Add/Update plies: fields and clicking Add New Ply or Insert
New Ply (for Insert New Ply, it is possible to choose to insert the ply above or below the selected
rows).

Note:

The number of rows in the table is not the number of plies. This is governed by the
stacking convention and the number of repetitions.

11. Data may be cut, copied from, pasted to, or deleted from selected fields using the toolbar, pull-
down Edit menu or Ctrl+X, Ctrl+C, Ctrl+V and Ctrl+D, respectively.

12. Table rows may also be cut, copied from, pasted to, or deleted from, using the toolbar, pull-down
Edit menu or Ctrl+X, Ctrl+C, Ctrl+V, and Ctrl+D, respectively.
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Note:

Rows are always pasted above selected rows.

When multiple non-sequential rows are copied and then pasted, they will be pasted as
sequential rows. For example, if rows 1 and 3 are copied and pasted at row 7, row 1
will be pasted as row 7, row 3 will be pasted as row 8, and what was row 7 will now be
row 9.

13. For the OptiStruct and Nastran user profiles it is possible to define thickness and orientation fields
in the Ply lay-up order table as designable and to assign design variables to them.

14. Click Update Laminate to save the changes for the current HyperLaminate session.

Note:  The HyperMesh database is only updated on exit from HyperLaminate.

Edit Laminates

1. In the Laminate Browser, select the laminate to be edited.
The Define/Edit and Review/Results panes are populated with the selected laminate definition.

2. The laminate definition may be modified in the Define/Edit pane in a manner similar to defining a
new laminate.

3. Click Update Laminate to save the changes for the current HyperLaminate session.

Note:  The HyperMesh database is only updated on exit from HyperLaminate.

Create and Edit Design Variables
Methods to create and edit design variables in HyperLaminate.

Create Design Variables

Design variables are only supported for the OptiStruct and Nastran user profiles.

1. Create design variable.

• In the browser, right-click on a sub-type under the design variable branch and select New
from the context menu.

• In the browser, right-click on a sub-type under the design variable branch, then select New
from the File menu.

• In the browser, right-click on a sub-type under the design variable branch, then click
(New) on the toolbar.

Only sub-type available is DESVAR.
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A new design variable appears under the selected branch.

A default name and ID are assigned to newly created design variable.

The newly created design variable is automatically selected in the Laminate browser and the
Define/Edit pane takes on the appropriate configuration.

2. If desired, a new name for the laminate may be entered in the Desvar field.

3. Initial, lower bound, and upper bound values for the design variable can be entered in the
appropriate data fields.

4. Checking the Move limit box activates the Move limit field, where a move limit value other than
the default of 0.5 may be entered.

5. Checking the Ddval ID box activates the Ddval ID field, where the ID of a discrete value list may
be entered.

6. Click Apply to save the changes for the current HyperLaminate session.

Note:  The HyperMesh database is only updated on exit from HyperLaminate.

Edit Design Variable

1. In the Laminate Browser, select the design variable to be edited.
The Define/Edit and Review panes are populated with the selected design variable definition.

2. Edit the data fields in the Define/Edit pane.
Data may be cut, copied from, pasted to, or deleted from the data fields using the toolbar, pull-
down Edit menu or Ctrl+X, Ctrl+C, Ctrl+V, and Ctrl+D, respectively.

3. Clicking Clear will reset all fields to their default values.
Each change is reflected in the Review pane.

4. Click Apply to save the changes for the current HyperLaminate session.

Note:  The HyperMesh database is only updated on exit from HyperLaminate.

The final design variable definition is displayed in the Review tab.
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Import Geometry
Import geometry into your current HyperMesh session, and set advanced import options.

1. From the menu bar, click File > Import > Geometry.
The Import browser opens, and the Import Type is automatically set to Geometry.

2. For File type, select the file type you wish to import.

Tip:  Select an input translator automatically by choosing Auto Detect.

3. Click  to choose the file to import.

Selected files are listed.

4. Set advanced import options by clicking Import Options to expand the panel.

Option Description

Set the
scale factor

1. For Target units, select a unit type.

2. In the Scale factor field, enter a scale factor.

This is useful when converting a model created in English units to Metric, for
example.

Define
cleanup
tolerance

Cleanup tolerance determine if two surface edges are the same and if two surface
vertices are the same. For example, cleanup tolerance determines if two surface
edges are close enough to be automatically combined to shared edges (green
edges) and if a surface is degenerate and should be removed.

1. For Cleanup tol, select a method for defining the cleanup tolerance.

• Choose Automatic to take the complexity of the surfaces and edge
geometries into account and to automatically define a tolerance to
maximize shared edges (green edges). By default, the automatic cleanup
tolerance value defaults to 100 times what is used internally by the
translator.

• Choose Manual to enter a tolerance.

The value you enter must be greater than the default value. The
translator modifies data only if the data stays within the original data
tolerance. Increasing the tolerance can cause serious problems. When
this value is set, any features equal to or less than the tolerance are
eliminated. The translator does not include any edge less than tolerance
long; if there are edges present that are important to the surface, that
surface will be distorted, or will fail to trim properly. Surfaces smaller
than the tolerance may not be imported. If the file you have read has
many very short edges, it may be worthwhile to reread the file using a
larger tolerance. The same holds true if surfaces appear to be "inside
out" when surface lines are displayed. The tolerance value should not be
set to a value greater than the node tolerance set in the options panel to
be used for your element mesh.
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Option Description

If you are reading a Catia file, you may need to override the tolerance in
the file.

Define how
blanked/
no show
entities are
imported

Import blanked entities in the IGES translator, as well as entities containing “NO
SHOW” from the Catia translator by selecting the Import hidden (blanked/no
show) entities checkbox.

5. Click Import.

Import Error Messages
When an external input translator is used to import data, a file for messages is created in the directory
in which the program was started.

This file is named translator.msg, where translator is the name of the translation program being used.
This file contains errors, warnings and useful information about the import process.

The translators also create a second file that contains extra data from the file being imported. This file is
named importfile.hmx, where importfile is the name of the file being imported. This extra data could
contain FEA data and keywords not supported and/or generic comments about the data.

If the Display Import Errors checkbox is selected on the Import tab, any error messages will display
in the Import Process Messages dialog. From this dialog you can choose to display the .hmx file, save
the message file or delete the message file. Clicking Close will close the dialog, but will not remove the
message file from your directory.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2654

Create Collectors
All entities in an HyperMesh database are stored in collectors. Based on the assigned template, each
collector may use a dictionary or card image to define the attributes assigned to the collector. The
definitions contained in the dictionaries or card image are used to translate models to external analysis
codes.

1. From the menu bar, select Collectors > Create > <collector type>.
The Create dialog opens.

2. In the Name field, enter a name for the collector.

3. Define additional fields accordingly.

Fields vary based on the collector type.

4. Click Close.

Change the Current Collector
By default, when you create a new collector it automatically becomes the current collector.

New components, loads, beam sections, multibodies, and so on will be created and organized within the
respective current collector.

The current collector status is indicated in bold.

From the Model Browser, right-click on the collector and select Make Current from the context menu.

Tip:  If you do not know the name of the collector to make current you can quickly find it by

activating the selector ( ) in the Model Browser and selecting the collector in the modeling

window. The selected collector becomes highlighted in the Model Browser.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2655

Create Geometry Data
If geometry is not available from a CAD system, you can create or edit geometry in HyperMesh.

• Create and edit lines.

Option Description

Lines Create lines in a variety of methods, including: from points, at tangents,
and at the intersection of other geometry.

Line Edit Edit existing lines in a variety of methods such as combine, split, smooth,
or extend.

Circles Create circles or arcs.

• Create and edit surfaces.

Option Description

Surfaces Create surfaces from existing lines or nodes by different methods, such
as spline, drag, or spin.

Primitives Create standard shaped surfaces or solid entities, including squares,
spheres, cones, and cylinders.

Surface Edit Edit existing surfaces by trimming, extending, or shrinking.

Defeature Edit existing surfaces by removing individual features such as holes or
fillets.

• Create and edit points and nodes.

Option Description

Nodes Create new nodes. Several methods are available.

Temp Nodes Add or remove nodes used only for geometry creation or editing.

Create NURBS Surfaces
A NURBS (non-uniform rational B-spline) surface is a parametric surface defined by control points,
knots and weights.

Use the ruled, spline/filler, and drag/spin subpanels of the Surfaces panel to create NURBS surfaces.
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The spline option creates a surface through 3D lines. If you select a set of lines that do not form a
closed loop, HyperMesh will connect the disconnected lines with straight lines, and create a spline
surface and/or mesh in the enclosed area. There is no limit on the number of lines used to create a
mesh/surface.

Figure 1574:
Lines form one path because they intersect at four points.

Figure 1575:
Lines form more than one path and cause an error.

The tolerance setting on the Options panel is used to determine the intersections between lines. If
the tolerance is too small and an intersection cannot be found, HyperMesh reports an error when you
attempt to create the surface.

Lines that contain sharp edges can cause problems when you create a surface. These lines result in
a more complex surface, which takes longer to create, and slows the automeshing process. These
sharp edges are sometimes the result of data created on other CAD/CAM systems and brought into
HyperMesh via a translator. These lines may need to be "smoothed" by using the line edit panel or
replaced with a new, smooth, line by using the Lines panel.

Figure 1576:
Creating a surface with these lines results in a relatively complex surface.

Figure 1577:
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The "circular" shaped line has been replaced with a smooth line, which results in a much simpler surface. In some cases the sharp

edges are required to represent the model and should not be smoothed.

The skin option can create a skinned surface through a set of lines.

Figure 1578:
Lines used to define a skinned surface.

Figure 1579:
A skinned surface created from the lines.

The ruled option can create a ruled surface between two lines.

Figure 1580:
Lines used to create a ruled surface.

Figure 1581:
A ruled surface created from the lines.
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Temporary Nodes
A temporary node list retains nodes that are not attached to an element, protecting them from
automatic removal by the database management.

Nodes are not protected from automatic removal for panels that automatically clear all temporary
nodes, such as edges, faces, edit elements. There may be times when you wish to use an unattached
node later in the modeling process.

The Temp Nodes panel allows you to modify the temporary node list. In the Temp Nodes panel, there
are three functions:

add
Adds selected individual nodes to the temporary node list.

clear
Removes selected individual nodes from the temporary node list.

clear all
Removes all the temporary nodes from the database.
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Select Surfaces
Overview of how to select surfaces in wireframe and shaded mode.

Surface edges may be used in the same way as lines in any surface creation panel, where appropriate.
If you use any surface edge lines in the Line Edit panel, duplicates of the lines are created and the
operation is applied to the duplicates.

Select surfaces.

Option Description

Wireframe mode The easiest method of selecting a surface is to pick the surface near
its edges or surface visualization lines. If several surfaces share an
edge, you can select any one of them by clicking on the edge, and
while holding the mouse button down, moving the mouse slightly
from side to side. Each surface highlights as selected. Release the
mouse button when the desired surface is highlighted.

Shaded mode Click anywhere on the surface to select it. Similar to wireframe
mode, you can hold the left mouse button down until the surface of
interest is highlighted, and release it to confirm the selection.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2660

Edit Surfaces
Each surface contains one or more faces. It is usually preferable to combine multiple faces into one
surface entity before you use the meshing tools.

This allows them to be meshed at the same time.

Use the Surface Edit panel to modify surface geometry when it is necessary to make changes before
you generate a mesh.

For example, to trim a surface with a line, use the trim with lines subpanel of the Surface Edit panel.
You must select the surface and the line and specify a direction vector. The surface is trimmed by
sweeping the line along the vector and intersecting the surface with the sweep. If the sweep does not
intersect the surface, the surface is not trimmed.

Figure 1582:
A circle and a surface (represented with surface lines) before trimming.

Figure 1583:
After the circle is used to trim the surface, two new surfaces are created (shown highlighted) and the original surface is trimmed.

To trim one surface with another, use the trim with surfs/planes subpanel.
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Figure 1584:
Two surfaces before trimming.

Figure 1585:
The smaller surface is split into two surfaces after it is trimmed with the larger surface.
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Associativity
Nodes and elements can be associated to surfaces.

When you create a mesh with the automesher, the nodes are automatically associated to the surface.
When nodes are associated to a surface, you can use the Smooth panel to smooth elements on the
surface and the Node Edit panel to move the nodes along the surface. Associated nodes and elements
can be selected by surface, which allows you to select all the nodes and/or elements associated to a
surface. Some operations break associativity. If you transform, such as translate, a surface, node, or
element, associativity is broken. However, if you transform a component that contains both a surface
and its associated nodes/elements, the associativity is not broken.

Associativity is also broken if you trim a surface. To re-associate a node to a surface, use the Node Edit
or Project panel.

Note:  Re-associating nodes to a surface is usually a time consuming task.
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Geometry Cleanup
Prepare surface geometry for meshing.

When designers create CAD geometry, their priorities are different from those of analysts trying to use
the data. A single smooth surface is typically split into smaller patches, each a separate mathematical
face. The juncture between two surfaces often contains gaps, overlaps, or other misalignments.

To make the geometry more appropriate for meshing, analysts need to combine a number of faces
into a single smooth surface. This allows the elements to be created on the entire region at once, and
prevents unnecessary artificial or accidental edges from being present in the final mesh.

The Quick Edit, Edge Edit, Point Edit, and Autocleanup panels contain tools to help you prepare surface
geometry for meshing.

Figure 1586:
The initial CAD geometry often contains gaps, misalignments, or pinholes.These features can distort the elements or demand a

finer mesh.

Figure 1587:
With the tools of the geometry cleanup panels, you can close the gaps between surfaces, combine surfaces into large meshing

regions, and eliminate pinholes. Using the simpler, cleaner geometry, you can easily build a much better mesh.
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Apply Loads
The final step in the model building process is to apply constraints and forces and to create or assign
coordinate systems.

Before you apply loads, create a load collector. Loads are displayed in the color assigned to the load
collector. The size of loads and constraints is based on model units and can be modified from within the
boundary condition panels.

HyperMesh stores and displays all loads in the global coordinate system. Depending on the analysis
code being used to calculate results, HyperMesh transforms the loads appropriately to any local nodal
output coordinate system.

HyperMesh currently supports the following load types:

Accelerations
Applies an acceleration at a node. Accelerations are displayed as a single-headed arrow with an
optional label, A. The label may also display the magnitude of the acceleration.

Constraints
Applies a constraint or enforced displacement at a node. Constraints are displayed as a triangle
with an optional label that displays the degrees of freedom affected by the constraint.

Equations
Applies a general equation constraint between nodes. Equations are displayed with the label, EQ.

Fluxes
Applies a flux load at a node. Fluxes are displayed as a thick arrow with an optional label, flux.
The label may include the magnitude of the flux.

Forces
Applies a concentrated force along any user-defined vector at a node. Forces are displayed as a
single-headed arrow with an optional label F. The label may include the magnitude of the force.

Linear interpolation input files for forces require 6 values with a space in between, as follows:

<X location> <Y location> <Z location> <X component> <Y component > <Z component >

Moments
Applies a concentrated moment about a user-defined vector at a node. Moments are displayed
as a double-headed arrow with an optional label, M. The label may include the magnitude of the
moment.

Linear interpolation input files for moments require 6 values with a space in between, as follows:

<X location> <Y location> <Z location> <X component> <Y component > <Z component >

Pressures
Applies a pressure on an element or geometry. Pressures are displayed as a single-headed arrow
with an optional label, P. The label may include the magnitude of the pressure.

Linear Interpolation input files for Pressures require 4 values with a space in between, as follows:

<X location> <Y location> <Z location> <magnitude>
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Temperatures
Applies a temperature constraint at a node. Temperatures are displayed as a straight line starting
at the node at which the temperature is applied extending upward, with an optional label, T.

Linear Interpolation input files for Temperatures require 4 values with a space in between, as
follows:

<X location> <Y location> <Z location> <magnitude>

Velocities
Applies a velocity at a node. Velocities are displayed as a single-headed arrow with an optional
label, V. The label may include the magnitude of the velocity.

Note:  Refer to the specific panel for detailed information about creating, reviewing, and
updating loads and constraints.
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Create Systems
Systems are referred to as coordinate systems and may be rectangular, cylindrical, or spherical.

Reference and analysis systems are supported. Reference systems transform geometric location or input
vectors from the global system to a local system. Nodes, mass elements, forces, and other systems are
eligible entities for a reference system. Analysis systems transform the output system of a node entity.
Systems are built and referenced in the Systems panel.

Note:  System collectors collect system entities. A system collector must exist and be
current in order to build a system.
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Tools
Overview of tools used when setting up your model.

Setup Modal Analysis
Define modal analysis cards, such as extraction methods, frequency range, modes to expand, iterative
solver tolerance, modes significance level and solution control options.

1. From the menu bar, click Tools > Analysis Setup.

2. In the Analysis Options dialog, set the modal analysis in the model.

All commonly used cards and options for modal analysis in the ANSYS solver are listed in the
dialog. You do not need to search for relevant cards in the control card list, and you do not need
to know the control cards that are used for modal analysis. All other implied ANSYS cards, such
as /SOLU, SOLVE are set up automatically. If any option or card is not required, then default
values will be exported. For example, in the image shown below, if Mass and stiffness matrix
multiplier value need not required.

If modal analysis needs to be carried out in the ANSYS solver, this dialog needs to be set up
before exporting the model to an ANSYS deck.
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Figure 1588:

Compare Models
Perform a model-based CAD-CAD, CAD-FE or FE-FE comparison between two models, or two selections
of entities, and find and report geometrical/shape differences.

When you are comparing entities, the entities must exist in the HyperMesh database. The Comparison
tool generates results by comparing the source entities to the target entities. Currently, only surfaces
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and 2D elements are supported in the Comparison tool. The results generated by this tool can be
broken down into the following categories: Matched, Overlapped, Intersected, and Unmatched.

Open Comparison dialog.

• From the menu bar, click Geometry > Check > Surfaces > Comparison.

• From the menu bar, click Mesh > Check > Elements > Comparison.

Generate Comparison Results
In the Generate tab, define the following options, which will be used to generate the comparison results.

The options available in this tab will vary depending on the Location you select.

1. Click the Generate tab.

2. From the Location list, specify where the entities you are comparing can be found.

• Choose Auto to generate results for entities positioned at any location, by automatically
calculating a transformation matrix between the source and target entities. A maximum of
one match for each source entity will be found. This option is only available for CAD-CAD
comparison.

• Choose Position to generate results for entities positioned at a location that you specify.
For the Source entities and the Target entities collectors, select up to three locations on the
source that correspond to the same three locations on the target. This option will use these
locations to define the transformation of the source entities to the target entities. A maximum
of one match for each source entity can be found.

• Choose Recursive to generate results for entities positioned at any location, by automatically
calculating transformation matrices between the source and target entities. Multiple matches
can be found for each source entity. A source entity may match more than one target entity
positioned at a different location. This option is only available for CAD-CAD comparison.

• Choose Rotate to generate results for entities rotated about a vector. Multiple matches may
be found for each source entity, depending:

Axis
Select a collector that defines the rotation axis/vector.

Angle
Specify the rotation angle to search and find target entities.

Steps
Specify the number of times to increment the angle value when searching.
For example, in the image below, assume the red element is the source, the blue
elements are the target, and the z-axis is the rotation vector. If the angle = 60 and
the steps = 1, then only the first blue element will be found. If the steps = 2, then the
first two blue elements will be found. If the steps = 3, then all three blue elements will
be found. Similarly, if the angle = 30 and the steps = 1, then no blue elements will be
found, but if the steps = 2, then the first blue element will be found.
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Figure 1589:

• Choose Same side to generate results for entities positioned at the same location. A
maximum of one match can be found for each entity source.

• Choose Symmetry to generate results for entities positioned symmetrically about a plane.
A maximum of one match can be found for each source entity. When you select this option,
the Symmetry plane selector becomes active. Use the Symmetry plane selector to select the
plane about which the symmetry exists.

• Choose Translate to generate results for the entities translated along a vector. Multiple
matches may be found for each source entity, depending on:

Direction
Select a collector that defines the translation vector.

Distance
Specify the translation distance to search and find target entities.

Steps
Specify the number of times to increment the distance value when searching.
For example, in the below image, assume the red element is the source, the blue
elements are the target, and the x-axis is the direction vector. If the distance = 2 and
the steps = 1, then only the first blue element will be found. If the steps = 2, then the
first two blue elements will be found. If the steps = 3, then all three blue elements will
be found. Similarly, if the distance = 1 and the steps = 1, then no blue elements will be
found, but if the steps = 2, then the first blue element will be found.

Figure 1590:

3. In the Tolerance field, enter the tolerance to use for comparing entities, in model units.

A smaller value will lead to a more strict interpretation, while a larger value will lead to a looser
interpretation.
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The tolerance is not used to remove features smaller than the tolerance value. All features for a
surface or mesh are considered valid for comparison regardless of their size, and must be within
the tolerance of a similar feature on the compared entities for the surfaces or elements to be
considered matched or overlapped.

4. For Result type, select the level of detail for the results.

Higher levels of detail require more calculation and processing time. Each level of detail produces
different results based on the type of comparison you are performing. For detail description of the
result types, refer to Comparison Result Types.

5. Optional: Perform a comparison a shells using their thickness.

a) Select the use thickened shells checkbox.

Restriction:  Only available when you are comparing FE-CAD/CAD-FE.

b) To keep the internally calculated fillet distance relatively small, meaning that elements near
fillet regions must also be close to the surfaces to prevent them from being marked as
intersected, select the Match fillets checkbox.

Fillets are assumed to lie nearby fillet roots, which are located at all t-intersections and bends
in the mesh of at least 44 degrees. Any nodes within an internally calculated distance of a
fillet root are treated as being inside the fillet, and therefore they cannot cause an element
to be marked as intersected. When you clear the Match fillets checkbox, the internally
calculated distance will be relatively large, preventing many elements in fillet regions from
being marked as intersected if they are not close to the surfaces.

The internally calculated fillet distance is based on the thickness of the elements touching
the fillet root and the average thickness in the model. It is not a precise determinant of the
actual fillet region and is only intended to prevent elements that are not close to the surfaces
due to the presence of fillets from being marked as intersected. As a result, most models
with fillets will have elements in the fillet regions marked as overlapped or intersected rather
than matched.

Note:  Clearing the Match fillets checkbox may cause the internally calculated
fillet distance to be rather large for certain models, and may potentially mark
elements as overlapped when they would otherwise be marked intersected due to
the element's edges not matching surface lines.

c) Use the Ignore holes/slots option to specify which holes and/or slots in the surface data to
ignored during the comparison.

If the features are smaller than the specified Holt/slot diameter and/or Slot length criteria,
then they will be ignored. Element edges in the region of an ignored hole or slot are not
required to be within the tolerance of a surface line. Element nodes over an ignored hole or
slot cannot cause the element to be marked as intersected.

Figure 1591:

6. To use the normal projection of the centroid of an element to help determine with which surface
an element should be associated, select the Include element centroids checkbox.
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Without this option, elements are associated with a given surface based on the largest number
of their nodes which are within the given tolerance of that surface. If an element has the same
number of nodes within the given tolerance of more than one surface the association will be made
arbitrarily. This option uses the projection of the element centroid to remove any ambiguity as to
which surface is the best fit.

Additionally, elements that lie partially or completely off the edge of a surface will be marked as
unmatched instead of intersected if the projection of the centroid does not lie on any surface. This
option is particularly useful when comparing coarse meshes to highly curved surfaces.

This option is turned off by default because it can substantially increase the time spent comparing
meshes if there are a large number of ambiguous elements.

Restriction:  Only available for CAD-FE/FE-CAD comparisons.

7. To refacet all the surfaces in the model so that their facet size will be roughly equal to that of the
compared elements, select the Refined facets checkbox.

This option is particularly useful when comparing highly curved geometries to FE meshes with a
tight tolerance.

The Comparison tool uses surface facets, rather than the surfaces themselves, to quickly compare
elements to surfaces or surfaces to surfaces. Often the default facets can be long, thin triangles
which only roughly capture the surface curvature in highly curved areas. While the default facets
can often be “close enough” to the surfaces they represent, nodes of an element which lie exactly
on the surface may actually lie outside the given tolerance of the nearest surface facet. If this
happens, the elements attached to that node will be marked as intersected or unmatched instead
of overlapped or matched.

One solution to this problem is to increase the tolerance, but there are times when using a large
tolerance will be undesirable. For those times you can select this option which will recalculate
the facets for the surfaces such that they more closely adhere to the actual surfaces. The result
will be more accurate results with more elements marked as matched or overlapped instead of
intersected or unmatched.

This option is turned off by default because it can substantially increase the time spent making the
comparison.

Restriction:  Only available for CAD-FE/FE-CAD comparisons.
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8. Click Run.

Comparison Result Types
Overview of the different result types you can select when working with the Comparison tool.

Standard Comparison

Table 263: Overview of Standard Comparison Result Type

CAD-CAD CAD-FE/FE-CAD FE-FE

Basic Matched (paired)

Unmatched

Matched (paired)

Unmatched

Matched

Unmatched

Full Matched (paired)

Overlapped

Intersected

Unmatched

Matched (paired)

Overlapped

Intersected

Unmatched

Matched

Overlapped

Intersected

Unmatched

Detailed Matched (paired)

Overlapped (paired)

Intersected (paired)

Unmatched

Matched (paired)

Overlapped (paired)

Intersected (paired)

Unmatched

Matched

Overlapped

Intersected

Unmatched

CAD-CAD

Result Type Description

Basic Matched
Occurs when a source or target surface is within the given
tolerance of a compared surface using a direct surface to surface
comparison. All points and lines comprising each surface must
match between the surfaces. Each matched surface is placed in a
separate match type group with the surface it matches.

Unmatched
Occurs when a source or target surface differs from the closest
compared surface to a degree larger than the tolerance.

Full Matched
Occurs when a source or target surface is within the given
tolerance of a compared surface using a direct surface to surface
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Result Type Description

comparison. All points and lines comprising each surface must
match between the surfaces. Each matched surface is placed in a
separate match type group with the surface it matches.

Overlapped
Occurs when all facet nodes of a source or target surface are
within the given tolerance of the compared surfaces and all of
the facet nodes on the nearest compared surfaces' exterior edges
are within the given tolerance of the source or target surface's
exterior edges. All of the overlapped surfaces are placed in a
single match type group.

Intersected
Occurs when at least one but not all facet nodes on a source or
target surface are within the given tolerance of the compared
surfaces or at least one of the facet nodes on the nearest
compared surfaces' exterior edges is outside the given tolerance
of the source or target surface's exterior edges. All of the
intersected surfaces are placed in a single match type group

Unmatched
Occurs when there are no facet nodes on a source or target
surface that are within the given tolerance of the compared
surfaces, or all the criteria for the intersected match type are met
and no interior facet nodes for the surface are within the tolerance
of the compared surfaces.

Detailed Behaves the same as Full, except overlapped and intersected match
types are separated out into pairs, or contiguous groups which share
the same match type.

CAD-FE/FE-CAD

Result Type Description

Basic Matched
Occurs when a group of elements are found having all nodes
within the given tolerance of a surface, the areas defined by the
surface and the elements are within 3%, and all of the nodes on
the elements' exterior edges are within the given tolerance of
the surface's exterior edges. Each matched surface is placed in a
separate match type group with the elements it matches.

Unmatched
Occurs for surfaces and elements when the matched criteria are
not met.
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Result Type Description

Full Matched
Occurs when a group of elements are found having all nodes
within the given tolerance of a surface, the areas defined by the
surface and the elements are within 3%, and all of the nodes on
the elements' exterior edges are within the given tolerance of
the surface's exterior edges. Each matched surface is placed in a
separate match type group with the elements it matches.

Overlapped
Occurs for a surface when all facet nodes on the surface are
within the given tolerance of the elements and all nodes along the
nearest FE mesh's exterior edges are within the given tolerance
of the surface's exterior edges. It occurs for an element when
all of the nodes of the element are within the given tolerance of
the surfaces and all of the nodes of the element which touch the
FE mesh’s exterior edges are within the given tolerance of the
surfaces’ exterior edges. All overlapped surfaces and elements are
placed in a single match type group.

Intersected
Occurs for a surface when at least one of the facet nodes on the
surface is within the given tolerance of the elements and at least
one point along the nearest FE mesh's exterior edges is outside
the given tolerance of the surface's exterior edges. It occurs for
an element when at least one node of the element is outside the
given tolerance of the surfaces, or when at least one of its nodes
which touch the FE mesh’s exterior edges is outside the given
tolerance of the surfaces’ exterior edges. All of the intersected
surfaces and elements are placed in a single match type group.
The options Include Element Centroids and Refine Facets can
improve the accuracy of the results in both Full and Detailed
results modes. Without these options, some elements will be
marked as intersected if one of their nodes lies outside of the
tolerance of a coarse facet approximating a curved surface.
Other elements may get marked as intersected if it is ambiguous
to which surface they belong or if they have one or two nodes
within the tolerance of any surface but do not overlap it at all. By
including element centroids in the calculations and using refined
facets, intersected elements and surfaces may be more accurately
marked as overlapped or unmatched.

Unmatched
Occurs for a surface when there are no facet nodes on the surface
that are within the given tolerance of the elements. It occurs for
an element when no nodes of the element are within the given
tolerance of the surfaces.
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Result Type Description

Detailed Behaves the same as Full, except that each surface will be placed in a
separate match type group with the elements it overlaps or intersects
with. Due to the grouping process, surfaces that are not grouped with
any elements are marked as unmatched. In Full results, such surfaces
may be marked as intersected if a surface edge is within the given
tolerance of an element but there is no overlap in the interior of either.
A given surface may be in two match type groups: one with overlapped
elements and another with intersected elements.

FE-FE

Result Type Description

Basic Matched
Occurs when an element is within the given tolerance of another
element using a direct node to node comparison. All matched
elements are placed in a single match type group.

Unmatched
Occurs if at least one node for the element lies outside the given
tolerance of the nodes of the compared FE mesh.

Full Matched
Occurs when an element is within the given tolerance of another
element using a direct node to node comparison. All matched
elements are placed in a single match type group.

Overlapped
Occurs when all nodes of a source or target element are within
the given tolerance of the compared elements and all of the
element’s nodes which touch the FE mesh’s exterior edges are
within the given tolerance of compared FE mesh’s exterior edges.
All of the overlapped elements are placed in a single match type
group.

Intersected
Occurs when at least one node of a source or target element is
outside the given tolerance of the compared elements or at least
one of the element’s nodes which touches the FE mesh’s exterior
edges is outside the given tolerance of the compared FE mesh’s
exterior edges. All of the intersected elements are placed in a
single match type group.
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Result Type Description

Unmatched
Occurs when there are no nodes of a source or target element
that are within the given tolerance of the compared elements.

Detailed Behaves the same as Full.

Thickened Shell Comparison
When you are performing a thickened shell comparison, Basic, Full, and Detailed all produce the same
answer.

CAD

Matched
There is no criteria for matched surfaces in a thickened shell comparison. However, a value
is provided by dividing the matched FE area by two. Surfaces are set to 100% matched if
the FE is also 100% matched. Surfaces are never categorized as matched, though, as the
overlapped match type is the maximum category.

Overlapped
Occurs when all points of a surface are within the tolerance of the elements (when offset
is projected by thickness). The element edge nodes that are not within the tolerance
of a surface edge may be projected on to the surface. This is calculated by dividing the
overlapped FE area by two.

Intersected
Occurs when at least one point of a surface is within the tolerance of the elements (when
offset is projected by thickness). This value is adjusted to make sure the percentages add
up to 100%.

FE

Matched
Occurs when all of an element's nodes (when offset is projected by thickness) are within
the tolerance of a surface on both sides. If a node is lying along the edge of a mesh, it must
also be within the tolerance of a surface line on at least one side.

Overlapped
Occurs when all of an element's nodes (when offset is projected by thickness) are within
the tolerance of a surface on both sides, located over an ignored hole or slot, or within the
internally calculated distance of the root of a fillet (any t-intersection or bend in the mesh of
at least 44 degrees). If a node is lying along an edge, it must also be within the tolerance
of a surface line on at least one side, located over an ignored hole or slot, or within the
internally calculated distance of the root of a fillet.

Intersected
Occurs when at least one of an element's nodes (when offset is projected by thickness) are
within the tolerance of a surface on at least one side, located over an ignored hole or slot,
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within an internally calculated distance of the root of a fillet (any t-intersection or bend in
the mesh of at least 44 degrees), or within the tolerance of any surface edge.

Define Review Settings
In the Review tab, you can control the comparison review mechanism options.

The Review tab is enabled once comparison results are available.

1. Click the Review tab.

2. Define the type of review to perform.

To perform Do this

No review Steps to perform if you do not want to apply any graphical review.

1. For Review type, select None.

Comparison Steps to perform if you want to generate a visual representation of the
comparison results graphically.

Figure 1592:

1. For Review type, select Comparison.

2. For Review colors, specify how to display the results of the match
types.

• Choose Basic to display all of the match types by grouping
together the matched/overlapped as matched and the
intersected/unmatched as unmatched.

Figure 1593:

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2679

To perform Do this

• Choose Detailed to display all of the match types by their
defined colors.

Figure 1594:

3. Under Source/target match types, click the color swatch and then
select a new color from the box to control the display colors of each of
the match types for both the source (left) and target (right) entities.

To control which match types display in the graphics area, select
the check box next to each match type you would like to display. If
any entity is part of two match types, then the "worse" type takes
precedence.

Figure 1595:

If you would like to reset the colors to their default values, click Reset
Colors.

4. For Transparent, specify whether the source entities, target entities,
or no entities at all will be drawn transparent. The entities displayed
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To perform Do this

that are not part of the comparison operation will always be drawn
transparent.

Figure 1596:

5. For Transparent color, specify how transparent entities will be drawn.

• Choose Gray to display transparent entities in the default
HyperMesh gray color.

Figure 1597:

• Choose Review to display transparent entities in their default
color.
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To perform Do this

Figure 1598:

Distance Steps to perform if you want to generate a contour plot that shows the
distance of the target entities from the source entities.

Restriction:  Not available for CAD-CAD comparisons.

1. For Review type, select Distance.

2. In the Maximum distance field, enter a maximum value to display in
the contour legend.
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To perform Do this

Figure 1599:

Review Results
In the Results tab, you can review the area-based qualitative results for the comparison.

The Results tab is enabled once comparison results are available.

The area, as a percentage, for the source and target entities of each match type is reported in the
Source area% and Target area% fields.
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Figure 1600:

1. Click the Results tab.

2. Review results.

When comparing CAD-CAD or FE-FE, the area percentages are calculated by summing the areas
of all the entities in each category and dividing them by the total area. However, when comparing
CAD-FE or FE-CAD, the Comparison tool uses the areas of the overlapped and intersected
elements in place of the overlapped and intersected surfaces when making these calculations.
While this may not be technically correct, it results in more accurate area percentage estimates.

The overlapped and intersected categories are inherently imprecise. The actual lines of
intersection between the compared entities seldom lie along the element and surface boundaries
and thus cannot be easily determined. If the surfaces and elements were highly refined to a very
small scale, you would have no overlapped or intersected entities at all. Instead the elements and
surfaces would all be either matched or unmatched and the area percentages could be calculated
to a high degree of accuracy. However, since this is not a practical solution, the Comparison Tool
tries to get the most accuracy out of the entities you have.

In general, intersections between CAD and FE usually involve only small areas of the model, for
example, a hole in the CAD which is not represented in the FE. The Comparison Tool marks the
entire surface as a single match type and chooses the most severe type: intersected. This is
despite the fact that the majority of the surface may be overlapped with the FE mesh. If the entire
surface is used when calculating the area percentage of the intersected surfaces, that figure may
end up being misleadingly high since only a small part of the model is actually intersected. Also,
the area percentages between the surfaces and the elements may end up being very different due
to the relative size differences between the elements and surfaces, which can be confusing. Is the
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model 5% intersected as the elements show or 25% intersected as the surfaces indicate? Since
elements are generally smaller than surfaces, they generally give a more accurate assessment of
the actual amounts of the model which are intersected and overlapped. For this reason, the FE
areas are used instead of the surface areas in the area calculations, with care taken to ensure that
the percentages all add up to 100%. The result is more accurate results and tighter correlation
between element and surface area percentages.

3. Export comparison results to external files.

a) To write the current comparison data (transformations, match types, match entities, and so
on) to a file, select the Write data file checkbox.

b) To write the current comparison results (area%, entity groupings) to a file, select the Write
results file checkbox.

Both distance and comparison results can also be exported to an H3D file by clicking File >
Export > Model from the menu bar and enabling the Write results checkbox.

For comparison results, the following special behaviors apply:

• If the source, target, or both are not transparent, and if a match type is turned off, the
entities belonging to that match type will not be exported.

• If the source, target, or both are transparent, all match types are exported regardless
of whether they are turned on or off. The components can be made transparent within
HyperView or HyperView Player as desired.

• If the transparent color is gray, the entities are shown as "no result" (which is also gray).
Otherwise they are shown in color.

4. Click Apply.

Create Entity Sets
In the Sets tab, you can create entity sets from the generated comparison results.

The Sets tab is enabled once comparison results are available.

1. Click the Sets tab.

2. Under Source entities, select the corresponding Source entities and Target entities checkboxes
for the entity sets you wish to create.

One entity set is created for each unique location-type-transformation grouping. A relevant
transformation matrix for each grouping is attached as metadata to each entity set created, with
the name CompareTransformationMatrix.

3. For Name prefix, enter a prefix for the generated entity set names.

HyperMesh generates the set names as:: <prefix>_Transform<#>-<Type>-
<SourcelTarget>_<#>

Figure 1601:
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4. Click Create.

Setup DDAM Analysis
Setup a DDAM analysis for Abaqus, and use the Shock Spectra curves for a subsequent Response
Spectum Analysis.

Before you can setup a DDAM analysis, a normal mode result must be available for the model. Abaqus
*.dat files are supported.

1. From the menu bar, click Tools > DDAM.
The HM DDAM Utility dialog opens.

2. In the Import Result File field, browse to the location of the results file.

3. Click Import.

Figure 1602:

4. Select shock modes for the DDAM process.

a) Under Shock Modes, select a type of mode selection.

• Choose Significant to automatically select modes based on the modal weight until a
cumulative contribution is met.

• Choose All to automatically select all of the modes. This option is not realistic for very
large models and frequency ranges due to the size of output files. It is recommended to
use this option with smaller output files.

• Choose Manual to manually select any selection of modes.

b) Under Direction, select a direction.

c) If you selected Manual, select modes from the table.
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Note:  By default, modes that have the largest contribution until the minimum
cumulative model weight of 80% is achieved are selected. These modes are
highlighted in grey. By default, these modes are shown for the contribution in the
X-Direction.

The summation of percent modal weight currently selected is displayed in the the
Percent Selected Modal Weight field. Green indicates the percentage is greater
than the minimum cumulative modal weight, yellow indicates the percentage is
close to the minimum cumulative modal weight, and red indicates more modes
are needed.
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Figure 1603:

5. Determine DDAM loading values.

a) Select a Ship Type.

b) Select a Mounting System.

c) Select a Deformation Type.

d) To manually define loading values, select Specify values.

Note:  By default, the loading values are pre-populated with the NREL 1396 values.

Figure 1604:

6. Click Calculate Spectrum.
The Shock Spectra curves are calculated, and the mode table and weighted average Da values are
populated.
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Figure 1605:

7. View a plot of the Shock Spectra curves.

a) Go to the Plots tab and select a Plot Type.

• Choose Acceleration vs. Frequency to display a line chart, which is only available after
shock spectra calculation.

• Choose Frequency vs. Mode to display a bar chart, which is available after importing a
results file.

• Choose Effective weight vs. Frequency to display a bar chart, which is available after
importing a results file.

b) Select a Shock Mode.

c) Select a Direction.
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8. Go to the DDAM tab and click Create Loadsteps.
Shock Spectra curves are created in the form of load steps, and organized in the Model Browser,
Load Step folder.

Fatigue Process
Create or open a fatigue analysis setup process.

Restriction:  Only available in the OptiStruct solver interface.

Create New Session

1. From the menu bar, click Tools > Fatigue Process > Create New.

2. The Create New Session dialog opens.

3. Create a new fatigue analysis setup process and save it to your working directory.

4. Click Create.
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Load Existing Session

1. From the menu bar, click Tools > Fatigue Process > Load Exist.
2. The Process Manager browser opens.

3. In the Load template field, load a fatigue analysis setup process that has been previously saved to
a file.
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Frequency Response Process
Setup a frequency response analysis with a series of step by step process templates.

These process templates prompt you to enter generic engineering data, and once the data is available, 
automatically create frequency response analysis loadcases and associated solver cards. The templates 
share a set of common process steps that are only described the first time they are used.

Setup a frequency response analysis by clicking Tools > Freq Resp Process from the menu bar, and 
selecting one of the step by step process templates.

Restriction:  Only available in the OptiStruct and Nastran user profiles.

Setup a Normal Model Process

The Normal Modes loadcase Process Manager automatically generates a loadcase template, which can
be used in the Analysis Manager for future normal modes loadcases without going through the Process
Manager again.
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Figure 1609:

1. From the menu bar, click Tools > Freq Resp Process > Normal Modes.

A normal modes analysis process template is loaded and opens in the Process Flow browser.

2. In the Subcase Definition task, create a new subcase or edit an existing subcase.

a) Create or edit a subcase.

• To create a new subcase, edit the optional subcase label and click Add.

• To edit an existing subcase, highlight an existing subcase in the list box, edit the optional
subcase label and click Update.

b) Once input to the task is complete, click Apply to proceed.

Figure 1610:

3. In the Normal Mode Frequency task, define Normal Mode Frequency.

a) Enter normal modes extraction parameters, such as Min. and Max. frequency, or the number
of modes desired.

In most cases, only input for the Max. frequency field is needed. When left blank, the Min.
frequency is interpreted as 0 (Hz.), and the No. of modes is however many found between
0 and the Max. frequency. This task gives you separate control over modal extraction in the
structural and fluid domains.
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b) Once input to the task is complete, click Apply to proceed.

Figure 1611:

4. In the Select Response Points task, select response points for output.

a) Select a Response type, such as Displacement.

b) Use the Entity selector to select nodes, a node set, or tags to be included in a particular
response set.

You can add or delete multiple response sets from the list using the Add row and Delete
row icons to the right of the list.

Figure 1612:

c) Under Output data format, select the complex frequency response data format (real/
imaginary or magnitude/phase).

d) Under Output file format, select the output file format (h3d, punch, or op2).

e) Once all the required responses have been defined, click Apply to proceed.
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Figure 1613:

5. In the Constraint selection, SPC task, select the boundary condition of the frequency response
analysis.

a) You can select existing SPCs by checking the corresponding box under the Active column, or
click Create SPC to go to the Constraints panel and define a new SPC.

b) Once the boundary condition has been fully defined, click Apply to proceed.

6. In the Constraint selection, MPC task, select MPC equations to turn on for the frequency response
analysis.

a) Select MPCs.

• NVH user profile: There are two options for managing MPCs, the Analysis Manager and
the Process Manager. If you select the Analysis Manager, the Select subcase option and
the MPCs list are disabled. If you select the Process Manager, after you select a subcase
you can then select existing MPCs by checking the corresponding box under the Active
column.

• HyperMesh user profile: The Analysis Manager option is not available, and the MPCs can
only be managed through the Process Manager.

b) Once the MPC equations have been selected, click Apply to proceed.

7. In the Parameter Selection task, select typical solution parameters, such as title, singular point
constraints, and so on.

a) Check all boxes under the Active column to activate the desired solution option.

b) Once the parameters have been selected, click Apply and a Process Manager message box
pops up informing you that the process has come to an end.

c) Click Yes to close the template, or No to review or edit the process steps.
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Figure 1614:

8. In the Generate TPL file task, generate and save the parameters defined in a standard template
file at your selected location.

In the Analysis Manager, the generated template file can be selected as loadcase and solver decks
can be exported for normal modes analysis.
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Figure 1615:

Setup CMS SE Generatin Process
The CMS SE Generation process template helps you generate a CMS SuperElement (SE) modal model
from a finite element based model.

Figure 1616:

1. From the menu bar, click Tools > Freq Resp Process > CMS SE Generation.
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2. In the CMS Modal Frequency step, define the CMS modal frequency.

a) For CMS method, select a type of CMS SE.

• Choose Craig-Bamption (CBN)  to create a fixed boundary Craig-Bamption (CBN) CMS
superelement.

• Choose GM - general modal method to create a mixed (free-free or fixed) boundary
(GM - general modal method) CMS superelement.

b) Define the modes to be included by specifying either the upper frequency or the number of
modes, as well as Spoint starting IDs to be assigned to the modes.

The Spoint ID fields are auto filled with the first available ID provided by the HyperMesh
database. Each mode added to the CMS SE will be assigned a Spoint ID sequentially from the
starting ID, and the total number of Spoint IDs actually used will be the same as the number
of modes found.

c) Fluid modes, as well as fluid-structure coupling matrix can be included in the CMS SE by
selecting the Coupled fluid-structure SE checkbox, and providing the above mentioned
frequency and Spoint ID definition for the fluid modes.

d) Once the task has been completed, click Apply to proceed.

Figure 1617:

3. In the CMS Modal Definition task, specify what recovery information is to be stored in the CMS SE.

a) Select a set of elements, for which the keyword Plotel is a valid specification, or a set of
grids.

b) To exclude/include rigid elements from the recovery set, select the Rigid checkbox.

c) Once the model recovery set has been defined, click Apply to proceed.

Figure 1618:

4. In the Attachment Definition task, specify attachment point sets.
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a) Both fixed and free-free attachments can be specified for a mixed (GM) CMS SE, while only
fixed attachments can be specified for a fixed (CBN) CMS SE.

b) Once the attachment set has been defined, click Apply to proceed.

Figure 1619:

5. In the MISC Options task, specify structural damping and fluid-structure coupling options.

a) You can specify a global material damping to be assigned to all structural parts, or select the
option of No damping to avoid adding any damping globally if damping has been specified
at the material level for all components.

Note:

Global modal viscous damping or global fluid damping cannot be stored in a
CMS SE, but can be applied in assembly (residual) runs using the CMS SE as a
component.

b) For fluid-structure coupling, choose Solver auto-search driven by the ACMODL card, or
Akusmod which assumes that coupling is provided in a binary file named ftn.70.

Figure 1620:

6. In the Parameter Selection task, select typical solution parameters, such as title, singular point
constraints, and so on.

a) Check all boxes under the Active column to activate the desired solution option.

b) Once the parameters have been selected, click Apply and an Process Manager message box
pops up informing you that the process has come to an end.

c) Click Yes to close the template, or No to review or edit the process steps.
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Setup CDS SE Generation Process
Generate a CDS SuperElement (SE) from a finite element based model.

Figure 1621:

1. From the menu bar, click Tools > Freq Resp Process > CDS SE Generation.

2. In the Select Analysis Frequencies task, enter the frequencies for which response solution is
needed.

a) Define the frequency set.

• To define the min, max, and a linear step, select Frequency range. For Incr type, select
Linear and then fill in the required fields.

• To define min, max, and a number of increments with logarithmic spacing, select
Frequency range. For Incr type, select Logarithmic and then fill in the required fields.

• To define an arbitrary list of frequencies, select Frequency list and enter a list of
arbitrary frequencies.
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b) Click Update.

A frequency set entry is created in the list box to the left. You can add additional frequency
sets, or delete one from the list using the Add row and Delete row icons to the right of the
list.

c) Once the frequency set(s) have been defined, click Apply to proceed.

Figure 1622:

3. In the Normal Mode Extraction task, the default frequencies filled in are based on the max.
frequency you filled in for the previous step.

a) Modify the values based on the specific requirements of the case under study.

These values are merely the suggested values based on general use cases.

b) Click Apply to proceed.

Figure 1623:

4. In the CDS Method task, define the CDS method.

a) For CDS method, select a type of CDS SE.

Currently only the BME method is available.

b) To store transfer functions in CDS superelement, select the Store transfer functions in
CDS superelement checkbox.

c) To generate a CMS-SE modal model result file after solving, select the Export CMS
superelement file checkbox.

d) Click Apply to proceed.
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Figure 1624:

5. In the CMS Model Definition task, specify which recovery information is to be stored in the CMS
SE.

Restriction:  This task is only activated when the Export CMS superelement file
checkbox is selected.

a) Select a set of elements, for which Plotel is a valid specification, or a set of grids.

b) To include or exclude rigid elements from the recovery set, select the Rigid checkbox.

c) Once the model recovery set has been defined, click Apply to proceed.

Figure 1625:

6. In the Attachment Definition task, specify attachment point sets.

a) Both fixed and free-free attachments can be specified for a mixed (GM) CMS SE, while only
fixed attachments can be specified for a fixed (CBN) CMS SE.

b) Once the attachment set has been defined, click Apply to proceed.
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Figure 1626:

7. In the MISC Options task, specify structural damping and fluid-structure coupling options.

a) You can specify a global material damping to be assigned to all structural parts, or select the
option of No damping to avoid adding any damping globally if damping has been specified
at the material level for all components.

Note:

Global modal viscous damping or global fluid damping cannot be stored in a
CMS SE, but can be applied in assembly (residual) runs using the CMS SE as a
component.

b) For fluid-structure coupling, choose Solver auto-search driven by the ACMODL card, or
Akusmod which assumes that coupling is provided in a binary file named ftn.70.

Figure 1627:

8. In the Parameter Selection task, select typical solution parameters, such as title, singular point
constraints, and so on.

a) Check all boxes under the Active column to activate the desired solution option.

b) Once the parameters have been selected, click Apply and an Process Manager message box
pops up informing you that the process has come to an end.

c) Click Yes to close the template, or No to review or edit the process steps.
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Figure 1628:

Setup Unit Input Frequency Response Process
Set up subcases with unit inputs. In practice, this is common to generate vibration and noise sensitivity
results.

Figure 1629:

1. From the menu bar, click Tools > Freq Resp Process > Unit Input Frequency Response.

2. In the Select Solution Type task, select a solution method.

a) Select either the Direct Frequency Response solution method, or the Modal Frequency
Response solution method. For large problems involving more than a few frequencies, the
modal solution is typically the most efficient solution.

b) Click Apply to proceed.
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3. In the Select Analysis Frequencies task, enter the frequencies for which response solution is
needed.

a) Define the frequency set.

• To define the min, max, and a linear step, select Frequency range. For Incr type, select
Linear and then fill in the required fields.

• To define min, max, and a number of increments with logarithmic spacing, select
Frequency range. For Incr type, select Logarithmic and then fill in the required fields.

• To define an arbitrary list of frequencies, select Frequency list and enter a list of
arbitrary frequencies.

b) Click Update.

A frequency set entry is created in the list box to the left. You can add additional frequency
sets, or delete one from the list using the Add row and Delete row icons to the right of the
list.

c) Once the frequency set(s) have been defined, click Apply to proceed.

Figure 1630:

4. In the Normal Mode Extraction task, the default frequencies filled in are based on the max.
frequency you filled in for the previous step.

a) Modify the values based on the specific requirements of the case under study.

These values are merely the suggested values based on general use cases.

b) Click Apply to proceed.

Figure 1631:

5. In the Define Input Points & Requests, Define Loads task, define what type of load is applied.

The first four types are only applicable for structural nodes, and the last one for fluid nodes.
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a) For Load type, select Force, Enforced motion (displacement, velocity, or acceleration), or
Acoustic source.

b) Use the Nodes selector to select nodes, a node set, or tags in the modeling window, then
click Add.
The table on the left hand side is populated with additional degree of freedom (DOF)
checkboxes.

c) You can make a single or multiple row selection within the table, and then right-click to
access the DOF row selection options. Alternatively, make a single or multiple row selection
within the table, and then right-click to access the column selection options.
All selected DOFs will be checked to indicate locations and directions where unit input are to
be applied.

d) Click Apply to proceed.
One loadcase will be created for each DOF indicated.

Figure 1632:

6. In the Define Input Points & Requests, Create Subcases & Transfer Function task, select to output
transfer function between input points.

Of particular interest are driving point (response taken at the same point as input) transfer
functions, which are commonly used as a measure for local dynamic stiffness, or full matrix (all
possible pairs of input point combinations) output, which is sometimes used as input for FRF
based substructuring analysis.

It is also possible to create new subcase groups of input to be used in individual subcases.

New subcase groups can be added by clicking the Add Group icon . You can make a single

or multiple row selections within the table, and then select the newly created Subcase group
and click Update. All input dofs belonging to one subcase group will be used as simultaneous
excitations in one subcase.
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Figure 1633:

7. In the Select Response Points task, select response points for output.

a) Select a Response type, such as Displacement.

b) Use the Entity selector to select nodes, a node set, or tags to be included in a particular
response set.

You can add or delete multiple response sets from the list using the Add row and Delete
row icons to the right of the list.

Figure 1634:

c) Under Output data format, select the complex frequency response data format (real/
imaginary or magnitude/phase).

d) Under Output file format, select the output file format (h3d, punch, or op2).

e) Once all the required responses have been defined, click Apply to proceed.

Figure 1635:
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8. In the Misc Options task, select from the damping options that are available, including the global
modal viscous damping on the structure side, and global material and viscous damping on the
fluid side.

Figure 1636:

9. In the Constraint selection, SPC task, select the boundary condition of the frequency response
analysis.

a) You can select existing SPCs by checking the corresponding box under the Active column, or
click Create SPC to go to the Constraints panel and define a new SPC.

b) Once the boundary condition has been fully defined, click Apply to proceed.

Figure 1637:

10. In the Constraint selection, MPC task, select MPC equations to turn on for the frequency response
analysis.

a) Select existing MPCs by checking the corresponding box under the Active column.

b) Once the MPC equations have been selected, click Apply to proceed.

11. In the Parameter Selection task, select typical solution parameters, such as title, singular point
constraints, and so on.

a) Check all boxes under the Active column to activate the desired solution option.

b) Once the parameters have been selected, click Apply and an Process Manager message box
pops up informing you that the process has come to an end.

c) Click Yes to close the template, or No to review or edit the process steps.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2707

Figure 1638:

12. In the Generate TPL file task, generate and save the parameters defined in a standard template
file at your selected location.

• Choose Full deck TPL to access the file that has all of the parameters for the complete
unit load FRF process manager. In the Analysis Manager, the generated template file can be
selected as loadcase for the Solution type Full deck TPL and solver decks can be exported for
the unit FRF.

Figure 1639:

• Choose Loads Only TPL to access the file that contains only the parameters for the loadcase
portion of the unit load FRF process manager. In the Analysis Manager, the generated
template file can be selected as the loadcase for the Solution type Frequency Response and
solver decks can be exported for general FRF.
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Figure 1640:

Setup Random PDS Frequency Response Process
Perform random frequency response analysis.

This analysis includes two steps, the first step is to define unit input frequency response subcase, and
the second is to perform random response analysis by combining the unit input subcases with the auto
and cross PSD matrix.
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Figure 1641:

1. From the menu bar, click Tools > Freq Resp Process > Random PSD Frequency Response.

2. In the Select Solution Type task, select a solution method.

a) Select either the Direct Frequency Response solution method, or the Modal Frequency
Response solution method. For large problems involving more than a few frequencies, the
modal solution is typically the most efficient solution.

b) Click Apply to proceed.

3. In the Select Analysis Frequencies task, enter the frequencies for which response solution is
needed.

a) Define the frequency set.

• To define the min, max, and a linear step, select Frequency range. For Incr type, select
Linear and then fill in the required fields.

• To define min, max, and a number of increments with logarithmic spacing, select
Frequency range. For Incr type, select Logarithmic and then fill in the required fields.

• To define an arbitrary list of frequencies, select Frequency list and enter a list of
arbitrary frequencies.

b) Click Update.

A frequency set entry is created in the list box to the left. You can add additional frequency
sets, or delete one from the list using the Add row and Delete row icons to the right of the
list.

c) Once the frequency set(s) have been defined, click Apply to proceed.
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Figure 1642:

4. In the Normal Mode Extraction task, the default frequencies filled in are based on the max.
frequency you filled in for the previous step.

a) Modify the values based on the specific requirements of the case under study.

These values are merely the suggested values based on general use cases.

b) Click Apply to proceed.

Figure 1643:

5. In the Define Input Points, Define Unit Loads task, define what type of load is applied.

The first four types are only applicable for structural nodes, and the last one for fluid nodes.

a) For Load type, select Force, Enforced motion (displacement, velocity, or acceleration), or
Acoustic source.

b) Use the Nodes selector to select nodes, a node set, or tags in the graphics window, then click
Add.
The table on the left hand side is populated with additional degree of freedom (DOF)
checkboxes.

c) You can make a single or multiple row selection within the table, and then right-click to
access the DOF row selection options. Alternatively, make a single or multiple row selection
within the table, and then right-click to access the column selection options.
All selected DOFs will be checked to indicate locations and directions where unit input are to
be applied.

d) Click Apply to proceed.
One loadcase will be created for each DOF indicated.
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Figure 1644:

6. In the Define Input Points, Create Subcases task, select to output transfer function between input
points.

Of particular interest are driving point (response taken at the same point as input) transfer
functions, which are commonly used as a measure for local dynamic stiffness, or full matrix (all
possible pairs of input point combinations) output, which is sometimes used as input for FRF
based substructuring analysis.

It is also possible to create new subcase groups of input to be used in individual subcases.

New subcase groups can be added by clicking the Add Group icon . You can make a single

or multiple row selections within the table, and then select the newly created Subcase group
and click Update. All input dofs belonging to one subcase group will be used as simultaneous
excitations in one subcase.

Figure 1645:

7. In the Define Input Points, Define PDS Loads task, input the NxN 2 dimensional PSD matrix (here
N is the number of subcases whose response are used in the random PSD calculations.

a) The diagonal cells are used to define auto PSD terms, and the off diagonal cells are used to
define cross PSD terms. For cross PSD, only the bottom triangle of the matrix needs to be
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defined. To input a PSD term, click one of the cells, and then specify the real and imaginary
scaling factor and the frequency table.

b) Once the PSD matrix input is completed, click Apply to proceed.

Figure 1646:

8. In the Define Responses, Select Response Points task, select response points for output.

a) Select a Response type, such as Displacement.

b) Use the Entity selector to select nodes, a node set, or tags to be included in a particular
response set.

You can add or delete multiple response sets from the list using the Add row and Delete
row icons to the right of the list.

Figure 1647:

c) Under Output data format, select the complex frequency response data format (real/
imaginary or magnitude/phase).

d) Under Output file format, select the output file format (h3d, punch, or op2).

e) Once all the required responses have been defined, click Apply to proceed.
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Figure 1648:

9. In the Define Responses, Select Nodal PSD Response task, define the response points and DOFs to
be output.

Response points and DOFs can be output into the following formatted files: XYPUNCH, XYPLOT,
and XYPEAK.

a) Select a response type and then select nodes, set of nodes, or tags, and then click Add.
The list box is populated to allow you to further the selection to a set of DOFs.

Figure 1649:

b) For each DOF, select the output formats.

Figure 1650:

c) Once the PSD response selection is completed, click Apply to proceed.

10. In the Misc Options task, select from the damping options that are available, including the global
modal viscous damping on the structure side, and global material and viscous damping on the
fluid side.
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Figure 1651:

11. In the Constraint selection, SPC task, select the boundary condition of the frequency response
analysis.

a) You can select existing SPCs by checking the corresponding box under the Active column, or
click Create SPC to go to the Constraints panel and define a new SPC.

b) Once the boundary condition has been fully defined, click Apply to proceed.

Figure 1652:

12. In the Constraint selection, MPC task, select MPC equations to turn on for the frequency response
analysis.

a) Select existing MPCs by checking the corresponding box under the Active column.

b) Once the MPC equations have been selected, click Apply to proceed.

13. In the Parameter Selection task, select typical solution parameters, such as title, singular point
constraints, and so on.

a) Check all boxes under the Active column to activate the desired solution option.

b) Once the parameters have been selected, click Apply and an Process Manager message box
pops up informing you that the process has come to an end.

c) Click Yes to close the template, or No to review or edit the process steps.
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Figure 1653:

Setup General Frequency Response Process
Apply loads at multiple DOFs simultaneously with arbitrary magnitude and delay (relative phase).

In the Unit Input Frequency Response process and the Random PSD Frequency Response processes,
loads are limited to single DOF with unit inputs subcases.
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Figure 1654:

1. From the menu bar, click Tools > Freq Resp Process > General Frequency Response.

2. In the Select Solution Type task, select a solution method.

a) Select either the Direct Frequency Response solution method, or the Modal Frequency
Response solution method. For large problems involving more than a few frequencies, the
modal solution is typically the most efficient solution.

b) Click Apply to proceed.

3. In the Subcase Definition task, create a new subcase or edit an existing subcase.

a) Create or edit a subcase.

• To create a new subcase, edit the optional subcase label and click Add.

• To edit an existing subcase, highlight an existing subcase in the list box, edit the optional
subcase label and click Update.

b) Once input to the task is complete, click Apply to proceed.
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Figure 1655:

4. In the Select Analysis Frequencies task, enter the frequencies for which response solution is
needed.

a) Define the frequency set.

• To define the min, max, and a linear step, select Frequency range. For Incr type, select
Linear and then fill in the required fields.

• To define min, max, and a number of increments with logarithmic spacing, select
Frequency range. For Incr type, select Logarithmic and then fill in the required fields.

• To define an arbitrary list of frequencies, select Frequency list and enter a list of
arbitrary frequencies.

b) Click Update.

A frequency set entry is created in the list box to the left. You can add additional frequency
sets, or delete one from the list using the Add row and Delete row icons to the right of the
list.

c) Once the frequency set(s) have been defined, click Apply to proceed.

Figure 1656:

5. In the Normal Mode Extraction task, the default frequencies filled in are based on the max.
frequency you filled in for the previous step.

a) Modify the values based on the specific requirements of the case under study.

These values are merely the suggested values based on general use cases.

b) Click Apply to proceed.
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Figure 1657:

6. In the Define Input Points, Define Load Points task, define what type of load is applied.

The first four types are only applicable for structural nodes, and the last one for fluid nodes.

a) For Load type, select Force, Enforced motion (displacement, velocity, or acceleration), or
Acoustic source.

b) Use the Nodes selector to select nodes, a node set, or tags in the modeling window, then
click Add.
The table on the left hand side is populated with additional degree of freedom (DOF)
checkboxes.

c) You can make a single or multiple row selection within the table, and then right-click to
access the DOF row selection options. Alternatively, make a single or multiple row selection
within the table, and then right-click to access the column selection options.
All selected DOFs will be checked to indicate locations and directions where unit input are to
be applied.

d) Click Apply to proceed.
One loadcase will be created for each DOF indicated.

Figure 1658:
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7. In the Define Input Points, Define Load Strength task, define frequency dependent load strength
and delay for individual subcases or DOFs in one subcase.

• For subcase based definition, once the subcase is selected, select a DOF row from the list box,
and then add load strength frequency tables in either real/imaginary or magnitude/phase
form.

Delay or phase relative to a reference input DOF can optionally be specified as well. Loading
strength can be defined manually, with external files in csv/text format and also universal
(.unv) files from external data acquisition tools like LMS, IDEAS, and B&K. Import the .csv/
text or universal file, select the relevant loading strength and click Save to define it. You can
select one of the radio buttons on the right to control how the definitions provided are filled
into various rows. It is also possible to go back to the Subcase Definition panel by clicking the

Create Subcase icon  to add new subcases or edit existing subcases. If subcases are added

or edited, then you will be redirected to the Select Analysis Frequencies task to repeat all the
steps prior to defining load strengths. If subcases are not edited then you will come back to
the Define Load Strength task.

Figure 1659:

• For DOF based definition, once the DOF is selected, select a subcase row from the list and
follow the same process described in the above section. With this option it is not possible to
add or edit subcases.

Figure 1660:

8. In the Select Response Points task, select response points for output.

Response selection can be global or subcase specific.
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a) Select a Response type, such as Displacement.

Figure 1661:

b) Use the Entity selector to select nodes, a node set, or tags to be included in a particular
response set.

You can add or delete multiple response sets from the list using the Add row and Delete
row icons to the right of the list.

Figure 1662:

c) Under Output data format, select the complex frequency response data format (real/
imaginary or magnitude/phase).

d) Under Output file format, select the output file format (h3d, punch, or op2).

e) Once all the required responses have been defined, click Apply to proceed.

Responses selected for the global subcase are by default available for other individual subcases.
Additional responses can be added and used for an individual subcase. It is also possible to add
duplicate response types to any individual subcase, in addition to those in the global subcase. In
this case a separate response set will be created for that subcase which will be a union of entities
in global and individual subcases.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2721

Figure 1663:

9. In the Diagnostic Output Request, Select Diagnostic Output Options task, control if diagnostic
outputs are to be generated.

a) Select No to generate diagnostic output requests and the process will go directly to the
Miscellaneous Options task. Select Yes to request diagnostic output only at selected
response peaks.

b) Click Apply to proceed.

Figure 1664:

10. In the Select Diagnostic Output Request, Synthesis Diagnostics task, select the Synthesis
diagnostic type which presents a breakdown (participation factors) to the response, such as modal
participations.

This type will be output only at the peak frequencies of the corresponding response DOF. The
selection of the Synthesis diagnostic type can be Global or Subcase Specific.

a) First select the subcase, either Global or Individual Subcase.

b) Select response DOFs by clicking Response points.

In a case of individual subcases the list of responses will be a union of response entities for
Global and Individual Subcase. There is a specific option of Attachment points on control
volume in Auto TPA and Traditional TPA. In Auto TPA you can select a connection node
set. The elements attached to connection nodes are automatically segregated into Non-
Rigid Element set (CONEL) and Rigid Element set (CONREL) based on the element type. In
Traditional TPA, you can create a node set at which attachment forces are to be calculated in
the assembled state.
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Figure 1665:

Selecting Traditional TPA as the diagnostic type enables Create Force Analysis Job and Create
Transfer Function Analysis Job tasks in the process manager tree. Create Force Analysis Job
allows you to export a solver deck or submit the job related to the first step of traditional TPA
for calculating attachment forces in the fully assembled state through the Analysis Manager.

Figure 1666:

c) Click Apply to invoke the Create Transfer Function Analysis Job task.

This will delete all the created entities, and entities related to unit transfer functions are
created. This allows you to export the solver deck or submit a job related to the second step
of TPA for calculating transfer function in Control Volume through the Analysis Manager.

Figure 1667:
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11. In the Select Diagnostic Output Request, Operating Diagnostics task, select the Operating
diagnostic type which is not response specific, such as ODS animation or energy.

Output in this case will be generated at the super set of the peak frequencies of all selected
response DOFs. In this case the selection of operating diagnostic type can be global or subcase
specific.

Figure 1668:

12. In the Select Diagnostic Output Request, Output Frequency Selection task, control to select
frequency at which diagnostic output is to be requested.

• Select Automated Peak Frequency Filtering to customize options used to define response
peak frequencies through the PEAKOUT card.

• Select User Specified Frequency List to enter a list of frequencies for each subcase, which
will be referenced by a OFREQ card in a separate diagnostic output subcase.

13. In the Select Diagnostic Output Request, Automated Peak Frequency Filtering task, select the
customized options specific for structural and acoustic responses to be used for selected response
peak frequencies.

a) Select customized options.

Frequency selection for this option can also be global or subcase specific. The PEAKOUT
card specified for the Global subcase is also used for those subcases for which a separate
PEAKOUT card is not specified. For those subcases where specific peak frequency selection
control is needed, a separate PEAKOUT card should be specified with appropriate parameters.

Figure 1669:

b) Specify a single threshold value or a frequency table.

Only peaks above the threshold are retained in the search process as candidates.

c) Specify the number of peaks (default =5) per response DOF to be kept in the peak frequency
set.
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Figure 1670:

14. In the Select Diagnostic Output Request, User Specified Frequency List task, specify a list of
frequencies at which diagnostic output is requested.

This definition is subcase specific. For subcases where a Frequency List is entered in the Select
Analysis Frequencies task, the same frequency list values are automatically entered by default.

Figure 1671:

15. In the Misc Options task, select from the damping options that are available, including the global
modal viscous damping on the structure side, and global material and viscous damping on the
fluid side.

Figure 1672:

16. In the Constraint selection, SPC task, select the boundary condition of the frequency response
analysis.

a) You can select existing SPCs by checking the corresponding box under the Active column, or
click Create SPC to go to the Constraints panel and define a new SPC.

b) Once the boundary condition has been fully defined, click Apply to proceed.
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Figure 1673:

17. In the Constraint selection, MPC task, select MPC equations to turn on for the frequency response
analysis.

a) Select existing MPCs by checking the corresponding box under the Active column.

b) Once the MPC equations have been selected, click Apply to proceed.

18. In the Parameter Selection task, select typical solution parameters, such as title, singular point
constraints, and so on.

a) Check all boxes under the Active column to activate the desired solution option.

b) Once the parameters have been selected, click Apply and an Process Manager message box
pops up informing you that the process has come to an end.

c) Click Yes to close the template, or No to review or edit the process steps.

Figure 1674:

ID-Management
Manage all of the IDs for the entities that you create, and define ID ranges for all of the entities in each
Include file in relation to the full model in order to avoid ID duplication.

Perform ID-management in the ID Manager.

Note:  When importing and/or creating new IDs, as well as editing entities in the Master
Model or Include files, the ID Manager updates accordingly.
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Once the ID ranges are defined for each Include file and child entity type, they will remain active and
any new entities created will be assigned an ID within the ID range following the new ID rules. Entities
that are imported into the Include file that have ID ranges already defined, will have the IDs that
overflow after import automatically corrected by Move After Max option.

Aside from new entity creation and import, the ID Manager will not actively correct all of the IDs in the
FE model. If there are entity IDs that result in overflow because of organization issues in the Include file
such as renumbering, they will remain as overflow and must be corrected manually.

FE entities in CAE models are labeled and tagged using IDs and names. IDs are used by the solvers
during analysis and then passed on by the solver to the results. This process enables you to interpret
the results and relate them to the FE model. In most cases, the IDs of the FE entities in a FE model
must be unique for efficient identification. In large models that involve several parts assembled
into sub-assemblies and main assemblies, it is essential to have a tool that manages a model's IDs
consistently in the part level, sub-assembly level, and in the global level for ease of identification using
IDs.

In the Abaqus user profile, the following entity types are supported and impacted by the operations
performed during ID-management: Assembly, Component, Element, Node, Property, Material, Beam
Collector, Beam Section and Tags. Only these entity types will honor the Min and Max ID ranges defined
in the ID Manager. Corrections made to an Include file only impact these entity types. During the
creation of new entities that are not supported by the ID Manager, the Max ID + 1 is used to assign new
IDs.

Manage IDs
Learn how to perform varios ID-management operations.

Create/Delete Included Files

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Create or delete Include files.

Option Description

Create From the right-click context menu, select Create > Include File.

Delete 1. Right-click on an Include file and select Delete from the
context menu.

2. In the Delete Entity dialog, select Also delete children
entities to delete the selected Include file(s) along with its
child entities.
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Option Description

3. Click OK.

Create ID Ranges for New Entity Types
ID ranges can be defined for entity types that do not yet exist in the Master Model or in an Include file.

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Right-click on the Master Model or an Include file and select Create > ID-Range from the context
menu.

3. In the Create dialog, select an entity type and enter a Minimum ID and Maximum ID.

4. Click OK.

Edit ID Ranges
Edit the minimum and maximum ID range of the Master Model, Include files and entities.

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Double-click the Min and Max columns and enter new values.

Clear ID Ranges

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Clear ID ranges in the following ways:

Option Description

Clear all ID ranges Clear all defined ID ranges across all Include files in your model
by right-clicking on the Master Model and selecting Clear All ID
Ranges from the context menu.

Clear selected ID
ranges

Clear ID ranges for a single Include file or entity by right-clicking on
the Include file or entity and selecting Clear ID-Ranges from the
context menu.
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Note:  Clearing an Include file's ID range also clears ID ranges defined for child entities. If
you clear the ID range defined for a child entity, when it is different from the Include range,
then the range defined for the Include file will be updated for the child entity. Clearing ID
ranges will not remove exclusions.

Exclude Entities

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Exclude entities in the following ways:

• To exclude a specific entity, right-click on a Master Model, Include file, or entity and select
Exclude > Exclude Only from the context menu.

If you right-click on a Master Model or Include file you must select a type of entity to exclude
in the Exclude dialog.

Exclusion is automatically applied if you right-click on an entity. When an entity is excluded,

an X icon ( ) displays in the Excluded column.

• To exclude IDs of the same entity type across all Include files, right-click on an entity and
select Exclude > Exclude Similar from the context menu.

Tip:  Excluded entities can be hidden in the ID Manager by selecting the Hide Excluded
Entities checkbox.

Clear Exclusions

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Clear exclusions in the following ways:

• To clear excluded IDs for a specific entity, right-click on one or more entities and select Clear
Exclusion > Clear Exclusion Only from the context menu.

• To clear excluded IDs of the same entity type across all Include files, right-click on an entity
and select Clear Exclusion > Clear Exclusion Similar from the context menu.

Note:  Multiple entities across Include files can be selected.

Lock/Unlock IDs
Lock IDs to prevent them from being changed by future ID management and renumbering operations,
or unlock IDs so they can be changed.

• Lock IDs.
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a) From the menu bar, click Tools > ID Manager.
The ID Manager opens.

b) Lock IDs.

• To lock all IDs, right-click on a Master Model, Include file, or entity and select Lock > All
IDs from the context menu.

• To lock discrete IDs, right-click on an entity and select Lock > Discrete IDs from the
context menu, then select specific IDs to lock in the panel area.

• To lock IDs of the same entity type across all Include files, right-click on an entity and
select Lock > All Similars from the context menu.

• Unlock IDs.

a) From the menu bar, click Tools > ID Manager.
The ID Manager opens.

b) Unlock IDs.

• To unlock all IDs, right-click on a Master Model, Include file, or entity and select Unlock >
All IDs from the context menu.

• To unlock discrete IDs, right-click on an entity and select Unlock > Discrete IDs from
the context menu, then select specific IDs to unlock in the panel area.

• To unlock IDs of the same entity type across all Include files, right-click on an entity and
select Unlock > All Similars from the context menu.

Reserve/Unreserve IDs
Reserve and unreserve available IDs for future use.

When reserving discrete IDs, if the ID or set of IDs being reserved does not fall within the defined ID
range, then those IDs will still be reserved but will be listed under the Master Model.

If you reserve IDs for an entity that supports ID pools, the reserved IDs will be applied to each ID
pool. For example, the count for elements reserves in LS-DYNA includes reserves for each element pool
available for the given ID range.

After IDs are reserved, they cannot be changed from renumbering operations. When an ID range is
cleared, reserved IDs will be moved to the Master Model. If the ID range is re-entered, reserved IDs
will be moved back to the entity it was originally reserved for. If you create an exclusion or delete an ID
range at the entity level, the reserve range defined and the reserves defined within that range will be
removed.

• Reserve IDs.

a) From the menu bar, click Tools > ID Manager.
The ID Manager opens.

b) Reserve IDs.

• To reserve all IDs, right-click on a Master Model, Include file, or entity and select
Reserve > All IDs from the context menu.
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All IDs within the defined ID range are automatically reserved if you right-click on an
entity. If you right-click on the Master Model or an Include file you must select a type of
entity to reserve all IDs for in the  Reserve All dialog.

The Reserve All option can only be used when there is an ID range defined at the entity
level. When you reserve all IDs, the Min Reserved and Max Reserved columns are
populated using the Min and Max ID range defined at the entity level. The Min and Max
Reserved columns can be manually edited as long as your modifications fall within the Min
and Max ID range. IDs within the reserve range that already exist in the model will be
populated in the Conflicts column.

• To reserve discrete IDs, right-click on a Master Model, Include file, or entity and select
Reserve > Discrete IDs from the context menu.

In the Reserve dialog, select an entity type and correction option, and enter IDs to be
reserved.

• Unreserve IDs.

a) From the menu bar, click Tools > ID Manager.
The ID Manager opens.

b) Unreserve IDs.

• To unreserve all IDs, right-click on a Master Model, Include file, or entity and select Un-
Reserve > All IDs from the context menu.

• To unreserve discrete IDs, right-click on a Master Model, Include file, or entity and select
Un-Reserve > Discrete IDs from the context menu. In the Un-Reserve dialog, select
an entity type and enter IDs to be unreserved.

Compact Entities
IDs that are already occupied in an Include File can be compacted.

Overflowed IDs are then placed into the ID range, starting from the Min ID occupied without any gaps.
Locked IDs in an Include file will not be renumbered.

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Right-click on a Master Model, Include File, or entity and select Compact Entities from the
context menu.

Note:  This option is only available if you have selected single/multiple Include files,
single/multiple child entities, or an Include file plus a child entity that has the ID range
defined.

Review ID Overflow

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.
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2. Right-click on the Master Model or an Include file and select ID Overflow List from the context
menu.

3. In the ID Overflow List dialog, review all of the overflow IDs in the Master Model or Include file.

The Name column lists all of the entities in the Master Model/Include file that contains overflow
IDs, along with the number of overflow IDs in each entity within parentheses. The Correction
Option column displays the correction option currently assigned to each entity.

4. Review overflow IDs in the graphics area.

• Left-click on each entity in the Name column to highlight it in the graphics area.

• Right-click on each entity to access additional display options from the context menu, such as
Show, Hide, or Isolate.

5. Correct ID overflow.

• To correct the ID overflow for a specific entity, right-click on the entity and select Correct
from the context menu.

• To correct all of the ID overflow listed, click Correct All.

Correct ID Overflow

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Right-click on an Include file or entity and select Correct > Overflow from the context menu.

Overflow IDs are corrected using the correction option assigned in the Correction Option column. If you
do not right-click on an Include file or entity folder, then this operation will be performed on all of the
overflow IDs inside of the model.

A message will appear before this action is performed, warning you that all of the overflow entities in
the model will be corrected once you click OK.

If the ID Manager cannot correct all of the IDs, a warning message will be displayed and none of the
overflow IDs within an Include file/entity folder will be corrected.

Correct Reserve Conflicts

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Right-click on the entity folder that contains conflicts and select Correct > Reserve Conflicts
from the context menu.

Note:  Nodes and element entities are isolated in the graphics area.

3. In the panel area, use the selector or other extended entity selection options to select IDs to
correct.

4. Click proceed.

5. In the Correct Reserve Conflicts dialog, select a correction method to resolve conflicts with.
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• Choose Move Out to move the selected IDs out of reserve range and renumbers them using
the max +1 rule, which is the maximum ID available plus 1. If the ID range is full, corrected
IDs will be marked as overflow. The conflict icon will only be removed if you resolve all of the
conflicts.

• Choose Lock to lock IDs in the reserve range and populates the Lock column. The conflict
icon will display, and all of the IDs listed in the reserve range are locked.

6. Click OK.

Import/Export a CSV File of ID Management Rules
Import/export a .csv file of ID management rules

ID management rules can be exported for only the entities that are currently displayed in the ID
Manager, or for all of the entities in the ID Manager including those excluded by ID management filters.

ID management data related to overflow, min/max occupied IDs, number of conflicts, number of
reserves, and number of locks will be calculated while reading the .csv file.

When you are importing a .csv file, you will be notified if overlapped ID ranges are identified.

1. From the menu bar, click Tools > ID Manager.
The ID Manager opens.

2. Right-click and select Import CSV file or Export CSV file from the context menu.

ID Manager Dialog
Overview of the ID Manager user interface.

Access the ID Manager by clicking Tools > ID Manager from the menu bar when the Abaqus, LS-
DYNA, Nastran, OptiStruct, PAM-CRASH 2G and Radioss user profiles are loaded.
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Figure 1675:

Table 264: ID Manager Options

Option Description

Filter by Include Files When enabled, Include files selected in the Select Includes dialog are filtered
from the ID Manager.

Click  to open the Select Includes dialog.

Data related to filtered Include files is saved to an .hm file.

Hide Excluded Entities When enabled, entities marked as "Excluded" are hidden in the ID Manager.

Data related to "Excluded" entities is saved to an .hm file.

Allow Duplicate IDs on
Correction

When enabled, duplicate ID pool's for supported entities are permitted to
have the same IDs.

Entities Displays the Master Model and its child entities, as well as each Include file
and its child entities.

ID Displays the ID of each Include file.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2734

Option Description

Excluded Displays an X icon ( ) when an entity is excluded from ID management

operations.

Min Enter a minimum integer value for the ID range that does not overlap with
any other range definitions in the model.

The Min should always be:

• greater than the Max of the previous range defined in the model.

• less than the Min of the next range defined in the model.

• less than the Max of the current range.

Max Enter a maximum integer value for the ID range that does not overlap with
any other range definitions in the model.

The Max should always be:

• greater than the Max of the previous range defined in the model.

• less than the Min of the next range defined in the model.

• greater than the Min of the current Include file.

#Overflow Displays the number of IDs in an Include file or entity folder that are outside
of the defined range.

Min Reserved Minimum integer value for the reserve ID range. You can manually edit the
Min Reserved column as long as your modifications do not violate the Min
and Max ID range.

When you reserve all IDs, the Min Reserved and Max Reserved columns are
populated using the Min and Max ID range defined at the entity level.

Max Reserved Maximum integer value for the reserve ID range. You can manually edit the
Max Reserved column as long as your modifications do not violate the Min
and Max ID range.

When you reserve all IDs, the Min Reserved and Max Reserved columns are
populated using the Min and Max ID range defined at the entity level.

Conflict
Displays a conflict icon ( ) when there are IDs in the reserve range that

already exist in the model.

#Conflicts Displays the number of conflicts in a reserve range.

User Status Indicates the status of reserve conflicts.
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Option Description

Pending
Pending displays as soon as conflicts occur. When conflicts are
resolved with the use of the Move Out correction method, the user
status automatically resets to a blank status.

WIP (Work in Progress)
When the conflict icon is displayed and conflicts have not been
addressed or are not completely resolved, change the status from
Pending to WIP.

Completed
When conflicts are resolved with the use of the Lock correction
method, change the status to Completed. The conflict icon will still be
displayed, but changing the status to Completed indicates conflicts
have been resolved.

#Reserved Displays the number of IDs reserved at the entity level.

When IDs are reserved, this column is populated for the corresponding
entity. All IDs within a defined ID range for an entity can be reserved,
or discrete IDs within a defined ID range can be reserved. For IDs being
reserved that do not fall into the defined ID range, these entities will be
moved into the #Reserved column of the Master Model.

If an entity type supports ID pools, the #Reserved column will display the
total number of reserves applied to each ID pool in that entity type.

Min Occupied Displays the minimum ID occupied by all of the entities in an Include file.
For individual entities, it displays the corresponding minimum ID occupied in
the Include file.

Max Occupied Displays the maximum ID occupied by all of the entities in an Include file.
For individual entities, it displays the corresponding maximum ID occupied in
the Include file.

#Entities Displays the total number of entities in Include files and entity folders.

#Locks Displays the number of IDs that have been locked from renumbering.

New ID Determines where new IDs will be placed within the current Include file
range.

After Max
Uses any free IDs available starting after the maximum ID occupied
within the defined range.

Before Min
Uses any free IDs available starting before the minimum ID occupied
within the defined range.
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Option Description

Fill in Gaps
Uses any free IDs available, starting after the minimum ID within the
defined range.

If the ID Manager cannot find any free IDs using the After Max and Before
Min options, then newly created entities will be assigned IDs using the Fill
in Gaps option.

If the ID Manager cannot find any free IDs within the defined ID range using
any of the above options, then newly created entities will be assigned IDs
beyond the Max ID occupied or the Max ID defined in the model, whichever
one is being the highest.

Correction Determines how duplicate IDs are renumbered to correct overflow.

None
Does not correct overflow IDs.

Compact And Fit
Compacts the IDs that are already occupied in an Include file, and
moves the overflow IDs into the range starting from the Min ID in the
defined ID range.

Move After Max
Moves the overflow IDs after the Max ID occupied in the defined ID
range.

Move Before Min
Moves the overflow IDs before the Min ID occupied in the defined ID
range.

Insert In Gaps
Moves the overflow IDs into gaps within the defined ID range.

Note:  IDs that are locked or reserved in an Include file will not
be renumbered.

ID Manager Examples
Examples to provide you with a more in-depth understanding of the ID-management functionality.

New ID
The example below explains how new components are assigned an ID after you have defined an ID
range and established rules for ID management.

An Include file contains components with the following IDs: 4, 5, 10 through 50, and 80 through
97. From the ID Manager, an ID range of 1 through 100 is defined for the Include file. When new
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components are added to the Include file, they will be assigned an ID based on the New ID option
selected.

After Max
New components will be assigned IDs from 98, 99, and 100. Once the Max ID of 100 reached, any
new component created will use the Fill in Gap option and be assigned IDs starting from 1.

Before Min
New components will be assigned IDs from 3, 2, and 1. Once the Min ID of 1 reached, any new
component created will use the Fill in Gap option and be assigned IDs starting from 1.

Fill in Gaps
New components will be assigned available IDs starting from the Min ID of 1, 2, 3, 6, and so on.

ID Correction
The example below explains how the different correction options correct overflow IDs.

An Include file contains components with the following IDs: 4, 5, 20 through 60, 80 through 90, 101,
105, 110, and 117. From the ID Manager, an ID range of 10 through 100 is defined for the Include file,
resulting in six overflow components. To correct the overflow IDs, a correction option is selected. The
behavior of each correction option is as follows:

None
No correction is performed and the overflow IDs remain the same.

Compact and Fit
Compacts the IDs that are already occupied in the Include, and places the overflow IDs into
the range starting from the Min ID of the defined range. The overflow IDs will be assigned the
following new IDs:

IDs Before Correction IDs After Correction

4 10

5 11

20 -60 12 - 52

80 - 90 53 - 63

101 64

105 65

110 66

117 67

Move After Max
Places the IDs that overflow after the Max ID occupied in the defined range. The overflow IDs will
be assigned the following new IDs:
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IDs Before Correction IDs After Correction

4 91

5 92

20 - 60 20 - 60

80 - 90 80 - 90

101 93

105 94

110 95

117 96

Move Before Min
Places the IDs that overflow before the Min ID occupied in the defined range. The overflow IDs
will be assigned the following new IDs:

IDs Before Correction IDs After Correction

4 19

5 18

20 - 60 20 - 60

80 - 90 80 - 90

101 17

105 16

110 15

117 14

Insert in Gaps
Places the IDs that overflow into the gaps in the defined range. The overflow IDs will be assigned
the following new IDs:

IDs Before Correction IDs After Correction

4 10
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IDs Before Correction IDs After Correction

5 11

20 -60 20 - 60

80 - 90 80 - 90

101 12

105 13

110 14

117 15

Reserve ID
The following examples explain how to reserve IDs using the ID Manager.

An Include file contains components with the following IDs: 4, 5, 20 - 60, 80 - 90, 101, 105, 110, and
117. From the ID Manager, an ID range of 10 through 100 is defined for the Include file, resulting in six
overflow components. To correct the overflow IDs, a correction option is selected.

By reserving all of the IDs within the range 1-100, the Number of ID reserves will be populated to 46,
which is number of available IDs for the ID range 1-100 (available IDs include: 1-3, 6-19, 61-79 and
91-100).

If a reserve is applied to an entity that supports ID pools, the reserves will be applied to each ID pool of
that entity. For example, consider a LS-DYNA model that has 10 ID pools for properties. If an ID range
of 1-100 as defined, as in the above example with the same individual IDs for properties as opposed to
components, the total count of reserves will be 460 (46 per pool and a total 10 pools).

Manage Penetrations/Intersections
Check components or groups for element penetrations and intersections using the Penetration Check
tool.

Penetration and intersection can be used individually or collectively. Penetration is defined as the
overlap of the material thickness of shell elements, while intersection is defined as elements passing
completely through one another.

1. From the menu bar, click Tools > Penetration Check.

Restriction:  Only available in the Radioss and LS-DYNA user profiles.

The Penetrations browser opens.

2. Setup the Penetration Check and check for intersections/penetrations.

a) In the Penetrations browser, click  to invoke the collision setup widget.
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b) In the Check type field, select the type of collision to check.

c) In the Entity type field, select the type of entity to be checked for intersections and/or
penetrations.

d) In the Selection field, select contacts (groups) or components to check.

Selecting one of more contacts will perform the penetration check according to the rules
enforced by the solver. In any case, the penetrating elements will be found, and the
results will display in the Penetration Browser. Results will be listed by pairs of components
regardless of the entity type that was used to select penetration candidates.

e) Select a Thickness option.

Restriction:  Only available for Component checks.

• Choose Component thickness to apply no adjustments as it uses the thickness value
specified in a component’s property card for each element within that component.

• Choose Thickness multiplier to multiply the selected entities' thickness by the value
entered in the Thickness multiplier field for purposes of the penetration check. Fractional
values are acceptable, but negative values are not.

• Choose Uniform thickness to ignore the existing component's thickness, and instead
uses the value entered in the Uniform Thickness field for all of the components in the
model.

Note:  Use Uniform thickness as a workaround to the lack of thickness
information in the default HyperMesh user profile, or when working with
models that do not have a thickness specified.

f) Select a Thickness > size option.

Restriction:  Only available for Component checks.

• Full thickness, but ignore neighborhood (slow, but accurate if thickness > element size)

• Reduce thickness to 40% of elem size (fast)

• Full thickness, consider neighborhood (special usage only)

g) To consider edge penetrations, select the Consider edge penetrations checkbox.

h) Select a treatment algorithm for the boundary shell edge.

• Choose Flat edges to consider external borders of the components flat.
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Figure 1676: Flat Edges

• Choose Rounded edges to extend external borders of the component by a cylinder
having the diameter of the component thickness.

Figure 1677: Rounded Edges

i) Click Check.
Once the check is complete, the browser populates with detected intersections and/or
penetrations.
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Figure 1678:

3. Review the penetrations/intersections using the view controls in the browser.

Figure 1679:

4. Fix the penetrations/intersections.

To fix Do this

Manually 1. Select groups/components to fix in the browser.

2. Click  on the collision toolbar. Additional tools display.

Figure 1680:

3. Select the elements or nodes to move.

4. Move and/or translate the selected elements/nodes.

5. Click  to recheck that the intersection/penetration no

longer remains.
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To fix Do this

Automatically 1. Select groups/components to fix in the browser.

2. Click  on the collision toolbar.
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Tip:

• If a component is intersecting with another, right-click on the component and
select Find Matching Penetrating Component Pair from the context menu
to find the same pair of components in the penetrations list. If the pair does not
penetrate, a message will display.

• To keep a specific component from changing when performing de-penetration
fixes, right-click on that component and select Lock Component from the context
menu. A red padlock displays on the component name in the browser to indicate
that it has been locked. The nodes in a locked component cannot be moved by
the Collision tool. To unlock, right-click a locked component and select Unlock
Component from the context menu.

Figure 1681:

• Sort the columns in the browser by clicking the column headings. For example,
clicking the Violations heading sorts the parent components according to their
number of violations. A small triangular arrow in the column heading indicates
whether the components are sorted in ascending or descending order; repeated
clicks toggle between these two options.

Penetration Check Browser
Overview of the Penetration Check Browser user interface.

Collision Toolbar

Option Description

Invokes the collision setup widget, which can be used to setup the Penetration Check
and check for intersections/penetrations.

Reruns the collision check. This is recommended when you modify any attributes that
control the collision check, or when a mesh modification has occurred.

Automatically attempts to fix the intersections/penetrations you have selected in the
browser, based on the settings found in the Options dialog.
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Option Description

You can perform a fix on all of the intersections/penetrations listed in the browser,
but it is highly recommended that all intersections are resolved before any automatic
penetration fix is executed.

Enables you to manually fix intersections/penetrations. When selected, additional tools
display in the browser that can be used to perform manual, rather than automatic,
penetration fixes.

Exports the result of the collision run to a .txt or .csv file.

Nodes and nodes + element pairs are supported.

When multiple collisions are displayed in graphics area, click this button to identity the
collision pairs in the collision browser after making a seletion in the graphics area.

Displays a node List for selected penetration that reports penetration depth (thickness
minus residual distance), thickness, relative penetration, (penetration divided by
thickness) and residual distance for all penetrating nodes.

View Controls

Button Action

Highlights all elements that caused penetrations or intersections when you select a
component in the browser.

Makes all elements transparent (wireframe) except for the interacting elements of the
component that you selected in the browser, which display in a solid color.

Displays a color gradient of the penetrating elements in the selected component, which
indicates the severity (degree) of penetration for the interacting elements.

This mode is not available for intersections because their depth cannot be determined.

Displays a color gradient of relative penetrating elements.

Displays individual vectors for each penetrating element in the component that you
select in the browser. These vectors indicate the direction and depth of penetration for
both the selected component and its interacting components.

This mode is not available for intersections because their depth cannot be determined.

Fits the failed elements to the display.

In large models, this can be very helpful in finding and viewing small areas of minor
penetration. Note that while this option is active, the view automatically fits to the
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Button Action

penetrating elements of any component that you click in the browser. Click the option
again to deactivate the fit mode.

Displays all elements, by unmasking all elements in the model, but not other masked
entities such as model geometry.

Masks everything in the model except for components with penetrations or
intersections. Note that this option only applies to components for which you have run
the current penetration check; other components may be interacting, but if you have
not run a check on them they do not appear as interacting, and they will be masked.

Masks everything in the model, including the interacting components, except for the
specific elements that penetrate or intersect.

Manual Fix Tools

Button Action

Select Elements By Tree. When enabled, clicking the lowest-level component in the
browser selects all of its failed elements.

Select Elements Manually. When enabled, you can click each desired element belonging
to the lowest-level component in the browser. This includes the ability to select non-
failed elements or a sub-set of the failed elements.

Select Nodes By Tree. When enabled, clicking the lowest-level component in the
browser selects all of the penetrating nodes in its failed elements. This differs from
Select Elements By Tree in that individual nodes can be moved to fix a penetration, thus
changing the shape of a failed element, instead of moving entire elements.

Select Nodes Manually. When enabled, you can click each desired node belonging to
the lowest-level component in the browser. This includes the ability to select individual
nodes of non-failed elements, or a sub-set of nodes belonging to the failed elements.

Determines the direction that you wish to manually move the selected nodes or
elements. Click the small triangle, in the bottom corner, to select one of the following:

Move along the average normal of the selected elements, or related elements in
the case of selected nodes.

Move along a fixed vector.
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Button Action

Move along the X axis.

Move along the Y axis.

Move along the Z axis.

Move along an already-existing vector entity in your model that you select.

Move along nodes in your model that you select to define the direction vector.
If you pick two nodes, they define the direction. If you pick three nodes, the
direction is the normal of the plane that these three nodes define (picking more
than three nodes uses only the last three picked.)

Moves the selected nodes/elements by the negative amount specified in the numeric
text box.
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Button Action

Moves the selected nodes/elements by the positive amount specified in the numeric
text box.

Review Orientation
Display/review and modify frequently used coordinate systems used in CAE analysis.

Figure 1682:

Review Elemental Systems
Select 1D, 2D, or 3D elements and display the coordinate system.

Elemental systems are dependent on the solver type. For example, for Nastran and for quad elements
the X axis is determined using the bisector of the diagonal line.

1. From the menu bar, click Tools > Orientation Review.
The Orientation Review dialog opens.

2. Click the Elemental system tab.

3. Use the Elements selector to select elements.
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4. Define display options.

5. Click Apply to show the system display.

The mode element can be added and the display can be super imposed. Clicking Clear removes the
information that you added, and clicking Clear All removes the system.

Review Material Systems

1. From the menu bar, click Tools > Orientation Review.
The Orientation Review dialog opens.

2. Click the Material system tab.

3. Use the Elements selector to select elements.

4. Define display options.

5. Click Apply to show the system display.

By default the material system aligns with the C1 direction of the element edge. C1 is the direction from
node 1 to node 2 of the element. You can super impose the elemental system on the same plot of the
material system.

Figure 1683:
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The blue and green arrows represent the elemental system (x and y) and the red and brown arrows represent the material

system (x and y).

Review Ply Directions
During CAD import of the composite data, each ply is associated with one or a separate system (one
system for several plies or a system for each ply). You can select a ply and review its system.

This is important to align the element normal to match the ply normal, or correct the ply angles if the
normals are in the opposite direction.

1. From the menu bar, click Tools > Orientation Review.
The Orientation Review dialog opens.

2. Click the Ply Directions tab.

3. Use the ply selector to select plies.

4. Define ply options.

• To show fiber direction without the correction for drape, select the Fiber orientation
checkbox.

• To show fiber direction with drape correction, select the Drape fiber orientation checkbox.

• To show a ply system for each ply, select the System checkbox.

5. Define display options.

6. Click Apply to show the ply system.

Figure 1684:
The green arrows show the material X direction. The blue arrow shows the ply 5 fiber direction without drape. The red arrows

shows ply 5 fiber direction with drape.

Review Orientation
Display and correct element orientation.

Element orientation is determined by the order of the nodes in the element connectivity. This is
sometimes referred to as C1, C2, C3, or element local system.

1. From the menu bar, click Tools > Orientation Review.
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The Orientation Review dialog opens.

2. Click the Orientation tab.

3. Use the elements selector to select elements.

4. Select a function.

• Choose By element to select an element with the correct orientation.

• Choose By edge_node to select edge nodes with the correct direction.

• Choose By System to select a system with the correct 1, 2, 3 direction.

• Choose Vector to select a vector direction.

• Choose Align N1-N2 dir to select a selection method.

5. Define display options.

6. Click Apply to show the element orientation.

The orientation of the rest of the elements will be determined based on the orientation or direction of
the selected entity.

Figure 1685: Display Normal and Reverse Normal 2D Elements

Figure 1686: Reverse Normals
The element already selected during the display normal will be reversed.
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Figure 1687: C1, C2, C3 Direction
This displays the element orientation of the nodes. C1 is the direction from node 1 to node 2 using the element connectivity order.

Figure 1688: Resequence Nodes
Align C1 direction of 2D quad elements. Using the display C1 direction, some of the elements may not be aligned, as shown in the

previous image. Select a guide element as the reference element and the rest of the element node connectivity will be changed to

align the C1 direction.

Figure 1689: Reverse 1D Element Direction
T function reverses the X direction (node 1 to node 2) of a 1D element. This image shows before reversing the elements.
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Figure 1690: After Reversing Elements

Review Ply Normals
Indicate which ply angles need to be reversed for which elements when they do not match the ply
normal.

CAD based ply angles and orientation are transformed with respect to the element material system for
analysis solvers. Most of the time you can correct the element normal to match the ply normal from the
CAD. There are times when it is not possible to change the element normal to match the ply normal,
as shown in the diagram below. In these cases, you need to change the ply angles with respect to the
element normal without changing the element normal. For example, a +45 degree ply will become a
-45 degree ply if the element normal and ply normal are in opposite directions.

Figure 1691:
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Figure 1692:
The ply normal does not match the element normal.

1. From the menu bar, click Tools > Orientation Review.
The Orientation Review dialog opens.

2. Click the Ply Normals tab.

3. Use the ply selector to select the single ply for which the element normal needs to be reversed.

4. Use the Elements selector to select the elements that need to be reversed.

5. Under Noramls, specify how to display normal.

• Choose Display to display normals.

• Choose Reverse to reverse the display of the normal if they do not match.

6. Define display options.

7. Click Apply to show the ply normals.

8. Repeat these steps for each ply.

The element normal for the ply is now reversed.

Note:  The actual element normal is not changed. The software takes a note (sets
a flag internally) for a particular ply, and the angle needs to be reversed for that
element, instead of reversing the normal. This is reflected in the solver data.
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Figure 1693:

Manage Transformations
Manage transformations and/or positions.

Manage Transformations with the Transformation Manager
Manage the definition of transformation applied on the nodes and elements in order to easily position
the entity using a combination of scale, rotate, and translate and symmetry functions.

These operations are usually applied on standard parts such as dummies, barriers, and so on for
positioning in different crash setups. Also they can be used for repositioning components with strain
history between multiple steps of simulation.

Access the Transformation Manager by selecting Tools > Transformation Manager from the menu
bar.

Restriction:  The Transformation Manager is available LS-DYNA and PAM-CRASH 2G solver
profiles.

The Transformation Manager has two basic folders/sections.

Transformation Definition
Lists the transformations defined in the model in a tree structure detailing the cross referencing
between the entity and the transformation.

Transformation Repository
Holds the candidates on which the transformations can be applied which is solver dependent. In
the PAM-CRASH 2G solver profile, the repository contains all the node sets defined in the model.
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In the LS-DYNA solver profile, the repository contains node sets and include files organized in two
different folders.

Toolbars
The Transformation Manager includes toolbars and a context menu. Toolbars provide the ability to
switch between the two views, show or hide entities on which transformation is applied within the
model, and activate or deactivate the transformation applied on an entity. The context menu provide
basic functions such as the creation, addition of entities, activation/inactivation of transformation,
deletion, card edit, manipulating the sequence of transformation, display control, and review.

Icon Function

Activate the selected transformation. If none are selected, activate all the
transformations defined.

Inactive the selected transformation. If none are selected, inactivate all the
transformations defined.

Active or inactive state depending in its current state for the selected transformation. If
none is selected, it is applied on all the transformations defined.

Switches to transformation – entity view

Switches to entity – transformation view

Context Menu
A context menu is available for any selected item in the Transformation Manager tree. To view the
context menu right-click on an entity folder, an individual entity, or in an empty space in the browser.
Clicking in the empty space provides options applicable to all the entities in the transformation
definition. The functions vary depending on whether it is performed on an entity in the transformation
repository or in a transformation definition. There are also subtle differences in functions performed
depending on the view.

Transformation Definition

Table 265: Entity- Transformation View

Item Definition

Create New Creates new entity on which transformation will be applied. Includes node sets for the
PAM-CRASH 2G solver profile. Includes node sets and include files for the LS-DYNA user
profile.

Add entity Allows you to edit the entity on which transformation is defined. Available only on
entity.
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Item Definition

Card edit Opens the corresponding solver Card Image panel. Available on both entity and
transformation.

Delete Deletes the selected entity. Available on both entity and transformation.

Transform Creates a new transformation and applies it on the selected entity. If transformation
already exists for the entity, it appends to it. Available on the entity.

Rename Renames the selected entity/ transformation. Available on both entity and
transformation.

Show, Hide,
Isolate, Show
all, Review,
Reset
review:

Similar to Model Browser functions. Available for both transformation and entity.

Move UP Swaps the ID of the selected transformation with the next smaller ID that is attached to
the same entity.

Move up Swaps the ID of the selected transformation with the next higher ID that is attached to
the same entity.

Collapse All Closes all of the folders in the tree structure, so that only the top-most level of items
displays.

Expand All Opens all of the folders in the entire tree structure, exposing every item nested at
every level.

Table 266: Transformation - Entity View

Item Definition

Create new Creates new transformation.

Add entity Allows to add a new entity on to the selected transformation. If the entity is selected,
you can edit the content. Available on both entity and transformation.

Card edit Opens the corresponding solver Card Image panel. Available on both entity and
transformation.

Delete Deletes the selected entity. Available on both entity and transformation.

Transform Appends the defined transformation on the selected transformation. Available only on
the transformation.
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Item Definition

Rename Renames the selected entity. Available on both entity and transformation.

Show, Hide,
Isolate, Show
all, Review,
Reset review

Similar to Model Browser functions. Available for both transformation and entity.

Move Up Swaps the ID of the selected transformation with the next smaller ID that is attached to
the same entity.

Move Down Swaps the ID of the selected transformation with the next higher ID that is attached to
the same entity.

Collapse All Closes all of the folders in the tree structure, so that only the top-most level of items
displays.

Expand All Opens all of the folders in the entire tree structure, exposing every item nested at
every level.

Transformation Repository

Item Definition

Transform Creates new transformation on the selected entity. The transformation and the entity
show up in the transformation definition folder.

Card Edit Opens the corresponding solver Card Image panel.

Rename Renames the selected entity.

Show, Hide,
Isolate,
Review,
Reset
review:

Similar to Model Browser functions.

Supported Solver Keywords
LS-DYNA

NODE_TRANSFORM

INCLUDE_TRANSFORM
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PAM-CRASH 2G
TRSFM _/_

Manage Positions/Transformations
Apply a transformation sequence on a set of nodes to change their position in the model.

Related reference
Positions
Transformations

Abaqus
Transformations are applied in the sequence in which they are listed in the Select Transformations
dialog. The list of transformations can have unique transformations, or a given transformation can be
repeated as many times as required. If there are changes made to the applied list of transformations,
for example if a Transformation was deleted, the Position entity will be automatically updated to
incorporate these changes. If you clear the Applied checkbox, the transformations will be undone in
the reverse order in which they were applied.

1. Open the Entity Editor for the Position entity you are adding a list of transformations to.

Figure 1694: Position Contains a Node Set for the Right, Rear Tire

2. In the Entity Editor, right-click on Transformations and select Select Ordered List from the
context menu.

3. In the Select Transformations dialog, click  to add transformations.

4. In the panel area, click transformations.

5. Select a transformation.

6. Click proceed.

7. If necessary, add additional transformations.

To remove transformations, select a transformation and click .
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To change the sequence of transformations, click .

8. Click OK.

Figure 1695:

9. In the Entity Editor, select the Applied checkbox to apply the list of transformations for the Node
Set in the Position entity.

Figure 1696: Transformations Applied
The right, rear tire moved to the left, rear side of the truck as a result of the applied transformations.

Radioss
Apply a transformation sequence on a set of nodes to change their position in the model.

In the Radioss solver profile, there is no solver keywords mapped to the position entity. Use the
position entity to manage the transformations applied on a set of nodes or a Submodel. Position and
transformations are managed in the Position/Transformation tool.

1. In the Model browser, right-click and select Position/Transformation from the context menu.
The Create or Edit Position/Transformation dialog opens.

2. Create a position.

a) Click .

A new position is created, and a list of entity attributes are displayed in bottom pane.

b) Edit the position's attributes accordingly.
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Figure 1697:

3. Apply a transformation to the position.

a) Select the position entity.

b) Apply a new or existing transformation to the position.

• Create a new transformation by clicking . Edit the transformation's attributes

accordingly in the bottom pane.

• Add an existing transformation by clicking  and selecting a transformation from the

Select Transformation dialog. Click OK when finished.
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Figure 1698:

4. Select the Applied checkbox for the position entity to apply the list of transformations.

You can select the Applied checkbox from the Applied column in the first pane, or by modifying the
position's attributes in the second pane.

Figure 1699:
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Tip:

• Search for positions/transformations using the search field.

• Change the sequence of transformations by clicking .

• Remove transformations by selecting a transformation and clicking .

Transform Elements
Translate, scale, reflect or rotate elements with multiple numbers of copies, including properties and
loads, attached to them.

Loads will also be copied to the new transformed elements with the possibility to reverse them. ID's can
also be assigned with offset for the newly created elements. Multiple instances (number of copies) can
also be created.

1. From the menu bar, click Tools > Transformation Tool.
The Transformation Tool dialog opens.

2. In the Action field, select an action to perform on elements.

3. In the Entities field, select source elements, nodes, components, or systems.

4. To create multiple instances, select the Duplicate checkbox.

5. In the Destination Component field, select where to organize elements after the transformation.

6. Define additional options accordingly.

7. Click Apply.

Figure 1700: Element to be Transformed with Loads
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Figure 1701: Reflected Wing with Loads in a New Load Collector

Create Pretension Bolt
Create pretension loads in 1D and 3D bolts.

ANSYS: Create Pretension Bolt
Create pretension loads in 1D and 3D bolts of ANSYS models using the ANSYS PRETS179 element type.

Element PRETS179 is a bar element with a third node used for pre-loading. Use the Pretension Bolt tool
to get a pre-loaded bolt with PRETS179 elements created at the desired location with a third node. A
pretension section is created and associated with the pretension elements created. Also, the pretension
load card SLOAD is created with the defined load in the utility, as well as a load steps on and off values.
You can edit this load card after completing this process.

Restriction:  The Pretension Bolt tool is only available in the ANSYS solver interface.

1. From the menu bar, click Tools > Pretension Bolt.
The Pretension Bolt dialog opens.

2. For Pretension Type, select the type of bolt to create.

3. In the Node ID field, enter the node ID for the third node of the pretension element.

Note:  If you do not enter a node ID, a default node number will be assigned.

4. In the Section Name field, enter a name for the pretension section to be created.

Note:  If you do not enter a section name, a default name will be assigned.

5. Toggle the type of method for loading the bolt to either Force or Displacement, then enter a
corresponding value.

6. In the Loadstep ID to activate [LSLOAD] field, enter the load step ID to which the load is to be
applied.
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7. In the Loadstep ID to lock [LSLOCK] field, enter the load step ID to which the displacements or
force loads needs to be locked.

8. Click Create.

9. Select source entities for the pretension bolt.

Option Description

1D pretension bolt 1. In the panel area, use the Nodes selector to select the nodes of the
1D elements where the pretension element needs to be created and
then click proceed.

3D pretension bolt 1. In the panel area, use the Comps selector to select the bolt
component and then click proceed.

Note:  Multiple components are not allowed to be
selected. If more than one bolt is selected, they will all
be placed under one component.

2. Use the elems selector to select the elements which form the cut
section of the bolt and then click proceed.

Pretension elements are created at this section.

Figure 1702: Example of a Typical Section

3. Use the node selector to select two or three nodes that define the
load direction for the pretension load and then click proceed.

For 1D pretension bolts, PRETS179 elements are created at the node locations, with the
pretension section created and associated to these elements. A SLOAD card with the given
pretension load is also created.
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For 3D pretension bolts, PRETS179 elements are created at the cut section with the pretension
section created and associated to these elements. A SLOAD card with the given pretension load is
also created.

10. To edit the SLOAD card, click Edit SLOAD.

Samcef: Create Pretension Bolt
Create and edit 1D and 3D pretension bolt loads and bolt sections.

Use the Pretension Manager to create and edit pretension bolts. Existing bolts and newly created bolts
are displayed in the table within the Pretension Manager dialog. The card attribute's of every bolt
present in the model are displayed. You can edit the output codes for each bolt in the Output column.
Any changes made to the Output column will be automatically updated in the respective BOLT cards.

Restriction:  The Pretension Bolt tool is only available in the Samcef solver interface.

Create a 1D Pretension Bolt

1. From the menu bar, click Tools > Pretension Manager.
The Pretension Manager  dialog opens.

2. Click Create New.

3. Set the Bolt type to 1D.

4. In the Name field, enter a name for the bolt.

5. Click Element > Select Existing Element.

Figure 1703:

6. In the panel area, use the elems selector to select a single beam, bar, or rod element and click
proceed.
The ID of the selected element is displayed in the field to the right of the Element definition
button.

7. To automatically generate a pretension node at the second node of the selected 1D element,
select the Auto generate pretension node checkbox.
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Figure 1704:

Once the 1D element is selected, the generated pretension node's ID is displayed in the Node ID
field.

Figure 1705:

8. Select whether to apply a Force or Displacement load on the bolt, then enter a corresponding
magnitude.

Note:  A load is not created until a load collector is specified.

9. Click Function Time.

10. In the panel area, use the curves selector to select the required curve for the load and click
proceed.
The selected curve and its corresponding ID are displayed in the field to the right of the Function
Time definition button.

11. Click Load Collector and select where to store the defined load.

• Choose Select Existing Collector to open the panel area where you can use the loadcol
selector to select an existing load collector.

• Choose Create New Collector to create a new load collector with the prefix PRETENS_#.
The number appended to the end of the load collector name depends on the number of load
collectors currently present in the model.

The load collector is created along the 1D bolt.
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Figure 1706:

12. To create a FIX parameter, select the FIX parameter checkbox and enter a FIX value.

13. Select where the different codes will be internally written in the solver deck.

• Total axial force in the bolt (9524)
• Relative displacement in the cut (9530)

14. Click Create.

A BOLT is created as a group entity.

The macro element ID for the first bolt that was created is written out as the maximum element ID
in the model + the number of nodes present in model. 1000 is added to the macro element ID for
consecutive bolts, that is, if the first bolt’s macro ID is 3, then the next bolt will be 1003 (3 + 1000).

The macro element ID of a bolt is reflected in its .SAI command, which is written along with the
bolt’s corresponding output-code. It is preceded by the comment !!HM_TEMP_OUTPUTBLOCK, which
enables the model-reader to ignore the output block upon import and not create any output blocks in
HyperMesh. A bolt card that does not contain an output definition will not have a .SAI command written
out.

All such commented commands are automatically exported out again upon re-export in the same
format.

The load applied on a bolt is written out in the solver deck. A load’s magnitude is written out after VAL,
and any curve attached to the load using Function Time is written after the keyword NF.

Create a 3D Pretension bolt

1. From the menu bar, click Tools > Pretension Manager.
The Pretension Manager  dialog opens.

2. Click Create New.

3. Set the Bolt type to 3D.

4. In the Name field, enter a name for the bolt.

5. Click Contact Surface and select where to create a new surface or select an existing surface.
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• Choose Create New Surface to open the panel area where you can use the node list selector
to select two consecutive nodes to generate a contact surface. The first node should be a
base node in the desired contact surface. The second node should lie in the direction of the
contact surface's normal. A default name is assigned to the new contact surface with the
prefix PRETENS_#. The number appended to the end of the name depends on the number of
contact surfaces currently present in the model.

Figure 1707:

• Choose Select Existing Surface to open the panel area where you can use the contactsurf
selector to select an existing contact surface.

6. Select a Method for defining the bolt.

• Choose 1 to create a .MCT contact between the two faces of the cut.

• Choose 2 to create a MEAN element and a new node on each side of the cut.

7. Select a pretension node.

• Choose Manually, then clear the Auto generate pretension node checkbox and click
Select. In the panel area, use the nodes selector to select two consecutive nodes. The first
node should be a base node in the desired contact surface. The second node should lie in
the direction of the contact surface's normal. The approximate center of the contact surface
where the pretension node will be created on is automatically estimated.

• Choose Auto-Generate, then select the Auto generate pretension node checkbox. A
pretension node will be automatically generated in the center of the contact surface.

8. Select whether to apply a Force or Displacement load on the bolt, then enter a corresponding
magnitude.

A load is not created until a load collector is specified. The load acts in the direction normal to
the contact surface. A load (force and displacement) is always created for bolts in the X-direction
(COMP1), regardless of the model.

9. Click Function Time.
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10. In the panel area, use the curves selector to select the required curve for the load and click
proceed.
The selected curve and its corresponding ID are displayed in the field to the right of the Function
Time definition button.

11. Click Load Collector and select where to store the defined load.

• Choose Select Existing Collector to open the panel area where you can use the loadcol
selector to select an existing load collector.

• Choose Create New Collector to create a new load collector with the prefix PRETENS_#.
The number appended to the end of the load collector name depends on the number of load
collectors currently present in the model.

The load collector is created along the 3D bolt.

12. To create a FIX parameter, select the FIX parameter checkbox and enter a FIX value.

13. Select where the different codes will be written internally in the solver deck.

• Total axial force in the bolt (9524)
• Relative displacement in the cut (9530)

14. Click Create.

A BOLT is created as a group entity.

The macro element ID of the first bolt that was created is written out as the maximum element ID
in the model + the number of nodes present in model. 1000 is added to the macro element ID for
consecutive bolts, that is, if the first bolt’s macro ID is 117653, then the next bolt will be 118653
(117653 + 1000).

The macro element ID of a bolt is reflected in its .SAI command, which is written along with the
bolt’s corresponding output-code. It is preceded by the comment !!HM_TEMP_OUTPUTBLOCK, which
enables the model-reader to ignore the output block upon import and not create any output blocks in
HyperMesh. A bolt card that does not contain an output definition will not have a .SAI command written
out.

All such commented commands are automatically exported out again upon re-export in the same
format.

The load applied on a bolt is written out in the solver deck. A load’s magnitude is written out after VAL,
and any curve attached to the load using Function Time is written after the keyword NF.

Manage Sets in the Sets Browser
Automate the grouping and display of model components through the entity set functionality using the
Sets Browser.

Open the Set Browser by selecting Tools > Set Browser from the menu bar.

The Sets Browser consists of a tree structure listing the current entity sets in the model, along with
the entity set display and export states. It also includes functions for displaying, creating, deleting,
renaming, appending entities to, and changing the export state of entity sets.
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Figure 1708:

Synch Set Browser with Graphics Display
The Sets Browser is meant to allow you to easily control the display and review of entity sets for model
grouping and visualization purposes. For large models, constantly synchronizing the display state of
entity sets with the current display can introduce performance issues.

To remedy these occurrences, the Sets Browser utility does not automatically synchronize the display
states of entity sets with the current display.

Synch the Sets Browser with the graphics display.

• Click the Display button at the bottom of the Sets Browser to update the display to match the
Sets Browser settings. When the Display button is used to update the display to the current Sets
Browser selection, the Sets Browser and the display remain synchronized until another selection is
made within the Sets Browser.

• Click the Synch button in the Sets Browser toolbar to update the Sets Browser to match the
current state of the display.

Set Display Options for Sets Browser

1. Open the Sets Browser.
The Sets Browser displays in the tab area.

2. Use the toolbar buttons in the Sets Browser tab to manipulate the display options, as desired.

Figure 1709:

• Use Ctrl-click and Shift-click to select multiple items in the tree structure. For large numbers

of selections, use the select all ( ), select none ( ), reverse ( ) buttons.
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• The Entity Type options allow you to control the entities (elements or geometry) that the
selection buttons apply to. These buttons are toggles; you can have one or both active at the

same time. In the screenshot above, the Element ( ) button is active, but the Geometry ( )

one is not.

• The Sync (  ) button synchronizes the entity set display states with the current display.

This means that if you have changed the display states of various entities, for example from
within the Model Browser, you can use this button to force the selection of entities in the Sets
Browser to match the current display states.

• The Name filter uses standard filtering syntax in the text box; click the funnel ( ) icon to

activate the text box, type in the string you wish to filter by, and then press Enter. This can
limit the entities which display in the tree structure. To undo the filter, click the funnel icon
again to disable the text box.

Change Sets Browser Display and Export States

1. Open the Sets Browser.
The Sets Browser displays in the tab area. Its tree structure lists all entity set currently existing in
the model, grouped in folders by type.

2. The display states of entity sets are controlled by clicking the checkboxes located next to each set
on or off.

Option Description

The checked state signifies that all entities in the entity set are currently displayed,
after clicking the Display button.

The blank state signifies that one or more of the entities in that entity set are not
displayed, after clicking either the Display button.

3. Once the display checkboxes are changed, click the Display button at the bottom of the browser
to update the display with the current selection.

Use the Sets Browser Right-Click Functionality

1. Open the Sets Browser.
The Sets Browser displays in the tab area. Its tree structure lists all entity set currently existing in
the model, grouped in folders by type.

2. Right-click anywhere within the tree structure to open the right-click menu.

There are many functions available, accessed by right-clicking in the background, on folders, or on
individual or multiple items within folders. Most options require that you click on a folder or one or
more items, and are grayed out of no selection is made; exceptions are specifically noted below.
The graphic above shows the available options, including:
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Option Description

Create Create a new entity set of the specified type. You are prompted to type in a name
for the set or accept a default name. Supported entity set types are shown above.
This option does not require any existing sets to be selected.

Edit Edit the element set, by picking a different group of elements to assign to it.

Delete Deletes the currently selected set(s). Multiple sets may be selected by using
standard Ctrl/Shift-click functionality.

Card edit Edit the property card assigned to the set (but not the entities within it).

Rename Rename the selected set.

Delete
Reference

Removes a set reference from an entity set type of sets.

Add
Entities
from Set

Adds entities into the currently selected set. This operation brings up an entity
selector to select entities to add to the set.

Remove
Entities
from Set

Removes entities from the currently selected set. This operation brings up an entity
selector to select entities to remove from the set.

Show This operation adds the entities contained in the selected set(s) to the display.

Hide This operation removes the entities contained in the selected set(s) from the
display.

Isolate This operation turns off (masks) the display of all entities not currently selected, so
that only the selected entities display.

Collapse All Collapses all branches (folders) of the tree. This option does not require any
selection.

Expand All Expands all branches (folders) of the tree. This option does not require any
selection.

Display
Options

Determines how the sets are labeled in the Sets Browser tree. Available options
are shown above. This option does not require any selection.

Display IDs Displays a popup window showing the IDs of all entities contained in the selected
set.

Export
Session
File

Saves a session file (.ses), containing group definitions for the selected node or
element sets, to the disk.
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Option Description

Import
Session
File

Loads a session file (.ses) containing group definitions. These group definitions
will be converted into entity sets. This option does not require any selection.

Find Connectivity
Check the connectivity between two or more components.

Certain types of connections can be included or excluded while checking for connectivity.

Restriction:  The Find Connectivity tool is only available in the LS-DYNA and Radioss user
profiles.

1. From the menu bar, click Tools > Find Connectivity.
The Find Connectivity Browser opens.

2. Invoke the Find Connectivity controller by right-clicking in the browser and selecting Find
Connectivity from the context menu.

Figure 1710:

3. In the Find Connectivity controller, enable the type(s) of connectivity to include in the check.

By default, all types of connectivity are enabled by except Connectors.
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Figure 1711:

4. Use the Select Entities selector to select two or more components to check the connectivity
between.

Connectivity check works on all the selected components regardless of its display state.
Connectivity due to mass elements are completely excluded when checking connectivity.

Figure 1712:

5. Click Check.

If two or more parts are connected, the number of connected parts are displayed in the browser.
Expand the folders to see individual components. If the parts are free, the free part is displayed
separately.

Results are displayed in the browser.
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Figure 1713:

Connectivity Types

Radioss
Physical connectivity

Checks for node to node connectivity (for 1D, 2D and 3D).

RBE2
Checks for RBE2 connectivity.

Rigids
Checks for RBODY connectivity.

Interface2
Checks for contacts with INTER/TYPE2.

Connectors
Checks for FE realized connections with connectors.

Rigid Links
Checks for RLINK connectivity.

RBE3
Checks for RBE32 connectivity.
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Joints
Checks for CYLJOINT connectivity.

LS-DYNA
Physical connectivity

Checks for node to node connectivity (for 1D, 2D and 3D).

Constrained Extra Nodes
Checks for connections using constrained extra nodes and extra noded joints.

*CONSTRAINED_EXTRA_NODES

Constrained Rigid Bodies
Checks for connections using constrained rigid bodies.

*CONSTRAINED_RIGID_BODIES

Constrained Groups

*CONSTRAINED_TIE-BREAK

*CONSTRAINED_TIED_NODES_FAILURE

Contact Groups

*CONTACT_SPOTWELD

NodesToSurface (only following types)

*CONTACT_TIED_NODES_TO_SURFACE

*CONTACT_TIEBREAK_NODES_TO_SURFACE

*CONTACT_TIED_SHELL_EDGE_TO_SURFACE

SurfaceToSurface (only following types)

*CONTACT_TIEBREAK_SURFACE_TO_SURFACE

*CONTACT_TIED_SURFACE_TO_SURFACE

SlidingOnly

*CONTACT_SLIDING_ONLY

Connectors
Checks for FE realized connections with connectors.

Rigid Links

*CONSTRAINED_NODAL_RIGID_BODY

*CONSTRAINED_NODE_SET_ID

*CONSTRAINED_GENERALIZED_WELD

*CONSTRAINED_SHELL_TO_SOLID

Welds

*CONSTRAINED_SPOTWELD

RBE3

*CONSTRAINED_INTERPOLATION
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Joints
Checks for connections with Joints

Slipring and Retractor
Checks for connections with sliprings and Retractor

*ELEMENT_SEATBELT_SLIPRING

*ELEMENT_SEATBELT_RETRACTOR

Review Mass Summary
Review details about Mass, Center of Gravity (Cog) and Inertia of your model.

1. From the menu bar, click Tools > Mass Details and select one of the following:

• Choose Mass only to calculate only the mass of the model.

• Choose Mass, Cog and Inertia to calculate the mass, center of gravity, and inertias.

Calculations are performed, and the Mass summary dialog opens.

Individual entity details can be reviewed in a tabular format from the browser area, and global
values of the whole model for Mass, Center of Gravity (Cog) and Inertia can be reviewed in the
lower part of the dialog.

2. Optional: Export the results to a CSV or HTML file by right-clicking in the browser and selecting
Export > <file format> from the context menu.

Tip:

• Manage the columns that are visible in the browser by right-clicking on a column header
and selecting the columns to display.

• Turn the display of entities ON/OFF in the browser and graphics window using the
Show, Hide, Isolate, and Reverse options available in the right-click context menu.

• Review only the selected entities, and make all other entities transparent using the
Review option available in the right-click context menu.
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Figure 1714: Summary of Mass

Supported Mass Values
Mass values supported in the Mass Summary dialog.

Structural Mass
Mass of the component defined by the mesh volume and material density.

Non Structural Mass
Mass added on the component, provided by following keywords:

LS-DYNA
*ELEMENT_MASS_PART
*ELEMENT_MASS_PART_SET
MAREA defined in *SECTION_SHELL
NSM defined in *SECTION_BEAM

Radioss
/ADMAS defined on PART

Lumped Mass
Nodal distributed mass provided by following keywords:

LS-DYNA
*ELEMENT_MASS
*ELEMENT_MASS_NODE_SET
*ELEMENT_INERTIA
*ELEMENT_SEATBELT_ACCELEROMETER
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Radioss
/ADMAS defined on NODES

Mass in CNRB
Constrained_Nodal_Rigid_Bodies

LS-DYNA
Total mass transferred to the *CONSTRAINED_NODAL_RIGID_BODYs in the model.

Mass on RBODY

Radioss
Total mass transferred to the RBODYs in the model.

Transferred Mass
For each component, this is the nodal massed transferred to the rigid bodies.

LS-DYNA
Deformable mass transferred to CONSTRAINED_NODAL_RIGID_BODY or to
the rigid parts of a *CONSTRAINEED_EXTRA_NODES or to the rigid parts of
*CONSTRAINED_RIGID_BODIES

Radioss
Deformable mass transferred to RBODY

Distributed Mass

LS-DYNA
Mass in rigid components coming from free nodes linked by *CONSTRAINED_EXTRA_NODES

Engineering Mass

LS-DYNA
Engineering Mass = Structural Mass + Non structural Mass + Lumped Mass + Distributed
Mass

Radioss
Engineering Mass =Structural Mass + Non structural Mass + Lumped Mass

Solver Part Mass
Solver Part Mass = Engineering Mass + Transferred Mass

Total Mass
Total Mass = Solver Part Mass

Manage Rigid Bodies
Manage and review all rigid bodies in the model using the RBODY Manager.

Access the RBODY Manager by selecting Tools > Rbody Manager from the menu bar.

Restriction:  Only available in the Radioss user profile.

The RBODY Manager provides the following features in one convenient tab:
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• Display all rigid bodies in the model

• Display individual rigid bodies

• Create new, and edit existing, simple and complex rigid body formulations

• View and update details of individual rigid bodies, though the card editor and the Rigid panel

Existing rigid bodies are shown in the table. For each rigid body, the display status, ID number, name,
master node ID, and type is shown.

Table 267:

Column Description

Disp Indicates whether the rigid body is displayed in the graphics area.

ID The ID number of the rigid body.

Title The descriptive name of the rigid body.

Master Node The ID of the node that serves as the master node of the rigid body.

Type S or C. S indicates a simple rigid body, which is a typical spider formulation. C
indicates a complex formulation, such as an RBODY that points to a part or a set
of sets.

Highlight individual entries or groups of entries to perform an action on the rigid body. Actions are
available from the context menu (by right-clicking over the table entries) or the toolbar buttons. These
actions are described below:

Table 268:

Icon Name Description

Review Option Customize the way the selected rigid bodies are displayed.
Options include transparency and auto-review selections.

Review Highlights the nodes to which the selected RBODY is attached.
The master node is shown in blue and the slave nodes are
shown in red.

Find Attached Highlights the elements that are attached to the selected rigid
body.

Edit Modify the definition of the rigid body through the Rigid panel.

Card Edit Opens the RBODY card in the Card Editor.

Delete Deletes the selected rigid body.
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Icon Name Description

Refresh Update the table of rigid bodies.

New rigid bodies can be created with the RBODY Manager. The following fields are available at the
bottom of the RBODY Manager tab, which enable you to supply all the basic data needed to create a
new RBODY. Nodes, parts, materials, properties, and GRNODs can be used to define the slave nodes.
Once the RBODY is created, click refresh to list it in the table. Then you can select the RBODY to edit
the card image, display the RBODY, and so on.

Note:

• When a large number of slave nodes are attached to a master node, the connecting
lines are not displayed in the graphical model.

• The table of rigid bodies can be sorted by the ID, title, mater node, and type columns.

• Select Show Details from the context menu to display a summary of details about the
rigid body including the ID, name, master node ID, and number of slave nodes.

• Select Editable from the context menu to make the title column editable. When the
Title column is editable you can modify the names of the rigid bodies.

The tool is also available in the PAM-CRASH 2G user profile and offers similar features.

Analyze Part Information
Analyze a summary of a part’s statistics using the Part Info tool.

Restriction:  Only available in the Radioss user profile.

1. From the menu bar, select Tools > Part Info.

2. Click component on the main menu area to select a component or click a component in the
graphics area to select it.

3. Click proceed.
The Part Information dialog opens, which lists the part ID, name, thickness, and material type.

4. To view additional statistics about the part, click More Detail.
5. To display statistics for a different part, select the part in the graphics area or the components

selector and click proceed again.

Tip:  Click the middle mouse button instead of the proceed button to quickly select
components.
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Relative Displacement
Create the /TH/SPRING card, which supports time histories with spring output using the Relative
Displacement tool.

Access the Relative Displacement tool by selecting Tools > Relative Displacement from the menu
bar. The tool opens as a tab named Relative Displacement.

Restriction:  Only available in the Radioss user profile.

Create Time Histories of Springs

1. Type a name in the Time History Name field and click Create/Edit.
A pop-up menu appears from which you can choose either to create the spring and edit the card
that is generated or simply create the spring.

2. The time history appears in the Output Blocks list. Right-click the list item and select Add
Springs to create springs for that time history.

3. Pick nodes from the model to define springs.

Note:  The first node you select is used as Node1 in the definition of the spring.

Edit Time Histories of Springs

1. Right-click its name in the Output Blocks list and select Edit.
The card for that time history opens in the main panel area. From here you can provide names for
each element, and add or modify variables.

2. To add variables, click NUM_VA.
A pop-up window of numbers opens.

3. Click the number of variables you want to include in the card.

Var fields appear where you can type the variable names.

When you use the Relative Displacement tool to create time histories of springs, you also create a
component named Comp_Rel_Disp. This component is of the Springs/Rivets type and no material
is assigned. The component contains one property, SPR_GENE, with only the mass value specified.

Manage Boundary Conditions
Create boundary conditions of any load collector type other than ACTIV using the BCs Manager tool.

Access the BCs Manager by selecting Tools > BCs Manager from the menu bar. The tool appears as a
tab in the tab area.
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Restriction:  Only available in the Radioss user profile.

This tool combines required actions from several panels into one convenient tab interface, including the
ability to create a boundary condition from both sets and individual nodes.

Create New Boundary Conditions

1. Select the type of boundary condition you want to create in the Select type field.

2. In the Name field, type a name for the load collector.

3. Select the type from the drop-down menu in the Select type field.

Based on the type selected, the options that display may change.

4. Use the selectors to pick sets and/or individual nodes to define boundary conditions. The switch
allows you change the selector to access parts, nodes, materials, properties, GRNOD (set), and
GRNOD (box). Pick the type of entity to be selected from the pull down menu and click the yellow
button to open the Selector panel.

5. Enter the loading conditions in the options.

Empty fields require user input, and yellow buttons provide links to another entity that needs to
be linked; namely curve, system or sensor. Each yellow tab has two options:

• Choose Create/select to directly create the entity from this GUI.

• Choose Select to select an entity already defined.

6. Click Create to create the database with the boundary condition data entered. Click Cancel to
cancel the creation and Close to close the dialog.

Update Existing Boundary Conditions

1. Highlight a boundary condition in the list to display its properties.
This opens the Review (editing) mode of the dialog.

2. In Review mode, every defined entity/entry in the field can replaced with new entity or modified.
To replace the entity on which boundary condition is define, set the GRNOD tab to the desired
entity to be selected and make the selection.
The selection will replace the existing entity on which the BC is defined. Similarly the curve,
system and sensor can be changed.

3. The table appears with list of entities that are referred in the selected boundary condition. To edit
the existing entity, select the entity, right-click it and select edit.
This opens a corresponding panel with editing features.

• Click Update to update the changes made to the selected boundary condition. Click return to
go back to Create mode.

• Click Cancel to nullify all updates made to the selected boundary condition. Click return to
go back to Create mode.

• Click Close to nullify all updates to the selected boundary condition and close the dialog.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Model Setup p.2785

• Click Review to highlight the entities on which the selected boundary condition is defined.

Table Functions
The table in the dialog lists the boundary conditions in the model by default.

This can be limited to the desired boundary condition using the Select type option on the top of the
table.

Right-clicking on each entity in the table provides the following functions:

Table 269:

Function Description

Refresh list Refreshes the table based on the option in the Select type field.

Card edit Opens the selected boundary condition's card image panel.

Delete Deletes the selected boundary condition.

Review Highlights the entities on which the selected boundary condition is defined and
grays out the others.

Clear review Returns the graphics window to regular mode.

Show all No pre-selection is needed. Displays the part on which the boundary conditions in
the table are defined and shows the load with handles.

Show Displays the part on which the selected boundary condition is defined, if hidden,
and shows the load with handle.

Isolate Isolates the part on which the selected boundary condition is defined in the
graphics and shows the load with handle.
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Control Cards
Control cards allow you to add input and output parameters to a model, including location and names
of the input, output and scratch files; the type of run (analysis, check or restart); overall running of the
analysis or optimization; and type, format and frequency of the output.

Control cards are assigned to your model from within the Control Cards panel. This panel lists all of the
control cards defined for the solver/user profile that you currently have loaded; you can disable, enable,
or delete cards as desired.

Use the Card Previewer

A control card may be in one of three states:

State Color Explanation

Undefined Gray The control card was either never
created or has been deleted.

Defined (See note.) Green Any control card viewed in the
card previewer is activated.

Inactive Red A card that has been defined
may be disabled. The attributes
for that card remain; however,
the control card is not output.

Note:  Those control cards that are defined (green in the control card editor) are output.

Default values for attributes are common throughout the card previewer. A default value field has two
states:

State Description

Default = ON In this state, the field label color is yellow and no
data entry is allowed.

Default = OVERRIDDEN To override a default value field, pick the yellow
field label. When you override a default value field,
the label text color changes to cyan and allows
you to enter data in the field.
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Boundary Conditions
Boundary Conditions define limits as well as loads on geometry and mesh.

Loads on Geometry
You can apply loads to geometrical entities and map them to the FE mesh using the Load on Geom
panel.

One advantage is that you can remesh a model without deleting complicated loads or boundary
conditions. After remeshing, loads or boundary conditions that have been applied to geometrical entities
can be remapped to the new mesh.

You can apply loads to geometry by using the following panels: Forces, Moments, Constraints,
Pressures, Temperatures, Flux, Velocities, and Accels. These are the same panels used to apply loads to
a mesh.

There are two ways to map loads on geometry to the mesh associated with this geometry (loads on
mesh):

• Manually, using the Load on Geom panel

• Automatically, by exporting the FE deck, using the Export tab.

The Model Browser allows separate or simultaneous visualization of loads on mesh and loads on
geometry.

To visualize loads on mesh and/or loads on geometry, right-click on the load in the Model Browser.

From the toolbar, click  (Elements/Geometry). This icon determines what the other buttons act on;

right-click the button (or left-click the small triangular downward arrow) to reveal a drop-down menu of
options. You can select Elements, Geometry, or both.

• When Elements is selected, you control the display of loads applied to elements.

• When Geometry is selected, you control the display of loads applied to geometric entities.

• Both means that you can control the display of both types of loads independently, and load
collectors may contain one type or both types simultaneously.

• Use the none, all and reverse buttons to assist in selecting which loadcols should be displayed.

Note:

Loads on mesh and loads on geometry can be displayed together, similar to the
simultaneous display of both elements and geometry belonging to a specific component.

A geometrical entity can be associated with one mesh or multiple meshes (component or
components) and/or with one load collector or multiple load collectors.

One load collector stores both loads on geometry and loads on mesh. The mesh, or multiple
meshes, is associated with the geometrical entities to which the loads on geometry have
been applied. Each load type is stored in a dedicated section of the same load collector.
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Terminology and Definitions

geometrical entities
A point, a line, or a surface.

loads on geometry or geometry loads
Loads applied to geometrical entities.

loads on mesh or mesh loads
Loads applied to mesh (nodes or element).
Loads can be applied directly to mesh or applied by mapping them from loads on geometry.

load mapping
The process of mapping geometrical loads to mesh loads. The loads are mapped from the
geometrical entities (to which the geometrical loads are applied) to the mesh that is associated
with the geometrical entities.

Application of Loads to Geometry
You can apply loads to geometrical entities in a way similar to the manner in which loads are applied to
mesh. The process includes two basic steps.

1. Creating a load collector by using the Collector panel.

2. Applying loads to the geometry using one of the following panels on the Analysis page: Forces,
Moments, Constraints, Pressures, Temperatures, Flux, Velocities, and Accels.

To apply a load to a geometrical entity, first create a load collector in which the loads applied
to geometrical entities will be stored. Next, access an HyperMesh load panel (such as Forces,
Constraints) located on the Analysis page, and choose the create subpanel. Third, select a
geometrical entity on which the loads will be applied (points, lines, or surfaces) using the panel
selection box, define the load or boundary condition parameters in the same way you would for
the application of the load or boundary condition on a FE mesh entity, such as a node, and click
create. HyperMesh stores the loads/boundary conditions in the database and displays them in the
modeling window.

The following chart specifies the geometrical entities to which loads can be applied, in each of the
load application panels listed above.

Panel Geometrical Entities

Accels Panel points, lines and surfaces

Constraints Panel points, lines and surfaces

Flux Panel points

Forces Panel points
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Panel Geometrical Entities

Moments Panel points

Pressures Panel surfaces

nodes on edge: lines (for 2D solid elements)

nodes on face: surfaces (for 3D solid elements)

Temperatures Panel points, lines and surfaces.

Velocities Panel points, lines and surfaces.

Refer to the specific panel for detailed information about creating, reviewing and updating loads
and constraints.

Exporting Loads
Export sessions that contain loads on geometry, loads on mesh that have been applied directly to mesh,
and loads on mesh that have been mapped from loads on geometry.

When saving the model as an HM database, all load types are saved and are retrieved when you open
the .hm file. When exporting the model using an export template, only the loads on mesh are exported.
The loads on mesh that are exported may have been applied directly to mesh, mapped from geometry
to mesh, or both.

The all/displayed option on the Export tab allows you to determine which loads are exported.

If all is selected, all the loads on geometry that have not been mapped (if any), are mapped to loads on
mesh and all the loads on mesh are exported.

If displayed is selected, all the displayed loads on mesh are exported. All the loads on mesh, both
displayed and hidden, that are associated with the displayed loads on geometry are exported as well. If
any loads on geometry are displayed and have not been mapped, they will automatically be mapped to
loads on mesh and exported as well.

Visualization of Loads on Geometry and Loads on Mesh
The Display panel allows you to visualize loads on mesh and loads on geometry.

Visualize loads on mesh and loads on geometry either individually or together by setting the collector
type to loadcols and using the toggle between elems and geoms.

The elems option controls the display of loads on mesh while geom controls the display of loads on
geometry. A simultaneous display is similar to the display of both elements and geometry belonging to
a specific component.
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Note:  A major graphical display difference between loads on geometry and loads on mesh
is the density of the arrows. Multiple arrows represent loads on mesh (one arrow per node
or element); a single arrow for each geometrical entity represents loads on geometry. The
basic length of the arrow also differs. For the same arrow magnitude percentage setting or
uniform size setting within the load application panels, an arrow that represents a load on
geometry is longer than arrows representing loads on mesh.

Create Load Collectors

1. In the Model Browser, right-click on the white area and select Create > Load Collectors.

2. In name field, enter a load collector name.

3. Click color and select a color from the pop-up menu.

4. If creating a generic load collector:

a) Click the switch and select no card image.

b) Click create.

c) Click return
5. If creating a specific load collector:

a) Click the switch and select card image.

b) Click card image = and select the card image type.

c) Click create/edit.
d) Enter the relevant data in the card image.

e) Click return.
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Morphing

Morph the shape of your finite element model.

This chapter covers the following:

• Approaches to Morphing  (p. 2792)

• Space Frame Model Strategies using Global Domains  (p. 2813)

• Shell Model Strategies using Local Domains  (p. 2832)

• Solid Model Strategies  (p. 2861)

Using morphing tools in HyperMesh you can rapidly change the shape on the FE mesh without severely
sacrificing the mesh quality.

During the morphing process, you can create shapes which can be used for subsequent design
optimization studies.
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Approaches to Morphing
HyperMorph utilizes exclusive HyperMesh morphing entities; domains, handles, morph constraints,
morph volumes, shapes, and symmetries.

While all the entities and functions are fully compatible, and may be used in a complementary fashion,
they can be divided into three approaches to morphing; the domains and handles concept, the morph
volume concept, and the freehand concept.

Domains and Handles Approach
The Domains and Handles approach involves dividing the mesh into domains containing elements or
nodes and placing handles at the corners of those domains.

The domains and handles approach also allows for parametric morphing of lengths, angles, radii, and
arc angles as well as morphing the mesh to match geometric data and other meshes. This approach
is most useful for making detailed changes to any mesh (local domains) as well as general changes to
space frame type meshes (global domains).

You can automatically divide the mesh into logical domains or you can manually define your own
domains and handles. When the handles are moved, the shape of the mesh changes according to
the domain boundaries. When the handles associated with a domain move, the shape of the domain
changes, which in turn changes the positions of the nodes inside those domains. During the morphing
process the mesh morphs in a logical way with nodes near the moving handles moving more and nodes
near the stationary handles moving less. In the areas between the handles, the mesh is stretched or
compressed to match the desired shape.

The amount each node moves with respect to each handle is relative to an internally calculated
influence coefficient. The process for calculating the influence coefficients is somewhat time consuming,
but once they are calculated they can be stored and applied rapidly. Thus, when handles and domains
are initially set up or edited, HyperMorph spends an amount of time, proportional to the size of the new
domains, calculating the handle influences. However, when handles are moved to morph the model, no
calculations are necessary and the actual morphing occurs quickly. The advantage of this approach is
that it makes morphing an interactive process, even for large models.

For very large domains, calculating influence coefficients can be time consuming. For domains that
have more than 50,000 elements, although you can change this default limit, the large domain solver
is used. The large domain solver much faster at morphing large domains, but the drawback is that it
must be invoked every time you wish to morph, thus making morphing slower. However, for very large
domains, the process of calculating influences can be too slow or too memory intensive, therefore the
large domain solver makes it possible to morph such domains.

Domains and handles are divided into two basic groups, global domains and local domains.
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Global Domains and Handles
Each global domain is associated with any number of global handles. Global handles will only influence
the nodes contained within their associated global domains. Global domains and handles are best for
making large scale shape changes to the model.

Global domains are represented by a cube made up of dashed lines, and located at the centroid of the
nodes which make up the global domain.

Global handles are the largest handles in the model. Handles are colored red if they are not dependent
on other handles, and they are colored yellow, cyan, or violet if they are dependent on other handles.
The handle color indicates their level of dependency. Dependent global handles are also smaller than
the handles on which they are dependent. The base size of all the handles in the model can be set

on the morphing Visualization Controls tab accessed by using the Visualization options ( ) on the

Visualization toolbar. The size given is used as the radius for the independent global handles. You
cannot edit the color of the handles nor the relative size between the dependent and independent
handles. However, you can edit the color of the domains in the morphing Visualization Controls tab.

The Domains panel is used to create, edit, and organize global domains. When a global domain is
created with the create handles option selected, HyperMorph generates several global handles.
Global handles are generated at each of the eight corners of a box surrounding the model laid out
along the global axes. These global handles are named corner followed by a number from one to eight.
HyperMorph also places at least one global handle within the global domain box in areas of peak nodal
density within the model. HyperMorph generally creates no more than about 30 global handles within
the global domain box. These handles are named global followed by a number. The automatic global
handle generation works well for space frame models such as full car models. If the handles are not
generated in the positions where you want them to be, you can always delete them, reposition them, or
create new handles using the Handles panel.
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Figure 1715: Global Domain and Global Handles
Eight handles are placed at the corners of a box enclosing the model. By moving the handles you can stretch or deform the model

along all three axes.
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Figure 1716: Space Frame with Six Manually Created Global Handles
When the handles are moved, the space frame morphs in a way such that the bars run between the handles.

The method for determining how global handles associated with global domains influence the mesh can
be selected in the Morph Options panel, Global subpanel.

Hierarchical
Global handles influence the local handles found at nodes inside the global domain, which in turn
influence nodes within the local domains.

Direct (default)
Global handles influence the nodes in the model directly even if the nodes are not in a local
domain.

Mixed
Global handles will influence every node inside the global domain using the hierarchical method if
the node is inside a local domain, or the direct method if the node is not in a local domain.

There are subtle differences in how the global handles influence the nodes for each method with the
main difference being that the parts of the model defined by local edge domains have their shape
preserved when using the hierarchical method. Straight edges will remain straight and circular holes will
remain circular for the hierarchical method, while the direct method may bend or warp these features
into curved edges and elliptical holes. You should select which method is right for the type of morphing
that you want to perform. If you wish to preserve the local geometry, choose the hierarchical or mixed
method. If you are willing to accept distortions in the local geometry, choose the direct method.
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Figure 1717: Global Morphing using the Hierarchical Method
When the highlighted (white) handle is moved to the right, it moves the local handles, which move the mesh. Note how the

straight edge remains straight and the circle remains round.

Figure 1718: Global Morphing using the Direct Method
When the highlighted (white) handle is moved to the right, the mesh is affected directly. Note the resulting distortion of the edge

and circle.
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Figure 1719: Global Morphing using the Direct Method and Biasing Factors
By increasing the biasing factor for the highlighted (white) handle, the angular shape of the morph becomes rounded.

The influences between the global handles and local handles using the hierarchical method or nodes
using the direct method can be calculated using either the spatial method or the geometric method.
Both methods attempt to determine how a global handle affects nodes or local handles in the space
surrounding it. The spatial method is the default, and is the fastest and most robust method for
generating global influences based on a spatial formulation for the entire model. The geometric
method can be slow for large models or large numbers of global handles, but may produce more
desirable influences. The geometric method is the method that was originally used in HyperMesh and
generates influences based on the geometric relationship between a given node or local handle and
the surrounding global handles. The method used can be selected in the global subpanel of the Morph
Options panel.

Local Domains and Handles
Each local domain is associated with any number of local handles. Local handles will only influence
nodes contained within their associated local domains. Local handles are intended to be used to make
small scale, parametric changes to the model.

A model can contain both global and local handles and domains, which allows for both large and small
scale morphs. It is not necessary to have both types of domains and handles in a model.

Local domains are represented by a single rectangle for 1D domains, two joined rectangles for 2D
domains, a cube for 3D domains, four joined rectangles for general domains, and a line for edge
domains.

Local handles are colored orange if they are not dependent on other handles. Local handles are
colored green, blue, or pink if they are dependent on other handles, the color indicating their level of
dependency. The base size of all the handles in the model can be set on the morphing Visualization

Controls tab accessed by using the Visualization Options icon ( ) on the Visualization toolbar. The

size given is used as the diameter for the independent local handles. You cannot edit the color of the
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handles nor the relative size between the dependent and independent handles. However, you can edit
the color of the domains in the morphing Visualization Controls tab.

Local domains can be created individually by selecting nodes or elements in the Domains panel, Create
subpanel. When local domains are created, HyperMorph automatically places local handles at the ends
of all edge domains. These local handles are named local followed by a number. The placement of local
handles depends on the type of domain created and the partitioning options, if partitioning is selected.

Figure 1720: Local Domains and Local Handles with Partitioning

In Figure 1720, the rigid elements have been placed in a 1D domain with the center node having
an independent (orange) handle and the other nodes having dependent (green) handles. The shell
elements have been placed in two 2D domains separated at the bend line due to partitioning. The solid
elements have been placed in a 3D domain. Shell elements have been created on the faces of the 3D
domain. These elements are placed in a component named ^morphface. 2D domains have been created
on the faces of the 3D domain and that edge domains have been created on the edges of all the 2D
domains. Handles have been placed at the ends of all the edge domains.

1D Domains
1D domains are made up of 1D elements, such as bars and rigid elements.

When automatically creating local 1D domains, 1D elements that share common nodes are grouped
together into 1D domains. An independent local handle is placed at the centermost node of the 1D
domain and dependent local handles are placed at every other node of the elements in the 1D domain.
The independent handle is larger and orange, while the dependent handles are smaller and green.
All the dependent handles in a given 1D domain are directly dependent on the independent handle.
This dependency relationship means that moving the independent handle also results in moving
the dependent handles the same amount in the same direction. This is done to preserve the unique
relationship established for groups of 1D elements. Additionally, the bias factors for the dependent
handles for a 1D domain are given an initial value of 3. All other handles in the model are given a
biasing factor of 1. A higher biasing factor means that a given handle will have greater influence over
the surrounding mesh than the others. The higher biasing factor given to dependent handles on 1D
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domains is intended to prevent mesh distortion when the 1D elements connect to nodes in 2D and 3D
domains.

Figure 1721: 1D Domain Created from Rigid Spider Elements
An independent local handle (orange) is placed at the centroid of the 1D domain and dependent handles (green) are placed at

each node. By moving the orange handle, the entire spider is moved, maintaining the proper shape and connectivity for the rigid

spider.

2D Domains
2D domains are made up of shell elements.

When automatically creating local 2D domains, shell elements that share common nodes are grouped
together into 2D domains. If partitioning has been selected, these domains are subdivided into smaller
domains along break angles and curvature changes according to the partitioning parameters. Edge
domains are placed along the edges of the 2D domains and are also partitioned. Local handles are
placed at the ends of all the edge domains. In general, the local handles are placed at the corners of
the 2D domains and at other useful positions. The intent is to make it faster and easier for you to apply
parametric changes to the model. Since you morph the model by moving handles, it helps to have
handles already at the positions where you want them. HyperMorph tries to predict where the handles
should be placed to reduce the amount of time it takes to prepare your model for morphing. If the
handles or domains are not laid out in the positions where you want them to be, you can delete them,
edit them, or create new ones. Also, even though the generated local handles are associated with the
edge domains, they will influence the nodes in any domain that shares the node at which it is placed.
This is true even if the handle is associated with the 2D domain. A handle associated with any domain
will always influence the nodes in domains that it is touching. Note that it is possible to create a handle
on a node that is not touching the domain to which it is associated. This allows you to place a handle
outside of a domain, such as floating in space near the domain, and have it influence the nodes within
its domain.
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Figure 1722: 2D Domains with Edge Domains and Handles
The model on the left shows the initial handle positions. The model on the right shows the addition of four new handles. Handles

can be placed anywhere, even at nodes not on the associated domain.

3D Domains
3D domains are made up of solid elements.

When automatically creating local 3D domains, solid elements that share common nodes are grouped
together into 3D domains. Shell elements are created on the faces of each 3D domain and placed into
a component called ^morphface. It is recommended that you do not delete or edit these elements nor
rename or delete the ^morphface component. However, if you do, these elements and their 2D domains
will be regenerated the next time you enter or exit a HyperMorph panel or the Delete panel. The shell
elements on the face of each 3D domain are placed into a 2D domain that is then partitioned if the
partitioning option is active. Edge elements are placed around each 2D domain and local handles are
created at the ends of each edge domain. In cases where shell elements that are attached to the faces
of solid elements are present in the model, HyperMorph will not create ^morphface elements coincident
with the existing elements. The color of the ^morphface component can be changed on the morphing
Visualization dialog accessed by using the Visualization Options icon on the Visualization toolbar.

Note:  The face elements in the ^morphface component will not be written out to any FEM
formatted deck since the component name begins with a "^".
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Figure 1723: 3D Domain Created from Block of Solid Elements
The gray shell elements on the face of the 3D domain are the ^morphface component. The ^morphface component has been

partitioned into 2D domains. Handles are created at the corners of the 2D domains.

Edge Domains
Edge domains are made up of a list of nodes.

When automatically creating local edge domains, edge domains are placed around the edges of all
2D domains. When you are selecting domains and are holding the mouse button down while placing
the mouse over the icon of a 2D or 3D domain, or an element in the domain, HyperMesh will highlight
both the domain icon and the surrounding edge domains. This makes it easier for you to tell which
domain you are selecting. When you release the mouse button, only the icon for the domain remains
highlighted.

Edge domains and 2D domains on the faces of 3D domains play an important function in determining
the influences for the handles over a given domain. Nodes on edge domains will only move as a
function of the handles touching the edge domain. No other handles will affect the nodes on the edges.
Similarly, nodes in a 2D domain on the face of a 3D domain will only move as a function of the handles
touching the 2D domain. This preserves the boundaries of 2D and 3D domains such that straight edges
remain straight, flat surfaces remain flat, and curved edges retain their curvature. It allows you to
move handles within a 2D or 3D domain without affecting the edges. If you do not want to have the
boundaries of a domain preserved, you can delete the edges for a given domain, or choose to create
the domain as a general domain instead. Also, non-reflective symmetries allow the influences of handles
to extend through edges and faces depending on the type of symmetry. For domains that have non-
reflective symmetry types, the boundaries may not be preserved during morphing.
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Figure 1724: Edge Domains
Edge domains are placed around the edges of 2D domains. In the model at the right an edge domain has been created inside a

2D domain. When an edge domain is created, it is partitioned and handles are placed at the ends and joints.
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Figure 1725: Edge Domains after Morphing
In the top two frames two handles inside a 2D domain are created and moved. In the bottom frames, two handles connected by

an edge domain are created and moved. The edge domain remains straight, preserving the shape of the feature.

General Domains
General domains are made up of any combination of 1D, 2D, and 3D elements.

General domains are not automatically created when automatically generating local domains. Like all
other domains, the elements within a single general domain must touch one another.

When a general domain is created, no 2D domains are created on the faces of any 3D elements and
no edge domains are created either, thus no handles are created for the domain. However, general
domains respect all neighboring edge domains and 2D domains and thus if you create 2D and edge
domains for your general domains they will impose restrictions on handle influences for the general
domain. Otherwise, handles on a general domain freely influence all of the nodes inside the general
domain, allowing it to stretch and deform in an unbounded manner with morphing extending across
differences in element type. General domains are very useful for realized connectors which are often
represented as clusters of different element types. Another use is for meshes where precise changes
are required for one section, where 1D, 2D, and 3D domains are used, but the rest of the mesh, where
a general domain is used, can simply follow along.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Morphing p.2804

Figure 1726: Interaction between General Domain and 2D Domains
In the top frame, two 2D domains are created for parts of two shell meshes and a general domain is creating from the remaining

rigid, shell, and solid elements. Two handles have been placed within the general domain at the ends of the rigid spiders. In

the bottom frame the two handles inside the general domain are translated. Note how the shell elements in the general domain

morph, bounded only by the edge of the 2D domains with the other domain morph, bounded only by the edge of the 2D domains

with the other edges free to follow the handles.

Partitioning
Partitioning is a method of dividing 2D domains into smaller 2D domains at logical places, such as at the
edges of surfaces associated with the mesh, or where the angle between elements exceeds a certain
value, or where the domain changes from flat to curved.

Partitioning allows you to prepare your model for morphing more quickly and easily since it divides your
model into sections where parametric changes can be applied.

Partitioning can be applied directly to 2D domains and indirectly to 3D domains. 3D domains are created
with 2D domains on their faces.

You can invoke partitioning when creating 2D or 3D domains by activating the partition 2D domains
checkbox on the Domains panel. If there are no surfaces in the model, or the use geometry option in
the Domains panel, Partitioning subpanel is unchecked, partitioning will divide your model such that
every radius and straight or flat section is placed into a separate domain. Partitioning is not always
exact, therefore it is possible that there will be areas where elements are not placed into the desired
domains. If you are unsatisfied with the partitioning, you may change the partitioning parameters in the
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Domains panel, Partitioning subpanel and try again, using the redo last button, or edit the domains by
hand using the create and organize subpanels in the Domains panel.

Figure 1727: Partitioning
For the model on the left, the 2D domain was created without partitioning. For the model on the right, partitioning was used. Note

how the 2D domains are divided along angle and curvature change boundaries. Also note that the edge domains are partitioned

regardless of whether the partitioning option is on or off.

There are two algorithms you can use to partition, element-based and node-based. These can be set
individually for quad/mixed meshes and for tria/tetra meshes. In general, the element-based algorithm
works better for quad/mixed meshes and second order meshes, while the node-based algorithm works
better for tria/tetra meshes.

There are also several parameters that govern the creation of domains for either algorithm. They are
found in the of the Domains panel, Partitioning subpanel.

If you have selected use geometry, all elements whose nodes are associated to surfaces in the model
will be partitioned along the edges of the surfaces. All other elements will be partitioned using one of
the partitioning algorithms. If you have also selected add to geometry, then any partitions created
outside of the surfaces will be added to the partitions created using the surfaces if the partitioning
algorithm does not find a break along the edges or the surfaces. This option is helpful when surface
data is incomplete of some of the nodes have been moved away from their surfaces.

Partitioning can be angle-based or curvature-based. In either case, the domain angle controls the break
angle along which a partitioning break is made. If the angle between the normal vectors between two
elements is greater than this value, a new domain is created with an edge running between the two
elements. When using curvature-based partitioning, the curve tolerance controls the angle of which
values less than it are considered straight for curvature measuring purposes. If the angle between the
normal vectors between two elements is less than this value, they are considered flat, otherwise they
are considered to be curved. If the curvature changes from straight to curved, changes direction, or
changes curvature by more than the curvature tolerance, a new domain is created with an edge running
between the two elements. Note that in order for a new partition to be created, a break due to angle or
curvature must be found along its entire edge.
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For the node based method, domain angle and curve tolerance have a roughly similar meaning as the
element based method. The node based method tends to create fewer partitions than the element
based method, although exact performance for each method depends heavily on the features in your
model. For instance, the node based method seems to work better on first order tria and tetra meshes
while the element based method seems to work better on mixed quad and tria meshes.

Dependent Handles
Handle can be made dependent on one or more other handles, and then those handles can be made
dependent on one or more other handles, and so on.

You can create any number of dependency layers. Handles that are dependent on other handles
appear smaller and in a color different from the handles on which they are dependent. In the Handles
panel, Update subpanel, clicking review allows you to view the handles on which a specific handle is
dependent. Making a handle dependent has no affect on the way it influences nodes.

Figure 1728: Global Handles
Independent (red) and dependent (yellow, cyan, and violet).

Figure 1729: Local Handles
Independent (orange) and dependent (green, blue, and pink).

The conditions for handle dependency are as follows:

• A handle that is dependent on another handle inherits the movements applied to the higher level
handle.

• If a handle is dependent on only one other handle, it inherits the full movement of the higher level
handle.

• If a handle is dependent on more than one handle, it will inherit a percentage of the movements
applied to each higher level handle. The percentage is based on the distance between the
dependent and independent handles.

• A handle may be dependent on any number of handles, but dependency loops are not allowed.

• A dependent handle can be moved independently of the handles on which it is dependent. This
means that movements applied to the dependent handle are not applied to the independent
handles. This allows you to add the movements of dependent and independent handles in a logical
manner.
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• In the hierarchical method, all local handles are dependent on global handles. These dependencies
are calculated internally and cannot be modified manually, biasing will affect them.

Handle dependencies are useful for several different applications.

Transparent control of domain edges and faces
You can create a dependent handle on an edge domain that is dependent on the handles at
the ends of the domain. When the dependent handle is moved, the shape of the edge can be
changed. When the handle at either end of the edge domain is moved, the dependent handle
moves along as if it was not there. This allows you to combine the changes easily without having
to apply separate perturbations for all of the handles.

Grouping features together to move as a unit
You can make all the handles at one cross section of a beam dependent on a single handle. This
allows you to move an entire cross section while only having to select one handle.

Linking several domains together
You can make all of the handles within several domains dependent on a few at the corners of
the domain. This allows you to stretch all of the domains uniformly by moving the independent
handles, in essence, performing localized "global" morphing.
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Figure 1730: Dependencies
The center global handle is dependent on the two outer global handles. When the highlighted handle on the left is moved (center

frame), the center handle follows along. In the lower frame, the center handle is moved independently.
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Figure 1731: Dependencies
In the model on the left, the three green handles on the top are dependent on the orange handle on the top. The bottom has

similar dependencies. The top and bottom halves of the cross sections are controlled by just two handles. In the model on the

right, all of the green handles are dependent on the orange handle. The entire cross section is controlled by one handle. Note that

the dependencies can extend beyond the 2D domain boundaries.

Figure 1732: Dependencies
An independent handle was created between the two holes and the handles governing the positions of the holes are made

dependent on it. When the independent handle is moved, both holes move with it. Also, each hole can be positioned separately by

moving the dependent handle associated with it.
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Figure 1733: Dependencies used to Reduce Mesh Distortion
Two dependent handles were created on the edges of the part near the center hole. The dependent handles were constrained

along vectors parallel to the sides of the part. When the handle at the hole is moved downward, the dependent handles follow and

reduce mesh distortion by spreading the morph across the entire part instead of only around the hole.

Shapes
Shapes are collections of handle and/or node perturbations from the initial configuration of the FE mesh
before the morph.

When you morph your model, HyperMorph stores the morph internally as a collection of perturbations
which you can then undo or redo. When you create a shape using the save shape subpanel on the
Morph panel or Freehand panels, the handle and/or node perturbations are stored in the new shape
entity along with biasing factors for the handle perturbations and details such as the biasing style.
HyperMorph takes the difference between the initial state of the model and the current state of the
model when creating a new shape. If you save the model using the save each morph step option in
the Shapes panel, each morph on the undo/redo list will be saved as a separate shape. To get to the
current state of the model from the initial state, all of these shapes must be applied. Creating shapes
allows you to generate shape variables for optimization and store model changes for parametric studies.

For many morphing operations, the morph consists only of handle perturbations. However, if constraints
are being used, or the morph is a mapping or radius changing operation, node perturbations are
required to fully describe the shape. In the case of freehand morphing, the morph consists only of node
perturbations. When you create a shape, vectors are drawn for each handle and node perturbation for
the shape. The vectors are drawn the exact length of the perturbation and the vectors for the handle
perturbations are drawn with thicker lines to denote that they are different from node perturbations.

Note:  While shapes with handle perturbations will move nodes when they are applied,
those shapes do not contain node perturbations and thus vectors are not drawn at those
nodes.

When you are saving a shape, you can select whether to save it as:
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as handle perturbations
Save shape as either handle perturbations only, or a combination of handle and node
perturbations if node perturbations are required to describe the shape.
Shapes saved as handle perturbations will differ from shapes that have been saved with changes
to the handle influences.

node perturbations
Save shape as node perturbations only.
Shapes saved as node perturbations are not affected by changes to domains and handles.

Whenever you make a change to your model, HyperMorph will ask you if you want to preserve any
existing shapes saved as handle perturbations by converting them to node perturbations. If you plan
to make changes to domains and handles, you should save shapes as node perturbations. If not, save
shapes as handle perturbations and they will require less memory and disk space. If you later decide
that you want to change a shape from node perturbations to handle perturbations or vice versa you can
do so in the Shapes panel, Convert subpanel.

Once a shape is saved, you can apply it to your model with any given scaling factor. Applying a shape in
this way is like any other morphing operation and can be undone, redone, or saved as part of another
shape.

Convert Saved Shapes
Convert shapes saved with handle perturbations to shapes saved with node perturbations, or vice-
versa.

1. From the Tool page, click HyperMorph module.

2. Click Shapes.

3. Select the Convert subpanel.

4. Select the type of conversion to perform.

5. Select the shapes to be converted.

6. Click convert.

Optimization Setup
Morphing can be used to create shape variables for optimization.

Note:  A shape is not a shape variable, but by adding a desvar which points to the shape, it
becomes a shape variable.

Create Shape Variables for Optimization Runs
Morph your model into the shape of the first shape variable.

1. From the Tool page, click HyperMorph module.

2. Click Morph.

3. Select the Save Shape subpanel.
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4. Save morph shape for each shape variable you want to create.

a) Save your morph as a shape.

b) Click undo all to return to your base model shape.

5. From the Analysis page, click Optimization module.

6. Click Shape.

7. Select multiple desvars.

8. Use the shapes selector to select the shapes for which you want to create shape variables.

9. Click create.

A desvar for each shape is created with the initial value and bounds in the panel. Each desvar is
given a unique name.

10. Animate the shape variables.

a) Click undo morphing if you did not click undo all after saving the last shape.

b) Click animate.

Once you have created shape variables for your shapes, you can set up the rest of your optimization
problem within the optimization module.

Morph Volume Approach
The Morph Volume approach involves surrounding the mesh with one or more morph volumes, which
are highly deformable six-sided prisms.

A number of methods exist to create the morph volumes, including single and matrix creation as well as
the interactive on-screen method. Morph volumes support tangency between adjoining edges and allow
for multiple control points along their edges. Handles placed at the corners and along the edges of the
morph volumes allow for the morphing of the morph volumes which in turn morphs the mesh inside the
morph volumes. The morph volume approach is quick and intuitive and is most useful for making large
scale changes to complex meshes.

Freehand Approach
The Freehand approach involves morphing by moving the nodes directly without the need to create any
HyperMesh morphing entities.

You define the nodes which will move, the nodes which will stay fixed, and the affected elements, which
manually allows for rapid changes to any mesh. You have great flexibility in how the moving nodes are
moved, such as translation, rotation, and projection to geometry as well as using a tool to "sculpt" the
mesh into the desired shape. You are also able to turn node manipulations made in any panel, such as
scaling or node projection, into morphs using the record subpanel. The freehand approach is an ideal
introduction to HyperMorph since it allows morphing without the creation of any HyperMesh morphing
entities while employing the concepts of domains and handles. The freehand approach also allows for
"customized" morphing, allowing you to do virtually any kind of morphing.
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Space Frame Model Strategies using Global
Domains
Space frames are models that have a sparse distribution of elements, such as a car body. Space frame
models can generally have element counts in the hundreds of thousands, but their basic structure is
rather simple.

Often the desired shape changes are general, such as making it smaller, shorter, wider, or altering the
basic positions of components within the frame. In many instances, these changes can be performed by
placing a handle at each joint in the frame and moving those handles to the desired locations. For these
types of models, all that is necessary is to create a global domain and global handles. Local handles are
not required since local changes to the frame components are not necessary. Since local handles and
domains for large models can consume a great deal of resources, you should avoid creating them unless
it is necessary.

Create Handles and Domains for Space Frame Model
Create a global domain and global handles at useful positions throughout the space frame.

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Create subpanel.

4. Set the selector to global domain.

5. Set the toggle to all nodes.

6. Set the toggle to create handles.

7. Click create.
A global domain and global handles are created at useful positions throughout the space frame.

8. If the handles are not where you want them to be, delete the handles and add global handles
elsewhere.

a) Open the Delete panel by pressing F2.

b) Delete unwanted handles.

c) Go to the HyperMorph module, Handles panel, Create subpanel.

d) In the name field, enter a name for the handle.

e) Select an xyz position or any number of nodes where you want global handles.

f) Click create.

A new global handle is created at each node or at the specified xyz location. If more than one handle is
created at a time, the handles will each be given a unique name by appending a number after the name
you have given. You should place global handles both in areas where you want to apply perturbations
and in areas that you want to stay fixed. You can also use morph constraints to fix nodes in place during
global morphing but if you want them to affect the surrounding mesh you must select the stretch mesh
around nodes option when creating the morph constraint. If you want a part of your model to move as a
rigid body, such as a wheel or the engine block, use a cluster type morph constraint.
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Figure 1734: Global Domain and Global Handles for Full Car Model

Exiting any panel in the HyperMorph module or the Delete panel automatically triggers HyperMorph
to refresh the handle influences, if necessary. Adding, editing, or deleting handles, domains, or
symmetries makes it necessary for HyperMorph to refresh the handle influences. For large models or
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large changes, this can be time consuming, so you will want to make all the changes you desire within
each panel before exiting.

Match Mesh, Line, or Surface Data
Move the handles into positions that change the shape of the model to match the mesh or geometry
data. If you are going to match a mesh you need to make sure that the mesh does not get morphed
when you are moving the handles.

This can be accomplished by constraining the nodes on the target mesh.

Constrain Nodes on the Target Mesh
Constrain all of the nodes in the target mesh to remain fixed during morphing operations.

1. From the Tools page, click HyperMorph.

2. Click Morph Constraints.

3. Select the Create/Update subpanel.

4. Select the nodes on the target mesh.

5. Switch the selector to fixed.

6. Clear the stretch mesh around nodes checkbox.

7. Click create.

All the nodes in the target mesh are constrained to remain fixed during morphing operations as
long as the constraint is active and the use constraints checkbox is selected. See the Morph
Options panel.

Note:  If you select the stretch mesh around nodes checkbox, the nodes between
the constrained nodes and the handles will be affected regardless of whether the mesh
is continuous between them.

Morph Interactively
Morph interactively by moving the handle and releasing the mouse button.

One of the most enjoyable ways to morph is interactively. As you drag a handle across the screen and
you can watch the mesh move along with it. For large models it may be too slow to morph interactively
in real time, but you can still morph interactively with any size model by setting HyperMorph to perform
the morphing after you move the handle and release the mouse button.

You can also select other features to drag the handle along such as a line, a plane, or a surface.
HyperMorph uses the position of the mouse on the screen to figure out where you want to move the
handle. You can use this feature to position a handle anywhere you want line or surface data.

1. From the Tools page, click HyperMorph.

2. Click Morph.
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3. Select the move handles subpanel.

4. Change the upper middle selector to interactive.

5. Change the rightmost toggle from real time to on release.

6. Change the lower middle selector from on domains to along vector.
7. Select a vector.

8. Morph.

a) Click morph.

b) Select a handle on the screen and hold the mouse button down.

c) Move the handle to the new location and release the mouse button.

As you drag the mouse, the handle follows along the selected vector. Since on release was
selected, only the graphics for the handle are updated, which leaves a dark trail through the
mesh. When you release the mouse button, the morph is applied to the model and the graphics
are updated for the entire model. If the handle position needs to be changed again, repeat step 8.
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Tip:  To save time, move more than one handle at the same time by selecting several
handles before performing step 8. When you release the mouse, all of the selected handles
are moved the same distance in the same direction.

Figure 1735: Morph to Profile Line
In the top frame, the global handles on either side of top of the windshield are selected. In the middle frame they 

are interactively moved upwards along a vector to a point matching with the profile line. In the bottom frame the 

process has been repeated for the other handles on the roof. The result is a morphed vehicle model that closely 

matches the profile line.

Figure 1736: Morph to Profile Line
A handle is added to the center of the rear windshield and is moved to better match the profile line. Handles may

always be added or deleted from a model without affecting the current morphed state of the model. However, any

shapes saved as handle perturbations may not yield the same morphed shape after handles have been added or

deleted. If you intend to add or delete handles in your model, save your shapes as node perturbations. HyperMorph

will give you the option of converting existing shapes from handle perturbations to node perturbations automatically

after you add, edit, or delete any morphing entities.

Match Target Mesh or Geometric Data
Match target mesh or geometric data by moving the handles to a specified node location.

1. From the Tools page, click HyperMorph.
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2. Click Morph.

3. Select the move handles subpanel.

4. Change the upper middle selector from interactive to move to node.

5. Select a handle.

6. Select a node.

The handle is moved to the position where the node was prior to morphing and the rest of the mesh
morphs accordingly.

Create Nodes on the Fly
Create nodes on the fly on lines and surfaces.

1. From the Tools page, click HyperMorph.

2. Click Morph.

3. Hold the mouse button down and drag the mouse over a line or surface until it is highlighted.

4. Click on the line or surface where you want the node.

A node will be created and the handle will immediately be moved to the node.

Make Parametric Changes
Dimensions such as distance and angle can be changed easily in HyperMorph.

Translate/Rotate Handles

1. From the Tools page, click HyperMorph.

2. Click Morph.

3. Select the Move Handles subpanel.

4. Translate the handles.

a) Change the upper middle selector from move to node to translate.

b) Use the handles selector to select handles.

c) Select a vector and distance.

a) Select the desired xyz translation.

b) Click translate.
The handles move the specified distance in the specified direction and the model morphs
accordingly.

5. Rotate the handles.

a) Change the upper middle selector from translate to rotate.

b) Use the handles selector to select handles.

c) Select an axis of rotation.

d) Set the rotation angle.
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e) Click rotate.
The handles rotate about the axis the specified angle and the model morph accordingly.

6. Specify dimensions more precisely

a) Select the Alter Dimensions subpanel.

b) Set the upper left selector to distance.

c) Change the middle left selector to nodes and handles.

d) Select node a and node b at nodes whose distance you want to change

e) Select follower handles for node a that are near node a.

f) Select follower handles for node b that are near node b.

g) Change the distance value.

h) Click morph.
HyperMorph moves the follower handles for node a as a group and the follower handles
for node b as a group either towards each other or away from each other so that the new
distance between node a and node b is equal to the specified distance. If the left selector is
set to hold end a, node a will not move, same for node b. If the left selector is set to hold
middle, both node a and node b will move the same distance.
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Figure 1737: Morph by Altering Distance between Two Nodes
The width of the car is found by placing node a (green dot) on the right hand door and node b (blue dot) on the left

hand door. The handles on the right side of the model are selected as followers for node a and the handles on the

left side of the model are selected as followers for node b. The distance is changed and the model morphs.

Change Angles

1. From the Tools page, click HyperMorph.

2. Click Morph.

3. Select the Alter Dimensions subpanel.

4. Set the upper left selector to angle.

5. Change the middle left selector to nodes and handles.

6. Select node a, vertex, and node b at nodes whose angle you want to change.

7. Select follower handles for node a that are near node a.

8. Select follower handles for node b that are near node b.
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9. Change the angle value.

10. Click morph.
HyperMorph moves the follower handles for each end in a way so that the new angle between
node a, the vertex, and node b are the specified angle. If necessary, HyperMorph will iterate to
achieve the desired angle, or at least get close. If node a and node b are selected coincident with
one of the follower handles, iteratation is not necessary.

Figure 1738: Morph by Altering Angle Formed by Three Nodes
The slope of the windshield is altered by defining an angle using three nodes, green, blue, and red, selecting two handles

at the front of the car as followers for node a (green), and selecting two handles on either side of the windshield as

followers for node b (red node). The angle is changed from 160 degrees to 150 degrees. Note that the handles on either

side of the windshield were constrained to move along the x-axis (front to back) thus maintaining the height of the roof.

Global Morphing with Handle Placement
Global morphing differs from local morphing in that there are no definite boundaries between the
handles that restrict their zones of influence. When you perform global morphing operations, the parts
of the model that are morphed are those that lie between the handles that are moving and those that
are not.

For the general space frame cases, positioning handles at the joints between the members of the space
frame restricts the handle influences to the parts of the frame that they are touching. However, for
cases where you are trying to morph a mesh that covers a wide area, you will need to place several
handles across both of sides of the zone of influence.
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You can visualize the handles as places on a sheet of rubber where you are placing your fingers. If you
place three fingers on one side and two on the other and try to stretch the sheet, the space between
your fingers on the two finger side will be pulled towards the three finger side. By placing three fingers
on each side, you allow for even stretching to occur between each set of fingers. In morphing this is
accomplished by placing handles evenly along both sides of the mesh to be stretched.

Figure 1739: Control Global Morphing with Handles
The handle on the roof is moved upwards and the center section of the car is morphed along with it.
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Figure 1740: Control Global Morphing with Handles
A handle is added directly below the handle on the roof near the center of the car. Now when the handle on the roof is moved

upwards, only the part of the car between the roof and the handles along the midline of the car is stretched.
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Figure 1741: Add Handles to Control Global Morphing
Using several handles on either side, the fender of the model is morphed. Note that dependent handles are used to simplify the

morphing operation. Also note that in cases where detailed shape changes are required, morph volumes will usually yield better

results.

Mirror Images using 1 Plane Symmetry
If your space frame is symmetric, you can create a plane of symmetry at the center of your space
frame and have your morphs applied in a symmetric fashion.

1. From the Tools page, click HyperMorph.

2. Click Systems.

3. Create a system at a node where the plane of symmetry is to be located and have the x-axis
pointing normal to the plane to be created.

4. Click return to go to the HyperMorph module.

5. Click Symmetry.

6. In the name field, enter a name.

7. Select the global domain icon.

8. Switch the selector from none to 1 plane.

9. Select the system you created.

10. Select x-axis as the axis to align the symmetry.
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11. Change the left toggle from approximate to enforced.

12. Click create.

A plane of symmetry is created at the origin of the system and based perpendicular to the x-axis. The
icon for a 1-plane symmetry is a rectangle positioned like a small mirror for the symmetry system.
HyperMorph also links any handles that it finds that are reflections of the other. Since enforced was
selected, HyperMorph creates new handles that are reflections of ones that are not linked to any others
and creates a symmetric link between them. When handles are created or deleted, the enforced option
will automatically create or delete handles on the other side of the symmetric link in order to enforce
symmetry of the handles.

The mesh itself does not need to be symmetric to use the symmetry options. The symmetry will be
applied to the handles and handle perturbations that will influence the mesh in a symmetric fashion.
If you want to add handles to one side of the plane of symmetry and not the other, yet still have
symmetry active for the symmetric handles, use the approximate option instead.

Figure 1742: System and 1-Plane Symmetry
The plane of symmetry is positioned at the origin of the system and perpendicular to the x-axis. The perturbations applied to

handles on one side of the plane of symmetry will be mirrored on to the other side.

Now when you perform a morphing operation you only need to move the handles on one side of the
plane of symmetry. If you have the symmetry links checkbox activated, HyperMorph automatically
applies the handle movements to the handles on the other side of the plane of symmetry through the
symmetry link. As a result, the model maintains symmetry across the symmetry plane.
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Figure 1743: Using 1-Plane Symmetry
Three handles on the right hand side of the roof are selected and moved towards the centerline. HyperMorph automatically moves

the corresponding nodes on the left hand side of the roof in a symmetric fashion.

Reduce 3D to 2D using Linear Symmetry
Use linear symmetry to apply morphs to the model in such a way that the model is essentially reduced
to two dimensions.

1. From the Tools page, click HyperMorph.

2. Click Systems.

3. Create a system with the x-axis pointing along the dimension to be reduced.

4. Click return to go to the HyperMorph module.

5. Click Symmetry.

6. Select the create subpanel.

7. In the name field, enter a name.

8. Select the global domain icon.

9. Switch the selector from 1 plane to linear.
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10. Select the system you created.

11. Select x-axis as the axis to align the symmetry.

12. Click create.

A linear symmetry is created along the x-axis of the system. The icon for a linear symmetry consists of
two parallel lines along the dimension to be reduced. The origin of the system is irrelevant. Now each
handle acts on the mesh as if it were a line extending along the system x-axis. If two handles lie along
a line parallel to the system x-axis, they will be linked through symmetry. When you move a handle, all
the nodes and handles with the same y and z coordinates will move along with it.
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Note:  Since linear is a non-reflective type of symmetry, leaving symlinks unchecked will not
prevent the handles from having linear influences. However, it will stop movements from one
handle from being applied to others that are linked via the symmetry. If you wish to turn
the symmetry off for a given morphing operation, make the symmetry inactive in the Morph
Options panel.

Figure 1744: System and Linear Symmetry
The linear symmetry icon consists of two parallel lines along the system x-axis. Note that the placement of a linear 

symmetry system does not matter, the effect of the linear symmetry system is determined only by the direction of 

the x-axis.

Applying a linear symmetry is very useful for making profile changes to a space frame 
model. It does not matter where the handles are placed along the x-axis, greatly simplifying 
the model set up. You only need to look at the model from one view to set up the handles 
and to morph the model. For models with a large number of elements this can save a great 
deal of time.

Figure 1745: Using Linear Symmetry
The handle on the rear part of the roof is selected and the entire rear portion of the roof is morphed along with it.

With linear symmetry you only need to place handles on one side of the model to affect the entire profile.

Reduce 3D to 1D using Planar Symmetry
Planar symmetry is similar to linear symmetry accept that it reduces two dimensions instead of one.
This enables you to morph your model along a single axis with only two or more handles.

1. From the Tools page, click HyperMorph.
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2. Click Systems.

3. Create a system with the x-axis pointing along the dimension to be retained.

4. Click return to go to the HyperMorph module.

5. Click Symmetry.

6. Select the create subpanel.

7. In the name field, enter a name.

8. Select the global domain icon.

9. Switch the selector from linear to planar.
10. Select the system you created.

11. Select the x-axis as the axis to align the symmetry.

12. Click create.

13. Click return to go to the HyperMorph module.

14. Click Symmetry.

15. Select the update by domain subpanel.

16. Select the global domain.

17. Select the planar symmetry.

18. Click update.

A planar symmetry is created and the other two symmetries from the global domain are removed.
You are allowed to have any number of symmetries associated with a domain and all will apply, but
combining linear and planar symmetry in the same direction results in an unrealistic situation and poor
influence calculations.

The planar symmetry icon is displayed as a filled-in rectangle perpendicular to the system x-axis. Now
each handle acts on the mesh as if it were a plane perpendicular to the x-axis. If two handles lie in
a plane perpendicular to the system x-axis, they will be linked through symmetry. When you move a
handle, all the nodes and handles with the same x coordinates will move along with it.
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Note:  Since planar is a non-reflective type of symmetry, leaving symlinks unchecked will
not prevent the handles from having linear influences. However, it will stop movements from
one handle from being applied to others. If you wish to turn the symmetry off for a given
morphing operation, make the symmetry inactive in the Morph Options panel.

Figure 1746: System and Planar symmetry
The planar symmetry icon is a plane perpendicular to the system x-axis. Note that the placement of a planar 

symmetry system does not matter, the effect of the planar symmetry system is determined only by the direction of 

the x-axis.

Applying a planar symmetry greatly simplifies a model. Essentially, it reduces the model to a 
lying along single axis. This symmetry type is very useful for changing dimensions along one 
axis through the entire model.

Figure 1747: Using Planar Symmetry
The handle at the rear of the model is selected and the entire trunk of the car is morphed. With planar symmetry

you only need a row of handles lying roughly along the planar symmetry system x-axis.
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Shell Model Strategies using Local Domains
Shell models are models that are made up primarily of shell elements, namely, quads, and trias. In
general, a shell model represents many parts, each with numerous features such as holes and edges,
and connected together using 1D elements such as bars and rigids.

HyperMorph is designed to make it easy to change the size and shapes of the shell model features. This
is done using one of the following methods:

• Moving the handles on the part to new locations

• Moving the global handles around the parts to new locations

• Altering the radius or curvature of curved edges of the parts, or mapping the nodes of a part to line
or surface data

For most models you only need to create 2D domains for the entire part, but you can also add a global
domain and global handles for shape alterations of a general nature.

Manage Handles and Domains for Shell Models
Create handles and domains, divide your shell model, and group, split, merge domains.

Create Handles and Domains for Shell Models

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the create subpanel.

4. Set the selector to 2D domains.

5. Change the toggle to all elements or select all the elements in the model.

6. Click create.
A 2D domain is created for each group of continuous shell elements. Parts joined by 1D or 3D
elements are separated into different domains. If partition domains is checked, the 2D domains
will be partitioned according to the settings selected in the partitioning subpanel of the Domains
panel. Once partitioned, edge domains are placed around the 2D domains and handles are
placed at the ends of the edge domains. All of this is automatic, but 1D and 3D elements will
not be placed into 1D and 3D domains unless you set the selector to local domains instead of 2D
domains. In many cases, the domains and handles will be generated where you want them to be.
If not you can always add, edit, or delete the handles and domains to meet your needs.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Morphing p.2833

Figure 1748: Shell Model Partitioned into 2D Domains

7. If you wish to generate a global domain as well as local domains for your model with a single
button click, either change the selector to global and local and click create, or to auto
functions and click generate.

In the case of the generate auto function, if there are any domains or handles in the model,
HyperMorph will first ask if you want to delete all the current morphing entities. If you say "yes",
or if there are no morphing entities in the model, HyperMorph automatically generates 1D, 2D,
3D, and edge domains for the entire model and a global domain and handles as well.

For tria meshes which lack underlying geometry, both the node-based and element based
partitioning algorithms may prove unsatisfactory. In these cases you may find it more effective
to ignore curvature when partitioning. To accomplish this, go to the partitioning subpanel, select
element based as the algorithm for tria/tetra meshes, and change the uppermost toggle from
curvature based to angle based. You may also want to lower the domain angle to 30 degrees.
HyperMorph will then only make partitions along edges in the model where the domain angle
is exceeded. You can then go in and manually divide the 2D domains where the curvature
breaks should go. This method is almost mandatory for meshes that began as first order meshes
but were transformed into second order meshes. For these meshes, HyperMorph will detect a
curvature break at every element along a curve if the midpoint nodes of the elements have not
been modified to capture the curvature. The result will be a domain for every element on a curve
which makes morphing impractical.

Solving the influence coefficients for 2D domains which contain more than 20,000 elements
can become very time consuming even though it is only done after domain editing and during
morphing operations such as radius change and map to geom. In these cases you may want to
divide the large domains into multiple domains or lower the limit for the large domain solver.
The large domain solver limit can be found in the global subpanel of the Morph Options panel.
However, even though influence calculations for large domains are more rapid, morphing using the
large domain solver can be time consuming, and thus subdividing 2D domains can often be the
best solution for efficient morphing.

Divide Shell Model

1. From the Tools page, click HyperMorph.

2. Click Domains.
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3. Select the create subpanel.

4. Set the selector to 2D domains.

5. Select the elements to be placed into a new 2D domain.

6. Click create.

When selecting the elements for the new domain you do not need to select only shell elements.
HyperMorph automatically removes any other elements before creating the domain. It does not matter
if the elements selected are already in a 2D domain. When the new domain is created, the elements are
moved from the old domains to the new domain.

Handle influences need to be recalculated every time handles, domains, or symmetries are added,
edited, or deleted. They are also recalculated during radius changes and geometry mapping. These
calculations occur when you enter or leave any HyperMorph panel or when you leave the Delete panel.
Thus, for models with large domains you will want to make all of your domain changes before exiting
the Domains panel. HyperMorph only recalculates the handle influences for handles in regions that have
been edited.

If the domains are not created exactly how you want them to be, you can edit them in the Domains
panel. The create subpanel allows you to create new domains. The organize subpanel allows you to edit
domains by adding and removing elements to or from a domain and by grouping domains together. The
edit edges subpanel allows you to split, merge, and place handles along edge domains. It is suggested
that you create and edit all the 2D domains, then create and edit the edge domains. This order works
better since creating or editing 2D domains will result in the regeneration of the surrounding edge
domains with the previous modifications to those edge domains being discarded.

Sometimes partitioning does not divide the mesh in the ways that would be most useful to you.
Occasionally, elements end up in domains adjacent to where you want them or placed in their own
domain. Partitioning is not an exact science, so some cleanup is sometimes required.

Organize Elements in Domains
Move elements from one domain to another.

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the organize subpanel.

4. Change the selector to add nodes/elems.

5. Change the toggle to local domain.

6. Select the elements to be moved.

7. Select the target domain.

8. Click organize.

Elements are moved from the domain that they are currently in to the selected domain. HyperMorph
also refreshes the edge domains around both domains as well as the edge domains at the interface.
New handles may also be created during this process, and if retain handles is not checked, handles may
be deleted. It is suggested that you keep retain handles unchecked unless you have created shapes for
the model that use the handles on the domains that you are editing.
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Figure 1749: Partitioning Problems
The model on the left shows problems that partitioning can encounter for some meshes. The model on the right has been

corrected using the organize subpanel of the domains panel. For this example the retain handles option was left unchecked

resulting in the elimination of handles that are no longer on the corners of the 2D domains. Note that the edge domains are

always partitioned for any new domain and handles are placed at the end of the edge domains. For the example above, a handle

was created in a new location due to the edge partitioning being different for the two domain configurations.

When you hold the mouse button down and the mouse is either over the icon for a 2D domain or over
an element inside a domain, the edge domains surrounding the domain are highlighted as well. This
allows you to better visualize the domain that you are selecting. The domain icon is placed at the
centroid of the domain, and some domains can end up away from the elements of the domain and near
other domain icons. Having the edges for the domain highlighted during selection is often necessary to
tell which icon goes with which group of elements.

Group Domains
Group two or more domains together.

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the organize subpanel.

4. Change the selector to combine domains.

5. Select the domains to be grouped together.

6. Click organize.

The selected domains are combined into a single domain and the surrounding domains and handles are
updated.
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Figure 1750: Two Domains Organized into One

Edge domains are automatically partitioned when they are created. They are also updated whenever a
change occurs for a domain of which they are on the edge. This is why any editing of the edge domains
should come after the editing of the other domains. If you do your edge editing first, your changes may
be erased when you edit the 2D domains.

Edge domains are used to make radius changes, so it is important to make sure that any radius in the
model that you intend to change be captured correctly by edge domains. HyperMorph tries to partition
edge domains where curvature begins and ends, but in some cases it may not identify the proper
starting and ending points. You may need to correct this by hand.

Split Edge Domains

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Edit Edges subpanel.

4. Change the selector to split.
5. Select an edge domain.

6. Select a node on that domain that is not on the edge.

7. Click split.
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The selected edge domain is split into two edge domains at the selected node. A handle is created at
the selected node.

Figure 1751: Splitting an Edge Domain
A circular edge domain is divided into two half circles. A handle was created at the joint to allow you to manipulate the edges.

Merge Edge Domains

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Edit Edges subpanel.

4. Change the selector to merge.

5. Select any number of connected edge domains.

6. Click merge.

The two edge domains are merged into one edge domain. This function only allows you to merge edge
domains that lie end to end such that the resultant edge domain is a continuous series of nodes.

Note:  You can also merge edge domains in the organize subpanel.
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Figure 1752: Merge Two Edge Domains
The two half circles are merged into a single domain. Since retain handles was unchecked, the handle at the joint was deleted.

You may also create dependent handles along an edge domain. This feature is quite useful for saving
time when you are changing the radius for the edge domain. If the domain containing the radius to be
changed is very large you may find it more efficient to place dependent handles on the edge domains
whose radii you wish the change before you go into the Morph panel.

Create Dependent Handles along Edge Domains
Create dependent handles on edge domains whose radii you wish the change.

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Edit Edges subpanel.

4. Change the selector to add handles.

5. Select the domain(s).

6. Click create.

The dependent handles are created on the selected edge domains. These handles are dependent
on the independent handles to either side of them along the edge domain.
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Figure 1753: Create Handles on Edge Domain
A dependent handle is created on each node of the edge domain.

Creating dependent handles in this way has two significant effects. The first is that since they
are dependent, movements applied to any of the independent handles on the edge will be
transparently applied to the dependent handles. It will be as if they were not there. Secondly,
when you make a radius change to an edge domain that has a handle at each of its nodes, the
influences do not need to be recalculated, which makes the radius change process much faster for
large models.

7. When you are satisfied with your domains, click return.
HyperMorph calculates the influences for the handles and you are ready to begin morphing.
During influence calculation you might run out of available memory. This generally happens when
a given domain is too large and it contains too many handles. In these cases you should divide
large domains, delete unnecessary handles, or lower the limit of the large domain solver.

Local Domains Moprhing
You can change the shape of a model with local domains and handles.

Moprhing can be accomplished using one or more of the following methods:

• Moving the local handles

• Changing a distance or angle

• Changing the radius, curvature, or arc angle of an edge domain

• Mapping nodes to a line, plane, surface, or mesh

• Using section mapping, line and surface difference, and element offset

• Using freehand morphing capabilities such as move nodes, record, and sculpting

You can move handles in the Morph panel, Move Handles subpanel using the following options:
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interactive
Move handles interactively by dragging the mouse across the screen. You select an entity such as
a vector, line, plane, surface, or domains, to orient the mouse location in 3D space, and move a
handle by clicking on it and dragging it to a new location. Interactive morphing is most effective
for visualizing how the mesh will react when a handle is moved and for making approximate
shape changes. If you want to move a handle a specific distance or to a specific position, it is
better to use a non-interactive option.

translate
Translate handles along a vector or element normals.

rotate
Rotate handles about an axis.

move to XYZ
Position handles at specific XYZ locations or place them on lines, surfaces, or another mesh.

move to node, move to point
Position handles at specific node or point locations, or place them on lines, surfaces, or another
mesh.
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Figure 1754: Morph by Translating Handles along Edge
By selecting the two handles along the edge of the flange and translating them along a vector defined at the end of the section

(green and blue nodes), the length of the flange is reduced.
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Figure 1755: Morph by Translating Handles along Vector
By selecting the three handles and translating them along a vector defined at the end of the section, the width of the channel is

increased.

Figure 1756: Morph by Translating Handles at Bottom of Part
By selecting the handles at the bottom of the part and translating them upwards, the thickness of the lower section is reduced.
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Figure 1757: Morph by Translating Handles around Bolt Boss
By selecting all the handles around the bolt boss and translating them horizontally, the position of the bolt boss is modified.

Figure 1758: Morph by Rotating Handles at End of Section - Constant
By selecting all the handles at the end of the section and rotating them about a point (violet node), the end angle of the section is

modified.
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Figure 1759: Morph by Rotating Handles at Right End of Block - Constant
The right end of the block is given a constant rotation.

Figure 1760: Morph by Rotating Handles for Entire Block - Linear
The entire block is given a linear rotation. Note how the magnitude of the twist increases linearly with the distance from the base

(purple) node.

When applying handle perturbations to your model, it is important to note that the nodes in the model
follow the movements of the handles according to the influence coefficients. This concept comes into
play when you are using the rotate function. After rotating handles you may find areas in the model,
particularly those defined by curved edges, that are not rotated the same as the neighboring handles.
This is because the nodes have followed the handles instead of being rotated about the axis. To correct
this situation, select the true rotation checkbox. This will cause the nodes to be rotated as well as
the handles with the amount of rotation being equal to the influence coefficient. Although it could be
argued that true rotation is the "correct" way to morph via rotation of the handles, not all morphing
applications are best done using true rotation.
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Figure 1761: Morph by Rotation Handles - Normal
Although the highlighted handles are rotated, the circle at the center of the model remains on the same plane as before.

Figure 1762: Morph by Rotating Handles - True Rotation
During "true rotation" the nodes rotate along with the handles.

While morphing a model, the following message may be displayed: "Some handles selected are
dependent on others. Would you like to ignore dependencies for this operation?". This occurs when
both a dependent handle and the handle on which it is dependent are selected to be morphed. If you
click yes the given perturbation is applied to each handle and the dependent handles are not given an
additional perturbation inherited from another handle. If you click no, the given perturbation and any
inherited perturbation is applied to each dependent node. For most cases you will want to click yes.

The Morph panel, Alter Dimensions subpanel allows you to change one of the parameters in the model,
such as the distance between nodes, the angle between nodes, or the radius or curvature of an edge
domain. The basic concept is as follows:

• Select two nodes (node a and node b).

• Select handles corresponding to those nodes.
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The handles selected are the ones that will move to make the distance between node a and node b, or
angle with a vertex selected, equal the specified value. You must select at least one handle for each
end and the handle may be coincident with one of the nodes. For solid models, controlling a particular
dimension often involves moving more than one handle for each end.

Figure 1763: Morph by Altering Dimensions using Channel's Bottom Width - Distance
By selecting the width of the bottom of the channel as the desired distance to alter (green and blue nodes) and by selecting the

handles on the left (highlighted) to follow the green node and the handles on the right (shown as gray) to follow the blue node,

the width of the bottom of the channel can be changed from 60 to 30 with the rest of the channel changing along with it.
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Figure 1764: Morph by Altering Dimensions using Block Thickness - Distance
By selecting the thickness of the block as the desired distance to alter (green and blue nodes) and by selecting the handles on

the radius (shown as gray) to follow the green node and the handles on the back face (highlighted) to follow the blue node, the

thickness of the block between the radius and the back face is altered from 15 to 25 by moving the entire back face.

Figure 1765: Morph by Altering Dimensions using Angle of Channel's Left Side - Angle
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By selecting the angle of the left side of the channel (green, blue, and red nodes) and by selecting the handle at the bottom right

of the channel (shown as gray) to follow the green node and the handle at the red node (highlighted) to follow the red node, the

angle of the left side of the section is changed from 110 degrees to 90 degrees.

Figure 1766: Morph by Altering Dimensions using Angle between Two Faces of Block - Angle
By selecting the angle between two faces of the block (green, blue, and red nodes) and by selecting the handles at and directly

below the green node (shown as gray) to follow the green node and the handles at, near, and below the red node (highlighted) to

follow the red node, the angle is altered from 126 degrees to 90 degrees.

The radius, curvature, and arc angle options are used as follows. You select any number of curved
edge or 2D domains, select the center calculation and style options, set the new radius,
curvature multiplication, or arc angle factor for them, and click morph. All the domains are changed
simultaneously.

Note:  The curvature tool scales your radius by a factor rather than a set radius, so if
you want to change a radius from 5.0 to 8.0, you need to set the curve ratio to 1.6. The
curvature tool is intended for domains that do not have constant curvature. Making the bias
factor retroactive does not work for radius changes.

Figure 1767: Morph by Altering Dimensions - Radius and Center
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By selecting the edge domain around the edge of the hole, the radius is changed from 3 to 1.5.

Figure 1768: Morph by Altering Dimensions - Radius and Fillet
By selecting the edge domain at the corner of the part and selecting the fillet option, the radius is changed from 5 to 2.5 and kept

in line with the edges at either end.

Figure 1769: Morph by Altering Dimensions - Radius and Hold Ends
By selecting the edge domain at the corner of the part and selecting the hold ends option, the radius is changed from 5 to 10 with

the ends held in place.
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Figure 1770: Morph by Altering Dimensions - Radius and Hold End
By selecting the edge domain at the corner of the part, selecting the hold end option, and selecting a node at the end of the edge

domain, the radius is changed from 5 to 8 while the held end remains in place.

Figure 1771: Morph by Altering Dimensions - Radius and Fillet
By selecting all of the edge domains that form the fillet between the flat sections and the round section and changing them

simultaneously, the fillet is reduced from 20 to 8.
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Figure 1772: Morph by Altering Dimensions - Radius
The radius is changed in three different ways. At the top right, the hold center option is used. At the lower left, the hold ends

option is used. At the lower right, the fillet option is used. In all cases, both the top and bottom edge domains were selected as

well as the 2D domain and the by normals option was used for center calculation. This option will directly calculate the radii for

the nodes on the 2D domain instead of inferring them from the edge domains which makes this approach more accurate for 2D

domains as well as more reliable for non-uniform meshes.

Figure 1773: Morph by Altering Dimensions - Arc Angle
The arc angle of the mesh is changed from 60 to 90 degrees using by axis (the vertical axis and violet base node) to calculate the

center of curvature.
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Figure 1774: Morph by Altering Dimensions - Arc Angle
The arc angle of the fillet is changed from 90 to 180 degrees using by normals to calculate the center of curvature.

Methods available for calculating the center of curvature for the selected domains include:

by normals (Default)
Uses the element normals to approximate where the center of curvature is for each node in the
selected domains. This method is not always accurate, but often gives good results for regular
meshes.

by axis
you may select an axis which will serve as the center of curvature.

by line
You may select a line which will serve as the center of curvature.

by node
You may select a node which will serve as the center of curvature.

by edges
Uses the edge domains to calculate the center of curvature with the center lying in the plane
of the edge domains. The symmetry option refers to how the morphing of the edge domains is
applied to neighboring 2D domains. The auto-symmetry option was the default for HyperMorph
prior to version 8.0. In 8.0 you may choose to turn off symmetry when using this option.

For auto-symmetry, the changes in the radii of the edge domains are applied to any 2D domain,
depending on the number of edge domains you change for the 2D domains. If you change only
one edge domain for a given 2D domain, the radius change will not be applied linearly across the
2D domain. If you change the radii of two edges for any given 2D domain, either a linear or planar
temporary symmetry is created between the two edge domains for the 2D domain that will apply radius
changes more linearly across the 2D domain. This works best if the mesh is regular. If you are changing
only one edge for a 2D domain, you can increase the bias factor of any handles on an edge domain to
yield a more even distribution.

Mapping an edge domain to a line or a 2D mesh to a plane, surface, or mesh is done using the Map
to Geom panel. This option is very effective for fitting a mesh to new geometric data. When mapping
a domain to a geometric feature, all the nodes in neighboring domains are stretched along with it,
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minimizing mesh distortion. You have several options for determining how the nodes for the mapped
domain are placed on the geometry. When mapping an edge domain or node list the nodes can be
moved normal to the line, along a vector to the line, or distributed along the full length of the line.
When mapping a 2D domain or selection of nodes to a plane, surface, or mesh, the nodes can be
moved normal to the target, normal to the elements of the 2D domain or selected nodes, or along a
vector. If you wish to fit a mesh to a surface, there is no option to do this automatically, however, with
multiple mapping operations, or using the user control option you can fit a 2D domain to a surface.

Furthermore, you have the option of creating a morph constraint between the nodes and the map target
automatically after mapping. This constraint will allow you to do further morphing operations while
maintaining the constrained nodes on the geometry.

The map to geom panel is also effective for solid model meshing. You can create a block of solid
elements roughly in the shape of the geometry that you are trying to mesh, and then use map to
surface to morph the faces of the block to the geometry.

Figure 1775: Morph by Mapping to Line - Automap and Normal to Geom
The edge domain is mapped to a line by moving the nodes normal to the line.

Figure 1776: Morph by Mapping to Line - Automap and Fit to Line
The edge domain is mapped to the line by fitting them along the line. Any proportional spacing between the nodes will be

maintained after mapping.
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Figure 1777: Morph by Mapping to Surface
By selecting the 2D domain on the top of the solid block to be mapped to the surface, the entire solid block is morphed to match

the surface.

Figure 1778: Morph by Mapping to Surface
A rectangular C-section is mapped to a curved surface.
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Figure 1779: Morph by Mapping to Surface - User Control Approach
The surface and 2D domain are selected and the user control button is clicked. This brings up a new panel which allows you to

place handles or map edges prior to the surface mapping operation. One by one each edge domain is placed on one of the lines

around the target surface using the fit to line option. This stretches the 2D domain to match the surface more closely than before.

When the map button is clicked, the domain is the mapped to the surface, fitting it perfectly to the geometry.

Global Handles Morphing
Global handles are most effective when used to make general shape changes for a model, such as
changing the basic shape of a model, stretching parts of a model, or making changes that involve the
movement of many local handles.

There are three methods available for affecting the way global handles influence the model, the direct
method, the hierarchical method and the mixed method. The default is the direct method, where
the global handles move the nodes directly. In the hierarchical method, the global handles move the
local handles which in turn move the nodes, but if any nodes lie outside of local domains they will be
unaffected. In the mixed method, the hierarchical method is used for all nodes in local domains and
the direct method is used for all other nodes. The hierarchical method maintains the shape of edge
domains in the model, but if local handles are not evenly placed throughout the model, some parts
will become distorted. The direct method gives you what you expect but often distorts the shape of
the edge domains. For shell and solid models, better morphing is more likely to occur if you use the
hierarchical method, and place local handles in areas where there is distortion.
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Morph Constraints
Morph constraints are a powerful tool that can be used to restrict the movement of nodes during
morphing operations.

The following types of constraints can be applied to any node: fixed, cluster, along vector, on plane,
along line, on surface, and on elements. Whenever a handle is moved that influences a node which
is constrained, the node is moved according to the handle perturbation and is then projected back
onto the feature to which it is constrained. This allows the nodes to slide across vectors, lines, planes,
surfaces, and meshes, to remain fixed when handles are moved, or to move as a cluster along with
other nodes. You may also constrain nodes where handles are located which, in effect, constrains the
handles. When a perturbation is applied to a constrained handle, the handle are moved along the
constraint feature regardless of the applied perturbation. This means that if you apply a translation in
the x direction on a handle that is constrained along a vector x - y = 0, the handle moves along both
the x and y axes.

There are also morph constraints that can be applied to domains, such as the smooth constraint, which
applies spline-based smoothing along the constrained edge domains, and model constraints, which
allow you to set a given parametric target, such as length, angle and mass, and have HyperMorph
adjust the model to meet that target. These constraints as well as bounded and set distance options for
the node constraints are described more fully in the panel help.

Morph constraints can be very useful for morphing a mesh that has been mapped to, projected to, or
created upon a surface. Note that the map to geom operation allows you to have a morph constraint
automatically created after mapping. Once you have done so, the nodes will remain on the surface
during morphing operations.

Note:  Although morph constraints can keep nodes on a curved line or surface during
morphing operations, when morphs are saved as shapes and then turned into shape
variables for optimization, the nodes will not stay on the line or surface during optimization.
This is because optimization is a linear process and the shapes will be treated as linear,
meaning that the nodes will move directly from their original point to their maximally
perturbed point without moving along any constraint.
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Figure 1780: Control Handle Positions with Morph Constraints
The angle of the lower right corner is changed from 74 to 90 degrees using the alter dimensions (angle) operation. The middle

frame shows the result with no constraints. The frame on the right shows the result with the node in the upper right corner

constrained to move along a vector that lies along the top edge.

Figure 1781: Nodes Tracking a Line During Morphing
The nodes along the right edge domain are constrained to the line. When the handle is moved, it and the other constrained nodes

move along the line.
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Figure 1782: Morph after Mapping to Surface
All mapped nodes are automatically constrained to the surface. When the handles are translated, the nodes are moved along the

surface a distance corresponding to the applied handle perturbations. If the handles were also part of the map to geom operation,

they too will be moved along the surface regardless of the applied perturbation. In this example, the handles were translated

linearly. HyperMorph automatically placed the handles back on the surfaces after applying the translation so that the constraint

was obeyed.

Biasing
Biasing allows you to control the shape of a mesh when applying handle perturbations.

Biasing increases or decreases the influence of a handle over the nodes within its area of influence. If
the biasing values for all of the handles are equal to 1.000, which is the default value for all handles
except for dependent handles on 1D domains, the morphing between the handles is linear, provided
both handles are global handles or they are located on edge domains. Higher biasing values generate a
smooth curvature near the handles, while lower biasing values generate harsh corners near the handles.
To smoothly change the shape of a domain it is recommended that you use a biasing factor of 1.000 at
the corners, 2.000 at the edges, and 3.000 in the middle.
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Figure 1783: Biasing for a 2D Domain
The model at the upper left has all five handles with the default biasing value of 1.000. The model at the upper right shows the

four corner handles with a biasing value of 1.000, and the mid-edge handle with a biasing value of 2.000. The model at the lower

left has all five handles with the default biasing value of 2.000. The model at the upper right shows the four corner handles with a

biasing value of 1.000 and the mid-edge handle with a biasing value of 0.500.

Figure 1784: Biasing to Reduce Mesh Distortion
When the hole is moved downward with a biasing factor of 1.000 for the handle at the hole, the mesh folds over due to the

influences of the other handles (middle frame). When the biasing value of the handle at the hole is increased to 3.000, the mesh

unfolds (right frame).
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Biasing can be applied retroactively after a morphing operation. After applying a morph, you can change
the biasing value by selecting the make retroactive checkbox, and have the current list of applied
morphs updated to reflect the new biasing values. This is useful in selecting a good biasing value to
apply for a given morph. Apply the morphs and change the biasing values retroactively until you get the
shape that you want.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Morphing p.2861

Solid Model Strategies
Solid models are models that are made up of solid elements, namely, tetras, pentas, and hexas. In
general, a solid model represents a single part with numerous features such as holes, edges, bosses,
flanges and ribs.

HyperMorph is designed to make it easy to change the size and shape of features in a solid model. This
is done using one of the following methods:

• Moving the handles on the part to new locations

• Moving the global handles around the part to new locations

• Altering the radius or curvature of curved edges of the part

• Mapping the nodes of the part to line or surface data.

For solid models, it is only necessary to create a single 3D domain for the entire part. You can also add
a global domain and global handles for shape alterations of a general nature.

Manage Handles and Domains for Solid Models
Create handles and domains, divide your solid model, and group, split, merge domains.

You can create a single 3D domain consisting of all the elements in a model. If the model is made
up of more than one part, each part is placed in its own 3D domain. The surfaces of each 3D domain
are covered with shell elements that are placed in a component named ^morphface. The elements
in ^morphface covering each 3D domain are placed into 2D domains. If partition 2D domains is
checked, these 2D domains are partitioned according to the settings selected in the parameter subpanel
of the Domains panel. Once partitioned, edge domains are placed around the 2D domains and handles
are placed at the ends of the edge domains. This procedure is automatic. In many cases, the domains
and handles are generated where you want them to be. If they are not, you can add, edit, or delete the
handles and domains to meet specific needs.

Create Single 3D Domains
Create a single 3D domain that consists of all the elements in a model.

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Create subpanel.

4. Set the selector to 3D domains.

5. Change the toggle to all elements, or manually select all of the elements in the model.

6. Click create.
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Figure 1785: 3D Domain Created for Solid Model
The automatic creation and partitioning of 2D domains on the face of the solid and the creation of edge domains and handles for

the 2D domains.

Create 3D Domains with Global Domains and Global Handles

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Create subpanel.

4. Set the selector to auto functions.

5. Click generate.

If there are any domains or handles in the model, you are asked if you want to delete all the current
morphing entities. If you click yes, or if there are no morphing entities in the model, 1D, 2D, and 3D
domains are automatically generated for the entire model, as well as a global domain and handles.

Figure 1786: Automatic Generation of Domains on Solid Model
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The addition of a global domain, global handles, and 1D domain, which produces dependent (green) handles.

If you do not select partition 2D domains when you generate a 3D domain, the 2D domain made up
of the elements on the surface of the 3D domain will not have edge domains and thus no handles will
be generated for it. Without handles, morphing cannot be performed. However, this approach will give
you a "blank slate" 2D domain that you can partition by hand. For meshes on which the automatic
partitioning does not work well, such as first order tetra meshes, you may find it easier to start with
a blank slate rather than editing the automatically created domains. Be sure to try both methods of
partitioning, element based and node based, before deciding to partition by hand.

Note:  The element based method sometimes works better on second order tetras since it
accounts for element curvature. However, if the second order tetras are converted first order
tetras and thus have no curvature, the node based partitioning will work better.

Also, for first order tetra meshes, you may find it more effective to ignore curvature when automatically
partitioning. To do this, in the parameters subpanel, change the uppermost toggle from curvature based
to angle based. You may also want to lower the domain angle to 30 degrees. Partitions will be made
only along edges in the model where the domain angle is exceeded. You can then manually divide the
2D domains where the curvature breaks should be located. This method is very helpful for meshes that
began as first order tetra meshes but then were then transformed into second order meshes. For these
meshes, a curvature break is detected at every element along a curve if the midpoint nodes of the
elements have not been modified to capture the curvature. This results in a domain for every element
on a curve which makes morphing impractical.

Solving the influence coefficients for 3D domains which contain more than 20,000 elements can become
very time consuming even though it is only done after domain editing and during morphing operations
such as radius change and map to geom. In these cases you may want to divide the domain into
multiple domains using the subdivide 3D function in the update subpanel of the Domains panel, or
lower the limit for the large domain solver. The large domain solver limit can be found in the global
subpanel of the Morph Options panel. However, even though influence calculations for large domains
are more rapid, morphing using the large domain solver can be time consuming, and thus subdividing
3D domains can often be the best solution for efficient morphing. Additionally, if you are only going to
morph a part of your 3D mesh, you only need to create domains for that part.

Subdivide Solid Models

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Update subpanel.

4. Set the selector to subdivide 3D.

5. Select the 3D domains to be subdivided.

6. Select any 2D domains on the surface of the 3D domain that are permissible for HyperMorph to
split into more than one 2D domain.

7. Click subdivide.
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HyperMorph automatically subdivides the 3D domains into one or more 3D domains while leaving the
2D domains not selected as being divisible unchanged. Not that in some cases HyperMorph will not be
able to subdivide a 3D domain without dividing an indivisible 2D domain. In these cases the 3D domain
will be left undivided.

Divide Solid Models Manually

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Create subpanel.

4. Set the selector to 3D domains.

5. Select the elements to be placed into a new 3D domain.

6. Click create.

When selecting elements for the new domain, you do not need to select only solid elements, other
elements are automatically removed before the domain is created. Therefore, you do not need to be
concerned about selecting the morphface elements.

Also, it does not matter if the selected elements are already in a 3D domain. When the new domain
is created, the elements are moved from the old domains to the new domain. Morphface elements
are placed at the internal interface between the new domain and the other domains and create a 2D
domain for the interface, but it will not partition the interface. This better accommodates the division
of tetra meshes that cannot be divided along flat or curved internal faces and thus would be partitioned
into many domains.

Note:  When you divide a 3D domain into parts, it has the effect of partitioning the surface
of the original 3D domain along seams where the divisions were made. So when you divide
your model into 3D domains, make sure that you divide it along lines where you want your
2D domains on the surface to be.

Dividing a 3D domain into many 3D domains can be very useful for controlling the movement of nodes
within the domain when the handles on the surface are moved. When some meshes are morphed, the
internal elements can become distorted. This is generally caused by handle influences extending too far
through the 3D domain. You can divide your 3D domains to restrict the handle influences and control
mesh distortion.
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Figure 1787: 3D Domain Split into Four 3D Domains
The influences of the handles will not extend across the boundaries between the domains.

Influences must be recalculated every time handles, domains, or symmetries are added, edited, or
deleted. They are also recalculated during radius changes and geometry mapping. These calculations
occur when you enter or leave a HyperMorph panel or when you leave the delete panel. For large
models you will want to make all of your domain changes before exiting the Domains panel. The
influences for handles are only recalculated in regions that have been edited.

If the domains are not created exactly the way you want them, you can edit them in the Domains
panel. The create subpanel allows you to create new domains. The organize subpanel allows you to edit
domains by adding and removing elements to or from a domain and by grouping domains together.
The edit edges subpanel allows you to split, merge, and place handles along edge domains. Since
creating or editing 3D domains results in the creation of 2D and edge domains, and creating or editing
2D domains results in the creation and deletion of edge domains, you should perform the tasks in the
following order:

1. Create and edit all the 3D domains that you want first.

2. Create and edit the 2D domains.

3. Create and edit the edge domains.

Automatic partitioning does not always divide a mesh in the most useful ways. Occasionally, elements
end up in domains adjacent to where you want them or placed in their own domain. Some cleanup may
be required.

Organize Elements in Domains
Move elements from one domain to another.

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Organize subpanel.

4. Change the selector to add nodes/elements.

5. Select the elements to be moved.

6. Select the target domain.

7. Click organize.
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The elements are moved from their current domain to the selected domain. The edge domains around
both domains are refreshed, as well as the 2D domains at the interface if solid elements are being
organized. New handles may also be created during this process, and if retain handles is not checked,
handles may be deleted. You should keep retain handles unchecked unless you have created shapes for
the model that use the handles on the domains that you are editing.

Figure 1788: Move Elements
The model on the left shows problems that partitioning can encounter for some meshes. The model on the right has been

corrected using the organize subpanel of the Domains panel. For this example, the retain handles option was left unchecked,

resulting in the elimination of handles that are no longer on the corners of the 2D domains.

Note:  Holding the mouse button down when the mouse is either over the icon for a 2D or
3D domain or over an element inside a domain, will highlight the edge domains surrounding
the domain. This allows you to visualize the domain that you are selecting. The domain
icon is placed at the centroid of the domain, and for some domains it can end up away from
the elements of the domain and near other domain icons. Having the edges for the domain
highlighted during selection is often necessary to tell which icon goes with which group of
elements.

Group Domains
Group two or more domains.

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Organize subpanel.

4. Change the selector to combine domains.

5. Select the domains to be grouped.

6. Click organize.
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The selected domains are combined into a single domain, and the surrounding domains and handles are
updated.

Edge domains are automatically partitioned when they are created. They are also updated whenever
a change occurs for a domain of which they are on the edge. This is why you should edit the edge
domains after the other domains have been edited. If you perform edge editing first, your changes may
be erased when you edit the 2D and 3D domains.

Edge domains are used to make radius changes, so it is important to make sure that any radius in
the model that you intend to change be captured correctly by edge domains. HyperMorph attempts
to partition edge domains where curvature begins and ends, but in some cases, it will not identify the
proper starting and ending points. You will need to correct this by hand.

Split Edge Domains

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Edit Edges subpanel.

4. Change the selector to split.
5. Select an edge domain.

6. Select a node on that domain that is not on the edge.

7. Click split.

The selected edge domain is split into two edge domains at the selected node. A handle is created at
the selected node.

Figure 1789: Split Edge Domains
The lower edge domain has been split at the gray node (left model), which becomes a handle (right model). Now the radius of

each new edge domain may be modified independently of the other.

Merge Edge Domains

1. From the Tools page, click HyperMorph.

2. Click Domains.
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3. Select the Edit Edges subpanel.

4. Change the selector to merge.

5. Select any number of edge domains.

6. Click merge.

The two edge domains are merged into one edge domain. This function only allows you to merge edge
domains that lie end-to-end such that the resultant merged edge domain is a continuous series of
nodes.

You may also create dependent handles along an edge domain. This feature helps save time when you
are changing the radius for the edge domain. If a model is very large, you may find it more efficient
to place dependent handles on the edge domains whose radii you wish to change before you enter the
morphing panel.

Note:  You can also merge edge domains in the organize subpanel.

Create Dependent Handles along Edge Domains

1. From the Tools page, click HyperMorph.

2. Click Domains.

3. Select the Edit Edges subpanel.

4. Change the selector to add handles.

5. Select one or more domains.

6. Click create.

Dependent handles are created on the selected edge domains. These handles are dependent on
the independent handles to either side of them along the edge domain.

Figure 1790: Dependent Handles Created using the Handles on Edge Feature

Creating dependent handles in this way has two significant effects. The first is that since they are
dependent, movements applied to any of the independent handles on the edge are transparently
applied to the dependent handles. It will be as if they were not there. Secondly, when you make
a radius change to an edge domain that has a handle at each of its nodes, the influences do not
need to be recalculated, which makes the radius change process much faster for large models.
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7. When you are satisfied with your domains, click return.

The influences for the handles is calculated and you are ready to begin morphing.

Note:  During influence calculation for large models you might run out of available
memory. This generally happens when a given domain is too large and it contains too
many handles. In these cases, you should divide large domains, delete unnecessary
handles, or lower the limit of the large domain solver.

Solid Model Display Controls
The HyperMesh graphics engine supports different visual options for viewing models as you work on
them.

Surface-Only Wire Frame
In this default mode, your model is displayed as a wire frame, but only the surface elements are drawn
because in a solid model, a full wire frame can make it very difficult to visualize the model because
every element in the model is displayed. Since HyperMorph creates a component called ^morphface,
which contains shell elements on the surface of the 3D domains, the default setting is to display only
that component, thus showing only the outer surface of your model and making it easier to work
on. However, since the viewing mode is still wire frame, you will see the two sides of your model
superimposed over each other.

Figure 1791: Surface-Only Wire Frame

Solid Fill
The option produces a display that is similar to what you see when you perform a fill plot in the Hidden
Line panel. You only see the side of the model that is facing you, as if your model was a real part. You
can still display the surface mesh, if desired, as shown.
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Figure 1792:

You can also view a solid model for morphing by turning off all the components and looking at only
the domains and handles. This is similar to looking at the model in a meshless wire frame mode.
Partitioning generally captures all the features on the surface of a solid, so by viewing only the domains
you can visualize the model with minimal clutter.

Figure 1793:
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Optimization

Setup an Optimization in HyperMesh.

This chapter covers the following:

• Structural Design and Optimization  (p. 2872)

• Setup Optimization in HyperMesh  (p. 2873)

• Design Interpretation - OSSmooth  (p. 2874)

HyperMesh Optimization technology is supported by OptiStruct. OptiStruct is a finite element and
multibody dynamics software application which can be used to design and optimize structures and
mechanical systems.

OptiStruct uses the analysis capabilities of Radioss and MotionSolve to compute responses for
optimization.
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Structural Design and Optimization
Structural design tools include topology, topography, and free-size optimization.

Sizing, shape and free shape optimization are available for structural optimization. In the formulation
of design and optimization problems, the following responses can be applied as the objective or as
constraints: compliance, frequency, volume, mass, moment of inertia, center of gravity, displacement,
velocity, acceleration, buckling factor, stress, strain, composite failure, force, synthetic response, and
external (user defined) functions. Static, inertia relief, nonlinear gap, normal modes, buckling, and
frequency response solutions can be included in a multi-disciplinary optimization setup.
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Setup Optimization in HyperMesh
Simple steps for setting up your optimization in HyperMesh.

1. Create a running model of your analysis type supported by Radioss or MotionSolve.

2. Define or create your Design space.

3. Create responses.

4. Define constraints.

5. Define objectives.
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Design Interpretation - OSSmooth
OSSmooth is a semi-automated design interpretation software, facilitating the recovery of a modified
geometry resulting from a structural optimization, for further use in the design process and FEA
reanalysis.

The OSSmooth tool has two incarnations: a standalone version that comes with the OptiStruct
installation, and a dependent version that is embedded in HyperMesh.

OSSmooth can be used in for OSSmooth for geometry, FEA topology reanalysis, and FEA topography
reanalysis.

OSSmooth (for geometry) can be used to:

• Interpret topology optimization results, creating an iso-density boundary surface (Iso-surface).

• Interpret topography optimization results, creating beads or swages on the design surface.

• Recover and smooth geometry resulting from a shape optimization.

• Reduce the amount of surface data from a given set of triangular patches by combining smaller
patches.

• Smooth surface data given as triangular patches.

For FEA topology reanalysis and FEA topography reanalysis, OSSmooth can be used to:

• Preserve component boundaries for multiple design components.

• Recover geometry with or without an artificial layer of elements around a non-design space
optionally.

• Tetramesh Iso-surfaces ‘by property’.

• Preserve boundary conditions upon geometry recovery to enable quick reanalysis.
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Figure 1794: OSSmooth Workflow
Overview of how OSSmooth works to interpret optimization results from OptiStruct.

Each of the three applications of OSSmooth has a corresponding sub-panel in the OSSmooth panel in
HyperMesh. OSSmooth (for geometry) is generally used to recover geometry by interpreting topology,
topography, and shape optimization results, while FEA topology and FEA topography are used to
generate recovered geometry with boundary conditions for FEA reanalysis.

OSSmooth (for geometry) requires a parameter file, generally has the file extension .oss to run. This
parameter file may be generated from the OSSmooth panel in HyperMesh, or it may be generated
manually through a text editor. At the completion of an optimization run, OptiStruct automatically
exports an OSSmooth parameter file <prefix>.oss with certain default settings depending on the type
of optimization run. The second order option has been added for parameters in the OSSmooth panel.

In addition to the parameter file, OSSmooth (for geometry) also requires the input file (<prefix>.fem),
the shape file (<prefix>.sh), and/or the grid file (<prefix>.grid) from an OptiStruct run. The grid
file <prefix>.grid contains the grid point locations after a topography or shape optimization and is
output at the end of a topography or shape optimization run. The shape file, <prefix>.sh, contains
the element density information of a topology optimization and is output at the end of a topology
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optimization run. If you want to use OSSmooth for topology results which is not from OptiStruct, simple
xy data is accepted.

FEA topology requires the input model (<prefix>.fem) to be loaded into HyperMesh before running,
which is different from OSSmooth (for geometry). It also requires the shape file (<prefix>.sh)
generated by a topology optimization. For processing of the non-design elements, two options, Keep
smooth narrow layer around and Split all quads, are provided to recover geometry.

FEA topography requires a grid file (<prefix>.grid) to run. Similar to FEA topology, it also requires
that the input model (<prefix>.fem) be loaded into HyperMesh first, with the option for iso-surface
that performs the same functionality as FEA topology.

Note:  OSSmooth currently does not recognize OptiStruct long-format input data. A possible
work-around for this problem is to import the long-format input file into HyperMesh and
export it using the regular OptiStruct template before running OSSmooth. The interpreted
design from OSSmooth can be exported as a finite element mesh in the bulk data format, as
IGES surfaces, as a stereolithography file, or as a Hyper3D file.

OSSmooth Parameter File
Parameter statements in the OSSmooth parameter file.

OSSmooth file parameter statements each have following format:

parameter_name arg1,arg2,...,argn

The parameter_name and arguments can be separated either by spaces or commas. The file is not case
sensitive.

Comment lines in the OSSmooth parameter file should start with either ‘#’ or ‘$’.

Supported Parameters
input_file

Identifies the files to be interpreted by OSSmooth.

arg1
The file name (without extension) of the OptiStruct .fem, .sh, and/or .grid files to be
interpreted by OSSmooth.

output_file
Name of the file to be output by OSSmooth.

arg1
Full name of the file output by OSSmooth.

output_code
Identifies the type of output.

arg1
Output format for iso-surface
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"1" Bulk data trias

"2" IGES patches

"3" STL trias [default]

"4" H3D trias

arg2
Output control for tet-meshing of volume enclosed by the iso-surface.
[Default: no tet-meshing]

"1" Tetra4 + Tria3 elements

"2" Tetra10 + Tria6 elements

"3" Tetra4 elements

"4" Tetra10 elements

The tet-mesh is written in OptiStruct input format to a file <input_file>_mesh.fem. In
this file, the design space of the file <input_file>.fem is replaced with a tet-mesh for
immediate reanalysis. Loads, boundary conditions, and non-design elements are carried
over from the input file.

units
Defines output units for IGES format. This information gets written to the header of the IGES file
and may be recognized by your CAD system.

1 (default)
inch

2
mm

4
foot

10
cm

autobead
Improves the recovered geometry from a topography optimization by applying automatic
geometry creation.

arg1
Operation flag [integer]

"0" autobead off

"1 (default)" autobead on

arg2
Threshold value for creating autobead.
[real, between 0.0 and 1.0, default = 0.3]

arg3
Bead layer [integer]

"1 (default)" create 1 layer bead

"2" create 2 layers bead
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isosurface
Generate threshold surface from a topology optimization by applying automatic geometry
creation.

arg1
Operation flag [integer]

"0" isosurface off

"1 (default)" isosurface on

arg2
Type of surface created [integer]

"0" isosurface only

"1" isosurface with Optimization-based smoothing

"2" Element threshold surface

"3 (default)" isosurface with Laplacian smoothing

For topology results, smoothing maintains the topology as suggested by OptiStruct, but it
can deviate from the given density distribution. If option 1 or 3 is used, check the maximum
and average smoothing error output by OSSmooth.

arg3
Density threshold for creating isosurface.
[real, between 0.0 and 1.0, default = 0.3]

opti_smoothing
Optimization-based smoothing [Only used if isosurface C2=1].

arg1
Unit-less surface distance coefficient
[real, default = 0.0]
Defines closeness of the smooth surface from the threshold surface. The effect of this
coefficient varies for different input meshes. Higher magnitudes, both positive and negative,
give smoother results, but the surface deviates more from the original density distribution.
The recommended range is from -50 to 50. When the coefficient is set between 0 and 50,
the surface usually tends to smooth and shrink. When the coefficient is set between 0 and
-50, the surface usually tends to smooth and expand.

arg2
Smooth isosurface boundary flag [integer]

"0 (default)" boundary not included in smoothing

"1" boundary included in smoothing

laplacian_smoothing
Laplacian smoothing [Only used if isosurface C2=3].

arg1
Number of iteration for Laplacian smoothing
[integer > 0, default = 10]

arg2
Feature angle threshold in degrees
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[real, default = 30.0]
The feature angle is defined as the angle of normal between two intersected element
planes. All corners with a feature angle larger than the threshold will be preserved in the
smoothing process.

arg3
Smooth isosurface boundary flag [integer]

"0" boundary not included in smoothing

"1 (default)" boundary included in smoothing

remesh
Remesh autobead surface and/or isosurface flag [integer]

0 (default)
remesh off

1
remesh on

Remesh detects 2-layer elements around bead shape and/or boundary of isosurface. Use mixed
type remesh if input mesh contains any QUAD elements, otherwise remesh with TRIA elements.

surface_reduction
Reduces the number of surfaces representing the geometry. Can reduce the number of surfaces
by up to 80 percent.

arg1
Surface reduction flag [integer]

"0 (default)" no surface reduction

"1" do surface reduction

arg2
Feature angle threshold in degrees
[real, default = 10.0]
The feature angle is defined as the angle formed by the surface normal of two adjacent
elements. The surface reduction will be performed on any two adjacent elements in which
the feature angle between the two elements is smaller than the threshold. The greater the
threshold, the more surface reduction will be conducted. The valid range of the threshold is
[1.0, 80.0].

pure_surf_smoothing
Surface smoothing only.

arg1
Pure surface smoothing flag [integer]

"0 (default)"

"1" Optimization-based smoothing

"2" Laplacian smoothing

arg2
Number of iteration [Only used if G1=2]
[integer > 0, default = 10]
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arg3
Feature angle threshold in degrees [Only used if G1=2]
[real, default = 30.0]
The feature angle is defined as the angle of normal between two intersected element
planes. All corners with a feature angle larger than the threshold will be preserved in the
smoothing process.

pure_surf_reduction
Surface reduction only.

arg1
Pure surface reduction flag [integer]

"0 (default)" no surface reduction

"1" do surface reduction

arg2
Feature angle threshold in degrees
[real, default = 10.0]
The feature angle is defined as the angle formed by the surface normal of two adjacent
elements. The surface reduction will be performed on any two adjacent elements in which
the feature angle between the two elements is smaller than the threshold. The greater the
threshold, the more surface reduction will be conducted. The valid range of the threshold is
[1.0, 80.0].

OSS Example Input File
input_file example

Identifies the root of the input files as example, so OSSmooth will look for the files example.fem,
example.grid, and example.sh.

output_file example.stl
The resulting output will be example.stl.

output_code 3
The output will be in stereolithography format.

Autobead 1 0.3 1
Topography results will be interpreted using the autobead feature with a threshold value of 30%
creating single depth beads.

Isosurface 1 3 0.3
Topology results will be interpreted by creating an iso-density boundary surface with at a density
value of 30% and smooth using laplacian smoothing.

laplacian_smoothing 10 30 1
The Laplacian smoothing will run for 10 iterations, consider a feature angle of 30-degrees and
including the boundary in the smoothing.
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Remesh 1
The two rows of elements around the recovered geometry will be remeshed in an attempt to
smooth the mesh transition.

Run OSSmooth
• Run OSSmooth from the command line.

a) Enter ossmooth <prefix>.oss.

• Run OSSmooth from the HyperMesh Solver panel.

a) From the menu bar, click Tools > Solver.
b) Set switch to OSSmooth.

c) In the input file field, enter <prefix>.oss.

d) Click solve.

OSSmooth standalone, which can also be invoked from the Solver panel in HyperMesh, checks
out 50 HyperWorks Units.

• Run OSSmooth from the HyperMesh ossmooth panel.

a) From the Post page, click ossmooth.

b) Choose either OSSmooth (for geometry), FEA topology or FEA topography.

c) In the file field, select the OptiStruct input file (<prefix.fem> and/or <prefix.sh> and/or
<prefix.grid >).

d) Edit the OSSmooth input data by making selections on the screen.

e) Click ossmooth.

OSSmooth (for geometry) will write a new <prefix.oss> file with the screen settings and load the
geometry recovered into HyperMesh if the data format is IGES, STL, or Nastran. FEA topology and
FEA topography will update the model in HyperMesh without outputting the result; if required, data
can be exported from HyperMesh.

OSSmooth invoked from the ossmooth panel in HyperMesh checks out 42 HyperWorks Units (21
leveled and 21 stacked).

• Run OSSmooth from the HyperWorks Run Manager.

a) In the Input file(s) field, select the .oss file.

b) Verify that the Options field is empty.

c) Click Run.

Interpretation of Topology Optimization Results
Topology optimization results are interpreted to provide an iso-density surface based on the volumetric
density information of a topology optimization, which is conducted using OptiStruct.

OSSmooth can handle both shell and solid elements with the same parameter setting.

#general parameters
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input_file mattel
output_file mattel.stl
output_code 3

#specific parameters
isosurface 1  3  0.300
laplacian_smoothing   10  30.000  1
surface_reduction     1  10.000

Figure 1795: Parameter File for Post-Processing of Shell Element Topology Optimization

Figure 1796: Surface Reconstruction of Shell Element Topology Optimization

The parameter laplacian_smoothing is used for additional smoothing. In most cases, the threshold
surface (isosurface with second argument 0) already creates a smooth shape. Additional smoothing
(isosurface with second argument 3) maintains the topology as suggested by OptiStruct, but it can
deviate from the given density distribution. If this option is used, the maximum and average smoothing
error output by OSSmooth should be checked. The surface_reduction parameter is used to reduce the
number of elements.

Connection Detection
While the iso-density surface is very useful in visualizing the resulting topology, simply using a density
threshold value for design interpretation can be misleading. This is due to the fact that when a density
threshold value is defined as the cut-off, all design elements with density values less than the threshold
are not considered in the interpreted design. This is the intent of the feature, but in many cases,
there are elements with densities lower than the threshold value that do contribute significantly to the
structural integrity of the design. Ignoring these sections could lead to design failures or an interpreted
design that is infeasible. Therefore, it is very important that these significant lower-density regions be
captured as well in the design interpretation process. These regions could be interpreted as thinner or
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weaker sections, but are necessary from a structural perspective nonetheless. The iso-surface design
interpretation capability of OSSmooth was therefore enhanced through the implementation of the
connection detection feature.

Once the density threshold is applied, certain strategies are used to detect areas with potential
connections or bridges between regions of material to preserve structural integrity of the interpreted
design. However, there may be many such potential connections, most of which typically have elements
with very low densities. Therefore, a lower bound threshold value can be defined to avoid finding the
unnecessary connections.

Both threshold value (T) and lower threshold value (t) refer to element density, and range from 0.0 to
1.0. The lower threshold value, t, should be smaller than the threshold value, T, defined. For example,
if T is 0.3, the lower threshold value should lie between 0.0 and 0.3. The default value for the lower
threshold is calculated internally as t=0.667*T. However, selection of this value is model-dependant,
so when necessary you can override the default by setting the lower threshold value based on your
requirements.

If the resulting iso-surface with default settings has unwanted connections, a larger lower threshold
value can simply be defined. On the other hand, if the final iso-surface does not contain the important
connections needed, the lower threshold value can be made smaller.

Connection detection was implemented to facilitate a more robust design interpretation process by
capturing important material distribution that could otherwise be missed due to the definition of a single
density cut-off value.

From Figure 1797 and Figure 1798, it is evident that by selecting a certain threshold value, certain
critical structural members may be lost in the design interpretation process.

Figure 1799 and Figure 1800 show the interpretation of the same density threshold values as figures 1
and 2 respectively, but with connectivity detection switched on. It is evident that important structural
members are preserved even at higher threshold values.

Figure 1797: Density Threshold = 0.5
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Figure 1798: Density Threshold = 0.7

Figure 1799: Connection Detection = 0.5
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Figure 1800: Connection Detection = 0.7

Draw Recovery
To further enhance the quality of recovered geometry from a topology optimization, a new draw
recovery option is implemented. By simply selecting the draw recovery checkbox in the OSSmooth
panel, the draw recovery option is enabled in the geometry extraction process. A draw direction can
be defined in the optimization formulation as a manufacturing constraint and the draw recovery option
uses this information in the interpretation of the geometry.

From the results of a topology optimization, for iso-surfaces near-parallel to the draw direction vector,
the draw recovery option creates smooth, straight surface walls in the draw direction, in the isosurface
interpretation. Figure 1801 showcases an iso-surface extraction without the use of draw recovery, and
Figure 1802 shows the same result with draw recovery. Straight surface walls in the draw direction are
interpreted with the draw recovery option. This simplifies the design interpretation task.

Figure 1801: No Draw Recovery
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Figure 1802: With Draw Recovery

Laplacian Smoothing
Laplacian smoothing can be used in the smoothing of the results of topology optimization.

The laplacian_smoothing statement controls the iteration number of when the Laplacian smoothing
will be performed and the feature angle threshold to preserve normal discontinuity at corners.

#general parameters
input_file surf
output_file surf.stl
output_code 3
isosurface 1  3  0.300 

#specific parameters
laplacian_smoothing   10  30.000  1

Figure 1803: Parameter File for Smoothing Result

Laplacian smoothing creates smooth boundary iso-surface by entering 1 as the 3rd argument of the
laplacian_smoothing parameter statement. Comparing Figure 1804 and Figure 1805, notice that
Figure 1805 is almost ready for casting.
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Figure 1804: Fix Boundary of Iso-Surface

Figure 1805: Smooth Boundary of Iso-surface

The advantages of the laplacian_smoothing statement in OSSmooth include:

• The flexibility of controlling the number of smoothing iterations to obtain different degrees of
smoothing (possibly a smoothing quality ready for casting). Normally, the iteration number ranges
from 5 to 20.
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• Smooth boundary of iso-surface with feature angle constrain are seamlessly incorporated into the
smoothing process, which is more challenging in a pure CAD system.

Interpretation of Topography Optimization Results
The autobead feature of OSSmooth allows OptiStruct topography optimization results to be interpreted
as one or two level beads.

Figure 1806 shows the level of detail captured in both cases; while the 2-level approach captures more
details, it is more complicated to manufacture than the 1-level interpretation, often without significant
performance gain.

Figure 1806: Autobead Interpretation of Topography Optimization Result

Example: Autobead Result from Topograph Optimizationn

#general parameters
input_file decklid
output_file decklid.fem
output_code 1 

#specific parameters
autobead 1  0.300  1
remesh 1

Figure 1807: Parameter File
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Figure 1808: Autobead Result from Topography Optimization

Example: 2-Layer Autobead Result from Topography Optimization
Some topography performances are relying on the half translation part. OSSmooth can interpolate
topography optimization results to 2-layer autobead (autobead third argument 2).

#general parameters
input_file decklid
output_file decklid.nas
output_code 1 

#specific parameters
autobead 1  0.300  2

Figure 1809: Parameter File
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Figure 1810: 2-Layer Autobead Result From Topography Optimization

Interpretation of Composite Free Sizing Optimization
Results
A free sizing optimization on composite materials is run to determine the optimal ply shapes and fiber
orientation/material selection.

After this optimization phase is run, the next step is to:

• Interpret the optimized ply shapes,

• Smooth the ply boundaries, and

• Setup a subsequent, more detailed size optimization run to determine the number of plies that are
required for each ply shape and material.

With the input file for the size optimization phase automatically generated by OptiStruct, handling
the ply interpretation and smoothing process can be a tedious, manual process. Altair's ply shape
interpretation functionality streamlines this design interpretation process, by allowing the interpretation
of optimized ply shapes from a composite free sizing optimization.

During the interpretation process, the boundaries of the ply shapes are smoothed, and options are
available to create separate ply entities for disconnected ply patches and for the treatment of very small
ply coverage regions.

Additionally, after the smoothing and interpretation process is complete, a ready-to-run OptiStruct input
deck is generated using the smoothed ply shapes and updated ply definitions, all while preserving the
material definition, properties and fiber orientation.
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Figure 1811: Ply Shape from Free Size Optimization

Figure 1812: Smoothed Ply Boundary after Running OSSmooth
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Figure 1813: Additional Treatment of Small Regions

The smooth iterations option defines the number of smoothing iterations to be run. Greater smoothing
can be achieved by increasing the number of iterations. The default number of iterations is 20.

The small region option determines how very local and small ply coverage regions are treated. Regions
smaller than the threshold value will be eliminated during the smoothing process. Two methods of
determining what constitutes a small region are available:

Area ratio
Local region area / total design area (real value between 0.0 and 1.0. Default=0.01)

Elem count
Small region identified by number of elements (integer >=0. Default=15)

The split disconnected option can be used to create separate ply entities from disconnected ply
coverage regions.

Shape Optimization Results, Surface Reduction and
Surface Smoothing
OSSmooth may also be used to reduce and smooth surfaces or the surfaces of a domain.

The parameter statements pure_surf_reduction and pure_surf_smoothing can be used for this
purpose.

The file defined by input_file must be in the OptiStruct bulk data format, and OSSmooth can smooth
the surface or the surfaces of a domain of the model.

#general parameters
input_file surf
output_file surf.stl
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output_code 3 

#specific parameters
pure_surf_smoothing   2  10  30.000
pure_surf_reduction   1  10.000

Figure 1814: Parameter File

FEA Topology for Reanalysis
FEA topology for reanalysis provides an iso-density surface based on the volumetric density information
from a topology optimization. Through tetrameshing for 3D models and inheriting boundary conditions,
the results from FEA topology can be used for quick reanalysis.

FEA topology can handle both shell and solid elements. For 3D models, the recovered iso-surface can be
tetrameshed-by-property automatically. FEA topology provides two options for the processing of non-
design elements:

Keep smooth narrow layer
Retain an artificial layer of elements around the non-design space in the interpretation.

Split all quads
Split quad elements in the non-design space, if present, to generate a tetra connection between
design and non-design regions.

FEA topology preserves boundary conditions by inheriting them from the original model
(<prefix>.fem). Those boundary conditions unattached to nodes/elements after geometry recovery are
deleted to ensure reanalysis.

Figure 1815 and Figure 1816 show FEA topology for reanalysis with following input data definition:

File
block

Density threshold
0.300

Figure 1815 was run with Keep smooth narrow layer around disabled and Split to quads enabled.
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Figure 1815: Result of FEA Topology for Reanalysis

Figure 1816 was run with Keep smooth narrow layer around enabled, and Split all quads disabled. This
approach creates a layer of elements around the non-design region and pyramids around the quad
elements, if quads exist, to connect to the design space tetrahedral elements.
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Figure 1816: Result of FEA Topology with a Layer of Elements around Non-Design Space

Tetramesh will be applied on the iso-surface result if there is one close volume at least. The advantages
of the tetramesh in FEA topology include:

• Tetramesh can be performed by property.

• The flexibility of controlling the number of tetramesh retries by perturbing the density threshold
value, in cases where tetramesh sometimes fails.

FEA Topography for Reanalysis
The FEA topography option in OSSmooth allows the results from an OptiStruct topography optimization
to be interpreted as one or two level beads and recover boundary conditions upon geometry extraction.
An option for iso surface is also provided for combined use, which performs the same functionality as
FEA topology, with FEA topography.

Figure 1817 and Figure 1818 show the level of detail captured in a 1-level bead and 2-level bead case
while preserving boundary conditions for quick reanalysis.

The input data definition for a 1-level Autobead extraction is as follows:

Grid file
brkt

Threshold
0.300
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Layers
1

Figure 1817: 1-Level Autobead Result from FEA Topography

A 2-level Autobead extraction is activated with the following input data:

Grid file
brkt

Threshold
0.300

Layers
2
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Figure 1818: 2-Level Autobead Result from FEA Topography
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Conversion Between Solver Formats

Convert finite element models to another solver format.

This chapter covers the following:

• Convert Model File Solver Format  (p. 2899)

• Batch Conversion Tools  (p. 2900)

• Abaqus Conversion  (p. 2901)

• ANSYS Conversion  (p. 2942)

• LS-DYNA Conversion  (p. 2971)

• Nastran Conversion  (p. 2980)

• OptiStruct Conversion  (p. 2992)

• PAM-CRASH 2G Conversion  (p. 3006)

• Permas Conversion  (p. 3011)

• Radioss Conversion  (p. 3013)

• Samcef Conversion  (p. 3021)

Finite element models defined for a particular card image solver generally cannot exchange information
with other card image or dictionary format solvers without manipulation of the data.
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Convert Model File Solver Format
Convert model files from one solver format to another.

Note:  Depending on the solver conversion, certain options, such as defining a source
template, a destination template, or a configuration file, may not be present.

1. Load your model in HyperMesh.

2. From the menu bar, select Tools > Convert > <solver format to convert from> > <solver
format to convert to>.

3. In the that opens asking if you want to load the chosen solver's user profile to continue, click Yes.
The conversion browser opens.

4. In the Source template field, select the appropriate template for your source solver.

5. In the Destination template field, select the appropriate template for your destination solver.
The Configuration File field is automatically populated. The default file, ConfigurationFile.txt,
provides a valid mapping scheme for the conversion.

Individual entities are listed in the browser, and color coded green, orange or red to highlight to
which extent the card is converted to the targeted solver.

6. Define a Log file location.

7. Click Conversion Options to view more options.

8. Review entities.

• Click an entity to display which card the current entity is mapped to, as well as which
parameters are translated.

• Open the Card Edit panel by right-clicking on an entity and selecting Edit Card from the
context menu.

9. Click Convert.
A dialog opens, informing you of the status of the conversion. After the conversion, the user
profile is automatically updated to the selected solver's format. Click Close to close the status
window.
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Batch Conversion Tools
Batch mode conversion is available for all solver interfaces.

To use batch mode conversion you must run a .tcl file in batch mode using hmbatch.exe.

Example: Convert Abaqus to OptiStruct
When running this .tcl file in batch mode, use the following commands in Windows and Linux:

<altair_home>/hm/bin/<platform>/hmbatch.exe -tcl </home/user/my_script.tcl>

## Bath mode conversion for Abaqus to Optistruct
## Note - Please keep the source model and script in the same folder
## Please replace XXXXX with name of the source deck and the destination files.

set altairHome [ hm_info -appinfo "ALTAIR_HOME" ]
set scriptFolder [ file dirname [info script] ]

*templatefileset "${altairHome}/templates/feoutput/abaqus/standard.3d"

*createstringarray 5 "Abaqus " "Standard3D " "LOADCOLS_DISPLAY_SKIP "
"CONTACTSURF_DISPLAY_SKIP " "SYSTCOLS_DISPLAY_SKIP "
*feinputwithdata2 "#abaqus/abaqus" "${scriptFolder}/XXXX.inp" 0 0 0 0 0 1 5 1 0

# *readfile "${scriptFolder}/XXXXX.hm"

*solverconvert "Abaqus" "optistruct" "Standard3D" "optistruct" "1"

hm_answernext "yes"
*createstringarray 1 "HM_NODEELEMS_SET_COMPRESS_SKIP "
*feoutputwithdata "${altairHome}/templates/feoutput/optistruct/optistruct"
"${scriptFolder}/XXXX.fem" 0 0 2 1 1
hm_answernext "yes"

Figure 1819: Sample .tcl File
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Abaqus Conversion

Abaqus to Nastran Conversion Mapping
The Abaqus to Nastran conversion uses an open conversion scheme; you can specify different mappings
in the configuration file.

Care has to be taken so that the element and property mappings are consistent. A valid mapping
scheme is provided in the ConfigurationFile.txt file. This document explains the scope and
limitations of the mapping scheme.

Elements
HyperWorks elements have two basic attributes – configuration (or config) and type. The "config"
defines the basic geometrical shape of an element. For example, tria3 configuration is a 3 node
triangular element and hexa8 is an 8-node hexahedral element. The "type" defines the solver specific
element type of a particular configuration. For example, the 4-node quadrilateral (quad4) element in
Abaqus can be any of the following types: S4, S4R, M3D4, R3D4 and so on. The Element Types panel
shows all supported element configurations and their types for a user profile.

For a specific configuration, you can map any supported Abaqus element type to any supported Nastran
element type, or vice versa. For example, for an Abaqus to Nastran direction, several 2-noded element
configurations such as spring, rigid, bar2, rid, and so on are supported. Because all of them are 2-
noded elements, conversion across these configurations is also allowed for some element types. For
example, CBUSH is of "spring" configuration in the Nastran user profile and CONN3D2 is of "rod"
configuration in the Abaqus user profile. It is possible to map a CBUSH to CONN3D2 even though their
configurations are different. The element mapping scheme must be under the *ElemTypeConversion
block in the ConfigurationFile.txt file. You need to provide both configuration and type information
to specify the element mapping scheme as shown for the Abaqus to Nastran direction below:

Table 270: Supported Element Mappings

HM configuration Abaqus type Nastran type

MASS CONM2

ROTARYI CONM2

SPRING1 CELAS1, CELAS2, CBUSH

DASHPOT1 CDAMP1

CONN3D2 CBUSH

Mass

CONN2D2 CBUSH

rigid BEAM RBE2
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HM configuration Abaqus type Nastran type

LINK RBE2

PIN RBE2

TIE RBE2

KINCOUP RBE2

COUP_KIN RBE2

COUP_DIS RBE2

RB3D2 RBE2

R2D2 RBE2

RAX2 RBE2

RB2D2 RBE2

DCOUP3D RBE3

COUP_DIS RBE3

rbe3

DCOUP2D RBE3

KINCOUP RBE2

RB3D2 RBE2

BEAM RBE2

LINK RBE2

PIN RBE2

TIE RBE2

COUP_KIN RBE2

COUP_DIS RBE2

R2D2 RBE2

rigidlink

RAX2 RBE2

SPRING2 CELAS1,CBUSH

SPRINGA CBUSH

spring

DASHPOT2 CDAMP1, CBUSH
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HM configuration Abaqus type Nastran type

DASHPOTA CBUSH

JOINTC CBUSH

B31 CBAR,CBEAM

B31H CBAR,CBEAM

B33 CBAR,CBEAM

B33H CBAR,CBEAM

B31OS CBAR,CBEAM

B31OSH CBAR,CBEAM

PIPE31 CBAR,CBEAM

PIPE31H CBAR,CBEAM

ELBOW31 CBAR,CBEAM

ELBOW31B CBAR,CBEAM

ELBOW31C CBAR,CBEAM

AC1D2 CBAR,CBEAM

GK3D2 CBAR,CBEAM

GK3D2N CBAR,CBEAM

SAX1 CBAR,CBEAM

B21 CBAR,CBEAM

B21H CBAR,CBEAM

B23 CBAR,CBEAM

B23H CBAR,CBEAM

PIPE21 CBAR,CBEAM

PIPE21H CBAR,CBEAM

F2D2 CBAR,CBEAM

bar2

FAX2 CBAR,CBEAM

bar3 B32 CBAR,CBEAM
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HM configuration Abaqus type Nastran type

B32H CBAR,CBEAM

B32OS CBAR,CBEAM

B32OSH CBAR,CBEAM

PIPE32 CBAR,CBEAM

PIPE32H CBAR,CBEAM

ELBOW32 CBAR,CBEAM

AC1D3 CBAR,CBEAM

MGAX2 CBAR,CBEAM

SFMAX2 CBAR,CBEAM

SFMGAX2 CBAR,CBEAM

SAX2 CBAR,CBEAM

B22 CBAR,CBEAM

B22H CBAR,CBEAM

PIPE22 CBAR,CBEAM

PIPE22H CBAR,CBEAM

T3D2 CROD

T3D2H CROD

T3D2T CROD

T3D2E CROD

MGAX1 CROD

SFMAX1 CROD

SFMGAX1 CROD

CONN3D2 CBUSH

T2D2 CROD

T2D2H CROD

rod

T2D2T CROD
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HM configuration Abaqus type Nastran type

T2D2E CROD

GK2D2 CROD

GK2D2N CROD

CONN2D2 spring CELAS1,CELAS2,CBUSH

GAPUNI CGAP

GAPCYL CGAP

gap

GAPSPHER CGAP

S3 CTRIA3,CTRIAR

S3R CTRIA3,CTRIAR

STRI3 CTRIA3,CTRIAR

M3D3 CTRIA3,CTRIAR

SFM3D3 CTRIA3,CTRIAR

R3D3 CTRIA3,CTRIAR

DS3 CTRIA3,CTRIAR

CPE3 CTRIA3,CTRIAR

CPE3H CTRIA3,CTRIAR

CPE3E CTRIA3,CTRIAR

CPS3 CTRIA3,CTRIAR

CPS3E CTRIA3,CTRIAR

CAX3 CTRIA3,CTRIAR

CAX3H CTRIA3,CTRIAR

CAX3E CTRIA3,CTRIAR

CGAX3 CTRIA3,CTRIAR

CGAX3H CTRIA3,CTRIAR

AC2D3 CTRIA3,CTRIAR

tria3

ACAX3 CTRIA3,CTRIAR
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HM configuration Abaqus type Nastran type

DCAX3 CTRIA3,CTRIAR

DCAX3E CTRIA3,CTRIAR

DC2D3 CTRIA3,CTRIAR

DC2D3E CTRIA3,CTRIAR

S4 CQUAD4,CQUADR

S4R CQUAD4,CQUADR

S4R5 CQUAD4,CQUADR

M3D4 CQUAD4,CQUADR

M3D4R CQUAD4,CQUADR

SFM3D4 CQUAD4,CQUADR

SFM3D4R CQUAD4,CQUADR

R3D4 CQUAD4,CQUADR

DS4 CQUAD4,CQUADR

GK3D4L CQUAD4,CQUADR

GK3D4LN CQUAD4,CQUADR

F3D4 CQUAD4,CQUADR

CPE4I CQUAD4,CQUADR

CPE4 CQUAD4,CQUADR

CPE4H CQUAD4,CQUADR

CPE4IH CQUAD4,CQUADR

CPE4R CQUAD4,CQUADR

CPE4RH CQUAD4,CQUADR

CPE4T CQUAD4,CQUADR

CPE4HT CQUAD4,CQUADR

CPE4E CQUAD4,CQUADR

quad4

CPS4 CQUAD4,CQUADR
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HM configuration Abaqus type Nastran type

CPS4I CQUAD4,CQUADR

CPS4R CQUAD4,CQUADR

CPS4T CQUAD4,CQUADR

CPS4E CQUAD4,CQUADR

CAX4 CQUAD4,CQUADR

CAX4H CQUAD4,CQUADR

CAX4I CQUAD4,CQUADR

CAX4IH CQUAD4,CQUADR

CAX4R CQUAD4,CQUADR

CAX4RH CQUAD4,CQUADR

CAX4T CQUAD4,CQUADR

CAX4HT CQUAD4,CQUADR

CAX4E CQUAD4,CQUADR

CAXA4N CQUAD4,CQUADR

CAXA4HN CQUAD4,CQUADR

CAXA4RN CQUAD4,CQUADR

CAXA4RHN CQUAD4,CQUADR

CGAX4 CQUAD4,CQUADR

CGAX4H CQUAD4,CQUADR

CGAX4R CQUAD4,CQUADR

CGAX4RH CQUAD4,CQUADR

AC2D4 CQUAD4,CQUADR

ACAX4 CQUAD4,CQUADR

DC2D4 CQUAD4,CQUADR

DC2D4E CQUAD4,CQUADR

DCAX4 CQUAD4,CQUADR
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HM configuration Abaqus type Nastran type

DCAX4E CQUAD4,CQUADR

DCCAX4 CQUAD4,CQUADR

DCCAX4D CQUAD4,CQUADR

GKPS4 CQUAD4,CQUADR

GKPE4 CQUAD4,CQUADR

GKPS4N CQUAD4,CQUADR

STRI65 CTRIA6

M3D6 CTRIA6

SFM3D6 CTRIA6

DS6 CTRIA6

CPE6 CTRIA6

CPE6H CTRIA6

CPE6M CTRIA6

CPE6MH CTRIA6

CPS6 CTRIA6

CPS6M CTRIA6

AC2D6 CTRIA6

ACAX6 CTRIA6

DCAX6 CTRIA6

DC2D6 CTRIA6

DCAX6E CTRIA6

DC2D6E CTRIA6

CAX6 CTRIA6

CAX6H CTRIA6

CAX6M CTRIA6

tria6

CAX6MH CTRIA6
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HM configuration Abaqus type Nastran type

CGAX6 CTRIA6

CGAX6H CTRIA6

S8R CQUAD8

S8R5 CQUAD8

S8RT CQUAD8

M3D8 CQUAD8

M3D8R CQUAD8

SFM3D8 CQUAD8

SFM3D8R CQUAD8

DS8 CQUAD8

CPE8 CQUAD8

CPE8H CQUAD8

CPE8R CQUAD8

CPE8RH CQUAD8

CPS8 CQUAD8

CPS8R CQUAD8

AC2D8 CQUAD8

ACAX8 CQUAD8

DC2D8 CQUAD8

DCAX8 CQUAD8

DCAX8E CQUAD8

DC2D8E CQUAD8

CAX8 CQUAD8

CAX8H CQUAD8

CAX8HT CQUAD8

quad8

CAX8R CQUAD8
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HM configuration Abaqus type Nastran type

CAX8RH CQUAD8

CAX8RHT CQUAD8

CAX8RHT CQUAD8

CGAX8 CQUAD8

CGAX8H CQUAD8

CGAX8R CQUAD8

CGAX8RH CQUAD8

CAXA8N CQUAD8

CAXA8HN CQUAD8

CAXA8PN CQUAD8

CAXA8RN CQUAD8

CAXA8RHN CQUAD8

CAXA8RPN CQUAD8

C3D4 CTETRA

C3D4H CTETRA

C3D4E CTETRA

AC3D4 CTETRA

DC3D4 CTETRA

tetra4

DC3D4E CTETRA

C3D6 CPENTA

C3D6H CPENTA

C3D6E CPENTA

AC3D6 CPENTA

GK3D6 CPENTA

GK3D6N CPENTA

penta6

SC6R CPENTA
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HM configuration Abaqus type Nastran type

COH3D6 CPENTA

C3D8I

C3D8

C3D8T

C3D8H

C3D8HT

C3D8IH

C3D8R

C3D8RH

C3D8E

AC3D8

DC3D8

DC3D8E

DCC3D8

DCC3D8D

SC8R

hex8

COH3D8

C3D10 DC3D10

C3D10H DC3D11

C3D10M DC3D12

C3D10MH DC3D13

C3D10E DC3D14

DC3D10E DC3D15

AC3D10 DC3D16

tetra10

DC3D10 DC3D17

penta15 C3D15 CPENTA
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HM configuration Abaqus type Nastran type

C3D15H CPENTA

C3D15E CPENTA

AC3D15 CPENTA

DC3D15 CPENTA

DC3D15E CPENTA

C3D20 CHEXA

C3D20H CHEXA

C3D20R CHEXA

C3D20RH CHEXA

C3D20E CHEXA

C3D20RE CHEXA

C3D20T CHEXA

C3D20HT CHEXA

C3D20RT CHEXA

C3D20RHT CHEXA

DC3D20 CHEXA

AC3D20 CHEXA

hex20

DC3D20E CHEXA

Abaqus CONN3D2 connector elements are converted to Nastran CBUSH, PBUSH using the following
guidelines:

• Connector1 types converted:

◦ AXIAL: Active = [1], Rigid = [-]

◦ CARTESIAN, PROJECTION CARTESIAN: Active = [123], Rigid = [-]

◦ JOIN: Active = [-], Rigid = [123]

◦ RADIAL-THRUST: Active = [13]*, Rigid = [-]

Note:  Requires cylindrical system
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◦ SLIDE-PLANE: Active = [23], Rigid = [1]

◦ SLOT: Active = [1], Rigid = [23]

• Connector2 types converted:

◦ ALIGN: Active = [-], Rigid = [456]

◦ CARDAN, EULER, ROTATION, FLEXION-TORSION, PROJECTION FLEXION-TORSION: Active =
[456], Rigid = [-]

◦ REVOLUTE: Active = [4], Rigid = [56]

• Special assembled Connector1 types:

◦ BEAM, WELD = (JOIN + ALIGN): Active = [-], Rigid = [123456]

◦ CYLINDRICAL = (SLOT + REVOLUTE): Active = [14], Rigid = [2356]

◦ HINGE = (JOIN + REVOLUTE): Active = [4], Rigid = [12356]

◦ PLANAR = (SLIDE-PLANE + REVOLUTE): Active = [234], Rigid = [156]

◦ TRANSLATOR = (SLOT + ALIGN): Active = [1], Rigid = [23456]

◦ BUSHING = (PROJECTION CARTESIAN + PROJECTION FLEXION-TORSION): Active =
[123456], Rigid = [-]

• PBUSH stiffness and damping values (Ki, Bi) for active DOFs are mapped from *CONNECTOR
BEHAVIOR material data. Rigid DOFs map to RIGID option inside PBUSH.

• CBUSH orientation is mapped from *CONNECTOR SECTION Orientation system.

◦ Only 1 Orientation system can be mapped to CBUSH CID.

◦ If 2 Orientation systems are present in the Abaqus card, HyperMesh only maps the first one.

It is also possible to use a simplified conversion of Abaqus connectors (CONN3D2) to rbe2 elements
when modifying the ConfigurationFile.txt file. Change the entry for rod element type configuration
to: rod,CONN3D2 rigid,rbe2

CONN3D2 elements will now be converted to RBE2 elements. Depending on the connection type set
in the CONNECTOR SECTION, such as AXIAL or HINGE, degrees of freedom will be set for the RBE2
element. If systems are associated to the connector elemental nodes they will be assigned to the nodes
of the RBE2 as well. Not all connection types are supported. If a system is ignored by a particular
CONNECTOR SECTION, it will not be assigned to the nodes of the RBE2 either.

These connector types are currently considered in conversion: AXIAL, JOIN, LINK, SLIDE-PLANE, SLOT,
ALIGN, REVOLUTE, BEAM, CYLINDRICAL, HINGE, PLANAR, TRANSLATOR, WELD.

*COUPLING/*KINEMATIC constraints with element based surfaces, currently mapped to groups in
HyperMesh, are converted into RBE2 rigid elements. *COUPLING/*DISTRIBUTING constraints are
converted to RBE3 elements.

All SPRING and DASHPOT related conversions (including JOINTC) map to CELAS1, CDAMP1, or CBUSH/
PBUSH using the following guidelines:

• SPRING1/2 without ORIENTATION converts to CELAS1

• SPRINGA or SPRING1/2 with ORIENTATION converts to CBUSH/PBUSH/PBUSHT with K/KN lines.
For SPRING1/2, ORIENTATION maps to CBUSH, CID.

• DASHPOT1/2 without ORIENTATION converts to CDAMP1
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• DASHPOTA or DASHPOT1/2 with ORIENTATION converts to CBUSH/PBUSH/PBUSHT with B line. For
DASHPOT1/2, ORIENTATION maps to CBUSH, CID.

Sectional Properties
Some of the properties in one solver can be converted to two different sections in the other solver.
For an Abaqus to Nastran conversion, for example, *DASHPOT can be converted to *PELAS or
PDAMP. The property mapping scheme can be edited under the *PropertyConversion block in the
ConfigurationFile.txt file.

Please note that the property conversion scheme and corresponding element conversion scheme must
be consistent. For example, if you define *CONNECTOR SECTION to PBUSH at the property mapping
scheme, the corresponding element CONN3D2 must map to CBUSH in the element mapping scheme.

For SOLID SECTION the converter will always convert to PSOLID unless the property has a data
line indicating a cross-sectional area for a truss element. In this case, conversion results in a PROD
property.

For BEAM (GENERAL) SECTION the algorithm automatically decides which property to convert
to depending on the element type chosen in the ElementTypeConversion section of the
ConfigurationFile.txt. For example, if you want to convert B31 elements to CBAR, the beam
property will get converted to a PBAR or PBARL property. If you choose to convert B31 elements to
CBEAM, then the converter creates PBEAM or PBEAML properties accordingly. The same logic applies to
B32 elements; the difference is that they are changed to first order beam elements first on conversion.

Table 271: Supported Sectional Property Mappings

Abaqus type Nastran type

*BEAM GENERAL SECTION PBAR(L), PBEAM(L)

*BEAM SECTION PBAR(L), PBEAM(L)

*CONNECTOR SECTION PELAS,PBUSH

*DASHPOT PELAS,PDAMP

*GAP PGAP

*MASS CONM2

*MEMBRANE SECTION PSHELL

*ROTARY INERTIA CONM2

*SHELL GENERAL SECTION PSHELL

*SHELL SECTION PSHELL

*SOLID SECTION PSOLID

*SPRING PELAS, PBUSH
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Abaqus type Nastran type

*SOLID SECTION (Homogeneous) PROD

*SHELL GENERAL SECTION (Homogeneous) PSHELL

*SHELL SECTION (Homogeneous) PSHELL

*SHELL GENERAL SECTION (User) PSHELL

*SHELL SECTION (Composite) PCOMP, PCOMPG

*SHELL GENERAL SECTION (Composite) PCOMP, PCOMPG

Materials
The material mapping scheme can be edited under *PropertyConversion block in the
ConfigurationFile.txt file.

Table 272: Supported Material Mappings

Abaqus Nastran type

*MATERIAL MAT1, MAT4, MATT1, MATS1

*CONNECTOR BEHAVIOR PBUSH, PELAS

Loads
HyperMesh loads have two basic attributes – configuration (or config) and type. The supported load
"configs" are: force, moment, constraint, pressure, temperature, flux, velocity, acceleration and
equation. The load "type" defines the solver specific type of a particular configuration. For example,
pressure load can be any of the following Nastran types: PLOAD, PLOAD2 or PLOAD4. The Load Types
panel shows all supported load configurations and their types for a user profile.

The converter also converts distributed surfaces loads (*DLSOAD) applied on faces of shell or solid
elements into pressure loads (PLOAD4).

For a specific configuration, you can map any supported Abaqus load type to any supported Nastran
load type. The conversion tool does not support conversion across load configurations. The load
mapping scheme can be edited under the *BCsTypeConversion block in the ConfigurationFile.txt
file. You need to provide both configuration and type information to specify the mapping scheme as
shown below:

Table 273: Supported Load Mappings

HM configuration Abaqus type Nastran type

temperature TEMPERATURE TEMP
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HM configuration Abaqus type Nastran type

pressure DLOAD PLOAD,PLOAD2,PLOAD4

Constraint ACCELERATION SPCD

VELOCITY SPCD

BOUNDARY SPC,SUPORT

moment CLOAD MOMENT

force CLOAD FORCE

equation EQUATION MPC

Sets

Table 274: Supported Set Mappings

Abaqus type Nastran type

*NSET SET

*ELSET SET

Systems

Table 275: Supported System Mappings

Abaqus type Nastran type

*ORIENTATION CORD2C,CORD2R,CORD2S

*SYSTEM CORD2C,CORD2R,CORD2S

*TRANSFORM CORD2C,CORD2R,CORD2S

*TRANSFORM- USER DEFINED NSET CORD2C,CORD2R,CORD2S

Load Steps and Analysis Type
The conversion tool maps between Abaqus steps and Nastran subcases. It does not convert Abaqus
analysis type to the solution type. You must define it manually using the Load Step Browser.

The converter converts *STEP into SUBCASE. Load collector references are maintained upon
conversion. If multiple load collectors of a particular step contain constraints, a SPCADD card is created
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automatically. The same happens in case of loads in separate load collectors; a new LOAD card is
created on conversion.

Abaqus to Radioss Conversion Mapping

Elements

Table 276: Supported Element Mappings

Abaqus (Explicit) Radioss

C3D10M /BRICK

C3D4 /BRICK

C3D6 /BRICK

C3D8R /BRICK

S3R /SH3N

S4R /SHELL

SC8R /BRICK

SC6R /PENTA6

R3D3 /SH3N + /RBODY

R3D4 /SHELL + /RBODY

MASS /ADMAS

M3D4R/M3D3 /PROP/SHELL

Properties

Table 277: Supported Property Mappings

Abaqus (Explicit) Radioss

*SOLID_SECTION and *CONTROL_SECTION /PROP/SOLID

*SHELL_SECTION and *CONTROL_SECTION /PROP/SHELL or PROP/TSHELL

*RIGIDBODY PROP/SHELL or /PROP/SOLID

*MASS /ADMAS
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Abaqus (Explicit) Radioss

*SHELL SECTION COMPOSITE /PROP/TSH_COMP(P22_TSH_COMP)

Materials

Table 278: Supported Material Mappings

Abaqus (Explicit) Radioss

ELASTIC, ISOTROPIC /MAT/ELASTIC

PLASTIC, ISOTROPIC /MAT/PLAS_TAB

Hyperelastic, Mooney, Rivlin MAT/OGDEN

Hyperelastic, Ogden MAT/OGDEN

PLASTIC,JOHNSON COOK M2PLAS_JOHN_ZERIL

HYPERELASTIC,MARLOW /MAT/LAW70

HYPERFOAM, VISCOELASTIC /MAT/LAW62

Functions

Table 279: Supported Function Mappings

Abaqus (Explicit) Radioss

*AMPLITUDE /FUNCT, /MOVE_FUNCT

Groups

Table 280: Supported Group Mappings

Abaqus (Explicit) Radioss

*NSET /GRNOD

*ELSET /GSHEL, /GRSH3N, /GRBRIC
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Abaqus (Explicit) Radioss

*SURFACE /GRNOD, /SURF

Loads

Table 281: Supported Load Mappings

Abaqus (Explicit) Radioss

*BOUNDARY /IMPDISP, /IMPVEL, /IMPACC, /BCS

*INITIAL CONDITION /INIVEL

*CLOAD /CLOAD

*DLOAD /GRAV, /PLOAD

Contacts

Table 282: Supported Contact Mappings

Abaqus (Explicit) Radioss

*TIED, *CONTACT_CLEARANCE,
*SURFACE_INTERACTION

/INTER/TYPE2

*CONTACT_CLEARANCE,
*SURFACE_INTERACTION

/INTER/TYPE7

*CONTACT PAIR /INTER/TYPE24

GENERAL CONTACT /INTER/TYPE24

Constraints

Table 283: Supported Constraint Mappings

Abaqus (Explicit) Radioss

*COUPLING KINEMATIC, *COUPLING DYNAMIC /RBE2, /RBE3

*MPC BEAM
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Abaqus (Explicit) Radioss

/RBODY

Output Blocks

Table 284: Supported Output Block Mappings

Abaqus (Explicit) Radioss

*STEP, STEP NAME /TITLE and /RUN

*DYNAMIC, T_period /TSTOP

*VARIABLE MASS SCALING /DT/NODA/CST

*OUTPUT FIELD /ANIM/DT, /ANIM/VECT/(ACC, VEL, DISP, FINT,
PCONT), /ANIM/BRICK/TENS/(STRESS,STRAIN) /
ANIM/SHELL/TENS/(STRESS,STRAIN), /ANIM/
ELEM/(VONMISES, PRESSURE,EPSP, ENER, DENS)

*OUTPUT HISTORY /TFILE, /TH/NODE, /TH/SHEL, /TH/SH3N, /TH/
BEAM, /TH/BRIC

Abaqus to OptiStruct Conversion Mapping
The Abaqus to OptiStruct conversion uses an open conversion scheme; you can specify different
mappings in the configuration file.

Care has to be taken so that the element and property mappings are consistent. A valid mapping
scheme is provided in the ConfigurationFile.txt file. This document explains the scope and
limitations of the mapping scheme.

Contact and Pretension Groups
• Contacts

◦ NLPARM card is automatically created and assigned to a nonlinear quasi-static subcase for
models containing contacts.

◦ *SURFACE INTERACTION property with clearance/pressure vs conductivity is mapped to
PCONTHT with TABLED1 cards.

◦ *MODELCHANGE conversion is supported for both element set and contact group.

◦ *CONTACT PAIR will be mapped to FINITE when SMALL SLIDING is not defined.

◦ *CONTACT PAIR will be mapped to its default (SLIDE) when SMALL SLIDING is defined.

◦ *CONTACT CONTROLS are converted to CNTSTB and is mapped to loadstep.
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• Bolt Pretension

◦ *PRETENSION SECTION group maps to a PRETENS entity set with reference to a 1D pretension
element or a 3D pretension surface (SURF).

◦ *CLOAD applied to a pretension node converts to PTFORCE.

◦ *BOUNDARY applied to a pretension node converts to PTADJST.

◦ *BOUNDARY, FIXED option in step converts to STATSUB(PRETENS) on a preceding pretension
subcase.

Table 285: Supported Contact and Pretension Group Mappings

Abaqus type HM config, OptiStruct type

*SURFACE (node based) set, SET

*SURFACE (element based) contact surface, SURF

*CONTACT PAIR group, CONTACT

*TIE group, TIE

*PRETENSION SECTION set, PRETENS

contact surface, SURF

*SURFACE INTERACTION, Separatiopn, No/Yes Property ,PCONT, Separation, No/Yes

*CONTACT CONTROLS Load collector, CNTSTB

*MODEL CHANGE MODCHG

* RIGID BODY rbody, RBODY

*SHELL TO SOLID COUPLING Group, TIE

Elements
HyperMesh elements have two basic attributes – configuration (or config) and type. The "config" defines
the basic geometrical shape of an element. For example, tria3 configuration is a 3 node triangular
element and hexa8 is an 8-node hexahedral element. The "type" defines the solver specific element
type of a particular configuration. For example, the 4-node quadrilateral (quad4) element in Abaqus
can be any of the following types: S4, S4R, M3D4, R3D4, and so on. The Element Types panel shows all
supported element configurations and their types for a user profile.

For a specific configuration, you can map any supported Abaqus element type to any supported
OptiStruct element type, or vice versa. For example, for an Abaqus to OptiStruct direction, several 2-
noded element configurations such as spring, rigid, bar2, rid, and so on, are supported. Because all of
them are 2-noded elements, conversion across these configurations is also allowed for some element
types. For example, CBUSH is of "spring" configuration in the OptiStruct user profile and CONN3D2
is of "rod" configuration in the Abaqus user profile. It is possible to map a CBUSH to CONN3D2
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even though their configurations are different. The element mapping scheme must be under the
*ElemTypeConversion block in the ConfigurationFile.txt file. You need to provide both configuration
and type information to specify the element mapping scheme.

Table 286: Supported Element Mappings

HM configuration Abaqus OptiStruct type

MASS CONM2

ROTARYI CONM2

SPRING1 CELAS1, CELAS2, CBUSH

DASHPOT1 CELAS1, CELAS2, CBUSH

CONN3D2 CBUSH

Mass

CONN2D2 CBUSH

BEAM RBE2

LINK RBE2

PIN RBE2

TIE RBE2

KINCOUP RBE2

COUP_KIN RBE2

COUP_DIS RBE2

RB3D2 RBE2

R2D2 RBE2

RAX2 RBE2

rigid

RB2D2 RBE2

DCOUP3D RBE3

COUP_DIS RBE3

rbe3

DCOUP2D RBE3

KINCOUP RBE2

RB3D2 RBE2

rigidlink

BEAM RBE2
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HM configuration Abaqus OptiStruct type

LINK RBE2

PIN RBE2

TIE RBE2

COUP_KIN RBE2

COUP_DIS RBE2

R2D2 RBE2

RAX2 RBE2

RB2D2 RBE2

SPRING2 CELAS1, CBUSH

SPRINGA CBUSH

DASHPOT2 CDAMP1, CBUSH

DASHPOTA CBUSH

spring

JOINTC CBUSH

B31 CBAR,CBEAM

B31H CBAR,CBEAM

B33 CBAR,CBEAM

B33H CBAR,CBEAM

B31OS CBAR,CBEAM

B31OSH CBAR,CBEAM

PIPE31 CBAR,CBEAM

PIPE31H CBAR,CBEAM

ELBOW31 CBAR,CBEAM

ELBOW31B CBAR,CBEAM

ELBOW31C CBAR,CBEAM

AC1D2 CBAR,CBEAM

bar2

GK3D2 CBAR,CBEAM
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HM configuration Abaqus OptiStruct type

GK3D2N CBAR,CBEAM

SAX1 CBAR,CBEAM

B21 CBAR,CBEAM

B21H CBAR,CBEAM

B23 CBAR,CBEAM

B23H CBAR,CBEAM

PIPE21 CBAR,CBEAM

PIPE21H CBAR,CBEAM

F2D2 CBAR,CBEAM

FAX2 CBAR,CBEAM

B32 CBAR,CBEAM

B32H CBAR,CBEAM

B32OS CBAR,CBEAM

B32OSH CBAR,CBEAM

PIPE32 CBAR,CBEAM

PIPE32H CBAR,CBEAM

ELBOW32 CBAR,CBEAM

AC1D3 CBAR,CBEAM

MGAX2 CBAR,CBEAM

SFMAX2 CBAR,CBEAM

SFMGAX2 CBAR,CBEAM

SAX2 CBAR,CBEAM

B22 CBAR,CBEAM

B22H CBAR,CBEAM

PIPE22 CBAR,CBEAM

bar3

PIPE22H CBAR,CBEAM
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HM configuration Abaqus OptiStruct type

T3D2 CROD

T3D2H CROD

T3D2T CROD

T3D2E CROD

MGAX1 CROD

SFMAX1 CROD

SFMGAX1 CROD

CONN3D2 CROD

T2D2 CROD

T2D2H CROD

T2D2T CROD

T2D2E CROD

GK2D2 CROD

GK2D2N CROD

rod

CONN2D2 spring CELAS1,CELAS2,CBUSH

GAPUNI CGAP

GAPCYL CGAP

gap

GAPSPHER CGAP

S3 CTRIA3,CTRIAR

S3R CTRIA3,CTRIAR

STRI3 CTRIA3,CTRIAR

M3D3 CTRIA3,CTRIAR

SFM3D3 CTRIA3,CTRIAR

R3D3 CTRIA3,CTRIAR

DS3 CTRIA3,CTRIAR

tria3

CPE3 CTRIA3,CTRIAR
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HM configuration Abaqus OptiStruct type

CPE3H CTRIA3,CTRIAR

CPE3E CTRIA3,CTRIAR

CPS3 CTRIA3,CTRIAR

CPS3E CTRIA3,CTRIAR

CAX3 CTRIA3,CTRIAR

CAX3H CTRIA3,CTRIAR

CAX3E CTRIA3,CTRIAR

CGAX3 CTRIA3,CTRIAR

CGAX3H CTRIA3,CTRIAR

AC2D3 CTRIA3,CTRIAR

ACAX3 CTRIA3,CTRIAR

DCAX3 CTRIA3,CTRIAR

DCAX3E CTRIA3,CTRIAR

DC2D3 CTRIA3,CTRIAR

DC2D3E CTRIA3,CTRIAR

S4 CQUAD4,CQUADR

S4R CQUAD4,CQUADR

S4R5 CQUAD4,CQUADR

M3D4 CQUAD4,CQUADR

M3D4R CQUAD4,CQUADR

SFM3D4 CQUAD4,CQUADR

SFM3D4R CQUAD4,CQUADR

R3D4 CQUAD4,CQUADR

DS4 CQUAD4,CQUADR

GK3D4L CQUAD4,CQUADR

quad4

GK3D4LN CQUAD4,CQUADR
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HM configuration Abaqus OptiStruct type

F3D4 CQUAD4,CQUADR

CPE4I CQUAD4,CQUADR

CPE4 CQUAD4,CQUADR

CPE4H CQUAD4,CQUADR

CPE4IH CQUAD4,CQUADR

CPE4R CQUAD4,CQUADR

CPE4RH CQUAD4,CQUADR

CPE4T CQUAD4,CQUADR

CPE4HT CQUAD4,CQUADR

CPE4E CQUAD4,CQUADR

CPS4 CQUAD4,CQUADR

CPS4I CQUAD4,CQUADR

CPS4R CQUAD4,CQUADR

CPS4T CQUAD4,CQUADR

CPS4E CQUAD4,CQUADR

CAX4 CQUAD4,CQUADR

CAX4H CQUAD4,CQUADR

CAX4I CQUAD4,CQUADR

CAX4IH CQUAD4,CQUADR

CAX4R CQUAD4,CQUADR

CAX4RH CQUAD4,CQUADR

CAX4T CQUAD4,CQUADR

CAX4HT CQUAD4,CQUADR

CAX4E CQUAD4,CQUADR

CAXA4N CQUAD4,CQUADR

CAXA4HN CQUAD4,CQUADR

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Conversion Between Solver Formats p.2928

HM configuration Abaqus OptiStruct type

CAXA4RN CQUAD4,CQUADR

CAXA4RHN CQUAD4,CQUADR

CGAX4 CQUAD4,CQUADR

CGAX4H CQUAD4,CQUADR

CGAX4R CQUAD4,CQUADR

CGAX4RH CQUAD4,CQUADR

AC2D4 CQUAD4,CQUADR

ACAX4 CQUAD4,CQUADR

DC2D4 CQUAD4,CQUADR

DC2D4E CQUAD4,CQUADR

DCAX4 CQUAD4,CQUADR

DCAX4E CQUAD4,CQUADR

DCCAX4 CQUAD4,CQUADR

DCCAX4D CQUAD4,CQUADR

GKPS4 CQUAD4,CQUADR

GKPE4 CQUAD4,CQUADR

GKPS4N CQUAD4,CQUADR

STRI65 CTRIA6

M3D6 CTRIA6

SFM3D6 CTRIA6

DS6 CTRIA6

CPE6 CTRIA6

CPE6H CTRIA6

CPE6M CTRIA6

CPE6MH CTRIA6

tria6

CPS6 CTRIA6
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HM configuration Abaqus OptiStruct type

CPS6M CTRIA6

AC2D6 CTRIA6

ACAX6 CTRIA6

DCAX6 CTRIA6

DC2D6 CTRIA6

DCAX6E CTRIA6

DC2D6E CTRIA6

CAX6 CTRIA6

CAX6H CTRIA6

CAX6M CTRIA6

CAX6MH CTRIA6

CGAX6 CTRIA6

CGAX6H CTRIA6

S8R CQUAD8

S8R5 CQUAD8

S8RT CQUAD8

M3D8 CQUAD8

M3D8R CQUAD8

SFM3D8 CQUAD8

SFM3D8R CQUAD8

DS8 CQUAD8

CPE8 CQUAD8

CPE8H CQUAD8

CPE8R CQUAD8

CPE8RH CQUAD8

quad8

CPS8 CQUAD8
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HM configuration Abaqus OptiStruct type

CPS8R CQUAD8

AC2D8 CQUAD8

ACAX8 CQUAD8

DC2D8 CQUAD8

DCAX8 CQUAD8

DCAX8E CQUAD8

DC2D8E CQUAD8

CAX8 CQUAD8

CAX8H CQUAD8

CAX8HT CQUAD8

CAX8R CQUAD8

CAX8RH CQUAD8

CAX8RHT CQUAD8

CAX8RT CQUAD8

CGAX8 CQUAD8

CGAX8H CQUAD8

CGAX8R CQUAD8

CGAX8RH CQUAD8

CAXA8N CQUAD8

CAXA8HN CQUAD8

CAXA8PN CQUAD8

CAXA8RN CQUAD8

CAXA8RHN CQUAD8

CAXA8RHN CQUAD8

C3D4 CTETRAtetra4

C3D4H CTETRA
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HM configuration Abaqus OptiStruct type

C3D4E CTETRA

AC3D4 CTETRA

DC3D4 CTETRA

DC3D4E CTETRA

C3D4T CTETRA

C3D6 CPENTA

C3D6H CPENTA

C3D6H CPENTA

C3D6H CPENTA

DC3D6 CGASK6

DC3D6E CGASK6

GK3D6 CPENTA

GK3D6N CPENTA

SC6R CPENTA

penta6

COH3D6 CPENTA

C3D8I CHEXA

C3D8 CHEXA

C3D8T CHEXA

C3D8H CHEXA

C3D8HT CHEXA

C3D8IH CHEXA

C3D8R CHEXA

C3D8RH CHEXA

C3D8E CHEXA

AC3D8 CHEXA

hex8

DC3D8 CHEXA
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HM configuration Abaqus OptiStruct type

DC3D8E CHEXA

DCC3D8 CHEXA

DCC3D8D CHEXA

GK3D8 CGASK8

GK3D8N CGASK8

SC8R CHEXA

COH3D8 CHEXA

C3D10 DC3D10

C3D10H DC3D11

C3D10M DC3D12

C3D10MH DC3D13

C3D10E DC3D14

DC3D10E DC3D15

AC3D10 DC3D16

tetra10

DC3D10 DC3D17

C3D15 CPENTA

C3D15 CPENTA

C3D15 CPENTA

C3D15 CPENTA

C3D15 CPENTA

penta15

C3D15 CPENTA

C3D20 CHEXA

C3D20 CHEXA

C3D20R CHEXA

C3D20RH CHEXA

hex20

C3D20E CHEXA
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HM configuration Abaqus OptiStruct type

C3D20RE CHEXA

C3D20T CHEXA

C3D20HT CHEXA

C3D20RT CHEXA

C3D20RHT CHEXA

DC3D20 CHEXA

AC3D20 CHEXA

DC3D20E CHEXA

C3D8HT CPYRAPyramid

C3D20R CPYRA

Abaqus CONN3D2 connector C3D20R elements are converted to OptiStruct CBUSH, PBUSH or JOINTG
using the following guidelines:

• Connector1 types converted:

◦ AXIAL: Active = [1], Rigid = [-]

◦ CARTESIAN, PROJECTION CARTESIAN: Active = [123], Rigid = [-]

◦ JOIN: Active = [-], Rigid = [123]

◦ RADIAL-THRUST: Active = [13]*, Rigid = [-]

Note:  Requires cylindrical system

◦ SLIDE-PLANE: Active = [23], Rigid = [1]

◦ SLOT: Active = [1], Rigid = [23]

• Connector2 types converted:

◦ ALIGN: Active = [-], Rigid = [456]

◦ CARDAN, EULER, ROTATION, FLEXION-TORSION, PROJECTION FLEXION-TORSION: Active =
[456], Rigid = [-]

◦ REVOLUTE: Active = [4], Rigid = [56]

• Special assembled Connector1 types:

◦ BEAM, WELD = (JOIN + ALIGN): Active = [-], Rigid = [123456]

◦ CYLINDRICAL = (SLOT + REVOLUTE): Active = [14], Rigid = [2356]

◦ HINGE = (JOIN + REVOLUTE): Active = [4], Rigid = [12356]

◦ PLANAR = (SLIDE-PLANE + REVOLUTE): Active = [234], Rigid = [156]
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◦ TRANSLATOR = (SLOT + ALIGN): Active = [1], Rigid = [23456]

◦ BUSHING = (PROJECTION CARTESIAN + PROJECTION FLEXION-TORSION): Active =
[123456], Rigid = [-]

• PBUSH stiffness and damping values (Ki, Bi) for active DOFs are mapped from *CONNECTOR
BEHAVIOR material data. Rigid DOFs map to RIGID option inside PBUSH.

• CBUSH orientation is mapped from *CONNECTOR SECTION Orientation system.

◦ Only 1 Orientation system can be mapped to CBUSH CID.

◦ If 2 Orientation systems are present in the Abaqus card, HyperMesh only maps the first one.

It is possible to use a simplified conversion of Abaqus connectors (CONN3D2) to rbe2 elements when
modifying ConfigurationFile.txt in the following way (change the entry for rod element type
configuration: rod,CONN3D2 rigid,rbe2

CONN3D2 elements will now be converted to RBE2 elements. Depending on the connection type set
in the CONNECTOR SECTION (such as AXIAL or HINGE), degrees of freedom will be set for the RBE2
element. If systems are associated to the connector elemental nodes they will be assigned to the nodes
of the RBE2 as well. Not all connection types are supported. If a system is ignored by a particular
CONNECTOR SECTION, it will not be assigned to the nodes of the RBE2 either.

These connector types are currently considered in conversion: AXIAL, JOIN, LINK, SLIDE-PLANE, SLOT,
ALIGN, REVOLUTE, BEAM, CYLINDRICAL, HINGE, PLANAR, TRANSLATOR, WELD.

*KINEMATIC COUPLING constraints with element based surfaces (currently mapped to groups in
HyperMesh) are converted into RBE2 rigid elements. *DISTRIBUTING COUPLING constraints are
converted to RBE3 elements.

All SPRING and DASHPOT related conversions (including JOINTC) map to CELAS1, CDAMP1, or CBUSH/
PBUSH using the following guidelines:

• SPRING1/2 without ORIENTATION converts to CELAS1

• SPRINGA or SPRING1/2 with ORIENTATION converts to CBUSH/PBUSH/PBUSHT with K/KN lines.
For SPRING1/2, ORIENTATION maps to CBUSH, CID.

• DASHPOT1/2 without ORIENTATION converts to CDAMP1

• DASHPOTA or DASHPOT1/2 with ORIENTATION converts to CBUSH/PBUSH/PBUSHT with B line. For
DASHPOT1/2, ORIENTATION maps to CBUSH, CID.

• Convertor has an additional option: Convert *SPRING defined with Orientation to CBUSH. If
this option is enabled, *SPRING is converted to CBUSH if not enabled to CELAS.

Refer to the following table for Connector Section values:

Connector Section Values

AXIAL AXIAL

AXIAL, ALIGN AXIAL, ORIENT

BEAM (JOIN + ALIGN) BALL + ORIENT OR CBUSH, Pbush (RIGID all)

LINK RROD
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Connector Section Values

LINK, ALIGN RROD, ORIENT

JOIN BALL

JOIN, ROTATION BALL, CARDAN

HINGE (JOIN + REVOLUTE) REVOLUTE, BALL

SLOT INLINE

CYLINDRICAL (SLOT + REVOLUTE) INLINE + REVOLUTE

TRANSLATOR (SLOT + ALGIN) INLINE, ORIENT

CARTESIAN CARTESIAN

SLIDE-PLANE INLINE

UJOINT (JOIN + UNIVERSAL) BALL, UNIVERSAL

HINGE RBAR + REVOLUTE

Nodal thickness is mapped to respective grid post conversions.

Configuration file paths are selected in batch mode conversion. Conversion options can be used in batch
mode conversion by editing the configuration file.

Sectional Properties
Some of the properties in one solver can be converted to two different sections in the other solver.
For an Abaqus to OptiStruct conversion, for example, *DASHPOT can be converted to *PELAS or
PDAMP. The property mapping scheme can be edited under the *PropertyConversion block in the
ConfigurationFile.txt file.

The property conversion scheme and corresponding element conversion scheme must be consistent.
For example, if you define *CONNECTOR SECTION to PBUSH at the property mapping scheme, the
corresponding element CONN3D2 must map to CBUSH in the element mapping scheme.

For SOLID SECTION the converter will always convert to PSOLID unless the property has a data line
indicating a cross-sectional area for a truss element. In this case conversion results in a PROD property.

For BEAM (GENERAL) SECTION the algorithm automatically decides which property to convert
to depending on the element type chosen in the ElementTypeConversion section of the
ConfigurationFile.txt. For example, if you want to convert B31 elements to CBAR, the beam
property will get converted to a PBAR or PBARL property. If you choose to convert B31 elements to
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CBEAM, then the converter creates PBEAM or PBEAML properties accordingly. The same logic applies to
B32 elements; the difference is that they are changed to first order beam elements first on conversion.

Table 287: Supported Sectional Property Mappings

Abaqus type OptiStruct type

*SURFACE INTERACTION PCONT

*SURFACE BEHAVIOR, PRESSURE -OVERCLOSURE
= EXPONENTIAL

PCONT SOFT YES + STFEXP

*FRICTION PCONT

*CLEARENCE PCONT

*GASKET SECTION PGASK

*BEAM GENERAL SECTION PBAR(L), PBEAM(L)

*BEAM SECTION PBAR(L), PBEAM(L)

*CONNECTOR SECTION PELAS,PBUSH

*DASHPOT PELAS,PDAMP

*GAP PGAP

*MASS CONM2

*MEMBRANE SECTION PSHELL

*ROTARY INERTIA

CONM2

*SHELL GENERAL SECTION PSHELL

*SHELL GENERAL SECTION PSHELL

*SHELL SECTION PSOLID

*SOLID SECTION PELAS, PBUSH, PBUSHT

*SPRING PROD

*SOLID SECTION (Homogeneous) PSHELL

*SHELL GENERAL SECTION (Homogeneous) PSHELL

*SHELL GENERAL SECTION (User) PSHELL
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Abaqus type OptiStruct type

*SHELL SECTION (Composite) PCOMP, PCOMPG

*SHELL GENERAL SECTION (Composite) PCOMP, PCOMPG

Materials
The material mapping scheme can be edited under *PropertyConversion block in the
ConfigurationFile.txt file.

Table 288: Supported Material Mappings

Abaqus type OptiStruct type

*ELASTIC, ISOTROPIC MAT1

*ELASTIC, ISOTROPIC

E, poisson's ratio, T

MATT1 with TABLEM1 for E and
poisson's ratio

*ELASTIC, LAMINA MAT8

*PLASTIC

stress (x), plastic strain (y)

MATS1 with TYPSTRN=1 for
plastic strain.

TABLES1 with stress (y) vs
plastic strain (x)

*PLASTIC

stress (x), plastic strain (y),
Temp

For each T, need a separate
TABLES1.

TABLEST to define T and
corresponding TABLES1.

*SPECIFIC HEAT MAT4, CP

*CONDUCTIVITY MAT4, K

*MATERIAL

*EXPANSION

expansion coeff, T

MATT1 with TABLEM1 for
expansion coeff (A)

*GASKET ELASTICITY,
COMPONENT = MEMBRANE

MGASK + MAT1*GASKET BEHAVIOR

*GASKET ELASTICITY,

COMPONENT = TRANSVERSE
SHEAR

MGASK + MAT1

GPL field of MGASK card
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Abaqus type OptiStruct type

*GASKET THICKNESS
BEHAVIOR, DIRECTION =
LOADING

pressure (x), closure (y)

TABLES1 curve with pressure (y)
vs closure (x) definition

TABLES1 referred in TABLED field
of MGASK

*GASKET THICKNESS
BEHAVIOR, DIRECTION =
LOADING for TYPE = ELASTO-
PLASTIC

BEHAV = 0 in MGASK

*GASKET THICKNESS
BEHAVIOR, DIRECTION =
LOADING for TYPE = DAMAGE

BEHAV = 1 in MGASK

*GASKET THICKNESS
BEHAVIOR,
DIRECTION=LOADING for TYPE
= DAMAGE or ELASTO-PLASTIC
with TENSILE STIFFNESS
FACTOR

EPL in MGASK

*GASKET THICKNESS
BEHAVIOR, DIRECTION =
UNLOADING

pressure, closure, Max closure

For "n" max/plastic closure
values, creates "n" TABLES1 for
individual unloading pressure vs
closure curves.

TABLES1 referred in TABLU1

TABLUn fields in MGASK.

*EXPANSION

expansion coeff, T

*MATERIAL *CONDUCTIVITY MATT4,TABLEM1

*MATERIAL *HYPERELASTIC,OGDEN MATHE,OGDEN,TABLES1

*ELASTIC, TYPE = ENGINEERING CONSTANTS MAT9ORT

*CONNECTOR BEHAVIOR PBUSH, PELAS

Loads
HM loads have two basic attributes – configuration (or config) and type. The supported load "configs"
are: force, moment, constraint, pressure, temperature, flux, velocity, acceleration and equation. The
load "type" defines the solver specific type of a particular configuration. For example, pressure load can
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be any of the following OptiStruct types: PLOAD, PLOAD2, or PLOAD4. The Load Types panel shows all
supported load configurations and their types for a user profile.

The converter also converts distributed surfaces loads (*DLSOAD) applied on faces of shell or solid
elements into pressure loads (PLOAD4).

Temperature with *INTIAL condition is converted to TEMP(INTIAL) and mapped to Global Case Control.

FILM loads are converted to CHBDYE elements, sink temperatures are converted to SPC and heat
transfer coefficient(H) with PCONV.

SFILM loads are converted to CHBDYE elements, sink temperatures are converted to SPC and heat
transfer coefficient(H) with PCONV.

Distributed surfaces loads (*DLSOAD) applied on faces of shell or solid elements into pressure loads
(PLOAD4).

For a specific configuration, you can map any supported Abaqus load type to any supported OptiStruct
load type. The conversion tool does not support conversion across load configurations. The load
mapping scheme can be edited under the *BCsTypeConversion block in the ConfigurationFile.txt
file. You need to provide both configuration and type information to specify the mapping scheme.

Table 289: Supported Load Mappings

HM configuration Abaqus type OptiStruct type

temperature TEMPERATURE TEMP

pressure DLOAD PLOAD,PLOAD2,PLOAD4

pressure DLOAD, ROTA RACC

pressure CENTRIFUGAL RFORCE

FILM SPC

SFILM SPC

pressure

DFLUX QBDY1

ACCELERATION SPCD

VELOCITY SPCD

BOUNDARY SPC,SUPORT

Constraint

BOUNDARY on pretension node PTADJST

moment CLOAD MOMENT

CLOAD FORCEforce

CLOAD on pretension node PTFORCE
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HM configuration Abaqus type OptiStruct type

equation EQUATION MPC

temperature BOUNDARY SPC

Connector Load CONNECTOR LOAD LOADJG

Connector Motion CONNECTOR MOTION MOTIONJG

Sets

Table 290: Supported Set Mappings

Abaqus type OptiStruct type

*NSET SET

*ELSET SET

Control Cards
• Node set and element set from output block for displacement and stress are mapped.

• PARAM, INREL, -2 is created if there is *INERTIA RELIEF in the OptiStruct deck.

• PARAM, RBE3COL is created if there are rbe3 elements in the OptiStruct deck.

Systems

Table 291: Supported System Mappings

Abaqus type OptiStruct type

*ORIENTATION CORD2C,CORD2R,CORD2S

*SYSTEM CORD2C,CORD2R,CORD2S

*TRANSFORM CORD2C,CORD2R,CORD2S

*TRANSFORM- USER DEFINED NSET CORD2C,CORD2R,CORD2S

Control Cards
Displacement, Stress and Contact pressure output card is created on conversion and is mapped to
respective loadstep.

If OUTPUTBLOCK is not mapped to any loadstep these are updated in GLOBAL CASE CONTROL.
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*RESTART,WRITE,OVRELAY is converted to OS RESTARTW= 1 ,COVER

Load Steps and Analysis Type
The converter converts *STEP into respective supported SUBCASE. Load collector references are
maintained upon conversion. If multiple load collectors of a particular step have constraints, an SPCADD
card is created automatically. Similarly, a LOAD card is created for homogeneous loads and mapped to
step.

For models containing contacts, NLPARM card is automatically created and assigned to a nonlinear
quasi-static subcase.

Abaqus models that contain both conductivity and temperature defined under *CONDUCTIVITY in
*MATERIAL is converted to a non-linear Heat transfer (NLHEAT) analysis type in OptiStruct.

NLGEOM is set to YES in a loadstep with id 'i', CNTNLSUB will be set checked on, OPTION set to YES and
SCID points to the previous loadstep in loadstep with id 'i+1'. The chain continues for the loadsteps.

*PERTURBUTION steps are converted to linear static.

*FREQUENCY RESIDUAL=YES is converted to RESVEC=YES on conversion.

*FREQUENCY (analysis type) is converted to normal modes with the EIGRL card (load collector) mapped
in the loadstep on conversion.

*STATIC load step wuth Int_INC is mapped to NLPARM load collector with NINC=1/Int_INC.

*STATIC load step with MinIcr is mapped to NLADAPT,DTMIN load collector.

*STATIC load step with MaxIncr is mapped to NLADAPT,DTMAX load collector.

*STEP with unsymm=yes is converted to PARAM, UNSYMSLV.
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ANSYS Conversion

ANSYS to Abaqus Conversion Mapping

Materials
Modulus of Elasticity, Poisson's ratio and density are mapped.

Table 292: Supported Material Mappings

ANSYS type Abaqus type HM Configuration

MASS21 MASS Mass

COMBI14 SPRING2 Spring

BEAM4 B31 Bar2

LINK8 T3D2 Rod

SHELL43, SHELL63, SHELL181 S3 Tria3

SHELL43, SHELL63, SHELL181 S4 Quad4

SHELL93 STRI65 Tria6

SHELL93 S8R Quad8

SOLID45, SOLID62, SOLID64,
SOLID69, SOLID70, SOLID96,
SOLID97, SOLID164, SOLID185

C3D4 Tetra4

SOLID62, SOLID70, SOLID96,
SOLID97, SOLID164

C3D8 Pyramid5

SOLID5, SOLID45, SOLID62,
SOLID64, SOLID69, SOLID70,
SOLID96, SOLID97, SOLID164,
SOLID185

C3D6 Penta6

SOLID5, SOLID45, SOLID62,
SOLID64, SOLID69, SOLID70,
SOLID96, SOLID97, SOLID164,
SOLID185

C3D81 Hex8

SOLID87, SOLID90, SOLID92,
SOLID95, SOLID98, SOLID117,

C3D10 Tetra10
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ANSYS type Abaqus type HM Configuration

SOLID148, SOLID168,
SOLID186, SOLID187, SOLID191

SOLID90, SOLID95, SOLID117,
SOLID186

C3D20 Pyramid13

SOLID90, SOLID95, SOLID117,
SOLID147, SOLID186, SOLID191

C3D15 Penta15

SOLID90, SOLID95, SOLID117,
SOLID147, SOLID186, SOLID191

Hex20

MPC184 BEAM_RIGID Rigid

RBE3, CONTA175, TARGE170 COUP_DIS RBE3

CP COUP_KIN Rigid

COMBIN39 SPRINGA Spring

Properties

Table 293: Supported Property Mappings

ANSYS type Abaqus type Convert Parameters

MASS21p MASS none

COMBI14p SPRING none

BEAM4p, LINK8p BEAMSECTION none

SHELL43p, SHELL63p, SHELL93p SHELLSECTION Shell Thickness

SOLID45p, SOLID70p,
SOLID95p, SOLID117p,
SOLID191p

SOLIDSECTION none

BEAM4p BEAMGENSECTION Area, Ixx,Iyy,Izz
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Note:  If ANSYS solid elements do not have a property, then one SOLIDSECTION property
will be created by using this conversion tool.

Loads and Boundary Conditions
Loads and boundary conditions will not be converted on using this conversion tool.

ANSYS to Nastran Conversion Mapping

Conversion Notes
• All ANSYS solid and shell elements that are currently supported are included in the conversion tool.

• Material properties – Thermal Conductivity, specific heat, thermal expansion co-efficient can be now
converted.

• Nonlinear material data and temperature dependent materials defined through TB tables are
converted to TABLESx cards inside a MATS1.

• 2D and 3D Orthotropic properties of E, NU, and Alpha can be converted.

• If components or properties do not have a material associated to them on conversion, then MID =
1 will be associated.

• On conversion, a model will be cleaned by removing unused sets, ET types, and contact elements.

• COMBIN14 elements are now converted to CELAS1 if key option2 for COMBIN14 in ANSYS is
defined. If key option 3 is defined, it is converted to 3 coincident CELAS (1 per DOF).

• ANSYS BEAM188 converts to CBEAM now [please note section properties defined using SECDATA
card in ANSYS are not yet converted].

• Forces, Moments, Pressures, Temperatures and Constraints are automatically converted. MODOPT
(control cards) will be mapped to EIRGL. ACEL (Control Cards) will be converted to GRAV.

• BEAM44 element type end release options defined in KEYOPTIONS 7 and 8 are converted to values
in fields PA and PB respectively in the CBEAM card.

• BEAM188 section properties are converted from the BeamSection Collector data and not from the
EtType Sensor (this is how the BEAM188 section data is modeled in the HyperMesh ANSYS User
Profile).

◦ SECTYPE with TYPE equal to BEAM and SUBTYPEs equal to RECT, CSOLID, CTUBE, I, L, T
convert to a PBEAML property with corresponding standard section definition.

◦ SECTYPE with TYPE equal to BEAM and SUBTYPEs equal to ASEC, QUAD, CHAN, Z, HATS, HREC
convert to a PBEAM property with corresponding cross section property values.

• MPC184 converts to either a RBE2 rigid element or a CBUSH/PBUSH bushing element depending on
the KEYOPT(1) value, as follows:

◦ KEYOPT(1) equal to 0 converts to RBE2 with constraint DOFs equal to [123]

◦ KEYOPT(1) equal to 1 converts to RBE2 with constraint DOFs equal to [123456]

◦ KEYOPT(1) equal to 6 converts to CBUSH + PBUSH

∙ K4 equals <blank>/0.0
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∙ K1, K2, K3, K5, K6 equals 1e10

◦ KEYOPT(1) equal to 8 converts to CBUSH + PBUSH

∙ K1, K4, K5, K6 equals <blank>/0.0

∙ K2, K3 equals 1E10

◦ KEYOPT(1) equal to 9 converts to CBUSH + PBUSH

∙ K2, K3, K4, K5, K6 equals <blank>/0.0

∙ K1 equals 1E10

◦ KEYOPT(1) equal to 10 converts to CBUSH + PBUSH

∙ K1 equals <blank>/0.0

∙ K2, K3, K4, K5, K6 equals 1E10

◦ KEYOPT(1) equal to 11 converts to CBUSH + PBUSH

∙ K1, K4 equals <blank>/0.0

∙ K2, K3, K5, K6 equals 1E10

◦ KEYOPT(1) equal to 12 converts to CBUSH + PBUSH

∙ K2, K3, K4 equals <blank>/0.0

∙ K1, K5, K6 equals 1E10

◦ KEYOPT(1) equal to 13 converts to RBE2 with constraint DOFs equal to [123456]

◦ KEYOPT(1) equal to 14 converts to RBE2 with constraint DOFs equal to [456]

◦ KEYOPT(1) equal to 15 converts to RBE2 with constraint DOFs equal to [123]

Assumptions

• The Conversion tool will only convert entities imported by the ANSYS FE input reader.

• For shell elements, constant thickness parts are assumed.

• Analysis types assumed: Static – gravity, forces, pressures and constraints; Modal.

Elements

Table 294: Supported Element Mappings

ANSYS Nastran

mass, CONTAC175 sets, GRID

mass, MASS21 mass, CONM2

rigid, CP equation, MPC

rigid, CERIG rbe2, RBE2

rigidlink, CP equation, MPC

rigidlink, CERIG equation, MPC

rbe3/RBE3 rbe3/RBE3
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ANSYS Nastran

spring, CONBIN14 spring, CBUSH

bar2, BEAM44 bar2, CBEAM

bar2, BEAM188 bar2, CBEAM

bar2, PIPE16 bar2, CBEAM

bar2, BEAM4 bar2, CBEAM

rod, LINK8 rod, CROD

rod, MPC184 rbe2,RBE2 / spring,CBUSH

tria3, PLANE182 tria3, CTRIA3

tria3, SHELL181 tria3, CTRIA3

tria3, SHELL163 tria3, CTRIA3

tria3, PLANE162 tria3, CTRIA3

tria3, SHELL157 tria3, CTRIA3

tria3, SHELL143 tria3, CTRIA3

tria3, SHELL131 tria3, CTRIA3

tria3, PLANE75 tria3, CTRIA3

tria3, PLANE67 tria3, CTRIA3

tria3, SHELL63 tria3, CTRIA3

tria3, SHELL57 tria3, CTRIA3

tria3, PLANE55 tria3, CTRIA3

tria3, SHELL43 tria3, CTRIA3

tria3, PLANE42 tria3, CTRIA3

tria3, SHELL41 tria3, CTRIA3

tria3, PLANE25 tria3, CTRIA3

tria3, PLANE13 tria3, CTRIA3

quad4, PLANE182 quad4, CQUAD4

quad4, SHELL181 quad4, CQUAD4
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ANSYS Nastran

quad4, SEHLL163 quad4, CQUAD4

quad4, PLANE162 quad4, CQUAD4

quad4, SHELL157 quad4, CQUAD4

quad4, SHELL143 quad4, CQUAD4

quad4, SHELL131 quad4, CQUAD4

quad4, PLANE75 quad4, CQUAD4

quad4, PLANE67 quad4, CQUAD4

quad4, SHELL63 quad4, CQUAD4

quad4, SHELL57 quad4, CQUAD4

quad4, PLANE55 quad4, CQUAD4

quad4, SHELL43 quad4, CQUAD4

quad4, PLANE42 quad4, CQUAD4

quad4, SHELL41 quad4, CQUAD4

quad4, SHELL28 quad4, CQUAD4

quad4, PLANE25 quad4, CQUAD4

quad4, PLANE13 quad4, CQUAD4

tetra4, SOLID185 tetra4, CTETRA

tetra4, SOLID164 tetra4, CTETRA

tetra4, SOLID97 tetra4, CTETRA

tetra4, SOLID96 tetra4, CTETRA

tetra4, SOLID73 tetra4, CTETRA

tetra4, SOLID72 tetra4, CTETRA

tetra4, SOLID70 tetra4, CTETRA

tetra4, SOLID69 tetra4, CTETRA

tetra4, SOLID64 tetra4, CTETRA

tetra4, SOLID62 tetra4, CTETRA
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ANSYS Nastran

tetra4, SOLID46 tetra4, CTETRA

tetra4, SOLID45 tetra4, CTETRA

tetra4, SOLID285 tetra4, CTETRA

penta6, SOLSH190 penta6, CPENTA

penta6, SOLID185 penta6, CPENTA

penta6, SOLID164 penta6, CPENTA

penta6, VISCO107 penta6, CPENTA

penta6, SOLID97 penta6, CPENTA

penta6, SOLID96 penta6, CPENTA

penta6, SOLID73 penta6, CPENTA

penta6, SOLID70 penta6, CPENTA

penta6, SOLID69 penta6, CPENTA

penta6, SOLID64 penta6, CPENTA

penta6, SOLID62 penta6, CPENTA

penta6, SOLID46 penta6, CPENTA

penta6, SOLID45 penta6, CPENTA

penta6, SOLID5 penta6, CPENTA

hex8, SOLSH190 hex8, CHEXA

hex8, SOLID185 hex8, CHEXA

hex8, SOLID164 hex8, CHEXA

hex8, SOLID97 hex8, CHEXA

hex8, SOLID96 hex8, CHEXA

hex8, SOLID73 hex8, CHEXA

hex8, SOLID70 hex8, CHEXA

hex8, SOLID69 hex8, CHEXA

hex8, SOLID64 hex8, CHEXA
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ANSYS Nastran

hex8, SOLID62 hex8, CHEXA

hex8, SOLID46 hex8, CHEXA

hex8, SOLID45 hex8, CHEXA

hex8, SOLID5_1 hex8, CHEXA

tria6, PLANE183 tria6, CTRIA6

tria6, SHELL150 tria6, CTRIA6

tria6, PLANE145 tria6, CTRIA6

tria6, SHELL132 tria6, CTRIA6

tria6, SHELL281 tria6, CTRIA6

tria6, PLANE121 tria6, CTRIA6

tria6, SHELL99 tria6, CTRIA6

tria6, SHELL93 tria6, CTRIA6

tria6, SHELL91 tria6, CTRIA6

tria6, PLANE83 tria6, CTRIA6

tria6, PLANE82 tria6, CTRIA6

tria6, PLANE78 tria6, CTRIA6

tria6, PLANE77 tria6, CTRIA6

tria6, PLANE53 tria6, CTRIA6

tria6, PLANE35 tria6, CTRIA6

tria6, PLANE2 tria6, CTRIA6

quad8, PLANE183 quad8, CQUAD8

quad8, SHELL150 quad8, CQUAD8

quad8, PLANE145 quad8, CQUAD8

quad8, SHELL132 quad8, CQUAD8

quad8, SHELL281 quad8, CQUAD8

quad8, PLANE121 quad8, CQUAD8
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ANSYS Nastran

quad8, SHELL99 quad8, CQUAD8

quad8, SHELL93 quad8, CQUAD8

quad8, SHELL91 quad8, CQUAD8

quad8, PLANE83 quad8, CQUAD8

quad8, PLANE82 quad8, CQUAD8

quad8, PLANE78 quad8, CQUAD8

quad8, PLANE77 quad8, CQUAD8

quad8, PLANE53 quad8, CQUAD8

tetra10, SOLID191 tetra10, CTETRA

tetra10, SOLID187 tetra10, CTETRA

tetra10, SOLID186 tetra10, CTETRA

tetra10, SOLID148 tetra10, CTETRA

tetra10, SOLID117 tetra10, CTETRA

tetra10, SOLID98 tetra10, CTETRA

tetra10, SOLID95 tetra10, CTETRA

tetra10, SOLID92 tetra10, CTETRA

tetra10, SOLID90 tetra10, CTETRA

tetra10, SOLID87 tetra10, CTETRA

penta15, SOLID191 penta15, CPENTA

penta15, SOLID186 penta15, CPENTA

penta15, SOLID147 penta15, CPENTA

penta15, SOLID117 penta15, CPENTA

penta15, SOLID95 penta15, CPENTA

penta15, SOLID90 penta15, CPENTA

hex20, SOLID191 hex20, CHEXA

hex20, SOLID191 hex20, CHEXA
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ANSYS Nastran

hex20, SOLID191 hex20, CHEXA

hex20, SOLID191 hex20, CHEXA

hex20, SOLID191 hex20, CHEXA

hex20, SOLID191 hex20, CHEXA

Properties

Table 295: Supported Property Mappings

ANSYS Nastran

LINK8P LINK8P

BEAM4P PBEAM

BEAM44P PBEAM

SOLID45P PSOLID

SOLID46P PSOLID

SOLID70P PSOLID

SOLID95P PSOLID

SOLID97P PSOLID

SOLID117P PSOLID

SOLID185P PSOLID

SOLID191P PSOLID

SHELL28P PSHELL

SHELL41P PSHELL

SHELL43P PSHELL

SHELL57P PSHELL

SHELL63P PSHELL

SHELL91P PCOMP

SHELL93P PSHELL
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ANSYS Nastran

SHELL99P PCOMP

SHELL131P PCOMP

SHELL132P PCOMP

SHELL143P PSHELL

SHELL150P PSHELL

SHELL157P PSHELL

SHELL181P PSHELL

SHELL281P PSHELL

PLANE2P PSHELL

PLANE42P PSHELL

PLANE82P PSHELL

PLANE145P PSHELL

PLANE183P PSHELL

PIPE16P PBEAML

COMBIN14P PBUSH

MASS21P CONM2

Materials

Table 296: Supported Material Mappings

ANSYS Nastran

MP MAT1
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ANSYS Nastran

MPDATA MAT1

Loads

Table 297: Supported Load Mappings

ANSYS Nastran

temperature, BF_TEMP temperature, TEMP

temperature, IC_TEMP temperature, TEMP

temperature, D_TEMP temperature, TEMP

pressure, HFLUX pressure, PLOAD2

pressure, ConvBulkTe pressure, PLOAD

pressure, PRESSURE pressure, PLOAD4

constraint, D_VOLT constraint, ASET1

constraint, IC_CONSTRNT constraint, SPCD

constraint, D_CONSTRAIN constraint, SPC

moment, FORCE2 moment, MOMENT
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ANSYS Nastran

force, FORCE force, FORCE

Sets

Table 298: Supported Set Mappings

ANSYS Nastran

set set

Cards

Table 299: Supported Card Mappings

ANSYS Nastran

ACEL GRAV

Sensors

Table 300: Supported Sensor Mappings

ANSYS Nastran

Link8 PROD

BEAM4 PBEAM

BEAM44 PBEAM

BEAM188 PBEAML

SOLID5 PSOLID

SOLID5 PSOLID

SOLID46 PSOLID

SOLID62 PSOLID

SOLID64 PSOLID

SOLID69 PSOLID

SOLID70 PSOLID
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ANSYS Nastran

SOLID87 PSOLID

SOLID90 PSOLID

SOLID92 PSOLID

SOLID95 PSOLID

SOLID96 PSOLID

SOLID97 PSOLID

SOLID98 PSOLID

SOLID117 PSOLID

SOLID147 PSOLID

SOLID148 PSOLID

SOLID164 PSOLID

SOLID185 PSOLID

SOLID186 PSOLID

SOLID187 PSOLID

SOLID191 PSOLID

SOLSH190 PSOLID

SOLID226 PSOLID

SOLID227 PSOLID

SOLID285 PSOLID

SHELL28 PSHELL

SHELL41 PSHELL

SHELL43 PSHELL

SHELL51 PSHELL

SHELL57 PSHELL

SHELL63 PSHELL

SHELL91 PCOMP
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ANSYS Nastran

SHELL93 PSHELL

SHELL99 PCOMP

SHELL131 PCOMP

SHELL132 PCOMP

SHELL143 PSHELL

SHELL150 PSHELL

SHELL157 PSHELL

SHELL181 PCOMP OR PSHELL

SHELL281 PCOMP OR PSHELL

PLANE2 PSHELL

PLANE13 PSHELL

PLANE25 PSHELL

PLANE35 PSHELL

PLANE42 PSHELL

PLANE67 PSHELL

PLANE75 PSHELL

PLANE77 PSHELL

PLANE78 PSHELL

PLANE82 PSHELL

PLANE83 PSHELL

PLANE121 PSHELL

PLANE145 PSHELL

PLANE162 PSHELL

PLANE183 PSHELL

PLANE223 PSHELL

PIPE16 PBEAM
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ANSYS Nastran

COMBIN14 PBUSH

MASS21 CONM2

MPC184 PBUSH

ANSYS to OptiStruct Conversion Mapping

Conversion Notes
• All ANSYS solid and shell elements that are currently supported are included in the conversion tool.

• Material properties – Thermal Conductivity, specific heat, thermal expansion co-efficient can be now
converted.

• Nonlinear material data and temperature dependent materials defined through TB tables are
converted to TABLESx cards inside a MATS1.

• 2D and 3D Orthotropic properties of E, NU, and Alpha can be converted.

• If components or properties do not have a material associated to them on conversion, then MID
equal to 1 will be associated.

• On conversion, a model will be cleaned by removing unused sets, ET types, and contact elements.

• COMBIN14 elements are now converted to CELAS1 if key option2 for COMBIN14 in ANSYS is
defined. If key option 3 is defined, it is converted to 3 coincident CELAS (1 per DOF).

• Forces, Moments, Pressures, Temperatures and Constraints are automatically converted. MODOPT
(control cards) will be mapped to EIRGL. ACEL (Control Cards) will be converted to GRAV.

• Surface to Surface and Node to Surface contact pairs can be converted to OptiStruct. Contact
element pairs CONTA173-TARGE170 and CONTA174-TARGE170 are converted to SURF (contact
surfaces) in OptiStruct, and CONTA175 is converted to Grid SET. A CONTACT group for each contact
pair is created during conversion.

• Composite data conversion: ANSYS composite elements and layer information is converted to
OptiStruct composite elements and composite property information.

• BEAM44 element type, end release options defined in KEYOPTIONS 7 and 8 are converted to values
in fields PA and PB respectively in CBEAM card.

• BEAM188 section properties are converted from the BeamSection Collector data and not from the
EtType Sensor (this is how the BEAM188 section data is modeled in the HyperMesh ANSYS User
Profile).

◦ SECTYPE with TYPE equal to BEAM and SUBTYPEs equal to RECT, CSOLID, CTUBE, I, L, T
convert to a PBEAML property with corresponding standard section definition.

◦ SECTYPE with TYPE equal to BEAM and SUBTYPEs equal to ASEC, QUAD, CHAN, Z, HATS, HREC
convert to a PBEAM property with corresponding cross section property values.
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• MPC184 converts to either a RBE2 rigid element or a CBUSH/PBUSH bushing element depending on
the KEYOPT(1) value, as follows:

◦ KEYOPT(1) equal to 0 converts to RBE2 with constraint DOFs equal to [123]

◦ KEYOPT(1) equal to 1 converts to RBE2 with constraint DOFs equal to [123456]

◦ KEYOPT(1) equal to 6 converts to CBUSH + PBUSH

∙ K4 equals <blank>/0.0

∙ K1, K2, K3, K5, K6 equals RIGID

◦ KEYOPT(1) equal to 8 converts to CBUSH + PBUSH

∙ K1, K4, K5, K6 equals <blank>/0.0

∙ K2, K3 equals RIGID

◦ KEYOPT(1) equal to 9 converts to CBUSH + PBUSH

∙ K2, K3, K4, K5, K6 equals <blank>/0.0

∙ K1 equals RIGID

◦ KEYOPT(1) equal to 10 converts to CBUSH + PBUSH

∙ K1 equals <blank>/0.0

∙ K2, K3, K4, K5, K6 equals RIGID

◦ KEYOPT(1) equal to 11 converts to CBUSH + PBUSH

∙ K1, K4 equals <blank>/0.0

∙ K2, K3, K5, K6 equals RIGID

◦ KEYOPT(1) equal to 12 converts to CBUSH + PBUSH

∙ K2, K3, K4 equals <blank>/0.0

∙ K1, K5, K6 equals RIGID

◦ KEYOPT(1) equal to 13 converts to RBE2 with constraint DOFs equal to [123456]

◦ KEYOPT(1) equal to 14 converts to RBE2 with constraint DOFs equal to [456]

◦ KEYOPT(1) equal to 15 converts to RBE2 with constraint DOFs equal to [123]

Asseumptions:

• The Conversion tool only converts entities imported by the ANSYS FE input reader.

• For shell elements, constant thickness parts are assumed.

• Analysis types assumed: Static – gravity, forces, pressures and constraints; Modal.

Elements

Table 301: Supported Element Mappings

ANSYS OptiStruct

mass, CONTAC175 sets, GRID

mass, MASS21 mass, CONM2

rigid, CP equation, MPC
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ANSYS OptiStruct

rigid, CERIG rbe2, RBE2

rigidlink, CP equation, MPC

rigidlink, CERIG equation, MPC

rbe3/RBE3 rbe3, RBE3

spring, COMBIN14 spring, CBUSH

bar2, BEAM44 bar2, CBEAM

bar2, BEAM188 bar2, CBEAM

bar2, PIPE16 bar2, CBEAM

bar2, BEAM4 bar2, CBEAM

rod, LINK8 rod, CROD

rod, MPC184 rbe2,RBE2 / spring,CBUSH

tria3, PLANE182 tria3, CTRIA3

tria3, SHELL181 tria3, CTRIA3

tria3, CONTA173 contact surf

tria3, TARGE170 contact surf

tria3, SHELL163 tria3, CTRIA3

tria3, PLANE162 tria3, CTRIA3

tria3, SHELL157 tria3, CTRIA3

tria3, SHELL143 tria3, CTRIA3

tria3, SHELL131 tria3, CTRIA3

tria3, PLANE75 tria3, CTRIA3

tria3, PLANE67 tria3, CTRIA3

tria3, SHELL63 tria3, CTRIA3

tria3, SHELL57 tria3, CTRIA3

tria3, PLANE55 tria3, CTRIA3

tria3, SHELL43 tria3, CTRIA3
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ANSYS OptiStruct

tria3, PLANE42 tria3, CTRIA3

tria3, SHELL41 tria3, CTRIA3

tria3, PLANE25 tria3, CTRIA3

tria3, PLANE13 tria3, CTRIA3

quad4, PLANE182 quad4, CQUAD4

quad4, SHELL181 quad4, CQUAD4

quad4, CONTA173 contact surf

quad4, TARGE170 contact surf

quad4, SEHLL163 quad4, CQUAD4

quad4, PLANE162 quad4, CQUAD4

quad4, SHELL157 quad4, CQUAD4

quad4, SHELL143 quad4, CQUAD4

quad4, SHELL131 quad4, CQUAD4

quad4, PLANE75 quad4, CQUAD4

quad4, PLANE67 quad4, CQUAD4

quad4, SHELL63 quad4, CQUAD4

quad4, SHELL57 quad4, CQUAD4

quad4, PLANE55 quad4, CQUAD4

quad4, SHELL43 quad4, CQUAD4

quad4, PLANE42 quad4, CQUAD4

quad4, SHELL41 quad4, CQUAD4

quad4, SHELL28 quad4, CQUAD4

quad4, PLANE25 quad4, CQUAD4

quad4, PLANE13 quad4, CQUAD4

tetra4, SOLID185 tetra4, CTETRA

tetra4, SOLID164 tetra4, CTETRA
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ANSYS OptiStruct

tetra4, SOLID97 tetra4, CTETRA

tetra4, SOLID96 tetra4, CTETRA

tetra4, SOLID73 tetra4, CTETRA

tetra4, SOLID72 tetra4, CTETRA

tetra4, SOLID70 tetra4, CTETRA

tetra4, SOLID69 tetra4, CTETRA

tetra4, SOLID64 tetra4, CTETRA

tetra4, SOLID62 tetra4, CTETRA

tetra4, SOLID46 tetra4, CTETRA

tetra4, SOLID45 tetra4, CTETRA

tetra4, SOLID285 tetra4, CTETRA

penta6, SOLSH190 penta6, CPENTA

penta6, SOLID185 penta6, CPENTA

penta6, SOLID164 penta6, CPENTA

penta6, VISCO107 penta6, CPENTA

penta6, SOLID97 penta6, CPENTA

penta6, SOLID96 penta6, CPENTA

penta6, SOLID73 penta6, CPENTA

penta6, SOLID70 penta6, CPENTA

penta6, SOLID69 penta6, CPENTA

penta6, SOLID64 penta6, CPENTA

penta6, SOLID62 penta6, CPENTA

penta6, SOLID46 penta6, CPENTA

penta6, SOLID45 penta6, CPENTA

penta6, SOLID5 penta6, CPENTA

hex8, SOLSH190 hex8, CHEXA
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ANSYS OptiStruct

hex8, SOLID185 hex8, CHEXA

hex8, SOLID164 hex8, CHEXA

hex8, SOLID97 hex8, CHEXA

hex8, SOLID96 hex8, CHEXA

hex8, SOLID73 hex8, CHEXA

hex8, SOLID70 hex8, CHEXA

hex8, SOLID69 hex8, CHEXA

hex8, SOLID64 hex8, CHEXA

hex8, SOLID62 hex8, CHEXA

hex8, SOLID46 hex8, CHEXA

hex8, SOLID45 hex8, CHEXA

hex8, SOLID5_1 hex8, CHEXA

tria6, PLANE183 tria6, CTRIA6

tria6, CONTA174 contact surf

tria6, TARGE170 contact surf

tria6, SHELL150 tria6, CTRIA6

tria6, PLANE145 tria6, CTRIA6

tria6, SHELL132 tria6, CTRIA6

tria6, SHELL281 tria6, CTRIA6

tria6, PLANE121 tria6, CTRIA6

tria6, SHELL99 tria6, CTRIA6

tria6, SHELL93 tria6, CTRIA6

tria6, SHELL91 tria6, CTRIA6

tria6, PLANE83 tria6, CTRIA6

tria6, PLANE82 tria6, CTRIA6

tria6, PLANE78 tria6, CTRIA6
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ANSYS OptiStruct

tria6, PLANE77 tria6, CTRIA6

tria6, PLANE53 tria6, CTRIA6

tria6, PLANE35 tria6, CTRIA6

tria6, PLANE2 tria6, CTRIA6

quad8, PLANE183 quad8, CQUAD8

quad8, CONTA174 contact surf

quad8, TARGE170 contact surf

quad8, SHELL150 quad8, CQUAD8

quad8, PLANE145 quad8, CQUAD8

quad8, SHELL132 quad8, CQUAD8

quad8, SHELL281 quad8, CQUAD8

quad8, PLANE121 quad8, CQUAD8

quad8, SHELL99 quad8, CQUAD8

quad8, SHELL93 quad8, CQUAD8

quad8, SHELL91 quad8, CQUAD8

quad8, PLANE83 quad8, CQUAD8

quad8, PLANE82 quad8, CQUAD8

quad8, PLANE78 quad8, CQUAD8

quad8, PLANE77 quad8, CQUAD8

quad8, PLANE53 quad8, CQUAD8

tetra10, SOLID191 tetra10, CTETRA

tetra10, SOLID187 tetra10, CTETRA

tetra10, SOLID186 tetra10, CTETRA

tetra10, SOLID148 tetra10, CTETRA

tetra10, SOLID117 tetra10, CTETRA

tetra10, SOLID98 tetra10, CTETRA
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ANSYS OptiStruct

tetra10, SOLID95 tetra10, CTETRA

tetra10, SOLID92 tetra10, CTETRA

tetra10, SOLID90 tetra10, CTETRA

tetra10, SOLID87 tetra10, CTETRA

penta15, SOLID191 penta15, CPENTA

penta15, SOLID186 penta15, CPENTA

penta15, SOLID147 penta15, CPENTA

penta15, SOLID117 penta15, CPENTA

penta15, SOLID95 penta15, CPENTA

penta15, SOLID90 penta15, CPENTA

hex20, SOLID191 hex20, CHEXA

hex20, SOLID186 hex20, CHEXA

hex20, SOLID147 hex20, CHEXA

hex20, SOLID117 hex20, CHEXA

hex20, SOLID95 hex20, CHEXA

hex20, SOLID90 hex20, CHEXA

Properties

Table 302: Supported Property Mappings

ANSYS OptiStruct

LINK8P LINK8P

BEAM4P PBEAM

BEAM44P PBEAM

SOLID45P PSOLID

SOLID46P PSOLID

SOLID70P PSOLID
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ANSYS OptiStruct

SOLID95P PSOLID

SOLID97P PSOLID

SOLID117P PSOLID

SOLID185P PSOLID

SOLID191P PSOLID

SHELL28P PSHELL

SHELL41P PSHELL

SHELL43P PSHELL

SHELL57P PSHELL

SHELL63P PSHELL

SHELL91P PCOMP

SHELL93P PSHELL

SHELL99P PCOMP

SHELL131P PCOMP

SHELL132P PCOMP

SHELL143P PSHELL

SHELL150P PSHELL

SHELL157P PSHELL

SHELL181P PSHELL

SHELL281P PSHELL

PLANE2P PSHELL

PLANE42P PSHELL

PLANE82P PSHELL

PLANE145P PSHELL

PLANE183P PSHELL

TARGE170P PCONT
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ANSYS OptiStruct

CONTAC173P PCONT

CONTAC174P PCONT

PIPE16P PBEAML

COMBIN14P PBUSH

MASS21P CONM2

Materials

Table 303: Supported Material Mappings

ANSYS OptiStruct

MP MAT1

MPDATA MAT1

Loads

Table 304: Supported Load Mappings

ANSYS OptiStruct

temperature, BF_TEMP temperature, TEMP

temperature, IC_TEMP temperature, TEMP

temperature, D_TEMP temperature, TEMP

pressure, HFLUX pressure, PLOAD2

pressure, ConvBulkTe pressure, PLOAD

pressure, PRESSURE pressure, PLOAD4

constraint, D_VOLT constraint, ASET1

constraint, IC_CONSTRNT constraint, SPCD

constraint, D_CONSTRAIN constraint, SPC

moment, FORCE2 moment, MOMENT
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ANSYS OptiStruct

force, FORCE force, FORCE

Sets

Table 305: Supported Set Mappings

ANSYS OptiStruct

set set

mass, CONTA175 set, GRID

Cards

Table 306: Supported Card Mappings

ANSYS OptiStruct

ACEL GRAV

Sensors

Table 307: Supported Sensor Mappings

ANSYS OptiStruct

Link8 PROD

BEAM4 PBEAM

BEAM44 PBEAM

BEAM188 PBEAML

SOLID5 PSOLID

SOLID45 PSOLID

SOLID46 PSOLID

SOLID62 PSOLID

SOLID64 PSOLID

SOLID69 PSOLID
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ANSYS OptiStruct

SOLID70 PSOLID

SOLID87 PSOLID

SOLID90 PSOLID

SOLID92 PSOLID

SOLID95 PSOLID

SOLID96 PSOLID

SOLID97 PSOLID

SOLID98 PSOLID

SOLID117 PSOLID

SOLID147 PSOLID

SOLID148 PSOLID

SOLID164 PSOLID

SOLID185 PSOLID

SOLID186 PSOLID

SOLID187 PSOLID

SOLID191 PSOLID

SOLSH190 PSOLID

SOLID226 PSOLID

SOLID227 PSOLID

SOLID285 PSOLID

SHELL28 PSHELL

SHELL41 PSHELL

SHELL43 PSHELL

SHELL51 PSHELL

SHELL57 PSHELL

SHELL63 PSHELL
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ANSYS OptiStruct

SHELL91 PCOMP

SHELL93 PSHELL

SHELL99 PCOMP

SHELL131 PCOMP

SHELL132 PCOMP

SHELL143 PSHELL

SHELL150 PSHELL

SHELL157 PSHELL

SHELL181 PCOMP OR PSHELL

SHELL281 PCOMP OR PSHELL

PLANE2 PSHELL

PLANE13 PSHELL

PLANE25 PSHELL

PLANE35 PSHELL

PLANE42 PSHELL

PLANE67 PSHELL

PLANE75 PSHELL

PLANE77 PSHELL

PLANE78 PSHELL

PLANE82 PSHELL

PLANE83 PSHELL

PLANE121 PSHELL

PLANE145 PSHELL

PLANE162 PSHELL

PLANE183 PSHELL

PLANE223 PSHELL
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ANSYS OptiStruct

TARGE170 PCONT

CONTAC173 PCONT

CONTAC174 PCONT

PIPE16 PBEAM

COMBIN14 PBUSH

MASS21 CONM2

MPC184 PBUSH
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LS-DYNA Conversion

LS-DYNA to Nastran Conversion Mapping

Elements

Table 308: Supported Element Mappings

LS-DYNA Nastran

*ELEMENT_MASS CONM2

*ELEMENT_INERTIA CONM2

*ELEMENT_BEAM CBAR

*ELEMENT_SHELL CTRIA3,CQUAD4, CQUAD8, CTRIA6

*ELEMENT_SOLID CTETRA4/CHEXA8/CPENTA6

*CONSTRAINED_SPOTWELD RBAR

*ELEMENT_PLOTEL PLOTEL

*CONSTRAINED_INTERPOLATION RBE3

*CONSTRAINED_NODE_SET RBE2

*ELEMENT_DISCRETE CELAS1

Properties

Table 309: Supported Property Mappings

LS-DYNA Nastran

*SECTION_SOLID PSOLID

*SECTION_SHELL PSHELL

*SECTION_BEAM PBAR, PBARL

*SECTION_BEAM with ELFORM 1 is mapped to the PBARL property.
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*SECTION_BEAM with ELFORM 2 is mapped to the PBAR property.

Materials
All the LS-DYNA materials are mapped MAT1 in Nastran.

Boundary Conditions

Table 310: Supported Boundary Condition Mappings

LS-DYNA Nastran

*BOUNDARY_SPC SPC

*LOAD_NODE_POINT FORCE, MOMENT

*LOAD_SEGMENT PLOAD4

*INITIAL_TEMP TEMP

Coordinate System

Table 311: Supported Coordinate System Mappings

LS-DYNA Nastran

*DEFINE_COORDINATE_NODE CORD1R

*DEFINE_COORDINATE_SYSTEM CORD2R

LS-DYNA to Radioss Conversion Mapping

Constrained Definitions

Table 312: Supported Constrained Definition Mappings

LS-DYNA Radioss

*CONSTRAINED_JOINT_REVOLUTE /SPRING,/PROP/KJOINT2/ property type 2

*CONSTRAINED_JOINT_SPHERICAL /SPRING,/PROP/KJOINT2/ property type 1

*CONSTRAINED_JOINT_CYLINDRICAL /SPRING,/PROP/KJOINT2/ property type 3

*CONSTRAINED_JOINT_TRANSLATIONAL /PROP/KJOINT2/ property type6
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LS-DYNA Radioss

*CONSTRAINED_JOINT_STIFFNESS_GENERALIZED /SPRING

*CONSTRINED_RIGID_BODY /RBODY

Control Cards

Table 313: Supported Control Card Mappings

LS-DYNA Radioss

*CONTROL_ADAPTIVE ADMESH_GLOBAL, ADMESH_SET

Contact Interfaces

Table 314: Supported Contact Interface Mappings

LS-DYNA Radioss

*CONTACT_AUTOMATIC_GENERAL INTER/TYPE7

*CONTACT_AUTOMATIC_GENERAL_INTERIOR INTER/TYPE7

*CONTACT_AUTOMATIC_NODES_TO_SURFACE INTER/TYPE7

*CONTACT_AUTOMATIC_ONE_WAY_SURFACE_TO_SURFACEINTER/TYPE7

*CONTACT_AUTOMATIC_SINGLE_SURFACE INTER/TYPE7

*CONTACT_AUTOMATIC_SURFACE_TO_SURFACE INTER/TYPE7

*CONTACT_INTERIOR INTER/TYPE7

*CONTACT_AUTOMATIC_SINGLE_SURFACE INTER/TYPE7

Components

Table 315: Supported Component Mappings

LS-DYNA Radioss

*DAMPING_PARTS_OPTIONS PART

*PART_OPTIONS PART
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LS-DYNA Radioss

*INCLUDE_STAMPED_PART PART

Curves

Table 316: Supported Curve Mappings

LS-DYNA Radioss

*DEFINE_CURVE FUNCT

Elements

Table 317: Supported Element Mappings

LS-DYNA Radioss

*ELEMENT_SHELL SHELL, SH3N

*ELEMENT_SOLID BRICK, TETRA44

*ELEMENT_MASS ADMAS

*ELEMENT_BEAM BEAM

*ELEMENT_DISCRETE SPRING2N

*ELEMENT_SEATBELT_ACCELEROMETER ACCEL

Loads

Table 318: Supported Load Mappings

LS-DYNA Radioss

*BOUNDARY_SPC_NODE/SET BCS

*LOAD_NODE_POINT/SET CLOAD
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LS-DYNA Radioss

*INITIAL_VELOCITY_NODE/GENERATION/ RIGID
BODY

INIVEL

Materials

Table 319: Supported Material Mappings

LS-DYNA Radioss

*MAT_ELASTIC M1_ELASTIC

*MAT_PLASTIC_KINEMATIC M36_PLASTIC_TAB

*MAT_NULL M0_VOID

*MAT_RIGID M1_ELASTIC (nodes of material defined as /
RBODY)

*MAT_PIECEWISE_LINEAR_PLASTICITY M36_PLAS_TAB

*MAT_SIMPLIFIED_JOHNSON_COOK M2_PLAS_JOHNS_ZERIL

*MAT_BLATZ_-KO_RUBBER M42_OGDEN

*MAT_SPRING_NONLINEAR_ELASTIC P13_SPR_BEAM

*MAT_SPOTWELD_TITLE P13_SPR_BEAM

*MAT_SPRING_ELASTIC /PROP/TYPE13

*MAT_SEATBELT /PROP/SPRING

*MAT_MOONEY_RIVLIN_RUBBER /M42_OGDEN /M69

*MAT_LOW_DENSITY_FOAM /MAT/LAW38

*MAT_SOLID/TYPE45 /MAT/LAW70

*MAT_FABRIC/MAT_034 /MAT/FABRI

MAT_NONLINEAR_ELASTIC_DISCRETE_BEAM_TITLE/SPRING,/PROP/SPR_BEAM

MAT_VISCOELASTIC_OPTION/MAT_006 MAT/LAW42

MAT_SPRING_GENERAL_NONLINEAR/MAT_S06 /PROP/SPR_BEAM
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LS-DYNA Radioss

*MAT_DAMPER_VISCOUS /SPRING,/PROP/SPR_BEAM

Properties

Table 320: Supported Property Mappings

LS-DYNA Radioss

*SECTION_BEAM P3_BEAM

*SECTION_DISCRETE P4_SPRING

*SECTION_SHELL P1_SHELL

*SECTION_SOLID P14_SOLID

Rigid Walls

Table 321: Supported Rigid Wall Mappings

LS-DYNA Radioss

*RIGIDWALL_GEOMETRIC_FLAT_OPTIONS RWALL

*RIGIDWALL_PLANAR_OPTIONS RWALL

Sets

Table 322: Supported Set Mappings

LS-DYNA Radioss

*SET_NODE_ADD /GRNOD/NODE
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LS-DYNA Radioss

*SET_NODE_ADD_ADVANCED /GRNOD/GRNOD

Systems

Table 323: Supported System Mappings

LS-DYNA Radioss

*DEFINE_COORDINATE_NODES SKEW/MOVE/

*DEFINE_COORDINATE_SYSTEM SKEW/FIXED

Time History Definitions

Table 324: Supported Time History Definition Mappings

LS-DYNA Radioss

*DATABASE_HISTORY_BEAM TH/BEAM

*DATABASE_HISTORY_NODE TH/NODE

*DATABASE_HISTORY_SHELL TH/SHEL

*DATABASE_HISTORY_SOLID TH/BRIC

*DATABASE_HISTORY_TSHELL TH/THSH

*DATABASE_HISTORY_NODE_SET_LOCAL /TH/NODE

*DATABASE_EXTENT_BINARY /ANIM/SHELL/TENS/STRESS/UPPER

*DATABASE_BINARY_D3PLOT /TFILE/1

*DATABASE OPTION /TFILE/1
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LS-DYNA Radioss

*DATABASE_CROSS_SECTION_PLANE /SECT

LS-DYNA to OptiStruct Conversion Mapping

Elements

Table 325: Supported Element Mappings

LS-DYNA OptiStruct

*ELEMENT_MASS CONM2

*ELEMENT_BEAM CBAR

*ELEMENT_SHELL CTRIA3,CQUAD4, CQUAD8, CTRIA6

*ELEMENT_SOLID CTETRA4/CHEXA8/CPENTA6

*CONSTRAINED_SPOTWELD RBAR

*ELEMENT_PLOTEL PLOTEL

*CONSTRAINED_INTERPOLATION RBE3

*CONSTRAINED_NODE_SET RBE2

*ELEMENT_DISCRETE CELAS1

Properties

Table 326: Supported Property Mappings

LS-DYNA OptiStruct

*SECTION_SOLID PSOLID
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LS-DYNA OptiStruct

*SECTION_SHELL PSHELL

Materials
All the LS-DYNA materials are mapped MAT1 in OptiStruct.

Boundary Conditions

Table 327: Supported Boundary Condition Mappings

LS-DYNA OptiStruct

*BOUNDARY_SPC SPC

*LOAD_NODE_POINT FORCE, MOMENT

*LOAD_SEGMENT PLOAD4

*INITIAL_TEMP TEMP

Coordinate Systems

Table 328: Supported Coordinate System Mappings

LS-DYNA OptiStruct

*DEFINE_COORDINATE_NODE CORD1R

*DEFINE_COORDINATE_

SYSTEM

CORD2R
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Nastran Conversion

Nastran to Abaqus Conversion Mapping

Elements
HyperMesh elements have two basic attributes – configuration (or config) and type. The "config" defines
the basic geometrical shape of an element. For example, tria3 configuration is a 3 node triangular
element and hexa8 is an 8-node hexahedral element. The "type" defines the solver-specific element
type of a particular configuration. For example, the 4-node quadrilateral (quad4) element in Abaqus
can be any of the following types: S4, S4R, M3D4, R3D4, and so on. The Elem Types panel shows all
supported element configs and their types for a user profile.

For a specific configuration, you can map any supported Nastran element type to any supported Abaqus
element type. Several 2-noded element configurations such as spring, rigid, bar2, rid, and so on
are supported. Because all of them are 2-noded elements, conversion across these configurations is
also allowed for some element types. For example, CBUSH is of "spring" config in the Nastran user
profile and CONN3D2 is of ‘rod" config in the Abaqus user profile. It is possible to map a CBUSH to
CONN3D2 even though their configs are different. The element mapping scheme must be under the
*ElemTypeConversion block in the ConfigurationFile.txt file. You need to provide both config and
type information to specify the element mapping scheme.

Table 329: Supported Element Mappings

Nastran Abaqus

tria3, CTRIA3 tria3, S3

tria3, CTRIAR tria3, S3R

quad4, CQUAD4 quad4, S4

quad4, CQUADR quad4, S4R

quad4, CSHEAR quad4, M3D4

tetra4, CTETRA tetra4, C3D4

penta6, CPENTA penta6, C3D6

hex8, CHEXA hex8, C3D8

tria6, CTRIA6 tria6, STRI65

quad8, CQUAD8 quad8, S8R

tetra10, CTETRA tetra10, C3D10
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Nastran Abaqus

penta15, CPENTA penta15, C3D15

hex20, CHEXA hex20, C3D20

mass, CONM2 mass, MASS

mass, CELAS1 mass, SPRING1

mass, CELAS2 mass, SPRING1

rigid, RBE2 rigid, COUP_KIN

rigidlink, RBE2 rigidlink, COUP_KIN

rbe3, RBE3 rbe3, COUP_DIS

spring, CELAS1 spring, SPRING2

spring, CELAS2 spring, SPRING2

spring, CDAMP1 spring, DASHPOT1

spring, CDAMP2 spring, DASHPOT2

spring, CBUSH rod, CONN3D2

bar2, CBEAM bar2, B31

bar2, CBAR bar2, B31

rod, CROD rod, T3D2

rod, CONROD rod, T3D2

gap, CGAP gap, GAPUNI

weld, RBAR rigid, KINCOUP
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Note:

• The CELAS1 or CELAS2 elements in Nastran have both spring stiffness and damping
attributes. If both spring and damping values are present and the mapping scheme is
CELAS1 to SPRING1, the conversion tool will automatically create an extra DASHPOT
element.

• Similarly, the CONM2 elements in Nastran have both translational and rotational mass
values. If both translational and rotational values are present and the mapping scheme
is CONM2 to MASS, the conversion tool will automatically create an extra ROTARY1
element.

• *COUPLING/*KINEMATIC constraints with element based surfaces, currently mapped to
groups in HM, are converted into rigid elements. Currently conversion of *COUPLING/
*DISTRIBUTING with element based surfaces is not supported.

• The configuration file can be updated such that config can be changed to DCOUP3D for
Rbe3 with COUP_DIS as the default conversion.

• In the Nastran to Abaqus Conversion browser, the conversion option Define Direction
Cosines in Property after conversion for PBar, PBeam, PBarL, and PBeamL is selected
by default. If your provided direction cosines for beams in Nastran then this option will
transfer this information to *Beam Section in Abaqus.

Contacts
BSURF is converted to *SURFACE ELEMENT

BCBODY in BCTABLE is mapped to CONTACT PAIR

Friction in BCTABLE is mapped to *SURFACE INTERACTION

Sectional Properties
Some of the properties in one solver can be converted to two different Abaqus sections in the other
solver. For a Nastran to Abaqus conversion, for example, PSHELL can be converted to *SHELL SECTION
or *SHELL GENERAL SECTION. In the mapping scheme, you must select one of them. The property
mapping scheme must be under the *PropertyConversion block in the ConfigurationFile.txt file.

Abaqus beam section axes are defined at the element level in Nastran. They are in the sectional
property level in Abaqus unless the beam axis is defined by a third node in element connectivity. This
means that several elements with different beam axis directions can point to the same PBEAM, PBEAML,
PBAR or PBARL property in Nastran. But in Abaqus, all elements under a *BEAM SECTION or *BEAM
GENERAL SECTION property have one beam axis orientation. If a third node is used to define the beam
axis, even Abaqus beams with a different axis can belong to a single *BEAM SECTION property. Use the
conversion tool to select an extra (1 or 0) argument to define the beam axis conversion mechanism.

If the argument is 0 (or not defined), the conversion tool will take the beam axis direction of the
first element corresponding to a PBEAM, PBEAML, PBAR or PBARL property and map that to the
corresponding *BEAM SECTION or *BEAM GENERAL SECTION card. The beam axis vectors of other
elements with the same property will be ignored.

If the argument is 1, the conversion tool will create a third node for each element to define the
equivalent beam axis vector. As a result, the axis direction for each element will be maintained after
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the conversion. Because this option updates each element, the conversion process might take a
considerable amount of time for models with a large number of beams.

Therefore for CELAS1 two options can be set in the ConfigurationFile.txt (1 or 0). If the option is 1,
one property per element will be created (default). If the flag is set to 0, one property per PELAS card
will be created. In this case, the settings of the first element found on this property will be translated.
From CELAS2 elements you always create a *SPRING and *DASHPOT or *CONNECTOR SECTION
property per element.

Table 330: Supported Section Property Mappings

Nastran Abaqus Beam axis option

PSOLID *SOLID SECTION

PSHELL *SHELL SECTION or *SHELL
GENERAL SECTION

PBEAM *BEAM GENERAL SECTION 1 or 0

PBEAML *BEAM SECTION 1 or 0

PBAR *BEAM GENERAL SECTION 1 or 0

PBARL *BEAM SECTION 1 or 0

PROD *SOLID SECTION

PBUSH *CONNECTOR SECTION

PBUSHT(KN) *CONNECTOR PLASTICITY

PELAS (*SPRING + *DASHPOT) or
*CONNECTOR SECTION

1 or 0

PDAMP *DASHPOT or *CONNECTOR
SECTION

PGAP *GAP PROPERTY

CELAS2 (*SPRING + *DASHPOT) or
*CONNECTOR SECTION

CDAMP2 *DASHPOT or *CONNECTOR
SECTION

CONM2 (*MASS +*ROTARY INERTIA)
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Note:

• CELAS2, CDAMP2 and CONM2 are elements in Nastran, but they are sectional
properties in Abaqus. Therefore, the mapping for them must also be defined under
*PropertyConversion.

• The PELAS or CELAS2 in Nastran have both spring stiffness and damping attributes.
If both spring and damping values are present and they are mapped to *SPRING, the
conversion tool will automatically create an extra *DASHPOT property. The elements will
both be kept in the same component and the property will be directly assigned to the
*SPRING or *DASHPOT element.

• Similarly, the CONM2 in Nastran has both translational and rotational mass values. If
both translational and rotational values are present and it is mapped to *MASS, the
conversion tool will automatically create an extra *ROTARY INERTIA component.

• The property conversion scheme and corresponding element conversion scheme must
be consistent. For example, if you define PBUSH to *CONNECTOR SECTION at the
property mapping scheme, the corresponding element CBUSH must map to CONN3D2 in
the element mapping scheme.

• A Nastran model with PBUSHT KN referencing TABLED1 is converted to
CONNECTORSECTION & CONNECTOR_BEHAVIOR ,and TABLED1 is mapped to
CONNECTOR PLASTICITY.

Materials
The material mapping scheme must be defined under *PropertyConversion block in the
ConfigurationFile.txt file.

Table 331: Supported Material Mappings

Nastran Abaqus

MAT1 *MATERIAL *ELASTIC, TYPE=ISO;
*EXPANSION, TYPE=ISO; and
*DENSITY (G is used only for
*BEAM GENERAL SECTION)

MAT2 *MATERIAL When used alone in a PSHELL,
MAT2 is translated to *ELASTIC,
TYPE=LAMINA or *ELASTIC,
TYPE=ANISOTROPIC

MAT8 *MATERIAL ELASTIC, TYPE=LAMINA;
*EXPANSION, TYPE=ORTHO; and
*DENSITY

MAT9 *MATERIAL *ELASTIC, TYPE=ANISOTROPIC
unless the data are found to
be orthotropic, in which case
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Nastran Abaqus

the data are analyzed to create
*ELASTIC, TYPE=ENGINEERING
CONSTANTS. Also *DENSITY;
and *EXPANSION, TYPE=ANISO
or ORTHO.

MAT9ORT *MATERIAL *ELASTIC,TYPE=ENGINEERING
CONSTANTS

Note:  If a PBEAM or PBAR is mapped to a *BEAM GENERAL SECTION, the material
properties defined in the corresponding Nastran material are mapped to the *BEAM
GENERAL SECTION card. No *MATERIAL is created in this case.

Nastran to ANSYS Conversion Mapping

Materials

Table 332: Supported Material Mappings

Nastran ANSYS Convert Parameters

MAT1 MPTEMP/MPDATA E, G, NU, RHO, A, GE, TREF

MATT1 MPTEMP/MPDATA T(E), T(G), T(NU), T(RHO), T(A),
T(GE)

MAT2 MATERIAL density

MAT4 MATERIAL density

Elements

Table 333: Supported Element Mappings

Nastran ANSYS HM Configuration

CONM2 MASS21 Mass

CELAS1 COMBI14 Spring

CBAR, CBEAM BEAM44 Bar2
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Nastran ANSYS HM Configuration

CROD LINK8 Rod

CTRIA3, CTRIAR SHELL63 Tria3

CQUAD4, CQUADR, CSHEAR SHELL63 Quad4

CTRIA6 SHELL93 Tria6

CQUAD8 SHELL93 Quad8

CTETRA SOLID45 Tetra4

CTETRA SOLID95 Tetra10

CHEXA SOLID45 Hex8

CHEXA SOLID95 Hex20

CPENTA SOLID45 Penta6

CPENTA SOLID95 Penta15

CGAP CONTACT52 Gap

CBUSH COMBI14 Spring

Properties

Table 334: Supported Property Mappings

Nastran ANSYS Convert Parameters

PBAR, PBARL, PBEAM, PBEAML BEAM44p none, only creates property card
with BEAM44p

PBUSH COMBI14p k1 to k6, GE1 to GE6

PELAS COMBI14p k, GE

PGAP CONTACT52p U0, KA, KT, MU1

PROD LINK8p none

PSHELL, PSHEAR (tria3, quad4) SHELL63p Shell Thickness

PSHELL, PSHEAR (tria6, quad8) SHELL93p Shell Thickness

PSOLID (tetra4, penta6, hex8) SOLID45p none

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Conversion Between Solver Formats p.2987

Nastran ANSYS Convert Parameters

PSOLID (tetra10, penta15,
hex20)

SOLID95p none

ETType of ANSYS
If the model contains Nastran elements which were mapped to MASS21, LINK8, COMBI14, BEAM44,
SHELL63, SHELL93, SOLID45 and SOLID95 elements, respective ETTYPES will be created and assigned
to the component. Key options of ETTYPE will not be updated.

Components
If the component collector contains different type of configuration of elements, new components will be
created for the respective configurations and those elements will be moved into the new component.
ETTYPE, material and realset IDs will be assigned to the new component.

Loads and Boundary Conditions
Loads and boundary conditions will not be converted by using this conversion tool.

Nastran to LS-DYNA Conversion Mapping

Element

Table 335: Supported Element Mappings

Nastran LS-DYNA

CONM2 *ELEMENT_MASS or *ELEMENT_INERTA

CWELD Meshless weld

(feabsorb, fe realize using HEXA)

CDAMP1/CDAMP2

(0 length)

*ELEMENT_DISCRETE

(card edit for ground option check box)

PLOTEL *ELEMENT_PLOTEL

RBAR/RBE2/RJOINT *CONSTRAINED_NODAL_RIGID_BODY

RBE3 *CONSTRAINED_INTERPOLATION

CBAR/CBEAM/CROD/CTUBE/CBUSH

CELAS1/CELAS2

*ELEMENT_BEAM
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Nastran LS-DYNA

CTRIA3/CTRIAR

CQUAD4, CQUADR, CSHEAR

CQUAD8, CTRIA6

(Change to 1st order then convert)

*ELEMENT_SHELL

CTETRA4/CHEXA8/CPENTA6

CTETRA10/CHEXA20/CPENTA15

(Change to 1st order then convert)

*ELEMENT_SOLID

Properties

Table 336: Supported Property Mappings

Nastran LS-DYNA

PBAR/PBEAM/PROD

(Only single section PBEAM is supported)

*SECTION_BEAM

PBARL/PBEAML/PRODL

(ROD, TUBE, BAR)

*SECTION_BEAM

PBUSH *SECTION_BEAM +
*MAT_GENERAL_SPRING_DISCRETE_BEAM

PELAS *SECTION_BEAM +
*MAT_1DOF_GENERALIZED_SPRING

PDAMP *SECTION_DESCRETE

PSHELL/PSHEAR *SECTION_SHELL

PSOLID *SECTION_SOLID

PCOMP PCOMPG *PART_COMPOSITE +*ELEMENT_SHELL
with angle option; all materials referred
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Nastran LS-DYNA

in PCOMP, PCOMPG converted to
*MAT_ORTHOTROPIC_THERMAL

Materials

Table 337: Supported Material Mappings

Nastran LS-DYNA

MAT1 *MAT_ELASTIC

MAT2 *MAT_PIECEWISE_LINEAR _PLASTICITY

MAT4 *MAT_PIECEWISE_LINEAR _PLASTICITY

MAT8 *MAT_ORTHOTROPIC_ELASTIC

MAT9 *MAT_ANISOTROPIC_ELASTIC

Coordinate Systems

Table 338: Supported Coordinate System Mappings

Nastran LS-DYNA

CORD1R *DEFINE_COORDINATE_NODE

CORD2R *DEFINE_COORDINATE_SYSTEM

Loads

Table 339: Supported Load Mappings

Nastran LS-DYNA

SPC *BOUNDARY_SPC

FORCE *LOAD_NODE_POINT

MOMENT *LOAD_NODE_POINT

PLOAD4 *LOAD_SEGMENT
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Nastran LS-DYNA

TEMP *INITIAL_TEMP

Nastran to Radioss Conversion Mapping

Elements

Table 340: Supported Element Mappings

Nastran Radioss

CONM2 /ADMAS

CWELD Mesh less weld

(feabsord, fe realize using HEXA)

CELAS1/CELAS2

CDAMP1/CDAMP2

(0 length)

/SPRING

PLOTEL Plot element

RBAR /RIVET

RBE2/RBE3 /RBODY

RJOINT /RLINK

CBUSH

(When using vector)

/ SPRING3N

CBUSH1D /SPRING2N

CBAR/CBEAM/CBEND BEAM

CROD TRUSS

CONROD TRUSS and /PROP/TRUSS

CTRIA3/CTRIAR

CTRIA6

(Change to 1st order before convert)

/SH3N
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Nastran Radioss

CQUAD4, CQUADR, CSHEAR

CQUAD8

(Change to 1st order then convert)

/SHELL

CTETRA4

CTETRA10

(Change to 1st order then convert)

/TETRA4

CHEXA8/ CPENTA6

CHEXA20/ CPENTA15

(Change to 1st order then convert)

/BRICK

Properties

Table 341: Supported Property Mappings

Nastran Radioss

PBAR/PBEAM

(Only single section PBEAM is supported)

/PROP/BEAM

PBUSH /PROP/SPR_GENE

PBUSH1D/PDAMP/PELAS /PROP/SPRING

PROD /PROP/TRUSS

PSHELL/PSHEAR /PROP/SHELL

PSOLID /PROP/SOLID

Materials

Table 342: Supported Material Mappings

Nastran Radioss

MAT1 /MAT/ELASTIC

MAT8 /MAT/LAW19
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OptiStruct Conversion

OptiStruct to Abaqus Conversion Mapping
The OptiStruct to Abaqus conversion uses an open conversion scheme; you can specify different
mappings in the configuration file.

Care has to be taken so that the element and property mappings are consistent. Altair provides a valid
mapping scheme in the ConfigurationFile.txt. This document explains the scope and limitations of
the mapping scheme.

Elements
HyperMesh elements have two basic attributes – configuration (or config) and type. The "config" defines
the basic geometrical shape of an element. For example, tria3 configuration is a 3 node triangular
element and hexa8 is an 8-node hexahedral element. The "type" defines the solver specific element
type of a particular configuration. For example, the 4-node quadrilateral (quad4) element in Abaqus
can be any of the following types: S4, S4R, M3D4, R3D4, and so on. The Element Types panel shows all
supported element configurations and their types for a user profile.

For a specific configuration, you can map any supported Nastran element type to any supported
Abaqus element type. For example, for an OptiStruct to Abaqus conversion, several 2-noded element
configurations such as spring, rigid, bar2, rid, and so on are supported. Because all of them are 2-
noded elements, conversion across these configurations is also allowed for some element types. For
example, CBUSH is of "spring" configuration in the HyperMesh user profile and CONN3D2 is of ‘rod"
configuration in the Abaqus user profile. It is possible to map a CBUSH to CONN3D2 even though their
configurations are different. The element mapping scheme must be under the *ElemTypeConversion
block in the ConfigurationFile.txt file. You need to provide both configuration and type information
to specify the element mapping scheme.

Table 343: Supported Element Mappings

OptiStruct Abaqus

tria3, CTRIA3 tria3, S3

tria3, CTRIAR tria3, S3R

quad4, CQUAD4 quad4, S4

quad4, CQUADR quad4, S4R

quad4, CSHEAR quad4, M3D4

tetra4, CTETRA tetra4, C3D4

penta6, CPENTA penta6, C3D6
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OptiStruct Abaqus

hex8, CHEXA hex8, C3D8

tria6, CTRIA6 tria6, STRI65

quad8, CQUAD8 quad8, S8R

tetra10, CTETRA tetra10, C3D10

penta15, CPENTA penta15, C3D15

hex20, CHEXA hex20, C3D20

mass, CONM2 mass, MASS

mass, CELAS1 mass, SPRING1

mass, CELAS2 mass, SPRING1

rigid, RBE2 rigid, COUP_KIN

rigidlink, RBE2 rigidlink, COUP_KIN

rbe3, RBE3 rbe3, DCOUP3D

spring, CELAS1 spring, SPRING2

spring, CELAS2 spring, SPRING2

spring, CDAMP1 spring, DASHPOT2

spring, CDAMP2 spring, DASHPOT2

spring, CBUSH rod, CONN3D2

bar2, CBEAM bar2, B31

bar2, CBAR bar2, B31

rod, CROD rod, T3D2

rod, CONROD rod, T3D2

gap, CGAP gap, GAPUNI

weld, RBAR rigid, KINCOUP
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Note:

• The CELAS1 or CELAS2 elements in OptiStruct have both spring stiffness and damping
attributes. If both spring and damping values are present and the mapping scheme is
CELAS1 to SPRING1, the conversion tool will automatically create an extra DASHPOT
element.

• Similarly, the CONM2 elements in OptiStruct have both translational and rotational mass
values. If both translational and rotational values are present and the mapping scheme
is CONM2 to MASS, the conversion tool will automatically create an extra ROTARY1
element.

• *COUPLING/*KINEMATIC constraints with element based surfaces (currently mapped
to groups in HyperMesh) are converted into rigid elements. Currently conversion of
*COUPLING/*DISTRIBUTING with element based surfaces is not supported.

Sectional Properties
Some of the properties in one solver can be converted to two different Abaqus sections in the
other solver. For a OptiStruct to Abaqus conversion, for example, PSHELL can be converted to
*SHELL SECTION or *SHELL GENERAL SECTION. In the mapping scheme, you must select one
of them. The property mapping scheme must be under the *PropertyConversion block in the
ConfigurationFile.txt file.

Abaqus beam section axes are defined at element level in OptiStruct. They are in the sectional property
level in Abaqus unless the beam axis is defined by a third node in element connectivity. This means that
several elements with different beam axis direction can point to the same PBEAM, PBEAML, PBAR or
PBARL property in OptiStruct. But in Abaqus, all elements under a *BEAM SECTION or *BEAM GENERAL
SECTION property have one beam axis orientation. If a third node is used to define the beam axis, even
Abaqus beams with a different axis can belong to a single *BEAM SECTION property. Use the conversion
tool to select an extra (1 or 0) argument to define the beam axis conversion mechanism.

If the argument is 0 (or not defined), the conversion tool will take the beam axis direction of the
first element corresponding to a PBEAM, PBEAML, PBAR or PBARL property and map that to the
corresponding *BEAM SECTION or *BEAM GENERAL SECTION card. The beam axis vectors of other
elements with the same property will be ignored.

If the argument is 1, the conversion tool will create a third node for each element to define the
equivalent beam axis vector. As a result, the axis direction for each element will be maintained after
the conversion. Because this option updates each element, the conversion process might take a
considerable amount of time for models with a large number of beams.

The system for CELAS1 or CELAS2 elements is sitting on the grid nodes. Thus, every element can have
a different system. Ideally, on conversion one *SPRING (and *DASHPOT) or *CONNECTOR SECTION per
element needs to be created. For large models this can be time-consuming.

Therefore for CELAS1 two options can be set in the ConfigurationFile.txt (1 or 0). If the option is 1,
one property per element will be created (default). If the flag is set to 0, one property per PELAS card
will be created. In this case, the settings of the first element found on this property will be translated.
From CELAS2 elements you always create a *SPRING and *DASHPOT or *CONNECTOR SECTION
property per element.
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Composite sections PCOMP and PCOMPG can be converted to Abaqus as well. From
ConfigurationFile.txt a user can select to convert to SHELL SECTION or SHELL GENERAL SECTION
properties. Besides individual layers, the conversion takes care of system assignments, offsets, SYM,
BEND and other similar parameters. In PCOMPG a global ply id (GPLYID) number is honored in the ply
name in Abaqus user profile after conversion.

Table 344: Supported Section Property Mappings

OptiStruct Abaqus Beam axis/property option

PSOLID *SOLID SECTION

PSHELL *SHELL SECTION or *SHELL
GENERAL SECTION

PCOMP(G) *SHELL SECTION or
*SHELL GENERAL SECTION
(COMPOSITE)

PBEAM *BEAM GENERAL SECTION 1 or 0

PBEAML *BEAM SECTION 1 or 0

PBAR *BEAM GENERAL SECTION 1 or 0

PBARL *BEAM SECTION 1 or 0

PROD *SOLID SECTION

PBUSH *CONNECTOR SECTION

PELAS (*SPRING + *DASHPOT) or
*CONNECTOR SECTION

1 or 0

PDAMP *DASHPOT or *CONNECTOR
SECTION

CELAS2 (*SPRING + *DASHPOT) or
*CONNECTOR SECTION

CDAMP2 *DASHPOT or *CONNECTOR
SECTION

CONM2 (*MASS + *ROTARY INERTIA)
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Note:

• CELAS2, CDAMP2 and CONM2 are elements in OptiStruct but they are sectional
properties in Abaqus. Therefore, the mapping for them must also be defined under
*PropertyConversion

• The PELAS or CELAS2 in OptiStruct both spring stiffness and damping attributes. If
both spring and damping values are present and they are mapped to *SPRING, the
conversion tool will automatically create an extra *DASHPOT property. The elements will
both be kept in the same component and the property will be directly assigned to the
*SPRING or *DASHPOT element.

• Similarly, the CONM2 in OptiStruct has both translational and rotational mass values.
If both translational and rotational values are present and it is mapped to *MASS, the
conversion tool will automatically create an extra *ROTARY INERTIA component.

• The property conversion scheme and corresponding element conversion scheme must
be consistent. For example, if you define PBUSH to *CONNECTOR SECTION at the
property mapping scheme, the corresponding element CBUSH must map to CONN3D2 in
the element mapping scheme.

Materials
The material mapping scheme must be defined under *PropertyConversion block in the
ConfigurationFile.txt file.

Table 345: Supported Material Mappings

OptiStruct Abaqus Notes

MAT1 *MATERIAL *ELASTIC, TYPE=ISO;
*EXPANSION, TYPE=ISO; and
*DENSITY (G is used only for
*BEAM GENERAL SECTION)

MAT2 *MATERIAL When used alone in a PSHELL,
MAT2 is translated to *ELASTIC,
TYPE=LAMINA or *ELASTIC,
TYPE=ANISOTROPIC

MAT8 *MATERIAL ELASTIC, TYPE=LAMINA;
*EXPANSION, TYPE=ORTHO; and
*DENSITY

MAT9 *MATERIAL *ELASTIC, TYPE=ANISOTROPIC
unless the data are found to
be orthotropic, in which case
the data are analyzed to create
*ELASTIC, TYPE=ENGINEERING
CONSTANTS. Also *DENSITY;
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OptiStruct Abaqus Notes

and *EXPANSION, TYPE=ANISO
or ORTHO.

Note:  If a PBEAM or PBAR is mapped to a *BEAM GENERAL SECTION, the material
properties defined in the corresponding OptiStruct material are mapped to the *BEAM
GENERAL SECTION card. No *MATERIAL is created in this case.

Loads
HyperMesh loads have two basic attributes – configuration (or config) and type. The supported
load "config" are: force, moment, constraint, pressure, temperature, flux, velocity, acceleration and
equation. The load "type" defines the solver specific type of a particular configuration. For example,
pressure load can be any of the following Abaqus types: DLOAD, FILM, DFLUX, and so on. The Load
Types panel shows all supported load configurations and their types for a user profile.

The converter also converts distributed surfaces loads (*DLSOAD) applied on faces of shell or solid
elements into pressure loads (PLOAD4).

For a specific configuration, you can map any supported OptiStruct load type to any supported Abaqus
load type. The conversion tool does not support conversion across load configurations. The load
mapping scheme is valid for either direction and must be under the *BCsTypeConversion block in the
ConfigurationFile.txt file. You need to provide both configuration and type information to specify
the mapping scheme.

Table 346: Supported Load Mappings

OptiStruct Abaqus

force, FORCE force, CLOAD

moment, MOMENT moment, CLOAD

const, SPC const, BOUNDARY

const, SPCD const, VELOCITY

const, SUPORT const, BOUNDARY

pressure, PLOAD pressure, DLOAD

pressure, PLOAD2 pressure, DLOAD

pressure, PLOAD4 pressure, DLOAD

temp, TEMP temp, TEMPERATURE

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Conversion Between Solver Formats p.2998

OptiStruct Abaqus

equation, MPC equation, EQUATION

In addition to the above load types, the conversion tool also converts OptiStruct Dload, with
corresponding Rload1, Rload2, DAREA, TABLED1, TABLED2, TABLED3, to Abaqus *BOUNDARY or
*CLOAD (with corresponding *AMPLITUDE curve). No mapping scheme needs to be specified for this
conversion; the conversion is done automatically if present in the model.

Load Steps and Analysis Type
The conversion tool maps between OptiStruct subcases and Abaqus steps. It does not convert the
solution type from/to any Abaqus analysis type. You must define it manually using the Abaqus Step
Manager or the OptiStruct Load Step Browser.

Systems and Masses
The conversion tool converts OptiStruct system types into the corresponding Abaqus system (*SYSTEM,
*TRANSFORM or *ORIENTATION). It also converts the NSM into *NONSTRUCTURAL MASS and assigns
them to the relevant properties.

Table 347: Supported System and Mass Mappings

OptiStruct Abaqus

NSM

NSM1

NSML

NSML1

NSMADD

*NONSTRUCTURAL MASS

GRID *NODE AND *SYSTEM

CORD1R

CORD1C

CORD1S

CORD2R

CORD2C

*SYSTEM for nodes

*TRANSFORM if referred to on GRID

*ORIENTATION for elements
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OptiStruct Abaqus

CORD2S

WTMASS
If the WTMASS parameter is defined in the OptiStruct model, it is used to modify density, mass, and
inertia values during conversion.

OptiStruct to ANSYS Conversion Mapping

Conversion Notes
1. If CBEAM is associated with PBEAM/PBEAML, then the properties within those cards will be

converted to ANSYS SECTION with type BEAM. OptiStruct beam cross sections of types: BAR,
CHAN, HAT, I, L, T, ROD, and TUBE are converted to ANSYS equivalent beam sections.

OptiStruct Z and BOX sections are converted to ANSYS ASEC beam sections. CHAN, Z, and BOX
sections are only converted when PBEAML has a HyperBeam section attached. PBEAM is converted
to ANSYS ASEC when HyperBeam sections are not attached to a property card. OptiStruct NSM is
converted to ANSYS ADDMAS.

Limitation: In the current version of the conversion tool, section offsets are not considered.

2. PSHELL and PSHEAR properties are converted to ANSYS SECTIONS with type SHELL. Shell
thickness and material from PSHELL/PSHEAR are mapped to TK and Material of SHELL section.
After conversion, section offset is always set to MID.

3. Conversion of contact surfaces: If contact surfaces in OptiStruct are defined with node sets, then
the surfaces will not be converted.

Materials

Table 348: Supported Material Mappings

OptiStruct ANSYS Convert Parameters

MAT1 MPTEMP/MPDATA E, G, NU, RHO, A, GE, TREF

MATT1 MPTEMP/MPDATA T(E), T(G), T(NU), T(RHO), T(A),
T(GE)

MAT2 MATERIAL density
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OptiStruct ANSYS Convert Parameters

MAT4 MATERIAL density

Elements

Table 349: Supported Element Mappings

OptiStruct ANSYS HM Configuration

CONM2 MASS21 Mass

CELAS1 COMBI14 Spring

CBEAM BEAM188 Bar2

CBAR BEAM44 Bar2

CROD LINK8 Rod

CTRIA3, CTRIAR SHELL181 Tria3

CQUAD4, CQUADR, CSHEAR SHELL181 Quad4

CTRIA6 SHELL281 Tria6

CQUAD8 SHELL281 Quad8

CTETRA SOLID45 Tetra4

CTETRA SOLID95 Tetra10

CHEXA SOLID45 Hex8

CHEXA SOLID95 Hex20

CPENTA SOLID45 Penta6

CPENTA SOLID95 Penta15

CGAP CONTACT52 Gap
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OptiStruct ANSYS HM Configuration

CBUSH COMBI14 Spring

Properties

Table 350: Supported Property Mappings

OptiStruct ANSYS Convert Parameters

PBEAM, PBEAML SECTION .

PBAR, PBARL BEAM44p None. Only creates a property
card.

PBUSH COMBI14p k1 to k6, GE1 to GE6

PELAS COMBI14p k, GE

PGAP CONTACT52p U0, KA, KT, MU1

PROD LINK8p None

PSHELL, PSHEAR (tria3, quad4) SECTION .

PSHELL, PSHEAR (tria6, quad8) SECTION

PSOLID (tetra4, penta6, hex8) SOLID45p None
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OptiStruct ANSYS Convert Parameters

PSOLID (tetra10, penta15,
hex20)

SOLID95p None

ETType of ANSYS
If the model contains OptiStruct elements which were mapped to MASS21, LINK8, COMBI14, BEAM44,
SHELL181, SHELL281, SOLID45 and SOLID95 elements, respective ETTYPES will be created and
assigned to the component. Key options of ETTYPE are not updated.

Components
If the component collector contains different type of configuration of elements, new components will be
created for the respective configurations and those elements will be moved into the new component.
ETTYPE, material, and realset section IDs will be assigned to the new component.

Loads and Boundary Conditions
Loads and boundary conditions will not be converted by using this conversion tool.

Contact Surfaces
Conversion of contact surfaces: If in OptiStruct a contact pair's master and slave are both contact
surfaces (CSURF), then the contact surfaces and the pair will be retained after conversion. However,
in ANSYS, you must add the details for the surfaces, such as Et type and property card. If the friction
coefficient MU1, available in the OptiStruct property card, is attached to the contact pair, then a new
material card with a MPDATA card image will be created, and the value will be mapped to MU in the
ANSYS format after conversion.

OptiStruct to LS-DYNA Conversion Mapping

Elements

Table 351: Supported Element Mappings

OptiStruct LS-DYNA

CONM2 *ELEMENT_MASS

CBAR *ELEMENT_BEAM

CTRIA3,CQUAD4, CQUAD8, CTRIA6 *ELEMENT_SHELL

CTETRA4/CHEXA8/CPENTA6 *ELEMENT_SOLID

RBAR *CONSTRAINED_SPOTWELD
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OptiStruct LS-DYNA

PLOTEL *ELEMENT_PLOTEL

RBE3 *CONSTRAINED_INTERPOLATION

RBE2 *CONSTRAINED_NODE_SET

CELAS1

*ELEMENT_DISCRETE

Properties

Table 352: Supported Property Mappings

OptiStruct LS-DYNA

PSOLID *SECTION_SOLID

PSHELL *SECTION_SHELL

Materials
All the LS-DYNA materials are mapped MAT1 in OptiStruct.

Boundary Conditions

Table 353: Supported Boundary Condition Mappings

OptiStruct LS-DYNA

SPC *BOUNDARY_SPC

FORCE, MOMENT *LOAD_NODE_POINT

PLOAD4 *LOAD_SEGMENT

TEMP *INITIAL_TEMP

Coordinate Systems

Table 354: Supported Coordinate System Mappings

OptiStruct LS-DYNA

CORD1R *DEFINE_COORDINATE_NODE
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OptiStruct LS-DYNA

CORD2R *DEFINE_COORDINATE_ SYSTEM

OptiStruct to Radioss Conversion Mapping

Elements

Table 355: Supported Element Mappings

OptiStruct Radioss

CONM2 /ADMAS

CWELD Mesh less weld

(feabsord, fe realize using HEXA)

CELAS1/CELAS2

CDAMP1/CDAMP2

(0 length)

/SPRING

PLOTEL Plot element

RBAR /RIVET

RBE2/RBE3 /RBODY

RJOINT /RLINK

CBUSH

(When using vector)

/SPRING3N

CBUSH1D /SPRING2N

CBAR/CBEAM/CBEND /BEAM

CROD /TRUSS

CONROD /TRUSS and /PROP/TRUSS

CTRIA3/CTRIAR

CTRIA6

(Change to 1st order before convert)

/SH3N
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OptiStruct Radioss

CQUAD4, CQUADR, CSHEAR

CQUAD8

(Change to 1st order then convert)

/SHELL

CTETRA4

CTETRA10

(Change to 1st order then convert)

/TETRA4

CHEXA8/ CPENTA6

CHEXA20/ CPENTA15

(Change to 1st order then convert)

/BRICK

Properties

Table 356: Supported Property Mappings

OptiStruct Radioss

PBAR/PBEAM

(Only single section PBEAM is supported)

/PROP/BEAM

PBUSH /PROP/SPR_GENE

PBUSH1D/PDAMP/PELAS /PROP/SPRING

PROD /PROP/TRUSS

PSHELL/PSHEAR /PROP/SHELL

PSOLID /PROP/SOLID

Materials

Table 357: Supported Material Mappings

OptiStruct Radioss

MAT1 /MAT/ELASTIC

MAT8 /MAT/LAW19
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PAM-CRASH 2G Conversion

PAM-CRASH 2G to Radioss Conversion Mapping

Elements

Table 358: Supported Element Mappings

PAM-CRASH 2G Radioss

BAR TRUSS

BEAM BEAM

SPRING SPRING

SPRBM SPRING+PROP/SPR_BEAM (TYPE 13)

MEMBR SH3N, SHELL

SHELL SH3N, SHELL

SOLID BRICK

TETRA44 TETRA44

MASS ADMAS

PLINK SPRING+INTER/TYPE2

KJOIN SPRING+PROP/KJOINT(TYPE33)

Boundary Conditions

Table 359: Supported Boundary Condition Mappings

PAM-CRASH 2G Radioss

INIVEL INIVEL

BOUNC BCS
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PAM-CRASH 2G Radioss

CONLO CLOAD

Systems

Table 360: Supported System Mappings

PAM-CRASH 2G Radioss

FRAME FRAME

Materials

Table 361: Supported Material Mappings

PAM-CRASH 2G Radioss

MAT_1D TYPE 201 M1_ELASTIC

MAT_1D TYPE 220 /PROP/SPRING

MAT_1D TYPE 223 /PROP/SPR_BEAM

MAT_2D TYPE 100 M0_VOID

MAT_2D TYPE 101 M1_ELASTIC

MAT_2D TYPE 102 M36_PLAS_TAB

MAT_2D TYPE 103 M36_PLAS_TAB, M44_, COWPER
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PAM-CRASH 2G Radioss

M2_PLAS_JOHNS

Curves

Table 362: Supported Curve Mappings

PAM-CRASH 2G Radioss

FUNCT FUNCT

Control Cards

Table 363: Supported Control Card Mappings

PAM-CRASH 2G Radioss

TITLE TITLE

OCTRL/

DSYOUPUT /ANIM/DT
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PAM-CRASH 2G Radioss

THPOUTPUT /TFILE

Components

Table 364: Supported Component Mappings

PAM-CRASH 2G Radioss

PART PART

Contact Interfaces

Table 365: Supported Contact Interface Mappings

PAM-CRASH 2G Radioss

CNTAC36 INTER/TYPE7

Rigid Walls

Table 366: Supported Rigid Wall Mappings

PAM-CRASH 2G Radioss

RWALL RWALL

Time History

Table 367: Supported Time History Mappings

PAM-CRASH 2G Radioss

THELE TH/SHEL, SH3N, SPRING, BRIC

THNODE TH/NODE
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PAM-CRASH 2G Radioss

THLOC TH/FRAME/ACCELEROMETER

Section

Table 368: Supported Section Mappings

PAM-CRASH 2G Radioss

SECFO SECT

Group

Table 369: Supported Group Mappings

PAM-CRASH 2G Radioss

GROUP GRNOD

Airbags

Table 370: Supported Airbag Mappings

PAM-CRASH 2G Radioss

BAGIN MONVOL
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Permas Conversion

Permas to OptiStruct Conversion Mapping

Elements

Table 371: Supported Element Mappings

Permas OptiStruct

BECOC CBEAM

MASS3 CONM2

MASS6 CONM2

TRIA3 CTRIA3

QUAD4 CQUAD4

SPRING1 CBUSH

SPRING3 CBUSH

SPRING6 CBUSH

DAMP1 CBUSH

DAMP3 CBUSH

DAMP6 CBUSH

TET4 CTETRA

TET10 CTETRA

PENTA6 CPENTA

HEXE8 CHEXA

HEXE20 CHEXA

$MPC RIGID RBE2
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Permas OptiStruct

$MPC WLSCON, DOFTYPE=DISP RBE3

Properties

Table 372: Supported Property Mappings

Permas OptiStruct

BEAM PBEAM

DAMPER PBUSH

SHELL PSHELL

SOLID PSOLID

SPRING PBUSH

Materials

Table 373: Supported Material Mappings

Permas OptiStruct

MATERIAL MAT1

+ $CONDUCTIVITY + MAT4

+ $HEATCAP + MAT4

+ $ELASTIC, INPUT=TABLE + MATT1

+ $THERMEXP, INPUT=TABLE + MATT1

+ $HARDENING + MATS1

+ $PLASTIC + MATS1
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Radioss Conversion

Radioss to PAM-CRASH 2G Conversion Mapping

Elements

Table 374: Supported Element Mappings

Radioss PAM-CRASH 2G

TRUSS BAR

BEAM BEAM

SPRING SPRING

SPRING+PROP/SPR_BEAM (TYPE 13) SPRBM

SH3N SHELL

SHELL SHELL

BRICK SOLID

TETRA44 TETRA44

ADMAS MASS

SPRING+INTER/TYPE2 PLINK

SPRING+PROP/KJOINT(TYPE33) KJOIN

RBODY RBODY

Boundary Conditions

Table 375: Supported Boundary Condition Mappings

Radioss PAM-CRASH 2G

INIVEL INVEL

BCS BOUNC
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Radioss PAM-CRASH 2G

CLOAD CONLO

Systems

Table 376: Supported System Mappings

Radioss PAM-CRASH 2G

FRAME/FIX FRAME

SKEW/MOV FRAME

SKEW/FIX FRAME

Materials

Table 377: Supported Material Mappings

Radioss PAM-CRASH 2G

M1_ELASTIC MAT_1D TYPE 201, MAT_2D TYPE 101

/PROP/SPRING MAT_1D TYPE 220

/PROP/SPR_BEAM MAT_1D TYPE 223

M0_VOID MAT_2D TYPE 100

M36_PLAS_TAB MAT_2D TYPE 102/103

M44_COWPER MAT_2D TYPE 102/103

M2_PLAS_JOHNS MAT_2D TYPE 102/103

Properties

Table 378: Supported Property Mappings

Radioss PAM-CRASH 2G

PROP/BEAM PART, TYPE= BEAM

PROP/KJOINT PART, TYPE = KJOIN

PROP/SHELL PART, TYPE = SHELL
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Radioss PAM-CRASH 2G

PROP/SOLID PART, TYPE = SOLID

PROP/SPRING PART, TYPE = SPRING

PROP/SPR_BEAM PART, TYPE = SPRING

PROP/SPR_GENE PART, TYPE = SPRING

PROP/TRUSS PART, TYPE = BAR

Curves

Table 379: Supported Curve Mappings

Radioss PAM-CRASH 2G

FUNCT FUNCT

Control Cards

Table 380: Supported Control Card Mappings

Radioss PAM-CRASH 2G

TITLE TITLE

OCTRL/

/ANIM/DT DSYOUPUT
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Radioss PAM-CRASH 2G

/TFILE THPOUTPUT

Components

Table 381: Supported Component Mappings

Radioss PAM-CRASH 2G

PART PART

Contacts

Table 382: Supported Contact Mappings

Radioss PAM-CRASH 2G

CNTAC36 INTER/TYPE7

Rigid Walls

Table 383: Supported Rigid Wall Mappings

Radioss PAM-CRASH 2G

RWALL RWALL

Time History

Table 384: Supported Time History Mappings

Radioss PAM-CRASH 2G

TH/SPRING THELE

TH/NODE THNODE
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Radioss PAM-CRASH 2G

TH/FRAME THLOC

Sections

Table 385: Supported Section Mappings

Radioss PAM-CRASH 2G

SECT SECFO

Groups

Table 386: Supported Group Mappings

Radioss PAM-CRASH 2G

GRNOD/NODE GROUP

GRNOD/GENE GROUP

GRNOD/SUBSET GROUP

GRNOD/PART GROUP

GRNOD/MAT GROUP

GRNOD/PROP GROUP

GRNOD/GRNOD GROUP

GRNOD/SURF GROUP

GRNOD/GRSHEL GROUP

GRNOD/GRBRIC GROUP

GRNOD/GRSPRI GROUP

GRNOD/GRSH3N GROUP

GRNOD/GRTRUS GROUP

GRNOD/GRBEAM GROUP

GENOD/NODENS GROUP
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Radioss PAM-CRASH 2G

GRNOD/FORMULA GROUP

Airbags

Table 387: Supported Airbag Mappings

Radioss PAM-CRASH 2G

BAGIN MONVOL

Radioss to OptiStruct Conversion Mapping

Elements

Table 388: Supported Element Mappings

Radioss OptiStruct

BEAM CBEAM

BRIC20 CHEXA

BRICK CHEXA, CPENTA, CTETRA

PENTA6 CPENTA

SH3N CTRIA3

SHELL CQUAD4

SPRING + PROP/SPRING (TYPE 4) CBUSH1D

SPRING CBUSH

TETRA4 CTETRA
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Radioss OptiStruct

TRUSS CROD

Properties

Table 389: Supported Property Mappings

Radioss OptiStruct

PROP/BEAM (TYPE 3) PBEAM + PBEAMX*

PROP/SH_SANDW (TYPE11) PCOMP**

PROP/SHELL (TYPE 1) PSHELL + PSHELLX*

PROP/SOLID (TYPE 14) PSOLID + PSOLIDX*

PROP/SPR_BEAM (TYPE 13) PBUSH + PBUSHT

PROP/SPR_GENE (TYPE 8) PBUSH + PBUSHT

PROP/SPR_PUL (TYPE 12) PBUSH

PROP/SPRING (TYPE 4) PBUSH1D

PROP/TRUSS (TYPE 2) PROD

*Only when you click Yes in the RadiossBlock to OptiStruct conversion tool dialog.

**Only material, ply thickness, and ply angle is converted.

Materials

Table 390: Supported Material Mappings

Radioss OptiStruct

MAT/COMPSH (LAW 25) MAT9ORT**

MAT/ELAST (LAW 1) MAT1

MAT/HONEYCOMB (LAW 28) MAT9ORT + MATX28*

MAT/PLAS_JOHNS (LAW 2) MAT1 + MATX02*

MAT/PLAS_TAB (LAW 36) MAT1 + MATX36*
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Radioss OptiStruct

MAT/VOID (LAW 0) MAT1 + MATX0*

*Only when you click Yes in the RadiossBlock to OptiStruct conversion tool dialog.

**The values of NU23 and NU31 are set to default values on conversion.
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Samcef Conversion

Convert Samcef to OptiStruct Mapping

Element
HyperMesh elements have two basic attributes, configuration (or config) and type. The "config" defines
the basic geometrical shape of an element. For example, Tria3 configuration is a 3 node triangular
element and hexa8 is an 8-node hexahedral element. The "type" defines the solver specific element
type of a particular configuration. For example, the 4-node quadrilateral (quad4) element in Samcef can
be any defined by different hypothesis: MINDLIN, VOLUMIC, and so on. The Element Types panel shows
all supported element configurations and their types for a user profile.

Table 391: Supported Element Mappings

Samcef OptiStruct

tria3, MINDLIN tria3, CTRIA3

quad4, MINDLIN quad4, CQUAD4

tetra4, VOLUMIC tetra4, CTETRA

pyramid5, VOLUMIC pyramid5, CPYRA

penta6, VOLUMIC penta6, CPENTA

hex8, VOLUMIC hex8, CHEXA

tria6, MINDLIN tria6, CTRIA6

quad8, MINDLIN quad8, CQUAD8

tetra10, VOLUMIC tetra10, CTETRA

pyramid13, VOLUMIC pyramid13, CPYRA

penta15, VOLUMIC penta15, CPENTA

hex20, VOLUMIC hex20, CHEXA

bar2, VOLUMIC BARS, CBEAM

rod, VOLUMIC rod, CWELD
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Samcef OptiStruct

rbe3, RBE3 rbe3, RBE3

Properties

Table 392: Supported Property Mappings

Samcef OptiStruct

SHELLPHP PSHELL

SOLIDMAT PSOLID

BPR PBEAML

Material

Table 393: Supported Material Mappings

Samcef OptiStruct

ISOTROPIC MAT1

ORTHOTROPIC MAT9ORT

Load

Table 394: Supported Load Mappings

Samcef OptiStruct

force, FORCE force, FORCE

moment, MOMENT moment, MOMENT

constraint, FIX/DEP constraint, SPC
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Samcef OptiStruct

pressure, PRESSURE pressure, PRESSURE

Contacts

Table 395: Supported Contact Mappings

Samcef OptiStruct

MTI CONTACT
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XY Plotting

Study relationships between data vectors in results files.

This chapter covers the following:

• XY Plots Module  (p. 3025)

• Create XY Plots  (p. 3027)

• Manage XY Plot Windows  (p. 3028)

• Create Curves on XY Plots  (p. 3029)

Information about xy plots is stored in plot collectors, which are referred to as plots. Plots maintain
a list of pointers to curves that are to be displayed on the plot. The plot may contain any number of
curves. There is no limit to the number of plot collectors that an HM database may contain.

Information about curves is stored in curve collectors, which are referred to as curves. To display a
curve, you must assign the curve collector to a plot. A curve may appear on more than one plot at a
time and there is no limit to the number of curves that an HM database may contain.

You can create standard plots or dual plots that show real /imaginary or phase/magnitude data.
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XY Plots Module
The XY Plots module is a group of panels that perform operations on plots and the curves displayed on
those plots.

The XY Plots module can be accessed from the XY Plots menu.

Axis Labels Panel
Modify the x and y axes titles and labels. You can also change the color and font size used to
display these entities.

Axis Scaling Panel
Modify the starting and ending values of the plot axes. You can set the values explicitly or
implicitly by using the panel functions such as find curves, circle zoom, and zoom out.

Border Panel
Change the thickness and color of the border around the plot. You may also specify whether the
border is displayed and the size of the margin between the border and the plot.

Curve Attribs Panel
Change the color, marker style (used to indicate the point location), thickness, and the line style
(solid, dashed, and so on). You can apply a scaling factor to the original data points. You can also
change the curve title that appears in the legend.

Edit Curves Panel
Creates and modifies the curves in the database. This panel allows you to read data vectors from
files as well as perform advanced mathematical operations on curves.

Grid Attribs Panel
Change the color, line style, thickness of the grid lines, and the margin displayed around the grid
lines.

Grid Labels Panel
Change the color, font, and number of significant places in the labels. Grid labels appear along the
x and y axes in the plot (tick marks).

Integrate Panel
Calculates and displays the integral of a curve.

Legend Panel
Change the location and the font used to display the legend.

Plot Titles Panel
Change the plot title, subtitle, and label. In addition, you can change the color and font size used
to display these entities.

Plots Panel
Create an xy plot and assign curves to the xy plot.

Query Curves Panel
Determine the coordinate values of points in a curve.

Read Curves Panel
Reads curves from an ASCII file.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
XY Plotting p.3026

Rename Panel
Eename curves.

Results Curves Panel
Generates a curve from the currently-selected results file.

Simple Math Panel
Perform simple mathematical calculations on a curve.

In addition, you can use the Curve Editor to view and modify curves already defined in your HyperMesh
model.
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Create XY Plots
Create an entirely new plot or a new plot based on default values from an existing plot.

If you have complex data, you can create dual plots to display real/imaginary or phase/magnitude curve
data. You can also select the curves that are to be displayed on the plot.

Plot attributes include the title, subtitle, and labels, and also the margin and border around the xy plot.
These attributes can be adjusted before or after you add curves to the plot.

1. In the Model Browser, right-click and select Create > Plot from the context menu.
A new curve opens in the Entity Editor.

2. In the Name field, enter a name for the plot.

3. Define plot attributes by modifying their corresponding fields.

Plot attributes include a title, subtitle, axis title, and labels, and so on.

4. Select curves.

a) Click Curves > 0 Curves.

b) Click the curves entity selector.

c) In the Select Curves dialog, select the curves to display.

d) Click OK.

Tip:  When several plots are contained within a database, you can modify one of the values
on all of the plots. For example, you may wish to change the axis titles so that they are all
the same. You can simultaneously modify one plot so that it has the desired values, and
then apply those modifications to the other plots, or a subset of the plots. When you modify
xy plots using the panels of the xy plots module, the plot = field allows you to select one
plot and the plots entity selector allows you to select multiple plots.
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Manage XY Plot Windows
Every xy plot is placed within a window to help you to control multiple plots by resizing and moving
plots around the screen.

1. Press W to open the Window panel.

2. Modify XY plot windows.
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Create Curves on XY Plots

Create Curves Manually
Create and define new curves.

1. In the Model Browser, right-click and select Create > Curve from the context menu.
The Curve editor dialog opens.

2. Create curve.

a) Click New.

b) In the panel area, Name field, enter a name for the curve.

c) Click proceed.

3. In the X and Y table, enter curves X and Y coordinates.

4. To display the curve in the graph area, in the Curve List, right-click on the curve and select
Display only from the context menu.

5. Define curve attributes such as the title, the thickness of the curve line, the style of the line used
to draw the curve, the color of the line, and the marker style used to identify the curve.

Edit a curve by right-clicking on it in the Model Browser and selecting Edit from the context menu. In
the Curve editor dialog, edit the curve and click Update.

Read Curves from ASCII Files
Create curves by reading in an xy data set from an ASCII file.

Each curve in the file is defined in a block format. The block begins with the statement, XYDATA. After
XYDATA, the title assigned to the curve, which is displayed in the legend, follows on the same line. Point
data follows with a set of (x, y) data pairs on each line. The block ends with an ENDDATA statement. In
the above example, there are two blocks of data, which define two curves.

XYDATA,TITLE
X1, Y1
X2, Y2
.
.
.
ENDDATA
XYDATA,TITLE
X1, Y1
X2, Y2
.
.
.
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ENDDATA

Figure 1820: Format of the input file

1. From the Post page, click XY Plots.

2. Click read curves.

3. Click plot= and select the plot on which to display the new curve.

4. Double-click file and select the file that contains the xy data.

5. Click input.

The specified curve data is loaded, and a new curve is created from it.

Create Analysis Based Curves
Create analysis-based curves by extracting data from an HyperMesh binary results file.

When you create an analysis curve, you select entities of interest in your model, and then select a data
type for the x axis data points and a data type for the y axis data points. After this information has
been supplied, the required data is read from the results file and generates the appropriate curve.

This function is useful after running a model because it allows you to display the data in a two-
dimensional format as an xy plot. Once the curve is created, you can integrate the curve and inspect
points.

1. From the Post page, click XY Plots.

2. Click results curves.

3. Select the plot on which to display the new curve.

• Choose plot= to select an existing plot.

• Choose create new plot to create an entirely new plot.

4. Select data.

If data is in vector format, you can extract the components or the magnitude of the vector. Click
the switch after x data type/y data type to change the data that is extracted from the database.

a) Click x data type and select the type of data that should appear on the x axis.

b) Click y data type to select the type of data that should appear on the y axis.

5. Use the entity selector to select nodes or elements to include on the curve.

6. Define the simulation range.

a) In the start with field, enter the first simulation to be used.

b) In the end with field, enter the last simulation to be used.
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7. Click create.

Create Curves using Simple Math Operators
Create curves using simple math operators.

You can combine two curves, transform a curve, or export the curve. For every operation, you can
specify that the x or y values of the curve remain fixed.

You can also apply external filters to curves. Examples of external filters are in the filters subdirectory
that is provided when this option is selected. Essentially, filters exchange data with HyperMesh, using
the standard HyperMesh curve data file format.

1. From the Post page, click XY Plots.

2. Click simple math.

3. Click plot= and select the plot to edit.

4. Select curves.

For example, when subtracting, the second curve is subtracted from the first curve.

a) Select the initial curve by clicking 1st curve= and selecting a curve.

b) Select the secondary curve by clicking 2nd curve= and selecting a curve.

5. Select the mathematical operation to perform.

The available operations depend on the number of curves selected.

6. Specify which values of the curve should remain fixed during the operation.

Only the values not chosen here are affected by the operation, for example, multiplied or
subtracted.

• Choose x-fixed to keep X values fixed.

• Choose y-fixed to Y values fixed.

7. In the factor field, enter the amount, in model units, to translate or scale.

Restriction:  Only available when the operation is translate or scale.

8. In the filter field, specify a file.

Restriction:  Only available when the operation is external.

9. In the params field, enter any necessary parameters.

Restriction:  Only available when the operation is external.

10. Click execute.
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The selected mathematical operations are performed on the selected curves.

Create Curves from Files or Math Expressions
Create new curves using either a data vector in a data file or a math expression.

For example, the data source for the x vector could be a file, and the data source for the y vector could
be a math expression.

The x and y fields displays the data sources for the x and y vectors once they are selected.

1. From the Post page, click XY Plots.

2. Click edit curves.

3. Select the create subpanel.

4. Click plot= and select the plot on which to create the curve.

An untitled plot is created if no plot currently exists.

5. Define data source.

To define data source
using

Do this

Source file 1. Select file.

2. In the File field, navigate to the file that contains curve data.

3. Click type= and select a data type.

4. Click req= and select a request set.

5. Click comp= and select a component.

Tip:  For type, req, and comp, click + or - to scroll
through the list of available options.

Math expressions 1. Select math.

The math expression must evaluate to an array.

6. Click create.

Use the modify subpanel to edit an existing curve.

To access the x and y vectors of a curve, you must indicate the curve number and the x or y vector, in
the format, c#.vector. For example:

c1.x
Reference the x vector of curve 1.

c1.y
Reference the y vector of curve 1.
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If you try to reference a curve that has not been created with this panel, you will receive the message,
"This curve has no defined source. Convert to math curve?" Respond by clicking Yes or No. If the
selected curve has too many points, it cannot be converted.
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Post-Processing Analysis

Learn how to use post-processing functions.

This chapter covers the following:

• HyperMesh Results Database  (p. 3035)

• Load Results File  (p. 3036)

• Create Deformed Geometry Plots  (p. 3037)

• Create Animations  (p. 3038)

• Create Vector Plots  (p. 3039)

• Create Contour Plots  (p. 3040)

• Create Assigned Plots  (p. 3041)

• Add Plot Identification  (p. 3042)

• Inspect Results  (p. 3043)

• Free Body Diagrams  (p. 3044)

• H3D Writer  (p. 3067)

Result databases can be used during post-processing to create contour, assigned, deformed, and vector
plots.

Review results files and databases generated by external codes using post-processing tools. Results
files can be translated into HyperMesh results databases which are then read into HyperMesh for post-
processing. This translation is done using result translators; for more information, refer to the individual
translators in the Interface help system.
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HyperMesh Results Database
An HyperMesh Results data base contains translated results files, which are read into HyperMesh for
post-processing.

The structure of a results database allows you to access results by a method similar to that of the
analysis code. A results database is divided into sections called simulations. Each simulation stores the
results for a model as it responds to a loading condition. For example, if you run a linear statics problem
and apply three different loading conditions to your model, the results file generated by the translator
contains three simulations. If you run a nonlinear job, each load step (the response of the model to
each incremental amount of load applied) translates to a simulation.

Each simulation in the results database is further subdivided into data types. Each data type found in a
simulation contains a group of results of the same type. For example, each simulation in a results file
may contain two data types: displacements and von Mises stress. A data type may contain only one
type of result. Data types are one of the forms described below:

Nodal Displacement
Stores three floating point values at a node. This form of data type is usually used to store
displacements or a vector quantity.

Nodal Value
Stores one floating point value at a node. This form of data type is used to store stress quantities
or other types of results where a single value is needed at a node.

Element Value
Stores one floating point value at an element. This form of data type is used to store stress
quantities or other types of results where a single value is needed at an element.

Complex Nodal Displacement
Stores a complex value (magnitude and phase) at a node. This form of data type is usually used
to store displacements or a vector quantity.

Complex Nodal Value
Stores a complex value (magnitude and phase) at a node.

Complex Element Value
Stores a complex value (magnitude and phase) at an element.

Complex Nodal von Mises
Stores a complex von Mises value (magnitude, phase, offset) at a node.

Complex Element von Mises
Stores a complex von Mises value (magnitude, phase, offset) at an element.

Data types are not required to contain results for every node or element in the model, and may contain
a subset of the total model, if this is appropriate. If this occurs, a message is printed indicating that
results for some of the entities requested were not found in the database. In order to complete the
post-processing function being executed, HyperMesh sets the results values needed for that function to
zero for all of the nodes or elements that are missing.
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Load Results File
In order to perform post-processing functions, you must first specify the name and location of the
results database.

Select a results file.

• Click File > Load > Results and select the .res file.

• In the Global panel, for results file, enter the path and name of the results file or click browse to
select a file using the browser.
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Create Deformed Geometry Plots
Display the deformed geometry of your model statically, in either wire frame or hidden line mode.

In the Deformed panel, selected simulation must have a data type in it that contains nodal displacement
records.
It is from the data contained with the nodal displacement records that allows the calculation of the
deformed geometry of the structure.
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Create Animations
View your model structure in motion.

Create animation.

Option Description

Linear Linear animation creates and displays an animation sequence that starts with the
original position of the structure and ends with the fully deformed position of the
structure. An appropriate number of frames are linearly interpolated between
the first and the last positions. Linear animation is usually selected when results
are from a static analysis. Linear animation sequences are generated in the
Deformed panel.

Modal Modal animation creates and displays an animation sequence that starts and
ends with the original position of the structure. The deforming frames are
calculated based on a sinusoidal function. Modal animation is most useful for
displaying mode shapes. Modal animation sequences are generated in the
Deformed panel.

Transient Transient animation displays the structure in its timestep positions as calculated
by the analysis code. Transient animation is used to animate the transient
response of a structure. Transient animation sequences are generated in the
Transient panel.

The selected simulations must include a data type that contains nodal displacement records in order
to create an animation sequence. HyperMesh calculates the deformed geometry of the structure from
the data contained within the nodal displacement records. For linear and modal animation, HyperMesh
uses only one simulation and this simulation must include a data type that contains nodal displacement
records. For transient animation, HyperMesh uses a range of simulations. In this case, each of the
simulations used in the animation sequence must include a data type that contains nodal displacement
records.
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Create Vector Plots
Create analysis-based vector plots.

Use the Vector Plots panel to display the model with a vector at each node that has a result-based
direction and magnitude. Vector plots are used to determine the direction of movement and allow
you to verify the location of the center of rotation of a model. See the Vector Plot panel for more
information.
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Create Contour Plots
Generate color bands on a model, based on the values found in the results file.

The bands of color are created by calculating a value for each node in the model and then interpolating
across each element.

The results file must include a simulation that contains one of the three forms of data types. Each
data type is handled differently when it is used to generate a contour plot. When a contour function is
performed, the objective is to take all of the results and place them at the nodes of the elements. In
order to accomplish this, HyperMesh may have to average results before it can display the contour plot.

nodal values and displacements
The results are stored at the nodes. HyperMesh can create the contour plot without modifying any
of the values in the results file.

element values
The values are located at the centroid of the element. HyperMesh averages the centroidal element
values to the nodes of the elements. You should be aware that averaging is taking place when
element centroid values are used to create a contour plot.

In the Contour panel, use the contour function to generate contour plots.
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Create Assigned Plots
Assign a color to each element in the model, based on the values in the results file.

The elements are then displayed in the solid color assigned to them. This allows you to display elements
that have values within a specified range.

The results file must include a simulation that contains one of the three forms of data types. Each
data type is handled differently when it is used to generate a contour plot. When the assign function
is performed, the objective is to take all of the results and place them at the centroid of the elements.
In order to accomplish this, HyperMesh may have to average results before it can display the assigned
plot.

element values
The results are already stored at the centroid of the element, so no further calculations are
required.

nodal values and displacements
HyperMesh averages the results at the nodes to the centroid of the elements. For each element,
this is accomplished by adding the results at each node and dividing by the number of nodes
on the element. You should be aware that averaging is taking place when nodal values or nodal
displacements are being used to create an assigned plot.

In the Contour panel, use the assign function to generate assigned plots.
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Add Plot Identification
After you create a results-based plot, you can add titles, modify the colors used in the legend, and
relocate the legend and the descriptor.

1. Temporary titles can be added to each type of plot by entering a title in the title field in the
Contour panel.

After you enter the title and create the plot, the temporary title is displayed on the upper left side
of the screen.

HyperMesh creates the "descriptor" in order to display the simulation and data type that were
used to create the plot. By default, the descriptor is located in the upper left-hand corner of the
plot above the legend.

2. To modify the descriptor, click within the descriptor to access the Title Edit panel, click color to
change the color of the text of the descriptor, click font and select the size font you want to use in
the descriptor.
HyperMesh plots a legend if the results-based plot created requires it.

3. To modify a legend, click within the displayed legend to access the Legend Edit panel.

Functions on this panel allow you to move the legend to a different location on the screen, change
the color of the text in the legend, reverse the colors of the legend, change the font size, and also
change the colors used in the legend that correspond to the model.
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Inspect Results
A contour or assigned plot provides a fast, convenient way of viewing the results of a large number of
elements.

When you want to determine the actual value that an analysis code has calculated for a node or
element, you can select the node or element after the results-based plot has been created.
The ID, simulation and data type, and value of the node or element are displayed in the menu area.
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Free Body Diagrams
Free Body Diagram (FBD) utilities facilitate the extraction and post-processing of grid point force
results.

FBD extractions are typically utilized for breakout and/or sub-modeling analysis schemes, where
balanced "free body" sub-cases are extracted from a coarse grid model and applied to a fine grid
sub-model for eventual optimization and/or analysis. FBD is also used to extract cross-sectional
resultant forces and moments, typically at the centroid of a cross-section, for use in traditional strength
calculations.

Figure 1821: Coarse Grid Model, Typical for FBD Extractions

Figure 1822: Typical FBD – Forces Output on a Wing Rib
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Figure 1823: Typical Result Force and Moment Output on a Floor Beam

Extract Displacement Data
Extracts displacement data for user defined node set(s).

Extracting displacement data is useful for doing breakout modeling within a sub-modeling scheme.

After you define an element set with an associated node set, all appropriate displacements and
rotations are extracted. Results can be output to load collectors for graphical review, a text summary
table, and a formatted .csv file which can be loaded into traditional spreadsheet software packages.

1. From the menu bar, click Post > Free Body > Displacements.
The FBD Displacements tab opens.

2. In the .op2/.odb file field, specify the full path and filename of the results file containing the
displacement output for the current model.
Once an results file is selected, loadstep names and IDs with displacement output are saved with
the rest of the HyperMesh database for use with all FBD utilities. If a new results file is required,
or if the original results file changes, you must load the new results file into the database,
overwriting the previously selected one.

3. In the Loadsteps section, select which loadstep(s) to extract displacement information.

Only loadsteps with displacement results from the currently selected results file display for
selection. You can select multiple loadsteps by Ctrl-clicking or Shift-clicking. Filter buttons allow
for additional selection control, including a namefilter that uses standard HyperMesh filtering
syntax. The loadstep display can be switched between ID and Name (ID).

The ID option lists the loadsteps as "SUB-CASE #". The Name (ID) option lists the loadstep as
"SUBTITLE - LABEL(ID)". If no SUBTITLE exists, only the LABEL is used. See the OptiStruct online
reference guide for more information regarding SUBTITLE and LABEL loadstep information cards.

4. Select entities to extract displacement data from.

The entity selection section allows you to select and/or create the appropriate entities required to
execute the FBD Displacements utility.

a) Use the Element Set selector to define the elements that contain the nodes at which
displacement data will be extracted.

The Set Browser utility on the Tools menu can be used to create the necessary element sets.

b) Use the Node Sets selector to define the nodes at which displacement data will be extracted.

Only the nodes contained within the selected node set will be part of the extraction. If a node
set is not selected, then all nodes within the element set are used.
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c) To automatically finds the nodes attached to elements that are not contained within the
currently selected element set, select the Auto find interface nodes checkbox.

This procedure selects the nodes interfacing with the remainder of the structure. You will be
prompted to give the newly created node set a name. Additional nodes may be added to the
node set once it is created by clicking the Node Setselector and picking additional nodes.

d) To automatically displays the entire model in transparency mode and highlights the currently
selected element and node sets, select the Show Model checkbox.

This functionality allows you to verify which element and node sets are currently selected.

5. Define Output options.

The Output options section contains various options to review and display results of FBD
Displacement extractions.

a) Use the Coordinate Systems selector to determine the coordinate system used to
display the nodal coordinates (x,y,z) in the summary table and .csv file output options.
Displacement data (Ux, Uy,…) is always output in the system that the results are stored with
in the results file format. Results coordinate system transformations are not performed on
displacement data.

The FBD Displacement utility extracts and applies the displacement and rotation results
from the results file in the output coordinate system without any further coordinate system
transformations. It is assumed that the output coordinate system assigned to each node in
the HyperMesh database matches that used to run the analysis and generate the results file.
Output coordinate systems are defined in HyperMesh by accessing the Systems panel. On
the Setup menu, click Coordinate Systems, and toggle to the assign subpanel, select the
required nodes and a coordinate system, and click Set Analysis. In OptiStruct and Nastran
this operation sets the CD field on the GRID card(s). See the OptiStruct online reference
guide for more information regarding the GRID bulk data card. If the output coordinate
systems for each node in the HyperMesh database does not match those used to run the
analysis then the extracted values will be incorrect. Situations when this behavior could occur
include modification of nodal output system within HyperMesh without rerunning the analysis
and/or loading a results file that does not match the currently loaded model.

If a coordinate system is not specified, the HyperMesh "base" system is used by default.

b) In the Zero Tolerance field, enter the cut-off point below which a result quantity is considered
zero. All calculations are done with float point precision and the zero tolerance value is only
used for controlling the output of results to the various formats. The option helps to eliminate
"relatively small" values from being output to the result formats. To maintain float precision
the default is set to 1.0e-6, otherwise modify the value as desired.

c) To extract the specified displacement data and display it in organized load collectors within
HyperMesh for graphical visualization within the model window5, select the Create Load
Collectors checkbox.

A single load collector, for the current element and node set, is created for each
loadstep. The load collector name format is FBDD_E(#)_N(#)_S(#)_Disp. For example,
FBDD_E(1)_N(1)_S(1)_Disp would be created for element set 1, node set 1 and loadstep
1. The loads in this load collector are created with the SPC load type. This collector can be
referenced as the SPC in the loadstep panel.
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Tip:  To choose a color for all created load collectors, click the Color button. This
color can be modified later using either the interface or the FBD Results Manager
utility

d) To create a load collector with the name "FBDD_E(#)_N(#)_S(#)_SPCD", select the Create
SPCD checkbox.

Loads in this collector are created with the SPCD load type. This collector can be referenced
as the LOAD in the loadstep panel.

e) To output the results to a popup window for instant review, select the Show summary
checkbox.

The table contains information about the loadsteps, element and node set(s), and detailed
displacement data at each node.

Figure 1824:

f) To create a .csv file that contains the same information as the summary table, but in a
comma-separated file, select the Create .csv file checkbox, then select a new file or an
existing file.

If the data you are extracting already exists in the file, based on element set, node set and
loadstep IDs, the existing block will be overwritten with the new data. If it does not exist, it
will be appended to the end of the file.

In any case, you will be warned that the file already exists and asked if you want to replace
it. Selecting yes will not overwrite the file; it will append/replace the data.
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6. Click Accept.

Extract Forces
Extract grid point force data, including forces and moments, for a user-defined element set.

Extracting FBD forces is useful for doing breakout modeling within a sub-modeling scheme.

Results can be output to load collectors for graphical review, a text summary table, and/or a formatted
Comma-Separated Values (.csv) file which can be loaded into traditional spreadsheet software
packages.

1. From the menu bar, click Post > Free Body > Force.
The FBD Forces tab opens.

2. In the .op2/.odb file field, specify the full path and filename of the results file containing the forces
output for the current model.

Once you have selected an results file, loadstep names and IDs with grid point force output are
saved to the database for use with all FBD utilities. The loadstep name and ID information is
retained within the HyperMesh database once saved.

If a new results file is required, or if the original results file changes, you must load the new
results file into the database, overwriting the previously selected.

3. In the Loadsteps section, select which loadstep(s) to extract grid point force information.

Loadsteps with grid point force results from the currently selected results file are displayed for
selection only. Multiple loadsteps can be selected via Ctrl-click or Shift-click functionality. Filter
buttons allow for additional selection control as shown including a name filter that uses standard
filtering syntax. The loadstep list can be switched between ID and Name (ID).

The ID option lists the loadsteps in the format SUBCASE ID. The Name (ID) option lists the
loadstep in the format NAME – ITERATION (ID).

4. Select entities.

a) Use the Element Set selector to define the elements that make up the free body and contain
the nodes at which GPFORCE data will be extracted.

The Set Browser tool can be used to create the necessary element sets.

b) Use the Result System selector to define the coordinate system into which the grid point
force and moment result vectors are transformed and output.

If a results system is not specified, the HyperMesh "base" system is used by default.

The FBD Forces utility extracts grid point force and moment results from an results file in the
output coordinate system in which the solver output these results. HyperMesh assumes that
the output coordinate system assigned to each node in the HyperMesh database matches
that used to run the analysis and generate the results file. Output coordinate systems are
defined in HyperMesh by accessing the Systems panel. On the assign subpanel, select the
required nodes and a coordinate system, and click Set Analysis. In OptiStruct and Nastran
this operation sets the CD field on the GRID card(s).

If the output coordinate systems for each node in the HyperMesh database do not match
those used to run the analysis, the extracted values will be incorrect. This could occur when
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modifying a nodal output system within HyperMesh without rerunning the analysis and, or
when loading a results file that does not match the currently loaded model. In addition,
results coming from, or output to, cylindrical or spherical result coordinate systems should be
inspected for validity near the origin and along principal axes.

c) Use the Summation Node selector to define the node about which the GPFORCE data is
summed for the selected element set.

This is useful for verifying free body behavior through zero-sum values for all force and
moment components about any node. It is also useful for calculating the result of applied
or reaction forces about any node. If a node is not selected, the HyperMesh origin (0,0,0) is
used by default.

d) To automatically display the entire model in transparency mode while highlighting the
currently selected element set, result system and summation node, select the Show Model
checkbox.

This allows you to verify which element sets is currently selected.

5. Define output options.

a) For FBD type, select the type of grid point force and moment data to extract and utilize for
FBD calculations for each node in the selected element set.

• Choose All Loads to extract and utilize all element contribution, applied, SPC, and
supported MPC grid point data for FBD calculations on the nodes in the selected element
set.

• Choose Applied Loads Only to extract and utilize only the applied loads grid point data
for FBD calculations on the nodes in the selected element set.

• Choose Reaction Loads Only to extract and utilize only SPC and supported MPC grid
point data for FBD calculations on nodes in the selected set.

MPC force and moment data are properly extracted for the following MPC constraint types:
RBE2, RBE3, Rigidlink, RJOINT, RROD, and RBAR.

b) In the Zero Tolerance field, enter the cut-off point below which a result quantity is considered
zero.

All calculations are performed with floating point precision and the zero tolerance value is
only used to control the output of results to the various formats. This option helps to prevent
relatively small values from being output to the result formats. To maintain floating-point
precision the default is set to 1.0e-6; modify the value as desired.

c) To extract the specified grid point data and display it in organized load collectors for
visualization in the model window, select the Create Load Collectors checkbox.

Multiple load collectors are created — one for each force and moment component —
for each selected loadstep of the current element set. The load collector name format
is "FBDF_E(#)_S(#)_(compID)". For example FBDF_E(1)_S(1)_Fx would be created
for element set 1, loadstep 1, and component Fx. In addition a load collector with the
Nastran/OptiStruct LOAD card is also created, referencing the component force and moment
load collectors. This load collector is named "FBDF_E(#)_S(#)_C" and can be referenced in
the loadstep panel as the LOAD entry for the various loadstep definitions.
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Tip:  To choose a color for all created load collectors, click the Color button. This
color can be modified later using either the interface or the FBD Results Manager
utility.

The FBD Results Manager can be used to review the load collectors generated from FBD
Forces utility. When you save the database, all FBD Forces load collectors are saved to the
database. This allows FBD information to be reviewed and utilized in the future without
having to rerun the tool. Renumbering element or node sets after running the tool invalidates
the link between the load collector names and the associated sets; therefore it is important
to avoid renumbering any element or node sets for which FBD result must be retained as
load collectors in HyperMesh.

d) To output the results to a popup window for instant review, select the Show summary table
checkbox.

The table contains information about the loadsteps, element set(s), and detailed data from
the grid point extraction at each node.

Figure 1825:

e) To create a .csv file that contains the same information as the summary table, but in a
comma-separated file, select the Create .csv file checkbox and select a new file or an
existing file.

If the data you are extracting already exists in the file, based on element set, loadstep
IDs, the existing block will be overwritten with the new data. If it does not exist, it will be
appended to the end of the file.

You are asked if you wish to replace the existing file. However, selecting yes will not
overwrite the file, it will append/replace the data as described above.
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6. Click Accept.

Create and Manage FBD Cross-Section Definitions
Create and manage cross-section definitions that are used within the Resultant Force and Moment
utility.

Cross-sections, are defined by an element set, node set, summation node, and a local result coordinate
system.

The FBD Cross-section Manager features semi-automatic generation of element and node sets for
defining cross-sections. Functionality is also available to reorder FBD cross-sections.

The FBD Cross-section Manager interface has two creation methods available for cross-section
definition: manual and (semi-) automatic. The Advanced options section provides the means to semi-
automatically create cross-section element and node sets for beam-like structures with regular meshes.
This auto-create cross-section capability requires a continuous mesh with rows of nodes (of any
orientation) to work properly. The mesh should not have any discontinuities (such as holes and gaps)
and must have identifiable rows of nodes, starting from the selected nodes and progressing along the
length of the selected elements.

Manually Define Cross Sections

1. From the menu bar, click Post > Free Body > Cross Section.
The FBD Cross Section Manager tab opens.

2. Use the Element Set selector to specify the elements containing the nodes that define the cross-
section.

The Set Browser can be used to create the necessary element sets.

If multiple element sets are selected, each set is added to the table as a separate cross-section
definition which can be modified later by selection.

3. Use the Node Set selector to define the nodes in each currently selected element set at which grid
point data will be extracted and summed from.

Only the nodes contained within the selected node set will be part of the grid point extraction. Use
the Set Browser to create the necessary node sets.

If multiple node sets are selected for a single element set, HyperMesh adds separate cross-section
definitions to the table with the original element set and each selected node set.

4. Use the Summation Node selector to define the node about which the grid point data will be
summed.

If no node is selected, the utility defaults to "Centroid". This option calculates the nodal averaged
centroid of the coordinates of all of the nodes in the node set and creates a temporary node at
that location.

When using the "Centroid" option, a temporary node is created. If this node is deleted from the
model, the loads associated with that node are also deleted.
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5. Use the Result System selector to define the coordinate system into which the grid point vector
results will be transformed and output.

If a results system is not specified, the HyperMesh "base" system is used by default.

6. To display the element set, node set, result system and summation node which define the cross-
section in the graphics display area, select the Display sections checkbox.

7. To display the entire model in transparency mode, highlighting the currently selected element set,
node set, result system and summation node, select the Show model checkbox.

This allows you to verify a cross-section definition.

8. Use the filter buttons on the top of the spreadsheet to select which cross-sections are required.

Standard Ctrl/Shift–click functionality can be used to select cross-sections. Selected cross-sections
can also be deleted from the database by using the Remove selection button on the right end of
the filter buttons.

Each time a cross-section is created, modified, or deleted, the cross-section data is saved to the
database. When the database is saved, all cross-section definitions are also saved. Therefore, cross-
section definitions only need to be defined once and stored in the database. Cross-Sections can then be
accessed from within the Resultant Force and Moment utility, which utilizes the cross-section definitions
to perform these calculations.

Renumbering element or node sets after running the tool invalidates the link between the cross-section
names and the associated sets. Therefore, it is important to avoid renumbering any element or node
sets for which cross-sections are to be retained within the database.

Automatically Define Cross Sections

1. From the menu bar, click Post > Free Body > Cross Section.
The FBD Cross Section Manager tab opens.

2. Use the Elements selector to choose the elements that define the entire "beam-like" component
from which cross-sections will be generated.

3. Use the Nodes selector to pick nodes for the first node set (first cross-section).

These nodes should be at one end of the beam.

4. To automatically display the entire model in transparency mode, highlighting the currently
selected elements and nodes, select the Show model checkbox.

5. In the Element set prefix field, enter a prefix for the name of each generated element set.

For example, you type in "ESET" each element set will be named ESET [#], where "#" increases
with each new set generated.

6. In the Node set prefix field, enter a prefix for the name of each generated node set into the Node
set prefix field.

For example, you type in "NSET" each element set will be named NSET [#], where "#" increases
with each new set generated.

7. In the Numbering offset field, enter an offset value for generated set names.
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By default, the offset value is zero and HyperMesh generates numbered set names starting with
one. If the offset value is set to a value greater than zero, the generated set names are numbered
starting from that value.

8. To have each element set contain the elements from the previous set, select the sets
accumulate checkbox.

This determines whether each progressive set also contains the elements from the previous set, or
only the new "row" of elements.

Extract Resultant Force and Moment Data
Extract grid point force data for user defined cross-sections created via the Cross-section Manager.

The Resultant Force and Moment utility generates input data for shear and moment (VMT) diagrams
and/or to perform load-case screening with Potato plots in HyperGraph. Two utilities available within
HyperGraph are available for these purposes.

Results can be output to load collectors for graphical review, a text summary table, and/or a formatted
.csv file which can be loaded into traditional spreadsheet software packages.

1. From the menu bar, click Post > Free Body > Resultant Force and Moments.
The Resultant Force and Moments tab opens.

2. In the .op2/.odb file field, specify the full path and filename of the results file containing the
desired GPFORCE output for the current model.

When a results file is selected, loadstep names and IDs with GPFORCE output are saved to the
database for use with all FBD utilities. The loadstep name and ID information is retained within the
database once saved. If a new results file is required, or if the original results file changes, you
must load the new results file into the database, overwriting the previously selected.

3. In the Loadsteps section, select which loadstep(s) to extract GPFORCE information.

Loadsteps with GPFORCE results from the currently selected results file display for selection only.
Multiple loadsteps can be selected by Ctrl-clicking and Shift-clicking. The list can be filtered using
the buttons provided, including a name filter that uses standard HyperMesh filtering syntax. The
loadstep list can be organized by ID or Name (ID).

The ID option lists the loadsteps as "SUBCASE #". The Name (ID) option lists the loadstep as
"SUBTITLE – LABEL (ID)". If no SUBTITLE exists, only the LABEL is used. See the OptiStruct online
reference guide for more information regarding SUBTITLE and LABEL loadstep information cards.

4. In the Cross Sections section, select the cross-sections from which you want to calculate resultant
force and moment results for each selected loadstep.

Cross-sections are created using the Cross-section Manager. Multiple cross-sections can be
selected by Ctrl-clicking and Shift-clicking. The list can be filtered using the buttons provided,
including a name filter that uses standard HyperMesh filtering syntax.

5. Define Output options.

The Output options section contains various options to review and display the results of Resultant
Force and Moment extractions
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a) Use the Coordinate Systems selector to determine the coordinate system used to output
the nodal coordinates (x,y,z) in the summary table, .csv file, and .fbd file output options.

Resultant force and moment vector results are always output in the result coordinate system
defined for each cross-section. Result coordinate systems for cross-sections are defined using
the Cross-section Manager. If a coordinate system is not specified, the HyperMesh "base"
system is used by default.

The Resultant Force and Moment utility extracts grid point force and moment results from
the results file in the output coordinate system in which the solver output these results. It is
assumed that the output coordinate system assigned to each node in the database matches
that used to run the analysis and generate the results file. Output coordinate systems are
defined by accessing the Systems panel. On the assign subpanel, select the required nodes
and a coordinate system, and click Set Analysis. In OptiStruct and Nastran this operation
sets the CD field on the GRID cards.

If the output coordinate systems for each node in the database do not match those used to
run the analysis, the extracted values will be incorrect. This can occur when modifying nodal
output system without rerunning the analysis, and/or loading a results file that does not
match the currently loaded model. In addition, results coming from or output to cylindrical or
spherical result coordinate systems should be inspected for validity near the origin and along
principal axes.

MPC force and moment data are properly extracted for the following MPC constraint types:
RBE2, RBE3, Rigidlink, RJOINT, RROD, RBAR.

b) In the Zero Tolerance field, enter the cut-off point below which a result quantity is considered
zero.

All calculations are done with float point precision and the zero tolerance value is only used
to control the output of results to the various formats. The option helps to eliminate relatively
small values from being output. To maintain float precision the default is set to 1.0e-6,
otherwise modify the value as desired.

c) Extract the specified grid point data and display it in organized load collectors for graphical
visualization within the model window. Select the Create Load Collectors checkbox.

Multiple load collectors are created — one for each force and moment component — for each
selected loadstep of the current cross-section, each made up of an element set and node
set. The load collector name format is "RF&M_E(#)_N(#)_S(#)_(compID)". For example
RF&M_E(1)_N(1)_S(1)_Fx would be created for element set 1, node set 1, loadstep 1, and
component Fx.

Tip:  To choose a color for all created load collectors, click the Color button. This
color can be modified later using either the interface or the FBD Results Manager
utility.

You can also use the FBD Results Manager to review the load collectors generated from the
Resultant Force and Moment utility. When the database is saved, all resultant force and
moment load collectors are saved in the database. This allows resultant force and moment
information to be reviewed and utilized in the future without having to rerun the tool.
Renumbering element or node sets after running the tool invalidates the link between the
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load collector names and the associated sets and therefore it is important to not renumber
any element or node sets for which resultant force and moment result are to be retained as
load collectors in HyperMesh.

d) To output the results to a popup window for instant review, select the Show summary
checkbox.

The table contains information about the loadsteps and cross-sections, and detailed data
from the grid point extraction at each node.

e) To create a .csv file that contains the same information as the summary table, but in a
comma-separated file, select the Create .csv file checkbox, then select a new or existing
file.

If an existing file is selected, it is appended to.

f) To create a file that can be read into HyperGraph using the "Shear and Moment Plot" and
"Potato Plot" utilities, select the Create .fbd file checkbox, then select a new or existing file.

6. Click Accept.

When saving over existing .csv or .fbd file, there are several items to note.

• If the data you are extracting already exists in the file, based on element set, loadstep IDs, the
existing block will be overwritten with the new data. If it does not exist, it will be appended to the
end of the file.

• You are asked if you wish to replace the existing file. However, selecting ‘yes’ will not overwrite the
file; it will append/replace the data into the file as described above.

• Two utilities available within HyperGraph interact with data generated from the Resultant Force
and Moment utility: Shear and Moment Diagrams (VMT Plots) and Potato Plot. These utilities are
accessed from the Free Body Diagrams item within the HyperGraph Utilities menu.

Review Load Collectors
Graphically review and manage the load collectors generated from all FBD and Resultant Force and
Moment utilities.

1. From the menu bar, click Post > Free Body.
The FBD Results Manager tab opens.

2. Select one or more element sets.

The Entity selection section allows you to select the element set for which to review FBD,
Displacement, or Resultant Force and Moment load collector output.

You must choose an existing element set for which you wish to the review the FBD, Displacement,
and Resultant Force and Moment load collector output.

The optional Show model checkbox, when checked, displays the entire model in transparency
mode and highlights the currently selected element set.

3. Select the desired Results type.

The Results selection section lets you select the FBD result type to review. Valid types include FBD
Displacements, FBD Forces (All Loads), FBD Forces (Applied Loads), FBD Forces (Reaction Loads),
and Resultant Force and Moment.
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Selecting an FBD result type scans the HyperMesh database and updates the loadstepslist with
available loadsteps for the currently selected element set and result type.

4. Select the desired loadsteps by clicking on them.

Multiple loadsteps can be selected using standard Ctrl/Shift–click functionality. Filter buttons allow
for additional selection control as shown including a name filter that uses standard HyperMesh
filtering syntax.

For FBD Displacements and Resultant Force and Moment Result types, the Results selection
interface is modified to include a Node sets selector. This selector lists all of the node sets
associated with the currently selected element set and loadsteps. If multiple loadsteps are
selected, only the node sets that are common to all of them will be listed.

5. In the Display options section, select which force and moment components display in the graphics
area for the current selection.

• The Fx, Fy, Fz checkboxes determine which component/resultant vectors display when you
click Accept. Grayed-out checkboxes indicate force and moment components or results that
can’t display for the currently selected element set/loadstep/node sets. These checkboxes are
disabled for the FBD Displacements Result type.

• The Update load collector color option will recolor the load collectors associated with
the current selection to the color selected in the Color option. Click the Color box to pick a
different color, if desired.

6. Choose a command.

• Click Accept to display the selected result vectors on in the graphics area.

• Click Deleteto delete the load collectors associated with the current selection. A popup
warning tells you what will be deleted and requires you to confirm the deletion.

• Click Reset to clear the graphics area of all result vectors and resets all of the FBD Results
Manager entry fields.

Export Load Collectors
Export FBD, Displacement, and/or Resultant Force and Moment load collectors generated by other FBD
utilities.

After export, the exported data can be used for breakout modeling within a sub-modeling scheme.

1. From the menu bar, click Post > Free Body.
The FBD Export Manager tab opens.

2. Use the Element set selector to specify the set for which you want to export data.

3. To display the entire model in transparency mode, highlighting the currently selected element set
for review, select the Show model checkbox.

4. Choose the results type to export.

This populates the list of loadsteps. Click the one(s) that you wish to export to highlight them; use
<Ctrl>-click or <Shift>-click to select multiple results.
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If you choose FBD Displacements or Resultant Force and Moment as the result type, an
additional list of node sets displays. Select the desired node sets in the same fashion as the
loadsteps.

5. Click add to export to add the highlighted results to the export batch.

6. Define export options.

a) To create loadsteps upon export, select the Create appropriate loadsteps checkbox and
then click the open-folder button in the Output file text box.

This opens a standard file browser window that you can use to browse to the desired
destination directory and either select an existing file, or type in a name for a new one.

This option will also create SUBTITLE and LABEL cards if they are available from the loadstep
information within the currently selected results file.

b) Select the Results type to determine how loadsteps are created.

• Choose FBD Forces – All Loads to create a SUBCASE with LOAD = assigned to the
"FBDF_E(#)_S(#)_C" load collector which references the LOAD card pointing to each
component "FBDF_E(#)_S(#)_(compID)" load collector for the selected loadstep.

• Choose FBD Displacements to create a SUBCASE with SPC = assigned to the
"FBDD_E(#)_N(#)_S(#)_Disp" load collector for the selected loadstep.

◦ If the SPCD option was enabled when creating FBD Displacement loads, LOAD =
will also be assigned to the "FBDD_E(#)_N(#)_S(#)_SPCD" load collector for the
selected loadstep.

◦ If multiple node sets are selected for export the following will occur:

An SPCADD load collector will be created and the appropriate "FBDD_E(#)_N(#)_S(#)_Disp"
load collectors will be assigned to it. The SPC = will reference the newly created SPCADD
load collector.

If the SPCD checkbox was selected when creating the FBD Displacement loads, a LOAD load
collector will be created and the appropriate "FBDD_E(#)_N(#)_S(#)_SPCD" load collectors
will be assigned to it. The LOAD = will reference the newly created LOAD load collector.

If FBD Force and FBD Displacement load collectors from the same loadstep are selected for
export, you are prompted to select one or the other from which to create the loadstep.

7. Choose a command.

• Click Export to execute the export process, meaning that clicking it:

• Turns off the display of all currently displayed elements

• Creates temporary mass elements on the nodes where the selected FBD, Displacement,
and/or Resultant Force and Moment loads are displayed

• Exports the model with the "displayed" option

• Deletes the temporary mass elements from the current model

• Removes unnecessary header information from the output file
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• Click Reset to clear all of the export criteria so that you can start over.

Review Grid Point Force Balance
The Grid Point Force Balance table is the data around which all FBD-Forces and Resultant Force and
Moment utility calculations are performed.

See the OptiStruct online reference guide for more information regarding GPFORCE option cards.

Figure 1826: Sample Model used to Demonstrate Grid Point Force Calculations
This model consists of two elements, a fixed support on the left end, and a point load on the right end.

The complete GPFORCE table for the above cantilever beam model is presented below.

Note:  For any given node within the GPFORCE table, several types of entries are possible
depending on the forces acting at that node.

• Applied forces and moments

• SPC forces and moments

• MPC forces and moments

• Element forces and moments from elements attached to the node

• Total summed values for each node, which in turn must sum to zero for the complete
GPFORCE table.
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Figure 1827:

From the menu bar, click Post > Free Body.
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The FBD Forces and Resultant Force and Moment utilities use element and node set definitions to define
what information to extract and sum from the GPFORCE table. This information is then used to produce
free bodies and/or resultant force and moments.

FBD Forces
The FBD Forces utility uses an element set to define the values to extract from the GPFORCE table.

The FBD Forces utility uses an element set to define which values to extract from the GPFORCE table.
This serves several purposes:

• Any nodes in the element set that have Applied loads will have those values extracted.

• Any nodes in the element set that have SPC loads will have those values extracted.

• Any nodes in the element set that have MPC loads will have those values extracted.

• Any nodes in the element set attached to one or more elements not in the element set will have the
appropriate element forces extracted.

The following example of FBD-Forces extraction uses element 1 from the same 2-element image shown
at the beginning of this topic.

Element Set
The element set contains only element 1. Element 1 has nodes 1, 2, 3 and 4.

X-Force
Node 1 is only attached to element 1 and has an SPC constraint. Since element 1 is in the
element set, its force contributions are not considered. From the GPFORCE table, the x-force
value that is extracted for node 1 is the SPC force 2.121e+03.
Node 2 is only attached to element 1 and has an SPC constraint. Since element 1 is in the
element set, its force contributions are not considered. From the GPFORCE table, the x-force
value that is extracted for node 2 is the SPC force -2.121e+03.
Node 3 is attached to elements 1 and 2. Since element 1 is in the element set, its force
contributions are not considered. Since element 2 is not in the element set, its force contributions
will be considered. From the GPFORCE table, the x-force value that is extracted for node 3 is the
element 2 force -1.085e+03.
Node 4 is attached to elements 1 and 2. Since element 1 is in the element set, its force
contributions are not considered. Since element 2 is not in the element set, its force contributions
will be considered. From the GPFORCE table, the x-force value that is extracted for node 4 is the
element 2 force 1.085e+03.
These values sum to 0.

Y-Force
All values are zero in this model.

Z-Force
Node 1 is only attached to element 1 and has an SPC constraint. Since element 1 is in the
element set, its force contributions are not considered. From the GPFORCE table, the x-force
value that is extracted for node 1 is the SPC force -4.332e+02.
Node 2 is only attached to element 1 and has an SPC constraint. Since element 1 is in the
element set, its force contributions are not considered. From the GPFORCE table, the x-force
value that is extracted for node 2 is the SPC force -5.668e+02.
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Node 3 is attached to elements 1 and 2. Since element 1 is in the element set, its force
contributions are not considered. Since element 2 is not in the element set, its force contributions
will be considered. From the GPFORCE table, the x-force value that is extracted for node 3 is the
element 2 force 6.426e+02.
Node 4 is attached to elements 1 and 2. Since element 1 is in the element set, its force
contributions are not considered. Since element 2 is not in the element set, its force contributions
will be considered. From the GPFORCE table, the x-force value that is extracted for node 4 is the
element 2 force 3.574e+02.
These values sum to 0.

X-Moment
All values are zero in this model.

Y-Moment
Node 1 is only attached to element 1 and has an SPC constraint. Since element 1 is in the
element set, its moment contributions are not considered. From the GPFORCE table, the y-
moment value that is extracted for node 1 is the SPC moment 2.370e+01.
Node 2 is only attached to element 1 and has an SPC constraint. Since element 1 is in the
element set, its moment contributions are not considered. From the GPFORCE table, the y-
moment value that is extracted for node 2 is the SPC moment 2.277e+01.
Node 3 is attached to elements 1 and 2. Since element 1 is in the element set, its moment
contributions are not considered. Since element 2 is not in the element set, its moment
contributions will be considered. From the GPFORCE table, the y-moment value that is extracted
for node 3 is the element 2 moment -8.871e+00.
Node 4 is attached to elements 1 and 2. Since element 1 is in the element set, its moment
contributions are not considered. Since element 2 is not in the element set, its moment
contributions will be considered. From the GPFORCE table, the y-moment value that is extracted
for node 4 is the element 2 moment -1.024e+01.
Additionally, the cross-product of all the forces about the Y axis need to be considered. Selecting
node 1 as the summation node (any node in the model can be selected) and performing rXF (all
element edge lengths are 0.166) the following is obtained:

Node 1
No additional rXF contributions since it is the sum point

Node 2
-0.166*Fx + 0*Fz = -0.166*-2.121e+03 + 0*-2.121e+03 = 3.535e+02

Node 3
0*Fx + -0.166*Fz = 0*-1.085e+03 + -0.166*6.426e+02 = -1.071e+02

Node 4
-0.166*Fx + -0.166*Fz = -0.166*1.085e+03 + -0.166*3.547e+02 = -2.400e+02

These values sum to about 0.
Since there are only 4 significant digits in the GPFORCE table, the precision of the calculated
moments are compromised. In the actual FBD utilities, the full result and machine precisions are
used.

Z-Moment
All values are zero in this model.
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Figure 1828: Output Table from the FBD Forces Utility
Element 1 (element set) with node 1 used as the summation point.

Resultant Force and Moment
The Resultant Force and Moment utility uses an element set and a node set (cross-section definition)
define the values to extract from the GPFORCE table.

The cross-section definition serves several purposes.

• All nodes in the node set must be attached to one or more elements in the element set.

• All nodes in the node set that have Applied loads will be extracted and utilized in Resultant Force
and Moment calculations.

• All nodes in the node set that have SPC loads will be extracted and utilized in Resultant Force and
Moment calculations.

• All nodes in the node set that have MPC loads will be extracted and utilized in Resultant Force and
Moment calculations.

• For all nodes in the node set, Element contributions from only those elements which are not a part
of the element set of the cross-section definition will be extracted and utilized in the Resultant
Force and Moment calculations.

The following example of Resultant Force and Moment extraction uses element 1 and nodes 3 & 4 from
the same example as the previous FBD Forces.

Node Set
The node set contains nodes 3 and 4; the element set contains only element 1.

X-Force
Node 3 is attached to elements 1 and 2. Since element 1 is in the element set, its force
contributions are not considered. Since element 2 is not in the element set, its force contributions
will be considered. From the GPFORCE table, the x-force value that is extracted for node 3 is the
element 2 force -1.085e+03.
Node 4 is attached to elements 1 and 2. Since element 1 is in the element set, its force
contributions are not considered. Since element 2 is not in the element set, its force contributions
will be considered. From the GPFORCE table, the x-force value that is extracted for node 4 is the
element 2 force 1.085e+03.
These values sum to 0.
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Y-Force
All values are zero in this model.

Z-Force
Node 3 is attached to elements 1 and 2. Since element 1 is in the element set, its force
contributions are not considered. Since element 2 is not in the element set, its force contributions
will be considered. From the GPFORCE table, the x-force value that is extracted for node 3 is the
element 2 force 6.426e+02.
Node 4 is attached to elements 1 and 2. Since element 1 is in the element set, its force
contributions are not considered. Since element 2 is not in the element set, its force contributions
will be considered. From the GPFORCE table, the x-force value that is extracted for node 4 is the
element 2 force 3.574e+02.
These values sum to 1.000e+03.

X-Moment
All values are zero in this model.

Y-Moment
Node 3 is attached to elements 1 and 2. Since element 1 is in the element set, its moment
contributions are not considered. Since element 2 is not in the element set, its moment
contributions will be considered. From the GPFORCE table, the y-moment value that is extracted
for node 3 is the element 2 moment -8.871e+00.
Node 4 is attached to elements 1 and 2. Since element 1 is in the element set, its moment
contributions are not considered. Since element 2 is not in the element set, its moment
contributions will be considered. From the GPFORCE table, the y-moment value that is extracted
for node 4 is the element 2 moment -1.024e+01.
Additionally, the cross-product of all the forces about the Y axis need to be considered. Selecting
node 3 as the summation node (any node in the model can be selected) and performing rXF (all
element edge lengths are 0.166) the following is obtained:

Node 3
No additional rXF contributions since it is the sum point

Node 4
-0.166*Fx + 0*Fz = -0.166*1.085e+03 + 0*3.547e+02 = -1.808e+02

These values sum to -2.000e+02. Since there are only four significant digits in the GPFORCE
table, the precision of the calculated moments are compromised. In the actual FBD utilities, the
full result and machine precisions are used.

Z-Moment
All values are zero in this model.

Proprietary Information of Altair Engineering



Altair HyperMesh 2019 Users Guide
Post-Processing Analysis p.3064

Figure 1829: Output Table from the Resultant Force and Moment Utility
For element 1 (element set) and nodes 3 and 4 (node set) with node 3 used as the summation point.

FBD Displacements
The FBD Displacements utility uses an element set and a node set to define the values to extract from
the Displacement table.

The element and node sets serve several purposes:

• All nodes in the node set will have displacement and rotation values extracted.

• The element set is for visualization and breakout modeling purposes only.

Additional Information

• Recommended practice is to output GPFORCE data for the element set(s) of interest only. This
procedure reduces the size of the .op2 file and helps speed up the FBD Forces extractions.
Additionally, for Nastran and OptiStruct, consider using STRESS = NONE and/or DISPLACEMENT =
NONE options to further reduce the size of the .op2 file. See the OptiStruct online Reference Guide
for more information regarding STRESS and DISPLACEMENT I/O Option cards.

• MPC forces and moments are properly extracted for the following MPC constraint types:

RBE2
RJOINT

RBE3
RROD

Rigidlink
RBAR
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• The GPFORCE and Displacement results are extracted from the .op2 file in float point precision in
binary format. This maintains the integrity of the calculations as well as enhances the performance
of the utilities.

FBD Solver Interfacing
The Free Body Diagram utilities behave differently depending on the solver that you interface with in
HyperMesh.

Abaqus
• Results are supported through the .odb output file.

• Grid point force results are requested with the following output requests:

*NODE OUTPUT

RF

CFD

*ELEMENT OUTPUT

NFORC

• Displacement results are requested with the following output request:

*NODE OUTPUT

U

• It is recommended practice to output data for only the node/element set(s) of interest. This
procedure reduces the size of the solver results file and helps speed up the FBD extractions.

• Abaqus rigid elements, *Rigid bodies, *Coupling constraints, *MPC, *Fastener and *Equations
do not export forces and moments. If any of these are attached to the element set of interest,
all elements attached to them must be included in the element set to insure the GPF balance is
correct. If they are not included, an imbalance will occur. Refer to the Abaqus documentation to
determine these elements/bodies. Make sure to check the validity of all GPF results when any of
these are present in the model.

• The FBD Export Manager is currently not supported for Abaqus.

ANSYS
• Results are supported through the .rst output file.

• Grid point force results are requested with the following output requests:

OUTRES,ALL,ALL

or

OUTRES,NSOL,ALL

OUTRES,RSOL,ALL

• Displacement results are requested with the following output requests:

OUTRES,ALL,ALL

or
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OUTRES,NSOL,ALL

OUTRES,RSOL,ALL

• The FBD Export Manager is currently not supported for ANSYS.

Nastran
• Results are supported through the .op2 and .xdb output files.

• Grid point force results are requested with the GPFORCE output request.

• Displacement results are requested with the DISPLACEMENT output request.

• It is recommended practice to output data for only the node set(s) of interest. This procedure
reduces the size of the solver results file and helps speed up the FBD extractions. Consider using
STRESS=NONE and STRAIN=NONE to further reduce the size of the results file.

• MPC forces and moments are properly extracted for the following MPC constraint types:

RBE2

RBE

RigidLink

RJOINT

RROD

RBAR

OptiStruct
• Results are supported through the .op2 output file.

• Grid point force results are requested with the GPFORCE output request.

• Displacement results are requested with the DISPLACEMENT output request.

• It is recommended practice to output data for only the node set(s) of interest. This procedure
reduces the size of the solver results file and helps speed up the FBD extractions. Consider using
STRESS=NONE and STRAIN=NONE to further reduce the size of the results file. You may consider
using the NOMODEL option on the OUTPUT,OP2 output format request.

• MPC forces and moments are properly extracted for the following MPC constraint types:

RBE2

RBE3

RigidLink

RJOINT

RROD

RBAR
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H3D Writer
Overview of how to create and manage H3D files.

Create H3D Files from HyperMesh
Using an H3D file, you can save 3D animations from HyperMesh in the .h3d format for viewing with the
HyperView Player.

In order to enable the option to create H3D files, you must activate the checkbox labeled launch HV
after H3D creation in the Options panel.

HyperView Player is an Internet browser plug-in for visualizing 3D Computer Aided Engineering (CAE)
models and results. Using product data in Altair's compact .h3d format allows you to incorporate
animated images in an HTML document for presentation or engineering reports. Simulation results can
be sent by e-mail or placed on the web for others to open and review.

HyperView Player is available as a free download on Altair's Web site at http://www.altair.com.

1. Select one of the following panels: Contour, Deformed, Hidden Line, Transient, or Geom Cleanup.

2. To control the display attributes for your model, specify your desired display attributes using visual
options or the visual panel.

3. Click Hyper3d or H3D > HV.

Two files are created. One is an H3D file, using anim#.h3d as the file name. The symbol # is
automatically assigned to the H3D file. The other is a sample HTML file including an <EMBED>
statement for the corresponding H3D file.

H3D > HV loads the newly created H3D file into HyperView. You can define this option in the
Options panel under modeling.

4. Review the model in a web browser.

• Double-click the HTML file to launch a browser.

• Click H3D to activate the standalone HyperView Player.

You can customize the external HTML template, h3d_template.html, located in the altair/hm/
html directory, to suit your needs.

Note:  In the HyperMesh Geom Cleanup panel, the Hyper3D button is displayed when you
select the shaded option in the Visual options subpanel.

Embed HyperView Player Object in HTML Documentation
Arguments and example for embedding statements in an HTML document in order to view a HyperView
Player graphic object.

Since the H3D file created from HyperView and HyperMesh includes scene information, the arguments
in the old statements for model readers and result readers are no longer needed. The HTML statements
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have been simplified in this release. However, the HTML files created for HyperView Player 3.1 are still
supported.

HyperView Player only supports H3D direct readers. You can create an H3D file using HyperView,
HyperMesh, HyperMesh result translators, such as hmnast, hmnasto2, hmradioss, hmpam, hmansys,
and hmabaqus, and OptiStruct.

Note:  You may need to modify your HTML files created for HyperView Player 3.1 if you were
using direct readers other than h3d.dll, such as adams.dll, gfile.dll, lsdyna.dll, and
madymo.dll, since those readers are no longer supported in HyperView Player.

To embed a HyperView Player object, the <EMBED> statement in HTML is used.

All arguments are case insensitive.

General Arguments for
EMBED Statements

Description

type Application/x-h3d

width/height Measured in pixels

SRC="URL" The location of the plug-in data file as indicated by its URL.

<EMBED type="application/x-h3d"
width=450 height=400

src="HTTP:\\www.altair.com\h3d\bumper.h3d">

<EMBED type="application/x-h3d"
width=450 height=400
src="../bumper.h3d">

Figure 1830: Embedded Statement Example

Share H3D Files
Share H3D files in an HTML file or via e-mail.

Share H3D Files Using HTML File
You can use HyperView Player to share information by embedding it in an HTML file.

You can use either a relative path or a standard Uniform Resource Locator (URL) to specify the path for
the H3D file in the <EMBED> statement. There are three different ways to define file transfer protocol:
FILE, HTTP, and FTP.

Select a protocol for file transfer using the files, anim1.html and anim1.h3d, as examples.
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Option Description

Embedded mode FILE://
An absolute path is required for File:// and the H3D file must reside
in the specified path. When you distribute the files, you may need to
modify the HTML file for the path.

<EMBED type="application/x-h3d" width=450 height=400
SRC="File://c:\Altair\demos\hvp\anim1.h3d">

Figure 1831: File:// Example

HTTP://
Others can access your public web area on the Internet. When sharing
an H3D file, you can place the anim1.html and anim1.h3d files in
your public HTML directory and send the link to others in the company
by email. The link could be, for example, http://www:8080/~John/
anim1.html. By doing this, you do not need to distribute the H3D file
and can guarantee the path is working correctly. If you have HyperView
Player installed and you click the link in the email, the model will be
displayed.

<EMBED type="application/x-h3d" width=450 height=400
SRC="http://www:8080/~John/anim1.h3d>

Figure 1832: HTTP:// Example

FTP://
You can place the anim1.html and anim1.h3d files on your FTP
site. If you have HyperView Player installed and you click ftp://
ftp.altair.com/pub/outgoing/HVP/anim1.html, the model is
displayed.

<EMBED type="application/x-h3d" width=450 height=400
SRC="FTP://ftp.altair.com/pub/outgoing/HVP/anim1.html>

Figure 1833: FTP:// Example

Relative path Using a relative path allows you to distribute an HTML file easily. You can
create a folder with the necessary HTML and h3d files for distribution.

<EMBED type="application/x-h3d" width=450 height=400
SRC="../anim/.h3d>

Figure 1834: Relative Path Example
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Option Description

Full page mode In an HTML file, you can easily hyperlink a string to an H3D file. When you
click the hyperlink, the plug-in loads a model in full-page mode.

Share H3D Files using E-Mail
You can attach an H3D file to an e-mail message.

If the recipient is using a PC, he or she can click the attachment and the H3D file will load automatically.
You can also save the H3D file and at a later time double-click the file to invoke the standalone version
of HyperView Player. Another available option is to drag the H3D file and drop it into a browser to view
the model in a full window.

1. Open your e-mail.

2. Attach the H3D file to your e-mail.

3. Click Send.

H3D FAQ
Learn more about H3D writer with these FAQs.

How can I view a model with shaded display in HyperView Player?
The model display settings are recorded during H3D creation. Set up the desired model display,
with such options as mesh lines and feature lines, in the Vis panel under the Performance
Graphics mode in HyperMesh.

Why doesn’t the legend setting in HyperView Player reflect the setting in HyperMesh?
HyperView Player only supports default settings for the legend display from HyperMesh. The
specified Max and Min values in HyperMesh are not recorded in the H3D file of this version.

Can I view complex result animation in HyperView Player?
No, the H3D writer does not support complex result data.

What types of element are not supported in the H3D file?
Second order elements, rigidlinks, and RBE3s are not supported in this version. The mid-side
node of a second order element is ignored when it is read into HyperView Player.

How can I change the window size for viewing HyperView Player in the browser?
You can modify the width and height values in the <EMBED> statement in the HTML file. For
example, width = 600, height = 600.
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